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Welcome to Lytec MD 
Welcome to Patient Records and Appointment Scheduler! 

Key features 
Patient Records is a complete medical records system for Microsoft Windows®. Patient Records is easy 
to use because it is modeled on paper-based patient records.  

Lytec MD is adaptable to a wide variety of settings, from a single-user configuration in a small medical 
office, to a local area network in a large multi-clinic setting, to a wide area network. The flexibility of 
Patient Records makes it an ideal choice for growing practices.  

Patient Records provides many essential features that will help you manage your patient information 
with ease.  

Instant Access  
Complete patient information is always at your fingertips. For each patient, you can quickly view 
patient history, progress notes, problem lists, health maintenance information, laboratory data, 
medications, notes, and more. A unique patient inquiry feature makes it easy to pinpoint information.  

Graphic Images  
You can use the built-in graphics editor to add or import images into patient notes. You can also 
quickly draw diagrams or edit medical images from a graphics library.  

Health Maintenance Tracking  
You can track health maintenance procedures such as immunizations and lab tests, and keep patients 
up-to-date with reminder notices.  

Prescriptions and Drug Interactions  
You can write and print prescriptions automatically as you record medications and dosages. The 
optional Drug Interaction database, available on a subscription basis, checks patient medications for 
drug interactions and allergies.  

Prescription Formulary  
This feature supports insurance-specific and specialty-specific formularies. It also enables you to select 
medications by indication.  

Report Capabilities  
You can create a wide variety of reports for practice analysis, research, recertification, and CME credits. 
You can also use the unique patient inquiry feature to design report queries, create mailing lists, and 
produce reminders.  

Efficient Data Entry  
You can enter patient information directly with Patient Records' word processing features, or import 
patient data from a word processor. The Patient Records Text Data Loader transfers information to the 
appropriate section of the patient chart, including the problem list, vital sign, medication, allergy, and 
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health maintenance categories. Laboratory data can be transferred electronically from an outside 
laboratory with the Laboratory Data Loader.  

Patient Information Analysis  
You can use the powerful patient inquiry feature to search for and analyze patient information. You can 
also export laboratory data, vital signs, medications, allergies, patient demographics, problem lists, 
visit titles, and health maintenance data to statistical packages, spreadsheets, and databases.  

Flow Charts and Plots  
You can instantly translate vital signs and laboratory data into a tabular format or display the items 
graphically, ensuring that the data can be easily read and interpreted.  

Integrated Patient Education  
You can use the built-in browser to access the optional Patient Education libraries, thousands of 
informational handouts that you can print and give to your patients.  

Built-in Browser for Knowledge Bases and the Web  
You can also use the built-in browser to access your own custom local knowledge base, and to surf the 
Web if you have Web access.  

Letters Feature  
You can configure templates and macros to automatically include patient demographic, clinical data, 
and conditional logic in letters. Patient Records supports full page layout, including fonts, headers, 
footers, and margins.  

Multi-User Capability and Remote Access  
You can use Patient Records with your networking software to make records available from several 
locations at once. With the addition of telecommunications software and a modem, you can access 
Patient Records from home or hospital.  

Multiple users may interact concurrently with Lytec MD and may view the same record, clinical 
document, or template, though the application does not allow multiple users to edit a document or 
piece of data at the same time. Record-level protection is provided. 

Confidentiality and Data Security  
You can prevent unauthorized access to patient information with multi-level password protection. You 
can also safeguard irreplaceable patient data with Patient Records’ archiving feature.  

Flexibility  
You can create your own patient chart sections and develop formats for progress notes, patient 
histories, and prescription forms. Other options that provide flexibility include renaming laboratory 
data categories and defining your own health maintenance protocols.  
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Usability  
You will use simple, straightforward Microsoft Windows commands, menus, and dialog boxes to get 
your work done. You and your staff will not need extensive prior computer experience or training to 
get started.  

Patient Records can be used equally well by small, medium-sized, and very large medical practices. 
You can use it on a single, standalone PC-compatible computer; a Microsoft® Windows NT® or Novell® 
network; or on a combination of standalone and network workstations. These systems may all be in a 
single location or connected by telecommunications to a remote site. For convenience, you may even 
want to transfer a copy of selected information to a laptop computer.  

When choosing the setup for your own office, you will want to consider your equipment budget, the 
size of your practice, and the size and capabilities of your staff. Whatever your decision, you will still be 
able to change configurations later as your practice grows.  

Common system configurations 
Lytec MD does not include hardware, though the Lytec MD Client Services and Support Staff can 
advise you on hardware selection. This section discusses several hardware setups that are typical of 
medical offices using Patient Records. 

A Network of PCs Using Both Patient Records and a Word Processor  
There are many terminals throughout the office and in each exam room. No files need be physically 
transported. When a terminal is not in use, the “Park” function is used to prevent unauthorized access 
to the system. This configuration takes the best advantage of Patient Records features.  

A Wide Area Network  
In many cases you may have practices in different locations. These can be connected together with a 
single central database. For practices with many workstations you should consider a T1 high-speed 
phone line or its equivalent. For smaller remote practices you may choose a remote control solution 
(for example, Citrix) that can use a slower phone line such as a dialup, 56K, or ISDN line.  

If you cannot connect the practices with reliable high-speed phone lines, you can keep a local 
database in each practice and merge the data into a central database each night.  

A Network of PCs, Along with a Remote PC  
The network version of Patient Records is installed so that various authorized personnel have access to 
the system from a variety of locations in the office. A remote medical transcriptionist uses the remote 
PC for medical transcription with a word processor. Data is transferred on floppy disk or via modem 
from the word processing computer to the Patient Records network.  

A Single PC-Compatible Computer  
In a small office, Patient Records can be set up on a single, standalone PC. The hard disk has Patient 
Records installed on it. All data entry and retrieval is done on this single computer. A provider receives 
a printed chart summary or complete chart to carry into the exam room. The printout may be 
discarded after the visit.  
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Standalone PCs with Laptops for Remote Access 
The same configuration as above, with the addition of portable laptop computers. Patient charts 
needed by a provider are transferred from the Patient Records system to the portable. The provider 
carries the portable into the exam room, and has access to the complete patient chart.  

Additional Hardware Options 
In addition to any of the hardware setups above, you will want to add the capability for a physician or 
other provider to access Patient Records from a remote location. You can add a modem hookup so 
that an authorized provider can dial in from another standalone PC at home, in the hospital, or in 
another office. Or you can use Patient Records unique “Transfer to Portable” feature so that selected 
patient information can be copied to and re-synchronized from a portable system. For example, a 
provider might use the portable system to view and edit patient information while on hospital rounds 
or at a nursing home.  

You may also wish to provide a modem so that an outside laboratory facility can send laboratory data 
via telecommunications in a format that can be loaded directly into Patient Records.  

System Requirements 
This version of Lytec MD requires that you have Windows 2000, Windows 2003, Windows XP, or 
Windows Vista Business edition. Lytec MD no longer supports Windows 95, Windows 98, Windows 
ME, or Windows NT4.0. 

See the System Requirements Guide for a complete list of Lytec MD's system requirements.  
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Logging on to Lytec MD 
Every Lytec MD operator is assigned a user name and password. This prevents unauthorized access to 
the system, protects critical patient information, and protects patient confidentiality. Lytec MD provides 
several access levels so that users may have access to some or all of the program features. 

Each time you sign into Lytec MD, you must correctly enter your user name and password. The 
characters you enter for the password are replaced with asterisks (*) on the screen so that no one will 
see what you are typing. 

A system administrator may limit the number of log on attempts using PRUtils. If an operator's number 
of unsuccessful attempts exceeds the number permitted, the operator's status changes to inactive and 
Patients Records must be restarted. A system administrator must restore an inactivated operator to 
active status. 

Operators can be assigned a default provider and practice that display automatically on the log on 
screen. If your operator account has the appropriate access permissions, you can select a different 
provider and practice when you log on. Once you are logged on, you can also change the current 
provider, if necessary. 

The sign-in provider and practice are used by many areas of Lytec MD as defaults. For example, the 
sign-in provider will be used as the current provider for charts, notes, schedules, and messages. The 
sign-in practice is useful if you have multiple locations or sites, or you want to restrict access to certain 
patient charts. 

Note: If you are on a network, the system makes sure that you are running the latest version of Lytec 
MD installed on your file server. If you are not, Lytec MD will automatically update your software. An 
update message (“Will exit to finish updating. You must restart the application.”) will appear. This 
message displays only for the first time that the client is updated. Click the OK button and restart the 
application. 

Logging on to Lytec MD 
To start Lytec MD: 

Start Lytec MD (by clicking the Lytec MD icon or by selecting the appropriate version on the Start 
button’s Programs menu). The Lytec MD Sign In screen appears. 

In the User ID field, type your assigned user identification code. 

In the Password field, type your password. 

In the Provider ID field, select the appropriate provider. If the system administrator set you up with a 
default provider, the ID appears automatically in this field. 

If you work in a setting with multiple practices, select the appropriate practice in the Practice ID field. If 
the system administrator set you up with a default practice, the ID appears automatically in this field.  

Note: You can only change the values in the Provider ID and Practice ID fields if the access level 
associated with your operator account has 'Access' rights enabled for the Provider/practice selection 
item on the Access Level Configuration screen. 

Click the OK button. A disclaimer screen appears. 

Please review the important information on the disclaimer screen thoroughly, and then click OK. 

If you are using the Drug Interaction database, and the database is near its expiration date, you will get 
a warning indicating the expiration date of the database. If the database has expired, you will get the 
warning "Drug Interaction or Allergy Checking database has expired. Therefore, this checking will not 
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occur." Please see the Clinical Tools Installation and Upgrade Guide for information about how to 
update your Drug Interaction database. 

The main Lytec MD screen appears. 
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Passwords 
Every operator has an assigned user name, password, and access level. This prevents unauthorized 
access to the system, protects critical patient information, and protects patient confidentiality. A system 
administrator does the following for the user: 

• Creates the user name. 

• Creates the personal password that is used on an ongoing basis, or creates a temporary 
password that is used one time. 

• Assigns the access level. 

Depending on what system settings were made, either the system administrator or the operator 
creates a personal password used by the operator on an ongoing basis. Also, the system settings 
control what restrictions there are in creating passwords. 

When an operator creates a personal password, the system administrator creates a temporary 
password for the operator's initial use. An operator-created personal password may be good for a 
limited time period. A system administrator may reset an operator's password at any time.  

When an operator uses a temporary password created by a system administrator during log on, 
Password displays after using the temporary password. The operator uses Password to create an 
ongoing personal password.  

An operator-created personal password may be set to expire after a set period of time. When a 
personal password expires, Password displays to create a new personal password. 

When a system administrator creates the personal password used on an ongoing basis, Password 
does not display when an operator uses that password during log on. 

Encryption of Passwords 
Lytec MD stores passwords using 192-bit key encryption with the Triple DES algorithm (TDEA or 
3DES). Passwords are encrypted for transmission between client workstations and the database. 3DES 
is a standards-based encryption algorithm widely used in the computer industry when secure 
encryption is required.  

Secure Transmission of Protected Health Information 
It is of the utmost importance that the security of Protected Health Information be maintained. Lytec 
MD wishes to advise you of the following: 

1. Lytec MD stores passwords using 192-bit key encryption with the Triple DES algorithm (TDEA 
or 3DES). Passwords are encrypted for transmission between client workstations and the 
database.  

2. If you choose to allow access to your system remotely through the Internet (e.g., through 
Windows Terminal Services or Citrix), you should require use of an encrypted Virtual Private 
Network ("VPN") connection via a 3DES-compliant firewall. Use of a VPN connection utilizing 
the L2TP/IPSec protocol is recommended to ensure data integrity. We recommend that you 
configure your VPN to require, in addition to username and password, authentication by 
means of a physical token with a tokencode that is frequently and automatically updated. 

3. If you use a wireless network within your practice, we recommend you configure the wireless 
network to use 128-bit WEP or WPA encryption. This provides for data integrity as well as 
confidentiality. To protect against false remote nodes (that is, access to your network by 
unauthorized parties), we recommend that you disable broadcasting of your wireless network’s 
SSID, and restrict access to nodes with known MAC addresses. 
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4. When Lytec MD uses the Internet for outbound interfaces, this traffic travels either through an 
encrypted VPN connection or with SSL encryption. 

Procedure for changing a password 
To create a temporary or personal password by a system administrator: 

A system administrator follows these steps when an operator needs a new password, or when the 
operator cannot log on using an existing password. 

Note: Only asterisks (*) display in the box when typing the new password. This helps to protect the 
security of the new password from anyone that might see it on the monitor. 

1. From the Maintenance menu, point to Set Up, and then click Operators. This opens Re-enter 
Password. 

2. Type the password in Please re-enter the password, and click OK. This opens Operator. 

3. Click to highlight the operator, then click Edit. This opens Operator Maintenance to the 
General tab. 

4. Change the password on the General tab, using up to 16 characters: 

5. If this is a personal password used by the operator on an ongoing basis, type the changes in 
Password. 

6. If this is a temporary password used by operator one time only, click Reset Password and type 
the changes in Temporary New Password.  

7. Click OK. This closes Operator Maintenance. 

8. Click Close on Operator. The new password has been created. 

9. Inform the operator of the new password. 

If the system administrator created a temporary password, the operator creates a personal password 
when logging on. 

To create a personal password by an operator: 

An operator follows these steps when prompted by the system. This would occur when a system 
administrator creates a new temporary password for the operator or when a password has expired. 
This steps following immediately after typing the User ID and Password on Lytec MD Sign In and 
clicking OK. This opens Password with the request, "Please change your password." 

Note: Only asterisks (*) display in the box when typing the new password. This helps to protect the 
security of the new password from anyone that might see it on the monitor. 

1. Type up to 16 characters in New Password for use as the personal password on an ongoing 
basis. 

2. Type the same characters in Re-enter new password that as they were typed in New Password 
in order to verify the text. 

3. Click OK. The new personal password has been created. 

Restrictions on passwords  
The system administrator restricts what may be used as a password. These settings include: 

1. Set a minimum length for a password. The minimum may be from 4 to 16 characters. 
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2. Prohibit a new password matching a recently used password. This may be set to prohibit 
matching up to the last five passwords used. Using 0 (zero) turns off this check. 

3. Optionally require a password to have at least one letter and one number. 

4. Optionally require a password to have at least one character that is not a letter or a number. 
This would require using at least one symbol such as @, &, and ^. 

5. Optionally prohibit a password from containing the user log on name. 

6. Optionally validate a password against a forbidden word list.  

A message warns when a new password violates one of the restrictions. A different password must be 
chosen before a new password may be saved. 

See PRUtils for more information about setting restrictions on passwords. 

Information on Password 

Field Description 

New Password Type up to 16 characters in the box. This becomes the new 
personal password when finished. 
Only asterisks (*) display in the box in order to protect the 
security of the new password from anyone that might see it on 
the monitor. 

Re-enter new password Type the same characters in the same way they were typed in 
New Password. This verifies the new password. 
Only asterisks (*) display in the box in order to protect the 
security of the new password from anyone that might see it on 
the monitor. 
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Changing the Current Provider or Practice When You 
are Logged In  
Note: You can only change the current provider or practice if the access level associated with your 
operator account has 'Access' rights enabled for the Provider/practice selection item on the Access 
Level Configuration screen. 

To change the current provider or practice:  

1. Click the Prov button on the toolbar. The Provider/Practice Selection screen appears.  

2. In the Provider ID field, select the current provider from the drop-down list. You can also type 
the ID in the field.  

3. If you work in a setting with multiple practices, you can select the practice whose data you want 
to access. Select the appropriate practice from the drop-down list, or type the ID in the field.  

4. Click the OK button. The main Lytec MD screen appears.  
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Parking workstations 
The Lytec MD Park feature may be used when leaving the workstation for a moment without exiting 
from the program. When a workstation is “parked” it cannot be accessed without re-entry of a valid 
operator's user name and password.  

The system administrator may do the following: 

Use a setting on the Special Features screen to prevent window switching when the Park function is 
activated.  

Use a setting on the Special Features screen to display a confirmation message when operators 
attempt to park a workstation. 

Use a setting in PRUtils to automatically lock workstations after a specified period of time (AutoPark). 

How to unpark a workstation depends on whether window switching while the workstation is in Park 
mode is enabled.  

If the window switching option is enabled, enter two passwords (the screen saver or workstation 
password, and then the Lytec MD user name and password) to resume working on the workstation.  

If the window switching option is not enabled, enter only the Lytec MD user name and password to 
resume working on the workstation. 

Parking and unparking workstations 
To park a workstation: 

Do one of the following to park a workstation. 

• Select File > Park.  

• Click the Park button on the tool bar.  

Note: If the Confirm Park Selection check box is selected in the Special Features screen, a 
confirmation message appears. Click Yes to park the workstation. 

To unpark a workstation: 

Note: If the window switching option is enabled, first enter the screen saver or workstation password. It 
may be necessary to press CTRL+ALT+DELETE to use this password screen. 

1. Type your assigned user identification code in the User ID field.  

2. Type your password in the Password field.  

3. Type the appropriate provider ID in the Provider ID field, or click the down arrow button to 
select the appropriate provider from the Provider Select screen. If the system administrator set 
you up with a default provider, the ID appears automatically in this field.  

4. If you work in a setting with multiple practices, select the appropriate practice in the Practice ID 
field. If the system administrator set you up with a default practice, the ID appears automatically 
in this field. 

Note: You can only change the values in the Provider ID and Practice ID fields if the access level 
associated with your operator account has 'Access' rights enabled for the Provider/practice 
selection item on the Access Level Configuration screen. 

5. Click the OK button. The last active screen used on Lytec MD displays. 
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Getting started 

Exploring the main Lytec MD screen 
To navigate through Lytec MD, it is important that you understand the parts of the screen.  

The main Lytec MD screen appears when you log into the program. This screen is your work area. The 
main screen contains the:  

• Title bar - The title bar states the title of the program. This is standard in all Windows packages, 
including Lytec MD. When you open a patient chart, the patient’s name appears in the title bar.  

• Menu bar - The menu bar contains the menus of Lytec MD commands. The menus and 
commands available may change depending on the task you are currently performing. For 
example, the Maintenance menu will not appear when you are in the patient chart, because you 
cannot perform maintenance tasks while you are working with patient information.  

• Tool bar - The tool bar provides instant access to important Lytec MD functions (Exit, Park, Chart, 
Schedule, and so on). You can click these buttons to activate the related function. There are 
times when some of the buttons on the tool bar may be disabled (not available), because the 
functions of the buttons are not appropriate for the task you are currently performing.  

• Go to bar - When a patient chart is open, the go to bar provides a shortcut to crucial sections of 
the patient chart. The go to bar, located just above the status bar, contains buttons for the most 
commonly used sections of the patient chart. When a section contains data, the related button is 
highlighted. You can access a patient chart section directly from the go to bar by clicking the 
corresponding button.  

• Status bar - The status bar (or message bar) at the bottom of the main Lytec MD screen, displays 
the provider ID of the current provider with the text “Provider” prefacing the ID. The operator ID 
of the current operator is also displayed with the text “Operator” prefacing the ID. Your system 
administrator can use ppart.ini settings to turn this feature off. The status bar also displays 
additional information or messages about the task you are currently performing. For example, 
when a patient chart is open, the status bar displays the current patient's ID, sex, age, and Web 
View status. 
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Shortcut Keys to Speed Data Entry 
Patient Records provides many shortcut keys to speed data entry. You can use shortcut keys as 
keystrokes instead of a mouse to select menus, click buttons, and more. Using a shortcut key consists of 
pressing and holding one or more keys while pressing a second or third key. For example, to close a 
screen you can press and hold the Alt key and then press C (Alt+C) instead of selecting the Close 
button.  

Patient Records makes it easy for you to access file menus, tabs and buttons by selecting the following: 

• File Menus: Press and hold the Alt key on the keyboard, and then press the menu's underlined 
letter. 

• Tabs: Press and hold the Alt and Shift keys on the keyboard, and then press the first letter of the 
tab label. If multiple tabs have the same first letter, then press again to open the desired tab.  

• Buttons: Press and hold the Alt key on the keyboard, and then press the button's underlined 
letter.  

Button Shortcut Keys  
The following button shortcut keys can be used from any of the Lytec MD screens: 

Button Shortcut 

OK  Enter 

Cancel ESC 

Apply Alt+Y 

New Alt+N 

Delete Alt+D 

Close Alt+C 

Help Alt+H 

Main Menu Shortcut Keys 
The following shortcut keys can be used to access the main menus from the main Lytec MD screen. 
Once the selected main menu is open, you can select the menu's options, by pressing Shift + the 
underlined letter on the menu item.  

Menu Shortcut 

File Alt+F 

Show Alt+S 

View Alt+V 

Task Alt+T 

Maintenance Alt+M 

Reports Alt+R 

Help Alt+H 
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Getting help with Lytec MD 
Lytec MD, is committed to providing customers with high-quality, timely technical support. This section 
describes the range of support services available. 
 
Lytec MD Patient Records & Appointment Scheduler is warranted for ninety days. See the licensing and 
limited warranty agreement for additional details.  

If you need more information about using Lytec MD, many resources are available to you. Here are a 
few options: 

• View the online help: Lytec MD provides an extensive online help system. 

• View the printed documentation. The printed documentation includes details on setting up 
and using Lytec MD, and is available on the installation CD. 

• Obtain telephone product support: Live product support is available from Lytec MD Technical 
Support at 800-895-6700. There are several options for reaching Technical Support by 
telephone, depending on whether you have a support contract and what time of day you are 
calling.  

Before calling Technical Support, please have the following information ready: 

• A brief description of the problem, including the exact text of any error messages 
received, and the steps necessary to recreate the problem.  

• The type of computer, monitor, and printer in use.  

• The version of Appointment Scheduler and the version of Microsoft Windows in use. 

Note: To see Lytec MD system and version information, select Help > About Lytec MD. The screen that 
appears will identify the version of Lytec MD installed on your system and your practice-specific 
product ID. 
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About the Patient Records Online Help  
Once Lytec MD is installed, the online help is available. The Lytec MD online help works like the online 
help in most Microsoft Windows applications, so it will look very familiar to you.  

You can access online help in several ways:  

Search for general topics by selecting Help > Contents. You can search the table of contents by using 
the Contents tab, search the index by using the Index tab, or search all words in the online help by 
using the Find tab.  

Search for context-sensitive help by pressing F1 or by clicking the Help button on the tool bar. Context-
sensitive help provides information related to the screen you are currently using.  

Using the online help 
The Lytec MD help provides the following tools to assist you: 

• Contents tab: The Contents tab displays the table of contents. Information on this tab is 
organized into books and pages that represent categories of information in the help. When you 
click a closed book, it opens to display its content (sub-books and pages). When you click an 
open book, it closes. When you click pages, you select topics to view in the viewing pane to the 
right of the help window.  

• Index tab: The Index tab displays a list of keywords and phrases associated with topics in the 
help system. To open a topic in the viewing pane, click the keyword. 

• Search tab: The Search tab provides a full-text search of the Lytec MD help. You can type 
keywords or phrases in the search field, then click the List Topics button to display a list of topics 
containing those words.  

• Glossary tab: The Glossary tab provides a list of words and their definitions, as they relate to 
Lytec MD. Clicking a term in the top frame displays the corresponding definition in the lower 
frame. 

• Browse sequences: Browse sequences are different than the Back and Forward buttons you 
may be familiar with from web browsers such as Internet Explorer. Browse sequences guide you 
through a series of topics in a specific order. For example, when you are viewing the Patients 
topic (about the Patients screen), the related browse sequence links all topics related to the 
Patients screen. You can click any topic in the browse sequence frame to jump directly to that 
topic, or use the Previous and Next buttons to move through the browse sequence one topic at a 
time. 
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For system administrators 

Installing Lytec MD 
Patient Records/Appointment Scheduler can be adapted to a variety of medical practices. For example, 
you can use Lytec MD with different computer hardware configurations, monitors, and printers.  

Lytec MD meets the demands of small practices with a single health care provider as well as much 
larger practices. If your practice grows, you can change your system to accommodate more patients, 
more health care providers, or an expanding computer system. Lytec MD can be used along with 
networking software in a multi-user environment or accessed via a remote personal computer.  

The installation media (CD-ROMs) for Lytec MD software, and the systems on which they are created, 
have been subject to scanning for viruses with McAfee Virus Scan using up-to-date virus detection data 
files. 

See the Lytec MD Installation Guide for detailed instructions on installing or upgrading Lytec MD.  

Client Notes  
This section provides important information for sites installing Lytec MD on client workstations.  

MRPATH.FL  

This file, which Lytec MD installs on the client local drive, contains the drive and path for Patient 
Records data on the network. It is critical that the drive mapping for this data be the same on all client 
workstations.  
 
If you are using Lytec MD on multiple network file servers, make sure that each file server is mapped to 
a unique drive. The drive in MRPATH.FL will redirect the user to the correct data server (for example, 
F:\ppart\).  

You must include the trailing slash mark (\) after the pathname.  

Updates  

For updates, you only need to update the software to the file server from a workstation. The next time a 
client runs an older version of Lytec MD (i.e., a version older than the one on the server), Lytec MD 
automatically updates the client software.  
 
When clients are automatically updated, a message will inform users that they must restart Lytec MD. 
This message displays only for the first time that the client is updated. Click the OK button and restart 
the application.  

After Installation: What’s Next?  
After installation, click the Lytec MD icon to start the application, and enter your user name and 
password. Then configure Lytec MD to suit your practice’s daily routines.  

Patch (hot-fix) Handling Process 
New Lytec MD features are provided through a formal upgrade process, using an upgrade installer 
program provided by Lytec MD. Patches are produced only on occasion and supplied directly to 
customers, generally on CD-ROM.  
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To install a patch:  

1. Copy the patch file into your server's pp2000 folder. 

2. Open a DOS prompt, navigate to your pp2000 folder, and enter: 

touch prw.new 

Post-installation testing consists of verifying that the problem the patch was intended to fix no longer 
occurs. 

During the installation and upgrade processes, Lytec MD detects the need for critical Operating 
System updates or patches which are necessary for proper functioning of Lytec MD, notifies the 
administrator performing the installation or upgrade, and automatically applies those updates or 
patches based after user confirmation. Please reference the documentation from the provider of the 
update patch for information about the effects the update or patch may have on your system. 

Lytec MD will post updates on our website (www.lytec.com) and/or directly contact you when we 
become aware of any new Operating System updates or patches which are necessary for proper 
functioning of Lytec MD.  All other hardware, firmware, operating system, or database management 
system patches or updates are the responsibility of the customer, per Lytec MD's specifications as to 
supported versions. 

For updates to Microsoft Windows operating systems and the Microsoft SQL Server database 
management system, see: 

http://www.microsoft.com/downloads 

For updates to Oracle database management systems, see: 

http://www.oracle.com/security/critical-patch-update.html 

Updates to C-Tree Plus and C-Tree server database management systems are included in the Lytec MD 
application. 

Encryption of Passwords 
Lytec MD stores passwords using 192-bit key encryption with the Triple DES algorithm (TDEA or 3DES). 
Passwords are encrypted for transmission between client workstations and the database. 3DES is a 
standards-based encryption algorithm widely used in the computer industry when secure encryption is 
required.  
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Backing up Lytec MD 
Backing up your data is critical! Your data is an asset, and serves as evidence of what you do. Under 
normal circumstances, you are unlikely to lose the information that you enter in Lytec MD. Lytec MD will 
retain data until it is purged, deleted, archived, or otherwise deliberately removed. However, if your 
Lytec MD data is lost or becomes corrupt, your office could have quite a problem on its hands.  

Data can be damaged by a malfunctioning computer system or the failure of media used to store the 
data (such as a tape). Either way, you'll have data you cannot get to, so your best bet is to be armed 
with backup "best practices" and good equipment.  

Lytec MD supports full backups and restoration of application data, security credentials, and audit files. 
We recommend a backup plan based on systematic rotation of the backup media (tapes, disks, CDs, 
etc). The goal is to recover data as quickly and easily as possible. 

Through a locally available drive, you should back up data using a writeable CD-ROM, tape drive, or 
other media.  

Note: If you run Lytec MD on a network, all other users must exit from the program before you start the 
backup.  

Before backing up or restoring your data 
If your site is using c-tree Server, you must turn off c-tree Server before backing up your data. See the 
Stopping the c-tree Server section in the c-tree Server System Administrator's Guide for more 
information.  

Before backing up your data or restoring your data using your backup system, you must stop the PMSI 
Application Service and the PMSI Data Service. After the backup or restore is complete you must re-
start the PMSI services.  

Important  
• The PMSI Service Manager must be run on the server.  
• If your site uses Web View it is advised that the services be restarted during off peak hours to ensure 

no users will be affected.  
• You should not stop the services when there are users still running Patient Records. The services can 

be stopped with clients still connected, but it is advised that all clients disconnect.  

To stop and restart the PMSI Services:  

1. Open Windows Explorer, and navigate to your \ppart directory (usually p:\ppart). 

2. Double-click the PMSI.Networking.Services.Manager.exe. The PMSI Service Manager screen 
appears. 

3. If the PMSI Application Server status is “Running”, click the Stop button. Windows will stop the 
PMSI Application Server and the status will change to “Stopped”.  

4. If the PMSI Data Server status is “Running”, click the Stop button. Windows will stop the PMSI 
Data Server and the status will change to “Stopped”.  

5. Click the Start buttons. Windows will start the PMSI Application Server and the PMSI Data Server 
and the status will change to “Running”.  

Minimum recommended backup plan 
We recommend maintaining separate daily backups, archived in a safe place, during the current week, 
weekly backups for the current month, monthly backups for the current year, and annual backups.  
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You can put this kind of system into place by rotating disks or tapes. For a five-day workweek, use four 
tapes for daily backup. You'll also need four tapes for the weekly backup, 12 tapes for the monthly 
backup, and a tape for each year.  

The table below provides a sample backup plan. 

Time period Description

Daily Each day, create a backup of the data files. The daily backup 
does not contain the whole database, rather only the data files 
that have been modified the day the daily backup is 
performed. 

Weekly Every Wednesday, do not do the daily backup, but a weekly. A 
weekly is a backup of the whole database, including the log 
files and database files. This backup overwrites the oldest 
weekly backup tape, so there is no Wednesday tape.  

Monthly On the last Wednesday of every month, you do a monthly 
backup. To do this backup, trade the newest weekly backup 
tape for the monthly backup tape, and overwrite it. 
Note: Some months have five Wednesdays, so you'll need at 
least four tapes for storing the weekly backups.  

Annually On the last Wednesday of the year according to the calendar 
year you've established, remove the newest monthly backup 
disk, tape, or CD. Permanently archive it and then replace it 
with new media.  

In all cases, you're only doing a single backup operation, which means that you never have to do both a 
"daily" and a "weekly" backup. Also, you don't have to do anything special at the end of a month or 
year. Simply rotate the tapes and ensure they're labeled properly.  

This backup plan is practical, and can be set up with very little effort. The entire rotation scheme can be 
accomplished with as few as four tapes for the current week (Monday, Tuesday, Thursday, Friday); 
three tapes for the current month (Week 1, Week 2, and Week 3), and 12 tapes for the current year. 
Rather than rotating the last weekly up to the month tier, there are benefits to maintaining the system 
with one tape for each month. One of these is that you don't need to remember which month has no 
tape.  

This basic backup plan can be changed to suit the workload at your practice. For example, if you have a 
very heavy workload, you may elect to do full backups daily, where you would reset the transaction log 
file each day, as well. Conversely, in a very light workload scenario, you might do full backups only 
once per month, backing up your transaction log file each week.  

Copying the backup files to archive media 
Once your have your backup files, you can copy them to the archival media. For added security, you 
could make two copies of the backup so that you have one for off-site storage.  

After you have completed the backup, be sure to make it a habit to copy the backup files onto archive 
media as soon as possible.  

Here are a few more backup tips: 

• If you are using magnetic media (tapes or floppy disks), don't overwork the media by continually 
overwriting it. Choose some number of overwrites as your limit, and maintain a count either on 
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the label or in your logs. When the media has been used the planned number of times, switch it 
out.  

• Be sure that your backups are kept in a secure area. It's a good idea to store all the backup disks, 
CDs, or tapes off-site.  

• Consider making duplicate copies of your monthly and annual backups so that you can if needed 
restore the system without having to go get off-site media. 

• Many commercial backup software applications are available, and you should test whatever you 
buy. Several times per year, restore data using your backup system to double-check its 
operation. 

What data to backup 
The location of your Lytec MD data will depend in which database management system you are using. 
The following are recommendations for ensuring a complete backup of your data for each of the 
database management systems which can be used with Lytec MD: 

c-tree Plus: 

• The database directory (assigned by user during system installation, usually p:\ppart) 

• The files folder(s) (assigned by user during system installation and referenced by the "basepath" 
line in ppart.ini and; usually a sub-directory of ppart) 

c-tree Server: 

• The database directory (assigned by user during system installation, usually p:\ppart) 

• The files folder(s) (assigned by user during system installation and referenced by the "basepath" 
line in ppart.ini and; usually a subdirectory of ppart) 

• The c-tree Transaction Files (designated in the c-tree Server Configuration File, usually one 
folder level up from the Database Directory; any file in this location with a suffix of .fcs should be 
backed up) 

Microsoft SQL Server: 

• The application directory (assigned by user during system installation, usually p:\ppart) 

• The files folder(s) (assigned by user during system installation and referenced by the "basepath" 
line in ppart.ini and; usually a sub-directory of ppart) 

• A full database backup, including transaction logs (using SQL Server Enterprise Manager) should 
be done nightly. In addition, the transaction log should be backed up several times a day. 

Oracle: 

• The application directory (assigned by user during system installation, usually p:\ppart)  

• The files folder(s) (assigned by user during system installation and referenced by the "basepath" 
line in ppart.ini and; usually a sub-directory of ppart) 

• Back up your Oracle database using one of Oracle’s integrated backup processes. We advise 
you retain the services of a qualified Oracle database administrator for backups of Oracle 
databases. 

Please see the System Requirements Technical Guide for suggestions on tape drive formats. We 
recommend software from the following vendors for tape backups. These can be used with many 
different tape backup systems: 

• Veritas 

• Yosemite 
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Restoring data from a backup 
It is possible to restore all of your application data, security credentials and log/audit files from a 
backup. The process for restoring data from a backup depends on the type of database management 
system you are using.  

c-tree Plus: 

• Replace your existing database directory (usually p:\ppart) with the backed up copy of the 
database directory 

• Replace your files folder(s) with the backed up copy of the files folder(s) 

c-tree Server: 

• Shut down c-tree server 

• Replace your existing database directory (usually p:\ppart) with the backed up copy of the 
database directory 

• Replace your files folder(s) with the backed up copy of the files folder(s) 

• Restart c-tree server 

Microsoft SQL Server: 

• Replace your existing application directory (usually p:\ppart) with the backed up copy of the 
application directory 

• Replace your existing files folder(s) with the backed up copy of the files folder(s) 

• Restore your backed up SQL database using SQL Enterprise Manager, overwriting the existing 
database, if one exists 

Oracle: 

• Replace your existing application directory (usually p:\ppart) with the backed up copy of the 
application directory 

• Replace your existing files folder(s) with the backed up copy of the files folder(s) 

• Restore your backed up Oracle database using one of Oracle’s integrated restoration processes. 
The method for doing this depends on the method used for creating the backup. We advise you 
retain the services of a qualified Oracle database administrator for restoration of Oracle 
databases. 

If you need to restore data from a backup and have any questions about how to go about it, please 
contact the Lytec MD Support Department. Lytec MD Support will attempt to provide guidance but will 
not perform actual data restoration processes. 
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Configuring Lytec MD 
Before you enter patient information in Patient Records and Appointment Scheduler, you need to think 
about how you want to organize the information that you will store in Lytec MD.  

Lytec MD lets you organize your data to a considerable degree, modifying the system to suit your way 
of working. You can use templates, the user-defined fields, and other Lytec MD features to do just that.  

Some of the features you can set up on the Maintenance menu include: 

• Providers 

• Practices 

• Referring sources 

• Operators 

• Access levels 

• Printers 

• QuickText 

• Diagnosis/problem codes 

• Procedure codes 

• Insurance carriers 

• Demographic guides 

• Address defaults 

• Specialty codes 

• Templates for Patient Records: You can create or modify templates for health maintenance; 
laboratory data; progress notes; prescriptions; formularies; letters; pages; Past Medical, Social, 
and Family History; flow charts; images; and more 

• Customize Patient Records' patient chart for the site or individual providers  

• Customize Patient Records' chart summary for the site or for individual providers  

• For Appointment Scheduler: Rooms, resources, calendars, schedule templates, and more 

• You can also configure options using the ppart.ini file, including: 

• Requiring providers to sign each note during review  

• Requiring that lab data results be sent to a provider  

• Selecting which font should be used in notes  

• Removing vertical blank lines in notes  

• Removing blank lines from unexpanded labels in notes  

• Setting how major problems are inserted into notes  

• Changing the settings for units of measurement: English or metric  
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Maintaining Lytec MD 
To make sure that Lytec MD works efficiently in your practice, and to safeguard your records from loss, 
you should follow some simple housekeeping procedures.  

You should always maintain appropriate backups for your system. You can use a variety of media for 
archiving and/or backing up your Lytec MD database.  

You can also import and export forms from Lytec MD. 

For Patient Records, additional maintenance procedures include:  

• Archiving the records of inactive patients to keep your disk from becoming too crowded.  

• Restoring archived information to the system.  

• Merging two records when a patient has accidentally been registered twice (for example, under 
slightly different names).  

• Importing charts into and exporting charts out from Patient Records.  

• Purging outdated messages from the system.  

• Purging patients with no clinical data - you can use this feature to purge outdated records of 
patients who have not made an appointment with your office or practice, and who have no Lytec 
MD data.  

• Purging old access log files, if this feature is active.  

• For Order Entry, additional maintenance procedures include: 

• Archiving orders. 

• Changing the status of orders. 

• Importing extended order screens. 

• For Appointment Scheduler, additional maintenance procedures include: 

• Purging appointments. 

• Purging hospital rounds to purge discharged patients from Hospital Rounds and print Admission 
and Discharge Summary and Hospital Admission and Discharge Statistics.  

• Changing provider schedules to move the schedule of one provider into the schedule of another 
provider.  

• Scheduling appointments in the Wait List in batch mode to automatically schedule appointments 
in the Wait List in one large group. Normally you would do this when you open up a new month’s 
schedule.  

• Deleting old file logs. From time to time, you will need to delete the old file logs used for 
logging appointments as they were made. The easiest way to do this is to delete a month of logs 
at a time. Before you delete the old file logs, make sure that you backup your data first. 
 
For example, to delete all the file logs for March 2008, make sure you are in the appointment log 
directory and type the following at a system prompt: 
 
del 03??08.apt [RETURN]  
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Using templates 

About templates 
Patient Records uses “templates” to help you customize patient charts for your practice. Templates are 
simply sets of standard formats for the sections of patient charts, like the ruled and labeled sheets that 
are used in a paper patient record-keeping system. With Patient Records, you have the opportunity to 
design your own formats.  

In many cases, you can define what type of patient information you want to display and the format in 
which it is displayed. Some templates are required (marked below), while others are optional.  

You can set up templates for:  

• Laboratory Data (required) - Select the laboratory tests names you will use and the normal 
range of values for each test. These categories are displayed on the Laboratory Data screens.  

• Flow Charts (required for lab data) - Decide which label notes from the Laboratory Data, Vital 
Signs, Health Maintenance, and Medications sections will display on patient flow charts. You can 
create as many patient flow charts as you like. Each flow chart can have up to 50 items, and you 
can graph up to 4 items at once.  

• Health Maintenance (required) - Define health maintenance schedules for all your patients by 
sex and age group, problem, Rx, or protocol. The procedures you establish on the templates 
appear on the health maintenance chart for each patient in the corresponding group.  

• Prescriptions - Define prescription templates. These include all necessary information for 
frequently prescribed medications. You can define provider-specific templates or universal 
prescription templates for the entire practice.  

• Formularies - Create lists of medication templates that insurance carriers have approved, or that 
are specialty specific.  

• Images - Create an image library for drawing. The file types supported by Patient Records are 
listed on the Import Image screen, which is available when you add a new image.  

• Medical History (family, social, past medical) - Define how information will be displayed on the 
Family History, Social History, and Past Medical History sections of the Patient Chart. For 
example, you can design a format that includes patient habits, such as smoking or drinking.  

• Notes - You can create new templates in Patient Records. These templates are available 
whenever you are working in a text-based Patient Chart section.  

• Letters – Create letter templates that include macros for inserting patient-specific data when you 
write letters about patients. You can also create page templates to format how you want to the 
letters to look when they are printed.  

Tips on setting up templates 
Carefully consider how you want to define your templates before you begin entering patient 
information in Patient Records. For example, you may want to structure the Patient Records templates 
so that they parallel the paper records system you have been using until now—or you may want to take 
this opportunity to rethink how you could best access patient information and apply your ideas to 
Patient Records.  

The Patient Records system is quite flexible. Feel free to experiment with a set of templates and then 
change them as necessary. However, once you have entered patient data, you need to use the health 
maintenance template conversion utilities. With these utilities, you will be able to make extensive 
changes to your templates when necessary, giving you more flexibility in the design of your own 
record-keeping system.  
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Here are some tips to help you get up and running quickly in Patient Records:  

1. Lytec MD can supply you with suggested health maintenance protocols, if you need them.  

2. You may be able to delay flow chart templates until later.  

3. Prescription templates can be created as you write prescriptions.  
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System configuration: Maintenance menu 

Providers 
You can use the Provider Maintenance screen to indicate a provider’s ID, name, provider groups, Rx 
format file, signature, and Appointment Scheduler defaults.  

Once providers are set up, you can add them to provider groups. Each provider can belong to up to 
four groups. You can use the General tab on the Provider Maintenance screen to assign providers to 
different provider groups. The group ID can be used interchangeably with provider IDs in Appointment 
Scheduler.  

When scheduling appointments, instead of entering a provider ID, or leaving the ID blank to indicate 
all providers, you can enter a group ID and the appointment is made with each provider belonging to 
the group.  

Adding, editing, and deleting providers 
To open the provider maintenance screen: 

• Select Maintenance > Providers. The Providers Maintenance Select screen appears. 

To add a provider: 

• On the Providers Maintenance Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To view a provider: 

• On the Providers Maintenance Select screen, highlight the provider that you want to view. Click 
the View button. When you finish, click the OK button. 

To change a provider: 

• On the Providers Maintenance Select screen, highlight the provider that you want to change. 
Click the Edit button, then make the necessary changes. When you finish, click the OK button. 

To delete a provider: 

• On the Providers Maintenance Select screen, highlight the provider that you want to delete. Click 
the Delete button. A message asks you to confirm the deletion. Click the OK button. 

To print a provider report or labels: 

1. On the Provider Maintenance Select screen, click the Print button. The Provider Maintenance 
screen appears. 

2. Use the criteria fields to filter the providers: 

• Status: Select whether you want to print a list of active providers, inactive providers, or all 
providers. 

• Report Type: Indicate whether you want to print a list or labels. 

• Label Type: If you select Labels in the Report Type field, select the label type. 
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• Order Report By: Select whether you want the report sorted by provider ID, name, ZIP 
Code, or specialty. 

3. Click the OK button. If the Windows Print screen appears, select the printer and click the OK 
button. 

Fields on Provider Maintenance 
Field Description 

General Tab 

ID Code Type the new provider's ID, up to three characters. 
This field can't be changed if the provider has appointments in Appointment 
Scheduler. 

Status Select the provider's status (active or inactive). 

Default Provider If you want this provider to be the default system provider, mark the Default 
Provider check box.  
If you mark this check box, the provider will display on the Lytec MD Sign In 
screen and the Provider/Practice Selection screen for operators who do not 
have a default provider.  

Last Name Type the provider's last name. 

First Name Type the provider's first name. 

MI Type the provider's middle initial. 

SSN Type the provider's Social Security Number. 

NPI Type the provider's NPI (National Provider Identifier). 

Note: If you are using RxHub you must enter the provider's NPI. Contact your 
Lytec MD sales representative for more information about RxHub.  

Suffix Type the provider's suffix (M.D., etc.). 

Greeting Type a greeting for the provider. 

Title Type a title for the provider. 

Provider Groups Providers can belong to 10 provider groups. 
If this provider belongs to a provider group, you can either: 

 Select the provider group from the drop-down list. 

 Add a new provider group by typing the group ID in an empty field. A 
message will ask you to verify that you want to create the new group. 
Click the Yes button, then enter a description of the new group. 
 
You can then view or edit the group by clicking the Groups button on 
the Provider Maintenance Select screen. 
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Address Type the provider's street address.  

Note: You can use three lines for the street or post office box part of the mailing 
address. 

City Type the provider's city.  

Note: If you have configured address defaults for the city, skip to the ZIP Code 
field and type the ZIP Code first. Then the city will default in this field. 

County If you have the county feature turned on, type the provider's county. This feature 
is added through the Demographic Settings screen. 
If you do not have the county feature turned on, this field will not appear on 
screen. 

Note: If you have configured address defaults for the county, skip to the ZIP 
Code field and type the ZIP Code first. Then the county will default in this field. 

State Select the provider's state. 

Note: If you have configured address defaults for the state, skip to the ZIP Code 
field and type the ZIP Code first. Then the state will default in this field. 

ZIP/Postal Code Type the provider's ZIP Code (postal code). 

Home Type the provider's home phone number.  
If you want to add a note for this number (for example, "Do not call after 8 

p.m."), click the  button. The Phone Note screen appears.  

If you have the phone dialer configured for your workstation, click the  
button to dial the number.  

Work Type the provider's work phone number.  

If you want to add a note for this number, click the  button. The Phone Note 
screen appears.  

If you have the phone dialer configured for your workstation, click the  
button to dial the number.  

Cell Type the provider's cell phone number.  

If you want to add a note for this number, click the  button. The Phone Note 
screen appears.  

If you have the phone dialer configured for your workstation, click the  
button to dial the number.  

Pager Type the provider's pager number.  

If you want to add a note for this number, click the  button. The Phone Note 
screen appears.  

If you have the phone dialer configured for your workstation, click the  
button to dial the number.  
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Fax Type the provider's fax number. 

Email Type the provider's e-mail address.  

Click the  button to send a message to this patient through your default e-
mail editor (such as Microsoft Outlook). 

Records tab (for sites with Patient Records) 

Rx Format File Type the path and name of the prescription format file to use when printing the 
provider's prescriptions, or click the Browse button and navigate to the relevant 
.cfg file. 
Leave this field blank to use the default prescription format file specified in the 
Prescription Defaults screen. 

Rx Format File for 
Faxing 

Type the path and name of the prescription format file to use when faxing the 
provider's prescriptions, or click the Browse button and navigate to the relevant 
.cfg file. 
Leave this field blank to use the default prescription format file for faxing 
specified in the Prescription Defaults screen. 

Operator ID for 
Lab Messages 

Select the operator ID for automatic messages which get sent when a lab result 
in the "critical range" is entered and directed to the Provider. This field is 
required. 

Processing 
Operator for 
Orders 

Click the arrow to select from Operator Select. 

Provider 
Signature 

This feature is available only if you have been assigned the Signatures access 
level. 
If your practice requires providers to electronically sign their notes, type the 
electronic signature for the provider. When a provider has an assigned 
electronic signature, Lytec MD will ask for the signature when the provider saves 
a note. 
Provider signatures cannot use the same digit more than two times (for example, 
1234 and 12234 are valid, but 122234 is not). 
Your system administrator can use a ppart.ini setting to indicate whether 
signatures should be six characters or nine characters.  
If PRUtils has been configured to allow users to set their own passwords, this 
field will be disabled. 

Previous Provider 
Signatures 

This feature is available only if you have been assigned the Signatures access 
level. 
This box displays electronic signatures previously assigned to the provider. 
Whenever you change the provider signature, this box provides an audit trail of 
the changes. Signatures must be unique, and must not have been previously 
used by the provider. 
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Signature Image 
for Faxing 

Enter the name of the signature image that you want to include on faxed 
prescriptions. The file must be saved in the client folder (typically this is the 
\prwin folder) and must be a .bmp, .jpg, or .gif file.  
You can use the %prov_signature variable in the prescription format file to 
specify the position of the signature. 

Rx Header Enter the name of the provider-specific header to include on printed or faxed 
prescriptions. The file must be saved in the client folder (typically this is the 
\prwin folder) and must be a .bmp, .jpg, or .gif file. 
You can use the %prov_header variable in the prescription format file to specify 
the position of the signature. 

Rx Fax Cover Enter the name of the cover page that will be sent with faxed prescriptions for 
this provider. This should be the name of a cover page set up on your Windows 
2003 fax server or Zetafax server.  

Note: If you do not specify fax cover pages for the provider in this screen, the 
default cover pages specified in the ppfax.ini file will be used.  
 
For more information on the steps required to integrate Lytec MD with a 
Windows 2003 fax server or Zetafax server, see Setting Up Your Fax Server. 

Letter Fax Cover Enter the name of the cover page that will be sent with faxed letters for this 
provider. This should be the name of a cover page set up on your Windows 
2003 fax server or Zetafax server. 

Chart Fax Cover Enter the name of the cover page that will be sent with notes or faxed partial or 
complete chart reports for this provider. This should be the name of a cover 
page set up on your Windows 2003 fax server or Zetafax server. 

Scheduler tab (for sites with Appointment Scheduler) 

Type of Visit If you have Appointment Scheduler, and you want to set a default type of visit 
for the provider, select the appropriate TOV code. 

Appointment 
Length 

If you have Appointment Scheduler, and you want to set a default appointment 
length for the provider, select the length (in minutes). 

On Call Note If you are using Appointment Scheduler's on call feature, you can use this text 
box to type a note that will display on the on call schedule when this provider is 
scheduled. 
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Process-specific 
time limits 

You can use this section of the screen to set up time tolerance alerts for 
appointment processes for a specific provider. You can also set up time 
tolerance alerts for practices and for your organization. See the Process-
Specific Time Limits topic in Appointment Scheduler help for a complete 
explanation of process-specific time limits.  

To add a process-specific time limit: 

 Click the New button. The Time Tolerance screen appears. Select a 
process code and a time tolerance from the drop-down lists. When you 
are finished, click the OK button.  

To change a process-specific time limit: 

 Highlight the process that you want to change in the list. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK 
button. 

To delete a process-specific time limit: 

 Highlight the process that you want to delete. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 

 

Other Data tab 

User-defined 
fields 

On the Other Data tab, you can enter data in user-defined fields. Your system 
administrator can customize these user-defined fields to meet the specific needs 
of your organization. Your access level determines whether you can use the 
Other Data tab.  

General 2 tab 

Specialties Select up to six (6) provider specialty codes. Reports based on providers group 
the providers by these codes. 

Encounter Forms  

Paper If you want to specify a paper encounter form for this provider, select the form's 
code.  

Electronic If you want to specify an electronic encounter form (EEF) for this provider, select 
the form's code.  

Practice If an electronic encounter form is created from a progress note, and the note 
does not have a practice associated with it, the practice you specify here will be 
used for the EEF. 

Supervising 
Provider 

Select the provider's supervising provider. This field is informational only. 

Type Select the provider type, as defined in the ppart.ini (for example, intern or 
resident). 
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Date Provider 
Added This field displays the date the provider was first created in Lytec MD. 

Date Provider 
Last Edited 

This field displays the date the provider's information was last changed in Lytec 
MD. 

Credentials tab 

DEA  

DEA 
Number 

Enter the provider's Drug Enforcement Agency (DEA) number. 

Note: If you are using RxHub you must enter the provider's DEA number. 
Contact your Lytec MD sales representative for more information about RxHub.  

First Issued Enter the date the DEA number was first issued. 

Last/Next 
Renewed 

Enter the date the DEA number was last renewed, or the date it needs to be 
renewed. 

State (1) and (2) You can enter license information for two states. 

State Select the state in which the provider is licensed. 

License 
Number Enter the provider's state license number. 

First Issued Enter the date the state license was first issued. 

Last/Next 
Renewed 

Enter the date the state license was last renewed, or the date is needs to be 
renewed. 

UPIN Enter the provider's Unique Provider Identification Number (UPIN) for Medicare. 

Credential Notes Enter any notes related to the provider's credentials. 

Adding, editing, and deleting provider groups 
To open the provider group maintenance screen: 

• Select Maintenance > Providers. On the Providers Maintenance Select screen, click the Groups 
button. The Display/Rearrange Groups of Providers screen appears. 

To add a provider group: 

• Provider groups are created in the Provider Groups field on the provider maintenance screen's 
General tab. When you add or edit a provider, simply type the new ID for the group in the 
Provider Groups field, then tab out of the field. Click Yes when a message asks whether you want 
to create a new group. The new group will display on the Display/Rearrange Groups of Providers 
screen. 
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To view providers in a provider group: 

• On the Display/Rearrange Groups of Providers screen, click the View button. Click the Next 
button until the ID of the provider group that you want to view displays in the Enter Group ID 
field. When you finish, click the OK button. 

To rearrange providers in a provider group: 

1. On the Display/Rearrange Groups of Providers screen, click the View button. Click the Next 
button until the ID of the provider group that you want to change displays in the Enter Group ID 
field.  

2. Click the ID of the first provider that you want to move, then click the Mark button. This highlights 
the provider's ID and name. Click the row where you want to move the provider, then click the 
Move button. When you finish rearranging providers, click the OK button. 

To delete a provider group: 

On the Display/Rearrange Groups of Providers screen, click the Delete button. Click the Next button 
until the ID of the provider group that you want to delete displays in the Enter Group ID field. A 
message asks you to confirm the deletion. Click the OK button.  

Fields on Provider Group Maintenance 
Field Description 

Group ID Type an ID for the new provider group. 

Description Type a description of the new provider group. 

Provider ID/Name table This table displays the providers in the provider group.  

 To add a provider, click the New button. On the 
Assign Provider to Group screen, click the drop-
down button and select a provider from the list. 

 To edit a provider, highlight the provider that 
you want to change. Click the Edit button. 

 To delete a provider, highlight the provider that 
you want to delete from the provider group. 
Click the Delete button. 
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Practices 
If you are using the Lytec MD practice feature (optional in Appointment Scheduler, but not Patient 
Records or Appointment Scheduler Enterprise), you must create an entry for each practice. Practice 
features include restricting users to patient data for particular practices, and accessing Lytec MD 
Appointment Scheduler Enterprise schedules by practice. 

Adding, editing, and deleting practices 
To open the Practice Maintenance screen: 

• Select Maintenance > Practices. The Practice Maintenance screen appears. 

To add a practice: 

• On the Practice Maintenance screen, click the New button. Fill in the fields on this screen, then 
click the OK button. 

To change a practice: 

• On the Practice Maintenance screen, select the practice that you want to change. Click the Edit 
button, then click the Prior and Next buttons to locate the appropriate practice. Make the 
appropriate changes. When you finish, click the OK button. 

To delete a practice: 

• On the Practice Maintenance screen, select the practice that you want to delete. Click the Delete 
button, then click the Prior and Next buttons to locate the appropriate practice. Click the OK 
button. A message asks you to confirm the deletion.  

To print a practice report: 

1. On the Practice Maintenance Select screen, click the Print button. The Practice Maintenance 
screen appears. 

2. Use the criteria fields to filter the practices: 

• Status: Select whether you want to print a list of active practices, inactive practices, or all 
practices. 

• Order Report By: Select whether you want the report sorted by practice ID or name. 

3. Click the OK button. If the Windows Print screen appears, select the printer and click the OK 
button. 

Fields on the Practice Maintenance screen 
Field Description 

Code Enter an ID for the new practice. 

Name Enter a name for the practice. 

Status Select the status (active or inactive) of the practice. 

General 1 tab 

Address Enter the practice's street address, up to two lines. 
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City Enter the practice's city. 

County Enter the practice's county. 

State Enter the practice's two-letter state code (for example, WA for Washington). 

Postal Code Enter the practice's ZIP Code. 

NPI Enter the NPI (National Provider Identifier).  

Work Enter the practice's phone number. 

Fax Enter the practice's fax number. 

Email Enter the practice's e-mail address. 

General 2 tab 

Demographic 
defaults 

You can use this field to set address and demographic defaults for the practice. 
You can use these defaults to automatically enter information about the 
practice. Although the information will automatically display in demographic 
fields, operators can change the information as needed. 

City Enter the default city for the practice. 

County Enter the default county for the practice. 

State Enter the default state for the practice. 

Zip Code Enter the default ZIP Code for the practice. 

Country Enter the default country for the practice. 

Provider Enter the default provider for the practice. 

Account 
Type 

Enter the default account type for the practice. 

Providers Affiliated 
with Practice 

You can identify individual providers with the practice.  
 To add a provider, click the New Prv button. Select the provider, type of 

visit, and length of visit. 
 To change a provider, highlight the provider and click the Edit Prv 

button. 
 To delete a provider from the practice, highlight the provider and click 

the Delete Prv button. 

Records tab (for sites with Patient Records) 

Report Headings You can enter up to four lines that will appear as headings on the chart 
summary, partial chart, and complete chart reports for this practice. To use this 
feature, the Enable Title on chart reports check box on the Special Features 
screen must be marked. 
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Logo You can select a logo image that will display on the chart summary, partial 
chart, and complete chart reports printed for this practice. The logo will also be 
displayed on printed and faxed prescriptions for the practice. To use this 
feature, the Enable Logo on chart reports check box on the Special Features 
screen must be selected. The Scale Logo on chart reports setting can be used 
to automatically print the logo at 200x75 pixels and thus make sure it does not 
take up more than 4 lines at the top. 
To add a practice logo: 

1. Click the Logo button. The Load Logo screen appears.  

2. In the Image Folder field, type the path to the file. You can also click 
the Browse button and navigate to the folder that contains the file. 
Select the Image Type (JPG, Bitmap, or GIF) to view all files of that type 
in the folder. Highlight the appropriate file in the box on the left, a 
thumbnail view will be displayed on the right.  

3. If you want to delete the original file after you close the Load Logo 
screen, select the Delete Original File After Load? check box.  

4. When you finish, click the OK button. You return to the Practice 
Maintenance screen.  

Note: You can use the %prac_logo variable in the prescription format file to 
specify the position of the logo on printed and faxed prescriptions.  

Scheduler tab (for use with Appointment Scheduler) 

Process-specific 
time limits section 

You can use this section to set up time tolerance alerts for appointment 
processes for a specific practice. You can also set up time tolerance alerts for 
providers and for your organization. See the Process-Specific Time Limits 
topic in Appointment Scheduler help for a complete explanation of process-
specific time limits.  

To add a process-specific time limit: 

 Click the New button. The Time Tolerance screen appears. Select a 
process code and a time tolerance from the drop-down lists. When you 
are finished, click the OK button.   

To change a process-specific time limit: 

 Highlight the process that you want to change in the list. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK 
button. 

To delete a process-specific time limit: 

 Highlight the process that you want to delete. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 

User-defined fields On the Other Data tab, you can enter data in user-defined fields. Your system 
administrator can customize these user-defined fields to meet the specific 
needs of your organization. Your access level determines whether you can use 
the Other Data tab.  
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Referring sources 
A referring source is the resource (for example, an external physician, other patient, or emergency 
room) responsible for referring a patient to your practice. Referring sources can be assigned to a 
patient or an appointment. 

Before you can track referring sources, you must first add them to the Lytec MD database. You add a 
new referring source by opening the Referring Source Maintenance screen and entering information 
such as referring source ID and basic demographic information. Normally, you will use the Referring 
Source Maintenance screen only when you first add a referring source or when the referring source’s 
information changes. 

You can also add user-defined fields to the Referring Source Maintenance screen. The fields you add 
appear on the Other Data tab of the Referring Source Maintenance screen. Keep in mind that when you 
delete a user-definable field, you are also deleting all data that has been entered in that field. Once 
deleted, you may not be able to restore the data. 

Lytec MD ships with several referring source types. As the name implies, a referring source type 
indicates the type of resource. Referring source types include physician, emergency room, hospital, 
yellow pages, Web site, osteopath, chiropractor, patient, and other. These types are stored in the 
ppart.ini file, so can add to the list as needed. 

You can add referring source types to the pppart.ini file by adding to the [ReferralTypes] section.  

[ReferralTypes]  
RFTP00=MD, Physician  
RFTP01=ER, Emergency Room  
RFTP02=HOSP, Hospital  
RFTP03=YP, Yellow Pages  
RFTP04=WEB, Web Site  
RFTP05=DO, Osteopath  
RFTP06=CH, Chiropractor  
RFTP07=PAT, Patient  
RFTP08=OTH, Other  

The format includes the following elements:  

• RFTP  

• 2 digit number  

• Equal sign  

• 2 to 4 character ID  

• Comma  

• Space  

• Name of the referring source type  

In the example above, you would add a new referring source type by using the next consecutive 
number and adding a line after RFTP08=OTH, Other. For example:  

RFTP09=MIL, Military  
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Adding, editing, and deleting referring sources 
To open the Referring Source Maintenance screen: 

• Select Maintenance > Referring Source. The Referring Source Maintenance Select screen 
appears. 

To add a referring source: 

• On the Referring Source Maintenance Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a referring source: 

• On the Referring Source Maintenance Select screen, highlight the referring source that you want 
to change. Click the Edit button. Make the appropriate changes. When you finish, click the OK 
button. 

To delete a referring source: 

• On the Referring Source Maintenance Select screen, highlight the referring source that you want 
to delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK 
button. 

To print a referring source list: 

1. On the Referring Source Maintenance Select screen, click the Print button. The Referring 
Source Maintenance screen appears. 

2. Use the criteria fields to filter the referring sources: 

• Status: Indicate whether you want to print only active, only inactive, or both active and 
inactive referring sources. 

• Report Type: Indicate whether you want to print a list or labels. 

• Label Type: If you select Labels in the Report Type field, select the label type. 

• Order Report By: Select whether you want the report sorted by referring source ID, name, 
ZIP Code, or specialty. 

3. Click the OK button. If the Windows Print screen appears, select the printer and click the OK 
button. 

Fields on the Referring Source Maintenance screen 
Field Description 

Demographics tab 

ID Type a referring source ID code. Initials or abbreviations are 
easiest to remember (such as ERNW for Northwest Emergency 
Room), but you can enter any combination of numbers or letters. 

Type Select the referring source's type. 

Last Name/Entity If the referring source is a person, type the person’s last name. 
If the referring source is an organization, type the organization’s 
complete name.  
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First Name Type the referring source's first name. 

MI Type the referring source's middle initial. 

Suffix Type the referring source's suffix (for example, MD. or Jr.). 

Greeting Type a salutation (greeting) for use in correspondence to the 
referring source (for example, “Dear Dr. Smith”). You can include 
this phrase in mail merge files, form letters, and form cards. 

Address Type the referring source's address. 
You can use three lines for the street or post office box part of 
the mailing address. 

City Type the referring source's city. 
Note: If you have configured address defaults for the city, skip to 
the ZIP Code (Postal Code) field and type the ZIP Code first. Then 
the city will default in this field. 

County If you have the county feature turned on, type the referring 
source’s county. This feature is added through the Demographic 
Settings screen. 
If you do not have the county feature turned on, this field will not 
appear onscreen. 
Note If you have configured address defaults for the county, skip 
to the ZIP Code (Postal Code) field and type the ZIP Code first. 
Then the county will default in this field. 

State Type the referring source's state. 
Note: If you have configured address defaults for the state, skip 
to the ZIP Code (Postal Code) field and type the ZIP Code first. 
Then the state will default in this field. 

ZIP Code Type the referring source's ZIP Code. 

Country If you have the country feature turned on, select the referring 
source’s country from the drop-down list. The feature is added 
through the Special Features screen. 
If you do not have the country feature turned on, this field will not 
appear on screen. 

NPI Type the NPI (National Provider Identifier).  

Home Type the referring source's home phone number. 

Work Type the referring source's work phone number and extension. 

Cell  Type the referring source's cell phone number. 

Pager Type the referring source's pager number. 

Fax Type the referring source's fax number. 

E-mail Type the referring source's e-mail address. 

Specialties If this referring source is a health care provider, select up to ten 
(10) provider specialty codes from the drop-down list. Reports 
based on referring sources group referring providers by these 
codes. 

Notes In the text box (near the bottom of the Demographics tab), type 
any notes about the referring source. 

Other Data tab 
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User-defined fields On the Other Data tab, you can enter data in user-defined fields. 
Your system administrator can customize these user-defined 
fields to meet the specific needs of your organization. Your 
access level determines whether you can use the Other Data tab. 

Configuration tab 

Allow Webview Access If you have Web View and you want to allow the referring source 
to use Web View, select this check box. 
When selected, the Login name and Password fields are 
displayed. Enter the referring source's login name in the Login 
name field, and a password in the Password field. 
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TablesQuickText 
You can use QuickText to add commonly-used words, phrases, comments, sentences, and even 
paragraphs of up to 1000 characters of previously defined text. You assign each text fragment an easy-
to-remember sequence of keystrokes.  

You can also use QuickText to insert standard Dot codes and letter codes needed by Patient Records. 
You can store QuickText for a specific provider or practice (depending on the Allow QuickText and 
Templates by Practice setting on the Special Features screen), or "universally" for all 
providers/practices. 

To improve QuickText performance, Patient Records always keeps the QuickText screen available in 
the background, and does not reread the QuickText table. When you add QuickText, Patient Records 
automatically refreshes the QuickText screen. At some sites, this may cause performance issues. You 
can turn off the automatic refresh feature by changing a setting in the ppart.ini file. If you turn off this 
feature, you will not see new QuickText that has been added until you exit the program and log back in. 
Please note a maximum of 32,767 QuickTexts can be displayed on the QuickText Maintenance screen.  

Adding, editing, and deleting QuickText 
To open the QuickText Maintenance screen: 

• Select Maintenance > Tables > QuickText. The QuickText Maintenance screen appears. 

To manually refresh the QuickText list: 

• On the QuickText Maintenance screen, click the Refresh button. New QuickText that has been 
added since you logged in will display in the list. 

To add QuickText "from scratch": 

Note: QuickText names cannot begin with "age", "sex", or "date". These terms are reserved for use by 
Lytec MD. For example, do not add a QuickText item called Ageism. 

• On the QuickText Maintenance screen, click the New button. Fill in the fields on this screen, 
then click the Save button. 
 
You can also create QuickText from a note or other text editor in Patient Records. From the 
note, copy the text to the Windows clipboard (highlight the text, then select Edit > Copy or 
press CTRL+C). Then select Insert > QuickText or click the QText button on the tool bar. On 
the Insert QuickText screen, click the New button. The New QuickText screen displays the 
text you copied. Simply add a name, and indicate whether the QuickText is provider-
specific (by entering a provider ID in the Provider field) or available to all providers (by 
leaving the Provider field blank). 

To add QuickText by copying an existing QuickText item: 

• On the QuickText Maintenance screen, highlight the QuickText that you want to copy. Click the 
Edit button. On the Edit QuickText screen, make the appropriate changes, then click the Save As 
button. Type a name for the new QuickText, and click the Save button. 

To change QuickText: 

• On the QuickText Maintenance screen, highlight the QuickText that you want to change. Click 
the Edit button. Make the appropriate changes. When you finish, click the Save button. 
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To rename QuickText: 

• On the QuickText Maintenance screen, highlight the QuickText that you want to rename. Click 
the Edit button and type the new name. When you finish, click the OK button. 

To delete QuickText: 

• On the QuickText Maintenance screen, highlight the QuickText that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields and buttons on the QuickText Maintenance screen 
Field Description 

Provider/Practice A ppart.ini setting (QuickTextByPractice defines which field is 
available. 
If you want the QuickText to be available only to a specific 
provider or practice, type the provider or practice ID in this 
field. 
To make the QuickText available to all providers/practices, 
leave this field blank. 

QuickText name Type a name for the QuickText. 
Note: QuickText names cannot begin with "age", "sex", or 
"date". These terms are reserved for use by Lytec MD. For 
example, do not add a QuickText item called Ageism. 

Text box Type the QuickText. If you copied the text from a note or other 
text editor, the text displays automatically. 

Label button To insert a label in the text box at the cursor, click this button. 

EM Code button To insert an E&M code in the text box at the cursor, click this 
button. Then select the appropriate E&M code. 
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Diagnosis/problem codes  
You can manually enter diagnosis/problem codes or use the pre-loaded list provided.  

In addition, you can link procedures to diagnosis codes. Several Dot codes include an optional relative 
number field. These codes include .MP, .MP2, .OP, .OP2, .DX, .DX2, .PR5, .PR6, .PR9, and .PR1. 

Adding, editing, and deleting diagnosis codes 
To open the diagnosis code maintenance screen: 

• Select Maintenance > Tables > Diagnosis Codes. The Diagnosis Codes screen appears. 

To add a diagnosis code: 

• On the Diagnosis Codes screen, click the New button. Fill in the fields on this screen, then click 
the OK button. 

To change a diagnosis code: 

• On the Diagnosis Codes screen, highlight the diagnosis code that you want to change. Click the 
Edit button, then make the necessary changes. When you finish, click the OK button. 

To delete a diagnosis code: 

• On the Diagnosis Codes screen, highlight the diagnosis code that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

To print a diagnosis codes report: 

1. On the Diagnosis Codes screen, click the Print button. The Diagnosis Code Maintenance Print 
screen appears. 

2. Use the criteria fields to filter the diagnosis codes: 

• Order Report By: Indicate whether the diagnosis codes should be sorted by Standard 
Code, Office Code, Long Description, or Short Description. 

• Status: Select whether you want to print a list of active codes, inactive codes, or all codes. 

3. Click the OK button. If the Windows Print screen appears, select the printer and click the OK 
button. 

Fields on the Diagnosis Code Maintenance screen 
Field Description 

General tab 

Office Code Type the code used in your office for the diagnosis or 
problem. This is the code that displays in the list when users 
need to select a diagnosis code (for example, when adding a 
diagnosis code to a note through the Insert menu). 
If it helps you remember the code, type an abbreviation or 
mnemonic instead of the standard code.  
For example, you can enter HA as the code for Headache. 
When you post a diagnosis, enter HA. 
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If you prefer, you can enter the actual diagnosis code in both 
the Office Code and Standard Code fields. 

Standard Code Type the code used by most insurance carriers for this 
diagnosis.  
If most of your carriers use ICD-9 codes, enter the appropriate 
ICD-9 code. 
If some carriers use a different code, enter that code on the 
translation for diagnosis code screen for those carriers. 
If left blank, the standard code is replaced by the office code 
when you click the OK button. 

Status Select a status for the diagnosis code. 

Short Description Type a short description of the diagnosis code. This 
description displays on screens from which you select a 
diagnosis code. You can insert this description into your notes. 

Long Description Type a full description of the diagnosis code. You can insert 
this description into your notes.  

Alternative Lookups To look up the diagnosis using different mnemonics than the 
office code, enter the alternative wordings. These can be 
longer than the office code. They can also be used to group 
similar diagnosis  codes. 

Start Use/Stop Use If you want the diagnosis code to only be available for 
selection during a specific period of time, select start and end 
dates from the Start Use and Stop Use fields. 
Leave these fields blank if you want the diagnosis code to 
always be available. 

Note: Operators will be prevented from using the diagnosis 
code if the date is outside the range of dates defined by these 
fields. 

Automatically Linking Procedure Codes and Diagnosis 
Codes  
Note: This feature requires the use of a custom billing interface.    

You can link diagnosis codes to procedures when you are writing progress notes. This linking feature 
provides quicker and more accurate billing, because the linked diagnosis codes and procedures can 
be used for encounter forms imported into a third-party billing system through an interface.  

You can also manually add diagnosis codes to procedure codes.  

When you write a progress note, you can add relative numbers to the .MP, .MP2, .OP, .OP2, .DX, and 
.DX2 dot codes. The numbers are relative, because they apply only in the current note. You can use 
these relative numbers to link the diagnosis codes to four new procedure codes: .PR5, .PR6, .PR9, and 
.PR10.  

The format for the new procedure codes is as follows:  

.PR5: procedure name : proc. code1 : rel. dx/prob # : rel. dx/prob code # : rel. dx/prob code # : rel. 
dx/prob code #  

.PR6: procedure name : proc. code1 : modifier 1 : modifier 2 : rel. dx/prob # : rel. dx/prob code # : rel. 
dx/prob code # : rel. dx/prob code #  
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.PR9: procedure name : date : note : proc. code1 : rel. dx/prob # : rel. dx/prob code # : rel. dx/prob 
code # : rel. dx/prob code #  

.PR10: procedure name : date : note : proc. code1 : modifier1 : modifier2 : rel. dx/prob # : rel. dx/prob 
code # : rel. dx/prob code # : rel. dx/prob code #  

Let’s say that you use these dot codes in your note:  

.MP: Diabetes : 290.1 : V23 : 1  

.OP: UTI : 491.2 : : 2  

.MP2: Hypertension : 05/01/02 : started when CRF began : 345.2 : 3  

The numbers in bold are the relative numbers. For each of the dot codes listed above, you can add one 
relative number. You can add the number manually, or you can add a setting to the ppart.ini file so that 
Patient Records will automatically insert the number. Patient Records will number the dot codes in the 
order they are listed in your note (as in the example above).  

Once you add the relative numbers, you can link them to the procedure codes (remember, only the 
new .PR5, .PR6, .PR9, and .PR10 procedure codes support relative numbers). You can add up to four 
relative numbers to each of these procedure codes. Let’s look at an example, using the diagnosis 
codes listed above:  

.PR6: Office Visit Level 1 : 99121 : 10 : 12 : 3 : 1  

.PR10: Office Visit Level 1 : 05/01/01 : took a long time : 99121 : 10 : 15 : 1 : 3 : 2  

.MP and .MP2 are linked in this note to .PR6.  

.MP, .OP, and .MP2 are linked in this note to .PR10.  

To make this feature easier to use, you should change this setting in the ppart.ini file: 
InsertRelativeDxNumber=ON in the [Diagnosis_Procedure_Codes] section. With this setting, when you 
use the Insert Problem/Diagnosis Code screen (accessed from the toolbar or menu), either a label or 
the relative number will be inserted. To have Patient Records automatically insert the relative number, 
make this change in the ppart.ini file: AutoNumberRelativeNumber=ON in the 
[Diagnosis_Procedure_Codes] section.  

To make inserting the proper procedure code line easier from the Insert Procedure Code screen, select 
the procedure code line type that most closely meets your practice’s requirements, and then make this 
change in the ppart.ini file: PRCodetoInsert=### in the [Diagnosis_Procedure_Codes] section. ### is 
the new procedure code (.PR3 to .PR10) that you want to automatically insert in the note.  

To set the relative linking options:  

Note: Before you open the ppart.ini file, make a backup copy. For example, save the backup copy as 
ppart.bak.  

1. Use Windows Notepad or another text editor to edit ppart.ini in your Lytec MD database 
directory.  

2. Locate the [Diagnosis_Procedure_Codes] section.  

3. Make the appropriate changes.  

Ppart.ini setting Description 

InsertRelativeDxNumber=ON  When you use the Insert Problem/Diagnosis Code screen 
to add a problem or diagnosis code to a note, Patient 
Records will either:  

 Insert a label for the relative number, if 
AutoNumberRelativeNumber=OFF.  

 Insert the relative number based on how many .MP, 
.OP, .DX, MP2, .OP2, and .DX2 lines precede the 
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insertion, if AutoNumberRelativeNumber=ON.  

AutoNumberRelativeNumber=ON  If InsertRelativeDxNumber=ON, Patient Records will insert 
the relative number based on how many .MP, .OP, .DX, 
MP2, .OP2, and .DX2 lines precede the insertion. For 
example, if you insert two .MP lines and one .DX line (in 
that order), the first .MP line will have a relative number of 
1, the second .MP line will have a relative number of 2, and 
the .DX line will have a relative number of 3.  

PRCodetoInsert=###  Replace “###” with the new procedure code (.PR3 to .PR10) 
that you want to automatically insert when you use the 
Insert Procedure Code screen (accessed from the tool bar 
or menu).  

4. When you finish, save and close the file.  

Manually Linking Diagnosis Codes and Procedure Codes  
In addition to automatically linking diagnosis codes and procedure codes, you can manually add 
diagnosis codes to four new procedure codes: .PR3, .PR4, .PR7, and .PR8.  

The format for the new procedure codes is as follows:  

.PR3: procedure name : proc. code1 : dx/prob code 1 : dx/prob code 2 : dx/prob code 3 : dx/prob 
code 4  

.PR4: procedure name : proc. code1 : modifier1 : modifier2 : dx/prob code 1 : dx/prob code 2 : 
dx/prob code 3 : dx/prob code 4  

.PR7: procedure name : date : note : proc. code1 : dx/prob code 1 : dx/prob code 2 : dx/prob code 3 : 
dx/prob code 4  

.PR8: procedure name : date : note : proc. code1 : modifier1 : modifier2 : dx/prob code 1 : dx/prob 
code 2 : dx/prob code 3 : dx/prob code 4  

To manually add the diagnosis codes, simply replace dx/prob code with the diagnosis code. Some 
examples are listed below:  

.PR3: Office Visit Level 1 : 99121 : 560.3 : 349.3 : 456.1 : 541  

.PR8: Office Visit Level 1 : 05/01/01 : took a long time : 99121 : 10 : 12 : 560.3 : 349.3 : 456.1  
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Procedure codes  
You can manually enter procedure codes or use the pre-loaded list provided.  

In addition, you can link procedures to diagnosis codes using Dot codes in progress notes. Several Dot 
codes include an optional relative number field. These codes include .MP, .MP2, .OP, .OP2, .DX, .DX2, 
.PR5, .PR6, .PR9, and .PR1.  

Adding, editing, and deleting procedure codes 
To open the procedure code maintenance screen: 

• Select Maintenance > Tables > Procedure Codes. The Procedure Codes screen appears. 

To add a procedure code: 

• On the Procedure Codes screen, click the New button. Fill in the fields on this screen, then click 
the OK button. 

To change a procedure code: 

• On the Procedure Codes screen, highlight the procedure code that you want to change. Click 
the Edit button, then make the necessary changes. When you finish, click the OK button. 

To delete a procedure code: 

• On the Procedure Codes screen, highlight the procedure code that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

To print procedure codes: 

1. On the Procedure Codes screen, click the Print button. Select the appropriate print options: 

• Status: Indicate whether you want to print only active procedure codes, only inactive 
procedure codes, or both active and inactive procedure codes. 

• Print Codes with Fees Only: Mark this check box if you want to print only codes with fees. 

• Order Report By: Indicate whether the report data should be sorted by Standard Code, 
Office Code, Long Description, or Short Description. 

2. Click the OK button. If the Windows Print screen displays, select a printer and click the OK (or 
Print) button. 

Fields on the Procedure Code Maintenance screen 
Field Description 

Office Code Enter the code used in your office for the procedure. This is the 
code that displays in the list when users need to select a 
procedure code (for example, when adding a procedure code to 
a note through the Insert menu). 
If it helps you remember the code, enter an abbreviation or 
mnemonic instead of the standard code.  
For example, you could enter OV as the code for Office Visit. 
When inserting the procedure code in a progress note, you 
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would type or select the office code: OV. 
If you prefer, you can enter the actual procedure code in both 
Office Code and Standard Code. 

Standard Code Enter the code used by most insurance carriers for this 
procedure.  
If most of your carriers use CPT® codes, enter the appropriate 
CPT® code. For example, the CPT® code for an initial 
examination may be 99203.  
If this field is left blank, the standard code is replaced by the 
office code when you click the OK button. 

Status Select the procedure code's status (active or inactive). 

General tab 

Short Description Enter a short description (for HCPCS Level I and II codes) of the 
procedure code. This description displays on screens from which 
you select a procedure code. You can insert this description into 
your notes.  
Note: Statement form items will use only the first 30 characters of 
the description. 

Long Description 1, 2, 3 Enter up to 3 full descriptions of the procedure code. You can 
insert this description into your notes.  
Note: Statement form items will use only the first 30 characters of 
the description. 

Start Use Indicate the date that procedure code was or should be first 
used. 

Stop Use Indicate the date the procedure code will or should be last used. 

Alternative Lookup To look up the procedure using different mnemonics than the 
office code, enter the alternative wordings. These can be longer 
than the office code. They can also be used to group similar 
procedure codes. 

Note: "CPT" is a registered trademark of the American Medical Association. 
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Insurance carriers 
Use this to store detailed information about insurance carriers.  

Adding, editing, and deleting insurance carriers 
To open the Insurance Carrier Maintenance screen: 

• Select Maintenance > Tables > Insurance Carriers. The Carrier Maintenance Select screen 
appears. 

To add an insurance carrier: 

• On the Carrier Maintenance Select screen, click the New button. Fill in the fields on this screen, 
then click the OK button. 

To change an insurance carrier: 

• On the Carrier Maintenance Select screen, highlight the insurance carrier that you want to 
change. Click the Edit button. Make the appropriate changes. When you finish, click the OK 
button. 

To delete an insurance carrier: 

• On the Carrier Maintenance Select screen, highlight the insurance carrier that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

To print a list of insurance carriers: 

3. On the Carrier Maintenance Select screen, click the Print button. Select the appropriate 
printing options: 

• Status: Select whether you want to print only active carriers, only inactive carriers, or both 
active and inactive carriers. 

• Print Plan Information: Select this check box if you want to print plan information for the 
carriers that meet the other criteria you select. 

• Report Type: Select whether you want to print a list or labels. 

• Label Type: If you select Labels in the Report Type field, select the appropriate label type. 

• Order Report By: Indicate whether the list or labels should be sorted by carrier ID (code) 
or carrier name. 

• Translations: Click the Translations button to select which types of carrier translations 
should print on the carriers list; selection number 8 will give you all code translations for 
all carriers. Use the Carrier/Plan field to specify just one carrier to be printed, showing the 
selected translation codes for that carrier. 

4. Click the OK button. If the Windows Print screen appears, select the printer and click the OK 
button. 

Fields and buttons on the Insurance Carrier Maintenance 
screen 
Note: The settings on the Billing and Plans tabs do not apply to Lytec MD.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 87 

 

General 1 tab 

Field Description 

Carrier ID Enter an ID code for the insurance carrier. You can enter any 
combination of numbers or letters. Abbreviations may be easiest 
to remember. 

Name Enter the carrier's name. 

Status Indicate whether the carrier is active or inactive. 

General 1 tab 

Report Group Select the report group for the carrier. This is used when you 
print carrier plans by groups. 

Accept Assignment Select Y if you accept assignment for charges billed to this 
carrier. 
Select N if you do not accept assignment. 
Notes: * If you accept assignment on some plans offered by this 
carrier, but not all, select N. When you enter information about 
multiple plans for a carrier on the Plan screen, you can indicate 
plan-by-plan whether you accept assignment. 
 
* Your entry in this field also appears in the Accept Assign field 
on the Plan screen. 

Address Enter the carrier's address.  
You can enter up to three lines for the street or post office box 
part of the mailing address.  

City Enter the carrier's city.  
Note: If you have configured address defaults for the city, skip to 
the ZIP Code field and type the ZIP Code first. Then the city will 
default in this field.  

County If you have the county feature turned on, type the carrier's 
county. This feature is added through the Demographic Settings 
screen.  
If you do not have the county feature turned on, this field will not 
appear on screen.  
Note: If you have configured address defaults for the county, 
skip to the ZIP Code field and type the ZIP Code first. Then the 
county will default in this field 

State Select the carrier's state.   
Note: If you have configured address defaults for the state, skip 
to the ZIP Code field and type the ZIP Code first. Then the state 
will default in this field.  

Postal Code Enter the carrier's ZIP Code (postal code).  

Country If you have the country feature turned on, select the carrier's 
country from the drop-down list. The feature is added through 
the Special Features screen.  
If you do not have the country feature turned on, this field will not 
appear on screen.  
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Bus. Phone Enter the carrier's work phone number and extension.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Fax Enter the carrier's fax number.  

Email Enter the carrier's e-mail address.  

Click the   button to send a message to this carrier through 
your default e-mail editor (such as Microsoft Outlook).  

Button on the General 1 tab 

Open another screen from the General 1 tab by clicking: 

Attachments. Click to open Carrier Attachments Select. Use this to store text, image, or other files 
related to this carrier. The button has bold typeface if there are stored images.  

General 2 tab 

Field Description 

Carrier Contact 1, 2, 3 You can enter information for three contacts at the insurance 
carrier. 

Name Enter the contact's name. 

Work Enter the contact's work phone number and extension.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Pager Enter the contact's pager number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Fax Enter the contact's fax number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Email Enter the contact's e-mail address.  

Click the   button to send a message to this carrier through 
your default e-mail editor (such as Microsoft Outlook).  

Note Enter notes about the contacts. 

Records tab 

Field Description 

Provides Pharmacy Benefits Only Select this check box if the insurance carrier provides pharmacy 
benefits only. 

Note: For more information about assigning pharmacy benefits 
plans to patients, see Pharmacy Benefits Plans. 

Carrier Formulary Complete For sites using the optional insurance formularies feature in 
Patient Records: 
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After you create a formulary for a carrier, select this check box. 
This allows the insurance carrier's formulary to display in the 
Select Rx Template list. The Complete column on the insurance 
carrier maintenance screen will also display "Yes". 

Carrier Formulary ID For sites using the optional insurance formularies feature in 
Patient Records: 
Type the carrier's InfoScan ID in this field.  
If a formulary ID is also set for a plan linked to this carrier, the 
plan's formulary takes precedence over the carrier's formulary. 

Other Data tab 
On the Other Data tab, you can enter data in user-defined fields. Your system administrator can 
customize these user-defined fields to meet the specific needs of your organization. Your access level 
determines whether you can use the Other Data tab. 

Plans tab 
Many carriers provide a choice of insurance plans for their customers.  

• To add a plan, click the New button on the Notes tab. Fill in the fields on the Plan Maintenance 
screen, then click the OK button. 

• To edit a plan, highlight the plan in the table on the Plans tab and click the Edit button. Make the 
appropriate changes, then click the OK button. 

• To delete a plan, highlight the plan in the table on the Plans tab and click the Delete button. A 
message asks you to confirm the deletion. Click the Yes button. 
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Plans for insurance carriers 
Many carriers provide a choice of insurance plans for their customers. You can add plans through the 
Carrier Maintenance screen's Plans tab. 

Adding, editing, and deleting plans 
To access the Plan Maintenance screen: 

• On the Carrier Maintenance screen, click the Plans tab. 

To add a plan: 

• On the Carrier Maintenance screen's Plans tab, click the New Plan button. Fill in the fields on this 
screen, then click the OK button. 

To change a plan: 

• On the Carrier Maintenance screen's Plans tab, highlight the plan that you want to change. Click 
the Edit Plan button. Make the appropriate changes. When you finish, click the OK button. 

To delete a plan: 

• On the Carrier Maintenance screen's Plans tab, highlight the plan that you want to delete. Click 
the Delete Plan button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Plan Maintenance screen 
Note: The settings on the Billing tab do not apply to Lytec MD.  

General 1 tab 

Field Description 

Plan ID Enter an ID code for the plan. You can enter any combination of 
numbers or letters. Abbreviations may be easiest to remember. 

Name Enter the plan's name. 

Status Indicate whether the plan is active or inactive. 

General 1 tab 

Plan Report Group Select the report group for the plan. This is used when you print 
carrier plans by groups. 

Accept Assignment Mark this check box if you accept assignment for charges billed 
to this plan. 

Note: The Accept Assignment field on the Account Insurance 
Plan screen defaults to this entry, if this plan is selected. 

Authorization Required Select one of the following options: 
 Y - authorization is always required 
 N - authorization is never required 

 S - authorization is sometimes required 
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Group Number Enter the group number for the plan. 

Address Enter the plan's address.  
You can enter up to three lines for the street or post office box 
part of the mailing address.  

City Enter the plan's city.  

Note: If you have configured address defaults for the city, skip to 
the ZIP Code field and type the ZIP Code first. Then the city will 
default in this field.  

State Select the plan's state.   
Note: If you have configured address defaults for the state, skip 
to the ZIP Code field and type the ZIP Code first. Then the state 
will default in this field.  

Postal Code Enter the plan's ZIP Code (postal code).  

General 2 tab 

Field Description 

Plan Contact 1, 2, 3 You can enter information for three contacts for the plan. 

Name Enter the contact's name. 

Work Enter the contact's work phone number and extension.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Pager Enter the contact's pager number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Fax Enter the contact's fax number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Email Enter the contact's e-mail address.  

Click the   button to send a message to this plan through 
your default e-mail editor (such as Microsoft Outlook).  

Note Enter notes about the contacts. 

Records tab 

Field Description 

Carrier Formulary Complete For sites using the optional insurance formularies feature in 
Patient Records: 
After you create a formulary for a carrier (used for this specific 
plan), mark this check box. This allows the insurance plan's 
formulary to display in the Select Rx Template list. The 
Complete column on the insurance carrier maintenance screen 
will also display "Yes". 

Carrier Formulary ID For sites using the optional insurance formularies feature in 
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Patient Records:
Type the plan's InfoScan ID in this field.  
If a formulary ID is also set for the plan's carrier, the plan's 
formulary takes precedence over the carrier's formulary. 

Other Data tab 
On the Other Data tab, you can enter data in user-defined carrier fields. Your system administrator can 
customize these user-defined fields to meet the specific needs of your organization. Your access level 
determines whether you can use the Other Data tab. 
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Carrier Attachments 
Use this to attach files to Carrier Maintenance. This file may be in one of the following formats: 

• JPEG (Joint Photographic Experts Group) 

• Bitmap 

• GIF (Graphic Interchange Format) 

• All files  

Note: Attachments must be readable by Internet Explorer or other applications installed on the PC (for 
example, Microsoft Word). 

The following may be done after saving a file:  

• Edit the description of a file. On Carrier Attachments Select, select the file and click Edit. On 
Carrier Attachment Description, type the changes in the box, and click OK.  

• Print or view a full-sized version of the image or document. On Carrier Attachments Select, 
select the file and click View. If you selected an image it will be opened in Carrier Attachment, 
where the image may be printed or viewed at full size. If you selected a document such as a 
Word document, it will be opened as a read-only file, where you can then print the document. 

• Delete a file. On Carrier Attachments Select, select the file and click Delete.  

Adding, changing, and deleting attachments 
To open Carrier Attachments Select: 

• On Carrier Maintenance, click the Attachments button. Carrier Attachments Select displays. 
This lists files that have already been attached to the carrier. Click the file description to view a 
thumbnail of it. You can click on the attachment description to view a thumbnail of the file (if the 
selected attachment is an image file (JPG, Bitmap, or GIF). If the selected attachment is a non-
image file (Word, Excel) the file type (e.g., .XLS) will be displayed in the box on the right. 

To add a carrier attachment: 

1. Click the New button. The Load Carrier Attachment screen appears.  

2. In the Attachment Description field, type a description of the file. This description will display 
on the Carrier Attachments Select screen.  

3. In the Attachment Folder field, type the path to the file. You can also click the Browse button 
and navigate to the folder that contains the file. Select the Attachment Type to view all files of 
that type in the folder. Highlight the appropriate file in the box on the left (if the selected 
attachment is an image file (JPG, Bitmap, or GIF) a thumbnail view will be displayed on the 
right).  

4. If you want to delete the original file after you close the Load Carrier Attachment screen, 
select the “Delete Original File After Load?” check box.  

5. When you finish, click the OK button. You return to the Carrier Attachments Select screen.  

To view a carrier attachment: 

1. On the Carrier Attachments Select screen, highlight the file that you want to view. Click the 
View button. The Carrier Attachment screen appears. If you selected a non-image file, the 
attachment will appear in its native application. For example, if you select a Word document, 
the file will open up in Word.  
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2. To view the file at full size, click the Full Size button on the Carrier Attachment screen. Click 
the Fit Screen button, to return to the file's original size.  

3. Click the Print button to print the file.  

4. When you finish, click the OK button. 

To change the description of a carrier attachment: 

• On the Carrier Attachments Select screen, highlight the attachment that you want to change. 
Click the Edit button and change the attachment's description. When you finish, click the OK 
button. 

To delete a carrier attachment: 

• On the Carrier Attachments Select screen, highlight the attachment that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the Yes button. 

To print image files (JPGs, Bitmaps, or GIFs):  

• On the Carrier Attachments Select screen, highlight the attachment that you want to print. Click 
the Print button.  

Note: To print TIF images, highlight the file on the Carrier Attachment Select screen. Click the View 
button. The TIF image will appear in the Microsoft Office Document Imaging application. Click the Print 
button in the application to print the file.  

To print text files, PDFs, or TIFs: 

• On the Carrier Attachment Select screen, highlight the attachment you want to print. Click the 
View button. The attachment will appear in its native application. Use the Print button in the 
native application to print the attachment.  
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Pharmacies 
Pharmacy Maintenance allows you to store information about pharmacies. Once information for a 
pharmacy has been created, you can associate the pharmacy with a patient using Patient 
Demographics. To use Pharmacy Maintenance, the Pharmacies Access Level must be enabled. 

With the Pharmacy screen, you can: 

• Record pharmacy information, such as, ID, address, telephone and fax number, and pharmacy 
hours. 

• Record electronic prescribing information. Most fields are reserved for future use. 

Procedures for adding, editing, and deleting pharmacies 
To open the Pharmacy Select screen: 

• Select Maintenance > Tables > Pharmacies. The Pharmacy Select screen appears. 

To add a new pharmacy: 

• On the Pharmacy Select screen, click the New button. Fill in the fields on the Pharmacy screen, 
then click the OK button. 

To change a pharmacy: 

• On the Pharmacy Select screen, highlight the pharmacy that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a pharmacy: 

• On the Pharmacy Select screen, highlight the pharmacy that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Pharmacy screen 
Field Description 

Pharmacy ID Type the ID code for the pharmacy. You can enter any 
combination of numbers or letters. Abbreviations may be easiest 
to remember. 

Status Select the pharmacy's status from the drop-down list. Your 
options are Active and Inactive. 

Pharmacy Name Type the pharmacy's name. 

Nickname Type the pharmacy' nickname.  You may enter any text string in 
this field, so that you can easily find the pharmacy record from 
pharmacy select screens. 
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Neighborhood Type the pharmacy's neighborhood, or select a neighborhood 
from the drop-down list. 

Note: The neighborhood field is not automatically populated. 
You must use List Maintenance to set up a list of neighborhoods 
for users to select from the drop-down list. Your administrator 
must then add the PharmacyNeighborhoodListName setting 
under the [Pharmacy] section of the PPart.ini file, and then 
specify the list name you set up for neighborhoods. 

Address Type the pharmacy's address.  
You can enter up to three lines for the street or post office box 
part of the mailing address. 

City  Type the pharmacy's city.  

State Select the pharmacy's state. 

Postal Code Type the pharmacy's ZIP Code (postal code). 

Country Select the pharmacy's country from the drop-down list.  

Fax Type the pharmacy's fax number. Fax numbers must be entered 
in the following format: ###-###-#### 

Email Type the pharmacy's e-mail address. 

Telephone Type the pharmacy's phone number. Phone numbers must be 
entered in the following format: ###-###-#### 

Hours Type the pharmacy's hours. 

Notes Type any other notes about the pharmacy you may have. 

ePrescribing  

NCPDP ID When a pharmacy is loaded into your system using the 
ePrescribing Configuration utility’s Pharmacy Download process, 
this field will be automatically populated with the pharmacy's 
NCPDP ID.  

Source When a pharmacy is loaded into your system using the 
ePrescribing Configuration utility’s Pharmacy Download process, 
this field will be automatically populated with the network the 
pharmacy belongs to (e.g., SureScripts).  

Send Type Select whether you want, by default, to print the pharmacy's 
prescriptions or fax the prescriptions. If you select the fax option, 
the pharmacy must have a fax number. The "Int" option is 
reserved for future use. 
RxH (RxHub) and SS (SureScripts) are automatically assigned to 
pharmacies when pharmacies are added by the ePrescribing 
Configuration Utility download process.   

Note: To send prescriptions via RxHub, the ePrescribing 
interface must be installed and connectivity to the RxHub 
network must be established. Please contact your Lytec MD sales 
representative for more information. 

Location Qualifier This field is reserved for future use. 

Service Level This field is reserved for future use. 

Partner Account This field is reserved for future use. 
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Store Number This field is reserved for future use. 

Alt Ref Number This field is reserved for future use. 

Alt Ref Num Qual This field is reserved for future use. 

Alternate Phone 1 This field is reserved for future use. 

Alternate Phone 2 This field is reserved for future use. 

Alternate Phone 3 This field is reserved for future use. 

Alternate Phone 4 This field is reserved for future use. 

Alternate Phone 5 This field is reserved for future use. 

Mail Order Pharmacy Select this check box if the pharmacy type is Mail Order.  
When a pharmacy is loaded into your system using the 
ePrescribing Configuration utility’s Pharmacy Download process, 
this check box will be automatically checked or left clear 
depending on whether the pharmacy is a mail-order pharmacy. 

Retail Pharmacy Select this check box if the pharmacy type is Retail.  
When a pharmacy is loaded into your system using the 
ePrescribing Configuration utility’s Pharmacy Download process, 
this check box will be automatically checked or left clear 
depending on whether the pharmacy is a retail pharmacy. 
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Facilities 
You can use Facility Maintenance to record information about each location used for patient services. 
Facility names and addresses print on insurance claims. 

Facility Order-Specific Settings 
You can set up the facilities (both in-house and external) that will process and fulfill orders. 

Many insurance carriers require tests to be sent to pre-determined testing facilities. With Order Entry, 
you can link facilities to specific orders by insurance.   

When a facility is linked to an order, it can control which form the order is printed on, whether it is sent 
electronically, to whom it is sent electronically, whether a processing information (Process Info.) dialog 
appears when an order is processed, what labels are printed, and whether a requisition form is printed.  

Many facilities require that orders be sent with specific information, such as the date a specimen was 
acquired or the volume of a sample. You can set up Processing Dialogs to capture this data when an 
operator is processing orders in Lytec MD. To do this, create an Extended Order screen specifying the 
data you want processors to enter, then assign the Extended Order screen to the facility in Facility 
Maintenance. Note that this is different from adding an Extended Order dialog to an Order, which 
prompts the ordering user to enter data when the order is placed. 

Your system administrator can enable the RequireProcessInfo setting in the ppart.ini file to require 
processing information to be filled out before an order is sent. 

Note: Linking the facility to an order does not necessarily mean that the processing information screen 
will display each time the order is added. If the patient's insurance is linked to a facility, that facility 
overrides the facility linked to the order. 

You can use the Cross References screen to add an alias or the facility name for an order. 

See the Order-Specific Settings section for more information.  

Procedures for adding, editing, and deleting facilities 
To open the Facilities Maintenance screen: 

• Select Maintenance > Tables > Facilities. The Facilities Maintenance screen appears.  

When the Include Inactive check box is enabled, the screen will display active and inactive 
codes. Only active codes will be displayed when this option is disabled. 

To add a new facility: 

• On the Facilities Maintenance screen, click the New button. Fill in the fields on the Facility 
Maintenance screen, then click the OK button. 

To change a facility: 

• On the Facilities Maintenance screen, highlight the facility that you want to change. You can 
also select the Facility Code or Name radio button and enter the full or partial name or code in 
the corresponding search field. Click the Search button. The item with the closest matching 
name will be selected. Click the Edit button. Make the appropriate changes. When you finish, 
click the OK button.  
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To delete a facility: 

• On the Facilities Maintenance screen, highlight the facility that you want to delete. You can also 
select the Facility Code or Name radio button and enter the full or partial name or code in the 
corresponding search field. Click the Search button. The item with the closest matching name 
will be selected. Click the Delete button. A message asks you to confirm the deletion. Click the 
OK button. 

To print a facility report: 

Please note the print option is reserved for future use. 

• On the Facilities Maintenance screen, highlight the facility that you want to print the report for. 
Click the Print button.  

Fields on the Facility Maintenance screen 
The Facility Maintenance screen is divided into the following tabs: General, Records, and Other Data.   

General tab  

Field Description 

Facility Code Enter the ID code for the facility. You can enter any combination 
of numbers or letters. Abbreviations may be easiest to 
remember. 
Because you can set up multiple variations for a facility (linking 
different forms to different orders), the name and description 
do not have to be unique. 

Name Enter the facility's name. 

Status Select the facility's status. Your options are Active and Inactive.

Address Enter the facility's address.  
You can enter up to three lines for the street or post office box 
part of the mailing address. 

City  Enter the facility's city. 

Note: If you have configured address defaults for the city, skip 
to the ZIP Code field and type the ZIP Code first. Then the city 
will default in this field.   

County If you have the county feature turned on, type the facility’s 
county. This feature is added through the Demographic 
Settings screen.  
If you do not have the county feature turned on, this field will 
not appear on screen.  

Note: If you have configured address defaults for the county, 
skip to the ZIP Code field and type the ZIP Code first. Then the 
county will default in this field.  
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State Enter the facility's state. 

Note: If you have configured address defaults for the state, skip 
to the ZIP Code field and type the ZIP Code first. Then the state 
will default in this field.  

Zip Code Enter the facility's ZIP code (postal code). 

NPI Enter the NPI (National Provider Identifier).  

Facility Type Select the facility type. 

Facility Type X12 Select the X12/HIPAA facility type.  

Relationship to Practice Select the facility's relationship to your practice. Your options 
are, Internal and External. 

Phone Type the facility’s phone number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Alt Phone Type the facility’s alternate phone number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number. 

Fax Type the facility’s fax number.  

Email Type the facility’s e-mail address.  

Click the   button to send a message to this guarantor 
through your default e-mail editor (such as Microsoft Outlook). 

First Type the contact's first name. 

M.I. Type the contact's middle initial. 

Last Type the contact's last name. 

Phone Type the contact's phone number.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number. 

Fax Type the contact’s fax number.  

Email Type the contact’s e-mail address.  

Click the   button to send a message to this guarantor 
through your default e-mail editor (such as Microsoft Outlook). 

Notes Enter any other notes you may have about the facility. 

Records tab 

Field Description 

Printed Order Form If applicable, select the form that will be printed for the facility 
or order/facility combination.  
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Electronic Order Form This setting applies if you have an outbound orders interface. It 
will determine how orders are transmitted electronically to 
outside entities.  
If applicable, select the electronic address ("form") that will be 
used to transmit orders for the order/facility combination. Each 
interface must have an electronic form name, which you assign 
using the Electronic_Order ppart.ini settings.  
Please consult the Lytec MD Support Department if you have 
questions about how to set this variable. 

Label Form If applicable, select a label that will be printed for the facility or 
order/facility combination. 

Extended Dialog Name If applicable, select an extended order screen that contains the 
information you want processors to enter. 

Requisition Form If applicable, select a requisition form that will be printed for 
the facility or order/facility combination. 

Printer Type If applicable, select a printer type that will be used when an 
order is printed for the facility. 

Order-specific settings  Click this button to open the Order-Specific Facility Settings 
screen. This screen allows you to define order-specific settings 
for orders associated with the selected facility. These settings 
will override the default order settings for the selected order. 
See the Order-Specific Settings section for a complete overview 
of this screen. 

Please note this button is only enabled when you edit a facility.  

Other Data tab 
You can create user-defined facility fields using the Facility Define Other Data screen. Your system 
administrator can customize these user-defined fields to meet the specific needs of your organization. 
Your access level determines whether you can use the Other Data screen.  

Order-Specific Settings 
The Order-Specific Facility Settings screen allows you to define order-specific settings for orders 
associated with the selected facility. These settings will override the default order settings for the 
selected order. From this screen enter the order name (the order name must exist in the Patient 
Records database), and then continue to assign unique settings to the order. 

Note: The Order-specific settings button is only enabled on the Facility Maintenance <Edit> screen.  

Adding, editing, and deleting order-specific settings 
To open the Order-Specific Facility Settings screen: 

• On the Facility Maintenance, Records tab, click the Order-specific settings button. The Order-
Specific Facility Settings screen appears.  

To add order-specific settings: 

• On the Order-Specific Facility Settings screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 
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To change order-specific settings: 

• On the Order-Specific Facility Settings screen, highlight the order that you want to change. 
Click the Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete order-specific settings: 

• On the Order-Specific Facility Settings screen, highlight the order that you want to delete. Click 
the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Order Facility screen 
Field Description 

Facility ID This field displays the selected facility's ID.  
When entering order-specific facility settings, this field is not 
editable. 

Facility Description This field displays the description of the selected facility. When 
entering order-specific facility settings, this field is not editable. 

Order Name Type the name of an order that has special requirements for the 
facility. The order name must exist in the Patient Records 
database. 

Print Form If applicable, select the form that will be printed for the 
order/facility combination. 

Electronic Form This setting applies if you have an outbound orders interface. It 
will determine how orders are transmitted electronically to 
outside entities.  
If applicable, select the electronic address ("form") that will be 
used to transmit orders for the order/facility combination. Each 
interface must have an electronic form name, which you assign 
using the Electronic_Order ppart.ini settings.  
Please consult the Lytec MD Support Department if you have 
questions about how to set this variable. 

Order Label Form If needed, select a label that will be printed for the facility or 
order/facility combination. 

Processing Info If applicable, select an extended order screen that contains the 
information you want processors to enter. 

Requisition Form If applicable, select a requisition form that will be printed for 
the order/facility combination. 

Printer Type If applicable, select a printer type that will be used when an 
order is printed for the facility. 
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Configuration 

Special Features 
You can use the settings on the Special Features screen to control how Lytec MD operates locally. 

To configure how this program operates locally: 

1. Select Maintenance > Configuration > Special Features. The Special Features screen 
appears.  

2. Configure the settings on each of the Special Features screen tabs. 

3. When you are finished, click OK. 

Tabs on the Special Features screen 
The tabs that are available on the Special Features screen depend on which Lytec MD programs have 
been installed: 

• All installations 

• General tab 

• Installations with Patient Records 

• Records 1 tab 

• Records 2 tab 

• Records 3 tab 

• Records 4 tab 

• Records 5 tab 

• Records 6 tab 

• Records 7 tab 

• Records 8 tab 

• Installations with Order Entry 

• Order Entry 1 tab 

• Order Entry 2 tab 

• Order Entry 3 tab 

• Installations with Appointment Scheduler 

• Scheduler 1 Tab 

• Scheduler 2 Tab 

• Scheduler 3 Tab 

• Scheduler 4 Tab 

Special Features: All Installations 
The following tabs on the Special Features screen are available for all installations: 

• General tab 

Note: To open the Special Features screen, select Maintenance > Configuration > Special Features. 
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The General Tab 

Field Description 

Use Medical Billing (DOS) This option does not apply to Lytec MD.  

Default access applies to 
unspecified practices (Patient 
Records only) 

Click to give default-level access level by an operator for patient 
data in all practices. When this option is selected, operators are 
given their default level of access to charts that belong to 
practices for which the operator has no specified access level.  
Clear to remove default-level access level by an operator for 
patient data in all practices. When the default-level access level 
is removed, operators have access to charts only based on the 
practice specific access level given the operator. The operator's 
practice-specific access level applies when accessing data in a 
practice-specific patient chart. If an operator does not have a 
practice specific access level then they will not be able to 
access charts that belong to the unspecified practices. 
Please note if an operator has a default Access Level of "HI" 
then the restrictions above do not apply and the operator may 
open the Patient Chart screen of any patient (though their 
Access Level may still restrict which portions of the Patient 
Chart they may access.) 

Show previous User Name when 
in Park  

Click to display the operator's name on Lytec MD Sign In when 
in park mode. 

Phone Dialer Local Area Code  Type the local area code in this box for the phone dialer. 

Display Country  Click to specify a country on address screens, such as the 
General tab of Patient. Specify the default country by clicking it 
from the list.  
 
To add a country to the list, the system administrator edits 
ppart.ini.  

1. Under [Demographics], locate the following: 
CountryList= 

2. Add the country, without any spaces. For example: 
CountryList=USA,CAN,UK  

Allow quick registration from the 
Lookup screen 

Click to allow quick registration from the Lookup screen. 

Maximize Lytec MD on start up Click to maximize Lytec MD window on start up.   

WebView Installed Click if you have Web View installed. This setting must be 
enabled, if you have Web View installed. When this setting is 
enabled you can send messages to patients, patient groups, 
and external providers via Web View.  

Confirm Park Selection Select this check box to display a confirmation message when 
operators attempt to park a workstation.  

Show disclaimer screen when 
unparking 

Select to display the Disclaimer screen after unparking a 
workstation. 
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Custom message for disclaimer 
screen 

Type your own login or warning text (for example, "The system 
should only be accessed by authorized users.") which will be 
displayed on the Disclaimer screen. The text will be displayed 
in bold at the top of the screen. The maximum length is 2000 
characters.  

Special Features: Patient Records 
The following tabs on the Special Features screen are available for installations with Patient Records: 

• The Records 1 Tab 

• The Records 2 Tab 

• The Records 3 Tab 

• The Records 4 Tab 

• The Records 5 Tab 

• The Records 6 Tab 

• The Records 7 Tab 

• The Records 8 Tab 

Note: To open the Special Features screen, select Maintenance > Configuration > Special Features. 

• The Records 1 Tab 

Field Description 

Encounter Form Interface area These involve the creation of electronic encounter forms. 
Generate Encounter Form with Progress Notes  
Click to create the form for notes saved in Patient Records with 
a .PR: dot code. 

Note: If diagnosis codes or modifiers are specified on the .PR 
line of a progress note, they will be used in the generated 
encounter form instead of the default diagnosis codes and 
modifiers associated with the procedure code. 

Generate Encounter Form with Text Data Loader 
Click to create the form for notes loaded via the Text Data 
Loader. 
Generate Encounter Form with Orders 
Click to create the form when issuing an order. 

Store Messages in Click an area of the patient chart from the list. This specifies the 
storage location of text-based messages sent between Lytec 
MD operators about patients. 

Store EKGs in  Click an area of the patient chart from the list. This specifies the 
storage location of ECGs created with the Brentwood ECG add-
on module or the Welch Allyn ECG add-on module.  

Store Spirometry in Click an area of the patient chart from the list. This specifies the 
storage location of spirometry results created with the 
Brentwood Spirometry add-on module. 

Indicate presence of data on 
Patient Chart Menu  

Click this check box to highlight the patient chart buttons for 
sections containing data for the current patient.  

Skip Dot Codes when printing Click this check box to remove the dot codes while including 
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the associated text when printing notes. 
Some codes are replaced by their meaning. For example, 
"Allergies:" prints instead of ".AL:" when selecting this check 
box. 

Show drug costs in template list  Click to display drug costs on Medications if using the Drug 
Interaction database.  

Store Imported Medical Summary 
Documents in 

Select an area of the patient chart from the list. This specifies 
the storage location of medical summary documents imported 
using the Import Medical Records Summary tool. The imported 
CCR or CCD data will be saved as an HTML file and added to 
the specified section as a PLINK in a note. The default setting is 
Progress Notes. 

Store Imported Medical Summary 
Advance Directives in 

Select an area of the patient chart from the list. This specifies 
the storage location of medical summary advance directives 
imported using the Import Medical Records Summary tool. The 
imported CCR or CCD data will be saved as an HTML file and 
added to the specified section as a PLINK in a note. The default 
setting is Progress Notes. 

Store Imported Medical Summary 
Encounters in 

Select an area of the patient chart from the list. This specifies 
the storage location of medical summary encounters imported 
using the Import Medical Records Summary tool. The imported 
CCR or CCD data will be saved as an HTML file and added to 
the specified section as a PLINK in a note. The default setting is 
Progress Notes.  

Store Imported Medical Summary 
Plans of Care in 

Select an area of the patient chart from the list. This specifies 
the storage location of medical summary plans of care 
imported using the Import Medical Records Summary tool. The 
imported CCR or CCD data will be saved as an HTML file and 
added to the specified section as a PLINK in a note. The default 
setting is Progress Notes. 

Store Imported RelayHealth 
Message in 

Select an area of the patient chart from the list. This specifies 
the storage location of RelayHealth "clinical messages" 
imported into Lytec MD. The imported clinical messages will be 
saved as a note in the specified section. You must choose a 
section of the chart that requires a provider signature, if you do 
not, the provider's RelayHealth messages will not be sent to 
their review bin.  

Note: You may not import messages into the following sections 
of the chart: Past Medical History, Family History, and Social 
History.  

The Records 2 Tab 

Field Description 

Notes Area  

Remove ELINK from note on save  Click to remove ELINK label markers from notes when the note 
is saved. 

Compress blank lines from notes This defines whether Patient Records removes blank lines in 
notes. If clicked, Patient Records deletes empty lines after 
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processing notes (after removing non-expanded labels and 
replacing Dot codes with text).  
Type the number of consecutive empty lines that can be 
present before removal in the box. For example, if typing 2 
allows two consecutive empty lines. When there are three or 
more empty lines, all the empty lines are removed.  

Compress blank lines from letters This defines whether Patient Records removes blank lines in 
letters. If clicked, Patient Records deletes empty lines after 
processing letters (after removing non-expanded labels and 
replacing Dot codes with text).  
Type the number of consecutive empty lines that can be 
present before removal in the box. For example, if typing 2 
allows two consecutive empty lines. When there are three or 
more empty lines, all the empty lines are removed.  

Reformat Subjective Paragraph This is for saving HTML-formatted progress notes. Click this 
check box to remove each hard return starting from the 
beginning of a progress note until a O: or Objective: is reached 
in the note. In addition if two hard returns occur in a row, only 
one will be removed. The effect of this feature is to reformat the 
Subjective part of the progress note into a narrative paragraph. 
For example: 
Original progress note: 

S: This is a 46 year old male who comes in for chest pain. 
Side:  left 
Duration: one hour 
Location: mid left sternal 
ROS is otherwise negative. 
History of previous MI: none 
Smoking: none 
O: 

With Reformat Subjective Paragraph selected, the above 
becomes: 

S: This is a 46 year old male who comes in for chest pain. 
Side:  left.  Duration: one hour. Location: mid left sternal. 
ROS is otherwise negative. History of previous MI: none. 
Smoking: none. O: 

Use Relative Dx Numbering in 
Notes 

Click to number a diagnosis within a patient's note when using 
Insert Problem/Diagnosis Code. See Diagnosis/Problems 
Codes for more information. 

Create Other Problems from Note 
Titles  

Click to automatically populate the Other Problems list with the 
titles of progress notes you add for a patient. Problems are 
displayed on the Other Problems tab of the Problems / 
Procedures screen.  

Create duplicate Other Problems 
from Note Titles if matching Other 
Problem exists 

Click to allow Lytec MD to add the titles of progress notes to the 
patient’s Other Problems list even if there is already an Other 
Problem record with the same name. 

Note: To enable this feature the Create Other Problems from 
Note Titles setting must be enabled.  
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Auto Create Relative Numbers Click to create a relative diagnosis number automatically. See 
Diagnosis/Problems Codes for more information. 

Remove Lab (.L) on note printing Click to remove lab lines from progress notes.  

Show Dot Codes and Label 
Markers when adding or editing 
notes 

Click to display the Dot code instead of its title (description) 
and the Label Marker when adding or editing notes. For 
example, ".D:" instead of "Date:" displays. 

Hide Delete Label Markers when 
adding or editing notes 

Click to hide these label markers. 

Gray unselected Quick Text when 
adding or editing notes and 
messages 

Click to make these unavailable for use. 

Gray out Delete Labeled Lines if 
no text entered 

Click to make label delete (<<DEL>>) markers gray in the lines 
above the selected label (the label in focus). If text is added to a 
grayed label delete marker, the marker will be un-grayed. 

Note: To enable this feature the Gray unselected Quick Text 
when adding or editing notes and messages setting must be 
enabled. 

Allow Quick Text and Templates 
by Practice 

Click to allow QuickText and templates to be configured by 
practice. 
This setting defines whether QuickText and note, letter, and 
message templates may be set up for individual providers or 
practices. That is, is Provider or Practice available on the 
QuickText or template screen. 
If selected, the individual practice to which the QuickText or 
template is available can be specified. An individual provider 
cannot be specified. 
If not selected, the individual provider can be specified. An 
individual practice cannot be specified. 

Use short description for inserting 
medication list 

Click this to use the short description. 

Include Title when inserting 
clinical data 

Click to display the title of the clinical data to be inserted. This is 
available for the following only: 

 Current Medications 

 Major Problems 
 Social History 

 Past Medical History 
 Family History 

Use native application for PLINK Click to display the native application when a PLINK is opened. 
For example, if the PLINK points to a Word file, the link will be 
opened up in Word. 

When appending or editing 
history sections change the date 
line to the current date and time. 

Click to change the date line to the current date and time when 
adding or editing history sections of the patient chart.  

Show Print Range Select Dialog 
when printing notes  

Click to display the Print Range Select screen when printing a 
note-based section of the chart, including progress notes, and 
letters. If this setting is not selected, the Print Range Select 
screen will not be displayed, and the entire note will be printed. 
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Populate Transcription Queue This feature is reserved for future use. 

Spelling Area These options apply to all text-based sections of the patient 
chart, including progress notes, letters, and history notes. They 
also apply to the templates associated with the text-based 
sections, such as note templates and letter templates. 
Select the appropriate check boxes. 

Check spelling when saving note Click to activate spell checking when clicking OK when saving a 
note or note template. 

Ignore spelling of words in caps Click to Ignore words spelled in all capital letters. 

Share user dictionary Click to have all users use the shared user dictionary accessible 
by all workstations. Any new words added by one user to the 
dictionary are available to other users the next time they log on. 
Clear to have each user use the unshared user dictionary 
accessible only by the workstation being used. Any new words 
added to the dictionary are not available to users on other 
workstations. 

The Records 3 Tab 

Field Description 

Auto Save Notes Area Enable Auto Save of Progress Notes 
This setting can be used to recover HTML-based progress notes 
that are open if Lytec MD stops responding or the computer 
fails.  
If selected, open progress notes are saved to temporary files 
(*.sav). The file names start with AutoSave, and include the 
operator ID, date, and time the note was last saved. The 
temporary file is deleted after correctly saving a note to the 
Lytec MD database. 
If not selected, open progress notes are not saved. They are not 
recoverable if the program stops responding or the computer 
fails. 
Auto Save Path 
When Enable Auto Save of Progress Notes is selected, type 
the directory in which to save the temporary note files. The 
directory can be any valid drive and path to which a user has 
access rights, and has creation and deletion rights for files. 
If no path is typed in the box, notes are saved in the Lytec MD 
directory (the default location). 
Auto Save Interval 
When Enable Auto Save of Progress Notes is selected, type 
the interval in seconds for saving open notes to temporary files. 
If no interval is typed in the box, notes are saved every 60 
seconds (the default time). 

Note: You can also save notes manually using the Ctrl+S 
shortcut key. 

Lab Review Area Use Lab Review Templates 
Click to permit the use of lab review templates. When enabled 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 110 

 

you must create special lab review templates to use since your 
normal lab templates will not be used during lab review. 
Default Lab Review Message Template 
Type the name of the default message template to be used in 
lab review. 
Default Lab Review Note Template 
Type the name of the default note template to be used in lab 
review. 
Original Provider must sign lab on forward 
This switch determines what happens to a note after it is 
forwarded to another provider from the lab review bin. 
Select ON to require a signature by the original provider, even 
when the lab data is forwarded. 
Select OFF to remove the forwarded lab data from the review 
bin without being signed. 
Select ASK to ask the user whether the note should be signed. 

Review Tabular Laboratory Data Click to load laboratory data into the lab review queue for a 
specified provider. 

Enable parallel review of lab and 
notes (but not progress notes) 

Click to enable parallel review of lab data and notes. This 
setting determines whether review data items (except for 
progress notes) are sent simultaneously to the review bins for 
every provider listed on the item. 
If selected, the item appears simultaneously in the review bin 
for every provider linked to the item. This allows the providers 
to review the items in parallel. 
If not selected, the item appears in the review bin of only the 
first provider linked to the item. That provider may forward the 
item to another provider, and so on. Only one provider at a 
time can review the item. 

If Laboratory Data restricted, show 
asterisks 

Click to display asterisks instead of displaying a blank value for 
a restricted (confidential) laboratory test when viewing the 
laboratory data table. The asterisks indicate that a test was 
done.  
The test must have an access level of R1, R2, or R3 assigned. 

Original Provider must sign 
progress note on forward 

Click this to require a signature for a forwarded progress note 
by the original provider. 

Original provider must sign non-
progress note documents on 
forward 

Click this to require a signature for a forwarded non-progress 
note document by the original provider. 

Open chart on notes review Click to automatically open a patient's chart when their note is 
selected in the note review bin. 

Open chart on lab review Click to automatically open a patient's chart when their lab is 
selected in the lab review bin. 

Activate lab review for lab in note Click to activate lab review for labs in a note. When enabled, 
labs in a note will be sent to the lab review bin when .L or .L2 
Dot codes are used. Every provider on the .PV line will have the 
lab sent to their review bin.  
If this feature is not selected, and .L or .L2 Dot codes are 
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inserted in to a note, and then the note is signed, the labs for 
the note will also be signed. Please note that providers on the 
.PV line of the note will not receive the labs in their review bin. 
Also, the starting provider will not receive the labs in his or her 
review bin if the note is not signed at the time of creation. 

Activate lab review for lab in 
loaded note 

Click to activate lab review for labs in notes loaded by the Text 
Data Loader. When enabled, labs in a loaded note will be sent 
to the lab review bin when .L or .L2 Dot codes are used.  
If this feature is not selected, notes loaded by the Text Data 
Loader with .L or .L2 Dot codes will not be sent to the lab 
review bin.  

The Records 4 Tab 

Field Description 

Report Logo Area Enable Logo on chart reports 
Click to print a logo image on the partial chart reports and 
complete chart reports. Set up logos on Practice Maintenance. 
Enable Title on chart reports 
Click to print a title header on the partial chart reports and 
complete chart reports. Set up title headers on Practice 
Maintenance. 
Scale Logo on chart reports 
When Enable Logos on Chart Reports is selected, click to 
automatically reduce the logo size to a maximum of 200 pixels 
by 75 pixels to fit better on the report. 
Default Practice for chart reports 
When Enable Logos on Chart Reports is selected, type the 
default practice logo and title to use when no logo or title is 
specified for a practice. 

Messaging Area Refresh Messaging every [box] seconds 
Type the interval in seconds for checking for new messages. 
If no interval is typed in the box, messages are checked for 
every 60 seconds (the default time). 
Autoarchive Inbox Messages over [box] days old. 
If selected, Patient Records automatically archives received 
messages older than a specified number of days.  
Type the maximum number of days before received messages 
are archived.  
Autoarchive Sent Messages over [box] days old. 
If selected, Patient Records automatically archives sent 
messages older than a specified number of days.  
Type the maximum number of days before sent messages are 
archived.  
Show Bcc when creating message. 
Click to allow addressing a blind courtesy copy to recipients. 
Include Original message in reply. 
Click to include the original message when making a reply. 
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Message Delivery Time
Type the time that you want Web View to check for messages, 
and deliver those messages to the recipients' Web View 
inboxes and send them an e-mail notification. 
Note: This setting is only enabled if you have Web View 
installed and the WebView Installed setting on the General 
tab is enabled.  

E&M Coding Area 
Default values for these settings 
are set in the [E&MCoding] 
section of the PPart.ini file. 

Use E&M Coding Assistance 
Select to use evaluation and management (E&M) coding 
assistance. 

Display E&M Labels as default 
Select to display E&M labels in progress notes by default unless 
hidden using the Edit menu during a user session. 

Note: Lytec MD recommends displaying the E&M codes by 
default so that they will be seen and not accidentally deleted 
from progress notes. 

Add E&M Calculation Details to Note 
Specifies whether to add information about how the E&M code 
was calculated to the Progress Note. 

 If selected, a line describing the guideline version used 
to calculate the CPT code is automatically added to the 
progress note. In addition, if the 1997 guideline was 
used, then a second line listing the relevant Physical 
Exam Type from the guideline is also added to the 
progress note. 

 If deselected, no additional information is inserted in 
the progress note. 

E&M Labels color 
Select the color to use for E&M labels in progress notes. 

E&M Guidelines 
Select the version of the CMS documentation guidelines to use 
as the basis for calculating CPT codes, either 1995 guidelines 
only, 1997 guidelines only, or whichever guideline is most 
favorable. 
If you select to use either 1995 guidelines only or 1997 
guidelines only, then labels from the selected guideline only 
will be used when calculating the CPT code to insert in the 
progress note. 
If you select Use whichever guideline is most favorable, then 
two separate CPT codes are calculated using the 1995 and 
1997 guidelines, and the higher code is used. 

Default Visit Type 
Select the default visit type to use when calculating CPT codes, 
either Office or Consultation. Office is the default value for this 
setting. 

Note: Operators can change the visit type for each note in the 
Evaluation and Management Coding Results screen. 
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The Records 5 Tab 

Field Description 

Dashboard Area Note: More frequent automatic refresh rates may adversely 
affect system performance. 

To Do refresh rate 
Type the number of seconds in the box for the automatic 
refresh rate. The user may refresh more frequently manually. 
Lab Review refresh rate 
Type the number of seconds in the box for the automatic 
refresh rate. The user may refresh more frequently. 
Note Review refresh rate 
Type the number of seconds in the box for the automatic 
refresh rate. The user may refresh more frequently. 
Schedule load offset 
The dashboard shows appointments based on the current time 
to reduce the need to scroll. Type the number of minutes in the 
box by which you wish to offset the "current" time. 
Select operator processing by  
This sets the defaults for Order Processing, to be either by 
Operator or Provider. This setting affects the "Nurse" 
Dashboard. 
Open dashboard on logon 
Click to have the Dashboard automatically display when 
logging on. Please note to enable this feature you must also set 
the Dashboard Configuration on Operator Maintenance to 
Provider or Nurse. If the configuration is left blank, the 
Dashboard will not open on logon.  
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Problem List Area The Problem List in Patient Chart contains problems for which 
the patient has sought treatment. These are inserted using the 
.IPR Dot Code.  
Insert Problem 
Click the style for inserting problems in notes: 

 Vertical (default value) 
 Horizontal 

 Vertical with Code 
 Vertical with Code and Notes 

Insert Diagnosis 
Click the style for inserting diagnosis in notes: 

 Vertical (default value) 
 Horizontal 

 Vertical with Code 
 Vertical with Code and Notes 

Insert Other Problems 
Click the style for inserting problems in notes: 

 Vertical (default value) 

 Horizontal 
 Vertical with Code 

 Vertical with Code and Notes 
Insert Procedures 
Click the style for inserting procedures in notes: 

 Vertical  
 Horizontal (default value) 

 Vertical with Code 
 Vertical with Code and Notes 

Filter Procedure Codes 
Type the procedure codes in the box that are not to be inserted 
using the .IPR Dot Code.  
Separate each procedure code with a comma, and without a 
space. For example: 

99201,99202,99203,99204 
Use long description 
Click to use the long description when problem dot codes are 
inserted into a note. 
Make Problem List Names all Caps 
Select this option if you want to convert all problems entered in 
the Problem List to capital letters. For example, if you enter a 
new problem with upper and lower case letters, the problem 
will be converted to all capital letters once saved. Problems in 
lower and upper case letters imported through the Text Data 
Loader, or inserted as a Dot code will also be converted to 
capital letters when this setting is enabled.  
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Insert Problem As Dot Codes These settings control the default settings for the Insert As 
selections on the Insert Problem screen. From this screen you 
can select to insert Major Problems, Other Problems, and 
Diagnoses as a Major Problem or Diagnosis. If you are inserting 
a Diagnosis or Other Problem, you can also choose to insert the 
problem as a Other Problem. When these configurations are set 
the Insert As radio buttons will default to the setting as 
specified here. The default setting is Diagnosis.  

Procedure and Diagnosis Lookup 
Defaults 

Patients Records Procedure 
Click the default method to find a procedure from the list: 

 Office Code 

 Word 
 Short Description 

 Long Description 
 Tree 

Patient Records Diagnosis 
Click the default method to find a diagnosis from the list: 

 Office Code 

 Word 
 Short Description 

 Long Description 
 Tree 

The Records 6 Tab 

Field Description 

Apply Protocol when Problem 
added to list 

Click to automatically assign a template to patients meeting the 
template's criteria when assigning problems on the chart's 
problem list. The problem name must be the same as the 
template name. 

Apply Problem Protocol when 
Progress note saved 

Click to automatically assign a template to patients meeting the 
template's criteria when assigning problems in a note. The 
problem name must be the same as the template name. 

Apply Protocol when Rx added Click to automatically assign a template to patients meeting the 
template's criteria when writing a prescription on the 
Rx/Medications tab. The medication name must be the same 
as the template name. 

Apply Rx Protocol when Progress 
note saved 

Click to automatically assign a template to patients meeting the 
template's criteria when writing a prescription through progress 
notes. The medication name must be the same as the template 
name. 

For overdue HM, status R = N Click to have the status of refused (R) mean the same as not 
applicable. When this feature is enabled, the procedure will 
never be overdue for the patient. If this feature is not enabled, 
the procedure will remain overdue although the patient refused 
it. Read information about health maintenance statuses. 

For overdue HM, status O = X Click to have the status of ordered (O) mean that the procedure 
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was performed. Clear to have the status of O mean that the 
procedure was not performed. Read information about health 
maintenance statuses. 

Show Health Maintenance 
Template Name on summary 
screen 

Click to display the rules that have been set up for the 
corresponding health maintenance procedure. 

Enable Active Health Maintenance 
reminders 

Click to display overdue health maintenance items for a patient 
when opening that patient's chart.  

Track Health Maintenance using 
Date of Registration 

Click to use the date the patient's registration date in Lytec MD 
as the start date for health maintenance tracking. Clear to use 
the patient's birth date for health maintenance tracking. 

Allow use of Provider Specific 
Age/Sex templates 

Click to permit the use provider-specific templates. If selected, 
templates will not be specified by practice. 

Automatically apply Provider 
Specific Age/Sex templates 

Click to apply the provider's template automatically to the 
patients for whom a provider is designated as the "Primary 
Provider" on the Provider tab of the Patient screen. Clear to 
require the provider's templates to be specifically applied to 
the patient. 

Update HM based on Note Titles Select the check box if you want Patient Records to 
automatically set a health maintenance procedure's status to 
Done (X) if the title of a progress note matches the name of the 
procedure. This is the default value for this setting. 
Clear the check box if you do not want the status of health 
maintenance procedures to be updated based on note titles. 

Immunization Report Status 
Default (X, E, N, R, P O) 

Type the default value or values in the box. Separate individual 
values by a comma and without a space. For example: 

X,E 
The following table has the meaning of each available 
procedure code. 

Status Meaning 

X–Done An activity or test was completed on-site. For 
example, this could be a flu shot given during 
an office visit. 

E–Done 
Elsewhere 

An activity or test performed by another 
medical facility or practice. For example, this 
could be a blood sugar test given by a 
hospital lab and reported to the provider. 

N–Not 
Applicable 

An activity or test is not appropriate for this 
patient. This speeds report production by 
eliminating unnecessary record searches. 

R–Refused An activity or test was prescribed for the 
patient, but the patient refused it. 

P–
Postponed 

An activity or test prescribed for the patient, 
but the patient requested it be performed 
later. The date has not been set. 

O–Ordered An activity or text prescribed for the patient 
that has is going to happen in the future. The 
date has been set. 

 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 117 

 

Double Book Color for Provider 
Schedule 

Select the color that you want one of the Provider schedule 
rows highlighted in if there are two appointments at the same 
time for the same provider/practice. 

Schedule load offset The Provider schedule shows appointments based on the 
current time to reduce the need to scroll. Type the number of 
minutes in the box by which you wish to offset the "current" 
time. 

The Records 7 Tab 

Field Description 

When printing Lab as part of 
Chart, print lab in Template order. 

Click to print a lab in template order when the lab is printed as 
part of the chart. 

When printing Lab as part of 
Chart, use Lab's default template. 

Click to use a Lab's default template when the lab is printed as 
part of the chart. 

Include laboratory source 
information when printing Labs 

Click to include information about the laboratory where the test 
was performed when printing the Partial Chart report and 
Complete Chart report. 

Omit Signature Lines from Letters 
when Printing Letters. 

Click to omit signature lines when printing letters. When this 
setting is enabled, printed letters will not include the "Signed 
by," "Cosigned by," and "Revised by" lines.  

Omit Lab Dot Code Lines when 
Printing Letters. 

Click to omit lab Dot code lines when printing letters. When 
enabled, printed letters will not include lines which start with an 
.L Dot code. 

Remove all Dot Code Lines when 
Printing Letters. 

Click to remove all Dot code lines when printing letters.  

If no provider line (.PV:) in Text or 
Lab Loader Note then send to 
Universal Provider's review bin.  

Click to send a text or lab loader note to the Universal 
Provider's review bin when there is no provider line. 

Refresh QuickText after adding a 
new item 

Click to automatically refresh the QuickText Maintenance 
screen after a new QuickText item has been added.  

Lab for Serum Creatinine Click the Lab Name button to select the lab name that will be 
used to represent serum creatinine concentration when the 
formula for calculating Creatinine Clearance is used. The Lab 
Test Names screen appears. Select an item from the table. If 
you do not see the item that you want:  

 Use the scroll arrows to find the item, or  
 Enter the full or partial name in the field above the table 

and click the Search button. The item with the closest 
matching name will be selected. Please note the lab 
test name search is case-sensitive.  

Click the OK button, the lab name will appear in the Lab for 
Serum Creatinine field. The default setting is CREAT. 

Note: Creatinine clearance is an estimate of glomerular 
filtration rate or "GFR". 
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Lab for Measured Creatinine 
Clearance 

Click the Lab Name button to select the lab name that will be 
used to represent measured creatinine clearance when the 
formula for calculating Creatinine Clearance is used. The Lab 
Test Names screen appears. Select an item from the table. If 
you do not see the item that you want:  

 Use the scroll arrows to find the item, or  

 Enter the full or partial name in the field above the table 
and click the Search button. The item with the closest 
matching name will be selected. Please note the lab 
test name search is case-sensitive.  

Click the OK button, the lab name will appear in the Lab for 
Measured Creatinine Clearance field. The default setting is 
CREAT CLEAR. 

Note: Creatinine clearance is an estimate of glomerular 
filtration rate or "GFR". 

The Records 8 Tab 

Field Description 

On-Screen Width for Notes This setting can be used to set the default width of the HTML 
Note Editor window in inches.  
To change the width, type a new number. The default width is 
8.5 inches.  

On-Screen Height for Notes This setting can be used to set the default height of the HTML 
Note Editor window in inches.  
To change the height, type a new number. The default height is 
11 inches. 

Maximum Weight to Display 
Ounces 

This setting controls whether the ounces (oz) component of the 
patient’s weight will be displayed on the Vital Signs screen 
when the Weight field is set to display in English 
measurements. 
When a patient’s weight in pounds is equal to or less than the 
value of this setting, the oz component will be displayed. When 
the patient's weight is greater than this setting, the oz 
component will not be displayed. 
Enter a number of pounds. The default value is 25 pounds. 

Show Provider Suffix in Note 
Signatures 

This setting determines whether provider suffixes are included 
in note signature lines. 
When this check box is selected, the provider's suffix will be 
added to the signature line after their last name, separated by a 
comma. For example: 
<First Name> <Middle Initial> <Last Name>, <Suffix> 
When this check box is cleared, provider suffixes will not be 
included in note signatures. 

Note: If both this and the Show Provider Title in Note 
Signatures setting are enabled, the suffix will appear before the 
title in the signature line. For example: 
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<First Name> <Middle Initial> <Last Name>, <Suffix>, <Title>

Show Provider Title in Note 
Signatures 

This setting determines whether provider titles are included in 
note signature lines. 
When this check box is selected, the provider's title will be 
added to the signature line after their last name, separated by a 
comma. For example: 
<First Name> <Middle Initial> <Last Name>, <Title> 
When this check box is cleared, provider titles will not be 
included in note signatures. 

Note: If both this and the Show Provider Title in Note 
Signatures setting are enabled, the suffix will appear before the 
title in the signature line. For example: 
<First Name> <Middle Initial> <Last Name>, <Suffix>, <Title> 

Show Registration Notes when 
Linking to Chart from a Message 

This setting specifies whether patient registration notes are 
displayed automatically when operators click the Link button 
when viewing a message in the View Message screen. 
Select this check box to display any relevant patient registration 
notes before displaying the patient chart.  
Clear the check box to display the patient chart without first 
displaying registration notes. 
This check box is selected by default. 

Days to look back for height for 
Vitals/Clinical Elements normal 
range checking  

This setting indicates the number of days that Patient Records 
will look back for height data when considering whether to use 
height-based normal ranges for vital signs and clinical 
elements. If you enter “0”, only height data from the same day 
will be used. The default number of days is 30.  Height-based 
ranges can be specified when setting up vital sign names and 
clinical element names from the Ranges screen. 

UpToDate® Integration  

Enable UpToDate Integration Specifies whether integration with the UpToDate online 
reference web site is enabled. 
Select this check box to allow users to search the UpToDate 
web site directly from Patient Records. Your site must have a 
valid UpToDate® subscription and user account for this feature 
to work.  
For more information on configuring and launching UpToDate 
searches, see the Searching UpToDate® from Patient Records 
section. 

URL Specifies the URL used to search the UpToDate online 
reference web site.  

Important: The default URL is set during installation. You must 
verify with UpToDate that this is the correct URL for your 
subscription, and if not, type the correct URL here. 

Integration Level Specifies the level of integration with the UpToDate online 
reference web site. Select one of the following options from the 
list: 

 Level 1: Select this option if you use a site-based 
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license to access UpToDate. This is the default value for 
this setting. 

 Level 2: Select this option if individual operators use 
separate user accounts to access UpToDate. If you 
select Level 2, you must associate Lytec MD operator 
accounts with the relevant UpToDate account 
information. For more information, see the Searching 
UpToDate® from Patient Records section. 

Special Features: Order Entry 
The following tabs on the Special Features screen are available for installations with Order Entry: 

• The Order Entry 1 Tab 

• The Order Entry 2 Tab 

Note: To open the Special Features screen, select Maintenance > Configuration > Special Features. 

The Order Entry 1 Tab 

Field Description 

Check for duplicates, [box] days Click to check for duplicate orders within the number of days 
typed in Days. For example, click the check box and type 3 in 
the Days box to search for duplicate orders within the past 
three days. 
This check is made when an order moves from the Order Tree 
to the Order List on Order. A warning message displays if a 
duplicate or duplicates are found. Since duplicate orders may 
be added, either click OK to add the duplicate order or click 
Cancel to not add the order. 
This checking also works when adding orders through Dot 
codes. It does not work when adding orders through the Text 
Data Loader. 

Don't print orders when sending Click to suppress the automatic printing of an order when 
sending it. 

Default Cancelled Order Form Type the default form to used for cancelled orders. If this is 
blank, the system uses the pre-configured cancellation form, 
Cancelled Orders. 

Default Order Label Type the default label to use for orders. 

Number of ABN copies to print Type the number of medical necessity forms (also known as 
Advance Beneficiary Notice, or ABN) to print if the patient's 
insurance company will not pay for the test. 

Append orders vertically in note Click to display orders vertically in the note. Clear to display 
orders horizontally.  
This applies when entering an order on Order <New>, and a 
copy of the order is added automatically to the patient's 
progress note.  
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Include extended order in note Click to display the order name and extended order 
information in notes. Clear to display only the order name in 
notes.   
This applies when entering an order on Order <New>, and a 
copy of the order is added automatically to the patient's 
progress note.  

Include all urgencies in note Click to display all order urgencies in notes. Clear to not display 
the order urgency in notes.  
This applies when entering an order on Order <New>, and a 
copy of the order is added automatically to the patients 
progress note.  

Include STAT urgency in note Click to display the order urgency in notes only when the 
urgency is STAT. Clear to not limit the order urgency to STAT.  
This applies when entering an order on Order <New>, and a 
copy of the order is added automatically to the patients 
progress note.  

Display Text Data Loader errors Click to display an error message when using the Text Data 
Loader to receive results electronically when finding a matching 
order but one of the following situations exists:  

 The order has already been marked as completed.  

 The order is currently marked as denied, suspended, 
approved, or pending.  

 The order is locked by another user and cannot be 
edited at the moment. 

Clear to not check for duplicates. 

Prompt for orders grouped by 
facility 

Click to prompt a user whether to process all orders for a 
grouped facility when processing one order belonging to the 
group. Orders can be grouped by entering a Group Type when 
adding or editing an Order Name. 
If selected, a message displays when processing one order for a 
grouped facility. If the response to the message is Yes, then 
Grouped Orders displays with orders sharing the same patient 
ID, date, and group type. 

Print cost on ABN form Click to include the order cost when printing an Advance 
Beneficiary Notice (ABN) form.  

Print date on ABN form Click to include the current date when printing an Advance 
Beneficiary Notice (ABN) form.  

New order default insurance to 
blank 

Click to have Insurance on Order be blank by default when 
creating a new order. 
Clear to have the default value for Insurance be the patient's 
primary insurance carrier. 

Warn if no Insurance for new 
orders 

Click to display a warning when creating a new order using 
Order for a patient with insurance, but the insurance carrier has 
not been selected.  
Selecting this is helpful if New order default insurance to 
blank is selected, and electronic encounter forms or outbound 
lab interfaces are used. 
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Ask if ABN was signed? Click to display after printing an Advance Beneficiary Notice 
(ABN) form asking if the patient has signed the ABN.  
This verification may also be added or changed by the user 
when editing an order.  

The Order Entry 2 Tab 

Field Description 

Send Procedures to EEF for 
Pending Orders 

This setting specifies when electronic encounter forms are 
created for orders. 
Select this check box to create EEFs when an order's status is 
set to Pending or Suspended. 
Clear the check box to create EEFs when an order's status is set 
to Sent. 

Special Features: Appointment Scheduler 
The following tabs on the Special Features screen are available for all installations including 
Appointment Scheduler: 

• The Scheduler 1 Tab 

• The Scheduler 2 Tab 

• The Scheduler 3 Tab 

• The Scheduler 4 Tab 

Note: To open the Special Features screen, select Maintenance > Configuration > Special Features. 

• The Scheduler 1 Tab 

Field Description 

Log appointments as 
they are made area 

All appointments may be logged to a file or printer. Click one of the 
following options: 

 Print log. Print a full description of each appointment made or 
changed when confirming it. 

 Log to File. Save a full description of each appointment made or 
changed to a file when confirming it. Type the path of the log file 
in Log file path (for example, f:\PPart). 

 The name of the log file contains the date (mmddyy.apt). For 
example, the log for March 15, 2008, would be 031508.apt.  

 No log. Appointments are not logged by printing or saving to a 
file. 

Print Reminder slip Click to print a reminder slip for the patient when confirming the 
appointment.  
Change the format and wording of the reminder by editing remind.cfg. 
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Chart Requests area Individual chart requests may be printed on a local or remote printer 
when making appointments. Click one of the following options: 

 Print all requests. Print a chart request for all appointments with 
Chart selected on Patient Appointment. 

 Print STAT requests only. Print a chart request for appointments 
with Chart selected on Patient Appointment within the number of 
days defined for STAT (immediate). Type or select the number of 
days for a STAT request in Define STAT as. 

 Do not print. Requests for charts are not printed. 
Each chart request prints one at a time. Change the format and wording 
of the request by editing request.cfg.  
When printing chart request slips, define STAT using Define STAT as. 
Type or select 1 for the same day, 2 for the same or next day, and so 
forth. 

Note: Do not type or select 0 (zero) for Define STAT as. The chart 
request does not print when if 0 (zero) is used. 

X-ray Requests area X-ray requests may be printed on a local or remote printer when making 
appointments. Click one of the following options: 

 Print all requests. Print an x-ray request for all appointments with 
X-Ray selected on Patient Appointment. 

 Print STAT requests only. Print an X-ray request for appointments 
with X-Ray selected on Patient Appointment within the number of 
days defined for STAT (immediate). Type or select the number of 
days for a STAT request in Define STAT as. 

 Do not print. Requests for charts are not printed. 
Each X-ray request prints one at a time. Change the format and wording 
of the request by editing xray.cfg.  
When printing X-ray request slips, define STAT using Define STAT as. 
Type or select 1 for the same day, 2 for the same or next day, and so 
forth. 

Note: Do not type or select 0 (zero) for Define STAT as. The X-ray 
request does not print when if 0 (zero) is used. 

The Scheduler 2 Tab 

Field Description 

Use default provider and date for 
initial Scheduler views 

Click to open Daily Schedule using the default provider and 
the current date. A dialog does not ask for the provider and 
date when opening Schedule. 
Clear to require asking for a provider and date when opening 
Daily Schedule. 

Share changes in provider and 
date among Scheduler views 

Click to keep the same provider and date when switching 
among the Daily tab, the Weekly tab, and the Monthly tab. 
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Appointment Cancellation area Click the a check box or check boxes: 
 Duplicate slot upon cancellation. Create a duplicate 

appointment slot when an appointment is cancelled. 
 Print Cancellation Slip. Print a cancellation slip for a 

cancelled appointment. 
 Create progress note for No Shows and Cancellations. 

With Patient Records installed, click this to have 
Appointment Scheduler automatically create a progress 
note for no shows and cancellations. 

 Create progress note review item for No Shows and 
Cancellations. With Patient Records installed, click this 
to have Appointment Scheduler automatically create a 
progress note that must be reviewed for no shows and 
cancellations. 

Month and Providers In views area PM begins at 
Type or click the starting time for the afternoon appointments. 
The default time to start afternoon appointments is 12:01 P.M. 
(which is technically correct). 
Show % available 
Click to display the percentage of appointments that are still 
available when on the Month tab. 

Multiple Provider Appointments—
Default Intervals area 

Minimum 
Type or select the smallest number of minutes between 
appointments on More Providers when scheduling 
appointments in the order of provider entry. 
Maximum 
Type or select the largest number of minutes between 
appointments on More Providers when scheduling 
appointments in the order of provider entry. 

On call time On Call Start time 
Use this setting to enter the default on-call start time for on-call 
scheduling. The time entered will be used as the default start 
time on the On Call List screen.   
On Call End time 
Use this setting to enter the default on-call end time for on-call 
scheduling. The time entered will be used as the default end 
time on the On Call List screen.  

The Scheduler 3 Tab 

Field Description 

Patient Appointment Dialog Show overdue HM 
Click to display overdue health maintenance items for a patient. 
This happens by clicking HM when it is highlighted in red on 
Patient Appointment.   
Show Account balances 
Show Co-pays  
These options do not apply to Lytec MD. 
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Encounter Form Check-in Default Click one from the list: 
 Paper (Paper Encounter Form) 
 EEF (Electronic Encounter Form) 
 Both (Both paper and an EEF) 

Label Form for Check-in Default Type the default text of the label to be printed at patient check 
in. If the box is blank, no label is printed.  

Default Encounter Form for 
Check-in 

Type the default encounter form to used at patient check in.  

Show Encounter Form List on 
Check-in 

Click to make a list of encounter forms available for selection 
when opening Patient Check-in.  

Always show Case List when Visit 
Counting is on 

Click to display Case List always when the patient has visit 
counting in effect.  
If this is not selected, there are situations when Case List may 
not display when creating an appointment. If this happens, an 
appointment could automatically count towards a visit total. 

Schedule Graphics  Extend TOV Color to entire line 
Click to display type of visit (TOV) color on the entire line for the 
scheduled visit on the Dashboard, Daily, Dual, and Provider 
schedule view screens. 
Time Unit for Length graphical display 
Enter the number of minutes you would like each column in the 
graph to represent on the Daily and Dual schedule view screen. 
For example, if you enter 5, the graph will display columns that 
represent increments of 5 minutes.   

The Scheduler 4 Tab 

Field Description 

Chart Sections to Check for 
Appointment Note Status 

The Appointment Note Status settings allow you to select which 
Patient Chart tabs Appointment Scheduler will look in for notes 
for a particular appointment. This feature is beneficial for sites 
that use Patient Chart tabs rather than Progress Notes to enter 
notes for patient visits.  
Click the Patient Chart tab check boxes to have Appointment 
Scheduler look for notes in the selected section of the patient 
chart.  

Open Note  
 

Select the color that you want the Note Status field to be 
highlighted in when there is an open progress note for the visit. 

Closed Note  Select the color that you want the Note Status field to be 
highlighted in when there is a closed progress note for the visit. 

Signed Note  Select the color that you want the Note Status field to be 
highlighted in when there is a signed progress note for the visit. 

No Note  Select the color that you want the Note Status field to be 
highlighted in when there is no progress note for the visit.  
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Multiple Notes  Select the color that you want the Note Status field to be 
highlighted in when Patient Records cannot definitively 
determine if there is a progress note for the visit because the 
patient has multiple appointments on the same day.  

Time-in-Process Alert Color When you have process specific time limits set up for providers, 
practices, or your organization you can use this setting to 
choose the color that the Time in Process field will be 
highlighted in on the Schedule screen when the specified time 
tolerance has elapsed.  
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Prescription Defaults 
Use Prescription Defaults to view and change defaults for adding prescriptions, and to control how 
the Current Tab on Rx/Medications works.   

• Printing Prescriptions. Set the default printing method, such as whether to print all the 
prescriptions in a group, or print the current prescription immediately, or fax.  

• Prescriptions Defaults. Set how you want to write prescriptions, including whether to use an 
extended sig, whether to translate the sig into laymen’s terms, and whether to include patient 
instructions with a prescription.  

• Drug Interaction Checking. Set whether or not to automatically check a prescription you are 
writing against all medications listed in the Current Medications screen. This feature requires you 
to subscribe to the Drug Interaction Database to check drug interactions.  

• Other Checks. Set disease and dosage checking in the system. 

• Frequency Defaults. Set what terms will be used for frequency when writing prescriptions. See 
Complying with JCAHO's National Patient Safety Goal #2 for 2004 (Communication). 

• Required Rx Fields. Set required fields to enforce generation of a complete prescription.   

Configuring Prescription Defaults 
To open Prescription Defaults: 

• Select Maintenance > Configuration > Prescription Defaults. 

To configure Prescription Defaults: 

• On Prescription Defaults, set the preferences wanted. 

Information and Actions on Prescription Defaults 
There are the following tabs on Prescription Details: 

• The Print Defaults Tab 

• The Rx Defaults Tab 

• The Drug Interactions Tab 

• The Other Checks Tab 

• The Frequency Defaults Tab 

• The Required Rx Fields Tab 

The Print Defaults Tab 

Item Description 

Rx format file Type the path and name of the default prescription format file 
to use when printing prescriptions. 

Note: If you want a specific provider to use a different 
prescription format file, specify the relevant file in the Rx 
Format File field on the Provider Maintenance screen. 

Rx Format File for Faxing Type the path and name of the default prescription format file 
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to use when faxing prescriptions.

Note: If you want a specific provider to use a different 
prescription format file, specify the relevant file in the Rx 
Format File for Faxing field on the Provider Maintenance 
screen. 

Usual print option Select the default print option that applies when writing a 
prescription:  

 Print locally immediately 
 Print remotely immediately 
 Print locally as a group 
 Print locally and fax as a group 
 Fax as a group 
 Print locally and remotely as a group 
 Print remotely as a group 
 Sample given 
 Do not print 
 Was printed 

Rx renew print option Select the default print option that applies when renewing a 
prescription:  

 Print locally immediately 
 Print remotely immediately 
 Print locally as a group 
 Print locally and fax as a group 
 Fax as a group 
 Print locally and remotely as a group 
 Print remotely as a group 
 Sample given 
 Do not print 
 Was printed 

Print note Click to print a prescription note. 

Print medication list Click to print a list of current medications. Common 
abbreviations are translated for the patient. 

Review Rx on screen Click to show the formatted prescription on screen before 
printing. 

Translate sig Click to translate the prescription signature. 

On renewal, print Patient 
instructions 

Click to reprint patient instructions when a prescription is 
renewed. 

The Rx Defaults Tab 

Item Description 

Extended Sig Click to use an extended signature on the prescription. An 
extended signature allows for a more complex signature than 
usual. Up to ten lines may be entered. 
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Use extended sig  Click to print the extended signature for a prescription only. 
The information for Take and Frequency does not print.  
The Extended Sig check box must be selected to use this 
option.  

Patient instruction Click to print patient instructions with the prescription. 

Limit refills Click to warn when renewing a medication outside the 
limitations. 

Allergy Check Click to check for allergies.  
The subscription for the drug interactions and allergies 
database must be current before checking takes place. 

Use updated Frequency drop 
down list 

Click to use the updated Frequency drop-down list. 

Route Type a default route, such as oral, or leave blank. 

Ask if Med effective Click to determine if a discontinued medication should be 
moved to the historical list (for effective drugs) or ineffective list. 

Store templates by Provider Click to allow a provider to create and keep templates. 

Progress Note Click to append prescription additions or changes to the end of 
progress notes or messages recorded as progress notes. 

Indication Required Click to require entering information in Indication. 

Verify Indication  Click to verify validity of the code entered in Indication. 

Select Rx Template List Click to display what types of templates in Select Rx Template: 
 Ins. Formulary. Displays the insurance formulary. 
 Universal. Displays the universal provider templates and 

the provider specific templates in the general 
formulary. 

 Specialty. Displays the provider specialty templates and 
provider specific templates in the general formulary. 

Allow Future Rx's Click to permit changing Date on Prescription to a date in the 
future.  
If the date cannot be changed, the date on all prescriptions is 
the current date, which is the default. 

Require reason for drug 
discontinuation  

Click to require operators to enter a reason for discontinuation 
when they discontinue a prescription. If a reason for 
discontinuation is not entered, and this setting is enabled, the 
operator will receive a message telling them that the field is 
required, and they will be returned to the Confirm 
discontinuation screen. 

Require reason for warning 
override 

Click to require operators to enter a reason for overriding a 
drug interaction warning. If a reason for the override is not 
entered, and this setting is enabled, the operator will receive a 
message telling them to indicate the reason, and they will be 
returned to the Reason for overriding warning screen. 
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Check Food Allergies when 
checking allergies 

Select this check box if you want to check for food allergy 
intolerances when medications are prescribed to a patient. 
Clear the check box to ignore food allergies when medications 
are prescribed. This is the default value of this setting. 

Note: If this check box is selected, and no allergy intolerance 
information is available for the food allergy, operators will 
receive a message warning them that the prescribed 
medication cannot be checked against the food allergy, each 
time a medication is prescribed. 

Number of days back to look for 
formulary data 

This setting indicates the maximum number of days the on-file 
eligibility data for a patient can be for the formulary information 
it references to be displayed to the user in the Formulary 
section on the Prescription screen. The default number of days 
is 7.  

The Drug Interactions Tab 

Item Description 

Drug Interaction Check Click to check for drug interactions. 
The subscription for the drug interactions and allergies 
database must be current before checking takes place. 

Minimum Level of Severity to 
Display (0-3) 

If the Drug Interaction database is installed, specify the 
minimum severity of interaction to display. The levels are: 

 3-Major. The interaction is potentially life-threatening or 
capable of causing permanent damage. 

 2-Moderate. The interaction may cause deterioration of 
the patient's condition. Additional treatment or 
hospitalization may be necessary. 

 1-Minor. The interaction may be bothersome or 
unnoticed. For example, an interaction that may cause 
drowsiness is considered minor. 

 0-None. The interaction has no documented effect. 

Minimum Level of Documentation 
to Display (0-5) 

If the Drug Interaction database is installed, specify the 
minimum severity of interaction to display based upon the 
documentation. The levels are: 
5-Established. Proved to occur in well-controlled clinical 
studies. 
4-Probable. Very likely, but not proved clinically. 
3-Suspected. Could occur. Good data exists, but more study is 
needed. 
2-Possible. Could occur. Limited data exists. 
1-Doubtful/Unknown. Doubtful. No consistent and reliable 
data. 
0-None. The interaction has no documented effect. 
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The Other Checks Tab 

Item Description 

Drug-Disease Check Level This compares the patient's current medical condition with all 
drugs currently prescribed or in a new prescription. A warning 
displays when there is a contraindication, based on the level 
chosen. 
Note: Problems with the status of "Inactive" or that have been 
resolved will not be checked. 
Type or select one of these levels: 

 1-Absolute contraindication. A warning displays when 
there is an absolute contraindication only. 

 2-Potential contraindication. A warning displays when 
there is an absolute or potential contraindication. 

 3-Precaution. A warning displays when there is an 
absolute or potential contraindication, or when caution 
should be used. This is the default level. 

Age of problems to check for 
Drug - Disease (in months) 

This setting controls the limit in months for which drug disease 
checking for other problems and diagnoses is performed when 
a new prescription is written. For example, if this configuration 
is set to 3 months, a diagnosis or other problem older than 3 
months will not be checked when a new prescription is written. 
If the diagnosis or other problem is less than 3 months old, it 
will be checked.  
Please note this configuration does not apply to Major 
Problems or Risks. 
The default for this configuration is 2 months. 

Drug Dose Area This compares the patient's age and gender with all drugs in a 
new prescription. A warning displays when there is a 
contraindication, based on the options chosen. 
This does not check for: 

 Special conditions in the patient, including but not 
limited to hepatic impairment, malnutrition, obesity, or 
renal failure. 

 Difference between acute and maintenance therapies, 
including but not limited to therapies for peptic ulcer 
drugs. 

 Some types of drugs, including but not limited to 
aerosols and rectal preparations. 

 Children under the age of one year old. 
To check a new prescription for the drug does, click any or all of 
the following: 

 Drug Dose Check 
 Warn adult dose checking not available 
 Warn geriatric dose checking not available 
 Warn pediatric dose checking not available 
 Warn infant dose checking not available 
 Warn about recommended dose 
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The Frequency Defaults Tab 

Item Description 

Rx Frequency Defaults Type a standard frequency in each box, such as "daily," or 
"twice daily." Up to 50 different frequencies may be used.  
These frequencies may be selected in Frequency on 
Prescription. 
The default values may also be created in the [Rx] section of the 
ppart.ini file. 

The Required Rx Fields tab 

Item Description 

Size Click to require operators to enter the Size on the Prescription 
screen. 

Take Click to require operators to enter the Take on the Prescription 
screen. 

Freq Click to require operators to enter the Frequency on the 
Prescription screen. 

Dur Click to require operators to enter the Duration on the 
Prescription screen. 

Amount  Click to require operators to enter the Amount on the 
Prescription screen. 

Refills Click to require operators to enter the Refills on the Prescription 
screen. 

Route Click to require operators to enter the Route on the Prescription 
screen. 

Provider (if not Outside Rx) Click to require operators to enter the Provider on the 
Prescription screen if the provider is not outside the practice. 
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Age Expression 
The Age Expression feature allows you to configure Lytec MD to display age in appropriate units for 
patients in different age ranges, both in the application and in printed reports. For example, you can 
use this feature to express age with specificity down to hours for a newborn infant, with specificity only 
down to weeks in an infant up to a certain age, and only in years in an adult.  

The system allows you to have age displayed differently for patients in different age ranges.  To do this, 
“age ranges” must be defined.  For each age range, you can decide how you wish age to be expressed 
(by choosing your desired “age expression”; see below).  Patient Records comes with default age 
ranges and age expressions which you can modify to meet your organization's needs.  You can also 
create your own age ranges. You can define as many age ranges as you wish as long as your ranges do 
not overlap.  

Your patients' time and date of birth as entered from the Patient Demographic screen is used to 
determine which age expression range will be used when displaying their age.  

Note: If the patient's time of birth is not recorded, the application will not include hours data in the age 
expression, regardless of the age expression that is applied.  

Default Age Ranges and Age Expressions 
If you choose to use the default age ranges, the following ranges will be applied to display your 
patients' ages. If an age range is not explicitly specified for a patient, the patient's age will appear in 
"Years" unless otherwise specified by your system administrator. 

From Age Through Age Default Age Expression  

Birth 28d/0h Days-Hours 

28d/1h 3mo/0d/0h Weeks-Days 

3mo/0d/1h 2y/0mo/0d/0h Months-Days 

2y/0mo/0d/1h 18y/0mo/0d/0h Years-Months 

18y/0mo/0d/1h 999y Years 

Adding, Editing, and Deleting an Age Range Expression 
You can add, modify, and delete age range expressions to specify how your patients' age appears in 
Patient Records and on printed reports. You can enter an unlimited number of age range expressions 
as long as your ranges do not overlap. You may choose to express age ranges in terms of "Years", 
“Years-Months”, “Years-Months-Days”, “Months-Days”, “Weeks-Days”, or “Days-Hours” (you if you enter 
an age range that include months, you may not enter another age range that includes weeks, and vice-
versa). 

To add an age range: 

1. On the Age Range Expressions screen, click the New button. The Age Range Setup <New> 
screen appears.  

2. Type a "from" year in the provided field, or click the arrow buttons to move back or forward by 
one year. 

3. Select the Months radio button or Weeks radio button.  
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Note: The selected option will automatically be selected for the "to" range. For example, if you select 
Months, then months will be selected for the "to" range.  

4. Type the "from" day(s) in the provided field, or click the arrow buttons to move back or forward 
by one day.  

5. Type the "from" hour(s) in the provided field, or click the arrow buttons to move back or 
forward by one hour.  

6. Type a "to" year in the provided field, or click the arrow buttons to move back or forward by 
one year. 

7. Type the "to" day(s) in the provided field, or click the arrow buttons to move back or forward by 
one day.  

8. Type the "to" hour(s) in the provided field, or click the arrow buttons to move back or forward 
by one hour.  

9. Select an age expression from the drop-down list.  

10. When you are finished, click the OK button.  

To change an age range: 

1. On the Age Range Expressions screen, highlight the age range that you want to change, and 
then click the Edit button. The Age Range Setup <Edit> screen appears.  

2. Make the appropriate changes.  

3. When you finish, click the OK button. 

To delete an age range: 

1. On the Age Range Expressions screen, select the age range that you want to delete, and then 
click the Delete button. A confirmation message appears. 

2. Click the Yes button. The age range is deleted. 

Age Range Expressions screen 
The Age Range Expressions screen lists the age range expressions that have been set up in Patient 
Records. You can use this screen to add new age range expressions or change or delete existing age 
range expressions. 

To open the Age Range Expressions screen: 

• Select Maintenance > Configuration > Age Expression. The Age Range Expressions screen 
appears. 

Fields on the Age Range Expressions screen 
Field Description 

Age Range Expressions list Lists the age range expressions that have already been set up in 
Patient Records. 

New button Click to add a new age range expression. The Age Range Setup 
<New> screen appears.  
See the Adding, Editing, and Deleting an Age Range 
Expression section for more information. 
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Edit button Click to change the currently selected age range expression. 
The Age Range Setup screen appears.  
See the Adding, Editing, and Deleting an Age Range 
Expression section for more information. 

Delete button Click to delete the currently selected age range expression. A 
confirmation message appears. Click Yes to delete the age 
range. 
See the Adding, Editing, and Deleting an Age Range 
Expression section for more information. 

Age Range Setup New and Edit screen 
The Age Range Setup screen is used when adding or editing an age range. You can use this screen to 
specify a "Years-Months-Days-Hours" or "Years-Weeks-Days-Hours" range, and to specify the age 
expression for the range.  

To open the Age Range Setup screen:  

1. Select Maintenance > Configuration > Age Expression. The Age Range Expressions screen 
appears. 

2. Click New to add a new age range, or click Edit to edit the currently selected age range. The 
Age Range Setup <New> screen or Age Range Setup <Edit> screen appears.     

Fields on the Age Range Setup screen 
Field Description 

From Age Specify the "from" range. Type the Year, Week or Month, Day, 
and Hour. You can also click the arrow buttons to move back or 
forward between years, months/weeks, days, and hours.  

Note: You can specify age ranges in "Years-Months-Days-
Hours" or "Years-Weeks-Days-Hours". You cannot mix your age 
ranges by Months and Weeks. You must choose one or the 
other. For example, if you select Months for the "from" range, 
then the Months radio button will be automatically selected for 
the "to" range, and the Weeks radio button option will be 
greyed out. 

See the Adding, Editing, and Deleting an Age Range 
Expression section for more information.  
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To Age Specify the "to" range. Type or select, the Year, Week or 
Month, Day, and Hour. You can also click the arrow buttons to 
move back or forward between years, months/weeks, days, and 
hours.  

Note: You can specify age ranges in "Years-Months-Days-
Hours" or "Years-Weeks-Days-Hours". You cannot mix your age 
ranges by Months and Weeks. You must choose one or the 
other. For example, if you select Months for the "from" range, 
then the Months radio button will be automatically selected for 
the "to" range, and the Weeks radio button option will be 
greyed out. 

See the Adding, Editing, and Deleting an Age Range 
Expression section for more information.  

Age Expression  Select the expression for the age range. Your choices include: 
Years, Years-Months, Years-Months-Days, Months-Days, Weeks-
Days, and Days-Hours. This will be the way the patient's age will 
appear in Patient Records and on printed reports.  
For example, if you want the age for patients from the age of 0 
to 28 days old to be displayed in Days and Hours, select the 
Days-Hours option from the drop-down list. The patient's age 
in Patient Records and on printed reports will then be displayed 
in days and hours (e.g., 3 days, 6 hours).  
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Demographic guides 
You can configure “guides” used to aid data entry on demographic screens. Demographic guides will 
indicate which screens and tabs are required, and which can be skipped. This means that guides can 
reduce the complexity and increase the accuracy of data entry.  

You can set up a guide to require a sequence of screens. You can also use the guide to require that 
users access specific tabs and buttons on these screens. 

Note: Your ability to add, change, or delete demographic guides depends on your access level.  

If you are using the guides feature, the default guide runs whenever an operator adds a new patient or 
guarantor. The screens for these demographic items will mark required tabs and buttons with a red 
arrow. "Include" (optional) tabs and buttons will be marked with a blue arrow. Once an operator has 
accessed a tab, the arrow will change to a black check mark.  

Operators can access any tab or subscreen on the demographic screens. The guide simply points out 
which should normally be accessed during new entry.  

You can specify a default demographic guide for operators in Operator Maintenance. You can also 
designate one of the demographic guides as "Default" for the entire site and this will apply when the 
operator doesn't have a demographic guide specified by Operator Maintenance. 

You will use the Demographic Guide Configuration screen to mark whether to include or require 
certain elements (the demographic screen’s tabs and subscreens) in the guide.  

• Include indicates that operators often must enter data on the tab.  

• Required indicates that operators must enter data on the tab before proceeding to the next 
demographic screen in the guide.  

The Demographic Guide Configuration screen is divided into four tabs: Account, Guarantor, Patient, 
and Insurance. The table below describes each tab.  

Field Description 

Account tab This tab does not apply to Lytec MD. 

Guarantor tab Use this tab to determine which tabs should be used when 
operators add a new guarantor.  

Use this tab to indicate which tabs and fields on the Guarantor 
screen should be included or required. 

Patient tab Use this tab to determine which tabs on the Patient screen 
should be used when operators add a new patient.  

The General tab is required for every new patient, so the 
General element is always set to Include and Required. Use the 
other fields to indicate whether each element should be 
included or required.  

If the CHC element is set to Required, operators need only 
click on the CHC tab when adding a new patient. They are not 
required to enter data in the tab. 

Note: The CHC tab is only displayed in the Patient screen if the 
Display CHC Tab check box is selected in the Demographic 
Settings screen. If Display CHC Tab is not selected, the CHC 
tab will not be displayed on the Patient screen, even if the CHC 
element is set to Include or Required on the Demographic 
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Guide Configuration screen.

Insurance tab This tab does not apply to Lytec MD. 

The General tab is required for every new account insurance plan, so the General element is always set 
to Include and Required. Use the other fields to indicate whether each element should be included or 
required.  

If you set up a guide that requires a sequence of screens (for example, the Guarantor screen first, 
followed by the Patient screen, then the Account Insurance Plan screen), the guide will appear:  

• Only when adding a new patient (File > New Patient).  

Adding, editing, and deleting demographic guides 
To open the demographic guide maintenance screen: 

• Select Maintenance > Configuration > Demographic Guides. The Demographic Guide 
Configuration Select screen appears.  

To add a demographic guide "from scratch": 

• On the Demographic Guide Configuration Select screen, click the New button. Fill in the fields 
on this screen, then click the OK button. 

To add a demographic guide by copying an existing guide: 

• On the Demographic Guide Configuration Select screen, highlight the demographic guide that 
you want to copy. Click the Copy button. Type an ID and description for the new guide, then 
change the fields on this screen as necessary. When you finish, click the OK button. 

To select a default demographic guide: 

• On the Demographic Guide Configuration Select screen, highlight the demographic guide that 
you want to make the default guide for all operators. Click the Default button. A check appears in 
the Default column for the demographic guide you selected.  

To change a demographic guide: 

• On the Demographic Guide Configuration Select screen, highlight the demographic guide that 
you want to change. Click the Edit button. Make the appropriate changes. When you finish, click 
the OK button. 

To delete a demographic guide: 

• On the Demographic Guide Configuration Select screen, highlight the demographic guide that 
you want to delete. Click the Delete button. A message asks you to confirm the deletion. Click 
the OK button. 
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Fields and tabs on the Demographic Guide Maintenance 
screen 
Note: The Account and Insurance tabs do not apply to Lytec MD. 

 

Field Description 

ID Code Type an identification code for the new guide. 

Description Type a description of the guide. 

Default check box If you want this guide to be the default demographic guide, 
mark this check box.  

Guarantor tab Select whether you want to include or require individual tabs on 
the Guarantor screen.  

Patient tab Select whether you want to include or require individual tabs 
and screens selected from tabs on the Patient screen.  
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Demographic settings 
Demographic settings are your key to working with demographic information. You can use the 
Demographic Settings screen to establish a variety of demographic preferences, including:  

• How you search for records (General tab)  

• Whether you want records to include a county field (General tab)  

• Whether you want records to include a default greeting, school, and area code (Patient tab)  

• Whether you want Lytec MD to display the attending provider and the patient’s race (Patient tab)  

• How Lytec MD should handle authorizations (Patient tab)  

• Whether Lytec MD should search for duplicate records when you add new records (Patient tab)  

Lookup screen and search preferences 
You can use the Lookup area on the Demographics Settings screen to set the default search options 
for the General, Name, and ID tabs in the Lookup screen. When operators access the Lookup screen, 
the search type in each tab will default to the options specified here. This can save users time if they 
typically perform searches for the same type of information. Users can search for different information 
by selecting another search option in the Lookup screen. 

The options available for selection are listed by application in the table below: 

Lookup Screen tab 
                                        

Patient Records 

General tab 
                                                         
 

Patient Name 
Patient ID 
Phone Number 
Social Security Number 
Account ID 

Name tab Patient 
Patient Name History 
Alias 

ID tab Patient                                       
Head of Household                    
Alternate 

Automatic demographic ID preferences 
You can configure Lytec MD to automatically generate unique demographic identification numbers. 
This means that each time you add a new account, guarantor, or patient, Lytec MD will automatically 
assign a unique ID based on the settings you select.  

During installation, you are asked if you want to use the auto ID feature. If you select yes, you indicate 
the number of characters for each ID (the ID’s length), the starting numbers, the increment between 
each unique ID, and whether each ID should have a prefix.  

Important: The starting IDs displayed on the Demographic Settings screen are not incremented as 
accounts, guarantors, or patients are added. Rather, they are the starting IDs specified during 
installation. You cannot change these numbers or turn on the automatic demographic IDs feature 
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through the Demographic Settings screen. If necessary, you can change your automatic demographic 
ID options later using the plugnxid utility (contact Lytec MD technical support).  

Authorization preferences 
You can use the Demographic Setting screen to set preferences for Patients’ referring sources. These 
options will be automatically selected when you create referrals to outside providers, when you record 
referrals coming into the office from outside providers or other sources, and when you create referrals 
for internal use only (such as for visit tracking only). Your options include the default referral type, and 
default provider type.  

Configuring demographic settings 
To open the Demographic Settings Maintenance screen: 

• Select Maintenance > Configuration > Demographic Settings. The Demographic Settings 
screen appears.  

To configure demographic settings: 

• On the Demographic Settings screen, use the fields on this screen to indicate your preferences.   

Fields on the Demographic Settings Maintenance screen 
Field Description 

General tab 

General, Name, ID  The lists in this section can be used to specify the default search 
type for each tab in the Lookup screen.  
The Medical Billing settings do not apply to Lytec MD.  
Select a default search type from each of the General, Name, and 
ID lists. 

Display Inactive Account Plans  This setting does not apply to Lytec MD. 

Identify Collection Accounts Select this check box to list accounts in search lists with a red 
background if they are in collections. An account is considered in 
collections if the account type is a collections account type, or 
there is a guarantor collection note.  
If a patient is selected who belongs to multiple accounts, and 
one of the accounts is in collections, the account that is in 
collections will be highlighted in red. 

Display County  Select this check box if you want to include a County field for 
demographic addresses.  

County (default)  If you mark the Display County check box and you want to set a 
default county for all records, type the county in this field.  

Recently Opened Account List  This setting does not apply to Lytec MD. 

Length of Demographic IDs  If you selected the autonumbering feature during installation, this 
field displays the length (in number of characters) for each 
demographic ID.  

This field is view-only and cannot be edited.  
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Starting ID  If you selected the autonumbering feature during installation, this 
field displays the starting number for each type of demographic 
ID. The starting ID number applies only to the first automatically-
generated number for each ID type.  

This field is view-only and cannot be edited.  

Increment  If you selected the autonumbering feature during installation, this 
field displays the amount by which you want each demographic 
ID to increment.  

This field is view-only and cannot be edited.  

Prefix  If you selected the autonumbering feature during installation, this 
field displays the prefix used for each type of demographic ID 
(for example, P for patients and G for guarantors).  

This field is view-only and cannot be edited.  

Base IDs on Account ID  This setting does not apply to Lytec MD. 

Patient tab 

Check for Duplicate When Adding 
Patient  

Select this check box if you want the system to search for 
duplicate accounts when you add a new patient.  

Warn if patient has incomplete 
address or home phone 

If you prefer that users add complete address and home 
telephone number for patients, mark this check box. When 
marked, the system will display a message if either of these fields 
is incomplete.  

Attending Provider  If you want the Attending Provider field to appear on the Patient 
Internal Provider screen and on the patient internal provider list, 
mark this check box.  

Race  If you want a Race field to display on the Patient screen, mark this 
check box.  
If your practice uses the optional Brentwood spirometry module, 
you should turn on this field. This will assist the Brentwood 
application in making more accurate interpretations of 
spirometry tests. 

Display CHC tab If you want the CHC tab to display on the Patient screen, select 
this check box. If the ppart.ini setting, "DisplayPatientCHC" is On, 
this check box will automatically be selected.  

Greeting (default)  If you want a default greeting to display on the General tab of the 
Patient screen, type that greeting in this field.  

School (default)  If you want a default school to display on the General tab of the 
Patient screen, type that school in this field.  

Area Code (default)  If you want a default area code to display on the General tab of 
the Patient screen, type that area code in this field.  

Default for Recall - Date Active (1 - 
365) 

To display a default Date Active in the Patient Recall <New> 
screen when a new patient recall is added, type a number of days 
in this box. 
The default Date Active will be the system date plus the number 
of days entered in this box. For example, if you want new patient 
recalls to have a default Date Active of a week after the day they 
are added, enter 7 in this box. 
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Valid values are numbers from 1 to 365. If you leave this box 
blank, no default Date Active will be displayed in the Patient 
Recall <New> screen. 

Use Head of Household address 
for patient address  

This setting does not apply to Lytec MD. 

Default patient Head of Household 
to account default guarantor  

If you want the patient’s head of household to be the default 
account guarantor, mark this check box.  

[Default selection for patient 
address]  

Select one of these options:  
 Use Head of Household address for Patient address - 

When selected, the patient's address fields will be 
filled in with the head of household's address 
information.  
 
When a new patient is added, the already-completed 
address fields use a different background color than 
other fields on the Patient screen. If you change the 
data in these fields, the background color changes to 
the default color (yellow).  
 
If the head of household's address is changed, a 
message asks whether the addresses of patients who 
share the head of household's address should also be 
updated.  

 Use Guarantor address for Patient address - When 
selected, the patient's address fields will be filled in 
with the guarantor's address information.  
 
When a new patient is added, the already-completed 
address fields use a different background color than 
other fields on the Patient screen. If you change the 
data in these fields, the background color changes to 
the default color (yellow).  
 
If the guarantor's address is changed, a message asks 
whether the addresses of patients who share the 
guarantor's address should also be updated. If a 
patient also belongs to another account, you will need 
to manually update the address fields.  

 Do not default patient address - When selected, the 
patient's address fields will be left blank. No address 
information will default from the head of household or 
guarantor.  

From Type  Select the default authorization type.  

To Provider Type  Select the default provider type.  

Carrier or Visit Tab  Select whether you want to default to the Carrier or Visits tab.  

Guarantor tab - This tab does not apply to Lytec MD.  

Account Plan tab - This tab does not apply to Lytec MD.  
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Field validations 
The Field Validations feature allows you to set up data entry requirements for a number of guarantor, 
patient, and account plan fields. By creating field validations you specify which fields should be filled in 
when registering a new patient thus increasing the accuracy of claim data submitted to insurance 
carriers.  

You can set up validations to require data entry in the following demographic fields: 

• Guarantor 
Address Line 1, City, Home Tel #, State, Zip Code 

• Patient  
Address, City, Date of Birth, Home Tel #, Sex, State, Zip 

• Account Insurance Plan 
Date of Birth, Sex, Insured ID, Group ID, Override Insured ID  

Note: Your ability to add, change, or delete field validations depends on your access level.  

Guarantor and Patient validations are applied to every patient and guarantor. Account Insurance Plan 
validations can be global or carrier/carrier group specific, which means that you can set up data entry 
requirements for specific carriers or carrier groups. If you have specified both global and carrier 
specific rule, the carrier specific rule will be applied. 

In addition, you can also set the entry format for the Insured ID, Group ID, and Override Insured ID 
fields on the Account Insurance Plan screen. For example, you can configure the Insured ID field to 
allow both alphabetic (a-z, A-Z) and numeric characters (0-9).  

Use the Field Validation Maintenance screen to specify whether certain fields on the Guarantor, Patient 
or Account Insurance Plan screens are required:  

• Entry Required indicates that operators must enter data in the field when registering a patient in 
full or standard registration mode or when updating patient demographic information when a 
patient checks in for an appointment.  

• Entry Required on Quick Reg indicates that operators must enter data in the field when 
registering a patient using the quick registration mode (Quick Reg mode).  

• Format Required indicates that the data entered in the field must conform to the format 
requirements set up for that field on the Field Validation: Account Plan screen. Alternatively, if a 
format requirement is specified for a field but the Format Required check box is clear, the 
operator will be reminded of the format should they not conform to it, but will be allowed to 
continue without adhering to it.  

If you are using the Field Validations feature, Lytec MD will apply the field validations that have been 
set up in the system whenever an operator adds a new patient, guarantor, or insurance plan. Field 
validation rules are also triggered when a patient checks in for an appointment thus reminding the 
operator that required data fields were not populated at the time the patient made the appointment (if 
Quick Reg was set as the default demographic guide). The required fields for these demographic items 
will be highlighted in red.  

Setting up, editing, and deleting field validations 
To open the Field Validations Maintenance screen: 

• From the Maintenance menu, point to Configuration and then click Field Validations to open the 
Field Validations Maintenance Select screen.  
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To add a field validation: 

1. Select the screen you want to set up field validations for. Click the arrow button to select from 
the list of available options: Patient, Guarantor or Account Plan. 

2. Click New. Fill in the fields on this screen, and then click OK. 

To change a field validation: 

• On the Field Validations Maintenance Select screen, click the field that you want to change in 
order to highlight it. Click Edit and make the necessary changes. When finished, click OK. 

Note: You cannot change your carrier or carrier group selections for an existing field validation. To 
select a different carrier or carrier group for a field validation rule, delete the existing rule first and then 
create a new rule and associate it with the desired carrier or carrier group. 

To delete a field validation: 

• On the Field Validations Maintenance Select screen, click the field that you want to delete in 
order to highlight it. Click Delete. A message asks for confirmation. Click OK. 

Fields on the Field Validation Maintenance Select screen 
Field Description 

Type Enter the demographic field type that you want to set up 
validation criteria for or click the arrow button to select from 
the list of available field types - Guarantor, Patient, or Account 
Plan.   

Carrier or Group This option is only available for Account Insurance Plan 
validations. It allows you to search for field validations that have 
been configured in the system for a specific carrier or carrier 
group.  
Enter the name of the carrier or carrier group you want to 
search for and click the Search button. The Field Validations list 
below displays all field validations that exist in the system for 
that carrier or carrier group.  

Field Validations list Displays a list of all previously configured validations for the 
selected demographic type.  

New  Click this button to open the Field Validation <New> screen 
which allows you to enter validation criteria for the selected 
field type. 

Edit Click this button to open the Field Validation <Edit> screen 
which allows you to modify the validation criteria that you have 
set up for the selected field type. 

Delete Allows you to delete field validations. Click the record that you 
want to delete in order to highlight it and then click Delete. A 
message asks for confirmation. Click OK. 

Close Click this button to close the Field Validation Maintenance 
Select screen.  
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Fields on the Field Validation Maintenance <New> screen 
Field Description 

Data Entry Control  

Field Select the field you want to set up validation criteria for. Click the arrow to 
open a list of the available fields.  

Entry Required Select this check box if users will be required to enter data in the field.  

Note: This setting does not apply to patient registration in quick 
registration mode (Quick Reg).  

This check box is selected by default.  

Entry Required on Quick 
Reg 

Select this check box if users will be required to enter data in the field 
when registering patients using the quick registration mode.  
This check box is clear by default. 

Format Allows you to set the data entry format for alphanumeric fields (Insured 
ID, Group ID, and Override Insured ID). You can enter one of the 
following for each character in a field, up to the length of the field:   

Mask Character Description 

# Digit placeholder. 

. Decimal placeholder. The actual character used is 
the one specified as the decimal placeholder in 
your international settings. This character is treated 
as a literal for masking purposes.  

, Thousands separator. The actual character used is 
the one specified as the thousands separator in 
your international settings. This character is treated 
as a literal for masking purposes.  

: Time separator. The actual character used is the 
one specified as the time separator in your 
international settings. This character is treated as a 
literal for masking purposes.  

/ Date separator. The actual character used is the 
one specified as the date separator in your 
international settings. This character is treated as a 
literal for masking purposes.  

\ Treat the next character in the mask string as a 
literal. This allows you to include the '#', '&', 'A', and 
'?' characters in the mask. This character is treated 
as a literal for masking purposes.  
Example:  
A mask of "\ABCAAAA" requires that the field value 
starts with "ABC" and then contains any 4 
alphanumeric characters. 

& Character placeholder. Valid values for this 
placeholder are ANSI characters in the following 
ranges: 32-126 and 128-255.  
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> Convert all the characters that follow to uppercase. 

< Convert all the characters that follow to lowercase. 

A Alphanumeric character placeholder (entry 
required). For example: a – z, A – Z, or 0 – 9.  

a Alphanumeric character placeholder (entry 
optional).  

9 Digit placeholder (entry optional). For example: 0 – 
9.  

C Character or space placeholder (entry optional). 
This operates exactly like the & placeholder. 

? Letter placeholder. For example: a – z or A – Z.  

Literal  All other symbols are displayed as literals; that is, 
as themselves.  
Example:  
A mask of “ABCAAA” requires that the field value 
starts with “ABC” and then contains any 3 
alphanumeric characters. 

 

Format Required Available for selection for alphanumeric fields only (Insured ID, Group ID, 
and Override Insured ID) and if the entry format has been set up for the 
field in the Format field.  
Select this check box if the text entered in the Insured ID, Group ID, or 
Override Insured ID field must adhere to the format specified in the 
Format field.  
Leave the check box clear if the specified format is just a voluntary 
guideline that operators may use when entering data in the field.  
If the field data does not conform to the format requirements, a warning 
message will display.  

Carrier 

Carrier Available for selection only if the field Type = Account Plan and if no 
carrier group has been entered in the Carrier Group field.   
Enter the name of the insurance carrier to which you want to apply the 
specified field validations and/or data entry format requirements or click 
the arrow button to select from the list of the available carriers.  

Note: You cannot select a carrier that has been previously selected in 
another validation for the same field, either via the Carrier or the Carrier 
Group field.  

Carrier Group Available for selection only if the field Type = Account Plan and if no 
carrier has been entered in the Carrier field.    
Enter the name of the insurance carrier group to which you want to apply 
the specified field validations and/or data entry format requirements or 
click the arrow button to select from the list of the available carrier 
groups.  
Note: You cannot select a carrier group that has been previously selected 
in another validation for the same field, or if a carrier in the group was 
previously selected in the Carrier field.  
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Address defaults 
To make registration as easy and flexible as possible, Lytec MD provides address defaults. You can use 
these defaults to automatically enter information that would ordinarily be the same for many of your 
patients and guarantors. For example, most of your patients probably live in the same state – or even in 
the same city. You can set defaults that will automatically enter the city and state based on the ZIP Code 
entered during registration.  

Once you set up the address defaults, you can simply enter the ZIP Code on the demographic screen. 
The system will then fill in the appropriate city, state, and country (if applicable). If you enter a city or 
state first, and then enter a ZIP Code that is not linked to that city or state, the system will not replace 
your entry.  

While you can enter the ZIP Codes linked to cities and states on the Address Defaults screen, the ZIP 
Codes are also entered automatically when you add a patient. In other words, each time you enter a 
new ZIP Code when adding a patient, the Address Default table is automatically updated. Likewise, if 
you change the city or state associated with a ZIP Code when adding a patient, the Address Default 
table is automatically updated.  

Note: In addition, your system administrator can set a default country on the Special Features screen; a 
default county on the General tab of the Demographic Settings screen; and a default patient greeting 
and school on the Patient tab of the Demographic Settings screen. Also on the Patient tab of the 
Demographic Settings screen, your system administrator can elect to use the head of household as the 
default account guarantor, and the head of household or guarantor address as the default patient 
address.  

You can also set defaults for the county and country fields. The table below describes the order in 
which address defaults (of any kind) will display on demographic screens.  

Default Where the information will display... 

County and country defaults  Defaults for these fields display on the demographic screens.  

Current practice defaults  If the current practice has a default city, state, ZIP Code, and 
area code, these values display on the demographic screens.  

Head of household or guarantor 
defaults  

If the head of household or guarantor address option is 
selected, then all address and telephone fields will default to 
values from the head of household.  

ZIP Code defaults  If ZIP Code defaults have been set up on the Address Defaults 
screen, then the city, state, and county values for the ZIP Code 
will default when you enter a value in the ZIP Code field.  

Adding, editing, and deleting address defaults 
To open the address default maintenance screen: 

• Select Maintenance > Configuration > Address Defaults. The Address Defaults screen appears.  

To add an address default: 

• On the Address Defaults screen, click the New button. Fill in the fields on this screen, then click 
the OK button. 
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To change an address default: 

• On the Address Defaults screen, highlight the address default that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete an address default: 

• On the Address Defaults screen, highlight the address default that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the address defaults screen 
Field Description 

ZIP Code (Postal Code) Type the ZIP Code (postal code) that will be used to link the 
address defaults.  

City If you want to link a city to the ZIP Code (postal code), type the 
name in this field.  

County If you have turned on the country feature (so that the County 
field appears on demographic screens), and you want to link a 
county to the ZIP Code, type the name in this field.  

State  Select the state you want to link to the ZIP Code (postal code).  
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Specialty codes 
You can create specialty codes (codes that describe the kind of medicine that physicians practice) that 
can be assigned to providers.  

Adding, editing, and deleting specialty codes 
To open the specialty code maintenance screen: 

• Select Maintenance > Configuration > Specialty Codes. The Specialty Codes screen appears. 

To add a specialty code from scratch: 

• On the Specialty Codes screen, click the New button. Fill in the fields on this screen, then click 
the OK button. 

To add a specialty code by copying an existing formulary: 

• On the Specialty Codes screen, click the Copy All button. On the Copy All From screen select 
whether you want to copy the formulary from a universal provider, an insurance carrier, or 
another specialty. Click the OK button, and make any necessary changes. 

To change a specialty code: 

• On the Specialty Codes screen, highlight the specialty code that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete a specialty code: 

• On the Specialty Codes screen, highlight the specialty code that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the specialty code maintenance screen 
Field Description 

ID Code Type an ID for the new specialty. 

Description Type a description of the specialty. 

Complete For sites using the optional insurance formularies feature: 
After you create a formulary for a specialty, you should return to 
the specialty code maintenance screen, highlight the specialty 
and click the Edit button, then mark the Complete check box. 
This allows the specialty code's formulary to display in the 
Select Rx Template list.  

Comments Type an optional note about the specialty. 
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Define Other Data 

Carrier (user-defined fields) 
You can add user-defined fields to store additional information about insurance carriers. These fields 
display on the Carrier Maintenance screen’s Other Data tab. Your system administrator can limit who 
has access to the Other Data tab.  

When you delete a user-definable field, you are also deleting all data that has been entered in that 
field. Once deleted, you may not be able to restore the data.  

Adding, editing, and deleting user-defined carrier fields 
To open the user-defined carrier field screen: 

• Select Maintenance > Configuration > Define Other Data > Carrier. The Carrier Define Other 
Data Select screen appears.  

To add a user-defined carrier field: 

• On the Carrier Define Other Data Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a user-defined carrier field: 

• On the Carrier Define Other Data Select screen, highlight the user-defined carrier field that you 
want to change. Click the Edit button. Make the appropriate changes. When you finish, click the 
OK button. 

To delete a user-defined carrier field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Carrier Define Other Data Select screen, highlight the user-defined carrier field that you 
want to delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK 
button. 

Fields on the user-defined carrier field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  
 Numeric – users can type numbers in the field.  

 Date – users can type dates in the field.  
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Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  

 For numeric fields, up to 9 digits.  For date fields, two-
digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Guarantor (user-defined fields) 
You can add user-defined fields to store additional information about guarantors. These fields display 
on the Guarantor screen’s Other Data tab. Your system administrator can limit who has access to the 
Other Data tab.  

When you delete a user-definable field, you are also deleting all data that has been entered in that 
field. Once deleted, you may not be able to restore the data.  

Adding, editing, and deleting user-defined guarantor fields 
To open the user-defined guarantor field screen: 

• Select Maintenance > Configuration > Define Other Data > Guarantor. The Guarantor Define 
Other Data Select screen appears.  

To add a user-defined guarantor field: 

• On the Guarantor Define Other Data Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a user-defined guarantor field: 

• On the Guarantor Define Other Data Select screen, highlight the user-defined guarantor field 
that you want to change. Click the Edit button. Make the appropriate changes. When you finish, 
click the OK button. 

To delete a user-defined guarantor field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Guarantor Define Other Data Select screen, highlight the user-defined guarantor field 
that you want to delete. Click the Delete button. A message asks you to confirm the deletion. 
Click the OK button. 

Fields on the user-defined guarantor field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  
 Numeric – users can type numbers in the field.  

 Date – users can type dates in the field.  

Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  
 For numeric fields, up to 9 digits.  For date fields, two-

digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Patient (user-defined fields) 
You can add user-defined fields to store additional information about patients. These fields display on 
the Patient screen’s Other Data tab. Your system administrator can limit who has access to the Other 
Data tab.  

You can also add user-defined fields to store alternate patient IDs. These fields display on the Patient 
Alternate IDs screen, which appears when you click the Patient screen’s Alt IDs button.  

When you delete a user-definable field, you are also deleting all data that has been entered in that 
field. Once deleted, you may not be able to restore the data.  

Adding, editing, and deleting user-defined patient fields 
To open the user-defined patient field screen: 

• Select Maintenance > Configuration > Define Other Data > Patient. The Patient Define Other 
Data Select screen appears.  

To add a user-defined patient field: 

• On the Patient Define Other Data Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a user-defined patient field: 

• On the Patient Define Other Data Select screen, highlight the user-defined patient field that you 
want to change. Click the Edit button. Make the appropriate changes. When you finish, click the 
OK button. 

To delete a user-defined patient field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Patient Define Other Data Select screen, highlight the user-defined patient field that you 
want to delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK 
button. 

Fields on the user-defined patient field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  
 Numeric – users can type numbers in the field.  

 Date – users can type dates in the field.  
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Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  

 For numeric fields, up to 9 digits.  For date fields, two-
digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Patient alternate ID (user-defined fields) 
You can add user-defined fields to store alternate patient IDs. These fields appear on the Patient 
Alternate IDs screen, accessed from the Patient screen by clicking the Alt IDs button.  

Adding, editing, and deleting user-defined patient alternate 
ID fields 
To open the user-defined patient ID field screen: 

• Select Maintenance > Configuration > Define Other Data > Patient Alternate ID. The Patient 
Define Alternative ID Select screen appears.  

To add a user-defined patient ID field: 

• On the Patient Define Alternative ID Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a user-defined patient ID field: 

• On the Patient Define Alternative ID Select screen, highlight the user-defined patient ID field that 
you want to change. Click the Edit button. Make the appropriate changes. When you finish, click 
the OK button. 

To delete a user-defined patient ID field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Patient Define Alternative ID Select screen, highlight the user-defined patient ID field that 
you want to delete. Click the Delete button. A message asks you to confirm the deletion. Click 
the OK button. 

Fields on the user-defined patient alternate ID field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  

 Numeric – users can type numbers in the field.  

Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  
 For numeric fields, up to 9 digits.  For date fields, two-

digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Practice (user-defined fields) 
You can add user-defined fields to store additional information about your practices. These fields 
display on the Practice Maintenance screen’s Other Data tab. Your system administrator can limit who 
has access to the Other Data tab.  

When you delete a user-definable field, you are also deleting all data that has been entered in that 
field. Once deleted, you may not be able to restore the data.  

Adding, editing, and deleting user-defined practice fields 
To open the user-defined practice field screen: 

• Select Maintenance > Configuration > Define Other Data > Practice. The Practice Define Other 
Data Select screen appears.  

To add a user-defined practice field: 

• On the Practice Define Other Data Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a user-defined practice field: 

• On the Practice Define Other Data Select screen, highlight the user-defined practice field that 
you want to change. Click the Edit button. Make the appropriate changes. When you finish, click 
the OK button. 

To delete a user-defined practice field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Practice Define Other Data Select screen, highlight the user-defined practice field that 
you want to delete. Click the Delete button. A message asks you to confirm the deletion. Click 
the OK button. 

Fields on the user-defined practice field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  
 Numeric – users can type numbers in the field.  

 Date – users can type dates in the field.  

Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  
 For numeric fields, up to 9 digits.  For date fields, two-

digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Provider (user-defined fields) 
You can add user-defined fields to store additional information about providers. These fields display on 
the Provider Maintenance screen’s Other Data tab. Your system administrator can limit who has access 
to the Other Data tab.  

When you delete a user-definable field, you are also deleting all data that has been entered in that 
field. Once deleted, you may not be able to restore the data.  

Adding, editing, and deleting user-defined provider fields 
To open the user-defined provider field screen: 

• Select Maintenance > Configuration > Define Other Data > Provider. The Provider Define Other 
Data Select screen appears.  

To add a user-defined provider field: 

• On the Provider Define Other Data Select screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a user-defined provider field: 

• On the Provider Define Other Data Select screen, highlight the user-defined provider field that 
you want to change. Click the Edit button. Make the appropriate changes. When you finish, click 
the OK button. 

To delete a user-defined provider field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Provider Define Other Data Select screen, highlight the user-defined provider field that 
you want to delete. Click the Delete button. A message asks you to confirm the deletion. Click 
the OK button. 

Fields on the user-defined provider field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  
 Numeric – users can type numbers in the field.  

 Date – users can type dates in the field.  

Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  
 For numeric fields, up to 9 digits.  For date fields, two-

digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Referring source (user-defined fields) 
You can add user-defined fields to store additional information about referring sources. These fields 
display on the Referring Source screen’s Other Data tab. Your system administrator can limit who has 
access to the Other Data tab.  

When you delete a user-definable field, you are also deleting all data that has been entered in that 
field. Once deleted, you may not be able to restore the data.  

Adding, editing, and deleting user-defined referring source 
fields 
To open the user-defined referring source field screen: 

• Select Maintenance > Configuration > Define Other Data > Referring Source. The Referring 
Source Define Other Data Select screen appears.  

To add a user-defined referring source field: 

• On the Referring Source Define Other Data Select screen, click the New button. Fill in the fields 
on this screen, then click the OK button. 

To change a user-defined referring source field: 

• On the Referring Source Define Other Data Select screen, highlight the user-defined referring 
source field that you want to change. Click the Edit button. Make the appropriate changes. When 
you finish, click the OK button. 

To delete a user-defined referring source field: 

Note: When you delete a user-definable field, you are also deleting all data that has been entered in 
that field. Once deleted, you may not be able to restore the data.  

• On the Referring Source Define Other Data Select screen, highlight the user-defined referring 
source field that you want to delete. Click the Delete button. A message asks you to confirm the 
deletion. Click the OK button. 

Fields on the user-defined referring source field screen 
Field Description 

Label Type the name of the user-defined field.  

Description Type a description for the user-defined field.  

Type Select the appropriate type of field. Your options are:  
 Text – users can type characters in the field.  
 Numeric – users can type numbers in the field.  

 Date – users can type dates in the field.  

Format Select the field’s format. Your options are:  
 For text fields, up to 30 characters.  
 For numeric fields, up to 9 digits.  For date fields, two-

digit year (mm/dd/yy) or four-digit year (mm/dd/yyyy).  
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Customize Chart Summary for Site or Provider 
Just as you can customize the entire patient chart for the site and for individual providers, you can also 
customize the chart summary for your entire site and for individual providers.  

When you customize the chart summary, you can indicate how many and which chart categories should 
display on the chart summary.  

To customize the chart summary:  

1. If you want to customize the chart summary for a specific provider, make sure you are logged in 
as that provider.  

2. Do one of the following: 
• To customize the chart summary for a provider, select Maintenance > Configuration > 

Customize Chart Summary for Provider. 

• To customize the chart summary for a site, select Maintenance > Configuration > 
Customize Chart Summary for Site.  

The Chart Summary Configuration screen appears.  

3. To select the number and layout of panes, select one of the radio buttons in the Layout Options 
frame. You can display 4, 5, 6, 7, or 8 panes, each containing one category of chart information, 
such as Major Problems, Medications, or Vital Signs.  

A preview of the selected layout option is shown in the Chart Summary Window frame. 

4. In the Content Selection frame, use the drop-down lists to select the chart category to display in 
each pane. 

5. When you finish, click the OK button.  

To view the chart summary: 

1. Open the patient chart. 

2. Select Show > Chart Summary. The Chart Summary screen appears. 
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Customize patient chart 
To offer the maximum flexibility in a wide variety of practices and office settings, the patient chart may 
be customized.  

If you plan to customize the chart for the site, you should do it as part of setup. That’s because when 
you modify the chart for the site, it affects how individual providers view the chart. If you modify the 
chart after providers have customized the chart for their own use, it would change what they see.  

Plan carefully before you make extensive changes. It might be helpful to mockup your final patient 
chart on paper or on a computer screen before making the changes.  

One potential use of the ability to create custom chart sections is documentation of disclosures of 
patient information, in compliance with the Health Insurance Portability and Accountability Act of 1997 
(“HIPAA”) and other applicable laws and regulations. If you set up a Patient Chart section titled 
“Information Disclosures,” you can create notes in that tab documenting relevant information, such as 
the date of the disclosure, the name and address of the entity or person who received the protected 
health information, and a brief description of the information disclosed and the purpose of the 
disclosure. 

Customize patient chart for site 
This option lets you label any section of the patient chart with a new name and icon. That allows you to 
use chart sections for whatever information you want, and to move sections. Once you have renamed a 
section of the patient chart, the new name appears on the tab on the patient chart and on the Show 
menu.  

You can also assign a name and icon to the unused sections of the patient chart to add additional 
categories of information.  

Note: You can change the names of patient chart sections at any time without affecting patient 
information.  

To customize the chart for the site:  

1. Select Maintenance > Configuration > Customize Patient Chart for Site. The Patient Chart 
Configuration for Site screen appears.  

2. Select the patient chart category that you want to change. When the Configuration screen 
appears, you have three options:  
• Choose Category - If you want to change what information displays in this part of the 

chart, click on the list box and select another chart section. Categories are never lost so, if 
necessary, you can always restore back to the original category. All categories display 
under this list box, with their current name.  

Note: There are several confidential sections of the Patient Chart: the undefined 
categories I & J on the bottom left of the chart, and the last section on the bottom right of 
the chart. You can use these sections to store information to which only users with the 
appropriate access levels have access.  

• Rename Category - To change the name of the chart section, type in a new name. It will 
display on the tab for the chart section. If you want to change back to the original 
category name, that category is noted to the right under System Default.  

Note: If you need to call Technical Support about a category or need to look it up in the 
manual index, be sure to use the original category name.  
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• Icon - If you want to change the chart section icon, click on the list box and select another 
icon. If you want to change back to the original icon, that icon displays on the right side of 
the screen.  

3. When you finish, click the OK button.  

Customize patient chart for provider 
You can customize the patient chart for any provider, changing which chart categories display and 
selecting each category’s icons. The modifications apply only to the currently selected provider’s chart 
display. This allows you to reorder the chart into the format a provider finds most comfortable.  

As part of this, you can also establish a default progress note filter for a provider, instructing the system 
to display progress notes only for one provider. Although the provider will usually be the same as the 
provider for whom you are modifying the chart, you can actually select any provider. You can also 
instruct the system to display only notes with a particular title.  

To customize the patient chart display:  

1. Close any patient charts that are open.  

2. If you are customizing the patient chart display for a provider, make sure you are logged in as 
that provider.  

3. Select Maintenance > Configuration > Customize Patient Chart for Provider. The Patient Chart 
Configuration for Provider screen appears.  

4. Click the patient chart category that you want to change. The Configuration screen appears.  

5. Make the necessary changes. Your options are:  
• Choose Category - If you want to change what information displays in this part of the 

chart, select another section from the drop-down list.  

• Filter - This option displays only if you clicked Progress Notes. If you click the Filter button, 
the Filter Parameters screen appears. Select the provider whose progress notes should 
display when the currently selected provider is viewing the patient chart.  
 
If you want to display only progress notes that have a particular title, enter that title in the 
Title box.  
 
The practice option will be available in a future version of Patient Records.  

Note: You can override this filter at any time on the Patient Chart screen. To do that, click 
the All radio button on the right side of the screen.  

• Icon - If you want to change the chart section icon, select another icon from the drop-
down list.  

6. Click the OK button.  
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Templates 

Note templates 
To speed note entry, you can create note templates for common problems. Templates contain often-
repeated text and the necessary Dot codes for a given problem. That way, when you insert a template 
into a note, you only need to add patient-specific information.  

New sites are provided with a starter set of note templates. You can modify or add to these templates 
as necessary.  

Universal templates are available to all providers/practices. You can also add templates for a specific 
provider or practice (depending on the Allow QuickText and Templates by Practice setting on the 
Special Features screen) to reflect the style and organization preferred by the specified 
provider/practice. 

If you are using the HTML note features, note templates provide many of the features available in word 
processing software such as Microsoft Word. You can format the text by changing the font and size; 
bolding, italicizing, or underlining the text; centering or justifying the text; and indenting the text. You 
can also quickly add tables and other formatting. Your system administrator can use settings in the 
ppart.ini file to restrict the fonts and font sizes available in note templates. 

With note templates, you can also: 

• Use speech recognition if you have the Dragon Naturally Speaking add-on module installed. 

• Record dictation or insert sound files. 

• Insert QuickText, Dot codes and insert codes, and labels to speed data entry. 

• Insert temporary hyperlinks and permanent hyperlinks to external files and Web sites. 

• Require users to enter data or text by using the REQ label marker. 

• Use conditional logic to automatically fill in patient-specific information. 

Note: For best results, you should select and use a corporate font in your templates (make sure the font 
is set as the default font in the ppart.ini file). That way, all Lytec MD users will see the template the way it 
was designed. Otherwise, when users don't have the font installed on their system, a different font will 
be used and the template’s text and spacing may be considerably different when used in notes. 

Labels, context-sensitive QuickText, and special labels  
Where a provider will usually insert patient-specific information, insert label markers - the «*» symbol. 
The label marker is a blue colored underlined hypertext link. When the provider works on the note, 
pressing F10 or TAB will move the cursor between labels, where he or she can type in the appropriate 
text or data.  

Another type of label marker, shown in red, can be created. It always forces a pick list. (See Inserting 
Labels into Note Templates.)  

Label markers are protected. You cannot partially delete them. To delete them, highlight the entire 
label and press the delete key. You can highlight them using your shift and arrow keys or using shift 
and your left mouse button.  

When you create a template, you can also embed QuickText item names (or partial names) into the «*» 
label markers. When you use the template to create a note, in addition to the F10 key, you can use TAB, 
the QT Auto button, or ALT+N to move between label markers. When you reach a label marker with an 
embedded QuickText item name and you used QT Auto, Patient Records will replace the item name 
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with its associated QuickText. If you embedded a partial item name, then press ALT+A, it will display a 
list of items, starting with the closest match.  

You can add QuickText item names and the following special labels to your templates:  

• «del» - Use this label if you want a progress note line brought in by a template to be deleted if 
nothing is entered following the «del» label. This lets you automatically clean up the note, saving 
only text applicable to the patient’s note.  
 
If you enter one or more characters in the note after this label, the note retains the line when the 
note is saved.  

• «QuickText name» - To embed a QuickText item name, remove the asterisk from the label and 
replace it with the QuickText item name.  

• «*sex*» - Patient Records replaces this label with the patient’s sex.  

• «*age*» - Patient Records replaces this label with the patient’s age. For one year and older 
patients, the abbreviation yr follows. If the patient is less than 1 year old mo follows.  

• «*date*» - Patient Records replaces this label with the current system year.  

• «LINK» - Allows you to link to a specified site or document.  

• «REQ» - Allows you to require data entry wherever this label marker is located in a note.  

You insert labels by using the Insert menu. You can edit a label by moving your cursor over it and 
typing. However, you cannot delete the last character from inside a label, so do not delete the asterisk 
to start with. Delete the asterisk at the end of your edit. The delete key will also not work on the label 
delimiters. Instead, to delete a label, highlight it using the shift arrow keys and the press the delete key.  

Using the LINK label marker in note templates 
The LINK label marker allows you to place a hyperlink – to an HTML document or Internet Web site – in 
a note template. Clicking on the LINK label marker starts up your Web browser and displays the 
specified document or Internet site. You must have Internet Explorer and the Patient Education 
component installed in order to use this label marker.  

After a note is saved, the LINK label marker is removed from the note. To permanently save links in 
your note, use PLINK or PLINK2 label markers. 

To add the LINK label marker in a template:  

1. Place the cursor at the point in your note template where you want to insert the label.  

2. Select Insert > QuickText, or click the QText button on the toolbar.  

3. Mark the DOT code radio button.  

4. Select “Hyperlink1” from the list and click the Insert button.  

5. Immediately after the colon, replace “filename or web address” with the full path and filename 
of the document, or the full path of the Internet site.  
 
For example: «LINK:f:\ppart\prevention.html» or «LINK:www.lytec.com»  
 
If the filename for a document does not have a path, Patient Records will look for the filename 
in the database directory (for example, «LINK:prevention.html» ).  
 
If you want to display a label name for the document or site, select “Hyperlink2” from the 
QuickText list and replace “label” with the label name immediately after the colon, leave the 
vertical bar in place, then replace “filename or web address” with the full path.  
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For example: «LINK:Prevention Guidelines|f:\ppart\prevention.html» or «LINK:Lytec MD 
website|www.lytec.com»  

Note: You can substitute an asterisk (*) for the database directory of the document filename that you 
place in a LINK label marker. However, you must enter the subdirectory and filename of the HTML 
document that you want to view. For example, enter <LINK:*\kbase\cataract.htm> , where the asterisk 
(*) stands for f:\ppart.  

Note: Only the label name will display in a note when the option to show Dot codes and label markers 
in the Records 2 tab of Special Features is not marked.  

The LINK label marker becomes highlighted in blue in a note or note template. After a note is saved, 
the LINK label marker is removed from the note.  

Using permanent hyperlinks in note templates 
You can now place permanent hyperlinks directly into notes. Unlike the LINK label marker, permanent 
hyperlinks are not removed when you save the note.  

These permanent hyperlinks can point to any file viewable by Internet Explorer (for example, HTML 
pages, graphics files, text files, and files in the Lytec MD Knowledge Base). The address can be a 
relative or absolute path. Permanent hyperlinks appear in notes as PLINK or PLINK2 labels, and are 
saved with the note.  

For image files, the PLINK and PLINK2 labels support JPG, BMP, WMF, GIF, PNG, and TIF file formats 
with chart reports such as partial or complete charts.  

You can continue to display many other image types in Lytec MD that may not be printable. Generally, 
any image or document viewable in Internet Explorer will display; however, only the types above will 
print out when you print a partial or complete chart reports. 

You can also use ELINK labels to insert links to Patient Education handouts. When you select Insert > 
Patient Education Link, you can select the handout by module title or code. 

These links are for use only with the Lytec MD Patient Education Module and make the Patient hand out 
links independent of any directory changes.  

The format for the ELINK is:   

ELINK: Display Title | PE Module | Handout Title 

To add a permanent hyperlink in a template:  

1. Place the cursor at the point in your note where you want to insert the hyperlink.  

2. Select Insert > Linked File. The Insert Linked File screen appears.  

3. In the Enter file name field, type the address or path to the file.  
 
The file must be displayable in Internet Explorer (examples include p:\ppart\kbase\Asthma 
Management.htm, f:\images\mri.jpg, and images.ct.jpg).  

4. In the Title of File field, type an optional name for the file. This name will display in the note in 
front of the link.  

5. Click the OK button.  
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Using the REQ label marker in note templates 
The REQ label marker requires a user to enter data or text immediately after the marker so that you do 
not miss entering data in required fields. You cannot save a note permanently if any REQ label marker 
is missing data.  

You can use the REQ label marker as many times as necessary in a template. Remember that data or 
text must follow immediately after the marker. When creating a template, you can use QuickText labels 
in conjunction with REQ label markers.  

The following lines shows some examples of the syntax for using the REQ label marker:  

«REQ» <cr> (where <cr> stands for a carriage return at the end of a line)  

«REQ» «REQ» (you need to enter text after both REQ markers)  

«REQ» «item name» <cr> (where «item name» is a QuickText label)  

«REQ» «item name» «REQ» (where «item name» is a QuickText label)  

The following is an example of a line in a note template that uses REQ label markers:  

Recent Hypoglycemia <<REQ>> << none >> Last FBS << REQ>>  

To add the REQ label marker in a template:  

1. Place the cursor at the point in your note template where you want to insert the label.  

2. Select Insert > QuickText, or click the QText button on the toolbar.  

3. Mark the DOT code radio button.  

4. Select “Required1” from the list and click the Insert button.  
 
You can also choose pre-configured REQ label markers from the list, depending on the 
template that you want to create.  

Note: A user cannot delete the REQ label marker from a note unless he or she were given permission, 
as determined from his or her access level. For more information, see Assigning Access Levels.  

The REQ label marker becomes highlighted in red in a note or note template. After a note is saved, the 
REQ label marker is removed from the note.  

Using conditional logic in a note template 
You can create a note template that automatically fills in patient-specific information and also 
determines which information is appropriate for a specific patient. You can do this by using letter codes 
and conditional logic in your note template. Conditional logic evaluates specific statements to be either 
true or false, and generates results based upon whether the statements are true or not. Using 
conditional logic is explained in the letter template section. 

Adding, editing, and deleting note templates 
You can add a note template from scratch, or use a progress note to create a note template. 

To add a note template from scratch: 

1. Select Maintenance > Templates > Note Templates. The Provider/Practice Selection screen 
appears.  
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2. Select the provider or practice you want to add a template for, or leave the Provider/Practice ID 
field blank to add a universal template.  
 
The Allow QuickText and Templates by Practice setting on the Special Features screen defines 
whether you can add a template for individual providers or individual practices. 

3. Click the OK button.  
• If no templates exist for the specified provider, you are asked if you would like to create a 

new template. Click the Yes button. The Note Templates screen appears.  

• If templates exist, the Template Lookup screen displays a list of templates. Click the New 
button. If you are adding a template for a provider, the Note Templates screen appears. If 
you are adding a template for all provides, the Universal Note Templates screen appears.  

4. Enter the template. As you enter text, you can format the text and insert QuickText, procedure 
codes, and much more. 

5. When you finish, click the OK button. The Enter Template name screen appears.  

6. In the Name field, type a name for the new template.  

7. Click the OK button.  

To use a progress note to create a note template: 

1. Open the note that you want to use.  

2. Highlight the entire note to select it and select Edit > Copy (you can also press CTRL+A to 
highlight the note and then press CTRL+C to copy it).  

3. Close the note, and the patient chart.  

4. Select Maintenance > Templates > Note Templates. The Provider/Practice Selection screen 
appears.  

5. Select the provider for whom you want to add a template, or leave the Provider ID field blank to 
add a universal template.  

6. Click the OK button.  
• If no templates exist for the specified provider, you are asked if you would like to create a 

new template. Click the Yes button. The Note Templates screen appears.  

• If templates exist, the Template Lookup screen displays a list of templates. Click the New 
button. The Note Templates screen appears.  

7. Select Edit > Paste, or press CTRL+V, to paste the note into the template.  

8. Make any necessary changes.  

9. Click the OK button.  

To change a note template: 

1. Select Maintenance > Templates > Note Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice whose templates you want to view, or leave the 
Provider/Practice ID field blank to view universal templates.  

3. Click the OK button. The Template Lookup screen appears. This screen displays all existing 
note templates.  

4. Highlight the template you want to view. If you want to find the template quickly, enter the 
template code in the Name field and the closest match will be selected in the table.  
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5. Click the OK button, or double-click the template. The Note Templates screen appears.  

6. To edit the template, click the Edit button and make the necessary changes.  

7. When you finish, click the OK button.  

To delete a note template: 

1. Select Maintenance > Templates > Note Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice whose template you want to delete, or leave the 
Provider/Practice ID field blank to delete a universal template.  

3. Click the OK button. The Template Lookup screen appears. This screen displays all existing 
note templates.  

4. Highlight the template you want to delete. If you want to find the template quickly, enter the 
template code in the Name field and the closest match will be selected in the table.  

5. Click the OK button, or double-click the template. The Note Templates screen appears.  

6. Select Edit > Delete Note. A message asks you to confirm the deletion.  

7. Click the OK button.  

Formatting toolbar, buttons, and the Insert menu 
Field Description 

Format toolbar This toolbar provides standard text formatting tools.  

 Select the font that you want to use in the template. 
Your system administrator can use settings in the 
ppart.ini file to define which fonts are available in the 
list. 

 Select the font size. Your system administrator can use 
settings in the ppart.ini file to define which font sizes are 
available in the list. 

 
Indicate whether you want text in the template to be 
bolded (B), italicized (I), or underlined (I). 

 
Indicate whether the text should be aligned with the left 
margin, centered, aligned with the right margin, or 
justified (text lines up with both the left and right 
margins). 

 
Indicate whether text should be bulleted. 

 
Indicate whether text should be indented five spaces 
toward the right margin, or moved five spaces toward 
the left margin. 
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Select the size at which you want to view the text. 

 

Buttons 

QText Insert QuickText. You can also insert QuickText by selecting Insert > QuickText. 

Temp Insert a note template. You can also insert a template by selecting Insert > 
Template. 

Proc Insert a procedure code. You can also insert a code by selecting Insert > Procedure 
Code. 

Pb/Dx Insert a problem/diagnosis code (you can select from a list of all problem/diagnosis 
codes). You can also insert a code by selecting Insert > Problem/Diagnosis Code. 

QT Auto This button works like the TAB and F10 keys, but it also lets you quickly merge 
QuickText that are built into the labels of templates. 
When you click the QT Auto button, the cursor jumps to the next label. If the current 
label marker has an embedded QuickText item name, the item name is replaced 
with the associated QuickText. If part of the QuickText item name is embedded, 
Patient Records displays a QuickText picklist starting with that partial name. You can 
select the item from the list. 
Once the embedded text is inserted, the cursor then moves on to the next label.  
If you pressed TAB or F10 to reach a label, you can also press ALT+N to insert the 
QuickText associated with an embedded item name. 

QT Ed Test your label markers. When this button is clicked your cursor will move to the 
next label marker in the template. The Insert Quick Text screen will be displayed 
with QuickText options to select from when QuickText item names (or partial 
names) in «*» label markers are encountered in the template. This screen allows you 
to select and replace the existing QuickText label marker with new QuickText.  

Print Print the template. 

Spelling Check spelling in the template. The spell checker is based on Stedman’s medical 
dictionary, and includes more than 500,000 English and medical words. You can 
also add words to the dictionary. Your system administrator will determine if the 
new words you add are shared among all users, or just specific to the workstation. 
If you have opened a new template or are editing an existing template, you can use 
the spell check feature to check the entire template for spelling errors. You can also 
limit the spell check to just one or more words by highlighting them before 
activating the spell check. 
You can also check spelling by pressing F7 or by selecting Edit > Check Spelling. 

Insert Table Insert a table. On the New Table Parameters screen, type the number of rows and 
number of columns for the table. 
You can also manage tables by selecting Edit > Table. From this menu, you can 
insert a table, insert a column, insert a row, and delete cells. 

EM Codes Insert an E&M label. You can also insert a label by selecting Insert > EM Label. 

Insert menu 

Page Break Insert a manual page break. In the note template, click where you want to start a 
new page. On the Insert menu, click Page Break. 

Template Insert a note template. You can also insert a template by clicking the Temp button. 

QuickText Insert QuickText. You can also insert QuickText by clicking the QText button. 

Procedure Code Insert a procedure code. You can also insert a code by clicking the Proc button. 
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Problem/Diagnosis 
Code 

Insert a problem/diagnosis code (you can select from a list of all problem/diagnosis 
codes). You can also insert a code by clicking the Pb/Dx button. 

QuickText at Label Insert QuickText at a label. 

Bookmark Insert a bookmark in a template when you want someone to jump to a particular 
location. For example, with shared templates, you can place a bookmark at the 
point in the template where the next provider should begin. The provider can then 
jump right to that point, instead of scrolling and searching manually. You can 
include bookmarks in templates or insert them as you write notes. 
You can find your bookmark(s) by selecting Edit > Find. The Find screen appears. 
Select the Bookmark radio button, and click OK. Your cursor will move to next 
bookmark in the note.   

Label Insert label characters wherever you want patient-specific data inserted. You can 
enter QuickText names within the label markers. For example, «macro».  
If you want to create a special label, move the cursor over the asterisk in the middle 
of the label. Then, enter the QuickText name or partial name, or «del», «*sex*», 
«*age*», or «*date*». A QuickText label could look like this: «NLFUNDI».  
In a note with these labels, age could be replaced by a value like 39 yr, and 
NLFUNDI by "Fundi are benign." If nothing followed the «del» label, the entire line 
would be deleted.  
You can also force the QuickText pick list to appear even when the QuickText entry 
is an exact match. To do that, follow the procedure above, and insert three periods 
(...) after you enter the QuickText item name. This label marker, with the embedded 
item name, becomes highlighted in red in a note or note template. Example: «item 
name...»  
If you want to change the current item name in a label marker, you need to edit the 
label marker in the note template.  
When you use the template, the TAB, F10 key or the QT Auto button will move the 
cursor directly to that label where you can then type in the appropriate text. Label 
markers include LINK and REQ. 

Image from File Insert an image from a file. From the Select Image File to Insert screen, browse to 
the existing image file. You can import BMP, WMF, GIF, TIF, and JPG formatted files. 
Click the Open button. The image file is displayed in the note template. If the image 
file is larger than one page, an automatic page break will be inserted, and the 
image file will be displayed on the next page. 

Linked File Insert a linked file. 

Patient Education 
link 

Insert a link to a Patient Education handout. 
These links are for use only with the Lytec MD Patient Education Module and make 
the Patient hand out links independent of any directory changes.  
The format for the ELINK is:   
ELINK: Display Title | PE Module | Handout Title 

Letter Template Insert a letter template. 

Page Setup 
Template 

Insert a page template. 

Sound File Insert a sound file. 

Record a Dictation Record a dictation. 

E&M Label Insert an E&M label. You can also click the EM Codes button. 
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Image templates 
With Patient Records’ drawing capabilities, you can create your own image templates. These templates 
can then be used in the Images section of the patient chart. 

You can also import digital images to Patient Records so they will be available as images or image 
templates. You can use commercial image collections, or you can scan images with a desktop or hand 
scanner. Images can be black and white or color. Some images, such as EKGs, are clearer in color if the 
tracing and grid are different colors. The file types supported by Patient Records are listed on the 
Import Image dialog box, which is available when you add a new image.  

You may need to experiment with adjusting the size of the scanned image. Once the image is saved as 
a file in one of the two formats, you can import the image to Patient Records.  

You can also create images freehand in much the same way as you would in any graphics application. 
You need a Microsoft or compatible mouse or a Lytec MD-approved light pen to add or revise images, 
although you can view images without a mouse. However, the left mouse button selects image tool bar 
items and activates features.  

Note for WTS and Citrix sites 
Due to Windows Terminal Services and Citrix limitations with vector-based graphics, you may 
experience a problem drawing curved lines. To solve this issue, we recommend slowing down the 
mouse movements, or drawing the image from a standalone workstation. 

Adding, editing, and deleting image templates 
You can add a template “from scratch” (by drawing the image using the image tools), by importing an 
existing image, and by copying and modifying an existing one.  

If you are adding an image to the patient chart, click here.  

To add an image template “from scratch”:  

1. Select Maintenance > Templates > Images Templates.  
• If an image template does not exist, you are asked if you would like to create a new 

template. Click the Yes button.  

• If a template exists, the Image Templates screen appears. Click the New button.  

2. On the Image Templates screen, draw the image.  
To use an item on the images tool bar, simply click it using the left mouse button. The mouse 
will perform the operation you select. When you want to switch items, just click the new tool bar 
item.  

3. When you finish, click the OK button.  

4. Click Yes to save the template. The Image: Save As screen appears.  

5. In the Name field, type a name for the new image template.  

6. Click the OK button.  

To add an image template by importing an existing image:  

1. Select Maintenance > Templates > Images Templates.  
• If an image template does not exist, you are asked if you would like to create a new 

template. Click the Yes button.  

• If a template exists, the Image Templates screen appears. Click the New button.  
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2. Select File > Import. The Import Image screen appears.   

3. Browse to the existing image file. You can import PCX, BMP, GIF, and TIF formatted files.  

4. Click the Open button. The image displays on the Image Templates screen.  

5. Make any necessary changes.  

6. When you finish, click the OK button.  

To add an image template by modifying an existing image template:  

1. Select Maintenance > Templates > Images Templates. The Image Templates screen appears.  

2. Highlight the template you want to copy.  

3. Click the Rename button. The Image: Save As screen appears.  

4. In the Name field, type a name for the new template.  

5. Click the OK button. The new template now displays on the Image Templates screen with the 
existing templates.  

6. To edit the new template, highlight it and click the OK button. Make the necessary changes.  

7. When you finish, click the OK button.  

To change an image template: 

1. Select Maintenance > Templates > Images Templates. The Image Templates screen appears.  

2. Highlight the template you want to view.  

3. Click the OK button, or double-click the template. The Image Templates screen appears.  

4. To edit the template, click the Edit button and make the necessary changes.  

5. When you finish, click the OK button.  

To delete a image template: 

1. Select Maintenance > Templates > Images Templates. The Image Templates screen appears.  

2. Highlight the template you want to delete.  

3. Click the Delete button. A message asks you to confirm the deletion.  

4. Click the OK button.  

Image tool bar options 
The image tool bar provides standard graphics options such as pen, ellipse, and line. To use an item on 
the images tool bar, simply click it using the left mouse button. The mouse will perform the operation 
you select. When you want to switch items, just click the new tool bar item. The table below describes 
the image tool bar options.  

Tool Description 

Pen  Draw images “free-hand” directly on your screen. Hold the left 
mouse button down.  

Eraser  Erases the image, pixel by pixel. Move the mouse pointer to the 
area you want to erase and hold down the left mouse button 
while you move the mouse.  
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Text  Enters text. Click the left mouse button where you want the line 
to begin, move the mouse pointer to where you want the line to 
end, and then release the left mouse button.  

Line  Draws a line. Hold down the left mouse button where you want 
the line to begin, move the mouse pointer to where you want 
the line to end, and then release the left mouse button.  

Ellipse  Draws an ellipse. Hold down the left mouse button and move 
the mouse pointer until the ellipse is the size you want. Then, 
release the mouse button.  

Rectangle  Draws a rectangle. Hold down the left mouse button and move 
the mouse pointer until the rectangle is the size you want. Then, 
release the mouse button.  

Fill Ellipse  Draws a filled elliptical area at the location of the mouse 
pointer.  

Fill Rectangle  Draws a filled rectangular area at the location of the mouse 
pointer.  
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Prescription Templates 

New prescription templates 
Prescription templates make writing prescriptions easier and faster. You can create universal templates 
that can be accessed by all providers, or you can create customized templates for individual providers. 
For provider-specific templates, your system administrator must mark the Store Templates by Provider 
check box on the Prescription Defaults screen.  

You can also save individual prescriptions as templates as you write them, which allows you to create 
additional templates quickly and conveniently.  

When creating a general prescription template, you can indicate the problems or diagnoses and the Rx 
type (for example, standard or authorization required) for which the template will be used.  

Adding, editing, and deleting prescription templates 
To open the prescription template screen: 

• Select Maintenance > Templates > Prescription Templates > New Prescription Templates. The 
Prescription Templates screen appears. This screen displays the prescription templates that have 
been added.  

Note: If the Select Provider screen appears, select the provider for whom you want to add a 
prescription template, or leave the field blank to create a universal template.  

To add a prescription template: 

• On the Prescription Templates screen, click the New button. Fill in the fields on this screen, then 
click the OK button. 

Note: To copy and modify an existing template, click the Copy Template button. On the Enter Code of 
Rx Template to Copy screen, type the code of the appropriate template or leave the field blank and 
click the OK button to select from a list of templates. After the original template's information displays 
on the Prescription Templates <New> screen, make any necessary changes. 

To view a prescription template: 

• On the Prescription Templates screen, highlight the prescription template that you want to view. 
Click the View button. When you finish, click the OK button. 

To change a prescription template: 

• On the Prescription Templates screen, highlight the prescription template that you want to 
change. Click the Edit button. Make the appropriate changes. When you finish, click the OK 
button. 

To delete a prescription template: 

• On the Prescription Templates screen, highlight the prescription template that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 
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To print a list of prescription templates: 

• On the Prescription Templates screen, click the Print All button. If the Windows Print screen 
appears, select the printer and click the OK button. 

Fields on the Prescription Template Maintenance screen 
Field Description 

Rx Template Code Type an ID for the new prescription template 

Rx Template Name Type a name for the template. 

Medication Enter the medication name (for example, AMOXICILLIN). You 
can also type the first few characters of the medication name, 
then tab out of this field. When a list of medications appears, 
select the appropriate medication and click the OK button. 
If you entered the correct medication name and the list 
appears, click the Drug OK button to use the medication you 
entered. 

Size Enter the pill size (e.g., 250 mg) or leave blank. 

Take Enter how many to take (e.g., 1 or 2) or leave blank 

Frequency Enter the frequency (e.g., tid, qid, etc.) or leave blank. 

PRN Select this check box for medications taken as needed.  
When this check box is selected, the letters 'prn' are displayed 
after the selected frequency in the Freq column of the 
Rx\Medications screen. 

Route Enter the route or leave it blank. 

Duration Enter the duration in days (e.g., 7, 10). For chronic medications, 
leave this blank or enter a hyphen. For prn medications, enter 
prn. 

Amount Enter the amount to dispense (e.g., 30, 60, or 6 0x, 1 bottle). 

Refills Enter the number of refills (e.g., 0, 1, 2, 3). 

Print Select how the prescription should be printed: Print locally 
immediately, Print remotely immediately, Print locally as a 
group, Print locally and fax as a group, Fax as a group, Print 
locally and remotely as a group, Print remotely as a group, 
Sample given, Do not print, or Was printed. 

Note Enter a note on the prescription or leave it blank. 

Pharmacy Enter the name of the pharmacy or leave it blank. 

Use Extended Sig Mark this check box to use an extended sig, which is free-form 
text for more complex medication instructions (e.g., for topical 
meds or prednisone tapers). Another screen prompts for 
details. 

Use Extended Sig Only Mark this check box to print only the extended sig, not the 
values for size, amount, etc. Make sure that the previous check 
box, Use Extended sig, is also selected.  

Use Patient Instructions Mark this check box to print patient instructions. Another screen 
prompts for patient instructions. 
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Limit Refills Mark this check box to display a ! or + next to the medication. 
When you refill the medication, a warning message appears. 

Substitution OK Mark this check box to permit substitution of generic 
medication. If the Rx configuration contains a %xsub, an X 
appears on the prescription in the desired location. 

Update Progress Note Mark this check box to update the progress note with the Rx. 

Drug Interaction Check Mark this check box to check for drug interactions. 
When a provider uses the template to write a prescription and 
the Drug Interaction Check option is marked, if there is a 
possible drug interaction, the Drug Interaction screen appears 
with a summary of the drug interaction. The provider can click 
the Mono button to get a more detailed report about the drug 
interaction.  

Allergy Check Mark this check box to check for allergies. 
When a provider uses the template to write a prescription and 
the Allergy Check option is marked, if there is a possible allergy 
or drug intolerance, the Allergy/Intolerance Reaction screen 
appears with a summary of the possible reactions. The provider 
can click the Mono button to get a detailed monograph about 
the drug interaction.  

General Formulary This check box displays only when you are adding a universal 
template. By default, it is marked so that this template displays 
in the General Formulary table on the Select Rx Template 
screen. If you unmark this check box, you will not be able to 
select the Rx Type and Indications. Rx templates that are not 
part of the General Formulary can be used only for insurance-
specific or specialty-specific formularies.  

OTC Use to indicate that this is an over the counter drug, thus a 
prescription is not required.  

Actual Total The Wholesale and Generic fields display information from the 
formulary. To change the wholesale total, type the actual total 
amount of the medication in this field. 

Alternative To view a list of alternative drugs in the same class as the one 
you are prescribing, click the Alternative button. Patient 
Records displays all drugs in the Drug Interaction database that 
are in the same class as the drug entered in the medication 
field, along with their costs. To use one of the alternative 
medications, highlight the medication that you want, and click 
the OK button. When you display drug alternatives, Patient 
Records only displays drugs with the same route. To use Route, 
enter a two-letter abbreviation (for example OR for oral or IN for 
inhalation). To view all routes, leave the Route field blank. 

Rx Type If you want to indicate the Rx Type and a message for this new 
template, click this button.  
For the Rx Type, you can select standard, preferred, or requires 
authorization. These three types can be used according to the 
definition set by your practice. For insurance-specific Rx Types, 
use the Insurance formulary.  
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Indications If you want to indicate the problems or diagnoses for which the 
template will be used, click this button. On the Indications for 
Rx Template screen, enter the indications for this template.  
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Extended Sig Templates 
A complicated prescription may be written by providers through the use of a extended sig template. 
Use the Extended SIG screen to add or modify an extended sig template.  

Adding, editing, and deleting Extended Sig Templates 
To open the Extended SIG screen: 

• Select Maintenance >Templates > Prescription Templates > Extended Sig Templates. The 
Extended SIG screen appears.  

To add an extended sig template: 

1. On the Extended SIG screen, click the New button. The Edit Extended SIG <New> screen 
appears. 

2. Type a template code in the Code field and a template name in the Name field. The same 
code and name for the corresponding prescription template may be used. 

3. Type the rest of the patient instruction information in the Description field. 

4. When finished, click the OK button, then click Cancel.   

Note: If the patient instruction template code is the same as the prescription template code, the 
Extended SIG screen will not display when writing the prescription and this extended sig will be 
included. To review an extended sig template before inclusion, give the template a different code than 
the prescription template.  

To change a extended sig template: 

• On the Extended SIG screen, click the Edit button. The Edit Extended SIG <Edit> screen 
appears. Make the appropriate changes. When you finish, click the OK button. 

To delete an extended sig template: 

• On the Extended SIG screen, highlight the template that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 
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Patient Instructions 
A patient may receive instructions for a prescription through the use of a patient instruction template. 
Use Patient Instructions to add or modify a patient instruction template.  

Enter patient instructions directly into the template, or specify a text (ASCII) file that has the text of the 
patient instructions. Create a text file with any word processor that can save text in this format.  

Adding, editing, and deleting patient instruction templates 
To open the Patient Instructions: 

1. From the Maintenance menu, point to Templates, then Prescription Templates.  

2. Click Patient Instruction Templates. Patient Instructions displays.  

To view a patient instruction template: 

1. On Patient Instructions, click View. Patient Instructions <View> displays. 

2. To locate a specific template, type all or part of the code in Template code, then click Lookup. 
If necessary, click Next or Prior to locate the template to be viewed.  

3. When finished, click OK, then click Cancel.  

To add a patient instruction template by typing the information: 

1. On Patient Instructions, click New. Patient Instructions <New> displays. 

2. In Add using template code, type an ID for a template upon which to base the new patient 
instruction template. To display a list of templates, type the first few letters of the template ID, 
then press TAB. 

3. Type a Template code and Template name for the new patient instruction template. The 
same code and name for the corresponding prescription template may be used. 

4. Type the rest of the patient instruction information in the or type below box. 

5. When finished, click OK, then click Cancel.  

Note: If the patient instruction template code is the same as the prescription template code, Patient 
Instructions will not display when writing the prescription and those patient instructions will be 
included. To review a patient instruction template before inclusion, give the template a different code 
than the prescription template.  

To add a patient instruction template using a text file: 

1. On Patient Instructions, click New. Patient Instructions <New> appears.  

2. In Add using template code, type an ID for a template upon which to base the new patient 
instruction template. To display a list of templates, type the first few letters of the template ID, 
then press TAB. 

3. Type a Template code and Template name for the new patient instruction template. The 
same code and name for the corresponding prescription template may be used. 

4. Type the entire path to the file in Use file. The file must reside in the Patient Records data 
directory (for example, p:\ppart\patinst.txt).  

5. When finished, click OK, then click Cancel.  
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To change a patient instruction template: 

1. On Patient Instructions, click Edit. Patient Instructions <Edit> displays. 

2. To locate a specific template, type all or part of the code in Template code, then click Lookup. 
If necessary, click Next or Prior to locate the template to be edited.  

3. Make the changes to the template.  

4. When finished, click OK, then click Cancel.  

To delete a patient instruction template: 

1. On Patient Instructions, click Delete. Patient Instructions <Delete> displays. 

2. To locate a specific template, type all or part of the code in Template code, then click Lookup. 
If necessary, click Next or Prior to locate the template to be edited.  

3. Click OK. A confirmation displays.  

4. When finished, click OK, then click Cancel.  

To print a list of patient instruction template: 

• On Patient Instructions, click Print. 
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Medication note templates 
You can create a template for medication notes. The medication notes template is a free-form text 
window where you can enter any information you want about a medication (for example, pharmacy 
name, address, telephone, or fax number). The note can be displayed on the patient chart's 
Rx/Medications tab. You can create only one medication notes template.  

Adding, editing, and deleting medication note templates 
To add or edit the medication note template: 

1. Select Maintenance > Templates > Prescription Templates > Medication Note Template. 
• If a medication note template does not exist, you are asked if you would like to create a 

new template. Click the Yes button. The Rx/Medication Notes screen appears.  

• If a template exists, the Rx/Medication Notes screen appears. Click the Edit button.  

2. Enter the template. For example, you can:  
• Type text.  

• Insert Dot and letter codes. Select Insert > QuickText, or click the QText button on the 
tool bar.  

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  

3. When you finish, click the OK button to save the template.  

To delete the medication note template: 

1. Select Maintenance > Templates > Prescription Templates > Medication Note Template. The 
Rx/Medication Notes screen appears.  

2. Select Edit > Delete Note. A message asks you to confirm the deletion. 

3. Click the OK button.  
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Formulary for insurance 
Insurance formularies are lists of medication templates that insurance carriers have approved. They can 
save you time when writing a prescription by displaying only the medications approved by the patient’s 
account insurance plan. 

As insurance carriers approve new items for the formularies, you can update the list of insurance 
formularies in the Formulary For Insurance dialog box. This dialog box displays the Rx type, template 
code, name, insurance cost, wholesale cost, message, and indications. For the Rx type, you can assign 
Standard, Preferred, or Requires Authorization. In the message field, you can enter a message that 
appears in the Lookup screen. In addition, whenever you enter the template code exactly for an Rx 
requiring authorization, a popup window will appear with the message. An indication is a description of 
the patient’s problem or diagnosis. An indication code followed by three periods (...) means more than 
one indication is intended. 

In addition to insurance formularies, you can create formularies for provider specialties. You can also 
import formularies through the optional InfoScan Formulary Database. 

Adding, editing, and deleting insurance formularies 
To open the insurance formulary screen: 

1. Select Maintenance > Templates > Prescription Templates > Formulary for Insurance. The Enter 
Insurance Carrier ID screen appears. 

2. Select the insurance carrier whose formulary you want to view.  

3. Click the OK button. The Formulary screen appears. This screen lists all prescription templates 
for the insurance carrier you selected. 
 
This screen displays the code, name, insurance code, message, and other information that has 
been added for each template in the formulary.  
 
If you are using the optional InfoScan Formulary Database, the User column indicates whether 
the prescription is the original InfoScan template (“O”), has been modified since it was 
imported (“M”), or has been added from scratch (“U”). 

To view medication templates in the insurance formulary: 

1. On the Formulary screen, highlight the template that you want to view. 
 
You can also enter a code in the Template Code field and click the Search button. The closest 
match for the code will be selected in the table.  

2. Click the View button. The Rx Template Info screen appears. This screen displays the type, any 
message, and insurance cost. 

To copy all medication templates from another formulary: 

1. On the Formulary screen, click the Copy All button. The Copy All From screen appears.  

2. Mark the appropriate radio button and click the OK button.  
• Universal Provider – copies universal provider templates  

• Insurance Carrier – copies an insurance carrier’s templates  

• Specialty – copies a provider specialty’s templates  
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3. If you marked either the Insurance Carrier or Specialty option, a screen for that option appears. 
Enter an ID and click the OK button.  

4. The templates from the option you selected are copied to the specialty’s list of formularies.  

To add a medication template to the insurance formulary: 

1. On the Formulary screen, click the New button. The Select Rx Template screen appears. 

2. Highlight the template that you want to use. You can also enter a code in the Template Code 
field and click the Search button. The closest match for the code will be selected in the table. 

3. Click the OK button. The Rx Template Info screen appears. The Template Code and Name 
display onscreen. 

4. In the Rx Type field, select the prescription’s type (standard, preferred, or requires 
authorization). 

5. To add an optional message, type the text in the Message field. 

6. To add an optional insurance cost, type the number in the Ins Cost field.  

7. When you finish, click the OK button. The new formulary item appears on the Formulary screen. 

To change a medication template in the insurance formulary: 

1. On the Formulary screen, highlight the insurance formulary that you want to change. You can 
also enter a code in the Template Code field and click the Search button. The closest match for 
the code will be selected in the table.  

2. Click the Edit button. Make the appropriate changes.  

3. When you finish, click the OK button. 

To delete a medication template in the insurance formulary: 

1. On the Formulary screen, highlight the insurance formulary that you want to delete. You can 
also enter a code in the Template Code field and click the Search button. The closest match for 
the code will be selected in the table.  

2. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Using indications 
Indications describe the patient’s problem or diagnosis. Using indications allows you to select 
medications based on problem or diagnosis. You can add multiple indications to a medication 
template in a formulary. 

Note: You can also add indications by clicking the Indications button on the prescription template 
screen. 

To open the indications screen from the formulary: 

1. On the Formulary screen, highlight the appropriate medication template. 

2. Click the Indications button. The Indications for Rx Template screen appears. 

To add an indication to a formulary's medication template: 

1. On the Indications for Rx Template screen, click the New button. The Insert Problem/Diagnosis 
Code screen appears. 
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2. Highlight the appropriate diagnosis and click the OK button. The Indication for Rx Template 
screen appears. 

Note: You can search for the diagnosis by marking the Code, Short Description, or Long Description 
radio button. Then type the code or description and click the Search button. The diagnosis that most 
closely matches the code or description will be selected in the table. 

3. In the Rx Type field, select the prescription’s type (standard, preferred, or requires 
authorization). 

4. To add an optional message, type the text in the Message field. 

5. Click the OK button. You return to the Indications for Rx Template screen. The new indication 
displays on this screen. 

To change an indication for a formulary's medication template: 

• On the Indications for Rx Template screen, highlight the indication that you want to change. Click 
the Edit button. You can change the Rx Type or Message. When you finish, click the OK button. 

To delete an indication for a formulary's medication template: 

• On the Indications for Rx Template screen, highlight the indication that you want to delete. Click 
the Delete button. A message asks you to confirm the deletion. Click the OK button. 
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Formulary for specialty 
Specialty formularies are lists of medication templates that are specific to provider specialties. They can 
save you time when writing a prescription by displaying only the medications used by the specialty. 

As new items for the specialty formularies are approved, you can update the list of specialty formularies 
on the Formulary for Specialty screen.  This screen displays the Rx type, template code, name, specialty 
cost, wholesale cost, message, and indications. For the Rx type, you can assign Standard, Preferred, or 
Requires Authorization. In the message field, you can enter a message that appears in the Lookup 
screen. In addition, whenever you enter the template code exactly for an Rx requiring authorization, a 
popup window will appear with the message. An indication is a description of the patient’s problem or 
diagnosis. An indication code followed by three periods (...) means more than one indication is 
intended. 

In addition to specialty formularies, you can create formularies for insurance carriers. You can also 
import formularies through the optional InfoScan Formulary Database. 

Adding, editing, and deleting specialty formularies 
To open the specialty formulary screen: 

1. Select Maintenance > Templates > Prescription Templates > Formulary for Specialty. The Enter 
Specialty ID screen appears. 

2. Select the specialty whose formulary you want to view.  

3. Click the OK button. The Formulary screen appears. This screen lists all prescription templates 
for the specialty you selected. 
 
This screen displays the code, name, specialty code, message, and other information that has 
been added for each template in the formulary.  
 
If you are using the optional InfoScan Formulary Database, the User column indicates whether 
the prescription is the original InfoScan template (“O”), has been modified since it was 
imported (“M”), or has been added from scratch (“U”). 

To view medication templates in the specialty formulary: 

1. On the Formulary screen, highlight the template that you want to view. 
 
You can also enter a code in the Template Code field and click the Search button. The closest 
match for the code will be selected in the table.  

2. Click the View button. The Rx Template Info screen appears. This screen displays the type, any 
message, and specialty cost. 

To copy all medication templates from another formulary: 

1. On the Formulary screen, click the Copy All button. The Copy All From screen appears.  

2. Mark the appropriate radio button and click the OK button.  
• Universal Provider – copies universal provider templates  

• Insurance Carrier – copies an insurance carrier’s templates  

• Specialty – copies a provider specialty’s templates  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 186 

 

3. If you marked either the Insurance Carrier or Specialty option, a screen for that option appears. 
Enter an ID and click the OK button.  

4. The templates from the option you selected are copied to the specialty’s list of formularies.  

To add a medication template to the specialty formulary: 

1. On the Formulary screen, click the New button. The Select Rx Template screen appears. 

2. Highlight the template that you want to use. You can also enter a code in the Template Code 
field and click the Search button. The closest match for the code will be selected in the table. 

3. Click the OK button. The Rx Template Info screen appears. The Template Code and Name 
display onscreen. 

4. In the Rx Type field, select the prescription’s type (standard, preferred, or requires 
authorization). 

5. To add an optional message, type the text in the Message field. 

6. To add an optional specialty cost, type the number in the Ins Cost field.  

7. When you finish, click the OK button. The new formulary item appears on the Formulary screen. 

To change a medication template in the specialty formulary: 

1. On the Formulary screen, highlight the specialty formulary that you want to change. You can 
also enter a code in the Template Code field and click the Search button. The closest match for 
the code will be selected in the table.  

2. Click the Edit button. Make the appropriate changes.  

3. When you finish, click the OK button. 

To delete a medication template in the specialty formulary: 

1. On the Formulary screen, highlight the specialty formulary that you want to delete. You can 
also enter a code in the Template Code field and click the Search button. The closest match for 
the code will be selected in the table.  

2. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Using indications with specialty formularies 
Indications describe the patient’s problem or diagnosis. Using indications allows you to select 
medications based on problem or diagnosis. You can add multiple indications to a medication 
template in a formulary. 

To open the indications screen: 

1. On the Formulary screen, highlight the appropriate medication template. 

2. Click the Indications button. The Indications for Rx Template screen appears. 

To add an indication to a formulary's medication template: 

1. On the Indications for Rx Template screen, click the New button. The Insert Problem/Diagnosis 
Code screen appears. 

2. Highlight the appropriate diagnosis and click the OK button. The Indication for Rx Template 
screen appears. 
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Note: You can search for the diagnosis by marking the Code, Short Description, or Long Description 
radio button. Then type the code or description and click the Search button. The diagnosis that most 
closely matches the code or description will be selected in the table. 

3. In the Rx Type field, select the prescription’s type (standard, preferred, or requires 
authorization). 

4. To add an optional message, type the text in the Message field. 

5. Click the OK button. You return to the Indications for Rx Template screen. The new indication 
displays on this screen. 

To change an indication for a formulary's medication template: 

• On the Indications for Rx Template screen, highlight the indication that you want to change. Click 
the Edit button. You can change the Rx Type or Message. When you finish, click the OK button. 

To delete an indication for a formulary's medication template: 

• On the Indications for Rx Template screen, highlight the indication that you want to delete. Click 
the Delete button. A message asks you to confirm the deletion. Click the OK button. 
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Letter templates 
Using letter templates, like using note templates, can save you time when you are writing a letter. You 
can use the letter templates that are included in the program or you can create your own.  

You can store letter templates for a specific provider or practice (depending on the Allow QuickText 
and Templates by Practice setting on the Special Features screen), or "universally" for all 
providers/practices. 

You can also create page templates to customize how your letter looks when it is printed. A page 
template allows you to set the page margin, and set the font and size of the text. Once you create a 
page template, you can insert it into a letter or letter template.  

Using conditional logic in a letters and notes 
Using the "Conditional Logic" feature, you can embed algorithmic (IF-THEN-ELSE) logic in your Letter 
and Note templates so that the content is tailored to data in the patient’s record and elsewhere in your 
database. Conditional logic evaluates specific statements to be either “true” or “false”, inserts text into 
your letter or note based upon whether the statements are true or not.  

The following conventions will be used in describing the conditional logic syntax:  

• <letter code> : any of the letter codes 

• <comparison operator> : any of the following symbols used to compare values: =,<>,<,<=,>,>=  

• <string> : any string; must be surrounded by double straight quotes ("")  

• <compare value> : either a <string> or a <letter code>  

• <logical operator> : AND or OR 

• <condition> : The combination of <letter code> <comparison operator> <compare value> in 
that order 

• <output> : any combination of text, letter codes, and conditions; will appear or not appear in the 
note or letter based on whether the preceding IF or ELSE clause evaluates to “true” or “false”. 
When a Template or Quick Text that includes a Conditional Logic statement is inserted into a 
letter or note, the Conditional Logic statement is replaced by whatever output is dictated by the 
logic of the statement. 

• [Brackets] below denote optional content 

Every Conditional Logic statement must begin and end with double pipes (“||”). 

The basic structure of a Conditional Logic statement is:  

|| 

IF <condition> [<logical operator> <condition>] 

{<output>} 

[ELSE {<output>}] 

|| 

 

Notes: 
- Leading spaces or tab characters and extra line breaks are allowed and will not affect the function of a 
Conditional Logic statement. They may make it easier to compose and edit Conditional Logic 
statements. 
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- The words IF, ELSE, AND, and OR must be capitalized and are reserved for use in conditional 
statements. 
 
- Spaces are required before and after comparison operators and logical operators, as well as the word 
ELSE. You do not need to include a space at the beginning of a line, or if an operator is proceeded by a 
brace (i.e., {).  
 
- You can combine multiple AND phrases or multiple OR phrases together within a single IF or ELSE 
clause. However, you cannot combine AND and OR terms together within a single IF or ELSE clause. 
For example: 
 
Allowed: 
||IF PAT_CITY = "SEATTLE" AND PAT_AGE > "40" AND PAT_AGE < "85" 
{The patient is a Seattleite in the prime of life}|| 
 
Not Allowed: 
||IF PAT_CITY = "SEATTLE" AND PAT_AGE < "40" OR PAT_AGE > "85 
{The patient is a Seattleite but not in the prime of life}|| 

The following Conditional Logic statement inserts text to indicate whether or not a patient is eligible for 
a certain surgery. 

||We hereby notify you that your elective surgery  
 
IF PAT_AGE < "40"  
 
{is not covered for  
 
IF PAT_SEX = "male" {males}  
 
ELSE {females}  
 
of your age.}  
 
ELSE  
 
{IF PAT_SEX = "male" {is not available.}  
 
ELSE {is covered.}}||  

This example statement is of the form IF {IF-ELSE} ELSE {IF-ELSE}. The braces {} are used to delimit the 
scope of the IF and ELSE clauses.  

The example statement above would result in the following text for a 39-year-old male patient, “We 
hereby notify you that your elective surgery is not covered for males of your age.”  

For a 45-year-old female patient, the example statement would produce the following text, "We hereby 
notify you that your elective surgery is covered."  

Note: When using the PAT_SEX letter code in a conditional statement of a letter template, use the 
string “male” or “female” (using lowercase letters) instead of using “M” or “F” (as indicated in the “Sex” 
field of the Patient screen).  

Operators that you can include in conditional statements are: equal (=), not equal (<>), less than (<), 
less than or equal (<=), greater than (>), and greater than or equal (>=). In addition, you can also use 
the logical operators AND and OR.  
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Empty strings can also be used in conditional statements, to determine when particular data is not 
present. Use double quotes ("") to indicate an empty string. The following is an example:  

||IF LAB<Iron>[=TodaysDate] = "" {You did not have a lab Iron today.}  
 
ELSE {You had a lab Iron today.}||  

If the patient did not have a lab Iron performed today, then an empty string would be returned for that 
patient and the string, "You did not have a lab Iron today." would be displayed on the letter. If the 
patient did have a lab Iron performed, a string such as “Iron: 100” would be returned and the string, 
"You had a lab Iron today." would be displayed on the letter.  

Carriage returns are automatically removed from output clauses. You can, however, use the <BR> letter 
code to insert line breaks into the output of the IF-ELSE clause. For example:  

||IF LAB<Iron>[=TodaysDate] = "" {You did not have a lab Iron today.} 
 
ELSE {You had a lab Iron today. <BR>  
 
<BR>  
 
Results: LAB<Iron>[-Date]}||  

If the patient did have a lab Iron performed, the example statement above would display the following 
text on the letter:  

You had a lab Iron today.  

Results: Iron: 100 on 12/29/06  

The second line displays the results of today’s test, if today’s date is 12/29/06.  

Important: If you paste conditional logic into Patient Records from another source (for example, from 
Microsoft Word or from an e-mail message), make sure that the logic uses straight quotes (" ") instead 
of curly/smart quotes ( ). Templates that include curly quotes will not work correctly.  

Adding, editing, and deleting letter templates 
You can add a letter template from scratch, or use a letter to create a letter template. 

To add a letter template from scratch: 

1. Select Maintenance > Templates > Letter Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice you want to add a template for, or leave the Provider/Practice ID 
field blank to add a universal template.  
 
The Allow QuickText and Templates by Practice setting on the Special Features screen defines 
whether you can add a template for individual providers or individual practices. 

3. Click the OK button.  
• If no templates exist for the specified provider, you are asked if you would like to create a 

new template. Click the Yes button. The Letter Templates screen appears.  

• If templates exist, the Template Lookup screen displays a list of templates. Click the New 
button. If you are adding a template for a provider, the Letter Templates screen appears. 
If you are adding a template for all provides, the Universal Letter Templates screen 
appears.  
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4. Enter the template. You can:  
• Type text.  

• Insert letter codes. Select Insert > QuickText, or click the QText button on the tool bar. 
The Insert QuickText screen appears. Mark the Letter Code radio button. In the table, 
highlight the QuickText item that you want to insert. Click the Insert button.  

• Insert Dot codes. Select Insert > QuickText, or click the QText button on the tool bar. The 
Insert QuickText screen appears. Mark the Dot Code radio button. In the table, highlight 
the QuickText item that you want to insert. Click the Insert button.  

• Insert procedure codes. Select Insert > Procedure Code, or click the Proc button in the 
tool bar.  

• Insert diagnosis/problem codes. Select Insert > Problem/Diagnosis Code, or click the 
Pb/Dx button in the tool bar. 

• Insert bookmarks. Select Insert > Bookmark. Later, when you create a note with this 
template, you can search on this bookmark. You can find your bookmark(s) by selecting 
Edit > Find. The Find screen appears. Select the Bookmark radio button, and click OK. 
Your cursor will move to next bookmark in the note.   

• Insert permanent hyperlinks. 

• Insert links to Patient Education handouts. Select Insert > Patient Education Link. You can 
select by module title or code. The handouts associated with the title or code you select 
display in the box. Highlight the appropriate handout, and click the OK button. 

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  
 
If you want to create a special label, move the cursor over the asterisk in the middle of the 
label. Then, enter the QuickText name or partial name, or «del», «*sex*», «*age*», or 
«*date*». A QuickText label could look like this: «NLFUNDI».  
 
In a letter with these labels, age could be replaced by a value like 39 yr, and NLFUNDI by 
"Fundi are benign." If nothing followed the «del» label, the entire line would be deleted.  
 
You can also force the QuickText pick list to appear even when the QuickText entry is an 
exact match. To do that, follow the procedure above, and insert three periods (...) after 
you enter the QuickText item name. This label marker, with the embedded item name, 
becomes highlighted in red in a template. Example: «item name...»  
 
If you want to change the current item name in a label marker, you need to edit the label 
marker in the template.  
 
When you use the template, the TAB, F10 key or the QT Auto button will move the cursor 
directly to that label where you can then type in the appropriate text. Label markers 
include LINK and REQ. 

5. When you finish, click the OK button. The Enter Template name screen appears.  

6. In the Name field, type a name for the new template.  

7. Click the OK button.  

To use a letter to create a letter template: 

1. Open the letter that you want to use.  

2. Highlight the entire letter to select it and select Edit > Copy (you can also press CTRL+A to 
highlight the letter and then press CTRL+C to copy it).  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 192 

 

3. Close the letter, and the patient chart.  

4. Select Maintenance > Templates > Letter Templates. The Provider/Practice Selection screen 
appears.  

5. Select the provider for whom you want to add a template, or leave the Provider ID field blank to 
add a universal template.  

6. Click the OK button.  
• If no templates exist for the specified provider, you are asked if you would like to create a 

new template. Click the Yes button. The Letter Templates screen appears.  

• If templates exist, the Template Lookup screen displays a list of templates. Click the New 
button. The Letter Templates screen appears.  

7. Select Edit > Paste, or press CTRL+V, to paste the letter into the template.  

8. Make any necessary changes.  

9. Click the OK button. 

To change a letter template: 

1. Select Maintenance > Templates > Letter Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice whose templates you want to view, or leave the 
Provider/Practice ID field blank to view universal templates.  

3. Click the OK button. The Template Lookup screen appears. This screen displays all existing 
letter templates.  

4. Highlight the template you want to view. If you want to find the template quickly, enter the 
template code in the Name field and the closest match will be selected in the table.  

5. Click the OK button, or double-click the template. The Letter Templates screen appears.  

6. To edit the template, click the Edit button and make the necessary changes.  

7. When you finish, click the OK button.  

To delete a letter template: 

1. Select Maintenance > Templates > Letter Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice whose template you want to delete, or leave the 
Provider/Practice ID field blank to delete a universal template.  

3. Click the OK button. The Template Lookup screen appears. This screen displays all existing 
letter templates.  

4. Highlight the template you want to delete. If you want to find the template quickly, enter the 
template code in the Name field and the closest match will be selected in the table.  

5. Click the OK button, or double-click the template. The Letter Templates screen appears.  

6. Select Edit > Delete Note. A message asks you to confirm the deletion.  

7. Click the OK button.  
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Letter Codes 
Letter codes work similarly to Dot codes. You can embed letter codes when you create a template so 
that when you write a letter, patient-specific information appears wherever you have inserted a letter 
code. These codes are listed on the Insert QuickText screen. In addition, you can also use letter codes 
when you create note templates.  

The following table displays the available letter codes and their descriptions.  

Letter code Description 

||BEST_EDC_BY_EST_GESTATION|| The estimated date of confinement based on the most 
recent estimated gestation date (Lytec MD assumes a 
gestation of 40 weeks for this formula) 
* See note about lab data test names you must add 
for this letter code. 

||BODY_MASS_INDEX|| Patient's BMI 

||BODY_SURFACE_AREA|| The patient's body surface area, calculated using the 
Mosteller Formula: 

 BSA (m2) =   square root of (height (cm) x 
weight (kg) / 3600) 

NEJM 317(17): 1098, 1987 

||CLINICALELEMENT<ce_name>||  Clinical Element Name 

||DATE|| Date 

||EDC_BY_CONCEPTION_DATE|| The estimated date of confinement, 266 days (38 
weeks) from the newest conception date 
* See note about lab data test names you must add 
for this letter code. 

||EDC_BY_LAST_MENSTRUAL_PERIOD|| The estimated date of confinement, 280 days (40 
weeks) from the last menstrual period 
* See note about lab data test names you must add 
for this letter code. 

||EDC_BY_US_GESTATION|| Calculates the estimated date of confinement based 
on the most recent estimated gestation (Lytec MD 
assumes a gestation of 40 weeks for this formula). For 
the purposes of this item, Estimated Gestation is the 
clinician’s best assessment of gestation on a given 
date based on all data (for example, LMP, Ultrasound, 
and Fetal Heart Tones). Estimated Gestation must be 
added to the lab data test names for this formula to 
work. If more than one is entered, the most recent one 
will be used. 
* See note about lab data test names you must add 
for this letter code. 

||GROWTH_VELOCITY|| Growth velocity 

||HM|| Last result for all of the patient's current health 
maintenance (HM) items 
||HM<hm_name>|| will retrieve the last result for the 
specified procedure 
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||HM[-Date]|| Last result and date completed for all of the patient's 
current health maintenance (HM) items 
||HM<hm_name>[-Date]|| will retrieve the last result 
and date completed for the specified procedure 

||HM[-UpToDate]|| All health maintenance procedure names that are up-
to-date for the patient 

||HM[-NotUpToDate]|| All health maintenance procedure names that are not 
up-to-date for the patient 

||LAB<lab_name>|| Laboratory Name (Lab)  

||LPNOTE|| Date Last Progress Note 

||PAT_ADDR1|| Patient's address line 1  

||PAT_ADDR2|| Patient's address line 2 

||PAT_ADDR3|| Patient's address line 3 

||PAT_AGE||  Patient's age  

||PATIENT_AGE_IN_MONTHS|| Patient's age in months 

||PATIENT_AGE_IN_YEAR_MONTHS|| Patient's age in years and months 

||PAT_BUS_PHONE||  Patient's work phone number 

||PAT_DOB||  Date of birth 

||PAT_CARRIER1_NAME||  Carrier 1 name 

||PAT_CARRIER2_NAME||  Carrier 2 name 

||PAT_CARRIER3_NAME|| Carrier 3 name 

||PAT_CARRIER4_NAME|| Carrier 4 name 

||PAT_CELL_PHONE|| Patient's cell phone number 

||PAT_CITY||  Patient's city 

||PAT_EMPLOYER||  Patient's employer 

||PAT_EXT_ID||  Patient's external ID 

||PAT_FNAME||  Patient's first name 

||PAT_HOME_PHONE||  Patient's home phone number 

||PAT_INS1_ID||  Patient's insurance 1 ID 

||PAT_INS2_ID||  Patient's insurance 2 ID 

||PAT_INS3_ID||  Patient's insurance 3 ID 

||PAT_INS4_ID||  Patient's insurance 4 ID 

||PAT_LAPPT|| Patient's last appointment 

||PAT_LNAME||  Patient's last name 

||PAT_LVISIT||  Patient's last visit 

||PAT_MI|| Patient's middle initial 

||PAT_PLAN1_NAME||  Patient's carrier plan 1 name 

||PAT_PLAN2_NAME|| Patient's carrier plan 2 name 

||PAT_PLAN3_NAME|| Patient's carrier plan 3 name 

||PAT_PLAN4_NAME|| Patient's carrier plan 4 name 
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||PAT_PROV_NAME||  Patient's default usual provider 

||PAT_SEX||  Patient's sex/gender 

||PAT_SSN||  Patient's Social Security Number  

||PAT_STATE|| Patient's state 

||PAT_ZIP||  Patient's ZIP Code 

||PERCENTILE_HEIGHT|| Patient's percentile -- height 

||PERCENTILE_WEIGHT|| Patient's percentile -- weight 

||PROGRESS_NOTE||  Last progress note 

||REFSRC1_ADDRESS_CITY|| Referring source 1's city 

||REFSRC1_ADDRESS_LINE1|| Referring source 1's address line 1 

||REFSRC1_ADDRESS_LINE2|| Referring source 1's address line 2 

||REFSRC1_ADDRESS_LINE3|| Referring source 1's address line 3 

||REFSRC1_ADDRESS_STATE|| Referring source 1's state 

||REFSRC1_ADDRESS_ZIP|| Referring source 1's ZIP Code 

||REFSRC1_EMAIL|| Referring source 1's e-mail 

||REFSRC1_GREET|| Referring source 1's greeting 

||REFSRC1_NAME_FIRST|| Referring source 1's first name 

||REFSRC1_NAME_LAST|| Referring source 1's last name 

||REFSRC1_NAME_SUFFIX|| Referring source 1's suffix 

||REFSRC1_PHONE_BUS|| Referring source 1's work phone number 

||REFSRC1_PHONE_CELL|| Referring source 1's cell phone number 

||REFSRC1_PHONE_FAX|| Referring source 1's fax number 

||REFSRC1_PHONE_HOME|| Referring source 1's home phone number 

||REFSRC1_PHONE_PAGER|| Referring source 1's pager number 

||REFSRC1_SPEC1|| Referring source 1's specialty code 1 

||REFSRC1_SPEC2|| Referring source 1's specialty code 2 

||REFSRC1_SPEC3|| Referring source 1's specialty code 3 

||REFSRC1_SPEC4|| Referring source 1's specialty code 4 

||REFSRC1_SPEC5|| Referring source 1's specialty code 5 

||REFSRC1_SPEC6|| Referring source 1's specialty code 6 

||REFSRC1_SPEC7|| Referring source 1's specialty code 7 

||REFSRC1_SPEC8|| Referring source 1's specialty code 8 

||REFSRC1_SPEC9|| Referring source 1's specialty code 9 

||REFSRC1_SPEC10|| Referring source 1's specialty code 10 

||REFSRC1_TYPE|| Referring source 1's type 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 196 

 

Note on additional referring sources To add information for up to 4 referring sources, 
change the "1" in the letter codes to "2," "3," or "4." 
For example, REFSRC2_PHONE_FAX is referring 
source 2's fax number and REFSRC4_NAME_FIRST is 
referring source 4's first name. 

||STD_DEV_HEIGHT|| Patient's standard deviation - height 

||STD_DEV_WEIGHT|| Patient's standard deviation - weight 

||TIME|| Time 

||VITAL<vital_name>||  Vital Sign Name 

||VITAL_BPDIA||  Diastolic 

||VITAL_BPSYS||  Systolic  

||VITAL_HGT||  Height  

||VITAL_OFC|| OFC 

||VITAL_OTHER||  Other vitals 

||VITAL_OXIMETRY|| Oximetry 

||VITAL_PULSE||  Pulse 

||VITAL_RESP|| Respirations 

||VITAL_TEMP||  Temperature  

||VITAL_WGT||  Weight  

||WEEKS_GESTATION|| The weeks of gestation based on the date of the visit 
(as indicated in a lab or flow chart) and, if present: 

 The estimated date of confinement by 
estimated gestation. If not present, then: 

 The estimated date of confinement by 
conception date. If not present, then: 

 The estimated date of confinement by 
ultrasound. If not present, then: 

 The estimated date of confinement by LMP.  
* See note about lab data test names that must be 
added for this letter code. 

<BR>  Line break 

Manually Adding Letter Codes to Templates  
You can manually add letter codes to letter templates. Type the letter code, and enclose the code 
between two pairs of vertical bars: || and ||. For example, to include the patient’s last name, type: 
||PAT_LNAME||. Vertical bars can surround more than a single code entry.  

If you select either HM<hm_name> or LAB<lab_name>, the actual name of the health maintenance or 
the lab and its value will be inserted into the text. For example, if you type: ||LAB<Bacteria>|| in the 
letter template, the letter will display: Bacteria: XX, where XX is the value of the lab data.  

In addition to letter codes, you can also use filtering attributes. Date filtering attributes available are:  

• =SpecificDate:CCYYMMDD (for specific date, where CCYYMMDD is the format for the date)  

• =LastVisitDate (for last visit)  
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• =TodaysDate (for today’s date)  

By using date filtering attributes, you can check whether data is available for a specific date for a 
specific lab, vital sign, or health maintenance. When using filtering attributes, enclose them with 
brackets: [ ].  

For example, if you type: ||LAB<Iron>[=TodaysDate]|| in your template, the letter will display “Iron: 
10”. This means that there was a lab of iron with a value of 10 performed today for the patient.  

Output attributes can also be used to display data available for a patient. Output attributes available 
are:  

• Name  

• Date  

• Value  

• Status  

• Range  

• Units  

Vital signs can have name, date, and value outputs. Labs can have name and date outputs. Health 
Maintenance can have name, value, and date outputs. When using output attributes, enclose them with 
brackets [ ].  

For example, if you type: ||LAB<Iron>[-Date]|| in your template, "Iron: 10 on 12/31/97" displays on the 
letter. This means that there was a lab of iron with a value of 10 performed on 12/31/97 for the patient.  
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Page templates 
You can create page templates to customize how your letters (created from letter templates) look when 
they are printed. A page template allows you to set the page margins, and set up custom headers and 
footers with your choice of font and font size as well as image. Once you create a page template, you 
can insert it into a letter or letter template.  

Adding, editing, and deleting page templates 
To add a page template: 

1. Select Maintenance > Templates > Page Templates. The Page Setup Templates screen 
appears. This screen displays all existing page templates.  

2. Click the New button. The Page Setup screen appears.  

3. Enter a code and name for the new page template.  

4. Enter the margins in inches. If you want the top margin of the first page to be different than the 
other pages, you can enter the margin in inches in the Top margin of first page only field.  

5. If you want to include a header or footer, click the Header tab or Footer tab. Enter the header 
text or footer text in the Text field. Select a font and font size from the Font and Size drop-
down fields.  

If you want the first page header and footer to be different than the other pages, you can click 
the Header (1st Page) tab or the Footer (1st Page) tab and enter the header or footer text for 
the 1st page in the Text field. Select a font and font size from the Font and Size drop-down 
fields. If you do not enter anything on the Header (1st Page) tab, then whatever is entered in 
the Header tab will be used for all pages. If you do not enter anything on the Footer (1st Page) 
tab, then whatever is entered in the Footer tab will be used for all pages.  

6. When you finish, click the OK button. The new page template appears on the Page Setup 
Templates screen.  

To insert images into headers and footers: 

1. On the Page Setup Template screen, click the header or footer tab (i.e., Header (1st Page), 
Header, Footer (1st Page), or Footer) that you want to add the image for.  

2. Click the Image button. The Open screen appears. Browse to the location where the image 
that you want to use is saved. You can use BMP, GIF, and JPG formatted files. When you have 
selected the image click the OK button. The selected image will be displayed in the image area 
provided on the Page Setup Template screen. 

3. You can select the Scale image to width available check box to scale the image down when it 
is too wide for the space available. If you do not select this option, the image will always be 
shown at its original size.  

4. When you are finished, click the OK button.  

To insert a page template into a letter: 

1. Open the letter into which you want to insert the page template.  

2. Select Insert > Page Setup Template. The Page Setup Templates screen appears.  

3. Highlight the template that you want to insert. If you want to find the template quickly, enter the 
template code in the Search for Code field and the closest match will be selected in the table.  
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4. Click the OK button, or double click the template. The page template is inserted into the letter.  

To insert a page template into a letter template:  

1. Open the letter template into which you want to insert the page template.  

2. Select Insert > Page Setup Template. The Page Setup Templates screen appears.  

3. Highlight the template that you want to insert. If you want to find the template quickly, enter the 
template code in the Search for Code field and the closest match will be selected in the table.  

4. Click the OK button, or double click the template. The page template is inserted into the letter 
template.  

To change a page template: 

1. Select Maintenance > Templates > Page Templates. The Page Setup Templates screen 
appears. This screen displays all existing page templates.  

2. Highlight the template that you want to edit. If you want to find the template quickly, enter the 
template code in the Search for Code field and the closest match will be selected in the table.  

3. Click the Edit button, or double click the template. The Page Setup screen appears.  

4. Make the necessary changes.  

Note: If you change only the code when you edit the template, you create a duplicate of the existing 
template.  

5. When you finish, click the OK button.  

To delete a page template: 

1. Select Maintenance > Templates > Page Templates. The Page Setup Templates screen 
appears. This screen displays all existing page templates.  

2. Highlight the template that you want to delete. If you want to find the template quickly, enter 
the template code in the Search for Code field and the closest match will be selected in the 
table.  

3. Click the Delete button. A message asks you to confirm the deletion.  

4. Click the OK button.  
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Message templates 
Using message templates, like using note templates, can save you time when you are writing a 
message. You can use the message templates that are included in the program or you can create your 
own.  

You can store message templates for a specific provider or practice (depending on the Allow 
QuickText and Templates by Practice setting on the Special Features screen), or "universally" for all 
providers/practices. 

Dot codes that write to the chart will not work, unless the message is recorded to a progress note (for 
example, the .L code will not write to the lab section). Letter codes and Dot codes that read from the 
Lytec MD database will work in templates and messages.  

Adding, editing, and deleting message templates 
You can add a message template from scratch, or use a message to create a message template. 

To add a message template from scratch: 

1. Select Maintenance > Templates > Message Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice you want to add a template for, or leave the Provider/Practice ID 
field blank to add a universal template.  
 
The Allow QuickText and Templates by Practice setting on the Special Features screen defines 
whether you can add a template for individual providers or individual practices. 

3. Click the OK button.  
• If no templates exist for the specified provider, you are asked if you would like to create a 

new template. Click the Yes button. The Message Templates screen appears.  

• § If templates exist, the Template Lookup screen displays a list of templates. Click the 
New button. If you are adding a template for a provider, the Message Templates screen 
appears. If you are adding a template for all provides, the Universal Message Templates 
screen appears. 

4. Enter the template. You can:  
• Type text.  

• Insert letter codes or insert codes to pre-populate the message with existing patient data 
such as recent laboratory results. Select Insert > QuickText, or click the QuickText button 
on the toolbar. The Insert QuickText screen appears. Mark the Letter Code radio button 
(or the Dot Code button for insert codes, which begin with .I). In the table, highlight the 
QuickText item that you want to insert. Click the Insert button.  

• Insert Dot codes. Select Insert > QuickText, or click the QText button on the toolbar. The 
Insert QuickText screen appears. Mark the Dot Code radio button. In the table, highlight 
the QuickText item that you want to insert. Click the Insert button. If the message is 
recorded, Dot codes with chart information will be written to the note. 

• Insert procedure codes. Select Insert > Procedure Code, or click the Proc button in the 
toolbar.  

• Insert diagnosis/problem codes. Select Insert > Problem/Diagnosis Code, or click the 
Pb/Dx button in the toolbar. 
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• Insert bookmarks. Select Insert > Bookmark. Later, when you create a note with this 
template, you can search on this bookmark. You can find your bookmark(s) by selecting 
Edit > Find. The Find screen appears. Select the Bookmark radio button, and click OK. 
Your cursor will move to next bookmark in the template.   

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  
 
If you want to create a special label, move the cursor over the asterisk in the middle of the 
label. Then, enter the QuickText name or partial name, or «del», «*sex*», «*age*», or 
«*date*». A QuickText label could look like this: «CALLREASON».  
 
In a message with these labels, age could be replaced by a value like 39 yr, and 
CALLREASON by "Rx refill" If nothing followed the del label, the entire line would be 
deleted.  
 
You can also force the QuickText pick list to appear even when the QuickText entry is an 
exact match. To do that, follow the procedure above, and insert three periods (...) after 
you enter the QuickText item name. This label marker, with the embedded item name, 
becomes highlighted in red in a template. Example: «item name...»  
 
If you want to change the current item name in a label marker, you need to edit the label 
marker in the template.  
 
When you use the template, the TAB, F10 key or the QT Auto button will move the cursor 
directly to that label where you can then type in the appropriate text. Label markers 
include LINK and REQ. 

5. When you finish, click the OK button. The Enter Template name screen appears.  

6. In the Name field, type a name for the new template.  

7. Click the OK button.  

To change a message template: 

1. Select Maintenance > Templates > Message Templates. The Provider/Practice Selection screen 
appears.  

2. Select the provider or practice whose templates you want to view, or leave the 
Provider/Practice ID field blank to view universal templates.  

3. Click the OK button. The Message Template Lookup screen appears. This screen displays all 
existing message templates.  

4. Highlight the template you want to view. If you want to find the template quickly, enter the 
template code in the Name field and the closest match will be selected in the table.  

5. Click the OK button, or double-click the template. The Message Templates screen appears.  

6. To edit the template, click the Edit button and make the necessary changes.  

7. When you finish, click the OK button.  

To delete a message template: 

1. Select Maintenance > Templates > Message Templates. The Provider/Practice Selection screen 
appears.  
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2. Select the provider or practice whose template you want to delete, or leave the 
Provider/Practice ID field blank to delete a universal template.  

3. Click the OK button. The Message Template Lookup screen appears. This screen displays all 
existing message templates.  

4. Highlight the template you want to delete. If you want to find the template quickly, enter the 
template code in the Name field and the closest match will be selected in the table.  

5. Click the OK button, or double-click the template. The Letter Templates screen appears.  

6. Select Edit > Delete Note. A message asks you to confirm the deletion.  

7. Click the OK button.  
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List Maintenance 
Lytec MD allows you to create custom lists from which users may choose when entering data for vital 
signs, clinical elements, or extended order elements.  

Custom lists can be applied to one or more of the items on an Extended Order screen in Extended 
Order Maintenance, or to the value or attribute fields of a Vital Sign or Clinical Element in the Vitals 
Maintenance and Clinical Elements Maintenance screens.  

For example, if you want to add a new clinical element name called patient's shirt color, and add 
options such as Red, Blue, Green, and Orange, you would first create a List called Patient's Shirt Color. 
You can then add List Item options for "Red," "Blue," "Green," and "Orange." Next, from the Clinical 
Elements Maintenance screen, you would select the new list name from the Element List field. You 
can also designate an attribute type and select an attribute list in the same fashion.  

Clinical Elements Maintenance and Vitals Maintenance also allow you to define whether the List Items 
will be displayed as a text box, drop-down, combo-box, check box, radio button group, or label on the 
template. 

Important: To use List Maintenance the "List Maintenance" access level must be enabled.  

Procedures for adding, editing, and deleting list names 
To open the List Names Select screen: 

• Select Maintenance > Templates > List Maintenance. The List Names Select screen appears. 

To add a list name: 

1. On the List Names Select screen, click the New button. The New List Name screen appears.  

2. Enter the maximum List Item length in the Maximum Item Length field. Maximum lengths of 
up to 50 characters are allowed. 

3. Enter the new List name in the Name field.  

4. Click the OK button. The new name will be added to the list of existing names. 

To edit a list name: 

• On the List Names Select screen, highlight the List name that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a list name: 

• On the List Names Select screen, highlight the List name that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Procedures for adding, editing, and deleting list items 
To open the List Items View screen: 

• Select Maintenance > Templates > List Maintenance. The List Names Select screen appears. 
Highlight the List name that you want to add List Items for. Click the Edit button. The List Items 
View screen appears. 
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To add a list item: 

1. On the List Items View screen, click the New button. The List Item screen appears.  

2. Enter the new List Item's name in the Name field. The maximum character length for the List 
Item is displayed below the Name field.  

3. Enter a description of the List Item in the Desc field (this field is optional).  

4. Click the OK button. The new item will be added to the list box on the List Items View screen. 
You can continue to add list items as necessary. 

To edit a list item: 

• On the List Items View screen, highlight the List Item that you want to change. You can also 
enter the full or partial List name in the corresponding search field. Click the Search button. The 
item with the closest matching name will be selected. Click the Edit button. Make the 
appropriate changes. When you finish, click the OK button. 

To delete a list item: 

• On the List Items View screen, highlight the List Item that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 
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Lab data test names 
You can use the Laboratory Test Names screen to define the laboratory data names you want to appear 
in your templates. You can use the Laboratory Value Ranges screen to define the normal, validation, 
and critical ranges for this data for both male and female patients. Range limits are optional.  

The names you enter here become permanent labels for the data items appearing in your laboratory 
data template. The laboratory data names you use must be unique. For example, you cannot use 
“glucose” for both the U/A and Chemistry categories. Instead, you can use “glucose” for U/A and “bld. 
glu.” for Chemistry.  

Note: It is important to create laboratory data test names before you begin entering laboratory 
information in the patient chart.  

Using pre-defined formulas 
When you create laboratory data test names, you can use one of the following pre-defined formulas 
available, if it is applicable to a test.  

Formula Description 

Age  Calculates the patient’s age, in years and months, based on the 
specified date.  

Body Mass Index  Calculates the patient’s body mass index (BMI), based on the 
weight and (BMI = weight in kilograms) / (height in meters)2). 
The weight from the same day is used to calculate the BMI. The 
height used for the calculation is based on the following time 
frames:    
 
Female patients 

 If the patient is older than 22 years old, the most recent 
height within the past 5 years will be used. 

 If the patient is in between the ages of 17 and 22, the 
most recent height within the past year will be used.  

 If the patient is under 17 years old, the current height 
will be used (i.e., the height from the same day).  

Male patients 
 If the patient is older than 24 years old, the most recent 

height within the past 5 years will be used.  
 If the patient is between the ages of 19 and 24, the 

most recent height within the past year will be used.  
 If the patient is under 19 years old, the current height 

will be used (i.e., the height from the same day). 
Please note the BMI will not be calculated if a patient’s weight is 
not entered or if a height is not found within the time ranges 
specified above. 

Growth Velocity  Calculates the patient’s rate of growth, per year, based on the 
height and specified date. Both English and metric percentile 
files are available. 

Std. Deviation of Height for Age  Calculates the patient’s standard deviation for height, based on 
the age.  
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Percentile of Height for Age  Calculates the patient’s percentile for height, based on the age. 

Std. Deviation of Weight for Age  Calculates the patient’s standard deviation for weight, based on 
the age.  

Percentile of Weight for Age  Calculates the patient’s percentile for weight, based on the age. 

Est. Date of Confinement by LMP This formula currently should not be used.  

Prenatal formula 
Calculates the estimated date of confinement, 280 days (40 
weeks) from the last menstrual period. 
* See note below about lab data test names you must add for 
this formula. 

Est. Date of Confinement by 
Conception Date 

This formula currently should not be used.  

Prenatal formula 
Calculates the estimated date of confinement, 266 days (38 
weeks) from the newest conception date. 
* See note below about lab data test names you must add for 
this formula. 

Est. Date of Confinement by 
Ultrasound 

This formula currently should not be used.  

Prenatal formula 
Calculates the estimated date of confinement based on the 
date of the ultrasound and weeks of gestation (Lytec MD 
assumes a gestation of 40 weeks for this formula). 
* See note below about lab data test names you must add for 
this formula. 

Est. Date of Confinement by Est. 
Gestation 

This formula currently should not be used.  

Prenatal formula 
Calculates the estimated date of confinement based on the 
most recent estimated gestation (Lytec MD assumes a gestation 
of 40 weeks for this formula). For the purposes of this item, 
Estimated Gestation is the clinician’s best assessment of 
gestation on a given date based on all data (for example, LMP, 
Ultrasound, and Fetal Heart Tones). Estimated Gestation must 
be added to the lab data test names for this formula to work. If 
more than one is entered, the most recent one will be used. 
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Weeks Gestation This formula currently should not be used.  

Prenatal formula 
Calculates the weeks of gestation based on the date of the visit 
(as indicated in a lab or flow chart) and, if present: 

 The estimated date of confinement by estimated 
gestation. If not present, then: 

 The estimated date of confinement by conception date. 
If not present, then: 

 The estimated date of confinement by ultrasound. If not 
present, then: 

 The estimated date of confinement by LMP.  
* See note below about lab data test names you must add for 
this formula. 

Body Surface Area (BSA) Calculates the patient's body surface area, using the Mosteller 
Formula: 

 BSA (m2) =   square root of (height (cm) x weight (kg) / 
3600) 

 BSA (m2) =  square root of (height (in) x weight (lb) / 
3131) 

NEJM 317(17): 1098, 1987 

Creatinine Clearance Calculates the patient's serum creatinine concentration based 
on age, gender, and body weight.  

Note: Creatinine clearance is an estimate of glomerular 
filtration rate or "GFR". 

* Note for estimated date of confinement and weeks of gestation formulas 
Currently, you must add the following lab data test names for these formulas: 
 
LMP - Last menstrual date 
 
Conception Date - Date of conception 
 
US Gestation - Weeks of gestation for the ultrasound 
 
Est. Gestation - Estimated weeks of gestation 

Except for the Age and estimated date of conception/weeks of gestation formulas, these formulas 
calculate value based on height and/or weight. Therefore, you must have data for each of these items 
for the patient. When using the Age formula, you need at least one other data item in the flow chart or 
lab table in order for the patient’s age to appear.  

Since height or weight can be entered in either English or Metric format, for the formulas to be 
accurate, Patient Records must be configured for a particular format (through a setting in the ppart.ini 
file). During installation, you choose the format (English or Metric) for height and weight (as well as 
OFC and temperature). You must be consistent in how you enter the information for each item for 
the formulas to be accurate.  

The Body Mass Index (BMI) formula depends on height being in centimeters (cm) and weight in 
kilogram (kg) if you are using metric standards, or in inches (in) and pounds (lb) if you are using English 
standards. Likewise, the growth velocity (GV) formula depends on the height being in cm if you are 
using metric standards, or in inches if you are using English standards.  
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For example, if you use the English standard, you can enter 5’11” for height and 175 for weight. The 
height will be correctly interpreted as “five feet and eleven inches” (or 71 inches) and weight as “175 
pounds” to produce the correct values for the Body Mass Index formula.  

If the unit of measurement for height is in inches, the result that displays in a laboratory data table or 
flow chart will be labeled with “inches/yr” for the GV formula. If the unit is in centimeters, the result will 
be labeled with “cm/yr”.  

However, for the BMI formula, the result will be labeled with “kg/m2” whether you use cm and kg, or in 
and lb. Data entered for in and lb will be automatically converted to cm and kg to produce the correct 
results.  

Security levels for lab tests 
When you create or edit a lab test, you can restrict which users can view the test result by assigning an 
access level to the lab test. You can assign N, R1, R2, or R3, with N having no restriction, and R3 having 
the highest restriction.  

The user can only view test results with access levels that are equal or lower than his or her lab table 
access level. For example, if a user is assigned an R3 Lab Table access level, he or she can view test 
results for tests that were assigned access levels of R3 or lower. In contrast, a user assigned an N access 
level can view only test results for tests assigned the N access level.  

Depending on what your system administrator selected on the Special Features screen, a user with a 
low lab table access level will either see asterisks (to indicate that the test was done) in place of actual 
test result values, or blank fields for the test result values when viewing a test that was assigned a 
higher access level than the user’s access level.  

For lab tests that may be classified as “Confidential” or contain highly sensitive information, you can 
assign a high level (such as R3) access, and then assign an appropriate Lab Table access level for the 
user. Using this method will either:  

• Allow the user to see the test results.  

• Allow the user to know that a test was done as indicated by the asterisks.  

• Not allow the user to know that a test was done because the test result field is blank.  

The following table displays what will show in a laboratory data table, depending on the user’s lab 
table access level and the lab test’s access level. The table also applies to other screens where test 
results are displayed, such as: Most Recent Lab Data, Lab Table Review, and Flow Charts.  

Lab test  
access level  

 

User's 
lab 

table 
access 
level 

N 

User's 
lab 

table 
access 
level 

R1 

User's 
lab 

table 
access 
level 

R2 

User's 
lab 

table 
access 
level 

R3 

 N test 
results 

test 
results 

test 
results 

test 
results 

R1 *** or 
blank 
field 

test 
results 

test 
results 

test 
results 

R2 *** or 
blank 
field 

*** or 
blank 
field 

test 
results 

test 
results 
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R3 *** or 
blank 
field 

*** or 
blank 
field 

*** or 
blank 
field 

test 
results 

Note: If the test result is in the critical range, and the Messaging feature is activated for the test, all 
users will receive and can view the critical range message containing the test result. However, only 
users with appropriate lab table access levels can view the lab tables.  

Adding, editing, and deleting lab data test names 
To open the lab data test name maintenance screen: 

• Select Maintenance > Templates > Lab Data Test Names. The Laboratory Test Names screen 
appears.  

To add a lab data test name: 

• On the Laboratory Test Names screen, click the New button. Fill in the fields on this screen, then 
click the OK button. 

To change a lab data test name: 

• On the Laboratory Test Names screen, highlight the lab data test name that you want to change. 
Click the Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete a lab data test name: 

Note: Do not delete any test for which data exists. 

• On the Laboratory Test Names screen, highlight the lab data test name that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields and buttons on the lab data test name maintenance 
screen 
Field Description 

Test Name  Type a name for the new lab data test.  

Xref button If you want to use this name as a cross-reference for the 
Laboratory Data Loader, click this button next to the Test Name 
field. The test name appears in the Cross Reference field.  

Test Description  Type a description of the test.  

Units  Type the unit used in the test (if applicable).  

Formulas Select one of the available formulas (if applicable to the test), or 
leave None as the default. Formulas currently available are: 
Age, Body Mass Index, Growth Velocity, Std. Deviation of 
Height for Age, Percentile for Height for Age, Std. Deviation of 
Weight for Age, Percentile of Weight for Age, Est. Date of 
Confinement by LMP, Est. Date of Confinement by Conception 
Date, Est. Date of Confinement by Ultrasound, Est. Date of 
Confinement by Est. Gestation, Weeks Gestation, Body Surface 
Area (BSA), and Creatinine Clearance. 
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Lab Default Template Select the default lab template for the laboratory data item. 
Lytec MD will use this to determine which lab template to use 
when displaying results for this lab name in the Lab Table 
Review. 

Access Level Select the restriction (security level) you want to place on the 
test. You can select N for no restrictions, or up to R3 for highest 
restriction.  

Exclude from Review Bin Select this option to exclude the lab from the Lab Table Review 
screen. You can select this option to exclude labs that are used 
as clinical elements (e.g., cardiac murmur). When selected, the 
lab will automatically be signed using the administrator 
signature. 
The name and setting are written to the ExcludeLabNames.fl file 
in the \ppart directory. The file’s format consists of one lab 
name per line and a bar to separate which screen(s) the lab 
name should be excluded from (i.e., 1 = Lab Table Review 
screen, 2 = Most Recent Lab Data screen, and 3 = both 
screens).  
IMPORTANT: 
You must setup a new Administrator provider from the 
Provider Maintenance screen to enable this feature.  
To add an administrator provider:  

1.  Enter ADM in the ID Code field.  

2.  Enter the provider’s name in the First Name and Last 
Name fields. For example, enter the in the First Name 
field, and administrator in the Last Name field.  

3.  From the Records tab, enter the provider’s signature in 
the Provider Signature field. 

Exclude from Most Recent Select this option to exclude the lab from the Most Recent Lab 
Data screen. You can select this option to exclude labs that are 
used as clinical elements (e.g., cardiac murmur).  
The name and setting are written to the ExcludeLabNames.fl file 
in the \ppart directory. The file’s format consists of one lab 
name per line and a bar to separate which screen(s) the lab 
name should be excluded from (i.e., 1 = Lab Table Review 
screen, 2 = Most Recent Lab Data screen, and 3 = both 
screens).  
IMPORTANT: 
You must setup a new Administrator provider from the 
Provider Maintenance screen to enable this feature.  
To add an administrator provider:  

1. Enter ADM in the ID Code field.  

2. Enter the provider’s name in the First Name and Last 
Name fields. For example, enter the in the First Name 
field, and administrator in the Last Name field.  

3. From the Records tab, enter the provider’s signature in 
the Provider Signature field. 
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Ranges button If you want to enter normal value ranges, click this button. Enter 
the value range, then click the OK button to close this screen.  
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Flow/Lab/Clinical templates 
You can use the Patient Records Flow/Lab/Clinical Templates screen to choose numeric and text data 
from laboratory data, vital signs, Rx/medications, health maintenance, Label chart tabs, clinical 
elements, and prenatal elements to display on patient flow charts and laboratory data tables. With 
these templates, you can create patient flow charts and laboratory data tables to view and compare 
patient data rapidly and efficiently. You may define as many flow charts and laboratory data tables as 
you wish.  

For new sites, Patient Records includes a set of pre-defined templates for laboratory data tables and 
flow charts available for use.  

You can create a template specifically for a laboratory data table (also known as a laboratory panel) or a 
flow chart. You can also create a template that can be used for both types.   

Selecting Items From the Template Categories  
You can select items from the following categories:  

Laboratory Data  
1. On the Flow/Lab/Clinical Templates screen, select the Laboratory Data category by clicking the 

plus (+) sign in the treeview or by double clicking the category name. The Lab Test Names 
screen appears.  

2. Select an item from the table. If you do not see the item that you want:  
• Use the scroll arrows to find the item, or  

• Enter the full or partial name in the field above the table and choose the Search button. 
The item with the closest matching name will be selected. Please note the lab test name 
search is case-sensitive.  

Note: For universal templates: If a default lab template has been selected for this lab item (lab data test 
name), a message asks whether you want to make the new template the lab item's default template. 

3. If you want to automatically graph the item in a laboratory data table or a flow chart, mark the 
Graph check box.  

4. Click the OK button. The item you selected now appears in the Template Items box.  

Vital Signs  
1. On the Flow/Lab/Clinical Templates screen, select the Vital Signs category by clicking the plus 

(+) sign in the treeview or by double clicking the category name. The Select Vital Sign Name 
screen appears.  

2. Select an item from the table. If you do not see the item that you want:  
• Use the scroll arrows to find the item, or  

• Enter the full or partial name in the field above the table and click the Search button. The 
item with the closest matching name will be selected. 

3. Click the OK button. A message will appear asking if you would like to graph the vital sign. If 
you want to automatically graph the item in a vital signs table or a flow chart, click Yes.  

4. The item you selected now appears in the Template Items box.  
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Medications 
1. On the Flow/Lab/Clinical Templates screen, select the Medications category by clicking the 

plus (+) sign in the treeview or by double clicking the category name. The Medication Name 
screen appears.  

2. There are several ways to indicate which medications you want:  
• Enter the name (or the first few letters) of the medication in the text field and click the 

Search button. A table displays the closest match of the medication name.  
 
If the closest match is the correct medication name, double click that name.  
 
If you want a different medication name, select that name from the table and double click 
that name, or click the OK button.  
 
After you select the medication name, the previous screen appears.  

• If you want to select a medication belonging to a class of medication at the time you 
display the laboratory data table or flow chart, select the All Drugs In That Class check 
box, then enter the name of the medication.  

• If you want to select a medication from the patient’s historical medication list at the time 
you display the laboratory data table or flow chart, select the Any Historical Medication 
check box.  

• If you want to display a medication only from the patient’s current medication list at the 
time you display the laboratory data table or flow chart, select the Current Medication 
check box.  

3. If you want to include a medication automatically in a graph, mark the Graph check box, then 
enter the name of the medication.  

4. When you are finished with the selection, click the OK button. The Flow/Lab Template screen 
appears, and the medication name and the attributes you selected appear in the Template 
Items box.  

Health Maintenance 
1. On the Flow/Lab/Clinical Templates screen, select the Health Maintenance category by clicking 

the plus (+) sign in the treeview or by double clicking the category name. The Health 
Maintenance Procedures screen appears. 

2. Select the item name that you want to include in the laboratory data table or flow chart.  

Label 
1. On the Flow/Lab/Clinical Templates screen, select the Label (for Note) category by clicking the 

plus (+) sign in the treeview or by double clicking the category name. The Label (for Note) 
screen appears. 

2. Enter the label that you want to include in the laboratory data table or flow chart. 

3. Click the OK button. The Flow/Lab Template screen appears and the item you have entered 
appears in the Template Items box. A note field with the label you entered is added to the 
template. You can enter a short note or any other data.  
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Clinical Elements 
1. On the Flow/Lab/Clinical Templates screen, select the Clinical Elements category by clicking 

the plus (+) sign in the treeview or by double clicking the category name. The Select Clinical 
Element Name screen appears.  

2. Select an item from the table. If you do not see the item that you want:  
5. Use the scroll arrows to find the item, or  

6. Enter the full or partial name in the field above the table and click the Search button. The 
item with the closest matching name will be selected. 

3. Click the OK button. A message will appear asking if you would like to graph the clinical 
element. If you want to automatically graph the item in a clinical elements table or a flow chart, 
click Yes.  

4. The item you selected now appears in the Template Items box.  

Prenatal 
Important: You can not add prenatal templates at this time. You must use the PrenatalVisit flow chart 
template provided by Patient Records. You can modify this template to meet your specific practice 
needs.  

1. On the Flow/Lab/Clinical Templates screen, select the Prenatal category by clicking the plus (+) 
sign in the treeview or by double clicking the category name. The Select Prenatal Name 
screen appears.  

2. Select an item from the table. If you do not see the item that you want:  
• Use the scroll arrows to find the item, or  

• Enter the full or partial name in the field above the table and click the Search button. The 
item with the closest matching name will be selected. 

Note: The Graph check box is reserved for future use.  

3. Click the OK button. The item you selected now appears in the Template Items box.  

Adding, editing, and deleting flow/lab/clinical templates 
To add a flow/lab/clinical template: 

1. Select Maintenance > Templates > Flow/Lab/Clinical Templates. The Provider/Practice 
Selection screen appears.  

2. Select a provider ID to create a provider-specific template, or leave the field blank to create a 
universal template.  

3. Click the OK button. The Flow/Lab/Clinical Templates screen appears. If you selected a 
provider ID, the ID appears in the title bar.  

4. In the Display By panel, mark the appropriate radio button for the type of template that you 
want to display in the table. By default, all existing templates appear in the table.  

Important: You can not add prenatal templates at this time. You must use the PrenatalVisit flow chart 
template provided by Patient Records. You can modify this template to meet your specific practice 
needs.  

5. Click the New button. The Flow/Lab Templates <New> screen appears.  

6. In the Name field, type a name for the new template.  
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7. Indicate the type of template you are creating. You can mark more than one check box if the 
template will be used for more than one template type. For example, if you want the template 
to be used in a laboratory data table and also in a flow chart, select both the Lab Table check 
box and the Flow Chart check box.  
 
Mark the:  
• Lab Table check box to create a laboratory data template.  

• Flow Chart check box to create a flow chart template.  

Note: The Lab Entry check box is reserved for future use.  

8. Select items from the categories of templates: Laboratory Data, Vital Signs, Medications, Health 
Maintenance, and Label (for Note), Clinical Elements, and Prenatal. You can either double-click 
the category name or select the plus (+) sign next to the name.  

9. When you select a category, a screen appears. Each screen displays either a list of items or asks 
you to enter the name of an item.  

10. You can remove any item from the Template Items box by selecting that item and clicking the 
Remove button.  

11. You can change the sequence of items in the Template Items box by selecting an item and 
clicking the up or down arrow buttons to the right of the box. Items on a data table or flow chart 
will match the sequence of items you select in this box.  

12. When you finish, click the OK button to save this template.  

To change a flow/lab/clinical template: 

1. Select Maintenance > Templates > Flow/Lab/Clinical Templates. The Flow/Lab/Clinical 
Templates screen appears.  

2. In the Display By panel, mark the appropriate radio button for the type of template that you 
want to edit. By default, all existing templates appear in the table.  

3. Highlight the template that you want to edit.  

4. Click the Edit button. The Flow/Lab Templates <Edit> screen appears. This screen displays 
the template’s name and type of in the title bar.  

5. Select items among the categories of templates.  
 
When you select a category, a screen appears. Each screen either displays a list of items or asks 
you to enter the name of an item.  

Note: When modifying the PrenatalVisit template you can only select items from the Laboratory Data, 
Clinical Elements, and Prenatal categories. 

6. If necessary, remove items from the Template Items box by selecting that item and clicking the 
Remove button.  

Note: For universal templates: If the template is the default lab template for the lab item (lab data test 
name), a message displays the other templates to which the lab item is attached, so that you can select 
another default template for the item. 

7. If necessary, change the sequence of items in the Template Items box by selecting an item and 
clicking the up and down arrow button to the right of the table.  

8. To add a category to the template, mark the appropriate check box (Flow Chart, Lab Table, or 
Lab Entry).  
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Note: To remove a category from the template, you must return to the Flow/Lab/Clinical Templates 
screen (the list of all templates), mark the radio button for the category that you want to remove, and 
click the Delete button. For example, to remove the Lab Table category, mark the Lab Table radio 
button on the main Flow/Lab/Clinical Templates screen and click Delete.  

9. When you finish, you can either save this template with the same name or with another name.  
• To save this template with the same name, click the OK button. The original template is 

overwritten with this edited template.  

• To save this template as a new template with another name, click the Save As button. The 
Saving Template Name screen appears. Enter a new name in the Save as field and click 
the OK button.  

To delete a flow/lab/clinical template: 

Note: If you delete a lab template, you cannot view the lab items on the template until you create 
another lab template that contains the items.  

1. Select Maintenance > Templates > Flow/Lab/Clinical Templates. The Flow/Lab/Clinical 
Template screen appears.  

2. In the Display By panel, mark the appropriate radio button for the type of template that you 
want to delete. By default, all existing templates appear in the table.  

3. Highlight the template that you want to delete.  

4. Click the Delete button. A message asks you to confirm the deletion.  

5. Click the Yes button. The deleted template is permanently removed from the database.  
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Health maintenance procedure names 
The health maintenance feature tracks periodic patient treatments such as examinations, tests, and 
immunizations. Before this information can be tracked in the patient chart, you must establish health 
maintenance schedules for specific groups of patients (for example, by sex and age). Setting up the 
schedules is a two-part process: first, you create health maintenance procedure names; then, you use 
the procedure names in health maintenance templates. 

When you add a health maintenance procedure, you specify the procedure's name, description, any 
synonyms or codes, and cross-reference. You can use the HM Synonyms field on the health 
maintenance procedure name screen to maintain alternate names for procedures. For example, you 
may have the procedure DTaP, which was previously known as DPT. By adding DPT as a synonym for 
DTaP, Lytec MD will check for both DTaP and DPT when verifying whether procedures are current. 

Note that in Lytec MD, "synonyms" refers to alternate names for problems/diagnoses and medications 
as well. Those are set up on the Health Maintenance Synonyms screen available through health 
maintenance templates.  

You can create customized information files (similar to help files) for specific health maintenance 
procedures. Once you have created health maintenance help files, you can access them from the 
Health Maintenance screen whenever you need information about a procedure.  

You can use the Health Maintenance Conversion utility to change a procedure name, if necessary. 

Adding, editing, and deleting health maintenance 
procedure names 
To open the Health Maintenance Procedure Name screen: 

• Select Maintenance > Templates > Health Maintenance Names. The Health Maintenance 
Procedure Names screen appears. 

To add a health maintenance procedure name: 

• On the Health Maintenance Procedure Names screen, click the New button. Fill in the fields on 
this screen, then click the OK button. 

To change a health maintenance procedure name: 

• On the Health Maintenance Procedure Names screen, highlight the health maintenance 
procedure name that you want to change. Click the Edit button. Make the appropriate changes. 
When you finish, click the OK button. 

Note: As on other "list" or table screens, the search field at the top of the screen can help you quickly 
find the appropriate procedure. Type the procedure name (or the first part of the name) in the field, 
and click the Search button. The procedure that most closely matches the name will be selected in the 
table. 

To delete a health maintenance procedure name: 

Warning: If you delete a procedure name, and patient data exists for the procedure, the data will no 
longer be visible in the patient chart. If you add the procedure name back, the data will be visible 
again. 
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• On the Health Maintenance Procedure Names screen, highlight the health maintenance 
procedure name that you want to delete. Click the Delete button. A message asks you to confirm 
the deletion. Click the OK button. 

Fields on the health maintenance procedure name screen 
Field Description 

HM Name Type a name for the health maintenance procedure. 

XRef button Sometimes the Text Data Loader is used to load data from 
sources where procedure names may be different than the 
ones defined in your own health maintenance templates. 
You can make sure this data updates the appropriate health 
maintenance procedures. Click the XRef button. The procedure 
name appears in the HM Cross Reference field. Edit the name 
as necessary to match the name used by the outside source. 

HM Description Type a short description of the health maintenance procedure. 

HM Synonyms Type the synonyms associated with the health maintenance 
name. 

HM Code 1 Type a code associated with the health maintenance 
procedure. 

HM Code 2 Type a code associated with the health maintenance 
procedure. 

HM Cross Reference When the XRef button is clicked, the procedure name appears 
in this  field. You can edit the name as necessary to match the 
name used by the outside source. 
You can also use this field to enter a Clinical Element name or 
Vital Sign name. When a name is entered the data for the 
entered Clinical Element or Vital Sign for the patient will be 
recognized by Health Maintenance as satisfying a Health 
Maintenance Procedure for the patient. See the Health 
Maintenance: Clinical Elements and Vital Signs section for more 
information.  

More button Click this button to add default information (such as 
vaccination, dose, route, and lot) about the health maintenance 
procedure name. 

Fields on the health maintenance more info screen 
Field Description 

Dose Default dose. 

Route Default route. 

Given By Default person who administered the procedure. 

Location Default part of the body where the procedure was 
administered. 

Lot Default lot number. 

Expiration Date Immunization expiration date.  
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Manufacturer Default manufacturer. 

Device Default instrument used to administer the procedure. 

Comment Default note or comment about the procedure. 
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Vital Sign Names 
You can use the Vital Sign Names screen to define the vital sign data names you want to appear on the 
Vital Signs <New> entry screen and in your Vital Signs templates, Flow Charts, etc. Patient Records also 
supplies a list of pre-configured names. These vital signs are based on typical medical practice and 
except in rare circumstances there should be no need to modify or delete them. If, however, you have 
deleted a pre-configured vital sign and wish to restore it, you may do so by creating a new Vital Sign 
and assigning it the "Type" value corresponding to the name of the vital sign which was deleted. 

The names you enter here become permanent labels for the data items appearing in your vital signs 
template. The vital sign names you use must be unique.  

Using pre-defined formulas 
When you create vital sign names, you can use one of the following pre-defined formulas. Vital sign 
names for which a formula is selected may be added to vital sign and other templates, causing that 
template to display data calculated based on the formula you choose. They will not be displayed on the 
Vital Signs <New> screen, because they represent calculated data rather than data to be entered by a 
user. 

Formula Description 

Age  Calculates the patient’s age, in years and months, based on the 
specified date.  

Body Mass Index  Calculates the patient’s body mass index (BMI), based on the 
weight and (BMI = weight in kilograms) / (height in meters)2). 
The weight from the same day is used to calculate the BMI. The 
height used for the calculation is based on the following time 
frames:    
 
Female patients 

 If the patient is older than 22 years old, the most recent 
height within the past 5 years will be used. 

 If the patient is in between the ages of 17 and 22, the 
most recent height within the past year will be used.  

 If the patient is under 17 years old, the current height 
will be used (i.e., the height from the same day).  

Male patients 
 If the patient is older than 24 years old, the most recent 

height within the past 5 years will be used.  
 If the patient is between the ages of 19 and 24, the 

most recent height within the past year will be used.  
 If the patient is under 19 years old, the current height 

will be used (i.e., the height from the same day). 
Please note the BMI will not be calculated if a patient’s weight is 
not entered or if a height is not found within the time ranges 
specified above.   

Growth Velocity  Calculates the patient’s rate of growth in height per year.  

Std. Deviation of Height for Age  Calculates the patient’s standard deviation for height, based on 
the age.  
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Percentile of Height for Age  Calculates the patient’s percentile for height, based on the age. 

Std. Deviation of Weight for Age  Calculates the patient’s standard deviation for weight, based on 
the age.  

Body Surface Area (BSA) Calculates the patient's body surface area, using the Mosteller 
Formula: 

 BSA (m2) =   square root of (height (cm) x weight (kg) / 
3600) 

NEJM 317(17): 1098, 1987 

Creatinine Clearance Calculates the patient's serum creatinine concentration based 
on age, gender, and body weight.  

Note: Creatinine clearance is an estimate of glomerular 
filtration rate or "GFR". 

These formulas calculate value based on height and/or weight. Therefore, you must have data for each 
of these items for the patient. When using the Age formula, you need at least one other data item in the 
flow chart or lab table in order for the patient’s age to appear.  

Since height or weight can be entered in either English or Metric format, you can select whether you 
want to use English or Metric measurements using the Conversion field on the Vitals Maintenance 
screen.  

If the unit of measurement for height is in inches, the result that displays in a laboratory data table or 
flow chart will be labeled with “inches/yr” for the Growth Velocity formula. If the unit is in centimeters, 
the result will be labeled with “cm/yr”.  

However, for the BMI formula, the result will be labeled with “kg/m2” whether you use cm and kg, or in 
and lb. Data entered for in and lb will be automatically converted to cm and kg to produce the correct 
results. 

Procedures for adding, editing, and deleting vital sign 
names 
To open the Vital Sign Names Select screen: 

• Select Maintenance > Templates > Vital Sign Names. The Vital Sign Names Select screen 
appears. 

To add a vital signs name: 

• On the Vital Sign Names Select screen, click the New button. Fill in the fields on the Vitals 
Maintenance screen, then click the OK button. 

To change a vital signs name: 

• On the Vital Sign Names Select screen, highlight the vital signs name that you want to change. 
Click the Edit button. Make the appropriate changes. You may not change the name of a vital 
sign once created. When you finish, click the OK button. 

To delete a vital signs name: 

• On the Vital Sign Names Select screen, highlight the vital signs name that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 
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Fields and buttons on the Vitals Maintenance screen 
Field Description 

Name Type the new vital sign name. 

Description Type a description of the new vital sign name. 

Units Type the unit used for the vital sign (if applicable). For example, 
for height you can select centimeters or feet/inches. 

Alt Units This feature has not yet been implemented. 

Conversion Select whether you want to use English or Metric 
measurements. 

Vital Type If you are creating a new vital sign, user-defined will be 
displayed in this field. If you have previously deleted a pre-
configured vital sign, you may select the deleted vital sign from 
this menu to create a new type.  

Data Type Select whether you want the data entered in text, numeric, or 
date format.  

Data Length Select the length of data that can be entered. The maximum 
length is 20 characters.  

Entry Type Select the type of field you want displayed for the clinical 
element. Your choices include: 

 Text box: Select this option to display a field that allows 
you to enter data. 

 Drop-down: Select this option to display a drop-down list. 
The user will be able to select only items from the drop-
down list. 

 Combo-box: Select this option to display a drop-down list. 
The user will be able to select items from the drop-down 
list or type in whatever they choose. 

 Check-box: Select this option to display a check box. 

 Radio button group: Select this option to present your list 
items as a group of radio buttons.  

 Label: Select this option to display a read-only label.  

Element List You can create your own lists to populate the choices users will 
have for the values of a vital sign using List Maintenance. Each 
list consists of a list of values which will determine the choices 
for a drop-down, combo-box, or radio button group. Click 
Lookup to display available lists. Select a list by highlighting it, 
and click the OK button.  

Attribute Type Attributes are additional pieces of data about a vital sign which 
are recorded along with the value of the vital sign itself. For 
instance, you might have a vital sign “Smoking” whose value 
would be the patient's smoking status, with an attribute “Packs 
per day” whose values might be “0.5”, “1”, or “2”. Enter the 
attribute name in this field. If you created list items using List 
Maintenance you can select a list for the attribute using the 
Attribute List Lookup button.  
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Attribute List Select the attribute list you want to use for the entered Attribute 
Type. If you created list items you can select the group of list 
items that you want to use by clicking the Lookup button. The 
Select List Name screen displays the defined list names. Select 
a name from the list by highlighting it, and click the OK button. 
The selected list name will be displayed in this field.  

Cross Ref. This feature has not yet been implemented. 

Code 1 This feature has not yet been implemented. 

Code 2 This feature has not yet been implemented. 

Formulas Select one of the available formulas (if applicable), or leave 
None as the default. Formulas currently available are: Age, 
Body Mass Index, Growth Velocity, Std. Deviation of Height for 
Age, Percentile for Height for Age, Std. Deviation of Weight for 
Age, Percentile of Weight for Age, Body Surface Area (BSA), 
and Creatinine Clearance. 

Profile This feature has not yet been implemented. 

Ranges If you want to enter normal value ranges, click this button. Enter 
the value range, then click the OK button to close this screen.  
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Clinical Element Names 
You can use the Clinical Element Names screen to define the clinical element names you want to 
appear in your templates. You can use the Ranges screen to define the normal and validation ranges 
for this data for both male and female patients. Range limits are optional.  

The names you enter here become permanent labels for the data items appearing in your clinical 
elements template. The clinical element names you use must be unique. 

Note: It is necessary to create clinical element names before you begin entering clinical element 
information in the patient chart. 

This screen also allows you to create prenatal element names and edit pre-configured names supplied 
by Patient Records. See the Prenatal Names section for a complete explanation.  

Procedures for adding, editing, and deleting clinical 
element names 
To open the Clinical Element Names Select screen: 

• Select Maintenance > Templates > Clinical Element Names. The Clinical Element Names 
Select screen appears. 

To add a clinical element name: 

• On the Clinical Element Names Select screen, click the New button. Fill in the fields on the 
Clinical Elements Maintenance screen, then click the OK button. 

To change a clinical element name: 

• On the Clinical Element Names Select screen, highlight the clinical element name that you 
want to change. You can also enter the full or partial name in the corresponding search field and 
click the Search button. The item with the closest matching name will be selected. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a clinical element name: 

• On the Clinical Element Names Select screen, highlight the clinical element name that you 
want to delete. You can also enter the full or partial name in the corresponding search field and 
click the Search button. The item with the closest matching name will be selected. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields and buttons on the Clinical Elements Maintenance 
screen 
Field Description 

Name Type the new clinical element name. This may not be modified 
when editing an existing clinical element. 

Description Type a description of the clinical element. 
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Units Type the unit used for the clinical element (if applicable). For 
example, for "Heart Murmur Intensity" you might enter "/6". 
 You will be able to modify the units when entering data.  

Alt Units This feature has not yet been implemented. 

Conversion This feature does not affect clinical elements. 

Vital Type This feature does not affect clinical elements. 

Data Type Select whether you want the data entered in text, numeric, or 
date format. 

Data Length Select the length of data that can be entered. The maximum 
length is 40 characters.  

Entry Type Select the type of field you want displayed for the clinical 
element. Your choices include: 

 Text box: Select this option to display a field that allows 
you to enter data. 

 Drop-down: Select this option to display a drop-down list. 
The user will be able to select only items from the drop-
down list. 

 Combo-box: Select this option to display a drop-down list. 
The user will be able to select items from the drop-down 
list or type in whatever they choose. 

 Check-box: Select this option to display a check box. 

 Radio button group: Select this option to present your list 
items as a group of radio buttons.  

 Label: Select this option to display a read-only label.  

Element List You can create your own lists to populate the choices users will 
have for the values of a Clinical Element. Each list consists of a 
list of values which will determine the choices for a drop-down, 
combo-box, or radio button group. Click Lookup to display 
available Lists. Select a list by highlighting it, and click the OK 
button.  

Attribute Type Attributes are additional pieces of data about a clinical element 
which are recorded along with the value of the element itself. 
For example, you might have a clinical element "Date of Injury" 
whose value would be a date, with an attribute "Degree of 
Certainty" whose values might be "low," "moderate," or "high." 
 Enter the attribute name in this field. If you created list items 
using List Maintenance you can select a list for the Attribute 
 using the Attribute List Lookup button.  

Attribute List Select the attribute list you want to use for the entered Attribute 
Type. If you created list items you can select the group of list 
items that you want to use by clicking the Lookup button. The 
Select List Name screen displays the defined list names. Select 
a name from the list by highlighting it, and click the OK button. 
The selected list name will be displayed in this field.  

Cross Ref This feature has not yet been implemented. 

Code 1 This feature has not yet been implemented. 

Code 2 This feature has not yet been implemented. 
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Formulas These formulas have not yet been implemented.  

Profile This feature has not yet been implemented. 

Ranges button If you want to enter normal value ranges, click this button. Enter 
the value range, then click the OK button to close this screen.  
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Prenatal names 
You can use the Prenatal Names screen to create the pregnancy-related Clinical Elements you want to 
appear in on the Prenatal Visit Flow Chart screen or on a Flow Chart or Clinical Elements screen. The 
PrenatalVisit template is the pre-configured flow chart template provided with Patient Records which 
determines what data is displayed on the Prenatal Visit Flow Chart screen. Prenatal Clinical Element 
names must be unique. 

Your system administrator can specify alternative column headers for an item in the PrenatalVisit 
template using the Prenatal Columns ppart.ini settings.  

Procedures for adding, editing, and deleting prenatal names 
To open the Prenatal Names Select screen: 

• Select Maintenance > Templates > Clinical Element Names. The Clinical Element Names 
Select screen appears. Select Prenatal Names from the drop-down menu. The Prenatal Names 
Select screen appears. 

To add a prenatal name: 

• On the Prenatal Names Select screen, click the New button. Fill in the fields on the Prenatal 
Maintenance screen, then click the OK button. Only the Name field is required. 

To change a prenatal name: 

• On the Prenatal Names Select screen, highlight the prenatal name that you want to change. You 
can also enter the full or partial name in the corresponding search field and click the Search 
button. The item with the closest matching name will be selected. Click the Edit button. Make the 
appropriate changes. Please note you can only modify the prenatal description. When you finish, 
click the OK button. 

To delete a prenatal name: 

• On the Prenatal Names Select screen, highlight the prenatal name that you want to delete. You 
can also enter the full or partial name in the corresponding search field and click the Search 
button. The item with the closest matching name will be selected. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 

Fields on the Prenatal Maintenance screen 
Field Description 

Name Type the prenatal name. 

Description Type a description of the prenatal name. 

Units Type the unit used for the prenatal clinical element (if 
applicable). For example, for "Heart Murmur Intensity" you 
might enter "/6".  You will be able to modify the units when 
entering data.  

Alt Units This feature has not yet been implemented. 

Conversion This feature does not affect prenatal clinical elements. 
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Vital Type This feature does not affect prenatal clinical elements. 

Data Type Select whether you want the data entered in text, numeric, or 
date format. 

Data Length Select the length of data that can be entered. The maximum 
length is 40 characters.  

Entry Type Select the type of field you want displayed for the prenatal 
clinical element. Your choices include: 

 Text box: Select this option to display a field that allows 
you to enter data. 

 Drop-down: Select this option to display a drop-down list. 
The user will be able to select only items from the drop-
down list. 

 Combo-box: Select this option to display a drop-down list. 
The user will be able to select items from the drop-down 
list or type in whatever they choose. 

 Check-box: Select this option to display a check box. 

 Radio button group: Select this option to present your list 
items as a group of radio buttons.  

 Label: Select this option to display a read-only label.  

Element List You can create your own lists to populate the choices users will 
have for the values of a Prenatal Clinical Element. Each list 
consists of a list of values which will determine the choices for a 
drop-down, combo-box, or radio button group. Click Lookup 
to display available Lists. Select a list by highlighting it, and click 
the OK button.  

Attribute Type Attributes are additional pieces of data about a prenatal clinical 
element which are recorded along with the value of the 
element itself. Enter the attribute name in this field. If you 
created list items using List Maintenance you can select a list for 
the Attribute  using the Attribute List Lookup button.  

Attribute List Select the attribute list you want to use for the entered Attribute 
Type. If you created list items you can select the group of list 
items that you want to use by clicking the Lookup button. The 
Select List Name screen displays the defined list names. Select 
a name from the list by highlighting it, and click the OK button. 
The selected list name will be displayed in this field.  

Cross Ref This feature has not yet been implemented. 

Code 1 This feature has not yet been implemented. 

Code 2 This feature has not yet been implemented. 

Formulas These formulas have not yet been implemented.  

Profile This feature has not yet been implemented. 

Ranges button This feature has not yet been implemented. Ranges at this time 
do not have an effect on the data as it is displayed or printed. 
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Health maintenance templates 
The health maintenance feature tracks periodic patient treatments such as examinations, tests, and 
immunizations. Before this information can be tracked in the patient chart, you must establish health 
maintenance schedules for specific groups of patients (for example, by sex, age, or problem). Setting 
up the schedules is a two-part process: first, you create health maintenance procedure names; then, 
you use the procedure names in health maintenance templates. 

You can use health maintenance templates to create health maintenance schedules for various 
procedures for your patients. You can create templates by age/sex, problem, medication, protocol, or 
pregnancy. Once you define the procedures associated with the template, you assign these templates 
to your patients. Through the patient chart, you can also customize health maintenance templates for 
individual patients. 

Universal templates are available to all providers. You can also add templates for a specific provider to 
reflect the style and organization preferred by the specified provider. 

How age ranges are used in health maintenance templates 
Standard age ranges for the templates that come with Lytec MD are 0 to 2, 3 to 10, 11 to 18, 19 to 39, 
40 to 49, 50 to 59, and 60 to 100 years old. However, you can use different age ranges.  

As patients age, their age/sex templates can be automatically changed to the correct one by running 
the Age Health Maintenance Template utility from the Utilities menu once per month or by running the 
utility as a standalone utility through Windows scheduler to run once each month. 

The age ranges defined in health maintenance templates ordinarily should not overlap. For example, 
you shouldn't define one template for males ages 21 to 40 and another for males ages 30 to 35. We 
recommend that you set up your templates for reasonably narrow age ranges (for example, 10 to 20 
years) and simply re-enter the same procedures in several templates, if they are applicable. 

Rule files for health maintenance procedures 
You can use Health Maintenance (HM) rule files to determine overdue/not overdue status for HM 
procedures with more complex logic than the standard options in HM. HM rule files may contain letter 
codes as well as special “HM Rule Codes” described below. 

The person designing the rule files should be familiar with the basics of programming and using 
conditional logic.  

Conditional logic evaluates specific statements to be either true or false, and generates results based 
upon whether the statements are true or not. This system uses the IF-ELSE statement to determine the 
results.  

Components of HM rule files: 

• Comparison Operators: =,<>,<,<=,>,>=  

• Logical operators: IF, ELSE, AND, OR  

• Letter Code: Any Lytec MD Letter Code may be used in an HM Rule File. These allow you to 
access information regarding patient demographics, laboratory data, other health maintenance 
tests, diagnoses, medications, etc. 

• HM Rule Codes: See below 

• HM Rule File Variables: See below 

• Arithmetic Operator: PLUS, MINUS, TIMES, DIVIDED_BY 
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• Count Variable: Any HM Rule File may contain up to nine numerical variables, named “COUNT1”, 
“COUNT2”,…”COUNT9”. Arithmetic Operators are applied to Count Variables in HM Rule Files. 
The value of any Count Variable is 0 until defined with an Arithmetic Operator. 

• Outcome Operators:  

• RETURN IS_OVERDUE 

• RETURN NOT_OVERDUE 

• DO_ONCE (at start of the template) 

• DO_ONCE_WITHIN XXX DAY/MONTH/YEAR 

• DO_EVERY XXX DAY/MONTH/YEAR 

• DO_IN XXX DAY/MONTH/YEAR 

• DO_AT_GESTATIONAL_AGE XXX 
This Outcome Operator is for use in HM Procedures that are attached to a Pregnancy-type HM 
Template. XXX is either a number representing gestational age in weeks or the word INITIAL, 
indicating the procedure be performed at the onset of prenatal care) 

Notes: 
- We recommend using line breaks to separate various components of your rule file, as done in the 
examples provided in this document. This will make your rule files more easily readable and less 
confusing, and help avoid errors. However, line breaks are ignored by the program. 
 
- Spaces are required before and after comparison operations and logical operators. You do not need 
to include a space at the beginning of a line, or if the operation is proceeded by a brace (i.e., {).  
 
- The instructions after an IF or ELSE statement must be enclosed in {curly braces} (see examples 
below). 
 
- If an HM rule file contains more than one IF clause they must be separated by an ELSE clause (see 
example in the section on Order rule files. 
 
- Logical Operators, Arithmetic Operators, and Time Operators must be capitalized. 
 
- You cannot use both AND and OR logical operators within a single IF clause. The IF clause may 
produce an unexpected result if you use both logical operators.  
 
- If the end of a rule file is reached without reaching an Outcome Operator, the HM Procedure is set to 
Not Overdue and no due date will appear. 

The following table displays the available HM rule codes and their descriptions. 

HM Rule Code Description 

COUNTHM<hm_name> When included in a HM Rule, this Rule Code 
resolves to a non-negative integer representing 
the number of times the specified health 
maintenance procedure has been performed 
 (“performed”  means it has a value of “X”, “E”, or, 
if the check box ‘For overdue HM, status O = X’ 
on the Records 6 tab of Special Features screen is 
checked, “O”). For example, if the HM record for 
a patient has item BP recorded as having been 
done three times then 
IF COUNTHM<BP> = “3” 
{RETURN NOT_OVERDUE} 
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ELSE
{RETURN IS_OVERDUE} 
would set the HM Procedure to Not Overdue. 

COUNTHM_WITHIN<hm_name> xxxx 
DAY/MONTH/YEAR 

When included in a HM Rule, this Rule Code 
resolves to a non-negative integer representing 
the number of times the specified health 
maintenance procedure has been performed 
within the specified time period (“performed” 
 means it has a value of “X”, “E”, or, if the check 
box ‘For overdue HM, status O = X’ on the 
Records 6 tab of Special Features screen is 
checked, “O”). For example, if the patient's blood 
pressure has been taken 5 times within the last 6 
months then 
IF COUNTHM_WITHIN<BP> 6 MONTH > “4” 
{RETURN NOT_OVERDUE} 
would set the HM Procedure to Not Overdue. 
Please note you must include either DAY, 
MONTH, or YEAR. 

DATE_START_PROTOCOL<TEMPLATE_NAME> When included in a HM Rule, this Rule Code 
resolves to the date that the specified HM 
Template was applied to the patient. For 
example: 
IF DATE_START_PROTOCOL<LAMISIL> < 
"01/01/2007" 
{RETURN NOT_OVERDUE} 
ELSE 
{RETURN IS_OVERDUE} 
Would return a value of Overdue if the “Lamisil” 
HM Template had been applied to the patient on 
or after January 1, 2007. 

DIAGNOSIS<diagnosis_name> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific diagnosis name on their 
Diagnosis list (in the Problems/Procedures 
section of their chart). For example, if a patient 
has “HYPERTENSION” on his or her diagnosis list, 
then 
IF DIAGNOSIS<HYPERTENSION> = “TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. Note 
that Diagnoses marked as “Inactive” will be 
ignored. 

DIAGNOSIS_CODE<diagnosis_code> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 
1 or Code 2 fields of an entry on their Diagnosis 
list (in the Problems/Procedures section of their 
chart). For example, if a patient has a diagnosis 
with code "401.9" on his or her diagnosis list, 
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then
IF DIAGNOSIS_CODE<401.9> = “TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. Note 
that Diagnoses marked as “Inactive” will be 
ignored. 

GET HM_LATEST<hm_name> Gets the most recent value for the specified 
health maintenance Procedure. The values are 
entered by users on the Health Maintenance 
Procedure screen or through the .H Dot codes. 
The value retrieved is stored in the Rule File 
Variable “HM_VALUE” and the date in the Rule 
File Variable “HM_DATE.” These variables can 
then be used in an IF clause.  Note that if no 
result is returned then the HM_DATE variable will 
be set to “” 
Possible values are: 
X-Done 
E-Done Elsewhere 
N-Not applicable 
R-Refused 
P-Postponed 
O-Ordered 
For example, if a patient’s last recorded value for 
the HM Procedure BP was “E” then the rule file: 
GET HM_LATEST<BP> 
IF HM_VALUE = "E" 
{RETURN NOT_OVERDUE} 
ELSE 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Not Overdue. 

GET HM_LATEST_WITHIN<hm_name> xxxx 
DAY/MONTH/YEAR 

Gets the most recent value for the specified 
health maintenance Procedure within the 
specified date period. The values are entered by 
users on the Health Maintenance Procedure 
screen or through the .H Dot codes. The value 
retrieved is stored in the Rule File Variable 
“HM_VALUE” and the date in the Rule File 
Variable “HM_DATE.” Note that if no result is 
returned then the HM_DATE variable will be set 
to “”. 
For example, if a patient’s last recorded value for 
the HM Procedure BP was “R” on a date 7 months 
ago, the following rule file would set the HM 
Procedure to Overdue. If, however, it was “R” on 
a date 5 months ago, the rule file would set the 
HM Procedure to Not Overdue: 
GET HM_LATEST_WITHIN<BP> 6 MONTH 
IF HM_VALUE = "R" 
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{RETURN NOT_OVERDUE}
ELSE 
{RETURN IS_OVERDUE} 

GET HM_FIRST<hm_name> Get the first (oldest) results for the specified 
health maintenance Procedure and stores it in the 
Rule File Variable “HM_VALUE”. The date of the 
HM Procedure is stored in the Rule File Variable 
“HM_DATE.” Note that if no result is returned 
then the HM_DATE variable will be set to “”. 

GET HM_NEXT<hm_name> Get the next results for the specified health 
maintenance item and stores it in the Rule File 
Variable “HM_VALUE”. Can be used along with 
GET HM_PREVIOUS. This command must be 
preceded by a GET HM_LATEST, GET 
HM_LATEST_WITHIN, or GET_HM_FIRST 
command. The date of the HM Procedure is 
stored in the Rule File Variable “HM_DATE.” Note 
that if no result is returned then the HM_DATE 
variable will be set to “”. For example: 
GET HM_FIRST<BP> 
IF HM_VALUE <> "R" 
{ 
DO_EVERY 1 YEAR 
} 
ELSE 
{ 
GET HM_NEXT<BP> 
IF HM_VALUE <> "R" 
{ 
DO_EVERY 1 YEAR 
} 
ELSE 
{ 
NOT_OVERDUE 
} 
} 

GET HM_PREVIOUS<hm_name> Get the previous results for the specified health 
maintenance item. Can be used along with GET 
HM_NEXT. This command must be preceded by 
a GET HM_LATEST, GET HM_LATEST_WITHIN, or 
GET_HM_FIRST command.   

GET LAB_LATEST_WITHIN<lab_name> xxxx 
DAY/MONTH/YEAR 

Get the most recent value for the specified lab 
data item within the specified date period. The 
value retrieved is stored in the Rule File Variable 
“LAB_VALUE” which can then be used in an IF 
clause. In addition, the date is stored in 
LAB_DATE, and the normal/abnormal flag in 
LAB_STATUS (for the latter, c = critical high, b = 
critical low, h = high, l = low, a = abnormal, and n 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 234 

 

= normal). Note that if no result is returned then 
the LAB_DATE variable will be set to “”. 
For example, if a patient’s last sodium was 150 on 
a date 7 months ago, the following rule file would 
set the HM Procedure to Not Overdue. If, 
however, it was 150 on a date 5 months ago, the 
rule file would set the HM Procedure to due every 
1 month: 
GET LAB_LATEST_WITHIN<SODIUM> 6 MONTH 
IF LAB_VALUE > "150" 
{DO_EVERY 1 MONTH} 
ELSE 
{RETURN NOT_OVERDUE} 

GET LAB_LATEST<lab_name> Get the most recent value for the specified lab 
data item within the specified date period. The 
value retrieved is stored in the Rule File Variable 
“LAB_VALUE” which can then be used in an IF 
clause. In addition, the date is stored in 
LAB_DATE, and the normal/abnormal flag in 
LAB_STATUS (for the latter, c = critical high, b = 
critical low, h = high, l = low, a = abnormal, and n 
= normal). Note that if no result is returned then 
the LAB_DATE variable will be set to “”. 

GET LAB_FIRST<lab_name> Get the first (oldest) value for the specified lab 
data item within the specified date period. The 
value retrieved is stored in the Rule File Variable 
“LAB_VALUE” which can then be used in an IF 
clause. In addition, the date is stored in 
LAB_DATE, and the normal/abnormal flag in 
LAB_STATUS (for the latter, c = critical high, b = 
critical low, h = high, l = low, a = abnormal, and n 
= normal). Note that if no result is returned then 
the LAB_DATE variable will be set to “” 

GET LAB_NEXT<lab_name> Get the next results for the specified lab data 
item. In addition, the date is stored in LAB_DATE, 
and the normal/abnormal flag in LAB_STATUS 
(for the latter, c = critical high, b = critical low, h = 
high, l = low, a = abnormal, and n = normal). 
 Note that if no result is returned then the 
LAB_DATE variable will be set to “”. 

GET LAB_PREVIOUS<lab_name> Get the previous results for the specified health 
maintenance item and stores it in the Rule File 
Variable “LAB_VALUE”.  In addition, the date is 
stored in LAB_DATE, and the normal/abnormal 
flag in LAB_STATUS (for the latter, c = critical 
high, b = critical low, h = high, l = low, a = 
abnormal, and n = normal). Note that if no result 
is returned then the LAB_DATE variable will be 
set to “”. For example, the following rule file will 
set the HM Procedure to which it is linked to “Do 
Every 1 month” if either of the last two sodium 
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levels were over 150; otherwise the HM 
Procedure will be set to Not Overdue. 
GET LAB_LATEST<SODIUM> 
IF LAB_VALUE > "150" 
{ 
DO_EVERY 1 MONTH 
} 
ELSE 
{ 
GET LAB_PREVIOUS<SODIUM> 
IF LAB_VALUE > "150"  
{ 
DO_EVERY 1 MONTH 
} 
ELSE  
{ 
NOT_OVERDUE 
} 
} 

MAJOR_PROBLEM<problem_name> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific diagnosis name on their 
Major Problem list (in the Problems/Procedures 
section of their chart). For example, if a patient 
has “HYPERTENSION” on his or her Major 
Problem list, then 
IF MAJOR_PROBLEM<HYPERTENSION> = 
“TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. Note 
that Problems marked as “Inactive” will be 
ignored. 

MAJOR_PROBLEM_CODE<problem_code> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 
1 or Code 2 fields of an entry on their Major 
Problem list (in the Problems/Procedures section 
of their chart).  For example, if a patient has a 
Major Problem with code “401.9”, then 
IF MAJOR_PROBLEM_CODE<401.9> = “TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. Note 
that Problems marked as “Inactive” will be 
ignored. 

MEDICATION<med_name> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a particular medication on their 
current medications list. For example, if a patient 
has medication Lisinopril on his or her Current 
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Medication list, then
IF MEDICATION<LISINOPRIL> = "TRUE" 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. 

MEDICATION CLASS<med_name> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has any medication in the same class 
as a particular medication on their current 
medications list. For example, if a patient has any 
ACE Inhibitor (a drug class of which Lisinopril is a 
member) on his or her Current Medication list, 
then 
IF MEDICATION CLASS<LISINOPRIL> = "TRUE" 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. 

PROCEDURE_CODE<procedure_code> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 
1 or Code 2 fields of a Procedure record (in the 
Problems/Procedures section of their chart). For 
example, if a patient has a Procedure with code 
“12345”, then 
IF PROCEDURE_CODE<12345> = “TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. 

OTHER_PROBLEM<problem_name> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific name on their Other 
Problem list (in the Problems/Procedures section 
of their chart). For example, if a patient has 
“HYPERTENSION” on his or her Other Problem 
list, then 
IF OTHER_PROBLEM<HYPERTENSION> = 
“TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. Note 
that Problems marked as “Inactive” will be 
ignored. 

OTHER_PROBLEM_CODE<problem_code> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 
1 or Code 2 fields of an entry on their Other 
Problem list (in the Problems/Procedures section 
of their chart).  For example, if a patient has a 
Other Problem with code “401.9”, then 
IF OTHER_PROBLEM_CODE<401.9> = “TRUE” 
{RETURN IS_OVERDUE} 
would set the HM Procedure to Overdue. Note 
that Problems marked as “Inactive” will be 
ignored. 
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Here is an example rule file which combines a number of the elements described above: 

This rule file can be used to determine whether a patient should be considered overdue for an adult 
tetanus-diphtheria-pertussis vaccine (Tdap). As of 2006, current guidelines call for a one-time booster 
dose of Tdap in place of the every-10-year Td if it has been > 10 years since the last Td. This rule file 
would be applied to a HM Procedure “Tdap” in a system where there is a HM Procedure “Td” to 
represent the Td immunization. 

IF COUNTHM<Tdap> > “0” 

{RETURN NOT_OVERDUE} 

ELSE 

{IF COUNTHM_WITHIN<Td> 10 YEAR = “0” AND PAT_AGE > “18” 

{RETURN IS_OVERDUE}} 

To create a health maintenance rule file:  

1. Use a text editor (for example, Windows Notepad) to create an ASCII text file that contains the 
rules.  

2. Save the file with a .txt extension in the Lytec MD database directory (the default directory is 
P:\ppart, but your database path may be different). 

Utilities to help you manage health maintenance templates 
In general, it is a good idea to define your health maintenance templates before you begin entering 
patient information in Lytec MD. However, it is often difficult to determine what the optimal templates 
are for your practice before you have had much experience with Lytec MD. In addition, as national 
recommendations for health maintenance evolve, you will need to change your templates occasionally. 
When you modify a template, the changes apply instantly to all the patients to which the template is 
applied.  

However, you may want to change the name of a health maintenance item. Since patients can have 
existing data, you need a utility to change the name of health maintenance items on all existing patient 
data.  You can use the health maintenance utilities to make these changes. Be sure to back up your 
data before you run any of these utilities.  

In addition, as patients change age groups, they will need new age/sex templates applied. The Age 
Health Maintenance Utility can do this. 

Patient Records provides the following health maintenance utilities:  

• Age Health Maintenance Template utility - Changes the templates for individual patients who 
have moved into a new age group. You should run this utility monthly. You can also run this 
regularly as a standalone utility through the Windows scheduler. 

• Convert Health Maintenance utility - Changes the names of health maintenance procedures. 

• Health Maintenance Protocols utility - Applies health maintenance templates to a list of patients 
or all patients who do not yet have templates applied.  

Adding, editing, and deleting health maintenance templates 
To open the health maintenance templates screen: 

1. Select Maintenance > Templates > Health Maintenance Templates. The Provider/Practice 
Selection screen appears. 
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2. Select the provider whose templates you want to access, or leave the Provider ID field blank to 
access universal templates (that is, templates that can by used by all providers).   

3. If you are using Appointment Scheduler Enterprise, you must select a practice in the Practice ID 
field.  

4. Click the OK button. The Health Maintenance Templates screen appears. 

To filter the templates that display on the health maintenance templates screen: 

• In the Display by frame (at the top of the screen), click the button that corresponds to the type of 
template that you want to access. You can view All templates, only Age/Sex templates, only 
Medication templates, only Problem/Dx templates, only Protocol templates, or only Pregnancy 
templates. 

To add a health maintenance template: 

• On the Health Maintenance Templates screen, click the New button. Fill in the fields on this 
screen, then click the OK button. 

To change a health maintenance template: 

Note: If necessary, you can add or change the list of health maintenance procedures on the template 
or the intervals at which the procedures should be performed.  

• On the Health Maintenance Templates screen, highlight the health maintenance template that 
you want to change. Click the Edit button. Make the appropriate changes. When you finish, click 
the OK button. 

To delete a health maintenance template: 

When you delete a health maintenance template, the template will be removed from all patients 
assigned the template, and all related data will be made historical.  

Please note this may take some time. 

• On the Health Maintenance Templates screen, highlight the health maintenance template that 
you want to delete. Click the Delete button. A message asks you to confirm the deletion. Click 
the OK button. 

Fields on the Health Maintenance Template Maintenance 
screen 
Field Description 

Name Type the name of the new health maintenance template. 
The name cannot end with a [space] followed by one of the 
following health maintenance status characters: X, R, E, N, P, O 
For example, names not allowed include TD X and Blood 
Pressure R. 
Also, while you can add multiple templates with the same name 
for different providers, templates assigned to patients must 
have unique names (for example, you cannot assign two 
"TDTemplates" to the one patient). 

Type Select the template type. The options are Age/Sex, 
Problem/Dx, Medication, Protocol, and Pregnancy.  
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Top right corner The box in the top right corner of the screen changes 
depending on the template type you select. The options for 
each type are listed below. 

     Age/Sex If the type is Age/Sex, select the appropriate gender and type 
the age range (from/to). 
If a template applies to patients of any age, simply enter a 
range from 0 to an arbitrarily high number (for example, 120). 
Keep in mind, however, that age ranges ordinarily should not 
overlap between templates.  
To define this template for patients of both sexes, you can 
create separate but identical templates for males and females. 

     Problem/Dx Type the problem name. You can also click the Look Up button 
and locate the diagnosis code from the list. 
To add a synonym for the problem, click the Synonym button. 

     Medication Type the medication name. You can also click the Search button 
and locate the medication code from the list. 
To add a synonym for the problem, click the Synonym button. 

     Protocol Type the protocol name.  

     Pregnancy / Problem Type the pregnancy name or problem name. You can also click 
the Look Up button and locate the diagnosis code from the list. 
To add a synonym for the problem, click the Synonym button.  

Description Type a short description of the new template. 

Info File To link a health maintenance information file to the template, 
type the file name in this field. 

HM Procedure This column displays the health maintenance procedures that 
have been added to the template. You can add up to 50 
procedures to the template. 

 To add a procedure, click the New Proc button. Select the 
appropriate procedure, then click the OK button. Set up 
the health maintenance procedure's rules, then click the 
OK button. 

 To change a procedure from the template, highlight the 
procedure that you want to change. Click the Edit Proc 
button. Make the appropriate changes. When you finish, 
click the OK button. 

 To delete a procedure from the template, highlight the 
procedure that you want to delete, and then click the 
Delete Proc button. A message appears, indicating that 
Lytec MD will need to update patient Health Maintenance 
data, and asks you to confirm that you want to proceed 
with the deletion. Click the OK button to continue. 
 
You will receive another message when you attempt to 
save the Health Maintenance template, indicating that 
patient Health Maintenance data will be updated and you 
must not stop the process. Click Yes to continue. 

Note: If the deleted template has been applied to patients, 
and data has been entered for the procedure you have 
deleted, the relevant patient data is automatically marked 
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as historical and moved to the Historical Health 
Maintenance Summary screen. 

Rule Summary This column displays the rules that have been set up for the 
corresponding health maintenance procedure. 
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Health maintenance synonyms 
You can specify alternate names, called "synonyms," for medications and problems/diagnoses. (Note 
that in Lytec MD, "synonyms" refers to alternate names for health maintenance procedures as well.)  

Adding and deleting health maintenance synonyms 
To open the health maintenance synonym screen: 

• On the Health Maintenance Template screen, when the type is Medication or Problem/Dx, click 
the Synonym button in the top right corner. The Health Maintenance Synonyms screen appears. 

To add a health maintenance synonym: 

• On the Health Maintenance Synonyms screen, click the New button (you can also click ALT+C). 
On the Health Maintenance Synonyms <New> screen, type the synonym. When you finish, click 
the OK button. 

To delete a health maintenance synonym: 

• On the Health Maintenance Synonyms screen, highlight the health maintenance synonym that 
you want to delete. Click the Delete button (you can also click ALT+D). A message asks you to 
confirm the deletion. Click the Yes button. 
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Health maintenance procedure rules 
When you are setting up a health maintenance template, you can create rules for the procedures in the 
template. Rules define when and how the procedure should be accomplished.  

In addition to the pre-defined rules provided in Lytec MD, you can create customized rule files. 

How Lytec MD implements rules 

A health maintenance procedure can have the following frequencies:  

• Do once in xx days/weeks/months 

• Do every xx days/months/years for xx times  

• Do at ages xx 

Lytec MD uses both the frequency and the selected template to determine when the procedure should 
be completed, and therefore whether the procedure is either up-to-date or overdue. The application 
determines the Procedure Start Date (application date) as follows: 

• Do once in frequency: If the Age/Sex template is selected and the Special Features setting 
“Track Health Maintenance Using Date of Registration” is disabled the patient’s date of birth will 
be used as the start date. The start date is based on the patient’s 1st birthday from the start of the 
template age range. For example, the patient’s date of birth is 6/20/2000, and the applied 
template goes from 5-7 years of age. This means the patient must complete the visit within 10 
days of their birthday. 

If the “Track Health Maintenance Using Date of Registration” setting is enabled, the patient’s 
registration date will be used as the start date. 

• Do every frequency: If an Age/Sex template is selected and the Special Features setting “Track 
Health Maintenance Using Date of Registration” is disabled and the health maintenance 
procedure has never been recorded, the start date will be the date the template was applied, 
thus making the procedure immediately overdue if the template was applied today or previous 
to today. If there are existing procedures or data then the most recent date will be used as the 
start date. If the setting is enabled, the patient’s registration date will be used as the start date. 

If the patient has not received the treatment before and a Non-Age/Sex template is applied, then 
the Do every rule is based on the date the template was applied. For example, the Do every 
frequency is once a month and the template is applied June 1st, thus the start date will be July 1st.   

If the patient has received a previous treatment before and an Age/Sex template is applied, the Do 
every rule is based on the date of the previous treatment. For example, a patient receives treatment 
for MMR on June 1st. The selected Do every frequency is once a month and the template is applied 
on June 5th, thus the start date will be July 1st. 

• When the Medication, Protocol and Individual templates and any of the frequencies are 
selected, the date of the application will be used as the start date. 

• When a Problem template is selected the most recent health maintenance procedure date will 
be used as the start date. If there are no procedures the start date will be the date the template 
was applied.  
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Fields on the Health Maintenance Procedure Rules screen 
Field Description 

Do once in Use this field when you want the procedure done once in a set 
number of days, months, or years from now. 
In the first field, type the interval number at which the 
procedure should be performed. In the second field, select the 
type of interval (days, months, or years). 

Note: Pregnancy procedures using this rule will be displayed in 
the Other section on the Prenatal Lab/Plan screen.  

Do every __ for __ times Use this field when you want the procedure done in a set 
number of days, months, or years for a specific number of 
times. 
In the first field, type the interval number at which the 
procedure should be performed. In the second field, select the 
type of interval (days, months, or years). In the third field, type 
the number of times the procedure should be performed (this 
field can be left blank). 

Note: Pregnancy procedures using this rule will be displayed in 
the Other section on the Prenatal Lab/Plan screen. 

Do at ages Use this field when you want the procedure done at specific 
ages. You can specify up to 10 ages. 
Type the year (using a yyy format), followed by the month 
(using a mm format) for each age. For example, if you want the 
procedure performed at age 2 years and 6 months, type 
002/06. To perform a procedure at age 55 and 9 months, type 
055/09. 

Count Procedures Select this check box when the number of procedures done is 
more important than whether the last one is done (this is 
important, for example, with children's immunizations).  

Min. Interval Use this field to specify that the timing between procedures 
must be at least the amount of time you specify (in days, 
months, or years). Please note this setting only applies if the 
Count Procedures option is selected. 
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Initial  Select this check box if the procedure is intended to be 
performed at the onset of prenatal care.  
When selected all fields on the HM Procedure Rules screen will 
be unavailable except for the Required, Lab Test, and Info File 
fields. 
When selected all fields on the HM Procedure Rules screen will 
be unavailable, except, the Required, Lab Test, and Info File 
fields. 
To display the procedure under the Initial section on the 
Prenatal Lab/Plan screen, select this check box, and the 
Required check box. If the Required check box is not checked, 
this procedure will be displayed under the Optional section on 
the Prenatal Lab/Plan screen. 

Note: This option is only for HM Pregnancy templates.  

Gestational Age Enter the gestational age at which the procedure should be 
completed. When selected, all fields on the HM Procedure 
Rules screen will be unavailable, except, the Required, Lab 
Test, and Info File fields. 
The procedure will be displayed under the corresponding 
gestational age section on the Prenatal Lab/Plan screen. For 
example, if you enter a procedure that needs to be completed 
when the gestational age is 10 weeks, the procedure will be 
included in the 8+ section. 

Note: This option is only for HM Pregnancy templates.  

Required Select this check box to indicate that the procedure is intended 
to be performed in all or almost all pregnancies. For required 
procedures a "Y" will be displayed in the Req field on the 
Prenatal Lab/Plan screen.  
Note: This option is only for HM Pregnancy templates.  

Lab Test Select this check box if the procedure is a lab test. If the 
procedure is not a lab test, do not select this check box.  

Note: This option is only for HM Pregnancy templates.  

Do according to formula Use this field when you want the procedure done according to 
a pre-specified formula. 
Select the formula from the drop-down field. 

Do according to rule file Use this field when you want the procedure done according to 
a pre-specified rule file. 
Type the path to the rule file. 

Info file For health maintenance items, you can create customized 
health maintenance information files that provide "help" 
information to providers about the template or procedure. 
Use this field to link a health maintenance information file to the 
procedure. Type the path to the file (a full path must be 
provided if the file is not in the Lytec MD directory). 
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Health maintenance: additional setup 
You can use Lytec MD's data loaders to update or load health maintenance information. You can: 

• Update a health maintenance procedure through the Laboratory Data Loader. This works if the 
laboratory data name matches a health maintenance item or if there is an entry for the laboratory 
data name in the health maintenance Laboratory Data Loader cross-reference file 
(HMLBXREF.FL). 

• Load a report with the same name as a health maintenance item (for example, mammography), 
with the Text Data Loader to update the procedure automatically. It is also updated if the report 
title is in the health maintenance Text Data Loader cross-reference file (HMTXXREF.FL). 

Using the Lab Data Loader to update health maintenance 
data 
In addition to recording laboratory data, you can use the Laboratory Data Loader to update health 
maintenance procedures for your patients. If the health maintenance procedure names match 
laboratory test names, health maintenance procedures are updated automatically in the Health 
Maintenance section of the patient chart.  

If health maintenance procedure names and laboratory test names do not match, you can create a 
cross-reference file that links the health maintenance procedure name with the laboratory data name. 
To do this, create a file named HMLBXREF.FL with any text editor that can create a text-only (that is, 
ASCII) file. The file should contain a table in the following format:  

hmname : labname1, labname1 ...  
hmname: labname1, labname2 ...  

where hmname is a health maintenance procedure name, and labname1 and labname2 are the names 
of laboratory tests. When the results of a lab test satisfy a scheduled health maintenance procedure, the 
health maintenance status will be updated automatically.  

For example, if the HMLBXREF.FL file contains:  

U/A : U. PROTEIN  
TFT : T4, TSH  

then the results of the urine protein test (U. Protein) will update the U/A health maintenance item. The 
results of the T4 or TSH tests will automatically update the TFT (that is, thyroid function test) health 
maintenance item.  

The HMLBXREF.FL file is case-sensitive, which means that entries in the file must exactly match the lab 
names in Patient Records. You must use the appropriate uppercase and lowercase characters. If the lab 
name is SODIUM, the entry in the cross-reference file must also be SODIUM, not Sodium or another 
variation.  

Using the Text Data Loader to load health maintenance data 
Sometimes the Text Data Loader is used to load data from sources where procedure names may be 
different than the ones defined in your own health maintenance templates.  

To make sure this data updates the appropriate health maintenance procedures, you can create a 
health maintenance Text Data Loader cross-reference file named HMTXXREF.FL.  
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This file should have the following format, where the title is the name following the Title (.T:) Dot code 
in the data loaded from the outside source:  

hmname1: title1  
hmname2: title1, title2...  

For example:  

Mammog: Mammography, Mammogram  

This means that for the above example, if Mammography is the title but the health maintenance 
procedure is Mammog, the health maintenance procedure will still be updated.  

Note: The matching of HMTXXREF.FL data to note titles is not case-sensitive.  

Note: The maximum number of characters per line in the HMTXXREF.FL is 300.  

Health maintenance information files  
For health maintenance items, you can create customized help files that contain information about 
health maintenance procedures. Once you have created health maintenance help files, you can access 
them from the health maintenance screen whenever you need information about a procedure.  

Your system administrator can link health maintenance information files to procedures in templates. 

To create a health maintenance information file:  

1. Use a word processor or text editor (for example, Windows Notepad) to create an HTML or 
ASCII text file containing the help information.  

2. Save the file in the Lytec MD database directory. 

3. Link the information file to a health maintenance template. 

To display a health maintenance information file: 

• On the Health Maintenance Summary screen, double-click the procedure name or template. 
 
If two templates have the same procedure, and these procedures have different information files, 
a message asks which information file you want to view. 
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Past medical history templates 
You can use the patient history templates to customize the past medical history section of the patient 
chart for your own practice.  

For example, you can create a form for the past medical history section that has a space for “childhood 
illnesses,” “hospitalizations,” and other categories of information.  

You can add or edit text in the past medical history section to create a convenient format for medical 
history information. If you have renamed any of the History sections of the chart, these tabs display your 
new name instead.  

You can create one template for each of the history types: past medical history, social history, and 
family history. To make the templates complete but easily shortened during data entry, you can make 
liberal use of the «del» labels.  

Adding and editing the past medical history template 
To add or edit the past medical history template: 

1. Select Maintenance > Template > Past Medical History Templates. 
• If a history template does not exist, you are asked if you would like to create a new 

template. Click the Yes button. The Past Medical History Template screen appears.  

• If a template exists, the Past Medical History Template screen appears. Click the Edit 
button.  

2. Enter the template. For example, you can:  
• Type text.  

• Insert Dot codes and letter codes. Select Insert > QuickText, or click the QText button on 
the tool bar.  

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  

3. When you finish, click the OK button to save the template.  

To delete the past medical history template: 

1. Select Maintenance > Template > Past Medical History Templates. The Past Medical History 
screen appears.  

2. Select Edit > Delete Note. A message asks you to confirm the deletion. 

3. Click the OK button.  
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Social history templates 
You can use the patient history templates to customize the social history section of the patient chart for 
your own practice.  

For example, you can create a form for the social history section that has a space for “marital status,” 
"children,” and other categories of information.  

You can add or edit text in the social history section to create a convenient format for medical history 
information. If you have renamed any of the History sections of the chart, these tabs display your new 
name instead.  

You can create one template for each of the history types: past medical, social, and family. To make the 
templates complete but easily shortened during data entry, you can make liberal use of the «del» 
labels.  

Adding and editing the social history template 
To add or edit the social history template: 

1. Select Maintenance > Template > Social History Templates. 
• If a history template does not exist, you are asked if you would like to create a new 

template. Click the Yes button. The Social History Template screen appears.  

• If a template exists, the Social History Template screen appears. Click the Edit button.  

2. Enter the template. For example, you can:  
• Type text.  

• Insert Dot codes and letter codes. Select Insert > QuickText, or click the QText button on 
the tool bar.  

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  

3. When you finish, click the OK button to save the template.  

To delete the social history template: 

1. Select Maintenance > Template > Social History Templates. The Social History Template screen 
appears.  

2. Select Edit > Delete Note. A message asks you to confirm the deletion. 

3. Click the OK button.  
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Family history templates 
You can use the patient history templates to customize the Family History section of the patient chart 
for your practice.  

For example, you can create a form for the Family History section that has a space for “mother's 
history,” “father's history,” and other categories of information.  

You can add or edit text in the family History section to create a convenient format for medical history 
information. If you have renamed any of the History sections of the chart, these tabs display your new 
name instead.  

You can create one template for each of the history types: past medical, social, and family. To make the 
templates complete but easily shortened during data entry, you can make liberal use of the «del» 
labels.  

Creating a family history template is much like creating a progress note template. 

Adding and editing the family history template 
To add or edit the family history template: 

1. Select Maintenance > Template > Family History Templates. 
• If a history template does not exist, you are asked if you would like to create a new 

template. Click the Yes button. The Family History Template screen appears.  

• If a template exists, the Family History Template screen appears. Click the Edit button.  

2. Enter the template. For example, you can:  
• Type text.  

• Insert Dot codes and letter codes. Select Insert > QuickText, or click the QText button on 
the tool bar.  

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  

3. When you finish, click the OK button to save the template.  

To delete the family history template: 

1. Select Maintenance > Template > Family History Templates. The Family History Template 
screen appears.  

2. Select Edit > Delete Note. A message asks you to confirm the deletion. 

3. Click the OK button.  
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Order Templates 

Order names 
You will use the Order Name screen to define orders and their associated information. When you add 
an order name, you can set up the order’s description, cost, requirements, extended dialog (user-
defined fields), type, procedure codes, return times for routine and stat results, the default facility that 
will process the order, and associated notes. You can also indicate if a diagnosis is required for the 
order. 

Once that information has been entered, you can create insurance-specific information for the order. 
By carrier and plan, you can enter which diagnosis codes are required for the order to be covered, 
which facility the order should be processed at, whether authorization is required, and insurance-
specific cost. This insurance-specific information overrides the default order information for patients 
with the insurance. For example, let’s say the default cost for an order is $20, but Aetna’s cost is $15. 
When you initiate an order for a patient with Aetna insurance, the cost that displays on the order 
processing screens and reports is $15.  

If you are sending an order to an outside facility, and the facility does not use the same terminology 
that you are using, you can set up cross reference names for the order by facility. This is important if the 
facility uses a different name for the order than the one used in Order Entry. The cross reference allows 
you to link the names together. 

Finally, you can add operator and patient instructions that are specific to the order. When an order is 
initiated, the provider can print instructions for the patient and for the person who will be processing 
the order. 

Importing order names through text files 
In addition to manually entering order names through Lytec MD, you can import order name 
information from ASCII text files. This feature uses the OrderDefSetup.exe file in the Lytec MD database 
directory, and requires that the order type and facility be set up already in Lytec MD.  

Use Notepad to create an ASCII delimited text file (*.txt), then use the following format for the order 
name information: 

Order Name | Order Description | Order Type | Order Facility | Procedure Code | Initial Action S/P/E 

Order Name is the only required element. If you skip any element (for example, Order Type), you must 
leave the pipe symbol ( | ). 

You can use any combination of Initial Action: S (set to pending), P (print immediately), and E (transmit 
immediately). 

For example: 

HCT | Hematocrit | | Quest | 10010 | SE 

Save the file in the Lytec MD database directory (usually p:\ppart). 

When you are ready to import, open a command line (DOS) prompt in the Lytec MD database directory 
and type: 

OrderDefSetup filename.txt 

where filename.txt is the name of the file (for example, OrderDefinitions.txt). 
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Rule files for order procedures 
You can use Order rule files to display alerts to the user when he or she places an order, based on 
algorithmic logic. Rules result in one of three types of messages: 

• A warning message (in this case, the user is still allowed to place the order) 

• A message that the order is denied (in this case, the order cannot be placed) 

• A message that authorization is required (in this case, the order’s status will be set to suspended 
when the order is placed). 

Messages displayed on the Order Warnings screen indicate the order name, message type, and 
message text. 

Order rule files use logic similar to Health Maintenance rule files or Conditional Logic in Letter and 
Note templates. They may contain letter codes as well as special “Order Rule Codes” described below. 

The person designing the rule files should be familiar with the basics of programming and using 
conditional logic.  

Conditional logic evaluates specific statements to be either true or false, and generates results based 
upon whether the statements are true or not. This system uses the IF-ELSE statement to determine the 
results.  

Components of Order rule files: 

• Comparison Operators: =,<>,<,<=,>,>=  

• Logical operators: IF, ELSE, AND, OR  

• Letter Code: Any Lytec MD Letter Code may be used in an Order Rule File. These allow you to 
access information regarding patient demographics, laboratory data, other health maintenance 
tests, diagnoses, medications, etc. 

• Order Rule Codes: See below 

• Order Rule File Variables: See below 

• Arithmetic Operator: PLUS, MINUS, TIMES, DIVIDED_BY 

• Count Variable: Any HM Rule File may contain up to nine numerical variables, named “COUNT1”, 
“COUNT2”,…”COUNT9”. Arithmetic Operators are applied to Count Variables in HM Rule Files. 
The value of any Count Variable is 0 until defined with an Arithmetic Operator. 

• Outcome Operators: 

RETURN MESSAGE “…” 

RETURN REQ_AUTHORIZATION “…” 

RETURN IS_DENIED “…” 

The … above refers to text that will be displayed to the user. 

Notes:  
- We recommend using line breaks to separate various components of your rule file, as done in the 
examples provided in this document. This will make your rule files more easily readable and less 
confusing, and help avoid errors. However, line breaks are ignored by the program. 
 
- Spaces are required before and after comparison operations and logical operations. You do not need 
to include a space at the beginning of a line, or if the operation is proceeded by a brace (i.e., {).  
 
- For a repeating order set, rule files linked to the first order in the set are applied to all orders in the 
set. 
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- The instructions after an IF or ELSE statement must be enclosed in {curly braces} (see examples 
below). 
 
- Logical Operators, Arithmetic Operators, and Time Operators must be capitalized. 
 
- You cannot use both AND and OR logical operators within a single IF clause. The IF clause may 
produce an unexpected result if you use both logical operators. 
 
- If an Order rule file contains more than one IF clause they must be separated by an ELSE clause (see 
example at the end of this section). 
 
- When an Order is being placed, if the end of an Order rule file is reached without reaching a Return 
Operator, Lytec MD will display to the user the message “No RETURN keyword found” on the Order 
Warnings screen. 
 
- If a rule returns “MESSAGE” or “REQ_AUTHORIZATION” then the user will see the Order Warning 
dialog when they click “OK” on the Order dialog, and in the “Message Type” column will be displayed 
“Message” or “Authorization Required,” respectively. 
 
- If a rule returns IS_DENIED, then the user will see the Order Warning dialog when they click “OK” on 
the Order dialog. In the “Message Type” column will be displayed “Denied” and the user will not be 
able to place the order. 

The following table displays the available Order rule codes and their descriptions. 

Order Rule Code Description 

GET ORDER_LATEST_WITHIN<order_name> 
xxxx DAY/MONTH/YEAR 

Get the most recent order date and time within the 
specified date period for the specified order name. 
The values retrieved are stored in the Rule File 
variables “ORDER_DATE” and “ORDER_TIME”, 
which can then be used in an IF clause. Note that if 
no result is returned then the value of both 
variables will be set to “”. 
For example, if a patient had an EKG ordered 5 
months ago, the following Order rule file: 
GET ORDER_LATEST_WITHIN<EKG> 6 MONTH  
IF ORDER_DATE = "" 
{RETURN MESSAGE "No EKG in last 6 months"} 
ELSE 
{RETURN MESSAGE "EKG done in last 6 months"} 
Would display a message “EKG done in last 6 
months” 

Note: If you put the text “passed order_name” 
within the <angled brackets> on the GET line, 
Lytec MD will look for whatever order the rule is 
being applied to. This facilitates writing a rule and 
applying it to multiple orders. 

GET ORDER_LATEST<order_name> Get the date and time the latest order with the 
specified order name was created. See “GET 
ORDER_LATEST_WITHIN” above for details on 
syntax. 
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DIAGNOSIS<diagnosis_name> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific diagnosis name on their 
Diagnosis list (in the Problems/Procedures section 
of their chart). For example, if a patient has 
“HYPERTENSION” on his or her diagnosis list, then 
IF DIAGNOSIS<HYPERTENSION> = "TRUE" 
{RETURN MESSAGE "Patient has HTN"} 
ELSE 
{RETURN MESSAGE "Patient does not have HTN"} 
would display the message “Patient has HTN”. Note 
that Diagnoses marked as “Inactive” will be 
ignored. 

DIAGNOSIS_CODE<diagnosis_code> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 1 
or Code 2 fields of an entry on their Diagnosis list 
(in the Problems/Procedures section of their chart). 
For example, if a patient has a diagnosis with code 
“401.9” on his or her diagnosis list, then 
IF DIAGNOSIS_CODE<401.9> = "TRUE" 
{RETURN MESSAGE "Patient has HTN"} 
ELSE 
{RETURN MESSAGE "Patient does not have HTN"} 
would display the message “Patient has HTN”. Note 
that Diagnoses marked as “Inactive” will be 
ignored. 

GET LAB_LATEST_WITHIN<hm_name> xxxx 
DAY/MONTH/YEAR 

Gets the most recent value for the specified lab 
data item within the specified date period. The 
value retrieved is stored in the Rule File Variable 
“LAB_VALUE” which can then be used in an IF 
clause. In addition, the date is stored in LAB_DATE, 
and the normal/abnormal flag in LAB_STATUS (for 
the latter, c = critical high, b = critical low, h = high, 
l = low, a = abnormal, and n = normal). Note that if 
no result is returned then the LAB_DATE variable 
will be set to “”. 
For example, if a patient’s last sodium was 150 on a 
date 7 months ago, the following rule file would 
generate a message “Last Sodium > 150”. If, 
however, it was 150 on a date 5 months ago, the 
rule file would generate the message “Last Sodium 
not < 150”: 
GET LAB_LATEST_WITHIN<SODIUM> 6 MONTH 
IF LAB_VALUE > "150" 
{RETURN MESSAGE “Last Sodium > 150”} 
ELSE 
{RETURN MESSAGE “Last Sodium not < 150”} 

GET LAB_LATEST<hm_name> Get the latest results for the specified lab data item.
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GET LAB_FIRST<hm_name> Get the first results for the specified lab data item. 

GET LAB_NEXT<hm_name> Get the next results for the specified lab data item. 

GET LAB_PREVIOUS<hm_name> Get the previous results for the specified lab data 
item 

MAJOR_PROBLEM<problem_name> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific diagnosis name on their 
Major Problem list (in the Problems/Procedures 
section of their chart). For example, if a patient has 
“HYPERTENSION” on his or her Major Problem list, 
then 
IF DIAGNOSIS<HYPERTENSION> = "TRUE" 
{RETURN MESSAGE "Patient has HTN"} 
ELSE 
{RETURN MESSAGE "Patient does not have HTN"} 
would display the message “Patient has HTN”. Note 
that Problems marked as “Inactive” will be ignored.

MAJOR_PROBLEM_CODE<problem_code> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 1 
or Code 2 fields of an entry on their Major Problem 
list (in the Problems/Procedures section of their 
chart). For example, if a patient has a diagnosis with 
code “401.9” on his or her Major Problem list, then 
IF DIAGNOSIS_CODE<401.9> = "TRUE" 
{RETURN MESSAGE "Patient has HTN"} 
ELSE 
{RETURN MESSAGE "Patient does not have HTN"} 
would display the message “Patient has HTN”. Note 
that Problems marked as “Inactive” will be ignored.

MEDICATION<med_name> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a particular medication on their 
current medications list. For example, if a patient 
has medication Lisinopril on his or her Current 
Medication list, then 
IF MEDICATION<LISINOPRIL> = "TRUE" 
{RETURN MESSAGE “Patient is on Lisinopril”} 
ELSE 
{RETURN MESSAGE “Patient is not on Lisinopril”} 
would display the message “Patient is on 
Lisinopril”. 

MEDICATION CLASS<med_class> When included in a HM Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has any medication in the same class as 
a particular medication on their current 
medications list. For example, if a patient has any 
ACE Inhibitor (a drug class of which Lisinopril is a 
member) on his or her Current Medication list, then 
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IF MEDICATION CLASS<LISINOPRIL> = "TRUE"
{RETURN MESSAGE “Patient is on an ACE 
Inhibitor”} 
ELSE 
{RETURN MESSAGE “Patient is not on an ACE 
Inhibitor”} 
would return the message “Patient is on an ACE 
Inhibitor”. 

PROCEDURE_CODE<procedure_code> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 1 
or Code 2 fields of a Procedure record (in the 
Problems/Procedures section of their chart). For 
example, if a patient has a Procedure with code 
“58210”, then 
IF PROCEDURE_CODE<58210> = "TRUE" 
{RETURN MESSAGE "Has had a hysterectomy"} 
ELSE 
{RETURN MESSAGE "Hasn't had a hysterectomy"} 
would display the message “The patient has had a 
hysterectomy”.  

OTHER_PROBLEM<problem_name> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific name on their Other 
Problem list (in the Problems/Procedures section of 
their chart). For example, if a patient has 
“HYPERTENSION” on his or her Other Problem list, 
then 
IF OTHER_PROBLEM<HYPERTENSION> = “TRUE” 
{RETURN MESSAGE “Has HTN”} 
ELSE 
{RETURN MESSAGE “Doesn’t have HTN”} 
Would return the message “Has HTN”. 

OTHER_PROBLEM_CODE<problem_code> When included in a Order Rule, this Rule Code 
resolves to “TRUE” or “FALSE” based on whether 
the patient has a specific value in either the Code 1 
or Code 2 fields of an entry on their Other Problem 
list (in the Problems/Procedures section of their 
chart). For example, if a patient has a Other 
Problem with code “401.9”, then 
IF OTHER_PROBLEM_CODE<401.9> = “TRUE” 
{RETURN MESSAGE “Has HTN”} 
ELSE 
{RETURN MESSAGE “Doesn’t have HTN”} 
Would return the message “Has HTN”. 

Here is an example rule file which combines a number of the elements described above: 

This rule file can be used to perform a numerical score of coronary risk factors to give a user an alert 
when ordering a noninvasive cardiac stress test that the likelihood of existing coronary disease is so 
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high, it might be best to instead perform a more definitive invasive test. In addition, it will alert the user 
if the risk is so low that prior authorization is required.  

Note: The rule below is only meant to demonstrate how this feature might be used. Its logic is arbitrary 
and does not constitute any clinically validated risk stratification tool. 

COUNT1 = 0 

GET LAB_LATEST<LDL-CHOL> 

IF LAB_VALUE > "160" 

{ 

COUNT1 = COUNT1 PLUS 1 

} 

ELSE{} 

GET LAB_LATEST<HGB A1C> 

IF LAB_VALUE > "8" 

{ 

COUNT1 = COUNT1 PLUS 1 

} 

ELSE{} 

GET LAB_PREVIOUS<HGB A1C> 

IF LAB_VALUE > "8" 

{ 

COUNT1 = COUNT1 PLUS 1 

} 

ELSE{} 

IF MAJOR_PROBLEM<TOBACCO USE> = "TRUE" OR MAJOR_PROBLEM_CODE<305.1> = "TRUE" 

{ 

COUNT1 = COUNT1 PLUS 2 

} 

ELSE{} 

IF COUNT1 < "1" 

{RETURN REQ_AUTHORIZATION "Low CAD risk"} 

ELSE 

{IF COUNT1 > "3" 

{RETURN MESSAGE "High CAD risk; consider invasive testing"} 

ELSE 

{RETURN MESSAGE "CAD risk is such that noninvasive testing is appropriate"}} 
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To create an order rule file:  

1. Use a text editor (for example, Windows Notepad) to create an ASCII text file that contains the 
rules.  

2. Save the file with a .txt extension in the Lytec MD database directory (the default directory is 
P:\ppart, but your database path may be different). 

Adding, editing, and deleting order names 
To open the order name screen: 

• Select Maintenance > Templates > Order Templates > Order Names. The Order Names Select 
screen appears. 

To add an order name: 

• On the Order Names Select screen, click the New button. Fill in the fields on the Order Name 
<New> screen, then click the OK button. 

To change an order name: 

• On the Order Names Select screen, highlight the order name that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete an order name: 

• On the Order Names Select screen, highlight the order name that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields and buttons on the Order Name screen 
Field Description 

Order Type frame Select whether you are adding: 
 Single order 
 Visible order set (a set of orders are initiated by a single 

order) 
 Hidden order set (used when results come back in 

components to determine the completeness of an 
order) 

Order Name Type a name for the order. 

Order Description Type a description for the order. 

Order Workflow The Order Workflow field is not active in this release. 
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Order Cost Type the cost of the order. If an insurance carrier-specific cost is 
linked to the order, the insurance cost will be used. 
You can enter a cost for a visible order set that is different than 
the sum of the component orders, but this cost will be 
overridden by an insurance-specific cost. If one of the 
component orders is removed, there is no longer an order set, 
and the cost reverts back to the sum of the single orders. Cost is 
for informational purposes only. If you use the Electronic 
Encounter Form, the actual charge is based on the procedure 
codes associated with the order. 

Order Facility Type the name of the processing facility. The name must match 
one that has already been added in Order Entry. 
Linking the facility to an order does not necessarily mean that 
this facility will be used each time the order is added. If the 
patient's insurance is linked to a facility, that facility overrides 
the facility linked to the order. 

Note: This feature is not available for visible order sets. 

Order Ext. Dialog To assign an extended dialog for the order, select a dialog from 
the drop-down list. After you select a dialog, you can review it 
by clicking the View Dialog button. 

Order Type Select the type for the order from the drop-down list. 

Note: This feature is not available for visible order sets. 

Order Rule If there is a rule file for this order, type the name of the file in 
this field. The file must be in the Lytec MD data directory 
(usually p:\ppart). 

Order Requirements If there are requirements for the test (for example, a specific 
type of sample tubes), type the requirements in this field. 

Procedure Code(s) Select up to four procedure codes for the order. These codes 
will be used for the Electronic Encounter Form. 

Proc Code Modifiers Enter up to four modifiers for the selected procedure code. 

Diagnosis Required If you want to require a diagnosis for the order, select this check 
box. 

Note: This feature is not available for visible order sets. 

Group Type Type the order group type. 

Notes Use the text box to type notes related to the order. 

Routine Results Back Within In the Hours and Days fields, indicate the time period in which 
routine results for this order should be returned. You can use 
whole numbers only. 

Note: This feature is not available for visible order sets. 

Stat Results Back Within In the Hours and Days fields, indicate the time period in which 
stat results for this order should be returned. You can use whole 
numbers only. 

Note: This feature is not available for visible order sets. 
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Set Status as Pending To automatically assign a status of pending to the order, mark 
this check box. 

Note: This feature is not available for visible order sets. 

Print Immediately To print the order when it is saved, mark this check box. 

Note: This feature is not available for visible order sets. 

Electronically Transmit 
Immediately 

To send the order electronically when the order is added and 
saved, mark this check box. 
How this feature works: To be transmitted electronically, the 
order must have a facility and an electronic form associated 
with it. When the order is issued, Patient Records checks to see 
whether an insurance plan is linked to the order that matches 
the patient’s primary insurance. If a plan is linked, the facility 
(and related electronic form) associated with the insurance plan 
overrides the facility (and related electronic form) linked to the 
order name itself. This means that issuing the same order for 
different patients may immediately transmit electronic forms of 
different types, or no forms may be transmitted electronically, 
depending on the patient’s primary insurance. 

Note: If you mark this check box, we recommend that you do 
not mark the Set Status as Pending check box. If both check 
boxes are marked, two records will be created for the order 
(once when the order is created and set to Pending, once when 
the order is electronically transmitted). 

Note: This feature is not available for visible order sets. 

Apply button Click this button to save the order information, and to continue 
adding data. 

Insurance button To add insurance information for the order, click this button.  

Note: This feature is not available for visible order sets. 

Xref button To add facility-specific name cross reference Information for the 
order, click this button. It will be used for outbound order 
interfaces as the name of the order.  

Note: This feature is not available for visible order sets. 

Order Set button (Order sets only) To add child orders of the order set to the 
order, click this button. 

Instructions To add patient and operator instructions for the order, click this 
button.  

Note: This feature is not available for visible order sets. 
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Order Set screen 
Orders sets combine a group of orders into one item (Chem Panel is an example of a commonly 
requested set of orders). When you order tests, you can then select only the order set name instead of 
ordering each individual test. You can tailor order sets to meet the specific needs of providers and 
specialties. 

When you select an order set, you are really ordering the component orders in the set. You can remove 
an order from the set if necessary after selecting the order set. This allows you to customize order sets 
on the fly.  

There are two types of order sets: visible and hidden.  

• With visible order sets, the individual (component) orders appear on the Order <New> screen 
when the order set is selected, and they effectively become individual orders. The Order Set 
column on the Order screens (Orders, Provider Orders, Order Processing Select, and Overdue 
Orders) will display the name of the visible order set if the order was issued as part of a visible 
order set. You can suppress (select not to view or print) the extended dialogs and instructions for 
child orders in visible order sets. 
 
The "parent" of a visible order set does not have an order type, order facility, routine/stat time, 
initial action, insurance, or many other typical attributes of an order. The parent can have 
procedure codes (stored with the child orders, after each child's procedure codes), extended 
dialogs, requirements, and operator/patient instructions. 
 
Visible order sets can also have a cost that is different from the sum of the component orders, 
but this cost will be overridden by an insurance-specific cost or any time the order is processed 
through an electronic encounter form. If one of the component orders is removed, there is no 
longer an order set, and the cost reverts back to the sum of the single orders. 

• With hidden order sets, the individual orders do not appear on the Order <New> screen when 
the order set is selected, so they are treated as one order. Since an order may come back as a 
collection of tests (for example, Chem Panel would return as Na, K, Glucose, etc.), hidden order 
sets allow the original order to be automatically updated to Completed or Partially Completed 
status when the results are processed by an interface or by the lab/text data loaders. 
 
Orders in a hidden order set must have a status of Sent before the order set can be marked as 
Completed. 

You can use a setting on the Special Features screen to determine whether Lytec MD will check for 
duplicate orders within a specified number of days. If this feature is activated, and a child order in an 
order set is a duplicate of an existing order, the duplicate order is removed from the order set. 

Costs for individual orders in an order set are not displayed when you order tests, but the total cost of 
the order does display. If you remove a member of the order set, the cost becomes the sum of the 
individual orders rather than the cost of the order set. 

Diagnosis codes linked to an order set will override diagnosis codes linked to specific orders in the 
order set. 

The procedure for editing and deleting orders from the order set is similar to that of adding orders to 
the set. You open the Order Set screen, and change or delete the orders. 
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Adding orders to create order sets 
To add orders to an order set: 

1. On the Order Name screen, click the Order Set button. The Order Set screen appears. 

2. In the Order Name field, type the name of an order that you want to add to the order set. You 
can also click the arrow to select from a list of orders. 

3. (Visible order sets only) If you want to suppress (not view) the extended dialog for the order, 
mark the check box. 

4. (Visible order sets only) If you want to suppress (not view or print) the operator and patient 
instructions for the order, mark the check box. 

5. To add additional orders to the set, repeat steps 2 through 5. The maximum number of orders 
you can add to a set is 50.  

6. When you finish, click the OK button. You return to the Order Name screen. 
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Cross References screen 
If you are sending an order to an outside facility, and the facility does not use the same terminology 
that you are using, you can set up cross reference names for the order by facility. This is important if the 
facility uses a different name for the order than the one used in Order Entry. The cross reference allows 
you to link the names together. 

To import orders with the Text Data Loader, you must set up the OEXREF.FL file. 

Note: This feature is not available for visible order sets. 

Adding, editing, and deleting cross-references for orders 
To open the cross-reference screen: 

• On the Order Name screen, click the Xref button. The Cross References screen appears. 

To add a cross-reference for an order: 

1. On the Cross References screen, click the New button. The Cross Reference <New> screen 
appears. 

2. In the Facility ID field, type the facility name as it appears in Order Entry. 

3. In the Cross-Reference field, type the facility's name for the order that will be used when 
sending the order to the facility. 

4. Click the OK button. You return to the Cross References screen. 

To change a cross-reference for an order: 

• On the Cross References screen, highlight the cross-reference that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete a cross-reference for an order: 

• On the Cross References screen, highlight the cross-reference that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 
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Order Insurance screen 
You can link insurance carrier information to tests. Then, when the test is ordered, Order Entry will look 
at the patient’s account insurance plan to determine whether the diagnoses entered for the test are 
covered and whether specific testing facilities are and facilities are used. The insurance carrier 
information will also be used to verify whether other restrictions such as cost or authorization 
requirements are in effect.  

Note: This feature is not available for visible order sets. 

You can create rules at the carrier level, or at the carrier plan level. 

• At the carrier level, which means that the Carrier Plan Name field is left empty, the rule applies to 
all patients on the carrier (even those patients who have plans specified on the Patient screen's 
Billing tab).  

• At the carrier plan level, the rule applies only to patients on the carrier who have the specific 
plan.  

You can create rules at both levels for the same carrier. The carrier-level rule is the default when a 
patient does not have a carrier plan that has specific rules. For example: 

Example 1: 

Order has Insurance ID 111  plan ID <blank> 

• Patient has Insurance ID 111 plan ID <blank>  = order insurance restrictions apply 

• Patient has Insurance ID 111 plan ID xxx  = order insurance restrictions apply 

• Patient has Insurance ID 111 plan ID yyy   = order insurance restrictions apply 

• Patient has Insurance ID 222 plan <blank> = no insurance restrictions 

Example 2: 

Order has  Insurance ID 111  plan ID <blank> with restrictions A 

Order has  Insurance ID 111  plan ID xxx with restrictions B 

• Patient has Insurance ID 111 plan ID <blank>  = order insurance restrictions set A apply 

• Patient has Insurance ID 111 plan ID xxx  = order insurance restrictions set B apply 

• Patient has Insurance ID 111 plan ID yyy   = order insurance restrictions set A apply 

• Patient has Insurance ID 222 plan <blank> = no insurance restrictions 

Authorizations 
When you set up insurance-specific information for an order, you can indicate whether an authorization 
is required by the carrier for that order. When an order with an authorization requirement is initiated, 
the status is automatically set to Suspended. Only users with the appropriate access level can change 
the status from Suspended to Approved (the carrier has approved the test) or Denied (the carrier has 
denied the test). 

• An Approved status is similar to a Pending status. Once an order is approved, it can be 
processed. 

• A Denied status is similar to a Completed status. Once an order is denied, it will not be 
processed, so the order is moved to the Completed tab of the order review screen. 
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Adding, editing, and deleting insurance carriers to orders 
To open the Order Insurance screen: 

• On the Order Name screen, click the Insurance button. The Order Insurance screen appears. 

To link an insurance carrier to an order: 

• On the Order Insurance screen, click the New button. Fill in the fields on the Order Insurance 
<New> screen, then click the OK button. 

To change an insurance carrier linked to an order: 

• On the Order Insurance screen, highlight the insurance carrier that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete an insurance carrier linked to an order: 

• On the Order Insurance screen, highlight the insurance carrier  that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields and buttons on the order insurance screen 
Field Description 

Carrier Specify the insurance carrier by: 
 Typing the insurance carrier ID in the field. 
 Clicking the arrow to display the Carrier Select screen. 

This screen lists all insurance carriers in the database. 
Highlight the appropriate carrier in the table, then click 
the OK button. 

Carrier Plan Name Type the appropriate plan for the insurance carrier. 

Facility ID Type the name of the facility at which the order should be 
completed. 

Cost Type the insurance cost associated with the order. 

Authorization required? If authorization for the order is required, mark this check box. 

Codes Click this button to add carrier-specific diagnosis codes for this 
insurance carrier. 
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Carrier-Specific Diagnosis Codes screen 
If an insurance carrier requires specific diagnosis codes for a test or procedure, you can link that 
diagnosis code to the order. Then, when the order is issued, Lytec MD will check to make sure the 
correct diagnosis code is selected. If not, a message asks users to either select the correct diagnosis 
code, print a medical necessity form (ABN), or return to the Order <New> screen. 

Diagnosis codes linked to a hidden order set will override diagnosis codes linked to specific orders in 
the order set. 

For visible order sets, we recommend that you link carrier-specific diagnosis codes to the visible order 
set rather than the child orders in the order set. Although you can specify up to four insurance carrier-
specific diagnosis codes for each order or order set, it is possible to exceed the number of diagnosis 
codes allowed by linking the codes to the child orders. 

Adding, editing, and deleting carrier-specific diagnosis 
codes 
To open the carrier-specific diagnosis code screen: 

• On the Order Insurance screen, click the Codes button. The Carrier-Specific Diagnosis Codes 
screen appears. 

To link a carrier-specific diagnosis code to an order: 

1. On the Carrier-Specific Diagnosis Codes screen, click the New button. Click the New button. 
The Carrier-Specific Diagnosis Codes <New> screen appears. 

2. In the Carrier-Specific Diagnosis Code field, specify the diagnosis code by: 
• Typing the diagnosis code in the field. 

• Clicking the arrow to display the Diagnosis Code Select screen. This screen lists all 
diagnosis codes in the database. Highlight the appropriate diagnosis code in the table, 
then click the OK button. 

3. Click the OK button. 

To change a carrier-specific diagnosis code linked to an order: 

• On the Carrier-Specific Diagnosis Codes screen, highlight the diagnosis code that you want to 
change. Click the Edit button. Make the appropriate changes. When you finish, click the OK 
button. 

To delete a carrier-specific diagnosis code linked to an order: 

• On the Carrier-Specific Diagnosis Codes screen, highlight the diagnosis code that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 
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Order Instructions screen 
You can attach operator and patient instructions to orders. Operator instructions, as the name implies, 
are directions about the order that should be followed by the person who will be processing the order. 
Patient instructions are instructions about the order for the patient (for example, nothing by mouth after 
midnight). Instructions can be up to 1000 characters long. 

Note: You can also add, modify, and print patient and operator instructions for a specific order from 
the Order screen. See the Order Entry: issuing and editing orders section for more information. 

In addition to typing the instructions, you can link to an outside text, RTF (rich text format), or HTML file. 
You must use the following format: 

#path\document_name.xxx 

Where path is the complete path to the file, and document_name.xxx is the file’s name and extension. 
For example, you might link to an HTML file in the Lytec MD Knowledge Base by typing the following: 

#p:\ppart\KBASE\CBC_instructions.html 

You can also link to a web address, for example, www.mckesson.com. The link can be located any 
where in the instruction's text box, it does not have to be on the first line.  

The procedure for editing and deleting instructions is similar to that of adding instructions. You open 
the Instructions screen, and change or delete the text. 

Note: This feature is not available for visible order sets. 

Adding, editing, and deleting order instructions 
To open the Order Instructions screen: 

• On the Order Name screen, click the Instructions button. The Order Instructions screen appears. 

To add an order instruction: 

1. In the Operator box, type instructions that will be displayed to or printed by the operator who 
processes the order. 

2. In the Patient box, type instructions that can be printed for patients. 

3. Click the OK button. You return to the Order Name screen. 

To change an order instruction: 

1. Open the Order Instructions screen. 

2. Make the appropriate changes.  

3. When you finish, click the OK button. 

To delete an order instruction: 

1. Open the Order Instructions screen. 

2. Highlight the text and press the Delete key.  

3. When you finish, click the OK button. 
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Extended orders 
The Extended Order Maintenance screen can be used to create two types of Order screens: the 
Extended Order screen and the facility-specific Processing Information screen. 

You can add user-defined fields to capture specific information at the time an Order is placed. For 
example, for x-rays, you wish to prompt the user to enter information about the patient’s history and 
reason for the x-ray.  

You can group up to 200 user-defined fields on an extended order screen. You can place the fields in 
any order, and can leave "blank space" on the extended order screen by leaving rows empty on the 
Extended Order Maintenance screen. 

Once the extended order screen is created, you can then assign it to one or more orders on the Order 
Names maintenance screen as an Order Ext. Dialog.  

If the screen is intended as a Processing Information screen instead, you can assign it to a facility or 
facility/order combination on the Facility screen. You can print the extended order fields on order 
forms and transmit them electronically through an Order Entry interface. Processing information fields 
can be printed on the Requisition form. 

The ID for each Extended Order field allows you to set up uniquely searchable fields for custom 
reporting. 

Important: When you delete a user-definable order field, you are also deleting all data that has been 
entered in that field. Once deleted, you may not be able to restore the data.  
 
Note: You can “fill out” Extended Order fields directly from a progress note using the .ORN Dot code. 
If you want to use .ORN dot codes with a Visible Order Set, make sure that all child orders of the set use 
the same extended order dialog.  

Adding, editing, and deleting extended order screens 
To open the extended order maintenance screen: 

• Select Maintenance > Templates > Order Templates > Extended Orders. The Extended Orders 
Select screen appears. 

To add an extended order screen: 

1. On the Extended Orders Select screen, click the New button. The Extended Order 
Maintenance screen appears. In the Dialog Name field, type a name for the extended order 
screen. 

2. To add a user-defined field to the extended order screen, highlight the row in which you want 
to add the field and click the New button. Fill in the fields on the Extended Order Field <New> 
screen, then click the OK button. 

Note: You can use the copy (CTRL+C) and paste (CTRL+V) shortcut keys, to cut and paste between the 
fields on the Extended Order Field screen. 

To change an extended order screen: 

1. On the Extended Orders Select screen, highlight the extended order screen that you want to 
change. Click the Edit button. Make the appropriate changes: 
• To add a new user-defined field, click the New button. 

• To change a field, highlight the field and click the Edit button. 
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• To delete a field, highlight the field and click the Delete button.  

2. When you finish, click the OK button. 

To test an extended dialog:  

• On the Extended Orders Select screen, highlight the extended order screen that you want to 
test. Click the Test button. The extended order screen appears. When you finish viewing the 
extended order screen, click the Close button.  

To delete an extended order screen: 

• On the Extended Orders Select screen, highlight the extended order screen that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the extended order field screen 
Field Description 

Caption Type the text that you want to use for the field name (the field 
name is the caption that users will see). 
This field is required if you plan to use .ORN Dot codes in 
progress notes.  

ID Type an ID for the user-defined field. This optional field will allow 
you to do custom reporting on the Extended Order fields. Valid 
IDs for the user-defined field include: 

d_drawn Date Drawn: The date of the sample taken. 
Displays as a Date field. 

t_drawn      Time Drawn: The time of the sample taken. 
Displays as a Time field. 

oe_vol        Sample Volume: The volume of the sample. 
Displays as a Text field. 

oe_fast Fasting Status: Indicates whether the patient 
has fasted for the appropriate length of time. 
Displays as a Yes/No field. 

oe_ctrl_num Control Number: The control number is a 
unique number that is automatically 
incremented by the system. This field is not 
editable by the user. Displays as a Numeric 
field. 

Note: This field can only be used when an 
interface is present. 

 

Type Select the appropriate type of field. Your options are:  
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Date Operators can type a date in the field.  
Indicate whether you want today's date to 
automatically default in the field (Use Today's 
Date). Operators can change the date if 
necessary. 
Note: Customers using Oracle/MS-SQL 
servers will always have the extended dialog 
date display the current date, regardless of 
the date option they select. 

Number Operators can type numbers in the field. 
Indicate how many numbers operators can 
enter (Width).  
You can also enter a number that will 
automatically display in the field (Default). 
Operators can change the default number if 
necessary. 

Text Operators can type alpha-numeric text in the 
field. 
Indicate how many characters operators can 
enter (Width). The maximum is 800 
characters. 
You can also enter text that will automatically 
display in the field (Default). Operators can 
change the default text if necessary. 

Yes/No Operators can type either Yes or No.  
You can mark the Default check box if you 
want Yes to be the default answer in the field. 

Time Operators can type a time in the field.  
Indicate whether you want the current system 
time to automatically default in the field (Use 
Current Time). Operators can change the 
time if necessary. 
Note: Customers using Oracle/MS-SQL 
servers will always have the extended dialog 
time display the current time, regardless of 
the time option they select. 

List Item 
(strict) 

Operators can select from a drop-down list of 
items. Extended order list names and List 
Items are created using List Maintenance.  
Select a list name from the Default drop-
down list. To set a default option for the 
drop-down list, select a List Item from the 
drop-down list located below the Default list. 
Leave this field blank to use blank as the 
default.  
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List Item 
(non-strict) 

Operators can select items from a drop-down 
list or type in a different response if they 
choose. Extended order list names and list 
items are created using List Maintenance.  
Select a list name from the Default drop-
down list. To set a default option for the 
drop-down list, select a List Item from the 
drop-down list located below the Default list. 
Leave this field blank to use blank as the 
default.  

 

Width For single-line fields, type the number of characters that you want 
to use for the field. For example, if you want to limit users to 
entering 10 characters, type 10. 

Note: If you select a field type of date, the width automatically 
defaults to 10 and cannot be changed. 

For multiple-line fields, type the width of the box, in number of 
characters. For example, if you want the box to be 50 characters 
wide, type 50.  

Default If you want default text to appear in the field, type the text here. 

Required Mark this check box if you want to require operators to enter data 
in the field. 
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Order trees 
An order tree is a list of orders grouped together by order category (for example, immunizations). You 
can configure provider-specific order trees that provide quick access to the tests used most frequently 
by the provider. You can also create a default order tree that is available to all providers who do not 
have a provider-specific tree. 

Order Entry provides a “copy tree” feature that allows you to copy an existing order tree. This saves set-
up time, because you do not need to build an order tree from scratch for each provider. 

The procedure for editing and deleting order trees is similar to that of adding order trees. You open 
the Order Tree screen, and change or delete the orders in the tree. 

When you delete a provider's order tree, you can add a new tree from scratch while the Order Tree is 
open, or you can close the screen without adding a tree. If you do not add a tree, the next time you 
access the Order Tree screen for the provider, an empty order tree will appear. 

The cost associated with the order or the order set displays in the order tree (after the order or order 
set has been added to the order tree).   

Adding, editing, and deleting order trees 
To open the order tree screen: 

1. Select Maintenance > Templates > Order Templates > Order Tree. The Provider/Practice 
Selection screen appears.  

2. Select a provider ID to create a provider-specific order tree, or leave the field blank to create a 
default/universal tree (for use by all providers without a specific order tree).  

3. Click the OK button. The Order Tree screen appears.  

To add an order tree: 

1. Open the Order Tree screen. The default order tree appears in the box to the right of the 
screen.  
 
If you want to copy and modify an existing order tree (for example, the default order tree or an 
order tree from another provider), click the Copy Tree button. On the Copy Tree screen, select 
the provider whose tree you want to copy. Then click the OK button. 

2. Click  to expand the list. You can add to or subtract from the order tree, or you can create a 
new order tree. 
• To delete an order from the order tree: In the box on the right, highlight the order and 

click the Remove button. The order appears in the Order Name box. If the order was part 
of an order set, a message asks whether you want to remove only the order or the entire 
order set. 

• To add an order to the order tree: In the Order Name box, highlight the order and click 
the Insert button. The order appears in the box on the right. 

• To move an order in the order tree: In the box on the right, highlight the order and: 

• To move the order left or right in the order hierarchy, click   or . 

• To move the order up or down in the order hierarchy, click   or . 

Note: The first level in the order hierarchy, denoted by the  to the left of the level, should always be 
“Order Tree.” All orders in the hierarchy should be subordinate to “Order Tree.”  
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3. Once you finish, click the OK button. 

To change an order tree: 

• On the Order Tree screen, make the appropriate changes. When you finish, click the OK button. 

To delete an order tree: 

• On the Order Tree screen, click the Delete Tree button. A message asks you to confirm the 
deletion. Click the OK button. You can now add a new tree from scratch, or close the screen 
without adding a tree. If you do not add a tree, the next time you access the Order Tree screen 
for the provider, an empty order tree will appear.  
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Order types 
When you add order names, you can specify a type for the order. You can select an order type when 
you add an order name. The order type is used to determine who will process the order, and for 
reports so that you can analyze data for a specific group of orders (for example, immunization orders). 

Adding, editing, and deleting order types 
To open the order type screen: 

• Select Maintenance > Templates > Order Templates > Order Types. The Order Types screen 
appears. 

To add an order type: 

• On the Order Types screen, click the New button. Fill in the fields on the Order Type <New> 
screen, then click the OK button. 

To change an order type: 

• On the Order Types screen, highlight the order type that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete an order type: 

• On the Order Types screen, highlight the order type that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Order Type screen 
Field Description 

Type Type a name for the order type. 

Description Type an optional description for the order type. 

Order Label Select an order label to assign to the order type. 

E & M Type Select an E & M type to assign to the order type.  

Printer Type Select a printer to assign to the order type. The 
printer selected will be used as the order type's 
default printer. 
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Order categories 
You can set up order categories to group common orders together. Categories are used in the order 
tree as a way of keeping related orders organized. Some typical categories include Hematology, 
 Chemistry, Radiology, Immunizations, and Microbiology. When you add an order name, you indicate 
the category the order belongs to.  

Adding, editing, and deleting order categories 
To open the order category screen: 

• Select Maintenance > Templates > Order Templates > Order Categories. The Order Categories 
screen appears. 

To add an order category: 

1. On the Order Categories screen, click the New button. The Order Category <New> screen 
appears. 

2. In the Category field, type a name for the order category. 

3. In the Description field, type an optional description of the order category. 

4. When you finish, click the OK button. You return to the Order Categories screen. 

To change an order category: 

• On the Order Categories screen, highlight the order category that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete an order category: 

• On the Order Categories screen, highlight the order category that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 
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Form Templates 

Encounter Forms 
Encounter forms are generated for outpatient visits, and are used both to display relevant patient 
information and to collect data about the visit. Encounter forms often include patient demographic 
information, date of service, responsible party/guarantor, insurance information, and problem and 
diagnosis codes. You can develop custom encounter forms that contain the information most 
applicable to your practice.  

The most important steps in designing a custom form are determining the:  

• Information that should print on the form. Are you familiar enough with the database to find the 
data items you need? How do you want the data sorted? Do you want to add text labels to the 
type of data?  

• Layout of the information. How are you going to place the data in rows and columns so that it 
matches the layout of the form?  

• Format of the information. What font and font size do you want to use? Do you want to use text 
formatting such as bold or underline? Do you want to print barcodes? How do you want to 
format date fields (for example, mmddyy or mm/dd/yyyy)?  

Keep in mind that the form may print differently than it appears on screen, because of differences with 
printer drivers and fonts. For example, if you selected to use a particular font (such as Arial) but the 
printer does not have that font installed, another font will be substituted. The substitute font may have a 
different point size or pitch, so printed text may be misaligned or cut off.  

Another important issue is the width of the font (pitch) and the width of the data fields. The font's pitch 
will help determine how you place more than one field in a row. Pitch is the number of characters per 
horizontal inch. For monospaced (non-proportional) fonts such as Courier, where all characters are of 
equal widths, you can calculate pitch by dividing 120 by the point size. For 12-point Courier, then, the 
pitch is 10. This means that for each inch, 10 characters will print. A data item with a width of 15 
characters will need 1.5 inches of space on the form. Proportional fonts have characters of different 
widths (the font used here is proportional), so it does not have a fixed number of characters per inch, 
and therefore does not have an absolute pitch.  

A font's point size is its height measured in points (1 point = 1/72 inch). For 10-point Courier font, the 
distance from the top of the highest character to the bottom of the lowest character is 10 points (10/72 
inch).  

Designing the form will probably take some trial and error. When you have a version that you want to 
test, print the custom form on a plain piece of paper. Then hold this prototype up behind the printed 
form from the lab or facility to check whether all the data items are positioned correctly.  

Adding, editing, and deleting encounter forms 
To open the Encounter Form Maintenance screen: 

• Select Maintenance > Templates > Form Templates > Encounter Forms. The Encounter Forms 
Select screen appears.  

To add a encounter form from scratch: 

1. On the Encounter Forms Select screen, click the New button. 

2. Fill in the fields on this screen, then click the OK button. 
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3. When you finish, click the OK button. The Form Layout <New> screen appears. You will use this 
screen to place individual fields on the form.  

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save the form and close the Form Layout screen.  

To add a encounter form by copying an existing form: 

1. On the Encounter Forms Select screen, highlight the encounter form that you want to copy.  

2. Click the Copy Form button. The Copy Order Form screen appears.  

3. Type a name for the new encounter form.  

4. Click the OK button.  

5. On the Encounter Forms Select screen, highlight the new encounter form in the table.  

6. Click the Edit button. The Encounter Forms <Edit> screen appears. The settings on this screen 
are from the original encounter form that you copied.  

7. Make the necessary changes to the settings.  

8. When you finish, click the OK button. You return to the Encounter Forms Select screen.  

To change a encounter form: 

1. On the Encounter Forms Select screen, highlight the encounter form that you want to change.  

2. Click the Edit button. Make the appropriate changes.  

3. When you finish, click the OK button. The Form Layout <Edit> screen appears. Make the 
necessary changes. 

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save your changes and close the Form Layout screen.  

To delete a encounter form: 

• On the Encounter Forms Select screen, highlight the encounter form that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Encounter Form Maintenance screen 
Field Description 

Name  Type a name for the encounter form.  

Description  Type a description for the encounter form.  
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Sort Indicate how you want the data to be sorted. You can sort data 
in:  

 Ascending order - A to Z, zero to 9, or earliest to latest 
date  

 Descending order - Z to A, 9 to zero, or latest to earliest 
date  

 No sorting preference  

Group By  Select how you want the data to be grouped (for example, use 
“FullName” to group data by patient name). This field is 
required.  
See Data Items for Custom Reports for a list of item names you 
can use in this field.  

Font  Click the Font button to set the default font for the encounter 
form. You can set the font, font style, font size, font effects, and 
font color.  
If you do not select a font, the default font will be used.  
Make sure the font you select is supported by the printer you 
will use, or the form will not print correctly.  

Row Unit  Indicate the height of rows on the encounter form. You can use 
specify the measurement in either inches or centimeters.  

Column Unit  Indicate the width of columns on the encounter form. You can 
use specify the measurement in either inches or centimeters.  

Width measured in... Mark the appropriate radio button to indicate whether width 
should be measured in characters or units. If you use units, 
indicate the size of the unit in the 1 Width Unit field.  

Left Margin  Indicate the width, in column units, of the left margin (the blank 
space on the left side of the page). The size of the column unit 
is specified in the 1 Column Unit field.  

Right Margin  Indicate the width, in column units, of the right margin (the 
blank space on the right side of the page). The size of the 
column unit is specified in the 1 Column Unit field.  

Top Margin  Indicate the width, in column units, of the top margin (the blank 
space on the top of the page). The size of the column unit is 
specified in the 1 Column Unit field.  

Bottom Margin  Indicate the width, in column units, of the bottom margin (the 
blank space on the bottom of the page). The size of the column 
unit is specified in the 1 Column Unit field.  
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Encounter Labels 
You can configure custom-designed encounter labels that include patient demographic information, 
date of service, responsible party/guarantor, insurance information, and other information.  

Adding, editing, and deleting encounter labels 
To open the Encounter Label Maintenance screen: 

• Select Maintenance > Templates > Form Templates > Encounter Labels. The Encounter Labels 
Select screen appears.  

To add an encounter label from scratch: 

1. On the Encounter Labels Select screen, click the New button. 

2. Fill in the fields on this screen, then click the OK button. 

3. When you finish, click the OK button. The Form Layout <New> screen appears. You will use this 
screen to place individual fields on the form.  

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save the form and close the Form Layout screen.  

To add an encounter label by copying an existing form: 

1. On the Encounter Labels Select screen, highlight the encounter label that you want to copy.  

2. Click the Copy Form button. The Copy Order Form screen appears.  

3. Type a name for the new encounter labels.  

4. Click the OK button.  

5. On the Encounter Labels Select screen, highlight the new encounter label in the table.  

6. Click the Edit button. The Encounter Labels <Edit> screen appears. The settings on this screen 
are from the original encounter label that you copied.  

7. Make the necessary changes to the settings.  

8. When you finish, click the OK button. You return to the Encounter Labels Select screen.  

To change an encounter label: 

1. On the Encounter Labels Select screen, highlight the encounter label that you want to change.  

2. Click the Edit button. Make the appropriate changes.  

3. When you finish, click the OK button. The Form Layout <Edit> screen appears. Make the 
necessary changes. 

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save your changes and close the Form Layout screen.  
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To delete an encounter label: 

• On the Encounter Labels Select screen, highlight the encounter label that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the encounter label maintenance screen 
Field Description 

Name  Type a name for the encounter labels.  

Description  Type a description for the encounter labels.  

Sort Indicate how you want the data to be sorted. You can sort data 
in:  

 Ascending order - A to Z, zero to 9, or earliest to latest date 

 Descending order - Z to A, 9 to zero, or latest to earliest 
date  

 No sorting preference  
Group By  Select how you want the data to be grouped (for example, use 

“FullName” to group data by patient name). This field is 
required.  

See Data Items for Custom Reports for a list of item names you 
can use in this field.  

Font  Click the Font button to set the default font for the encounter 
labels. You can set the font, font style, font size, font effects, and 
font color.  

If you do not select a font, the default font will be used.  

Make sure the font you select is supported by the printer you 
will use, or the form will not print correctly.  

Row Unit  Indicate the height of rows on the encounter labels. You can 
use specify the measurement in either inches or centimeters.  

Column Unit  Indicate the width of columns on the encounter labels. You can 
use specify the measurement in either inches or centimeters.  

Width measured in... Mark the appropriate radio button to indicate whether width 
should be measured in characters or units. If you use units, 
indicate the size of the unit in the 1 Width Unit field.  

Label Type  Select from the list of supported label types.  
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Order forms 
With Order Entry, you can develop custom forms to match printed forms from various labs and 
facilities. Custom forms can be assigned through the Facility Name screen. If a custom form is not 
selected for a facility, the standard order form prints.  

Lytec MD includes a pre-configured cancelled order forms (existing sites may need to import this form). 
This form prints if an order is cancelled, so that you can track the date, time, reason for cancellation, 
and order information for cancelled orders. You can customize this form, or create your own cancelled 
order form. If you create your own, your system administrator should update the Default Cancelled 
Order Form setting on the Special Features screen to match the name of the new form. That way, Lytec 
MD will know to print the new form, and not the pre-configured form. 

The most important steps in designing a custom form are determining the:  

• Information that should print on the form. Are you familiar enough with the database to find the 
data items you need? How do you want the data sorted? Do you want to add text labels to the 
type of data?  

• Layout of the information. How are you going to place the data in rows and columns so that it 
matches the layout of the form?  

• Format of the information. What font and font size do you want to use? Do you want to use text 
formatting such as bold or underline? Do you want to print barcodes? How do you want to 
format date fields (for example, mmddyy or mm/dd/yyyy)?  

Keep in mind that the form may print differently than it appears on screen, because of differences with 
printer drivers and fonts. For example, if you selected to use a particular font (such as Arial) but the 
printer does not have that font installed, another font will be substituted. The substitute font may have a 
different point size or pitch, so printed text may be misaligned or cut off.  

Another important issue is the width of the font (pitch) and the width of the data fields. The font's pitch 
will help determine how you place more than one field in a row. Pitch is the number of characters per 
horizontal inch. For monospaced (non-proportional) fonts such as Courier, where all characters are of 
equal widths, you can calculate pitch by dividing 120 by the point size. For 12-point Courier, then, the 
pitch is 10. This means that for each inch, 10 characters will print. A data item with a width of 15 
characters will need 1.5 inches of space on the form. Proportional fonts have characters of different 
widths (the font used here is proportional), so it does not have a fixed number of characters per inch, 
and therefore does not have an absolute pitch.  

A font's point size is its height measured in points (1 point = 1/72 inch). For 10-point Courier font, the 
distance from the top of the highest character to the bottom of the lowest character is 10 points (10/72 
inch). Lytec MD supports one barcode font whose height value may need adjusting; see Barcodes for 
forms and labels. 

When designing a form that includes multiple orders on a single page, you must include the Begin 
Loop and End Loop codes. You will also need to include a SortBy property set. 

Designing the form will probably take some trial and error. When you have a version that you want to 
test, print the custom form on a plain piece of paper. Then hold this prototype up behind the printed 
form from the lab or facility to check whether all the data items are positioned correctly.  

Adding, editing, and deleting custom order forms 
To open the custom order form maintenance screen: 

• Select Maintenance > Templates > Form Templates > Order Forms. The Order Forms Select 
screen appears.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 281 

 

To add a custom order form from scratch: 

1. On the Order Forms Select screen, click the New button. 

2. Fill in the fields on this screen, then click the OK button. 

3. When you finish, click the OK button. The Form Layout <New> screen appears. You will use this 
screen to place individual fields on the form.  

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save the form and close the Form Layout screen.  

To add a custom order form by copying an existing form: 

1. On the Order Forms Select screen, highlight the order form that you want to copy.  

2. Click the Copy Form button. The Copy Order Form screen appears.  

3. Type a name for the new order form.  

4. Click the OK button.  

5. On the Order Forms Select screen, highlight the new order form in the table.  

6. Click the Edit button. The Order Form <Edit> screen appears. The settings on this screen are 
from the original order form that you copied.  

7. Make the necessary changes to the settings.  

8. When you finish, click the OK button. You return to the Order Forms screen.  

To change a custom order form: 

• On the Order Forms Select screen, highlight the order form that you want to change.  

• Click the Edit button. Make the appropriate changes.  

• When you finish, click the OK button. The Form Layout <Edit> screen appears. Make the 
necessary changes. 

• Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

• Click the Preview button to preview the form.  

• When you finish, click the OK button to save your changes and close the Form Layout screen.  

To delete a custom order form: 

• On the Order Forms Select screen, highlight the order form that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the custom order form maintenance screen 
Field Description 

Name  Type a name for the order form.  

Description  Type a description for the order form.  
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Sort Indicate how you want the data to be sorted. You can sort data 
in:  

 Ascending order - A to Z, zero to 9, or earliest to latest date 

 Descending order - Z to A, 9 to zero, or latest to earliest 
date  

 No sorting preference  
Group By  Select how you want the data to be grouped (for example, use 

“FullName” to group data by patient name). This field is 
required.  

See Data Items for Custom Reports for a list of item names you 
can use in this field.  

Font  Click the Font button to set the default font for the order form. 
You can set the font, font style, font size, font effects, and font 
color.  

If you do not select a font, the default font will be used.  

Make sure the font you select is supported by the printer you 
will use, or the form will not print correctly.  

Row Unit  Indicate the height of rows on the order form. You can use 
specify the measurement in either inches or centimeters.  

Column Unit  Indicate the width of columns on the order form. You can use 
specify the measurement in either inches or centimeters.  

Width measured in... Mark the appropriate radio button to indicate whether width 
should be measured in characters or units. If you use units, 
indicate the size of the unit in the 1 Width Unit field.  

Left Margin  Indicate the width, in column units, of the left margin (the blank 
space on the left side of the page). The size of the column unit 
is specified in the 1 Column Unit field.  

Right Margin  Indicate the width, in column units, of the right margin (the 
blank space on the right side of the page). The size of the 
column unit is specified in the 1 Column Unit field.  

Top Margin  Indicate the width, in column units, of the top margin (the blank 
space on the top of the page). The size of the column unit is 
specified in the 1 Column Unit field.  

Bottom Margin  Indicate the width, in column units, of the bottom margin (the 
blank space on the bottom of the page). The size of the column 
unit is specified in the 1 Column Unit field.  
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Order labels 
You can configure custom-designed order labels that include patient demographic and order 
information.  

Lytec MD supports multi-column labels. A drop-down field on the setup screen displays all supported 
labels. You can also view the list by opening the Labels.xml file in the Lytec MD directory. 

Lytec MD uses the following logic to determine which order label should print: 

1. The insurance-specific order label prints, if one exists. If not... 

2. The facility-specific label for the order's default facility prints, if one exists. If not... 

3. The label for the order type prints. 

There is one exception to the logic above. If the Print Default Label check box is marked when adding 
an order, the label specified in the Special Feature screen's Default Order Label field will print. 

Adding, editing, and deleting order labels 
To open the order label maintenance screen: 

• Select Maintenance > Templates > Form Templates > Order Labels. The Order Labels Select 
screen appears.  

To add an order label from scratch: 

1. On the Order Labels Select screen, click the New button. 

2. Fill in the fields on this screen, then click the OK button. 

3. When you finish, click the OK button. The Form Layout <New> screen appears. You will use this 
screen to place individual fields on the form.  

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save the form and close the Form Layout screen.  

To add an order label by copying an existing form: 

1. On the Order Labels Select screen, highlight the order label that you want to copy.  

2. Click the Copy Form button. The Copy Order Form screen appears.  

3. Type a name for the new order labels.  

4. Click the OK button.  

5. On the Order Labels Select screen, highlight the new order label in the table.  

6. Click the Edit button. The Order Labels <Edit> screen appears. The settings on this screen are 
from the original order label that you copied.  

7. Make the necessary changes to the settings.  

8. When you finish, click the OK button. You return to the Order Labels Select screen.  
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To change an order label: 

1. On the Order Labels Select screen, highlight the order label that you want to change.  

2. Click the Edit button. Make the appropriate changes.  

3. When you finish, click the OK button. The Form Layout <Edit> screen appears. Make the 
necessary changes. 

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save your changes and close the Form Layout screen.  

To delete an order label: 

• On the Order Labels Select screen, highlight the order label that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Order Label Maintenance screen 
Field Description 

Name  Type a name for the order labels.  

Description  Type a description for the order labels.  

Sort Indicate how you want the data to be sorted. You can sort data 
in:  

 Ascending order - A to Z, zero to 9, or earliest to latest 
date  

 Descending order - Z to A, 9 to zero, or latest to earliest 
date  

 No sorting preference  

Group By  Select how you want the data to be grouped (for example, use 
“FullName” to group data by patient name). This field is 
required.  
See Data Items for Custom Reports for a list of item names you 
can use in this field.  

Font  Click the Font button to set the default font for the order labels. 
You can set the font, font style, font size, font effects, and font 
color.  
If you do not select a font, the default font will be used.  
Make sure the font you select is supported by the printer you 
will use, or the form will not print correctly.  

Row Unit  Indicate the height of rows on the order labels. You can use 
specify the measurement in either inches or centimeters.  

Column Unit  Indicate the width of columns on the order labels. You can use 
specify the measurement in either inches or centimeters.  

Width measured in... Mark the appropriate radio button to indicate whether width 
should be measured in characters or units. If you use units, 
indicate the size of the unit in the 1 Width Unit field.  
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Label Type Select from the list of supported label types. 
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Requisition forms 
With Order Entry, you can develop requisition forms for facilities. The most important steps in 
designing a custom form are determining the:   

• Information that should print on the form. Are you familiar enough with the database to find the 
data items you need? How do you want the data sorted? Do you want to add text labels to the 
type of data?  

• Layout of the information. How are you going to place the data in rows and columns so that it 
matches the layout of the form?  

• Format of the information. What font and font size do you want to use? Do you want to use text 
formatting such as bold or underline? Do you want to print barcodes? How do you want to 
format date fields (for example, mmddyy or mm/dd/yyyy)?  

Keep in mind that the form may print differently than it appears on screen, because of differences with 
printer drivers and fonts. For example, if you selected to use a particular font (such as Arial) but the 
printer does not have that font installed, another font will be substituted. The substitute font may have a 
different point size or pitch, so printed text may be misaligned or cut off.  

Another important issue is the width of the font (pitch) and the width of the data fields. The font's pitch 
will help determine how you place more than one field in a row. Pitch is the number of characters per 
horizontal inch. For monospaced (non-proportional) fonts such as Courier, where all characters are of 
equal widths, you can calculate pitch by dividing 120 by the point size. For 12-point Courier, then, the 
pitch is 10. This means that for each inch, 10 characters will print. A data item with a width of 15 
characters will need 1.5 inches of space on the form. Proportional fonts have characters of different 
widths (the font used here is proportional), so it does not have a fixed number of characters per inch, 
and therefore does not have an absolute pitch.  

A font's point size is its height measured in points (1 point = 1/72 inch). For 10-point Courier font, the 
distance from the top of the highest character to the bottom of the lowest character is 10 points (10/72 
inch).  

When designing a form that includes multiple orders on a single page, you must include the Begin 
Loop and End Loop codes. You will also need to include a SortBy property set. 

Designing the form will probably take some trial and error. When you have a version that you want to 
test, print the custom form on a plain piece of paper. Then hold this prototype up behind the printed 
form from the lab or facility to check whether all the data items are positioned correctly.  

Adding, editing, and deleting requisition forms 
To open the requisition form maintenance screen: 

• Select Maintenance > Templates > Form Templates > Requisition Forms. The Requisition Forms 
Select screen appears.  

To add a requisition form from scratch: 

1. On the Requisition Forms Select screen, click the New button. 

2. Fill in the fields on this screen, then click the OK button. 

3. When you finish, click the OK button. The Form Layout <New> screen appears. You will use this 
screen to place individual fields on the form.  

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  
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5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save the form and close the Form Layout screen.  

To add a requisition form by copying an existing form: 

1. On the Requisition Forms Select screen, highlight the requisition form that you want to copy.  

2. Click the Copy Form button. The Copy Order Form screen appears.  

3. Type a name for the new requisition form.  

4. Click the OK button.  

5. On the Requisition Forms Select screen, highlight the new requisition form in the table.  

6. Click the Edit button. The Requisition Forms <Edit> screen appears. The settings on this screen 
are from the original requisition form that you copied.  

7. Make the necessary changes to the settings.  

8. When you finish, click the OK button. You return to the Requisition Forms Select screen.  

To change a requisition form: 

1. On the Requisition Forms Select screen, highlight the requisition form that you want to change.  

2. Click the Edit button. Make the appropriate changes.  

3. When you finish, click the OK button. The Form Layout <Edit> screen appears. Make the 
necessary changes. 

4. Click the Validate button if you want Lytec MD to make sure the form layout you entered will 
work.  

5. Click the Preview button to preview the form.  

6. When you finish, click the OK button to save your changes and close the Form Layout screen.  

To delete a requisition form: 

• On the Requisition Forms Select screen, highlight the requisition form that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the requisition form maintenance screen 
Field Description 

Name  Type a name for the requisition form.  

Description  Type a description for the requisition form.  

Sort Indicate how you want the data to be sorted. You can sort data 
in:  

 Ascending order - A to Z, zero to 9, or earliest to latest 
date  

 Descending order - Z to A, 9 to zero, or latest to earliest 
date  

 No sorting preference  
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Group By  Select how you want the data to be grouped (for example, use 
“FullName” to group data by patient name). This field is 
required.  
See Data Items for Custom Reports for a list of item names you 
can use in this field.  

Font  Click the Font button to set the default font for the requisition 
form. You can set the font, font style, font size, font effects, and 
font color.  
If you do not select a font, the default font will be used.  
Make sure the font you select is supported by the printer you 
will use, or the form will not print correctly.  

Row Unit  Indicate the height of rows on the requisition form. You can use 
specify the measurement in either inches or centimeters.  

Column Unit  Indicate the width of columns on the requisition form. You can 
use specify the measurement in either inches or centimeters.  

Width measured in... Mark the appropriate radio button to indicate whether width 
should be measured in characters or units. If you use units, 
indicate the size of the unit in the 1 Width Unit field.  

Left Margin  Indicate the width, in column units, of the left margin (the blank 
space on the left side of the page). The size of the column unit 
is specified in the 1 Column Unit field.  

Right Margin  Indicate the width, in column units, of the right margin (the 
blank space on the right side of the page). The size of the 
column unit is specified in the 1 Column Unit field.  

Top Margin  Indicate the width, in column units, of the top margin (the blank 
space on the top of the page). The size of the column unit is 
specified in the 1 Column Unit field.  

Bottom Margin  Indicate the width, in column units, of the bottom margin (the 
blank space on the bottom of the page). The size of the column 
unit is specified in the 1 Column Unit field.  
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Form Layout screen 
You can use the Form Layout screen to place individual fields on Lytec MD forms and labels.  

Using the Form Layout screen 
To use the Form Layout screen: 

1. Add or edit a custom form template (encounter form, encounter labels, order form, order 
labels, or requisition form). When you click OK on the form's <Edit> or <New> screen, the 
Form Layout screen appears. 

2. In the Row field, type the row number for the field. You must enter row numbers numerically, so 
the first number you use should be either 0 or 1. Use the row height you designated on the 
form's <Edit> or <New> screen (for example, .5 inch) to design your form.  
 
You can enter decimals in this field (for example, 1.25). 

3. In the Column field, type the column in the row for the field. Use the column width you 
designated on the form's <Edit> or <New> screen (for example, .5 inch) to design your form.  
 
You can enter decimals in this field (for example, 1.25). 

4. Click in the Item field to display the drop-down arrow. Then click the arrow to open the Form 
Item Selection screen.  
 
In the Section field, select the type of data that you want to add. Your options include practice, 
provider, referring source, patient/account, balance, insurance, and tools (tools you can use to 
design the form).  
 
In the table, highlight the data field that you want to add.  
 
Click the OK button. The data field you selected displays in the Item field.  

5. In the Width field, type the number of characters (width) that you want to use for the field. Data 
that exceeds the width will be cut off after the number of characters you select, so make sure 
the width of the field is sufficient for the type of information.  

6. In the Height field, type the font height (based on the row unit selected on the previous form or 
label screen) you want to use for the field. This field is especially important if you are printing a 
barcode. For example, if you set the row unit as .5 inches, and you want the font height to be 
one inch, enter 2 in this field (.5 * 2 = 1 inch). 
 
If left blank, this field defaults to the point size of the selected (or default) font. 

7. In the Start field, indicate whether you do not want to display the first n characters of the field. 
For example, if all patient IDs begin with a prefix of A and you do not want to display the A in 
your report, type 1 here to suppress the first character of the data.  

8. In the Format field, type the format you want to use for the field. For example, to print last 
names in uppercase, type [>]  
 
If you selected Label as the Item, type the caption that you want to display on the form.  

9. In the Font field, click the drop-down arrow and select the font type, size, and format. For 
example, you may want to print the field in Arial font, size 14, bold format. If printing a barcode, 
make sure you select a font that starts with IDAutomation. 
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10. Add other fields as needed. You can move rows by:  
• First, highlight consecutive rows you want to move. Press the SHIFT button, then click the 

first row number, until the entire row is highlighted. While holding down the left mouse 
button, drag the cursor (which has become a cross) over any additional consecutive rows 
that you want to move.  

• Next, when the rows are highlighted, release both the SHIFT button and the left mouse 
button. Slowly move the cursor to the top (if you want to move the rows up) or the bottom 
(if you want to move the rows down) of the highlighted block of rows. The cursor changes 
from a cross to an arrow.  

• Click and hold the left mouse button down. Then move the rows to the new location. 
Notice that a line displays as you move the cursor. When the rows are at the right spot, 
release the left mouse button.  

11. Click the Validate button if you want Order Entry to make sure the form or label layout you 
entered will work.  

12. Click the Preview button to preview the form or labels.  

13. When you finish, click the OK button to save the form or labels and close the Form Layout 
screen.  

Data items for custom order forms 
The table below lists some of the data items you can use when you are setting up custom forms and 
labels. The data items are divided into the following categories, and may not be available for every 
type of form or label:  

• Practice 

• Provider 

• Referring source 

• Patient/account 

• Patient provider 

• Balance information 

• Insurance 1 - 4  

• Message 

• Miscellaneous 

• Order 

• Order insurance 

• Tools used to format the form 

• User-defined patient fields 

• Extended order fields 

Practice fields 

Item Description Width 

PRAC_Addr1 Practice address, line 1 35 

PRAC_Addr2 Practice address, line 2 35 

PRAC_Addr3 Practice address, line 3 35 

PRAC_City Practice city 25 
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PRAC_CityStateZIP Practice city, state, ZIP code 35 

PRAC_Country Practice country 3 

PRAC_County Practice county 25 

PRAC_Email Practice e-mail address 50 

PRAC_Fax Practice fax 25 

PRAC_Name Practice name 50 

PRAC_PhoneNum Practice phone number 25 

PRAC_State Practice state 2 

PRAC_Zip Practice ZIP code 12 

Provider fields 

Item Description Width 

PATPP_BusExt Primary provider phone extension 5 

PATPP_BusPhone Primary provider phone number 25 

PATPP_Title Primary provider title 30 

PATUP_BusExt Usual provider phone extension 5 

PATUP_BusPhone Usual provider phone number 25 

PATUP_Title Usual provider title 30 

PROV_Addr1 Provider address, line 1 30 

PROV_Addr2 Provider address, line 2 30 

PROV_Addr3 Provider address, line 3 30 

PROV_BusExt Provider phone extension 5 

PROV_BusPhone Provider phone number 25 

PROV_City Provider city 25 

PROV_CityStateZIP Provider city, state, ZIP code 45 

PROV_Country Provider country 3 

PROV_County Provider county 25 

PROV_DEA Provider DEA license number 13 

PROV_FirstName Provider first name 20 

PROV_FullName Provider full name 60 

PROV_LastName Provider last name 40 

PROV_Middle Provider middle initial 1 

PROV_State Provider state 2 

PROV_State1_Lic Provider state 1 license 3 

PROV_State1_Lic_Number Provider state 1 license number 31 

PROV_State2_Lic Provider state 2 license 3 

PROV_State2_Lic_Number Provider state 2 license number 31 

PROV_State3_Lic Provider state 3 license 3 

PROV_State3_Lic_Number Provider state 3 license number 31 
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PROV_State4_Lic Provider state 3 license 3 

PROV_State4_Lic_Number Provider state 4 license number 31 

PROV_State5_Lic Provider state 5 license 3 

PROV_State5_Lic_Number Provider state 5 license number 31 

PROV_Title Provider title 30 

PROV_UPIN Provider UPIN 11 

PROV_Zip Provider ZIP code 12 

Referring source fields 

Item Description Width 

REFSRC_Addr1 Referring source address, line 1 30 

REFSRC_Addr2 Referring source address, line 2 30 

REFSRC_Addr3 Referring source address, line 3 30 

REFSRC_City Referring source city 25 

REFSRC_CityStateZIP Referring source city, state, ZIP code 45 

REFSRC_Country Referring source country 3 

REFSRC_County Referring source county 25 

REFSRC_FullName Referring source full name 80 

REFSRC_State Referring source state 2 

REFSRC_ZIP Referring source ZIP code 12 

Patient/account fields 

Item Description Width 

ACCT_Copay Account copay 14 

ACCT_Num Account number 12 

ACCT_SigOnFile1 Account signature on file 1 1 

ACCT_SigOnFile2 Account signature on file 2 1 

ACCT_SigOnFile3 Account signature on file 3 1 

ACCT_SigOnFile4 Account signature on file 4 1 

GUAR_AcctID Guarantor account ID 11 

GUAR_Addr1 Guarantor address, line 1 30 

GUAR_Addr2 Guarantor address, line 2 30 

GUAR_Addr3 Guarantor address, line 3 30 

GUAR_BusExt Guarantor phone extension 5 

GUAR_BusPhone Guarantor phone number 25 

GUAR_City Guarantor city 25 

GUAR_CityStateZip Guarantor city, state, ZIP code 42 

GUAR_Country Guarantor country 3 
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GUAR_Email Guarantor e-mail address 50 

GUAR_FirstName Guarantor first name 20 

GUAR_FullName Guarantor full name 61 

GUAR_HomePhone Guarantor home phone number 25 

GUAR_LastName Guarantor last name 40 

GUAR_State Guarantor state 2 

GUAR_Type_Code Type of account (account code) 3 

GUAR_Type_Desc Type of account (description) 30 

GUAR_Zip Guarantor ZIP code 12 

PAT_Addr1 Patient address, line 1 30 

PAT_Addr2 Patient address, line 2 30 

PAT_Addr3 Patient address, line 3 30 

PAT_Age Patient age 3 

PAT_BusExt Patient business phone extension 5 

PAT_BusPhone Patient business phone number 25 

PAT_City Patient city 25 

PAT_Country Patient country 3 

PAT_County Patient county 25 

PAT_DOB Patient date of birth 10 

PAT_Email Patient e-mail address 50 

PAT_Employer Patient employer 30 

PAT_FirstName Patient first name 20 

PAT_FullName Patient full name 59 

PAT_ID Patient ID number 12 

PAT_LastFirstName Patient last, first name 52 

PAT_LastName Patient last name 30 

PAT_Middle Patient middle initial 1 

PAT_PermDiagCode1 Patient permanent diagnosis code 1 10 

PAT_PermDiagCode2 Patient permanent diagnosis code 2 10 

PAT_PermDiagCode3 Patient permanent diagnosis code 3 10 

PAT_PermDiagCode4 Patient permanent diagnosis code 4 10 

PAT_PermDiagCode5 Patient permanent diagnosis code 5 10 

PAT_PermDiagDesc1 Patient permanent diagnosis description 
1 

60 

PAT_PermDiagDesc2 Patient permanent diagnosis description 
2 

60 

PAT_PermDiagDesc3 Patient permanent diagnosis description 
3 

60 

PAT_PermDiagDesc4 Patient permanent diagnosis description 
4 

60 
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PAT_PermDiagDesc5 Patient permanent diagnosis description 
5 

60 

PAT_Phone Patient home phone number 25 

PAT_RelationToGuar Patient relationship to guarantor 1 

PAT_Sex Patient sex/gender 1 

PAT_SSN Patient Social Security Number 11 

PAT_State Patient state 2 

PAT_ZIP Patient ZIP Code 12 

Patient provider fields 

Item Description Width 

PATPP_Addr1 Primary provider address, line 1 30 

PATPP_Addr2 Primary provider address, line 2 30 

PATPP_Addr3 Primary provider address, line 3 30 

PATPP_City Primary provider city 25 

PATPP_CityStateZIP Primary provider city, state, ZIP 
code 

45 

PATPP_Country Primary provider country 3 

PATPP_County Primary provider county 25 

PATPP_DEA Primary provider DEA license 
number 

13 

PATPP_FirstName Primary provider first name 20 

PATPP_FullName Primary provider full name 60 

PATPP_LastName Primary provider last name 40 

PATPP_Middle Primary provider middle initial 1 

PATPP_State Primary provider state 2 

PATPP_State1_Lic Primary provider state 1 license 3 

PATPP_State1_Lic_Number Primary provider state 1 license 
number 

31 

PATPP_State2_Lic Primary provider state 2 license 3 

PATPP_State2_Lic_Number Primary provider state 2 license 
number 

31 

PATPP_State3_Lic Primary provider state 3 license 3 

PATPP_State3_Lic_Number Primary provider state 3 license 
number 

31 

PATPP_State4_Lic Primary provider state 3 license 3 

PATPP_State4_Lic_Number Primary provider state 4 license 
number 

31 

PATPP_State5_Lic Primary provider state 5 license 3 

PATPP_State5_Lic_Number Primary provider state 5 license 
number 

31 
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PATPP_UPIN Primary provider UPIN 11 

PATPP_Zip Primary provider ZIP code 12 

PATUP_Addr1 Usual provider address, line 1 30

PATUP_Addr2 Usual provider address, line 2 30 

PATUP_Addr3 Usual provider address, line 3 30 

PATUP_City Usual provider city 25 

PATUP_CityStateZIP Usual provider city, state, ZIP 
code 

45 

PATUP_Country Usual provider country 3 

PATUP_County Usual provider county 25 

PATUP_DEA Usual provider DEA license 
number 

13 

PATUP_FirstName Usual provider first name 20 

PATUP_FullName Usual provider full name 60 

PATUP_LastName Usual provider last name 40 

PATUP_Middle Usual provider middle initial 1 

PATUP_State Usual provider state 2 

PATUP_State1_Lic Usual provider state 1 license 3 

PATUP_State1_Lic_Number Usual provider state 1 license 
number 

31 

PATUP_State2_Lic Usual provider state 2 license 3 

PATUP_State2_Lic_Number Usual provider state 2 license 
number 

31 

PATUP_State3_Lic Usual provider state 3 license 3 

PATUP_State3_Lic_Number Usual provider state 3 license 
number 

31 

PATUP_State4_Lic Usual provider state 3 license 3 

PATUP_State4_Lic_Number Usual provider state 4 license 
number 

31 

PATUP_State5_Lic Usual provider state 5 license 3 

PATUP_State5_Lic_Number Usual provider state 5 license 
number 

31 
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PATUP_UPIN Usual provider UPIN 11 

PATUP_Zip Usual provider ZIP code 12 

Balance information fields 

Item Description Width 

BAL_2MonthsAgo Balance - 2 months ago 14 

BAL_3MonthsAgo Balance - 3 months ago 14 

BAL_4MonthsAgo Balance - 4 months ago 14 

BAL_AcctTOP Account top of balance page 14 

BAL_Bal30 Balance - 30 days 14 

BAL_Bal306090120 Balance - 30+60+90+120 days 14 

BAL_Bal60 Balance - 60 days 14 

BAL_6090120 Balance - 60+90+120 days 14 

BAL_90 Balance - 90 days 14 

BAL_90120 Balance - 90+120 days 14 

BAL_G120 Balance - >120 days 14 

BAL_BudgetPayAmount Balance - budget payment amount 14 

BAL_CurMonth Balance - current month 14 

BAL_CurrentBal Balance - current balance 14 

BAL_G4MonthsAgo Balance - > 4 months ago 14 

BAL_InsPort30 Ins. Portion Balance - 30 days 14 

BAL_InsPort306090120 Ins. Portion Balance - 30+60+90+120 
days 

14 

BAL_InsPort60 Ins. Portion Balance - 60 days 14 

BAL_InsPort6090120 Ins. Portion Balance - 60+90+120 days 14 

BAL_InsPort90 Ins. Portion Balance - 90 days 14 

BAL_InsPort90120 Ins. Portion Balance - 90+120 days 14 

BAL_InsPortCurr Ins. Portion Balance - current balance 14 

BAL_InsPortG120 Ins. Portion Balance - > 120 days 14 

BAL_InsPortTotal Ins. Portion Balance - total balance 14 

BAL_InsPortTOP Ins. Portion Balance - top of page 
balance 

14 

BAL_LastMonth Balance - last month 14 

BAL_LastStmtPatDue Balance - last statement patient due 14 

BAL_PatPort30 Patient Portion Balance -  30 days 14 

BAL_PatPort306090120 Patient Portion Balance - 
30+60+90+120 days 

14 

BAL_PatPort60 Patient Portion Balance - 60 days 14 
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BAL_PatPort6090120 Patient Portion Balance - 60+90+120 
days 

14 

BAL_PatPort90 Patient Portion Balance - 90 days 14 

BAL_PatPort90120 Patient Portion Balance - 90+120 days 14 

BAL_PatPortCurr Patient Portion Balance - current 
balance 

14 

BAL_PatPortG120 Patient Portion Balance - > 120 days 14 

BAL_PatPortTotal Patient Portion Balance - total balance 14 

BAL_PatPortTOP Patient Portion Balance - top of page 
balance 

14 

BAL_PatTOP Balance - patient top of page balance 14 

BAL_TotalBal Balance - total balance 14 

Insurance 1 - 4 fields 
The table below lists the Insurance 1 fields. For insurance 2-4, replace INS1_ with INS2_, INS3_, or 
INS4_. 

Item Description Width 

INS1_AcctPlan Insurance 1 account plan 20 

INS1_Carrier Insurance 1 carrier name 20 

INS1_CarrierAddr1 Insurance 1 carrier address, line 
1 

30 

INS1_CarrierAddr2 Insurance 1 carrier address, line 
2 

30 

INS1_CarrierAddr3 Insurance 1 carrier address, line 
3 

30 

INS1_CarrierCity Insurance 1 carrier city 25 

INS1_CarrierCityStateZIP Insurance 1 carrier city, state, 
ZIP code 

45 

INS1_CarrierCountry Insurance 1 carrier country 3 

INS1_CarrierCounty Insurance 1 carrier county 25 

INS1_CarrierID Insurance 1 carrier ID 20 

INS1_CarrierPhone Insurance 1 carrier phone 
number 

25 

INS1_CarrierState Insurance 1 carrier state 2 

INS1_CarrierZIP Insurance 1 carrier ZIP code 12 

INS1_Employer Insurance 1 employer name 40 

INS1_EmployerAddr1 Insurance 1 employer address, 
line 1 

30 

INS1_EmployerAddr2 Insurance 1 employer address, 
line 2 

30 

INS1_EmployerAddr3 Insurance 1 employer address, 
line 3 

30 
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INS1_EmployerCity Insurance 1 employer city 25 

INS1_EmployerCityStateZIP Insurance 1 employer city, state, 
ZIP code 

45 

INS1_EmployerCountry Insurance 1 employer country 3 

INS1_EmployerState Insurance 1 employer state 2 

INS1_EmployerZIP Insurance 1 employer ZIP code 12 

INS1_FirstName Insurance 1 first name 20 

INS1_GroupNumber Insurance 1 group number 20 

INS1_Insurance ID Insurance 1 insurance ID 30 

INS1_LastName Insurance 1 last name 30 

INS1_Middle Insurance 1 middle initial 1 

INS1_OtherPlan Insurance 1 other plan 3 

INS1_PlanID Insurance 1 plan ID 20 

INS1_PlanName Insurance 1 plan name 20 

INS1_RelPlan Insurance 1 rel plan 1 

INS1_SSN Insurance 1 Social Security 
Number 

11 

Message fields 

Item Description Width 

MSG_LastApptDate Last appointment date 12 

MSG_NextApptDate Next appointment date 12 

Miscellaneous fields 

Item Description Width 

MISC_AppointmentReason Appointment reason 29 

MISC_AppointmentTime Appointment time 10 

MISC_DisplayDate Appointment date 12 

Order fields 

Item Description Width 

ORD_Acct_ID Order account ID 11 

ORD_Acct_Plan1 Order account plan 1 20 

ORD_Acct_Plan2 Order account plan 2 20 

ORD_Acct_Plan3 Order account plan 3 20 

ORD_Acct_Plan4 Order account plan 4 20 

ORD_CancelOperID Order cancelling operator ID 20 

ORD_CancelOperName Order cancelling operator name 30 
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ORD_CancelReason Order cancellation reason 100 

ORD_Case_ID Order case ID 20 

ORD_D_Cancelled Date order of cancellation 12 

ORD_D_Entered Date order entered 12 

ORD_D_First_Received Date order first received 12 

ORD_D_Last_Received Date order last received 12 

ORD_D_Ordered Date order ordered 12 

ORD_D_Overdue Date order overdue 12 

ORD_D_Received Date order received 12 

ORD_D_Sent Date order sent 12 

ORD_DiagCode1 Order diagnosis code 1 10 

ORD_DiagCode1_LDesc Order diagnosis code 1 long 
description 

60 

ORD_DiagCode1_SDesc Order diagnosis code 1 short 
description 

18 

ORD_DiagCode2 Order diagnosis code 2 10 

ORD_DiagCode2_LDesc Order diagnosis code 2 long 
description 

60 

ORD_DiagCode2_SDesc Order diagnosis code 2 short 
description 

18 

ORD_DiagCode3 Order diagnosis code 3 10 

ORD_DiagCode3_LDesc Order diagnosis code 3 long 
description 

60 

ORD_DiagCode3_SDesc Order diagnosis code 3 short 
description 

18 

ORD_DiagCode4 Order diagnosis code 4 10 

ORD_DiagCode4_LDesc Order diagnosis code 4 long 
description 

60 

ORD_DiagCode4_SDesc Order diagnosis code 4 short 
description 

18 

ORD_Facility Order facility ID 10 

ORD_Hidden_Set Order hidden set 1 

ORD_Hidden_Set_Name Order hidden set name 30 

ORD_Issued Order issued 1 

ORD_OfficeCode1 Order Office Code1 10 

ORD_OfficeCode2 Order Office Code2 10 

ORD_OfficeCode3 Order Office Code3 10 

ORD_OfficeCode4 Order Office Code4 10 

ORD_Order_Seq Order sequence number 12 

ORD_OrderName Order name 30 

ORD_OrderNote Order note 250 
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ORD_Number2 Order number 2 25 

ORD_OrderProcCode1 Order procedure code 1 10 

ORD_OrderProcCode10 Order procedure code 10 10 

ORD_OrderProcCode2 Order procedure code 2 10 

ORD_OrderProcCode3 Order procedure code 3 10 

ORD_OrderProcCode4 Order procedure code 4 10 

ORD_OrderProcCode5 Order procedure code 5 10 

ORD_OrderProcCode6 Order procedure code 6 10 

ORD_OrderProcCode7 Order procedure code 7 10 

ORD_OrderProcCode8 Order procedure code 8 10 

ORD_OrderProcCode9 Order procedure code 9 10 

ORD_OrderStatus Order status 11 

ORD_OrderType Order type 15 

ORD_OrderUrgency Order urgency 8 

ORD_OrderXRefName Order cross reference name 50 

ORD_Osort Order sort 1 

ORD_PatExtID Order patient external ID 12 

ORD_Practice ID Order practice ID 10 

ORD_PTID Order patient internal ID 12 

ORD_PVID Order provider ID 6 

ORD_Repeat_ID Order repeat ID 12 

ORD_SentPVID1 Order sent to provider 1 6 

ORD_SentPVID2 Order sent to provider 2 6 

ORD_SentPVID3 Order sent to provider 3 6 

ORD_SentPVID4 Order sent to provider 4 6 

ORD_Signing_PVID Order signing provider 6 

ORD_T_Cancelled Time order cancelled 12 

ORD_T_Entered Time order entered 12 

ORD_T_First_Received Time order first received 12 

ORD_T_Last_Received Time order last received 12 

ORD_T_Ordered Time ordered 12 

ORD_T_Overdue Time order overdue 12 

ORD_T_Received Time order received 12 

ORD_T_Sent Time order sent 12 

ORD_UrgencyIsStat Order urgency is Stat - X 1 

ORD_UrgencyIsStatMsg Order urgency is Stat Message 11 

ORDINSTR_Oper_Instr Operator Instruction 1000 

ORDINSTR_Pat_Instr Patient Instruction 1000 

REQ_D_Drawn Requisition date drawn/sampled 12 
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REQ_Fasting Requisition fasting 1 

REQ_Sample_Volume Requisition sample volume 20 

REQ_T_Drawn Requisition time drawn/sampled 12 

Order insurance fields 

Item Description Width 

ORDINS_AcctPlan Order insurance account plan 20 

ORDINS_Carreir Order insurance carrier name 20 

ORDINS_CarrierAddr1 Order insurance carrier address line 1 30 

ORDINS_CarrierAddr2 Order insurance carrier address line 2 30 

ORDINS_CarrierAddr3 Order insurance carrier address line 3 30 

ORDINS_CarrierCity Order insurance carrier city 25 

ORDINS_CarrierCityStateZIP Order insurance carrier city, state, ZIP Code 45 

ORDINS_CarrierCountry Order insurance carrier country 3 

ORDINS_CarrierCounty Order insurance carrier county 25 

ORDINS_CarrierID Order insurance carrier ID 20 

ORDINS_CarrierPhone Order insurance carrier phone number 25 

ORDINS_CarrierState Order insurance carrier state 2 

ORDINS_CarrierZip Order insurance carrier ZIP Code 12 

ORDINS_Employer Order insurance employer name 40 

ORDINS_EmployerAddr1 Order insurance employer address line 1 30 

ORDINS_EmployerAddr2 Order insurance employer address line 2 30 

ORDINS_EmployerAddr3 Order insurance employer address line 3 30 

ORDINS_EmployerCity Order insurance employer city 25 

ORDINS_EmployerCityStateZip Order insurance employer city, state, ZIP 
Code 

45 

ORDINS_EmployerCountry Order insurance employer country 3 

ORDINS_EmployerState Order insurance employer state 2 

ORDINS_EmployerZip Order insurance employer ZIP Code 12 

ORDINS_FirstName Order insurance first name 20 

ORDINS_GroupNumber Order insurance group number 20 

ORDINS_InsuranceID Order insurance ID 30 

ORDINS_LastName Order insurance last name 30 

ORDINS_Middle Order insurance middle initial 1 

ORDINS_PlanID Order insurance plan ID 20 

ORDINS_PlanName Order insurance plan name 20 

ORDINS_RelPlan Order insurance rel plan 1 

ORDINS_SSN Order insurance Social Security Number 11 
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Tool fields 

Item Description 

Begin Loop Loop begin point (beginning of detail)  

Blank Blank line; you can use Blank (and a row number) to insert an 
empty line in the report 

End Loop Loop end point (end of detail) 

Label Label 

Data formats for custom order forms 
The table below lists the formats you can use when you are setting up custom forms or labels.  

Format Description 

[#,###]  Prints 1234 as 1,234  

[#,###.##]  Prints 1234.567 as 1,234.56  

[Currency]  Prints 1234 as $1,234.00  

[Percentage]  Prints 0.05 as 5%  

[Long Date]  Prints 10/10/2008 as Friday, October 10, 2008  

[Short Date]  Prints 10/10/2008 as 10/10/2008  

[Medium Date]  Prints 10/10/2008 as 10-Oct-08  

[Long Time]  Prints 14:14:14 as 2:14:14 PM  

[>]  Prints all characters in upper case  

[<]  Prints all characters in lower case  
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Barcodes for forms and labels 
You can use the Code 3 of 9 barcode on Lytec MD forms (encounter forms, encounter labels, order 
forms, order labels, and requisition forms). Lytec MD installs both human readable fonts, with text 
below the barcode, and non-human readable fonts. 

The Code 3 of 9 barcode, also known as Code 39, is an easy-to-use alpha-numeric barcode, and can 
be used for various barcoding labels such as names and IDs. The Code 3 of 9 barcode includes the 
Health Industry Barcode (HIBC), a barcode format that should be used on health care products. The 
Code 3 of 9 fonts were developed according to AIM, ANSI, and European EN 800 standards.  

Symbols that are available for the barcode include characters 0-9, A-Z, the space character, and the 
following symbols: - . $ / + %. 

Note: Due to the barcode formatting requirements, exclamation marks ( ! ) and asterisks ( * ) cannot be 
used in the data to be barcoded. 

Code 3 of 9 fonts have been specially designed to produce dependable and scannable barcodes when 
printed at small point sizes. To ensure compatibility with all barcode scanners, we recommend printing 
the barcodes at 12 points or larger. The table below defines the approximate X (diagonal) dimensions 
for several point sizes. 

Point size Approximate X dimension 
(measured diagonally from top left to bottom right corner) 

24 .042 cm (16 mils) 

16 .028 cm (11 mils) 

14 .024 cm (9.5 mils) 

12 .021 cm (8 mils) 

8 .014 cm (6 mils) 

6 .0105 cm (4 mils) 

To print at a different X dimension, start with the point size with the X dimension closest to what you 
want, then use this formula to calculate the point size you need: 

12 * (X dimension you want) / (X dimension at 12 points) = (point size converted to integer) 

For example, if you want an X dimension of 12 mils, you need to print at 18 points: 12 * 12 / 8 = 18 

Lytec MD includes the following fonts: 

Font name *Font height at 12 points 

Code 3 of 9 fonts with text below the barcode (human readable): 

IDAutomationHC39XS 1/8" (.125") or .3 cm 

IDAutomationHC39S 1/4" (.25") or .6 cm 

IDAutomationHC39M 13/32" (.4") or 1 cm 

IDAutomationHC39L 1/2" (.5") or 1.5 cm 

IDAutomationHC39XL 7/8" (.88") or 2.2 cm 

IDAutomationHC39XXL 1-5/16" (1.31") or 3.4 cm 

Code 3 of 9 fonts with no text below the barcode: 

IDAutomationC39XS 1/8" (.125") or .3 cm 
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IDAutomationC39S 1/4" (.25") or .6 cm 

IDAutomationC39M 13/32" (.4") or 1 cm 

IDAutomationC39L 1/2" (.5") or 1.5 cm 

IDAutomationC39XL 7/8" (.88") or 2.2 cm 

IDAutomationC39XXL 1-5/16" (1.31") or 3.4 cm 

* Measurements are approximate, and are measured when printed at 12 points. Measurements for 
human readable fonts (HC) do not include the text below. 

Using the Code 3 of 9 barcode 
To use a Code 3 of 9 barcode on a form or label, you must select the font, and then enter [BC_3of9] in 
the Format field for the specified item. 

Although unlikely, you may have to additionally adjust the height setting for the barcode font. On the 
Form Layout screen, font height calculations exist but do not display because they rarely need 
adjusting. Barcode fonts are slightly larger and you may find that you need to adjust the height value to 
keep the font from extending outside the field. Remember that the height is based on the row unit. 
One row unit equals one-half inch. A possible height adjustment value for the barcode font is 0.70.  
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Immunizations Selection 
The system administrator should use Immunizations Selection to set up the Immunization Report and 
determine which Health Maintenance and Laboratory items will be on the report.  

Procedures for adding, editing, and deleting what is 
reported 
To open Immunizations Selection: 

• From the Maintenance menu, point to Templates and then Form Templates. Click Immunization 
Form to open Immunization Selection. 

To add a health maintenance activity to the report: 

• Click the health maintenance activity in HM Names to select it. Click the Add button between 
HM Names and HM Immunizations. The selected activity displays in HM Immunizations. This 
does not remove the selected health maintenance activity from HM Names. 

To add a lab result to the report: 

• Click the lab result in Lab Names to select it. Click the Add button between Lab Names and 
Lab Immunizations. The selected activity displays in Lab Immunizations. This does not remove 
the selected lab result from Lab Names. 

To remove a health maintenance activity from the report: 

• Click the health maintenance activity in HM Immunizations to select it. Click the Remove 
button between HM Names and HM Immunizations. The selected activity is removed from HM 
Immunizations. 

To remove a lab result from the report: 

• Click the lab result in Lab Immunizations to select it. Click the Remove button between Lab 
Names and Lab Immunizations. The selected activity is removed from Lab Immunizations. 

Information on Immunizations Selection 
Information Description 

HM Names The health maintenance activities in this box are available for 
the Immunization report. To add an activity to the report, click 
the health maintenance activity and then click Add. Listing the 
activity in HM Immunizations adds it to the report.  

HM Immunizations Any health maintenance activity listed in HM Immunizations is 
printed on the report. To delete an activity from the report, click 
the health maintenance activity and then click Remove. 
Deleting the activity from HM Immunizations removes it from 
the report.  

Lab Names The lab results in this box are available for the Immunization 
report. To add a result to the report, click the lab result and 
then click Add. Listing the activity in Lab Immunizations adds it 
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to the report. 

Lab Immunizations Any lab result listed in Lab Immunizations is printed on the 
report. To delete the result from the report, click the lab result 
and then click Remove. Deleting the result from Lab 
Immunizations removes it from the report.  
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Set Up 

Describe computer system 
You can use the Describe Computer System feature to view how you installed your system or change 
the operating system type.  

To display the Describe Computer System screen:  

1. Select Maintenance >Setup > Describe Computer System. The Describe Computer System 
screen appears.  

2. If you want to change the operating system type, mark the appropriate radio button.  

3. When you finish, click the OK button.  

Operator and Operator Maintenance 
Before an operator (user) can log on to Lytec MD, the user must have a user name, password, and 
access level. These access levels define whether the operator can access specific Lytec MD functions, 
and whether the operator can add, edit, view, and delete information.  

Create an operator ID for one of the following: 

• Specific user. For example, create operator ID "ABC" for the user "Adam Brian Crane." 

• Specific job function. For example, create operator ID "DAT" for all users that only do "data 
entry" and do not have their own operator ID. 

When assigning access levels, use one of the following: 

• Default access level for every practice. The operator has the same access level for each 
practice’s data. 

• Different access level for each practice. The operator has a different access level for each 
practice’s data.  

In Patient Records, the practice-specific access affects the operator’s ability to open a chart and see a 
patient’s data.  

• Select the Default access applies to unspecified practice check box on Special Features to 
give default-level access level by an operator for patient data in all practices. When this option is 
selected, operators are given their default level of access to charts that belong to practices for 
which the operator has no specified access level.  

• Clear the Default access applies to unspecified practice check box on Special Features to 
remove default-level access level by an operator for patient data in all practices. When the 
default-level access level is removed, operators have access to charts that is based on the 
practice specific access level given the operator. The operator's practice-specific access level 
applies when accessing data in a practice-specific patient chart.  

Note: A patient belongs to a specific practice if a practice is specified on the Patient screen’s Providers 
tab.  

Any operator assigned the access level "HI" can access all patients, regardless of practice assignment. 
This access level is particularly useful to correct errors in patient practice assignment.  
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Procedures for adding, editing, and deleting an operator 
and operator information 
Lytec MD makes an audit record whenever an operator is added, edited, or deleted.  

To open Operator: 

1. From the Maintenance menu, point to Set Up, and then click Operators.  

2. If asked, type the password. Operator appears.  

To add an operator: 

1. On Operator, click New. Operator Maintenance opens.  

2. Type the information for the General tab.  

3. To remove default-level access to all practices by assigning access for each practice, click the 
Practice Access Levels tab.  

4. To enter the operator's personal identification number (PIN), and configure the Dashboard 
display, click the Patients Records tab. 

5. When finished, click OK. 

To change an operator: 

1. On Operator, highlight the operator to be changed.  

2. Click Edit. Operator Maintenance opens. 

3. Make the changes from the appropriate tabs.  

4. When finished, click OK. 

To delete an operator: 

Any operator in this list cannot be deleted: 

• The current operator logged on to Lytec MD.  

• An operator with "HI" access level, if that operator is the only one with that access in the system.  

To delete any other operator: 

1. On Operator, highlight the operator to be deleted.  

2. Click Delete. A confirmation displays.  

3. Click Yes to delete the operator. 

To edit practice-specific access for the operator: 

Instead of allowing the default access level to all practices, the operator may be assigned a different 
access level for each practice's data.  

To create a new access level for a practice: 

1. On Operator Maintenance, click the Practice Access Levels tab.  

2. Click New Access to open Practice Access Level. 
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3. On Practice Access Level, click the Practice, Access Level, and Default Account Guide.  

4. Repeat clicking New Access until finished with each practice. 

5. Click OK to return to Operator Maintenance. 

Note: To edit an operator's practice-specific access level, highlight the practice on the Practice Access 
Levels tab and click Edit. To delete an operator's practice-specific access level, highlight the practice 
on the tab and click Delete. 

Rx only electronic signature (PIN) set up  
The Patient Records tab allows system administrators to configure an operator’s Rx only electronic 
signature (PIN) for prescriptions. The options displayed on the Patient Records tab depend on the 
PRUtils "User may set PIN" configuration.  

When "User may set PIN" configuration is enabled, operators will be prompted to enter their electronic 
signature (PIN) at login. See the Operator enters their own electronic signatures (PINs) section for a 
complete explanation on how to set up Lytec MD so operators can enter their own PINs for prescription 
signatures. 

When the "User may set PIN" configuration is not enabled, system administrators enter the operator’s 
electronic signatures (PINs). If the operator is not a provider with an electronic signature, the system 
administrator can enter an electronic signature (PIN) for the user to use when signing Rx's. See the 
System administrator enters electronic signatures (PINs) section for a complete explanation. 

Operator enters their own electronic signatures (PINs) 
When the operator is allowed to enter their own electronic signature (PIN) they will be prompted at 
login to enter their new PIN. System administrators use the Operator Maintenance, Patient Records 
tab to enable operators to set their own PIN.  

This screen allows system administrators to select from one of the following options: 

• Operator does not need an Electronic Signature: Select this option, when the operator does 
not need a PIN to sign for prescriptions. 

• Operator is Provider " " and will self enter a general signature: Select this option to allow an 
operator who is a provider to use their general signature. This option is only available when a 
Sign-on Provider has been selected on the General tab.  

• Operator is not a full, signing Provider, but will self enter an Rx only signature: Select this 
option to allow an operator who is not a provider to use an RX only signature. 

If an Operator’s Rx PIN needs to be changed, select the Reset Electronic Signature (PIN) check box to 
require the operator to enter a new PIN at their next login.  

System administrator enters electronic signatures (PINs) 
When the system administrator controls the rights to change an operator's PIN, operators will 
not be prompted at login to enter their electronic signature (PIN). When system administrators 
assign the operator’s PIN, the Patient Records tab will only display the PIN field.  

To allow an operator who is not a signing provider to have an Rx electronic signature: 

1. Type the PIN in the PIN field. 

2. When finished, click OK. 
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Dashboard configuration 
The Patient Records tab allows you to choose the default dashboard display.  

To assign the default Dashboard display: 

1. In the Dashboard Configuration list, click either Provider or Nurse. 

2. When finished, click OK. 

Options on Operator Maintenance 

The General Tab 

Field Description 

ID Code (required)  Type the operator’s identification code using up to 16 
alphanumeric characters.  
This is the operator's external ID. It must be different from every 
other internal or external ID code in the system. 

Name (required)  Type the operator’s name using up to 30 characters. Use 
"Family Name, First Name MI" order.   

Password (required) If PRUtils has been configured to allow operators to set their 
own passwords, this will not be available. 
Type the new operator’s password using up to 16 characters.  

Operator Title Type a title for the operator using up to 30 characters (i.e., the 
professional credentials of the operator). For example, M.D. 

Status Indicate whether the operator is active or inactive.  
Inactive operators cannot log into Lytec MD and will not display 
on operator lookups. 

Sign-on Practice  Select the operator's default practice. This practice appears on 
Lytec MD Sign In when the operator logs on to Lytec MD.  

Sign-on Provider  Select the operator's default provider. This provider appears on 
Lytec MD Sign In when the operator logs on to Lytec MD.   
If this is left blank, the default provider selected on Provider 
Maintenance becomes the operator's default provider.  

Default Demographic Guide  Select a default demographic guide for the operator.   

Access Level (Required)  Click to select the access level from the list.  
The access level controls whether the operator can access a 
Lytec MD function, and whether the operator can add, edit, 
view, and delete information. Each level is defined in Access 
Levels.  

Email  Type the operator's e-mail address.  

Telephone Code  Telephone code is reserved for future use. This will be used to 
set a default code for an automatic telephone dialer.  
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Reset Password If PRUtils has been configured to allow users to set their own 
passwords, this will be available. 
Select this check box to make an operator create a new 
password when logging in the next time. 
When adding a new operator, this check box is automatically 
selected. When editing an existing operator, click to select this 
check box to allow or force the operator to enter a new 
password. 

Temporary New Password When the Reset Password check box is selected, type a 
temporary password for the operator. The operator will have to 
change this temporary password to a new password when 
logging in the next time. 

Note: When adding a new operator, a temporary password is 
required. This field is optional when editing an existing 
operator. 

Notes  Type additional information about this operator in the box, if 
necessary. 
For example, the box can contain that this operator has 
responsibility for demographic data entry.  

The Practice Access Levels Tab 

Field Description 

New Access Click to display Practice Access Level to create a specific 
access level for a practice. See "To edit practice-specific access 
for the operator" for more information. 

Edit Access Click to display a highlighted practice in the table using 
Practice Access Level in order to edit the specific practice 
access level for the operator.  

Delete Access Click to delete a highlighted practice in the table to delete the 
specific practice access level for the operator. 

The Patient Records Tab 
The following fields are displayed on the Patient Records tab, when system administrators enter the 
electronic signatures (PINs) for prescriptions. 

Field Description 

PIN Type the prescription signature used by the operator in this 
field. 

Dashboard Configuration Click either Provider or Nurse from the list. This controls the 
Dashboard for the operator. The default value is Provider. 

The following fields are displayed on the Patient Records tab, when system administrators set up 
operators to enter their own electronic signatures (PINs) for prescriptions.
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Field Description 

Operator does not need an 
Electronic Signature 

This option is available only when PRUtils has been configured 
to allow operators to set their own PIN (prescription signature). 
Select this check box when the operator does not require an 
prescription signature. 

Operator is Provider " " and will 
self enter a general signature 

This option is available only when PRUtils has been configured 
to allow operators to set their own PIN (prescription signature). 
Select this check box to allow an operator who is a provider to 
use their general signature. 
Note: This option is only available when a Sign-on Provider 
has been selected. 

Operator is not a full, signing 
Provider, but will self enter an Rx 
only signature 

This option is available only when PRUtils has been configured 
to allow operators to set their own PIN (prescription signature). 
Select this check box to allow an operator who is not a provider 
to use an RX only signature. 

Reset Electronic Signature (PIN) This option is available only when PRUtils has been configured 
to allow operators to set their own PIN (prescription signature). 
Select this check box to require the operator to enter a new PIN 
when logging in the next time. 
Note: When Operator does not need an Electronic Signature 
is selected this field will not be enabled. 

Dashboard Configuration Click either Provider or Nurse from the list. This controls the 
Dashboard for the operator. The default value is Provider. 

Operator groups 
You can create operator groups (distribution lists) for use with the messaging system. A distribution list 
is a collection of people grouped by job tasks or other functions. In Lytec MD, operator groups are a 
collection of Lytec MD users grouped into your practice-specific categories. For example, you may 
want to create operator groups for departments, teams, or specialties. 

When you write a message, you can send it to individual operators or to operator groups. Operator 
groups save time when addressing messages, because you don't need to add every operator in the 
group to the To, Cc, or Bcc lines.  

Note: Your system administrator can use a setting in the ppart.ini file to define whether the blind copy 
(or Bcc) line should appear on the new/view message screen. 

Adding, editing, and deleting operator groups 

To open the operator group screen: 

• Select Maintenance > Set Up > Operator Groups. The Operator Group Maintenance screen 
appears. 

To add an operator group: 

1. On the Operator Group Maintenance screen, click the New button. The Operator Group 
Maintenance <New> screen appears. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 313 

 

2. Type a name for the new operator group. 

3. In the box on the left, highlight the operators who you want to include in the group. 
You can highlight contiguous operators by clicking on the first operator that you want to 
include, pressing and holding the SHIFT key, then clicking on the last operator.  
You can highlight non-contiguous operators by clicking on the first operator, pressing and 
holding the CTRL key, then clicking on additional operators one at a time. 

4. When you've selected the operators, click the arrow pointing to the box on the right. This 
moves the operators into the box. 

5. To delete an operator from the group, highlight the operator in the box on the right, then click 
the arrow pointing to the box on the left. 

6. When you finish, click the Save button. 

To change an operator group: 

• On the Operator Group Maintenance screen, highlight the operator group that you want to 
change. Click the Edit button. Add or delete operators from the operator group. When you 
finish, click the Save button. 

To delete an operator group: 

• On the Operator Group Maintenance screen, highlight the operator group that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the Yes 
button. 

Access Levels 
Access levels define whether an operator (a Lytec MD user) can access a given Lytec MD function, and 
whether the user can add, edit, view, and delete information. This means that you can limit the 
availability of Lytec MD functions to a selected number of staff members. You can also specify whether 
a user is required to enter a password to access information.  

Restricting access to Lytec MD is a two-step process:  

• First, you must define the access levels.  

• Second, you must assign access levels to each user (operator) of Lytec MD.  

It is critical that you consider carefully how you define access levels. This will determine the 
effectiveness of security and confidentiality in your practice. You should assign access levels to 
operators according to the type of information each will need to view or modify. Effective security 
ensures patient confidentiality and the integrity of your data.  

You must define access levels before you can use the Operator Maintenance screen to create a list of 
valid operators, along with their access levels and passwords.  

When you set access levels for Lytec MD, carefully consider the various users who will require access to 
Lytec MD functions. The pre-defined access level HI is assigned initially to the first operator running the 
program after it is installed. This operator will have access to all Lytec MD functions.  

Note: Be especially careful when deciding who will have access to the Operator Maintenance and 
Access Level Maintenance screens. An operator with access to these screens can change access levels 
and operators on Lytec MD.  
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Assigning access levels to operators 
To assign the restrictions that you want for an access level, click either the New or Edit button from the 
Access Levels screen. The Access Level Configuration screen appears.  

At the top of the Access Level Configuration screen is a field for the access level and another field for 
its description.  

The items for which you will assign access levels are divided by task, and are displayed on different 
tabs.  

• Tasks that apply to Patient Recordsand Appointment Scheduler for Windows display on the 
General tab.  

• Tasks for Patient Records display on the Records tab. 

• Tasks for Appointment Scheduler display on the Scheduler tab. 

• Tasks for Order Entry display on the Orders tab. 

• Tasks for reports display on the Reports tab. This tab is divided into tabs for general reports, 
Patient Records reports, Appointment Scheduler reports, and Order Entry reports. 

Note: The Scheduler tabs and tasks display only if you also installed Appointment Scheduler. 
Otherwise, the tab titles are hidden.  

By selecting the tab for the appropriate category (or subcategory), you can assign the type of security 
for each task item. Each type of security is displayed in the column titles of the list box. The six types of 
security are:  

• Access: Enables the operator to have access to the task item. Use when New, Edit, View, and 
Delete access is not appropriate.  

• New: Enables the operator to use the New button in a screen and use the New function.  

• Edit: Enables the operator to use the Edit button in a screen and use the Edit function.  

• View: Enables the operator to use the View button in a screen and use the View function.  

• Delete: Enables the operator to use the Delete button and use the Delete function.  

• Password: Displays the password screen before the operator can access the task item.  

The mode that you can select depends on the task item. One task item might require the Access type 
so that the item is accessible. Another task item might already be accessible, but you can restrict which 
screen modes and functions can be accessed, such as New, View, or Edit. For example, if an operator 
clicks the Edit button in a screen, but the operator’s access level does not allow the use of the Edit 
button, a message indicates that access is denied because the operator does not have a valid access 
level.  

Cells highlighted in gray in the list box are not applicable to the task items, and therefore, cannot be 
selected.  

The Password mode can be assigned to most of the task items. This means that if the Password mode is 
assigned to a task item, the Enter Password screen displays each time an operator tries to access the 
task item.  

Note: A password is required when you first start Patient Records.  

You can now start adding new access levels. At least one operator must have the access level HI.  

If you are using practice security, keep in mind that any user assigned the access level of HI can access 
all patients regardless of their practice assignment. This access level is particularly useful when 
correcting errors in patient practice assignment.  
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Limiting Access to Lytec MD Applications  
Warning:  
If you are using Patient Records and/or Appointment Scheduler and/or Order Entry, and you 
purchased a limited number of licenses, you can limit who has access to the applications to avoid 
running out of licenses. Each application is licensed separately. For example, let's say that you have 20 
Patient Records licenses and 10 Appointment Scheduler licenses. If you give access to both 
applications to everyone, only 10 people will be able to log onto Patient Records since they will be 
limited by the Appointment Scheduler licenses.  

To avoid the above problem you must alter the access levels that you assign to each user:  

• Look at the General Access Level Tab for all users. You will see “Hide AS except Provider 
Schedule?”, “Hide PR?”, and "Hide Orders?". When all three items are left unselected for an 
access level, a user assigned with this access level will use a Patient Records user license and an 
Appointment Scheduler user license and an Order Entry user license.  

• If you want the user to access only the Patient Records application, select the Access cell for the 
item, “Hide AS except Provider Schedule?” for the Access level. Only the Patient Records user 
license will be used. The user can still access the provider schedule and the check-in feature.  

• If you want the user to access only the Appointment Scheduler application, select the Access cell 
for the item, “Hide PR?” for the Access level. Only the Appointment Scheduler user license will be 
used.  

• If you want the user to access only the Order Entry application, mark the Access cell for both the 
“Hide AS except Provider Schedule” and “Hide PR?” items. Only the Order Entry user license will 
be used. If you limit a user to Order Entry only, the user can order, edit, and review orders 
through the Order Entry interface, but not through the patient chart.  

Limiting an access level to only one application ensures that a user assigned with this access level will 
use only one license for the assigned application. This will prevent problems with users being unable to 
log on.  

Adding, editing, and deleting access levels 

To open the access level maintenance screen: 

• Select Maintenance > Set Up > Access Levels. If required, enter your password and click the OK 
button. Access Levels appears. 

To add an access level "from scratch": 

• On Access Levels, click the New button. Fill in the fields on Access Level Configuration 
<New>, then click the OK button. 

To add an access level by copying an existing access level: 

• On Access Levels, highlight the access level that you want to copy. Click the Edit button. On 
Access Level Configuration <Edit>, click the Save As button. Type an ID and description for the 
new access level, and make the appropriate changes. When you finish, click the OK button. 

To change an access level: 

• On Access Levels, highlight the access level that you want to change. Click the Edit button. 
Make the appropriate changes. When you finish, click the OK button. 
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To delete an access level: 

• On Access Levels, highlight the access level that you want to delete. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 

Information and Actions on Access Level 

Field Description 

Access Level Type a code (up to three characters) for the access level. For 
example, you could type “REC” if the access level is for 
receptionists.  

Description Type a description of the access level. For example, you could 
type “Receptionist” as the description for the "REC" code.  

Task items The items for which you will assign access levels are divided by 
task, and are displayed on different tabs (General, Records, 
Scheduler, Orders, Reports).  
For each task item, mark the appropriate security types (Access, 
New, Edit, View, Del, Pswd). The security types change 
depending on the task item. 
To mark a security type, place the mouse cursor on the 
corresponding cell, then press the left mouse button. This 
action places an X in the cell to indicate the selection.  
You can also press the TAB key to initially highlight one of the 
grid cells, and then use the up/down arrow keys to move 
around the grid. Once the appropriate cell is highlighted, press 
the space bar to select that cell.  

Task items on the General tab  
Use the General tab to set general security (access levels) for all Lytec MD programs. The six types of 
security are:  

• Access: Enables the operator to have access to the task item. Use when New, Edit, View, and 
Delete access is not appropriate.  

• New: Enables the operator to use the New button on a screen and use the New function.  

• Edit: Enables the operator to use the Edit button on a screen and use the Edit function.  

• View: Enables the operator to use the View button on a screen and use the View function (for 
many screens, the View access allows the operator to access the task item's maintenance screen). 
View must be checked if the operator has New, Edit, or Delete access.  

• Delete: Enables the operator to use the Delete button and use the Delete function.  

• Password: Displays the password screen before the operator can access the task item.  

The task items for the General category include:  

Task item Description 

If Scheduler (AS) & Records (PR):  If both Patient Records and Appointment Scheduler are 
installed, access may be restricted to one application or the 
other by selecting one of the following two options:  

Hide AS except Provider Schedule?  
Click Access to deny the operator access to Appointment 
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Scheduler (that is, to "hide" Appointment Scheduler). The 
operator may still access Provider Schedule. This operator 
does not use an Appointment Scheduler user license.  

Hide PR? 
Click Access to deny the operator access to Patient Records. 
This operator does not use a Patient Records user license. 

Note: If Hide AS except Provider Schedule? and Hide PR? are 
not selected, the operator uses one user license for Patient 
Records and one user license for Appointment Scheduler.  

Hide Orders? 
Click Access to deny the operator access to Order Entry. This 
operator does not use an Order Entry user license. 

Provider/Practice Selection 
Click Access to allow the operator to change the current log on 
practice and provider when using the Lytec MD Sign In screen 
to log on or unpark a workstation. 
In Patient Records or Appointment Scheduler, this setting also 
controls access to the Provider or Practice Selection screen. 

Messages 
Click to allow the operator to Add, Edit, View, or Delete 
messages in Patient Records or Appointment Scheduler. 

Access other operator's messages? 
Click Access to allow the operator to view, edit, or delete 
another Lytec MD user's messages. 

All Messages For Patients 
Click Access to allow the current operator to view patient 
messages from all operators from the chart's Patient Messages 
screen. If this option is not enabled the operator will only be 
able to view their messages for the selected patient.  

Provider Schedule 
Click Access to allow the operator to access Provider 
Schedule in Patient Records or Appointment Scheduler.  

Transfer to Portable 
Click Access to allow the operator to access Transfer To 
Portable in Patient Records or Appointment Scheduler.  

Import Forms 
Click Access to allow the operator to access Import Forms in 
Patient Records or Appointment Scheduler.  

If Billing (MB)  These options do not apply to Lytec MD. 

Demographics  Lookup  
Click Access to allow the operator to access the  Patient 
Lookup screen.  

External Network Lookup 
Click Access to allow the operator to access the External 
Lookup tab of the Patient Lookup screen. 
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Account  
Click to allow the operator to View accounts.  

Patients  
Click to allow the operator to View patients. To limit access only 
to user-defined patient information, use Patient Other Data.  

Patient Practice Access  
Applies only when the operator is editing a patient.  
Click Access to allow the operator to change or add a patient's 
assigned practice, even if the operator does not have a 
specified access level for that practice. This is listed on the 
Practice-Specific Levels tab of Operators Maintenance.  
If this option is not selected, the operator may only change to or 
add a practice listed on the operator's Practice-Specific Levels 
tab.  

Patient Other Data  
Click Access to allow the operator to access the Other Data tab 
of Patient.  

Chart Access 
Click Access to allow the operator to access the Chart Access 
tab on the Patient screen.  

Patient Note 
Click Access to allow the operator to access the Notes tab of 
Patient, and the chart note (a note that displays near the 
bottom of the patient chart).  

Patient Web Access  
Click Access to allow the operator to add patient access to 
Web View (on the Configuration tab on Patient).  

Guarantors  
Click to allow the operator to View  guarantors. To limit access 
only to user-defined guarantor information, use Guarantor 
Other Data.  

Guarantor Other Data  
Click Access to allow the operator to access the Other Data tab 
of Guarantor.  

Guarantor Note 
Click to allow the operator to Add, Edit, View, or Delete 
guarantor notes.  

Insurance  
Click to allow the operator to View account insurance plans. If 
you want to limit access only to user-defined account insurance 
fields, use the Insurance Other Data task item.  

Insurance Other Data  
Click Access to allow the operator to access the Other Data tab 
of Account Insurance Plan.  
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Electronic Services These are reserved for future use. They do not affect the 
operation of the system at this time. 
Eligibility 
Referrals/Authorizations  

Task/Electronic Encounter Forms  Click to allow the operator to Add, Edit, View, or Delete 
electronic encounter forms.  

Task/Electronic Encounter From 
Scheduler  

Click Access to allow the operator to create electronic 
encounter forms using Appointment Scheduler data.  

Maintenance Practices 
Click to allow the operator to Add, Edit, View, or Delete 
practices.  

Providers/Groups  
Click to allow the operator to Add, Edit, View, or Delete 
providers.  

Carriers 
Click to allow the operator to Add, Edit, View, or Delete 
carriers.  

Referring Sources  
Click to allow the operator to Add, Edit, View, or Delete 
referring sources.  

Procedure Codes  
Click to allow the operator to Add, Edit, View, or Delete 
procedure codes.  

Diagnosis/Problem Codes  
Click to allow the operator to Add, Edit, View, or Delete 
diagnosis/problem codes.  

Facilities 
Click to allow the operator to Add, Edit, View, or Delete 
facilities.  

List Maintenance 
Click Access to allow the operator access to List Maintenance. 

Maintenance/Templates Encounter Form Templates  
Click Access to allow the operator to access Electronic 
Encounter Templates.  

Encounter Form Categories  
Click Access to allow the operator to access Encounter 
Category Maintenance. 

Encounter Form 
Click to allow the operator to Add, Edit, View, or Delete 
encounter forms.  

Encounter Labels 
Click to allow the operator to Add, Edit, View, or Delete 
encounter labels.  

Maintenance/Configuration  Special Features  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 320 

 

Click Access to allow the operator to access Special Features. 

Age Expression 
Click Access to allow the operator to add, edit, and delete age 
range expressions.  

Demographic Settings  
Click Access to allow the operator to access Demographic 
Settings.  

Address Defaults  
Click to allow the operator to Add, Edit, View, or Delete 
address defaults.  

Specialty Codes 
Click Access to allow the operator to Add, Edit, View, or 
Delete provider specialty codes.  

Demographic Guides  
Click to allow the operator to Add, Edit, View, or Delete 
demographic guides.  

Field Validations 
Indicate whether the operator can Add, Edit, View, or Delete 
field validations. 

Override Validation 
Mark Access to allow the operator to override field validations 
in an emergency and create a patient record without entering 
all required demographic or insurance information on the 
Patient, Guarantor or Account Insurance Plan screens. 

Patient User-defined data  
Click to allow the operator to Add, Edit, View, or Delete user-
defined patient information. 

Patient Alternate ID Definition  
Click to allow the operator to Add, Edit, View, or Delete user-
defined patient alternate ID information.  

Guarantor User-defined data  
Click to allow the operator to Add, Edit, View, or Delete user-
defined guarantor information.  

Insurance User-defined data  
Click to allow the operator to Add, Edit, View, or Delete user-
defined account insurance plan information.  

Practice User-defined data  
Click to allow the operator to Add, Edit, View, or Delete user-
defined practice information.  

Provider User-defined data  
Click to allow the operator to Add, Edit, View, or Delete user-
defined provider information.  

Referring Source User-defined data  
Click to allow the operator to Add, Edit, View, or Delete user-
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defined referring source information. 

Maintenance/Setup Workstation Setup 
Click Access to allow the operator to access Workstation 
Configuration.  

Describe Computer System  
Click Access to allow the operator to access Describe 
Computer System. This task should be limited to a system 
administrator only. 

Operators  
Click to allow the operator to Add, Edit, View, or Delete 
operators. This task should be limited to a system administrator 
only.  

Operator Groups 
Click to allow the operator to Add, Edit, View, or Delete 
operator groups used with the messaging system. This task 
should be limited to a system administrator only.  

Access Levels  
Click to allow the operator to Add, Edit, View, or Delete access 
levels. This task should be limited to a system administrator 
only.  

Printers  
Click Access to allow the operator to access Printer 
Maintenance.  
External Systems 
Click to allow the operator to Add, Edit, View, or Delete 
external systems. This task should be limited to a system 
administrator only.  

Maintenance/Utilities Purge Patients without data  
Click Access to allow the operator to access Purge Patients 
With No Clinical Data in Patient Records or Appointment 
Scheduler.  

Purge Messages  
Click Access to allow the operator to access Purge Messages 
in Patient Records or Appointment Scheduler. 

Merge Patients/Accounts  
Click Access to allow the operator to access Merge Patients in 
Patient Records or Appointment Scheduler. Currently, only 
Merge Patients is available for use.  

Import/Export Accounts 
This option does not apply to Lytec MD. 

Security Administration PRUtils 
Click Access to allow the operator to access the PRUtils system 
utility. 

Web View Admin 
Click Access to allow the administrator to have access to Web 
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View.

Provider 
Click Access to allow the provider to have access to Web View. 

Task Item Definitions for the Records Category  
You can use the Records category to set access level security for Patient Records. The six types of 
security are:  

• Access: Enables the operator to have access to the task item. Use when New, Edit, View, and 
Delete access is not appropriate.  

• New: Enables the operator to use the New button on a screen and use the New function.  

• Edit: Enables the operator to use the Edit button on a screen and use the Edit function.  

• View: Enables the operator to use the View button on a screen and use the View function (for 
many screens, the View access allows the operator to access the task item's maintenance screen). 
View must be marked if the operator has New, Edit, or Delete access.  

• Delete: Enables the operator to use the Delete button and use the Delete function.  

• Password: Displays the password screen before the operator can access the task item.  

The task items for the Records category include:  

Task item Description 

Patient Chart  The following items refer to actions the operator can perform in 
the patient chart.  

Break the Glass Select Access to allow the operator to access a chart that has 
been designated as off limits to them. This gives operators the 
opportunity to access a patient's chart if they have a legitimate 
reason. The operator's access will be recorded electronically.  

Note Compare Select Access to allow the operator to use note compare. With 
this feature operators can compare the changes they have made 
to their notes. They can compare up to 5 revisions of the same 
note against the original note.  

Chart Summary  Select Access to allow the operator to access the Chart Summary 
screen.  

Progress Notes  Indicate whether the operator can Add, Edit, View, or Delete 
progress notes.  

Past Medical History  Indicate whether the operator can Add, Edit, View, or Delete the 
patient's past medical history on the Past Medical History screen. 
(This category can be renamed.)  

Social History  Indicate whether the operator can Add, Edit, View, or Delete the 
patient's social history on the Social History screen. (This 
category can be renamed.)  

Family History  Indicate whether the operator can Add, Edit, View, or Delete the 
patient's family history on the Family History screen. (This 
category can be renamed.)  

Images  Indicate whether the operator can Add, Edit, View, or Delete 
images.  

Confidential - Confidential Indicate whether the operator can Add, Edit, View, or Delete 
data to the Confidential - Confidential section of the patient 
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chart. (This category can be renamed.) 

Confidential - Undefined #I Indicate whether the operator can Add, Edit, View, or Delete 
data to the Confidential - Undefined #I section of the patient 
chart. (This category can be renamed.)  

Confidential - Undefined #J  Indicate whether the operator can Add, Edit, View, or Delete 
data to the Confidential - Undefined #J section of the patient 
chart. (This category can be renamed.)  

Other Text Areas  Indicate whether the operator can Add, Edit, View, or Delete 
data in the other text areas of the patient chart. 

Delete «REQ» from note  Select Access to allow the operator to delete the «REQ» note 
label from a note.  

Flow Charts  Indicate whether the operator can Add, Edit, View, or Delete 
flow charts.  

Problem List  Indicate whether the operator can Add, Edit, View, or Delete the 
patient's problem list.  

Health Maintenance  Indicate whether the operator can Add, Edit, View, or Delete 
health maintenance data.  

Rx/Medications  Indicate whether the operator can Add, Edit, View, or Delete 
Rx/Medications.  

Note: If New is selected, the operator can use the Renew and 
Renew all buttons on the Rx/Medications screen. If New is not 
selected, the operator will not be able to renew prescriptions. 

Electronic RX signature for 
restricted RX 

Select Access to allow an electronic signature for restricted 
prescriptions (based on DEA Class). 

Electronic RX signature for non-
restricted RX 

Select Access to allow an electronic signature for non-restricted 
prescriptions. 

Require Co-Signature for restricted 
RX 

Select Access to allow an electronic signature for restricted 
prescriptions but require a co-signature as well. 

Require Co-Signature for non-
restricted RX 

Select Access to allow an electronic signature for non-restricted 
prescriptions but require a co-signature as well. 

Create Rx template from Rx  Select Access to allow the operator to mark the New Rx 
Template check box when writing a prescription.  

Rx Fill History Request Select Access to allow the operator to initiate a medication fill 
history request.  

Note: This feature will only be enabled if the ePrescribing 
interface is installed and connectivity to the RxHub network is 
established. Please contact your Lytec MD sales representative 
for more information.  

Rx Fill History Select Access to allow the operator to view a patient’s fill history 
in the Rx/Fill History tab on the Rx / Medications screen.   

Note: This feature will only be enabled if the ePrescribing 
interface is installed and connectivity to the RxHub network is 
established. Please contact your Lytec MD sales representative 
for more information. 

Allergies  Indicate whether the operator can Add, Edit, View, or Delete 
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allergies and intolerances. 

Vital Signs  Indicate whether the operator can Add, Edit, View, or Delete 
vital signs data.  

Clinical Elements Indicate whether the operator can Add, Edit, View, or Delete 
clinical element data.  

Pregnancy Indicate whether the operator can Add, Edit, View, or Delete 
prenatal information.  
You can select the View setting to allow users to only view 
prenatal data. To enable the view only mode you must only 
select the View setting, do not select the Add, Edit, and Delete 
settings.  
When the view only mode is enabled the prenatal data entry 
fields on the pregnancy screens will be read-only. Each 
pregnancy screen will display View Only next to the screen name 
in the title bar. The following offers a list of view only screens, and 
the buttons that are inactive when this mode is selected: 

 Prenatal Visit Flow Chart: New Preg, New Problem, 
Insert, and Clear Data buttons. Users will also not be 
able to double-click problem name row.  

 EDD Details  
 Pregnancies 

 Prenatal Lab/Plan 
 Prenatal Templates For 

Sound Recording Select Access to allow the operator to record dictation in 
progress notes. 

Dragon Voice Select Access to allow the operator to access the Dragon Voice 
add-on module. 

Rx Eligibility/Formulary  

Check Rx Eligibility on Demand Select Access to allow the operator to check Eligibility from the 
Rx / Medications screen and the Prescription screen. 

Note: This feature will only be enabled if the ePrescribing 
interface is installed and connectivity to the RxHub network is 
established. Please contact your Lytec MD sales representative 
for more information. 

Laboratory Data  The following items are for laboratory data.  

Lab Tables  In the Access column, indicate the operator's security level for 
laboratory data: N, R1, R2, or R3. You change this by clicking 
repeatedly on the item. See the Lab data test names section for a 
complete explanation of laboratory data access levels.  
Indicate whether the operator can Add, Edit, View, or Delete lab 
data.  

Miscellaneous  Indicate whether the operator can Add, Edit, View, or Delete 
miscellaneous lab data.  

Microbiology  Indicate whether the operator can Add, Edit, View, or Delete 
microbiology lab data.  

Review Data  
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Progress Notes and Documents  Select Access to allow the operator to access the Review 
Provider Data screen for progress notes and other documents.  

Laboratory Data  Select Access to allow the operator to access the Lab Table 
Review screen.  

Dashboard 

Provider Financial (default operator 
provider only) 

Select Access to enable the Provider Financials button on the 
Dashboard screen. When this access level is enabled, the 
financials for the current operators default provider will  be 
displayed. If the current provider does not have access to the 
providers financials, they will receive the following message:  
"Access denied for current Provider." 

Data Loader  

Text Data Loader  Select Access to allow the operator to access the Text Data 
Loader screen. 

Laboratory Data Loader  Select Access to allow the operator to access the Laboratory 
Data Loader screen.  

Print Laboratory Data or File  Select Access to allow the operator to print a laboratory data or 
file.  

Print Text Data Loader Error File  Select Access to allow the operator to print the text data loader 
error file. 

Print Laboratory Data Loader Error 
File  

Select Access to allow the operator to print the laboratory data 
loader error file.  

Data Acquisition 

EKG (third party) Indicate whether the operator can Add, Edit, View, or Delete 
data in the Brentwood ECG add-on module or the Welch Allyn 
ECG add-on module.  

Spirometry (third party) Indicate whether the operator can Add, Edit, View, or Delete 
data in the Brentwood Spirometry add-on module.  

Vitals (third party) Select Access to allow the operator to access the Welch Allyn 
vitals add-on module. 

Maintenance/Tables  

QuickText  Indicate whether the operator can Add, Edit, View, or Delete 
QuickText.  

Pharmacies Indicate whether the operator can Add, Edit, View, or Delete 
pharmacy data. 

Maintenance/Configuration  

Prescription Defaults  Select Access to allow the operator to access the Prescription 
Defaults screen.  

Customize Patient Chart for Site  Select Access to allow the operator to access the Patient Chart 
Configuration for Site screen. You should limit this task to the 
system administrator only.  

Customize Patient Chart for 
Provider  

Select Access to allow the operator to access the Patient Chart 
Configuration for Provider screen.  

Customize Chart Summary for Site  Select Access to allow the operator to access the Chart Summary 
Configuration screen. You should limit this task to the system 
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administrator only. 

Customize Chart Summary for 
Provider  

Select Access to allow the operator to access the Chart Summary 
Configuration screen.  

Maintenance Templates 

Immunization Form Select Access to allow the operator to the Immunizations 
Selection screen.  

Note Templates  

for Universal  Select Access to allow the operator to access the Universal Note 
Templates screen.  

for Provider  Select Access to allow the operator to access the Note 
Templates screen for provider-specific templates.  

Image Templates  Select Access to allow the operator to access the Image 
Templates screen. 

Prescription Templates  Select Access to allow the operator to access the Prescription 
Templates screen.  

Letter Templates  Select Access to allow the operator to access the Letter 
Templates screen.  

Page Templates  Select Access to allow the operator to access the Page Setup 
Templates screen.  

Message Templates  Select Access to allow the operator to access the message 
template screen.  

Lab Data Test Names  Indicate whether the operator can Add, Edit, View, or Delete lab 
data test names.  

Flow Chart/Lab Templates  Select Access to allow the operator to access the Flow/ Lab 
Template screen.  

Health Maintenance Templates  Select Access to allow the operator to access the Health 
Maintenance Templates screen.  

Health Maintenance Procedures Select Access to allow the operator access to the Health 
Maintenance Procedure names screen.   

Past Medical History Templates  Select Access to allow the operator to access the Past Medical 
History Template screen. (This category can be renamed.)  

Social History Templates  Select Access to allow the operator to access the Social History 
Template screen. (This category can be renamed.)  

Family History Templates  Select Access to allow the operator to access the Family History 
Template screen. (This category can be renamed.)  

Clinical Elements Maintenance Indicate whether the operator can Add, Edit, View, or Delete 
clinical elements data using the Clinical Elements Maintenance 
screen. 

Vital Signs Maintenance Indicate whether the operator can Add, Edit, View, or Delete 
vital signs data using the Vitals Maintenance screen. 

Maintenance/Setup  

Signatures  Select Access to allow the operator to access the Signatures 
frame on the Provider Maintenance screen. This frame allows the 
user to set up signatures for providers. You should limit this task 
to the system administrator only. 
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Maintenance/Utilities  

All Auto Saved Notes Select Access to allow the operator to view every auto saved 
note in the system. If this access level is not enabled, only the 
current operator's auto saved notes will be displayed.  

Archive Patient Data  Select Access to allow the operator to access the Archive Patient 
Data screen. Entering your password is required.  

Restore Patient Data  Select Access to allow the operator to access the Restore Patient 
Data screen.  

Health Maintenance Utilities  Select Access to allow the operator to access the Health 
Maintenance utilities.  

Laboratory Data Conversion  Select Access to allow the operator to access the Laboratory 
Data Conversion screen (for use with old laboratory data only) or 
the Laboratory Data Name Conversion Utility screen (for new 
laboratory data only).  

Blood Glucose Meter  Select Access to allow the operator to access the Blood Glucose 
Meter feature.  

Template Search and Replace Select Access to allow the operator to use the template search 
and replace feature.  

Task Item Definitions for the Scheduler Category  
You can use the Records category to set security for Appointment Scheduler. The six types of security 
are:  

• Access: Enables the operator to have access to the task item. Use when New, Edit, View, and 
Delete access is not appropriate.  

• New: Enables the operator to use the New button on a screen and use the New function.  

• Edit: Enables the operator to use the Edit button on a screen and use the Edit function.  

• View: Enables the operator to use the View button on a screen and use the View function (for 
many screens, the View access allows the operator to access the task item's maintenance screen). 
View must be marked if the operator has New, Edit, or Delete access.  

• Delete: Enables the operator to use the Delete button and use the Delete function.  

• Password: Displays the password screen before the operator can access the task item.  

For information on these items, refer to the Appointment Scheduler online help.  

The task items for the Scheduler category include:  

Task item Description 

Schedule (all views)  Indicate whether the operator can Add, Edit, or View data on the 
schedule views.  

Put Day on Hold  Mark Access to allow the operator to put a calendar day on hold. 

Remove Hold from a Day  Mark Access to allow the operator to remove the hold placed on 
a calendar day.  

Cancel Day  Mark Access to allow the operator to cancel a calendar day.  

Create Day  Mark Access to allow the operator to create an appointment for 
an unscheduled calendar day.  
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Reason for Visit  Mark Access to allow the operator to view the reason for a 
patient's visit.  

Protocol Scheduling Mark Access to allow the operator to access the protocol 
scheduling feature.  

Transfer to Outlook Mark Access to allow the operator to transfer appointments to 
Outlook. 

Appointment Slots  The following task items allow the operator to perform 
appointment and slot functions.  

Insert Slot/Double Book  Mark Access to allow the operator to insert an appointment into 
a schedule and to double-book an appointment.  

Edit Slot  Mark Access to allow the operator to edit an appointment slot 
from a schedule.  

Delete Slot  Mark Access to allow the operator to delete an appointment slot 
from a schedule.  

Block Slot  Mark Access to allow the operator to block an appointment slot. 

Cancel Appt  Mark Access to allow the operator to cancel appointments.  

Clear Appt  Mark Access to allow the operator to clear (delete) 
appointments.  

Find Appt  Mark Access to allow the operator to access the Find Patient 
Appointment screen.  

Over-ride TOV limit  Mark Access to allow the operator to exceed the Type of Visit 
(TOV) limit when scheduling an appointment.  

Wait List Appts  Indicate whether the operator can Add, Edit, View, or Delete 
appointments on the wait list. 

Over-ride Visit Counts Mark Access to allow the operator to override visit counts when 
scheduling an appointment. 

Schedule from Wait List  Mark Access to allow the operator to access the Schedule from 
Wait List screen.  

Non Patient Appointments  Mark Access to allow the operator to access the Non Patient 
Description screen and make non-patient appointments.  

Schedule Interpreter Requests  Mark Access to allow the operator to schedule interpreter 
requests. (Active only in Appointment Scheduler Enterprise.)  

Maintain Interpreter Requests  Indicate whether the operator can Edit, View, or Delete 
interpreter requests. (Active only in Appointment Scheduler 
Enterprise.)  

Check-in  Mark Access to allow the operator to access the Patient Check-In 
screen.  

Clear Multiple Patient 
Appointments  

Mark Access to allow the operator to access the Clear Multiple 
Patient Appointments screen.  

Patients In  Mark Access to allow the operator to access the Patients In 
screen. 

Hospital Rounds  Indicate whether the operator can Add, Edit, View, or Delete 
hospital rounds data.  

Maintenance  
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Rooms  Indicate whether the operator can Add, Edit, View, or Delete 
rooms.  

Resources  Indicate whether the operator can Add, Edit, View, or Delete 
resources.  

Interpreters/ Language Group  Indicate whether the operator can Add, Edit, View, or Delete 
interpreters and language groups. (Active only in Appointment 
Scheduler Enterprise.)  

Calendars  Indicate whether the operator can Add, Edit, View, or Delete 
calendars.  

Schedule Templates  Indicate whether the operator can Add, Edit, View, or Delete 
schedule templates.  

On Call Schedule Indicate whether the operator can Add, Edit, View, or Delete on 
call schedules.  

Group Scheduling Indicate whether the operator can Add, Edit, View, or Delete 
group schedules.  

Maintenance/Configuration  

Type of visit codes  Indicate whether the operator can Add, Edit, View, or Delete 
type of visit codes.  

Type of visit instructions  Indicate whether the operator can Add, Edit, View, or Delete 
type of visit instructions.  

Status codes  Indicate whether the operator can Add, Edit, View, or Delete 
status codes.  

Process codes  Indicate whether the operator can Add, Edit, View, or Delete 
process codes.  

Note: This access level also controls whether the operator can 
add, edit, view, or delete process-specific time limits. 

Process Check-in Links  Mark Access to allow the operator to access the Process Check-
in Links screen.  

Quick Text Indicate whether the operator can Add, Edit, View, or Delete 
appointment QuickText. 

Schedule Columns Indicate whether the operator can Add, Edit, View, or Delete 
schedule column templates.  

Maintenance/Utilities  

Purge Appointments  Mark Access to allow the operator to purge outdated schedules 
and print reports on them.  

Change Provider Schedules  Mark Access to allow the operator to access the Change 
Providers Schedules screen.  

Purge Hospital Rounds  Mark Access to allow the operator to purge discharged patients 
from Hospital Rounds and print Admission and Discharge 
Summary and Hospital Admission and Discharge Statistics.  

Batch Wait List Scheduling  Mark Access to allow the operator to access the Batch Wait List 
Scheduling screen to schedule all Wait List appointments at one 
time.  

Appointment Audit Purge Mark Access to allow the operator to use the Purge Appointment 
Audit Trail utility.  
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Maintenance/Templates 

Protocols Indicate whether the operator can Add, Edit, View, or Delete 
protocol templates.  

Protocol Elements Indicate whether the operator can Add, Edit, View, or Delete 
protocol element templates.  

Task Item Definitions for the Orders Category  
You can use the Orders category to set access level security for Order Entry. The six types of security 
are:  

• Access: Enables the operator to have access to the task item. Use when New, Edit, View, and 
Delete access is not appropriate.  

• New: Enables the operator to use the New button on a screen and use the New function.  

• Edit: Enables the operator to use the Edit button on a screen and use the Edit function.  

• View: Enables the operator to use the View button on a screen and use the View function (for 
many screens, the View access allows the operator to access the task item's maintenance screen). 
View must be marked if the operator has New, Edit, or Delete access.  

• Delete: Enables the operator to use the Delete button and use the Delete function.  

• Password: Displays the password screen before the operator can access the task item.  

The task items for the Orders category include:  

Task item Description 

Patient Orders  Indicate whether the operator can Add, Edit, View, or Delete 
orders on the Orders tab of the patient chart.  

Provider Orders  Indicate whether the operator can Add, Edit, View, or Delete 
orders on the Provider Orders screen.  

Order Processing  Indicate whether the operator can Add, Edit, View, or Delete 
orders on the Order processing screen.  

Order Authorization  Mark Access to allow the operator to access the order 
authorization screen.  

Order History  Mark Access to allow the operator to access the order history 
screen.  

New Orders  Mark Access to allow the operator to access the new order 
screen.  

Order Date Indicate whether the operator can access the Set Date/Time 
feature (backdate orders or create future orders) when adding 
(Add) or editing (Edit) orders.  

Maintenance 

Order Names  Indicate whether the operator can Add, Edit, View, or Delete 
order names.  

Order Extended Screens  Indicate whether the operator can Add, Edit, View, or Delete 
extended order screens.  

Order Trees  Indicate whether the operator can Add, Edit, View, or Delete 
order trees.  
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Order Types  Indicate whether the operator can Add, Edit, View, or Delete 
order types.  

Order Categories  Indicate whether the operator can Add, Edit, View, or Delete 
order categories.  

Order Forms  Indicate whether the operator can Add, Edit, View, or Delete 
custom order forms.  

Order Labels Indicate whether the operator can Add, Edit, View, or Delete 
custom order labels.  

Order Requisitions Indicate whether the operator can Add, Edit, View, or Delete 
custom order requisitions.  

Utilities 

Change Order Status utility  Mark Access to allow the operator to access the Change Order 
Status utility.  

Send Electronic Orders  Mark Access to allow the operator to access the Send Electronic 
Orders utility.  

Import Extended Dialogs Mark access to allow the operator access to the Import Extended 
Dialogs utility. 

Archive Orders Mark access to allow the operator access to the Archive Orders 
utility.  

Task Item Definitions for the Reports Category  
You can use the Reports category to set access level security for report tasks. The six types of security 
are:  

• Access: Enables the operator to have access to the task item. Use when New, Edit, View, and 
Delete access is not appropriate.  

• New: Enables the operator to use the New button in a screen and use the New function.  

• Edit: Enables the operator to use the Edit button in a screen and use the Edit function.  

• View: Enables the operator to use the View button in a screen and use the View function. View 
must be marked if the operator has New, Edit, or Delete access.  

• Delete: Enables the operator to use the Delete button and use the Delete function.  

• Password: Displays the password screen before the operator can access the task item.  

General Reports  

The task items for the General Reports category include:  

Task item Description 

Logon Access Report Select Access to allow the operator to access the Logon Audit 
report, which tracks logon attempts to Lytec MD. You can view 
this report by selecting Reports > Logon Audit and filling in the 
selection criteria. 

If Scheduler (AS) or Records (PR):  

Missing Progress Notes  Select Access to allow the operator to access the Missing 
Progress Notes report in Patient Records/Appointment 
Scheduler.  
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AS/PR Referrals Select Access to allow the operator to access the AS/PR 
Referrals Report.  

Patient Inquiry  Select Access to allow the operator to access the Patient Inquiry 
report in Patient Records/Appointment Scheduler.  

Data Export  Select Access to allow the operator to access the Data Export - 
Patient Selection screen in Patient Records/Appointment 
Scheduler.  

PDA Export Select Access to allow the operator to access the PDA Export 
report in Patient Records/Appointment Scheduler.  

If Billing (MB): - The following settings do not apply to Lytec MD 

Accounts/Guarantors   

Query   

If AS, PR, or MB:  

Patients  Select Access to allow the operator to access the patient 
registration report in Patient Records/Appointment Scheduler.  

Records Reports  

Task items for the Records Reports category include:  

Task item Description 

Print Chart Summary  Select Access to allow the operator to access the Print Patient 
Data screen to print the chart summary.  

Print Partial Chart  Select Access to allow the operator to access the Print Patient 
Data screen to print the partial chart.  

Print Complete Chart  Select Access to allow the operator to access the Print Patient 
Data screen to print the complete chart.  

Import Medical Summary Select Access to allow the operator to access the Import 
Medical Records Summary screen.  

Query for Medical Summary from 
Document Registry 

Select Access to allow the operator to search for patient 
documents on the Import from Document Repository screen.  

View Medical Summary from 
Document Registry 

Select Access to allow the operator to preview documents 
listed in the Documents Found area of the Import from 
Document Repository screen before importing them in a 
patient's chart.  

Import Medical Summary from 
Document Repository 

Select Access to allow the operator to access the Import from 
Document Repository screen.  

Export Medical Summary to 
Document Repository 

Select Access to allow the operator to access the Export to 
Document Repository screen. 

Export Medical Summary Select Access to allow the operator to access the Export 
Medical Summary screen.  

Print Notes Select Access to allow the operator to access the Print Note 
reports.  

Unsigned Notes  Select Access to allow the operator to access the Unsigned 
Notes report.  
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Unsaved Notes  Select Access to allow the operator to print unsaved notes.  

Formulary  Select Access to allow the operator to access the Medication 
Formulary Report screen.  

Access Log Report Select Access to allow the operator to access the Access Log 
report in Patient Records/Appointment Scheduler.  

Immunization Report Select Access to allow the operator to access the 
Immunizations Report.  

Prescription Log Report Select Access to allow the operator to access the Prescription 
Log Report.  

Scheduler Reports  

Task items for the Scheduler Reports category include:  

Task item Description 

Daily Schedule  Select Access to allow the operator to access the Daily 
Schedule Printed Report screen.  

Weekly Schedule Select Access to allow the operator to access the Weekly 
Schedule report in Patient Records/Appointment Scheduler.  

Appointments by Patients  Select Access to allow the operator to access the Appointments 
by Patients Printed Report screen.  

Hospital Rounds  Select Access to allow the operator to access the Hospital 
Rounds Printed Report screen.  

Charts to Pull  Select Access to allow the operator to access the Charts to Pull 
Printed Report screen.  

X-Ray Requests Select Access to allow the operator to access the X-ray 
Requests screen.  

Encounter Forms  Select Access to allow the operator to access the Encounter 
Forms Printed Report screen.  

Missed Appointments  Select Access to allow the operator to access the Missed 
Appointments Printed Report screen.  

Reminders  Select Access to allow the operator to access the Appointment 
Reminders screen.  

Provider Notification  Select Access to allow the operator to access the Provider 
Notification Report screen.  

Schedule Summary  Select Access to allow the operator to access the Schedule 
Summary Printed Reports screen.  

Schedule Forecast  Select Access to allow the operator to access the Schedule 
Forecast Printed Report screen.  

Appointment Available  Select Access to allow the operator to access the Appointment 
Availability Printed Report screen.  

Check-in  Select Access to allow the operator to access the Check In 
Report screen.  

Wait List Reports  Select Access to allow the operator to access the Wait List 
Report screen.  
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Appointment Cancellation Select Access to allow the operator to access the Appointment 
Cancellation Report screen.  

Appointment Groups Select Access to allow the operator to access the Appointment 
Group Report screen. 

Orders Reports  

Task items for the Order Reports category include:  

Task item Description 

Standard Orders  Select Access to allow the operator to access the Standard 
Orders report screen.  

Custom Orders  Select Access to allow the operator to access the Custom 
Orders report screen.  

Order Overdue  Select Access to allow the operator to access the Overdue 
Orders report screen.  

Orders Analysis  Select Access to allow the operator to access the Order 
Analysis report screen.  

Printers 
You can take advantage of Lytec MD’s flexibility by assigning default printers for different tasks. This 
means that you can maintain multiple printers with different types and sizes of paper to match specific 
tasks. For example, you can have a default printer with 8½ x 11” paper for reports, and a default printer 
for mailing labels. You can set printers to ports or print queues. 

Lytec MD uses the concept of printer groups. A printer group is simply a set of default printers that are 
appropriate to different users, their location, and their tasks. These tasks mirror the user’s job functions. 
Front office staff will print appointment reminders and chart requests. Back office staff will print 
instructions and prescriptions. Each of these tasks may require different paper, and may print on 
different printers. The user's location may also affect which printers are appropriate. 

If you want users to see the familiar Windows Print screen when they print from Lytec MD, you need to 
indicate this when you set up the printer group. This will let the users override the default printer. 
Otherwise, Lytec MD will simply print without offering the opportunity to change the printer. You can 
elect not to display the Windows Print screen for speed – no additional screens to work through – and 
to ensure that form-specific print jobs are sent to the printer loaded with the correct forms. 

Setting up printer groups 
A printer group is a set of default printers that are appropriate to different users, their location, and 
their tasks. Lytec MD uses the following order to determine which printer should be used. 

1. Environmental variable: You can assign a printer group to a particular workstation and user of 
that workstation by adding an environmental variable statement to the user’s login. Use the 
variable PP_PRINT. For example, the following statement will assign the FAMMED printer group 
to the user: 
 
Set PP_PRINT=FAMMED 
 
If you do not use an environmental variable, or if you set it equal to STANDARD, the user will 
have the Standard group of default printers.  
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Note: You will also have to update each user’s Windows Print setup so they can access the 
appropriate printers through Windows. You can speed that process up by extracting the 
appropriate section for each group from your ppart.ini file. 

2. Operator's printer configuration: Lytec MD uses the printer group assigned to the Lytec MD 
operator on the Workstation Configuration screen. This value is stored in the registry. 

3. Workstation's printer configuration: Lytec MD uses the printer group assigned to the Lytec 
MD workstation on the Workstation Configuration screen. This value is stored in the registry. 

4. Local ppart.ini printer group: If an environmental variable and registry settings don't exist, 
Lytec MD uses the printer group defined in the local ppart.ini. In the ppart.ini file on a 
workstation, you can use the [PrintGroup] setting to define the workstation's printer group.  
 
[PrintGroup] 
Print_Group= 
 
The first line always displays [PrintGroup]. After Print_Group, type the name of the printer 
group that should be used for the workstation. The name in the ppart.ini file must exactly match 
the name on the Printer Maintenance screen. 

5. Standard printer group: The default group of printers (the Standard printer group) is used 
when no specific printer group is specified. This setting is defined in the server's ppart.ini file: 
 
[PrintGroup] 
Print_Group=STANDARD 

Printing to a file  
You can print to a file from Lytec MD, but the Windows Generic / Text Only print driver must be 
installed on the workstation. You must also mark the Display Windows “Print” screen check box on the 
Printer Maintenance screen when you set up the printer group. 

Then, when you print to a file, you must select the generic text printer and mark the Print to File check 
box on the Windows Print screen. 

To view or edit a report that has been printed to file, you must use write.exe or Wordpad (but not 
Notepad) that reads and used carriage return and line feed characters. 

Printing to a file using the Generic / Text Only printer will produce an ASCII text file that contains tab 
characters and other formatting characters. If this is a problem, Lytec MD includes a utility called 
MBWFXTX that will convert the file to ASCII without tabs and remove the formatting markers. The utility 
is in the database directory (the default is /ppart). Open a command line (DOS) prompt in the database 
directory, and type MBWFXTX inputfile > outputfile, where inputfile is the name of the original file and 
outputfile is the name of the newly converted file. 

Printing to the screen 
Several reports provide an option (print preview) to print to the screen. To print to the screen, select 
File > Print to Screen before printing the report. When selected, this option will be indicated with a 
check mark. Then, when you print a report, the results will display on screen. You can turn this feature 
off by selecting File > Print to Screen. The check mark will disappear. 

Currently, the reports you can print to screen include the unsigned note, unsaved note, access log, 
encounter form, standard order, custom order, overdue order, and order analysis reports. 
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Fonts and printer drivers 
Reports may print differently than they appear on screen, because of differences with printer drivers 
and fonts. For example, if you selected to use a particular font (such as Arial) but the printer does not 
have that font installed, another font will be substituted. The substitute font may have a different point 
size or pitch, so printed text may be misaligned or cut off. 

Another important issue is the width of the font (pitch) and the width of the data fields. Pitch is the 
number of characters per horizontal inch (cpi). For monospaced (non-proportional) fonts such as 
Courier, where all characters are of equal widths, you can calculate pitch by dividing 120 by the point 
size. For 12-point Courier, then, the pitch is 10. This means that for each inch, 10 characters will print. A 
data item with a width of 15 characters will need 1.5 inches of space when printed.  Proportional fonts 
have characters of different widths (the font used here is proportional), so they do not have a fixed 
number of characters per inch, and therefore they do not have an absolute pitch. 

A font's point size is its height measured in points (1 point = 1/72 inch). For 10-point Courier font, the 
distance from the top of the highest character to the bottom of the lowest character is 10 points (10/72 
inch). 

You can determine which fonts are supported by a printer driver by: 

1. Setting the printer for which you want information as the default printer (through the Printers 
icon on the Control Panel). 

2. Opening Microsoft Word or an equivalent word processing program. 

3. Viewing the font list. In Microsoft Word, this list is accessed by selecting Format > Font. The 
fonts supported by the printer driver are displayed in the Font box. 

Printer types for Patient Records and Appointment Scheduler 
In Lytec MD, a printer type defines the tasks for which you need a printer. Patient Records and 
Appointment Scheduler ship with several printer types, including Rx, Remote Rx, Instructions, Charts, 
Reports, Fax, Labels, Reminders, Cancellation slip, Chart Request, Orders, X-Ray Request, and Log. 

There are also several general printer types (on the General tab) that are used by all Lytec MD 
programs. General printer types include Encounter, Encounter Label, and Message. 

Printer types display on the Printer Group Maintenance screen. When you are creating a printer group, 
you will add default printers for various printer types. 

Note: Do not change the pre-installed printer types.  

Patient Records printer types 

Patient Records provides the following printer types: Rx, Remote Rx, Instructions, Charts, Reports, Fax, 
Labels, and Orders. Each printer type affects different areas of printing.  

Report Category 

Chart summary Charts 

Partial chart Charts 

Complete chart Charts 

Messages (on the General tab) Reports 

Orders Orders 

Notes 

Unprinted notes by provider Charts 
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Unprinted notes by provider and date Charts 

All notes by provider and date Charts 

Signed notes by provider and date Charts 

Unsigned notes Reports 

Unsaved notes Reports 

Missing progress notes Reports 

Patient registration 

Mailing labels Labels 

Full printout Reports 

Rolodex cards Labels 

Patient inquiry Reports 

Data Loader 

Lab data file Reports 

Text data error file Reports 

Error file Reports 

Maintenance menu 

Diagnosis/problem Reports 

Procedure codes Reports 

Templates - patient instructions Reports 

Extended sig Reports 

Within a patient chart 

All notes and images Reports 

Vital signs Charts 

Health maintenance Charts 

Lab data Charts 

Flow charts, graphing Charts 

Rx 

When leaving the Rx screen Rx/Remote Rx/Fax 

Action, Print Rx/Remote Rx/Fax 

Monograph for Drug Interaction Rx/Remote Rx/Fax 

Other, All Rx Rx/Remote Rx/Fax 

Other, med list Charts 

Appointment scheduler printer types 

Appointment Scheduler provides the following printer types: Instructions, Reports, Fax, Labels, 
Reminders, Cancellation Slips, Chart Requests, X-Ray Requests, and Log. Each printer type affects 
different areas of printing.  

Report Category 

Type of visit  (TOV)/ patient instructions Instructions 
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Daily schedule Reports 

Appointments by patient Reports 

Hospital rounds Reports 

Charts to pull Reports 

X-ray reports Reports 

Encounter forms Reports 

Missed appointments Reports 

Provider notification Reports 

Schedule summary Reports 

Schedule forecast Reports 

Appointments available Reports 

Check-in reports Reports 

Patient registration 

Mailing labels Labels 

Full printout Reports 

Rolodex cards Labels 

Reminder slips Reminders 

Cancellation slips Cancellation slips 

Chart request Chart request 

X-ray request X-ray request 

Appointment log Log 

Adding, editing, and deleting printer groups 

To open the printer screen: 

• Select Maintenance > Setup > Printers. The Printer Group Maintenance Select screen appears.  

To add a printer group: 

• On the Printer Group Maintenance Select screen, click the New button (or double click the 
appropriate cell in the Default Printer column) to add a printer group from scratch. Fill in the 
fields on the Printer Group Maintenance screen, then click the OK button. 

• On the Printer Group Maintenance Select screen, click the Copy button to copy and modify an 
existing printer group. Make the necessary changes on the fields on the Printer Group 
Maintenance screen, then click the OK button. 

To change a printer group: 

1. On the Printer Group Maintenance Select screen, highlight the printer group that you want to 
change. Click the Edit button. Make the appropriate changes, including: 
• Adding a printer by double clicking the appropriate cell in the Default Printer column. 

The Printer Type Properties <New> screen appears. 

• Editing settings for an existing printer, or changing a printer, by highlighting the printer 
and clicking the Edit Printer button. The Printer Type Properties <Edit> screen appears. 
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• Deleting a printer by highlighting the printer and clicking the Delete Printer button. A 
message asks you to confirm the deletion. 

2. When you finish, click the OK button. 

To delete a printer group: 

• On the Printer Group Maintenance Select screen, highlight the printer group that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Printer Maintenance screen 

Field Description 

ID Code Type a short identification code for the new printer group. This 
is the ID you will use when you assign the printer group to 
users.  

Description Type a description of the new printer group. 

Default Printer column To add a default printer for each report type on the General 
and Records/Scheduler tabs, double-click the appropriate cell 
in the Default Printer column.  
For example, to set a default messaging printer (on the General 
tab), double-click the Default Printer cell to the right of the 
Message cell. The Printer Type Properties <New> screen 
appears. 
You can also copy printer settings from one report type to 
another. Printers for both report types must already be 
configured. For example, printers for both the Rx and Remote 
Rx types are set up, but you want to change the Remote Rx 
settings to be the same as the Rx settings. Highlight the Rx 
"Default Printer" column, and click the Copy button. Then click 
the "Default Printer" column for Remote Rx and click the Paste 
button. 

Windows radio button Make sure that the Windows radio button is marked in the 
Select Printers Source section. 

Select button Click the Select button next to the Name field. The Printer 
Selection screen appears. 
Select a printer from the drop-down list.  
Click the OK button to return to the Printer Type Properties 
<New> screen. 

Note: For Windows printers, if you select a printer that is not 
installed or available on the user’s workstation, a message 
appears in the Installed field on the Printer Type Properties 
<New> screen. 

Display Windows “Print” Screen If you want users to see the familiar Windows Print screen when 
they print from Patient Records, select this check box. The 
Windows Print screen gives users the opportunity to change 
printers if necessary. 

Variety Select the type of printer. Your options include laser, inkjet, and 
dot matrix. 
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Font Select the default font for the printer. The report type you 
selected earlier should influence which font you select, based 
on the font settings in the ppart.ini file. 

Font Size Select the appropriate font size. 

Top Offset This setting does not apply to Lytec MD. 

Orientation This setting does not apply to Lytec MD. 

Left Offset This setting does not apply to Lytec MD. 

Copies This setting does not apply to Lytec MD. 

Workstation 
Once you have set up printer groups, you can assign them to individual workstations and to individual 
Lytec MD operators. 

Configuring workstation printer settings 

To configure workstation and operator printer settings: 

1. Select Maintenance > Set Up > Workstation. The Workstation Configuration screen appears. 

2. To configure workstation settings, select a printer group in the Workstation Print Group section. 

3. To configure operator settings, select the operator and the printer group in the 
Operator/Workstation Print Group. 

4. Click the OK button. 
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External Systems 
The External Systems feature plays an integral part in integrating Patient Records with external systems, 
such as Horizon Patient Folder and RelayHealth. Before you can use external systems such as these, 
your system administrator must add specific detailed information about the system using the external 
system maintenance screens.  

Once an external system has been added, you can link your Operators to the system by entering their 
user name and password for the external system in Patient Records. This allows operators to access the 
external system from Patient Records. For example, if your organization uses Patient Records and 
Horizon Patient Folder, you can have an operator that has access in both systems open Horizon Patient 
Folder (HPF) from Patient Records. To do so, you must add them as an external user for HPF, and then 
add their HPF user name and password from the New External System User screen.  

Adding, Editing, and Deleting External Systems 
In order to integrate Lytec MD with an external system such as RelayHealth and Horizon Patient Folder, 
each system must be added as an external system in Lytec MD. You will be required to enter 
information specific to the external system, such as the system password, identifier, and URL. It is 
recommended that you verify the required information before adding an external system. If any of the 
required information is entered incorrectly you will receive an error when trying to access the system in 
Patient Records.  

To add an external system: 

1. Make sure your system administrator enables the Access Level settings (i.e., Add, Edit, Delete) 
for "External Systems" under the Maintenance/Setup section on the General tab. 

2. Select Maintenance > Setup > External Systems. The External Systems screen appears. 

3. Click the New button. The New External System screen appears.  

4. Select the type of external system you are adding to Lytec MD from the Type drop-down list. 
Your system administrator can use the "Types" setting under the "ExternalSystems" section in 
the ppart.ini file to configure the options displayed from the drop-down list.   

5. Type a description of the external system in the provided field.  

6. Type the password for the external system in the provided field. This field is not required if the 
external system is configured to require a secure token instead of a password. 

7. Type the external system's host system identifier (AppID) in the provided field.  

8. Type the URL you use to access the external system web site in the provided field. You must 
include the web protocol in the web address (i.e., https://).  

9. When you are finished, click the Create button.  

To edit an external system:  

1. On the External Systems screen, highlight the external system that you want to change, and 
then click the Edit button. The Edit External System screen appears.  

2. Make the appropriate changes.  

3. When you finish, click the Save button. 
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To delete an external system: 

1. On the External Systems screen, select the external system that you want to delete, and then 
click the Delete button. A confirmation message appears. 

2. Click the Yes button. The external system and corresponding users are deleted. 

Adding, Editing, and Deleting External System Users 
You can link your Lytec MD operators' to external systems by entering their user name and password 
for the external system in Patient Records. This allows operators to access external system information 
from Patient Records. For example, if your organization uses Patient Records and Horizon Patient 
Folder, you can have an operator that has access in both systems open HPF from Patient Records. To 
do so, you must add them as an external user for HPF, and then add their HPF user name and password 
from the New External System User screen.   

You can also modify the patient's user name and password using the Edit External System User screen 
if it changes in the external system.  

To add an external system user: 

1. On the External Systems screen, highlight the external system that you want to add a user for, 
and then click the Edit System Users button. The External System Users screen appears.  

2. Click the Add button. The New External System User screen appears.  

3. Type the operator ID in the provided field, or click the down arrow button to select an operator 
from the Operator Select screen.  

4. Type the operator's user name for the external system in the provided field. 

5. Type the operator's password for the external system in the provided field. 

6. Select this check box if the user is active.  

7. When you are finished, click the Create button.  

To edit an external system user:  

1. On the External Systems screen, highlight the external system that you want to modify a user 
for, and then click the Edit System Users button. The External System Users screen appears.  

2. Highlight the user in the list that you want to edit, and click the Edit button. The Edit External 
System User screen appears.  

3. Make the appropriate changes.  

4. When you finish, click the Save button. 

To delete an external system user:  

1. On the External Systems screen, highlight the external system that you want to delete a user 
for, and then click the Edit System Users button. The External System Users screen appears.  

2. Highlight the user in the list that you want to delete, and click the Delete button. A confirmation 
message appears. 

3. Click the Yes button. The external system user is deleted. 
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External Systems screen 
The External Systems screen lists all external systems that have been set up in Patient Records. You can 
use this screen to add new external systems, or edit, or delete existing external systems. 

To open the External Systems screen: 

• Select Maintenance > Setup > External Systems. The External Systems screen appears.  

Fields on the External Systems screen  

Field Description 

External Systems List Lists the external systems that have already been set up in 
Patient Records. 

New button Click to add a new external system. The New External System 
screen appears.  
See the Adding, Editing, and Deleting External Systems section 
for more information. 

Edit button Click to change the currently selected external system. The Edit 
External Systems screen appears.  
See the Adding, Editing, and Deleting External Systems section 
for more information. 

Delete button Click to delete the currently selected external system. A 
confirmation message appears. Click Yes to delete the external 
system and any corresponding users. 
See the Adding, Editing, and Deleting External Systems section 
for more information. 

Edit System Users button Click to add an external system user name, password (if 
required), and status for your Lytec MD Operators. This will 
allow them to have access to the external system in Patient 
Records using the single sign-on feature. The External System 
Users screen appears.  
See the Adding, Editing, and Deleting External System Users 
section for more information. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 344 

 

New and Edit External System screen 
The External System screen allows you add or modify external system information.  

To open the New External System screen or the Edit External System screen: 

1. Select Maintenance > Setup > External Systems. The External Systems screen appears. 

2. Click New to add a new external system, or click Edit to edit the currently selected external 
system. The New External System screen or Edit External System screen appears.   

Fields on the External System screen 

Field Description 

Type Select the type of external system you are adding to Lytec MD 
from the Type drop-down list.  
Your system administrator can use the "Types" setting under 
the "ExternalSystems" section in the PPart.ini file to configure 
the options displayed from the drop-down list.   

Description Type a description of the external system.  

Password Type the password for the external system. This field is not 
required if the external system does not require a password. 

Identifier  Type the external system's host system identifier (for Horizon 
Patient Folder this is the “AppID”). 

URL Type the URL you use to access the external system web site. 
You must include the web protocol in the web address (i.e., 
https://). 

Note: Lytec MD recommends that you verify the URL with the 
external system to ensure that the correct URL is entered here. 

Save button Click to save your data and to close the screen.  

 

External System Users screen 
The External System Users screen lists all users that have been set up in Patient Records for the 
selected external system. You can use this screen to add new users, or edit, or delete existing external 
system users. 

To open the External System Users screen:  

1. Select Maintenance > Setup > External Systems. The External Systems screen appears.  

2. Select the external system in the list that you want to create users for, and click the Edit System 
Users button. The External System Users screen appears.  
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Fields on External System Users screen 

Field Description 

External System Users List Lists the users that have been set up in Patient Records for the 
selected external system. 

New button Click to add a new user for the external system. The New 
External System User screen appears.  
See the Adding, Editing, and Deleting External System Users 
section for more information. 

Edit button Click to modify the external system user name, password, 
and/or status for the selected user. The Edit External System 
User screen appears.  
See the Adding, Editing, and Deleting External System Users 
section for more information. 

Delete button Click to delete a user for the currently selected external system. 
A confirmation message appears. Click Yes to delete the 
external system user. 
See the Adding, Editing, and Deleting External System Users 
section for more information. 

External System User screen 
The External System User screen allows you to add or modify a Lytec MD Operators' user name and 
password (if required) for the external system, so they can use the single sign-on feature when 
accessing the external system in Patient Records.  

To open the External System User screen:  

1. Select Maintenance > Setup > External Systems. The External Systems screen appears. 

2. Highlight the external system that you want to add or change users for, and then click the Edit 
System Users button. The External System Users screen appears.  

3. Click the Add button to add an external system, or click Edit button to edit the currently 
selected external system. The New External System User or Edit External System User screen 
appears.  

Fields on the External System User screen 

Field Description 

Operator Type the operator ID, or click the down arrow button to select 
an operator from the Operator Select screen.  

Username Type the external system user name for the Lytec MD Operator. 

Password Type the external system password for the Lytec MD Operator. 

Note: This field is only required if the external system requires 
passwords for its users.  

Active Select this check box if the user is active.  
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Utilities 

Archive Patient Data 
When you “archive” patient information, you simply transfer all the records for that patient from the files 
on your active system to a disk or other medium that is not normally accessed by the system. Any 
information you archive is deleted from the active system. You can select the data you want to archive 
by any of the following criteria: 

• Records for individual patients, selected by name or identification number. 

• Records for patients registered during a given period, seen by a particular provider, or not seen 
since a given date. 

• Records for the selected patients only up to a given date. 

• Records indicated by a Patient Inquiry file. 

You will use the Archive Patient Data – Selection screen to select the patient information that you want 
to archive. When you archive data, the data is transferred to the archive media (for example, tape or 
disk) that you specify. You can use any fully Windows-compatible storage medium that acts like a disk 
drive (for example, Zip drives, removable hard disks, some tape drives, CD-RW drives, and writeable 
DVD drives). We do not recommend using floppy disk drives for archiving. 

The first time you use archive media, a message may appear asking if you want to initialize the archive 
media. Answer Y for yes. Lytec MD automatically copies a set of blank archive files to the archive media. 
The archive data files are created during installation and have an "04" suffix. If they are not present, a 
message indicates that the archive files were not found. Answer Y for yes. If you see this message, 
contact your dealer or Lytec MD for further instructions. 

Archive tips 
Archiving patient information saves you valuable disk space. We recommend the following: 

• If you use floppy disks as your archive media: It is a good idea to archive small groups of patients 
at a time because you may run out of space on the floppy disk. You can use different floppies for 
different letters of the alphabet. For example, floppy 1 might be used to store information for 
patients whose names begin with letters A-D, etc. 

• If you archive data for multiple patients based on a set of criteria: Carefully label the archive 
media with the selection criteria you selected. Use fresh archive media each time you archive. 

• If you archive multiple patients and you run out of space on the archive media: Note the name of 
the patient where the archiving stopped and label the archiving media. Because archiving is 
done alphabetically, you can restart archiving with fresh archive media and continue from where 
you left off. 

Archiving patient data 
To archive patient information:  

1. Select Maintenance > Utilities > Archive Patient Data. The Archive Patient Data – Selection 
screen appears.  

Note: Depending on your access level, you may need to enter your password to access this utility.  

2. Select whether you want to archive data for a Single Patient, Selected Patients, All Patients, or 
Patient List File.  
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3. In the Patient Data from field, type the dates for which you want to archive information. You can 
also leave the date fields blank to select all dates.  

Note: If you do not enter dates to indicate how much information you want to archive, all information 
for the selected patients is archived, and the patients are deleted from the active system.  
 
If you do enter dates, all information for the selected dates is archived except for health maintenance 
data. 

4. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. The Archive Drive and Pathname screen 
appears.  

• Selected Patients: The Archive Patient Data – Selection Criteria screen appears. When you 
finish entering your criteria, click the OK button. The Archive Drive and Pathname screen 
appears.  

• All Patients: The Archive Drive and Pathname screen appears.  

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with a .tdl extension, that you want to archive. Then click the OK button. The 
Archive Drive and Pathname screen appears.  

5. Enter the drive and pathname to which you want to archive the information.  

6. Click the OK button.  
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Archive orders 
When you “archive” completed and cancelled orders, you transfer all the records for those orders from 
the files on your active system to a disk or other medium that is not normally accessed by the system. 
Any information you archive is deleted from the active system. You can select the data you want to 
archive by any of the following criteria: 

• Records for a specific provider, or for all providers. 

• Records for orders added during a given date range, or for all dates. 

The first time you use archive media, a message may appear asking if you want to initialize the archive 
media. Answer Y for yes. Lytec MD automatically copies a set of blank archive files to the archive media. 
The archive data files are created during installation and have an "02" suffix. If they are not present, a 
message indicates that the archive files were not found. Answer Y for yes. If you see this message, 
contact your dealer or Lytec MD for further instructions. 

Archive tips 
Archiving completed and cancelled orders saves you valuable disk space. We recommend the 
following: 

• If you use floppy disks as your archive media: It is a good idea to archive small groups of patients 
at a time because you may run out of space on the floppy disk. You can use different floppies for 
different letters of the alphabet. For example, floppy 1 might be used to store information for 
patients whose names begin with letters A-D, etc. 

• If you archive data for multiple patients based on a set of criteria: Carefully label the archive 
media with the selection criteria you selected. Use fresh archive media each time you archive. 

• If you archive multiple patients and you run out of space on the archive media: Note the name of 
the patient where the archiving stopped and label the archiving media. Because archiving is 
done alphabetically, you can restart archiving with fresh archive media and continue from where 
you left off. 

Archiving orders 
To archive completed and cancelled orders:  

1. Back up your database.  

2. Select Maintenance > Utilities > Archive Orders. A message asks you to confirm that you have 
backed up your database.  

3. Click the OK button if you have backed up your database (if you click No, the utility will exit). 
The Archive Completed/Cancelled Orders screen appears.  

4. In the Provider field, select a provider whose orders you want to archive. You can also leave this 
field blank to archive completed and cancelled orders for all providers. 

5. Select a date range for the completed and cancelled orders. 

6. Click the OK button. 
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Blood glucose meter 

BG Comments 
You can add practice-specific comments to the Comment pull-down list in the Blood Glucose Data 
screen to assist users in selecting meaningful comments to add to their records. Comments can also be 
configured in the ppart.ini file in [BGComments]. See the ppart.ini topic. 

Adding, editing, and deleting blood glucose meter comments 

To open the blood glucose meter comments screen: 

• Select Maintenance > Utilities > Blood Glucose Meter > BG Comments. The BG Comments 
screen appears. 

To add a blood glucose meter comment: 

• On the BG Comments screen, click the New button. Type the comment, then click the OK 
button. Comments cannot exceed 30 characters in length.  

To change a blood glucose meter comment: 

• On the BG Comments screen, highlight the comment that you want to change. Click the Edit 
button. Make the appropriate change. When you finish, click the OK button. 

To delete a blood glucose meter comment: 

• On the BG Comments screen, highlight the comment that you want to delete. Click the Delete 
button.  

BG Time Ranges 
Before you can use the blood glucose meter, you must set up time ranges that will be used to display, 
analyze, and graph glucose values entered into the blood glucose meter. For each time range, you can 
define minimum and maximum values that represent the highest level in a normal blood glucose 
range. Default time ranges include After Lunch, Bed Time, Breakfast, Dinner, and Lunch. You can add 
time ranges that meet the specific requirements of your practice. 

Adding, editing, and deleting blood glucose time ranges 

To open the blood glucose time ranges screen: 

• Select Maintenance > Utilities > Blood Glucose Meter > BG Time Ranges. The BG Time Ranges 
screen appears. 

To add a blood glucose time range: 

• On the BG Time Ranges screen, click the New button. Fill in the fields on this screen, then click 
the OK button. 
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To change a blood glucose time range: 

• On the BG Time Ranges screen, highlight the time range that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a blood glucose time range: 

• On the BG Time Ranges screen, highlight the time range that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the blood glucose time ranges screen 

Field Description 

Name Type a name for the time range. Names cannot exceed 20 
characters in length.  

Start Time Type a start time (using the HH:MM format) for the time range. 
The time can be in 24-hour or AM/PM format, depending on 
the display preference indicated on the BG Setup screen.  
 
Time ranges must span an entire day, with the first time range 
starting at 12:00 AM and the last time range ending at 11:59 
PM. Time ranges must be at least one minute in length. 

Min Value Type a value representing the lowest level in a normal blood 
glucose range. 

Max Value Type a value representing the highest level in a normal blood 
glucose range.  

BG Setup 
You can specify your display preferences for the blood glucose meter, such as selecting a time format, 
the import units, the order in which dates are displayed, and the default COM port by setting options in 
the BG Setup window.  

Setting blood glucose meter preferences 

To set up blood glucose meter preferences: 

• Select Maintenance > Utilities > Blood Glucose Meter > BG Setup. The BG Setup screen appears. 
Fill in the fields on this screen, then click the OK button. 

Fields on the BG Setup screen 

Field Description 

Time Format Select whether you want to display time in an AM/PM or a 24-
hour format.  

Import Units Select whether you want to use MG/DL or MMOL/L.  

Display Order Select whether you want to display dates in chronological or 
reverse chronological order.  

Default Com Port Select the default COM port for importing data from a glucose 
meter.  
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Change Order Status Utility  
You can use the Change Order Status utility to change the status of multiple orders. You can select the 
appropriate orders to change by selecting from criteria that includes:  

• Patient ID/name  

• Provider ID/name  

• Practice 

• Order type  

• Order date range  

• Processing operator  

• Whether the orders are printed or electronic  

Then you select the current status of the orders, and the new status you want to use.  

Your access level determines whether you can use this utility.  

Using the Change Order Status utility 
To run the Change Order Status utility:  

1. Back up your database.  

2. Select Maintenance > Utilities > Change Order Status. A message asks you to confirm that you 
have backed up your database.  

3. Click the OK button if you have backed up your database (if you click No, the utility will exit). 
The Change Order Status Utility screen appears.  

4. Enter the criteria you want to use to filter the orders. Your options include:  

Option Description 

Patient ID  To change the order status for all patients, leave this field 
blank.  
To change the order status for a specific patient, type the 
patient’s ID. When you tab out of the field, the patient’s name 
will appear in the Patient Name field. You can also type the 
patient’s name in the Patient Name field instead of using the 
patient’s ID.  

Provider ID  To change the order status for all providers, leave this field 
blank.  
To change the order status for a specific provider, select the 
appropriate provider from the drop-down list.  
When you tab out of the field, the provider’s name will appear 
in the Provider Name field.  

Practice  To change the order status for all practices, leave this field 
blank.  
To change the order status for a specific practice, select the 
appropriate practice from the drop-down list.  
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Facility ID  This field is available only when the Electronic Orders radio 
button is marked.  
To change the order status for all facilities, leave this field 
blank.  
To change the order status for a specific facility, type the 
facility ID.  

Order Type  To change the order status for all order types, leave this field 
blank.  
To change the order status for a specific order type, select the 
appropriate type from the drop-down list.  

Status  To change the order status for all statuses, leave this field 
blank.  
To change the order status for a specific status, select the 
appropriate status from the drop-down list. The available 
statuses are Pending, Sent, Suspend, Approved, and 
Completed.  

Order Date Range  In the date fields, select the range of dates for which you want 
to change the order status. When you select a starting and 
ending date, all orders created between those dates that 
meet the other criteria you set will be changed.  

Processing Operator  To change the order status for all processing operators, leave 
this field blank.  
To change the order status for a specific processing operator, 
type the processing operator’s ID.  

Printed Orders/ Electronic 
Orders  

To change the order status for orders that are printed, mark 
the Printed Orders radio button.  
To change the order status for orders that are sent 
electronically, mark the Electronic Orders radio button.  

Change Order Status To  Select the status to which all orders that meet the criteria you 
set will be changed.  

5. When you finish, click the OK button. A message asks you to confirm that you want to change 
all selected orders to the new status.  

6. Click the OK button. When the utility finishes, a message will display how many order statuses 
were changed.  
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Export Charts Utility 
With Patient Records, you can import and export patient charts. 

When health maintenance information is exported, only the patient's health maintenance data is 
exported, not the related health maintenance templates. 

Using the Export Charts utility 
To export a chart:  

1. Select Maintenance > Utilities > Export Chart. The Export Chart – Selection screen appears.  

Note: Depending on your access level, you may need to enter your password to access this utility.  

2. Select whether you want to export charts for a Single Patient, Selected Patients, All Patients, or 
Patient List File.  

3. In the Patient Data from field, type the dates for which you want to export charts. You can also 
leave the date fields blank to select all dates.  

4. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. The Export Chart Drive and Pathname 
screen appears.  

• Selected Patients: The Export Chart – Selection Criteria screen appears. Enter your 
criteria, and then click the OK button. You can fill in whatever information is appropriate, 
including scheduled provider, scheduled dates, registration dates, usual provider, patient 
status, and patient note (and the note’s function, such as Scheduler or Patient). When you 
finish entering your criteria, click the OK button. The Export Chart Drive and Pathname 
screen appears.  

• All Patients: The Export Chart Drive and Pathname screen appears.  

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to export. Then click the OK button. The 
Export Chart Drive and Pathname screen appears.  

5. Enter the drive and pathname to which you want to export the charts.  

6. Click the OK button.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 354 

 

Health Maintenance Utilities 

Age Health Maintenance Template Utility  
You can use the Age Health Maintenance Template utility to automatically advance patients to the next 
age/sex health maintenance template, if appropriate. We recommend running this utility once per 
month.  

The utility checks whether the correct age/sex template is already applied to the patient. If not, then it 
removes the incorrect template and applies the correct one. Data associated with the incorrect 
template is made historical only if the procedure does not exist in another template applied to the 
patient (for example, if aspirin therapy is part of the incorrect template and not the new template, but it 
also is part of a protocol template assigned to the patient, the aspirin therapy data will not be made 
historical). The utility also looks at the patient's historical data, and makes current any data that is part of 
the new template but not the incorrect template. 

For the utility to work, the patient must have a sex and age entered in the system, and there must be an 
HM template that matches the sex and age.  

To use the Age Health Maintenance Templates utility:  

• Select Maintenance > Utilities > Health Maintenance Utilities > Age Health Maintenance 
Templates.  
 
If a patient’s health maintenance template has been customized, then the template remains 
unchanged. A list of these patients is stored in a file called PRHMA.CHG. You can load this file 
into Windows Notepad or another editor to view and print it. You will need to fix these templates 
one at a time.  

Note: You should use the Age Health Maintenance Templates utility monthly to ensure that all patients 
who have changed age groups and whose templates are not individually customized, will be assigned 
to the correct templates for their new age group.  

The Age Health Maintenance Templates utility can also be run as a freestanding utility. You can use 
Windows Scheduler to run this automatically at an interval of your choice. We recommend running this 
utility once per month.  

To start the Age Health Maintenance Templates utility: 

• Click UpdatePatHmAgeTemplates.exe in the database directory (usually p:\ppart). This opens 
the Text Load Scheduler. 

Health Maintenance Conversion Utility  
You can use the Health Maintenance Conversion utility to change a health maintenance procedure 
name. When you change a procedure name, the name is changed in health maintenance templates 
and patient charts. 

To use the Health Maintenance Conversion utility:  

1. Select Maintenance > Utilities > Health Maintenance Utilities > Convert Health Maintenance. 
The Health Maintenance Conversion Utility screen appears.  

2. In the Old HM Procedure Name field, type the name of the health maintenance procedure you 
want to convert. 
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3. In the New HM Procedure Name field, type the name of the new procedure. 

4. When you finish, click the OK button to run the utility.  

Health Maintenance Protocols Utility 
The Health Maintenance protocols for problems and medications can easily be applied when new 
problems are added to a patient or new prescriptions are written. However, you may want to apply 
them to patients who already have the problem or who are on the relevant medication. The Health 
Maintenance Protocols Utility allows you to apply health maintenance protocols to a group of patients 
at once. 

You can use the Health Maintenance Protocols utility to apply health maintenance templates to a list of 
patients or all patients, for either specific problems or medications or for all problems or medications 
with protocols. The utility goes through the patients problem list and medications, when it finds a 
health maintenance template that applies to a major problem or diagnosis or current medication, the 
template is then applied to the patient. 

Using the Health Maintenance Protocols Utility 

To use the Health Maintenance Protocols utility:  

1. Select Maintenance > Utilities > Health Maintenance Utilities > Apply HM Protocols to 
Patients. The Health Maintenance Protocols screen appears.  

2. Select the All Patients radio button, to apply the template to all patients, or the Patients on list 
generated by Patient Inquiry radio button, to apply the template to a list of patients. 
• If you select the Patients on list generated by Patient Inquiry radio button, enter the 

patient inquiry file name in the corresponding field. You may also use the Browse button 
to locate the file. 

3. Select the All major problems or diagnoses option, to apply the template to all problems or 
diagnoses, or the Select health maintenance problems protocols to apply option, to choose 
which problems are applied.  
• If you select the Select health maintenance problems protocols to apply option, a dialog 

screen will be displayed. From this screen, select the Health Maintenance protocols you 
would like to include. Add protocols to apply, by highlighting the protocol in the 
Protocols list, and clicking Add. To remove a protocol from the list, select the item, and 
click Remove.  

4. Select either the All Medications option, to apply the template to all medications, or the Select 
health maintenance medication protocols to apply option, to choose which medications are 
applied.  
• If you select the Select health maintenance medication protocols to apply option, a dialog 

screen will be displayed. From this screen, select the Medication protocols you would like 
to include. Add protocols to apply, by highlighting the protocol in the Protocols list, and 
clicking Add. To remove a protocol from the list, select the item, and click Remove.  

5. When you finish, click the OK button to run the utility.  

Options on the Health Maintenance Protocols screen 

Options Description 

Select the All Patients Select this option to apply templates to all patients. 
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Patients on list generated by 
Patient Inquiry 

Select this option to apply templates to a list generated by 
Patient Inquiry.  

Patient inquiry file name Enter the file name in this field. You may also use the Browse 
button to locate the file. 

All major problems or diagnoses Select this option to apply templates to all major problems or 
diagnoses. 

Select health maintenance 
problems protocols to apply 

Select this option to choose which problem protocols to apply. 
When selected, a dialog screen is displayed. From this screen 
select the problem protocols you would like to apply. 

All Medications Select this option to apply templates to all medications. 

Select health maintenance 
medication protocols to apply  

Select this option to choose which medication protocols to 
apply. When selected, a dialog screen is displayed. From this 
screen select the medication protocols you would like to apply. 
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Import Charts Utility 
With Patient Records, you can import and export patient charts. 

You can set up a cross-reference table for each practice from which you will be importing charts. Other 
practices may have named their chart categories or lab names differently, so this cross-reference table 
helps you translate them into your terminology. 

When health maintenance and lab information is exported, only the patient's data is exported, not the 
related health maintenance templates or lab templates. This means that when you import the data, you 
may need to match imported health maintenance or lab names with the names in your database. 

You can also import clinical element names and user-defined vital sign data for cross-referencing.  

Patient Records also helps resolve the fact that patients may have had a different ID at the exporting 
practice. You will be asked how you want to identify patients when you import the charts.  

When you import a chart, the criteria you select to match the charts with existing patients must 
correspond exactly. If not, the charts are assumed to be for new patients.  

Patient Records generates a report listing the new patients added, existing patients updated, and 
possible duplicate charts added. 

The import feature handles provider IDs using the following criteria: 

• All imported provider IDs are preserved, even if they are not tied to the correct provider. 

• All notes are fully signed, so that they cannot be edited. 

• Provider IDs are removed from prescriptions. 

• Provider IDs are removed from other areas, including patient demographics. 

Note: You can import charts that were exported from a different version of Patient Records.  

Using the Import Charts utility 
To import a chart:  

1. Select Maintenance > Utilities > Import Chart. The Import Chart – Matching Patient 
Identification screen appears.  

Note: Depending on your access level, you may need to enter your password to access this utility.  

2. Indicate how Patient Records should match the imported charts with existing charts. Your 
options are:  
• Assume all patients are new.  

• Use Social Security Number, sex, and birthdate. If the SSN matches, but not the sex 
and/or birthdate, the chart is marked as a possible duplicate ID.  

• Use patient name, sex, birthdate, and address.  

• Use patient name, sex, birthdate, and telephone number.  

• Use patient ID.  

• Use alternate ID. If you mark this option, select which alternate ID should be used.  

3. Click the OK button. The Import Chart Drive and Pathname screen appears.  

4. Enter the drive and pathname of the chart(s) you want to import.  

5. Click the OK button. The Load Import Chart Cross Reference File screen appears.  
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6. Enter the drive and pathname of the text category cross-reference file (you can also click the 
Browse button and locate the file using the Cross Reference Text Categories File screen). Keep 
one file for each practice that you import data from. If there is no file, one will be created by the 
next few steps.  

7. If you also want to import lab data, select the Import Labs check box.  
 
If you also want to import health maintenance data, select the Import Health Maintenance 
check box. 

If you also want to import clinical elements data, select the Import Clinical Elements check box. 

If you also want to import user-defined vital signs, select the Import User-Defined Vital Signs 
check box. 

8. Click the OK button. The Import Chart - Match Text Categories screen appears.  
• Verify that the imported text categories will be sorted to the correct chart category. Make 

changes if necessary by clicking the arrow in the Your Text Categories column and 
selecting a different chart section. Click the OK button.  

• The Save Import Chart Cross Reference File screen appears. Enter the drive and 
pathname to which a list of imported text categories will be written.  

• Click the OK button. During the import process, you may have to further supply the 
external patient ID. This will be the case if you did not select patient ID or alternate ID, you 
selected the all new patients option, or if Patient Records cannot find a matching patient 
for the other options. 

9. If you selected to import lab data, the Import Chart – Match Text Categories screen appears. (If 
you are not importing lab data, go to the next step.) 
• Verify that the imported lab names match the lab names currently in your system. Make 

changes if necessary by clicking the arrow in the Your Lab Name column and selecting a 
different lab item. You can view a lab’s description by highlighting the lab in the table.  
 
Imported names that do not match current lab names are highlighted on this screen. 
Patient Records asks whether you want to convert to the current names.  

• Click the OK button. The Save Import Chart Cross Reference File screen appears. Enter 
the drive and pathname to which a list of imported lab names will be written.  

• Click the OK button. 

10. Click the OK button. If you selected to import health maintenance data, the Import Chart – 
Match Health Maintenance Names screen appears. (If you are not importing health 
maintenance data, go to the next step.) 
• Verify that the imported health maintenance names match the health maintenance names 

currently in your system. Make changes if necessary by clicking the arrow in the Your HM 
Name column and selecting a different health maintenance procedure. You can view an 
item's description by highlighting the health maintenance name in the table.  
 
Imported names that do not match current health maintenance names are highlighted on 
this screen. Patient Records asks whether you want to convert to the current names.  

• Click the OK button. The Save Import Chart Cross Reference File screen appears. Enter 
the drive and pathname to which a list of imported health maintenance names will be 
written.  

• Click the OK button. 

11. Click the OK button. If you selected to import clinical elements data, the Import Chart – Match 
Clinical Elements Names screen appears. (If you are not importing clinical elements data, go to 
the next step.) 
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• Verify that the imported clinical elements names match the clinical elements names 
currently in your system. Make changes if necessary by clicking the arrow in the Your 
Clinical Element Name column and selecting a different clinical element name. You can 
view an item's description by highlighting the clinical element name in the table.  
 
Imported names that do not match current clinical element names are highlighted on this 
screen. Patient Records asks whether you want to convert to the current names.  

• Click the OK button. The Save Import Chart Cross Reference File screen appears. Enter 
the drive and pathname to which a list of imported clinical element names will be written.  

• Click the OK button. 

12. Click the OK button. If you selected to import user-defined vital signs, the Import Chart – 
Match User-Defined Vital Signs Names screen appears. (If you are not importing clinical 
elements data, go to the next step.) 
• Verify that the imported vital signs names match the vital signs names currently in your 

system. Make changes if necessary by clicking the arrow in the Your User-Defined Vital 
Sign Name column and selecting a different vital sign name. You can view an item's 
description by highlighting the vital sign name in the table.  
 
Imported names that do not match current vital sign names are highlighted on this 
screen. Patient Records asks whether you want to convert to the current names.  

• Click the OK button. The Save Import Chart Cross Reference File screen appears. Enter 
the drive and pathname to which a list of imported vital sign names will be written.  

• Click the OK button. 

13. A screen displays the progress of the import process.  
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Import extended dialogs 
You can use the Import Extended Dialogs utility to import extended order dialogs from another Lytec 
MD database. 

Lytec MD stores extended dialog in MROZ99.dat files, while the Import Extended Dialogs utility looks 
for MROZ07.dat files. This means that the extended dialogs must be exported, using a DOS command, 
to create the MROZ07.dat files. You can then import the extended dialogs from Lytec MD or through a 
DOS command. 

Importing and exporting extended dialogs from the 
command line (DOS) prompt 
Currently, the only way to export extended dialogs is through the DOS prompt. You can also import 
extended dialogs through the command line (DOS) prompt. This feature uses the CopyExtDialogs.exe 
file in the Lytec MD database directory. A log file (ImportExportExtDialogs.fl) is created in the 
destination directory when you import or export extended dialogs. 

To import extended dialogs from the command line (DOS) prompt: 

1. Open a command line (DOS) prompt in the Lytec MD database directory (usually p:\ppart). 

2. Type CopyExtDialogs source destination replace name 
 
where: 
 
source is the full path to the files you are importing (can omit if the files are in the same 
directory as CopyExtDialogs.exe) and file name is MROZ07 
 
destination is the full path of the location to which you are importing the files (can omit if the 
files are in the same directory as CopyExtDialogs.exe) and file name is MROZ07 
 
replace is either Y to replace existing extended dialogs with the same names or N is do not 
replace 
 
name (optional) is the name of a specific extended dialog you want to export; when used, this 
extended dialog is the only extended dialog that will be exported 
 
For example: CopyExtDialogs c:\tmp\MROZ07 MROZ99 N means import the MROZ07 files 
from the c:\tmp directory to the MROZ99 files in the Lytec MD directory, but do not replace 
duplicate extended dialogs. 

3. Press Enter. 

To export extended dialogs from the command line (DOS) prompt: 

1. Open a command line (DOS) prompt in the Lytec MD database directory (usually p:\ppart). 

2. Type CopyExtDialogs source destination replace name 
 
where: 
 
source is the full path of the files you are exporting (can omit if the files are in the same 
directory as CopyExtDialogs.exe) and file name is MROZ99 
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destination is the full path of the location to which you are exporting the files (can omit if the 
files are in the same directory as CopyExtDialogs.exe) and file name is MROZ07 
 
replace is either Y to replace existing extended dialogs with the same names or N is do not 
replace 
 
name (optional) is the name of a specific extended dialog you want to export; when used, this 
extended dialog is the only extended dialog that will be exported 
 
For example: CopyExtDialogs MROZ99 c:\tmp\MROZ07 Y means export the MROZ99 files 
from the Lytec MD directory to the c:\tmp directory, and replace duplicate extended dialogs. 

3. Press Enter. 

Importing extended dialogs from Patient Records 
In addition to importing extended dialogs from the command line (DOS) prompt, you can also use 
Patient Records' Import Extended Dialogs utility. 

To import extended dialogs from Patient Records: 

1. Select Maintenance > Utilities > Import Extended Dialogs. The Import Extended Dialogs screen 
appears. 

2. If you want to replace existing extended dialogs with the same name (when the names match, 
the imported extended dialog will replace the original extended dialog), mark the Replace 
Existing Dialogs check box. 

3. In the Source Location field, type the full path and file name, including extension, to the files 
you want to import. For example, if the files are in the Lytec MD database on the P:\ drive, you 
would type p:\ppart\mroz07.dat 

4. Indicate whether you want to: 
• Import individual dialogs: With this option, you can select the specific extended dialogs 

from the selected file that you want to import. When you click the OK button, the Import 
Extended Dialogs screen appears. 
 
Move the extended dialogs you want to import from the box on the left to the box on the 
right. Highlight the extended dialog and click the Add button. You can also double-click 
the extended dialog. 

• Import all dialogs: With this option, all extended dialogs in the selected file will be 
imported.  

5. Click the OK button. 
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Import Forms 
You can use the Import Forms utility to import forms from another Lytec MD database. Forms include 
order forms, order labels, requisition forms, encounter forms, or encounter labels. 

Lytec MD stores form information in MRFD99.dat files, while the Import Forms utility looks for 
MRFD07.dat files. This means that the forms must be exported, using a command line utility to create 
the MRFD07.dat files. You can then import the forms from Lytec MD or through a command line utility. 

Importing and exporting forms from the command line 
(DOS) prompt 
Currently, the only way to export forms is through a command line utility.  You can also import forms 
through a command line utility.  This feature uses the CopyForms.exe file in the Lytec MD database 
directory. A log file (ImportExportForms.fl) is created in the destination directory when you import or 
export forms. 

To import forms from the command line (DOS) prompt: 

1. Open a command line (DOS) prompt in the Lytec MD database directory (usually p:\ppart). 

2. Type CopyForms source destination replace name 
 
where: 
 
source is the full path to the files you are importing (can omit if the files are in the same 
directory as CopyForms.exe) and file name is MRFD07 
 
destination is the full path of the location to which you are importing the files (can omit if the 
files are in the same directory as CopyForms.exe) and file name is MRFD07 
 
replace is either Y to replace existing forms with the same names or N is do not replace 
 
name (optional) is the name of a specific form you want to export; when used, this form is the 
only form that will be exported 
 
For example: CopyForms c:\tmp\MRFD07 MRFD99 N means import the MRFD07 files from 
the c:\tmp directory to the MRFD99 files in the Lytec MD directory, but do not replace 
duplicate forms. 

3. Press Enter. 

To export forms from the command line (DOS) prompt: 

1. Open a command line (DOS) prompt in the Lytec MD database directory (usually p:\ppart). 

2. Type CopyForms source destination replace name 
 
where: 
 
source is the full path of the files you are exporting (can omit if the files are in the same 
directory as CopyForms.exe) and file name is MRFD99 
 
destination is the full path of the location to which you are exporting the files (can omit if the 
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files are in the same directory as CopyForms.exe) and file name is MRFD07 
 
replace is either Y to replace existing forms with the same names or N is do not replace 
 
name (optional) is the name of a specific form you want to export; when used, this form is the 
only form that will be exported 
 
For example: CopyForms MRFD99 c:\tmp\MRFD07 Y means export the MRFD99 files from 
the Lytec MD directory to the c:\tmp directory, and replace duplicate forms. 

3. Press Enter. 

Importing forms from Patient Records 
In addition to importing forms from the command line (DOS) prompt, you can also use Patient Records' 
Import Forms utility. 

To import forms from Patient Records: 

1. Select Maintenance > Utilities > Import Forms. The Import Forms Select screen appears. 

2. If you want to replace existing forms with the same name (when the names match, the imported 
form will replace the original form), mark the Replace Existing Forms check box. 

3. In the Source Location field, type the full path and file name, including extension, to the files 
you want to import. For example, if the files are in the Lytec MD database on the P:\ drive, you 
would type p:\ppart\mrfd07.dat 

4. Indicate whether you want to: 
• Import individual forms: With this option, you can select the specific forms from the 

selected file that you want to import. When you click the OK button, the Import Forms 
screen appears. 
 
In the Source field, indicate whether you want to import all forms or a specific type of form 
(order forms, order labels, requisitions, encounter forms, or encounter labels). Then move 
the forms you want to import from the box on the left to the box on the right. Highlight 
the form and click the Add button. You can also double-click the form. 

• Import by type: With this option, all forms in the selected file that are of the type you 
select -- all forms or a specific type of form (order forms, order labels, requisitions, 
encounter forms, or encounter labels) -- will be imported.  

5. Click the OK button. 
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Import Formularies Utility 
Note: This topic applies only if you are using the optional integration with the InfoScan Formulary 
Database.  

Before you can import and update insurance formularies, you must:  

• Install the prescription formulary files to the Lytec MD database directory.  

• Add InfoScan IDs to insurance carriers in Patient Records.  

You can then use the Import Formulary utility to link the data in the formulary files to the insurance 
carriers when you receive the quarterly formulary update.  

Using the Import Formularies utility 
To import and update the insurance formularies:  

1. Select Maintenance > Utilities > Import Formulary. The Import Formularies screen appears.  

2. Click the OK button. The progress bar indicates the status of the import process.  
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Laboratory Data Name Conversion Utility  
At some point, you may decide to change the name of a laboratory test. Or you may find that you have 
a few laboratory tests that are really the same test, but they are labeled with different test names.  

You can change the name of an existing laboratory test, or merge existing laboratory data from one 
test into another, by using the laboratory data name conversion utility.  

If you want to change the name of an existing laboratory test, you must first create a new laboratory test 
using a new test name before you run the utility. Make sure that you enter the same cross-reference 
name that you use in the existing test into the new test name; this way, if you are using a laboratory 
interface, the names will match up with the new test.  

If you want to merge existing laboratory data from one test into another, you just need to run the 
conversion utility.  

Note: Before you can run this utility, you must have the appropriate access level. 
 
You must also make sure that you back up your data and that no one is using the Laboratory Data 
sections.  

Using the Laboratory Data Name Conversion utility 
To use the Laboratory Data Name Conversion utility:  

1. Select Maintenance > Utilities > Laboratory Data Conversion.  

2. A message asks you to verify that your data is backed up and that all other users have exited 
the Lab Data sections.  
• If you have not yet backed up your data and/or if someone else is using the Lab Data 

sections, click the No button to exit.  

• If you can answer yes to both requirements, click the Yes button to continue. The 
Laboratory Data Name Conversion Utility screen displays.  

3. In the Old Lab Data Name field, type the old (existing) laboratory data name.  
 
If you are merging data from one test into another, type the name of the test that currently 
holds the data you want to merge. Patient Records does not validate this name, since you may 
have already deleted it from the Lab Name table.  

4. In the New Lab Data Name, type the new laboratory data name.  
 
If you are merging data from one test into another, enter the name of the test into which the 
data will be merged. Patient Records will validate this name against the Lab Name table.  

5. Click the OK button.  
• If the new laboratory data name that you entered is not a valid test name, the Laboratory 

Test Names screen displays. The test name that closely matches the name entered will be 
highlighted in the list box. Search for the test name by using the up or down scroll arrows, 
or enter the name in the field next to the Search button and click the Search button. When 
you find the correct name, click the OK button.  
 
A message displays, “Please confirm that you are ready to proceed.”  

6. Click the Yes button to confirm.  
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When the conversion is complete, the indicator bar on the Laboratory Data Name Conversion 
Utility screen is highlighted in green.  

7. Click the Cancel button to exit.  

After you run the conversion utility, you may want to view the results of the conversion in the log file 
LABNMCHG.FL, located in the database directory. This log file is generated and updated each time 
you run the conversion utility. See Viewing the results of the lab data name conversion.  

Viewing the results of the Laboratory Data Name Conversion  
You can see the results of the conversion by using Notepad or any text editor to view the log file 
LABNMCHG.FL, located in the database directory. This file is updated each time that you run the 
conversion.  

For each lab test, you will see today’s date, the external Patient ID, the patient name, the old laboratory 
name changed to the new laboratory name, the lab test date, and the lab test time.  

Below is an example of the log file:  

09/20/04, 100-10, RICHARD STEIN, CHOL changed to CHOLESTEROL, 09/10/04, 09:46 AM  

09/20/04, 1004-2, DOROTHY STRATTON, HCT changed to HEMATOCRIT, 09/15/04, 02:08 PM  

09/21/04, 1212, JOE SMITH, NA changed to SODIUM, 09/20/99, 02:42 PM  

After the conversion 
After running the laboratory data name conversion, if you have not already done so, you should delete 
the old laboratory test name from the list in the Laboratory Test Names screen. This way, no one will 
inadvertently enter data for the old test name. If you merged two tests into one and both test names 
are present, delete the test name that you will no longer use.  

In addition, you should edit the laboratory data templates containing the old test name by removing 
the old test name from the template and adding the new test name. Again, if you merged two tests into 
one, delete the test name that you will no longer use.  
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Merge Patients Utility 
Occasionally, a patient may accidentally be registered twice under two slightly different names—and 
patient data will be recorded under both names. Lytec MD offers a utility to merge the two records. 
Make sure that the two records do, in fact, belong to the same patient before you merge the records. 

The Merge Patients utility combines patient information from two, separate records. You can use the 
Merge Patients utility when you have accidentally registered the same patient twice under two different 
ID numbers. The Lytec MD Sign In screen appears when you choose Merge Patients. You will need to 
enter a valid password in order to merge records. 

Using the Merge Patients utility 
To merge two patient charts:  

1. Select Maintenance > Utilities > Merge Patients. The Lytec MD Sign In dialog box appears.  

2. Enter your password.  

3. Click the OK button. The Merge Patient Data screen appears.  

4. In the left column, type the ID of the person whose information you want to merge (the "from" 
patient). This chart will be deleted from your database.  

5. In the right column, type the ID of the person with whom you want to merge information (the 
"to" patient). This chart stays in your database.  

Note: Make sure the patient names match. If the names do not match, a warning message appears. 
You will have the opportunity to stop the merge, if necessary.  

6. If you want to add more patients to merge, repeat steps 4 and 5.  

7. When you finish, click the OK button.  

Note: If you mistakenly merge the records of two different patients, you must edit all the data by hand, 
creating information for two separate patients.  
 
The easiest way to do this is to display the note, copy it to the Windows notepad, and then paste it into 
your word processor. Divide it into two notes, and then reload the data with the Text Data Loader.  
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Purge access log 
If the Lytec MD access log feature has been enabled, you can use the Purge Access Log utility to purge 
the log file. 

Using the Purge Access Log utility 
To use the Purge Access Log utility: 

1. Select Maintenance > Utilities > Purge Access Log. The Purge Access Log File screen appears. 

2. By default, today’s date displays in the “Purge all access logs before” field. You can change to a 
prior date by entering a date in the field, using the MM/DD/YYYY format. 
 
All access logs prior to the date that you use here will be purged. 

3. Click the OK button. A message asks you to confirm the deletion. 

4. Click the OK button to confirm. 
 
When the conversion is complete, the indicator bar on the Purge Access Log File dialog box is 
highlighted in green.  

5. When the purge is finished, click the Cancel button to exit. 
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Purge Messages utility 
You can use the Purge Messages utility to remove messages from the messaging feature's deleted and 
archived folders. This utility is currently the only way to delete messages permanently from Lytec MD. 

Using the Purge Messages utility 
To purge old messages:  

1. Before you purge messages, make sure that you back up your data first. 

2. Select Maintenance > Utilities > Purge Messages. The Purge Messages screen appears. 

Note: You may be prompted to enter your password. This is controlled by your access level. 

3. Indicate whether you want to purge messages from the Deleted and/or Archived folders. 

4. Indicate whether you want to purge messages for all operators or for a specific operator. For a 
specific operator, type the operator's ID or click the Operator button to select from a list of 
operators. For all operators, leave the operator field blank. 

5. Indicate the date through which you want to purge messages (messages with the specified 
date or an earlier date will be purged).  

6. When you finish, click the OK button. A message asks whether you are ready to purge the 
messages. 

7. Click the Yes button. 
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Purge Patients with No Clinical Data Utility 
You can use the Purge Patients with no clinical data feature to purge outdated records of patients who 
have not made an appointment with your practice, and who have no clinical data (including chart data). 
You can also print the information it purges. You must enter a Purge Cutoff Date and indicate whether 
you want a Printed Copy of All Data Purged.  

Using the Purge Patients with No Clinical Data utility 
To purge patients with no clinical data:  

Note: Before you perform this purge, make sure that you back up your data first.  

1. Select Maintenance > Utilities > Purge Patients with no clinical data. The Purge Patients with no 
clinical data screen displays.  

2. For the question Purge all patients who have not been active since (mm/dd/yy)?, enter two 
characters each for the month, day, and year of the cutoff date for the purge. Patient files that 
have shown no activity since that date are purged.  

3. For the question, Print patient data as it is purged?, enter Y (for Yes) to print reports on all 
purged patient files. The purge report includes information from Patient Registration and from 
the Patient Financial Summary screen (if it was selected as an option during installation).  

4. Click the OK button.  
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Restore Patient Data 
You can restore archived records to your system at any time. For example, if an inactive patient returns 
for treatment, or if you add another disk drive and decide you want to keep more of your records on 
your current system, you can restore the records from the backup medium. When you restore archived 
information, it is deleted from the archive media. 

You will use the Restore Archived Patient Data screen to retrieve archived patient information from the 
active storage drives on your Patient Records system. The archive disk or tape must be inserted and 
ready before you begin the restore procedure. 

Records can be restored selectively from the backup medium by any of the following criteria: 

• Records for individual patients, selected by name or identification number. 

• Records for patients registered during a given period, seen by a particular provider, or not seen 
since a given date. 

• Records for the selected patients only up to a given date. 

• Records based on patients listed in a Patient Inquiry file. 

Restoring patient data 
To restore previously inactive patient information:  

1. Select Maintenance > Utilities > Restore Patient Data. The Restore Drive and Pathname screen 
appears.  

Note: Depending on your access level, you may need to enter your password to access this utility.  

2. Enter the drive and pathname of the archived patient file.  

3. Click the OK button. The Restore Archived Patient Data screen appears.  

4. Select whether you want to restore data for a Single Patient, Selected Patients, All Patients, or 
Patient List File.  

5. In the Patient Data from field, type the dates for which you want to restore information. You can 
also leave the date fields blank to select all dates.  

6. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button.  

• Selected Patients: The Restore Archived Patient Data – Selection Criteria screen appears. 
Enter your criteria. You can fill in whatever information is appropriate, including 
scheduled provider, scheduled dates, registration dates, usual provider, patient status, 
and patient note (and the note's function, such as Scheduler or Patient). When you finish 
entering your criteria, click the OK button.  

• All Patients: A screen displays the status of the restore process.  

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to restore. Click the OK button.  

Note: If the information you are restoring is from a different version of Patient Records, a message will 
appear. To convert the archived information to the current version, click the OK button. If you click the 
Cancel button, the information will not be restored.  
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Send Electronic Orders Utility  
This utility initiates the electronic transmission process, and marks all selected pending and approved 
orders as sent. Your access level determines whether you can use this utility.  

Using the Send Electronic Orders utility 
To run the Send Electronic Orders utility:  

1. Select Maintenance > Utilities > Send Electronic Orders. The Send Electronic Orders screen 
appears.  

2. Enter the criteria you want to use to filter the orders.   

3. When you finish, click the OK button.  

Fields on the Send Electronic Orders screen 
Field Description 

Patient ID  To send orders electronically for all patients, leave this field 
blank.  
To send orders electronically for a specific patient, type the 
patient’s ID. When you tab out of the field, the patient’s name 
will appear in the Patient Name field. You can also type the 
patient’s name in the Patient Name field instead of using the 
patient’s ID.  

Provider ID  To send orders electronically for all providers, leave this field 
blank.  
To send orders electronically for a specific provider, select the 
appropriate provider from the drop-down list.  
When you tab out of the field, the provider’s name will appear 
in the Provider Name field.  

Practice  To send orders electronically for all practices, leave this field 
blank.  
To send orders electronically for a specific practice, select the 
appropriate practice from the drop-down list.  

Order Type  To send orders electronically for all order types, leave this field 
blank.  
To send orders electronically for a specific order type, select 
the appropriate type from the drop-down list.  

Order Date Range  In the date fields, select the range of dates for which you want 
to send orders electronically. When you select a starting and 
ending date, all orders created between those dates that meet 
the other criteria you set will be changed.  

Processing Operator  To send orders electronically for all processing operators, leave 
this field blank.  
To send orders electronically for a specific processing operator, 
type the processing operator’s ID.  
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Template Search and Replace 
You can use the Template Search and Replace utility to find and/or replace text (including text within 
Dot codes, Letter codes and Labels, and E&M codes) in Note Templates, Letter Templates, Message 
Templates, and History templates. This utility allows you to update multiple templates at one time. For 
example, if multiple templates contain a particular block of text you can use this tool to find and 
automatically replace the text. The tool can also help with system wide changes of Quick Text and Dot 
codes. For example, if your site wants to shift from storing data in Lab Tables with .L Dot codes to 
Clinical Elements with a .CE Dot code, you can search for .L Dot codes, and replace them with the .CE 
Dot codes.  

After completion, the Template Search and Replace utility will generate the Template Search and 
Replace report. This report lists the search criteria you selected and the names of the Templates that 
matched the criteria. The table lists the Type, Practice, Provider, and Name of each matching template. 

Important: Before running the Template Search and Replace tool your system administrator must back 
up your Note Templates (MRTE table).  

Using the Search and Replace tool 
To use the Template Search and Replace tool: 

1. Select Maintenance > Utilities > Text Template Utilities > Template Find and Replace. You will 
be asked if your templates are backed up. If you have not backed up your system data at this 
point you should click No, exit the application, and back up your template data. If you have 
backed up your data, click Yes. The Template Search and Replace Criteria screen appears. 

2. Select the type(s) of template you want to search for by selecting a radio button from the Type 
of Template list.  

3. Select the value that you want to replace by selecting a radio button from the Type of Replace 
list.  

4. In the Providers/Practices section of the screen you can select the providers and practices to 
include in the search. Please note you will only see the Practice option if you have templates by 
practice.  

Note: The Allow QuickText and Templates by Practice setting on the Records 2 tab on the Special 
Features screen must be enabled to configure templates by practice.  

To select providers: 

• Click the Providers button to open the Select Resource screen. Select the provider(s) you 
want to include, and when you are finished click the OK button. The provider(s) you 
selected will be included in the Providers list on the Template Search and Replace Criteria 
screen.  
You can select the Include All Providers check box to include all providers in the search. 
When this option is selected all providers will be included in the Providers list. 

To include practices:  

• Click the Practices button to open the Select Practices screen. Select the practice(s) you 
want to include, and when you are finished click the OK button. The practice(s) you 
selected will be included in the Practices list on the Template Search and Replace Criteria 
screen.  

You can select the Include All Practices check box to include all practices in the search. 
When this option is selected all practices will be included in the Practices list. 
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5. Select the Include Universal Templates check box to include Universal Templates (templates 
not assigned to a particular Provider and/or Practice) in the search.  

Note: This check box will not appear if the Allow Quick Text and Templates by Practice setting is 
enabled on the Records 2 tab of the Special Features screen. 

6. Click the OK button. The Template Search and Replace screen appears. 

7. Click the Templates button to select the template(s) you want to search for (or check the Select 
all Templates check box to select all templates). If you click the Templates button, the Select 
Template screen appears. Select the template you want to search for on the left hand side of 
the screen, and click the right arrow button. The selected template will be displayed in the list 
on the right hand side of the screen. You can remove a template from the list by selecting the 
template on the right hand side of the screen, and clicking the left arrow button. 

Once you have selected the template(s) you want to search for, click the OK button. The 
selected template(s) will be displayed in the Templates list on the Template Search and 
Replace screen.  

You can select the Select All Templates check box to search for all templates. When this 
option is selected all templates will be included in the Templates list. 

8. You can use the Search and Replace tool to search for every occurrence of a specific word or 
phrase, or to automatically replace that text with different text. 
• Select the Find radio button to search for every occurrence of a specific word or phrase. 

Enter the text you want to search for in the Find field.  

• Select the Find and Replace radio button to automatically replace a specific word or 
phrase. Enter the text you want to search for in the Find field and enter the replacement 
text in the Replace field.  

9. Select the Match whole word only check box to look for whole-word matches only (for 
instance, "any" is a whole-word match with the word "any" but not with the word "anyway"). This 
option will automatically be selected when you choose to search for Dot codes, E&M codes, 
and Letter codes. 

10. Select the Match case check box to search for the exact case entered in the Find field. If this 
option is not selected, the search will not be case-sensitive.  

11. To print the report to a file (instead of printing the report on paper), select the Print to file 
check box. 

12. Click the OK button.  

The report will be printed to your default printer, or if you have the Print to Screen option 
enabled, it will automatically print the report to your screen.  

If you selected the Print to file option, you may view the report by browsing to the location 
where you saved it.  
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Database utilities 

Lytec MD database utilities 
Lytec MD provides several utilities to help you manage your database. The table below describes the 
utilities available. 

Utility Description 

Check Checks and reports on the integrity of data files and indexes. 
For example, the Check utility can identify when a file has data 
body damage that needs to be repaired with the Fix utility. It 
also identifies index body damage that must be repaired by the 
Rebuild utility.  
Normal completion of the utility results in a list of file names 
(MRPA99, etc.) in the Output box of the Database Utilities 
screen. Any detail after a file name indicates an error.  

Count Shows the number of records in a selected data file. 

Filid Corrects patient ID errors. As a symptom, you may occasionally 
get the message “Duplicate patient ID” or “database error-
#111” inappropriately while registering a patient. This might 
occur if you restored an old ASCF99.DAT file to the system.  

Rebuild and Fix 
 

Note: "Fix" and "Rebuild" also appear separately, but you 
should run the combined "Rebuild and Fix" option. Be sure you 
have first run Check, and then run "Rebuild and Fix" against the 
file(s) indicated by Check to rebuild data file indexes.  
To use Fix and Rebuild:  

1. Run the Count utility on the affected file.  
2. Run Rebuild and Fix.  
3. Run the Count utility again. If you lost more than a few 

records (that is, the count is lower afterwards), restore 
from your backup and contact your dealer or Lytec MD. 

"Rebuild and Fix" fixes damaged data files and data file 
headers. 
Note: Use "Rebuild and Fix" only after consulting your dealer or 
Lytec MD. It is essential that you back up your data files before 
you use it. For AR* files, while "Rebuild and Fix" will successfully 
rebuild the files, the utility will have appeared to error out. 

Reset User Count Restores access to the system for all users. Occasionally, you 
may see the messages “Too many users,” or “All users must be 
off system for Backup or Restore” inappropriately. The most 
common reason for this problem is that a user exited from the 
program improperly by rebooting or powering off the system. 
Run this utility to correct the internal count of the number of 
users on the system. It also displays the number of users 
licensed to your system.  

Status Technical support staff may ask you to run this utility to help 
them solve database problems. It displays information about 
the structure and contents of your database files.  
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Using the Lytec MD database utilities 
1. Back up your data. This is critical!  

2. Make sure all users have exited from the system.  

3. Navigate to the PPart folder, typically c:\Ppart. 

4. Double-click the database utility, CTGUI.EXE. When the Database Utilities screen displays, 
choose a utility and the appropriate file. Refer to the Utility options in the table above. 

Error messages display in the Output window. They also are stored in the file PHUTIL.LOG. You can 
view this file in Windows Notepad.  

Note: PHUTIL.LOG is overwritten every time you start a database utility. For AR* files, while "Rebuild 
and Fix" will successfully rebuild the files, the utility will have appeared to error out. 
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Lytec MD general error messages 
The table below describes error messages you may see when a problem occurs in Patient Records and 
Appointment Scheduler. The table below provides guidance as to what actions you should take when 
those errors appear, for those cases where the action is not listed in the error message itself.  In some 
cases, you will need to fix these problems by using a Lytec MD utility.    

Unless noted, errors apply to both Patient Records and Appointment Scheduler. 

Error message Description 

#1.  The files MRPANEL or 
MRINDEX are missing. 
#3.  The files MRPANEL or 
MRINDEX are damaged. 

Appointment Scheduler only 
Copy MRPANEL and MRINDEX from your backup disk.  In some 
rare cases, this message may indicate insufficient memory not 
caught by other memory checks. 

Access denied The password you entered does not have a sufficiently high 
access level to perform the task you have selected. Another 
user with a higher level password must perform the task. If 
necessary, the system administrator can change your access 
level.  

All users must be off system for 
Backup or Restore 

Make sure that all other users have exited from Lytec MD before 
you back up or restore files on your system. 
If you see this message inappropriately (e.g., when you are the 
only user on the system), another user may have exited 
improperly by rebooting, or a power failure may have occurred. 
To fix this problem and reset the user log, exit from Lytec MD 
and use the Reset User Count utility.  

Appointment slot just altered by 
another user 

Appointment Scheduler only 
Another user has just changed the appointment slot you were 
scheduling. Even though you have apparently scheduled the 
slot, it will not be recorded. You will have to use another slot. 
This message occurs infrequently. 

Archive files not found Patient Records only 
Some archive files are missing from the archive media( e.g., 
tape or disk). If you are archiving, start again with fresh archive 
media. If you are restoring, your archive data has been 
damaged and some files are missing.  

Config.sys not set properly Appointment Scheduler only 
Your CONFIG.SYS file requires modification.  The CONFIG.SYS 
file is used by your operating system to determine the number 
of possible files, special memory buffers, and special devices 
that are being used by the program.  For example, you may 
have specified an insufficient number of files in the FILES= 
statement.  Lytec MD is unable to open all of the files necessary 
for operation. 

Coordinated rooms cannot be 
selected 

Appointment Scheduler only 
If you are viewing the Patient Check-In window, you cannot 
select a coordinated room at the time the patient checks in.  
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Database error:Module XXX Call 
XXX - Code #  

There is an error in the Lytec MD database. If you see this 
message, write down the filename, the error number and the 
task you were performing when the error occurred. If the code 
number is not listed below, call your dealer or Lytec MD to 
diagnose the problem.  

 #110. The file you were accessing is locked. Make sure 
all users are off the system. Then run the Clear utility to 
unlock all files.  

 #111. Duplicate Read. If this occurs while registering 
patients, first make sure all other users are off the 
system. Then, run the Filid utility.  

 #301 or #302. If you see one of these two error 
numbers, then disable the “Wake up” option on the 
workstation network interface card (NIC).  

 #311 or #312. If you see one of these two error 
numbers, check whether the file named in the message 
is missing or whether the pathname of your Lytec MD 
files is incorrectly set.  
 
Once you have located and corrected the error, restart 
Lytec MD. 

 #313. There is insufficient memory for the database 
manager. If your files are very large, memory 
requirements may increase. You may need more 
memory.  

Day is on hold Appointment Scheduler only 
If you try to make or edit an appointment on a day that is on 
Hold, you will get this message. 

Default system configuration 
missing  

Patient Records only 
From Program Manager, run the utility GUICHART.EXE. It 
should be in your database directory.  

Disk full  The disk where you are storing patient information is full. First, 
copy down the name of the file that follows this message. Then, 
remove any outdated or unnecessary records from your disk. 
You may need to use the Reorganize utility on the file that was 
being written to when you saw the “disk full” message.  

Duplicates found while restoring.  Patient Records only 
Duplicate information was found while during a restore. Some 
information was already on the system for the current patient. 
Duplicates are not overwritten, nor are they deleted from the 
archive file.  

Error reading disk Lytec MD is unable to read information from the file on the disk. 
You may have errors on your hard disk or floppy disk. First, try 
the Windows ScanDisk utility to see if there is a disk problem. If 
the disk is not damaged, run the Lytec MD Check utility to 
check the database.  
Note: If you use Novell and you suspect serious data problems, 
run Vrepair. See your manuals for more information about 
ScanDisk or Vrepair.  
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Error seeking on disk  Lytec MD is unable to read information from the file on the disk. 
You may have errors on your hard disk or floppy disk. First, try 
the Windows ScanDisk utility to see if there is a disk problem. If 
the disk is not damaged, run the Lytec MD Check utility to 
check the database.  
Note: If you use Novell and you suspect serious data problems, 
run Vrepair. See your manuals for more information about 
ScanDisk or Vrepair.  

Error writing to disk  Lytec MD is unable to write information to the disk. You may 
have errors on your hard disk or floppy disk. First, try the 
Windows ScanDisk utility to see if there is a disk problem. If the 
disk is not damaged, run the Lytec MD Check utility to check 
the database.  
Note: If you use Novell and you suspect serious data problems, 
run Vrepair. See your manuals for more information about 
ScanDisk or Vrepair.  

File is damaged  There is damage to the disk at the location where the file is 
stored. Restore the damaged file from your backup. Use the 
Windows ScanDisk utility or Novell Vrepair utility to see if there 
is a disk problem.  
If you cannot restore the file from your backup, try running the 
Lytec MD FIX utility.  

File locked - retry?  You may see this message if you are running Lytec MD on a 
local area network and the file server is very busy.  
Try answering Yes to this question. If you answer No, you will 
lose whatever data you have just entered.  
Very rarely, you may repeatedly see this message when you 
retry access. If so, the system is either overloaded or locked, 
usually due to an improper exit by a user. If the system is 
locked, all users should exit from Lytec MD. Then, reboot the 
system and restart Lytec MD. 

Files locked. Run CLEAR before 
running program again  

If you exit improperly from Lytec MD, one or more files may be 
locked. Locked files cannot be accessed. To unlock files, first 
make sure all other users are off the system. Then run the Lytec 
MD Clear utility from the Lytec MD Database Utilities. When you 
are finished, restart Lytec MD.  

General file transfer error  You may see this message during installation as Lytec MD 
copies files to your Lytec MD directories. Check your drives.  

Incompatible program versions 
mixed together  

Your current version of Lytec MD has been improperly updated. 
You must reinstall Lytec MD. Please carefully follow the 
installation instructions you received with your update.  

Initialize archive media?  Patient Records only 
The archive media does not have any data files on it. If you 
answer Yes, Lytec MD will copy data files to your archive disk.  
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Insufficient space - Archive not 
performed 

Patient Records only 
There was insufficient space on the archive media to complete 
the archive. The last patient displayed on the screen was not 
archived. To continue, put fresh archive media in the computer 
and repeat the archive. Archiving starts with the last patient 
archived and continues from there. 

Insufficient space - Restore not 
performed 

Patient Records only 
There was insufficient space on your data disk to complete the 
restore. To continue, delete unnecessary files from your data 
drives and repeat the restore, using the same criteria. Restoring 
starts with the last patient restored and continues from there. 
You may need additional disk storage space.  

Invalid access level message  The password you entered does not have a sufficiently high 
access level to perform the task you have selected. Another 
user with a higher level password must perform the task. If 
necessary, the system administrator can change your access 
level.  

Invalid Rx Format File. Enter a 
valid filename on the Rx Defaults 
Window  

Patient Records only 
Before you can print prescriptions, you must enter a valid 
prescription format file name in the Rx Defaults screen. 
Individual providers may have their own prescription format 
files.  

Item already exists Appointment Scheduler only 
If you try to add an item, such as a process or status code, that 
is already in the current list of items, you will get this message. 

Item does not exist Appointment Scheduler only 
If you try to edit or delete an item, such as a process or status 
code, that is no longer in the current list of items, you will get 
this message. 

No selection criteria Patient Records only 
You did not select any selection criteria for your patient inquiry. 
Select the patient inquiry criteria you want. Then repeat the 
search.  

Number of allowable users 
exceeded  

There are more users on your network than your version of 
Lytec MD allows. If you need to increase the number of users on 
your system, you may license additional capability from your 
dealer or Lytec MD.  
If you do not have an excessive number of users on your 
system, make sure all users exit Lytec MD and then use the 
Reset User Count utility.  

Patient Inquiry error  Patient Records only 
Unable to create output file.  
Unable to write output file.  
Unable to close output file.  
There was an error in creating, writing, or closing an output file. 
The possible causes are: a full disk, or a damaged disk. Erase 
unnecessary files, run the Windows ScanDisk utility or Novell 
Vrepair utility to see if there are problems with your disks.  
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Patient is not accessible by this 
user  

Patient Records only 
User who does not have a specific practice listed for access 
cannot access the patient chart for a patient from that practice.  

Records are busy  If you are using Lytec MD on a local area network, you may see 
this message if another user is editing the same data you are 
trying to change. For example, you may see this message if a 
user is updating the progress notes for the patient you have 
selected or a user is changing the provider file. You cannot edit 
the data until the other user is finished. Wait a few minutes and 
try the same task again. By preventing simultaneous access, 
Lytec MD protects data from damage.  

Room or facility not available Appointment Scheduler only 
If a room or resource is coordinated, you cannot select it if there 
are no available slots that can be scheduled. 

Screen load error #1 Appointment Scheduler only 
Lytec MD is unable to display screens. Make sure that you are in 
the right directory and that you have properly installed Lytec 
MD.   

Slot sequencer limit has been 
reached 

Appointment Scheduler only 
This message displays only when Lytec MD has reached 100 
duplicate time slots. Duplicate slots may have been created 
when you cancelled appointments or inserted time slots. 

Too many users. Access denied  There are more users on your network than your version of 
Lytec MD allows. If you need to increase the number of users on 
your system, you may license additional capability from your 
dealer or Lytec MD.  
If you do not have an excessive number of users on your 
system, make sure all users exit Lytec MD and then use the 
Reset User Count utility.  

Unable to block out this slot Appointment Scheduler only 
You will see this message if you try to block out an empty 
appointment slot that has a time slot earlier than the initial 
appointment you just made. Try to block out a slot after the 
initial appointment slot time. 

Unable to create a directory under 
...  

You may see this message during installation as Lytec MD 
copies files to your Lytec MD directories. If you get the 
message, make sure you have adequate network permissions in 
the Lytec MD directories.  

Unable to create file  Lytec MD is unable to create a new file. Either the disk or the 
disk directory is full, or you do not have correct network 
permissions. Try deleting any outdated or unnecessary files.  

Unable to open file  Lytec MD is unable to open a file because the file has been 
deleted, the pathname has been incorrectly set, or there is 
damage to the disk. If necessary, use your backup to restore the 
file you need or correct the pathname.  
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Unable to update the MISSED.NT? 
file. Run the Unsaved Notes 
report. 

Patient Records only 
If you are using Lytec MD on a local area network, you may see 
this message when two or more users are attempting to print 
notes simultaneously. System locking may prevent an update of 
the file MISSED.NT?, where ? is a number from 1 to 9. If this 
happens, some patients may have unsaved shared notes that 
will not be recorded in the Missed file. To be safe, run the Print 
List of Unsaved Shared Notes report.  

You must enter Rx Defaults before 
this operation can be completed.  

Patient Records only 
Before you print prescriptions, patient instructions, or patient 
medication lists, you must fill in the appropriate items on the Rx 
Defaults window. For example, before you write a prescription, 
you must supply the name of the default prescription format file 
you want to use.  
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The PPart.ini file 
The PPart.ini file is a configuration file that defines many Lytec MD features. The PPart.ini file includes 
both settings that can be defined only in the file, and settings that must be defined through the Special 
Features screen. The table below indicates which settings can be safely changed in the file, and which 
should be changed on the Special Features screen. 

Procedure for changing the PPart.ini file 
To open or edit the PPart.ini file: 

1. Make a backup of the PPart.ini file. For example, copy the file and rename it as ppart.bak. 

2. Use WordPad, Notepad, or another text editor to open the file. 

3. Make the necessary changes. The table below describes settings in the file, including which 
settings should not be edited. 

4. Save the file. 

Keys and variables in the PPart.ini file 
The table below has the keys (section titles) and variables in PPart.ini. 

Specific critical variables and the name of any key must not be changed, shown in the table as follows: 

• Keys: These are shown in bold. 

• Critical Variables: These are shown in italics. 

Note: Changing a critical variable or the name of a key will likely cause Lytec MD not to operate. 

Settings in PPart.ini 
Key Description 

[PrintGroup]  
Print_Group=STANDARD 

The default group of printers (the Standard printer group) is 
used for all Lytec MD operators. The first line always 
displays [PrintGroup]. You can use the second to indicate 
the name of your system default print group. Although the 
default is Standard in PPart.ini, you can change it to any 
other group.  

[PrinterOverrides] These settings apply to your system printers.  

PRINTER_DETAIL=OFF This setting indicates whether full printer details (including 
network path) should display on the printer maintenance 
screen. 
If this setting =ON, full details display. 
If this setting =OFF, only the printer name displays. 
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IMAGE_SCALE= This configuration controls the size of the graphs, certain 
images, flowcharts, and health maintenance items printed 
from Patient Records. It does not effect PLINK, PLINK2, 
ECG, or Spirometry. 
If this setting =Default, the document will be printed out 
without any special scaling.   
If this setting =Fit_Page, the Scaling factor will be 
determined automatically so that the document fits on one 
page (isotropic scaling). This is the default setting. 
If this setting =Fit_Width, the document will be scaled so 
that it fits the width of a page. A tall document scaled this 
way will be printed on pages that form a vertical column (in 
case the scaled document requires more than one page to 
fit). 
If this setting =Fit_Height, the document will be scaled so 
that it fits the height of a page. A wide document scaled 
this way will be printed on pages that form a horizontal row 
(in case the scaled document requires more than one page 
to fit). 

SHORT_PAT_LABEL= This setting controls whether two or three street address 
lines are printed on mailing labels and the Patient 
Registration report.  
If this setting =ON, two street address lines will be printed. 
If this setting =OFF, three street address lines will be 
printed. This is the default setting. 

[PrinterTypes] 
General1=Encounter,Encounter 
Label,Messages 
General2= 
PRASType1=RX,Remote 
RX,Instructions,Charts,Reports,Fax, 
Labels,Reminders,Cancellation 
slip,Chart Request,Orders 
PRASType2=X-Ray Request,Log,Order 
Label, Order Requisitions 

In Lytec MD, a printer type defines the tasks for which you 
need a printer. Printer types display on the Printer Group 
Maintenance screen. When you are creating a printer 
group, you will add default printers for various printer 
types. 

[Fonts]  
HP LaserJet 4/4M,Rx=Courier New,12 
HP LaserJet 4/4M,Instructions=Courier 
New,12 
HP LaserJet 4/4M,Charts=Courier 
New,12 
HP LaserJet 4/4M,Reports=Courier 
New,12 
HP LaserJet 4/4M,Labels=Courier 
New,12 

This section defines the default font and font size for each 
printer. Each line corresponds to one of your Windows 
printers and how its used in a print group. Make sure the 
name before the comma exactly matches the printer name 
that you select on the printer maintenance screen. 
Following the printer name, is the printing category (for 
example, Reports), and then the font name and size.  
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[NonProportionalFonts] 
ReportsNarrow1=Courier,10 
ReportsNarrow2=Courier,12 
ReportsNarrow3=Courier New 
ReportsNarrow4=Lucida 
ReportsWide1=Lucida Console 
ReportsWide2=MS Mincho 
ReportsWide3=Lineprinter 
Font1=Andale Mono CP437, 
Courier,Courier New 
Font2=Letter Gothic, 
Letter Gothic CP437, 
Letter Gothic MT, 
Letter Gothic (W1) 
Font3=Line Printer, 
Lucida Console,Lucida  
Sans Typewriter 
Font4=MS Mincho,@MS Mincho, 
Device Font 10cpi,Device Font  
12cpi,Device Font 17cpi 
Font5=OCR-A,OCR A Extended, 
OCR-A II,OCRB,OCR B MT 
Font6=Quartz,Space Toaster, 
Quick Type Mono,Quick Type II Mono 

Once you create your printer groups, you can control fonts 
for your reports and other printed materials by using the 
[NonProportionalFonts] section.  
Many reports in Lytec MD require non-proportional font 
(that is, fonts in which all characters are the same width). 
The fonts in the [NonProportionalFonts] section 
correspond to the fonts that are listed on the Printer Type 
Properties screen. You can add other non-proportional 
fonts by adding to the [NonProportionalFonts] section.  
At least one font from each of the font groups listed in the 
[NonProportionalFonts] section must be installed on the 
workstation. This will ensure that Lytec MD reports print 
correctly. 

[Documents] 
BoldHeaders= 

This setting defines whether headings in notes are bolded. 
If this setting =ON, headings are bolded. 
If this setting =OFF, headings are not bolded. 

[Scheduler] These settings apply to Appointment Scheduler. 

CONTEXT= 
CANCELLATIONS= 
APPT_LOG= 
MULTPVS= 
NOON= 
MONTHMODE= 
REMINDER_SLIP= 
XRAY_REQUEST= 
CHART_REQUEST= 
MUSC_ENCFMT= 
REFMT_NAME= 
EXTRAFILES= 
HR_PRGDATE= 
APT_PRGDATE= 

Do not change these settings in the PPart.ini file. 
These settings apply to Appointment Scheduler, and are 
set on the Special Features screen.  

Schedule Views Refresh= This setting defines how often the Schedule screen should 
be refreshed. 
To configure this feature, use the following format: 

Schedule Views Refresh=xxx 

where xxx is the number of seconds before the Schedule 
screen should be refreshed. The default is 60 seconds. 
To avoid significant on screen delays you may want to 
specify a longer refresh time.  
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ShowOnCallProvider= This setting indicates whether the on call provider feature 
is active in Appointment Scheduler. 
If this setting =ON, the on call provider feature is active. 
If this setting =OFF, the feature is not active. 

NonContiguousBlocking= This setting indicates whether Appointment Scheduler's 
non-contiguous blocking feature is active. 
If this setting =ON, appointment slots that are not 
contiguous (next to each other) can be blocked together. 
If this setting =OFF, only slots next to each other can be 
blocked. 

AlwaysShowCaseList= This setting indicates whether the Visit Tracking Case List 
screen will be shown if there is only one case. 
If this setting =ON, the screen will always be shown. 
If this setting =OFF, the screen will not be shown. 
Note: If set to OFF, and there are multiple cases, the 
screen will be shown. 

OnCallStartTime= Use this setting to enter the default on-call start time for 
on-call scheduling. The time entered will be used as the 
default start time on the On Call List screen. You must 
enter the time in hh:mm followed by AM or PM. For 
example: OnCallStartTime=07:00 AM  

OnCallEndTime= Use this setting to enter the default on-call end time for on-
call scheduling. The time entered will be used as the 
default end time on the On Call List screen. You must 
enter the time in hh:mm followed by AM or PM. For 
example: OnCallEndTime=05:00 PM 

LengthTimeUnit= This setting allows you to specify the number of minutes 
represented by each bar in the graphical icon on the Daily 
and Dual schedule view screen. For example, if you enter 
5, the each bar in the graphical icon will represent 5 
minutes. The default setting is 15. 

ProgNoteColorBlank=  
 
 
 

Configurable on the Scheduler 4 tab of the Special 
Features screen.  
This setting determines the color of the Note Status field 
when there is no progress note for the visit. The default 
setting is blank (no color).  
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 

ProgNoteColorO=  
 

Configurable on the Scheduler 4 tab of the Special 
Features screen.  
This setting determines the color of the Note Status field 
when there is an open progress note for the visit. The 
default setting is yellow.  
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 
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ProgNoteColorC=  
 

Configurable on the Scheduler 4 tab of the Special 
Features screen.  
This setting determines the color of the Note Status field 
when there is a closed progress note for the visit. The 
default setting is green.   
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 

ProgNoteColorS= 
 

Configurable on the Scheduler 4 tab of the Special 
Features screen.  
This setting determines the color of the Note Status field 
when there is a signed progress note for the visit. The 
default setting is blue.  
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 

ProgNoteColorQ= 
 

Configurable on the Scheduler 4 tab of the Special 
Features screen.  
This setting determines the color of the Note Status field 
when Patient Records cannot definitively determine if there 
is a progress note for the visit because the patient has 
multiple appointments on the same day. The default 
setting is magenta.  
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 

DoubleBookColorDA= 
 

This setting specifies which color will be used to highlight 
one of the Dashboard schedule rows if there are two 
appointments at the same time for the same 
provider/practice. 
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 

DoubleBookColorPS= Configurable in Special Features on the Records 6 tab. 
This setting specifies which color will be used to highlight 
one of the Provider Schedule rows if there are two 
appointments at the same time for the same 
provider/practice. 
Available values are red, dark red, green, dark green, blue, 
dark blue, yellow, dark yellow, magenta, dark magenta, 
cyan, dark cyan, and light gray. 

ProgNoteTabs= Do not change this setting in the PPart.ini file. You can 
make your changes using the Chart Sections to Check for 
Appointment Note Status settings on the Scheduler 4 
tab on the Special Features screen. 

[CheckInDefs]  These settings apply to Appointment Scheduler's check-in 
feature. 
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Check In=IN,CHECKED IN 
In Exam Room=IN,IN EXAM ROOM 
Provider Starts=IN,WITH PROV 
Provider Finishes=IN,PROV FINISH 
Check Out=OUT,CHECKED OUT 

These settings define what displays in the drop-down lists 
in Appointment Scheduler's check in feature. The 
categories (Check In, In Exam Room, Provider Starts, 
Provider Finishes, and Check Out) must not be changed, 
but you can add new definitions to the categories. 

CheckInForm= 
 

Configurable in Special Features on the Scheduler 3 tab, 
this setting specifies the default encounter form to print. 
Appointment Scheduler ships with a default encounter 
form, AS_Encounter, but you can modify this form or 
create your own form. 

ShowCheckInFormSelection= Configurable in Special Features on the Scheduler 3 tab, 
this setting defines whether a list of selectable encounter 
forms will display when the check-in feature is used. 
If this setting =ON, the list of encounter forms will display. 
If this setting =OFF, the list will not display. 

EncFormDef= Configurable in Special Features on the Scheduler 3 tab, 
this setting defines whether a paper form is printed, 
Electronic Encounter Form is created, or both when the 
Enc Form check box is selected from the Patient Check-in 
screen. 
If this setting =Paper, a paper encounter form will be 
printed. 
If this setting =EEF, an electronic encounter form will be 
created. 
If this setting =Both, a paper encounter form will be 
printed and an electronic encounter form will be created. 

[LicenseWaitIntervals] 
SecondsToWaitToSayStillBusy=75 
SecondsToWaitForLicense=180 

These settings are used to change the intervals Lytec MD 
waits before re-assigning user licenses. Both settings can 
be changed. However, if you change them, make sure that 
SecondsToWaitForLicense is at least twice as large as 
SecondsToWaitToSayStillBusy.  
SecondsToWaitToSayStillBusy is the interval in seconds 
between heart-beats, a message from a workstation 
running the application that the application is still in use. 
This process occurs automatically and lets the license 
manager know a license is still in use. If the user is running 
a long process such as a report, it may take longer to 
signal than the specified number of seconds for the 
application to send a heart-beat.  
SecondsToWaitForLicense is the interval in seconds before 
a specific workstation running the application is 
considered inactive and the license it was using is available 
to others. Generally it should be two or three times larger 
than SecondsToWaitToSayStillBusy.  
Keep in mind that shortening these numbers will increase 
network traffic and may slow overall application 
performance. Making the numbers bigger will decrease 
network traffic but will lead to longer waits for an unused 
license to be recovered. Sites with more than 50 users or 
sites using a wide area network may want to increase these 
numbers.  
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[ReferralTypes] 
RFTP00=MD, Physician 
RFTP01=ER, Emergency Room 
RFTP02=HOSP, Hospital 
RFTP03=YP, Yellow Pages 
RFTP04=WEB, Web Site 
RFTP05=DO, Osteopath 
RFTP06=CH, Chiropractor 
RFTP07=PAT, Patient 
RFTP08=OTH, Other 

Patient Records ships with several referring source types. 
As the name implies, a referring source type indicates the 
type of resource. Referring source types include physician, 
emergency room, hospital, yellow pages, Web site, 
osteopath, chiropractor, patient, and other. These types 
are stored in the PPart.ini file, so can add to the list as 
needed. 
You can add referring source types by adding to the 
[ReferralTypes] section.  
The format includes the following elements:  

 RFTP 

 2 digit number 
 Equal sign 

 2 to 4 character ID 
 Comma 

 Space 
 Name of the referring source type 

You can add a new referring source type by using the next 
consecutive number and adding a line after RFTP08=OTH, 
Other. For example: 
RFTP09=MIL, Military 

[ReviewData] These settings apply to reviewing lab results and notes. 

Notes_Chart= You can configure how to display the patient chart when 
reviewing progress notes.  
If this setting =NO, users can manually display the patient 
chart by clicking the Open Chart button on the Review 
Provider Data screen. 
If this setting =YES, the patient chart will automatically be 
displayed as a minimized screen when users access the 
Review Provider Data screen. 

Lab_Chart= You can configure how to display the patient chart when 
reviewing lab data.  
If this setting =NO, users can manually display the patient 
chart by clicking the Open Chart button on the Lab Table 
Review screen. 
If this setting =YES, the patient chart will automatically be 
displayed as a minimized screen when users access the 
Lab Table Review screen. 

[Park] 
Show_User_Name= 

This option is set through the Special Features screen's 
Show previous User Name when in Park check box. If the 
check box is marked (the setting =ON), when in Park 
mode, the user name displays in the Lytec MD sign in 
screen.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 390 

 

ConfirmPark= Specifies whether confirmation is required when operators 
park a workstation. This setting is configured in the Special 
Features screen on the General tab. 
If this setting =ON, a confirmation message appears when 
operators attempt to park a workstation. 
If this setting =OFF, no confirmation message appears. 
This is the default value for this setting.   

[InsertProblemList] 
InsertProblem= 

You can decide how major problems inserted into notes 
by using the .IMP Dot code should be displayed: 
horizontally, vertically, vertically with code, and vertically 
with code and notes. Examples of these options are 
provided below. If you do not set a preference, problems 
will display horizontally. 
Horizontally (setting =Horizontal) 
DEPRESSION, LOW BACK PAIN, DIABETES 
Vertically (setting =Vertical) 
DEPRESSION 
LOW BACK PAIN 
DIABETES 
Vertically with Code (setting =VerticalWithCode) 
DEPRESSION (271.23) 
LOW BACK PAIN (384.00) 
DIABETES (280.45) 
Vertically with Code and Notes (setting 
=VerticalWithCodeNotes) 
DEPRESSION (271.23) Started after father died 
LOW BACK PAIN (384.00) Workplace injury 
DIABETES (280.45) Recently became insulin dependent 

InsertOtherProblems=  You can decide how other problems inserted into notes by 
using the .IOP Dot code should be displayed: horizontally, 
vertically, vertically with code, and vertically with code and 
notes. Examples of these options are provided below. If 
you do not set a preference, problems will display 
horizontally. 
Horizontally (setting =Horizontal) 
DEPRESSION, LOW BACK PAIN, DIABETES 
Vertically (setting =Vertical) 
DEPRESSION 
LOW BACK PAIN 
DIABETES 
Vertically with Code (setting =VerticalWithCode) 
DEPRESSION (271.23) 
LOW BACK PAIN (384.00) 
DIABETES (280.45) 
Vertically with Code and Notes (setting 
=VerticalWithCodeNotes) 
DEPRESSION (271.23) Started after father died 
LOW BACK PAIN (384.00) Workplace injury 
DIABETES (280.45) Recently became insulin dependent 
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InsertDiagnosis=  You can decide how diagnosis codes inserted into notes 
by using the .IDX Dot code should be displayed: 
horizontally, vertically, vertically with code, and vertically 
with code and notes. Examples of these options are 
provided below. If you do not set a preference, problems 
will display horizontally. 
Horizontally (setting =Horizontal) 
FROSTBITE FACE, FROSTBITE FOOT  
Vertically (setting =Vertical) 
FROSTBITE FACE 
FROSTBITE FOOT  
Vertically with Code (setting =VerticalWithCode) 
FROSTBITE FACE (991.0) 
FROSTBITE FOOT (991.2) 
Vertically with Code and Notes (setting 
=VerticalWithCodeNotes) 
DEPRESSION (271.23) Started after father died 
LOW BACK PAIN (384.00) Workplace injury 
DIABETES (280.45) Recently became insulin dependent 

InsertProcedures= You can decide how procedure codes inserted into notes 
by using the .IMP Dot code should be displayed: 
horizontally, vertically, vertically with code, and vertically 
with code and notes. Examples of these options are 
provided below. If you do not set a preference, problems 
will display horizontally. 
Horizontally (setting =Horizontal) 
HAND/FINGER SURGERY, HAND TENDON 
RECONSTRUCTION 
Vertically (setting =Vertical) 
HAND/FINGER SURGERY 
HAND TENDON RECONSTRUCTION 
Vertically with Code (setting =VerticalWithCode) 
HAND/FINGER SURGERY (26989) 
HAND TENDON RECONSTRUCTION (26500) 
Vertically with Code and Notes (setting 
=VerticalWithCodeNotes) 
DEPRESSION (271.23) Started after father died 
LOW BACK PAIN (384.00) Workplace injury 
DIABETES (280.45) Recently became insulin dependent 

FilterProcedureCodes= You can use this setting to filter out procedure codes that 
you don't want inserted through the .IPR Dot code. For 
example, most practices won't want office codes to display 
in a progress note. 
After the =, type the procedure codes separated by 
commas. For example: 

FilterProcedureCodes=99201,99202,99203, 
99204,99205,99211,99212,99213,99214,99215 

[LineRemoval] These settings apply to notes. 
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RemoveNoteLines= Configurable in Special Features on the Records 4 tab, you 
can set up Patient Records to remove blank lines in notes.  
If this setting =ON, after notes are processed (that is, after 
unexpanded labels are removed and Dot codes are 
replaced with text), Patient Records will delete empty lines. 
If this setting =OFF, the empty lines will not be deleted. 

MaxNoteLinesInARow= 
 

This setting applies when RemoveNoteLines=ON. 
You can configure the maximum number of empty lines 
that can be present before they are removed. For example, 
if MaxNoteLinesInARow=2, then two empty lines in a row 
are allowed. When there are three or more empty lines, all 
the empty lines will be removed. For the 
MaxNoteLinesInARow=# setting, replace # with the 
maximum number of empty lines that can be present 
before the lines are removed. 

RemoveLetterLines= Configurable in Special Features on the Records 4 tab, you 
can sets up Patient Records to remove blank lines in 
letters. 
If this setting =ON, after letters are processed (that is, after 
unexpanded labels are removed and Dot codes are 
replaced with text), Patient Records will delete empty lines. 
If this setting =OFF, the empty lines will not be deleted. 

MaxLetterLinesInARow= This setting applies when RemoveLetterLines =ON. 
You can configure the maximum number of empty lines 
that can be present before they are removed. For example, 
if MaxLetterLinesInARow=2, then two empty lines in a row 
are allowed. For the MaxLetterLinesInARow=# setting, 
replace # with the maximum number of empty lines that 
can be present before the lines are removed. 
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[ImmunizationForm] 
StatusDefault= 

Set the default selections on Immunization–Status 
Selection. More than one status may be used for as default 
values. Separate each status by a comma and no space. 
The options are: 

Status Meaning 

X–Done An activity or test was completed on-
site. For example, this could be a flu 
shot given during an office visit. 

E–Done 
Elsewhere 

An activity or test performed by another 
medical facility or practice. For 
example, this could be a blood sugar 
test given by a hospital lab and 
reported to the provider. 

N–Not 
Applicable 

An activity or test is not appropriate for 
this patient. This speeds report 
production by eliminating unnecessary 
record searches. 

R–Refused An activity or test was prescribed for the 
patient, but the patient refused it. 

P–Postponed An activity or test prescribed for the 
patient, but the patient requested it be 
performed later. The date has not been 
set. 

O–Ordered An activity or text prescribed for the 
patient that has is going to happen in 
the future. The date has been set. 

The default selections may be set on the Records 6 tab of 
Special Features. 

The initial default value is StatusDefault=X,E. 

[Signatures] 
Always_sign= 

You can require providers to sign each individual note 
during review. You will need to change a setting in the 
PPart.ini file.  
If this setting =ON, providers must re-enter their electronic 
signature for each note during the review. 
If this setting =OFF, providers can sign their notes without 
constantly re-entering their PIN by pressing the Sign 
button during a given Review session.   

[ReviewProvider]  
Required_to_Enter= 

You can require users adding lab results to select at least 
one provider who should be sent the results. 
If this setting =ON, users must select at least one provider 
before they can save the lab results. 
If this setting =OFF, users can save the lab results without 
specifying the providers who should receive the results. 

[Relationships] 
InsRelationships=S,H,W,C,P,O 

This setting should not be changed in the PPart.ini file. 
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[EKG] 
StoreEKGIn= 

Configurable in Special Features on the Records 1 tab. 
If you are using the Brentwood ECG add-on module or the 
Welch Allyn ECG add-on module, you can specify the text-
based section of the patient chart where you want the 
ECGs to be stored. 

WelchAllyn_PreviousInstall= Use this setting to indicate whether the Welch Allyn ECG 
add-on module was installed previous to the installation of 
Patient Records. The default setting is False. If the module 
was installed after the installation of Patient Records, leave 
this setting set to False.  
Set to =True if the module was installed previous to the 
installation of Patient Records.  

DefaultEKGClient= Use this setting to specify the default ECG client. The 
default setting is Brentwood.   
Set to =WelchAllyn if your default client is the Welch Allyn 
ECG add-on module. 
Please note this setting is case-sensitive. You must 
capitalize the first letter of each word, e.g., Welch Allyn.  

[Diagnosis_Procedure_codes] This section sets the relative linking options for 
problem/diagnosis codes. 

InsertRelativeDxNumber= When you use the Insert Problem/Diagnosis Code screen 
to add a problem or diagnosis code to a note, Patient 
Records will either: 

 Insert a label for the relative number, if 
AutoNumberRelativeNumber=OFF. 

 Insert the relative number based on how many 
.MP, .OP, .DX, MP2, .OP2, and .DX2 lines precede 
the insertion, if AutoNumberRelativeNumber=ON. 

AutoNumberRelativeNumber= If InsertRelativeDxNumber=ON, Patient Records will insert 
the relative number based on how many .MP, .OP, .DX, 
MP2, .OP2, and .DX2 lines precede the insertion. For 
example, if you insert two .MP lines and one .DX line (in 
that order), the first .MP line will have a relative number of 
1, the second .MP line will have a relative number of 2, and 
the .DX line will have a relative number of 3. 

PRCodetoInsert= Replace ### with the new procedure code (.PR3 to .PR10) 
that you want to automatically insert when you use the 
Insert Procedure Code screen (accessed from the tool bar 
or menu). 

PC_TC=  This setting should not be changed in the PPart.ini file. 
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UseOfficeCode= The default =ON. With this set to ON, the Office Code for a 
problem or diagnosis is used in a progress note or text 
area when dot codes of .MP, .OP, .DX, or .PR are used. For 
example, with an office code of "stone" where the 
Standard Code is 592.00, when creating a .MP, you would 
get: 
.MP:  calculus of kidney : stone 
instead of: 
.MP: calculus of kidney: 592.00 
The Electronic Encounter Form and Order Entry diagnosis 
codes run off Office Codes, so if you use either EEF or OE, 
you should keep the setting =ON. 
Note that Patient Records only stores the Standard Code in 
the problem list table (major problems, other problems, 
diagnoses, procedures) this will be done automatically 
when a note is saved. 

[QuickText] These settings affect Patient Records' QuickText feature. 

Autorefreshifnew= To improve QuickText performance, Patient Records 
always keeps the QuickText screen available in the 
background, and does not reread the QuickText table. 
When you add QuickText, Patient Records automatically 
refreshes the QuickText screen. At some sites, this may 
cause performance issues. You can turn off the automatic 
refresh feature by changing a setting in the PPart.ini file. If 
you turn off this feature, you will not see new QuickText 
that has been added until you exit the program and log 
back in.  
If this setting =ON, the QuickText screen will automatically 
be refreshed. 
If this setting =OFF, the QuickText screen will not be 
automatically refreshed. You must manually refresh the 
screen to view QuickText added after you open the screen.

PositionToText= This allows QuickText to work properly in notes and 
should not be changed in the PPart.ini file. 

[PatientEducation] 
DBPath= 
DBUserID= 
DBPassword= 

These settings are set when you install Patient Education. 
They specify the name, user ID, and password for the 
Patient Education database. 

IgnorePVIDForNoteAppend=  If this setting =ON, the Provider ID in the note is ignored 
and the Patient Education hand-out append will be added 
to any progress note for the day. 
If this setting =OFF, only note(s) for the particular Provider 
ID that printed or e-mailed the Patient Education handout 
will be appended too. 
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ExitCareInstalled= Specifies whether ExitCare can be accessed from Patient 
Records. This setting must be set to ON to enable ExitCare 
integration. 
If this setting =ON, operators can launch ExitCare from 
Patient Records.  
If this setting =OFF, operators will receive a warning 
message when they attempt to launch ExitCare from 
Patient Records. 

ExitCareClient= Specifies the location and name of the ExitCare executable 
file. 
Enter a path and file name, for example 
C:\ExitCare\exitcare.exe. 

Important: This file must be accessible from the Patient 
Records workstation. 

ExitCareDataPath= Specifies the location on the local Patient Records 
workstation in which to store the data files used in ExitCare 
integration. 
Enter a local path, for example C:\ExitCare\data. 

Important: This must be a location on the local Patient 
Records workstation, not a network location.  
Patient Records saves files containing demographic data to 
this location so that patient information can be displayed in 
ExitCare. Patient handouts exported from ExitCare are 
temporarily saved to this location before being imported 
into Patient Records and referenced by progress notes. 

ExitCareImportInterval= Specifies how often Patient Records checks the location 
specified by the ExitCareDataPath= setting for files 
exported by ExitCare.  
Enter a number of minutes. The default value is 1. 

ExitCareAdministratorOperator= Identifies the Lytec MD operator who should receive any 
messages related to ExitCare. 
Enter a valid Patient Records operator ID. 

Note: The specified operator will receive messages 
through the Patient Records messaging system when there 
are problems deleting exported files from the 
ExitCareDataPath= folder. If you receive this message, 
manually delete the exported .mqe files from the data 
folder. 

[Orders] These settings apply to Order Entry. It is recommended 
that you determine Order Entry settings in Special 
Features; most settings can be made there on the Order 
Entry 1 tab. 
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VerticalAppend= This setting applies when you enter an order on the Order 
<New> screen, and a copy of the order is added 
automatically to the patient's progress note.  
If this setting =ON, orders will display vertically in the note. 
If this setting =OFF, orders will display horizontally in the 
note.  

IncludeExtended= This setting applies when you enter an order on the Order 
<New> screen, and a copy of the order is added 
automatically to the patient's progress note.  
If this setting =ON, the order name and extended order 
information will display in notes.  
If this setting =OFF, only the order name will display in 
notes.  

IncludeAllUrgency= This setting applies when you enter an order on the Order 
<New> screen, and a copy of the order is added 
automatically to the patient's progress note.  
If this setting =ON, the order urgency will display in notes.  
If this setting =OFF, the order urgency will not display in 
notes.  

IncludeSTATUrgency= This setting applies when you enter an order on the Order 
<New> screen, and a copy of the order is added 
automatically to the patient's progress note.  
If this setting =ON, the order urgency will display in notes 
only when the urgency is STAT.  
If this setting =OFF, the order urgency will not display in 
notes.  

Electronic_Order1= 
Electronic_Order2= 
Electronic_Order3= 

This setting applies to electronic Order Entry interfaces. 
Each interface must have an electronic form name, which 
you assign using this setting.  
xx = a number between 1 and 99 (this will be the form 
number, starting with 1)  
yyyy = the name of the electronic order form  
For example:  
Electronic_Order1=HL7  
Electronic_Order2=LabCorp  
Electronic_Order3=Quest  

RetrievePvidsFromNote= This setting applies if you are using Dot codes to enter an 
order.  
If this setting =ON, Order Entry will populate the order 
with the providers listed in the note's .PV line.  
If this setting =OFF, only the providers listed in order Dot 
codes will populate the order.  
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ReportPrintPreview= This setting applies to printing order reports.  
If this setting =ON, the print preview screen will appear 
when you print order reports. This screen displays the 
report as it will look when printed. Using this preview, you 
can decide whether to print the report or not.  
If this setting =OFF, the print preview screen will not 
appear. When you print orderreports, they will 
automatically be sent to the default Order Entry printer. 
One copy will print.  

Print_ABN_Cost= This setting applies to printing Advance Beneficiary Notice 
(ABN) forms.  
If this setting =ON, the order cost will print on Advance 
Beneficiary Notice (ABN) form.  
If this setting =OFF, the order cost will not print on the 
ABN form. 

Print_ABN_Date= This setting applies to printing Advance Beneficiary Notice 
(ABN) forms.  
If this setting =ON, the current date will print on Advance 
Beneficiary Notice (ABN) form.  
If this setting =OFF, the current date will not print on the 
ABN form.  

RefreshCount= This setting applies to automatically refreshing the Order 
Processing screen. You can use this setting to turn off the 
automatic refresh feature if the refresh will lead to a 
significant delay in screen response.  
To avoid significant on screen delays caused by rereading 
the database, this setting can be used to turn off the 
automatic refresh if too many records need to be read. 
The value is based on the total number of records you 
have reviewed in your Order Processing session. Once the 
total number of records exceeds this number, then no 
automatic refresh will occur. You will need to close the 
Order Processing screen and re-open it for automatic 
refresh to start up again.  
The setting must be greater than the number of records on 
one screen for any refresh to occur at all. We recommend 
setting the value to at least 20, although values of 100 or 
more are OK. If you want to turn the refresh feature off, set 
this value to 1.  
Processors can manually refresh the Order Processing 
screen by selecting Window > Refresh.  
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ProcessorRefresh=  This setting applies to how often to automatically refresh 
the Order Processing screen. You can use the 
ProcessorRefresh setting to automatically refresh the 
review screen every x seconds, where x is the value of 
ProcessorRefresh.  
Please note that automatic refresh may be turned off if the 
RefreshCount setting is too low.  
If this setting =0 (or if the setting is not present in the 
PPart.ini file), the Order Processing screen will not be 
automatically refreshed. This means that Order Entry will 
not re-read the orders table, and processors will not see 
new orders that have been added since they opened the 
review screen.  
If this setting =x (where x is a number greater than 1) the 
Order Processing screen will be automatically refreshed 
every x seconds. Larger sites may experience a 
performance issue if the Order Processing screen is 
refreshed too frequently.  
Processors can manually refresh the Order Processing 
screen by selecting Window > Refresh.  

TdlLog= This option is used with the Text Data Loader.  
If this setting =ON, when you use the Text Data Loader to 
receive results electronically, an error message will display 
if a matching order is found but one of the following 
situations exists:  

 The order has already been marked as completed. 
 The order is currently marked as denied, 

suspended, approved, or pending.  
 The order is locked by another user and cannot be 

edited right now.  
If this setting =OFF, no error message will display.  

NewOrderBlankInsurance= This setting applies to the Order <New> screen. 
If this setting =ON, the insurance field will default to blank. 
If this setting =OFF, the insurance field will default to the 
patient's primary insurance. 

NewOrderWarnOnNoInsurance= This setting applies to the Order <New> screen. 
If this setting =ON, a warning will display when a new 
order is created for a patient with no insurance. This 
setting is helpful if you are using electronic encounter 
forms or outbound lab interfaces. 
If this setting =OFF, no warning will display. 
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CheckDuplicates= This setting determines whether Lytec MD will check for 
duplicate orders within a specified number of days.  
This check is made when an order is moved from the order 
tree to the order list (on the Order screen). If duplicates are 
found, a warning message appears. Since you can 
legitimately add duplicate orders, you can either go ahead 
and add the duplicate order (click the OK button on the 
message) or cancel the order (click the Cancel Order 
button). 
This feature also works when orders are added through 
Dot codes. It does not currently work when orders are 
added through the Text Data Loader. 
The format for this setting is 
CheckDuplicates=ON/OFF,#_of_days 
If you want to check for duplicate orders, the setting 
should be =ON followed by a comma and the number of 
days you want checked. For example, if you want Lytec MD 
to search for duplicate orders within the past three days, 
the setting should be CheckDuplicates=ON,3 
If this setting =OFF, no duplicate checking will occur. 

OrdersDefaultLabel= This setting defines the default label that should be used 
for orders. 

ABNCopies=2 This setting defines how many medical necessity forms 
(also known as Advance Beneficiary Notice, or ABN) 
should print if the patient's insurance company will not pay 
for the test. 

TrackABNSign= This setting defines whether a screen that verifies that the 
patient signed the ABN should display when an ABN is 
printed. This verification can also be added or changed 
manually when editing an order. 
If this setting =ON, the screen displays after the ABN is 
printed.  
If this setting =OFF, the screen will not display. 

CancelledOrder= Configurable in Special Features on the Order Entry 1 tab, 
this setting determines which of your order forms should 
be used for canceled orders. To use Order Entry, you must 
specify an order form for canceled orders. 

DontPrintOrdersOnSend= Set this to =ON if you don't want to automatically print an 
order when it is sent. 

PromptForGroup= Configurable in Special Features on the Order Entry 1 tab, 
when enabled, this setting prompts a user whether to 
process all orders for a grouped facility when processing 
one order belonging to the group. Orders can be grouped 
by entering a Group Type when adding or editing an 
Order Name. 
If this setting =ON, a message displays when processing 
one order for a grouped facility. If the response to the 
message is Yes, then Grouped Orders displays with orders 
sharing the same patient ID, date, and group type. 
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SendProcedureToEEFForPendingOrder
s= 

Configurable in Special Features on the Order Entry 2 tab, 
this setting specifies when electronic encounter forms are 
created for orders. 
If this setting = ON, EEFs will be created when an order's 
status is set to Pending or Suspended. 
If this setting =OFF, EEFs will be created when an order's 
status is set to Sent. 

ShowAllPracticeOrders= This setting allows you to specify whether you want to 
display orders from all practices or only orders from the 
logon practice on the Provider Orders screen, Order 
Processing Select screen, and Overdue Orders screen.  
If this setting =ON, orders from all practices, not just the 
logon practice will be displayed on the Provider Orders 
screen, Order Processing Select screen, and Overdue 
Orders screen. 
If this setting =OFF, orders from only the logon practice 
will be displayed on the Provider Orders screen, Order 
Processing Select screen, and Overdue Orders screen. 

RequireProviderForOrders=  This setting controls whether a provider is required to 
place an order from the Order <New> and Order <Edit> 
screens. If required, a provider must be entered in the 
Ordered by field.  
When this setting =ON, a provider must be entered in the 
Ordered by field on the Order <New> and Order <Edit> 
screens.  
When this setting =OFF, a provider is not required to place 
an order. OFF is the default setting.  

Note: If Lytec MD is configured to require a signature for 
orders (this is done in PRUtils, by checking the Orders 
check box on the Signature tab), a provider will always be 
required to place an order, regardless of this setting. 

RequireDiagnosisForOrders= This setting controls whether a diagnosis is required to 
place an order from the Order <New> and Order <Edit> 
screens. If required, at least one diagnosis code must be 
selected from the Diagnosis drop-down lists. 
When this setting =ON, you must select at least one 
diagnosis code from the Diagnosis drop-down lists on the 
Order <New> and Order <Edit> screens. 
When this setting =OFF, a diagnosis is not required to 
place an order. OFF is the default setting.  
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[NoteCategories] 
PatientCategory1=Call 
PatientCategory2=Reminder 
GuarantorCategory1=Call 
GuarantorCategory2=Collection 
GuarantorCategory3=Reminder 
GuarantorCollCat1=New 
GuarantorCollCat2=1st Contact 
GuarantorCollCat3=2nd Contact 
GuarantorCollCat4=3rd Contact 

These settings define the categories available for patient 
and guarantor notes. 
You can add a new note category by using the next 
consecutive number in the appropriate section (patient or 
guarantor). For example, to add patient and guarantor 
categories of Follow-up, you would add PatientCategory3 
and GuarantorCategory4 lines: 
[NoteCategories] 
PatientCategory1=Call 
PatientCategory2=Reminder 
PatientCategory3=Follow-up 
GuarantorCategory1=Call 
GuarantorCategory2=Collection 
GuarantorCategory3=Reminder 
GuarantorCategory4=Follow-up 

[Lytec]  

BlueHighlightOnRefresh= When the "Indicate presence of data on Patient Chart 
Menu" option on the Special Features > Records 1 tab is 
marked, the go to menu (at the bottom of the chart's 
screen) displays highlighted sections of the chart that 
contain data for the current patient.   
This check happens when the patient chart is first opened. 
If this option is not marked, the sections on the go to menu 
are normally not highlighted, because Lytec MD does not 
check for patient data. 
However, if the option is not marked, you can use this 
setting to have Lytec MD check for patient data when the 
screen is refreshed. 
If this setting =ON, the check occurs when the screen is 
refreshed, and the appropriate sections of the go to menu 
are highlighted. 
If this setting =OFF, the check does not occur, and no 
sections are highlighted. 

StartMaximized= Configurable in Special Features on the General tab. When 
enabled, this setting will maximize Lytec MD on start up.   
If this setting =ON, Lytec MD will open in a maximized 
window. 
If this setting =OFF, Lytec MD is not maximized when 
opened. 
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ShowProviderPracticeOnLoginScreen= This setting controls whether the Provider ID and Practice 
ID fields are displayed on the Lytec MD Sign In screen and 
the Lytec MD Sign In – Park screen.  
If this setting =ON, the Provider ID and Practice ID fields 
will be displayed on the Lytec MD Sign In screen and the 
Lytec MD Sign In – Park screen. When these fields are 
present, users must select their Provider and/or Practice to 
login. This is the default setting.  
If this setting =OFF, the Provider ID and Practice ID fields 
will not be displayed on the Lytec MD Sign In screen and 
the Lytec MD Sign In – Park screen. 
See the Logging on to Lytec MD section and the Parking 
Workstations section for more information.  

[Demographics] These settings apply to demographic options. Most of the 
settings should not be changed in the PPart.ini file. Many 
of these settings are defined through the Maintenance 
menu. 

GuideDefault=DEFAULTGUIDE This setting should not be changed in the PPart.ini file. 

PatSexItems=M,F This setting should not be changed in the PPart.ini file. 

RaceEnable= This setting should not be changed in the PPart.ini file. 

RaceItems=American-Indian, 
Eskimo-Aleut,Asian-Pacific 
Islander,Black,White 

This setting defines the races available for selection from 
the Race field on the Patient screen (this field is activated 
through the Demographic Settings screen). 
If required, you can edit the values in the list, and add new 
values. The first five characters of any custom values added 
to this setting must be unique. Separate values with 
commas. 

EthnicityItems01=Hispanic,Non-
Hispanic 

This setting should not be changed in the PPart.ini file. 

MaritalItems=S,D,M,W,O This setting should not be changed in the PPart.ini file. 

PatStatusItems=Active,Inactive, 
Deceased 

This setting should not be changed in the PPart.ini file. 

PatGreetingDefault= This setting should not be changed in the PPart.ini file. 

EmployerCodeItems=Y,N,R,1,2,3, 
4,5,6,7,8,9 

This setting should not be changed in the PPart.ini file. 

SchoolCodeItems=F,P This setting should not be changed in the PPart.ini file. 

SchoolDefault= This setting should not be changed in the PPart.ini file. 

CountyEnable= This setting should not be changed in the PPart.ini file. 

CountyDefault= This setting should not be changed in the PPart.ini file. 
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StateDefault= This settings should not be changed in the PPart.ini file.

StateList1=AK,AL,AR,AZ,CA,CO, 
CT,DC,DE,FL,GA,HI,IA,ID,IL,IN, 
KS,KY,LA,MA,MD,ME, MI,MN,MO, 
MS,MT 

This setting should not be changed in the PPart.ini file. 

StateList2=NC,ND,NE,NH,NJ,NM, 
NV,NY,OH,OK,OR,PA,PR,RI,SC,SD, 
TN,TX,UT,VA,VT,WA,WI, WV,WY 

This setting should not be changed in the PPart.ini file. 

CountryEnable= This setting should not be changed in the PPart.ini file. 

CountryDefault= This setting should not be changed in the PPart.ini file. 

CheckForDupePat= This setting should not be changed in the PPart.ini file. 

CarrierInfoDefault= This setting should not be changed in the PPart.ini file. 

VisitCounterDefault= This setting should not be changed in the PPart.ini file. 

VisitCounterChange= This setting should not be changed in the PPart.ini file. 

AddInfoType=Alias,1st Type,2nd 
Type,3rd Type 

Lytec MD is configured with four patient information types: 
Alias, 1st Type, 2nd Type, and 3rd Type. These types are 
placeholders, and you should modify them to meet your 
needs. The [Demographics] section of the PPart.ini file has 
the following line: 
AddInfoType=Alias,1st Type,2nd Type,3rd Type 
You can change these types or add additional types. For 
example, you might have: 
AddInfoType=Alias,Summer Home,Winter Home,Next of 
Kin 
Be careful about changing or deleting the types once you 
start using Lytec MD. Once data has been entered for a 
type, the data can be retrieved only if that type still exists in 
the PPart.ini file. 
Types are used on the Additional Patient Information 
screen. 

CountryList=USA,CAN If necessary, you can add to the list that displays in the 
Country field on demographic screens.  

ParkPreventWindowSwitch= When this setting =ON, you prevent the use of a Parked 
workstation by displaying another Window. ALT-TAB and 
other screen switching options will be disabled during 
Park.  
When this setting =OFF, window switching remains 
enabled on the workstation.  

LocalAreaCode= This setting should not be changed in the PPart.ini file. 

GeneralLookupDefault= This setting should not be changed in the PPart.ini file. 

NameLookupDefault= This setting should not be changed in the PPart.ini file. 
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IDLookupDefault= This setting should not be changed in the PPart.ini file. 

DisplayInactiveAcctPlan= This setting should not be changed in the PPart.ini file. 

UseRecentAcctList= This setting should not be changed in the PPart.ini file. 

RecentAcctListCount= This setting should not be changed in the PPart.ini file. 

RefAuthFromType= This setting should not be changed in the PPart.ini file. 

RefAuthToType= This setting should not be changed in the PPart.ini file. 

DisplayAttendingProv= This setting should not be changed in the PPart.ini file. 

PatHOHDefaultToAcct= This setting should not be changed in the PPart.ini file. 

UseHOHAddrForPatAddr= This setting should not be changed in the PPart.ini file. 

WarnAddrOrPhone= This setting should not be changed in the PPart.ini file. 

CheckForDupeGuar= This setting should not be changed in the PPart.ini file. 

RefAuthCarrierVisit= This setting should not be changed in the PPart.ini file. 

TrackVisitsBy= This setting should not be changed in the PPart.ini file. 
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LookupColumns=BirthDate,SSN, 
Telephone,Sex,Provider, 
Practice,HOHID,AcctType,Address 

This setting configures the order in which the result 
columns display on the Lookup screen. The columns are: 

Account # 
Name 
ID 
Alternate ID (only if searching by alternate ID on the 
ID tab) 
Type 
Birth Date 
SSN 
Telephone 
Sex 
Provider 
Practice 
HOH ID 
Acct Type 
Address 

The order of the first five columns (listed in bold) are set, 
and cannot be changed. 
To change the order of the remaining nine columns can be 
changed using this setting in the PPart.ini file. These rules 
apply: 

 The column names must appear exactly as listed in 
the PPart.ini file 
(BirthDate,SSN,Telephone,Sex,Provider, 
Practice,HOHID,AcctType,Address). 

 A comma must separate each item. 
 All nine items must be listed in the PPart.ini file. 

If the PPart.ini file is not edited correctly, the default order 
listed above will be used. 

DisplayFinSumTabMonthAging= This setting should not be changed in the PPart.ini file. 

SigOnFileDefaultDate= This setting should not be changed in the PPart.ini file. 

DisplayTotalsForPractice= This setting should not be changed in the PPart.ini file. 

ShowPaidCharges= This setting should not be changed in the PPart.ini file. 

EnterKeyMovePaymentsAmount= This setting should not be changed in the PPart.ini file. 

ColorPatientPayments=Magenta This setting should not be changed in the PPart.ini file. 

ColorInsurancePayments=Red This setting should not be changed in the PPart.ini file. 

ColorAdjustments=Yellow This setting should not be changed in the PPart.ini file. 

ColorLedgerNotes=Black This setting should not be changed in the PPart.ini file. 

ShowLedgerAcctOpen= This setting should not be changed in the PPart.ini file. 

DefaultLabel= This setting should not be changed in the PPart.ini file. 

OpenLastTabCloseLedger= This setting should not be changed in the PPart.ini file. 
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ProvSigShort= This setting applies to provider signatures (set on the 
provider maintenance screen). You can indicate whether 
signatures should be six characters or nine characters. 
Provider signatures cannot use the same digit more than 
two times (for example, 1234 and 12234 are valid, but 
122234 is not). 
If this setting =ON, the provider signature is limited to six 
characters, and specifically, to numbers below 32,000. 
If the setting =OFF, the provider signature can be up to 
nine characters (up to the number 999,999,999). 

PrvTypeItems= These define the values listed in the Provider Maintenance 
General 2 tab, Type field. They indicate the type of 
provider, such as Physician's Assistant, Resident, etc. and 
are for internal reference.  

ClaimTypes= Do not change these settings in the PPart.ini file. 

CarrierReportGroups= These define the values listed in the Report Group field on 
the Carrier Maintenance General 1 tab. You can use the 
field to sort carriers into groups on custom reports and 
other reports. 

LimitPracticeIDLength= Do not change these settings in the PPart.ini file. 

DisplayLedgerAmtScreen= Do not change these settings in the PPart.ini file. 

EffectiveDateFirstDay=OFF 
 
 

This setting is configured in the Demographic Settings 
screen. 
This setting determines the default value of the Effective 
Date field in the Account Insurance Plan <New> screen. 
If set to ON, the default Effective Date for new account 
insurance plans will be the first day of the current year. 
If set to OFF, the default Effective Date for new account 
insurance plans will be blank. 
The default value of this setting is OFF. 

RecallDateActive= This setting is configured in the Demographic Settings 
screen. 
This setting determines the default value of the Date 
Active field in the Patient Recall <New> screen when a 
new patient recall is added. The default Date Active will be 
the system date plus the number of days specified by this 
setting. 
The default value of this setting is blank. Valid values are 
numbers from 1 to 365. If this setting is blank, no default 
Date Active will be displayed in the Patient Recall <New> 
screen. 

GeneralLookupDefault= Specifies the default search type for the General tab of the 
Lookup screen in Patient Records. 
This setting is configured in the Demographic Settings 
screen and should not be changed in the PPart.ini file. 
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NameLookupDefault= Specifies the default search type for the Name tab of the 
Lookup screen in Patient Records. 
This setting is configured in the Demographic Settings 
screen and should not be changed in the PPart.ini file. 

IDLookupDefault= 
 

Specifies the default search type for the ID tab of the 
Lookup screen in Patient Records. 
This setting is configured in the Demographic Settings 
screen and should not be changed in the PPart.ini file. 

ProviderRoleList=PROVIDER ROLE  Specifies the name of the Lytec MD List that contains 
different types of provider roles. 
The options in the specified list can be selected from the 
Provider Role field in the Patient Internal Provider screen 
when associating a provider with a patient. 
You can use List Maintenance to edit the default PROVIDER 
ROLE list, or set up a new list of provider roles. 

DefaultAgeExpression= 
 

You can add this setting to the PPart.ini file to specify the 
default age expression if an age range is not explicitly 
specified for a patient. The default is Years. After the =, 
type the new default age expression. Your options are: 

• YEARS 

• YEARS_MONTHS 

• YEARS_MONTHS_DAYS 

• MONTHS_DAYS 

• WEEKS_DAYS 

• DAYS_HOURS 

See the Age Expression section for more information.  

[DemographicIDs] 
IDLength= 
GenIDFromAccountID= 
AccountIDPrefix= 
GuarantorIDPrefix= 
PatientIDPrefix= 
AccountIDStart= 
GuarantorIDStart= 
PatientIDStart= 
AccountIDIncrement= 
GuarantorIDIncrement= 
PatientIDIncrement= 

Do not change these settings in the PPart.ini file. 
 

[PatientFiles]  
BasePath=C:\PPart\Photo\ 
FolderLevels=3 
FolderLimit=30 
FileLimit=50 

Do not change these settings in the PPart.ini file. 
These settings apply to photos and images you can attach 
to patients through the Patient screen. 

[DialingSettings] These settings apply to the phone dialer. You can set 
additional options in the phone.ini file. 
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LocalAreaCodes= Type the area codes that are local to your practice. Use a 
comma between each area code (for example, 
LocalAreaCodes=206,425).  

LocalAreaPrefixes1= Type the prefixes (the first three numbers in a phone 
number) that are local to your practice. Use a comma 
between each prefix (for example, 
LocalAreaPrefixes1=418,692).  

LocalAreaPrefixes2= Type additional prefixes (the first three numbers in a 
phone number) that are local to your practice. Use a 
comma between each prefix (for example, 
LocalAreaPrefixes2=987,876,321).  

InStateAreaCodes= If you have an in-state long distance calling program, type 
the non-local area codes for your state. Use a comma 
between each area code (for example, 
InStateAreaCodes=360). 

PrefixOverride= If PrefixOverride=ON, the prefix entered in the 
workstations phone.ini will be used. If no prefix is entered 
in the phone.ini, the prefix entered in the telephone field 
on the General tab will be used.  
If PrefixOverride=OFF, the prefix entered in the telephone 
field on the General tab will be used. If the phone number 
does not have a prefix, the prefix entered in the 
workstations phone.ini will be used.  

SuffixOverride= If SuffixOverride=ON, the suffix entered in the workstations 
phone.ini will be used. If no suffix is entered in the 
phone.ini, the suffix entered in the telephone field on the 
General tab will be used.  
If SuffixOverride=OFF, the suffix entered in the telephone 
field on the General tab will be used. If the phone number 
does not have a suffix, the suffix entered in the 
workstations phone.ini will be used.  

[EEF] The settings in this section apply to electronic encounter 
forms (EEF). 

ExpandedCategories= When you set up your electronic encounter form 
templates, you can add multiple categories that store 
related procedure or diagnosis codes. The 
ExpandedCategories setting is used to determine how 
many categories should be open when you access the 
Electronic Encounter screen. The default is 3, which means 
that the first three categories would display all the codes in 
the category. Additional categories display as closed 
folders below the open categories. This setting keeps you 
from having to scroll through a lengthy list of categories 
and codes. 
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EEFUseSmallFont= You can change the font size of the diagnosis and 
procedure codes that display on the electronic encounter 
form screen. The default size is 8 point. The smaller size (6 
point) will increase the amount of text that is visible, 
although you can also use the "tool tip" feature to view text 
that is off the screen (a "tool tip" is visible when you hold 
the cursor over the text).  
If this setting =N, the larger font size will be used. 
If this setting =Y, the smaller font size will be used. This 
means that more of the procedure code description to be 
visible 

Write_Dx_Codes_NoProc= This setting is used by the electronic encounter forms 
feature and the Text Data Loader, and applies when an 
electronic encounter form is added from a progress note. 
If this setting =ON, and the note does not include a 
procedure code, the diagnosis code will be added to the 
electronic encounter form. 
If this setting =OFF, and the note does not include a 
procedure code, the diagnosis code will not be used to 
the electronic encounter form. 

RefreshEEF= This setting is used by the electronic encounter forms 
feature to automatically refresh the list of electronic 
encounter forms on the Electronic Encounter Select 
screen. 
The default is 120 seconds. If necessary, you can change 
this number, or delete the number to turn off the automatic 
refresh function. 

ApplyDefaultDX= This setting controls whether the default diagnosis 
codes(s) selected for the procedure codes in the 
Procedure Code Maintenance screen will be selected as 
the default diagnosis code(s) when creating or editing an 
electronic encounter form.  
When this setting =ON, the default diagnosis code(s) 
selected for the procedure codes in the Procedure Code 
Maintenance screen will be selected as the default 
diagnosis codes. The default codes will be displayed 
under the procedure in the Procedure Selection box on 
the Electronic Encounter screen. The default code(s) will 
also populate the <Edit> screen’s Diagnosis Code fields 
when you double-click the procedure in the Procedure 
Selection box. 
When this setting =OFF, the default diagnosis code(s) 
selected for the procedure codes in the Procedure Code 
Maintenance screen will not be selected as the default 
diagnosis code(s).  
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[Messaging] 
InboxAutoArchive= 
SentAutoArchive= 
IncludeOriginalReply= 
MessageListAutorefresh= 
MessageButtonAutorefresh= 
ShowBlindCopyLine= 
Store_Message_In= 
LabReviewTemplate= 
CheckInMessageOperator 

The settings in this section apply to the messaging feature.

InboxAutoArchive= This setting defines whether messages in the Inbox should 
be archived, and if so, the age of messages to be archived. 
When set, Lytec MD will ask the operator whether the 
messages should be archived. Archived messages are 
stored in the Archived folder.  
To turn on this feature, use the following format: 

InboxAutoArchive=ON,xxx 

where xxx is the age of messages to be archived.  
For example, InboxAutoArchive=ON,10 indicates that the 
feature is turned on, and that messages in the Inbox more 
than 10 days old should be archived. 
To turn off this feature, use the following format: 

InboxAutoArchive=OFF 

SentAutoArchive= This setting defines whether messages in the Sent folder 
should be archived, and if so, the age of messages to be 
archived. When set, Lytec MD will ask the operator 
whether the messages should be archived. Archived 
messages are stored in the Archived folder.  
To turn on this feature, use the following format: 

SentAutoArchive=ON,xxx 

where xxx is the age of messages to be archived.  
For example, SentAutoArchive=ON,10 indicates that the 
feature is turned on, and that messages in the Sent folder 
more than 10 days old should be archived. 
To turn off this feature, use the following format: 

SentAutoArchive=OFF 
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IncludeOriginalReply= This setting defines whether the original message should 
be automatically included when an operator replies to a 
message. 
If this setting =ON, the original message will be 
automatically included when an operator replies to a 
message. When a message is recorded, the original 
message and the reply are automatically recorded. 
If this setting = OFF, the original message will not be 
automatically included. When a message is recorded, the 
operator is asked whether to record the entire sequence of 
messages (original message and reply) or only the current 
message. 

MessageListAutorefresh= This setting defines how often the Msg (Message) button in 
the tool bar should be refreshed.  
To configure this feature, use the following format: 

MessageButtonAutorefresh=xxx 

where xxx is the number of seconds before the Msg button 
should be refreshed. The default is 60 seconds. 

MessageButtonAutorefresh= This setting defines how often the Msg (Message) button in 
the tool bar should be refreshed.  
To configure this feature, use the following format: 

MessageButtonAutorefresh=xxx 

where xxx is the number of seconds before the Msg button 
should be refreshed. The default is 60 seconds. 

ShowBlindCopyLine= This setting defines whether the blind copy (or Bcc) line 
should appear on the new/view message screen. 
Operators can use the Bcc line to send a copy of the 
message to an operator without the other message 
recipients knowing the person received the message. 
To turn on this feature, use the following format: 

ShowBlindCopyLine=ON 

To turn off this feature, use the following format: 

ShowBlindCopyLine=OFF 

Store_Message_in= This setting defines where messages are stored when the 
operator clicks the Record button.  

Caution! 
This setting should be changed only through the Records 
1 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 

CheckInMessageOperator= Specifies the ID of the operator who will receive messages 
when a patient using Web View to check-in for an 
appointment changes their demographic information or 
indicates that their insurance/billing information has 
changed. 
The value of this setting can also be specified in the Site 
Administration screen in Web View. 
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[HealthMaintenance] The settings in this section apply to health maintenance. 

New_Design=Yes This setting indicates that the new health maintenance 
features are being used. Do not change this setting from 
=Yes. 

Problem_List_Protocol= This setting indicates whether a health maintenance 
template should be automatically assigned when a 
problem is added through the problem list, if the problem 
name matches the health maintenance template's name.  
If this setting =ON, templates are automatically assigned to 
patients that meet the template's criteria when problems 
are assigned on the chart's problem list, if the problem 
name is the same as the template name. 

Problem_Note_Protocol= This setting indicates whether a health maintenance 
template should be automatically assigned when a 
problem is added through a progress note, if the problem 
name matches the health maintenance template's name.  
If this setting =ON, templates are automatically assigned to 
patients that meet the template's criteria when problems 
are assigned in a note, if the problem name is the same as 
the template name. 

Medication_Protocol= This setting indicates whether a health maintenance 
template should be automatically assigned when an Rx is 
added through the Rx/Medications tab in the patient chart, 
if the medication name matches the health maintenance 
template's name.  
If this setting =ON, templates are automatically assigned to 
patients that meet the template's criteria when Rx are 
written on the Rx/Medications tab, if the medication name 
is the same as the template name. 

Medication_Note_Protocol= This setting indicates whether a health maintenance 
template should be automatically assigned when an Rx is 
added through a progress note, if the medication name 
matches the health maintenance template's name.  
If this setting =ON, templates are automatically assigned to 
patients that meet the template's criteria when Rx are 
written through progress notes, if the medication name is 
the same as the template name. 

TextDataLoaderMedProtocol= 

TextDataLoaderProbProtocol= 

If these settings =ON, health maintenance protocols are 
automatically loaded for prescriptions and diagnoses. For 
this to work, the other HM protocols must be enabled. 
If these settings =OFF, the protocols will not be 
automatically loaded.  

Status_R_Effectively_Means_Status_N= This setting applies to the status of health maintenance 
procedures, and whether procedures have been 
performed or not. 
If this setting =YES, the status for refused (R) means that 
the procedure was not performed.  
If this setting =NO, the status for refused (R) means that the 
procedure was performed. 
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Status_O_Effectively_Means_Status_X= This setting applies to the status of health maintenance 
procedures, and whether procedures have been 
performed or not. 
If this setting =YES, the status for ordered (O) means that 
the procedure was not performed. 
If this setting =NO, the status for ordered (O) means that 
the procedure was performed. 

Use_Patient_Reg_Date= Configurable in Special Features on the Records 1 tab, this 
setting applies to whether the patient registration date 
should be used as the start date for the Do Every Rule 
setting in health maintenance. 
If this setting = ON, the date the patient was registered in 
Lytec MD will be used as the start date for Do Every Rule. 
If this setting = OFF, the patient's birth date will be used as 
the start date. 

Result_X=Done 
Result_R=Refused 
Result_E=Done Elsewhere 
Result_N=Not Applicable 
Result_P=Postponed 
Result_O=Ordered 

These settings "translate" the status of health maintenance 
procedures when they are used as part of the .HM Dot 
code. 
When these settings appear in the PPart.ini file, and the 
.HM Dot code is used in a progress note, the procedure's 
status displays as the full text (Done, Refused, etc.) instead 
of the one-letter character (X, R, etc.). 

ActiveReminder= 
 

Configurable in Special Features on the Records 6 tab, 
Enable Active Health Maintenance Reminders.  
If this setting =ON, overdue health maintenance items for a 
patient are displayed when opening that patient's chart.  
If this setting =OFF, overdue health maintenance items will 
not be displayed when opening the patient's chart. 

UsePrimaryProviderAgeSexTemplate=  If this setting =ON, Lytec MD will look for the appropriate 
age/sex template from the primary provider. If the 
template does not exist, the universal age/sex template is 
used. This setting applies to all automatic applications 
including birth date routine. 
If this setting =OFF, providers can manually apply their 
own age/sex templates to a patient.  A patient is not 
allowed to have more than one age/sex template at a time.

AllowProviderAgeSexTemplates= If this setting =ON, provider based age/sex templates are 
allowed. 
If this setting =OFF, provider based age/sex templates are 
not allowed. 
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SummaryShowTemplate= Configurable in Special Features on the Records 6 tab. This 
setting controls whether a patient's health maintenance 
template name will be displayed in a column on the Health 
Maintenance Summary screen. 
If this setting =ON, the column will be shown on the Health 
Maintenance Summary screen.  
If this setting =OFF, the column will not be shown on the 
Health Maintenance Summary screen. You can still see 
which templates were applied by clicking the Templates 
button. 

UpdateHMVitals= This setting allows you to configure Health Maintenance so 
that entry of data for a Vital Sign on a patient is recognized 
by Health Maintenance as satisfying a Health Maintenance 
Procedure for the patient. The default setting for new sites 
is ON. The default setting for upgrading sites is OFF.  

UpdateHMCE= This setting allows you to configure Health Maintenance so 
that entry of data for a Clinical Element on a patient is 
recognized by Health Maintenance as satisfying a Health 
Maintenance Procedure for the patient. The default setting 
for new sites is ON. The default setting for upgrading sites 
is OFF.  

UpdateHMNoteTitle=ON Configurable on the Records 6 tab of the Special Features 
screen. This setting controls whether health maintenance 
procedures are updated based on information in note 
titles. 
If this setting =ON, Patient Records will automatically set a 
health maintenance procedure's status to Done (X) if the 
title of a progress note matches the name of the 
procedure. This is the default value for this setting. 
If this setting =OFF, information in note titles will not be 
used to update the status of health maintenance 
procedures. 

[DRAGONSPEECH]  
Use_Speech= 

This setting indicates whether you are using the Dragon 
voice recognition add-on module. 
If this setting =ON, the Dragon options in Patient Records 
are enabled. 
If this setting =OFF, the Dragon options are not enabled, 
and you will not be able to use NaturallySpeaking in 
Patient Records. 

[Provider]   

DEFAULT= Specify the default provider code for your practice. 

Prv3Char= 
 

When Prv3Char =ON, provider IDs are limited to 3 
characters. When the setting =OFF, the length is up to 6 
characters.  

[NoteHtml] The following settings apply only if you are using the HTML 
note feature. 
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AppendKLineUsingNewMethod= This setting controls how the .K Dot code is used to enter 
data in the Past Medical History, Social History, and Family 
History sections of the patient chart. If this setting =ON, the 
.K line will be added using the new method. This method 
streamlines how additional content is added to the history 
sections of the patient chart. If this setting =OFF, the .K line 
will be added using the existing method. The default 
setting =OFF for new and existing sites.  
When this setting =ON, the .K Dot code will use the 
following format when there is already existing content for 
the history section of the chart.  

 The .D line will be updated to the present date and 
time. 

 A new line will be created for the existing contents. 
 The new note contents will be added between the 

new line and the updated .D line. 
For example:  
Date: 03/21/08 : 09:14am 
Fracture left elbow 10/2008; repaired with ORIF 
 
01/18/08 : 07:52am 
DVT 1992; recovered without sequelae; 6mos of 
Coumadin 
Brief hospitalization for pneumonia 2001 

Use_Html_Note= This setting should not be changed in the PPart.ini file. 
This setting is set during the installation. If you selected 
during the installation to use HTML notes, this setting 
=ON. If you are using text-based notes, this setting =OFF. 

Parallel_Review= Configurable in Special Features on the Records 4 tab, this 
setting determines whether review data items (except for 
progress notes) are sent simultaneously to the review bins 
for every provider listed on the item.  
If this setting =ON, the item appears simultaneously in the 
review bin for every provider linked to the item. This allows 
the providers to review the items in parallel. 
If this setting =OFF, the item appears in the review bin of 
only the first provider linked to the item. That provider can 
then forward the item to another provider, and so on. Only 
one provider at a time can review the item. 

WhenForwardHaveOriginalSign= This setting determines what happens to a note after it is 
forwarded to another provider. 
If this setting =ON, the note is forwarded and then remains 
in the review bin until the original provider signs it. 
If this setting =OFF, the note is forwarded and then is 
removed from the review bin without being signed. 

ProgressNoteDefaultWidth= This setting is used to set the default width of the progress 
note window. The original setting is 688 pixels. You can 
change the width by editing the number after the equal 
sign. 
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ProgressNoteDefaultHeight= This setting is used to set the default height of the 
progress note window. The original setting is 250 pixels. 
You can change the height by editing the number after the 
equal sign. 

RemoveCategoryText= This setting indicates whether embedded category text in 
HTML notes (i.e., text marked with a .K Dot Code) will be 
removed when the note is saved. 
If this setting =ON, any embedded note text will be 
removed from the note after it is processed. 
If this setting =OFF, the embedded text will remain in the 
note. 

TextTemplatesByPractice This setting defines whether note, letter, and message 
templates can be set up for individual providers or 
practices (that is, whether the Provider or Practice field will 
be available on the template screen). 
If this setting =ON, you can specify an individual practice 
to which the template should be available. You will not be 
able to specify an individual provider. 
If this setting =OFF, you can specify an individual provider. 
You will not be able to specify an individual practice. 

AutoSave= Configurable in Special Features on the Records 3 tab, this 
setting can be used to recover HTML-based progress 
notes that are open when Lytec MD or your computer 
crashes.  
If this setting =ON, progress notes that are open are saved 
to temporary files (*.sav). The file names start with 
AutoSave, and include the operator ID and date/time the 
note was last saved. Once an auto-saved note has been 
correctly saved to the Lytec MD database, the temporary 
file is deleted. 
If this setting =OFF, progress notes are not saved, and are 
not recoverable. 

AutoSavePath= Configurable in Special Features on the Records 3 tab, 
when AutoSave=ON, this setting specifies the directory to 
which the temporary note files will be saved. The directory 
can be any valid drive and path, but the user must have 
access rights to it, and creation/deletion rights for files. 
If no path is specified, the default location is the Lytec MD 
directory. 

AutoSaveIntervalInSeconds= Configurable in Special Features on the Records 3 tab, 
when AutoSave=ON, this setting specifies the interval in 
seconds that open notes will be saved to temporary files. 
If no interval is specified, the default setting is 60 seconds. 
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DisplayAutoSaveDlgAtStartup= When AutoSave=ON, this setting specifies whether a 
screen displays auto-saved notes for the operator when 
the operator logs into Lytec MD. 
If this setting =ON, the screen automatically displays auto-
saved notes, if any exist for the operator. 
If this setting =OFF, no list of auto-saved notes displays at 
login. Operators can access a list of auto-saved notes at 
any time by selecting Task > Auto-Saved Notes. 

HideDeleteLabels= Configurable in Special Features on the Records 2 tab, 
when HideDeleteLabels=ON, this setting will hide all label 
delete (<<DEL>>) markers when adding or editing notes 
and messages. 

GrayUnusedLabels= Configurable in Special Features on the Records 2 tab, 
when GrayUnusedLabels=ON, this setting will make all 
labels above the selected label (the label with focus) gray 
when adding or editing notes and messages. 

GrayDeleteLabelLines= Configurable in Special Features on the Records 2 tab, 
when GrayDeleteLabelLines=ON, this setting will gray all 
label delete (<<DEL>>) markers above the selected label 
(the label with focus). If text is added to a grayed label 
delete marker, the marker will be un-grayed. 

RemoveLabOnPrint= Configurable in Special Features on the Records 2 tab. This 
setting causes lab Dot codes to be temporarily removed 
when printing notes from the editor window using the 
Print button, Complete Chart Print option, Partial Chart 
Print option, and Chart Summary Print option. 
If this setting =ON, when one of the above options is 
selected to print a note, the .L:, .L2:, .CO2: and .BC:  Dot 
codes are temporarily removed from the note text. 

SendCancelledApptNoteToReview= Configurable in Special Features on the Scheduler 2 tab. 
When enabled, Appointment Scheduler will send the 
cancelled or no show appointment note to the review bin.  
If this setting =OFF, the cancelled or no show appointment 
note will not be sent to the providers review bin. 

NoProvForLoaderNoteUseUnivProv=  When results are loaded with no provider (.PV) line, this 
setting defines whether the results will show up in the 
universal or usual providers lab review bin. The default 
setting is OFF.  
If this setting =OFF, and you load lab text (.MS or .MI) or 
text (.T) using the Lab Data Loader or Text Data Loader 
with out a provider line (.PV), the usual provider (defined in 
demographics) will be used as the provider. If the patient 
does not have a designated usual provider, the primary 
provider will be used.  
If this setting =ON, the universal provider will be used if 
there is no provider (.PV) line. 
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UseNativeAppForPLINK= If this setting =ON, the native application will be used 
when a PLINK is opened. For example, if the PLINK points 
to a Word file, the link will be opened up in Word. 
If this setting =OFF, the Lytec MD browser will be used 
when a PLINK is opened.  

RequireNoteTitle= This setting controls whether the operator is allowed to 
save notes without a title. This setting affects all note 
sections of the patient chart, except progress notes. 
Progress notes always require a title. If this setting =ON, 
the operator must enter a title before saving a note. If this 
setting =OFF, the operator can save notes without a title. 
The default setting =ON. 

ProviderSuffixInNoteSig=  
 

Use this setting to determine whether providers' suffixes 
are appended to their name in note signature lines. 
When this setting =ON, the provider's suffix will be added 
to the signature line appended to the end of the note. The 
suffix will be located after the provider's last name 
separated by a comma.  
For example:  
<First Name> <Middle Initial> <Last Name>, <Suffix> 
This is the default setting.  
When this setting =OFF, the provider's suffix will not be 
included in note signatures.  
You can use the ProviderTitleInNoteSig setting to 
 determine whether providers' titles are appended to their 
name in note signature lines. 
If both settings are enabled, the suffix will appear before 
the title in the signature line separated by a comma. For 
example: 
<First Name> <Middle Initial> <Last Name>, <Suffix>, 
<Title> 

ProviderTitleInNoteSig=   Use this setting to determine whether providers' titles are 
appended to their name in note signature lines. 
When this setting =ON, the providers title will be added to 
the signature line appended to the end of the note. The 
title will be located after the providers last name separated 
by a comma. 
For example:  
<First Name> <Middle Initial> <Last Name>, <Title> 
This is the default setting.  
When this setting =OFF, the providers title will not be 
included in the note signatures.  
You can also use the ProviderSuffixInNoteSig setting to 
determine whether providers' suffixes are appended to 
their name in note signature lines. 
If both settings are enabled, the suffix will appear before 
the title in the signature line separated by a comma. For 
example: 
<First Name> <Middle Initial> <Last Name>, <Suffix>, 
<Title> 
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CreateOtherProblemsFromNoteTitles= Configurable in Special Features on the Records 2 tab.  
This setting indicates whether new problems should be 
automatically created based on the titles of the progress 
notes you add for a patient. 
If this setting =ON, the Other Problems list is automatically 
updated with new problems that Patient Records creates 
from the titles of progress notes. This is the default value 
for this setting. 
If this setting =OFF, the automatic creation of problems 
from the titles of progress notes will not occur. 

CreateDuplicateOtherProblemsFromNo
teTitles= 

Configurable in Special Features on the Records 2 tab.  
This setting indicates whether problems created from note 
titles should be automatically added to the problem list, if 
records with the same names already exist in the system.  
If this setting=ON, problems, created from note titles, are 
automatically added to the list with matching problems.  
If this setting=OFF, the creation of duplicate problems 
from note titles will not occur. 

ShowPrintRangeSelect= Configurable in Special Features on the Records 2 tab. 
This setting controls whether the Print Range Select screen 
is displayed when printing a note-based section of the 
chart, including progress notes, and letters.  
When this setting =ON, the Print Range Select screen will 
be displayed. This is the default setting. 
When this setting =OFF, the Print Range Select screen will 
not be displayed and the entire note will be printed.  

PopulateTranscriptionQueue= This feature is reserved for future use. 

NotePageWidth= This setting can be used to set the default width of the 
HTML note editor window in inches. The default setting is 
8.5. You can change the width by editing the number after 
the equal sign.  

Note: If you specify this setting you must also specify the 
NotePageHeight setting.  

NotePageHeight= This setting can be used to set the default height of the 
HTML note editor window in inches. The default setting is 
11. You can change the height by editing the number after 
the equal sign.  

Note: If you specify this setting you must also specify the 
NotePageWidth setting.  
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SubjPara= This is for saving HTML-formatted progress notes. When 
this setting =ON, each hard return will be removed, 
starting from the beginning of a progress note until a O: or 
Objective: is reached in the note. In addition if two hard 
returns occur in a row, only one will be removed. The 
effect of this feature is to reformat the Subjective part of 
the progress note into a narrative paragraph. For example: 
Original progress note: 
S: This is a 46 year old male who comes in for chest pain. 
Side: left 
Duration: one hour 
Location: mid left sternal 
ROS is otherwise negative. 
History of previous MI: none 
Smoking: none 
O: 
With this setting enabled, the above becomes: 
S: This is a 46 year old male who comes in for chest pain. 
Side: left. Duration: one hour. Location: mid left sternal. 
ROS is otherwise negative. History of previous MI: none. 
Smoking: none. O: 

SharedNoteSignature= Specifies the text that will be used to replace 
"^Shared_Note_Sig" in a shared progress note when it is 
saved. The default text is, "# NURSING NOTE ABOVE 
SIGNED BY" followed by the operator's name, ID in 
parentheses, and the date and time. For example, # 
NURSING NOTE ABOVE SIGNED BY Jane Nurse, R.N. 
(123) 06/25/2008 01:31PM.  

[NotesHTML] Configurable in Special Features on the Records 4 tab, 
these logo settings apply to reports.  

UseLogoReport=  This setting defines whether a logo image should print on 
your reports. Logos can be set up for each practice. 
If this setting =ON, the logo image will print on reports. 
If this setting =OFF, the logo image will not print on 
reports. 

UseTitleReport= This setting defines whether a title header should print on 
your reports. Headers can be set up for each practice. 
If this setting =ON, the title header will print on reports. 
If this setting =OFF, the title header will not print on 
reports. 

DefaultPracticeReport= If you are using the logo/title feature, this setting defines 
the default logo and title to use when no logo or title is 
specified for a practice. After the =, type the name of the 
practice whose logo and title you want to be the default. 
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ScaleLogo=  If you are using the logo/title feature, this setting defines 
whether the logo size should be automatically reduced to 
200x75 pixels to fit better on the report. 
If this setting =ON, the logo will be reduced to 200x75 as 
needed. 
If this setting =OFF, the logo will not be reduced, and will 
print at its normal size. 

[NoteFont]  
TypeFace="Arial" 
Size=9 

The settings in this section apply to the HTML note 
features. These features include the ability to change font 
type and size, insert tables, and justify text. The reason to 
restrict the list of fonts is to make it easier to see your notes 
on a wide variety of workstations, and to allow a wide 
variety of printers to print the notes. 
You can select the font and font size for your notes by 
modifying the PPart.ini file. Using a monospace font such 
as Courier may help preserve spacing and layout when you 
print a note.  
In the TypeFace line, you can change the default font 
(Arial) to the font you want to use when printing your 
notes. For example, edit the line to TypeFace=Courier 
New. 
If the font you enter does not exist on your system, Patient 
Records will use the default Arial font. 
In the Size line, you can change the default font size to the 
size you want to use when printing your notes. 

[EditorFonts] 
Font1=Courier New 
Font2=Batang 
Font3=Tahoma 
Font4=MS Mincho 
Font5=Arial 
Font6=Arial Narrow 
Font7=Arial Black 
Font8=Times New Roman 
Font9=MS Comic Sans 
Font10=Lucida Console 
Font11=Verdana 
Font12=Trebuchet MS 
Font13=Georgia 
Font14=Century 

This setting displays the fonts available in the font drop-
down list of the HTML note editor. The HTML note editor is 
used in notes and messages (if your system is configured 
to use this feature). 
You can add up to 50 fonts as supported by your printer 
driver. 
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[EditorFontSize] 
Size1 = 8 
Size2 = 9 
Size3 = 10 
Size4 = 11 
Size5 = 12 
Size6 = 13 
Size7 = 14 
Size8 = 15 
Size9 = 16 
Size10 = 17 
Size11 = 18 
Size12 = 19 
Size13 = 20 
Size14 = 36 
Size15 = 48 
Size16 = 72 

This setting displays the font sizes available in the font size 
drop-down list of the HTML note editor. The HTML note 
editor is used in notes and messages if your system is 
configured to use this feature. 
You can add up to 16 font sizes. 

[FlowColors] 
High = Red 
Low = Green 
CriticalHigh = Red 
CriticalLow = Red 
Critical = Cyan 
Abnormal = FieldAbnormalBg 

This section defines how results display in flow charts. You 
can specify colors for high, low, critical high, critical low, 
critical, and abnormal results. 
Available values are red, dark red, light red, green, dark 
green, light green, blue, dark blue, light blue, yellow, dark 
yellow, light yellow magenta, dark magenta, light magenta, 
cyan, dark cyan, and light cyan. 

[BGConfiguration] 
BGMODE=BG1 

This setting should not be changed in the PPart.ini file. 
This setting applies to the Blood Glucose Meter. 

[BGComments] 
1=Fasting 
10=During Night 
11=Pre Exercise 
12=After Exercise 
13=Illness 
14=Hypoglycemia 
15=Other 
2=Pre Breakfast 
3=After Breakfast 
4=Pre Noon Meal 
5=After Noon Meal 
6=Pre Dinner 
7=After Dinner 
8=Different Food 
9=Bedtime 

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Comments screen. Note: You can have a 
comments section for each meter type. 

[BGMeters] 
1=One Touch Meters from LifeScan 
2=FreeStyle Meters from TheraSense 
3=Accu-Chek Meters from Roche 
4=IR Accu-Check Meters from Roche 
5=Bayer Meters 
; Units: 0=mg/dl, 1 = mmol/l  

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Setup screen.  
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[BGMeterMisc] 
DefaultPort=1 
Units=0 

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Setup screen.  

[BGTimeRanges] 
AfterLunch=840 
Bed Time=1260 
Breakfast=0 
Brunch=600 
Dinner=1020 
Lunch=690 

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Time Ranges screen.  

[BGMinValues] 
AfterLunch=-32000.000000 
Bed Time=100.000000 
Breakfast=100.000000 
Brunch=100.000000 
Dinner=100.000000 
Lunch=125.000000 

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Time Ranges screen.  

[BGMaxValues] 
AfterLunch=-32000.000000 
Bed Time=200.000000 
Breakfast=200.000000 
Brunch=200.000000 
Dinner=-32000.000000 
Lunch=225.000000 

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Time Ranges screen.  

[BGTimeMisc] 
DateFormat=MM/DD/YY 
Format=1 
Order=1 

Do not change these settings in the PPart.ini file. 
These settings apply to the Blood Glucose Meter, and are 
set on the BG Setup screen.  

[LabelRemoval] 
Remove= 

You can configure Patient Records to remove the blank 
lines created by unexpanded labels in notes when the 
label is the only item on a line.  
If this setting =ON, Patient Records will remove both the 
labels and the blank lines when the note is saved.  
If this setting =OFF, the labels are removed but the blank 
lines remain (your system administrator can also set an 
option that will remove blank lines).  

[E&M Coding] Configurable in the Records 4 tab of the Special Features 
screen, these settings apply to the E&M coding feature. 

UseEMCoding= This setting determines whether users can insert evaluation 
and management (E&M) labels in progress notes. 
If this setting =ON, the E&M coding feature is enabled. 
If this setting =OFF, the E&M coding feature is not 
available, and E&M labels cannot be used in notes. 

UseTitle= This setting determines whether the progress note title 
should be used when calculating the number of problems. 
If this setting =ON, the title is used when calculating the 
number of problems. 
If this setting =OFF, the title is not used. 
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DisplayEMLabels= This setting determines whether evaluation and 
management (E&M) labels are visible in notes. Users can 
also turn on labels by selecting Edit > Show E&M Labels. 
If this setting =ON, the E&M labels are visible in notes. 
If this setting =OFF, the labels are not visible. 

EMLabelsColor= This setting determines the color of the labels, if 
Display_EM_Labels=ON.  
Available values are red, dark red, light red, green, dark 
green, light green, blue, dark blue, light blue, yellow, dark 
yellow, light yellow magenta, dark magenta, light magenta, 
cyan, dark cyan, and light cyan.  

AlwaysRecalculateEMCode= This setting determines whether the E&M codes should be 
automatically recalculated when a progress note with 
codes is edited. 
If this setting =ON, the E&M labels are automatically 
recalculated when the edited note is saved. 
If this setting =OFF, the E&M labels are not automatically 
recalculated. 

EMDefaultGuidelinesVersion= Specifies which version of the CMS documentation 
guidelines will be used as the basis for calculating CPT 
codes. 
Supported values are 1995, 1997, and MostFavorable. 
MostFavorable is the default value for this setting. 

Note: If set to MostFavorable, separate E&M codes are 
calculated using the 1995 and 1997 guidelines, and the 
higher code is used. 

EMCoderDefaultVisitType= Specifies the default Visit Type to use when calculating 
E&M codes. 
Supported values are Office or Consultation. 
Office is the default value for this setting. 

Note: Operators can change the visit type for each note in 
the Evaluation and Management Coding Results screen. 

AddEMDetailToNote= Specifies whether to add information about how the E&M 
code was calculated. 
If set to NO, no additional information is inserted in the 
progress note. 
If set to YES, a line describing the guideline version used to 
calculate the E&M code is automatically added to progress 
notes. In addition, if the 1997 guideline was used, then a 
second line listing the relevant Physical Exam Type from 
the guideline is also added to the progress note. 
The default value of this setting is NO. 
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[EnglishMetric] 
Height=English 
Weight=English 
OFC=Metric 
Temperature=English 

You can specify the standard of measurement that you 
selected during installation. Depending on your 
preference, units of measurement can be expressed in 
English standards (inch and pound) or metric standards 
(centimeter and kilogram).  
By default, occipito-frontal circumference (OFC) uses the 
metric standard and temperature uses the English 
standard. At this time, the standards used by these two 
items are not yet configurable.  

[VitalsAcquire] 
DefaultCOM= 

This setting applies to the Welch Allyn vitals add-on 
module. If you do not have a standard COM port name for 
the communication port through which the vital sign 
equipment will interface with Lytec MD, you can use this 
setting to specify the COM port. Standard COM ports are 
COM1 through COM12. If your COM port is different, type 
the port name after the equal sign. 

[NoteColors] 
LowColorMode= 

This setting applies to Windows Terminal Services and 
Citrix sites (and other sites limited to using 256-color 
quality for their monitors) that are using the HTML note 
feature.  
The HTML notes normally display with a yellow 
background. However, on monitors limited to 256 colors, 
the background displays as dark gray, which may make the 
note text unreadable. You can use this setting to change 
the background back to yellow. 
If this setting =ON, the background displays as yellow. 
If this setting =OFF, the background displays as dark gray. 

[LabReview] 
WhenForwardHaveOriginalSign= 

This setting determines what happens to laboratory data 
after it is forwarded to another provider. 
If "ON" is selected, require signature by the original 
provider, even when the lab data is forwarded. 
If "OFF" is selected, the forwarded lab data is removed 
from the review bin without being signed. 

UseReviewTemplates=  Configurable in Special Features on the Records 3 tab. 
This setting allows the use of lab review templates. 
If set to =ON, users are permitted to use lab review 
templates.  
If set to =OFF, the normal lab templates will be used for 
review. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 427 

 

SaveNoteReviewLab= Configurable in Special Features on the Records 3 tab.  
This setting allows you indicate whether you want to send 
labs entered with .L or .L2 Dot codes to the lab review bin 
of the providers in the .PV line.  
When this setting =ON, when .L or .L2 Dot codes are 
inserted in to a note, and then the note is signed, the lab 
results will be sent to the lab review bin. Every provider on 
the .PV line will have the lab sent to their review bin. This is 
the default setting.  
When this setting =OFF, when the .L or .L2 Dot codes are 
inserted in to a note, and then the note is signed, the labs 
for the note will also be signed. Please note providers in 
the note will not receive the labs in their review bin. Also, 
providers on the .PV line and the standard provider will not 
receive the labs in their review bin if the note is not signed 
at the time of creation.  

TextLoadReviewLab= Configurable in Special Features on the Records 3 tab. 
This setting allows you to indicate whether you want lab 
results loaded by the Text Data Loader to be sent to the 
lab review bin.   
When this setting =ON, lab results loaded by the Text Data 
Loader with .L or .L2 Dot codes will be sent to the lab 
review bin. This is the default setting.  
When this setting =OFF, lab results loaded by the Text 
Data Loader with .L or .L2 Dot codes will not be sent to the 
lab review bin.  

[NoteRecovery]  
TempSave= 

This setting can be used to recover non-HTML-based 
progress notes that are open when Lytec MD or your 
computer crashes.  
If this setting =ON, progress notes that are open are saved 
to temporary files (*.sav).  
If this setting =OFF, progress notes are not saved, and are 
not recoverable. 

[Rx] These settings do the following: 
 Standardize wording used in frequencies, sizes, 

names, and amounts to preferred terms. 
 Set defaults for disease and dose checking. 

RxRequireSize= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the pill size when writing or changing a prescription. 
When this setting =OFF, operators will not be required to 
enter the pill size when writing or changing a prescription. 
The default setting is OFF. 
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RxRequireTake= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the quantity taken per dose when writing or changing a 
prescription. 
When this setting =OFF, operators will not be required to 
enter the quantity taken per dose when writing or 
changing a prescription. The default setting is OFF. 

RxRequireFreq= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the frequency when writing or changing a prescription. 
When this setting =OFF, operators will not be required to 
enter the frequency when writing or changing a 
prescription. The default setting is OFF. 

RxRequireDur= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the duration when writing or changing a prescription. 
When this setting =OFF, operators will not be required to 
enter the duration when writing or changing a 
prescription. The default setting is OFF. 

RxRequireAmount= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the amount when writing or changing a prescription. 
When this setting =OFF, operators will not be required to 
enter the amount when writing or changing a prescription. 
The default setting is OFF. 

RxRequireRefills= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the number of refills when writing or changing a 
prescription. 
When this setting =OFF, operators will not be required to 
enter the number of refills when writing or changing a 
prescription. The default setting is OFF. 

RxRequireRoute= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the route when writing or changing a prescription. 
When this setting =OFF, operators will not be required to 
enter the route when writing or changing a prescription. 
The default setting is OFF. 
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RxRequireProvider= Configurable in Prescription Defaults on the Required Rx 
Fields tab.  
When this setting =ON, operators will be required to enter 
the provider ID when writing or changing a prescription if 
the provider is not outside the practice. 
When this setting =OFF, operators will not be required to 
enter the provider ID when writing or changing a 
prescription. The default setting is ON. 
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Freq##= 
Frequency= 
Size##= 
Medication##= 
Amount##= 

These variables can be used to change existing 
frequencies, sizes, names, and amounts in order to 
standardize the terms used when writing prescriptions. 
These options are useful to meet the JCAHO national 
patient safety goals, although not limited to this use.  
For each of the following, state the preferred way to write a 
term when found in a prescription. The first term after the 
equal sign is changed into the second term (the one after 
the coma). For example, to change "QD" into "daily" 
wherever it occurs, add the following to this section (the 
"01" may be any two-digit number from 01 to 99):  

Freq01=QD,daily 

Do not confuse Freq## with Frequency. 

Here are the available variables: 
Freq##= 

This variable translates prescription frequency, 
using the following format: 

Freq##=original,translation 
Where: 

 ## is a number between 01 and 99 (use the 
next available number) 

 original is the abbreviation to be 
translated 

 translation is the preferred term 

For example: 
Freq01=QD,daily 
Freq02=QOD,every other day 
Freq03=QHS,at bedtime 

Frequency= 
This variable sets prescription frequency defaults 
available on Prescription, using the following 
format: 

Frequency=term1,term2, term3 
Where: 

 term1,term2,term3 is each default value 
for Freq, up to a maximum of 50 terms in 
the list 

The default setting is: 
Frequency=daily,twice daily,three times 
daily,four times daily,five times daily, every 
other day,at bedtime,prn,q2h,q3h,q4h,q6h 

Frequency does not translate one term to another 
like other variables in this section of [Rx]. 

Size##= 
This variable translates prescription size, using the 
following format: 

Size##=original,translation 
Where: 
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 ## is a number between 01 and 99 (use the 
next available number) 

 original is the abbreviation to be 
translated 

 translation is the preferred term 

For example: 
Size01=cc,ml 
Size02=iu,International Units 
Size03=U,units 

Medication##= 
This variable translates prescription name, using the 
following format: 

Medication##=original, translation 
Where: 

 ## is a number between 01 and 99 (use the 
next available number) 

 original is the abbreviation to be 
translated 

 translation is the preferred term 

For example: 
Medication01=MS,Morphine Sulfate  

Amount##= 
This variable translates prescription amounts, using 
the following format: 

Amount##=original, translation 
Where: 

 ## is a number between 01 and 99 (use the 
next available number) 

 original is the abbreviation to be 
translated 

 translation is the preferred term 

For example: 
Amount01=cc,ml 
Amount02=MG,milligrams 
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DrugDiseaseCheckLevel= Configurable in Prescription Defaults on the Other 
Checks tab. The drug disease check level compares the 
patient's current medical condition with all drugs currently 
prescribed or in a new prescription. A warning displays 
when there is a contraindication, based on the level 
chosen. 

Note: Problems with the status of "Inactive" or that have 
been resolved will not be checked. 

If this setting =1-Absolute contraindication, a warning 
displays when there is an absolute contraindication only. 
If this setting =2-Potential contraindication, a warning 
displays when there is an absolute or potential 
contraindication. 
If this setting =3-Precaution, a warning displays when 
there is an absolute or potential contraindication, or when 
caution should be used. This is the default level. 
Set this setting to =OFF to disable this feature. Please note 
if the Prescription Defaults setting, "Drug - Disease Check 
Level" is set enabled, this setting will be overridden.  

DrugDoseCheck= Configurable in Prescription Defaults on the Other 
Checks tab. The Drug Dose Check setting when enabled 
compares the patient's age and gender with all drugs in a 
new prescription. A warning displays when there is a 
contraindication, based on the options chosen. 
If this setting =ON, the drug dose checking feature is 
enabled. 
If this setting =OFF, the drug dose checking feature is 
disabled. 

WarnAdultDoseCheckingNotAvailable= Configurable in Prescription Defaults on the Other 
Checks tab.  
If this setting =ON, you will be warned that adult dose 
checking is not available when a new prescription is written 
for a patient. 
If this setting =OFF, you will not be warned. 

WarnGeriatricDoseCheckingNotAvailabl
e= 

Configurable in Prescription Defaults on the Other 
Checks tab.  
If this setting =ON, you will be warned that geriatric dose 
checking is not available when a new prescription is written 
for a patient. 
If this setting =OFF, you will not be warned. 

WarnPediatricDoseCheckingNotAvailab
le= 

Configurable in Prescription Defaults on the Other 
Checks tab.  
If this setting =ON, you will be warned that pediatric dose 
checking is not available when a new prescription is written 
for a patient. 
If this setting =OFF, you will not be warned. 
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WarnInfantDoseCheckingNotAvailable= Configurable in Prescription Defaults on the Other 
Checks tab.  
If this setting =ON, you will be warned that infant dose 
checking is not available when a new prescription is written 
for a patient. 
If this setting =OFF, you will not be warned. 

UseNewFreq= Configurable in Prescription Defaults on the Frequency 
Defaults tab. 
If this setting =ON, you can use and modify the Frequency 
Defaults list on the Prescription Defaults screen. 

WarnIfNoMatch= This setting controls whether the user will receive a 
warning message when a prescription is written and a 
match is not found for the prescription in the database. 
When the drug is not found, Lytec MD will not be able to 
check the following: Allergy Intolerance, Diagnosis, Drug 
Dosage, or Drug Interaction.  
If the setting =ON, users will receive a warning message. 
If the setting =OFF, users will not receive a warning 
message. 

AllowFutureRX= Configurable on the Prescription Defaults screen, this 
option allows users to enter a prescription date as a future 
date. 
If this setting =ON, users are allowed to enter a future date 
for a prescription. 
If this setting =OFF, prescriptions cannot be entered with a 
future date. 

AllowDualRxPrintOptions= This setting controls whether a prescription can be printed 
locally, and, at the same time, faxed or transmitted 
electronically to other pharmacies, associated with a 
patient.  
If this setting=ON, the Print locally and transmit as a 
group, Print locally and fax as a group, and Print locally 
and remotely as a group options are available for 
selection in the Print options list accessible through the 
Prescription screen.  
If this setting=OFF, the Print locally and transmit as a 
group, Print locally and fax as a group, and Print locally 
and remotely as a group options are not available for 
selection on the Prescription screen.  
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MonthsToCheckDiagnosis= Configurable in Prescription Defaults on the Other 
Checks tab. 
This setting controls the limit in months for which drug 
disease checking for other problems and diagnoses is 
performed when a new prescription is written. For 
example, if this configuration is set to 3 months, a 
diagnosis or other problem older than 3 months will not be 
checked when a new prescription is written. If the 
diagnosis or other problem is less than 3 months old, it will 
be checked.  
Please note this configuration does not apply to Major 
Problems or Risks. 
The default for this configuration is 2 months. 

SevereAllergyColor= This setting allows you to define the color severe allergies 
will be highlighted with in the Allergies and Intolerances 
section of the Rx/Medications screen. When a severe 
allergy is added the allergy cell will be highlighted in this 
color.  

UseFaxServer= This setting controls whether the fax defined in Printer 
Group Maintenance or a specified fax server will be used 
when faxing Rx prescriptions. 
When this setting =ON, the fax server will be used, if it is 
properly configured. See the Setting up the Fax Server 
section for more information. 
When this setting =OFF, Patient Records will use the fax 
defined in Printer Group Maintenance.  

RequireReasonForDC= Configurable in Prescription Defaults on the Rx Defaults 
tab. 
This setting controls whether a reason for discontinuation 
is required when discontinuing a prescription.  
If this setting =ON, operators will be required to enter a 
reason for discontinuation in the Reason for D/C field on 
the Confirm discontinuation screen. If a reason for 
discontinuation is not entered, and this setting is enabled, 
the operator will receive a message telling them that the 
field is required, and they will be returned to the Confirm 
discontinuation screen. 
If this setting =OFF, a reason for discontinuation is not 
required when discontinuing a prescription. The default 
setting =OFF.  
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RequireWarningOverrideReason= Configurable in Prescription Defaults on the Rx Defaults 
tab. 
This setting controls whether a reason for overriding a 
drug interaction warning is required.  
If this setting =ON, operators will be required to enter a 
reason for overriding a drug interaction warning on the 
Reason for overriding warning screen. If a reason for the 
override is not entered, and this setting is enabled, the 
operator will receive a message telling them to indicate 
the reason, and they will be returned to the Reason for 
overriding warning screen. 
If this setting =OFF, a reason for overriding a drug 
interaction warning will not be required. The default 
setting =OFF. 

WarningOverrideListName=RX 
OVERRIDE 

Specifies the name of the list set up in List Maintenance 
that contains the reason for overriding a drug interaction 
warning.  
The options in the specified list can be selected from the 
Reason for overriding warning screen, when the 
RequireWarningOverrideReason setting is set to ON, and 
an operator chooses to override a drug interaction 
warning.  
You can use List Maintenance to edit the default RX 
OVERRIDE list, or set up a new list of override reasons. 

Note: The list name must be entered in upper case. For 
example, WarningOverrideListName=RX OVERRIDE.  

CheckDIOnRenew= This setting controls whether Drug Interaction checking 
occurs on the renewal of current medications and when 
renewing current medications in response to refill requests 
with the ePrescribing module. 
When this setting =ON, Drug Interaction checking will 
occur on the renewal of current medications. 
When this setting =OFF, Drug Interaction checking will not 
occur on the renewal of current medications.  

InterfaceInstalled= This setting is added to the ppart.ini file when SureScripts 
is installed. When SureScripts is installed the setting will 
=True. Do not change this setting in the ppart.ini file. 
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TrackRxNumber=  This setting controls whether unique code numbers are 
given to prescriptions that are written using Patient 
Records. This will allow your site to distinguish one 
prescription from another. You can use the %RxTracking 
and %RxTrackingFaxOnly variables in the prescription 
format file to include the number on printed and/or faxed 
prescriptions. 
When this setting =ON, prescriptions will be given unique 
code numbers.  
When this setting =OFF, prescriptions will not be given 
code numbers. The default for this setting =OFF.  

Note: This setting must be set to ON to use the 
Prescription Output Log Report. 

CheckFoodAllergies= Configurable in the Prescription Defaults screen on the Rx 
Defaults tab. 
This setting controls whether Patient Records will check for 
food allergy intolerances when new medication is 
prescribed to a patient. 
When this setting=ON, Patient Records will check for food 
allergy intolerances when medications are prescribed. 
When this setting=OFF, Patient Records will ignore food 
allergies when medications are prescribed. This is the 
default value of this setting. 

Note: If this check box is selected, and no allergy 
intolerance information is available for the food allergy, 
operators will receive a message warning them that the 
prescribed medication cannot be checked against the 
food allergy, each time a medication is prescribed. 

AllowRxToday= This setting controls whether users are allowed to renew a 
medication that was prescribed on the same day. 
If the setting=ON, users will be allowed to renew a 
medication even if the medication date is today's.  
If the setting=OFF, users will receive a warning: "Cannot 
renew an Rx that was created today." and will not be 
allowed to renew the medication. 

FormularyRecencyDays= Configurable in the Prescription Defaults screen on the Rx 
Defaults tab. 
This setting indicates the maximum number of days the on-
file eligibility data for a patient can be for the formulary 
information it references to be in order to be displayed to 
the user in the Formulary section on the Prescription 
screen. The default number of days is 7. 
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SubstitutionOKDefault= This setting controls whether Patient Records will 
automatically select the Substitution OK check box on the 
Prescription screen when the Prescription screen is first 
displayed.  
When this setting =ON, Patient Records will automatically 
select the Substitution OK check box when the 
Prescription screen is first displayed.  
When this setting =OFF, the Substitution OK check box 
on the Prescription screen will not be automatically 
selected when the Prescription screen is first displayed.  

RxHubInstalled=True This setting is added to the ppart.ini file when RxHub is 
installed. When RxHub is installed the setting will =True. 
Do not change this setting in the ppart.ini file unless 
instructed to do so by Lytec MD personnel. 

Note: The ePrescribing interface must be installed and 
connectivity to the RxHub network must be is established 
to use this feature. Contact your Lytec MD sales 
representative for more information. 

LeftMarginWidth= This setting specifies the width of the left margin for all 
printed prescriptions. 
Enter a number of 'twips' (a unit equal to 1/20 of a 
typographical point). 

TopMarginWidth= This setting specifies the width of the top margin for all 
printed prescriptions. 
Enter a number of 'twips' (a unit equal to 1/20 of a 
typographical point). 
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BlockFaxingofControlled2=ON 
BlockFaxingofControlled3=OFF 
BlockFaxingofControlled4=OFF 
BlockFaxingofControlled5=OFF 
BlockPrintingControlled2=ON 
BlockPrintingControlled3=OFF 
BlockPrintingControlled4=OFF 
BlockPrintingControlled5=OFF 
BlockTransmissionofControlled2=ON 
BlockTransmissionofControlled3=ON 
BlockTransmissionofControlled4=ON 
BlockTransmissionofControlled5=ON 

You can use these settings to prevent operators from 
printing, faxing, or electronically transmitting prescriptions 
for medications that have a certain "schedule" level as 
controlled substances. Each setting controls whether your 
operators can fax, print, or transmit prescriptions for 
controlled substances assigned to a particular schedule by 
the U.S. Drug Enforcement Agency (DEA).  
By default faxing and printing prescriptions for schedule 2 
substances is not allowed, and the electronic transmission 
of prescriptions for schedule 2, 3, 4, and 5 substances is 
not allowed. To allow the printing, faxing, or transmission 
of prescriptions for these substances set the 
corresponding settings to OFF.  
If the setting =OFF printing, faxing, or transmitting a 
prescription for the medication with the schedule level will 
be allowed. 
If the setting =ON, printing, faxing, or transmitting of the 
prescription for the medication with the schedule level will 
not be allowed. When set to ON, and an operator attempts 
to print, fax, or transmit the prescription for the medication 
with the schedule level, the operator will receive a 
message informing them that they can not complete the 
action.  

Note: These settings have been introduced to provide 
flexibility in behavior of the prescribing module of Lytec 
MD Patient Records in the event that laws and regulations 
regarding prescribing controlled substances change in the 
near future. They are not intended to facilitate 
circumventing such laws and regulations. It is the 
responsibility of every Lytec MD customer to ensure that 
your use of the system complies with applicable federal, 
state, and local laws and regulations regarding 
prescribing. 

AllowUnrenewal= This setting controls the functionality of the Renew button 
on the Rx/Medications screen after a prescription has been 
renewed (i.e., clicking the button for the second time on 
the current day after the prescription has been renewed).  
Set to ON, to use the Renew button to cancel renewals 
after a prescription has been renewed on the same day. 
This is the default setting for existing sites. 
Set to OFF, if a medication is highlighted that has been 
renewed already on the current day, clicking the Renew 
button has no effect.  This is the default setting for new 
sites. 
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CheckDrugAllergyWhenAddingAllergy
= 

This setting controls whether drug-allergy interaction 
checking occurs when a new allergy is added from the 
Allergy: New screen, or the Medication/Allergy name is 
modified from the Allergy: Edit screen. When the user 
clicks OK from the Allergy: New screen or the Allergy: Edit 
screen (when modifying the Medication/Allergy name), 
Patient Records will check for drug-allergy interactions 
between the entered allergy and the patient’s current 
medications. A warning message will be displayed if any 
drug-allergy interactions are found. Please note the Lytec 
MD drug interaction and allergy checking database must 
be installed to use this feature.   
When this setting =ON, drug-allergy interaction checking 
will occur for new allergies, or the Medication/Allergy 
name is modified from the Allergy: Edit screen.  
When this setting =OFF, drug-allergy interaction checking 
will not occur for new allergies, or the Medication/Allergy 
name is modified from the Allergy: Edit screen. This is the 
default setting.  

ShowCoverageDetailsOnPrescriptionDi
alog= 

This setting controls the way formulary and co-pay 
information is displayed on the Prescription screen.  
If the setting=ON, the additional information about the 
coverage of a medication (formulary status, quantity limits, 
copay information, alternative information, etc.) will display 
in the right part of the Prescription screen. 
If the setting=OFF, the additional information about the 
coverage of a medication will display on a separate 
Formulary Details screen, accessible through the Details 
button of the Prescription screen.   

[SearchOptionDefaults] 
ProcLookupDefaultPR=Word 
ProcLookupDefaultMB=Office 
DiagLookupDefaultPR=Word 
DiagLookupDefaultMB=Office 
InsertIntoText=Long 
InsertAs=Diagnosis 

Do not change these settings in the PPart.ini file. 
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[PDA] 
HanDBasePath= 
PDATablesPath= 
PDASyncNames= 
AutoSync= 

Here, you set up parameters for exporting *.txt files onto 
Palm or PocketPC PDAs. You must be using HanDBase 
software. See PDA Export. 
HanDBasePath must specify the directory of your 
HanDBase executable. Example: c:\progra 1\Handbase3\ 
The PDATablesPath must specify the directory of your 
*.pdb files, which are 10 data tables created for you by 
Lytec MD. Example: c:\palm\current\ 
PDASyncNames refers to the operator names to sync the 
tables to. The default is ALL USERS, meaning it will sync to 
all available PDAs. 
If AutoSync=ON, the files are automatically placed in the 
appropriate location so that the next time the PDA is 
synced, the tables are transferred to the PDA. If AutoSync 
=OFF, then the files are generated but not prepared for 
sync, so if users want to transfer them to the PDA, they 
must do so manually as specified by their PDA's user 
guide. 

[TransferToPortable] 
UseAccessLogForResync= 

This setting applies to how laptop data resynchronization is 
handled. If the setting =ON, PR will perform chart-access 
logging on the laptop, meaning only the patient records 
that were accessed are flagged for resynchronization. New 
patients that are added and information added to existing 
patient charts is uploaded while unchanged records are 
not, typically increasing the resynchronization speed.  

EditDemographics=  This setting applies to what data operations are supported 
during Transfer to Portable and resynchronization. If this 
setting =ON, patient and guarantor demographics can be 
added and edited on the laptop and will over-ride the 
main database upon resynchronization.  

[Portable] 
Path= 
DriveLetter= 
OperatingSystem= 
PatientInquiryFile= 
AllPatients= 

Supply these settings, specific to your system, to use the 
command line utility TransferToPortable.exe.  
Path= The mapped drive to copy database files and PR 
application files to, or to write/read the portable database 
files to when resynchronizing or refreshing. 
DriveLetter= Hard drive of laptop. 
Operating System= Operating system of the laptop. Valid 
settings: WIN95, WIN98, WINME, WINNT, WIN2000, and 
WINXP.  
PatientInquiryFile=This setting will be a path and *.inq 
(patient inquiry) file that specifies only a subset of patient 
records to be transferred. Example: PatientInquiryFile= 
c:\temp\AllMalePatients.inq. See Patient Inquiry.  
AllPatients=Set this to YES to transfer all patients to the 
portable. 
Also see the Transfer to Portable help topic. 
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[ProtocolScheduling] 
OptimizeMinimum= 
OptimizeMaximum= 
OptimizeDependencies= 

Do not change these settings in the PPart.ini file. 
These settings apply to Appointment Scheduler. 
These three options =ON by default and should remain 
ON so that protocol scheduling runs as quickly as possible 
since multiple appointment slots must be located and 
reserved. 

[Formularies]  

UPDATE_IN_MAINT =  If set to =ON, Patient Records will check templates added 
in Maintenance against the existing insurance formularies.  
If set to =OFF, Patient Records will not check templates 
added in Maintenance against the existing insurance 
formularies.  

UPDATE_IN_RX =  This means formularies are checked against individual 
prescriptions.  If set to =ON, Patient Records will check 
templates added when you write prescriptions against the 
existing insurance formularies.  
If set to =OFF, Patient Records will not check templates 
added when you write prescriptions against the existing 
insurance formularies.  

RIGOROUS_MATCHING =  This requires Update_in_Rx=ON.  If set to =ON and 
Update_in_Rx=ON, prescriptions will be matched exactly 
against formularies. Matching criteria includes Rx name, 
size, route, units, etc.  
If set to =OFF and Update_in_Rx=ON, prescriptions will be 
matched against formularies only by name and size.  

RECORD_IF_NOT_RIG =  If set to =ON and Rigorous_Matching=OFF, Patient 
Records will write a list of tentative matches to a text file.  
If set to =OFF, Patient Records will not write a list of 
unmatched prescriptions.  

[Startup] 
CheckMDAC= 

When this =ON, Lytec MD looks for the latest version of 
Microsoft Data Access Components each time a Lytec MD 
application is started.  

[TDL] 
Load_Progress_Note_As_Shared= 
 

This setting controls whether a note will be loaded as 
shared by text data loader.   
If this setting =ON, the note will load as a shared note. This 
allows users to edit notes and insert Dot codes along with 
templates. If a shared note already exists for the patient 
then it will load the note as a progress note. 
If this setting =OFF, the note will be loaded normally. 
Note: These settings are normally only used by the 
standalone text data loader. 
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Do_Not_Process_K_Lines_When_Loadin
g_Shared_Note= 

This setting controls whether the .K lines in files are 
processed when the note is loaded as shared.   
If this setting =ON, the .K lines will not be processed when 
the note is loaded. The .K lines will be processed after the 
note has been permanently saved.  
If this setting =OFF, the .K lines will be processed when the 
note is loaded.  
Note: These settings are normally only used  by the 
standalone text data loader. 
The Load_Progress_Note_As_Shared setting needs to be 
ON for this setting to have an effect. 

[InsertMedicationList]  

ShortRxDescription= Configurable in Special Features on the Records 2 tab.  
If this setting =ON, duration, amount and refills will not 
show when inserting the medication list.  

[SelectNoteColumns] The [SelectNoteColumns] settings control the columns 
and captions displayed on the To Do List screen. Please 
contact Lytec MD Technical Support for details. 

[LabPrinting]  

PrintChartTemplateOrder= Configurable in Special Features on the Records 7 tab. The 
default for this setting is ON. 
If this setting =ON, a lab will be printed in template order 
when it is printed as part of a chart. 

PrintChartUseDefaultTemplate= Configurable in Special Features on the Records 7 tab. The 
default for this setting is OFF. 
If this setting =ON, a Lab's default template is used when a 
lab is printed as part of the chart. 

PrintLabSource= Configurable in Special Features on the Records 7 tab. 
This setting controls whether information about the 
laboratory where the test was performed is printed on the 
Partial Chart report and Complete Chart report.  
If this setting =ON, the laboratory source information will 
be printed on the reports. 
If this setting =OFF, the laboratory source information will 
not be printed on the reports. This is the default setting.  

[GrantPrograms]   

GrantPrograms=Migrant 
Health,Homeless Health,Public 
Housing,School Based 

This setting allows you to configure the options displayed 
from the Grant Program drop-down list on the Grant 
Program screen. To add a new option to the list, enter the 
new option with no space after the comma (i.e., Migrant 
Health,Homeless Health). 
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[Pregnancy]   

Outcome=Vaginal Delivery,C-
Section,SAB,Fetal Demise 

This setting allows you to configure the options displayed 
from the Outcome drop-down list on the Pregnancy 
screen. To add a new option to the list, enter the new 
option with no space after the comma (i.e., SAB,Fetal 
Demise). 

BirthweightUnit=gms This setting allows you to set the default birth weight unit. 
The selected unit is displayed in the Birth Weight attribute 
field. The default setting is gms.  

InitialNote=Prenatal Care  This setting allows you to define what note is displayed 
when the Initial H&P button is selected on the Prenatal 
Visit Flow Chart screen. The Default setting is Prenatal 
Care. This means when the button is clicked, Patient 
Records will display the note from the current pregnancy 
whose title begins with "Prenatal Care".  If there is more 
than one such note during the present pregnancy, the 
more recent one will be displayed. 

ProgressNote=OB This setting allows you to define what notes are displayed 
when the Prog Notes button is selected on the Prenatal 
Visit Flow Chart screen. The Default setting is OB. This 
means when the button is clicked, Patient Records will 
display the most recent note whose title begins with "OB". 
This setting may be changed to meet your specific practice 
needs. 

PlansNote= This setting allows you to define what note is displayed 
when the Educ / Plans button is selected on the Prenatal 
Visit Flow Chart screen. The Default setting is blank. This 
setting may be changed to meet your specific practice 
needs. When the button is clicked, Patient Records will 
display the most recent note whose title begins with the 
title designated for this ppart.ini setting. If there is more 
than one such note during the present pregnancy, the 
more recent one will be displayed. 

PrenatalMinAge=11 This setting allows you to set the prenatal minimum age. 
The default age is 11. This means that the Prenatal tab will 
not show up on a patient's chart unless the patient is over 
11 years of age. 

TestDateOffset=3 This setting allows you to set the number of days that 
prenatal procedures can be completed in advance to be 
counted as complete for the next procedure due date. For 
example, the setting is set to 3, and a procedure must be 
completed between the 25th week and 32nd week. If the 
item is completed 3 days before the item is due and you 
are still in the 24th week, the item will be marked as 
complete for the 25th week. 
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PrenatalColumns1=standard column 
name, new column name 
PrenatalColumns2=standard column 
name, new column name 
PrenatalColumns3=standard column 
name, new column name 

These settings allow you to define custom column header 
titles for the Prenatal Visit Flow Chart. You can enter as 
many names as you want. For example, if you selected the 
standard column name, "FHR", you can enter the entire 
name (Fetal Heart Rate) to be displayed as the column 
header on the Prenatal Visit Flow Chart. 
Example: 
PrenatalColumns1=FHR,  Fetal Heart Rate 

PrenatalHPTemplate= This setting allows you to define what note template is 
displayed when the Initial H&P button is selected on the 
Prenatal Visit Flow Chart screen. The default setting is OB: 
Initial Evaluation, which is the name of the note template 
from the Lytec MD standard note template collection for 
initial prenatal visits. . This setting may be changed to meet 
your specific practice needs. When the button is clicked, 
Patient Records will open a new note and automatically 
select the note template with the title designated for this 
ppart.ini setting. 

[Pharmacy]  

Type=Retail,Mail-Order,Other This setting allows you to configure the options displayed 
from the Type drop-down list on the Patient Pharmacy 
screen. To add a new option to the list, enter the new 
option with no space after the comma (i.e., Retail,Mail-
Order).  

Send_Type=Prt,Fax,SS,RxH This setting allows you to configure the options displayed 
from the Send Type drop-down list on the Pharmacy 
screen. To add a new option to the list, enter the new 
option with no space after the comma (i.e., Prt,Fax). 

PharmacyNeighborhoodListName= Specifies the name of the list set up in List Maintenance 
that contains the names of different neighborhoods 
meaningful to your users. 
The options in the specified list can be selected from the 
Neighborhood field in the Pharmacy Select screen and the 
Pharmacy <New> and <Edit> screens when adding or 
editing pharmacies. 

Note: The list name must be entered in upper case. For 
example, 
PharmacyNeighborhoodListName=NEIGHBORHOODS.  

[CHC]  

GrantYearStarts= This setting allows you enter the CHC grant year start date. 
Enter the date and day, separated by commas. For 
example, the grant year starts January 1st, so you would 
enter 01, 01.  

HIVLabName=HIV 1 Antibody, HIV 1 
DNA PCR, HIV 1 P24 ANTIGEN, HIV 1 
RNA, PCR 

This setting has not yet been implemented.  

HIVLabNameResult=Positive This setting has not yet been implemented.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 445 

 

HIVProblemName=HIV Disease, HIV 2, 
ASYMPTOMATIC HIV S 

This setting has not yet been implemented.  

[ProblemList]  

UseLongDescriptions= This configuration controls whether the short or long 
description is used for a new major problem, other 
problem, procedure, diagnosis, risk, or hospitalization 
name. This setting only applies to names selected using 
the Lookup button.   
If this setting =ON, the long description will be used. This 
is the default setting for new sites. 
If this setting =OFF, the short description will be used. This 
is the default setting for existing sites.  

ProblemListAllCaps= 
 

Configurable in Special Features on the Records 5 tab. This 
setting controls whether problems entered in the Problem 
List are converted to capital letters when saved. For 
example, if you enter a new problem with upper and lower 
case letters, the problem will be converted to all capital 
letters once saved. Problems in lower and upper case 
letters imported through the Text Data Loader, or inserted 
as a Dot code will also be converted to capital letters when 
this setting is enabled. 
When this setting =ON, problems will be converted to all 
capital letters. 
When this setting =OFF, problems will be displayed as 
entered (upper and lower case letters). This is the default 
setting.  

[PrintChart]  

ActiveMajorProblemsOnly= This configuration determines whether only active or all 
major problems (i.e., active and inactive) are printed on the 
Partial Chart report and Complete Chart report.  
If this setting =ON, only active major problems will be 
printed on the Partial Chart report and Complete Chart 
report.  
If this setting =OFF, all major problems will be printed on 
the Partial Chart report and Complete Chart report. 

ActiveRisksOnly= This configuration determines whether only active or all 
risks (i.e., active and inactive) are included on the Partial 
Chart report and Complete Chart report.  
If this setting =ON, only active risks will be printed on the 
Partial Chart report and Complete Chart report. 
If this setting =OFF, all risks will be printed on the Partial 
Chart report and Complete Chart report. 
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[LabNames]  

CREAT=CREAT Configurable in Special Features on the Records 7 tab.  
This configuration allows you to specify the lab name that 
will represent serum creatinine concentration when the 
formula for calculating Creatinine Clearance is used. If this 
setting is not specified, Patient Records will look for the lab 
names "CREATININE" or "Creatinine" when calculating 
Creatinine Clearance. The default setting is CREAT.  

CREATCLEAR=CREAT CLEAR Configurable in Special Features on the Records 7 tab.  
This configuration allows you to specify the lab name that 
will be used to represent measured creatinine clearance 
when the formula for calculating Creatinine Clearance is 
used. If this setting is not specified, Patient Records will 
look for the lab names "CREATININE" or "Creatinine" when 
calculating Creatinine Clearance. The default setting is 
CREAT CLEAR.  

[Letters]  

RemoveLetterSignatureLines= Configurable in Special Features on the Records 7 tab.  
This setting allows you to omit signature lines when 
printing letters.  
If this setting =ON, printed letters will not include the 
"Signed by," "Cosigned by," and "Revised by" lines.  
If this setting =OFF, printed letters will include the "Signed 
by," "Cosigned by," and "Revised by" lines.  

RemoveLetterLabDotCodeLines= Configurable in Special Features on the Records 7 tab.  
This setting allows you to omit lab Dot code lines when 
printing letters.  
If this setting =ON, printed letters will not include any lines 
which start with an .L Dot code.  
If this setting =OFF, printed letters will include lines which 
start with an .L Dot code. 

[Forms]  

ProviderSuffixTitle= Use this setting to indicate how suffixes are used with the 
provider's last name on forms.  
If this setting =S the provider's suffix will be added to their 
last name. This is the default setting. 
If this setting =ST a space plus the provider's title will be 
added after their suffix. 
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[DoseAdvisor]  

DoseAdvisorRaceBlack=Black 
DoseAdvisorRaceAmericanIndian=India
n/Alask 
DoseAdvisorRaceEskimoAleut=Eskimo-
Aleut 
DoseAdvisorRaceAsianPacificIslander=
Asian, Pac Isle 
DoseAdvisorRaceWhite=White 
 
 

The Dose Advisor will look for the specific values listed in 
these settings when calculating the proper dose for some 
medications. If you specified unique settings for the 
RaceItems= ppart.ini setting you will want to update the 
settings here. For example, if you entered American-Indian 
for the Race Items setting, you will want to add this setting 
to the DoseAdvisorRaceAmericanIndian= setting (i.e., 
DoseAdvisorRaceAmericanIndian=Indian/Alask, American-
Indian). You can add multiple setting entries, separated by 
commas.   

[InsertProblems]  

InsertMajorProblemAs=Diagnosis 
InsertOtherProblemAs=Diagnosis 
InsertDiagnosisAs=Diagnosis 

These settings control the default settings for the Insert As 
selections on the Insert Problem screen. From this screen 
you can select to insert Major Problems, Other Problems, 
and Diagnoses as a Major Problem or Diagnosis. If you are 
inserting a Diagnosis or Other Problem, you can also 
choose to insert the problem as a Other Problem. When 
these configurations are set the Insert As radio buttons will 
default to the setting as specified here. The default setting 
=Diagnosis.  

[Vitals]  

MaxWeightToShowOunces=25 This setting controls whether the ounces (oz) component 
of the patients weight will be displayed on the Vital Signs 
screen when the Weight field is set to display in English 
measurements, based on the overall weight in pounds.  
When a patients weight is equal to or less than this setting, 
the oz component will be displayed. When the patient's 
weight is greater than this setting, the oz component will 
not be displayed.  
The default value for this setting is 25. 

HeightRecencyforRangeChecking= Configurable in Special Features on the Records 8 tab. 
This setting indicates the number of days that Patient 
Records will look back for height data when considering 
whether to use height-based normal ranges for vital signs 
and clinical elements. If you enter "0", only height data 
from the same day will be considered. The default number 
of days is 30.  Height-based ranges can be specified when 
setting up vital sign names and clinical element names 
from the Ranges screen. 
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[ExportSummary]  

MedSummChartSection= This setting defines the storage location of medical 
summary documents that are imported using the Import 
Medical Records Summary tool. The default setting is 
Progress Notes.  
Caution! 
This setting should be changed only through the Records 
1 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 

MedSummNoteTitle= This setting allows you specify the name of the imported 
note. If there is more than 1 note with the same title, the 
note will append an underscore and a number at the end 
of the title starting with 1. For example, if you specify the 
name of the note as "Imported Continuity of Care Record 
(CCR)" then the second note for a patient would have the 
title "Imported Continuity of Care Record (CCR)_1". 

MedSummAdvanceDirectivesSection= This setting defines the storage location of medical 
advance directives that are imported using the Import 
Medical Records Summary tool. The default setting is 
Progress Notes.  
Caution! 
This setting should be changed only through the Records 
1 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 

MedSummEncounterSection= This setting defines the storage location of medical 
summary encounters that are imported using the Import 
Medical Records Summary tool. The default setting is 
Progress Notes.   
Caution! 
This setting should be changed only through the Records 
1 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 

MedSummPlanOfCareSection= This setting defines the storage location of medical 
summary plans of care that are imported using the Import 
Medical Records Summary tool. The default setting is 
Progress Notes.   
Caution! 
This setting should be changed only through the Records 
1 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 
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CCRPurpose=,Transfer of Care, Request 
For Consult, Request For Procedure, 
Request for Service, Request for 
Encounter, Request for Authorization, 
Request for Medical Device Or Product, 
Request for Medication, Request for 
Immunization, For Patient Use 

This setting allows you to configure the options displayed 
from the Purpose drop-down list on the Export Medical 
Summary screen. To add a new option to the list, enter the 
new option with a space after the comma. The maximum 
purpose name length is 30 characters.  
Please note the comma before the first option (Transfer of 
Care) is intentional. This means the default option for the 
Purpose drop-down list will be blank.  

Note: This setting applies to Continuity of Care Records 
(CCR) and Continuity of Care Documents (CCD). 

[RegistrationNotes]  

ShowRegNoteFromMessage=ON This setting specifies whether patient registration notes are 
displayed automatically when operators click the Link 
button when viewing a message in the View Message 
screen. 
If set to ON, any relevant patient registration notes will be 
displayed. This is the default setting. 
If set to OFF, the patient chart will be displayed. 
Caution! 
This setting should be changed only through the Records 
8 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 

[StatusBar]  

ShowOperatorInStatusBar= This setting specifies whether the status bar at the bottom 
of the main Lytec MD screen shows the current operator 
ID, with the text ”r;Operator” prefacing the ID.  
If this setting =ON, the operator ID will be shown in the 
status bar. This is the default setting.  
If this setting =OFF, the operator ID will not be shown in 
the status bar.  

ShowProviderInStatusBar= This setting specifies whether the status bar at the bottom 
of the main Lytec MD screen shows the current provider 
ID, with the text ”r;Provider” prefacing the ID.  
If this setting =ON, the provider ID will be shown in the 
status bar. This is the default setting.  
If this setting =OFF, the provider ID will not be shown in 
the status bar.  

[ExternalKnowledgeReferences]  

UpToDateIntegration=OFF Configurable in Special Features on the Records 8 tab. 
Specifies whether integration with the UpToDate® Online 
reference web site is enabled. 
Your site must have a valid UpToDate subscription and 
user account for this feature to work.  
For more information on configuring and launching 
UpToDate® searches from Patient Records, see the 
Searching UpToDate® Online from Patient Records 
section. 
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UpToDateURL=http://www.utdol.com/u
td/login.do  

Configurable in Special Features on the Records 8 tab. 
Specifies the URL used to search the UpToDate® Online 
web site.  

Important: The default URL is set during installation. You 
must verify with UpToDate that this is the correct URL for 
your subscription. 

UpToDateIntegrationLevel=1 Configurable in Special Features on the Records 8 tab. 
Specifies the level of integration with the UpToDate® 
Online web site. The following options can be entered: 

• 1: Enter 1 if you use a site-based license to access 
UpToDate. This is the default value of this setting. 

• 2: Enter 2 if individual operators use separate user 
accounts to access UpToDate.  

Note: If you enter 2, you must associate Lytec MD operator 
accounts with the relevant UpToDate account information. 
For more information, see the Searching UpToDate® 
Online from Patient Records section. 

UpToDateSourceSysID=PP01 Do not change or remove this setting. 
Identifies Patient Records as the system from which search 
requests sent to UpToDate® Online are made. 
Removing or changing the value of this setting will cause 
search requests made to the UpToDate® Online web site 
to fail. 

[XDS]  

MPIConnectivity= This setting specifies whether Master Person Index (MPI) 
connectivity via Integrating the Healthcare Enterprise (IHE) 
Profiles and HITSP constructs is enabled or not.  
If this setting = ON, you will be allowed to search for 
patients in the database of the external network linked to 
your Lytec MD system and create new patient records by 
importing the patient demographic information from the 
Health Information Exchange (HIE) into your Lytec MD 
database. See the External Lookup section for more 
information. 
If this setting = OFF, MPI connectivity will be disabled for 
your Lytec MD system and the External Lookup tab will be 
missing on the Patient Lookup screen.   
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XDSConnectivity= This setting specifies whether Cross-Enterprise Document 
Sharing (XDS) connectivity is enabled for your Lytec MD 
system or not.  
If this setting = ON, you will have access to the Import from 
Document Repository feature which allows you to view and 
import patient clinical data from the Document Repository 
into your Lytec MD database. If this setting = ON, you will 
also be allowed to export clinical data on a patient in 
Patient Records to the Document Repository using the 
Export to Document Repository feature.  

Note: If the XDSConnectivity setting is set to ON, the 
MPIConnectivity setting must also be set to ON. 

If this setting = OFF, Cross-Enterprise Document Sharing 
(XDS) connectivity will be disabled for your Lytec MD 
system and the Import from Document Repository and 
Export to Document Repository features will be missing 
from the Task and Reports menus, respectively.  

ConfigurationFile= This setting specifies the name and the location of the 
configuration file (xds.config) used to set up parameters 
for the components managing the communication 
between Lytec MD and the HIE linked to your system.  
The xds.config file is typically located in 
p:\ppart\Interface\XDS\.  
Use the Lytec MD Cross-Enterprise Document Share 
Configuration Utility (PMSI.xdsConfigurationUtility.exe) 
located in your Lytec MD database directory (p:\ppart\) to 
setup the parameters for the xds.config file. Please refer to 
the Lytec MD Cross-Enterprise Document Share 
Configuration Utility Guide for step-by-step instructions.  

[ExternalSystems]  

Types= This setting allows you to configure the options displayed 
from the Types drop-down list on the New External System 
screen and the Edit External System screen. The maximum 
type name length is 30 characters.  This field should not 
be modified in normal use. 

[HorizonPatientFolder]  

Installed= This setting specifies whether Horizon Patient Folder can 
be accessed from Patient Records. This setting must be set 
to ON to enable Horizon Patient Folder integration. 
If this setting =ON, authorized operators can launch 
Horizon Patient Folder from Patient Records.  
If this setting =OFF, no button will be present to allow 
users to launch Horizon Patient Folder. This is the default 
setting.  
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RequirePWD= This setting indicates whether the Horizon Patient Folder 
system to which Lytec MD is connected to is configured to 
require Horizon Patient Folder user passwords.  
Set this setting to =ON, if the Horizon Patient Folder 
system to which Lytec MD is connected is configured to 
require passwords. When set to ON, you must enter a user 
name and password for the Operators you link to HPF 
through the External System User screen.  
Set this setting to =OFF, if the Horizon Patient Folder 
system is not configured to require passwords. This is the 
default setting.  

SecureToken= This setting indicates whether the Horizon Patient Folder 
system to which Lytec MD is connected to is configured 
require a secure token.  
Set this setting to =ON, if the Horizon Patient Folder 
system to which Lytec MD is connected is configured to 
require a secure token. This is the default setting. 
Set this setting to =OFF, if the Horizon Patient Folder 
system is not configured to require a secure token.  

EMRV= This setting indicates whether the MRV or EMRV option 
shall be used when launching Horizon Patient Folder from 
a patient’s chart Patient Records. This option is dependent 
on whether your organization uses the Medical Record 
View (MRV) module or the Enterprise Medical Record View 
(EMRV). 
Set to =ON, if the EMRV option will be used when 
launching HPF from a patient's chart. This is the default 
setting. 
Set to =OFF, if the MRV option will be used when 
launching HPF from a patient's chart.  

appID= This setting stores the AppID used to identify the host 
system identifier to include in the Horizon Patient Folder 
URL calls. The AppID entered here must be the same in 
both systems, Lytec MD and HPF.  
Please note this is an optional setting. It is recommended 
that you check with your HPF System Administrator to see 
if this is needed, or see the Horizon Patient Folder 
WebStations Web Integration Services Integration Guide 
for Customers for more information about AppIDs. 
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CloseBrowser= This setting specifies whether the web browser with the 
current HPF session will close when Patient Records is 
closed or parked.  
Set this setting to ON, if you want Internet Explorer to 
close.  
Set this setting to OFF, if you want Internet Explorer to stay 
open. This is the default setting. 

Important: If your organization is using Internet Explorer 8, 
and this setting is set to ON, if Lytec MD is closed and the 
HPF session is still open, the next time Internet Explorer 8 
is opened, users will receive the message, "Your last 
browsing session closed unexpectedly. Would you like to 
restore your last session, or go to your home page?". If a 
user clicks Restore last session, they may have access to 
the HPF screen that was open before Lytec MD was closed. 
Due to this behavior it is recommended that this setting be 
set to OFF. 

Manual Settings 

EMRV only  

AlternateID= If your organization is using the Enterprise Medical Record 
View (EMRV), you must add the "AlternateID" setting to the 
PPart.ini file under the [HorizonPatientFolder] section.  
You must populate this setting with the name of the Patient 
Alternate ID label which will represent the HPF "enterprise 
patient number" (EPN) in Patient Records. You only need 
to store one HPF identifier for all of your patients. 
For example:  
AlternateID=EPN 

Note: This is the label that you will enter as a Patient 
Alternate ID (user-defined field) in Patient Records. For 
example, if you enter EPN here, you will add this as the 
label name for the Patient Alternate ID.  
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MRV only  

AlternateIDx= If your organization is using the Medical Records View 
(MRV) module, you must add the "AlternateIDx" setting(s) 
to the PPart.ini file under the [HorizonPatientFolder] 
section. Where "x" is a number between 1 and 9. The 
setting(s) allow you to store one HPF identifier for each 
"facility" in the organization that hosts HPF. Thus, your 
organization will have to set up one Patient Alternate ID for 
each of the HPF facilities. You can add up to 9 HPF 
facilities.  
You must populate the setting(s) with the name of the 
Patient Alternate ID label that shall be used to store the 
HPF medical record number (MRN) for a particular HPF 
facility, and the HPF Facility ID for that HPF facility, 
separated by a comma.    
For example: 
AlternateID1=ACME DOWNTOWN, DWNTN 
AlternateID2=ACME EASTSIDE, EAST 
AlternateID3=ACME WESTSIDE, WEST 

[Disclaimer]  

ShowDisclaimerOnUnpark= 
 

Configurable in Special Features on the General tab. This 
setting specifies whether the Disclaimer screen is 
displayed after un-parking a workstation. 
If this setting =ON, the Disclaimer screen will be displayed 
after a workstation is unparked.  
If this setting =OFF, the Disclaimer screen will not be 
displayed after a workstation is unparked. This is the 
default setting.  

DisclaimerText= 
 

Configurable in Special Features on the General tab. You 
can use this setting to specify your own login or warning 
text (for example, "The system should only be accessed by 
authorized users.") which will be displayed on the 
Disclaimer screen. The text will be displayed in bold at the 
top of the screen. You can start adding your text after the 
equal sign. The maximum length is 2000 characters.  

[RelayHealth]  

Installed= This setting is added to the ppart.ini file when the 
PPConnect: RelayHealth Inbound and Outbound Interfaces 
are installed. When the interfaces are installed the setting 
will =ON. Do not change this setting in the ppart.ini file 
unless instructed to do so by Lytec MD personnel. 

MessageCountTimer= This setting defines how often the Community Message 
button on the Dashboard should be refreshed.  
The default is 60 seconds. If necessary, you can change this 
number. 
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InboundNoteSection= This setting defines the storage location of RelayHealth 
"clinical messages" imported into Lytec MD. The default 
setting is Progress Notes (value = "00").   
Caution! 
This setting should be changed only through the Records 
1 tab on the Special Features screen. Do not modify the 
setting in the PPart.ini file. 

[WebView]  

AllowWVMessageToPatientFromPR= This setting controls whether messages are sent to patients 
through Web View in Patient Records or RelayHealth. If 
your site uses Web View and RelayHealth you can use this 
setting to control whether users have the option of sending 
outbound messages to patients from Lytec MD through 
Web View. If set to "OFF" then the screen controls in Lytec 
MD messaging that allow specification of a patient as an 
addressee for a Lytec MD message will be hidden. When 
the Lytec MD Connect - RelayHealth interface is installed, 
this setting will be set to OFF. Your system administrator 
can change this setting depending on your site's 
preference. 
When this setting =ON, messages sent to Patient Records' 
patients will be sent through Web View. 
When this setting =OFF, messages sent to Patient Records' 
patients will be sent through RelayHealth. 

AllowWVMessageToReferringSourceFro
mPR= 

This setting controls whether messages sent to outside 
providers (referring sources) are through Web View or 
RelayHealth. If your site uses Web View and RelayHealth 
you can use this setting to control whether users have the 
option of sending outbound messages to patients from 
Lytec MD through Web View. If set to "OFF" then the 
screen controls in Lytec MD messaging that allow 
specification of a Referring Source as an addressee for a 
Lytec MD message will be hidden. When the Lytec MD 
Connect - RelayHealth interface is installed, this setting will 
be set to OFF. Your system administrator can change this 
setting depending on your site's preference. 
When this setting =ON, messages sent to Patient Records' 
referring sources will be sent through Web View. 
When this setting =OFF, messages sent to Patient Records' 
referring sources will be sent through RelayHealth. 
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License manager error codes 
If an error code displays after you initially log in to Lytec MD, there is a licensing error present in the 
application. The error may be present in the ppart.ini file, or the new license files MRAC99.* and 
MRAL99.*  

The MRAC99.* files contain the records for the maximum number of licenses allowed. The MRAL99.* 
files contain the records for licenses of each installed application. These files are located in the 
database directory.  

If the error message dialog box displays, write down the error code before you click the OK button. 
Clicking the OK button closes the system immediately.  

Look up the error code in the first column of the table below. The second column explains the meaning 
of the error code, and the third column tells you what you can do to fix the problem. After you fix the 
problem, you can restart Lytec MD.  

License manager error codes 
The table below lists the PPL licensing error code, what the error code means, and how to fix the 
problem.  

Error code Description How to resolve the problem 

22 The license files MRAC99.* and 
MRAL99.* are empty.  

Run the SETUSER2 utility. 

26 The line 
SecondsToWaitToSayStillBusy does 
not have a value, or the value is 
incorrect. 

Open the ppart.ini file located in the 
database directory and check the line 
SecondsToWaitToSayStillBusy in the 
[LicenseWaitIntervals] section. Make 
sure that there is a value entered at 
the end of the line. The value must be 
greater than zero. 

27 The line SecondsToWaitForLicense 
does not have a value, or the value is 
incorrect. 

Open the ppart.ini file located in the 
database directory and check the line 
SecondsToWaitForLicense in the 
[LicenseWaitIntervals] section. Make 
sure that there is a value entered at 
the end of the line. The value must be 
greater than zero. 

34 The value for the line 
SecondsToWaitForLicense is less than 
the value for the line 
SecondsToWaitToSayStillBusy. 

Open the ppart.ini file located in the 
database directory and check the line 
SecondsToWaitForLicense in the 
[LicenseWaitIntervals] section. 
Increase the value entered at the end 
of the line so that it is at least twice as 
large as the value for the line 
SecondsToWaitToSayStillBusy. 

0 to 21, 23 to 25, 28 
to 33 

These error codes indicate various 
errors in the license files MRAC99.* or 
MRAL99.* 

Run the Reset User Count utility. 
If the Reset User Count utility does 
not fix the problem, run the 
SETUSER2 utility.  
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-214 The license files MRAC99.* or 
MRAL99.* are corrupt. 

Run the Rebuild utility. 

-311 The indexes need to be rebuilt. Run the Rebuild utility. 
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User licenses 
Lytec MD manages user licenses in the following ways: 

• If the application unexpectedly exits or crashes, a user can instantly log back in on the same 
machine, and recover the same license, without having to wait. 

• If all licenses are taken, the minimum wait time displays while a user waits for an available license. 
When the time runs out, the application will either find a license or, if not, it will exit. 

As system administrator, you can control some ways that user licenses are managed. By modifying 
default values in the license files and/or running the license utilities, you can: 

• Specify the intervals in which user licenses are reassigned. 

• Force recovery of lost licenses while users are still in the system. 

• Verify the number of current user licenses in use and determine the location of users. 

Note: If you purchased Patient Records, Appointment Scheduler, and Order Entry separate user 
license counts are maintained for each product. 

Note: If you use Windows Terminal Server (WTS), Citrix Winframe, or Citrix Metaframe server, the 
features mentioned above for determining the location of a user and instantly recovering a lost user 
license are not active. In addition, you MUST create or edit the PPUSER.INI file in the client directory to 
indicate that the executable directory is shared among multiple users. See License Notes for WTS and 
Citrix Users. 

Retrieving the Same License Instantly if the Application Exits 
Unexpectedly  
If the application exits unexpectedly (or the workstation crashes), a user can restart the application and 
then log in instantly. The user will be able to recover the same license that he or she was using. The 
user does not have to wait for the next available license.  

Note: This feature is not available if the user is a Windows Terminal Server or Citrix session. See Notes 
for WTS and Citrix Users.  

Monitoring the status of your licenses 
To find out how many users are logged into the application at any given time, run the LICSTAT utility 
located in the database directory. This utility creates and opens a text file, named LICSTAT.txt, that lists 
how many licenses are taken and how many are available.  

You can also determine the location of a user by using the LICSTAT utility and the PPUSER.INI file. To 
use this option, see Determining the Location of a User. 

Verifying the number of licenses used  
To verify the number of licenses used:  

1. Select the Start button, then select Run.  

2. In the Run dialog box, type drive:\path\Licstat  
 
(where drive is the drive letter, and path is the database directory)  

3. Click the OK button.  
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Note: You must run this utility each time you want to verify the number of licenses used.  

The LICSTAT.txt file is created and opened (using Notepad or another text editor), displaying the Lytec 
MD Licenses. This file is located in the database directory.  

The “App” column indicates the application license being used: PR for Patient Records, AS for 
Appointment Scheduler. If you have more than one Lytec MD application, a separate group displays 
the licenses for each application.  

The “In Use” column indicates “Yes” for a license currently in use, and “No” if not used.  

The “License ID” column indicates the number assigned for each user license.  

The “User Name” column indicates the user’s name.  

The “User Location” column indicates the user’s location, if this option is activated.  

Below the list of user licenses is a line that indicates how many Total Licenses were found.  

At the bottom section of this text file is a summary that shows the total number of user licenses allowed 
for each application.  

A sample LICSTAT.txt file is shown below.  

Lytec MD Licenses  

------------------------------------------------------------------------------  

App In Use License ID User Name User Location  

------------------------------------------------------------------------------  

PR Yes 1 Steve Clinic2, Room 211  

PR Yes 2 Bob Clinic1, Room 525  

Total PR licenses found: 2  

AS Yes 1 Mary Clinic3, Room 447  

AS Yes 2 Bob Clinic1, Room 525  

Total AS licenses found: 2  

------------------------------------------------------------------------------  

Total PR licenses allowed: 2  

Total AS licenses allowed: 2  

------------------------------------------------------------------------------  

The example above indicates that two user licenses were found for Patient Records (PR) and two for 
Appointment Scheduler (AS). Steve is using a PR license, Mary is using an AS license, and Bob is using 
both a PR and an AS license. In this case, the maximum licenses allowed for PR and AS is two licenses 
each. Steve is in Clinic2, Room 211; Mary is in Clinic3, Room 447; and Bob is in Clinic1, Room 525.  

Determining the location of a user 
Note: This task should be performed only by the system administrator.  

Note: This feature is not available if the user is a Windows Terminal Server or Citrix session. See Notes 
for WTS or Citrix users.  

To determine the location of a user, you must edit the PPUSER.INI file, as described below.  
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Run the application to create the PPUSER.INI file in the executable directory. Then exit the application. 
Before you open the PPUSER.INI file, make a backup copy. For example, save the backup copy as 
PPUSER.BAK.  

Use Windows Notepad to open the PPUSER.INI file. Find the section labeled “UserInfo”.  

Add a line to UserInfo, labeled “UserLocation=”, to the UserInfo section. Thus, you can help determine 
a user’s location by entering a description of the location. The description can be up to 25 characters 
long (including spaces).  

The description that you enter here will display in the LICSTAT.TXT file. The user location will display 
next to the user name. To view the LICSTAT.TXT file, run the LICSTAT utility.  

The other lines in “UserInfo” are automatically added and updated by the application, and track the 
user’s license ID and the date that the user last accessed the application.  

For example, open the PPUSER.INI file using a text editor. Add the line UserLocation=Clinic1, Room 
525 to the UserInfo section, and save the file. When you view the LICSTAT.TXT file, you will see Clinic1, 
Room 525 in the new User Location column for the user assigned with this location. Below is an 
example of a complete UserInfo section in PPUSER.INI:  

[UserInfo]  
LastUserIdForApp1=624  
LastDateForApp1=01/02/00  
LastUserIdForApp2=624  
LastDateForApp2=01/02/00  
UserLocation=Clinic1, Room 525  

When a User License is Unavailable  
If a user wants to log in to Patient Records, but all available user licenses are currently being used, a 
message informs the user that the application is waiting to see if a user license becomes available. The 
minimum wait time to retrieve a license displays. The message indicates the time remaining as it counts 
down. The wait time is the value entered for SecondsToWaitForLicense in the ppart.ini file in the 
database. If the user does not press Cancel, then the application will wait for the time indicated. When 
the time runs out, the application will either find a license or, if not, it will exit.  

The system administrator can hasten this process by running the PROCID utility as described below.  

Note: If a message displays an error code after you initially log in to Lytec MD, see Troubleshooting the 
License Manager Error Codes.  

Message Indicating License File is Busy  
If you run the PROCID utility at the same time as someone else, the following message displays:  

“License file is busy. Please try again.”  

Wait for a few minutes, and then try running PROCID again.  

As an alternative, you can run the Reset User Count utility from the Lytec MD Utilities option.  

Message Indicating User License Unavailable  
If a user gets the message, “Waiting to see if a User License becomes available. Press Cancel to exit 
immediately,” and the user presses Cancel, the following message displays:  

“License recovery cancelled. To recover lost User Licenses, restart Lytec MD and wait the indicated 
time, or ask the System Administrator to run the Lytec MD Utilities. Press OK to exit.  
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(The Wait Time for License recovery is configurable by the System Administrator)”  

Press the OK button to close the application, then you should run the Reset User Count utility. Then run 
the LICSTAT utility to verify how many licenses are being used. This utility creates and opens a text file, 
called LICSTAT.txt, that lists how many licenses are taken and how many are available.  

When viewing the text file, look at the line Total Licenses Allowed for each application. If the total 
number of licenses is not the same as the number of licenses you have purchased, then you should run 
the SETUSER2 utility. For example, if you see a total of only three user licenses instead of the ten you 
purchased, run SETUSER2 to correct the licenses allowed.  

If you are using both Patient Records and Appointment Scheduler, you should check the access level 
for all users. If the Access level allows a user to use both applications (which means the user is using 
one license for each application), instead of just one application as intended for the user, then you 
need to limit the application (and license) for the Access level. See Assigning Access Levels.  

Notes for WTS and Citrix users 

Avoiding License Conflicts 

If you use Windows Terminal Server (WTS), Citrix Winframe, or Citrix Metaframe server, you must add a 
special section in the PPUSER.INI file – located in the executable directory – to avoid user license 
conflicts when multiple users log in to the application at the same time. 

Make a backup copy of the PPUSER.INI file. Then add the following new section and line in PPUSER.INI:  

[Environ] 

SharedExeDir=Yes 

Running the SETUSER2 utility  
To run the SETUSER2 utility:  

1. Insert your License diskette into the floppy drive (for example, A: drive).  

2. Select the Start button, then select Run.  

3. In the Run dialog box, type: drive:\path\setuser2  
(where drive is the drive letter, and path is the database directory)  
For example: f:\ppart\setuser2  

4. Click the OK button.  

Running the PROCID utility 
You are not required to log out everyone using Patient Records in order to use the PROCID utility. This 
utility recovers user licenses that have become unusable due to an improper exit from the application. 
In effect, the utility re-initializes all user licenses. Users that are already logged on will be OK since they 
will re-assign themselves a license automatically.  

You should run PROCID after a power failure or some other event in which all users got knocked off the 
system. If users are getting a message that the application is waiting to see if a user license becomes 
available, you can speed up the process of getting a license by running PROCID provided that there 
are enough licenses available.  

You can run PROCID from the Run command or from the command line (DOS) prompt.  

Note: As an alternative, you can run the Reset User Count database utility. 
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After running the utility, you can verify the number of user licenses that are in use or available. See 
Monitoring the status of your user licenses.  

After running PROCID (or if a user is running a long process such as a report or a patient inquiry), if you 
have more users trying to log on than you have user licenses, an existing user could lose his license (a 
message indicates that login has been taken).  

The user should wait and see if he can log back in. If the user decides not to wait for an available 
license (by clicking the Cancel button), a message will indicate that the licenses are all taken, and that 
the user should exit Lytec MD. If the user continues to run Lytec MD, he will have limited access to the 
application.  

If the situation described in the note above occurs frequently, you should increase the interval value for 
SecondsToWaitForLicense in the PPART.ini file and/or you should purchase additional licenses. The 
value should be at least double the interval value indicated in SecondsToWaitToSayStillBusy. See 
Changing the Intervals Lytec MD Waits Before Re-assigning a User License.  

To run the PROCID utility from the Run command:  

1. Select the Start button, then select Run.  

2. In the Run dialog box, type drive:\path\Procid  
 
(where drive is the drive letter, and path is the database directory)  

3. Click the OK button.  

To run the PROCID utility from the command line (DOS) prompt:  

1. Open a command line (DOS) prompt at the database directory (usually \ppart).  

2. At the command line (DOS) prompt, type Procid  

3. Press ENTER.  
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Setting up Patient Education, knowledge base, and 
browser 
Settings are shared between Patient Education and the knowledge base and browser. The table below 
describes the options that are available. 

Field Description 

E-mail/Printing tab 
 

The E-mail/Printing tab sets for e-mail and printing.  

E-mail  You can view the comment before sending it with a handout 
through e-mail by marking the Show Message Before Sending 
check box.  

Default Mail Profile  In this field, enter the name of the email program you are using, 
such as Microsoft Outlook or Microsoft Exchange.  

Default Subject  In this field, you can use the default subject (Patient Education 
Hand-out) or enter a different subject or topic. You can also 
leave this field blank.  

Printing  You can print the comment automatically when you print a 
handout by marking the Include Comments By Default check 
box.  

Web Browser: Default Home Page 
and Default Knowledge Base  

Enter the directory path for the default home page. You can 
leave the default entry “www.lytec.com” if you want to use Lytec 
MD's web page as your home page.  

Enter the HTML filename for the Knowledge Base start page. 
The software assumes the file is located in the database 
directory. This file is typically “home.lytec.html", which is 
included with the Patient Records application.  

Editor tab The note editor controls the appearance of the comment that 
you can include with a handout.  

To change the default font:  

1. Click the Select Font button. The Font screen appears.  
2. Select the Font, Font Style, Size, and Script from the 

appropriate list boxes. A sample of the selections you 
made displays in the Sample box.  

3. Click the OK button. The Default Font and Default Font 
Size fields display your selections.  

To assign or change the default template:  

1. Click the Select File button.  
2. Select the file from the list. This file must be an RTF file.  
3. Click the Open button. The file name and directory 

appears in the Default Text field. The Preview box 
displays a sample of the text.  
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Files tab For this section, you can specify a location for the handout files, 
and which education module to load by default.  

Education Handouts  You can specify where files for the handouts are located:  

If the files are located in a local or network directory, mark the 
File System Directory radio button, then enter the directory 
path in the field.  

If the files are located on a Web site, mark the Web Server URL 
radio button, then enter the Web address in the field.  

Default Education Module  You can select which module will be automatically loaded as 
the default when no patient is selected. For example, let’s 
assume that you are currently using the Adult Advisor module 
as the default module, and then you switch to the Pediatric 
Advisor module as the new default. If you exit Patient Education 
and the Patient Records program and then re-enter both, the 
Pediatric Advisor module appears.  

To change the default module, select a module in the Default 
Education Module field.  

Search By  To set the default for the Search function, mark the Code radio 
button to search by code, or mark the Description radio button 
to search by description or title.  

Default Coding System  Select a coding system in the Default Coding System field: ICD 
and CPT®.  

Note: "CPT" is a registered trademark of the American Medical Association. 
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Phone dialer 
Lytec MD provides a built-in phone dialer so that you can directly dial telephone numbers entered on 
the General tab of the Patient and Guarantor screens. Your workstation must be connected to a 
modem or other telephony device.  

Your system administrator must enter settings for the phone dialer in the ppart.ini and phone.ini files.  

Once these settings have been added, you can access the phone dialer by clicking the  button next 
to the telephone number. When the Phone Dialer screen appears, verify that the phone number is 
correct and click the Dial button.  

Setting up the phone dialer 
The phone dialer uses settings in the ppart.ini file (in the database directory) and phone.ini file (in the 
workstation’s executable directory, where the PMSIPhone.ocx file is registered). The ppart.ini file 
applies to all workstations, while the phone.ini file is workstation-specific.  

To set up the phone dialer's ppart.ini settings: 

Note: Before you open the ppart.ini file, make a backup copy. For example, save the backup copy as 
ppart.bak.  

1. Use Windows Notepad or another text editor to edit ppart.ini in the Lytec MD database 
directory.  

2. Locate the [DialingSettings] section.  

3. Add or change the phone dialer variables, then save the ppart.ini file.  

To set up the phone dialer's phone.ini settings: 

Note: Before you open the phone.ini file, make a backup copy. For example, save the backup copy as 
phone.bak.  

1. Use Windows Notepad or another text editor to edit phone.ini in the workstation’s executable 
directory.  

2. Locate the [DialingSettings] section.  

3. Add or change the phone dialer variables, then save the ppart.ini file.  

Variables for the phone dialer in the ppart.ini file 
Field Description 

LocalAreaCodes=  Type the area codes that are local to your practice. Use a 
comma between each area code (for example, 
LocalAreaCodes=206,425).  

LocalAreaPrefixes1=  Type the prefixes (the first three numbers in a phone number) 
that are local to your practice. Use a comma between each 
prefix (for example, LocalAreaPrefixes1=418,692).  

LocalAreaPrefixes2=  Type additional prefixes (the first three numbers in a phone 
number) that are local to your practice. Use a comma between 
each prefix (for example, LocalAreaPrefixes2=987,876,321).  
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InStateAreaCodes=  If you have an in-state long distance calling program, type the 
non-local area codes for your state. Use a comma between 
each area code (for example, InStateAreaCodes=360).  

PrefixOverride= If PrefixOverride=ON, the prefix entered in the workstation’s 
phone.ini will be used. If no prefix is entered in the phone.ini, 
the prefix entered in the telephone field on the General tab will 
be used.  
If PrefixOverride=OFF, the prefix entered in the telephone field 
on the General tab will be used. If the phone number does not 
have a prefix, the prefix entered in the workstation’s phone.ini 
will be used.  

SuffixOverride= If SuffixOverride=ON, the suffix entered in the workstation’s 
phone.ini will be used. If no suffix is entered in the phone.ini, 
the suffix entered in the telephone field on the General tab will 
be used.  
If SuffixOverride=OFF, the suffix entered in the telephone field 
on the General tab will be used. If the phone number does not 
have a suffix, the suffix entered in the workstation’s phone.ini 
will be used.  

Variables for the phone dialer in the phone.ini file 
Field Description 

CommPort= Type the communication (serial) port to which the modem is 
connected (for example, if the modem is attached to COM2, 
use CommPort=2).  

LocalPrefix=  Type the number(s) required to access an outside line for local 
calls (for example, "LocalPrefix=9"). Leave blank if a number is 
not needed to dial an outside line.  

LDPrefix=  Type the number(s) required to access an outside line for long 
distance calls (for example, "LDPrefix=9,1"). The comma causes 
a pause when dialing. Leave blank if a number is not needed to 
dial an outside line.  

ISPrefix=  Type the number(s) required to access an outside line for in-
state long distance calls (for example, "ISPrefix=8,1"). The 
comma causes a pause when dialing. Leave blank if a number is 
not needed to dial an outside line.  

LocalSuffix=  Type the number(s) that need to be entered after local calls (for 
example, "LocalSuffix=643"). Leave blank if a suffix is not 
required.  

LDSuffix=  Type the number(s) that need to be entered after long distance 
calls (for example, "LDSuffix=6411"). Leave blank if a suffix is 
not required.  

Extension=  Type the extension for the workstation’s phone line. Leave 
blank if the workstation does not have a phone extension.  
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 Prescription format files 
Prescription format files determine the layout of prescription information on printed and faxed 
prescriptions. As part of setup, you should create a default prescription format file for your practice. 
Depending on the specific prescription format requirements of your practice, you can specify different 
content for printed as compared to faxed prescriptions by creating two separate prescription format 
files for printed and for faxed prescriptions. If required, you can also create custom prescription format 
files for individual providers in your practice. You can also use the default prescription format file 
provided with Patient Records. 

Contents of a prescription format file 
Prescription format files can contain the text information that you want to include in every prescription, 
such as the provider name, address, phone number, DEA number, and signature line. In addition, the 
file can contain identifiers that specify where to print variable information such as the patient’s name 
and address, medication name, sig, frequency, amount to dispense, etc.  

When a prescription is printed, any variables in the prescription format file are automatically replaced 
with the relevant information, as shown in the example below:  

Line in the prescription format file: 
Dispense: %long_amt with %long_ref refills 

Line in the printed/faxed prescription: 
Dispense: Fifty with two refills  

Note: The extended sig will always be printed in Courier New font. This is to make sure all lines of the 
extended sig are the same length and to prevent it from being truncated. When attempting to print an 
extended sig that will not fit on a prescription, you will receive a warning message that the extended 
sig will be truncated. 

Prescription format files can be created in either plain text or HTML format. Plain text prescription 
format files must be saved with a .CFG file extension. HTML prescription format files can be saved with 
either a .HTM, .HTML, or .CFG file extension. 

When you have created your default prescription format files for printed and faxed prescriptions, enter 
their names in the Prescription Defaults screen. If you created customized prescription format files for 
individual providers, enter the name of the relevant file in each provider’s Provider Maintenance 
screen. 

Note: The width of the top and left margins for all printed prescriptions are specified by the 
LeftMarginWidth and TopMarginWidth settings in the ppart.ini file. 

Example prescription format files 
Lytec MD provides an example prescription format file in HTML format (Rx.cfg). This file is specifically 
designed for use with the Lytec MD HTML Editor. You can modify this file to suit your needs, or use it as 
is. The example Rx.cfg file includes the date, the patient's name and address, the first 6 allergies on the 
patient's allergy list, the details of the prescription (including up to 6 lines of the extended sig and the 
note), the Provider name, the Provider DEA (if the prescription is a controlled substance), and the 
practice name, address, telephone number, and fax. It also includes two places for the Provider to sign 
the printed prescription, one labeled "Substitution Permitted" and one labeled "Dispense as Written". 

The example Rx.cfg file can be found in both the database directory (usually p:\ppart) and the 
\ppeditor directory (usually p:\ppart\ppeditor\). 
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If you would like different content for faxed prescriptions, you can make a copy of the existing Rx.cfg 
file, modify it as necessary, save it in the appropriate location and set it up as a default Rx Format File 
for Faxing on the Print Defaults tab of the Prescription Defaults screen. 

Configuring a prescription format file (HTML format) 
You can use various applications to create and edit prescription format files in HTML format. The 
following sections describe how to do this in the Lytec MD HTML Editor or Microsoft® Word, but you 
could also use an HTML editor such as Adobe® Dreamweaver® or Nvu, or, if you are comfortable 
writing HTML code, a text editor such as Microsoft Notepad.  

WYSIWYG editors such as Word or Dreamweaver will automatically generate the HTML code for you. If 
you choose to write or edit the prescription format file HTML code directly in a text editor, you must 
ensure that the file contains at least the opening and closing <HTML> tags, and that your HTML code is 
valid. You can include any valid HTML tags in the file. 

Note: HTML prescription format files can be saved with either a .HTM, .HTML, or .CFG file extension. 

Using the Lytec MD HTML Editor 
Lytec MD provides an HTML Editor utility that can be used to create and edit HTML prescription format 
files.  

The Lytec MD HTML Editor utility is installed automatically in the /ppeditor directory below the Lytec 
MD database directory (typically, p:/ppart/ppeditor/).  

Note: For detailed information about using this utility to create HTML prescription format files, see the 
HTML Editor User's Guide, located in the Documentation directory on your installation CD.  

To add or edit a prescription format file (HTML format) in the Lytec MD HTML Editor: 

1. Open Windows Explorer and navigate to the p:\ppart\ppeditor\ directory (where p:\ppart is 
the Lytec MD database directory). 

2. Double-click the ppeditor.exe file. The HTML Editor appears. 

3. Do one of the following: 
• To open an existing HTML prescription format file, select File > Open, and select the file. 

An example file (RX.CFG), specifically designed for use in the HTML Editor, is available in 
the p:\ppart\ppeditor\ directory. 

• To create a new HTML prescription format file, select File > New. 

4. Add or edit the text and variables that you want to include on the prescription. 

5. Format the text as you want it to appear on the printed prescription. If required, you can use 
tables to control the layout of variables such as logos (%prac_logo) and header images 
(%prov_header) in the prescription format file. 

6. When you have made all your changes, select File > Save As, navigate to the location in which 
you want to save the file, and then click Save. 

Using Microsoft Word 
You can also use Microsoft Word to create or edit HTML prescription format files. If you choose to do 
this, you must save the files using the Web Page, Filtered (*.htm; *.html) format in Word. 

To add or edit a prescription format file (HTML format) in Microsoft Word: 

1. Open Microsoft Word and do one of the following: 
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• Open an existing HTML prescription format file. 

• Start a new document. 

2. Add or edit the text and variables that you want to include on the prescription. 

3. Format the text as you want it to appear on the printed prescription. If required, you can use 
tables to control the layout of variables such as logos (%prac_logo) and header images 
(%prov_header) in the prescription format file. 

4. When you have made all your changes, select File > Save As, navigate to the location in which 
you want to save the file, select Web Page, Filtered (*.htm; *.html) from the Save as Type list, 
and then click Save. Word saves the file with a .HTM file extension. 

Important: After saving the document as a filtered web page, you should reopen it in Word and 
verify that the layout has not changed. If required, make additional edits to fix any layout issues, 
and then resave the document before continuing. 

5. In Windows Explorer, navigate to the location in which you saved the file, right-click the file, 
select Rename, and then change the file’s extension to .CFG. 

Note: If required, you can leave the prescription format file extension as .HTM. If you do this, 
ensure that any references to the file in the Prescription Defaults and Provider Maintenance screens 
use the .HTM file extension. 

6. Verify the layout of the updated prescription format file by printing a test prescription and 
viewing the results. 

Configuring a prescription format file (plain text format) 
You can also create prescription format files in plain text format. 

To add or edit a prescription format file (plain text): 

1. Open a text editor such as Microsoft Notepad and do one of the following: 
• Open an existing plain text prescription format file. 

• Start a new document. 

2. Add or edit the text and variables that you want to include on the prescription. 

Note: The top two lines of plain text prescription format files must both contain a number. These 
numbers specify the top and bottom margins for prescriptions printed on dot-matrix printers. The 
first line specifies the top margin; the second specifies the bottom margin. The unit of measure is 
the number of lines. 
 
These numbers do not affect prescriptions printed on other types of printers, however, the two 
lines must always be included in all plain text prescription format files.  

3. Save the file as plain text (ASCII format) with a filename that uses the extension .CFG. 

4. Verify the layout of the updated prescription format file by printing a test prescription and 
viewing the results.  
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Prescription format file variables 
The following variables can be included in the prescription format file to specify the position of the item 
in the printed prescription: 

Code Description 

%d The prescription date, written in mm/dd/yy format (for example, 
2/23/08). 

%long_date The prescription date, written as a full date (for example, 
February 23, 2008). 

%med Medication name. 

%siz The medication pill size from the size field in the prescription. 

%take The take field (how many pills to take) in the prescription. 

%freq The frequency field (how often to take) in the prescription. 

%dur The duration field in the prescription. 

%amt The Amount field (how much to dispense) in the prescription. 

%long_amt The Amount field, with the amounts written in long form (for 
example, 100 is written as one hundred). 

%ref The number of refills. 

%long_ref The number of refills, with the refill written in long form (for 
example, 100 is written as one hundred). 

%sig Extended sig. Free form text with more sig information. All lines 
of the extended signature will print. To allow room for the free 
form text, the %sig should be alone on its line. Any text in the 
format file that is on the same line as the %sig will be ignored. 

%sig# Multiple line extended sig. The # refers to the maximum 
number of line (up to 10). Use the maximum you intend to use 
so your prescriptions will not vary in length. Blank lines will be 
added if your sig is short. 

%rt The drug route. 

%not Note on the prescription. 

Note: Prescription notes will only be printed if the Print Note 
check box is selected in the Prescription Defaults screen. 

%n Patient name and middle initial. 

%na1 Patient address line 1. 

%na2 Patient address line 2. 

%na3 Patient address line 3. 
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%csz Patient city, state, ZIP Code. 

%htel Patient home telephone number. 

%btel Patient business telephone number. 

%id Patient ID. 

%dob Patient date of birth. 

%age Patient age. 

%soc Patient social security number. 

%wt Patient weight. 

%al Patient allergies. You can use this variable up to nine times to 
list a maximum of nine allergies. 

%xsub Inserts an X if Substitution OK is marked. 

%prov_name Provider's full name. 

%prov_dea Provider's DEA number. 

%prov_lic Provider's state license number. 

%lpract Login practice. 

%practa1 Practice address line 1. 

%practa2 Practice address line 2. 

%practa3 Practice address line 3. 

%practcsz Practice city, state, ZIP Code. 

%practco Practice country. 

%practtel Practice telephone number. 

%practfax  Practice fax. 

%carrier Carrier description. 

%plan Patient primary plan. 

%groupnum Patient primary group number. 

%InsID Patient primary insurance ID. 

%prov_cond_dea  Print provider's DEA number only if this is a DEA restricted 
drug.  

%font_sizeXX Font size. For example, %font_size10. 

%ind1c    Diagnosis code for Indication 1. 
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%ind1d  Long description for Indication 1 (or the short one if long 
description is blank). 

%ind2c  Diagnosis code for Indication 2. 

%ind2d Long description for Indication 2 (or the short one if long 
description is blank). 

%sex Patient's sex. 

%prov_signature Provider's signature image, as specified in the Signature Image 
for Faxing field on the Provider Maintenance screen Records 
tab. 

Note: The provider signature image will only be displayed on 
faxed prescriptions. 

%prov_header Provider header image. 

%prac_logo Practice logo. 

%RxTracking Prescription tracking number.  
Note that tracking numbers for prescriptions are only recorded 
when: 

 The TrackRxNumber setting is set to ON in the 
ppart.ini file. 

 Auditing is enabled for prescription printing. To turn on 
auditing, run the PRUtils utility and select the Audit 
Printing of Individual Records check box on the Audit 
Trail tab. 

%RxTrackingFaxOnly Prescription tracking number if the prescription is being faxed 
(if the prescription is not being faxed, nothing will be 
displayed). 
Note that tracking numbers for prescriptions are only recorded 
when: 

 The TrackRxNumber setting is set to ON in the 
ppart.ini file. 

 Auditing is enabled for prescription printing. To turn on 
auditing, run the PRUtils utility and select the Audit 
Printing of Individual Records check box on the Audit 
Trail tab. 

%DAW "DAW" will be displayed when the Substitution OK option is 
not selected on the Prescription screen. Nothing will be 
displayed if the Substitution OK option is selected. 

%DAWlong "Dispense as Written" will be displayed when the Substitution 
OK option is not selected on the Prescription screen. Nothing 
will be displayed if the Substitution OK option is selected.   

%cad Practice address line 1, address line 2, and address line 3. 
When included in the prescription format file, this variable will 
not show blank address lines.  

%prov_npi Provider's NPI (National Provider Identifier). 
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%current_date The date the medication was printed or faxed, written in 
mm/dd/yy format (for example, 10/01/08). 

%current_date_long The date the medication was printed or faxed, written as a full 
date (for example, October 1, 2008). 

%oper_name Displays the Operator Name of the user who signed the 
prescription, whether they signed it with a Provider Signature or 
an Operator PIN. This variable may be useful in practices where 
a person other than the prescribing provider is given the ability 
to create prescriptions on behalf of a provider, using an 
Operator PIN. If more than one user has signed the prescription 
(that is, if one user created and signed the prescription but the 
prescription was cosigned by another user), then the name of 
the last Operator who last signed the prescription is displayed.  

%copy_or_original Indicates whether a printed or faxed prescription is an original 
prescription or a copy of the original.  
When faxed or printed output is generated when adding, 
editing, or renewing a prescription this variable will display 
different information, depending on the output mode selected 
for the prescription: 

 If the selected output mode is Print locally and 
transmit as a group, "Duplicate copy of a transmitted 
prescription" will be displayed on the prescription. 

 If the selected output mode is Print locally and fax as a 
group, "Duplicate copy of a faxed prescription" will be 
displayed on the prescription. 

 If the selected output mode is Print locally and 
remotely as a group: 

 "Original prescription" will be displayed on the 
locally printed prescription.  

 "Duplicate copy of a printed prescription" will 
be displayed on the remotely printed 
prescription. 

 If the selected output mode is Print locally 
immediately, "Original prescription" will be displayed 
on the printed prescription. 

When a prescription is printed using the Print option accessible 
through the Action button on the Rx/Medications screen, "Re-
printed copy of original prescription" will be displayed on the 
printed prescription. 
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Drug name cross-reference file 
If you use the Drug Interaction database, the system looks up drug names when you enter drugs in the 
Rx/Medications section of the patient chart. If the system cannot find your drug name in the database, it 
displays the closest match. 

For example, a name may no longer match if the Drug Interaction database changes the wording for a 
name. So that your existing Patient Records name can find the correct name in the Drug Interaction 
database, you can create a drug name cross-reference file. This file contains the Patient Records drug 
name, and the equivalent name in the drug database. Each medication name can be up to 30 
characters. 

The cross-reference file – DRUGXREF.FL – is in your Patient Records data directory, and already 
contains several entries. You can edit this ASCII file with Windows Notepad or another editor.  

Each cross reference item takes up one line with the format: 

Patient Records Medication Name, Database Medication Name 

For example: 

Penicillin, Penicillin V 
Codeine, Codeine Sulfate 
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InfoScan formulary database 
Lytec MD provides an optional integration with the InfoScan Formulary Database to track formularies 
for an extensive list of insurance companies. You must also be using Drug Interaction (an optional 
feature, available on a subscription basis, that checks patient medications for drug interactions). This 
integration saves time and eliminates potential errors, because you can automatically update the 
insurance formularies.  

Important: The insurance formularies are available only for universal Rx templates, not provider-
specific templates. When you are adding a prescription, the formularies are listed on the Insurance 
Formulary tab of the Select Rx Template screen. Insurance formularies are also available only for the 
first insurance listed on the Patient screen’s Billing tab. This tab tracks information for up to four 
insurance plans, but the formulary applies only to the first of these plans. 

If a drug name fails to match, the optional formularies search drugxref.fl (a drug name cross-reference 
file). If the drug name is found in this file, the optional formularies attempt to match the cross-
referenced drug names. 

The link to the InfoScan Formulary Database adds a User column to the Formulary screen. This column 
indicates whether the prescription is the original InfoScan template (“O”), has been modified since it 
was imported (“M”), or has been added from scratch (“U”). 

Importing and updating the InfoScan Formulary Database 
Before you can import and update the insurance formularies, you must: 

• Install the prescription formulary files to the Lytec MD database directory. 

• Add InfoScan IDs to insurance carriers in Patient Records.  

You can then use the Import Formulary utility to link the data in the formulary files to the insurance 
carriers when you receive the quarterly formulary update. 

To import and update the insurance formularies: 

1. Select Maintenance > Utilities > Import Formulary. The Import Formularies screen appears. 

2. Click the OK button. The progress bar indicates the status of the import process. 

Setting options for the InfoScan Formulary Database 
You can set options for the InfoScan Formulary Database. The options are set in the ppart.ini file (in the 
database directory). The ppart.ini file applies to all workstations.  

To set up the InfoScan Formulary Database's ppart.ini settings: 

Note: Before you open the ppart.ini file, make a backup copy. For example, save the backup copy as 
ppart.bak.  

1. Use Windows Notepad or another text editor to edit ppart.ini in the Lytec MD database 
directory.  

2. Locate the [Formularies] section.  

3. Add or change the InfoScan Formulary Database variables, then save the ppart.ini file.  
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Variables for the InfoScan Formulary Database in the 
ppart.ini file 
Field Description 

Formularies checked against templates  

Update_in_Maint= If set to =ON, Patient Records will check templates added in 
Maintenance against the existing insurance formularies.  
If set to =OFF, Patient Records will not check templates added in 
Maintenance against the existing insurance formularies.  

Formularies checked against individual prescriptions  

Update_in_Rx= If set to =ON, Patient Records will check templates added when 
you write prescriptions against the existing insurance formularies. 
If set to =OFF, Patient Records will not check templates added 
when you write prescriptions against the existing insurance 
formularies.  

Rigorous Rx matching - requires Update_in_Rx=ON.  

Rigorous_Matching= If set to =ON and Update_in_Rx=ON, prescriptions will be 
matched exactly against formularies. Matching criteria includes 
Rx name, size, route, units, etc.  
If set to =OFF and Update_in_Rx=ON, prescriptions will be 
matched against formularies only by name and size.  

Record Rx if not rigorous  

Record_if_not_rigorous= If set to =ON and Rigorous_Matching=OFF, Patient Records will 
write a list of tentative matches to a text file.  
If set to =OFF, Patient Records will not write a list of unmatched 
prescriptions.  
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Percentile graphs for children 
Lytec MD's growth charts are based on the CDC-published data. You can find these files by visiting the 
CDC web site (www.cdc.gov).  

Percentiles are contained in .plt files that you can modify. Patient Records includes a standard set of .plt 
files in the Lytec MD database directory.  

These .plt files include non-sex-specific files: 

HEIGHT.PLT 
WEIGHT.PLT 
OFC.PLT 

And sex-specific files (files that end with ME.plt use the English standard of measurement; files that end 
with M.plt use the Metric standard): 

HEIGHTM.PLT or HEIGHTME.PLT  
WEIGHTM.PLT or WEIGHTME.PLT 
OFCM.PLT or OFCME.PLT 
BMIM.PLT 

HEIGHTF.PLT or HEIGHTFE.PLT  
WEIGHTF.PLT or WEIGHTFE.PLT 
OFCF.PLT or OFCFE.PLT 

BMIF.PLT 

You may need to modify the file you choose to use, depending on whether you record your data in 
centimeters, inches, pounds, or kilograms.  

When editing the files, do not use tabs as separators, only spaces. Also, add blank lines (carriage 
returns) at the end of the file. 

For children, the vital signs graphing option can automatically plot the 5th, 10th, 25th, 50th, 75th, 90th, 
and 95th percentiles for height, weight, and head circumference. The vital signs graphing option can 
also automatically plot the 3rd, 5th, 10th, 25th, 50th, 75th, 85th, 90th, 95th, and 97th percentile for 
body mass index (BMI) for children 2 years of age to 20 years of age.  

Note: Please note that both metric and English percentile files are included with Patient Records. If you 
do not want to use this feature, rename all *.plt files to another name.  

To create or modify percentile graphs for children:  

1. Use Windows Notepad or another text editor to edit the appropriate .plt file.  

Note: For the sex-specific percentiles, if you are using the English standard of measurement, edit the 
files that end with the letter “E” for the filename before the “PLT” file extension (for example, 
HEIGHTME.PLT).  
 
The other files (for example, HEIGHTM.PLT) are for the metric standard.  

2. In the first column of each file enter the normal value. In the second column enter the age in 
years (using decimals, if necessary). For each percentile, start the section with the percentile 
name after skipping two lines.  

3. Save the file. 
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PRUtils 
The system administrator can use the PRUtils system utility to: 

• Enable the autopark feature. With this feature, workstations and Lytec MD can be automatically 
parked and/or locked after a designated period of inactivity.  

• Enable password and electronic signature (PIN) protection. This allows operators to set their own 
passwords and PINs. The maximum number of days a password can be used before it must be 
changed may be set. Password text optionally may be case sensitive (that is, "P455W0RD" would 
be a different password from "p455w0rd"). 

• Configure Lytec MD to track access to individual patients. 

• Require electronic signatures from providers on notes, and allow only one electronic signature 
per note. You can also indicate the specific note sections that require an electronic signature. 

• Require electronic signatures (PIN) for all new prescriptions, restricted (based on DEA class) 
prescriptions (new, refill or change), non-restricted prescriptions, and renewal (refills) of non-
restricted prescriptions. 

Note: To use PRUtils, your operator account must have 'Access' permissions set for the PRUtils item on 
the General tab of the Access Level Configuration screen. 

Access Logging 
When you configure Lytec MD to track access to individual patients, each time an operator opens and 
closes a patient chart, the following information is recorded: 

• Internal patient ID 

• Internal operator ID 

• Date chart was opened 

• Time chart was opened 

• Date chart was closed 

• Time chart was closed  

• External patient ID 

• External operator ID 

• Operator’s Access Level 

• Provider ID 

• Type of Access: Chart, Export, or Print  

The access log feature records information when an operator performs the following actions: 

• Opens a patient chart by clicking the Chart button on the tool bar, or by selecting File > Open 
Patient. 

• Opens a patient chart attached to a message, laboratory test results from Lab Review, or a 
progress note. 

• Prints a chart summary, a partial or complete chart, or a progress note. 

• Exports a chart using Data Export. 

An access log file entry is created for every one of the actions listed above. You can print access logs 
for selected patients using the Access Log Report.  

When the Patient Records access log feature has been enabled, you can use the Purge Access Log 
utility to purge the log file. 
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Audit Trail 
You can configure Patient Records to keep an audit trail of user actions. When enabled, this feature will 
track and record all operator events, including the adding, editing, deleting, and viewing of records. 
Patient Records will also track and record the signing of patient notes and labs. Prescription printing, 
faxing, and transmitting will also be recorded. See the Electronic Security Configurations section for 
more information.  

When one or more of the Audit Trail options is selected from this screen, Patient Records will 
automatically track and record operator activity for the following: 

• Progress Notes 

• Other Notes 

• Health Maintenance 

• Problems 

• Labs 

• Rx 

• Allergies 

• Vital Signs 

• Clinical Elements 

• Images 

• Document Links 

• Flow Charts 

• Prenatal 

• Patient 

• Patient Chart 

• Patient Lookup 

• To Do Notes. When to do notes are marked as "completed".  

• Text Data Loader. When a note is imported, the user action Add_TDL will be recorded. 

• Lab Data Loader. When a result and/or lab note is imported, the user action Add_LDL will be 
recorded. 

• Zoom. When an operator imports or links to an external file (chart notes, patient photos, or 
patient attachments) 

• Audit Trail Reports. When an operator successfully creates an audit trail report, and when an 
operator attempts to create an audit trail report and cannot generate the report because they do 
not have access level permission for the report. 

• Operator Status. When an operator's status is changed from "active" to "inactive" the action will 
be recorded as "INACTIVATE", and when the operator's status is changed from "inactive" to 
"active" the action will be recorded as "ACTIVATE".   

Your system administrator can use PRUtils to further define what is recorded. The Operator Audit Trail 
Report can be used to view the recorded data. 

Using PRUtils 
To use the PRUtils system utility: 

Note: Before using this utility, you must contact Lytec MD for the PRUtils password. 
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1. Make sure all users are logged off from Lytec MD. 

2. To start PRUtils, navigate to the client folder (typically this is the \prwin folder) and double-click 
PRUtils.exe. The Lytec MD Sign In screen appears. 

3. Type your Lytec MD User ID and Password, then click OK. The Password screen appears. 

4. Type the PRUtils password provided by Lytec MD, then click OK. A message appears asking 
whether all users are off the system. 

5. If some users are still logged in, click No. PRUtils closes. 

 If all users are logged out, click Yes. The Electronic Security screen appears. 

6. On the Signature tab, indicate whether you want to require electronic signatures on notes, and 
whether only one electronic signature per note will be allowed. You can also select whether 
you want to require entry of an electronic signature to acknowledge review of a "review-only" 
copy (CC) of a note. Then click where electronic signatures are to be required. See the 
Electronic Security Configurations section for a complete explanation of the Signature tab 
configurations. 

7. On the Access 1 tab configure the autopark, password and PIN, track access, login security, RX 
audit, and Patient Data Link options. See the Electronic Security Configurations section for a 
complete explanation of the Access 1 tab configurations. 

8. On the Access 2 tab configure the prescription electronic signature options, password 
restrictions, and PIN restrictions. See the Electronic Security Configurations section for a 
complete explanation of the Access 2 tab configurations. 

9. On the Audit Trail tab configure the items to be audited by Patient Records. See the Audit Trail 
section for a complete explanation.  

10. When finished, click OK. 

Electronic Security Configurations 
The following chart shows the configuration options divided by tab, and offers a description of each of 
the configurations. 

Configuration Description 

Signature Tab  

Require electronic signature on notes Select this option to require electronic signatures on 
notes.  

Allow only one electronic signature per note Select this option to allow only one electronic 
signature per note. 

Require electronic signature when Reviewing 
notes 

Select this option to require entry of an electronic 
signature to acknowledge review of a “review-only” 
copy (CC) of a note.   

Access 1 Tab 

Auto Park 

Lock Workstation Select this option to automatically lock the 
workstation after a specified interval (period of 
inactivity, in seconds).  

Park Workstation Select this option to automatically park the 
workstation after the specified idle interval (period of 
inactivity, in seconds).  
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Lytec MD can be automatically parked only when 
locking is enabled also.  

Note: When this option is enabled and the user has 
been idle for the specified time, this feature will only 
occur if the current active screen can be clicked. The 
workstation will still lock, but auto-park will not work. 

Idle Interval (seconds) Enter the period of inactivity, in seconds that must 
lapse before the workstation automatically locks 
and/or parks. 

Password and Pin 

User may set password Select this option to allow users to set their own 
password. When this configuration is enabled, users 
are allowed to set their own password at login. 

User may set PIN Select this option to allow users to set their own PIN 
for prescription signatures. When this configuration is 
enabled, users are allowed to set their own PIN after 
they have logged in. 

Password Interval (days) Enter the number of days the user's password is valid 
for before it expires.  
When the user is allowed to set their own password 
and their password expires; the Password screen is 
displayed during login allowing the user to create a 
new personal password. 

Track Access 

Track Access to individual patients Select this option to have Lytec MD track access to 
individual patients. 
When this configuration is enabled, Lytec MD will log 
each time an operator opens, edits, prints, or exports 
data in a patient chart. The Access Log Report allows 
users to print access logs for selected patients. 

Login Security 

Inactive User Select this option to make the user inactive after a 
specified amount of incorrect logins. Once the user is 
inactive, the system administrator must reactivate the 
user. 

Exit Application Select this option to make the user automatically exit 
the application after a specified amount of incorrect 
logins. 

Number of incorrect logins Enter the number of incorrect logins the user will 
receive before becoming inactive or automatically 
exiting the application. 

RX Audit 

Audit all RX changes (even minor ones) Select this option to audit all RX changes. When this 
configuration is enabled, any RX changes will 
automatically be tracked. 

PDL 

Enable PDL Select this check box to allow external applications to 
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request and receive clinical data on Lytec MD
patients using the Patient Data Link (PDL) 
functionality.  

Note: This setting is only available if you have Lytec 
MD Patient Data Link installed on your computer. 

Privacy Mode Select the desired privacy mode for the Patient Data 
Link (PDL) functionality. Click the arrow button to 
select one of the two available options: 

 Opt-in. Select this option if your practice 
wants to only share data on patients who give 
positive affirmation that they want their 
clinical data to be shared with the end-uses of 
the external system linked to your Lytec MD 
system through PDL. In this privacy mode, 
PDL will only return data on patients who 
have been specifically noted to have opted in 
to having their clinical data shared through 
PDL.  

 Opt-out. Select this option if your practice 
wants to share data on all patients except 
those who specifically request that their 
clinical data not be shared with the end-users 
of the external system linked to your Lytec 
MD system through PDL. In this privacy 
mode, PDL will return data on any patient 
who has not been specifically noted to have 
opted out to having their data shared 
through PDL.  

For more information on how to set up the privacy 
mode for individual patients, see Configuring the 
privacy settings for the Patient Data Link functionality 
section. 
The default setting is the privacy mode you selected 
when installing PDL Processor.  

Note: The Privacy Mode setting is only available if 
you have Lytec MD Patient Data Link installed on your 
computer. 

Access 2 Tab 

Prescriptions 

All new prescriptions require an 
electronic signature 

Select this option to require electronic signatures for 
all new prescriptions. 

Restricted (DEA) prescriptions (new, 
refill or change) require electronic 
signature 

Select this option to require electronic signatures for 
restricted (based on DEA class) prescriptions (new, 
refill or change). 

Changes of non-restricted prescriptions 
require electronic signature 

Select this option to require electronic signatures 
when there are non-restricted changes. 

Renewal (Refills) of non-restricted 
prescriptions require electronic 

Select this option to require electronic signatures for 
renewal (refills) of non-restricted prescriptions. 
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signatures 

Password Restrictions 

Minimum Password Length Enter the minimum length for the password. The 
minimum may be from 4 to 16 characters. 

Password cannot be the same as the last 
_ entries. 

Enter a number in this field to prohibit a new 
password matching a recently used password. This 
may be set to prohibit matching up to the last five 
passwords used. Using 0 (zero) turns off this check. 

Require at least one letter and one 
number. 

Select this option to require a password to have at 
least one letter and one number. 

Require to have at least one character 
that is not a letter or a number. 

Select this option to require a password to have at 
least one character that is not a letter or a number. 
This would require using at least one symbol such as 
@, &, and ^. 

Password cannot contain the login 
name. 

Select this option to prohibit a password from 
containing the user login name. 

Validate password against a forbidden 
list. 

Select this option to validate a password against a 
forbidden word list.  

Password is case sensitive. Select this option to make the password case 
sensitive (that is, "P455W0RD" would be a different 
password from "p455w0rd"). 

Note: This setting also applies to Web View 
passwords. 

Display this message when an 
unacceptable password is entered 

Enter a message in this field that will be displayed 
when an incorrect password is entered. 

PIN Restrictions 

Minimum PIN length Select a minimum length for a PIN. The PIN may be 
no longer than 6 characters. 

No more than two digits the same Select this option to require a PIN not to have more 
than one number repeat. 

Audit Trail tab 

Audit Trail 

Audit New Records Select this option to audit new records. 

Audit Updated Records Select this option to audit updated records. 

Note: When this option is enabled, and a progress 
note is forwarded, a record will be written reflecting 
the forward.  

Audit Deleted Records Select this option to audit deleted records. 

Audit Viewing of Records by Category Select this option to audit the viewing of records by 
category. When this option is enabled, the audit 
event types ViewC, PrintC, and QueryC will be 
written. 
Selecting this option also turns on the auditing of 
lookup events performed in the Patient Lookup 
screen. When this option is enabled, the lookup 
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category (Name, ID, Phone, SSN, Account ID, etc.), 
lookup parameters (the text entered or options 
selected by the operator), and table (Patient) will be 
recorded in the audit trail. The event will be recorded 
as "Query". 
For example, if an operator performed a lookup for 
patients with a phone number area code of 206, 
"Category: Phone, Record: (206)___-____" would be 
recorded. 

Audit Viewing of Individual Records Select this option to audit the viewing of individual 
records. 
For example, when this option is selected, a View 
event will be recorded in the audit trail when an 
operator views patient demographic information in 
the Patient <Edit> screen. 
Selecting this option also turns on the auditing of 
document preview and import events performed on 
the Import from the Document Repository screen. For 
example, if an operator imports a patient document 
from a Document Repository, the event will be 
recorded as "HIE Import Document". If an operator 
previews a document before importing it for the 
selected patient, the event will be recorded as "HIE 
Preview Document". The name and ID of the patient 
whose clinical data has been imported/previewed 
will also be recorded in the audit trail. 

Audit Export of Records by Category Select this option to audit the export of records by 
category when the Data Export feature is run. When 
this option is enabled the export type will be 
recorded along with the table and category. The 
event will be recorded as "ExportC". 
For example, if the export type is Problem List-Major; 
Problem, Major, and ExportC will be recorded.  

Audit Export of Individual Records Select this option to audit the export of individual 
records when the Data Export or the Export to 
Document Repository feature is run.  
When exporting patient clinical data using the Data 
Export feature and this option is enabled, the export 
type will be recorded along with the record. The 
event will be recorded as "ExportI". For example, if 
the export type is Problem List-Major; Name of 
Problem, Major, and ExportI will be recorded.  
When exporting patient clinical data using the Export 
to Document Repository feature and this option is 
enabled, the event will be recorded as "HIE Export 
Document". The name and ID of the patient whose 
clinical data has been exported will also be recorded 
in the audit trail. 

Audit Printing of Individual Records 
(Applies only to Prescriptions) 

Select this option to audit the printing of individual 
records. This setting only applies to prescriptions.  

Types of Records to Audit 
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Clinical Records This feature has not yet been implemented. 

Appointments  Select this option to record actions related to 
appointment records. The actions recorded 
correspond to the option(s) selected from the Audit 
Trail section. 
For example, if you select the "Audit New Records" 
and "Audit Deleted Records" options, Patient 
Records will record audit data for the creation of new 
and the deletion of existing appointments. 

Patient Todo / Note  Select this option to record actions related to Patient 
Notes and To-Do notes. The actions recorded 
correspond to the option(s) selected from the Audit 
Trail section.  
For example, if you select the "Audit New Records" 
and "Audit Deleted Records" options, Patient 
Records will record audit data for the creation of new 
and the deletion of existing records for Patient Notes 
and To-Do notes.  

Messages This feature has not yet been implemented.  

Orders Select this option to record actions related to order 
records. The actions recorded correspond to the 
option(s) selected from the Audit Trail section. For 
example, if you select the "Audit New Records" and 
"Audit Deleted Records" options, Patient Records will 
record audit data for the creation of new and the 
deletion of existing order records.  

Audit Patient Inquiry Select this option to record when Patient Inquiry is 
run and finds patients which match the query either in 
your Lytec MD database or in the external Health 
Information Exchange (HIE) linked to your Lytec MD 
system.  
When an operator searches for a patient in the Lytec 
MD database, the event will be recorded as Lookup. 
When an operator searches for a patient in an 
external HIE on the Patient External Lookup screen, 
the event will be recorded as "HIE Lookup". Patient 
Records will keep an audit trail of the patients that 
match the inquiry. 

Audit Signatures Select this option to audit when notes and labs are 
signed.  

Keep a record of all Operators who 
contributed to each Note. 

Select this option to record the Operators who 
contribute to a note. When enabled, Lytec MD will 
keep track of all Operators who have contributed to a 
note and display them on the Contributions to Note 
screen (View > Show Contributors to Note). The 
default for this setting is ON.  
See the Recording Contributions to a Note section for 
more information.  
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Dashboard 
The Dashboard displays information from these specific functions: 

• Schedule 

• Patient Records  

• Order Entry 

A dialog box with more detail may be opened from the Dashboard. A provider and a nurse see 
different information. 

Using the Dashboard 
For a Dashboard area to display or be available for an operator: 

• The underlying function must be installed. For example, the Schedule area on the Dashboard is 
blank if Lytec MD appointment scheduling software has not been installed.  

• The operator needs to have access rights to that information. Set the operator level using the 
Practice Access Levels tab on Operator Maintenance. 

The following table has the areas on the Dashboard for each operator role, provided the installation of 
the underlying function. 

The Dashboard Areas Available by Operator Role 

Role Available Dashboard 
Areas 

Provider Schedule 
Messages 
To Do 
Lab Review 
Note Review 

Nurse Schedule 
Messages 
To Do 
Operator Processing 
(Orders) 

To set up an operator as a provider or nurse: 

1. Select Maintenance > Set Up > Operators. The Re-enter Password screen appears. 

2. Type the password, then click OK. The Operator screen appears. 

3. Double-click the operator to be set up to display Operator Maintenance. 

4. Click the Patient Records tab. 

5. Click the proper role (provider, nurse) in the Dashboard Configuration list, and then click OK. 

For more information, see Operator and Operator Maintenance. 

To open the Dashboard: 

• Click the Dash button on the Toolbar. The Dashboard opens. 
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To refresh information on the Dashboard: 

Do one of the following to update information the Dashboard before an automatic refresh. 

• On the Dashboard, click the Refresh button. 

• Press F5. 
Note: System administrators may set the automatic refresh rate for To Do Notes, Lab Reviews, and 
Note Reviews from the Records 5 tab on the Special Features screen. 

To display overdue orders: 

• On the Dashboard, click the Overdue Orders button. A dialog opens with any overdue orders for 
the current provider. 

Order Entry must be installed for the button to be available. 

To display a summary of an item on the Dashboard without opening it: 

• On the Dashboard, point to an item in an area with the mouse. A summary displays under the 
mouse. 

Checking RelayHealth Messages from the Dashboard 
If Patient Records has been configured to work with RelayHealth, you can check your messages from 
the Dashboard. The Community Messaging button displays the total number of messages and total 
number of unread messages in your RelayHealth inbox. If you have unread messages in your 
RelayHealth inbox the button will be highlighted in blue (like this). The number of messages displayed 
on the button is refreshed at a fixed interval. Your system administrator can change the automatic 
refresh rate using the ppart.ini file setting, "MessageCountTimer".  The default setting is 60 seconds. 

To check your RelayHealth messages: 

• On the Dashboard, click the Community Messaging button. Your RelayHealth Home screen 
opens in a web browser window.  

The Dashboard by Area 
This table has the information available in each area of the Dashboard, provided the underlying 
function has been installed.  

The table also shows the differences between what providers and nurses see. See "To set up an 
operator as a provider or nurse" for instructions on how to configure an operator with a view. 

Dashboard Area Name Description 

Schedule 

 Provider 
Dashboard 

 Nurse 
Dashboard 

This area presents the daily schedule for the current operator with: 

 Patient appointment time 

 Status 

 Type of visit 

 Length 

 Patient name 

 Patient identification number 

 Room 
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 Reason for visit 

Note: Your system administrator can customize the columns in the 
Schedule area from the Schedule Columns screen. See the Configure 
Appointment Scheduler Columns topic in Appointment Scheduler 
help for more information.  

Click the area's title to open Provider Schedules. Click an appointment to 
open Patient Chart for that patient.  
This is the same information presented by clicking Provider Schedule on 
the Task menu. 
To see the Schedule area, Appointment Scheduler must be installed. 
Ability to use General Tab and Provider Schedules is required, along 
with access-level security. 

Note: System administrators can enter a schedule load time offset in 
minutes from the Special Features screen. 

Messages 

 Provider 
Dashboard 

 Nurse 
Dashboard 

This area presents messages for the current operator with: 

 Message priority 

 Who sent the message 

 Patient name 

 Subject 

 Date received.  
Unread messages are in bold.  
Click the area's title to open Messages. Click a message to view it in View 
Message. From View Message, you can also reply to the person that sent 
the message. 
This is the same information presented by clicking Messages on the Task 
menu. 
To see the Messages area, permission to use General Tab and 
Messages is required, along with view-level security. 

To Do 

 Provider 
Dashboard 

 Nurse 
Dashboard 

 

This area presents action items for the current operator with: 

 Active date 

 Priority 

 Patient name 

 Subject 
Click the area's title to open To Do Note Select. Click an item to view it in 
Patient Note. 
This is the same information presented by clicking To Do on the Task 
menu to open To Do List. 
To see the To Do area, permission to use General Tab and Patient Note 
is required, along with view-level security. 

Lab Review 

 Provider 
Dashboard only 

This area presents un-reviewed lab results for the current provider with: 

 Patient name  

 Patient ID 

 Date 

 Time 
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Click the area's title to open Lab Table Review with all results for the 
provider. Click a specific laboratory test to open it in Lab Table Review. 
Lab results may be signed from Lab Table Review. 
This is the same information presented by pointing to Review Data on the 
Task menu, then clicking Lab Tables. 
To see the Lab Review area, permission to use Records Tab and 
Laboratory Data is required, along with access-level security. 

Note Review 

 Provider 
Dashboard only 

This area presents un-signed patient notes for review by the current 
provider with: 

 Patient name 

 Date 

 Time 

 Note title 
Click the area's title to open Review Provider Data with the first note for 
the provider. Click a note to view it in Review Provider Data. The note 
may be signed from Review Provider Data. 
This is the same information presented by pointing to Review Data on the 
Task menu, then clicking Progress Notes and Documents. 
To see the Note Review area, permission to use Records Tab and 
Progress Notes is required, along with view-level security. 

Operator Processing 

 Nurse 
Dashboard only 

 

This area presents pending and approved orders for the current operator 
or provider (configurable in Special Features) with: 

 Date ordered 

 Time ordered 

 Patient name 

 Patient ID 

 Order name 

 Status 

 Provider 

 Type 
Click the area's title to open Order Processing Select with orders for the 
nurse. Click an order to view and edit it. 
This is the same information presented by selecting the Order 
Processing option. 
To see the Operator Processing area, permission to use General Tab 
and Providers/Groups is required, along with view-level security. 
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Guarantors 
A guarantor is the person or organization who is financially responsible for a patient (in other words, 
the one “paying the bill”). When you add a guarantor in Lytec MD, you are also creating a Lytec MD 
account. This account links the guarantor to related patient records. Guarantor information can be 
shared between Lytec MD programs.  

The Basics of Guarantor Registration  
Because the amount of guarantor information is different for each practice, Lytec MD makes the 
registration process modular. That is, the program breaks the registration screen into several tabs. You 
can enter as little or as much information as you want. Your system administrator can also set address 
defaults, so that information that is similar for many guarantors (such as ZIP Codes and area codes) 
automatically appears on the registration screen.  

So, what’s the usual process for registering a guarantor in Lytec MD? Quite simply, you register a 
guarantor by opening the Guarantor screen and entering information such as guarantor ID and basic 
demographic information. This creates a guarantor record that is linked to the patient record you 
create when you register a patient.  

You can add a guarantor only after you add a patient, either through a demographic guide or by 
selecting File > New Guarantor when the Patient screen or a chart is open.  

More on the Guarantor screen 
You will use the Guarantor screen to store and track a variety of information for a guarantor. This data 
includes the guarantor’s name, address, and telephone numbers.  

You do not need to enter information in every field on the Guarantor screen. However, you must enter 
at least the guarantor’s name and ID before you enter any other information for the patient. 

Your system administrator may also have configured the Guarantor screen to meet the specific needs 
of your practice.  

In addition, your system administrator may also have used demographic guides to make some tabs 
required, which means that you must access the tab and either:  

• Add data (indicated by a red arrow next to the tab’s name): You are required to enter data on 
these tabs.  

• Review or add data (indicated by a blue arrow next to the tab’s name): You are not required to 
enter data on these tabs, but you must at least access the tab.  

Your system administrator may also have configured demographic field validations to make data entry 
in the Address Line 1, City, State, ZIP Code, or Home Tel# fields required, which means that you must 
access the tab and either: 

• Add data: You are required to enter data in these fields if the Entry Required check box for the 
respective field is selected on the Field Validations: Guarantor screen and your current default 
demographic guide is Full or Standard. If your current default demographic guide is set to Quick 
Reg, you are required to enter data in these fields if the Entry Required on QuickReg check box is 
selected on the Field Validations: Guarantor screen. 

• Review or add data: You are not required to enter data in these fields if the Entry Required check 
box for the respective field is clear on the Field Validations: Guarantor screen and your current 
default demographic guide is Full or Standard. You are not required to enter data in these fields 
when registering a guarantor in Quick Reg mode and the Entry Required in QuickReg check box 
is clear on the Field Validations: Guarantor screen. 
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Fields that are required are highlighted in red. These fields indicate the minimum information that must 
be entered for the guarantor.  

Guarantors can be added only when a patient chart or the Patient screen is open, or if a demographic 
guide requires the Guarantor screen.  

Opening guarantor records 
In Lytec MD, a guarantor record holds a guarantor’s demographic information (as entered on the 
Guarantor screen).  

You open a guarantor record by selecting File > Open Guarantor. When the Lookup screen appears, 
you simply enter the appropriate criteria to locate the correct record.  

Patients are the link to guarantors. Therefore, you can open a guarantor record only when the 
associated patient chart or patient record (Patient screen) is open.  
 
If you select File > Open Guarantor and no guarantor record exists for the patient, the New Guarantor 
screen appears.  

To open an existing guarantor record: 

1. Select File > Open Guarantor. The Lookup screen appears.  

2. Enter the search criteria and filters you want to use to narrow the search.  

3. Click the Lookup button.  

4. In the search results table, highlight the appropriate guarantor and click the OK button.  

Note: If another Lytec MD operator is working with the guarantor record, the screen opens in view-only 
mode. You will not be able to edit or delete the record. 

Adding, editing, and deleting guarantors 
To open the new guarantor screen: 

• Select File > New Guarantor. The Guarantor screen appears. Fill in the fields on this screen. To 
save the information you've added and continue to another tab, click the Apply button. When 
you're finished adding information, click the OK button to close the Guarantor screen. 
 
Your system administrator may use a demographic guide to make some tabs and buttons 
required or optional. 

To change a guarantor: 

• Open the Guarantor screen for the guarantor whose information you want to change. Make the 
appropriate changes. When you finish, click the OK button. 

To delete a guarantor: 

• On the Guarantor screen, click the Delete button. A message asks you to confirm the deletion. 
Click the OK button. 
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Fields on the Guarantor screen 

General tab 

Field Description 

Account Date Type the date the account was established with your practice.  

Guarantor ID  If you have the automatic ID feature turned on, an ID is 
automatically generated for the guarantor.  
 
If you do not have the automatic ID feature turned on, type an 
ID for the guarantor. You can use any combination of letters 
and numbers.  

Last Name or Entity  If the guarantor is a person, type the person’s last name.  
 
If the guarantor is an organization, type the organization’s 
complete name.  
 
How the Duplicate Name Check feature may affect this field. 
 
If you have the Duplicate Name Check feature turned on, when 
you move out of the name fields, the program checks to see if a 
guarantor with the same name already exists. If one does, then 
the Duplicate Name Check screen appears.  

 If the match is actually another guarantor with the same 
name, click the Close button to return to the Guarantor 
screen.  

 If the guarantor already exists in the program, click the 
Cancel New button. This closes the Guarantor screen.  

First Name and MI  Type the guarantor’s first name and middle initial. 

Type  This setting does not apply to Lytec MD. 

Status  Select the guarantor’s status from the drop-down list. Your 
options are Active, Inactive, and Collection.  

Suffix  Type the guarantor’s suffix (for example, Jr. or Sr.).  

Greeting  Type a salutation (greeting) for use in correspondence to the 
guarantor (for example, “Dear Smith Family”). You can include 
this phrase in mailmerge files, form letters, and form cards.  

Address  Type the guarantor’s street address.  
 
This address prints on statements and correspondence. 
 
Note: You can use three lines for the street or post office box 
part of the mailing address.  

City  Type the guarantor’s city.  
Note: If you have configured address defaults for the city, skip 
to the ZIP Code field and type the ZIP Code first. Then the city 
will default in this field.  
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County  If you have the county feature turned on, type the guarantor’s 
county. This feature is added through the Demographic 
Settings screen.  
If you do not have the county feature turned on, this field will 
not appear on screen.  
Note: If you have configured address defaults for the county, 
skip to the ZIP Code field and type the ZIP Code first. Then the 
county will default in this field.  

State  Select the guarantor’s state.   
Note: If you have configured address defaults for the state, skip 
to the ZIP Code field and type the ZIP Code first. Then the state 
will default in this field.  

ZIP Code (Postal Code)  Type the guarantor’s ZIP Code (postal code).  

Country  If you have the country feature turned on, select the guarantor’s 
country from the drop-down list. The feature is added through 
the Special Features screen.  
If you do not have the country feature turned on, this field will 
not appear onscreen.  

Home  Type the guarantor’s home phone number.  

If you want to add a note for this number, click the  button. 
The Phone Note screen appears.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Work/Extension  Type the guarantor’s work phone number and extension.  

If you want to add a note for this number, click the  button. 
The Phone Note screen appears.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Cell  Type the guarantor’s cell phone number.  

If you want to add a note for this number, click the  button. 
The Phone Note screen appears.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Pager  Type the guarantor’s pager number.  

If you want to add a note for this number, click the  button. 
The Phone Note screen appears.  
If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Fax  Type the guarantor’s fax number.  

Email  Type the guarantor’s e-mail address.  

Click the  button to send a message to this guarantor 
through your default e-mail editor (such as Microsoft Outlook).  

Provider  Select the provider who normally serves patients on this 
account.  
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Practice Select the practice to which patients on this account are 
normally assigned.  

Billing tab 
This tab does not apply to Lytec MD.  

Other Data tab 
On the Other Data tab, you can enter data in user-defined fields. Your system administrator can 
customize these user-defined fields to meet the specific needs of your organization. Your access level 
determines whether you can use the Other Data tab. 

Notes tab 
This tab does not apply to Lytec MD.  

Financial Summary tab 
This tab does not apply to Lytec MD.  

 



Patient Records  for Windows                                                                                                                             User’s and Technical Guide 

Page 495 

 

Accounts and registration 
The major Lytec MD programs share the same registration database. When you enter information on 
the demographic screens – including the Patient screen, Guarantor screen, and many Maintenance 
menu options – in Patient Records, the data will also be accessible in Appointment Scheduler.  

Patient Records has no accounts (except behind the scenes). Patients are the link to guarantors and 
account insurance information. You can add guarantors (the person financially responsible for a 
patient) and account insurance information only when a patient chart or the Patient screen is open. This 
lets Patient Records know which patient should be linked to the information.  
 
The first step in the registration process is to open the Patient screen and enter demographic 
information about the patient. You can then add account insurance information on the Patient screen’s 
Billing tab (there isn’t a separate screen to track account insurance plans). After you finish adding 
patient information, you can optionally enter data for the patient’s guarantor by opening and filling out 
the Guarantor screen. 

About registering guarantors  
A guarantor is the person or organization who is financially responsible for a patient (in other words, 
the one “paying the bill”). When you register a guarantor, you are creating the account. This account 
links the guarantor to related patients and account insurance plans.  

About registering patients  
When you register a patient, you can elect to link him to an existing account by selecting New Patient 
when the Guarantor screen is open. This automatically links the new patient to the current guarantor.  

You can also “quick register” a patient, a process that lets you add minimum information about the 
patient but does not require you to immediately link the patient to an account. If you use the quick 
registration mode, some of the Patient screen’s tabs and fields (those tracking account-specific 
information) will not be available. You can link a quick-registered patient to an account by selecting File 
> Add Patient to Acct when an account is active. An account is active when the Patient screen or patient 
chart is open for a patient who already belongs to the account, or when the Guarantor screen is open 
for the account's guarantor.  
 
For example, if Richard Stein is a patient and guarantor on the account to which you want to add the 
patient, you can make the account active by opening the Patient screen, patient chart, or Guarantor 
screen for Richard Stein.  
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Lookup 
You will use the lookup screen each time you search for a patient chart, patient, and guarantor in Lytec 
MD. This screen guides you in entering criteria and filtering the search, so you can quickly locate the 
record you need.  

You can view the screen by selecting File > Open (Chart, Patient, Guarantor). You can also open a 
patient record by clicking the Patient button in the toolbar. The Lookup screen also appears at various 
places in Lytec MD when you need to open a patient chart or when you need to select a patient and 
guarantor.  

When you are looking for an existing record, you can specify parameters used to narrow the search. 
Using the different tabs of the Lookup screen, you can search by criteria that includes name, 
identification number, telephone number, birth date, provider, and Social Security Number.  

Entering search criteria 
This section guides you through the process of selecting the criteria and filters you want to use in the 
search. It also includes a detailed look at each tab of the Lookup screen.  

Search criteria are the basic parameters you use to locate a record. These parameters include patient 
name, guarantor name, patient ID, head of household ID, and telephone number. To display different 
criteria fields, simply click the radio buttons on the Lookup screen. Lytec MD will display criteria fields 
appropriate to your selection. For example, if you mark the Patient ID radio button, the Patient ID field 
appears. 

Note: Your system administrator can set the default radio button for each tab on the Demographic 
Settings screen. 

If you are searching by patient name, Lytec MD also offers search filters that help you further narrow the 
results. These search filters include practice, provider, and birth date. Your system administrator can 
configure the default criteria for each tab of the Lookup screen. 

“Search by” options provide one or more criteria fields. You can enter information in any number of 
fields, and you do not need to fill out the entire field. For example, if you enter “Smi” in the Last Name 
or Entity field, the program will locate accounts with last names or organization names that begin with 
the characters you entered. The results will include Smith, Smithson, and other names that begin with 
“Smi”.  

Search criteria items are not case sensitive, so you can enter “Smith,” “smith,” “sMIth,” or any other 
combination of uppercase and lowercase characters.  

If you search by name, you can mark the Sounds Like check box to search for last names that are 
phonetically similar to the name you enter. For example, if you search for “Stein”, the results will include 
“Stein” but also “Stine”.  

Once you enter the search criteria and filters, you can click the Lookup button to begin the search.  

Note: Note for sites with large databases: When specifying any criteria or filters in addition to birth 
date, you may experience a performance issue. Lytec MD recommends that you do not use other 
criteria or filters when you are searching by birth date. 

The box at the bottom of the Lookup screen lists records in the order indicated by your selection 
criteria, starting with the closest match. (If it finds a unique and exact match, Lytec MD bypasses the list 
and opens the record). You can use the arrows to search manually through the list.  

Note: Your system administrator can configure the order in which the nine columns in this box display. 
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The Lookup screen only lists records appropriate to the criteria you enter. If you select all basic names, 
then it lists patient, guarantor, and insured party information (if you track guarantor and insurance 
information). If you search using patient ID or patient name, then only patient information displays. 

The information displayed includes account number, name, ID, type, SSN, telephone number, birth 
date, sex, and usual provider (your system administrator can configure the order in which the result 
columns display on the Lookup screen). Of course, information displays only if it is appropriate. Lytec 
MD does not store birth dates for guarantors, so nothing will display in the birth date column for 
guarantors. 

The Type column indicates what kind of data is displayed in a row. Each kind of data also has its own 
color. For example: 

• Guarantor displays in green (type = G) 

• Guarantor - other billing name displays in dark green (type = GO) 

• Patient displays in cyan (type = P) 

• Patient history type displays in dark blue (type = PH) 

• Insured party displays in magenta (type = I) 

Patients who belong to multiple accounts will display just once. If a patient who is selected from 
Account Lookup belongs to multiple accounts, the Choose Account dialog displays. Choose Account 
flags the patient's primary account with a check in the Primary Acct column, and highlights any 
accounts that are in collection in red.  

General tab 
The General tab includes the most commonly used search options: patient name, patient ID, 
telephone number, Social Security Number, account ID, and all basic names.  

The table below lists the search options and criteria available on the General tab. 

Field Description 

Patient Name Patient’s last name; patient’s first name and MI. 

Note: You can also filter results by selecting a practice, 
provider, or birth date. 

Patient ID Patient’s identification number. 

Phone Number Patient’s telephone number. 

SSN Patient’s Social Security Number. 

Account ID Account’s identification number. 

All Basic Names Patient’s last name, organization’s name, guarantor’s last name, 
guarantor’s “other billing name,” and insured’s last name; 
patient’s first name, guarantor’s first name, and insured’s first 
name (and MI for all selections). 

For example, Richard Stein has a patient record, guarantor 
record, and account insurance plan record. If you mark the All 
Basic Names radio button and type "Stein" in the Last Name 
field, three records will display for Richard Stein. Each record 
will display in a different color, and the record type (P for 
patient, G for guarantor, and I for account insurance plan) will 
display in the Type column. 
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Name tab 
The Name tab provides all options for searching by name. These options include searching by patient, 
guarantor, insured, patient name history, and patient alias.  

The patient name history option searches the patient demographic history records, which is useful for 
patients who have changed their names due to marriage or other reasons. A historical name search is 
not included in the All Basic Names search. 

The table below lists the search options and criteria available on the Name tab. 

Field Description 

Patient Patient’s last name; patient’s first name.  

Note: You can also filter results by selecting a practice, 
provider, or birth date. 

Guarantor Guarantor’s last name or organization’s name; guarantor’s first 
name.  

Insured Insured’s last name; insured’s patient’s first name. 

All Basic Names Patient’s last name, organization’s name, guarantor’s last name, 
guarantor’s “other billing name” and insured’s last name, 
patient’s first name, guarantor’s first name and insured’s first 
name. 

For example, Richard Stein has a patient record, guarantor 
record, and account insurance plan record. If you mark the All 
Basic Names radio button and type "Stein" in the Last Name 
field, three records will display for Richard Stein. Each record 
will display in a different color, and the record type (P for 
patient, G for guarantor, and I for account insurance plan) will 
display in the Type column. 

Patient Name History  From the patient demographic history records: Patient’s last 
name; patient’s first name.  

Note: You can also filter results by selecting a practice, 
provider, or birth date. 

Patient Alias This option searches on names entered in the Contact 
Information for Patient screen (accessed through the Patient 
screen’s Contacts button) with a type of Alias. 

ID tab 
The ID tab provides all options for searching by name. These options include patient ID, patient 
alternate ID, guarantor ID, insured ID, account ID, head of household ID, and all basic IDs. 

The table below lists the search options and criteria available on the ID tab. 

Field Description 

Patient Patient’s identification number. 

Guarantor Guarantor’s identification number. 

Insured Insured’s identification number. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 499 

 

All Basic IDs Patient’s identification number, organization’s identification 
number, guarantor’s identification number, or insured’s 
identification number. 

Account Account’s identification number. 

Head of Household Head of household’s identification number. 

Alternate Patient alternate identification number. 

Note: Your system administrator must set up user-defined 
patient alternate ID fields before you can select the field to 
search by from the drop-down list.  Patients are assigned an 
alternate ID number through the Patient Alternate IDs screen 
(accessed through the Patient screen’s Alt IDs button). 

External Lookup tab 
The External Lookup tab allows you to search through the patient index of the external Health 
Information Exchange (HIE) your Lytec MD system is linked to. You can search by a number of criteria 
that include patient name, birth date, sex, Social Security Number, address and home phone number. 
Each HIE may have configured different allowable criteria for the queries that are being sent to it (for 
example, an HIE may not allow queries based on Social Security Number). Query criteria that are not 
supported by the HIE will be ignored and will not be used to filter the query results.        

Note: The External Lookup tab is only available for selection if your system has been configured for 
MPI connectivity (the MPIConnectivity and XDSConnectivity settings in the [XDS] section of the Ppart.ini 
file are set to ON) and the External Network Lookup access level is enabled on the General tab of the 
Access Level Configuration screen for the current operator’s Access Level profile.   

The table below lists the search options and criteria available on the External Lookup tab. 

Field Description 

Last Name  Patient’s last name. 

First Name/MI Patient's first name and middle initial. 

Birth Date Patient's date of birth. 

Sex Patient's gender. 

SSN Patient's Social Security Number.  

City Patient's city.  

Country Patient's country. 

State Patient's state. 

Zip Code Patient's ZIP Code (postal code).  

Home Phone Number Patient's home phone number. 

External Lookup button Click this button to initiate a patient demographic query with 
the Health Information Exchange (HIE) associated with your 
system.  When the search is complete, the records that match 
your criteria will appear at the bottom of the Lookup screen. 
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New Patient button Highlight the appropriate patient in the search results table and 
click the New Patient button to open the Patient <New> 
screen. The fields on this screen are automatically populated 
with the patient demographic information retrieved from the 
Health information Exchange system, so you can create a new 
patient record in Lytec MD without having to manually enter 
basic demographic data. Make sure you have entered data in 
the required fields. When you finish, click the OK button to save 
the new patient record.  

Cancel Click this button to close the Patient Lookup screen.  

Using the Lookup screen 
The Lookup screen appears each time you search for a patient or a guarantor. This screen guides you 
in entering criteria and filtering the search, so you can quickly locate the record you need.  

To search for a patient in the Lytec MD database: 

1. On the Lookup screen, enter the search criteria. For name searches, you can also select filters 
you want to use to narrow the search.  

Note for sites with large databases: When specifying any criteria or filters in addition to birth date, 
you may experience a performance issue. Lytec MD recommends that you do not use other criteria or 
filters when you are searching by birth date. 

2. Click the Lookup button. The patients that match your criteria appear at the bottom of the 
Lookup screen. 

3. If the lookup feature finds a unique and exact match, Lytec MD bypasses the list and 
automatically opens the record. 

4. Highlight the patient you want to open and click the OK button. 

5. If the search criteria did not locate the appropriate record, you can start a new search while the 
Lookup screen is open. Simply change the criteria and then click the Lookup button.  

To search for a patient in an external Health Information Exchange (HIE) system: 

1. On the External Lookup tab of the Lookup screen, enter your search criteria. To prevent the 
generation of unmanageable number of records in response to your query and to improve the 
response time, try to use more restrictive parameters for your search.  

2. Click the External Lookup button. This launches a search of the Master Person Index (MPI) your 
system is linked to for patients matching your search criteria. You can stop the search in case it 
is taking a long time or if you want to narrow your search by entering additional search 
parameters. To do this, click the Abort Query button on the message that displays while the 
query is running. When the search is successfully completed, the records that match your 
criteria appear at the bottom of the Patient Lookup screen. 

3. To add a patient from the external network, highlight the appropriate record and click the New 
Patient button. The Patient <New> screen appears.  

Note: The New Patient button is only enabled if you have New Patient access level.  

4. Click the Apply button, fill in the rest of the required data in the appropriate fields, and then 
click the OK button.  
• If the name of the patient from the external system does not match the name of a patient 

in your Lytec MD database, the patient is automatically added to your database.  
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• If the name of the patient from the external system matches the name of a patient in your 
system, the program will display the Duplicate Name Check screen: 

• If the match is actually another patient with the same name, click Close to return to 
the Patient to continue data entry.  

• If the patient already exists in the system, click Cancel New. This closes Patient. 
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Messaging 

The Messaging System 
Use the messaging system to do the following: 

• Send messages to other providers or staff. It is similar to e-mail. 

• Send a personal message in the future to create a To Do list.  

Patient and chart information may be attached to messages.   

The messaging system is independent of other Lytec MD functions. The system may be left open in the 
background while completing other tasks.  

It is possible to: 

• Set up message templates to save time. This is like note templates and other Lytec MD 
templates. When writing a message, select a message template that automatically inserts patient 
information and often-repeated text. 

• Insert QuickText, Dot codes, and letter codes into messages. 

• Add attachments to messages, such as files.  

• Format the message text by changing the font style, size, or color. Text may be bolded, italicized, 
underlined, or indented. Bulleted lists may be created. Text alignment may be changed. 

• Check messages for spelling. 

• Turn on return receipt to receive notification that the recipients (the message's To field) opened 
your message. 

• Use operator groups to send messages to a specified group of Lytec MD operators. 

• Link to the chart section referenced by the message's type. For example, if the message type is 
HM, click Link to open the patient's health maintenance chart section. 

• Record the message as a progress note in the patient's chart. 

Messaging is operator-based. Any Lytec MD operator may use the messaging feature if having an 
access level that allows it. In addition to an access level item specifying whether an operator can 
add/edit/view/delete messages, Lytec MD provides another access level item that indicates whether an 
operator can view messages for other operators. 

Open the messaging system one of these ways: 

• Click Msg in the toolbar. 

• From the Task menu, click Messages.  

Msg turns blue when there is a message. When there is an urgent message (priority 9), Msg turns red.  

Note: If the messaging screen is open, Msg will turn blue or red when receiving new messages and will 
stay blue or red until one message is read. 

If you have used Microsoft® Office Outlook® or a similar e-mail program, Messages should look 
familiar. The left box displays the Archived, Deleted, Inbox, Pending, and Sent folders. The right box 
displays the messages in the selected folder. 

In addition, you can use many common word processing shortcut keys to complete messaging tasks, 
such as CTRL+P to print a message. See the Keyboard shortcuts for messages section for more 
information. 
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Messages 
Messages has three areas: Folders, Messages, and Buttons. 

The Folder Area 

This displays the default messaging folders. Clicking a folder displays any messages in that folder in 
messages area. The currently-selected folder is highlighted in gray.  

In the figure below, the Inbox folder has been selected. Any messages in Inbox display in the Message 
Area. 

 

Folder Description 

Archived The Message Area sorts Archived messages in the following order: 
1. Date received 
2. Priority 

Deleted The Message Area sorts Deleted messages in the following order: 
1. Date received 
2. Priority 

Inbox The Message Area sorts Inbox messages in the following order: 
1. Date received 
2. Priority 

Pending The Pending folder stores messages from the current operator that are waiting to 
be sent. A pending message may be edited before sending it. 
The Message Area sorts Pending messages in the following order: 
1. Date to activate 
2. Priority 

Selected  The Message Area displays selected messages after users have selected what 
messages they would like to view from the Select Messages screen.  

Sent The Message Area sorts Sent messages in the following order: 
1. Date sent 
2. Priority 

The Message Area 

This displays any messages in the folder selected in the Folder Area.  
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The Messages Area uses columns to display information (if available) for each message.  

Column Description 

! The message's priority, from 0 being the lowest priority and to 9 being the highest. 

Att A paper clip symbol displays if a message has an attachment.  

From The Lytec MD user sending the message. 

Patient The patient referenced in the message. 

Subject A brief summary of the message. 

Received When the message was received. 

Type The message type. Many types correspond to a tab on the patient chart, such as 
HM or Lab.  

Shortcut menu for the messaging system 
Without opening a message, right-click to use a shortcut menu to do the following actions: 

• Reply 

• Reply to all 

• Forward 

• Delete 

• Archive 

• Print 

• View  

The shortcut menu may be used to do the following: 

• Remove a message from the Archive folder 

• Restore a message from the Delete folder. 

More than one message may be archived or deleted at the same time by doing the following: 

Location of 
Messages 

Method 
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Adjacent 
Messages  

1. Select the first message. 
2. Hold down SHIFT and click the last message in the group. 
3. Right-click the selected messages. 
4. Select Archive or Delete. 

Non-Adjacent 
Messages 

1. Select the first message. 
2. Hold down CTRL and click each message in the group. 
3. Right-click any of the selected messages. 
4. Select Archive or Delete. 

The Button Area 

 

Click to do any of the following actions: 

Button Description 

Close Close the messaging system. 

New Create a new message. 

Delete Delete the selected message. Deleted messages move to the Deleted folder. 

View Open the selected message. In addition, a message may be opened by double-
clicking it. 

Link Click to jump to the chart of the patient referenced in the selected message. If a 
chart section is specified in the Type, the chart opens to there. 

Change Op To use this feature, the access level must allow access to other operator's 
messages.  
Click to change operators. The messaging system displays messages only for the 
current operator, so you can use this to view messages for another Lytec MD 
operator. 
If a person changes to another operator and sends a message, the message will 
be sent from the original operator—not as from the other operator. This prevents 
a user from sending messages using another user's name.  

Note: To send a message as another user, park and log in to Lytec MD as the 
other user. 

Print Click to print the selected message. 

Select Click to select messages to view from the Select Messages screen. This screen 
allows you to select the messages displayed in the message area. 

Community 
Messaging 

Click to check your RelayHealth inbox. Your RelayHealth Home page opens in a 
web browser window. The button displays the total number of messages and 
total number of unread messages in your RelayHealth inbox. If you have unread 
messages in your RelayHealth inbox the button will be highlighted in blue (like 
this). The number of messages displayed on the button is refreshed every 60 
seconds. 
See the Opening your RelayHealth Home Page in Patient Records section for 
more information.  

Note: This button will only be displayed if you are connected to RelayHealth and 
Lytec MD is configured for RelayHealth connectivity.  
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Customizing the messaging system 
Your company's system administrator can customize the messaging system using settings in the 
ppart.ini file. This includes: 

• Archive messages automatically in the Inbox and Sent folders. 

• Include the original message when users reply to the message. 

• Show the "blind copy" line on the New Message screen. 

Adding, viewing, and deleting messages 

To open the messaging system: 

Open Messages by doing one of the following: 

• Click Msg in the toolbar. 

• From the Task menu, click Messages. The Messages screen appears.  

From this screen, you can send a message (New button), view a message (View button), delete a 
message (Delete button), open the chart section referenced in the currently-selected message (Link 
button), change the operator who is currently accessing the messaging system (Change Op button), 
and print a message (Print button). 

To view a message: 

View a message by doing one of the following: 

• Select the message and click View.  

• Double-click the message.  

When viewing messages, it is possible to do the following: 

• Link to the chart section referenced in the message. 

• Record the message as a progress note in the patient's chart.  

See the "Messaging: Handling Messages" for more on handling messages. 

To create and send a message: 

1. On Messages, click New.  

2. Complete the fields on the New Message screen. 

3. Click OK.  

See the "Messaging: creating and sending messages" section for more on creating and sending 
messages. 

To delete a message: 

1. On Messages, select the message.  

2. Click Delete. A message asks to confirm the deletion.  

3. Click Yes.  

The message moves to the Deleted folder. 
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To permanently remove messages from the messaging system: 

• To delete messages from the Deleted or Archived folder, use the Purge Messages utility. 

Selecting messages  
The Select button displays the Select Messages screen. This screen allows you to select the messages 
you would like to view in the message area.  

Narrow your message selection down by choosing from the following search criteria: 

• Priority Range: Select a message priority, from 0 being the lowest priority and to 9 being the 
highest. For example, if you would like to view messages with a priority of 1 - 5, enter 1 to 5. 

• Folder: Select the folder for which you would like to view messages for. 

• To: Opens the Select Message To screen. This screen allows you to specify which sent messages 
you would like to view in the message area. You can choose to view messages sent to a specified 
operator, patient, or external provider. 

• From: Opens the Select Message From screen. This screen allows you to specify which received 
messages you would like to view in the message area. You can choose to view messages sent 
from a specified operator, patient, or external provider. 

• Date Range: Select a date range (to - from) for the messages you want to view. When you select 
a starting and ending date, all orders created between those dates that meet the other criteria 
you set will be displayed.  

• Message Type: Select the message type. 

• Subject: Enter a message subject (full or partial) in this field. Lytec MD will search the current 
Inbox for the subject or the closest match.  

Once you have finished making your selections, click the OK button. This will display the filtered 
messages in the Message Area. 

Messaging: creating and sending messages 
The process for creating and sending messages should be familiar to anyone who has used Microsoft 
Outlook or a similar messaging application. In a nutshell, you select to whom you want to send the 
message, type the message (or insert a message template), and select other options such as patient, 
message type, and priority. You can also attach files and request a return receipt. 

You access the messaging system through the Msg button in the tool bar, or by selecting Task > 
Messages. When you have new messages, the Msg button displays in blue. When you have an urgent 
message waiting (priority 9), the Msg button displays in red.  

Creating and sending messages 

To create and send a message: 

1. Click the Msg button in the tool bar, or select Task > Messages. The Messages screen appears.  

2. Click the New button. The New Message screen appears. 

3. Fill in the fields on this screen (refer to the next section). 

4. When you finish, click the Send button. 

Note: If a valid operator ID is not entered in the To, Cc, or Bcc fields, the Select Destination 
(Correction) screen is displayed. This screen allows you to select a valid operator ID from the list. The 
screen will be displayed for every invalid operator ID entered from the New Message screen.  
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Fields and buttons on the New Message screen 

Fields and 
buttons 

Description 

To Type the name(s) or ID(s) of the recipient(s) for the message.  
You can also click the To button to open the Select Destination screen. This screen 
allows you to select an operator, operator group, patient, patient group, or external 
provider to send your message to.  

IMPORTANT: The patient, patient group, and external provider send options are 
only available when the Special Feature setting, "WebView Installed" is enabled. 

Cc You can use the Cc line to send a copy of the message to a recipient. 
You can also click the Cc button to open the Select Destination screen. This screen 
allows you to select an operator, operator group, patient, patient group, or external 
provider to Cc your message to.  

IMPORTANT: The patient, patient group, and external provider send options are 
only available when the Special Feature setting, "WebView Installed" is enabled. 

Bcc You can use the Bcc line to send a copy of the message to a recipient without the 
other message recipients knowing the person received the message. Your system 
administrator must customize the messaging system to include this field. 
You can also click the Bcc button to open the Select Destination screen. This screen 
allows you to select an operator, operator group, patient, patient group, or external 
provider to Bcc your message to.  

IMPORTANT: The patient, patient group, and external provider send options are 
only available when the Special Feature setting, "WebView Installed" is enabled. 

Type Select a message type from the drop-down list. Many types correspond to a tab on 
the patient chart (for example, HM or Lab).  

Priority Select a message priority from the drop-down list. 0 is the lowest priority, 9 is the 
highest priority. 

Date to activate If you want to delay sending the message, select (or type) an activation date. When 
an activation date later than the current date is selected, the message is stored in 
the Pending folder until the activation date. The people to whom the message is 
addressed (in the To, Cc, and Bcc fields) will not receive the message until the 
activation date. 

Patient If the message relates to a patient, type the patient's ID in this field. You can also 
click the Patient button and use the Lookup screen to select the appropriate patient.
If you want to insert letter codes or Dot codes (or a message template that includes 
letter codes or Dot codes) in the message, you must select a patient first. 

Subject Type a brief summary of the message. 
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Text formatting 
tool bar 

This tool bar provides standard text formatting tools.  

 Select the font that you want to use in the message. 
Your system administrator can use settings in the 
ppart.ini file to define which fonts are available in the 
list. 

 Select the font size. Your system administrator can use 
settings in the ppart.ini file to define which font sizes are 
available in the list. 

 
Indicate whether you want text in the message to be 
bolded (B), italicized (I), or underlined (I). 

 
Indicate whether the text should be aligned with the left 
margin, centered, aligned with the right margin, or 
justified (text lines up with both the left and right 
margins). 

 
Indicate whether text should be bulleted. 

 
Indicate whether text should be indented five spaces 
toward the right margin, or moved five spaces toward 
the left margin. 

 
Select the magnification at which you want to view the 
text. 

 

Text box Type the message. You can use the formatting tools to change the appearance of 
the message text. In addition to typing text, you can also insert letter codes and Dot 
codes by clicking the QuickText button. However, Dot codes that write to the chart 
will not work, unless the message is recorded to a progress note (for example, the .L 
code will not write to the lab section).  

Buttons on the New Message screen 

Send  Click this button to send the message. If the date to activate is later than the current 
date, the message will not be sent until the future date. 

Note: If a valid operator ID is not entered in the To, Cc, or Bcc fields, the Select 
Destination (Correction) screen is displayed. This screen allows you to select a valid 
operator ID from the list. The screen will be displayed for every invalid operator ID 
entered from the New Message screen.  

Cancel Click this button to clear the message and close the New Message screen, without 
saving the information or sending the message. 

Template  Click this button to insert a message template into the body of the template. You 
can then modify the template as needed.  

Note: Letter codes or Dot codes will not be rendered if you insert a template or 
quicktext before selecting a patient.  
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Quick Text  Click this button to insert QuickText into the body of the message.  

Note: Letter codes or Dot codes will not be rendered if you insert a template or 
quicktext before selecting a patient.  

Spell Check Click this button to check spelling in the body of the message. If the spell check 
feature doesn't find any errors, a message indicates the number of words checked. 
If errors are found, a screen displays the errors and their suggested alternates. 

Attachments  Click this button to attach text, images, or other files to the message. You can attach 
up to 50 items to the message. Attachments must be readable by Internet Explorer 
or other applications installed on the PC (for example, Microsoft Word). 
When the Attachments screen opens, click the New button, then browse to the file. 
Click the Open button. When you finish selecting the files, click the Close button on 
the Attachments screen to return to the message. The Attachments button will 
display the number of files attached to the message. 

Return Receipt Select this check box to receive notification that the recipients (in the To field) read 
the message. 

Record If the message relates to a patient, you can select this check box to record the 
message to the patient’s progress note. 
The following message is displayed when you click the Send button: 
Record when the reply is sent? 
If you click Yes, the message will be recorded to the patient's progress note when 
the reply for the message is sent. 
If you click No, the message will be recorded to the patient's progress note right 
away. This will display the patient's progress note. Click OK to save the progress 
note. 

Note: If you select the Record check box when forwarding or replying to a 
message, and choose to record the message to a progress note immediately, the 
following message is displayed when the patient's progress note appears: 
 
Delete Original Message?  
 
Click the Yes button to delete the original message from your Inbox. Click the No 
button to keep the original message. 

Messaging: Viewing and responding to messages 
Note: Shortcut menus are used throughout Lytec MD. Right-click a message in the message pane to 
select the following options: Reply, Reply All, Forward, Delete, Archive, Print, and View. 

The process for viewing and responding to messages is like Microsoft® Office Outlook® or a similar 
messaging application. 

Open the messaging system by doing one of the following: 

• Click Msg in the toolbar. 

• From the Task menu, click Messages.  

Msg displays in blue when there is at least one new message waiting. Msg displays red when there is at 
least one urgent message waiting (priority 9).  
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Viewing and responding to messages 

To view and respond to a message: 

1. To open Messages, do either of the following: 
• Click Msg on the toolbar. 

• From the Task menu, select Messages. 

2. In the message pane, select the message and click View. Otherwise, double-click the message. 
The message opens in View Message. 

3. On the View Message screen, click the appropriate button to respond to or dispose of the 
message (for example, you can reply to the sender or forward the message to another 
operator). The next section details the options available, and describes the read-only fields on 
the View Message screen. 

Fields and buttons on View Message 

Fields and buttons Description 

From The system operator who sent the message. 

To The system operator(s), including you, who were sent the 
message. 

Cc The system operators who were sent a copy of the message. 

Bcc Your name appears in this field if you were sent a "blind copy" of 
the message. Your system administrator must customize the 
messaging system to include this field. 

Date/Time Created The date and time the message was created. 

Date Activated The date the message was activated. 

Patient If the message relates to a patient, the patient's ID and name 
displays in this field.  

Type The message type. 

Priority The message's priority. 0 is the lowest priority, 9 is the highest 
priority. 

Subject A brief summary of the message. 

Text box The message. 

Buttons on the View Message screen 

Tel # If a patient is referenced (in the Patient field), click this button to 
view the patient's telephone numbers. 

Allergies If a patient is referenced (in the Patient field), click this button to 
view the patient's allergies. 

Attachments If the message includes attachments, the number of attachments 
displays on this button. For example, for two attachments, the 
button will display Attachments (2). Click the button to access the 
attached files. 
Attachments must be readable by Internet Explorer or other 
applications installed on the PC (for example, Microsoft Word). 

OK Click this button to close the message.  
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Cancel Click this button to close the message.  

Reply  Click this button to reply to the person who sent the message. 

Reply to All  Click this button to reply to all people who were sent this 
message (everyone in the From, To, Cc, and Bcc fields). 

Forward  Click this button to forward the message to another system 
operator. 

Delete Click this button to delete the message. 

Link Click this button to open the chart section referenced by the 
message type.  
If the patient associated with the message has any demographic 
notes or flags, these display before the chart appears. 
If the patient has any registration notes, these display before the 
chart appears if the Show Registration Notes when linking to 
Chart from Message check box is selected in the Special 
Features screen. 

Record Click this button to create a progress note from the message. The 
progress note will include information from these fields: From, 
To, Cc, Bcc, Priority, Message Type, Date Sent (or Date of 
Activation), Subject, message text, and a list of attachments. 
If the message has been saved as a progress note previously, a 
choice is given to do one of the following: 

 Append the message to the previous progress note. 

 Save a new progress note using the same message. 
 Cancel creation of a progress note. 

After the message is recorded the following message is 
displayed: 

Delete Original Message?  
Click the Yes button to delete the original message from your 
Inbox. Click the No button to keep the original message. 

Print  Click this button to print the message. 

Messaging: message types 
When you create a message, you can add a message type to reference a related section of the patient 
chart. For example, if your message is about Richard Stein's health maintenance items, you can select 
"HM" as the message type. 

Message types are used with the Link button on the Messages screen (the main screen in the 
messaging system). When message recipients click the Link button, the appropriate patient chart 
opens to the location associated with the message type. 

Messaging types and their chart locations 
Many of the message types are self-evident, but the table below lists the message type and its 
corresponding location in the patient chart.  

Message type Chart location 

Arrived Chart summary 

Chart Patient chart 
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Chart summary Chart summary 

Email Patient chart 

Flow charts Flow charts 

HM Health maintenance 

In  Chart summary 

Lab Laboratory data 

Lab micro Laboratory data - microbiology 

Lab misc Laboratory data - miscellaneous 

Lab most recent Laboratory data - most recent lab data

Letters Letters 

Problem list Problem list 

Progress notes Progress note - most recent 

Reminder Chart summary 

Rx Rx/medications 

Schedule Provider schedule 

Tel -chart Patient chart 

Tel -progress note Progress notes (most recent) 

Tel -chart summary Chart summary 

Vitals Vital signs 

Select Destination screen 
When you create new message, the Select Destination screen allows you to select a specified 
operator, operator group, patient, patient group, or external provider, to send, Cc, or Bcc your 
message to. Please note the guarantor feature has not yet been implemented.   

IMPORTANT: The patient, patient group, and external provider send options are only available when 
the Special Feature setting, "WebView Installed" is enabled. 

Operator  
Click the Operator radio button, to send a message to a specified operator or operator group. When 
this option is selected the screen displays a list of active Lytec MD operators and operator groups 
(displayed as the group name followed by "---Group---").  

To select an operator or operator group: 

1. Scroll through the list and highlight the operator or group that you want to use.  

You can also type the operator's ID or group name in the Operator\Group field. Click the 
Search button. The operator or group that most closely matches the ID or name will be 
highlighted in the list. You can click the Members button to view the group members for the 
operator group highlighted in the list.  

2. Move the operator into the list by clicking the To, Cc, or Bcc right arrow button, or double-
clicking the operator or group.  

3. You can also remove the operator or group from the list by selecting the operator or group and 
clicking the left arrow button. 
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4. You can continue adding operators and groups to the list by selecting and moving the 
operators and groups into the list. 

5. When you are finished, click the OK button. This will return you to the New Message screen. 

Patient  
Click the Patient radio button, to send a message to a specified patient.  

To select a patient:  

1. Click the Lookup button. This displays the Patient Lookup screen. Enter your search criteria 
and select the appropriate patient. Click the OK button. The patient's name and ID will be 
displayed in the corresponding fields.  

2. Move the patient into the list by clicking the To, Cc, or Bcc right arrow button. The patient’s 
name followed by the patient’s ID will be displayed in the list. 

3. You can also remove the patient from the list by selecting the patient and clicking the left arrow 
button. 

4. You can continue adding patients to the list by selecting and moving the patients into the list. 

5. When you are finished, click the OK button. This will return you to the New Message screen. 

Please note if the patient is missing an e-mail address, the Missing Patient E-mail screen is displayed. 
Enter the patient’s e-mail address in the provided field. Click the OK button. The patient’s name and ID 
will be added to the list.  

Patient Group  
IMPORTANT: You must have Appointment Scheduler to view and send messages to patient groups.  

Click the Patient Group radio button, to send a message to a specified patient group. When this 
option is selected the screen displays a list of patient groups. 

To select a patient group: 

1. Scroll through the list and highlight the patient group that you want to use.  

You can also type the patient group’s code in the Patient Group field. Click the Search button. 
The patient group that most closely matches the code will be highlighted in the list. You can 
click the Members button to view the group members for the group highlighted in the list.  

2. Move the patient group into the list by clicking the To, Cc, or Bcc right arrow button. The 
patient group’s code followed by (Pt Group) will be displayed in the list. 

3. You can also remove the patient group from the list by selecting the group and clicking the left 
arrow button. 

4. You can continue adding patient groups to the list by selecting and moving the groups into the 
list. 

5. When you are finished, click the OK button. This will return you to the New Message screen. 

Please note if a patient is missing an e-mail address, the Missing Patient E-mail screen is displayed. 
Enter the patient’s e-mail address in the provided field. Click the OK button. The group will be added 
to the list.  
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External Provider  
Click the External Provider radio button, to send a message to a specified external provider. When this 
option is selected the screen displays a list of external providers.  

To select an external provider:  

1. Scroll through the list and highlight the external provider that you want to use.  

You can also type the external provider's ID in the Provider ID field. Click the Search button. 
The operator that most closely matches the ID will be highlighted in the list. 

2. Move the external provider into the list by clicking the To, Cc, or Bcc right arrow button. The 
external provider’s ID followed by (Ext Prov) will be displayed in the list. 

3. You can also remove the external provider from the list by selecting the provider and clicking 
the left arrow button. 

4. You can continue adding external providers to the list by selecting and moving the providers 
into the list. 

5. When you are finished, click the OK button. This will return you to the New Message screen. 

Please note if the external provider is missing an e-mail address, the Missing Referring Source E-mail 
screen is displayed. Enter the external provider’s e-mail address in the provided field. Click the OK 
button. The external provider will be added to the list.  

Select Messages screen 
The Select Message To screen and Select Message From screen are displayed when you select the 
To and From fields on the Select Messages screen. The To field opens the Select Message To screen 
and the From field opens the Select Message From screen. These screens allow you to specify which 
messages you would like to view in the message area. You can choose to view messages sent to or 
from a specified operator, operator group, patient, or external provider. Please note the guarantor 
feature has not yet been implemented.   

Operator Select  
When this option is selected the screen displays a list of active Lytec MD operators and operator 
groups. You can either:  

• Scroll through the list and highlight the operator or group that you want to use.  

• Type the operator's ID or group name in the Operator\Group field. Click the Search button. The 
operator or group that most closely matches the ID or name will be highlighted in the list. You 
can click the Members button to view the group members for the operator group highlighted in 
the list.  

When the appropriate operator or group is selected, click the OK button.  

Patient Select 
Click the Patient radio button, to view messages from a specified patient. When this option is selected:  

• Click the Lookup button. The Patient Lookup screen appears. Enter your search criteria and 
select the appropriate patient. Click the OK button. The patient's name and ID will be displayed 
in the corresponding fields.   

When the appropriate patient is selected, click the OK button.  
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External Provider Select 
Click the External Provider radio button, to view messages from a specified external provider. When 
this option is selected the screen displays a list of external providers. You can either:  

• Scroll through the list and highlight the external provider that you want to use.  

• Enter the external provider’s ID in the Provider ID field. Click the Search button. The operator 
that most closely matches the entered ID will be highlighted in the list.  

When the appropriate external provider is selected, click the OK button.  

Keyboard Shortcuts for Messages 
If you are accustomed to using shortcut keys on the keyboard – rather than using a mouse – to perform 
tasks, use the tables below when you are using the messaging system. Please note your pointer must 
be located on the messaging screen to use the shortcut keys. 

Keyboard Shortcuts on the main Messages screen 

Action Shortcut 

Close the message Alt+C 

Start a new message Alt+N 

Delete the message Alt+D 

View a message Alt+I 

Link the chart section referenced in the 
message 

Alt+K 

Print the message Alt+P 

Keyboard Shortcuts on the New Message screen 

Action Shortcut 

Send the message Alt+S 

Insert a message template Alt+E 

Insert QuickText Alt+Q 

Spell check the message Alt+K 

Attach text, images, or other files to the 
message 

Alt+A 

Return Receipt (receive notification that the 
recipients read the message) 

Alt+U 

Record a message to a patient's progress 
note 

Alt+C 

Keyboard Shortcuts on the View Message screen 

Action Shortcut 

Cancel (close the message) ESC 

Reply to the person that sent the message Alt+E 
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Reply to all people that were sent the 
message 

Alt+Y 

Forward the message Alt+O 

Delete the message Alt+D 

Link (to open the chart section referenced 
by the message type) 

Alt+K 

Record (create a progress note from the 
message) 

Alt+C 

Print the message Alt+P 

Attachment (display the number of 
attachments) 

Alt+A 
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Patients 

Patients 
Before you can enter information in a patients chart, you must "register" (add) the patient in Lytec MD.  

Registering patients with other Lytec MD programs 
Patient Records and Appointment Scheduler share the same patient registration database. Once you 
register patients in Patient Records, you will not need to register them again in Appointment 
Scheduler. 

Each program was designed for a different purpose, so while much of the information you enter during 
registration is used by all programs, some information is designed for use by just one or two programs. 
Patient Records and Appointment Scheduler focus more on patient demographics and provider 
information. 

Some financial-related fields and tabs do not apply to Lytec MD and are disabled or invisible. Keep this 
in mind when you read the related topics, because the screen shots and descriptions may differ from 
what you see in the program. 

The basics of patient registration 
Patient registration. There is no way to avoid it, but how much information do you need to track? Lytec 
MD solves this problem by making the registration process modular. That is, by breaking the 
registration screen into several tabs. You can enter as little or as much information as you want. Your 
system administrator can also set address defaults, so that information that is similar for many patients 
(such as ZIP Codes and area codes) automatically appears on the registration screen. 

So, what's the usual process for registering a patient in Lytec MD? Quite simply, you register a patient 
by opening the Patient screen and entering information such as patient ID and basic demographic 
data. Normally, you will use the Patient screen only when you first register a patient or when the 
patients demographic information changes. 

The Patient screen speeds up the registration workflow by placing each step of the process onto a 
separate tab. For each patient you add, the workflow can be summed up as: 

1. On the General tab of the Patient screen, enter basic demographic data. This creates the basic 
patient record. 

2. On the Provider tab, enter provider information. 

3. On the Other Data tab, enter additional patient information in fields that are customized by 
your practice. Information on this tab is available for Patient Inquiry searches. 

The Patient screen also contains tabs for entering notes, billing information, case information, and 
individual patient configuration information. On the Dates tab, you can enter patient recalls and, if you 
have Appointment Scheduler, view appointment date information.  

Your system administrator can also speed up the workflow by creating demographic guides for 
registration.  

For New Sites: When to Register Existing Patients 
If you have just added Lytec MD to your practice, you can register your patients in Lytec MD when they 
show up for their next appointment or you can put some time aside to register them all at once. You 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 519 

 

can also import patients from an existing system using the XFire utility. For information, see the 
documentation provided with the XFire utility or contact Lytec MD Technical Support. 

Description of Patient 
You will use the Patient screen to store and track a variety of patient data. To help you enter patient 
information, the Patient screen is divided into eight tabs. 

Some financial-related fields and tabs do not apply to Lytec MD and are disabled or invisible. 

You do not need to enter information in every field on the Patient screen. However, you must enter at 
least the patients name and identification number before you can save and close this screen. 

Your system administrator may also have configured the Patient screen to meet the specific needs of 
your practice. 

In addition, your system administrator may also have used demographic guides to make some tabs 
required, which means that you must access the tab and either: 

• Add data (indicated by a red arrow next to the tabs name): You are required to enter data on 
these tabs. 

• Review or add data (indicated by a blue arrow next to the tabs name): You are not required to 
enter data on these tabs, but you must at least access the tab. 

Your system administrator may also have configured demographic field validations to make data entry 
in the Address Line 1, Date of Birth, Home Tel#, and Sex fields required, which means that you must 
access the General tab and either: 

• Add data: You are required to enter data in these fields if the Entry Required check box for the 
respective field is selected on the Field Validations: Patient screen and your current default 
demographic guide is Full or Standard. If your current default demographic guide is set to Quick 
Reg, you are required to enter data in these fields if the Entry Required on QuickReg check box is 
selected on the Field Validations: Patient screen. 

• Review or add data: You are not required to enter data in these fields if the Entry Required check 
box for the respective field is clear on the Field Validations: Patient screen and your current 
default demographic guide is Full or Standard. You are not required to enter data in these fields 
when registering a patient in Quick Reg mode and the Entry Required in QuickReg check box is 
clear on the Field Validations: Patient screen. 

Fields that are required are highlighted in red. These fields indicate the minimum information that must 
be entered for the guarantor. 

When you click the Apply button to save the new patient, information may automatically display in 
several fields. This information includes address defaults set up by the system administrator. You can 
delete or change these defaults as necessary. 

Opening existing patient records 
In Lytec MD, a patient record holds a patients demographic information (as opposed to the patients 
medical information, which is stored in the patient chart).  

You open a patient record by selecting File > Open Patient, or by clicking the Patient button on the 
toolbar. When the Lookup screen appears, you simply enter the appropriate criteria to locate the 
correct record. 

1. Select File > Open Patient, or click the Patient button in the toolbar. The Lookup screen 
appears. 

2. Enter the search criteria and filters you want to use to narrow the search.  
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3. Click the Lookup button. 

4. In the search results table, highlight the appropriate patient and click the OK button.  

Note: If another Lytec MD operator is working with the patient record, the screen opens in view-only 
mode. You will not be able to edit or delete the record. 

Adding, editing, and deleting patients 
To add a patient: 

• Select File > New Patient. The Patient screen appears. Fill in the fields on this screen. To save the 
information you've added and continue to another tab, click the Apply button. When you're 
finished adding information, click the OK button to close the Patient screen. 
 
Your system administrator may use a demographic guide to make some tabs and buttons 
required or optional. 

To change a patient: 

• Open the Patient screen for the patient whose information you want to change. Make the 
appropriate changes. When you finish, click the OK button. 

To delete a patient: 

Note: You can delete a patient record only if you have not recorded any medical, scheduling, or billing 
information for that patient.  

• On the Patient screen, click the Delete button. A message asks you to confirm the deletion. Click 
the OK button. 

To print patient registration information: 

• Select Reports > Patient Registration to print the Patient Registration Printed report. 

Information on Patient 
Patient is divided into the following tabs:  

• General 

• Billing 

• Other Data 

• Notes 

• Providers 

• Dates 

• Cases 

• Configuration 

• Chart Access 
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The General Tab 

How the Duplicate Name Check feature may affect this box 

If the Duplicate Name Check feature is turned on, when completing and leaving Last Name, First 
Name/MI, SSN, and Date of Birth, the program checks to see if a patient with the same name already 
exists. If one does, then Duplicate Name Check appears. 

• If the match is actually another patient with the same name, click Close to return to the Patient to 
continue data entry.  

• If the patient already exists in the system, click Cancel New. This closes Patient. 

Entry Information 

Field Description 

Patient ID Type an identification number for the patient in this field. 

If you have the automatic ID feature turned on, an ID is 
automatically generated for the patient. 

If you do not have the automatic ID feature turned on, type an 
ID for the patient. You can use any combination of letters and 
numbers. 

Last Name Type the patient's last name. 
See "How the Duplicate Name Check feature may affect this 
box." 

First Name/MI Type the patient's first name and middle initial. 
See "How the Duplicate Name Check feature may affect this 
box." 

SSN Type the patient's Social Security Number. 
See "How the Duplicate Name Check feature may affect this 
box." 

Date of Birth Type the patient's date of birth. 
See "How the Duplicate Name Check feature may affect this 
box." 

Time of Birth Type the patient's time of birth in HH:MM format, and then 
select AM or PM from drop-down list. If the time of birth is 
unknown, leave this field blank.  

Age Lytec MD displays the patients age, based on the date you 
entered in the Birth date field. 

Sex Select the patients gender from the drop-down list. 

Marital Select the patients marital status from the drop-down list. Your 
options are S (single), D (divorced), M (married), W (widowed), 
and O (other). 

Usual Provider Lytec MD displays the patients default provider as specified on 
the Patient screens Provider tab. This is a read-only field. 
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Race If your system administrator has turned on this field (community 
health clinics and some other practices choose to gather this 
information for reporting, statistical, and research purposes), 
select the patients race from the drop-down list.  

Ethnicity If your system administrator has turned on the Race field 
(community health clinics and some other practices choose to 
gather this information for reporting, statistical, and research 
purposes), the Ethnicity field will be displayed. If you select the 
patient's race as white, you may choose either Hispanic or Non-
Hispanic from the drop-down list.  

Note: If you have the Spirometry add-on module, the patient's 
selected ethnicity will be used by the spirometer in order to 
make a correct interpretation of a spirometry test. Ethnicity will 
only be used if the patient's race is white. When the patient's 
race is white and their ethnicity is Hispanic, Brentwood 
Spirometry will treat the patient as Hispanic. 

Status Select the patients current status from the drop-down list. Your 
options are active, inactive, and deceased. 

OK to Mail Mark the check box if you want to send correspondence such 
as reminders and letters to the patient.  
To be active, your system administrator must use this setting in 
the ppart.ini file: Use_OK_to_mail=ON. 
Leave the box unchecked if you do not want the patient's 
information included in mailmerge files or mailing labels 
printed for the following reports: Appointment Reminders, 
Missing Appointments, and AS/PR Referrals 

Suffix Type the patients suffix (for example, Jr. or Sr.). 

Greeting Type a salutation (greeting) for use in correspondence to the 
patient (for example, Dear Jim Smith). You can include this 
phrase in mailmerge files, form letters, and form cards. 

Head of H. (Household) Select the patients head of household. 

If your system administrator has configured Lytec MD to 
automatically assign the account guarantor, you can change 
that value by clicking the Head of H. button. 

If your system administrator did not set a default, select a value 
from the list (the account guarantor or self). 

Note: You can select a head of household from any Lytec MD 
account by clicking the Head of H. button on this screen. 

Occupation Type the patients occupation (for example, carpenter or 
executive). 

Employer From the list, select the patient's employer code. For example, 
Y (yes, is working), N (not working), or R (retired). You can 
determine values for the other options (1 through 9). 

In the box, type the name of the patient's employer. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 523 

 

School From the list, select the patient's school status. The options are 
F (full time), P (part time), and blank (not currently attending 
school). 

In the box, type the name of the school that the patient attends 
or graduated from. 

Address Type the patients street address.  

Note: You can use three lines for the street or post office box 
part of the mailing address. 

City Type the patients city.  
Note: If you have configured address defaults for the city, skip 
to the ZIP Code field and type the ZIP Code first. Then the city 
will automatically display in this box. 

County If you have the county feature turned on, type the patients 
county. This feature is added through the Demographic 
Settings screen. 

If you do not have the county feature turned on, this field will 
not appear on screen. 

Note: If you have configured address defaults for the county, 
skip to the ZIP Code field and type the ZIP Code first. Then the 
county will automatically display in this box. 

State Select the patients state. 

Note: If you have configured address defaults for the state, skip 
to the ZIP Code field and type the ZIP Code first. Then the state 
will automatically display in this box. 

ZIP Code Type the patients ZIP Code (postal code). 

Country If you have the country feature turned on, select the patients 
country from the drop-down list. The feature is added through 
the Special Features screen. 

If you do not have the country feature turned on, this field will 
not appear on screen. 

Home Type the patients home phone number.  
 
If you want to add a note for this number (for example, "Do not 

call after 8 p.m."), click the  button. The Phone Note screen 
appears.  

If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  
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Work/Extension Type the patients work phone number and extension.  
 

If you want to add a note for this number, click the  button. 
The Phone Note screen appears.  

If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Cell Type the patients cell phone number.  
 

If you want to add a note for this number, click the  button. 
The Phone Note screen appears.  

If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Pager Type the patients pager number.  
 

If you want to add a note for this number, click the button. 
The Phone Note screen appears.  

If you have the phone dialer configured for your workstation, 

click the  button to dial the number.  

Fax Type the patients fax number.  

Email Type the patients e-mail address.  

Click the  button to send a message to this patient through 
your default e-mail editor (such as Microsoft Outlook).  

Buttons 

In addition to the fields listed below, click these buttons to open other dialogs from the General tab: 

• Alt IDs. Adding alternate patient IDs  

• Contacts. Adding contact information for patient 

• Head of H. Changing the head of household  

• History. Viewing the patient information history  

• Attach. Adding attachments (scans of insurance cards, etc.)  

• Photo. Adding a photo of the patient 

The Billing Tab 
All insurance information for the patient is stored on this tab because Account Insurance Plan does not 
exist. On the Billing tab, enter the insurance information, including carrier, plan, billing order, 
relationship to insured party, and effective date.  

Information for up to four insurance plans may be tracked. This tab helps to enter the insurance 
information by using a column format. Each column (labeled 1st, 2nd, 3rd, and 4th) contains the 
information for one insurance plan.  
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For each column, it is possible to specify if the patient has a different insurance ID than the insurance 
plan subscriber. The patient-specific information or the billing order for each insurance plan may be 
changed.  

Field Description 

Carrier  Select the appropriate carrier.  

Carrier Name  This displays the name of the carrier associated with the carrier 
ID you selected.  

Carrier Plan  Type the plan name.  

Group Number  Type the group number.  

Rel. to Insured  Select the relationship of the patient to the insured party.  

Last Name  Type the last name of the insured party.  

First and MI  Type the first name and middle initial of the insured party.  

Insured ID  Type the ID of the insured party.  

Insured SSN  Type the Social Security Number of the insured party.  

Effective Date  Select the date the insurance became effective.  

Expiration Date  Select the date the insurance expires.  

The Other Data Tab 
On the Other Data tab, enter data in user-defined fields. The system administrator may customize 
these to meet the specific needs. The user's access level determines if the Other Data tab may be 
used.  

The Notes Tab 
A patient registration note (not to be confused with notes in the patient's chart) is a written comment, 
instruction, or reference that is specific to a particular patient. Notes may be used to save important 
information about the patient. An unlimited number of notes for each patient may be entered.  

The information on this tab (and if this tab displays) depends on the user's access level and whether 
filters have been set. All activities may not be included in the totals.  

The Providers Tab 
On the Provider tab, indicate the patients primary provider (as defined by the patients insurance 
carrier or the initial referral). The usual provider(s) who will care for the patient in the practice or 
practices may be entered. These usual providers will be used as defaults for records, scheduling, and 
billing purposes. Depending on specialty, the primary provider and the usual provider may be the 
same provider.  

Field Description 

Primary Provider Click the patient's primary provider from the drop-down list. In 
Lytec MD, the primary provider is the primary care provider for 
the patient (as indicated by the insurance carrier or the initial 
referral). The primary provider can be internal (a provider in 
your practice) or external (for example, an outside primary care 
physician).  
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Type Select whether the primary provider is an internal or external 
provider.  

Date Active  Type the date the provider selected became the primary 
provider for the patient.  

Internal Providers Area  This area displays the patients internal providers. In addition to 
a primary provider, each patient may have a usual and 
attending provider for every practice in your organization. 
These are used for scheduling and other purposes. The 
attending provider is used if the usual provider is a resident or a 
mid-level health practitioner.  

Set one of the internal providers as the overall default provider. 
The default provider appears in the first row along with the 
default practice for the patient. The additional providers are 
sorted by practice. One provider may be entered with a blank 
practice.  

Referring Source Area  This area displays all referral entries that have been entered for 
the patient. Each row summarizes one referral.  

Referrals may be created to outside providers, or referrals 
coming into the office from outside providers or other sources 
may be recorded. Referrals may be created for internal use 
only, such as for visit tracking.  

Show Authorizations from External 
Referring Sources Only  

Click this check box to view a list of authorizations from outside 
referring sources only. This provides a quick overview of the 
patient's referring sources.  

The Dates Tab 
On the Dates tab, view important dates related to the patient. Dates displayed include the patient's 
first visit and last physical exam. Health maintenance information may be viewed from the patient's 
medical record by clicking HM.  

If Appointment Scheduler is being used also, the table displays the patient's appointment history with 
its date, time, type of visit, reason, and additional information. The appointment history is shown in 
descending chronological order, that is, with most recent at the top.  

If the HM button is red, the patient has overdue health maintenance items. Click to view them.  

The Configuration Tab 
The Configuration tab may be used to set a default flow chart for each patient, set up patient-specific 
growth charts for children, add, edit and delete patient pharmacies, and (if Web View is available) set 
up access for a patient to view portions of his or her chart on the Internet. 

The default flow chart is the first flow chart seen by a provider when selecting the Flow Chart tab on 
the patient chart.  

Growth charts for children are displayed when a provider graphs vital signs such as height, weight, and 
OFC. These may be customized for special pediatric situations such as Down's Syndrome or for certain 
ethnic groups.  

From the Configuration tab you can associate pharmacies with the patient. Before adding patient 
pharmacies you must create pharmacy records using Pharmacy Maintenance. You can associate 
multiple pharmacies with the patient.  
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Web View is a secure, Internet-based service that may be added to Lytec MD which lets patients, 
consultants, and providers view chart data on the web and send and receive secure messages. Patients 
can see selected portions of their personal chart, including medication lists, overdue health 
maintenance, future appointments, and vital signs. The system administrator sets which chart sections 
patients may view.  

If Web View is available, use the Configuration tab to indicate that the patient should be allowed to 
access Web View. The patient's user name and password may be entered.  

Field Description 

Height Plotting Normals If you want to use a different height plotting chart for the 
patient rather than the default plotting chart (for example, 
because of the patients ethnic background or disease state), 
click the Browse button and navigate to the appropriate .plt file.

Weight Plotting Normals If you want to use a different weight plotting chart for the 
patient rather than the default plotting chart (for example, 
because of the patients ethnic background or disease state), 
click the Browse button and navigate to the appropriate .plt file.

OFC Plotting Normals If you want to use a different OFC plotting chart for the patient 
rather than the default plotting chart (for example, because of 
the patients ethnic background or disease state), click the 
Browse button and navigate to the appropriate .plt file. 

Default Flow Chart To set the default flow chart for a patient, type the name of the 
appropriate flow chart template. This will be the first flow chart 
shown for the patient. You can also click the down arrow button 
to access the Flow Chart Select screen. Select the default flow 
chart from the list, and click the OK button.  

Allow Web View access for patient If you have Web View and you want to allow the patient to use 
Web View, select this check box. 
When selected, the Login name and Password fields are 
displayed. Enter the patient's login name in the Login name 
field, and a password in the Password field. 

Note: When the Patient Chart, Lab Table Review, or Review 
Provider Data screen is displayed, the current patient's Web 
View status is shown in the status bar at the bottom of the 
Patient Records window. If the patient can use Web View, the 
text 'Web View' is displayed in green in the status bar. If the 
patient cannot use Web View, the text is displayed in red. 

Patient Connected via RelayHealth This setting indicates whether the patient is connected to 
RelayHealth. Once the patient is enrolled with RelayHealth, 
RelayHealth will send your Lytec MD system a message via the 
RelayHealth Inbound interface indicating that the patient is 
"online" and this setting will be automatically enabled. Do not 
change this setting unless instructed to do so by Lytec MD 
personnel. 
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Patient Pharmacies This section of the Configuration tab allows you to associate 
pharmacies with the patient. Before you can associate 
pharmacies with the patient, pharmacy information must be 
entered using Pharmacy Maintenance. Once pharmacy 
information has been defined, you can use Patient Pharmacies 
to add, edit, and delete pharmacies for the patient. When a 
pharmacy is added for the patient, the pharmacy information 
will be displayed in the Patient Pharmacies list. See the Patient 
Pharmacies section for more information. 

The CHC tab 
This tab is displayed when the Demographic setting, "Display CHC tab" is enabled. This tab allows you 
to enter the following:  

• If the patient is female, the Pregnancy section is enabled. You can use this section to add a new 
pregnancy, edit existing pregnancy information, and delete pregnancy information. 

• Record missing teeth for the patient using the Dental button. This information prints on dental 
claim forms.  

Field Description 

Patient Status This section of the CHC tab allows you to add, edit, and delete 
patient status information. Click on the provided radio buttons 
(Grant Programs, Agricultural Work, or Homelessness) to view 
the patient's status for each category.     

To add a patient status: 

1. Select the Grant Programs, Agricultural Work, or 
Homelessness radio button. Use Grant Programs to note 
how the patient’s medical services are funded. Use the 
Agricultural Work and Homelessness options to record 
additional patient information, if they apply. Only one 
option can be selected at a time.  

2. Click the New button. The corresponding category screen 
will appear (i.e., Grant Program <New>).   

3. Fill in the fields on this screen. 
 Grant Programs <New>: Enter the date in the Date 

field, or click the down arrow button to access the 
calendar. Select Active or Inactive from the Status drop-
down list. Select the grant program from the drop-
down list.  

 Agricultural Work <New>: Enter the date in the Date 
field, or click the down arrow button to access the 
calendar. Select Active or Inactive from the Status drop-
down list. Select the worker type from the drop-down 
list.  

 Homelessness <New>: Enter the date in the Date 
field, or click the down arrow button to access the 
calendar. Select Active or Inactive from the Status drop-
down list. Select the homeless shelter from the drop-
down list. Select the homeless reason from the drop-
down list.  
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4. Click the OK button. The status will be displayed in the 
Patient Status list, under the corresponding category (i.e., 
Grant Programs).  

To edit a patient status: 

 Select the Grant Programs, Agricultural Work, or 
Homelessness radio button. In the list highlight the 
patient status you want to change. Click the Edit button. 
Make the appropriate changes. When you finish click 
the OK button.  

To delete a patient status: 

 Select the Grant Programs, Agricultural Work, or 
Homelessness radio button. In the list highlight the 
patient status you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. 
Click the OK button. 

Pregnancy The Pregnancy section of the CHC tab allows you to add new 
pregnancy CHC information, edit existing pregnancy 
information, and delete pregnancy information. See the 
Community Health Center - Pregnancy section for more 
information.  

Dental button Click this button to record missing primary and permanent 
teeth. The Dental - Missing Teeth screen allows you to select 
which teeth the patient is missing. To record a missing tooth 
select the check box of the missing tooth in the Primary or 
Permanent section of the screen. When you finish click the OK 
button.   

The Chart Access tab 
This tab allows you to specify which users are allowed access to the patient's chart, or which user's are 
not allowed access to the patient's chart.  

To limit access to certain users: 

1. Select the Limit Access to only these users radio button.  

2. Click the New User button. The Operator Select screen appears. 

3. Select an operator from the list. When the appropriate operator is selected, click the OK 
button. The operator will be added to the list.  

4. You may repeat this process until you have added all appropriate users to the list.  

To block certain user's from the patient's chart: 

1. Select the Block these user's from access radio button.  

2. Click the New User button. The Operator Select screen appears. 

3. Select an operator from the list. When the appropriate operator is selected, click the OK 
button. The operator will be added to the list.  

4. You may repeat this process until you have added all appropriate users to the list.  
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To remove a user from the list: 

• Highlight the user that you want to delete. Click the Delete User button. A message asks you to 
confirm the deletion. Click the OK button. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 531 

 

Accounts and registration 
The major Lytec MD programs share the same registration database. When you enter information on 
the demographic screens – including the Patient screen, Guarantor screen, and many Maintenance 
menu options – in Patient Records, the data will also be accessible in Appointment Scheduler.  

Patient Records has no accounts (except behind the scenes). Patients are the link to guarantors and 
account insurance information. You can add guarantors (the person financially responsible for a 
patient) and account insurance information only when a patient chart or the Patient screen is open. This 
lets Patient Records know which patient should be linked to the information.  
 
The first step in the registration process is to open the Patient screen and enter demographic 
information about the patient. You can then add account insurance information on the Patient screen’s 
Billing tab (there isn’t a separate screen to track account insurance plans). After you finish adding 
patient information, you can optionally enter data for the patient’s guarantor by opening and filling out 
the Guarantor screen. 

About registering guarantors  
A guarantor is the person or organization who is financially responsible for a patient (in other words, 
the one “paying the bill”). When you register a guarantor, you are creating the account. This account 
links the guarantor to related patients and account insurance plans.  

About registering patients  
When you register a patient, you can elect to link him to an existing account by selecting New Patient 
when the Guarantor screen is open. This automatically links the new patient to the current guarantor.  

You can also “quick register” a patient, a process that lets you add minimum information about the 
patient but does not require you to immediately link the patient to an account. If you use the quick 
registration mode, some of the Patient screen’s tabs and fields (those tracking account-specific 
information) will not be available. You can link a quick-registered patient to an account by selecting File 
> Add Patient to Acct when an account is active. An account is active when the Patient screen or patient 
chart is open for a patient who already belongs to the account, or when the Guarantor screen is open 
for the account's guarantor.  
 
For example, if Richard Stein is a patient and guarantor on the account to which you want to add the 
patient, you can make the account active by opening the Patient screen, patient chart, or Guarantor 
screen for Richard Stein.  
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Alternate patient IDs 
Alternate ID information for the patient is accessed through the Alt IDs button on the Patient screen’s 
General tab. Your system administrator must first set up user-defined fields for the alternate IDs.  

Adding, editing, and deleting alternate patient IDs 
To add an alternate patient ID: 

1. On the Patient screen, click the Alt IDs button. The Patient Alternate IDs <Edit> screen appears.  

2. Enter the appropriate data in the fields.  

Note: The system administrator must first set up the fields.  

3. When you finish, click the OK button. You return to the Patient screen.  

To change an alternate patient ID: 

• On the Patient Alternate IDs <Edit> screen, highlight the alternate patient ID that you want to 
change, then make the appropriate changes. When you finish, click the OK button. 

To delete an alternate patient ID: 

• On the Patient Alternate IDs <Edit> screen, highlight the entire text of the appropriate ID, then 
press the Delete key. When you finish, click the OK button. 
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Contact information for patient 
Contact information for the patient is accessed through the Contacts button. You can use the Contact 
Information for Patient screen to store information about the patient’s next of kin, emergency contacts, 
lawyers, and so on. You can create multiple contact records for each contact type (for example, parent, 
guardian, financial guarantor, etc.).  

The contact categories that you can choose from while entering contact information for a patient are 
configurable in the Ppart.ini file. Your system administrator can add new categories, if required.  

Adding contact information for patient 
To add contact information for a patient: 

1. On the Patient screen, click the Contacts button. The Contact Information for Patient: Summary 
screen appears. 

2. Click the New button to open the Contact Information for Patient <New> screen. 

3. Fill in the fields on this screen, then click the OK button. 

Fields and buttons on the Contact Information for Patient: 
Summary screen 
Field Description 

Type Displays the type of the contact information entered for the 
patient (for example, Alias, Emergency Contact 1, or Next of 
Kin). 

Description Displays the contact's description (for example, "Spouse" or 
"Half Brother").  

Name/Entity Displays the contact's full name (first name, middle initial, last 
name and suffix).  

Home Phone Displays the contact’s home phone number. 

Work Phone Displays the contact’s work phone number. 

Cell Phone Displays the contact’s cell phone number. 

Email Displays the contact's e-mail address. 

New Click this button to open the Contact Information for Patient 
<New> screen. Enter the required information, and then click 
the OK button to save the new contact record for the patient. 

Edit  Highlight an existing contact and click this button to open the 
Contact Information for Patient <Edit> screen. Make the 
appropriate changes, and then click the OK button to save the 
contact record.  

Delete Highlight a contact and click this button to delete it. You will be 
prompted to confirm the deletion. Click the Yes button. 

Close Click this button to close the screen.  
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Fields on the Contact Information for Patient <New> screen 
Field Description 

Type Select the type of contact information you are entering (for 
example, Emergency Contact 1 or Next of Kin). Your system 
administrator can add to the list that ships with Patient Records.

Description Type a description for the contact. Use this field to enter 
additional information about the contact's relationship to the 
patient (for example, if the contact's type is Next of Kin, you can 
enter "Mother" or "Half Brother"  in the Description field to 
further clarify the contact's kinship relation to the patient).  

Last Name or Entity If the contact you are adding is a person, type the person’s last 
name. 
If the contact you are adding is an organization, type the 
organization’s complete name. 

First Name and MI Type the contact’s first name and middle initial. 

Suffix Type the contact’s suffix (for example, Jr. or Sr.). 

Greeting Type a salutation (greeting) for use in correspondence to the 
contact (for example, “Dear Sandra Lever”). You can include this 
phrase in mail merge files, form letters, and form cards. 

Address Type the contact’s street address. 

Note: You can use three lines for the street or post office box 
part of the mailing address. 

City Type the contact’s city. 

Note: If you have configured address defaults for the city, skip 
to the ZIP Code field and type the ZIP Code first. Then the city 
will default in this field. 

County Type the contact’s county. 

Note: If you have configured address defaults for the county, 
skip to the ZIP Code field and type the ZIP Code first. Then the 
county will default in this field. 

State Select the contact’s state. 

Note: If you have configured address defaults for the state, skip 
to the ZIP Code field and type the ZIP Code first. Then the state 
will default in this field. 

ZIP Code (Postal Code) Type the contact’s ZIP Code (postal code). 

Country If the country feature is turned on, select the contact’s country 
from the drop-down list.  
The feature is added through the Display Country setting on 
the General tab of the Special Features screen. If the Display 
Country setting is disabled, this field will not appear on screen. 

Home  Type the contact’s home phone number. 

Work and Extension Type the contact’s work phone number and extension. 

Cell  Type the contact’s cell phone number. 
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Pager Type the contact’s pager number. 

Fax Type the contact’s fax number. 

Email Type the contact’s e-mail address. 

Notes Type text information (up to 1000 characters) that is related to 
the contact (for example, the best hours to reach the contact).  

OK Click this button to confirm the changes you made to the 
patient’s contact information and close the screen. 

Cancel Click this button to close the screen without saving the changes 
you made to it. 
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Head of household 
Head of household information for the patient is accessed through the Head of H. button. You can use 
this button to locate an existing patient or guarantor who is the patient’s head of household, and to tie 
together families created by social relationships.  

A record for the head of household must already have been entered in Lytec MD. This person is usually 
the guarantor on the account, but can be another patient.  

Changing the head of household 
To change the head of household: 

1. On the Patient screen, click the Head of H. button.  
• If a head of household has not already been selected, the Lookup screen appears.  

• If a head of household has already been selected, the Head of Household screen 
appears. Click the Account Lookup button. The Lookup screen appears.  

2. Enter the criteria to select the appropriate head of household, and then click the Lookup 
button.  

3. Highlight the head of household, and then click the OK button. You return to the Head of 
Household screen.  

4. Click the OK button to return to the Patient screen.  
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Patient history 
Historical demographic information for the patient is accessed through the Patient screen's History 
button. This information includes the patient’s previous names, addresses, and contact numbers. You 
can view this data for specific dates and times.  

Viewing the patient history 
To view the patient history: 

1. On the Patient screen, click the History button. The Patient Information History screen appears.  

2. In the Date/Time of Change field, click the date or time for which you would like to view 
historical information.  

3. When you finish, click the OK button. You return to the Patient screen.  
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Patient attachments 
In addition to adding a patient photo, you can attach unlimited text, image, or other files related to the 
patient. For example, you may want to scan and attach insurance ID cards, hospital and lab ID cards, or 
additional photos.  

After you add an attachment, you can:  

• Edit the description of a saved attachment. On the Patient Attachments Select screen, highlight 
the attachment and click the Edit button. On the Patient Attachment Description screen, make 
the necessary changes to the description.  

• Print or view a full-sized version of the image or document. On the Patient Attachments Select 
screen, select the file and click the View button. If you selected an image it will be opened in 
Patient Attachment, where the image may be printed or viewed at full size. If you selected a 
document such as a Word document, it will be opened as a read-only file, where you can then 
print the document. 

• Delete an image. On the Patient Attachments Select screen, highlight the attachment in the 
table and click the Delete button.  

Adding, changing, and deleting patient attachments 
To open the patient attachments screen: 

• On the Patient screen, click the Attach button. The Patient Attachments Select screen appears. 
This screen lists files that have already been attached to the patient. You can click on the 
attachment description to view a thumbnail of the file (if the selected attachment is an image file 
(JPG, Bitmap, or GIF). If the selected attachment is a non-image file (Word, Excel) the file type 
(e.g., .XLS) will be displayed in the box on the right. 

To add a patient attachment: 

1. Click the New button. The Load Patient Attachment screen appears.  

2. In the Attachment Description field, type a description of the file. This description will display 
on the Patient Attachments Select screen.  

3. In the Attachment Folder field, type the path to the file. You can also click the Browse button 
and navigate to the folder that contains the file. Select the Attachment Type to view all files of 
that type in the folder. Highlight the appropriate file in the box on the left (if the selected 
attachment is an image file (JPG, Bitmap, or GIF) a thumbnail view will be displayed on the 
right).  

4. If you want to delete the original file after you close the Load Patient Attachment screen, 
select the “Delete Original File After Load?” check box.  

5. When you finish, click the OK button. You return to the Patient Attachments Select screen.  

To view a patient attachment: 

1. On the Patient Attachments Select screen, highlight the patient file that you want to view. 
Click the View button. The Patient Attachment screen appears. If you selected a non-image 
file, the attachment will appear in its native application. For example, if you select a Word 
document, the file will open up in Word.  

2. To view the file at full size, click the Full Size button on the Patient Attachment screen. Click 
the Fit Screen button, to return to the file's original size.  
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3. Click the Print button to print the file.  

4. When you finish, click the OK button. 

To change the description of a patient attachment: 

• On the Patient Attachments Select screen, highlight the attachment that you want to change. 
Click the Edit button and change the attachment's description. When you finish, click the OK 
button. 

To delete a patient attachment: 

• On the Patient Attachments Select screen, highlight the attachment that you want to delete. 
Click the Delete button. A message asks you to confirm the deletion. Click the Yes button. 

To print image files (JPGs, Bitmaps, or GIFs):  

• On the Patient Attachments Select screen, highlight the attachment that you want to print. Click 
the Print button.  

Note: To print TIF images, highlight the file on the Patient Attachment Select screen. Click the View 
button. The TIF image will appear in the Microsoft Office Document Imaging application. Click the Print 
button in the application to print the file.  

To print text files, PDFs, or TIFs: 

• On the Patient Attachment Select screen, highlight the attachment you want to print. Click the 
View button. The attachment will appear in its native application. Use the Print button in the 
native application to print the attachment.  
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Patient photographs 
You can add an image file (.bmp, .gif, or .jpg format) of the patient through the Photo button. The 
photo displays on the Patient screen's General tab. 

In addition, you can add other images (for example, a scan of the patient's insurance card) through the 
Patient screen's Images button. 

Adding, changing, and deleting patient photographs 
To add or change a patient photograph: 

1. On the Patient screen, click the Photo button. The Load Patient Photo screen appears.  

If a patient photo has already been added, the Patient Photo screen appears. Click the Update button 
to open the Load Patient Photo screen.  

2. Click the Browse button and navigate to the folder that contains the photo file. Then click the 
Open button.  

3. If you want to delete the original photo file after you close the Load Patient Photo screen, mark 
the “Delete Original File After Load?” check box.  

4. If the name of the photo file does not display in the box on the left side, make sure that the 
appropriate file type is selected in the Image Type field.  

5. When you finish, click the OK button. You return to the Patient screen. Once you add a patient 
photo, and you click the Photo button, the Patient Photo screen appears.  

6. Click the Close button to return to the Patient screen.  

To delete a patient photograph: 

1. On the Patient screen, click the Photo button. The Patient Photo screen appears.  

2. Click the Delete button. A message asks you to confirm the deletion. 

3. Click the Yes button. 
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Patient's providers 
The Patient screen's Providers tab displays the patient's primary and internal providers. On this tab, 
you can use the Internal Providers frame to assign providers from your practice to the patient. 

Adding, editing, and deleting a patient's provider 
information 
To add a patient's provider information: 

• On the Patient screen, click the Providers tab. Then click the New Prv button. Fill in the fields on 
this screen, then click the OK button. 

To change a patient's provider information: 

• On the Patient screen's Providers tab, highlight the patient's provider that you want to change. 
Click the Edit Prv button. Make the appropriate changes. When you finish, click the OK button. 

To delete a patient's provider information: 

• On the Patient screen's Providers tab, highlight the patient's provider that you want to delete. 
Click the Delete Prv button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Patient Internal Provider screen 
Field Description 

Practice Select a practice from the drop-down list. There can be only 
one internal provider entry per practice.  

Usual Provider  Type the provider code, or click the down arrow button to 
select a provider from the Provider Select screen. Once you 
add the first practice and provider, the default provider for the 
practice appears in the Usual Provider field. You can select 
another provider if necessary.  

Attending Provider  If this feature is turned on, select an attending provider from the 
drop-down list. The Attending field is for residencies or for 
practices with mid-level practitioners.  

Other Provider Specify the patient's other provider if applicable. You can use 
the Provider Role list to specify the other provider's role with 
regard to the patient. 
Type the provider code, or click the down arrow button to 
select a provider from the Provider Select screen.  
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Provider Role Select the other provider's role from the drop-down list, or you 
may enter a role that is not on the list, if nothing on the list 
adequately describes the provider’s role with regard to the 
patient. 

Note: The options available from the Provider Role list are 
defined by the Lytec MD list specified by the ProviderRoleList= 
setting in the PPart.ini file. You can use List Maintenance to edit 
the default PROVIDER ROLE list, or set up a new list of provider 
roles. 

Default  If you select this check box, the provider you select in this field 
is used as the default provider.  
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Patient Referring Sources 
You can indicate a patient's referring sources on Referring Source <New>. To access this dialog, click 
New Src. on the Provider's tab on Patient. 

Procedures for adding, editing, and deleting referring 
sources for patients 
To access the referring source section of the Patient screen: 

• On Patient, click the Providers tab. The patient's referring sources can be added, edited, and 
deleted from the Referring Sources area. 

To add a referring source: 

• In the Referring Sources area, click New Src. Fill in the information on Referring Source, then 
click OK. 

To change a referring source: 

• In the Referring Sources area, select the referring source to be changed. Click Edit Src. Make 
the changes. When finished, click OK. 

To delete a referring source: 

• In the Referring Sources area, select the referring source to be deleted. Click Delete Src. A 
message asks to confirm the deletion. Click OK. 

Information on Referring Source 
Field Description 

From  In the first field, select the source initiating the authorization or 
referral from the drop-down list.  
In the second field, indicate whether the source is an internal 
provider, an external provider, or another patient.  

To Provider  In the first field, select the provider receiving the referral from 
the drop-down list.  
In the second field, indicate whether the source is an internal 
provider or an external provider.  

Description Type a short description of the referral source.  

Auth #  Type the carrier or internal authorization number. If an 
authorization was denied, you can type “Denied” or some other 
appropriate code for display instead.  

From (date)  Type the first date that the referral is valid.  

To (date)  Type the last date that the referral is valid.  

Completed  Type the date the authorized procedures were completed. Until 
you enter this date, the Actv (Active) check box in the 
Authorizations and Referring Sources Summary frame is 
marked.  
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Started by  This field displays the ID of the person who started the 
authorization.  

Visit Counts and AS Settings tab If you also have Appointment Scheduler, and you want to add 
visit tracking information, click this tab. 
Mark the Count in AS radio button, and then enter information 
into the fields on this tab/ 

Visit Counts – Allowed  Type the number of visits allowed for the referral.  

Visit Counts – Scheduled  This field displays the number of visits that have been 
scheduled for the referral. This number includes past visits.  

Visit Counts – Done  This field displays the number of completed visits.  

To Provider  If you mark the Required check box, when this referral is 
selected, Appointment Scheduler will allow you to schedule a 
visit for this provider only (the To Provider selected earlier).  
In a future version, Appointment Scheduler will also use this 
provider as the default for scheduling.  

To Practice  If you select a practice in this field, Appointment Scheduler will 
default to a calendar for that practice when visits are scheduled. 
A calendar for another practice can be selected when 
scheduling, unless you mark the Required check box.  
In a future version, Appointment Scheduler will also use this 
practice as the default for scheduling.  

Type of Visit  If you select a type of visit in this field, Appointment Scheduler 
will default to that type of visit when visits are scheduled. 
Another type of visit can be selected when scheduling, unless 
you mark the Required check box.  
In a future version, Appointment Scheduler will also use this 
type of visit as the default for scheduling.  
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Patient registration notes 
A patient registration note (not to be confused with progress notes in the patient’s chart) is a written 
comment, instruction, or reference that is specific to a particular patient. You can use notes to save 
important information about the patient. You can enter an unlimited number of notes for each patient.  

You can attach several attributes to a note, including function and “to do” attributes such as priority 
(used to prioritize “to do” notes only) and category (used to sort “to do” notes only). The different 
function options allow you to display notes in various sections of Patient Records and Appointment 
Scheduler. For example, you can select to: display the note when the patient’s chart is opened, an 
appointment is made, or an account is opened; display the note when the Patient screen appears; or 
print the note on the billing statement.  

Lytec MD stores both active and archived notes on the Patient screen’s Notes tab. You can view a 
summary of all notes for a patient. You can also edit or delete these notes, and add new notes. Notes 
display by function, then by date.  

Notes are stored in two folders on this tab. The Current Notes folder includes all active notes. The 
Archived Notes folder includes notes that were manually or automatically removed from active status. 
You can switch between folders by marking the Current Notes or Archived Notes radio buttons. If you 
try to add a note while in the Archived Notes folder, Lytec MD automatically changes to the Current 
Notes folder.  

By default, all notes display on this tab. You can “filter” the notes that appear by selecting a function in 
the filter list, or by marking the To Do Only check box. If you select a function, only notes with that 
function will display. If you mark the To Do Only check box, only “to do” notes will display. If you select 
a function and mark the check box, only “to do” notes with the chosen function will display.  

Note functions 
You can use the notes function feature to display selected notes for a patient each time you open a 
specified screen. For example, if you add the "patient" function to six patient notes, those six notes will 
display each time the Patient screen opens. Because you can select more than one note to display, 
Lytec MD groups the notes into the Display Notes screen.  

The note functions that display depend on which Lytec MD programs you are using:  

• With Appointment Scheduler, the Scheduler functions display.  

• With Patient Records, the Medical Record functions display.  

Note: The Show Registration Notes when linking to Chart from Message check box in the Special 
Features screen determines whether patient registration notes are displayed before the patient chart 
when operators click the Link button in the View Message screen. 

Patient note functions 

The table below describes where notes display for patient note functions.  

Function Description 

Patient  Displays when the Patient screen for the patient is accessed.  

Note  Display on the Patient screen's Notes tab only. These notes are 
for reference and to-do lists.  
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Patient/Scheduler/Medical Record  Displays when:  
 The Patient screen for the patient is accessed.  

 When an appointment is made for the patient in 
Appointment Scheduler.  

 When the patient is checked in for an appointment in 
Appointment Scheduler.  

 When the patient chart for the patient is accessed in 
Patient Records.  

Scheduler  Displays when:  
 When an appointment is made for the patient in 

Appointment Scheduler.  
 When the patient is checked in for an appointment in 

Appointment Scheduler.  

Scheduler/Medical Record  Displays when:  
 When an appointment is made for the patient in 

Appointment Scheduler.  

 When the patient is checked in for an appointment in 
Appointment Scheduler.  

 When the patient chart for the patient is accessed in 
Patient Records.  

Medical Record  Displays when the patient chart for the patient is accessed in 
Patient Records. 

Chart Displays on the patient chart, below the chart tabs. You may 
need to maximize the chart to see the note. 

Note: Chart-type notes can also be added or edited by typing 
directly in the Note field on the Patient Chart. You are 
prevented from adding or editing a Chart-type note from the 
Patient screen's Notes tab if another user is currently working in 
the Note field in the same patient's chart. 

Adding, editing, and deleting patient registration notes 
The information you see on the Patient screen's Notes tab (and whether you can even display this tab) 
depends on your access level and whether filters have been set. All activities may not be included in 
the totals.  

To add a patient registration note: 

• On the Patient screen, click the Notes tab. Then click the New Note button. Fill in the fields on 
this screen, then click the OK button. 

To change a patient registration note: 

• On the Patient screen, click the Notes tab. Highlight the patient registration note that you want 
to change. Click the Edit button. Make the appropriate changes. When you finish, click the OK 
button. 
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To delete a patient registration note: 

• On the Patient screen, click the Notes tab. Highlight the patient registration note that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Patient Registration Note screen 
Field Description 

Function From the drop-down list, select where you would like this note 
to display. For example, if you select Patient, the note will 
appear when the Patient screen is opened.  

Active Date  Type the date you want the note to be active. The active date is 
the day the note becomes “functional” (that is, the day the note 
displays according to the function you selected in the previous 
field).  

Expire Date  If you want the note to expire, type the expiration date in this 
field. The expiration date is the day the note will be archived or 
purged, depending on your system settings.  
If you do not select a date in this field, the note will never 
expire.  

Cycle  This feature has not yet been implemented.  

Note box  Type the text you want to appear in the note.  

To do?  If you want to make this note a to do item, mark the check box.  

Priority  If you marked the To do? check box and you want to assign a 
priority to the note, select the priority from the drop-down list. 
This is used to prioritize "to do" notes only.  

Category  If you marked the To do? check box and you want to assign a 
category to the note, select the category from the drop-down 
list. This is used to sort "to do" notes only.  

Assigned to  If you marked the To do? check box and you want to assign an 
operator to the note, select the operator from the drop-down 
list.  

Subject  If you marked the To do? check box and you want to assign a 
unique subject line to the note, type the subject in this field.  
If you do not assign a unique subject, the first 30 characters of 
the note appear as the subject when you save the note.  

Completed?  If you marked the To do? check box and the to do item has 
been completed, mark this check box.  
 
When you mark this check box, the note is archived or purged, 
depending on your system settings.  
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Patient pharmacies 
The Patient Pharmacies section of the Patient screen's Configuration tab allows you to associate 
pharmacies with the patient. Before you can associate pharmacies with the patient, pharmacy 
information must be entered using the Pharmacy Maintenance screen.  

Once pharmacy information has been defined, you can use Patient Pharmacies to add, edit, and delete 
pharmacies for the patient. When a pharmacy is added for the patient, the pharmacy information will 
be displayed in the Patient Pharmacies list.  

Note: If a single pharmacy has been added for the patient, it is displayed automatically in the 
Prescription screen's Pharmacy field when a new prescription is created. If multiple pharmacies are 
associated with the patient, the Pharmacy field will be blank. 

Procedures for adding, editing, and deleting patient 
pharmacies 
To add a patient pharmacy: 

1. On the Patient screen Configuration tab, click the New button in the Patient Pharmacies area. 
The Patient Pharmacy <New> screen appears. 

2. Fill in the fields on this screen, then click the OK button. 

To change a patient pharmacy: 

• In the Patient Pharmacy list, highlight the pharmacy that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a patient pharmacy: 

• In the Patient Pharmacy list, highlight the pharmacy that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Patient Pharmacy screen 
Field Description 

Pharmacy ID Type the pharmacy ID, or click the down arrow button to select 
a pharmacy from the Pharmacy Select screen. Once the ID has 
been selected, the pharmacy name will be displayed in the field 
next to the Pharmacy ID field. 

Preferred Select this option, to designate the pharmacy as the patient's 
preferred pharmacy. You may indicate one preferred Pharmacy 
for each Pharmacy Type. 

Note Enter any notes you may have. 
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Reports 

Patient Registration Report 
You can print patient registration information in a variety of formats. You can print mailing labels, full 
reports, or create a mailmerge file for incorporation in form letters or printed cards.  

You can select patients by provider, date of registration, day of birth, age, and sex. You can use any or 
all of these criteria. If you don’t use any of the criteria, information on all patients is printed. You can 
also select whether you want mailing labels, full reports, or a mailmerge file.  

To print a patient’s registration information:  

1. Select Reports > Patient Registration. The Patient Registration Printed Report screen appears.  

2. You can select specific patients or a range of patients. Highlight your choice from the list and 
press the TAB or ENTER key. Then fill in the appropriate data.  
• Patient ID or name – To select a specific patient, complete the Patient Lookup screen.  

• Provider ID – Enter a provider ID, or select one from the drop-down list. The Provider 
Name automatically displays.  

• Registered Since – Patients who have registered since that date.  

• Day of birth (from– to)  

• Birthdate range (from– to)  

• ZIP Code (postal code)  

• Sex  

3. You have a choice of three (3) print formats. From the Print Format list, select one of the 
following formats:  
• Full print-out – The full report uses one 8.5-inch by 11-inch sheet of paper for each 

patient. This report includes all the information on the Patient screen.  

• Mailing Labels – This option prints mailing labels on stock, single-column formfeed 
mailing labels, measuring 4 inches by 1 7/16 inches. The mailing label format prints the 
patient’s name, street address (three lines), city, state, and ZIP Code (postal code) for all 
the patients you select.  
 
Your system administrator can configure Patient Records to print only two street address 
lines, instead of the default three lines.  

• Mailmerge – You can use the mailmerge file to create personalized reminder letters for 
your patients. The mailmerge file option creates a file called PATMERGE that includes 
patient name, address, city, state, and ZIP Code (postal code) for all the patients you 
select. You can then merge the contents of this file with the text of a card or letter created 
with a word processing program. The items are in the following order:  
 
"lname","fname",”MI”,“Greeting”,“Suffix”,"address1", 
"address2",”address3",”city","state","postal code", “country”  
 
If you have previously used the mailmerge option, your previous mailmerge file is 
renamed PATMERGE.BAK and the new one replaces it.  
 
You can use this file with any word processor that can read the Microsoft Word mailmerge 
file format to create personalized patient reminder letters. To incorporate mailmerge 
information in cards or letters, follow the instructions in your word processing.  
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4. Click the OK button to print.  

Missing Progress Notes Report 
This report prints a list of patients who were scheduled for a visit, but for whom no progress note exists. 

To print the Missing Progress Notes report:  

1. Select Reports > Missing Progress Notes. The Progress Notes Report screen appears.  

2. To print the report for a specific provider, type the provider's ID. To print for all providers, leave 
the Enter Provider ID field blank. 

3. To print the report for specific dates, type the date range (from/to). To print for all dates, leave 
the date fields blank. 

4. Click the OK button. 

Note: After the report prints, you may return to the Progress Notes Report screen. Click the Cancel 
button to close the screen. 

AS/PR Referrals 
Use this report to generate a list of current referring sources for patients or appointments. You can print 
AS/PR Referrals in a variety of formats, including mailing labels, a mailmerge file for incorporation in 
form letters or printed cards, or a full report.  

You can select whether to generate the report for internal, external, or patient referrals. You can also 
choose to filter referrals by date, provider and/or practice, and type and/or specialty of referring 
source. 

To generate the AS/PR Referrals report: 

1. Select Reports > AS/PR Referrals. The AS/PR Referrals screen appears. 

2. Select whether you want the report to be generated based on appointments or based on 
patients. Select the Base on Appointments radio button to base the report on appointments. 
Select the Base on Patient radio button to base the report on patients.  

3. Select whether you want to print the report for external, internal, or patient referrals. When the 
Internal Referrals option is selected, you will not be able to filter the report by practice. When 
the Patient Referrals option is selected the Types and Specialties section will be disabled.  

4. Type the From Date and To Date to establish a range of referrals you want to print the report 
for. If you leave the dates blank, all referrals up to the current system date and time that meet 
the other criteria you set will be included in the report.  

5. Click the All Providers check box to print the report for all providers. When this option is 
selected the Providers list box will display all providers. You can also click the Select 
Scheduled Resource button to select the provider(s), room(s), or resource(s) you want to 
include in the report. See the Select Resource screen section in Appointment Scheduler Help 
for more information.  

6. Click the All Practices check box to print the report for all practices. When this option is 
selected the Practice list box will display all practices. You can also click the Select Practice 
button to select the practice(s) you want to include in the report. See the Select Practices 
screen section in Appointment Scheduler Help for more information.  

7. Click the All Types radio button, to print the report for all referring source types. When this 
option is selected all referring sources will be displayed in the list box. You can also click the 
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Select Source Types button to select the referring source type(s) you want to include in the 
report. See the Select Referring Source Type screen section for more information. 

8. Click the All Specialties radio button, to print the report for all specialties. When this option is 
selected all specialties will be displayed in the list box. You can also click the Select Source 
Specialties button to select the specialty you want to include in the report. See the Select 
Specialty screen section for more information. 

9. Select whether you want the report to be generated as a summary report or patient list. Select 
the Summary Report radio button to generate the report as a summary. Select the Patient List 
radio button to generate the report as a patient list.  

10. Select whether you want the report generated in report format, as mailing labels, a mailmerge 
file. You can select all options if desired. 

11. To print the report to a file (instead of to a printer), select the Print to file check box. 

12. Select the Filter On Practice/Pr radio button to sort the report by practice and provider. If this 
check box is not selected, the report will be sorted by referring source. 

13. Click the OK button to generate the report in the desired layout.  

Patient Inquiry  
With Patient Inquiry, you can view, print, or store a report based on a relational inquiry of the 
information you have stored in Patient Records. You can also save an inquiry and run it again later.  

The results of a Patient Inquiry can be used in a variety of ways. For example, you can generate form 
letters and labels for reminder notes to patients or selectively print the charts of patients who meet 
special criteria for research purposes.  

A special feature of Patient Inquiry is a statistical summary. Both the number and percentage of patients 
who meet all the criteria you specify are printed on the selection criterion report.  

Selecting the Patient Inquiry report type  

To select a type of report to print:  

• Select one of the following report type options:  

• Patient List – Produces a list of the patients whose records fit your inquiry. You can use this 
list to select and view their information. In addition, if health maintenance up-to-date or 
not up-to-date was a selection criterion, then the patient list includes those health 
maintenance procedures that are up-to-date or not up-to-date.  

• Mailing Labels – Generates labels on stock single-column form-feed labels, measuring 4 
inches by 1 7/16 inches.  
 
Your system administrator can configure Patient Records to print only two street address 
lines, instead of the default three lines by setting the SHORT_PAT_LABEL setting in the 
ppart.ini file to ON. 

• Mailmerge – Creates a mailmerge file that you can use to create personalized letters, 
automatically filling in the first name, last name, address, city, state, and ZIP Code (postal 
code) of each patient whose information matches the inquiry. In addition, if health 
maintenance up-to-date or not up-to-date was a selection criterion, then the mailmerge 
file includes those health maintenance procedures which were up to date or not up to 
date.  
 
The mailmerge filename is the filename selected, with the extension "mrg" added. For 
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example, "males.mrg" is the mailmerge file for the file called "males." If there is no health 
maintenance in the mailmerge file, the structure of the mailmerge file is:  
 
“Lastname”,“Firstname”,“MI”,“Greeting”,“Suffix”,“Address1”, 
“Address2”,“Address3”,“City”,“State”,“ZIP”,“Country”  
 
If there are health maintenance procedures in the mailmerge file, the file has the 
structure:  
 
“Lastname”,“Firstname”,“MI”,“Greeting”,“Suffix”,“Address1”, 
“Address2”,“Address3”,“City”,“State”,“ZIP”,“Country”,“hm1”, “hm2”,“hm3”  
 
where hm1, hm2, hm3, etc. (up to 13) are the health maintenance procedures (either up-
to-date or not up-to-date).  

• Chart Data – The *.sel file lists the criteria you used to generate the inquiry. The *.inq file 
lists the patients that match the criteria.  

Entering values for Patient Inquiry report items  
After you select a report item, you will need to establish the values for the corresponding report item in 
the Values screen. What you see in this screen varies with the type of item you selected. You may be 
asked for a patient name, a range of dates, or a numeric value, or a specific name, like a problem name 
or a health maintenance procedure.  

For example, to look for patients suffering from low back pain, choose “Problem” from the Select 
Criteria drop-down list and enter the name of the problem and indicate whether the problem is active 
or inactive on the Values screen. You can optionally enter a provider ID. To generate a Patient Inquiry 
for male patients only, choose “Sex” from the Select Criteria drop-down list. The Values screen displays 
the question "M/F?" and specify “M” in the Values screen.  

If you specify range, you will be returned to the Values screen to enter an optional upper limit if you 
haven’t already.  

Using the Report Logic Keys  
You can do “AND” searches, “OR” searches, or combinations of “AND” and “OR” searches with patient 
inquiry. The default search is an “AND” search—that is, Patient Records only finds cases where all the 
items match. In an “OR” search, at least one item must match.  

To switch to an “OR” search, select the “OR” Report Logic radio button. You can combine one group of 
“AND” items and one group of “OR” items in a single search, by switching between “AND” and “OR” 
logic before choosing the next report item. Once you switch to “OR” and then selected an item, you 
cannot switch back to using “AND”. You will get the message, “Logical Operators cannot be mixed.”  

The first item that you select displays in the Patient Inquiry screen. The next item you select displays 
below the previous item, but the Logic “AND” or “OR” displays at the end of the line of the previous 
item. Either “AND” or “OR” will display, depending on which Logic you select for the item.  

For example, if you want to search for male patients who are assigned to Provider ABC, you can select 
male as the first item and Provider ABC as the second. The Patient Inquiry screen might look like the 
following:  

Sex = M (AND)  
Provider = ABC  

Another example, if you want to search for patients who reside in Washington or Idaho, you can select 
WA as the first item and ID as the second. The screen might look like the following:  
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State = WA (OR)  
State = ID  

When you combine one group of "AND" items and one group of "OR" items in a single search, 
brackets [ ] will display around the “OR” items so that you can see how the items are grouped together. 
For example, combining the two examples above, the screen might look like the following:  

Sex = M (AND)  
Provider = ABC (AND)  
[State = WA (OR)  
State = ID]  

In the example above, notice that after you added the item “State=WA” and then selected the “OR” 
logic button, a bracket appeared to the left of the item. Then when you added the last item “State=ID”, 
a bracket appeared to the right of this item. The brackets enclose the items (the States) grouped 
together when you use the “OR” logic combined with an “AND” group. The search report should list all 
male patients who are assigned to Provider ABC and who reside in either the state of Washington or 
Idaho.  

Note: The relationship between a group of “AND” items and a group of “OR” items is the “AND” logic.  

Accessing Patient Inquiry 

To access Patient Inquiry:  

1. Select Reports > Patient Inquiry. The Patient Inquiry screen appears.  

2. In the Selection Criteria drop-down list, select the criteria you want to use. See the Patient 
Inquiry report items section below for a complete list of inquiry options. You can select up to 16 
items.  

3. When you finish entering your criteria, click the Run button.  

4. On the Enter File Name screen, type a name for the Patient Inquiry results file.  

5. Click the Open button to save the query.  
 
If printers have not been configured for your system, a "problem with printer defaults" message 
may appear. Click the OK button.  

6. Click the Cancel button to close the Patient Inquiry screen.  

7. Click the Close button to close the patient chart.  

Selecting Patient Inquiry report items  

To select report items:  

1. Click the Selection Criteria drop-down list to display the item list.  

2. Select an item. You can use the arrow keys, or the scroll bar and arrow buttons, to scroll down 
the list and display more items. Once an item is highlighted, you can click it or press ENTER.  

3. In the Values screen, enter the appropriate values for the item. Click the OK button.  

4. Keep repeating these steps until you have selected all of the report items that you need. You 
can select up to 16 items.  
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Completing the Patient Inquiry  
As you specify the criteria for your patient inquiry, they are displayed on the screen. Once you have 
chosen all the report items you want and specified the values and operators for each, check the criteria 
displayed. If the criteria are correct, you can store the results in a file so that the report can be printed.  

If you need to add additional items, choose the drop-down arrow in the Selection Criteria field to 
display the item list. Use the ARROW keys to select the item and press the ENTER key.  

To complete the patient inquiry and print the report:  

1. To delete items that you have selected, click the Delete button. You can also click the Clear 
button to clear all your selections for the current search.  

2. To change the Logic or Operator for an item, click the And or Or Report Logic button or select 
from the Operator screen as appropriate.  

3. Make sure that you selected the correct Report Type option. Change the type if necessary.  

4. When you finish with the report items, click the Run button on the Patient Inquiry screen.  

5. On the Enter File Name screen, enter a file name – without a file extension – that describes the 
inquiry. Patient Records adds the extension “.sel” to the report selection criteria file and adds 
the extension “.inq” to the report results file. This file stores the information generated by the 
patient inquiry. You can use this file to generate different reports (for example from the Reports 
menu) for this group of patients.  

6. Click the Open button.  
• A message displays the number of patients (and the percentage) that match the criteria 

you selected.  

• If there are no patients that match the criteria you selected, a message displays, “No Data 
Matches Criteria”.  

• For either message, click the OK button.  

• The Print screen displays.  

7. Click the OK button if you want to print the report.  

Patient Inquiry report items  
To generate a patient inquiry, choose items from the Patient Inquiry screen. Depending on your 
choices, there may be up to 190 items available in the screen. You can choose a single report item or a 
combination of report items (up to 16) to make your patient inquiry.  

The wide variety of report items you can choose with Patient Records’ patient inquiry makes it possible 
to search effectively through all your patient data—whether you are doing clinical research, or preparing 
a mailing list so that you can notify patients who need health maintenance procedures. For example, 
you might want to study the effects of codeine on all male patients between the ages of 35 and 40 with 
low back pain or send notices reminding female patients over 50 to receive mammograms.  
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Patient Inquiry report items include:  

Item Description 

Patient registration  You can do a wide variety of searches with patient registration 
information. Patient Inquiry lets you search for patients by 
name, including partial matches and ranges. For example, you 
can search for all patients whose names start with “St” or all 
patients with names starting with “A-L.” You can use partial 
matches and ranges of patient identification numbers, such as 
all patients whose numbers start with “62” or all patients whose 
numbers are in the range “1000A-2000A.” 
You can search for values which are the same as (equal to) or 
different than (not equal to) the usual provider, city, state, and 
name of employer. You can also search for male (m) or female 
(f) patients. You can search for ZIP Codes (postal codes), dates 
last active, or dates first registered which are equal to or not 
equal to a value or with a range of values. 

Insurance You can search for carriers or billing plans occupying a specific 
one of the four billing carrier slots for a patient by selecting one 
of the carrier or plan options. You can also search for all billing 
carriers or billing plans by selecting the Any Billing Carrier or 
Any Billing Plan options. 
Once you have selected an option, enter the billing data you 
want to search for in the corresponding field, and select the 
operator value from the drop-down list.  

Problem List  You can search for any problem by name or problem code, 
looking for values which are the same as (equal to) or different 
than (not equal to) the value. You can also search for diagnosis 
or procedure names or codes, or for problems by provider 
name. You can also search for active and inactive problems, by 
entering a Y or N in the Active (Y/N)? field on the Enter the 
Problem Name screen. If you leave this field blank, Patient 
Inquiry will search for both active and inactive problems 
matching the entered problem name. 

Procedure List  You can do searches that involve procedure codes. If you like, 
you can search by provider. 

Diagnosis List You can do searches that involve diagnosis codes. If you like, 
you can search by provider. 

Hospitalization List You can do a search for any problem for which the patient has 
been hospitalized or hospitalization codes, looking for values 
which are the same as (equal to) or different than (not equal to) 
the value. You can also search for problems for which the 
patient has been hospitalized by provider name. 

Risk List You can do a search for any risk of risk code, looking for values 
which are the same as (equal to) or different than (not equal to) 
the value. You can also search for risks by provider name. 
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Progress Notes  You can limit a search for progress notes items to a specific 
range of dates. You can use “Visit Title” to choose a title, 
problem name, or date range, searching for entries which are 
equal to or entries which are not equal to the values you 
specify. You can also search for progress notes which contain 
(that is, are equal to) or do not contain (that is, are not equal to) 
a fragment of text. If you have a lot of patient data, text searches 
can take a long time, so you may want to limit the search to a 
range of dates, or a range of patient names or ID numbers. 

Other Kinds of Text You can make searches through any other text-based sections 
of the patient chart, such as Histories, Consults, and User-
Defined Chart sections. You can choose to search on title 
and/or text pattern. You may also establish a date range for the 
search. 

Medications and Allergies To search the Current, Historical, and Ineffective Medication 
lists, use Current/Hist. Meds. In the screen, fill in the medication 
name and, optionally, the medication size, take, frequency, and 
dates of use. 
To search for allergies, you can search for all values which are 
the same as (equal to) or different than (not equal to) the 
medication or allergy. 

Vital Signs  Enter a date range and value for vital signs such as height, 
weight, blood pressure, pulse and other information. You may 
search for values that are equal to, not equal to, more than, less 
than or within a range of values. 

Note: You must enter the height, weight, temperature, and 
OFC values depending on the conversion type you selected 
from the Vitals Maintenance screen. Do not enter the unit used 
for the vital sign in the Value field (e.g., lb, kg, etc.). For 
example, if you selected Metric as the conversion type, you 
would enter 39.46 to search for patients that weigh 87lbs. If you 
selected English as the conversion type, you would enter 87.  

Clinical Elements Select the Clinical Element from the Clinical Element Selection 
list, and click OK. On the next screen enter a date range, 
operator value, and a clinical element value. You may search for 
values that are equal to, not equal to, more than, less a 
particular value. 

Prenatal Elements Select the Prenatal Element from the Clinical Element Selection 
list, and click OK. On the next screen enter a date range, 
operator value, and a clinical element value. You may search for 
values that are equal to, not equal to, more than, less a 
particular value. 
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Health Maintenance  For health maintenance searches, you can search for the name 
of the procedure, whether the procedure is up-to-date or not 
up-to-date, whether the procedure is absent, whether the 
procedure is present, or for a specific health maintenance value 
(with date range). 

Note: When selecting to query all up-to-date health 
maintenance procedures, the query will return any patient that 
has at least one health maintenance procedure that is up-to-
date.  

Other Patient Data  You can search on fields added to the Patient screen’s Other 
Data tab. 

Laboratory Data  You can search for any lab data item, including a user-defined 
item, by name, date range, and value. You can search for values 
equal to a value, not equal to a value, less than, more than, or 
with in a range of values. 
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Data Export 
You can use Patient Records to analyze your patient information in a variety of ways. You can export 
data from Patient Records to other programs such as spreadsheet, graphics, database, and statistical 
packages for more detailed analysis.  

To enhance your capability to analyze the data that you accumulate in Patient Records, you can use the 
data export feature to translate Patient Records information into a format understood by many 
commercial software packages. When you load data into these packages, you can:  

• Perform complex statistical analysis operations  

• Transfer information to standard database formats, such as that used by Access, Excel, and 
dBase  

• Create sophisticated charts, graphs, overheads, and slide shows  

• Use other word processing and mailmerge packages to create and implement form letter 
processing or produce documents with page layout software.  

Data export lets you export laboratory data, vital signs, medications, allergies, patient demographics, 
problem lists, visit titles, and health maintenance information. You can also export the patient’s race, if 
you have created it as a user-defined category. The data export feature creates ASCII files with 
standard delimiters, or separators, between individual fields and records. You will need to follow 
additional instructions provided by the software packages to load these ASCII files into the individual 
programs.  

To export data, you must first specify which patients you want to export data for, which data to export, 
the format of the export file needed by your application program, and the name you want to give to 
your file.  

Using the data export feature 
To export data:  

1. Select Reports > Data Export. The Data Export – Selection screen appears.  

2. Select whether you want to export data for a Single Patient, Selected Patients, All Patients, or 
Patient List File.  

3. In the Patient Data from field, type the dates for which you want to archive information. You can 
also leave the date fields blank to select all dates.  

Note: If you do not enter dates to indicate how much information you want to export, all information 
for the selected patients is exported.  

4. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. The Select Data to Export screen appears.  

• Selected Patients: The Data Export – Selection Criteria screen appears. Enter your criteria. 
You can fill in whatever information is appropriate, including scheduled provider, 
scheduled dates, registration dates, usual provider, patient status, and patient note (and 
the note’s function, such as Scheduler or Patient). When you finish entering your criteria, 
click the OK button. The Select Data to Export screen appears.  

• All Patients: The Select Data to Export screen appears.  
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• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to archive. Click the OK button. The 
Select Data to Export screen appears.  

5. On the Select Data to Export screen, select the data that you want to export. The table below 
describes the options available.  

Option Description 

1. Full patient demographics  Patient’s external ID, first name, last name, sex, birth date, 
age, address1, address2, address3, city, state, ZIP Code, 
home telephone, work telephone, e-mail address, head of 
household ID, head of household name, employer, social 
security number, date first registered, date of last visit, usual 
provider. You can also export the patient's race, if you 
created race as a user-defined category.  

2. Partial patient demographics  Patient’s external ID, first name, last name, sex, birth date, 
age, address1, address2, address3, city, state, ZIP Code, 
home telephone, work telephone, e-mail address, employer, 
social security number.  

3. Visit titles  Patient ID, patient name, date, visit title.  

4. Problem list - Major  Patient ID, patient name, problem name, code 1, code 2, 
date problem last occurred, date resolved, life cycle , internal 
provider, external provider. 

5. Problem list - Other Patient ID, patient name, problem name, code 1, code 2, 
date problem last occurred, date resolved, life cycle, 
provider who is managing the problem, internal provider, 
external provider. 

6. Problem list – all  Patient ID, patient name, problem name, code 1, code 2, 
date problem last occurred, date resolved, life cycle, label 
(used in major problems only), internal provider, external 
provider.  

7. Health maintenance received – 
all  

Patient ID, patient name, date, health maintenance 
procedure.  

8. Health maintenance received – 
specific  

Patient ID, patient name, date, health maintenance 
procedure.  

9. Health maintenance overdue – 
all  

Patient ID, patient name, date, health maintenance 
procedure.  

10. Health maintenance overdue 
– specific  
 

Patient ID, patient name, date, health maintenance 
procedure.  

11. Current medications  Patient ID, patient name (optional), age (optional), sex 
(optional), start date, discontinued date, medication name, 
size, take, frequency, duration, amount, refills, provider ID.  

12. Historical medications  Patient ID, patient name (optional), age (optional), sex 
(optional), start date, discontinued date, medication name, 
size, take, frequency, duration, amount, refills, provider ID, 
status (i.e., current, effective, ineffective).  
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13. All medications  Patient ID, patient name (optional), age (optional), sex 
(optional), start date, discontinued date, medication name, 
size, take, frequency, duration, amount, refills, provider ID, 
status (i.e., current, effective, ineffective).  

14. Medications from med list  Patient ID, patient name (optional), age (optional), sex 
(optional), and from the Medications screen, the 
medications, and dosage & notes values.  

15. Allergies  Patient ID, patient name, allergy, type, reaction, severity, 
code. 

16. Procedure codes  Patient ID, (optionally: name, age, and sex), problem date, 
problem name, problem code 1, problem code 2.  

17. Diagnosis codes  Patient ID, (optionally: name, age, and sex), problem date, 
problem name, problem code 1, problem code 2.  

18. Vital signs – all  Patient ID, patient name, date, vital sign, result, units, 
attribute.  

19. Vital signs – specific  Patient ID, patient name, date, vital sign, result, units.    

20. Laboratory data – all  Patient ID, patient name, date, time, test name, result.  

21. Laboratory data – specific  Patient ID, patient name, date, time, test name, result.  

6. Click the OK button. The Data Export Output Configuration screen appears. Now that you 
have indicated which data you want to export, you need to tell the system the format of the file 
that you want to create.  
 
Your choices depend in part on the application where you are exporting the data. Check your 
application manual for information about how data files must be organized or look at a data file 
created with the application. If you do not indicate any choices, the system will create an export 
file using the default configuration, or the last configuration you used.  
 
The table below describes the options available.  

Option Description 

Field separator The field separator, normally a comma, is the character or 
characters that separates each item of data, such as the date, 
patient ID, etc. The field separator can be up to three 
characters per line and can contain any characters except 
underlines. 

Use quotes around 
numeric/textual data 

The numeric or text fields may be delimited (that is, 
surrounded) by quotes and you may specify a maximum 
length, with longer fields truncated. Missing data will be 
marked with special characters or will appear as an empty 
field. 

Maximum textual field length Indicate the maximum length of a text field. The default is 
128 characters. 

If numeric/textual datum is 
missing, fill field with 

If there is no data available for a field in one or more records, 
indicate what, if anything, should be placed in that field. 
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Date format Date format options are mmddyy (e.g., 012208), mm/dd/yy 
(01/22/08), and separate fields for month, day, and year 
(01,22,08). You can also use Julian dates (that is, the number 
of days since 12/31/49. For example, 01.22.89 is 14267 
Julian. 

Time format Time format options are hhmm (0558), hh:mm (05:58), 
separate fields for hours and minutes (05, 58), and Julian 
time (the number of minutes since midnight). In Julian time, 
05:58 is 358. 

Age format Age format options are yyy (years only: 45, 101), yyy/mm 
(years and months: 12/06, 00/09), and separate fields for 
years and months (12, 06). 

Use 9-digit zip Select this option if you want to use 9 digit ZIP Codes (e.g., 
98121-9045) instead of 5 digit (e.g., 98121). 

Include patient name Indicate whether you want to include the patient’s name in 
the record. 

Export numeric data only Indicate whether you want to export only numeric data to the 
output file. If you answer Y, only numbers will be written to 
the file. Some statistical applications can only read numeric 
fields. Answer Y if you have selected all laboratory data 
(which includes text data), all vital signs, or all health 
maintenance. In addition, if you use this option Data Export 
will not use alphanumeric patient ID’s, but special internal 
patient ID’s instead, which are completely numeric. 

Substitute pseudo-identifiers for 
patient ID 

Select this option if you want to substitute patient IDs with 
"pseudo-identifiers" in the exported data. When this option 
selected, "pseudo-identifiers" will replace the patient's ID to 
distinguish which rows of data in the Data Export output 
correspond to the same patient. The identifier will be an 
integer starting with 1 which will correspond with the patient 
whose data is displayed in that row. The number will be 
incremented for each new patient in the data exported. 
When this option is not enabled, the patient's ID will be 
included in the exported data. This is the default setting.  
For example: 
Exported data example when this option is not enabled:  
"99",54,"M",062005,"DIET COUNSELING" 
"100-10",48,"M",101092,"ATOPIC DERMATITIS" 
"100-10",48,"M",040897,"SHOULDER PAIN" 
"100-1",63,"F",050702,"DIABETES MELLITUS" 
Exported data example when this option is enabled: 
"1",54,"M",062005,"DIET COUNSELING" 
"2",48,"M",101092,"ATOPIC DERMATITIS" 
"2",48,"M",040897,"SHOULDER PAIN" 
"3",63,"F",050702,"DIABETES MELLITUS" 

7. Click the OK button. The Data Export Filename screen appears.  

8. Enter the name and optional drive and path for the file.  

9. Click the OK button.  
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PDA Export 
You can use the PDA export report to move selected patient demographic and chart data to a Palm, 
PocketPC, or other PDA. You can export patient demographic information, problems, diagnoses, 
recent visit titles, current medication list, allergies, demographic notes (patient alerts), recent labs, and 
recent vitals. 

You cannot add to or change the exported patient data on a PDA. This feature is intended to provide 
view-only access to specific sections of the patient chart. If you want to enter data on the PDA, you can 
create a word processing file with Dot codes, transfer it to your PC, then load it using the Text Data 
Loader. Data loaded back into Patient Records would reflect your changes, overwriting the original 
information. 

The data is exported to comma-delimited text files. The data categories are saved in separate files 
(*_al.txt for allergies, *_bd.txt for brief demographics, *_fd.txt for full demographics, *_lb.txt for lab, 
*_nt.txt for note titles, *_pl.txt for problems, *_rx.txt for medication list, *_vi.txt for visits, and *_vt.txt for 
vitals).   

You are prompted to enter a file name, which is added as a prefix to the text files (that is, they replace 
the * in the names above). For example, if you enter "Patient" as the file name, the allergies file is saved 
as Patient_al.txt.  

To make the process easier, we have included a HanDBase application that can import and display the 
data on a Palm or Pocket PC. You must still purchase HanDBase itself, but the software is inexpensive. 
HanDBase is available at www.handbase.com. Using the HanDBase application that we have provided, 
you can view patients through the demographic table, and quickly link to the patient's other chart 
components such as Rx and vitals. 

If you use the HanDBase application, you must use "PDA" as the exported file name. 

The following section shows you how to extract data from Patient Records. A later section explains how 
to use the extracted data with HanDBase. 

Using the PDA export feature 
To export data:  

1. Select Reports > PDA Export. The PDA Export Selection screen appears.  

2. Select whether you want to export data for a Single Patient, Selected Patients, All Patients, or 
Patient List File.  

3. In the Patient Data from field, type the dates for which you want to archive information. You can 
also leave the date fields blank to select all dates. The dates apply only to the recent visit titles 
and recent lab categories. 

Note: If you do not enter dates to indicate how much information you want to export, all information 
for the selected patients is exported.  

4. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. The PDA Export Data Select screen 
appears.  

• Selected Patients: The Export PDA – Selection Criteria screen appears. Enter your criteria. 
You can fill in whatever information is appropriate, including scheduled provider, 
scheduled dates, registration dates, usual provider, patient status, and patient note (and 
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the note’s function, such as Scheduler or Patient). When you finish entering your criteria, 
click the OK button. The PDA Export Data Select screen appears.  

• All Patients: The PDA Export Data Select screen appears.  

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to archive. Click the OK button. The PDA 
Export Data Select screen appears.  

5. On the PDA Export Data Select screen, select the data that you want to export. The table 
below describes the options available.  

Option Description 

Brief demographics  Patient’s external ID, first name, last name, sex, birthdate, 
age, address1, address2, address3, city, state, ZIP Code, 
home phone, work phone, e-mail address, occupation, Social 
Security Number. The end of the file includes 12 copies of 
the patient's external ID for linking. 
Note: If you are using the included HanDBase application, 
we recommend selecting the full demographics so that you 
can quickly link to the patient's other extracted data (such as 
Rx or vitals). 

Demographics  Patient’s external ID, first name, last name, sex, birthdate, 
age, address1, address2, address3, city, state, ZIP Code, 
home phone, work phone, e-mail address, head of 
household ID, head of household name, occupation, Social 
Security Number, date first registered, date of last visit, usual 
provider, race (if your system administrator created race as a 
user-defined category), carrier 1, account plan 1, group 
number 1, insurance ID 1. The end of the file includes 12 
copies of the patient's external ID for linking. 

Note: If you are using the included HanDBase application, 
you can quickly link from the full demographics table to the 
patient's other extracted data (such as Rx or vitals). 

Major problem list Patient ID, problem type (M - major, O - other, D - diagnosis), 
problem name, code 1, code 2.  

Other problem list Patient ID, problem type (M - major, O - other, D - diagnosis), 
problem name, code 1, code 2.  

Diagnoses Patient ID, (optionally: name, age, and sex), problem date, 
problem name, problem code 1, problem code 2.  

Recent visit titles For the 30 most recent visits: Patient ID, date, visit title. 

Current medication list Patient ID, start date, discontinued date, medication name, 
size, take, frequency, duration, amount, refills, provider ID, 
status (current, effective, ineffective).  

Allergies Patient ID, allergies.  

Patient alerts (demographic 
notes) 

Patient ID, date, to do, notes.  

Recent lab For the 40 most recent lab tests: Patient ID, date, time, test 
name, result, h/l/n/a, normal range. 

Recent vitals For the last vitals only: Patient ID, date, vital sign, result. 

Select All Marks the check boxes of all the above options. 
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6. Mark the Include Field Names check box if you want the field's titles (for example, PatientID) to 
be saved in the file with the data.  
 
If you are using the HanDBase application, you must mark this check box. 

7. Mark Create PDA Tables to have Patient Records automatically create the (empty) PDA tables 
that will hold the text files of the file categories.  

8. Click the OK button. Select where you want to save the file, then enter a file name. The files will 
use this name as a prefix (for example, if you enter "Stein" as the file name, the problem file is 
saved as Stein_pl.txt).  
 
If you are using the HanDBase application, name the file PDA, and save the file in the 
"PDAdir" directory discussed in the HanDBase section. 

9. Click the Open button. A message indicates that the data was successfully exported. The next 
time you run PDA export and copy patient information to the PDA, the existing data on the PDA 
will be overwritten by the new patient information. 

Installing and using the Lytec MD HanDBase application 
HanDBase is a third-party development tool used to create relational databases (that is, databases that 
can link to one another). If you have HanDBase installed on your PDA and PC, Lytec MD has provided a 
HanDBase application that includes tables for all the exported elements, with the appropriate links 
already defined. When you export data from Patient Records through the PDA export option, then re-
sync your PDA, the patient data is moved into the Lytec MD-created tables in HanDBase. Then, when 
you open the HanDBase demographic table, the screen provides links to the rest of the patient's 
exported data. 

You must purchase HanDBase separately from Patient Records. Lytec MD provides a sample HanDBase 
application, but does not directly support HanDBase. 

To use this feature, you must be able to: 

• Install HanDBase on both the PDA and your PC. Depending on your specific needs, you can 
install HanDBase Plus, HanDBase Pro, or HanDBase Enterprise. 

• Synchronize the PDA with your network. 

• Create directories and copy files on the PC. 

• Run applications from a DOS prompt. 

To set up this feature: 

1. Install HanDBase version 3.0 or higher on both the PDA and PC. 

2. Create a directory in your PDA directory named PDAdir. 

3. Create a directory in the PDAdir directory named current. 

4. Copy the handbasedesktop.exe file from the HanDBase directory on the PC to the PDAdir 
directory. 

5. Copy the pda_export.bat file from the \ppartprw\PDA directory on the Patient Records 
installation CD to the PDAdir directory.  
 
Remove the file's read-only attribute. Right click on the file, select Properties, and unmark the 
Read Only check box. 
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6. Copy all files with a .pdb extension from the \ppartprw\PDA directory on the Patient Records 
installation CD to the current directory.  
 
Remove the files' read-only attribute. Right click on the files, select Properties, and unmark the 
Read Only check box. 

When you open the HanDBase application on the PDA, the Lytec MD tables are populated with the 
data you just exported. Although you can view the patient data by opening each table one by one, the 
demographics table provides links to all the other tables. 

To manually export data to the PDA: 

If desired, you can manually export data to your PDA (instead of having Lytec MD automatically export 
the data). 

1.    Create the Lytec MD tables on the PDA. 

 If you have a Palm OS PDA:  

• From a command line (DOS) prompt in the PDAdir directory, type pda_export firsttime 

• Synchronize the PDA. Depending on the Palm operating system, an "Install Tool" screen 
may appear for each of the tables. Click the Done button to accept the tables. 

• If you have a PocketPC PDA:  

• Synchronize all files from the PDAdir directory to the PDA. Refer to the PocketPC 
instructions. 

Note: You only need to create the tables once, unless you reset the PDA. After the tables are created, 
you can skip the step above and start with step 2 of this procedure. 

2. Select the data you want to extract to the PDA by using the PDA export feature. Make sure you 
mark the Include Field Names check box, and that you name the file PDA. Save the data files in 
the PDAdir directory. 

3. If there is only one PDA on the PC, or if the data is to be used on all PDAs, open a command 
line (DOS) prompt in the PDAdir directory and type pda_export allinstall. The next time 
you synchronize the PDA(s), the patient data will be automatically synchronized to the 
HanDbase application on the PDA(s). 
 
If more than one PDA is used on the PC, and you don't want all users to see the patient data, 
open a command line (DOS) prompt in the PDAdir directory and type pda_export. The .pdb 
files created in the PDAdir directory must then be manually synchronized to the appropriate 
PDAs. 

When you open the HanDBase application on the PDA, the Lytec MD tables are populated with the 
data you just exported. Although you can view the patient data by opening each table one by one, the 
demographics table provides links to all the other tables. 

The next time you run PDA export and copy patient information to the PDA (using steps 2 and 3 in the 
"To export data to the PDA" procedure above), the existing data on the PDA will be overwritten by the 
new patient information. 
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Logon Audit Report  
If your system administrator has enabled operator access for the Logon Audit report, you may use this 
report to track operator logon attempts.  

Note: The report will automatically track and record when the user successfully creates the report, and 
when the user attempts to generate the report but is not able to because they do not have the access 
level permission for the report. 

To print the Logon Audit report:  

1. Select Reports > Logon Audit. The Logon Audit screen appears. 

2. Select an operator from the Operator drop-down menu. To print the report for all operators, 
leave this field blank. 

3. Select a practice from the Practice drop-down menu. To print the report for all practices, leave 
this field blank. 

4. Select a logon event type from the Event Type drop-down menu. Options include: 
• Logon Failure: Select this option to only include the operator(s) logon failures. 

• Logon Success: Select this option to only include the operator(s) successful logons. 

• All Logons: Select this option to include all of the operator(s) logons (i.e., success and 
failures). 

5. Select the range of dates for which you want to print the report. When you select a starting and 
ending date, all logins created between those dates that meet the other criteria you select will 
be included in the printed report.  

If you leave the dates blank, all logins up to the current system date and time that meet the 
other criteria you set will print.  

6. To print the report to a file (instead of printing the report on paper), select the Print to file 
check box. 

7. Click the OK button. 
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Operator Audit Trail Report 
If your system administrator has enabled operator access for the Audit Trail report, you may use this 
report to print all operator recorded events in Patient Records. This includes the adding, editing, 
deleting, and viewing of records. Patient Records also tracks and records the signing of patient notes 
and labs. Prescription printing, faxing, and transmitting will also be recorded.  

Patient Records automatically tracks and records operator activity for the following functions: 

• Progress Notes 

• Other Notes 

• Health Maintenance 

• Problems 

• Labs 

• Rx 

• Allergies 

• Vital Signs 

• Clinical Elements 

• Images 

• Document Links 

• Flow Charts 

• Prenatal 

• Patient 

• Patient Chart 

• Patient Lookup 

• To Do Notes. When to do notes are marked as "completed". 

• Text Data Loader. When a note is imported, the user action Add_TDL will be recorded. 

• Lab Data Loader. When a result and/or lab note is imported, the user action Add_LDL will be 
recorded. 

• Zoom. When an operator imports or links to an external file (chart notes, patient photos, or 
patient attachments) 

• Audit Trail Reports. When an operator successfully creates an audit trail report, and when an 
operator attempts to create an audit trail report and cannot generate the report because they do 
not have access level permission for the report. 

• Operator Status. When an operator's status is changed from "active" to "inactive" the action will 
be recorded as "INACTIVATE", and when the operator's status is changed from "inactive" to 
"active" the action will be recorded as "ACTIVATE".   

• Break-the-Glass events. When an operator opens a patient’s chart when access to it has been 
restricted, the Operator ID, the Date/Time of the event, the Patient ID whose chart has been 
accessed, and the reason for "breaking the glass" as entered by the operator at the time of the 
event will print on the report. 

Your system administrator can use the PRUtils security utility to further define what is tracked and 
recorded for the Operator Audit Trail report. See the PRUtils section for more information.  

The table below lists the event types that you can select for the report: 
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Option Description 

Add Select this option to print a report for the new records that have been 
added to the Lytec MD database. 

Edit Select this option to print a report for the records that have been 
updated.  

Delete Select this option print a report for the records that have been deleted. 

Sign Select this option to print a report for all signed patient notes and labs. 

View Category Select this option to print a report for the specific sections of the patient 
chart that have been viewed by the user, such as Progress Notes, Major 
Problems, Other Problems, Procedures, Diagnoses, Risks, 
Hospitalizations, Current Medications, etc. Lookup events performed in 
the Patient Lookup screen will also print on the report, including lookup 
category (Name, ID, Phone, SSN, Account ID, etc.), lookup parameters 
(the text entered or options selected by the operator), and table 
(Patient). 

View Individual Select this option to print a report for the individual records that have 
been viewed by the user.  
For example, when this option is selected, a View event will be included 
in the report when an operator views patient demographic information 
on the Patient <Edit> screen. 

Break the Glass Select this option to print a report for the Break the Glass events that 
occurred when access to a chart has been restricted.  
The following information is included in the report: Operator ID, 
Date/Time of the event, Patient ID whose chart has been accessed, and 
reason for "breaking the glass"as entered by the operator at the time of 
the event.  

Add TDL Select this option to print a report for the notes that have been 
imported into a patient's chart using the Text Data Loader. 

Add LDL Select this option to print a report for the results and/or lab notes that 
have been imported into a patient's chart using the Lab Data Loader. 

Print Category Select this option to print a report for the records that have been 
printed by category.  
For example, if an operator printed a progress note, “Category: 
Progress Notes, Table: Progress_Note” will print on the report. 

Print Individual Select this option to print a report for the individual records that have 
been printed. This option only applies to printing of prescriptions.   

Query Category Select this option to print a report for the Patient Lookup events. When 
this option is selected, the lookup category (Name, ID, Phone, SSN, 
Account ID, etc.), lookup parameters (the text entered or options 
selected by the operator), and table (Patient) will be printed on the 
report.  
For example, if an operator performed a lookup for patients with a 
phone number area code of 206, "Category: Phone, Record: (206)___-
____" will print on the report. 
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Query Individual Select this option to print a report for the querying of individual records 
events.  
For example, if an operator  exported Medical Summary data for a 
certain patient, each exported record will print as a separate item on 
the report (e.g., “Category: Current, Record: ABILIFY, Table: Rx”). 

Export Category Select this option to print a report for the records that have been 
exported by category using the Data Export feature.  
For example, if the export type is Problem List-Major, "Category: Major, 
Table: Problem, and User Action: ExportC" will print on the report.).  

Export Individual Select this option to print a report for the individual records that have 
been exported using the Data Export feature.   
For example, if the export type is Problem List-Major, "Category: Major, 
Record: DIABETES MELLITUS, Table: Problem, and User Action: 
ExportI" will print on the report.  

Fax Individual Select this option to print a report for the records that have been faxed. 
This option only applies to faxing of prescriptions.  

Transmit Individual Select this option to print a report for the records that have been sent 
electronically. This option only applies to prescriptions that have been 
transmitted electronically.  

Forward Select this option to print a report for the progress notes that have 
been forwarded to providers. 

Completed  Select this option to print a report for the orders that have been marked 
as completed. 

To print the Operator Audit Trail report:  

1. Select Reports > Audit Trail. The Operator Audit Trail Report screen appears. 

2. Enter a valid operator ID in the Operator field (you can also click the down arrow button to 
access the Operator Select screen) or, to print the report for all operators, leave this field 
blank. 

3. Select a practice from the Practice drop-down menu. To print the report for all practices, leave 
this field blank. 

4. Enter a patient ID in the Patient field or a patient name in the Patient Name field. If a valid 
patient ID is entered, the patient's name will be displayed in the Patient Name field. To print 
the report for all patients, leave these fields blank.  

5. Select the range of dates for which you want to print the report. When you select a starting and 
ending date, all audit trail data created between those dates that meet the other criteria you 
select will be included in the printed report.  

If you leave the dates blank, all audit trail data up to the current system date and time that meet 
the other criteria you set will print.  

6. Select the range of times for which you want to print the report. When you select a starting and 
ending date, all audit trail data created between those times that meet the other criteria you 
select will be included in the printed report. 

7. Select the UTC check box, to print the report using Coordinated Universal Time. Otherwise, the 
report will be printed using GMT time (Greenwich Mean Time). 

8. Select the Sort by Operator check box, to have the report sort by operator. 

9. To print the report to a file (instead of to a printer), select the Print to file check box. 
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10. Select the audit events you want to include in the report. Use the Check All or Uncheck All 
buttons to select or clear the selections.  

11. Click the OK button. 
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Administration Audit Trail Report 
You may use this report to track events related to system security administration. This includes the 
adding, editing, deleting, and viewing of operator records, and access levels. The generated report will 
display the operator, the date/time of the event, the operator record which was accessed, or the access 
level which was changed, and the event type (e.g., update). 

Note: The report will automatically track and record when the user successfully creates the report, and 
when the user attempts to generate the report but is not able to because they do not have the access 
level permission for the report. 

To print the Administration Audit Trail report:  

1. Select Reports > Administration Audit Trail. The Administration Audit Trail Report screen 
appears. 

2. Enter a valid operator ID in the Operator field. You can also click the down arrow button to 
access the Operator Select screen. Select the operator from the list, and click OK. To print the 
report for all operators, leave this field blank. 

3. Select a practice from the Practice drop-down menu. To print the report for all practices, leave 
this field blank.  

4. Select the range of dates for which you want to print the report. When you select a starting and 
ending date, all audit trail data created between those dates that meet the other criteria you 
select will be included in the printed report.  

If you leave the dates blank, all audit trail data up to the current system date and time that meet 
the other criteria you set will print.  

5. Select the range of times for which you want to print the report. When you select a starting and 
ending date, all audit trail data created between those times that meet the other criteria you 
select will be included in the printed report. 

6. Select the Sort by Operator check box, to print the report by operator. For example, the audit 
logs on the printed report will be sectioned by operator. 

7. To print the report to a file (instead of printing the report on paper), select the Print to file 
check box. 

8. Click the OK button. 
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Health Information Exchange Audit Trail Report 
If your system administrator has enabled operator access for the Health Information Exchange Audit 
Trail report, you may use this report to print all operator recorded events related to the Health 
Information Exchange feature in Lytec MD. The generated report will display the name of the operator, 
the event type (e.g., patient lookup or import external document), the date/time of the event, the name 
and ID of the patient whose clinical data has been imported, exported, or previewed, and the outcome 
of the user's action (success or failure). 

Lytec MD automatically tracks and records operator activity for the following functions: 

• External Lookup queries - an audit record prints for every external lookup a user performs on the 
Patient External Lookup screen, including the search parameters used for the query. 

• Patient matching - an audit record prints for every instance where a user confirms that a 
particular patient in the external network matches a patient in Lytec MD. 

• Importing a document from a Document Repository - an audit record prints for each document 
imported by a user from a Document Repository. 

• Exporting a document to a Document Repository - an audit record prints for each document 
exported by a user to a Document Repository. 

• Previewing a document from a Document Repository - an audit record prints for each document 
previewed by a user from a Document Repository. 

To print the Health Information Exchange Audit Trail report: 

1. Select Reports > Health Information Exchange Audit Trail. The Health Information Exchange 
Audit Report screen appears. 

2. Enter a valid operator ID in the Operator field. You can also click the down arrow button to 
access the Operator Select screen. Select the operator from the list, and click OK. To print the 
report for all operators, leave this field blank. 

3. Select an event type from the Event Type drop-down menu. To print the report for all event 
types, leave this field blank.  

4. Select the range of dates for which you want to print the report. When you select a starting and 
ending date, all audit trail data created between those dates that meet the other criteria you 
select will be included in the printed report.  
If you leave the dates blank, all audit trail data up to the current system date and time that meet 
the other criteria you set will print.  

5. Select the range of times for which you want to print the report. When you select a starting and 
ending date, all audit trail data created between those times that meet the other criteria you 
select will be included in the printed report. 

6. To print the report to a file (instead of printing the report on paper), select the Print to file 
check box. 

7. Click the OK button. 

Note: Data will only be collected for the Health Information Exchange Audit Trail report if the following 
options are enabled on the Audit Trail tab of the Electronic Security Configuration screen in PRUtils: 
- Audit Patient Inquiry - to print audit records for the external lookup and patient matching events; 
- Audit Export of Individual Records – to print audit records for the export to Document Repository 
events; 
- Audit Viewing of Individual Records – to print audit records for the document preview and import 
from Document Repository events. 
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Print Chart Summary Report 
The Print Chart Summary command lets you print a two or three page summary of a patient chart 
containing only the most recent patient information.  

The following information appears on the chart summary:  

• Patient Demographic – The chart summary displays the name, identification number, sex, and 
age of the patient.  

• Problems – The patient’s most recent problems, and the major and other problem lists are 
displayed on the chart summary. The lists are taken from the Problem List section of the patient 
chart.  

• Allergies – The patient’s allergies, if any, are displayed on the chart summary. The allergy list is 
taken from the Medications section of the patient chart.  

• Most Recent Vital Signs – The most recent vital signs and the date on which these vital signs 
were measured. The vital signs printed on the chart correspond to the last set of vital signs in the 
Vital Signs section of the patient chart. They include the height, weight, temperature, pulse, the 
systolic and diastolic blood pressure, and the occipito-frontal circumference, if the patient is a 
child. If you have entered information in the “Other” field of the Vital Signs section of the patient 
chart, this information is also displayed here.  

• Health Maintenance Needed – Summarizes the health maintenance procedures for which the 
patient is overdue. This information is taken from the Health Maintenance section of the patient 
chart, and based on the Health Maintenance templates you have defined.  

• Current Medication – If Patient Records is set up with the “Use Current and Historical 
Medications” option, the chart summary prints a list of all current medications, one line per 
medication. The list includes the date, medication name, size, take, frequency, duration, amount, 
refills, and the prescribing provider.  

• Most Recent Progress Note – The most recent progress note from the Progress Notes section of 
the patient chart.  

• Most Recent Lab Data – In these fields, the most recent laboratory data results are displayed. 
These results are taken from the Laboratory Data section of the patient chart, labeled with the 
names you established when you used the Laboratory Data Names templates. The date of the 
laboratory results also print, along with the normal range and critical flags.  

To print a chart summary for a patient:  

1. Select Reports > Patient Records > Print Chart Summary.  

2. (optional) Indicate whether you want to print the first page data only, or limit the first page data. 
 
You can also select to print the report to a file. If you select this option, indicate whether you 
want to save the report as an RTF, HTML, or text file. Then type a name for the file. 

Note: If you select HTML, the report and associated image files will be saved in the current directory. If 
you later move the HTML file, you will also need to move the image files, which are saved as .PNG files 
that use the HTML file’s name.  

Note: Patient Records supports the printing of single and multiple page PDF plink image files when 
printing the chart summary report. 

3. Select the patient(s) for which you want to print a chart summary. The next screen to appear 
depends on the criteria you selected. If you selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button.  
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• Scheduled Patients: The Chart Selection screen appears. Enter the criteria, including 
scheduled provider and scheduled dates. When you finish entering your criteria, click the 
OK button.  

• Patients Last Seen on Specified Dates: The Chart Selection screen appears. Enter the 
criteria, including scheduled provider and scheduled dates. When you finish entering 
your criteria, click the OK button.  

• All Patients Belonging to a Usual Provider: The Chart Selection screen appears. Enter the 
scheduled provider, then click the OK button. 

• All Patients  

• Patients in Patient Inquiry List: The Patient Inquiry File screen appears. Enter (or browse 
to) the appropriate Patient Inquiry file, with an .inq extension. Then click the OK button.  

4. Indicate whether you want to print images associated with the notes.  

Note: If you print the chart summary to an HTML file, headers (for example, patient's name and date of 
birth) will not print if more than one chart is included in the report. This is an issue only when printing 
the chart summary to an HTML file. 
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Print Partial Chart (Report) 
You can use the Partial Chart Report command to print only selected parts of a patient chart for the 
range of dates you specify. If you wish to release a patient’s records to an outside entity but not all 
sections of the patient’s chart are relevant or appropriate for the specific situation, you can use the 
Partial Chart Report to exclude those sections. 

Chart sections you can print include: 

• Patient registration data 

• Problem list - Your system administrator can use settings in the ppart.ini file to determine 
whether only active or all major problems (i.e., active and inactive) are printed and whether only 
active risks or all risks are printed (i.e., active and inactive).  

• Vital signs  

• Allergies / current medications 

• Historical medications  

• Microbiology 

• Lab miscellaneous 

• All other sections of the patient chart for which there is information  

To print a partial chart report:  

1. Select Reports > Patient Records > Print Partial Report.  

2. (optional) Indicate the range of dates for which you want to print the charts.  
 
You can also select to print the report to a file. If you select this option, indicate whether you 
want to save the report as an RTF, HTML, or text file. Then type a name for the file. 

Note: If you select HTML, the report and associated image files will be saved in the current directory. If 
you later move the HTML file, you will also need to move the image files, which are saved as .PNG files 
that use the HTML file’s name.  

Note: Patient Records supports the printing of single and multiple page PDF plink image files when 
printing the partial chart report. 

3. Select the patient(s) for which you want to print a partial chart. The next screen to appear 
depends on the criteria you selected. If you selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. The Select Partial Chart screen appears. 

• Scheduled Patients: The Chart Selection screen appears. Enter the criteria, including 
scheduled provider and scheduled dates. When you finish entering your criteria, click the 
OK button. The Select Partial Chart screen appears. 

• Patients Last Seen on Specified Dates: The Chart Selection screen appears. Enter the 
criteria, including scheduled provider and scheduled dates. When you finish entering 
your criteria, click the OK button. The Select Partial Chart screen appears. 

• All Patients Belonging to a Usual Provider: The Chart Selection screen appears. Enter the 
scheduled provider, then click the OK button. The Select Partial Chart screen appears. 

• All Patients: The Select Partial Chart screen appears. 

• Patients in Patient Inquiry List: The Patient Inquiry File screen appears. Enter (or browse 
to) the appropriate Patient Inquiry file, with an .inq extension. Then click the OK button. 
The Select Partial Chart screen appears. 
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4. On the Select Partial Chart screen, use the Add button to move the appropriate chart sections 
from the Selection Criteria box to the Print Order box. Use the up and down arrows to arrange 
the items in the Print Order box into the order that you want the sections to print.  

5. When you finish, click the OK button. Indicate whether you want to print images associated 
with the notes. 

Each chart section is printed on a separate page, with the name of the chart printed at the top of the 
page. The patient’s name, identification, age, and sex also appears at the top of each page.  
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Print Complete Chart (Report) 
You can use this feature to print a patient's complete patient chart. This is intended to serve as the 
formal health record for disclosure purposes, and includes the following information: 

• Patient name, identification number, age and sex  

• Complete patient demographics  

• Problem list - Your system administrator can use settings in the ppart.ini file to determine 
whether only active or all major problems (i.e., active and inactive) are printed and whether only 
active risks or all risks are printed (i.e., active and inactive).   

• Procedures and diagnosis codes  

• Vital signs from vital signs  

• Allergies  

• Current, historical, and ineffective medications  

• Progress notes  

• Past medical, social, and family histories  

• Health maintenance  

• Laboratory data (with normal ranges and critical flags) 

• Graphic images (these formats: BMP, WMF, PNG, JPG, GIF) 

• All other sections of the patient chart for which there is information  

To print a complete chart report:  

1. Select Reports > Patient Records > Print Complete Chart.  

2. (optional) Indicate the range of dates for which you want to print the charts.  
 
You can also select to print the report to a file. If you select this option, indicate whether you 
want to save the report as an RTF, HTML, or text file. Then type a name for the file. 

Note: If you select HTML, the report and associated image files will be saved in the current directory. If 
you later move the HTML file, you will also need to move the image files, which are saved as .PNG files 
that use the HTML file’s name.   

3. Select the patient(s) for which you want to print a chart summary. The next screen to appear 
depends on the criteria you selected. If you selected:  
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button.  

• Scheduled Patients: The Chart Selection screen appears. Enter the criteria, including 
scheduled provider and scheduled dates. When you finish entering your criteria, click the 
OK button.  

• Patients Last Seen on Specified Dates: The Chart Selection screen appears. Enter the 
criteria, including scheduled provider and scheduled dates. When you finish entering 
your criteria, click the OK button.  

• All Patients Belonging to a Usual Provider: The Chart Selection screen appears. Enter the 
scheduled provider, then click the OK button.  

• All Patients  

• Patients in Patient Inquiry List: The Patient Inquiry File screen appears. Enter (or browse 
to) the appropriate Patient Inquiry file, with an .inq extension. Then click the OK button.  
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4. Indicate whether you want to print images associated with notes. Supported image files are 
currently JPG, BMP, WMF, GIF, PNG, Brentwood EKGs, and Welch Allyn EKGs. Non-supported 
image types will not print. 

5. Indicate whether you want to print images not associated with notes. Supported image files are 
currently JPG, BMP, WMF, GIF, PNG, Brentwood EKGs, and Welch Allyn EKGs. Non-supported 
image types will not print. 

Notes:  
 
* Given the wide variety of different TIFF formats, not all TIFF formats are supported. 
 
** Patient Records supports the printing of single and multiple page PDF plink image files when 
printing the complete chart report. 
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Export Medical Summary 
You can use Lytec MD to generate Continuity of Care Records (CCR) and Continuity of Care 
Documents (CCD) that summarize clinical information on a patient in a standardized format so that it 
can be displayed by, and incorporated into the patient records in, other software systems. This tool 
allows you to indicate the patient information you want to include in a CCR or CCD for a particular 
patient. When you have finished your selections, an *.xml file will be created that you can share with 
other health care providers.   

*The Import and Export CCR feature is based on the Standard Specification for Continuity of Care 
Record from ASTM International, Designation E 2369-05. The Import and Export CCD feature is based 
on the HL7 CDA Release 2 – Continuity of Care Document. 

Note: To use the Continuity of Care Documents (CCD) import/export feature you must enter your 
organization number in the PP ORG NUM field on the Practice Maintenance screen’s Other Data tab 
after upgrading or installing Patient Records. If you do not enter your organization number, CCD 
documents will be created in error. See the Adding Organization Numbers to your system section for 
more information.  

CCR Export Naming Conventions 
CCR documents created by Lytec MD are saved in a location specified by you. Once the file(s) has been 
exported you can navigate to the location you selected and find the individual files for each patient. If 
you select to export information for a single patient, you will be prompted for the name of the file 
during the CCR creation process. If you are exporting information for more than one patient, the 
exported files will be saved with the following naming convention: CCR#######. A number will be 
appended to the end of the file name for each additional file (e.g., CCR0000001, CCR0000002, 
CCR0000003, etc.).  

If you select to export CCR documents to the same location every time please be aware that the files 
from the previous export will be overwritten. We recommend that after you export your files to the 
selected location, you move them to another location.  

CCD Export Naming Conventions 
CCDs created by Lytec MD are saved in a location specified by you. Once the file(s) has been exported 
you can navigate to the location you selected and find the individual files for each patient. If you select 
to export information for a single patient, you will be prompted for the name of the file during the CCD 
creation process. If you are exporting information for more than one patient, the exported files will be 
saved with the following naming convention: CCD#######. A number will be appended to the end of 
the file name for each additional file (e.g., CCD0000001, CCD0000002, CCD0000003, etc.).  

If you select to export CCDs to the same location every time please be aware that the files from the 
previous export will be overwritten. We recommend that after you export your files to the selected 
location, you move them to another location.  

Creating and Exporting CCRs and CCDs 
To export medical summary data for a patient:  

1. Select Reports > Patient Records > Export Medical Summary. The Export Medical Summary 
screen appears.  

2. Select the patient(s) for which you want to export data for.  
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3. (optional) Select the purpose of the export from the Purpose drop-down list. Your system 
administrator can use the CCRPurpose setting in the ppart.ini file to configure the options 
displayed from the drop-down list.  

4. Select the CCR option or the CCD option.  

5. (optional) Indicate the range of dates for which you want to export the patient data. The next 
screen to appear depends on the criteria you selected. If you selected:  
• Single Patient:  

1. The Patient Lookup screen appears. Enter your search criteria and select the 
appropriate patient. Then click the OK button. The Save As dialog screen appears.  

2. Select the location where you want to save the file. Type the name you want to save the 
file as in the File name field. You cannot change the Save as type field. When finished, 
click the Save button.  
The Export Medical Summary - Detail Selection screen appears.  

3. Use this screen to select the patient information to export. Please note the sections of 
the patient chart for which the patient has data will only be displayed. If the item has a + 
you can click it to expand the list. When the top-level item is selected, all items in the 
list will be selected. To unselect an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was exported to the selected location. Click the OK button.  

• Scheduled patients (fill in date(s) and optionally provider):  

1. Once you have read the message, click the OK button, or the Cancel button to select 
another option. The Chart Selection screen appears.  

2. Enter the criteria, including scheduled provider and scheduled dates. Leave the 
Provider fields blank to export data for all providers. When you finish entering your 
criteria, click the OK button.  

3. The Browse For Folder screen appears if you are exporting information for more than 
one patient. Navigate to the folder where you want to save the file(s). You can also click 
the Make New Folder button to create a new folder to save the file(s) in. When 
finished, click the OK button.  

The Save As screen appears if you are exporting data for only one patient. Select the 
location where you want to save the file. Type the name you want to save the file as in the 
File name field. Do not change the Save as type field. When finished, click the Save button.  

The Export Medical Summary - Detail Selection screen appears.  

4. Use this screen to select the patient information to export. Please note the sections of 
the patient chart for which the patient has data will only be displayed. If the item has a + 
you can click it to expand the list. When the top-level item is selected, all items in the 
list will be selected. To unselect an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was exported to the selected location. Click the OK button.  

• Patients last seen on specified dates, optionally by provider:  

1. Once you have read the message, click the OK button, or the Cancel button to select 
another option. The Chart Selection screen appears.  
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2. Enter the criteria, including scheduled provider and scheduled dates. Leave the 
Provider fields blank to export data for all providers. When you finish entering your 
criteria, click the OK button.  

3. The Browse For Folder screen appears if you are exporting information for more than 
one patient. Navigate to the folder where you want to save the file(s). You can also click 
the Make New Folder button to create a new folder to save the file(s) in. When 
finished, click the OK button.  

The Save As screen appears if you are exporting data for only one patient. Select the 
location where you want to save the file. Type the name you want to save the file as in the 
File name field. Do not change the Save as type field. When finished, click the Save button.  

 The Export Medical Summary - Detail Selection screen appears.  

4. Use this screen to select the patient information to export. Please note the sections of 
the patient chart for which the patient has data will only be displayed. If the item has a + 
you can click it to expand the list. When the top-level item is selected, all items in the 
list will be selected. To unselect an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was exported to the selected location. Click the OK button.  

• All patients belonging to a usual provider:  

1. Once you have read the message, click the OK button, or the Cancel button to select 
another option. The Chart Selection screen appears.  

2. Select the scheduled provider ID from the Provider ID drop-down list, or enter the 
provider name in the Provider field, then click the OK button.  

3. The Browse For Folder screen appears if you are exporting information for more than 
one patient. Navigate to the folder where you want to save the file(s). You can also click 
the Make New Folder button to create a new folder to save the file(s) in. When 
finished, click the OK button.  

The Save As screen appears if you are exporting data for only one patient. Select the 
location where you want to save the file. Type the name you want to save the file as in the 
File name field. Do not change the Save as type field. When finished, click the Save button.  

The Export Medical Summary - Detail Selection screen appears.  

4. Use this screen to select the patient information to export. Please note the sections of 
the patient chart for which the patient has data will only be displayed. If the item has a + 
you can click it to expand the list. When the top-level item is selected, all items in the 
list will be selected. To unselect an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was exported to the selected location. Click the OK button.  

• All patients:  

1. Once you have read the message, click the OK button, or the Cancel button to select 
another option. The Browse For Folder screen appears.  

2. The Browse For Folder screen appears if you are exporting information for more than 
one patient. Navigate to the folder where you want to save the file(s). You can also click 
the Make New Folder button to create a new folder to save the file(s) in. When 
finished, click the OK button.  
The Export Medical Summary - Detail Selection screen appears. 
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3. Use this screen to select the patient information to export. Please note the sections of 
the patient chart for which the patient has data will only be displayed. If the item has a + 
you can click it to expand the list. When the top-level item is selected, all items in the 
list will be selected. To unselect an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was exported to the selected location. Click the OK button.  

• Patients on list generated by Patient Inquiry:  

1. Once you have read the message, click the OK button, or the Cancel button to select 
another option. The Patient Inquiry File screen appears. 

2. Enter (or browse to) the appropriate Patient Inquiry file, with an .inq extension. Then 
click the OK button.  

3. The Browse For Folder screen appears if you are exporting information for more than 
one patient. Navigate to the folder where you want to save the file(s). You can also click 
the Make New Folder button to create a new folder to save the file(s) in. When 
finished, click the OK button.  

The Save As screen appears if you are exporting data for only one patient. Select the 
location where you want to save the file. Type the name you want to save the file as in the 
File name field. Do not change the Save as type field. When finished, click the Save button.  

The Export Medical Summary - Detail Selection screen appears.  

4. Use this screen to select the patient information to export. Please note the sections of 
the patient chart for which the patient has data will only be displayed. If the item has a + 
you can click it to expand the list. When the top-level item is selected, all items in the 
list will be selected. To unselect an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was exported to the selected location. Click the OK button.  

 

Export Medical Summary - Detail Selection screen 
Use this screen to select the patient data you want to export. The screen displays content from the 
patient’s chart. If the item has a + you can click it to expand the list. When the first level item is selected, 
all items in the list will be selected. To un-select an item click the corresponding check box. To re-select 
an item click the corresponding check box. You can click the – to close the list. 

The first level items correspond to the following sections of the patient’s chart. If the patient’s chart has 
no data for sections described below the section will not be displayed on the screen. 

• Problems - Displays problem type. For example, Major, Other, Diagnosis, Hospitalization, Risk. 

• Medications – Displays the medication name and time.  

• Vital Signs – Displays the name, date, and time.  

• Immunizations - Displays the date, time, and name. 

• Laboratory Data – Displays template name and date. The order will be displayed starting with the 
most recent lab first.  

• Allergies - Displays the date and name. 
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Import Medical History Summary 
You can use Patient Records to import and export Continuity of Care Records (CCR) and Continuity of 
Care Documents (CCD) into the Lytec MD database.  

Note: To use the Continuity of Care Documents (CCD) import/export feature you must enter your 
organization number in the PP ORG NUM field on the Practice Maintenance screen’s Other Data tab 
after upgrading or installing Patient Records. If you do not enter your organization number, CCD 
documents will be created in error. See the Adding Organization Numbers to your system section for 
more information.  

*The Import and Export CCR feature is based on the Standard Specification for Continuity of Care 
Record from ASTM International, Designation E 2369-05. The Import and Export CCD feature is based 
on the HL7 CDA Release 2 – Continuity of Care Document. 

Important: Documents must have the suffix .xml to be imported into Lytec MD. 

Using this feature you can import: 

1. Individual pieces of discrete data in the CCR or CCD. The data will be added to specific data 
tables in Patient Records (for example, allergies, medications, and problems). You will be able 
to preview the contents and choose which discrete data will be imported into discrete fields in 
Patient Records.  

2. The entire CCR or CCD. Any time a document is imported into Lytec MD, all the information in 
the document will be rendered into an HTML file and the HTML document will be added to the 
patient's record as a PLINK in a chart note. This will allow you to review the entire imported 
CCR or CCD as an intact document. 

Note: Payers and providers will not be imported from a document as discrete data. 

Note: When importing CCDs into the Lytec MD database, Advance Directives, Encounters, Family 
History, and Social History will not be imported into the patients’ chart but will be included in the 
rendered HTML file. This will be resolved in a future release.  

You can use the Import Medical History settings on the Records 1 tab of the Special Features screen to 
configure where documents, advance directives, encounters, and plans of care will be stored in the 
patient's chart. The default for these settings is progress notes.  

The ppart.ini setting "MedSummNoteTitle" allows you to specify the name of the imported note. If 
there is more than 1 note with the same title, the note will append an underscore and a number at the 
end of the title starting with 1. The note date will be the date the import occurred. 

Importing CCRs and CCDs 

To import a CCR or CCD: 

1. Select Task > Import Medical Summary. The Import Medical Summary screen appears.  

Note: If your system is configured for Health Information Exchange (HIE) connectivity, you must select 
Task > Import Clinical Document > Import from File to access the Import Medical Summary screen. 

2. Select the location of the CCR or CCD that you want to import by entering the file path in the 
FileName field, or you can click the Browse button to navigate to the location of the file. You 
can only import *.xml files. 

3. Select the Show Detail Selection Screen check box if you want to select what discrete data 
elements will be imported. 
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4. When you are finished, click the OK button. The Establish Patient Identity screen appears. This 
screen allows you to establish the identity of the patient. You can also use this screen to add a 
patient imported from the CCR or CCD to the Patient Records database. Once you have 
verified the patient, or added a new patient, click the OK button. If you elected to add a new 
patient you will receive a confirmation message.  

5. If you selected the Show Detail Selection Screen option, the Import Medical Summary: Detail 
Selection screen appears. 

Use this screen to select the patient data you want to import. The screen displays the content 
from the document. If the item has a + you can click it to expand the list. When the top-level 
item is selected, all items in the list will be selected. To unselect an item click the corresponding 
check box. To re-select an item click the corresponding check box. You can click the – to 
collapse the list. 

6. Once you have made your selections, click the OK button. If the document was successfully 
imported you will receive a confirmation message. 

If you did not select the Show Detail Selection Screen option, and the document was 
successfully imported into Patient Records you will receive a confirmation message.   

 

Notes: 
- If an incoming problem, vital sign, lab, medication, and/or note matches the date and time, and name 
of a problem, vital sign, lab, medication, and/or note already in the patient's chart, then they are 
considered to be the same, and nothing will be written to Patient Records.  
 
- If an incoming allergy does not have a date, and you later edit the allergy from the Allergy screen you 
will be required to enter the allergy date before you exit the screen.  

Auto generating patient IDs 
If you select to add a patient imported from the CCR or CCD to the Patient Records database, a new ID 
will be auto generated for the patient regardless of whether Lytec MD is configured to auto generate 
patient IDs. If you did not configure Lytec MD to auto generate patient IDs, then the generated ID will 
include the prefix IMP for "import". If you are using the auto generate ID feature, the ID will be 
generated with your selected settings. The numeric portion of the patient ID will begin at 00001001 
and will be incremented by 1 every time a CCR and/or CCD imports results for a new patient (e.g., 
IMP00001001, IMP00001002, IMP00001003, etc.).  

You can use the AutoGenerateIDPrefix setting in the CCR_Import.ini file and the CDA_Import.ini file to 
change the prefix used for auto generated patient IDs when a new patient is added to the database.   

To change the default prefix:  

1. Open Windows Explorer, and navigate to your \ppart\interface directory (usually 
p:\ppart\interface). 

2. Open the CCR folder to change the prefix for imported CCRs, or open the CDA folder to 
change the prefix for CCDs.  

3. Make a backup of the CCR_Import.ini file or the CDA_Import.ini file. For example, copy the file 
and rename it as CCR_Import.bak. 

4. Use WordPad, Notepad, or another text editor to open the file. 

5. Specify the new prefix using the AutoGenerateIDPrefix setting under the [DemographicInfo] 
section (e.g., AutoGenerateIDPrefix=CDA). 
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6. Save the file. 

Viewing CCRs and CCDs in Patient Records 
Patient Records will save the entire document as an HTML file and create a note in the patient chart 
section indicated by the "MedSummChartSection" setting in the PPart.ini file. The HTML file will be 
saved as a PLINK in the note. Once the file has been imported you can open up the section of the chart 
that you designated the entire CCR or CCD data to be stored in.  

To view a patient’s CCR or CCD in Patient Records: 

1. Open the patient’s chart. 

2. Click the tab where you selected to store the documents. Progress Notes is the default 
selection.  

3. Click the PLINK in the note. The document is displayed as an HTML file.   
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Health Information Exchange 
Lytec MD allows you to share patient clinical information with other health care information systems 
(including non-McKesson systems) through communication with a Health Information Exchange (HIE), 
which may be provided by a RHIO, hospital or other organization wishing to share health care 
information across disparate organizations and/or systems. An HIE may provide multiple services such 
as: 

• Master Person Index (MPI). An MPI system manages identities of people, patients in particular, 
across multiple system and system types. It provides patient matching and linking services and 
allows systems to identify a patient through an affinity domain identifier (an ID that can be used 
by an HIE as a global patient identifier). 

• Document Registry. The Document Registry acts as a record locator service for documents 
stored on document repositories. It contains an index of documents with metadata that includes 
links to the location in which documents are stored. 

• Document Repository. A Document Repository acts as document storage system for 
documents. It allows users of systems connected to an HIE to submit and retrieve patient 
documents. 

• Audit Repository. Audit Repository provides storage for audit events of systems connected to 
an HIE. An audit trail of events related to HIE communication is important for ensuring 
accountability and security. 

The use of the services of an HIE greatly facilitates the access to, retrieval and exchange of clinical data 
between the providers in a community thus enabling them to provide more timely, efficient, and 
patient-centered care.  

You can use the HIE feature to: 

• Search through the patient index of the HIE your Lytec MD system is connected to; 

• Create a new patient record in Lytec MD by importing patient demographic information from the 
HIE thus minimizing the potential for mistakes of manually typing the patient's demographics 
directly into Patient Records; 

• Browse, view and import clinical documents for a patient from the HIE;  

• Generate Continuity of Care Documents (CCD) that summarize clinical information on a patient 
and export them to a Document Repository. 

Note: To use the Health Information Exchange functionality, your system administrator must configure 
the Cross-Enterprise Document Share configuration file (xds.config) used to setup the parameters for 
the components managing the communication between Lytec MD and the Document Repository 
linked to your system. See the Cross-Enterprise Document Share Configuration Utility Guide for step-
by-step instructions on how to configure the xds.config file and setup your system for the HIE 
functionality. 

Note: Lytec MD supports the Integrating the Healthcare Enterprise (IHE) Audit Trail and Node 
Authentication (ATNA) Integration profile. The IHE ATNA profile establishes security measures to 
provide Protected Health Information confidentiality, data integrity, and user accountability that Lytec 
MD can utilize for sites that are connected to a Health Information Exchange (HIE). The profile enables 
bi-directional authentication, encryption of data in transit, and auditing of user interactions with the 
system and an HIE. 



Patient Records for Windows                                                                                                                            User’s and Technical Guide 

Page 587 

 

 Export to Document Repository 
You can use Lytec MD to generate Continuity of Care Documents (CCD) that summarize clinical 
information on a patient in a standardized format and export them to a Document Repository. By 
posting a patient document to a Document Repository you are making it available for viewing and 
importing by other clinical systems thus facilitating the document sharing and exchange of clinical data 
between different organizations. Depending on the requirements of your practice, you can choose 
what information to include in the exported CCD document prior to posting it to the Document 
Repository. When you have finished your selections, a CCD document with the selected patient data 
will be transmitted to the Document Repository.    

Note: The Export to Document Repository Data feature is only available if your system has been 
configured for Health Information Exchange (HIE) connectivity (the MPIConnectivity and 
XDSConnectivity settings in the [XDS] section of the Ppart.ini file are set to ON) and the External 
Network Lookup access level is enabled on the General tab of the Access Level Configuration screen. 
In addition, you must have Export Medical Summary to Document Repository access level (configurable 
on the Records Reports tab of the Access Level Configuration screen) to be able to access the Export to 
Document Repository screen.  

Important: You can only export patient documents to a Document Repository if the patient is 
registered with the Document Registry. Patient Records uses the global patient identifier (also known 
as Community ID or affinity domain identifier) that uniquely identifies a patient registered with the 
Document Registry to locate the patient in the HIE. This ensures that the document you are adding to 
the repository will be associated with the correct patient.   

Creating and exporting CCD documents to a Document 
Repository 
To export a patient document to a Document Repository: 

1. Select Reports > Patient Records > Export Clinical Document > Export to Document 
Repository.  
• If a patient's chart is open and they have a cached Community ID, the Export to 

Document Repository screen appears (see step 4). 

• If a patient's chart is open and they do not have a cached Community ID, the Patient 
Lookup screen appears. Enter your search criteria and select the appropriate patient. 
Then click the OK button. The Match External Patient screen appears. 

• If no patient chart is open, the Patient Lookup screen appears. Enter your search criteria 
and select the appropriate patient. Then click the OK button.  
If the selected patient has a cached Community ID, the Export to Document Repository 
screen appears (see step 4). 
If the selected patient does not have a cached Community ID, the Match External Patient 
screen appears. 

2. The Match External Patient screen allows you to verify that the current patient exactly matches a 
patient in the external network so you can safely export documents for the patient to the 
Document Repository. 
• If no matches are found in the external network, a red "NO MATCHES FOUND IN 

EXTERNAL NETWORK" notification will display below your search criteria. You can modify 
your search criteria and click the Search button to run another patient demographic 
query, if you wish.  

• If (a) patient(s) with the specified demographic information exist in the external network, 
their names and demographic information will be displayed in the search results area.  
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3. Highlight the patient that exactly matches the patient selected in Patient Records and then click 
Confirm Match. The system compares the demographic information stored for the patient in 
the two systems (patient first name, middle initial, last name, gender, and date of birth). If any 
discrepancies are found, Patient Records will display a warning message, asking you to confirm 
that you want to proceed with the importation. The system will also display a warning message 
if there is more than one patient in the Lytec MD database that matches the one selected from 
the list provided by the HIE. Click the Yes button if you want to proceed with the import 
process. The Export to Document Repository screen appears. 

4. (Optional) Indicate the range of dates for which you want to export the patient data and then 
click the OK button. The Export Medical Summary: Detail Selection screen appears. 

5. Use this screen to select the patient information to export. Please note the sections of the 
patient chart for which the patient has data will only be displayed. If the item has a + sign you 
can click it to expand the list. When the top-level item is selected, all items in the list will be 
selected. To unselect an item, click the corresponding check box. To re-select an item, click the 
corresponding check box. You can click the – sign to close the list.  

6. Once you have made your selections, click the OK button. A message will be displayed to 
confirm that the file was successfully exported to the Document Repository. Click the OK 
button.  

Fields on the Export to Document Repository screen 
Field Description 

Date Range  Enter a date in the From Date field to export documents 
created on or after the specified date. Click the arrow button to 
select the date from the calendar list.  
Enter a date in the End Date field to export documents created 
by the specified date. Click the arrow button to select the date 
from the calendar list.  
Leave these fields blank to export all available patient 
documents regardless of the date they were created on.  

Note: Patient allergies and current medications will always be 
exported, regardless of the selected date range.  

OK Click this button to proceed with the export process and open 
the Export Medical Summary: Detail Selection screen. 

Cancel Click this button to cancel the document exportation and close 
the Export to Document Repository screen. 

 



Patient Records for Windows                                                                                                                            User’s and Technical Guide 

Page 589 

 

Import from Document Repository 
You can use the Import from Document Repository feature to view patient clinical documents in an HIE 
and import them into Lytec MD. 

Note: The Import from Document Repository feature is only available if your system has been 
configured for Health Information Exchange (HIE) connectivity (the MPIConnectivity and 
XDSConnectivity settings in the [XDS] section of the Ppart.ini file are set to ON) and the External 
Network Lookup access level is enabled on the General tab of the Access Level Configuration screen. 
You must also have Query for Medical Summary from Document Registry access level (configurable on 
the Records Reports tab of the Access Level Configuration screen) to be able to access the Import from 
Document Repository screen.  

Using this feature you can import documents in any of the following formats:  

• Cross-Enterprise Sharing of Medical Summaries (XDS-MS); 

• Cross-Enterprise Document Sharing for Scanned Documents (XDS-SD); 

• Continuity of Care Documents (CCD/C32); 

• Personal Health Record Content (XPHR); 

• Emergency Department Encounter Summary (EDES); 

• Clinical Document Architecture Release 2 (CDA R2). 

Any time a document is imported into Lytec MD, all the information in the document will be rendered 
into an HTML file and the HTML document will be added to the patient's record as a PLINK in a chart 
note. This will allow you to review the entire imported document as an intact document. Documents 
with embedded text documents and documents with embedded PDF documents will be stored as text 
and PDF documents, respectively, and will also be added to the patient's record as PLINKs in a chart 
note.  

In addition, depending on the format of the document selected for import, you can import individual 
pieces of discrete data in the selected document. The data will be added to specific data tables in 
Patient Records (for example, allergies, medications, vitals signs, lab results, and problems). You will be 
able to preview the contents and choose which discrete data will be imported into discrete fields in 
Patient Records. 

Note: Payers and providers will not be imported from a document as discrete data. 

Note: When importing CCDs into the Lytec MD database, Advance Directives, Encounters, Family 
History, and Social History will not be imported into those sections of the Lytec MD patient chart but will 
be included in the rendered HTML file.  

You can filter the documents in a Document Repository by combining the search criteria that best suit 
your needs. The allowable values for the different parameters that you can select from when creating 
your queries are defined in a Cross-Enterprise Document Sharing (XDS) codes file named 
XDSCodes.xml file (typically located in P:\ppart\Interface\XDS). Each HIE may choose its own set of 
metadata code sets.  

The Note Title of the chart notes created during the import process will be the same as the title of the 
document that is being imported, if one is provided.  

Importing from Document Repository 
To import a document from a Document Repository: 

1. Select Task > Import Clinical Document > Import from Document Repository.  
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• If a patient's chart is open and they have a cached Community ID, the Import from 
Document Repository screen appears (see step 4). 

• If a patient's chart is open and they do not have a cached Community ID, the Patient 
Lookup screen appears. Enter your search criteria and select the appropriate patient. 
Then click the OK button. The Match External Patient screen appears. 

• If no patient chart is open, the Patient Lookup screen appears. Enter your search criteria 
and select the appropriate patient. Then click the OK button.  
If the selected patient has a cached Community ID, the Import from Document Repository 
screen appears (see step 4). 
If the selected patient does not have a cached Community ID, the Match External Patient 
screen appears. 

2. The Match External Patient screen allows you to verify that the current patient exactly matches a 
patient in the external network so you can safely import documents for the patient from the 
Document Repository. 
• If no matches are found in the external network, a red "NO MATCHES FOUND IN 

EXTERNAL NETWORK" notification will display below your search criteria. You can modify 
your search criteria and click the Search button to run another patient demographic 
query, if you wish.  

• If (a) patient(s) with the specified demographic information exist in the external network, 
their names and demographic information will be displayed in the search results area.  

3. Highlight the patient that exactly matches the current patient selected in Patient Records and 
then click Confirm Match. The system compares the demographic information stored for the 
patient in the two systems (patient first name, middle initial, last name, gender, and date of 
birth). If any discrepancies are found, Patient Records will display a warning message, asking 
you to confirm that you want to proceed with the importation. The system will also display a 
warning message if there is more than one patient in the Lytec MD database that matches the 
one selected from the list provided by the HIE. Click the Yes button if you want to proceed with 
the import process. The Import from Document Repository screen appears. 

4. Make sure you will be importing documents for the correct patient by comparing the 
demographic information for the local and the  remote patient displayed in the Patient 
Information area of the screen. Click the Re-do Match button in case the patient was 
erroneously matched during the previous patient matching. 

5. Make your selections in the Search Criteria area of the screen and then click the Search button.  
The Documents Found area in the bottom of the screen displays all the documents that exist in 
the Document Repository for the selected patient that match your criteria.  

6. Highlight the document you want to import. Click the Preview button to view the contents of 
the file before importing it into Patient Records.  

Note: You can select only one document to preview or import. 

7. Select the Show Detail Selection Screen check box if you want to select what discrete data 
elements will be imported.  

Note: This option is only available for selection if the highlighted document is in a format that can 
be imported as discrete data.  

8. In the Place in Chart Section field, select the section of the patient chart where you want to import 
and store the data from the imported document.  

9. Once you have made your selections, click the Import button.  
• If you selected the Show Detail Selection Screen option, the Import Medical Summary: 

Detail Selection screen appears. Use this screen to select the patient data you want to 
import. The screen displays the content from the document. If the item has a + sign you 
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can click it to expand the list. When the top-level item is selected, all items in the list will 
be selected. To un-select an item, click the corresponding check box. To re-select an 
item, click the corresponding check box. You can click the – sign to collapse the list. Click 
the OK button. If the document was successfully imported you will receive a confirmation 
message. 

• If you did not select the Show Detail Selection Screen option, Patient Records will display 
a message asking you to confirm that you want to proceed with the import process 
without reviewing the import data on-screen first. Click the OK button to proceed. If the 
document was successfully imported into Patient Records you will receive a confirmation 
message.   

10. Repeat steps 6-9 as many times as necessary to import all the documents that you wish. 

Notes: 

- If an incoming problem, vital sign, lab, medication, and/or note matches the date, time and the name 
of a problem, vital sign, lab, medication, and/or note already in the patient's chart, then they are 
considered to be the same, and nothing will be written to Patient Records.  
- If an incoming allergy does not have a date, and you later edit the allergy from the Allergy screen you 
will be required to enter the allergy date before you exit the screen. 

Fields on the Import from Document Repository screen 
Field Description 

Patient Information Area 

Local Patient This pane of the Patient Information area displays demographic 
information (first name, last name, middle initial, date of birth, 
and gender) for the patient currently selected in Patient Records. 

Remote Patient This pane of the Patient Information area displays demographic 
information (first name, last name, middle initial, date of birth, 
and gender) for the patient from the external network that was 
matched to the Lytec MD patient.  

Re-do Match button Click this button to go back to the Match External Patient screen 
and re-run another demographic query for the patient. 

Search Criteria Area 

Import documents created 
between (From Date) and (End 
Date) 

Enter a date in the From Date field to search for documents 
created on or after the specified date. Click the arrow button to 
select the date from the calendar list.  
Enter a date in the End Date field to limit the search to 
documents created by the specified date. Click the arrow button 
to select the date from the calendar list.  
Leave these fields blank to search for all available patient 
documents regardless of the date they were created.  

Query for highly confidential data? Select this check box if you want to query for documents that 
have been designated in the HIE as containing “highly 
confidential” data. 
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Content Type/ 
Document Class/ 
Healthcare Facility Type/ 
Practice Setting 

These groups of options represent the meta-data fields in the 
documents available for import from the HIE.  
Select the item(s) you want to include in the search by selecting 
the appropriate check box(es).  
Click Check All to select all available items in an option group. 
Leave the Check All box clear to be able to select individual 
items within a group. 

Search button Click this button to search for documents available for the current 
patient in the HIE based on the selected search parameters. The 
documents available for import for the current patient display in 
the Documents Found area. 

Documents Found Area 

Importable Y (Yes) or N (No) based on whether the type of document is one 
that can be imported into Lytec MD. See the About Importing 
from Document Depository section for a complete list of the 
document types that can be imported into Lytec MD.  

Date of Document Date the document was created. 

Facility Name Name of the organization from which the document originated. 

Primary Author Name of the document's author. 

Document Title Title of the document. 

Content Type Type of clinical activity (for example, Summarization of Episode 
Note or Admission Evaluation). 

Document Class Document class (for example, Summarization of Episode). 

Confidentiality Code Confidentiality Code. 

Format Document format (for example, CDAR2 IHE 1.0, ScanTEXT/IHE 
1.0, etc.). 

Practice Setting Practice setting (for example, group practice, community clinic, 
etc.). 

Clinical Act A more detailed description of the main clinical event for the 
document. 

Facility Type Facility type (for example, hospital outpatient service, urgent 
care, rehabilitation hospital, etc.). 

Event General clinical event for the document. 

Show Detail Selection Screen Select this check box if you want to select what discrete data 
elements will be imported.  

Note: The Show Detail Selection Screen check box is only 
available for selection if the highlighted document is in a format 
that can be imported as discrete data. 

Place in Chart Section Select the section of the patient chart where you want to import 
and store the data from the imported document. Click the arrow 
to select from the list of available items. 

Preview button Click this button to view the contents of the selected document 
before importing it into the patient's chart. 

Import button Click this button to import the selected document into the 
patient's chart. 
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Close button Click this button to close the screen. 
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Print Notes 

Unprinted Notes by Provider and Date Report 
This report prints progress notes that have not yet been printed. You can specify a provider ID or leave 
it blank to print notes for all providers. You can also specify a range of appointment dates or leave it 
blank to print notes for all dates. 

Note: Shared notes are not printed until they have been permanently saved.  

To print unprinted notes:  

1. Select Reports > Patient Records > Print Notes > Unprinted Notes by Provider and Date. The 
Unprinted Notes screen appears. 

2. (optional) Select the provider and/or dates for which you want to print notes.  

3. To print the notes to a file (instead of printing the notes on paper), mark the Print to file check 
box. If you select this option, indicate whether you want to save the report as an RTF, HTML, or 
text file. Then type a name for the file. 

Note: If you select HTML, the report and associated image files will be saved in the current directory. If 
you later move the HTML file, you will also need to move the image files, which are saved as .PNG files 
that use the HTML file’s name.  

4. Click the OK button.  

5. Indicate whether images attached to the notes should be printed. 

All Notes by Provider and Date Report 
This report prints all progress notes whether or not they have been previously printed. You may specify 
a provider ID or leave it blank to print notes for all providers. You may specify a range of dates or leave 
it blank to print notes for all dates. 

A note printed through this report is marked as printed only if the note is signed (or if your system 
administrator does not require notes to be signed). 

Note: Shared notes are not printed until they have been permanently saved.  

To print all notes:  

1. Select Reports > Patient Records > Print Notes > All Notes by Provider and Date. The All Notes 
screen appears. 

2. (optional) Select the provider and/or dates for which you want to print notes.  

3. To print the notes to a file (instead of printing the notes on paper), mark the Print to file check 
box. 

4. Click the OK button.  

5. Indicate whether images attached to the notes should be printed. 

Signed Notes by Provider and Date Report 
This report prints signed progress notes whether or not they have been previously printed. You may 
specify a provider ID or leave it blank to print notes for all providers. You may specify a range of dates 
or leave it blank to print notes for all dates. 
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Notes printed through this report are marked as printed. 

Note: Shared notes are not printed until they have been permanently saved.  

To print signed notes:  

1. Select Reports > Patient Records > Print Notes > Signed Notes by Provider and Date. The 
Signed Notes screen appears. 

2. (optional) Select the provider and/or dates for which you want to print notes.  

3. To print the notes to a file (instead of printing the notes on paper), mark the Print to file check 
box. 

4. Click the OK button.  

5. Indicate whether images attached to the notes should be printed. 

Unsigned Notes Report 
You can use this report to view a list of progress notes that have not yet been signed.  

To get a complete list of unsigned notes:  

1. Select Reports > Patient Records > Unsigned Notes. You can then select a provider and/or 
appointment date range. 

2. Click the OK button.  

Unsaved Notes Report 
You can use this report to view progress notes that have not yet been signed and saved. This report 
allows you to easily track these notes, and sign all such notes at the end of the day. You can also view 
unsaved notes through the unsaved progress notes feature.  

Another option is to view on screen a list of unsaved progress notes. From this list, you can quickly link 
to and sign progress notes that haven't been saved.  

To get a complete list of unsaved notes:  

1. Select Reports > Patient Records > Unsaved Notes. You can enter a provider ID, or leave the 
field blank. 

2. Click the OK button.  
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Formulary Report 
You can print the formularies for insurance carriers. You can also print the general formularies for a 
specific provider or for a group or specialty. If you want to see both insurance and general formularies, 
you can print them as well.  

To print formularies:  

1. Select Reports > Patient Records > Formulary. The Medication Formulary Report screen 
appears.  

2. Select one of the following options:  
• All – prints formularies for all insurance carriers and for all providers, groups, and 

specialties  

• By Insurance Carrier ID – prints formularies for the selected insurance carrier; enter a 
carrier ID to print the insurance formularies  

• By Group/Specialty ID – prints formularies for the selected provider group or specialty; 
enter a group or specialty ID to print the group or specialty’s formularies  

3. Click the OK button.  

4. When the report finishes printing, click the Cancel button to close the Medication Formulary 
Report screen.  

The report title, date, page number, and insurance carrier, provider, or group/specialty ID display at 
the top of the printout. For each formulary, columns display the template name, medication, size, take, 
frequency, duration (in days), amount, insurance cost, extended sig (Y/N), flag (P/S/R), and message.  
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Access Log Report  
If your system administrator has turned on access logging, Lytec MD will log each time an operator 
opens, edits, prints or exports data in a patient chart. The currently-selected provider is also recorded. 

This report prints the access log for the selected patients, operators, or providers. 

Note: The report will automatically track and record when the user successfully creates the report, and 
when the user attempts to generate the report but is not able to because they do not have the access 
level permission for the report. 

To print the access log report:  

1. Select Reports > Patient Records > Access Log Report.  

2. Indicate whether you are printing the report for patient, operator, or provider. 

3. To print the report for a specific patient/operator/provider, type the ID. 

4. To print the report for a specific date or range of dates, type the dates. 

5. To print the notes to a file (instead of printing the notes on paper), select the Print to file check 
box. 

6. Click the OK button.  
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Immunizations Report 
You can use this option to print immunization reports within Patient Records. This report may be used 
for school enrollment or travel. Before printing the report use the Immunizations Selection screen to 
determine the health maintenance activities and lab results that will be specified on the report. Once 
these have been determined, use the Immunization-Status Selection screen to specify the status or 
statuses of activities and results included on the report. 

System administrators may use PPart.ini or the Records 6 tab of the Special Features screen to specify 
the default status selection or selections on the Immunization–Status Selection screen. 

To print immunization reports:  

1. Select Reports > Patient Records > Immunizations. The Immunization-Status Selection screen 
appears.  

2. Select the status or statuses of the health maintenance items that you would like to print on the 
report. Do this by selecting the appropriate status check boxes. The status defaults are "X" for 
done, and "E" for done elsewhere.  If you do not want to print health maintenance items done 
elsewhere then un-check the "E" check box. 

3. Select a print option(s): 
• Click Print Expanded Description to print the full report description. 

• Click Print Comments, Lot Numbers to print comments and lot numbers associated with 
the activity or result in the report. 

• Click Print to file to prepare the report in a PDF, HTML, or text file. If selected, the Render 
to file screen opens. Select the type of file, file name, and the location where to save it. 

3. Once a print option(s) has been selected, click the OK button. This will display the 
Immunization Form.  

4. On the Immunization Form select one of the following options:  
• Single Patient: This option displays the Patient Lookup screen. Enter your search criteria 

and select the appropriate patient. Click the Lookup or OK button to print the report. 

• Patients who meet specified criteria: When selected, you may narrow down your print 
criteria by selecting a date of birth range, provider ID, and status. Once the appropriate 
information has been selected, click OK to print the report. 

• Patients on list generated by Patient Inquiry: This option opens the Patient Inquiry File 
screen. Enter (or browse to) the appropriate Patient Inquiry file, with an .inq extension. 
Click OK to print the report. 
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Prescription Output Log Report 
You can use this report to generate a printout of prescription output events for a provider and/or 
prescription date range. The report lists each "prescription output event," meaning each time a 
prescription was printed, faxed, or electronically transmitted. 

Important 
The ppart.ini setting "TrackRxNumber" under the [Rx] section must be set to ON, in order to run this 
report. If this setting is not enabled, you will receive the following message:  
 
"Your system is not configured to record tracking numbers for prescriptions. This setting must be 
turned on to run the Prescription Output Log Report." 
 
If you receive this message, your system administrator must enable this setting, and then you may 
access the report. Note that prescriptions originally written with the "TrackRxNumber" setting set to 
OFF will not print on the Prescription Output Log report since these prescriptions do not have tracking 
numbers associated with them. In order for a prescription output event to show up on the report, the 
prescription must have a tracking number associated with it (the "TrackRxNumber" setting must be set 
to ON).  
 
In addition, for Lytec MD to record the data that the Prescription Output Log report presents, the audit 
trail feature setting, "Audit Printing of Individual Records ( Applies only to Prescriptions )" must be 
enabled.   

To print the Prescription Output Log report:  

1. Select Reports > Patient Records > Prescription Output Log Report. You can then select a 
provider and/or prescription date range. You can also enter a from and to time.  

2. To print the report to a file (instead of printing the report on paper), select the Print to file 
check box. 

3. Click the OK button.  

Since some medical practices regularly generate a record of prescription output events, you can 
generate a reminder for the report by setting up a Windows scheduled task. When set up, the following 
reminder will be displayed at the scheduled time, "IMPORTANT REMINDER Please Run the Prescription 
Log Report Today". 

To set up a Windows scheduled task: 

1. From the Windows desktop Start menu select Control Panel. 

2. Select Scheduled Tasks. 

3. Double-click Add Scheduled Task. The Scheduled Task Wizard appears. Click Next.  

4. Click the Browse button, and navigate to your database directory (typically p:\ppart). 

5. Double-click RxReportReminder.exe.  

6. Type a name for the task, or keep the default task name "RxReportReminder". 

7. Select when you want the task to be performed. Click Next. 

8. Select the time and day you want the task to start. 

9. Enter the name and password of the user you want the reminder to be generated for. Click 
Next. 

10. Click Finish to add the task to the entered user's Windows schedule. 
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Order Reports 

Custom Order Report 
The custom order report prints a selected group of orders using a custom order form. The custom 
order forms can also be used when you print a paper copy of an order if the order has a facility that 
requires a custom form.  

To print the custom order report:  

1. Select Reports > Orders > Custom Orders. The Orders Print Selection screen appears.  

2. In the table, highlight the custom order form that you want to print.  

3. Click the OK button. The Custom Order Printing Select screen appears.  

4. Enter the criteria you want to use to select the orders to print. Your options include:  

Field Description 

Patient ID  To print the report for all patients, leave this field blank.  
To print the report for a specific patient, type the patient’s ID. 
When you tab out of the field, the patient’s name will appear 
in the Patient Name field. You can also type the patient’s 
name in the Patient Name field instead of using the patient’s 
ID.  

Provider ID  To print the report for all providers, leave this field blank.  
To print the report for a specific provider, select the 
appropriate provider from the drop-down list. When you tab 
out of the field, the provider’s name will appear in the 
Provider Name field.  

Practice To print the report for all practices, leave this field blank.  
To print the report for a specific practice, select the 
appropriate practice from the drop-down list.  

Order Type  To print the report for all order types, leave this field blank.  
To print the report for a specific order type, select the 
appropriate type from the drop-down list.  

Status  To print the report for all statuses, leave this field blank.  
To print the report for a specific status, select the appropriate 
status from the drop-down list. The available statuses are 
Pending, Sent, Suspend, Approved, and Completed.  

Order Date Range  In the date fields, select the range of dates for which you 
want to print the report. When you select a starting and 
ending date, all orders created between those dates that 
meet the other criteria you set will print.  

Processing Operator  To print the report for all processing operators, leave this 
field blank.  
To print the report for a specific processing operator, type 
the processing operator’s ID.  
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Mark Pending and Approved 
Orders as Sent when printed  

To change all Pending and Approved orders that meet the 
criteria you specify to a status of Sent after they are printed, 
mark this check box.  

5. When you finish, click the OK button.  

6. If the Windows Print screen feature is turned on, select the printer and click the OK button.  

Order Analysis Report 
You can use the order analysis report to review the order types that have been placed, the cost and 
quantity of each order type, and how long it takes for the results to come back to the practice. This 
information provides a global perspective on what is being ordered and by whom. You can analyze 
orders based on the following variables: by provider, by practice, by order type, by order range, and 
by facility ID.  

To print the order analysis report:  

1. Select Reports > Orders > Order Analysis. The Order Analysis Select screen appears.  

2. Enter the criteria you want to use to select the orders to print. Your options include:  

Field Description 

Patient ID  To print the report for all patients, leave this field blank.  
To print the report for a specific patient, type the patient’s ID. 
When you tab out of the field, the patient’s name will appear 
in the Patient Name field. You can also type the patient’s 
name in the Patient Name field instead of using the patient’s 
ID.  

Provider ID  To print the report for all providers, leave this field blank.  
To print the report for a specific provider, select the 
appropriate provider from the drop-down list. When you tab 
out of the field, the provider’s name will appear in the 
Provider Name field.  

Practice  To print the report for all practices, leave this field blank.  
To print the report for a specific practice, select the 
appropriate practice from the drop-down list.  

Facility ID  To print the report for all facilities, leave this field blank.  
To print the report for a specific facility, type the appropriate 
facility’s ID.  

Order Type To print the report for all order types, leave this field blank.  
To print the report for a specific order type, select the 
appropriate type from the drop-down list.  

Order Name  To print the report for all order names, leave this field blank.  
To print the report for a specific order, type the order’s name. 
The available statuses are Pending, Sent, Suspend, 
Approved, and Completed.  

Order Date Range  In the date fields, select the range of dates for which you 
want to print the report. When you select a starting and 
ending date, all orders created between those dates that 
meet the other criteria you set will print.  
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Processing Operator  To print the report for all processing operators, leave this 
field blank.  
To print the report for a specific processing operator, type 
the processing operator’s ID.  

Include costs To print costs for the orders that meet your criteria, mark this 
check box.  

Include result times  To print the time it took for the orders that meet your criteria 
to be completed, mark this check box.  

Include orders that haven’t come 
back  

To print orders that do not have a status of completed, but 
that otherwise meet the criteria you specified, mark this 
check box.  

3. When you finish, click the OK button. The Order Analysis Sort Select screen appears.  

4. Select how the data should be sorted (grouped) for the report. At a minimum, you must select a 
first sort.  

5. If the Windows Print screen feature is turned on, select the printer and click the OK button.  

Overdue Order Report 
You can use the overdue orders report to view which orders are overdue, the provider who ordered 
the labs, the patient for whom the labs were ordered, and related information. This report allows you to 
follow up on orders that are pending to make sure they get processed, and to follow up with facilities 
for orders that have been sent but not completed.  

To print the overdue order report:  

1. Select Reports > Orders > Overdue Orders. The Overdue Orders Printing Select screen 
appears.  

2. Enter the criteria you want to use to select the orders to print. Your options include:  

Field Description 

Ordering Provider  To print the report for all ordering providers, leave this field 
blank.  
To print the report for a specific ordering provider, select the 
appropriate provider from the drop-down list. When you tab 
out of the field, the provider’s name will appear in the 
Provider Name field.  

Receiving Provider  To print the report for all receiving providers, leave this field 
blank.  
To print the report for a specific receiving provider, select the 
appropriate provider from the drop-down list. When you tab 
out of the field, the provider’s name will appear in the 
Provider Name field.  

Order Date Range  In the date fields, select the range of dates that the tests were 
ordered for which you want to print the report. When you 
select a starting and ending date, all orders created between 
those dates that meet the other criteria you set will print.  
If you leave the dates blank, all orders up to the current 
system date and time that meet the other criteria you set will 
print.  
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Overdue Date Range  In the date fields, select the range of dates that the tests are 
overdue for which you want to print the report. When you 
select a starting and ending date, all orders that were 
overdue between those dates that meet the other criteria you 
set will print.  
If you leave the dates blank, all overdue orders up to the 
current system date and time that meet the other criteria you 
set will print.  

Status  To print the report for all statuses, leave this field blank.  
To print the report for a specific status, select the appropriate 
status from the drop-down list. The available statuses are 
Pending, Sent, Suspend, Approved, and Completed.  

Type  To print the report for all order types, leave this field blank.  
To print the report for a specific order type, select the 
appropriate type from the drop-down list.  

Practice  To print the report for all practices, leave this field blank.  
To print the report for a specific practice, select the 
appropriate practice from the drop-down list.  

Facility ID  To print the report for all facilities, leave this field blank.  
To print the report for a specific facility, type the appropriate 
facility’s ID.  

Carrier ID  To print the report for all insurance carriers, leave this field 
blank.  
To print the report for a specific insurance carrier, type the 
appropriate insurance carrier’s ID.  

Patient ID  To print the report for all patients, leave this field blank.  
To print the report for a specific patient, type the patient’s ID. 
When you tab out of the field, the patient’s name will appear 
in the Patient Name field. You can also type the patient’s 
name in the Patient Name field instead of using the patient’s 
ID.  

Processing Operator  To print the report for all processing operators, leave this 
field blank.  
To print the report for a specific processing operator, type 
the processing operator’s ID.  

3. When you finish, click the OK button.  

4. If the Windows Print screen feature is turned on, select the printer and click the OK button.  

Standard Order Report  
The standard report is the “canned” version that ships with Order Entry. Unless you select a custom 
order form, the standard order report will be used when you print a paper copy of an order.  

To print the standard order report:  

1. Select Reports > Orders > Standard Orders. The Standard Orders Printing Select screen 
appears.  

2. Enter the criteria you want to use to select the orders to print. Your options include:  
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Field Description 

Patient ID  To print the report for all patients, leave this field blank.  
To print the report for a specific patient, type the patient’s ID. 
When you tab out of the field, the patient’s name will appear 
in the Patient Name field. You can also type the patient’s 
name in the Patient Name field instead of using the patient’s 
ID.  

Provider ID  To print the report for all providers, leave this field blank.  
To print the report for a specific provider, select the 
appropriate provider from the drop-down list. When you tab 
out of the field, the provider’s name will appear in the 
Provider Name field.  

Practice  To print the report for all practices, leave this field blank.  
To print the report for a specific practice, select the 
appropriate practice from the drop-down list.  

Order Type  To print the report for all order types, leave this field blank.  
To print the report for a specific order type, select the 
appropriate type from the drop-down list.  

Status  To print the report for all statuses, leave this field blank.  
To print the report for a specific status, select the appropriate 
status from the drop-down list. The available statuses are 
Pending, Sent, Suspend, Approved, and Completed.  

Order Date Range  In the date fields, select the range of dates for which you 
want to print the report. When you select a starting and 
ending date, all orders created between those dates that 
meet the other criteria you set will be changed.  

Processing Operator  To print the report for all processing operators, leave this 
field blank.  
To print the report for a specific processing operator, type 
the processing operator’s ID.  

Mark Pending and Approved 
Orders as Sent when printed  

To change all Pending and Approved orders that meet the 
criteria you specify to a status of Sent after they are printed, 
mark this check box.  

3. When you finish, click the OK button.  

4. If the Windows Print screen feature is turned on, select the printer and click the OK button.  
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Patient Records-only topics 

Blood glucose meter 

Setting up the Blood Glucose Meter  
To use the Blood Glucose Meter, you must configure the application by setting up:  

• Time ranges so the laboratory data will match your time range labels.  

• Laboratory tables so that you can store glucose readings in patient charts.  

You can also configure: 

• Display preferences (such as time format, high/low ranges, and display order).  

• Comments to populate the Comment pull-down list.  

Once you set up the Blood Glucose Meter, you can use an interface cable to connect a supported 
meter to the system (you will need a separate interface cable for each glucose meter brand). You will 
also need an available serial port on the workstation to which you can attach the cable.  

Using the Blood Glucose Meter  
You can use the Blood Glucose Meter feature to display, analyze, chart, and print blood glucose (BG) 
data. You can enter data manually or import data directly from the following supported glucose meters 
(please see the notes about connecting the meter to your PC):  

• All OneTouch meters from Lifescan  

• AccuChek Complete 

• AccuChek Advantage 

• TheraSense FreeStyle 

• Bayer 

Setting up laboratory tables for the blood glucose meter 
Once you set up time ranges, you can set up laboratory tables that will store mean glucose and 
standard deviation data for each time range.  

1. For each time range, create mean blood glucose and standard deviation laboratory data 
names to match the time range labels. For example, if the time range is “Breakfast”, you could 
create lab data names called “Breakfast Mean G” and “Breakfast Std”. You should have two lab 
data names for each time range.  

2. Assign lab data Xref names for each lab data name that you create.  
 
When you add the lab data test name, click the Xref button on the Laboratory Test screen. 
Then, in the Cross Reference field, use the following syntax (must be exact, including spaces):  
 
For mean glucose lab data names:  
 
[time range label] / Mean Glucose (e.g., “Breakfast / Mean Glucose”)  
 
For standard deviation lab data names:  
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[time range label] / Standard Deviation (e.g., “Breakfast / Standard Deviation”)  

3. Create a laboratory flow chart that contains your new lab data names.  

Important notes about connecting the meter to your PC 
If the glucose meter is not correctly connected to your PC, you will not be able to import data into the 
system. Please review the information below, as it may prevent or resolve problems in importing the 
glucose data. 

• The Blood Glucose Meter does not import data from meters connected through a USB port. The 
Blood Glucose Meter currently imports data only through serial ports. 

• Make sure you use the appropriate interface cable. Interface cables should be acquired from the 
company that produces the meter. 
 
Verify whether the serial port to which you will connect the meter is a 25-pin or 9-pin port, then 
make sure the cable is the same type. For example, if the serial port is 9-pin, but the cable is 25-
pin, you will need to purchase either a 25-pin to 9-pin adapter or a 9-pin cable. 
 
If you are using a OneTouch FastTake meter, you will need to connect a FastTake adapter to the 
test strip port on the meter, then connect the interface cable to the FastTake adapter. 

• If another device was previously connected to the serial port, you may need to restart your 
computer. However, if you are using either the Brentwood EKG or Brentwood Spirometer add-
on modules, be advised that the Brentwood software appropriates the serial port. You will not be 
able to import data from a meter attached to the serial port without un-installing the Brentwood 
software. 

• Make sure you select the appropriate COM port on the Blood Glucose Meter screen. When you 
connect the meter to the serial port, note which COM port is used. Then, in Patient Records, 
select the appropriate COM port in the Blood Glucose Meter screen's Comm Port field. 

• If you are using an infrared AccuChek meter, select IR AccuChek on the Blood Glucose Meter 
screen. To import data into Patient Records from an infrared AccuChek meter, you must select 
"IR AccuChek Meters from Roche" in the Blood Glucose Meter screen's Device field. 
 
To turn on the infrared AccuChek meter, hold down the MEM and SET buttons at the same time. 

• For OneTouch meters: If your device is blue in color, turn the meter off before importing data. If 
your device is gray or silver, turn it on before importing data. Blue meters include OneTouch 
FastTake. Gray/silver meters include OneTouch Basic, OneTouch Basic Plus, OneTouch Profile, 
OneTouch SureStep, and OneTouch UltraSmart. 

Importing, editing, graphing, analyzing, and printing blood 
glucose data 
To open the Blood Glucose Meter screen: 

• When a patient chart is open, select Task > Add-ons > Blood Glucose Meter. The Blood Glucose 
Meter screen appears.  

To import data from a glucose meter: 

1. Connect the glucose meter to your computer.  

2. Select Data > Import. The Import Data for Blood Glucose Meter screen appears.  
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3. In the Device field, select the glucose meter type.  

4. In the Comm port field, select the com port (serial port) to which your meter is connected.  

5. Click the OK button. The data appears on the Blood Glucose Meter screen. The date range 
displayed should match the dates of the imported data.  

Note: If the date/time of the meter is different than the current PC system date/time, you are given the 
option of changing the date/time of the imported data. 

To enter blood glucose data manually: 

1. On the Blood Glucose Meter screen, click the New button. The Blood Glucose Data <New> 
screen appears.  

2. In the Date field, type the date of the blood glucose test. Dates must be in the format 
MM/DD/YY.  

3. In the Note field, type a note if applicable. You can enter one note for each day.  

4. In the first empty cell in the Time column, type the time the test was administered. Test times 
can be entered in either AM/PM or 24-hour format, depending on the preferences your system 
administrator has selected.  

5. In the corresponding cell in the Value column, type the test result . If the result is above normal, 
the data appears red. If the data is below normal, the data appears yellow. Normal ranges are 
set by the system administrator.  

6. In the corresponding cell in the Comment column, select a comment from the drop-down list. 
You can also type a comment directly in the cell, or leave the cell blank.  

7. Click the OK button.  

To edit blood glucose data : 

1. On the Blood Glucose Meter screen, highlight the column that you want to edit.  

2. Click the Edit button. The Blood Glucose Data <Edit> screen appears.  

3. Make the necessary changes.  

4. Click the OK button.  

To graph blood glucose data : 

1. On the Blood Glucose Meter screen, highlight the row that you want to graph.  

2. Click the Graph button. The Blood Glucose Graph screen appears.  

3. To print the graph, click the Print button. To return to the Blood Glucose Meter screen, click the 
Close button.  

To analyze blood glucose data : 

1. On the Blood Glucose Meter screen, click the Analyze button. The Blood Glucose Analysis 
screen appears.  

2. To print the analysis, click the Print button.  

3. To save the mean and standard deviation values to the patient chart Laboratory Data section, 
click the Store button. Be sure to click Store; if you don't, none of the data will be saved in the 
patient chart. 

Note: To store blood glucose data, you must first set up the Blood Glucose laboratory data.  
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4. To return to the Blood Glucose screen, click the Close button.  

To print blood glucose data : 

• On the Blood Glucose Meter screen, click the Print button. If the Windows Print screen appears, 
select the printer and click the OK button. 
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Data loaders 

Lab Data Loader 
You can use the Laboratory Data Loader to transfer information supplied by your laboratory facility to 
the patient chart Laboratory Data section. The Laboratory Data Loader saves you the trouble of 
entering laboratory data manually into Patient Records.  

The laboratory records the laboratory data in a text-only (that is, ASCII) file, with the appropriate Dot 
codes added. This file may be transferred by any standard PC-compatible telecommunications 
program from the laboratory or supplied to your practice on disk. Print the file sent by the laboratory 
for a daily summary of laboratory results.  

The test results and comments are loaded directly into the corresponding laboratory data category, 
and additionally may be kept together in a single file in the Lab Miscellaneous category.  

Using the Lab Data Loader to update health maintenance data 
In addition to recording laboratory data, you can use the Laboratory Data Loader to update health 
maintenance procedures for your patients. If the health maintenance procedure names match 
laboratory test names, the health maintenance procedures are updated automatically in the Health 
Maintenance section of the patient chart.  

If health maintenance procedure names and laboratory test names do not match, you can create a 
cross-reference file that links the health maintenance procedure name with the laboratory data name. 
To do this, create a file named HMLBXREF.FL with any text editor that can create a text-only (that is, 
ASCII) file. The file should contain a table in the following format:  

hmname : labname1, labname1 ...  
hmname: labname1, labname2 ...  

where hmname is a health maintenance procedure name, and labname1 and labname2 are the names 
of laboratory tests. When the results of a lab test satisfy a scheduled health maintenance procedure, the 
health maintenance status will be updated automatically.  

For example, if the HMLBXREF.FL file contains:  

U/A : U. PROTEIN  
TFT : T4, TSH  

the results of the urine protein test (U. Protein) will update the U/A health maintenance item. The results 
of the T4 or TSH tests will automatically update the TFT (that is, thyroid function test) health 
maintenance item.  

The HMLBXREF.FL file is case-sensitive, which means that entries in the file must exactly match the lab 
names in Patient Records. You must use the appropriate uppercase and lowercase characters. If the lab 
name is SODIUM, the entry in the cross-reference file must also be SODIUM, not Sodium or another 
variation.  

Note: Health maintenance names longer than 10 characters cannot be loaded through the Lab Data 
Loader. 

Formatting Lab Data Loader files 
• If you are using the HTML note format: Make sure the text files you transfer are in HTML format, 

with Lytec MD-specified Dot codes included. 
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• If you are not using the HTML note format: Make sure that text files you transfer contain only 
ASCII characters, with Lytec MD-specified Dot codes included.  

The laboratory facility must follow the specifications for the file format, as defined by Lytec MD. If the 
laboratory is not equipped to prepare files for importing into Patient Records, have them contact Lytec 
MD for help. A complete specification booklet is available.  

Lytec MD also supports the ASTM 1238 and HL7 formats, and has special laboratory software preset for 
most major national labs. Contact Lytec MD or your dealer for information.  

Each Laboratory Data Loader file begins with a special header record containing the following 
information for every patient for whom test results are recorded in the file:  

• The name of the file.  

• The provider requesting the laboratory data (required to send lab information to the lab review 
bin).  

• Patient ID information.  

The rest of the file contains patient data, including numeric laboratory data, comments on the 
laboratory data, and text information for the Microbiology and Laboratory Miscellaneous categories.  

The Laboratory Data Loader puts each laboratory data item into the correct Laboratory Data category, 
and places text in the correct patient chart sections. Tests that do not fit in any of the existing 
Laboratory Data categories (for example, serum protein electrophoresis) will be placed in the Lab 
Miscellaneous category.  

The Laboratory Data Loader loads all data into the Lab Review queue.  

Note: When the laboratory identifies a test as high, low, abnormal, or normal, this will override the 
range of normal values you defined on the Laboratory Data Test Names.  

Dot codes for the Lab Data Loader 
The table below lists the Dot codes available specifically for use with the Lab Data Loader. You can also 
use general Dot codes. 

Code Type Description/Example 

.BC laboratory lab category 

.CO2 laboratory The .CO2: code allows you to load a comment for a specific lab 
test as well as the date and time. The format is:  
.CO2 : date : time : lab name : comment 

.D date The .D line contains the date, followed by the patient's name, 
ID, and time.  
The patient's name should be entered in the format:lastname, 
firstname MI 
The patient ID is required, and should correspond to the 
patient's registration in Patient Records, up to eleven characters 
long. 
An example of a .D line for the Lab Data Loader: 
.D: 01/01/03 : Stein, Richard : 100-10 : 10:00 am 

.L laboratory Laboratory data is loaded into the numeric laboratory data 
sections of the chart (for example, CBC-1 or U/A-1). Use the 
following format:  
The .L: Dot code is followed by a laboratory test name (for 
example, Hematocrit), which is the laboratory name for the test 
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as entered in the cross-reference table for laboratory data. The 
name cannot exceed 40 characters. You must also add a result 
which is a numeric value (for example, 40.5) or a text value (for 
example, yellow). You can also indicate the units of 
measurement, indicate whether the results were normal or 
abnormal (for example, H for high, L for low, N for normal, or A 
for abnormal), and specify the normal range. You can have up 
to 15 .L: lines per note.  
.L: laboratory test name: results: units: normal/abnormal: 
normal range  
.L:glucose:100 

.L2 laboratory The .L2: code allows you to load a different date and time than 
the one on the .D: line. The format is:  
 
.L2: date : time : test name : result : units : normal/abnormal : 
nl.range  
 
For example: 

.L2: 12/23/02 : 08:45 : ALB : 3.3 : g/dL : L : 3.5-5.5  

The variables for the .L2: lines are as follows:  

date mm/dd/yy 
For example, 02/23/04. 

time hh:mm  

For example, 08:45 for 8:45 
am or 16:30 for 4:30 pm. 

test name (required)  The name of the test as it 
appears in cross reference 
table for laboratory data.  

result (required)  A numeric or text value.  

units (optional)  The units of measurement 
used in the test.  

normal/abnormal (optional) H, L, N, C, B or A  
 H = high  
 L = low  

 N = normal  
 C = critical high  

 B = critical low  
 A = abnormal  

nl. range (optional)  The normal range.  

For example, 38 - 46.  
 

.PV provider Every note belongs to one primary provider. When you print 
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reports by provider or search for notes by provider, this is the 
one that is considered.  
However, you can have additional providers review and cosign 
the note by using the .PV line. You may include up to six 
providers on the .PV line. The .PV line must be in the first 10 
lines.  
The format for the .PV code is: 
.PV: provider ID: provider ID: provider ID  
This line is required to send lab results to the lab review bin 
and to send critical flag messages to the provider(s) identified 
in the .PV line. 

Loading files with the Lab Data Loader 
When you receive data from the laboratory, you can easily transfer the patient laboratory data into 
Patient Records with the Laboratory Data Loader.  

To load a file with the Lab Data Loader:  

1. Select Task > Data Loader > Laboratory Data Loader. The Laboratory Data Loader screen 
appears.  

2. Enter the name of the file that you want to load. Include the drive and path, if necessary. For 
example, you can enter 011293.LB1, 122392.LBL, or \lab\012293.LB2.  

3. If you want an exact copy of the laboratory file for each patient to be loaded into the Lab 
Miscellaneous area, type Y for Yes. Otherwise, type N to not store the extra copy.  

4. If the delimiter is not a colon, enter the appropriate character. The delimiter is the character 
that separates each field in the file. It is usually a colon, but can be changed by your lab. They 
will tell you if it is different.  

5. Click the OK button to start the load. You will see the name and ID of each patient as they are 
being loaded.  

Printing Lab Data Loader error messages 
When you load laboratory data, Patient Records creates an error file with the same name as the 
laboratory data file (.LBL), with the extension .ERL added. After the load, you can display this file on the 
screen (answer Y when asked whether you want to view the errors) or print it.  

To print the error messages: 

1. Select Task > Data Loader > Print Laboratory Data Loader Error File. 

2. Enter the name of the error file (the file has an .ERL extension). If the file you are loading is in a 
different directory than Patient Records, enter the file’s name and path (or click the Dir button 
to search for the file).  

Note: The error file is placed in the same drive and directory as the .LBL file.  

3. Click the OK button to print the error file.  

4. After examining the error listing, you should do one of the following. If the errors are such that 
no laboratory data was loaded, then correct the errors and reload the file. If some data did 
load, edit the files, delete the information that loaded successfully, correct the errors, and 
reload. Or enter the data directly into the Laboratory Data windows, without using the loader.  
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When a laboratory file has been loaded, the words “ALREADY LOADED” are inserted at the top 
of the file. If you want to reload the file, you must delete these words. Otherwise the loader will 
not load the file.  

Error messages 
The table below lists the most commonly occurring error messages that appear in Laboratory Data 
Loader error files.  

Field Description 

A line was found out of order Since patient data must follow the .D: line, lines with 
patient data are not allowed before the first .D: line. 
Likewise, general header information must precede the 
.D: line. 

The delimiter is invalid  The usual delimiter is the colon (:). Invalid delimiters are 
blank(), underline(_), or a comma (,).  

A duplicate lab comment record exists The duplicate comment was not loaded. If necessary, add 
it directly in Patient Records.  

A duplicate lab test exists for the 
following lab data name  

A duplicate laboratory test was not loaded. The loader 
will not load the same test twice if drawn on the same 
date and time. In this case, the date for this lab test (same 
time and date) was already entered in Patient Records. If 
this is not a true duplicate, add the lab test result directly 
in Patient Records.  

Duplicate .NP line Only one .NP: line (number of patients) should be present 
in each laboratory file. The duplicate .NP: line will be 
ignored. The laboratory should correct its method of file 
preparation so duplicate .NP: lines are not created.  

Duplicate test not loaded The Laboratory Data Loader file contains the same 
laboratory test twice for the same date and there is no 
time entry in the file. The second occurrence of the 
laboratory test was not loaded. If this is not a true 
duplicate, add the lab test result directly in Patient 
Records.  

Error seeking on disk When reading the laboratory data file an error occurred. 
The laboratory data file may be damaged. If no data was 
loaded, replace the file and reload it. If some data was 
loaded, enter the rest of the data directly in Patient 
Records.  
Note: This message displays a special error screen and 
stops the Laboratory Data Loader. 

The file has already been loaded. 
Continue? 

The laboratory data file has already been loaded. If you 
press Y, some duplication of data will result.  
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The H/L/A/N field must be ‘H’, ‘L’, ‘A’, ‘N’ 
or blank 

The H/L/A/N field determines whether the entry is High, 
Low, Normal, or Abnormal. Only H, L, A, N, or blank are 
allowed in this field. An invalid entry means the 
associated laboratory test was loaded without a flag 
indicating whether it was High, Low, Normal, or 
Abnormal. Patient Records will rely instead on the default 
normal range for the test. The laboratory should correct 
its method for preparing the load files.  

Incomplete file, data is missing. (or .NP: 
line is incorrect) 

The .NP: line indicates how many patients’ data will be 
loaded. The data for some patients are apparently 
missing due to an incomplete transmission. Print the 
laboratory file and have the laboratory retransmit the file. 
Determine which patients are missing and create a new 
load file with their data.  

Invalid date format  The date on the .D: line is invalid. Correct the date and 
reload it. 

Invalid line found before the first .D: line Since patient data must follow the .D: line, lines with 
patient data are not allowed before the first .D: line. 
Likewise, general header information must precede the 
.D: line. 

Invalid line found after .D line and 
before data lines 

Since patient data must follow the .D: line, lines with 
patient data are not allowed before the first .D: line. 
Likewise, general header information must precede the 
.D: line. 

Invalid .NP: line There is an error on the .NP: line.  

Invalid time format The date on the .D: line is invalid. Correct the date and 
reload it. 

Internal error # An internal error has occurred. Write the error number 
down and contact your dealer or Lytec MD.  

Lab file locked; data not loaded Another user was writing to a file for the patient at the 
same time as the load. Enter the data manually.  

Line skipped. Only one .OR: line 
allowed 

One .OR: line is allowed before the patient data begins, 
and one .OR: line is allowed within each patient’s data. If 
extra .OR: lines are found, they will be skipped. Have the 
laboratory correct their method for preparing the data 
file.  

Line truncated Because the line was too long, it was truncated.  

Missing date, or date field is too long The date field could not be identified, either because it is 
missing or formatted incorrectly. The usual format is 
mm/dd/yy (e.g., 01/03/04 means January 3, 2004).  

Missing patient ID, or patient ID field is 
too long 

The patient ID field could not be identified, either 
because it is missing or formatted incorrectly. The 
maximum number of characters is eleven.  

Missing patient name, or patient name 
field is too long  

The patient name field could not be identified, either 
because it is missing or formatted incorrectly. The usual 
format is last name, first name, with a maximum of twenty-
eight characters (fourteen for each name). 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 615 

 

No .D line found The date on the .D: line is invalid. Correct the date and 
reload it. 

No data found for this patient A patient with no data was included in the laboratory file. 
In general, the laboratory should not include patients with 
no data in the file.  

No cross-reference Loader category 
names exist 

When you used the Laboratory Data Names and Normal 
Values window, you did not enter Cross-Reference 
Laboratory Category names. You must do so before you 
can load laboratory data successfully.  

No generic lab names were found No laboratory data names entered with Enter Laboratory 
Data Names and Normal Values were found. Either your 
system is not properly configured or your data files are 
damaged.  

No match found for lab name in the 
main cross-reference table  

The name of the laboratory test was not present in the 
cross-reference table. The test was loaded into Lab 
Miscellaneous. If the test will be used frequently, enter it 
into the cross-reference table.  

Note file locked; data not loaded Another user was writing to a file for the patient at the 
same time as the load. Enter the data manually.  

.OR: line truncated The .OR line was too long and was truncated.  

Patient not registered The date on the .D: line is invalid. Correct the date and 
reload it. 

Patient ID different from name The date on the .D: line is invalid. Correct the date and 
reload it. 

Unable to close file An error occurred closing the laboratory data file or error 
file. While not usually serious, you or your dealer should 
recheck your system configuration.  
Note: This message displays a special error screen and 
stops the Laboratory Data Loader. 

Unable to delete file The Laboratory Data Loader was unable to delete an old 
error file. No data was loaded.  
Note: This message displays a special error screen and 
stops the Laboratory Data Loader.  

Unable to open file The laboratory data file or the error file could not be 
opened. Make sure that the laboratory data file is present 
in the correct directory. If the error file could not be 
opened, you may have too many files in your directory or 
your system does not allow sufficient files to be open at 
once. Delete some of the files that you no longer need, or 
increase the number of files that can be opened 
simultaneously.  
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Unable to write A write error occurred. The Laboratory Data Loader was 
unable to write to the error file or to the database files. 
The most likely reason is that you are out of disk space. 
Delete some unnecessary files. Enter the data that was 
not loaded directly in Patient Records. A less likely reason 
for this message would be a damaged hard disk. Check 
your hard disk and repair it if necessary.  
Note: This message displays a special error screen and 
stops the Laboratory Data Loader.  

Text Data Loader 
You can enter patient chart information directly into Patient Records, or with the Text Data Loader, you 
can transfer it into Patient Records from a file. You can create and import RTF (files with an .rtf 
extension) or text files (files with an .txt extension). 

The information that you load must be properly coded with Dot codes. Patient Records transfers 
information to the various patient chart sections based on how you coded the information.  

Similarly, you can enter laboratory information directly, or you can transfer it from an outside file 
created by your laboratory using the Laboratory Data Loader. 

Loading files with the Text Data Loader 
You can load files in ASCII or RTF format. Make sure that lines with Dot codes on them are shorter than 
200 characters. 

Each patient note or report must be preceded by Date (.D:), Title (.T:), and optionally Category (.K:) 
line, or by Date (.D:) and Title (.T:) lines. If these lines are missing or incorrectly entered, the entire note 
will not load. You will need to correct the error in the note, and then reload the corrected note. 

If you want to replace partial note markers in an existing note with text from the uploaded file, you must 
include the note's date, patient name, and patient ID in the .D line, and include a .P line for each marker 
you want to replace, followed by the replacement text. 

If the note loaded successfully, but you were unable to load the patient’s problem list (.MP:, .OP:), 
allergies (.AL:), medications (.RX:), vital signs (.V1:, .V2:, .V3:), or health maintenance (.H:, .H2:), add or 
correct the entries directly in the patient chart instead of reloading them with the Text Data Loader. 

To load a file with the Text Data Loader: 

1. Select Task > Data Loader > Text Data Loader. The Text Data Loader screen appears. 

2. Indicate whether you will Load Data from Medical Writer or Load Data from a Word Processor 
File (a file with an .rtf or .txt extension). 

3. If the file you are loading is in a different directory than Patient Records, enter the file’s name 
and path (or click the Browse button to search for the file). 

4. Click the OK button. While the file is being loaded, the screen displays the current percentage 
completed and the name of the patient whose note is currently loading. 

If you need to reload notes: 

If some of your notes do not load, you can prevent duplicate errors when you reload by doing the 
following: 

You may want to delete the notes for the patients which have been successfully loaded from the RTF or 
text file. Otherwise, you may see “duplicate” type error messages when you reload the file. 
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Printing Text Data Loader error messages 
The Text Data Loader rejects improperly formatted notes, and stores error messages in a separate file. 
This file has the same name as your original text file, with the extension .ERR appended (for example, 
“MDNOTE.ERR”). The error file is located in the same drive and directory as the file you loaded. 

You can print a list of these errors so that you can correct the notes that failed to load and then reload 
them. 

If errors occur when you save a note directly in Patient Records, you are asked if you want to display the 
error messages on your screen. If you do not display the messages on your screen, you can print an 
error file later .The error file for notes loaded directly into Patient Records is PRLOAD.ERR. Error 
messages are the same as those for the Text Data Loader. 

Each message in the data error file is preceded by the line: 

----Note Identification---- 

Next, you will see the .D: and .T: lines or the first three lines of the note, if the .D: and .T: cannot be 
recognized by the Text Data Loader. The messages apply to the notes for a single patient. 

To print the error messages: 

1. Select Task > Data Loader > Print Text Data Loader Error File. 

2. Enter the name of the error file (i.e. MDNOTE.ERR). If the file you are loading is in a different 
directory than Patient Records, enter the file’s name and path (or click the Dir button to search 
for the file). 

3. Click the OK button to print the error file.  

4. After the error file prints, check the file’s contents. For each note where an error occurred, 
identifying information will be printed, followed by the error itself. 

Error messages  
The table below lists error messages that may appear in the data error file (for example, MDNOTE.ERR) 
when you use the Text Data Loader. 

Message Description 

An .RX: line must precede a .SIG: line  All .SIG: lines must be preceded by a .RX: (or .RX2:, etc.) 
line so that the Text Data Loader knows which medication 
the extended sig belongs to.  

Could Not Find a Note Within the File... This error applies to RTF files loaded through the Text 
Data Loader.  
The date on the .D: line is invalid, or the .D line is missing. 
Correct the date and reload it. 

.D: Line Format Error The .D: line has been entered incorrectly. Correct the line 
and reload the note.  

.D: Line Must Directly Precede .K: Line  The text was not loaded. Applies to all categories of data 
except progress notes. Correct and reload. 

.D: Line Must Directly Precede .T: Line  The text was not loaded. Applies to progress notes only. 
Correct and reload.  
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Duplicate Problem (2)  There is another progress note for this patient and date 
with identical secondary (that is 2nd, 3rd, 4th or 5th) 
problems for the same date and time. The note will not be 
indexed by the duplicate problem and will not be 
retrievable by that problem.  

Duplicate Text - not loaded (1)  A progress note for this patient with the same date, time 
and primary problem (that is, the first problem on the .T: 
line) has already been loaded. This note is regarded as a 
duplicate. To load two progress notes with the same date 
and time, change the title for the second note. For 
example, if two X-Ray reports were recorded on the same 
day, give them different titles. 

End of Messages for an embedded 
note  

The preceding error messages applied to embedded text 
(e.g., Past Medical History, EKG, etc.) and the subsequent 
error messages apply to the starting note for the patient 
(e.g., the progress note).  

Health Maintenance Locked, Data Not 
Loaded  

Another user was editing health maintenance procedures 
for this patient or the file was locked. Enter health 
maintenance information directly in the health 
maintenance section of the patient chart.  

Illegal Single .K: Line  The .K: has been ignored and the entry has been included 
as text.  

Insufficient memory: .RX: lines not 
loaded  

There was insufficient memory available to load the .RX: 
lines. You may need to reconfigure your computer so that 
more memory is available.  

Insufficient memory: .SIG: lines not 
loaded  

There was insufficient memory to load the .SIG: lines. You 
may need to reconfigure your computer so that more 
memory is available.  

Invalid Date Format  The date on the .D: line is invalid. Correct the date and 
reload it. 

Invalid Diagnosis format: not loaded  The diagnosis code format was incorrect. Fix the diagnosis 
directly in the patient chart. 

Invalid note category -- the .K: is not a 
valid text category and the entry has 
been included as text 

This error message applies only to HTML notes. When 
using the Text Data Loader, .K: lines must be worded 
exactly the same as the patient chart tabs. For example, 
you must enter ".K: Family History," not ".K: History of 
Family." If you do not include a .K: line, the Text Data 
Loader assumes that you are loading a progress note, and 
the text on the .K: line is added as note text. 

Invalid Procedure format: not loaded  The procedure format was incorrect. Fix the procedure 
directly in the patient chart.  

Invalid time format -- time on .D: is not 
valid 

This error message applies only to HTML notes. HTML 
notes require a time after the date. Make sure the note 
uses this format: 
.D: date : time : patient name : patient ID 
For example: 

.D: 01/01/04 : 10:00 am : Stein, Richard : 100-10 
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Invalid time format or patient not 
registered -- time or patient ID on .D: is 
not valid 

This error message applies only to HTML notes. HTML 
notes require a valid patient ID and a time after the date. 
Make sure the note uses this format: 
.D: date : time : patient name : patient ID 
For example: 

.D: 01/01/04 : 10:00 am : Stein, Richard : 100-10 

.K: Line Format Error  The .K: line is incorrect. Correct the line and reload the 
note.  

Medications Locked, Data Not Loaded Another user was editing medications for this patient or 
the file was locked. Enter medications directly in the 
medications section of the patient chart.  

No Template in Age Range: Health 
Maintenance Not Loaded 

There is no individual template for the patient and no 
template for the patient’s sex and age group. As a result, 
Health Maintenance could not be loaded. Enter health 
maintenance data directly in the health maintenance 
section of the patient chart.  

Note is too long--so it was only partially 
loaded 

The note is too long for the Text Data Loader. The 
maximum note length for “old style” notes is 999 lines. 
There are no limits for HTML style notes. 

Note with this date and title already 
exists. 

This error message applies only to HTML notes. To load 
correctly, HTML notes must have unique dates and titles. 
Change the date and/or title of the note. 

Partial note was not loaded because 
note with the same date and marker 
does not exist for this patient 

This error message occurs when you attempt to replace 
partial note markers in an existing note with text from the 
imported text data file, but Patient Records either could 
not find a note matching the information in the .D line of 
the uploaded file or could not find the partial note markers 
identified by .P lines in the uploaded file. 
Ensure that the .D line correctly identifies the date, time, 
patient name, and patient ID of the existing note: 

.D: 01/01/04 : 10:00 am : Stein, Richard : 100-10 

Ensure that any .P lines correctly identify the partial note 
markers you want to replace in the existing note: 

.P: 1001 

Patient ID Different From Name The note could not be loaded because the patient ID did 
not correspond to the patient name. Make sure that the 
patient name is spelled correctly and that the identification 
number is right. Correct the name or number and reload 
the note.  

Patient Not Registered There is no patient registered with this identification 
number. Make sure the patient is registered. Then reload 
the data.  

Problem List Locked, Data Not Loaded Another user was editing the problem list for this patient 
or the file was locked. Enter the problems from the .T: line 
directly into the problem list section of the patient chart.  
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Problem List Not Loaded Some or all of the problems on the .T: line could not be 
loaded. Add these problems directly in the problem list 
for the patient.  

Progress Note Locked, Data Not 
Loaded 

Another user was adding or editing information for the 
patient whose information was being loaded or the file 
was locked. Reload the progress note.  

Read Error A potentially serious read error occurred during the load. 
Run the CHECK utility to make sure all the files are intact. 
Then reload. If you see primary duplicate errors, they can 
be ignored. Make sure that all data for this patient has 
been successfully loaded, by looking at it in Patient 
Records.  

Some Allergies Not Loaded Some or all allergies could not been loaded. Add these 
allergies directly in the medications section of the patient 
chart.  

Some Health Maintenance Not Loaded Some or all health maintenance procedures could not be 
loaded. Add these health maintenance procedures 
directly in the health maintenance section of the patient 
chart.  

Some Medications Not Loaded Some or all medications could not be loaded. Add 
medications directly in the medications section of the 
patient chart.  

Some Vitals Not Loaded Some or all vital signs could not be loaded. Add the vital 
signs directly in the vital signs section of the patient chart. 

.T: Line Format Error  The format of the .T: line is incorrect. Correct the line and 
reload the note.  

The .PV: line must be within the first few 
lines of the note 

The .PV: line must be in the first ten lines of the note.  

The Rx duration value is invalid Valid entries for Rx duration are blanks, prn, -, or a number 
less than 1000.  
 

The Rx Medication Name is missing or 
is too long 

The maximum length of an Rx medication name is twenty-
five characters. 

The Rx refills value is invalid Valid entries for Rx refills are blanks, or a number less than 
1000.  

Too Many .H lines The maximum number of .H: lines per note is 10.  

Too Many .L: lines The maximum number of .L: lines per note is 160.  

Too Many .MP: lines The maximum number of .MP: lines per note is 200.  

Too Many .OP: lines The maximum number of .DX:, .OP:, and .PR: lines per 
note is 200 lines combined.  

Too Many .RX: lines The maximum number of .RX: lines per note is fifteen.  

Too Many .SIG: lines The maximum number of .SIG: lines per note is ten. 

Too Many .T: lines You may only enter a single .T: line for each note.  

Too Many .TME lines You may only enter a single .TME: line for each note. 

Too Many .V: lines You have attempted to enter too many .V: lines for the 
note. 
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Unknown .K: Line The format of the .K: line is incorrect. Make sure your entry 
is spelled correctly and reload it.  

Vital Signs Locked, Data Not Loaded Another user was editing vital signs information for this 
patient or the file was locked. Enter the vital signs 
information directly in the vital signs section of the patient 
chart.  

Write Error A potentially serious write error occurred during the load. 
Run the CHECK utility to make sure all the files are intact. If 
so, reload them. If the files are damaged, you may need to 
use the BUILD or FIX utilities to recover them. After you 
see a write error and you reload your data, you may see 
primary duplicate errors. These can be ignored. Make sure 
that all the data for this patient has been loaded.  

Text Load Scheduler 
The Text Load Scheduler schedules when the Text Data Loader loads text files. The Text Data Loader 
periodically checks for text files and then loads the notes into Patient Records. 

The system administrator can use the Text Load Scheduler utility to select the: 

• Time and days to check for files. 

• Scheduled interval time in minutes or hours. 

• Start date and end date (optional). 

• Location, destination, and text to append to the text files. 

• Operator to send messages to when the Text Data Loader generates an error. 

To use the Text Load Scheduler: 

• Start the Text Load Scheduler. Click textloadscheduler.exe in the client folder (typically this is the 
\prwin folder). This opens the Text Load Scheduler. 

• Enter the Text Load Scheduler settings. See the Fields on the Text Load Scheduler screen section 
for a complete explanation of the settings. 

• Please note the utility can be used to schedule time for the Text Data Loader to check for text 
files or IMH files. To run the utility for text files, you must select the Schedule is for normal Text 
Load not for Instant Medical History Files option.  

• Click OK to save your settings. You will be presented with the Computer Account screen. Enter 
your computer User Name and Password, and click OK. 

Once you have entered your settings, the Text Data Loader will collect the TDL files during the selected 
run times. When the Text Data Loader is running a DOS window will appear. Do not close this window 
while the Text Data Loader is running, if the window is closed, the Text Data Loader will stop collecting 
files. The DOS window will close automatically at the Text Data Loader’s selected stop time.   

The files will then be stored in the patient’s chart as a note. If an error is produced during the loading 
process, the operator you selected from the Text Load Scheduler will be sent a message via the Patient 
Records messaging system. For a complete explanation of the settings located on the Text Load 
Scheduler utility, please see the Fields on the Text Load Scheduler screen section.   

Fields on the Text Load Scheduler screen 
The following table offers detailed descriptions of the fields on the Text Load Scheduler screen. 
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Field Description 

Schedule Type 

Schedule is for normal Text 
Load not for Instant Medical 
History Files 

To run this utility for text files you must select this option.  

Use Social Security Number 
for Patient Matching 

This setting determines the Text Load Scheduler .D line format. 
When this setting is enabled, you may load notes without a 
patient ID. To use the regular .D line format do not select this 
setting.  

Start/Stop Time 

Start  
 

Select the Text Data Loader start time. You can use the fields up 
and down arrows to scroll to the desired time. 

Stop  Select the Text Data Loader stop time. You can use the fields up 
and down arrows to scroll to the desired time. 

Days fields (Mon, Tues, etc.)  Select the days you want the Text Data Loader to run to collect 
text files. 

Schedule Interval  Enter the amount of time that the Text Data Loader will check for 
text files. Use the provided fields to enter the exact time in 
minutes or hours.  

Start/Stop Date  

Start Date  Select the Text Data Loader start date. You can enter the date, or 
click the down arrow button to access the calendar. 

End Date Select the Text Data Loader stop date. You can enter the date, or 
click the down arrow button to access the calendar. If you do not 
want to enter an end date, do not select the End Date check box. 

Text Loader Settings  

Location of Files  Enter (or browse to) the folder where you want to store the text 
files. You can use the Browse button to navigate to the folder. 

Destination Folder for 
Loaded Files 

Enter (or browse to) the folder where you want to store the text 
files. You can use the Browse button to navigate to the folder. 

Text to Append to Loaded 
Files 

Enter the text to append to the files extension. For example, 
when you enter IMH in this field, the loaded file will be tagged 
with IMH at the end of the extension (e.g., .tdlIMH). 

Operator ID to send to Text 
Data Loader Errors too  

Enter the operator’s ID in this field. The selected operator will 
receive a message if a file fails to load or an error is encountered. 
An attachment will be sent to the operator using the Patient 
Records messaging system. 

Mark Notes as printed  Select this option to mark notes in the database to tell whether 
they have been printed or not. 

Delete duplicate notes  Select this option to delete duplicate notes. For example, if there 
is a note in the database, and a new note is generated with the 
same date, title, and name, the existing note in the database will 
be deleted. 
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Load Progress Note As a 
Shared Note  

This setting controls whether a note will be loaded as shared. 
When enabled, the note will load as a shared note. This will allow 
you to edit notes and insert Dot codes along with templates. If a 
shared note already exists for the patient then it will load the note 
as a saved progress note. If this setting is disabled, the note will 
be loaded as a saved progress note. 

Do not process K Lines when 
loading Progress Notes as a 
Shared Note  

This option controls whether the .K (chart section) lines in files are 
processed when the note is loaded as shared. Select this option 
to process .K lines after a note is permanently saved. If this option 
is not selected, .K lines will be processed when the note is 
loaded. 
Note: This option is only enabled when the Load Progress Note 
As a Shared Note option is selected. 
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Dot codes and insert codes 
You can include Dot codes in your notes to tell Patient Records what type of information you are 
entering. Properly coded text is automatically transferred into the appropriate chart section, as are 
problem list, vital sign, medication, laboratory, allergy, clinical element, and health maintenance data.  

You can use Dot codes for notes entered directly into Patient Records, and for notes transferred into 
Patient Records from an ASCII text file prepared using another word processor.  

Each Dot code is preceded by a dot (.) and followed by a colon (:). You can use optional spaces after 
the colon for readability. If you use another word processor, you must enter the Dot codes yourself.  

A convenient way to use Dot codes when writing a note is by using QuickText. All available Dot codes 
are listed and you can select and insert the codes.  

Embedding Dot codes in progress notes 
If you are using the Text Data Loader, you can embed categories of text, such as Past Medical History, 
within a progress note. All text for a particular patient must still start with .D: (Date), .K (Category), and 
.T: (Title) lines. If the Category line is missing, the text is assumed to be a progress note. You can switch 
to a new progress note, or switch temporarily to a new category of text.  

A .T: (Title) line by itself means a new progress note for the same patient has been started. A Category 
line followed by a Title line means a new note type is being entered. For example, you can embed an 
EKG report or Past Medical History within a progress note. The end of the new note type is indicated 
with the .End Dot code. Subsequent text will load to the previous note type. You cannot use embedded 
notes when you are entering notes directly into Patient Records.  

In the following example, the progress notes Cellulitis L foot and FH early M.I. are loaded, along with 
the Past Medical History entry Patient's Father died of an M.I. at age 50:  

.D: 03/01/08 : Smith, David : 1256  

.T: Cellulitis L foot  
 
S: L foot has been tender and red for 2 days. No previous history of redness in the area. No history of 
injury or insect bite. Seems to be getting worse. Has taken ASA to no avail.  
 
O: T: 98.6  
Dorsum of L foot, distal to 1st MP joint, there is a 3 cm in diameter area of bright erythema and heat. 
Moderate edema. No streaking. No palpable inguinal nodes. 
 
A: Cellulitis  
 
P: Hot soaks.  
Keflex 250 mg qid for 10 days  
CB 1 week, earlier prn.  
 
.T: FH early M.I.  
 
S: Patient wants EKG because father died one week ago from an M.I. He has no history of chest pain. 
He does not smoke.  
 
.K: Family History  
Patient's Father died of an M.I. at age 50.  
.end  
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.V1: Syst 120: Diast 80: P 80  
COR:NSR, no murmur  
Chest: clear  
 
A: Family History early M.I.  
 
P: Cholesterol, EKG (at patient's request), reassurance  

Updating health maintenance using Dot codes 
If the Category line of a note is for the X-Ray, EKG, Pathology, or Special Studies section, and the Title 
line is the name of a health maintenance item, the item is updated automatically in the patient's chart.  

For example:  

.D: 04/17/08: APPLEBY, ANNIE : 200-10  

.K: X-Ray  

.T: Mammog  

When this note is uploaded, health maintenance will be updated to include the item Mammog 
performed on 04/17/08. 

Note: By default, if the title of a note matches the name of a health maintenance procedure, the 
procedure's status is automatically updated to Done (X). If you do not want to update health 
maintenance procedures based on note titles, you can use the Update HM based on Note Titles 
check box on the Special Features screen Records 6 tab to turn off this feature. 

Saving progress notes with Dot codes 
When you save a progress note with Dot codes, various parts of the patient chart are updated. 
Depending on which Dot codes you have used, problem list, vital signs, laboratory, medications, 
allergies, and health maintenance sections of the chart are updated automatically.  

If errors occur, an error file named PRLOAD.ERR is created, and you will be asked if you wish to view 
this file on the screen. You can also print it out for review, using the Print Laboratory Data or a File 
option on the Data Loader Menu.  

Note: For more information about the error file generated when loading notes from an external file, 
see Text Data Loader.  

Tip on Entering .AL:, .V1:, .V2:, .V3:, .H:, .H2:, .MP:, . RX:, or 
.OP: Lines 
Lines with these codes must start on the left margin and must be kept alone on the line. If you get a 
load error on any of these lines, you must correct it by entering the data directly into the appropriate 
chart section in Patient Records.  

About insert codes 
Insert codes are available so that you can insert data into your notes and letters from medications, 
problem list, social history, past medical history, family history, and vital signs. Insert codes perform the 
opposite function of the standard Dot codes and display the letter I after the dot (.), so that you can tell 
them apart from standard Dot codes.  
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You can insert data as you type a note or letter by choosing the command from the Insert menu, or by 
using the Dot code list on the QuickText screen.  

You can also type these codes in note or letter templates, or insert the codes by using QuickText. When 
you write a note or letter using the template, Dot codes are replaced with the data.  

Using Dot codes 
To insert a Dot code or insert code using QuickText: 

1. Place the cursor at the point in your note where you want to insert the Dot code.  

2. Select Insert > QuickText, or click the QuickText button on the toolbar. The Insert QuickText 
screen appears.  

3. Select the Dot Code radio button.  

4. Highlight the Dot code or insert code that you want to insert. You can scroll through the list to 
select the code, or you can enter part of the code name in the QuickText name field. The code 
that most closely matches the name you enter will be highlighted.  

5. Click the Insert button to insert the code into the note.  

List of Dot codes and insert codes 
Insert codes are distinguished from Dot codes because they start with .I. 

Code Type Description/Example 

.AL allergies You can use the .AL: code to add allergies to the note. You can 
enter up to nine .AL: codes per note. 
.AL: allergen 
For example: 

.AL: tetracycline 

.AL: codeine 

.AL2 allergies You can use the .AL2: code to add allergies to the note. This 
line contains the medication name, reaction, type, severity, and 
code (reserved for future use). 

Note: If the allergy type has not been selected, the type will be 
set to DA (drug allergy). 

For example: 

.AL2: PREDNISONE : difficulty breathing : DA : Moderate  
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.AL3 allergies You can use the .AL3: code to add allergies to the note. This 
line contains the date the allergy was identified, medication 
name, reaction, type, severity, and code (reserved for future 
use). 

Note: If the allergy type has not been selected, the type will be 
set to DA (drug allergy). 

For example: 

.AL3: 01/15/06 : PREDNISONE : difficulty breathing : DA : 
Moderate  

.ALR allergies You can use the .ALR code to record the date allergies were 
reviewed. If the date is left blank then todays date is used. 
.ALR: date 
For example: 

.ALR: 11/30/06 

.AC EEF You can use the .AC: code to enter action items for electronic 
encounter forms. Up to 10 .AC lines can be added. While each 
.AC line can be up to 200 characters long, there is a total limit of 
400 characters for all AC items on a single EEF.  
For example: 

.AC: patient needs to be seen a week from today 

.CC  Use the .CC: code to send review-only copies of a note to the 
review queue of one or more providers. You may include up to 
six providers on the .CC line. The .CC line must be in the first 10 
lines.  
The format for the .CC code is: 
.CC: provider ID: provider ID: provider ID  
For example:  

.CC: GPL: CLD: RMB 

Notes: 
It is not possible to "cc" a note to a provider if he or she is on 
the .PV line in the same note. If they are, the user will receive the 
following message when saving the note: "A provider was 
specified on both a .PV and .CC line; the note will be sent to the 
provider for cosigning only." 
 
If a provider is on a .CC line or .PV line and the same note 
already exists (in either form) in the providers review queue, the 
following message will be displayed when the note is saved: 
"One of the providers specified on a .CC or .PV line already has 
this note in their Review Queue. No new Review Queue item will 
be created." 

.CE clinical elements The .CE: code is used for clinical elements. This line contains, 
the clinical element name, results, units, and whether the results 
are normal or abnormal.  
For example: 

.CE: My Clin Element : Result 1 : Unit 1 : n 
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.CE2 clinical elements The .CE2: code is used for clinical elements. This line contains, 
the date, time, clinical element name, results, units, and whether 
the results are normal or abnormal.  
For example: 

.CE2: 12/01/05 : 12:34pm : My Clin Element : Result 2 : U2 : a 

.D date The .D line contains the date, followed by the patient's name 
and ID.  
The patient's name should be entered in the following format: 
lastname, firstname MI 
The patient ID is required, and should correspond to the 
patient's registration in Patient Records, up to eleven characters 
long. 
For example: 

.D: 01/01/03 : Stein, Richard : 100-10 

If you are using HTML-based notes, a time is required after the 
date.  
For example: 

.D: 01/01/03 : 10:00 am : Stein, Richard : 100-10 

Note: The .D line for the Lab Data Loader uses a different 
format than the .D line used in notes. 

.DC Rx You can use the Dot code .DC to discontinue a medication and 
add it to the patient's historical medication list. The .DC line has 
the format:  
.DC: medication name  
Optionally, follow the medication name with E for Effective or I 
for Ineffective.  
.DC: medication name: I  
For example:  

.DC: Amoxicillin: I  

If you do not add E or I, Patient Records assumes the 
medication was effective. (Use the E code only if you need to 
add it for clarity.)  

.DC2 Rx You can use the Dot code .DC2 to discontinue a medication 
and add it to the patient's historical medication list. The reason 
for discontinuation is also included. Optionally, follow the 
medication name with E for Effective or I for Ineffective.  
The .DC2 line has the format:  
.DC2: medication name : effectiveness : reason for 
discontinuation 
For example:  

.DC2: Omeprazole : E : Cost 
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.DX diagnosis You can use the .DX: code to add a diagnosis code to the note. 
Include the name, and optionally, up to two diagnosis codes. 
DX: diagnosis name: code1: code2  
For example:  

.DX: Headache: 215.2  

Note: You can use a combined total of two hundred Dot codes 
per note for other problems, diagnoses, procedures, risks, 
hospitalizations, and pregnancy problems. 

.DX2 diagnosis For additional diagnosis codes use .DX2: followed by a 
diagnosis name, and optionally, a date, note, and diagnosis 
code. 
.DX2: name : date : note: code1 
For example:  

.DX2: Spinal Stenosis Lumbar : 08/20/08 : L1-2 broad :724.02 

.DX3 diagnosis You can use the .DX3: code to add the diagnosis name, a 
numerical code (such as an ICD-9-CM code), the condition's 
lifecycle status, the provider, the external provider, and an 
additional code (such as a SNOMED-CT code).  
.DX3: name : code : lifecycle : provider : Ext Provider : code 2  
For example:  

.DX3: Headache: 784.0 : Resolved: ABC : AAA: 25064002 

.DX4 diagnosis You can use the .DX4 code to add the diagnosis name, an 
associated date, a free text note (maximum length 100 
characters), a numerical code, the condition's lifecycle status, 
the provider, the external provider, and an additional code 
(such as a SNOMED-CT code).   
.DX4: name : date : note : code 1 : lifecycle : provider : Ext 
Provider : code 2  
For example:  

.DX4: Headache: 04/01/05 : Mild : 784.0 : Resolved: ABC : 
AAA: 225064002 

.DX5 diagnosis You can use the .DX5 code to add the diagnosis name, the date 
the problem last occurred, a free text note (maximum length 
100 characters), a numerical code (such as an ICD-9-CM code), 
the condition's "lifecycle" status, the provider, the external 
provider, and an additional code (such as a SNOMED-CT code). 
.DX5: name : date last : note : code 1 : lifecycle : provider : Ext 
Provider : code 2 
For example:  

.DX5: Headache: 04/25/05 : Mild : 784.0 : Resolved: ABC : 
AAA: 225064002 
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.DX6 diagnosis You can use the .DX6 code to add the diagnosis name, a 
numerical code (such as an ICD-9-CM code), and whether the 
diagnosis is Active or Inactive.  
.DX6: name : code : active 
For example:  

.DX6 : Headache : 784.0 : Inactive 

.H health maintenance Health maintenance entries start with a .H: code, followed by 
the procedure name and the procedure's status (indicating 
whether the procedure has been completed, refused, and so 
on). There may be up to five procedures on a line and twenty 
lines per note. Here is an example with three procedures:  

.H: DT X: PAP R: GUAIAC O 

In this example, the DT has been performed the pap test was 
refused, and guaiac has been ordered.  
The health maintenance procedures must be worded exactly as 
they are on the health maintenance template. You can use up to 
20 .H: lines in a patient note.  
If a .H: code includes health maintenance data for a health 
maintenance procedure code which is not on any of the 
patient's health maintenance templates, the information will be 
added to the patient's historical health maintenance list. 

.H2 health maintenance If you want to assign a date different than the date of the note to 
a health maintenance item, you can use the .H2: code, which 
includes a date followed by up to four procedure names. 
For example:  

.H2: 01/03/02: PAP X : MAMMOGRAM  

In this example, a PAP was performed on 01/03/02. A 
mammogram was not performed.  
The health maintenance procedures must be worded exactly as 
they are on the health maintenance template. You can use up to 
20 .H2: lines in a patient note.  
If a .H2: code includes health maintenance data for a health 
maintenance procedure code which is not on any of the 
patient's health maintenance templates, the information will be 
added to the patient's historical health maintenance list.  
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.H3 health maintenance If you want to assign a date AND time different than the date 
and time of the note, you can use the .H3: code, which includes 
this information followed by up to four procedure names. 
.H3: <date> : <time> : <proc1> <status> : <proc2> <status> : 
 <proc3> <status> : <proc4> <status>  
For example:  

.H3: 09/15/03 : 09:00 am : TD X: BP X: PAP R: HGT/WGT X 

The health maintenance procedures must be worded exactly as 
they are on the health maintenance template. You can use up to 
20 .H3: lines in a patient note.  
If a .H3: code includes health maintenance data for a health 
maintenance procedure code which is not on any of the 
patient's health maintenance templates, the information will be 
added to the patient's historical health maintenance list. 

.H4 health maintenance If you want to record data usually entered on the “More” section 
of the Health Maintenance <New> or <Edit> screen, you can 
use the .H4 code.   
.H4: <Procedure Name> <Procedure Status> : <Dose> : 
<Route> : <Provider> : <Location> : <Lot> : <Exp Date> : 
<Manufacturer> : <Device> 

.H4: Tdap X: 0.5 mL: IM: AA: Left Deltoid: 3494J: 11/08/07: 
Merck: Syringe 

The health maintenance procedures must be worded exactly as 
they are on the health maintenance template. You can use up to 
20 .H4: lines in a patient note.  
If a .H4: code includes health maintenance data for a health 
maintenance procedure code which is not on any of the 
patient's health maintenance templates, the information will be 
added to the patient's historical health maintenance list. 

.HS hospitalizations To add a problem for which the patient was hospitalized to the 
hospitalization (problem) list, enter an .HS: code followed by the 
problem name, a numerical code (such as an ICD-9-CM code), 
and an additional code (such as a SNOMED-CT code).  
.HS: hospitalization name : code1 : code 2 

.HS: Pneumonia : 486  

Note: You can use a combined total of two hundred Dot codes 
per note for other problems, diagnoses, procedures, risks, 
hospitalizations, and pregnancy problems. 

.HS2 hospitalizations You can use the .HS2 code to include a problem for which the 
patient was hospitalized, along with a start date, a note about 
the hospitalization, and a numerical code (such as an ICD-9-CM 
code).  
.HS2: hospitalization name : date : note : code 
For example: 

.HS2: Pneumonia : 01/05/06 : note : 486  
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.IAL insert code Inserts up to nine of the patient's allergies. The reaction 
associated with each allergy is also displayed in parentheses. 
For example: 
"Amoxicillin (Rash)". 

.IAL2 insert code Inserts up to nine of the patient's allergies (and associated 
reactions in parentheses), and a note that includes the date 
when the allergy history was last updated. For example: 
"Allergy history last updated on 11/30/06". 

.ICM insert code Inserts a list of patient's current medications. If the patient is not 
taking any medications, and On No Meds is displayed in the 
Rx/Medications list, "The patient is on no medications" will be 
inserted. 

.ICM2 insert code Inserts a list of patient's current medications that includes the 
route of medications, instructions for use, and the quantity and 
duration of medication administration, explained in simple, 
non-medical language. 
 
For example, the following prescription:  
 
Medication: XANAX; Size: 0.25 MG; Take: 1 Tab; Freq: BID; 
Dur: 30; Route: Oral;  
Extended Signature: Use for anxiety. Do not use more than 3 
days in a row. 
Note: May cause drowsiness 
Indication 1: PANIC DISORDER 
Indication 2: INSOMNIA W SLEEP APNEA 
 
will be inserted in your note as:  
 
XANAX 0.25 MG 1 Tab by mouth twice each day as needed for 
30 days   
Instructions: Use for anxiety.  Do not use more than 3 days in a 
row. 
Note: May cause drowsiness 
Indication 1: PANIC DISORDER 
Indication 2: INSOMNIA W SLEEP APNEA 

Important: If you are upgraded to Patient Records 9.3.1, in 
order for the frequency values in a prescription to be translated 
by the .ICM2 insert code, you must populate the [Rx] section of 
the ppart.ini file with “Freq##” values (i.e., Freq01, Freq02, etc.) 
indicating the values you would like translated, and what you 
would like them translated to. See the PPart.ini file section for a 
complete explanation of this setting.  

.IDX insert code Inserts the patient's diagnoses. Uses a setting in the ppart.ini file 
to determine whether the problem should be inserted 
horizontally, horizontally with codes, vertically, or vertically with 
codes. 
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.IFH insert code Inserts the patient's family history. If you are using E&M codes, 
.IFH also inserts the appropriate E&M code. 

.IHS insert code Inserts the entries on the "Hospitalization" tab of the Problem 
List section of the Patient Chart. 

.IRK insert code Inserts the entries on the "Risks" tab of the Problem List section 
of the Patient Chart. 

.ILR insert code Inserts lab review data. Lab review screen must be open for this 
dot code to work. 

.IMP insert code Inserts the patient's major problems. Uses a setting in the 
ppart.ini file to determine whether the problem should be 
inserted horizontally, horizontally with codes, vertically, or 
vertically with codes. 

.IPP insert code Inserts the patient's pregnancy problems.  

.IOP insert code Inserts the patient's other problems. Uses a setting in the 
ppart.ini file to determine whether the problem should be 
inserted horizontally, horizontally with codes, vertically, or 
vertically with codes. 

.IPH insert code Inserts the patient's past medical history. If you are using E&M 
codes, .IMP also inserts the appropriate E&M code. 

.IPR insert code Inserts the patient's procedures. Uses a setting in the ppart.ini 
file to determine whether the problem should be inserted 
horizontally, horizontally with codes, vertically, or vertically with 
codes. 
Another setting defines procedure codes that should not be 
inserted. For example, most practices will not want office codes 
to be inserted into the note. 

.ISH insert code Inserts the patient's social history. If you are using E&M codes, 
.ISH also inserts the appropriate E&M code. 

.ITM insert code Inserts current system time. 

.IV1 insert code Inserts the patient's BP and pulse as recorded today (vital signs). 
The BP and pulse attributes are also inserted. 

.IV2 insert code Inserts the patient's temp, height, and weight as recorded today 
(vital signs). 

.IV3 insert code Inserts the patient's OFC and Other vitals as recorded today 
(vital signs). 

.IV4 insert code Inserts the patient's respiration and oximetry data.  

.IV5 insert code Inserts the patient's postural data (pulse and/or blood 
pressure). This can included up to three sets. The attributes of 
each BP and pulse measurement are also inserted.  
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.K category You can use the Dot code .K to indicate the note's category (or 
type of note). For example: 

K: Family History 

This is optional, unless you are loading notes via the Text Data 
Loader.  
If you are using the Text Data Loader, .K: lines must be worded 
exactly the same as the patient chart tabs. For example, you 
must enter ".K: Family History," not ".K: History of Family." If you 
do not include a .K: line, the Text Data Loader assumes that you 
are loading a progress note. 

.L laboratory Laboratory data is loaded into the numeric laboratory data 
sections of the chart (for example, CBC-1 or U/A-1). Use the 
following format:  
The .L: Dot code is followed by a laboratory test name (for 
example, Hematocrit), which is the laboratory name for the test 
as entered in the cross-reference table for laboratory data. The 
name cannot exceed 40 characters. You must also add a result 
which is a numeric value (for example, 40.5) or a text value (for 
example, yellow). You can also indicate the units of 
measurement, indicate whether the results were normal or 
abnormal (for example, H for high, L for low, N for normal, or A 
for abnormal), and specify the normal range. You can have up 
to 15 .L: lines per note.  
.L: laboratory test name: results: units: normal/abnormal: 
normal range  

.L:glucose:100 

.L2 laboratory The .L2: code allows you to load a different date and time than 
the one on the .D: line. The format is:  
 
.L2: date : time : test name : result : units : normal/abnormal : 
nl.range  
 
For example: 

.L2: 12/23/02 : 08:45 : ALB : 3.3 : g/dL : L : 3.5-5.5  

The variables for the .L2: lines are as follows:  

date mm/dd/yy 
For example, 02/23/04. 

time hh:mm  

For example, 08:45 for 8:45 
am or 16:30 for 4:30 pm. 

test name (required)  The name of the test as it 
appears in cross reference 
table for laboratory data.  
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result (required)  A numeric or text value.  

units (optional)  The units of measurement 
used in the test.  

normal/abnormal flag 
(optional)  

H, L, N, C, B or A  
 H = high  

 L = low  
 N = normal  

 C = critical high  
 B = critical low  

 A = abnormal  
Note: A flag specified via a 
.L2 Dot code will override 
the flag stored in Patient 
Records for the test and the 
flag determined by the 
range entered via the .L2 
Dot code, if the values are 
different. 

nl. range (optional)  The normal range. If you 
enter a range, you must also 
specify the appropriate flag 
for the test result. 

For example, 38 - 46.  

Note: A range specified via 
a .L2 Dot code will override 
the range stored in Patient 
Records for the test, if the 
values are different. 

 

.MP major problem To add a problem to the major problem list, enter an .MP: code 
followed by the problem name, and optionally, a numerical 
code (such as an ICD-9-CM code), and an additional code (such 
as a SNOMED-CT code).  
You can use up to twenty .MP: codes per note. 
.MP: major problem name : code1 : code 

.MP: Diabetes Mellitus Type 2: 250.00 

.MP2 major problem You can use the .MP2: code to include a major problem, along 
with a start date, a note about the problem, and a numerical 
code (such as an ICD-9-CM code). You can use up to twenty 
.MP2: codes per note.  
For example: 

.MP2: Diabetes Mellitus Type 2 : 02/02/05 : NIDDM : 250.00 
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.MP3 major problem You can use the .MP3: code to include a major problem, along 
with an ICD-9 code, the condition's status, the provider, the 
extended provider, and an additional code (such as a 
SNOMED-CT code). You can use up to twenty .MP3: codes per 
note.  
.MP3: name : code : lifecycle : provider : Ext Provider : code 2  
For example: 

.MP3: Diabetes Mellitus Type 2 : 250.00 : Stable : ABC : AAA : 
44054006 

.MP4 major problem You can use the .MP4: code to include a major problem, along 
with a start date, a note about the problem, an ICD-9 code, the 
condition's status, the provider, the extended provider, and an 
additional code (such as a SNOMED-CT code). You can use up 
to twenty .MP4: codes per note.  
.MP4: name : date : note : code 1 :  lifecycle : provider : Ext 
Provider : code 2  
For example:  

.MP4: Diabetes Mellitus Type 2 : 02/02/05 : NIDDM : 250.00 : 
Stable :  ABC : AAA : 44054006  

.MP5 major problem You can use the .MP5: code to include a major problem, along 
with the date the problem last occurred, a note about the 
problem, an ICD-9 code, the condition's status, the provider, 
the extended provider, and an additional code (such as a 
SNOMED-CT code). You can use up to twenty .MP5: codes per 
note.  
.MP5: name : date last : note : code 1 : lifecycle : provider : Ext 
Provider : code 2 
For example:  

.MP5: Sinusitis Maxillary : 02/02/05 : Prolonged : 461.0 : 
Improving :  ABC : AAA : 35923002 

.MP6 major problem You can use the .MP6: code to include a major problem, along 
with an ICD-9 code, and whether the problem is active or 
inactive. You can use up to twenty .MP6: codes per note.  
.MP6: name : code : active  
For example: 

.MP6: Diabetes : 02/02/05 : 250.0 : active  

.NRS E&M coding If you put the .NRS code in a note, it will tell the E&M coder that 
a Review of Systems (ROS) was obtained from the patient. It has 
the same effect on the coder as including all of the 14 ROS E&M 
tags in the note, or of checking off all of the 14 ROS check 
boxes on the E&M Coding Detail screen. The .NRS code 
essentially achieves the same thing as manually checking the 
"notation that all other ROS are negative in the history" check 
box on the E&M detail screen. 
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.OC orders This Dot code marks orders as completed.  
.OC: order ID : order name (optional) 
.OC: 2389 : RBC 
If you do not use an order name, the order with the specified ID 
is marked as complete. If the order is a parent order, all children 
in the set are marked as complete. 
If you use an order name, the order will be marked as complete 
as long as both the ID and name match the information you 
specified. If the name does not match, the system assumes the 
order is a parent order, and looks for a child order in the set 
with a matching order name. If found, the child order is marked 
as complete. 
When used with the Lab Data Loader, the .OC line must be 
used after an .L2 line. 

.OP other problem You can add additional problems to the other problem list, 
using the .OP: code.  
.OP: problem name : ICD-9 code 
For example: 

.OP: Wrist Pain 

Note: You can use a combined total of two hundred Dot codes 
per note for other problems, diagnoses, procedures, risks, 
hospitalizations, and pregnancy problems. 

.OP2 other problem You can use the .OP2 code to add a problem to the other 
problem list along with a start date, a note, and an ICD-9 code.  
.OP2: other problem name: start date: note: code1 
For example: 

.OP2: Wrist Pain : 02/02/06 

.OP3 other problem You can use the .OP3: code to add a problem to the other 
problem list along with an ICD-9 code, the condition's status, 
the provider, the external provider, and an additional code 
(such as a SNOMED-CT code).  
.OP3: other problem name : code : lifecycle : provider : Ext 
Provider : code 2  
For example: 

.OP3: Wrist Sprain : 842.0 : Improving : ABC : AAA : 70704007 

.OP4 other problem You can use the .OP4: code to add a problem to the other 
problem list along with a start date, a note, an ICD-9 code, the 
condition's status, the provider, the external provider, and an 
additional code (such as a SNOMED-CT code).  
.OP4: other problem name : date : note : code 1 : lifecycle : 
provider : Ext Provider : code 2  
For example: 

.OP4: Wrist Sprain : 02/02/06 : From Skateboarding : 842.0 : 
Improving : ABC : AAA : 70704007 
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.OP5 other problem You can use the .OP5: code to add a problem to the other 
problem list along with the date the problem last occurred, a 
note, an ICD-9 code, the condition's status, the provider, the 
external provider, and an additional code (such as a SNOMED-
CT code). 
.OP5: other problem name : date last : note : code 1 : lifecycle : 
provider : Ext Provider : code 2 
For example: 

.OP5: Wrist Sprain : 03/02/06 : From Skateboarding : 842.0 : 
Resolved : ABC : AAA : 70704007 

.OP6 other problem You can use the .OP6: code to add a problem to the other 
problem list along with an ICD-9 code, and whether the 
problem is active or inactive.   
.OP6: other problem name : code : active  
For example: 

.OP6: Wrist Sprain : 842.0 : Inactive 

.OR orders You can use the .OR: codes (.OR to .OR5) to insert orders. 
Allowable values for "urgency" are: STAT and Routine 
.OR: order name : urgency  
For example: 

.OR: CBC : Routine 

.OR2 orders .OR2: order name : urgency : processor 
For example: 

.OR2: CBC : Routine : CMH 

.OR3 orders .OR3: order name : urgency : processor : Dx 1 : Dx 2 
For example: 

.OR3: UA : Routine : CMH : 141.23 : 123.34 

.OR4 orders .OR4: order name : urgency: processor : Send to PVID1 : Send 
to PVID 2 : Send to PVID 3 : Send to PVID 4  
For example: 

.OR4: Chem Panel : Stat : CMH : ABC : BBB : CCC : DDD 

.OR5 orders .OR5: order name : urgency : processor : Dx 1 : Dx 2 : Send to 
PVID 1 : Send to PVID 2 : Send to PVID 3 : Send to PVID 4 
 For example: 

.OR5: Chem Panel : Stat : CMH : 141.23 : 123.34 : ABC : BBB : 
CCC : DDD 
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.OR6 orders .OR6: order name : urgency: referring source ID : processor : 
Send to PVID1 : Send to PVID 2 : Send to PVID 3 : Send to PVID 
4  
For example: 

.OR6: Chem Panel : Stat : RJH : CMH : ABC : BBB : CCC : DDD 

.OR7 orders .OR7: order name : urgency : xx : processor : Send to PVID 1 : 
Send to PVID 2 : Send to PVID 3 : Send to PVID 4 
where xx is the number of days in which the order should be 
done. 
For example: 

.OR7: CBC: routine: 7: RN1: ABC 

.OR8 orders .OR8: order name : urgency : xx : processor : Dx1 : Dx2 : Send 
to PVID 1 : Send to PVID 2 : Send to PVID 3 : Send to PVID 4 
where xx is the number of days in which the order should be 
done. 
For example: 

.OR8: FSH: Routine: 7: RN1: 250.00: ABC 

.ORN orders You can use the .ORN: code to add an extended dialog. 
.ORN: label on extended dialog : text 
For example: 

.ORN: Reason : R/0 pneumonia 

Note: The .ORN: Dot code always applies to the .OR code that 
immediately precedes it. In the list above, for example, the 
extended dialog text would be pulled from the order that is 
listed in the .OR5: code. 

.ORP orders You can use the .ORP: code to add a field to the order 
processing screen. This field is accessed through the Process 
Info button. 
.ORP: field on order processing screen 
For example: 

.ORP: Reason : R/0 pneumonia 

Note: The .ORP: Dot code always applies to the .OR code that 
immediately precedes it. In the list above, for example, the 
extended dialog text would be pulled from the order that is 
listed in the .OR5: code. 
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.PP pregnancy problem You can use the .PP codes (.PP to .PP6) to add problems to the 
pregnancy problem list. Enter an .PP: code followed by the 
problem name, and optionally, a numerical code (such as an 
ICD-9-CM code), and an additional code (such as a SNOMED-
CT code).  
.PP: pregnancy problem name : code1 : code 2 
For example: 

.PP: MILD PREECLAMPSIA: 642.42: 308551004  

Note: You can use a combined total of two hundred Dot codes 
per note for other problems, diagnoses, procedures, risks, 
hospitalizations, and pregnancy problems. 

.PP2 pregnancy problem You can use the .PP2: code to include a pregnancy problem, 
along with a start date, a note about the problem, and a 
numerical code (such as an ICD-9-CM code).  
For example: 

.PP: MILD PREECLAMPSIA: 04/01/20: On bedrest: 642.42 

.PP3 pregnancy problem You can use the .PP3: code to include a pregnancy problem, 
along with an ICD-9 code, the condition's status, the provider, 
the external provider, and an additional code (such as a 
SNOMED-CT code).  
.PP3: name : code : lifecycle : Provider : Ext Provider : code 2  
For example: 

.PP: MILD PREECLAMPSIA: 642.42: Stable: ABC: RJC: 
308551004 

.PP4 pregnancy problem You can use the .PP4: code to include a pregnancy problem, 
along with a start date, a note about the problem, an ICD-9 
code, the condition's status, the provider, the extended 
provider, and an additional code (such as a SNOMED-CT code). 
.PP4: name : date : note : code 1 : lifecycle : Provider : Ext 
Provider : code 2  
For example:  

.PP: MILD PREECLAMPSIA: 04/01/07: On bedrest: 642.42: 
Stable: ABC: RJC: 308551004 

.PP5 pregnancy problem You can use the .PP5: code to include a pregnancy problem, 
along with the date the problem last occurred, a note about the 
problem, an ICD-9 code, the condition's status, the provider, 
the extended provider, and an additional code (such as a 
SNOMED-CT code).  
.PP5: name : date last : note : code 1 : lifecycle : Provider : Ext 
Provider : code 2 
For example:  

.PP: MILD PREECLAMPSIA: 04/05/07: On bedrest: 642.42: 
Stable: ABC: RJC: 308551004 
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.PP6 pregnancy problem You can use the .PP6: code to include a pregnancy problem, 
along with an ICD-9 code, and whether the problem is active or 
inactive.  
.PP6: name : date: code : active  
For example: 

.PP: MILD PREECLAMPSIA: 04/05/07: 642.42: Inactive 

.PR procedure You can use the .PR codes (.PR to .PR10) to add a procedure to 
the procedure list. Include the name, followed by one or more 
procedure codes. For example, you can use the .PR2 code to 
add a procedure to the Procedure list. Include the name, date, a 
note, and a procedure code.  
The format for the .PR code is: 
.PR: procedure name: code1: code2 

.PR: Treadmill test: 93019 

Note: You can use a combined total of two hundred Dot codes 
per note for other problems, diagnoses, procedures, risks, 
hospitalizations, and pregnancy problems. 

Note: If the Generate Encounter Form with Progress Notes 
check box is selected on the Special Features screen Records 1 
tab, an electronic encounter form will be generated from the 
.PR lines in a progress note. If diagnosis codes or modifiers are 
specified on the .PR lines, they will be used in the generated 
encounter form instead of the default diagnosis codes and 
modifiers associated with the procedure codes. 

.PR2 procedure .PR2: procedure name: date: note: code1 

.PR2: Treadmill test: 04/03/93: Normal: 93019 

.PR3 procedure .PR3: procedure name: proc. code1: dx/prob code 1 : dx/prob 
code 2 : dx/prob code 3 : dx/prob code 4 

.PR3: Office Visit Level 1 : 99121 : 560.3 : 349.3 : 456.1 : 541 

.PR4 procedure .PR4: procedure name: proc. code1: modifier1 : modifier2: 
dx/prob code 1 : dx/prob code 2 : dx/prob code 3 : dx/prob 
code 4 

.PR4: Office Visit Level 1 : 99121 : 10 : 12 : 560.3 : 349.3 : 456.1 
: 454 

.PR5 procedure .PR5: procedure name: proc. code1: rel. dx/prob # : rel. 
dx/prob code # : rel. dx/prob code # : rel. dx/prob code # 

.PR5: Office Visit Level 1 : 99121 : 3 : 1: 2 : 5 
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.PR6 procedure .PR6: procedure name: proc. code1: modifier 1: modifier 2 : rel. 
dx/prob # : rel. dx/prob code # : rel. dx/prob code # : rel. 
dx/prob code # 

.PR6: Office Visit Level 1 : 99121 : 10 : 12 : 3 : 1: 2 : 5 

.PR7 procedure .PR7: procedure name: date: note: proc. code1: dx/prob code 
1 : dx/prob code 2 : dx/prob code 3 : dx/prob code 4 

.PR8 procedure .PR8: procedure name: date: note: proc. code1: modifier1 : 
modifier2: dx/prob code 1 : dx/prob code 2 : dx/prob code 3 : 
dx/prob code 4 

.PR9 procedure .PR9: procedure name: date: note: proc. code1: rel. dx/prob # : 
rel. dx/prob code # : rel. dx/prob code # : rel. dx/prob code # 

.PR10 procedure .PR10: procedure name: date: note: proc. code1: modifier1 : 
modifier2:rel. dx/prob # : rel. dx/prob code # : rel. dx/prob 
code # : rel. dx/prob code # 
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.PV provider Every note belongs to one primary provider. When you print 
reports by provider or search for notes by provider, this is the 
one that is considered.  
However, you can have additional providers review and cosign 
the note by using the .PV line. You may include up to six 
providers on the .PV line. The .PV line must be in the first 10 
lines.  
The format for the .PV code is: 
.PV: provider ID: provider ID: provider ID  
For example:  

.PV: GPL: CLD: RMB 

Once permanently saved or loaded, the note goes into a 
signature queue for the first provider indicated in the .PV line. 
Once the first provider signs the note through the Review Data 
command on the Task Menu, it moves into the next providers 
queue, and so on.  
If You Enter a Note Within Patient Records  
The provider entering the progress note is the primary 
provider, and a .PV code is not required. If the electronic 
signature feature is set up on the Provider Maintenance screen, 
the provider can enter a signature when saving the note. The 
note belongs to this provider.  
However, the provider can use the .PV code so that other 
providers can review and co-sign the note. In this case, after all 
providers have signed the note, the note belongs to the first 
provider on the .PV line. That means if you want the note to 
belong to the entering provider, that provider must be the first 
provider on the .PV line.  
If the .PV line is used, and the provider entering the note is not 
on the .PV line, their only opportunity to sign the note is when 
they permanently save it.  

Note: Until the last provider on the .PV line signs the note, the 
note temporarily belongs to the next provider in the queue.  

If the person who wrote the note is on the .PV line, but signed 
the note when saving it, that person will not have to re-sign it 
during the Review Data process. The note simply jumps to the 
next providers signature queue.  

Note: If a provider has already signed a note, and later another 
provider edits the note, the editing provider must also sign the 
note when resaving it.  

If You Enter a Note with the Text Data Loader  
For the most part, notes loaded via the Text Data Loader work 
the same way as notes loaded directly in Patient Records with 
regards to the .PV line. However, if you are using the Text Data 
Loader, the first provider on the .PV line is always the primary 
provider. Any additional providers are cosigners.  
If there is no .PV line, then the note belongs to no provider. 
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.RK risks To add a risk to the problem list, enter an .RK: code followed by 
the risk name, a numerical code (such as an ICD-9-CM code), 
and an additional code (such as a SNOMED-CT code).  
.RK: name : code 1 : code 2 
For example: 

.RK: Social Isolation : V60.3 : 64441002 

Note: You can use a combined total of two hundred Dot codes 
per note for other problems, diagnoses, procedures, risks, 
hospitalizations, and pregnancy problems. 

.RK2 risks You can use the .RK2: code to include a risk, along with a start 
date, a note about the risk, and an ICD-9 code.  
.RK2: risk name : date : note : code 
For example: 

.RK2: Social Isolation : 01/05/06 : Lives alone : V60.3 

.RX Rx You can use the .RX: code to specify a current medication. You 
can have up to 15 .RX lines per note. This code has the 
following format:  
.RX: med name : extended sig : dur : ref  

.RX: HC 1% cream: Apply lightly tid: 14 

Note: You can use the Rx: code to specify that the patient is not 
taking any medications by entering: 
Rx: ON NO MEDICATIONS 
For the .RX: codes (.RX:, .RX2:, .RX3:, .RX4:), the variable are: 

med name Medication name 

extended sig A line of text with further Sig 
information (for example, 
apply lightly to the affected 
area); it can be left blank 

take How many to take (for 
example, 1 or 2); it can be 
left blank 

dur Duration in number of days 
(for example 7, 10). For 
chronic medications, leave 
this blank or enter a 
hyphen. For prn 
medications, enter prn 

amount Amount to dispense (for 
example, 30, 60, or 6 oz., 1 
bottle) 

ref Number of refills 
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.RX2 Rx You can use the .RX2: code to specify a current medication. This 
code has the following format: 
.RX2: med name : size : take : freq : dur : amount : ref 

.RX2: Amoxicillin: 250 mg: 1: tid: 10: 30: 0 

.RX3 Rx You can use the .RX3: code to specify a current medication. This 
code has the following format: . 
RX3: med name : dur : amount : ref 

.RX3: Amoxicillin: 10: 30: 0 

.RX4 Rx You can use the .RX4: code to specify a current medication. This 
code has the following format:  
.RX4: date : med name : size : take : freq : dur : amount : ref 

.RX4: 02/01/93: Amoxicillin: 250 mg: 1: tid: 10: 30: 0 

.RX5 Rx You can use the .RX5: code to specify a current medication. This 
code has the following format:  
.RX5: med name : size : take : freq : prn : dur : amount : ref  

.RX5: Amoxicillin: 250 mg: 1: tid: prn : 10: 30: 0 

.SIG Rx For further sig information (i.e., what to do with medications), 
you can add up to 10 .SIG: lines containing the Extended Sig 
after each .RX: note. You can have up to 10 .SIG: lines per note. 
For example:  

.SIG: Apply lightly to affected areas 

.T title (note) You can use the .T: code to enter the name (title) of the note. 
.T: Name of note 

.T: Mammog 

.TME laboratory When using the .L or .L2 codes, you can also add a .TME: line 
with the time the test was done. Only one .TME: line is allowed 
per note.  
For example:  

.TME: 10:00 am 

.TR transcriber Inserts the text 'Transcriptionist:' in a note. 
This code can be included in an uploaded text data file if you 
want to record transcriber information when replacing partial 
note markers in an existing note. 
For example: 

.TR: Smith, David 01/29/07 
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.V1 vital signs The .V1:, .V2:, and .V3: codes are used for vital signs. The .V1: 
Dot code is used for blood pressure and pulse, in the order of 
systolic blood pressure, diastolic blood pressure, and pulse. 
Please note the maximum length for the .V1: code is 20 
characters. 
On .V1:, .V2:, and .V3: lines, the data must be entered in the 
correct order, separated by colons (:). For example, on the .V1 
line, you must enter systolic BP, diastolic BP, and pulse in that 
order. The labels within the line (for example, Syst. BP, Diast. BP, 
and P.) do not have to be exact and are for guidance only.  
.V1: syst Bp value: diast Bp value: P value 
For example:  

.V1: Systolic 120: Diastolic 80: Pulse 80  

.V2 vital signs The .V2: code, used for the second vital signs line, contains 
temperature, height, and weight. Please note the maximum 
length for the .V2: code is 20 characters. 
For example:  

.V2: T 98.4: Ht. 511: Wt. 140lb  

or  

.V2: T 36.2: Ht 1.62m: Wt 60 kg  

Note: You can only enter the following units for height when 
adding the .V2 code: ", ', ft, in, or cm. For example, if you enter 
INCH as a unit it will not be recognized.  

.V3 vital signs The .V3: code, used for the third vital signs line, contains OFC 
and other information. Please note the maximum length for the 
.V3: code is 20 characters. 
For example:  

.V3: OFC 44: Other 20  

.V4 vital signs The .V4: Dot code is used to record respiratory rate and 
oximetry measurements. Please note the maximum length for 
the .V4: code is 20 characters. 
For example: 

 .V4: 22 : 100 

.V5  vital signs The .V5: code is used to record user-defined vital signs and 
contains the vital sign name, results, and whether the result was 
normal or abnormal. Please note the maximum length for the 
name field is 30, the result field is 20, and the normal / 
abnormal value is 1. 
For example:  

.V5: Other : Refused : n 
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.V6  vital signs The .V6: code is used to record user-defined vital signs and 
contains the vital sign name, results, units, and whether the 
result was normal or abnormal. Please note the maximum 
length for the .V6: code is 7 characters. 
For example:  

.V6: Left Foot : 31 : cm : n 

.VT visit time The .VT code is used to specify the visit time. The entered value 
is the visit duration in minutes.  
The time entered for the code will populate the Evaluation and 
Management Coding Result screens visit time field (i.e., The 
duration of the visit was xx minutes field). If the value entered is 
not an integer or is greater than 3 digits, it will not be entered in 
this field.  
.VT: <visit duration in minutes> 
For example: 

.VT: 45 
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E and M Coding 
When billing for a patient visit, physicians are required to provide a CPT code that best represents the 
evaluation and management services provided to the patient during the visit or consultation (E&M 
code). 

Patient Records can automatically calculate the appropriate E&M code for a visit, based on 
documentation in a progress note. You can define the services provided by adding E&M code labels 
from the Centers for Medicaid and Medicare Services (CMS) 1995 or 1997 E&M coding guidelines to a 
patient's progress notes. For best results you should incorporate the E&M coding labels into any note 
templates and QuickText that you currently use. 

When progress notes are saved, the system calculates the appropriate E&M code based on the E&M 
coding labels in the note. If not enough information is available to determine the code, or if you want to 
modify or refine the results, you can specify additional information in the Evaluation and Management 
Coding Results screen and recalculate the code. 

Note: To use E&M coding in notes, your system administrator must select the Use E&M Coding 
Assistance check box in the Special Features screen. 

To enable E&M coding in Patient Records: 

1. Open the patient's progress note. 

2. Add E&M coding labels to the note for each service provided to the patient. 

3. Save the note. 

4. If required, use the Evaluation and Management Coding Results screen to provide additional 
information or refine the coding results. 

5. When complete, the relevant CPT code is calculated and added to the progress note using a 
.PR dot code. 

Disclaimer: The E and M (Evaluation and Management) code advisor suggests Evaluation and 
Management codes according to rules that may be based on incomplete or not fully accurate 
information. The E and M code advisor is provided as a convenience to physicians and staff and should 
not be relied upon as always suggesting the correct code for any particular situation. Physicians and 
staff must apply their judgment and training to determine proper Evaluation and Management codes. 
Lytec MD disclaims all warranties, whether expressed or implied, regarding the suggested Evaluation 
and Management codes. 

How does Patient Records calculate the CPT® code? 
When a progress note or template containing at least one E&M label is saved, Patient Records analyzes 
the number and types of E&M labels in the note to determine the appropriate CPT®  code for the visit. 
Patient Records considers the following elements of evaluation and management services to calculate 
the appropriate CPT®  code for a patient's visit: 

• History 

• Physical Examination 

• Medical Decision Making 

• Additional Factors 

Note: You can refine the information used to determine the values of each of these elements through 
the Evaluation and Management Coding Results screen. 
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History 
The level of E&M service for the history element is determined by: 

• Chief complaint 

• History of present illness (HPI): A chronological description of the patient's illness from the first 
sign or symptom or from the previous encounter to the present.  
 
The history can be characterized as brief or extended, depending on how many of the following 
elements are present: location, quality, severity, duration, timing, context, modifying factors, and 
associated signs and symptoms. 

• Review of systems (ROS): An inventory of body systems obtained through a series of questions to 
identify signs or symptoms the patient may be or has experienced. 
 
The review of systems can be characterized as problem pertinent, extended, or complete, 
depending on how may of the following systems are affected: constitutional symptoms, eyes, 
ears/nose/mouth/throat, cardiovascular, respiratory, gastrointestinal, genitourinary, 
musculoskeletal, integumentary, neurological, psychiatric, endocrine, hematologic/lymphatic, 
and allergic/immunologic. 

• Past, family, and/or social history (PFSH): A review of the patient's past, family, and/or social 
history. 
 
The PFSH can be characterized as pertinent or complete, depending on the level of review. A 
pertinent PFSH is a review of the history area directly related to the problem(s) identified in the 
HPI. A complete PFSH is a review of two or all three history areas, depending on the category of 
E&M service. Two history areas are sufficient for most services, except for services that include a 
comprehensive assessment or re-assessment of the patient. 

Lytec MD uses these components to establish the type of history: Problem Focused, Expanded 
Problem Focused, Detailed, or Comprehensive. The table below illustrates the relationship between 
the history components and the history type. To qualify for a type of history, all three components in 
the table must be met.  

History of Present 
Illness (HPI) 

Review of Systems 
(ROS) 

Past, Family, and/or 
Social History (PFSH) 

Type of History 

Brief 
1-3 elements 

n/a n/a Problem Focused 

Brief 
1-3 elements 

Problem Pertinent 
ROS inquires about the 
system directly related 
to problem(s) 
identified in the HPI 

n/a Expanded Problem 
Focused 

Extended 
Four or more elements 

Extended 
ROS inquires about the 
system directly related 
to problem(s) 
identified in the HPI 
and a limited number 
of additional systems 

Pertinent 
Review of the history 
area directly related to 
problem(s) identified 
in the HPI 

Detailed 
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Extended 
Four or more elements 

Complete 
ROS inquires about the 
system directly related 
to problem(s) 
identified in the HPI 
plus all additional 
body systems 

Complete 
A review of two or all 
three history areas, 
depending on the 
category of E&M 
service 

Comprehensive 

Note: If Patient Records cannot establish the type of history based on the E&M labels in a note, you can 
provide additional information in the History Result screen, accessed from the Evaluation and 
Management Coding Results screen. 

Physical Examination 
The level of E&M service for the physical examination element is based on the following types of 
examinations: 

• Problem focused: A limited examination of the affected body area or organ system. 

• Expanded problem focused: A limited examination of the affected body area or organ system 
and other symptomatic or related organ systems. 

• Detailed: An extended examination of the affected body area or organ system and other 
symptomatic or related organ systems. 

• Comprehensive: A general multi-system examination or complete examination of a single organ 
system. 

The body areas are recognized as: head and face, neck, chest (breasts and axillae), abdomen, genitalia 
(groin, buttocks), back and spine, and each extremity. 

The organ systems are recognized as: constitutional, eyes, ears/nose/mouth/throat, cardiovascular, 
respiratory, gastrointestinal, genitourinary, musculoskeletal, skin, neurologic, psychiatric, and 
hematologic/lymphatic/immunologic. 

Two sets of E&M coding guidelines (1995 and 1997) are available from CMS, each defining different 
physical examination codes. You can add E&M coding labels to a progress note from one or both 
guidelines. The value of the E&M Guideline field in the Special Features screen determines which 
guideline to use when calculating the final CPT code. If you select Use whichever guideline is most 
favorable, then two separate codes are calculated using the 1995 and 1997 guidelines, and the higher 
code is added to the progress note. As such, if this option is selected, ensure that both the relevant 
1995 and 1997 E&M coding labels are added to progress notes so that both codes can be calculated 
accurately. 

Note: If Patient Records cannot establish the physical examination level, based on E&M labels in a 
note, you can provide additional information in the Physical Examination Result screen, accessed from 
the Evaluation and Management Coding Results screen. 

Medical Decision Making 
Medical decision making refers to the complexity of establishing a diagnosis and/or selecting a 
management option, as determined by: 

• The number of possible diagnoses and/or the number of management options that must be 
considered. 

• The amount and/or complexity of medical records, diagnostic tests, and/or other information 
that must be obtained, reviewed, and analyzed. 

• The risk of significant complications, morbidity, and/or mortality associated with the patient's 
presenting problems, the diagnostic procedures, and the possible management options. 
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Lytec MD uses these components to establish the type of decision making: Straightforward, Low 
Complexity, Moderate Complexity, and High Complexity. The table below illustrates the relationship 
between the decision making components and the decision making type. 

Number of diagnoses 
or management 
options 

Amount and/or 
complexity of data to 
be reviewed 

Risk of complications 
and/or morbidity or 
mortality 

Type of Decision 
Making 

Minimal Minimal or None Minimal Straightforward 

Limited Limited Low Low Complexity 

Multiple Moderate Moderate Moderate Complexity

Extensive Extensive High High Complexity 

Note: If Patient Records cannot establish the medical decision making level, based on the E&M labels 
in a note, you can provide additional information in the Physical Examination Result screen, accessed 
from the Evaluation and Management Coding Results screen. 

Additional Factors 
The following additional factors can affect the CPT code calculated by Patient Records: 

• Type of Patient 

• Type of Visit 

• Time of Visit 

Type of Patient 

Different CPT Codes apply depending on whether the patient is a new or established patient. Patient 
Records automatically determines whether the patient is new or established, based on whether there 
are existing progress notes for the patient. 

A patient is considered new if there are no existing progress notes for the patient, the last progress 
note is more than 3 years old, or the only progress notes in the past three years are titled Canceled or 
No Show. Otherwise the patient is considered an existing patient. 

Note: You can change the patient type when using the Evaluation and Management Coding Results 
screen to refine the E&M coding results. 

Type of Visit 

Different CPT codes apply depending on whether the patient's visit was an office visit or consultation. 
The default type of visit is determined by the value of the Default Visit Type field in the Special 
Features screen. 

Note: You can change the type of visit when using the Evaluation and Management Coding Results 
screen to refine the E&M coding results. 

Time of Visit 

Time can be considered a factor when calculating the CPT®  code if the over half of the visit was spent in 
counseling or coordination of care. 

You can specify that time should be considered by selecting the >50% of face to face time spent in 
counseling or coordination of care check box and entering the length of the appointment in the The 
duration of the visit was [] minutes box in the Evaluation and Management Coding Results screen. 
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When this check box is selected, Lytec MD uses the duration of the appointment to calculate a CPT 
code. If this code is higher than the code calculated based on the E&M labels in the progress note, 
then the time-based code is used. 

List of CPT Codes 
When all factors have been considered, Lytec MD assigns one of the following CPT®  codes for the visit 
and adds it to the progress note: 

Code Description 

99201 Office visit level 1, new patient 

99202 Office visit level 2, new patient 

99203 Office visit level 3, new patient 

99204 Office visit level 4, new patient 

99205 Office visit level 5, new patient 

99211 Office visit level 1, established patient 

99212 Office visit level 2, established patient 

99213 Office visit level 3, established patient 

99214 Office visit level 4, established patient 

99215 Office visit level 5, established patient 

99241 Consultation visit level 1 

99242 Consultation visit level 2 

99243 Consultation visit level 3 

99244 Consultation visit level 4 

99245 Consultation visit level 5 

Note: "CPT" is a registered trademark of the American Medical Association. 

Adding E&M Labels 
E&M coding labels can be added to progress notes to record the components of evaluation and 
management services provided during a patient visit or consultation, such as reviewing information 
with the patient, performing a physical examination, and making diagnoses.  

When a progress note is saved, Patient Records uses the E&M labels added to a note to calculate the 
relevant CPT code for the patient visit. If not enough information is available from the labels, the 
Evaluation and Management Coding Results screen appears when the note is saved, so that you can 
provide additional information that can be used to calculate the code. 

Note: Your system administrator can use the UseTitle= setting in the ppart.ini file to specify whether 
E&M labels in the progress note's title are be considered when calculating the CPT® code. For most 
sites, we recommend that this setting () be turned on. 

You can either select the E&M labels to insert from the Insert E&M Label screen, from the Insert menu, 
or type them directly into the note. The appropriate E&M codes are also automatically added to notes 
when you use the following insert codes: .IFH (insert family history), .IPH (insert past history), and .ISH 
(insert social history). 

In the progress notes, Patient Records uses † to mark the start of the label and ‡ to mark the end of the 
label. For example, the E&M label for past medical history is †P1‡. Depending on system settings, the † 
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‡ markers may or may not be visible on screen. Labels are displayed in the color selected from the 
E&M Labels Color list in the Special Features screen. 

Note: E&M coding also takes into account any prescriptions added for the note. Please note that over-
the-counter medication is not considered when Lytec MD calculates the final E&M code results. 

About E&M coding guidelines 
Two sets of E&M coding guidelines (1995 and 1997) are available from CMS, each defining different 
ways of determining the level of physical examination. You can add E&M coding labels to a progress 
note from one or both guidelines. The value of the E&M Guideline field in the Special Features screen 
determines which guideline to use when calculating the final CPT code. 

If you select Use whichever guideline is most favorable, then two separate codes are calculated 
using the 1995 and 1997 guidelines, and the higher code is used. As such, if this option is selected, 
ensure that both the relevant 1995 and 1997 E&M coding labels are added to progress notes so that 
both codes can be calculated accurately. 

If you want to insert additional guideline version information when the CPT code is added to a progress 
note, select the Add E&M Calculation Details to Note check box in the Special Features screen. A 
line describing the guideline version used to calculate the CPT code is automatically added to the 
progress note. In addition, if the 1997 guideline was used, then a second line listing the relevant 
Physical Exam Type from the guideline is also added to the progress note. 

See the list of E&M Labels for a complete set of labels associated with each guideline. 

Procedures for adding, editing, and deleting E&M labels 
To insert an E&M label in a progress note: 

1. Open the progress note and place the cursor at the point where you want to insert the E&M 
coding label. 

2. Do one of the following: 
• Select Insert > EM Label, and then navigate through the sub-menus to select the 

appropriate label. 

• Click the EM Codes button and select the label from the list on the Insert EM Label 
screen. You can use this screen to select multiple labels. Double-click each label you want 
to add, or highlight the label and click the Apply button. When you finish, click the Close 
button to return to the note. 

• Type the label code directly in the note, using † to mark the start of the code and ‡ to 
mark the end of the code. To add an open label character (†), hold the ALT key and type 
0134. To add a close label character (‡), hold the ALT key and type 0135. 

3. Click OK to save the note or template. A confirmation message appears, asking if you are 
permanently done with the note. 

4. Click OK. 

5. If this is the first time the note was saved, or the system cannot determine the appropriate code 
from the labels in the note, the Evaluation and Management Coding Results screen appears. 
Use this screen to provide additional information that can be used to calculate the CPT code. 

Note: To turn on E&M coding when editing an existing note, selecting Edit > Recalculate E&M 
Code. 
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To show or hide E&M labels in progress notes: 

• Select Edit > Show E&M Labels or Hide E&M Labels. 

Note: Depending on the DisplayEMLabels= setting in the ppart.ini file, the E&M labels may or may 
not be visible when a progress note is added or edited. When E&M labels are hidden in the note, 
they may be accidentally deleted, so we recommend making them visible. When you print or view 
a note, E&M labels do not appear. 

To delete an E&M label from a note: 

1. Open the note, and click the Edit button. 

2. Highlight the E&M label in the note and press the Delete key. 

3. Click OK to save the note. 

Note: If, after deleting a label, the system cannot calculate the CPT code based on the remaining 
labels in the note, the Evaluation and Management Coding Results screen will appear so that you 
can provide more information. 

List of E&M Labels 
The table below lists the E&M labels that can be added to progress notes, templates, and QuickText in 
Patient Records. The following categories of E&M Labels are available: 

• Chief complaint 

• History of present illness 

• Review of systems 

• Past, family, social history 

• PE per 1995 documentation guidelines 

• PE per 1997 documentation guidelines 

• Diagnosis/treatment 

• Information review 

Category Subcategory Code 

Chief complaint  C1 

History of present 
illness 

HPI location H1 

HPI quality H2 

HPI severity H3 

HPI duration H4 

HPI timing H5 

HPI context H6 

HPI modifying factors H7 

HPI associated signs and symptoms H8 

Review of  
systems 

ROS constitutional R1 

ROS eyes R2 

ROS ears, nose, mouth, throat R3 

ROS cardiovascular R4 
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ROS respiratory R5 

ROS gastrointestinal R6 

ROS genitourinary R7 

ROS musculoskeletal R8 

ROS skin and/or breasts R9 

ROS neurological R10 

ROS psychiatric R11 

ROS endocrine R12 

ROS hematologic/lymphatic R13 

ROS allergic/immunologic R14 

Past, family,  
social history 

Past history P1 

Family history P2 

Social history P3 

PE per 1995 
documentation 
guidelines 

PE body area PE head E1 

PE neck E2 

PE chest and breasts E3 

PE abdomen E4 

PE genitalia and buttocks E5 

PE back E6 

PE left upper extremity E7 

PE right upper extremity E8 

PE left lower extremity E9 

PE right lower extremity E10 

PE organ 
system 

PE constitutional O1 

PE eyes O2 

PE ears, nose, mouth, throat O3 

PE cardiovascular O4 

PE respiratory O5 

PE gastrointestinal O6 

PE genitourinary O7 

PE musculoskeletal O8 

PE skin O9 

PE neurological O10 

PE psychiatric O11 

PE hematologic/lymphatic/immunologic O12 

PE per 1997 
documentation 
guidelines 

General 
Multisystem 

Constitutional PE 3+ Vitals PC1 

PE General 
Appearance 

PC2 

Eyes PE Conjunctivae/Lids PE3 
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PE Pupils/Irises PE6 

PE Ophthalmoscopy 
Optic Discs/Posterior 
Segments 

PE12 

ENMT PE Inspection 
Ears/Nose 

PN1 

PE Otoscopy PN2 

PE Hearing PN4 

PE Nasal Mucosae PN5 

PE Inspection 
Lips/Teeth/Gums 

PN6 

PE Oropharynx PN9 

Neck PE Neck PK1 

PE Thyroid PK3 

Respiratory PE Respiratory Effort PR1 

PE Chest Percussion PR3 

PE Chest Palpation PR4 

PE Lung Auscultation PR5 

Cardiovascular PE Heart Palpation PV1 

PE Heart Auscultation PV2 

PE Carotids PV5 

PE Abdominal Aorta PV6 

PE Femoral aa. PV7 

PE Pedal Pulses PV8 

PE Extremities 
edema/varicosities 

PV9 

Breasts PE Breast Inspection PB2 

PE Breast Palpation PB3 

Gastrointestinal PE Abdominal 
mass/tenderness 

PG1 

PE Liver/Spleen PG2 

PE Herniae PG3 

PE Anus/Rectum PG4 

PE Stool for Occult 
Blood 

PG5 

Genitourinary PE Scrotal Contents  PU2 

PE Penis  PU6 

PE Prostate via DRE  PU8 

PE Female External 
Genitalia 

PU11 

PE Female Urethra PU12 
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PE Female Bladder PU14 

PE Cervix  PU16 

PE Uterus  PU17 

PE Adnexae  PU18 

Lymphatic PE Lymphatic Neck  PL2 

PE Lymphatic Axillae  PL3 

PE Lymphatic Groin  PL4 

PE Lymphatic Other  PL5 

Musculoskeletal PE Gait/Station  PM1 

PE Digits/Nails  PM6 

PE Head/Neck 
Inspection/Palpation 

PM7 

PE Head/Neck ROM  PM8 

PE Head/Neck Stability  PM9 

PE Head/Neck 
Strength/Tone  

PM10 

PE Spine/Ribs/Pelvis 
Inspection/Palpation  

PM11 

PE Spine/Ribs/Pelvis 
ROM  

PM12 

PE Spine/Ribs/Pelvis 
Stability  

PM13 

PE Spine/Ribs/Pelvis 
Strength/Tone 

PM14 

PE RUE 
Inspection/Palpation  

PM16 

PE RUE ROM  PM17 

PE RUE Stability  PM18 

PE RUE Strength/Tone  PM19 

PE LUE 
Inspection/Palpation  

PM20 

PE LUE ROM  PM21 

PE LUE Stability  PM22 

PE LUE Strength/Tone  PM23 

PE RLE 
Inspection/Palpation  

PM24 

PE RLE ROM  PM25 

PE RLE Stability  PM26 

PE RLE Strength/Tone  PM27 

PE LLE 
Inspection/Palpation  

PM28 

PE LLE ROM  PM29 
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PE LLE Stability  PM30 

PE LLE Strength/Tone  PM31 

Skin PE Skin Inspection  PS1 

PE Skin Palpation  PS2 

Neurologic PE Cranial Nerves  PQ1 

PE Deep Tendon 
Reflexes  

PQ10 

PE Sensation  PQ11 

Psychiatric PE Judgment/Insight  PY1 

PE Orientation  PY2 

PE Memory  PY3 

PE Mood/Affect  PY4 

Organ system-
specific 

Constitutional PE 3+ Vitals  PC1 

PE General 
Appearance  

PC2 

PE Voice/Ability to 
communicate  

PC3 

Head and Face PE Head/Face 
Inspection  

PH1 

PE Face 
Palpation/Percussion  

PH2 

PE Salivary Glands  PH3 

PE Facial Strength  PH4 

Eyes PE Visual Acuity  PE1 

PE Visual Fields by 
Confrontation  

PE2 

PE Conjunctivae/Lids  PE3 

PE Conjunctivae  PE4 

PE Ocular Adnexae  PE5 

PE Pupils/Irises  PE6 

PE Ocular 
Motility/Alignment  

PE7 

PE Slit Lamp Corneas  PE8 

PE Slit Lamp Anterior 
Chambers  

PE9 

PE Slit Lamp Lenses  PE10 

PE Intraocular 
Pressures  

PE11 

PE Ophthalmoscopy 
Optic Discs/Posterior 
Segments  

PE12 
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PE Dilated 
Ophthalmoscopy Optic 
Discs  

PE13 

PE Dilated 
Ophalmoscopy 
Posterior Segments  

PE14 

ENMT PE Inspection 
Ears/Nose  

PN1 

PE Otoscopy  PN2 

PE Otoscopy/Pneumo-
Otoscopy  

PN3 

PE Hearing  PN4 

PE Nasal Mucosae  PN5 

PE Inspection 
Lips/Teeth/Gums  

PN6 

PE Teeth/Gums/Palate  PN7 

PE Inspection 
Teeth/Gums  

PN8 

PE Oropharynx  PN9 

PE Pharyngeal 
Walls/Sinuses  

PN10 

PE Mirror Exam Larynx  PN11 

PE Mirror Exam 
Nasopharynx  

PN12 

PE Oral Mucosa for 
pallor/cyanosis 

PN13 

Neck PE Neck  PK1 

PE Jugular vv.  PK2 

PE Thyroid  PK3 

Respiratory PE Respiratory Effort  PR1 

PE Chest Inspection  PR2 

PE Chest Percussion  PR3 

PE Chest Palpation  PR4 

PE Lung Auscultation  PR5 

Cardiovascular PE Heart Palpation  PV1 

PE Heart Auscultation  PV2 

PE Blood Pressure in 2 
extremities 

PV3 

PE Peripheral Vascular  PV4 

PE Carotids  PV5 

PE Abdominal Aorta  PV6 

PE Femoral aa.  PV7 
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PE Pedal Pulses  PV8 

PE Extremities 
edema/varicosities 

PV9 

Breasts PE Breast 
Inspection/Palpation 

PB1 

Gastrointestinal PE Abdominal 
mass/tenderness 

PG1 

PE Liver/Spleen  PG2 

PE Herniae  PG3 

PE Stool for Occult 
Blood  

PG5 

Genitourinary PE Anus Inspection  PU1 

PE Scrotum  PU3 

PE Epididymes  PU4 

PE Testes  PU5 

PE Penis  PU6 

PE Urethral Meatus, 
Male  

PU7 

PE Prostate via DRE  PU8 

PE Seminal Vesicles via 
DRE  

PU9 

PE Sphincter/Rectum 
via DRE  

PU10 

PE Female External 
Genitalia  

PU11 

PE Female Urethra  PU12 

PE Female Urethral 
Meatus  

PU13 

PE Female Bladder  PU14 

PE Vagina  PU15 

PE Cervix  PU16 

PE Uterus  PU17 

PE Adnexae  PU18 

Lymphatic PE Lymph Nodes  PL1 

Musculoskeletal PE Gait/Station  PM1 

PE Gait/Exercise 
Capacity  

PM2 

PE Muscle 
Strength/Tone  

PM3 

PE Muscle Strength 
LE/UE  

PM4 

PE Muscle Tone LE/UE  PM5 
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PE Digits/Nails  PM6 

PE Head/Neck 
Inspection/Palpation 

PM7 

PE Head/Neck ROM  PM8 

PE Head/Neck Stability  PM9 

PE Head/Neck 
Strength/Tone  

PM10 

PE Spine/Ribs/Pelvis 
Inspection/Palpation  

PM11 

PE Spine/Ribs/Pelvis 
ROM  

PM12 

PE Spine/Ribs/Pelvis 
Stability  

PM13 

PE Spine/Ribs/Pelvis 
Strength/Tone 

PM14 

PE Back for 
Scoliosis/Kyphosis  

PM15 

PE RUE 
Inspection/Palpation  

PM16 

PE RUE ROM  PM17 

PE RUE Stability  PM18 

PE RUE Strength/Tone  PM19 

PE LUE 
Inspection/Palpation  

PM20 

PE LUE ROM  PM21 

PE LUE Stability  PM22 

PE LUE Strength/Tone  PM23 

PE RLE 
Inspection/Palpation  

PM24 

PE RLE ROM  PM25 

PE RLE Stability  PM26 

PE RLE Strength/Tone  PM27 

PE LLE 
Inspection/Palpation  

PM28 

PE LLE ROM  PM29 

PE LLE Stability  PM30 

PE LLE Strength/Tone  PM31 

Skin PE Skin Inspection or 
Palpation  

PS3 

PE Palpation 
Scalp/Inspection Hair  

PS4 

PE Skin Inspection or 
Palpation Head/Neck  

PS5 
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PE Skin Inspection or 
Palpation Head 

PS6 

PE Skin Inspection or 
Palpation Neck 

PS7 

PE Skin Inspection or 
Palpation Trunk 

PS8 

PE Skin Inspection or 
Palpation Chest  

PS9 

PE Skin Inspection or 
Palpation Back 

PS10 

PE Skin Inspection or 
Palpation Abdomen  

PS11 

PE Skin Inspection or 
Palpation 
Genitalia/Buttocks  

PS12 

PE Skin Inspection or 
Palpation RUE  

PS13 

PE Skin Inspection or 
Palpation LUE  

PS14 

PE Skin Inspection or 
Palpation RLE  

PS15 

PE Skin Inspection or 
Palpation LLE  

PS16 

PE Inspection 
Eccrine/Apocrine 
Glands  

PS17 

Neurologic PE Cranial Nerves  PQ1 

PE Cranial Nerve 2  PQ2 

PE Cranial Nerves 3, 4, 
6  

PQ3 

PE Cranial Nerve 5  PQ4 

PE Cranial Nerve 7  PQ5 

PE Cranial Nerve 8  PQ6 

PE Cranial Nerve 9  PQ7 

PE Cranial Nerve 11  PQ8 

PE Cranial Nerve 12  PQ9 

PE Deep Tendon 
Reflexes  

PQ10 

PE Sensation  PQ11 

PE Coordination  PQ12 

Psychiatric PE Judgment/Insight  PY1 

PE Orientation  PY2 

PE Memory  PY3 
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PE Mood/Affect  PY4 

PE Attention  PY5 

PE Language  PY6 

PE Fund of Knowledge  PY7 

PE Speech  PY8 

PE Thought Processes  PY9 

PE Associations  PY10 

PE Abnormal Thoughts  PY11 

Diagnosis/ 
treatment 

Review and/or order clinical lab tests D1 

Review and/or order radiology tests D2 

Review and/or order other tests D3 

Discussion of test results with performing physician D4 

Decision to obtain old records and/or obtain history from 
someone other than patient 

D5 

Information 
review 

Review/summarize old records and/or obtain history from 
someone other than patient and/or discussion of case with 
another health care provider 

I1 

Independent visualization of image, tracing, or specimen itself I2 

Evaluation and Management Coding Results screen 
If the Use E&M Coding Assistance option is selected in the Special Features screen, or if Lytec MD 
cannot determine the appropriate CPT code for a patient visit from the E&M labels in a progress note, 
the Evaluation and Management Coding Results screen is automatically displayed when the note is 
saved so that you can provide additional information. 

You can use the screen to modify the patient type or visit type, or to specify the duration of the visit. 
Clicking the Modify buttons in the History Result, Physical Examination Result, or Medical Decision 
Making Result (MDMC) areas opens a new screen in which you can select any additional E&M code 
labels that apply to the visit.  

You can also click the Refine button to enter information in the E&M Coding Additional Questions 
screen or click the Coding Help button to access the Expanded Coding Assistance screen, which 
allows you to see the impact on the CPT code when you change the history, physical exam, or medical 
decision making results. 

When you have provided additional information, the relevant CPT code is calculated and displayed in 
the top of the screen. You can then click OK to close the screen and add the code and appropriate .PR 
description to the progress note. 

Procedures for accepting or refining coding results 

To open the Evaluation and Management Coding Results screen: 

The Evaluation and Management Coding Results screen is displayed automatically when you save a 
new progress note containing E&M labels. It is also displayed if insufficient information was available in 
a progress note to calculate the CPT code. 
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Note: To calculate the E&M code when editing an existing progress note, select Edit > Recalculate 
E&M Code. The Evaluation and Management Coding Results screen will be displayed when you save 
the note. 

To accept the CPT code result: 

• If a CPT code is displayed and the information in the rest of the Evaluation and Management 
Coding Results screen is accurate, click OK to accept the code and add it to the progress note 
through a .PR dot code. 

To refine the CPT code result: 

1. Review the information on the Evaluation and Management Coding Results screen. 

2. If required, change the Patient Type. 

3. If required, change the Visit Type. 

4. If more than 50% of the appointment was spent in counseling or coordination of care, select 
the >50% of face to face time spent in counseling or coordination of care check box and 
optionally type the length of the appointment in the The duration of the visit was [] minutes 
box. 

5. If the code could not be calculated, a question mark will be displayed in one or more of the 
History Result, Physical Examination Result, or Medical Decision Making Result (MDMC) 
areas. Click the Modify button in relevant area to provide additional information in the History 
Result, Physical Examination Result, or Medical Decision Making (MDMC) Result screens. 

6. To provide additional information, click the Refine button and complete the questions in the 
E&M Coding Additional Questions screen. 

7. Click the Refresh button to view the result of your changes on the CPT code. 

8. Click OK to close the screen and add the CPT code to the current progress note. 

To get more coding help: 

• Click the Coding Help button. The Expanded Coding Assistance screen appears. 

Fields on the Evaluation and Management Coding Results screen 

Field Description 

E&M Code Displays the current CPT code that will be inserted in the 
progress note. 
If not enough information is available to calculate the code, 
'E&M code cannot be determined for new/established patient 
based on the following' is displayed, and you must provide 
more information. 
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Patient Type Select either New or Established to describe the patient. 
This option is unavailable if Consultation is selected as the Visit 
Type. 

Note: Patient Records automatically determines whether the 
patient is new or established, based on whether there are 
existing progress notes for the patient. A patient is considered 
new if there are no existing progress notes for the patient, the 
last progress note is more than 3 years old, or the only progress 
notes in the past three years are titled Cancelled or No Show. 
Otherwise the patient is considered an existing patient. For 
more information on how the patient type can affect the 
calculations of the CPT code, see the E&M Coding Overview 
topic. 

Visit Type Select the type of visit, either Office Visit or Consultation. 

Note: The default type of visit is determined by the value of the 
Default Visit Type field in the Special Features screen. For 
more information on how the visit type can affect the 
calculations of the CPT code, see the E&M Coding Overview 
topic. 

>50% of face to face time spent in 
counseling or coordination of care 
check box 

Select this check box if more than half of the visit duration was 
spent in counseling or coordination of care. 
If the check box is selected, you can enter a number in the The 
duration of the visit was [] minutes box.  

Note: For more information on how the visit duration can affect 
the calculations of the CPT code, see the E&M Coding 
Overview topic. 

History Result Displays one of the following history levels: 
 Problem Focused 
 Expanded Problem Focused 

 Detailed 
 Comprehensive 

If not enough information is available to determine the history 
result, a question mark (?) is displayed.  
To provide additional patient history information, click the 
Modify button to open the History Result screen. 

Note: For more information on how the history result level is 
determined, see the E&M Coding Overview topic. 
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Physical Examination Result Displays one of the following physical examination levels: 
 Problem Focused 

 Expanded Problem Focused 
 Detailed 

 Comprehensive 
If not enough information is available to determine the Physical 
Examination result, a question mark (?) is displayed. 
To provide additional physical examination information, click 
the Modify button to open the Physical Examination Result 
screen and select any additional physical examinations 
performed during the appointment. 

Note: For more information on how the physical examination 
result is determined, see the E&M Coding Overview topic. 

Medical Decision Making Result 
(MDMC) 

Displays one of the following medical decision-making result 
levels: 

 Straightforward 
 Low complexity 

 Moderate complexity 
 High complexity 

If not enough information is available to determine the Physical 
Examination result, a question mark (?) is displayed.  
To provide additional medical decision-making information, 
click the Modify button to open the Medical Decision Making 
(MDMC) Result screen. 

Note: For more information on how the medical decision 
making result level is determined, see the E&M Coding 
Overview topic. 

Refine button Click to open the E&M Coding Additional Questions screen and 
provide additional information that can be used to refine the 
CPT code. 

Coding Help button Click to open the Expanded Coding Assistance screen which 
can be used to view the impact on the CPT code when you 
change the history, physical exam, or medical decision making 
results. 

 

Expanded Coding Assistance screen 
The Expanded Coding Assistance screen displays the original CPT code calculated by Patient Records, 
and allows you to view the impact on the code when you change the combination of history, physical 
exam, and medical decision making results. 

You can also use the Modify buttons to select additional E&M code labels for services provided during 
the patient visit or consultation, and view the impact on the CPT code before deciding whether to 
retain or discard your changes. 
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Procedures for accepting or refining coding results 

To open the Expanded Coding Assistance screen: 

• Click the Coding Help button in the Evaluation and Management Coding Results screen. 

To view tentative CPT codes for different combinations of results: 

• Click the relevant buttons in the History, Physical Examination, and MDMC areas to change the 
combination of results. A tentative CPT code is displayed in the Tentative E&M Code field at the 
top of the screen to reflect your changes. 

Note: Clicking buttons in the History, Physical Examination, and MDMC areas does not change the 
actual results or the actual code calculated by Lytec MD, it only displays what the code would be if 
the actual results matched your selections. 

To modify history, physical exam, or medical decision making results: 

1. Click the Modify button in the History, Physical Examination, and MDMC areas. 

2. Use the History Result, Physical Examination Result, or Medical Decision Making (MDMC) 
Result screens to select any additional E&M code labels that apply to the patient visit or 
consultation, and then click OK to return to the Expanded Coding Assistance screen. 

3. Click the Refresh button to view the impact of your changes on the CPT code. The updated 
CPT code is displayed in the Modified E&M Coding Level field. 

4. Click Close to save your changes, accept the new code, and return to the Evaluation and 
Management Coding Results screen. To discard your changes, click the Original button. 

Fields on the Evaluation and Management Coding Results screen 

Field Description 

Original E&M Coding Level Displays the original CPT code calculated based on the E&M 
labels in the progress note. 

Tentative E&M Coding Level Displays a tentative CPT code based on the results currently 
selected in the History, Physical Examination, and MDMC 
areas. 

Note: This field only indicates what the CPT code would be if 
the History, Physical Examination, and MDMC results were 
equal to those you have selected in this screen. It does not 
indicate the CPT code that will be entered into the progress 
note. To actually change the History, Physical Examination, and 
MDMC results, click the Modify button in the relevant area and 
select the options that apply to the patient visit or consultation. 

Modified E&M Coding Level Displays the modified CPT code, based on any changes you 
have made using the Modify buttons in this screen. 
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History area Click a history result to display a tentative CPT code in the 
Tentative E&M Coding Level field. This indicates what the CPT 
code would be if the history result was equal to your selection. 
Click the Modify button to open the History Result screen and 
provide any additional history information. 

Note: For more information on how the history result level is 
determined, see the E&M Coding Overview topic. 

Physical Examination area Click a physical examination result to display a tentative CPT 
code in the Tentative E&M Coding Level field. This indicates 
what the CPT code would be if the physical examination result 
was equal to your selection. 
Click the Modify button to open the Physical Examination 
Result screen and select any additional physical examinations 
performed during the visit. 

Note: For more information on how the physical examination 
result is determined, see the E&M Coding Overview topic. 

MDMC area Click an MDMC result to display a tentative CPT code in the 
Tentative E&M Coding Level field. This indicates what the CPT 
code would be if the MDMC result was equal to your selection. 
Click the Modify button to open the Medical Decision Making 
(MDMC) Result screen and provide any provide additional 
medical decision-making information. 

Note: For more information on how the medical decision 
making result level is determined, see the E&M Coding 
Overview topic. 

Original button Click to return the screen to its original state. Any modifications 
you made in this screen, including changes made after clicking 
the Modify buttons will be lost. 

Refresh button Click to highlight (in pink) the current History, Physical 
Examination, and MDMC results, based on selections made 
after clicking the Modify buttons. 

E&M Coding Additional Questions screen 
The E&M Coding Additional Questions screen enables you to provide additional information that can 
be used to refine the CPT code calculated by Patient Records in the Evaluation and Management 
Coding Results screen. 

To open the E&M Coding Additional Questions screen: 

1. Click the Refine button in the Evaluation and Management Coding Results screen. The E&M 
Coding Additional Questions screen appears. 

2. Select check boxes next to the statements that apply to the current patient visit. 

3. Click OK to return to the Evaluation and Management Coding Results screen. 
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History Result screen 
The History Result screen allows you to provide additional information that Patient Records can use to 
determine the correct CPT code for a patient visit. Typically, this screen is used when insufficient patient 
history information was included in a patient's progress note to determine the CPT code. 

Note: For detailed information on how the History Result level is determined, see the E&M Coding 
Overview topic. 

Procedures for viewing and updating the History Result 

To open the History Result screen: 

• Click the Modify button in the History Result area of the Evaluation and Management Coding 
Results screen or Expanded Coding Assistance screen.  

To view E&M label codes in the History Results screen: 

• Click the Show Tags button. The relevant E&M label code is shown next to each check box in the 
screen. 

To update the History Result information: 

1. Select the check boxes that apply to the patient. 

2. To view the updated History Result level, based on your changes, click the Refresh button. The 
new level is displayed in the History Result field. 

3. Click OK to return to the Evaluation and Management Coding Results screen. 

Fields on the History Result screen 

Field Description 

History Result Displays the current History Result level.  
Click the Refresh button to update the result to reflect any 
changes made in the screen. 

History of Present Illness 
Questions Asked 

Select check boxes next to each of the questions asked during 
the visit. 

Review of Systems Select check boxes next to each review of systems performed 
during the visit. 

Past, Family, and Social History Select check boxes next to each type of patient history 
reviewed during the visit. 

Additional Questions Select check boxes next to each of the statements that apply to 
the patient's history. 

Refresh button Click to update the History Result field to reflect other changes 
made in the screen. 

Show Tags button Click to display the E&M label codes associated with each 
option on the screen. 
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Medical Decision Making (MDMC) Result screen 
The Medical Decision Making (MDMC) Result screen allows you to provide additional information that 
Patient Records can use to determine the correct CPT code for a patient visit. Typically, this screen is 
used when insufficient medical decision making information was included in a patient's progress note 
to determine the CPT code. 

Note: For detailed information on how the Medical Decision Making Result is determined, see the E&M 
Coding Overview topic. 

Procedures for viewing and updating the Medical Decision Making 
Result 

To open the Medical Decision Making (MDMC) Result screen: 

• Click the Modify button in the Medical Decision Making area of the Evaluation and Management 
Coding Results screen or Expanded Coding Assistance screen.  

To view E&M label codes in the Medical Decision Making (MDMC) Result screen: 

• Click the Show Tags button. The relevant E&M label code is shown next to each check box in the 
screen. 

To update the Medical Decision Making (MDMC) Result information: 

1. Select any check boxes that apply to the patient. 

2. To view the updated Medical Decision Making Result level, based on your changes, click the 
Refresh button. The new level is displayed in the Medical Decision Making Result field. 

3. Click OK to return to the Evaluation and Management Coding Results screen. 

Fields on the Medical Decision Making (MDMC) Result screen 

Field Description 

Medical Decision Making Result Displays the current Medical Decision Making Result level. Click 
the Refresh button to update the result to reflect any changes 
made in the screen. 

Amount/Complexity of Data 
Reviewed 

Select check boxes next to each set of data reviewed during the 
visit. 

Number of Diagnoses or 
Treatment Options 

Select check boxes which describe the number and condition 
of any patient problems. 

Risk of Complications and/or 
Morbidity or Mortality 

Select the check boxes which reflect the risks associated with 
the patient problems. 

Refresh button Click to update the History Result field to reflect other changes 
made in the screen. 

Show Tags button Click to display the E&M label codes associated with each 
option on the screen. 
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Physical Examination Result screen 
The Physical Examination Result screen allows you to provide additional information that Patient 
Records can use to determine the correct CPT code for a patient visit. Typically, this screen is used 
when insufficient physical examination information was included in a patient's progress note to 
determine the CPT code. 

Note: For detailed information on how the Physical Examination result is determined, see the E&M 
Coding Overview topic. 

Procedures for viewing and updating the Physical Examination result 

To open the Physical Examination Result screen: 

• Click the Modify button in the Physical Examination area of the Evaluation and Management 
Coding Results screen or Expanded Coding Assistance screen. 

To view E&M label codes in the Physical Examination Result screen: 

• Click the Show Tags button. The relevant E&M label code is shown next to each Physical 
Examination label in the screen. 

To update the Physical Examination Result information: 

1. Select either the 1995 Guidelines or 1997 Guidelines tab. 

2. Select the physical examination labels which apply to the visit. 

3. To view the updated Physical Examination level, based on your changes, click the Refresh 
button. The new level is displayed in the Physical Examination Result field. 

4. Click OK to return to the Evaluation and Management Coding Results screen. 

Fields on the Physical Examination Result screen 

Field Description 

Physical Examination Result Displays the current Physical Examination Result level.  
Text below this field indicates the guidelines and examination 
type that were used to determine the current physical 
examination result level. 
Click the Refresh button to update the result to reflect any 
changes made in the screen. 

Note: The value selected in the E&M Guidelines field in the 
Special Features screen determines whether 1995 guidelines, 
1997 guidelines, or the most favorable guidelines are used to 
calculate the physical examination result. If Most Favorable is 
selected, ensure that you select appropriate labels from both 
the 1995 and 1997 guidelines tabs. 

1995 Guidelines tab Click to view physical examination codes from the 1995 
guidelines. 
Select the check box next to each examination performed 
during the visit. 

1997 Guidelines tab Click to view physical examination codes from the 1997 
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guidelines.
Navigate through the guideline structure and click next to each 
examination performed during the visit. 

Refresh button Click to update the History Result field to reflect other changes 
made in the screen. 

Show Tags button Click to display the E&M label codes associated with each 
option on the screen. 
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Knowledge base and browser 
Patient Records provides access to local and Internet-based knowledge bases and its built-in browser 
allows you to access the Web. To use these functions, you must have Microsoft Internet Explorer 
version 5.0 or later.   

The Knowledge Base can be used to store useful information for your practice, such as documents 
(saved as HTML files) containing clinical, insurance, and practice information. You do not need a web 
server or direct access to the World Wide Web because you can store the HTML files on your local 
server. You can add links to World Wide Web sites if you do have Web access.  

You can customize the start page for your own Knowledge Base by using the HTML file supplied with 
the application. The file home.lytec.html is located in the database directory where you installed 
Patient Records. You can edit this template file to use as a starting point, or you can create your own. 
When editing the file, you will add hyperlinks to your Knowledge Base files.  

Included in this file are two hyperlinks: "Practice Guidelines from the Agency for Health Care Policy and 
Research" and "Guide to Clinical Preventive Services from the US Preventive Services Task Force". 
These two links lead to many HTML documents included with Lytec MD in the subdirectory (under your 
database directory) called "Kbase". You will see this home page if it was selected during the 
installation.    

Accessing the knowledge base 
To access the knowledge base:  

1. Select Task > Knowledge Base. The Knowledge Base start page appears.  

2. Click the underlined links to bring up selected HTML documents that may in turn be linked to 
other documents.  

3. To see material you previously viewed in this session, click the Back or Forward toolbar 
buttons.  

To close the knowledge base:  

• Select File > Exit.  

To add a hyperlink to the knowledge base home page:  

1. Open Microsoft Word or Microsoft FrontPage.  

Note: You can also use another HTML editor. Although this procedure provides instructions only for 
Microsoft Word and Microsoft FrontPage, the steps will be similar in another editor.  

2. Open the home.lytec.html file in your Lytec MD database directory.  

3. Type the text that you want to use as a hyperlink (for example, if you are adding a link to an 
emergency procedure page, you can type "Emergency Procedures").  

4. Highlight the text you just entered. One way to do this is to double-click on the first word, hold 
down the left mouse button, and move the cursor to the last word.  

5. In Word and FrontPage, select Insert > Hyperlink. In FrontPage, you can also click  in the 
toolbar.  

6. In Word, the Insert Hyperlink screen appears. To link to a file on your network, click the File 
button in the Browse for: section. To link to a Web page on the Internet, click the Web Page 
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button. Then navigate to the file or Web page. When you finish, click the OK button.  
 

In FrontPage, the Create Hyperlink screen appears. To link to a file on your network, click . 

To link to a Web page on the Internet, click . Then navigate to the file or Web page. When 
you finish, click the OK button.  

7. To add additional hyperlinks, repeat steps 3 to 6.  

8. When you finish, save and close the home.lytec.html file.  

Accessing the built-in browser 
You can use the built-in browser to access the World Wide Web. By default, the Lytec MD web page, or 
another web page that your System Administrator selects, appears as the Home page. The workstation 
must be linked to the Internet for World Wide Web Access to occur.  

To access the browser and the World Wide Web:  

1. Select Task > World Wide Web. The Web Home Page appears.  

2. Click the underlined links to bring up selected HTML documents or other Web sites.  

3. To search the World Wide Web, click the Search button.  

4. To see material you previously viewed in this session, click the Back or Forward toolbar 
buttons.  

To close the browser:  

• Select File > Exit.  

Knowledge base: setup 
Patient Records provides a knowledge base and built-in browser. You can set defaults for this feature, 
and you can add HTML pages to the knowledge base. 

Setting defaults for the knowledge base and built-in browser 
The knowledge base and browser defaults also apply to Patient Education. 

To set defaults: 

1. Open the knowledge base by selecting Task > Knowledge Base. 

2. Select Maintenance > Set Defaults. The Administration – Default Settings screen appears. This 
screen has three tabs: Files, E-Mail/Printing, and Editor. 

3. Click the appropriate tab for the section that you want to view or edit. For example, to change 
file defaults, click the Files tab. 

4. When you finish specifying the default settings, click the Close button. 

Adding and editing the home page and other HTML pages  
For the Knowledge Base mode, you should edit the "home.lytec.html" file included with the 
application. It is located in the database directory. You can also use the procedure below to create new 
HTML pages, and to edit existing pages. 
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You can create and edit HTML pages by using Microsoft Word, FrontPage, or any HTML editor. 

To add or edit an HTML page: 

1. Create a new file, or open an existing file. 

2. Enter or change the text, and add hyperlinks that you want. The hyperlinks can simply be HTML 
files residing in a directory on your server. They do not need to be URLs. If you have Internet 
access at all workstations, then you can use URLs as well. 

3. Save the file using the HTML file extension. 

Note: You must have the HTML file extensions installed in the Word program. 

Changing to Patient Education, the Knowledge Base, or the browser 
Once you have accessed Patient Education, the Knowledge Base, or the browser, you can switch to any 
one of the modes without exiting the system.  

To change modes:  

1. Select Task > Mode.  

2. Select one of the following modes: Patient Education, Knowledge Base, and Browse Web.  
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Patient Chart 
The Patient Records patient chart is organized in much the same way as most paper-based medical 
records systems. You will use the patient chart to store a wide variety of patient information, including 
progress notes, medications, and patient histories.  

Many of the chart sections (or tabs) are note-based. That is, they contain mainly non-numeric data. 

Because the Patient Records patient chart is designed to be flexible enough to accommodate any 
medical practice, it provides additional tabs for categories of information that do not fit the pre-defined 
sections of the chart.  

These sections are assigned names by your system administrator. They then appear on the patient 
chart tabs, as well as on the Show menu, with those names. Chart sections with data have icons that are 
highlighted in blue, when the "Indicate presence of data on Patient Chart Menu" check box is marked 
on the Special Features screen. 

You can view, add, or update the information that appears on the user-defined chart sections in the 
same way you would information in any of the text-based section of the patient chart.  

If you like, you can reserve some of the undefined sections for confidential information. You can use 
password protection to limit access to these sections of the patient chart. The confidential sections of 
the patient chart are the undefined categories I & J on the bottom left of the chart, and the last section 
on the bottom right of the chart.  

Accessing and closing patient charts 
You can access the patient chart in several ways: via the File menu, the toolbar’s Chart button, or the 
Schedule feature.  

The File menu will also show up to 15 patients whose charts were most recently opened by the 
operator.  

To access a patient chart:  

1. Select File > Open Patient, or click the Chart button on the toolbar. The Lookup screen 
appears.  

2. Enter the search criteria. For patient name searches, you can also select filters you want to use 
to narrow the search. See Entering Search Criteria.  

3. Click the Lookup button. The patients who match your criteria appear at the bottom of the 
Lookup screen.  

4. Highlight the chart you want to open and click the OK button. 

To access the patient chart using the Schedule feature:  

1. If your system is configured to show the provider schedule, select Task > Provider Schedule. 
You can also click the Sched button on the toolbar.  

2. If you did not enter a provider ID at some point in your current Patient Records session (for 
example, when you signed in), you must do so now. That way, Patient Records will know which 
provider’s schedule to display. Type the ID in the Provider ID field, and then click the OK 
button.  
 
Scheduler has two views depending on your access privileges and the Patient Records 
modules purchased. See your system administrator for more information.  
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3. Highlight the appropriate visit slot. When you first display the screen, the slot closest to the 
current time is highlighted. Double-booked slots display with a green highlight.  

4. If you need to change dates, move between calendar dates by using the arrow keys. Click the 
left arrow to move one day back. Click the right arrow to move one day forward.  

5. When you finish selecting the schedule slot, click the OK button to display the chart for the 
selected slot.  

To close a patient chart:  

• Click the Close button on the tool bar, or click the Close icon in the upper-right corner of the 
patient chart screen. The current patient chart and any related screens for the patient close. If a 
progress note is open, you will be prompted to save it.  

Accessing ExitCare® from the patient chart 
MedQuest’s ExitCare is a third-party product that can be used to generate patient education handouts. 
If Patient Records has been configured to work with ExitCare, it can be accessed directly from the 
Patient Chart screen. Any handouts printed for the patient in ExitCare are automatically imported as a 
PDF file and can be accessed from a link in the patient’s latest progress note. 

Note: See Integrating Patient Records with ExitCare for more information on configuring Patient 
Records to work with ExitCare. 

To access ExitCare from the patient chart: 

1. Ensure that the patient chart is displayed. 

2. Click the ExitCare button. ExitCare opens and the patient’s demographic data is displayed. 

3. Use ExitCare to create and print patient education handouts. For more information, consult 
your ExitCare documentation. 

Accessing RelayHealth® from the Patient Chart 
If Patient Records has been configured to work with RelayHealth, then RelayHealth can be accessed 
directly from the Patient Chart screen. You can access RelayHealth's "New Message to Patient" screen 
to compose a new message for the current patient, or check the current patient's online health 
summary in RelayHealth. These screens will be opened in a browser window.  

To compose a new message for the patient using RelayHealth:  

1. Ensure that the patient chart is displayed. 

2. Click the Pt Msg button. The New Message to Patient screen opens. 

To view the patient's RelayHealth online health summary:  

1. Ensure that the patient chart is displayed. 

2. Click the Online Health Summary button. The RelayHealth Health Summary screen opens.  

Note: See RelayHealth section for more information on using Patient Records with RelayHealth. 
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Other note-based sections of the chart 
Many sections of the patient chart contain text (note-based) information. The notes in these sections 
have a title and a date. They are accessed in reverse chronological order (that is, with the most recent 
note first).  

The main note-based section is progress notes. The history sections (family history, social history, and 
past medical history) and the letters section are also note-based. 

Other text-based chart sections include:  

Section Description 

Attending notes The Pathology section contains the patient's attending notes. 

Consults  The Consults section contains a record of the patient's 
consultations.  

EKG The EKG section contains the patient's EKG results. It also 
contains results from the Brentwood module or the Welch Allyn 
module, if you have that product.  

Hospital Reports The Hospital Reports section contains the physician’s 
summaries of patient hospitalizations.  

Messages The Messages section contains messages about the patient that 
have been recorded through the messaging system.  

Pathology The Pathology section contains the patient's pathology reports.

Special Studies The Special Studies section contains reports from any other 
type of test or study.  

User-defined sections 
 

The patient chart corresponds to a complete paper patient 
chart. It is designed to be flexible enough to accommodate any 
medical practice. Therefore, additional sections of the chart are 
reserved for categories of information that do not fit the pre-
defined sections of the chart. 
 
These sections are assigned names by your system 
administrator. They then appear on the patient chart tabs, as 
well as on the Show menu, with those names. 
 
You can view, add, or update the information that appears on 
the user-defined chart sections in the same way you would 
information in any of the text-based section of the patient chart.
 
If you like, you can reserve some of the undefined sections for 
confidential information. You can use password protection to 
limit access to these sections of the patient chart. The 
confidential sections of the patient chart are the undefined 
categories I & J on the bottom left of the chart, and the last 
section on the bottom right of the chart. 

X-Ray The X-ray section contains the patient's X-Ray reports.  

You can enter text in the note-based sections in any form you like, using Patient Records’ powerful 
word processing functions. You can also use the Text Data Loader to transfer notes from word 
processing files or from Medical Writer. 
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Your system administrator can use the Customize Patient Chart options to rename any of these patient 
chart sections. Then you can use them to store any category of information that is appropriate to your 
practice. Once you have changed the name of a chart section, the new name appears on the patient 
chart tab. 

Patient Comment Notes 
The text-based sections of the chart allow you to add Patient Comment notes which can be viewed by 
the patient via Web View. These notes can be used to contain text that is applicable to the patient's 
labs, reports, and messages. You can create Patient Comment notes for a specific result or all results for 
the current date. Please note you can not create Patient Comment notes when viewing or reviewing 
progress notes.  

Because this feature is Web View based, it is imperative that you have Web View and the patient is set 
up to have access to Web View. You can do this by enabling the "Allow Web View access for patient" 
configuration.  

Once a Patient Comment has been created, the user can then log into Web View to view the note. If the 
patient has a new comment, it is displayed on the first screen after the user logs in. Patients can also 
view their notes in the Note section of the Web View patient chart. When the section is open, they can 
scroll to the item, and click on it to view the result. The result screen will display a message at the top of 
the screen indicating that a comment exists for the result. The patient can then click on the provided 
link to view the comment. The Comment column also displays a "Y" if a comment exists for the result.  

For example, if a Patient Comment note is created for an X-Ray report, the patient can view the 
comment by clicking on the X-Ray link on the left hand side of the Web View screen. The patient can 
then click on the X-Ray result the note was created for. This opens the X-Ray result screen. On this 
screen click the link at the top of the screen to view the comment.  

To view all Patient Comment notes for a patient when their chart is open, select the Patient Comment 
Notes option from the Show menu. From the Patient Comment screen you can view older and newer 
notes, edit an existing note, print a note, fax a note, or attach an image to a note. 

When a Patient Comment note exists, the Pt Comment button will be highlighted in blue. You can click 
the button to view the most recent Patient Comment linked to the note being viewed. If there is more 
than one Patient Comment linked to the note you can use the Older and Newer buttons to view 
previous and more recent Patient Comment notes. 

See the Patient Comment Notes section for a complete overview of this feature. 

Note Compare 
Lytec MD keeps track of changes made to the text-based sections of the patient chart, including 
Progress Notes. You can compare up to five revised versions of the same note against previous 
versions.  

Note Compare displays additions and deletions made to notes between versions. Deleted text is 
displayed with strikethrough formatting (like this), and added text is highlighted in green (like this).  

Before you can use the Note Compare feature, your system administrator must enable the Access Level 
setting, "Note Compare".  

To use note compare: 

1. Open the note you want to compare.  

2. Select the Note Compare option from the Patient Records Edit menu. 
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• If you have edited the note more than once, the Audit Trail Notes List screen appears. 
Highlight the version of the note that you want to compare to the current version of the 
note, and click the Compare button.  

The Changes to Note screen appears. From this screen you can view the changes to the note. 
If there are no audit trail notes to compare against the current note, a message will be 
displayed. 
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Patient Information screen 
The Patient Information screen provides quick access to a patient’s data. The information displayed is 
pulled from the Patient screen, and includes the patient’s name, ID, address, home address, telephone 
numbers, account type, head of household, insurance carriers, pharmacy benefits carriers, usual 
provider, and referral sources. Keep in mind that this information displays only if it has been entered on 
the Patient screen. For example, if a usual provider is not indicated on the Patient screen, the Usual 
provider field on the Patient Information screen will be blank. 

The screen includes several buttons, so that you can quickly jump to additional patient information. You 
can click the: 

• HM button to view the patient’s overdue health maintenance. 

• Allergies button to view the patient’s allergies. 

• Co-pay button to view the patient’s co-pay data.  

• Guarantor button to view and edit guarantor data for the patient. If a guarantor does not exist for 
the patient, Patient Records will ask if you want to add one. 

• Insurance button, this button does not apply to Lytec MD. 

Accessing the Patient Information screen 
To access the Patient Information screen: 

1. When a patient chart is open, select Show > Patient Info, or click the Pt Info button on the 
toolbar. The Patient Information screen for the current patient appears. 

2. If you want to view additional patient information, click one of the buttons (HM, Allergies, 
Copay, Guarantor, or Insurance). 
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Timing screen 
If you are also using Appointment Scheduler, and if the patient has an appointment for the current day, 
you can use the Timing button (available in the tool bar only when a chart is open) to track process 
information for patient visits. You can record the exact time a patient checks in, is put in the exam room, 
sees the provider, is finished with the provider, and leaves. This feature helps you to determine the 
average amount of time patients spend waiting and with providers. 

Using the timing feature 
To use the timing feature: 

1. When a chart is open, click the Timing button in the tool bar, or select Task > Timing. The 
Timing screen appears. 

2. For each process (check-in, in exam room, provider starts, provider finishes, and check-out) that 
you want to track: 
• Type a time in the field; or 

• Mark the check box to use the current system time.  

3. When you finish, click the OK button. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 683 

 

Attending notes 
The Attending Notes section contains all attending notes for the patient. Adding attending notes is 
much like adding a progress note. You can type the history directly into the system, or you can use the 
Text Data Loader to import data from an outside source.  

The Attending Notes section consists of a single note that displays the date you first entered attending 
notes for the patient. As with progress notes, you can use templates to quickly and accurately record 
information. Templates provide a general framework, indicating what information you should enter. 

The Attending Notes section can be as long as you like, and is treated much like one long progress 
note. You can rename the Attending Notes section of the chart and use this section for your own 
category of patient information. 
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Clinical Elements 
Historically, Lytec MD users had to create custom Laboratory Names as a workaround for recording 
custom discrete and non-discrete data. The Clinical Elements feature provides a way for you to do this 
without using Laboratory Names, and with greater power and versatility. For example, you can enter 
physiological parameters that don't constitute vital signs, such as left ventricular ejection fraction, 
standardized symptom scores, intraocular pressure, etc. Clinical elements provides a convenient and 
flexible way for you to enter and display this data. You can display and enter clinical elements using 
flow charts, you can insert them into notes and letters using Insert Codes, and you can record them 
from notes using Dot codes.  

Before you begin entering clinical element data, your system administrator will need to set up clinical 
element names to define the data you want to display and track. In addition, the normal ranges that 
your system administrator defines on the Ranges screen determine which values are highlighted as 
abnormal. 

Procedures for adding, editing, and deleting clinical 
elements 
To open the Clinical Elements screen: 

• In the patient chart, select Show > Results > Clinical Elements, or click the Clinical Elements 
tab. The Clinical Elements screen appears. 

To add clinical elements data directly in the patient chart: 

1. On the Clinical Elements screen, select the clinical elements template you want to work with 
from the Template drop-down menu.  

Note: You can quickly scroll through the templates by clicking the right or left arrows on the keyboard 
or next to the Template field.  
 
You can also jump directly to a template by typing the first letter of the template name (for example, 
type the letter C to jump to the CBC template). The first template starting with that letter will be 
selected. If this is not the template you want, keep typing the letter until the template is selected (this 
scrolls alphabetically through the templates that begin with the letter).  

2. When the clinical elements template appears, click the New button on the Clinical Elements 
screen. The Clinical Elements <New> screen appears.  

3. The current date and time are automatically entered in the date and time fields. Change the 
date and/or time if necessary. Add the value for each category in the appropriate fields. Use 
the TAB or arrow keys to move between fields.  

4. When you finish, click the OK button. 

To graph clinical elements data: 

1. On the Clinical Elements screen, highlight the column of clinical elements data you want to 
graph. To highlight an entire row, click the row name. You can select up to four rows by clicking 
on one, then pressing SHIFT while you select the others. 
 
You can also highlight part of a row. To do that, click on the first cell, and then press SHIFT 
while you select the others.  
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You can also highlight cells in different rows by clicking on the first cell in one row, and then 
pressing CTRL while you select other cells in other rows.  

2. Click the Graph button. The Graph screen appears. This screen displays a graph of the vital 
sign items you selected.  

To print a clinical elements graph:  

• When the graph of the clinical element is open, click the Print button. If the Windows Print 
screen appears, select the printer and click the OK button. 

To change clinical elements data: 

• On the Clinical Elements screen, highlight the column of clinical elements that you want to 
change. Click the Edit button. The Clinical Elements <Edit> screen appears. Make the 
appropriate changes. When you finish, click the OK button. 

To delete a column of clinical elements data: 

• On the Clinical Elements screen, highlight the column of clinical elements that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK 
button. 

To print a list of clinical elements: 

• On the Clinical Elements screen, click the Print button. The Date Range Selection screen 
appears. Enter the date range in the From and to fields. Click the OK button. 

Viewing older and newer clinical elements data: 

• To view previous clinical elements data, click the Older button. To view more recent data, click 
the Newer button.  

To display clinical element details (such as clinical element name, the time the clinical element 
data was entered, and the data entered):  

• Select the Details check box located on the bottom right of the screen. 
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Chart Summary  
The Chart Summary screen displays the most recent chart information about a patient in a concise, 
easy-to-read format. You can use the Chart Summary screen to get a quick overview of a patient’s chart.  

Administrators can customize the chart summary, specifying which information appears for your entire 
site and for individual providers. For more information, see the Customize Chart Summary for Site or 
Provider section. 

The chart summary is solely for viewing existing patient information. You cannot delete or change 
information directly on the Chart Summary screen. If you need to change any information displayed 
here, you must change it in the appropriate section of the patient chart.  

You can double-click any chart summary item to go directly to that section of the chart. For example, 
you can double-click a medication to view the patient's current medications. Use the arrow buttons to 
scroll through the information in each section of the Chart Summary screen.  

The default chart summary layout shows the patient’s most recent problems, along with the 
corresponding visit date. It also displays the patient’s major problem list, current medications, allergies 
(if any), and a summary of overdue health maintenance procedures. Depending on your screen 
resolution, the patient's basic demographic information is also shown at the top of the screen.  

Accessing the chart summary 
To access the chart summary: 

Do one of the following: 

• Select Show > Chart Summary. 

• Click the Chart Summary tab on the patient chart.  

• Click the Summary button on the Go To bar. 
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Consults 
The Consults section of the patient chart contains all consultations for the patient. Adding consult 
information is much like adding a progress note. You can type the history directly into Lytec MD, or you 
can use the Text Data Loader to import data from an outside source.  

The Consults section consists of a single note that displays the date you first entered consult 
information for the patient. As with progress notes, you can use templates to quickly and accurately 
record information. Templates provide a general framework, indicating what information you should 
enter. 

The Consults section can be as long as you like, and is treated much like one long progress note. You 
can rename the Consults section of the chart and use this section for your own category of patient 
information. 
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EKG 
The EKG section contains ECG reports for the patient. Adding ECG information is much like adding a 
progress note. You can type the history directly into Patient Records, or you can use the Text Data 
Loader to import data from an outside source.  

As with progress notes, you can use templates to quickly and accurately record information. Templates 
provide a general framework, indicating what information you should enter. 

This section also stores information from the Brentwood ECG add-on module or the Welch Allyn ECG 
add-on module.  

ECG Module Overview 
If you have the ECG add-on module, Lytec MD provides extended ECG functionality. In addition to the 
standard EKG text section in the patient chart, the add-on module fully integrates the IQmark™ Digital 
ECG from Brentwood (Midmark) or the Welch Allyn CardioPerfect™ Workstation with Lytec MD.  

Note: You cannot use both the IQmark™ Digital ECG from Brentwood (Midmark) or the Welch Allyn 
CardioPerfect™ Workstation with Lytec MD at the same time. Your system administrator can use the 
ppart.ini file setting, DefaultEKGClient to specify which module you are using.  

When using your ECG product with Lytec MD, the product converts your PC into a real time 12-lead 
EKG machine with critical interpretation. This means that you can acquire, display, interpret, and store 
the ECG results through the PCs that are part of your Lytec MD system.  

Working with your ECG module  
Taking ECGs through Lytec MD is simple. You connect the EKG module to your computer. Then, in 
Lytec MD, you select a patient’s chart and run the ECG. While still in Lytec MD, you view the results and 
interpretation. You can also modify the interpretation. The EKG is then stored in Lytec MD. You can use 
the Special Features screen to indicate where the data is stored in the patient chart. 

If you are using the Brentwood ECG add-on module, blood pressure (taken within one week of the EKG 
date), weight (taken within one month of the EKG date), and height are imported into the EKG module 
from the patient chart. You can change these in the module, or add them if necessary. Prescriptions 
and the patient history are not imported. The provider currently logged into Lytec MD is displayed on 
the EKG.  

You can review an ECG through the Task menu or through the EKG tab of the patient chart. However, 
to edit or delete an EKG, you must use the Task menu. 

See the Brentwood ECG module section or the Welch Allyn ECG module section for basic instructions 
for using the modules through Lytec MD. Refer to the Brentwood user's manual or the Welch Allyn 
user's manual for specific instructions on connecting, setting up, and using all features of the IQmark 
Digital ECG acquisition module or the Welch Allyn CardioPerfect Workstation. 
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Brentwood ECG module 

About the Brentwood ECG add-on module 
Brentwood's ECG module converts your PC into a real time 12-lead ECG machine with critical 
interpretation. This means that you can acquire, display, interpret, and store the ECG results through 
the PCs that are part of your Lytec MD system.  

The EKG module provides many additional features:  

• You can use the module as a monitor, and can acquire rhythm strips up to 6 minutes in length. 

• You can use the integrated digital calipers and other diagnostic tools, such as macros for adding 
diagnostic statements. 

• You do not need to pay for expensive ECG machines and components. 

• You can print results on plain paper instead of special ECG graph paper, or simply store the 
results electronically without ever printing them. 

• Lytec MD stores the results as data points, which are more flexible and accurate than image files. 
Data points take up less memory, and you can use them for analysis and research. You can also 
share results with providers outside your Lytec MD system by having them download a free ECG 
viewer from the Brentwood Web site.  

• If you have Web View installed you can view your ECGs in Web View. 

Technical tips for Windows Terminal Services 
Some Windows Terminal Services sites have reported improved performance with the following: 

• When the module is open, click the Settings button. On the Default Interpretation and 
Acquisition Display Settings, unmark the Waveform Smoothing check box. 

• Open My Computer and click the Device Manager button. Under Ports, double click the serial 
port to which the ECG device is attached. Click the Port Settings tab. Then:  

• Select Hardware in the Flow control field. 

• Click the Advanced button. Change the Receive Buffer setting to the maximum (14). 

After you've changed the Device Manager settings, reboot the PC. 

Adding, editing, and deleting ECGs with the Brentwood 
module 
To take an ECG: 

1. Make sure the patient’s vital signs have been updated in the patient chart. Blood pressure, 
weight, and height are automatically imported into the ECG module. 

2. Place electrodes on the patient. 

3. While the patient chart is open, select Task > Add-ons > EKG. The EKG screen appears. This 
screen lists all ECGs that have been completed for the patient. 

Note: You can also select Task > Add-ons > EKG while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  

4. On the EKG screen, click the New button. The EKG for <Patient> screen appears.  
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Note: The ECG module requires a patient birth date. If the module cannot find a birth date in the 
patient chart, a message appears. 

5. The EKG screen displays the patient’s current tracing. On this screen, you can: 
• Capture anomalies for review by clicking the Analyze button. 

• Freeze the current on screen tracing by clicking the Freeze button. 

• See the interpretation by clicking the Review button. You can change the interpretation if 
necessary (for example, edit the diagnostic statements). On the Reports for <Patient> 
screen, you can do your own measurements by clicking the Details button. 

6. When you finish, click the Exit button. The ECG results and interpretation are saved in Lytec MD 
as a text entry on the EKG tab of the patient chart. The ECG image is also attached to the text 
note, and can be displayed any time from within Lytec MD. 

Reviewing ECGs taken with the Brentwood module 
You can review ECGs taken with the Brentwood module through the Task menu or through the patient 
chart.  

To review an ECG through the Task menu:  

1. While the patient chart is open, select Task > Add-ons > EKG. The EKG screen appears. This 
screen lists all ECGs that have been completed for the patient.  

Note: You can also select Task > Add-ons > EKG while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the ECG that you want to review.  

3. Click the View button. The EKG for <Patient> screen appears.  

4. When you finish, click the Exit button. 

To review an ECG through the patient chart:  

1. In the patient chart, click the EKG tab. The newest ECG note for the patient appears. 

2. Scroll through the reports to locate the ECG you want to review. You can view the full 
interpretation in the report.  

3. To view the tracing, click the   icon. The ECG tracing for the patient appears.  

Note: ECGs taken with the Brentwood module will use the  icon. ECGs stored as images in Lytec 

MD will use the  icon.  

4. When you finish, click the Exit button. You return to the ECG note. Click the Close button.  

To modify an ECG taken with the Brentwood module: 

1. While the patient chart is open, select Task > Add-ons > EKG. The EKG screen appears. This 
screen lists all ECGs that have been completed for the patient.  

Note: You can also select Task > Add-ons > EKG while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the ECG that you want to modify or edit.  

3. Click the Edit button. The EKG for <Patient> screen appears.  
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4. Make the necessary changes. For example, you can change the interpretation, medications, or 
the vital signs.  

5. When you finish, click the Exit button.  

To delete an ECG taken with the Brentwood module: 

1. While the patient chart is open, select Task > Add-ons > EKG. The EKG screen appears. This 
screen lists all ECGs that have been completed for the patient.  

Note: You can also select Task > Add-ons > EKG while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the ECG that you want to delete.  

3. Click the Delete button. A message asks you to confirm the deletion.  

4. Click the Yes button.  
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Welch Allyn ECG module 
The Welch Allyn CardioPerfect™ Resting ECG module allows you to record, view, and interpret resting 
ECGs. You can use patient record's to acquire, display, interpret, and store the ECG results through the 
PCs that are part of your Lytec MD system.  

For detailed information about the Welch Allyn CardioPerfect Resting ECG module, visit 
www.welchallyn.com or consult your Welch Allyn documentation. To purchase the Welch Allyn 
CardioPerfect software, please consult your Lytec MD sales representative. 

If you install the Welch Allyn ECG add-on module with Patient Records you can: 

• Launch the Welch Allyn ECG add-on module from Patient Records 

• Store your patients' ECGs in Lytec MD. You can use the Special Features screen to indicate 
where the data is stored in the patient chart. 

• Add and review ECGs, and modify interpretations taken with the Welch Allyn ECG add-on 
module in Patient Records 

Required installation and configuration steps 
The following sections describe the installation and configuration steps required to use the Welch Allyn 
ECG add-on module with Patient Records: 

• System requirements 

• Install and configure the Welch Allyn ECG add-on module 

• Configure Patient Records PPart.ini file settings 

System requirements 
Patient Records can only be integrated with:  

• Welch Allyn CardioPerfect Workstation version 1.6 or later  

• Welch Allyn CardioPerfect FileLink Workstation tool version 1.1.3 or later.  

Before installing the Welch Allyn CardioPerfect software, ensure that your system meets the minimum 
requirements recommended in the Welch Allyn documentation. 

Install and configure the Welch Allyn ECG add-on module 
To install and configure the Welch Allyn CardioPerfect Workstation and FileLink Workstation tool, 
follow the installation instructions in your Welch Allyn documentation.  

During installation, ensure that the Welch Allyn CardioPerfect Workstation and the FileLink Workstation 
tool, is installed on a location in your network that can be accessed by the Patient Records workstation.  

Configure Patient Records PPart.ini file settings 
Before you can access the Welch Allyn ECG add-on module from Patient Records, you must first 
configure settings in the PPart.ini file. These settings enable Patient Records to launch the Welch Allyn 
ECG add-on module and allow ECGs to be imported and exported between the two applications. 

To configure PPart.ini settings: 

1. Make a backup of the PPart.ini file. For example, copy the file and rename it as ppart.bak. 
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2. Use WordPad, Notepad, or another text editor to open the file. 

3. Set the appropriate values in the [EKG] section of the ppart.ini file: 

Key Description 

[EKG]  

StoreEKGIn= 
 

Configurable in Special Features on the Records 1 tab. 
You can specify the text-based section of the patient chart 
where you want the ECGs to be stored. 

WelchAllyn_PreviousInstall= Use this setting to indicate whether the Welch Allyn ECG add-
on module was installed previous to the installation of Patient 
Records. The default setting is False. If the module was installed 
after the installation of Patient Records, leave this setting set to 
False.  
Set to =True if the module was installed previous to the 
installation of Patient Records.  

DefaultEKGClient= Use this setting to specify the default ECG client. The default 
setting is Brentwood.   
Set to =WelchAllyn if your default client is the Welch Allyn ECG 
add-on module. 
Please note this setting is case-sensitive. You must capitalize the 
first letter of each word, e.g., Welch Allyn.  

4. Save the PPart.ini file. 

Working with the Welch Allyn ECG add-on module 
When the Welch Allyn ECG add-on module has been installed and you have completed the required 
configuration steps, you can launch the module from Patient Records. The following procedures 
describe how to add and review ECGs, and modify interpretations with the Welch Allyn ECG add-on 
module in Patient Records. For more detailed information, consult your Welch Allyn documentation. 

Note: Some features, such as viewing, deleting, and comparing ECGs, are disabled when you access 
the Welch Allyn ECG add-on module from Patient Records. 

Note: When working with the module in Patient Records, Patient Records will be locked when you are 
in the Welch Allyn CardioPerfect Workstation. You must exit the Welch Allyn CardioPerfect Workstation 
to return to Patient Records.  

Note: Welch Allyn ECGs cannot be viewed in Web View. 

To take an ECG with the Welch Allyn ECG add-on module:  

1. Place electrodes on the patient. 

2. While the patient chart is open, select Task > Add-ons > EKG. The EKG screen appears. This 
screen lists all ECGs that have been completed for the patient. 

Note: You can also select Task > Add-ons > EKG while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  

4. On the EKG screen, click the New button. If you have not logged into the Welch Allyn 
CardioPerfect workstation, the login screen appears. Type your user name and password, and 
then click the Login button.  

5. If the selected patient is found in the Welch Allyn database, you will receive a confirmation 
message, "Patient Matched". Please note the patient's name, date of birth, patient ID, and 
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gender must match the information in the Welch Allyn patient card, and the PPart.ini file 
setting, WelchAllynPreviouslyInstalled must =True for the patient to be immediately matched.  

If the selected patient is not found in the Welch Allyn database, you will receive a message. 
Click OK, and then scroll through the list of patient's in Welch Allyn to find the matching 
patient. You can also add the patient to the Welch Allyn database if the patient does not exist. 
At the minimum, you must enter the patient's name, date of birth, patient ID, and gender to 
ensure a match. Once a match has been made, the match between the two patients will be 
saved in the database. See the Welch Allyn documentation for more information.  

Once you have selected the matching patient from Welch Allyn, you will receive the message, 
"Cannot find a matching patient in Lytec MD, please select one manually." Click OK, the 
Establish Patient Identity screen appears. Select the appropriate patient and then click the OK 
button. You will receive a confirmation message, "Patient Matched". Once the patient has been 
matched, any historical ECG records (notes and tests) will be loaded into EKG section of the 
patient's chart. 

6. Use the Welch Allyn ECG module to record the patient's ECG. See the Welch Allyn 
documentation for information. 

7. When you finish, exit the Welch Allyn module. The ECG results and interpretation are saved in 
Lytec MD as an entry on the EKG tab of the patient chart. The ECG test is also attached to the 
note, and can be displayed any time from within Lytec MD. 

To review an ECG through the patient chart:  

1. In the patient chart, click the EKG tab. The newest ECG note for the patient appears. 

2. Scroll through the reports to locate the ECG you want to review. You can view the full 
interpretation in the report.  

3. To view the tracing, click the   icon. The ECG tracing for the patient appears.  

Note: ECGs taken with the add-on module will use the  icon. ECGs stored as images in Lytec MD 

will use the  icon.  

4. When you finish, click the Exit button. You return to the ECG note. Click the Close button.  

To modify an interpretation taken with the Welch Allyn module: 

1. While the patient chart is open, select Task > Add-ons > EKG. The EKG screen appears. This 
screen lists all ECGs that have been completed for the patient.  

Note: You can also select Task > Add-ons > EKG while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the ECG that you want to modify, and then click the Edit button. The ECG 
for <Patient> screen appears.  

3. Make the necessary changes to the interpretation.  

4. When you finish, click the Exit button.  
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Family history 
The patient chart provides three patient history sections:  

• Family History – Records medically relevant information about the patient’s family, including 
major diseases and chronic conditions. 

• Past Medical History – Records all the chronic illnesses, hospitalizations, and other health 
information for the patient. 

• Social History – Records medically relevant information about the patient's life, such as marital 
status, habits, work, etc. 

Adding patient history information is much like adding a progress note. You can type the history 
directly into Patient Records, or you can use the Text Data Loader to import data from an outside 
source.  

Each history section of the chart consists of a single note that displays the date you first entered history 
information for the patient. As with progress notes, you can use templates to quickly and accurately 
record historical information. Templates provide a general framework, indicating what information you 
should enter. 

The history sections can be as long as you like, and each section is treated much like one long progress 
note. You can design templates to provide forms for entering history information. You can also rename 
any, or all, of the three History sections of the chart and use these sections for your own categories of 
patient information. 
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Flow charts 
You can use patient flow charts to view numeric and textual patient data in tabular form, including 
laboratory data, vital signs, Rx/medications, and health maintenance. You can also view text data in the 
note field in a flow chart. Flow charts help you compare and analyze patient information quickly.  

Before you can view patient flow charts, you must set up templates to define the information you want 
to display on the flow charts.  

Each flow chart can display up to 50 items.  

Once you have selected the flow chart you want, and if prompted selected a medication, the Flow 
Chart screen appears. The title bar displays the name of the patient. The Template field displays the 
template name you selected. The data names appear on the left, with the dates on which the data was 
collected across the top.  

If there are more data items than fit in the screen, use the scroll bar to scroll through the list of data 
items. Click the Older button to display older data.  

If data is available for more dates than the range of dates you chose to display, click the Date button.  

You can also change flow chart templates and dates when viewing the flow chart.  

An asterisk next to a data indicates that a comment exists. The comment is displayed in the Details 
panel at the bottom of the screen. In addition to comments, the Details panel also displays information 
such as laboratory data test name, normal range, critical high or low range warning, and provider ID for 
laboratory data items.  

If there is a Note field in the flow chart, you can enter a short note. The name of the note will be 
whatever name was entered when the template was created.  

Viewing, graphing, and printing flow charts 
To access the flow chart section of the patient chart: 

• Select Show > Results > Flow Charts, or click the Chart Summary tab on the patient chart. You 
can also click the Flow Chart button on the go to bar.  

To view a flow chart: 

1. Click the Flow Chart tab on the patient chart.  

2. Select the appropriate flow chart template from the table on the Flow Chart Selection screen. 

3. Enter the beginning and ending date for the range of dates you want to display in the flow 
chart, or leave the fields blank to display all data.  

4. Click the OK button.  

5. If your flow chart includes the Current Medication, Any Historical Medication, or Class of 
Medications category, you are prompted to select a medication from a list. Highlight a 
medication from the Medications table, click the Apply button, and then click the Close button.  

To change the template used by a flow chart: 

• When the flow chart is open, click the drop-down table next to the Template field and select a 
different template. You can also click the left or right double arrows to select the previous or next 
template.  
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To change the date(s) used by a flow chart: 

• When the flow chart is open, click the Date button. On the Flow Chart Selection screen, type the 
beginning and ending date for the range of dates you want to display in the flow chart. Click the 
OK button.  

To add, edit, or delete notes for a flow chart: 

• To add a note: Click the New Note button. In the Note Entry screen, enter a note and then click 
the OK button.  

• To edit a note: Highlight the note and click the Edit Note button. Edit the note and then click the 
OK button.  

• To delete a note: Highlight the note and click the Delete Note button. A warning appears, 
“Confirm Delete.” Click the OK button.  

To turn on/off the flow chart Details panel: 

The Details panel displays additional information about lab data items in flow charts. The information 
includes the following information, if available: laboratory test name, the date and time the test was 
performed, the laboratory test value, a high or low status indicator if the value is in a critical range, the 
normal range, any comment, the provider ID, and who revised the previous information and when. 

• To turn on the Details panel: Mark the Details check box at the bottom right of the screen. 

• To turn off the Details panel: Unmark the Details check box. 

To graph a flow chart: 

1. When the flow chart is open, highlight the row of data you want to graph. To highlight an entire 
row, click on the row name. You may select up to four rows by clicking on one, then pressing 
SHIFT while you select the others.  
 
You can also highlight part of a row. To do that, click on the first cell, and then press SHIFT 
while you select the others.  
 
To select non-contiguous rows, press CTRL while you select additional rows.  

2. Flow chart items that are set in the flow chart template to automatically graph are already 
highlighted.  

3. Click the Graph button. The Flow Chart Graph screen appears with a line graph of the flow 
chart data item you selected. 

4. When you finish viewing the graph, click the Close button to return to the Flow Chart screen.  

A note about graphing medications 
You can plot medication alone, or against any other laboratory data values. The value plotted is the 
daily dosage, for example, size x take x freq. If a daily dosage cannot be computed because one of the 
dosage variables is a non-numeric value, the medication will be plotted in an ON/OFF format.  

To print a flow chart graph: 

• When the graph of the flow chart is open, click the Print button. If the Windows Print screen 
appears, select the printer and click the OK button. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 698 

 

Health Maintenance 
Note: Before you can use the health maintenance feature, your system administrator must set up health 
maintenance procedures and templates. The system administrator should also verify the health 
maintenance settings in the ppart.ini file. 

The health maintenance feature helps you track a patient's periodic preventive and follow up care 
treatments. You can use this feature to schedule patients for periodic examinations and tests based on 
age/sex criteria, medications, problems, diagnoses, protocols, or individual patient needs. You can 
track a wide variety of items including the entire USPHS guidelines, cholesterol, immunizations, pap 
smears, mammograms, chemistry panels, creatinine, HgBA1C, and so forth.  

For new customers, Lytec MD comes with a wide variety of preset health maintenance templates, 
including the USPHS guidelines, many common medical problems, and many common medications. 
You can modify these templates to meet the specific needs of your practice. 

Within a health maintenance template, each test or exam is given a rule to determine how often it 
should be performed. These rules can be simple or very complex. For complex rules, you can create 
“rule files” where complex logic can be entered. The complex logic can include reading existing patient 
data such as lab results, diagnoses etc.  

Other health maintenance features include: 

• You can set up templates based on age/sex, problems, Rx, or protocol. 

• You can assign multiple templates to patients. 

• Templates are automatically assigned to patients that meet the template's criteria. Depending on 
settings in the ppart.ini file, this action includes when medications are written or manually 
discontinued, or when problems are assigned in a note or on the chart's problem list. For 
example, if you document a problem, and a template exists for that problem, you are prompted 
to assign the template to the patient. 

• You can set up an individual template for patients. This means that you can apply generic rules to 
a patient through a template, or individualized rules through a personalized template. 

• You can create customized help files that contain information for providers and patients about 
health maintenance procedures.  

• You can mark procedures as completed, refused, done elsewhere, not applicable to the patient, 
offered but postponed, or ordered. Entering not applicable for a procedure will stop all overdue 
checking for that procedure. 

• Lytec MD calculates when procedures are overdue. In addition to pre-defined rules that ship with 
Patient Records, you can create customized rule files that determine whether a procedure is up-
to-date. 

• Overdue items are highlighted in the patient chart for easy viewing. Lytec MD also displays a 
prompt for overdue items when a patient is scheduled through Appointment Scheduler. 

• You can use synonyms to maintain alternate names for medication or problem names in health 
maintenance templates. Synonyms are used when Lytec MD checks whether procedures are up-
to-date. For example, you may create a template for DTaP, which was previously known as DPT. 
By adding DPT as a synonym for DTaP, Lytec MD will check for both DTaP and DPT when 
verifying whether procedures are up-to-date. 

• You can generate reminder letters or a Patient Inquiry report for patients who are overdue for 
health maintenance procedures. 

• If you use the Text Data Loader to load health maintenance data from an external source, you 
can set up a cross-reference file to link procedure names in your health maintenance templates 
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to procedure names from the external source. A similar cross-reference file can be created to 
update health maintenance when lab results are loaded using the Lab Data Loader. 

How Lytec MD implements rules 
When you create templates, you set rules for each procedure in the template. If more than one 
template is assigned to a patient, and a procedure appears in multiple templates, the rule with the 
greatest frequency will be used (for example, if one template has the procedure done once and 
another has the procedure done every 7 days for two weeks, the second rule will be used). 

An individual template takes precedence over other templates, if a health maintenance item appears 
on more than one template. 

A health maintenance procedure can have the following frequencies: Do once in xx 
days/weeks/months, do every xx days/weeks/months for xx times, and do at ages xx. You can also set 
the count procedure check box and the minimum interval.  In addition, you can also select a 
customized rule file that determines whether a procedure is up-to-date. 

For age/sex templates for children, many items will have a “count procedure” rule, along with a 
minimum interval. This is particularly important for childhood immunizations. 

Lytec MD uses both the frequency and a start date to determine when the procedure should be 
completed, and therefore whether the procedure is either up-to-date or overdue. The start date of the 
procedure is calculated using the following logic: 

• Age and sex templates: If there are no procedures and the Use_Patient_Reg_Date setting in the 
ppart.ini file is set to OFF, the start date is the date the template was applied to the patient. 

• Age and sex templates: If there are no procedures and the Use_Patient_Reg_Date setting in the 
ppart.ini file is set to ON, the start date is the patient's registration date. 

• Age and sex templates: If there are treatments than the most recent treatment date will be used 
as the start date.   

• Medication, problem, and protocol templates: If there are no procedures, the start date is the 
date the template was applied to the patient. 

• Medication, problem, and protocol templates: If there are procedures AFTER the date the 
template was applied, the start date is the date of the treatment.  

• Problem templates: If there are no treatments for the procedure the start date is the day the 
template was applied.  

• Problem templates: If there are treatments for the procedure the most recent treatment date 
will be used as the start date.  

If the patient has had treatments before the template was applied then the most recent treatment date 
is still used as the start date. If the time interval between the date the template was applied and the last 
treatment date (i.e., the date the temp was applied minus the last treatment date) is greater than the 
time interval between procedures than the date the template was applied is used as the start date. For 
example, if the prior treatment was three years ago and the interval is one year, then the due date is the 
application date.  However, if the prior treatment was six months ago and the interval was one year, 
then the due date is the prior treatment plus the interval. 

• For health maintenance items used in multiple templates: The start date is the date of the 
uncompleted template with the most frequency (that is, the template in which a procedure will 
be complete most frequently). 

How to update a patient's health maintenance information 
There are several ways to update health maintenance procedures: 
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• Use the Health Maintenance screen to indicate the procedure's status (for example, completed 
or refused). 

• Add a health maintenance procedure to a patient note that you enter directly in Patient Records 
or that you upload with the Text Data Loader, by adding the appropriate Dot code (.H:, .H2:, or 
.H3:). 

• Create a progress note with a title matching the name of a health maintenance procedure to 
automatically set the procedure's status to 'Done'. This feature can be turned off using the 
Update HM based on Note Titles check box in the Special Features screen. 

• Update a health maintenance procedure through the Laboratory Data Loader. This works if the 
laboratory data name matches a health maintenance item or if there is an entry for the laboratory 
data name in the health maintenance Laboratory Data Loader cross-reference file 
(HMLBXREF.FL). 

• Load a report with the same name as a health maintenance item (for example, mammography) 
with the Text Data Loader, to update the procedure automatically. It is also updated if the report 
title is in the health maintenance Text Data Loader cross-reference file (HMTXXREF.FL). 

Accessing a patient's historical health maintenance 
information 
If you wish to store historical health maintenance information that is not relevant to current templates 
(for example, childhood immunizations for an older patient), you can add the information to the 
historical health maintenance section.  

• To add a new result for a procedure already in the historical section, click the New button.  

• To add a new procedure to the historical section, click the New Item button and select the 
procedure. Then click the New button to add the status of the new procedure. 

If a patient's health maintenance template has been deleted, any associated performed procedures 
that are not part of another current health maintenance template can be seen as historical health 
maintenance information. Similarly, if a procedure is deleted from a health maintenance template that 
has been assigned to the patient, any data entered for the patient for that procedure is also marked as 
historical.  

If you later assign a template to the patient, and a procedure in the new template is the same as a 
historical procedure, the historical information is moved back to the current health maintenance 
section. 

The Historical Health Maintenance Summary screen displays up to 500 procedures from all health 
maintenance templates assigned to the patient.  

From the Historical Health Maintenance Summary screen, you can work with the patient's historical 
health maintenance information. The procedures for adding, editing, and deleting results for historical 
information is similar to the main health maintenance section.  

• To add a new result for a procedure already in the historical section, click the New button.  

• To add a new procedure to the historical section, click the New Item button and select the 
procedure. Then click the New button to add the status of the new procedure. 

To access the health maintenance section of the patient chart: 

• Select Show > Health Maintenance, or click the Health Maintenance tab on the Patient Chart. 
You can also click the Hlth Maint button on the go to bar. The Health Maintenance Summary 
screen appears. 
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This screen uses a table to display the patient's health maintenance data. The left column lists 
the procedures in the health maintenance template(s) assigned to the patient. The 
Recommended For column displays the template for the procedure (if the procedure is listed in 
more than one template, the column displays "Multiple"). The Due column displays the date by 
which the procedure should be completed and, if applicable, the sequence number for the 
procedure. Procedures that are overdue display in a red box. The other columns represent a 
date on which health maintenance procedures were performed, with a letter marking the 
procedure's status. If a letter is marked with an asterisk (*), you can view comments added for the 
procedure by marking the Detail button. The comments display in the box near the bottom of 
the screen. 

 The number of columns that display depends on the size of the window. You can maximize the 
window (by clicking ), or you can use the scroll bars or the Newer/Older buttons to display 
columns that aren't displaying on the current window. 

Note: The Health Maintenance Summary screen displays up to 500 procedures from all templates 
assigned to the patient. You cannot apply templates that would increase the number of procedures to 
501+. For example, if the patient is already assigned 10 templates, and each template includes the 
maximum number of procedures (50), you can't apply another template because the number of 
procedures is already 500. 

To add health maintenance data: 

1. On the Health Maintenance Summary screen, click the New button. The Health Maintenance 
Procedure <New> screen appears. 

2. The Date and Time fields display the current system date and time. Change these fields if 
necessary. 

3. For each procedure that has been completed, click the Status column and type the status (or 
right click in the column and select a status from the right-click menu). Your options are: 
• X - the procedure has been completed 

• R - patient refused the procedure (with a setting in the ppart.ini file, a status of R can act 
the same as a status of N) 

• E - the procedure was done elsewhere 

• N - the procedure is not applicable for the patient (this status will turn off overdue 
checking) 

• P - the procedure was offered, but the patient postponed 

• O - the procedure has been ordered (with a setting in the ppart.ini file, a status of O can 
act the same as a status of X) 

4. To add a comment to a procedure, type in the comments box at the bottom of the screen while 
the cursor is in the procedure's Status column. 

5. To add additional information for a procedure, click the More button while the cursor is in the 
procedure's Status column. The additional information you can add includes dose, route, given 
by, location, lot, expiration date, manufacturer, and device. 

6. When you finish, click the OK button. 

To change health maintenance data: 

• On the Health Maintenance Summary screen, highlight the column of health maintenance data 
that you want to change. Click the Edit button. Make the appropriate changes. When you finish, 
click the OK button. 
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To delete health maintenance data: 

• On the Health Maintenance Summary screen, highlight the specific health maintenance item or 
column of data that you want to delete. Click the Delete button. A message asks you to confirm 
the deletion. Click the OK button. 

To print health maintenance data: 

• On the Health Maintenance Summary screen, click the Print button. If the Windows Print screen 
appears, select the printer and click the OK button. 

Viewing, adding, customizing, and deleting a patient's 
health maintenance templates 
You can easily view and customize the health maintenance templates that apply to (or have been 
assigned to) a patient.  

If a patient requires special health maintenance procedures, you can create a new template specifically 
for the patient. Each patient can have one individual health maintenance template. 

The rules in the individualized template take precedence over the rules in the other templates if they 
have items in common. 

Occasionally, a patient may end up with the wrong health maintenance template. For example, if you 
had entered an incorrect birth date or sex for a patient on the Patient screen, the patient would be 
assigned the wrong health maintenance template. In this example, a patient registered with the 
incorrect sex will get the wrong template. You can delete the incorrect template and apply the correct 
one. 

Note: Make sure that you correct the patient registration data for the patient before you delete and re-
apply a health maintenance template to a patient. For example, correct the patient birth date or sex 
first, then delete the incorrect health maintenance template, then apply the correct one. 

You can quickly add historical health maintenance information, which may be helpful when you need to 
document a child’s previous health maintenance, for example. Apply an older (in age brackets) health 
maintenance age/sex template to the patient, then enter the pre-existing HM data and save it. Delete 
the older health maintenance template and apply the correct one to the patient. The actual health 
maintenance data will be retained after template is deleted, and will display in the historical health 
maintenance section.  

To view the patient's health maintenance templates: 

• Select Show > Health Maintenance Template. You can also click the Template button on the 
Health Maintenance Summary screen. 
 
The Health Maintenance Templates screen displays the templates that apply to or have been 
assigned to the patient. The name of each template appears on screen as a tab on the Health 
Maintenance Templates screen. If the patient has an individualized template, it displays on an 
"Individ" tab. If the template is specific to a provider, the provider's ID displays above the 
template's name on the tab. 

To apply a new health maintenance template for the patient: 

1. On the Health Maintenance Templates screen, click the New Template button. 

2. If the template is provider-specific, select the appropriate provider. Make sure the practice ID is 
correct, then click the OK button. 
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3. On the Health Maintenance Templates screen, select the template.  
 
You can use the Display by frame (at the top of the screen) to filter the templates that display in 
the list. Click the button that corresponds to the type of template that you want to access. You 
can view All templates, only Age/Sex templates, only Medication templates, only Problem/Dx 
templates, or only Protocol templates. 

4. When the template is highlighted in the table, click the OK button. 

Note: A message will let you know if the patient's age and sex do not match the age and sex 
configured for the template. If the message appears and you still want to use the template, click the Yes 
button. 

To create an individualized health maintenance template for the patient: 

• On the Health Maintenance Templates screen, click the Individual Template button. The 
Individual Health Maintenance Template screen appears. Fill in the fields on this screen. When 
you finish, click the OK button. 

To delete a patient's health maintenance template: 

Important: Age/sex templates are automatically assigned to patients based on their age and sex. If you 
delete the patient's age/sex template, it will display the next time the Health Maintenance tab is 
accessed. You can make an age/sex template partially or completely "not applicable" to a patient by 
setting the status of inappropriate tests in the template to N.  

• On the Health Maintenance Templates screen, click the tab of the template that you want to 
delete. Click the Delete Template button. A message asks you to confirm the deletion. Click the 
OK button. 

Fields on the Individual Health Maintenance Template 
screen 
Field Description 

Description Type a short description of the new template. 

Info File To link a health maintenance information file to the template, 
type the file name in this field. The information file provides 
"help" information to providers about the template or 
procedure. 

HM Procedure This column displays the health maintenance procedures that 
have been added to the template.  

 To add a procedure, click the New Proc button. Select the 
appropriate procedure, then click the OK button. Set up 
the health maintenance procedure's rules, then click the 
OK button. 

 To change a procedure from the template, highlight the 
procedure that you want to change. Click the Edit Proc 
button. Make the appropriate changes. When you finish, 
click the OK button. 

 To delete a procedure from the template, highlight the 
procedure that you want to delete. Click the Delete Proc 
button. A message asks you to confirm the deletion. Click 
the OK button. 
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Rule Summary This column displays the rules that have been set up for the 
corresponding health maintenance procedure. 

Reminder for overdue health maintenance 
When the active health maintenance reminder feature is turned on, this screen displays -- as you open a 
patient chart -- the health maintenance items that are overdue for the patient. 

You can link directly to the patient chart's Health Maintenance tab by clicking the HM button. 

This feature is activated by marking the Enable Active Health Maintenance Reminders check box on 
the Special Features screen. 
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Immunization-Status Selection 
Use the Immunization–Status Selection screen to print a report of selected health maintenance 
activities and lab results. This report may be used for school enrollment, travel, or sending to an 
immunization registry. 

Use Immunizations Selection to specify the activities and results included on the report. Use the check 
boxes on Immunization–Status Selection to specify what the status or statuses of activities and results 
included on the report. A system administrator may use PPart.ini or the Records 6 tab of Special 
Features to specify the default status selection or selections on Immunization–Status Selection. 

Procedures for adding and deleting what is printed on the 
report 
To open Immunization–Status Selection: 

• Click the Health Maintenance tab on Patient Chart to open Health Maintenance Summary. Click 
Immun to open Immunization–Status Selection. 

To add or remove a status: 

• Click the check box to the left of the status in the HM statuses to print area. 

To print full description of an activity or result: 

• Click Print Expanded Description. 

Clear Print Expanded Description to print only a short description in the report. 

To print comments and lot numbers: 

• Click Print Comments, Lot Numbers. 

Clear Print Comments, Lot Numbers to remove this information from the report. 

To create the report in a PDF, HTML, or text file instead of printing: 

• Click Print to file. 

Clear Print to file to send the report directly to a printer. 

Option Description 

HM statuses to print 
area 

The report includes health maintenance activities and lab results with each 
selected status in this area. These are the possible statuses: 

Status Meaning 

X=Done An activity or test was completed on-site. For example, 
this could be a flu shot given during an office visit. 

E=Done 
Elsewhere 

An activity or test performed by another medical facility 
or practice. For example, this could be a blood sugar test 
given by a hospital lab and reported to the provider. 

N=Not 
Applicable 

An activity or test is not appropriate for this patient. This 
speeds report production by eliminating unnecessary 
record searches. 
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R=Refused An activity or test was prescribed for the patient, but the 
patient refused it. 

P=Postponed An activity or test prescribed for the patient, but the 
patient requested it be performed later. The date has not 
been set. 

O=Ordered An activity or text prescribed for the patient that has is 
going to happen in the future. The date has been set. 

A status or statuses may be default selections. A system administrator may 
use PPart.ini or the Records 6 tab on Special Features to make the default 
selections. 

Print Expanded 
Description 

Click to print the full description in the report. 

Print Comments, Lot 
Numbers 

Click to print comments and lot numbers associated with the activity or result 
in the report. 

Print to file Click to prepare the report in a PDF, HTML, or text file. If selected, Render to 
file opens to select the type of file, file name, and the location where to save 
it. 
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Vital Sign and Clinical Element data fulfill HM 
Requirements 
The Health Maintenance feature in Lytec MD is often used to track measurements and observations that 
are recorded as Vital Signs or Clinical Elements. Health Maintenance can be set up to automatically 
recognize Vital Sign and Clinical Element data as fulfilling a HM requirement. 

When data is entered for a Vital Sign or Clinical Element for a particular patient, Lytec MD will mark an 
HM Procedure as done (status = “X”) on the date corresponding to the value, if the name of the Vital 
Sign or Clinical Element is the same as any of the following: 

• “Health Maintenance Name” of the Health Maintenance procedure 

• Any of the “HM Synonyms” for the Health Maintenance procedure 

• The “Health Maintenance Cross Reference” for the Health Maintenance procedure 

• A string cross-linked to the HM Procedure through the Health Maintenance Vital Signs Cross 
Reference File or Health Maintenance Clinical Elements Cross Reference File, whichever applies. 

Note: This only applies to HM Procedures which are already on a Template that has been applied to 
the patient. 

Important: The updating of HM by Vital Signs of Clinical Elements can be turned on or off via the 
ppart.ini settings UpdateHMVitals and UpdateHMCE located in the [HealthMaintenance]. The default 
setting for new sites is ON. The default setting for upgrading sites is OFF. 

Health Maintenance Procedure Names 
When health maintenance procedure names match Clinical Element names or Vital Sign names, health 
maintenance procedures are updated automatically in the Health Maintenance section of the patient 
chart.  

If health maintenance procedure names do not match with Clinical Element names or Vital Sign names, 
you can associate a Clinical Element name and/or Vital Sign name with a Health Maintenance 
Procedure name from the Health Maintenance Procedure Names screen.  

To associate a Clinical Element name and/or Vital Sign name with a Health Maintenance 
Procedure name: 

• On the Health Maintenance Procedure Names screen, enter the Clinical Element name(s) or Vital 
Sign name(s) in the HM Synonyms fields.  

• You can also enter a Clinical Element name or Vital Sign name in the HM Cross Reference field.  

Cross-Reference Files 
You can also create cross-reference files that link health maintenance procedure names with the clinical 
element names and the health maintenance procedure names with vital sign names. To do this, create 
a file named HMVSXREF.FL for Vital Signs and HMCEXREF.FL for Clinical Elements with any text editor 
that can create a text-only (that is, ASCII) file. The files should contain a table in the following format:  

HMVSXREF.FL 

hmname :  vsname1, vsname2...  

hmname :  vsname1, vsname2... 
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Where hmname is a health maintenance procedure name, and vsname1 and vsname2 are the names of 
vital signs. 

HMCEXREF.FL 

hmname :  cename1, cename2...  

hmname :  cename1, cename2... 

Where hmname is a health maintenance procedure name, and cename1 and cename2 are the names 
of clinical elements. 

For example, if the HMVSXREF.FL file contains:  

BP : Diastolic 

then the entry of data for the Vital Sign “Diastolic” will update the BP health maintenance item.  

The HMVSXREF.FL and HMCEXREF.FL files are not case-sensitive.  

Important: Separate cross-reference files need to be created for Clinical Elements and Vital Signs 
because it is possible to have both a Vital Sign and a Clinical Element with the same name in Patient 
Records. 

To create the cross-reference file: 

1. Open WordPad, Notepad, or another text editor. 

2. Type the Health Maintenance name, and corresponding Clinical Element name(s) or Vital Signs 
name separated by a colon.  

For example:  

hmname : cename1, cename2 

hmname : vsname1, vsname2 

Note: The cross reference files are not case sensitive. 

3. Repeat this process until you have linked all desired health maintenance procedure names with 
Clinical Element names or Vital Signs name.  

4. If you created the cross-reference file for Clinical Element names, save the file in your database 
directory (usually p:\ppart) as hmcexref.fl 

If you created the cross-reference file for Vital Sign names, save the file in your database 
directory (usually p:\ppart) as hmvsxref.fl 
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Integrating Patient Records with Horizon Patient 
Folder 
McKesson's Horizon Patient Folder™ WebStations (HPF) is a document imaging system that gives 
physicians, HIM personnel and other hospital staff anytime, anywhere access to review, analyze, code 
and complete electronic charts in their electronic medical records system. When Patient Records is 
integrated with HPF providers can launch HPF WebStations directly from a patient's chart in Lytec MD, 
without logging in separately.  

For detailed information about HPF WebStations, visit www.mckesson.com or consult your Horizon 
Patient Folder documentation. To purchase HPF WebStations, please consult your Lytec MD sales 
representative. 

How does Patient Records work with Horizon Patient 
Folder? 
If you integrate Patient Records with HPF WebStations you can: 

• Launch Horizon Patient Folder WebStations directly from a patient's chart in Patient Records 

Required installation and configuration steps 
The following sections describe the configuration steps required to use HPF WebStations with Patient 
Records: 

• System requirements 

• Do one of the following:  

• Set up and configure Patient Records to use the Enterprise Medical Record View (EMRV)  

• Set up and configure Patient Records to use the Medical Records View (MRV) module 

• Add Horizon Patient Folder as an external system in Patient Records 

System requirements 
• Patient Records can only be integrated with HPF WebStations 13.0 or later. 

• A local web browser must be installed that is compatible with HPF WebStations 13.0 or later.  

• The web browser on the Lytec MD client workstations must be configured to accept cookies from 
third-party Web sites. See the Third-party cookies section in the Horizon Patient Folder 
WebStations Web Integration Services Integration Guide for Customers for complete details.  

• Integration between Lytec MD and HPF partly relies on logon and password validation. Good 
password policies and procedures are critical to secure HPF from inappropriate access (e.g., 
keeping passwords private, one Lytec MD logon per user, etc.). See the Passwords section for 
some guidelines.  

Refer to the Horizon Patient Folder WebStations Web Integration Services Integration Guide for 
Customers for more information.  
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Setting up HPF WebStations (EMRV and MRV) for Patient 
Records  
The setup for HPF WebStations integration with Patient Records depends on whether your organization 
is using the Medical Records View (MRV) module which provides access to all encounters, and 
associated document images, for a patient at a single facility, or the Enterprise Medical Record View 
(EMRV) which provides a summary of all medical records for the patient across multiple facilities. Follow 
the steps below to set up EMRV or MRV depending on what your organization is using.  

Note: You can only integrate one Horizon Patient Folder system with Lytec MD. It is not possible to link 
multiple Horizon Patient Folder systems (e.g., at different hospitals) from a single Lytec MD system. 

Setting up Patient Records to use the Enterprise Medical 
Record View (EMRV)  
If your organization is using the EMRV, you must complete the following steps to integrate the HPF 
EMRV with Patient Records: 

1. Configure settings in the PPart.ini configuration file (see below). 
2. Add “HPF Alternate ID” as a Patient Alternate ID (user-defined field). This field will be displayed 

on the Patient Alternate IDs screen.  
3. For the patients for whom you want to access HPF data, enter their HPF ID in the “HPF Alternate 

ID” field on the patient demographics screen. 

See the PPart.ini file settings section for a complete explanation of the settings in the steps below.  

To configure the PPart.ini file settings:  

1. Make a backup of the PPart.ini file. For example, copy the file and rename it as ppart.bak. 

2. Use WordPad, Notepad, or another text editor to open the file. 

3. Under the [HorizonPatientFolder] section: 
a. Set the "Installed" setting to =ON.  
b. Do one of the following: 
• If your HPF system requires patient passwords, set the "RequirePWD" setting to =ON.  

• If your HPF system requires a secure token, set the "SecureToken" setting =ON.  
c. Set the "EMRV" setting to =ON. This is the default setting.  
d. Optional  Enter the AppID used to identify the host system identifier using the "AppID" 

setting. The AppID is the host system identifier which will be included in the Horizon Patient 
Folder URL calls. For example, AppID=12345. 

e. Optional  Indicate whether you want to close the web browser with the current HPF session 
when Patient Records is closed or parked using the "CloseBrowser" setting. The default 
setting is OFF.  

f. Manually add the "AlternateID" setting to the PPart.ini file under the [HorizonPatientFolder] 
section. Populate this setting with the name of the Patient Alternate ID label which will 
represent the HPF enterprise patient number (EPN) in Patient Records. The maximum 
number of characters for the label is 14. It is only necessary to store one HPF ID for each 
patient. For example, AlternateID=EPN.  
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To add the HPF Alternate ID as a Patient Alternate ID (user-defined field): 

1. In Patient Records select Maintenance > Configuration > Define Other Data > Patient 
Alternate ID. The Patient Define Alternative ID Select screen appears.  

2. Click the New button. The Patient Define Alternate ID <New> screen appears.  

3. Type an Alternate ID label (e.g., EPN) in the Label field. This is the label you entered for the 
PPart.ini file setting, "AlternateID". The maximum number of characters is 14.  

4. Type a description in the corresponding field.  

5. Select Text or Numeric from the Type drop-down list.  

6. Select the fields format (number of characters or digits) from the Format drop-down list. 

7. When you are finished, click the OK button. The Patient Alternate ID is added to the list.  

To add a Horizon Patient Folder ID as an Alternate ID for a patient: 

1. Open the Patient screen for a patient that you want to add EMRV access for in Patient Records.  

2. Click the Alt IDs button. The Patient Alternate IDs <Edit> screen appears. The alternate patient 
ID field (e.g., EPN) that you added from the previous step will be displayed on this screen.  

3. In the alternate patient ID field, type the patient's Horizon Patient Folder ID.  

4. When you are finished click the OK button.  

5. Repeat this process for all patients that you want to access EMRV for in Patient Records.  

Setting up Patient Records to use the Medical Record View 
(MRV) module 
If your organization is using the MRV module, you must complete the following steps to integrate the 
HPF MRV module with Patient Records: 

1. Configure PPart.ini file settings. 

2. Add the HPF Facility Name(s) as Patient Alternate IDs (user-defined field). This field will be 
displayed on the Patient Alternate IDs screen.  

3. Add the Facility Alternate ID as an Alertnate ID for the patients' that you want to access the MRV 
module for in Patient Records.  

See the PPart.ini file settings section for a complete explanation of the settings in the steps below.  

To configure the PPart.ini file settings:  

1. Make a backup of the PPart.ini file. For example, copy the file and rename it as ppart.bak. 

2. Use WordPad, Notepad, or another text editor to open the file. 

3. Under the [HorizonPatientFolder] section: 
a. Set the "Installed" setting to =ON.  
b. Do one of the following: 
c. If your HPF system requires patient passwords, set the "RequirePWD" setting to 

=ON.  
d. If your HPF system requires a secure token, set the "SecureToken" setting =ON.  
e. Set the "EMRV" setting to =OFF.  
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f. Optional  Enter the AppID used to identify the host system identifier using the 
"AppID" setting. The AppID is the host system identifier which will be included in 
the Horizon Patient Folder URL calls. For example, AppID=12345. 

g. Optional  Indicate whether you want to close the web browser with the current HPF 
session when Patient Records is closed or parked using the "CloseBrowser" setting. 
The default setting is OFF.  

h. Manually add the "AlternateIDx" setting(s) to the PPart.ini file under the 
[HorizonPatientFolder] section. Populate the added setting(s) with the name of the 
Patient Alternate ID label that shall be used to store the MRN for a particular HPF 
facility, and the HPF Facility ID for that HPF facility, separated by a comma. The 
maximum number of characters for the label is 14. You can add up to 9 alternate 
IDs for each of your facilities. For example:  
AlternateID1=ACME DOWNTOWN, DWNTN 
AlternateID2=ACME EASTSIDE, EAST 
AlternateID3=ACME WESTSIDE, WEST 

To add the HPF Facility Name(s) as a Patient Alternate ID: 

1. In Patient Records select Maintenance > Configuration > Define Other Data > Patient 
Alternate ID. The Patient Define Alternative ID Select screen appears.  

2. Click the New button. The Patient Define Alternate ID <New> screen appears.  

3. Type the Facility Name in the Label field. This is the Patient Alternate ID label that you entered 
to store the MRN for a particular HPF facility in the PPart.ini file ("AlternateIDx"). The facility ID 
can be no longer than 14 characters.   

4. Type a description for the facility in the corresponding field.  

5. Select Text or Numeric from the Type drop-down list.  

6. Select the fields format (number of characters or digits) from the Format drop-down list. 

7. When you are finished, click the OK button. The Patient Alternate ID is added to the list.  

8. Repeat this process until you have added all facilities for the HPF system (i.e., all of the labels 
you entered for the PPart.ini file setting(s), "AlternateIDx").  

To add the Facility Alternate ID as an Alternate ID for the Patients that you want to access HPF for 
in Patient Records: 

1. Open the Patient screen for a patient that you want add MRV access for.  

2. Click the Alt IDs button. The Patient Alternate IDs <Edit> screen appears. The facility names 
you added from the previous step will be displayed on this screen.  

3. In the Alternate ID field, type the alternate ID for the HPF facility. Make sure to enter all 
alternate IDs if you have more than one facility. 

4. When you are finished click the OK button.  

5. Repeat this process for all patients that you want to access the MRV module for in Patient 
Records.  

Add Horizon Patient Folder as an External System 
Before you can access HPF WebStations from Patient Records, you must set up HPF as an external 
system in Patient Records and link your Operators to the system so they can access HPF from Patient 
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Records without having to login separately. See the Adding an External System section for complete 
details.  

Please note when adding HPF as an external system you must select the Horizon Patient Folder option 
from the Type drop-down list on the New External System screen.  

Accessing Horizon Patient Folder from Patient Records 
When you have completed the required configuration steps, you can launch HPF WebStations from 
Patient Records. 

Note: All of the HPF WebStations screens launched by Patient Records are web-based and a part of the 
HPF WebStations application.  

To access HPF WebStations from Patient Records: 

1. Open a patient's chart. 

2. Click the Horizon Patient Folder button on the Patient Chart.  

3. If you are set up for the EMRV, the EMPI Record View page will open for the patient.  

If there is no HPF identifier entered for the patient, the HPF Patient Search screen will open. 
Select the matching patient from the list. For detailed information about searching for patients 
in HPF WebStations, consult your Horizon Patient Folder documentation.  

• If you are set up for the MRV module, and the patient is only connected to one facility, the 
medical record viewer will open for the patient.  

If the patient is connected to more than one facility, the Select a Facility screen appears. Select 
the facility in the list that you want to view the MRV module for, and click the OK button.  

If the selected patient is not found in the Horizon Patient Folder database, the HPF Patient 
Search screen will be opened. Select the matching patient from the list. For detailed 
information about searching for patients in Horizon Patient Folder, consult your Horizon Patient 
Folder documentation.  
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Hospital reports 
The Hospital Reports section of the patient chart contains the physician’s summaries of patient 
hospitalizations. Adding hospital reports information is much like adding a progress note. You can type 
the history directly into Patient Records, or you can use the Text Data Loader to import data from an 
outside source.  

The Hospital Reports section consists of a single note that displays the date you first entered 
information for the patient. As with progress notes, you can use templates to quickly and accurately 
record information. Templates provide a general framework, indicating what information you should 
enter. 

The Hospital Reports section can be as long as you like, and is treated much like one long progress 
note. You can rename the Hospital Reports section of the chart and use this section for your own 
category of patient information. 
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Images 
You can add graphical images to your progress notes or other text-based sections of the patient chart. 
You can:  

• Create a graphical image for a note at any time while you are adding or editing a note.  

• Take an image from an image template, modify it, and attach it to a note.  

• Create a new image template.  

• Input a scanned image (for example, an EKG).  

You will find Patient Records’ drawing capabilities both powerful and easy to use.  

You can import digital images to Patient Records so they will be available as images or image 
templates. You can use commercial image collections, or you can scan images with a desktop or hand 
scanner. Images can be black and white or color. Some images, such as EKGs, are clearer in color if the 
tracing and grid are different colors. The file types supported by Patient Records are listed on the 
Import Image dialog box, which is available when you add a new image.  

You may need to experiment with adjusting the size of the scanned image. Once the image is saved as 
a file in one of the two formats you can import the image to Patient Records.  

You can also create images freehand in much the same way as you would in any graphics application. 
You need a Microsoft or compatible mouse or a Lytec MD-approved light pen to add or revise images, 
although you can view images without a mouse. However, the left mouse button selects image tool bar 
items and activates features.  

Note for WTS and Citrix sites 
Due to Windows Terminal Services and Citrix limitations with vector-based graphics, you may 
experience a problem drawing curved lines. To solve this issue, we recommend slowing down the 
mouse movements, or drawing the image from a standalone workstation. 

Adding, editing, and deleting images 
To open the images screen: 

• Click the Chart button on the toolbar, or select File > Open Chart. Use the Lookup screen to 
open the appropriate patient chart. When the chart is open, click the Images tab. The Images 
<All Chart Sections> screen appears. 

To add an image: 

1. On the Images <All Chart Sections> screen, click the New button. The Images screen appears. 
 
To modify an existing image template (the original template image remains unchanged), select 
File > Open Template. Select the appropriate template.  

2. Use the drawing tools to add the image. When you finish, click the OK button.  

3. On the Image: Save As screen, type a name for the image and select the chart section to which 
the image should be attached (you can always view the image on the Images tab). You can also 
select a note to which the image will be attached. When you finish, click the OK button. 

To rename an image: 

• On the Images <All Chart Sections> screen, highlight the image that you want to rename. Click 
the Rename button, then change the name. When you finish, click the OK button. 
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To delete an image: 

• On the Images <All Chart Sections> screen, highlight the image that you want to delete. Click 
the Delete button. A message asks you to confirm the deletion. Click the OK button. 

Image drawing tools 
The image toolbar provides standard graphics options such as pen, ellipse, and line. To use an item on 
the images tool bar, simply click it using the left mouse button. The mouse will perform the operation 
you select. When you want to switch items, just click the new toolbar item.  

The image toolbar options include:  

Name Description 

Pen Draw images “free-hand” directly on your screen. Hold the left mouse 
button down.  

Eraser Erases the image, pixel by pixel. Move the mouse pointer to the area you 
want to erase and hold down the left mouse button while you move the 
mouse.  

Text  Enters text. Click the left mouse button where you want the line to begin, 
move the mouse pointer to where you want the line to end, and then 
release the left mouse button.  

Line  Draws a line. Hold down the left mouse button where you want the line to 
begin, move the mouse pointer to where you want the line to end, and then 
release the left mouse button. 

Ellipse  Draws an ellipse. Hold down the left mouse button and move the mouse 
pointer until the ellipse is the size you want. Then release the mouse button. 

Rectangle  Draws a rectangle. Hold down the left mouse button and move the mouse 
pointer until the rectangle is the size you want. Then release the mouse 
button.  

Fill Ellipse  Draws a filled elliptical area at the location of the mouse pointer. 

Fill Rectangle  Draws a filled rectangular area at the location of the mouse pointer.  
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Laboratory data 
The Laboratory Data section of the patient chart is used to record numeric and textual laboratory data 
for the patient. To help you interpret this data, you can display selected numeric and textual laboratory 
data items on a patient flow chart or on a laboratory data table.  

Before you begin entering patient data, your system administrator will need to set up laboratory data 
test names to define the tests you want to display and track. In addition, the normal ranges that your 
system administrator defines on the Laboratory Value Ranges screen determine which values are 
highlighted as abnormal on the Laboratory Data screen for lab data entered directly into the program.  

There are several ways to enter laboratory data. You can use the Lab Data Loader to import laboratory 
test results provided electronically by outside laboratory facilities or internal lab information software. 
An interface exists that can handle file formats provided by most outside labs.  

You can also enter information directly into the laboratory data windows, through a Patient Records 
progress note, or via the Text Data Loader to transfer information from a file or another application.  

You can view four different types of laboratory data on the Laboratory Data screen:  

• Most Recent Lab Data – Provides a convenient display of the most recent information for each 
category of laboratory data in the Lab Data Tables. You may graph the most recent laboratory 
data but you may not add or edit laboratory data in this screen.  

• Lab Data Tables – Lets you add, view, edit, or graph numeric laboratory data for any laboratory 
data category.  

• Microbiology – Lets you view and edit text information about microbiology data.  

• Miscellaneous – Lets you view and edit text information about miscellaneous laboratory data.  

The Microbiology and Miscellaneous categories are for text information and work like all text-based 
sections of the patient chart.  

Adding comments to laboratory data 
You can attach a comment to a laboratory data. If the laboratory data has an attached comment, an 
asterisk (*) appears next to the data item. To view the comment in the Display panel, select the data 
item from the screen. In addition to comments, the Details panel also displays information (such as 
laboratory data test name, normal range, critical high or low range, and provider ID) for laboratory data 
items.  

Sending critical range messages to providers 
If you enter a value that falls in the critical range for a laboratory data item and messaging for critical 
values was enabled, the patient’s providers are automatically alerted by a message sent if you entered 
the provider in the Lab Data screen. The message is automatically generated and contains the critical 
value for the test performed, the date and time of the test, and the normal and critical ranges for the 
test. You can send this message by selecting the patient’s providers in the Lab Data screen.  

Patient Comment Notes 
The laboratory data section of the chart allows you to add comments (“Patient Comment Notes”) which 
can be viewed by the patient via Web View. When creating a Patient Comment, you may choose to 
apply it to a specific lab test, all tests on a given template for a particular date, or all tests from that 
date. 
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Because this feature is Web View based, it is imperative that you have Web View and the patient has 
access to Web View. You can do this by enabling the "Allow Web View access for patient" 
configuration.  

Once a Patient Comment has been created, the user can then log into Web View to view the note. If the 
patient has a new comment, it is displayed on the first screen after the user logs in. They can also view 
the note under the applicable chart section. When the section is open, they can scroll to the item, and 
click on it to view the note. The Comment column also displays a "Y" if a comment exists for the result.  

For example, if a Patient Comment note is created for a specified lab test, the patient can click on the 
Lab Results link on the navigation bar on the left hand side of the Web View page. When the Lab 
Results page is open, they can scroll to the lab result and click on it to view the result and comment.  

To view all Patient Comment notes for a patient when the patient's chart is open, select the Patient 
Comment Notes option from the Show menu. This displays the Patient Comment screen. From the 
Patient Comment screen you can view older and newer notes, edit an existing note, print a note, fax a 
note, or attach an image to a note. 

See the Patient Comment Notes section for a complete overview of this feature. 

Entering text values on the Laboratory Data Table screen 
Patient Records lets you enter text values in laboratory data. For example, if you want to record a color 
for U/A, you can enter “brown.”  

You can use this feature for any piece of text you want. For example, you could use words like "many," 
"few," or "pink," or ranges like "1-5," or "5-20." The only restriction on text data entered this way is that 
it cannot be plotted, and in some cases is not highlighted as abnormal.  

The following text values are the valid text values that can be entered on the Laboratory Data Table 
screen. The values are case-sensitive and must be entered as they are seen below. Please note this 
feature will not work if you attempt to add values not in the list.  

"   ",     

"NEGATIVE",   

"WNL", 

"-", 

"TR", 

"1+",    

"2+", 

"3+", 

"4+", 

 "ABNL", 

"+",   

"POSITIVE", 

"TNTC", 

"YELLOW", 

"CLEAR", 

"CLOUDY",   
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"TURBID", 

"COLA", 

"PINK", 

"RED"    

Viewing, adding, editing, and deleting laboratory data 
To open the laboratory data screen: 

1. On the patient chart, select Show > Laboratory Data, or click the Laboratory Data tab. The 
Select Lab Category screen appears.  

2. Mark the radio button that corresponds to the type of laboratory data you want to display.  

3. Click the OK button. The Laboratory Data screen that corresponds to your selection appears.  

Note: You can also go directly to the Most Recent Lab Data screen or the Lab Data Tables. On the Go 
To bar, click the Recent Lab Data button or the Lab Tables button. 

To view the most recent lab data: 

The Most Recent Lab Data screen provides a convenient way for you to view the most recent laboratory 
data for the patient on a single screen. You can graph a category of laboratory data from the Most 
Recent Lab Data screen.  

1. When you select Most Recent Lab Data on the Select Lab Category screen, the Most Recent 
Lab Data screen appears. The name of the current patient displays in the title bar.  

2. To view previous laboratory data, click the Older button. To view more recent data, click the 
Newer button.  

3. An asterisk next to data indicates that there is a comment about the data in the Details panel at 
the bottom of the screen. To view the comment, select the data from the screen.  

To view the lab data tables: 

The Lab Data Tables screen contains laboratory data for all the primarily numeric laboratory data.  

1. When you select Lab Data Tables on the Select Lab Category screen, the Laboratory Data Table 
screen appears, with the name of the current patient in the title bar.  

2. Select the Laboratory Data template that you want to view from the table. The laboratory data 
for this template appears. You can also switch templates by clicking the right or left arrow 
buttons next to the Template table.  

3. If your Lab Data Table includes Current Medication, Any Historical Medication, or Medications 
by Class, you are prompted to select a medication from a list. Highlight a medication from the 
Medications table, click the Apply button, and then click the Close button.  

4. To view previous laboratory data, click the Older button. To view newer laboratory data, click 
the Newer button.  

5. For each of the numeric categories of laboratory data, a list of the data items you defined in the 
Laboratory Data Names screen is displayed in the left column. The results for each date are 
displayed in the remaining columns.  

A note about normal ranges  
If your system administrator has defined the normal ranges of values for laboratory data, abnormal 
values are highlighted on the screen. On a color monitor, abnormal values are highlighted in color. 
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High values are highlighted in red. Low values are highlighted in green.  
 
Any numeric laboratory data values that are out of range appear highlighted in the Laboratory Data 
Table screen. Except for the pre-defined data values (e.g., WNL, -, 1+, 2+, 3+, 4+, and ABNL), text 
laboratory data values are not highlighted, even if they are abnormal.  
 
Normal values or ranges of values are established with the Laboratory Value Ranges screen or when 
the lab data is received electronically from an outside lab. You can view the normals defined for the 
laboratory data item. Normals are displayed in the Details panel when you select the data item.  

To manually add laboratory data: 

1. On the Laboratory Data Table screen, select the Laboratory Data template you want to work 
with from the Template table.  

Note: You can quickly scroll through the templates by clicking the right or left arrows on the keyboard 
or next to the Template field.  
 
You can also jump directly to a template by typing the first letter of the template name (for example, 
type the letter C to jump to the CBC template). The first template starting with that letter will be 
selected. If this is not the template you want, keep typing the letter until the template is selected (this 
scrolls alphabetically through the templates that begin with the letter).  

2. When the laboratory data template appears, click the New button on the Laboratory Data 
Table screen. The Lab Data <New> screen appears, with the name of the current laboratory 
data template in the title bar.  

3. Enter the date and time, followed by each laboratory data item. Use the TAB key to move 
between fields.  

4. If you want to include comments for a result that you entered, select that result box and click 
the Comment button. Enter your comments in the Comments panel and click the OK button 
when you are finished.  

5. If you want to send the results to be reviewed by a provider or an automatic message about 
critical values, enter a provider ID in one of the four Send To fields or choose a provider ID 
from the drop-down arrow table. You can select up to four providers by using the rest of the 
Send To fields.  

6. When you have entered the correct values, click the OK button. If you do not want to enter the 
data, click the Cancel button instead.  

To automatically add laboratory data: 

• Set up the Lab Data Loader to automatically load lab data into the patient chart as soon as it is 
received electronically from the laboratory. 

To change laboratory data: 

1. On the Laboratory Data Table screen, select the Laboratory Data template you want to work 
with from the Template table. The laboratory data for this template appears. You can click the 
Print button to print the data.  

2. Highlight the column of data you want to edit. Click the Edit button. The Lab Data <Edit> 
screen appears.  

3. Make the necessary changes.  
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4. If you need to revise the time for a particular test, select the test, edit the time, and click the 
Save Time button.  

5. To change a comment, click the Comment button, then enter or edit your comment.  

6. Click the OK button to save your changes.  

To delete laboratory data: 

You can delete a single lab data item or an entire column of laboratory data. Patient Records keeps 
track of your changes, providing a type of audit trail.  

1. On the Laboratory Data Table screen, select the Laboratory Data template you want to work 
with from the Template table. The laboratory data for this template appears.  

2. Highlight the item or column of data you want to delete. Click the Delete button on the 
Laboratory Data screen.  

3. Click the OK button to confirm the deletion, or click the Cancel button to keep the column of 
laboratory data.  

To graph lab data on the Laboratory Data Table screen: 

You can graph laboratory data for any template from the Laboratory Data Table screen. This makes it 
easier to see trends or changes in a patient’s condition.  

1. Select the appropriate template of Laboratory Data from the Template table.  

2. Highlight up to 4 rows of laboratory data you want to graph. You can also highlight cells in 
different rows by clicking on the first cell in one row, and then pressing CTRL while you select 
other cells in other rows.  

3. Click the Graph button. The Laboratory Data Graph screen appears with a line graph of the 
laboratory data item(s) you selected. Once you have created the laboratory data graph, you 
can print it.  

4. When you finish, click the Close button to return to the Laboratory Data screen.  

To graph laboratory data on the Most Recent Lab Data screen:  

1. On the Most Recent Lab Data screen, highlight up to 4 cells in one or more Laboratory Data 
categories. To highlight multiple cells, click on one, then press SHIFT while you select the 
others.  

2. Click the Graph button. The Lab Date Range Selection screen appears.  

3. Enter the beginning and ending date for the range of dates you want to graph.  

4. Click the OK button. The Laboratory Data Graph screen appears, with a line graph of the 
information you selected.  

To print a lab data graph:  

• When the graph of the lab data is open, click the Print button. If the Windows Print screen 
appears, select the printer and click the OK button. 
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Letters 
The Letters section of the patient chart is designed to allow providers to write letters about their 
patients. For example, you can write letters to a patient (about a lab test or physical, etc.), refer a 
patient, send back a consultation report, respond to an insurance company request, or write a general 
letter. Letters written in Patient Records are stored in the Letters section so that you can review or edit 
them at a later time.  

Letters are a modified version of the progress notes feature, and are part of the other text-based 
section of the patient chart. Many of the functions available for the notes feature work with letters, such 
as entering and editing text, inserting Dot codes and images, and using QuickText.  

Letters use special letter templates. These templates can contain built-in macros, called letter codes, 
that enable you to automatically include patient demographic and clinical data into your 
correspondence. Patient information (such as patient name, age, address, sex, weight, blood pressure, 
visit notes, current medications, and patient problems) can automatically appear on screen when the 
template is brought up.  

Letter templates can also contain conditional logic that determines which phrases appear, and can 
contain page templates that specify how the letter should be printed. You can control the margins, 
font, and font sizes to be used. Headers and footers can also be included.  

Adding, editing, and deleting letters 
To add a letter: 

1. In the patient chart, select Task > Letters, or click the Letter button on the toolbar.  
• If no letters are stored (already exist) in the Letters section, a message asks if you would 

like to create a new letter. Click the Yes button. The Insert Template screen appears.  

• If letters exist for the patient, click the New button on the Letters screen. 

2. On the Insert Template screen, select one of the templates in the list box, if any are available, 
and then click the OK button. If the template that you want is not displayed in the list box, you 
can use the scroll arrows to find that template, or you can enter the template name and click 
the Search button.  
 
If you do not want to use a template, click the Cancel button.  

3. On the Letters screen, enter the text. You can:  
• Type text.  

• Insert Dot codes and letter codes. Select Insert > QuickText, or click the QText button on 
the toolbar.  

• Insert label characters wherever you want patient-specific data inserted. Select Insert > 
Label. You can enter QuickText names within the label markers. For example, «macro».  

4. When you finish, click the OK button 

5. If prompted, enter your signature. 

To change a letter: 

1. In the patient chart, select Show > Outside Reports > Letters, or click the Letters tab. The 
Letters screen appears. 

2. Use the Newer and Older buttons to find the letter that you want to change. 
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3. Click the Edit button. Make the appropriate changes. 

4. When you finish, click the OK button. 

5. If prompted, type your signature. 

To delete a letter: 

1. In the patient chart, select Show > Outside Reports > Letters, or click the Letters tab. The 
Letters screen appears. 

2. Use the Newer and Older buttons to find the letter that you want to delete. 

3. Select Edit > Delete Note. A message asks you to confirm the deletion. 

4. Click the OK button. 

To print a letter:  

1. Click the Print button. 

2. Under Print Range, specify the portion of the document you want to print. 
• Entire File: Select this option to print the entire file. 

• Selected Pages: Select this option to enter page numbers or page ranges you want to 
include. 

Note: The Selected Text option is currently not available. 

3. In the Number of Copies field, enter the number of copies you want to print. 

4. To print a complete copy of the note before the first page of the next copy is printed, select the 
Collate check box.  

5. Click OK, to print the letter. 

To fax a letter:  

1. Click the Fax button. The Fax to screen appears. 

2. Select who you want to send the fax to, and click OK.  
• Referring Source: The Referring Source for Fax screen appears. Click one of the following 

buttons on the Referring Source for Fax screen: 

• Current Referring Sources: Click this button to select one or more of the patient’s current 
referring sources to send the fax to. Once all referring sources have been selected, click 
the OK button. The selected source(s) will be displayed in the Ref. Sources for this Appt 
list. 

• Current Cases: Click this button to select a current case and its referring sources to send 
the fax to. Once a case has been selected, click the OK button. The selected source(s) will 
be displayed in the Ref. Sources for this Appt list. Please note you may only select one 
case at a time. 

• Referring Source List: Click this button to send a fax to a referring source not currently 
assigned to the patient. This button displays the Referring Source Select screen. Once all 
sources have been selected, click the OK button. The selected source(s) will be displayed 
in the Ref. Sources for this Appt list. 

Click the OK button, once all referring sources have been selected. The fax will be sent to the 
selected referring sources. Please note the referring source must have a fax number, before the 
fax is sent.  
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• Patient: The Patient Fax Number screen appears. Enter the patient's fax number in the Fax 
Number field, and click OK. 

• Other: The Fax to Other screen appears. Enter the recipient's fax number in the Fax 
Recipient field, and the recipient's fax number in the Fax Number field. Click the OK 
button. 

Note: The Selected Text option is currently not available. 

3. In the Number of Copies field, enter the number of copies you want to print. 

4. To print a complete copy of the note before the first page of the next copy is printed, select the 
Collate check box. 

5. Click OK, to print the letter. 
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Messages 
The Messages section contains messages about the patient that have been recorded through the 
messaging system. As with other note-based sections of the patient chart, you can add or edit notes in 
the Messages section.  
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Orders 
The Orders tab on the patient chart displays the patient's pending, in process, and completed orders. 
From this screen, you can: 

• Add orders: Click the New button. The Order <New> screen appears. 

• Edit orders: Highlight the appropriate order in the table and click the Edit button. The Order 
<Edit> screen appears. 

• View orders: Highlight the appropriate order in the table and click the View button. The Order 
<View> screen displays the order's information, except for the procedures in the order. You 
cannot make changes to this information. 

• Delete orders: Highlight the appropriate order in the table and click the Delete button. A 
message asks you to confirm the deletion. 

To filter the orders that appear on this screen, click the Select button. Use the Select Orders screen to 
filter the orders that you want to view. 
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Past medical history 
The patient chart provides three patient history sections:  

• Past Medical History – Records all the chronic illnesses, hospitalizations, and other health 
information for the patient. 

• Family History – Records medically relevant information about the patient’s family, including 
major diseases and chronic conditions. 

• Social History – Records medically relevant information about the patient's life, such as marital 
status, habits, work, etc. 

Adding patient history information is much like adding a progress note. You can type the history 
directly into Patient Records, or you can use the Text Data Loader to import data from an outside 
source.  

Each history section of the chart consists of a single note that displays the date you first entered history 
information for the patient. As with progress notes, you can use templates to quickly and accurately 
record historical information. Templates provide a general framework, indicating what information you 
should enter. 

The history sections can be as long as you like, and each section is treated much like one long progress 
note. You can design templates to provide forms for entering history information. You can also rename 
any, or all, of the three History sections of the chart and use these sections for your own categories of 
patient information. 
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Pathology 
The Pathology section of the patient chart contains pathology reports for the patient. Adding 
pathology information is much like adding a progress note. You can type the history directly into 
Patient Records, or you can use the Text Data Loader to import data from an outside source.  

The Pathology section consists of a single note that displays the date you first entered pathology 
information for the patient. As with progress notes, you can use templates to quickly and accurately 
record information. Templates provide a general framework, indicating what information you should 
enter. 

The Pathology section can be as long as you like, and is treated much like one long progress note. You 
can rename the Pathology section of the chart and use this section for your own category of patient 
information. 
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Patient Messages 
The Patient Msg section of the patient chart opens the Patient Messages screen. This screen displays 
the messages for the patient from the current operator or all operators (depending on configuration). 
This screen also allows you to send secure messages to patients via Web View. Once the message has 
been sent, a message will be sent to the patient's private e-mail account (entered on the Patient screen) 
letting them know they have received a secure message from their health care provider. They can then 
log into Web View to view the message in their Inbox. 

Note: To view all operator messages for the selected patient the Access Level, "All Messages For 
Patient" must be enabled. 

Important: To send messages to patients via Web View you must have Web View, and the "Allow Web 
View access for patient" configuration must be enabled for the patient.  

From this screen you can: 

• Create: Create a new message. You can send a new message to the patient and they can access 
their message via Web View. When a message is sent to a patient, a message is also sent to the 
patient's private e-mail account which lets them know they have received a secure message from 
their health care provider. They can then log into Web View to view the message in their Inbox. 
Once the new message has been sent, the message will be saved in the Patient Messages, Sent 
folder.  

• Delete: Delete the selected message. Deleted messages move to the Deleted folder. 

• View: Open the selected message. In addition, a message may be opened by double-clicking it. 

• Print: Click to print the selected message. 

• Select: Click to select messages to view from the Select Messages screen. This screen allows you 
to select the messages displayed in the message area. This option only applies to the current 
patient.  

Please note the Change Op button and Link button are disabled on this screen. 

For a complete explanation of the messaging system see the Messaging System section. 
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Prenatal 
The first time the Prenatal tab is accessed for a patient, the Pregnancy <New> screen is displayed. 
This screen allows you to enter an identifying title for the pregnancy (e.g., “First Pregnancy”) and the 
LMP (last menstrual period). The remaining fields on this screen pertain to the ultimate outcome of the 
pregnancy and can be completed at a later time (unless you are documenting a past pregnancy). To 
start documenting a current pregnancy, once the title and LMP has been entered, click the OK button. 
The Prenatal Visit Flow Chart screen is displayed. For the remainder of the pregnancy, when you open 
the Prenatal section of the chart for the patient, the Prenatal Visit Flow Chart screen will be displayed.  

Other features of the Prenatal Visit Flow Chart screen include: 

• Calculation of Estimated Date of Delivery (on the Estimated Due Date screen) 

• Entry and review of pregnancy-specific problems 

• Management of pregnancy-related health maintenance data 

• Display of Progress Notes that pertain to the patient's pregnancy 

• View of the patient's current medications 

• Access to historical pregnancy data 

Prenatal Visit Flow Chart section 
The main section of the screen is a flow chart showing one row for each of the patient's visits. The 
columns of this flow chart are based on the PrenatalVisit flow chart template provided with Patient 
Records. It is possible to modify this template to meet your specific practice needs. See the 
Flow/Lab/Clinical Templates section for more information. 

To enter data for the visit, click the Insert button. This will insert the current date and the Estimated 
Gestational Age automatically. Enter the applicable information in the supplied fields. To clear data 
from the flow chart, highlight one or more cells and click the Clear Data button.  

The data presented in the Prenatal Visit Flow Chart, the Prenatal Lab/Plans screen, and prenatal visit-
related Progress Notes is displayed based on a start date and end date. The start date and end date 
are determined based on the following logic: 

Start date 

• If there is an EDD, the start date is 280 days before the EDD. 

• If there is no EDD, the start date is the date of the LMP. 

• If there is no LMP, the start date is the date the current pregnancy was entered into the database. 

End date 

• If there is a date of delivery, the end date is the date of delivery. 

• If there is no date of delivery, the end date is 336 days after the determined start date. 

Note: The pregnancy start and end dates are displayed in the title bars of the Prenatal Visit Flow 
Chart and Prenatal Lab/Plans screens.  

Important notes about the PrenatalVisit template  
The Prenatal Visit Flow Chart screen will only display data from the Prenatal flow chart template with 
the exact title “PrenatalVisit” (case-sensitive). When Lytec MD is installed, a flow chart of that name will 
be loaded into your system, populated with data which corresponds to general prenatal care practices. 
If this template is deleted, no data will be displayed on the Prenatal Visit Flow Chart screen. Any 
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template with a different name or of a different type will not have any effect on the display of data on 
the Prenatal Visit Flow Chart screen. 

See the Flow/Lab/Clinical Templates section for more information.  

Medication list 
The Medication list located at the top left-hand side of the screen displays information about the 
patient's current medications. Information in this list includes the following details for current 
medications: 

• Medication name 

• Size 

• Dosage 

• Frequency 

Note: When a prescription is being written or edited, drug-disease checking will check for interactions 
with pregnancy if the patient has a current pregnancy. 

Pregnancy Problem list 
This section of the Prenatal Visit Flow Chart screen allows you to enter and view active pregnancy-
specific problems for the current pregnancy. You can select the Show Inactive check box to view 
inactive pregnancy-specific problems for the current pregnancy. Please note only pregnancy related 
problems will be shown in this list. Problems entered from the patient chart's problem list will be 
contained in that section of the chart.  

To add a problem: 

1. On the Prenatal Visit Flow Chart screen, click the New Problem button. You can also right-
click in the Problem list located in the top left of the screen and select the New Problem 
option. The Pregnancy Problem <New> screen appears. 

2. Fill in the fields on the Pregnancy: Problem <New> screen.  

3. When you finish, click the OK button. The problem appears in the problem list.  

To change a problem: 

• On the problem list, highlight the problem that you want to change. Right-click, and select the 
Edit Problem option. Make the appropriate changes. When you finish, click the OK button. 

To delete a problem: 

• On the problem list, highlight the problem that you want to delete. Right-click, and select the 
Delete Problem option. 

Fields and buttons on the Pregnancy Problem screen 
Field Description 

Problem Type the name of the new problem. The maximum name length is 50 
characters. You can also click the Lookup button, to select a diagnosis 
code from the Diagnosis Code Select screen.  
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Code 1 Enter a diagnosis or other standard code. Click the Lookup button, to 
select a diagnosis code from the Diagnosis Code Select screen. If you 
selected a problem from the Diagnosis Code Select screen, the 
diagnosis code will automatically be entered in this field.  

Code 2 Enter an additional diagnosis code or other standard code. Click the 
Lookup button, to select a diagnosis code from the Diagnosis Code 
Select screen.  

Provider The logon provider is automatically entered in this field. To change the 
logon provider, click the down arrow button. The Provider Select 
screen appears. Select the appropriate provider and click the OK 
button. The selected provider will be displayed in this field. 

External Provider Select the external provider that is associated with the problem for the 
patient. Click the down arrow button to access the Provider Select 
screen. Select the appropriate provider and click the OK button. The 
selected external provider will be displayed in this field.  

Note Enter any notes you may have about the problem. The maximum length 
is 100 characters.  

Active/Inactive Select whether the problem is active or inactive. New problems default 
to Active.  

Date of onset Enter the date of onset for the Problem. When creating a new problem, 
the date defaults to the current date. 

Date last occurred Enter the date the problem last occurred. This date is intended for 
episodic conditions. 

Date resolved Enter the date the condition was resolved, if applicable. 

Lifecycle Select whether the condition is: Improving, Stable, Worsening, or 
Resolved.  

Fields and buttons on the Prenatal Visit Flow Chart screen 
Field Description 

Allergies This section displays the patient's allergies. You can use the 
right and left arrow buttons to scroll through the patient's 
allergies. This section is only displayed for the patient's current 
pregnancy. See the Rx/Medications section of the patient chart 
for  

Pre-Pregnancy Weight The patient's pre-pregnancy weight can be entered and viewed 
here. In the adjacent field enter the units. The default setting is 
pounds. 

Blood Transfusion OK Select this option if it the patient has confirmed willingness to 
receive, if necessary, a blood transfusion.  

Anesthesia Consult Select this option if an anesthesiology consultation during labor 
is planned.  

New Problem button Click this button to open the Pregnancy: Problem <New> 
screen. This screen allows you to enter a new problem for the 
patient's pregnancy. See the Pregnancy Problem List section for 
more information.  
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LMP The LMP date entered on the Pregnancy screen will be 
displayed in this field. You can change this date if necessary by 
typing a new date or click the down arrow button to access the 
calendar.  

EDD Best Estimate This field displays the best estimated due date. Initially this is 
calculated using the patient's LMP but may be updated on the 
Estimated Due Date screen. See the Estimated Due Date 
section for more information.  

EDD Details button Click this button to open the Estimated Due Date screen. Use 
this screen to enter and review data related to due date 
estimation.    
See the Estimated Due Date section for more information. 

Insert button Click this button to insert a new row in the Prenatal Visit flow 
chart. 

Clear Data button This button allows you to clear flow chart data. Highlight the 
data you want to clear, and click the Clear Data button. Please 
note actual changes to the database will not take place until 
you exit the Prenatal Visit Flow Chart screen. 

Detail Click this check box to display the Comment field. 

Print button Click this button to print a report with information from the 
current pregnancy. This button opens the Select Print Sections 
screen. The screen allows you to indicate which sections you 
wish to print. Your options include: 

 Initial OB Visit 
 Prenatal Visit Flow Chart 

 Prenatal Lab/Plans 
 OB Plans/Patient Education 

 OB Progress Note  
After you have selected your options, click OK to print the 
report. A message appears asking whether you want to print 
images associated with notes. Click Yes, to print the images. 
Click No, if you do not want to print the images.  

Lab / Plans button Click this button to view and enter prenatal health maintenance 
data for the patient. This section is similar to the Health 
Maintenance section of the patient chart. See the Prenatal 
Lab/Plan section for more information.  

Educ / Plans button Click this button to display an existing Progress Note from the 
present pregnancy regarding pregnancy-related plans and 
education discussed with the patient (or to create a new one). 
Lytec MD allows you to specially identify such notes with a 
specific title. The note title is specified using the ppart.ini 
setting, "PlansNote". The default setting is blank. Your system 
administrator must enter the title of the note in the ppart.ini file 
before you can use this button.  
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Initial H&P button Click this button to display an existing Progress Note from the 
present pregnancy recording the initial prenatal evaluation 
("History and Physical") (or to create a new one). Lytec MD 
allows you to specially identify such notes with a specific title. 
The title is specified using the ppart.ini setting, "InitialNote". 
The default setting is Prenatal Care. Your system administrator 
can change this setting to meet your specific practice needs.  

Prog Notes button Click this button to display prenatal visit-related Progress Notes 
from the present pregnancy (or to create a new one).  Lytec MD 
allows you to specially identify such notes with a specific title. 
The title is specified using the ppart.ini setting, "ProgressNote". 
The default setting is "OB". Your system administrator can 
change this setting to meet your specific practice needs.  

Preg button Click this button to open the Pregnancies screen. This screen 
displays a list of the patient's pregnancies. Use this screen to 
edit an existing pregnancy or add a new pregnancy. 

Preg Summary button Click this button to open the Pregnancy <Edit> screen. This 
screen allows you to edit the patient's current pregnancy 
information.  

New Preg button Click this button to add a new pregnancy for the patient. A 
message appears asking whether this is the current pregnancy. 
Click Yes, if it is a current pregnancy, click No, if it is not a 
current pregnancy. The Pregnancy <New> screen is displayed. 
Fill in the fields on this screen and click OK.  

Comment Enter any comments you may have. This field is only displayed 
when the Details check box is selected. 

Fields and buttons on the Pregnancy screen and Infant 
Information screen 
Field Description 

Title Enter a title for the patient's pregnancy (e.g., "First Pregnancy"). 
 This may not be changed once the pregnancy is created. 

LMP Enter the date of the first day of the patient's last menstrual 
period, if known. Click the down arrow button to access the 
calendar. 

Delivery/Resolution 

Date of Delivery/Resolution Enter the date of delivery or resolution of the pregnancy. Click 
the down arrow button to access the calendar. 

Outcome Select the pregnancy outcome from the drop-down list. Your 
options are: Vaginal Delivery, C-Section, SAB, and Fetal Demise. 
Your system administrator can define outcome options using the 
ppart.ini, "Outcome" setting. 

Location of Delivery Enter the delivery location. 

Delivery Provider Select from the drop-down list whether the delivery provider is 
"I" - Internal or "E" – External to your organization. Enter the name 
of provider who delivered the infant in the adjacent field.  
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Note Enter any notes you may have about the infant. 

CHC button Click this button to enter CHC (Community Health Center) 
information. This button is only displayed when the ppart.ini 
setting, "DisplayPatientCHC" is On. See the Community Health 
Center (CHC) section for more information.  

Infant Information screen 

Name Enter the infant's name. 

Patient ID If the infant is a patient in your system, you can enter the patient 
ID for the infant here. You can also click the Lookup button and 
use the Patient Lookup screen to select the appropriate patient. 

Gestational age at birth Enter the infant's gestational age at birth. 

Birth Weight Enter the infant's birth weight. In the adjacent field enter the 
units. The default setting is gms. Your system administrator can 
define the default birth weight units using the ppart.ini, 
"BirthweightUnit" setting. 

Apgars 1 Enter the first Apgar score. 

Apgars 2 Enter the second Apgar score.  

Estimated Due Date 
The Estimated Due Date screen allows you to enter and review data related to due date estimation. It 
features automatic calculation of due dates based on various types of data, and includes a single 
Current Best EDD field to represent the provider’s best estimate of EDD at any particular moment. 

Procedures for adding estimated due date data 

To open the Estimated Due Date screen: 

• On the Prenatal Visit Flow Chart screen, click the EDD Details button. The Estimated Due Date 
screen appears. 

To add estimated due date data: 

• On the Estimated Due Date screen, enter data in the applicable sections. For the patient's initial 
visit, enter data in the Initial EDD Estimate section, for estimations during the 18-22 week range, 
enter data in the 18-22 Week EDD Update section, and add additional information such as the 
"Ultrasound 3" and "Ultrasound 4" in the Other section, if applicable. See the Fields on the 
Estimated Due Date screen section below for an explanation of each of the fields. When you 
finish, click the OK button. The current best EDD will be displayed in the EDD Best Estimate 
field.  
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Fields on the Estimated Due Date screen 

Field Description 

Current Best EDD The system will initially calculate the Current Best EDD based on 
the LMP, if entered. However, you can modify this as appropriate 
based on other information affecting EDD estimation. Click the 
down arrow button to access the calendar.  
This estimate will be displayed in the EDD Best Estimate field on 
the Prenatal Visit Flow Chart screen. 

Initial EDD Estimate 

LMP / EDD The date of the patient's last menstrual period is displayed in the 
LMP field. You may update this value whenever necessary. Click 
the down arrow button to access the calendar.  
Based on this date, the system will calculate an estimated due 
date. The date is displayed in the EDD field to the right of the 
LMP field. 

Initial Exam / Gest Age / EDD Enter the date of the initial physical exam in the Initial Exam field. 
Click the down arrow button to access the calendar.  
Enter the estimated gestational age at the time of the initial exam 
in weeks (W) and days (D). 
Based on the initial exam and the gestational age, the system will 
calculate an estimated due date. The date is displayed in the 
EDD field to the right of the Gest Age fields. 

Ultrasound / Gest Age / EDD Enter the date of the first ultrasound (if applicable) in the 
Ultrasound field. Click the down arrow button to access the 
calendar.  
Enter the estimated gestational age at the time of the ultrasound 
in weeks (W) and days (D). 
Based on the ultrasound date and the gestational age, the 
system will calculate an estimated due date. The date is 
displayed in the EDD field to the right of the Gest Age fields. 

Initial Best Estimate Based on the data entered in this section, the system will 
calculate an initial best estimate. This may be updated if 
necessary. 

Provider Enter the provider ID, or click the down arrow button to access 
the Provider Select screen. Select the appropriate provider and 
click the OK button. The selected provider will be displayed in 
this field. 

18-22 Week EDD Update 

Quickening / EDD Enter the date of the quickening. Click the down arrow button to 
access the calendar. Based on the entered date, the system will 
calculate the estimated due date, assuming a gestational age of 
18 weeks at quickening. The date is displayed in the EDD field to 
the right of the Quickening field. 
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Fundal Height at Umbilicus / EDD Enter the date the Fundal Height was found to be at Umbilicus, if 
applicable. Click the down arrow button to access the calendar. 
Based on the entered date, the system will calculate the 
estimated due date, assuming a gestational age of 20 weeks 
when the fundal height is at the umbilicus. The date is displayed 
in the EDD field to the right of the Fundal Height at Umbilicus 
field. 

Ultrasound / Gest Age / EDD Enter the date of the second ultrasound in the Ultrasound field. 
Click the down arrow button to access the calendar.  
Enter the estimated gestational age at the time of the ultrasound 
in weeks (W) and days (D). 
Based on the ultrasound date and the gestational age, the 
system will calculate an estimated due date. The date is 
displayed in the EDD field to the right of the Gest Age fields. 

New Best Estimate Enter a new best estimate based on the data entered in this 
section. Click the down arrow button to access the calendar. This 
may be updated if necessary. 

Provider Enter the provider ID, or click the down arrow button to access 
the Provider Select screen. Select the appropriate provider and 
click the OK button. The selected provider will be displayed in 
this field. 

Other  

Ultrasound 3 / Gest Age / EDD Enter the date of the third ultrasound in the Ultrasound 3 field, if 
applicable. Click the down arrow button to access the calendar.  
Enter the estimated gestational age in weeks (W) and days (D). 
This may be updated if necessary. 
Based on the ultrasound date and the gestational age, the 
system will calculate an estimated due date. The date is 
displayed in the EDD field to the right of the Gest Age fields. 

Ultrasound 4 / Gest Age / EDD Enter the date of the fourth ultrasound in the Ultrasound 4 field, 
if applicable. Click the down arrow button to access the calendar. 
Enter the estimated gestational age in weeks (W) and days (D). 
 This may be updated if necessary. 
Based on the ultrasound date and the gestational age, the 
system will calculate an estimated due date. The date is 
displayed in the EDD field to the right of the Gest Age fields. 

Comment Enter any comments you may have about EDD estimation for this 
pregnancy. 
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Prenatal Lab/Plans 
Note: Before you can use the prenatal lab/plans feature, your system administrator must set up health 
maintenance procedures and prenatal templates. Patient Records comes with a pre-built Prenatal 
health maintenance template. You can modify this template to meet your specific practice needs, or 
add your own prenatal templates. 

Click the Lab / Plans button on the Prenatal Visit Flow Chart screen to display the patient's prenatal 
health maintenance data. This section is similar to the Health Maintenance section of the patient chart. 
The prenatal lab/plans feature helps you track a patient's periodic preventive and follow up care 
treatments over the course of their pregnancy. 

Note: Prenatal lab/plans health maintenance items are independent of the items entered using regular 
Health Maintenance and will not appear on the patient’s Health Maintenance Summary screen. 

Within a health maintenance template, each test or exam is given a rule to determine how often it 
should be performed. These rules can be simple or very complex. For complex rules, you can create 
“rule files” where complex logic can be entered. The complex logic can include reading existing patient 
data such as lab results, diagnoses etc.  

Procedures are grouped together on the Prenatal Lab/Plans screen based on when in the pregnancy 
they are intended to be done. The group section rows are highlighted in blue. The screen is divided 
into the following sections: 

• Initial – These are items which are intended to be performed at the onset of prenatal care and 
are considered applicable in all or almost all pregnancies. Items that are overdue and required 
are highlighted in red. 

• Optional – These are items which are intended to be performed at the onset of prenatal care but 
only in certain pregnancies. 

• 8+ - These are items which are intended to be performed within the 8-23 week gestational age 
range.  

• 24+ - These are items which are intended to be performed within the 24-31 week gestational 
age range.  

• 32+ - These are items which are intended to be performed within the 32-36 week gestational 
age range. 

• 37+ - These are items which are intended to be performed after 37 weeks’ gestation. 

• Other - If the "do every" or "do once" rules are used, the items will be displayed in this section. 

Note: Procedures that are on or after the start date of a pregnancy will be taken into account when 
calculating the "Initial" and "Optional" start date. 

 Other prenatal health maintenance features include: 

• Lytec MD calculates when procedures are overdue.  

• Overdue and Required items are highlighted in red on the Prenatal Lab/Plans screen.  

• You can assign multiple prenatal HM templates to patients. 

• You can create customized help files that contain information for providers and patients about 
health maintenance procedures.  

• You can mark procedures as completed, refused, done elsewhere, not applicable to the patient, 
offered but postponed, or ordered. Entering not applicable for a procedure will stop all overdue 
checking for that procedure. 

• You can use synonyms to maintain alternate names for medication or problem names in health 
maintenance templates. Synonyms are used when Lytec MD checks whether procedures are up-
to-date. For example, you may create a template for DTaP, which was previously known as DPT. 
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By adding DPT as a synonym for DTaP, Lytec MD will check for both DTaP and DPT when 
verifying whether procedures are up-to-date. 

Procedures for adding, editing, and deleting prenatal lab/plans 

To access the prenatal lab/plans section: 

• Click the Lab / Plans button on the Prenatal Visit Flow Chart screen. The Prenatal Lab/Plans 
screen appears.  
 
This screen uses a table to display the patient's health maintenance data. The left column lists 
the procedures in the health maintenance prenatal template(s) assigned to the patient. The Req 
column displays a "Y" if the procedure was set by the system administrator as “required” and an 
"N" if the procedure is not “required.” Procedures that are required and overdue are highlighted 
in red. The Gest Age column displays the gestational age the procedure is due (if it is not 
designating as being due at the onset of prenatal care, in which case it displays “Initial”). The 
Due Date column, displays the procedure's due date.  

• The Show drop-down list allows you to display lab and plans, plans only, or lab only.  

• To view previous prenatal lab/plan data, click the Older button. To view newer prenatal lab/plan 
data, click the Newer button.  

• The Show data Prior to this pregnancy check box allows you to display all prenatal health 
maintenance data, including data from prior to the pregnancy.  

• The pregnancy start and end dates are displayed in the title bar of the Prenatal Lab/Plans 
screen. For more information on how these dates are calculated, see the Prenatal topic. 

Note: The Prenatal Lab/Plans screen displays up to 500 procedures from all templates assigned to the 
patient. You cannot apply templates that would increase the number of procedures to 501+. For 
example, if the patient is already assigned 10 templates, and each template includes the maximum 
number of procedures (50), you can't apply another template because the number of procedures is 
already 500. 

To add Prenatal Lab/Plan data: 

1. On the Prenatal Lab/Plan screen, click the New button. The Prenatal Lab/Plans <New> 
screen appears. 

2. The Date and Time fields display the current system date and time. You may modify these 
fields if necessary. 

3. For each procedure that has been completed, click the Value column and type the status (or 
right-click in the column and select a status from the right-click menu).  

For non-lab procedure items, type or select one of the following options: 

• X - the procedure has been completed 

• E - the procedure was done elsewhere 

• N - the procedure is not applicable for the patient (this status will turn off overdue 
checking) 

• R - patient refused the procedure (with a setting in the ppart.ini file, a status of R can act 
the same as a status of N) 

• P - the procedure was postponed 

• O - the procedure has been ordered (with a setting in the ppart.ini file, a status of O can 
act the same as a status of X) 

• <None> - clears your selection from the Value column 
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For Lab procedure items, do one of the following: 

• Type the lab result name in the Value column. The name will be saved for the Lab 
procedure and X will be saved as the status of the related Health Maintenance procedure. 

• Leave the Value field blank and select a status for the Health Maintenance procedure from 
the right-click menu. A confirmation message appears, indicating that if you leave the 
field blank, the selected value will be stored in Health Maintenance. Click OK to continue. 
The selected Health Maintenance status is displayed in the Comment field and the Value 
field remains blank. 

Note: For Lab procedure items, an asterisk is displayed in the Prenatal Lab/Plan screen if you 
selected a Health Maintenance status but did not enter a lab result. Clicking the asterisk displays 
the selected Health Maintenance status in the Comment field. 

4. To add a comment to a procedure, type in the Comments box at the bottom of the screen 
while the cursor is in the procedure's Value column. 

5. To add information regarding a procedure which corresponds to a medication or immunization 
administered in the office, click the More button while the cursor is in the procedure's Value 
column. The additional information you can add includes dose, route, given by, location, lot, 
manufacturer, and device. 

6. When you finish, click the OK button. The Prenatal/Lab Plan screen appears. 

To change prenatal lab/plan data: 

• On the Prenatal Lab/Plan screen, highlight the column of data that you want to change. Click 
the Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete prenatal lab/plan data: 

• On the Prenatal Lab/Plan screen, highlight the specific item or column of data that you want to 
delete. Click the Delete button. A message asks you to confirm the deletion. Click the OK 
button. 

Viewing, adding, and deleting a patient's prenatal templates 
You can easily view and customize the health maintenance prenatal templates that have been assigned 
to a patient.  

If a patient requires special health maintenance procedures, you can create a new template specifically 
for the patient.  

To view the patient's prenatal templates: 

• Click the Template button on the Prenatal Lab/Plan screen. The Prenatal Templates For screen 
appears. 

• The Prenatal Templates For screen displays the templates that have been assigned to the 
patient. The name of each template appears on screen as a tab on the Prenatal Templates For 
screen. The screen displays the HM procedure name, and the procedure rule. 

To apply a new prenatal template for the patient: 

1. On the Prenatal Lab/Plans screen, click the New Template button. 

2. If the template is provider-specific, select the appropriate provider. Make sure the practice ID is 
correct, then click the OK button. 

3. On the Prenatal Templates screen, select the template.  
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4. When the template is highlighted in the table, click the OK button. 

To delete a patient's prenatal template: 

• On the Prenatal Templates For screen, click the tab of the template that you want to delete. 
Click the Delete Template button. A message asks you to confirm the deletion. Click the OK 
button. 

Community Health Center (CHC) 
When the Demographic setting, "Display CHC tab" is enabled, the CHC button is displayed on the 
Pregnancy <New> screen. This screen allows you to enter Community Health Center information 
regarding the patient's pregnancy. 

You can also add and modify prenatal CHC information from the Patient, CHC tab. 

To add CHC information: 

1. Click the CHC button on the Pregnancy <New> screen. The Community Health Center 
(CHC) screen appears.  

2. Fill in the fields on this screen.  

3. When you finish, click the OK button.  

Fields on the Community Health Center (CHC) screen 

Field Description 

Location Care Started Select the location prenatal care started from the drop-down 
list. Your options are Grantee and Other Provider. You can also 
leave this field blank. 

Date First Prenatal Care (Current 
Grant Year) 

Enter the date of the patient's first prenatal care visit for the 
current grant year. Click the down arrow button to access the 
calendar. 

Date First Prenatal Care (Previous 
Grant Year) 

If the pregnancy spans two years, then Current Grant Year will 
be moved into Previous Grant Year. Edit as needed. Click the 
down arrow button to access the calendar. 

Trimester Start Select the trimester prenatal care started from the drop-down 
list.  

Delivered By Select the provider from the drop-down list. Your options are 
Another Provider, or Grantee.  

Mother Prenatal Select this check box if the mother enrolled in the WIC prenatal 
care program.  

Mother Postpartum Select this check box if the mother enrolled in the WIC 
postpartum care program.  

Infant Select this check box if the infant was enrolled in the WIC infant 
care program.  
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Community Health Center - Pregnancy 
Use this screen to can add, change, and delete Community Health Center (CHC) information 
pertaining to a patient's pregnancy.  

To add a pregnancy: 

1. Click the New button. The Community Health Center - Pregnancy screen is displayed. 

2. Fill in the fields on this screen.  

3. To add infant information click the New button. The Infant Information screen is displayed. Fill 
in the fields on this screen. Repeat this process if you need to add additional infants for the 
current pregnancy.  

4. Click the CHC button to enter Community Health Center information.  

5. When you finish, click the OK button. 

To change pregnancy information: 

• In the Pregnancy list, highlight the pregnancy that you want to change. Click the Edit button. 
Make the appropriate changes. When you finish, click the OK button. 

• To edit infant information, highlight the infant that you want to edit information for in the Infant(s) 
list. Click the Edit button. Make the appropriate changes. When you finish, click the OK button.  

To delete pregnancy information: 

• In the Pregnancy list, highlight the pregnancy that you want to delete. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 

To remove infant data: 

• In the Infant(s) list highlight the infant information that you want to remove. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Community Health Center - Pregnancy screen 

Field Description 

Title Enter a title for the patient's pregnancy (e.g., first pregnancy). 

Date of Delivery/Resolution Enter the date of delivery or resolution. Click the down arrow 
button to access the calendar. 

Outcome Select the pregnancy outcome from the drop-down list. Your 
options are: Vaginal Delivery, C-Section, SAB, Termination, and 
Fetal Demise. 
Your system administrator can define outcome options using the 
ppart.ini "Outcome" setting. 

Location of Delivery Enter the delivery location. 

Delivery Provider Enter the ID code of the provider who delivered the infant. In the 
adjacent field select whether the delivery provider is "Int" - 
Internal or "Ext" - External from the drop-down list.  

Delivered by Select who the infant was delivered by from the drop-down list. 
Your options are: Grantee and Other Provider.  
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Note  Enter any notes you may have about the infant. 

Infant Information screen 

Name Enter the infant's name. 

ID Enter the patient ID for the infant. You can also click the Lookup 
button and use the Patient Lookup screen to select the 
appropriate patient. 

Gestational Age at Birth Enter the infant's gestational age at birth.  

Birth Weight Enter the infant's birth weight. In the adjacent field enter the 
units. The default setting is gms. Your system administrator can 
define the default birth weight units using the ppart.ini, 
"BirthweightUnit" setting. 

Apgars 1 Enter the first Apgar score. 

Apgars 2 Enter the second Apgar score. 

Community Health Center - Pregnancy screen 

Location Care Started Select the location prenatal care started from the drop-down list. 
Your options are Grantee and Other Provider.  

Date First Prenatal Care (Current 
Grant Year) 

Enter the date of the patient's first prenatal care visit at the 
community health center in the current grant year. Click the 
down arrow button to access the calendar. 

Date First Prenatal Care (Previous 
Grant Year) 

If the pregnancy spans two years, then Current Grant Year will be 
moved into Previous Grant Year. Edit as needed. Click the down 
arrow button to access the calender 

Trimester Start Select the trimester prenatal care started from the drop-down 
list.  

Delivered By Select the provider from the drop-down list. Your options are 
Another Provider, or Grantee.  

Mother Prenatal Select this check box if the mother enrolled in the WIC prenatal 
care program.  

Mother Postpartum Select this check box if the mother enrolled in the WIC 
postpartum care program.  

Infant Select this check box if the infant was enrolled in the WIC infant 
care program.  

Pregnancies screen 
This screen displays all pregnancies for a patient. The pregnancies are displayed by the date they were 
added to Patient Records, and pregnancy title. A "Y" is displayed in the Current Preg column if the 
pregnancy is the current pregnancy, and an "N" is displayed in this column if it is not the current 
pregnancy. Using this screen you can: 

• View the patient's pregnancies 

• Add a pregnancy for the patient 

• Edit existing pregnancy data 
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Procedures for adding and editing pregnancies 

To open the Pregnancies screen: 

• On the Prenatal Visit Flow Chart screen, click the Preg button. The Pregnancies screen 
appears. 

To add a pregnancy: 

1. On the Pregnancies screen, click the New button. A message appears asking whether the 
pregnancy is the current pregnancy. Click Yes, if the pregnancy is a current pregnancy, or click 
No, if the pregnancy is not a current pregnancy. The Pregnancy <New> screen appears. Fill in 
the fields on this screen.  

2. To add infant information click the New button. The Infant Information screen is displayed. Fill 
in the fields on this screen. Repeat this process if you need to add additional infants for the 
current pregnancy.  

3. When you finish, click the OK button. 

To change pregnancy data: 

• On the Pregnancies screen, highlight the pregnancy that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

• To edit infant information, highlight the infant that you want to edit information for in the Infant(s) 
list. Click the Edit button. Make the appropriate changes. When you finish, click the OK button.  

To remove infant data: 

• In the Infant(s) list highlight the infant information that you want to remove. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 
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Prescriptions and Medications 

Rx/Medications 
Patient Records offers a comprehensive way to record a patient's current, historical, and ineffective 
medications on the Patient Chart by using Rx/Medications.  

Tabs on the Rx/Medications screen 
There are five tabs on the Rx/Medications screen: 

• Current. Displays current medications. Use to write, renew, or discontinue prescriptions. 

• Historical. Displays discontinued medications that were effective. 

• Ineffective. Displays discontinued medications that were ineffective. 

• Rx Fill History. Displays pharmacy fill events downloaded to your system from the patient’s 
Pharmacy Benefits Manager(s).   

• Eligibility. Displays pharmacy benefits eligibility data.  

Note: The Rx Fill History and Eligibility tabs will only be enabled if the ePrescribing module is 
installed and connectivity to the ePrescribing network is established.  

The Current tab 
The Current tab on the Rx/Medications screen lists a patient's current medications, including dosage 
and frequency information. 

Use this tab to do the following: 

• Add a prescription 

• Print a prescription 

• Change a prescription 

• Discontinue a prescription, and marking whether effective or not 

• Renew a prescription 

• Delete a prescription  

When discontinued, a medication moves to either the Historical tab or the Ineffective tab.  

Read more. 

The Historical tab 
The Historical tab on the Rx/Medications screen lists the discontinued medications that were effective 
for the patient. For more details about a historical medication, click Detail. Medication details display 
the same way for historical medications as current medications. 

Medications may be renewed from historical medications. 

The Ineffective tab 
The Ineffective tab on the Rx/Medications screen lists discontinued medications that were ineffective 
for the patient. For more details about an ineffective medication, click Detail. Medication details 
display the same way for ineffective medications as current medications. 
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Rx Fill History tab 
Note: The Rx Fill History tab will only be enabled if the ePrescribing module is installed and 
connectivity to the ePrescribing network is established.  

The Rx Fill History tab on the Rx/Medications screen displays pharmacy fill events downloaded to your 
system from the patient’s Pharmacy Benefits Manager(s). This feature allows you to see details of what 
medications your patient is actually obtaining from pharmacies, whether they were prescribed by you, 
another provider at your practice, or a provider outside your practice. You can review detailed 
information about a prescription by selecting the prescription from the list and clicking the Show 
Detail button. The Medication Fill History Detail screen will appear with detailed information about the 
prescription. You can refresh the fill history by clicking the Update Fill Hx button, which will initiate a 
live download of data from the patient’s Pharmacy Benefits Manager(s). 

You can also easily update the patient’s Current Medications list by clicking the Add To Current Meds 
button. This will add the selected medication to the Current Medications list as shown in the Current 
tab of the Rx/Medications screen. 

To print a prescription in the Rx Fill History list: 

• On the Rx/Medications screen, click the Rx/Fill History tab. Select the fill history event(s) that you 
want to print from the list. Click the Print button.   

Eligibility tab 
Note: The Eligibility tab will only be enabled if the ePrescribing module is installed and connectivity to 
the ePrescribing network is established.  

You can send pharmacy benefit eligibility queries using Patient Records to RxHub via the Lytec MD 
Clearinghouse. The patient’s eligibility will be checked automatically when their chart is opened (unless 
a successful Eligibility check has already occurred in the prior 24 hours). The results of the eligibility 
check will be displayed in the Eligibility tab.  

You can also do an on-demand pharmacy eligibility check using the Check/Recheck Eligibility button 
on the Rx/Medications screen.   

For more information see the Eligibility tab on the Rx/Medications screen section.  

Writing Prescriptions Using Patient Records 
Default settings may be used when writing prescriptions. Also, a PIN may be required when writing 
prescriptions. 

Prescriptions may be written: 

• While Patient Chart is open, or any open function from Patient Chart.  

• From Rx/Medication. In addition writing new prescriptions, current, historical, and ineffective 
medications may be viewed. 

Templates may be used when writing a prescription. A prescription may be added to a progress note 
that is being written.  

Read more. 

See Procedures for adding, editing, discontinuing, and deleting prescriptions. 
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Additional Features 
There are additional features available when writing a prescription. Some features require an additional 
subscription fee. 

• Prescription Electronic Signatures. To prevent unauthorized operators from writing 
prescriptions, Rx/Medications may be configured to require the use of an electronic signature 
(PIN) when writing DEA restricted and/or non-restricted prescriptions. The PIN serves as a 
signature or co-signature on the prescription. When a signature or co-signature is required, the 
prescription will not print or fax until the PIN is provided. Outside prescriptions may be entered 
without a PIN.  

• Drug Interaction Checking. Drug interactions may be checked while writing prescriptions using 
an optional drug interaction and allergy checking database. This database is available on a 
quarterly subscription basis to all Patient Records users.  

• Allergy Intolerance Checking. Allergy intolerance may be checked while writing prescriptions 
using an optional drug interaction and allergy checking database. This database is available on a 
quarterly subscription basis to all Patient Records users.  

• Drug Dosage Checking. A patient's drug dosage may be checked while writing and editing 
prescriptions using an optional drug interaction and allergy checking database. When the 
Prescription Defaults setting "Drug dose check" is enabled, the drug dosage will be checked 
against the entered size, take, or frequency. A warning displays when there is a contraindication, 
based on the options chosen.  

• Diagnosis Checking. A patient's diagnosis may be checked while writing prescriptions using an 
optional drug interaction and allergy checking database. When this is enabled, when writing 
prescriptions, the diagnosis and drug will be checked and if there is a contraindication, a 
message will be displayed to the user. The warning message displayed is based on the setting 
level chosen.  

• Entering Prescriptions from Outside Providers. A patient may receive a prescription from an 
outside provider, such as a specialist to whom the patient was referred. This outside prescription 
needs to be entered in order to perform drug and allergy interaction checking.  

• Adding Patient Instructions to Prescriptions. Use Patient Instruction to add instructions to 
prescriptions. Either type the patient instructions or use patient instruction templates.  

• Adding Extended Signatures to Prescriptions. Use Extended SIG when the instructions or 
format for a prescription are too complicated for the New Prescription. Up to ten lines of text 
may be added using Extended SIG. Either type the extended signature or use extended 
signature templates.  

• Previewing Prescriptions before Printing or Faxing. A prescription may be previewed before 
printing or faxing using Preview Rx. This displays after writing, renewing, or editing a 
prescription.  

• Viewing Drug Cost Information. When adding a prescription or creating a prescription 
template, the drug cost information may be viewed for many common drugs. This is available 
only with a subscription to the Drug Interaction database service.  

• Formulary Checking. You can use the formulary checking feature to see the formulary status for 
a drug for a particular patient when writing a new prescription, editing an existing prescription, 
or renewing a prescription.  

Note: The formulary checking feature will only be enabled if the ePrescribing module is installed and 
connectivity to the ePrescribing network is established.  
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Discontinuing Prescriptions 
When a patient no longer takes a medication, discontinue the prescription. The discontinued 
medication transfers from the Current tab to either the Historical tab or Ineffective tab.  

When discontinuing a prescription name (or synonym) associated with a health maintenance 
template/protocol, there is an opportunity given to delete the related template assigned to the patient. 

The ability to select whether a discontinued medication is listed as ineffective or historical is available 
only if the system administrator has enabled this feature in Prescription Defaults. Otherwise, the system 
automatically transfers discontinued current medications to historical medications.  

See Discont for more information. 

Complying with JCAHO's National Patient Safety Goal #2 
for 2004 (Communication) 
The system administrator may enter a list of default frequencies on the Prescription Defaults screen to 
standardize the terms used and help meet the JCAHO guidelines. In addition, the system administrator 
can cause the translation of certain frequencies and other terms on printed Rxs or inserted Rxs from 
older terms to JCAHO accepted terms by modifying the ppart.ini file. These options are useful to meet 
the JCAHO National Patient Safety Goal #2 for 2004.  
Read more. 

Procedures for Adding, Editing, Discontinuing, and Deleting 
Prescriptions 
To open Rx/Medications: 

With a patient chart open, do one of the following to display Rx/Medications:  

• Click Rx/Medications from the Show menu. 

• Click Rx/Medications from the patient chart. 

• Click Rx/Meds on the Go To bar.  

To add a prescription: 

1. On Rx/Medications, click New to open Prescription. 

2. Complete the information on Prescription.  
• A prescription template may be used to complete some of the information. A template 

search may be made by either the drug name or template code, or by indications.  

3. Click OK. 
• The system may be configured to display a message asking whether to apply a health 

maintenance protocol to the patient if the prescription name (or synonym) is associated 
with a health maintenance template. This displays if the template has been assigned to 
the patient already, or if a template with the same name as the problem has been 
assigned to the patient. 

4. If Electronic Signature is required for this type of Rx, then enter the PIN. The action chosen in 
Print now happens. 
• If the operator does not have a PIN or cannot enter a valid PIN, Rx Signature Required 

(and not entered) opens. Click Suspend to hold the prescription for later approval by a 
provider with PIN authority. Click Cancel to remove the prescription from the system. 
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Note: Suspended medications are highlighted in red to show they are suspended. 

To find a prescription template by drug name or template code: 

1. Type all or part of a drug name or template code in Rx Template Code. 

2. Click by Template Code. 

3. Click Lookup to display Select Rx Template. 

4. Click either the Insurance Formularies tab or the General Formularies tab.  

5. To search for other drugs, move up or down through the table by clicking the arrows on the 
right side of the table. 

6. Click the drug name to be used in order to highlight it, then click OK. Otherwise, double-click 
the drug name. The template details complete the information on Prescription. 

7. Revise the information on Prescription as necessary for the patient. 

To find a prescription template by indications: 

1. Click by Indications. 

2. Click Lookup to display Diagnosis Code Select. 

3. Type the indication, office code, or standard code in the text box. 

4. Click the type of search: 
7. Office Code 
8. Word 

9. Short Description 
10. Long Description 

5. Click Search. The first diagnosis matching the search item becomes highlighted. To search for 
other diagnosis, move up or down through the table by clicking the arrows on the right side of 
the table.  

6. Click the drug name to be used in order to highlight it, then click OK. Otherwise, double-click 
the drug name. The template details complete the information on Prescription. 

7. Revise the information on Prescription as necessary for the patient. 

To change a prescription: 

1. On Rx/Medications, click the prescription to be changed in order to highlight it. 

2. Click Action, then Edit.  

3. Make the appropriate changes.  

4. When finished, click OK. 

When editing a prescription, the progress note is updated only if (A) the date of the prescription does 
not change, and (B) the change is made to one of the following: 

• Medication name 

• Size 

• Take 

• Frequency 

• Duration 
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• Amount 

• Route 

• Refills 

To use an alternative medication: 

1. With the prescription open during creation or editing, click Alternative. A list of alternatives 
with their cost displays in Alternative Drugs. 
• Only drug alternatives using the same route display in Alternative Drugs. To view 

alternatives of all routes, leave Route blank on Prescription before clicking Alternative. 

2. To use an alternative, click the medication, then OK.  

3. When finished, click OK. 

To discontinue a prescription: 

1. On Rx/Medications, click the prescription to be discontinued in order to highlight it. 

2. Click Discont. to display Confirm discontinuation. 

3. As necessary, enter a Discontinuation Date and Reason for D/C.  

Note: You must enter the reason for discontinuation if the Prescription Default setting, "Require reason 
for drug discontinuation" is enabled. 

4. Click Yes to confirm the discontinuation. A question on whether the medication was effective 
displays. 

5. Answer the question on the effectiveness. 
• Click Yes, and the medication moves from the Current tab to the Historical tab. 

• Click No, and the medication moves from the Current tab to the Ineffective tab. 

To delete a prescription: 

Note: This completely removes the prescription. This does not discontinue the prescription (move the 
medication to the Historical or Ineffective tab). 

1. On the Rx/Medications screen, click the prescription to be deleted in order to highlight it. 

2. Click Action, then Delete. Confirm Delete displays. 

3. Click OK. 
• The system may be configured to display a message asking whether to delete the related 

template assigned to the patient if the prescription name (or synonym) is associated with 
a health maintenance template/protocol. 
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Information and Actions on the Rx/Medications screen 
The Rx/Medications screen displays by clicking Rx/Medications on the patient's chart.  

You can sort the prescriptions on the Rx/Medications screen by clicking a column header. For example, 
to sort prescriptions by date, click the Date column header. Click the column header again to reverse 
the sort direction.  

Rx/Medications 

Name Action 

Allergies and 
Intolerances list 

The Allergies or Intolerances list on the Rx / Medications screen allows you to 
record, review, and update the patient’s allergies and medication intolerances. 
You can also use this feature to re-activate allergies that have been deleted for 
the patient.  
See the Allergies and Intolerances Overview for more information.  

Allergies 
Reviewed 

Displays the date that the patient's allergies and intolerances were last reviewed 
with the patient. You can click the Today button to record the current date and 
time, or you can enter a prior date if the allergies were reviewed with the patient 
on a prior date.  

Today button Click to record the current date as the date the patient's allergies and medication 
intolerances were last reviewed with the patient.  
When clicked, the date, time, and the ID of the logged in operator who reviewed 
the allergies will be recorded.  

View Deleted 
button 

Click to view the deleted allergies and medication intolerances for the patient.  
See the Viewing and Re-activating Deleted Allergies section for more 
information.  

New button Click the New button to add a prescription for the patient. Complete the 
information on Prescription. After clicking the New button, complete the 
prescription by doing one of the following: 

 Enter the information requested. Some information may be entered with 
the default values specified on Prescription Defaults. 

 Use a prescription template, which enters standard responses for the 
information requested. The information entered from the template may 
be modified as necessary for the needs of each patient.  

The medication name and other information is added to the Current tab on 
Rx/Medications after finishing the prescription. 

Note: If you use a medication name not recognized by the database, the allergy 
and drug interaction cannot be checked. A message displays when this happens, 
asking whether to proceed. Clear the Drug Interaction Check and Allergy 
Check check boxes to prevent this message from displaying. 

Note: When transferring medications to Patient Records with the Text Data 
Loader, use the Dot codes .RX:, .RX2:, RX3:, and .RX4: for medications to be 
transferred to the current, historical, and ineffective lists.  
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Renew button Click one prescription in order to highlight it, then click Renew. You can also 
select multiple prescriptions to renew, by holding down the Shift key and 
selecting each of the prescriptions you want to renew.  
In Refills, type or select the number of refills to be authorized. If a pharmacy was 
specified for the original prescription, its name will appear in the Pharmacy field. 
You can click the Lookup button to select or change the pharmacy.  
The Formulary area of the screen displays the result of the formulary check. See 
the Formulary Checking section for a complete explanation of this feature. 

Note: The formulary checking feature will only be enabled if the ePrescribing 
module is installed and connectivity to the ePrescribing network is established.   

You can click the Details button to view any additional information about the 
coverage for the medication, based on the patient's health plan coverage. The 
Details button opens the Formulary Details screen. See the Formulary Checking 
section for a complete explanation of this screen. 
You can click the Alternatives button to view the list of alternative medications 
with a more preferential formulary status. If there is no such data, the 
Alternatives button will be greyed out.  
Please note you cannot select an alternative medication when checking 
formularies when renewing a prescription.  
 
Note: If you chose a Print option involving faxing or electronic transmission, you 
must enter a pharmacy that is in your system’s pharmacy list. If you do not, you 
will receive a warning message and be asked to enter a pharmacy from your 
system’s pharmacy list. You can use the Lookup button to select a pharmacy your 
system’s pharmacy list.  
In Print, select one of the following on how the refill is to be printed: 

 Print locally immediately 

 Print remotely immediately 
 Print locally as a group 

 Print locally and transmit as a group 
 Transmit as a group 

 Transmit immediately 
 Print locally and fax as a group 

 Fax as a group 
 Print locally and remotely as a group 

 Print remotely as a group 
 Sample given 

 Do not print 
 Was printed  

Note: If necessary, cancel the renewal by clicking Renew again.  

Note: You can only renew prescriptions if the access level associated with your 
operator account has 'New' rights enabled for the Rx\Prescriptions item on the 
Access Level Configuration screen. 
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Renew All 
button 

Click Renew All to renew all prescriptions. To renew prescriptions for which 
refills have been limited, select the Renew limited refill medications check box.  
In Print, select one of the following on how the refill is to be printed: 

 Print locally immediately 
 Print remotely immediately 

 Print locally as a group 
 Print locally and transmit as a group 

 Transmit as a group 
 Transmit immediately 

 Print locally and fax as a group 
 Fax as a group 

 Print locally and remotely as a group 
 Print remotely as a group 

 Sample given 
 Do not print 

 Was printed  

Note: To un-renew selected medications, highlight the medications and click the 
renew button. 

Note: You can only renew prescriptions if the access level associated with your 
operator account has 'New' rights enabled for the Rx\Prescriptions item on the 
Access Level Configuration screen. 

Discont button Click one prescription in order to highlight it, then click Discont to discontinue it. 
Confirm Discontinuation screen appears. Complete this information: 

1. In Discontinuation date, enter the date that the medication was 
discontinued. The default date is the current date.  

2. In Reason for D/C, add a note indicating why the medication was 
discontinued.  

Note: You must enter the reason for discontinuation if the Prescription Default 
setting, "Require reason for drug discontinuation" is enabled. 

3. Click Yes. A message asks whether the medication was effective.  
4. Select Yes or No on whether the medication was effective. 

 Click Yes, and the medication moves to the Historical tab.  
 Click No, and the medication moves to the Ineffective tab.  

Allergy button Click Allergy to add the patient's allergies or intolerances. You can enter an 
unlimited number of allergies and intolerances for the patient. When an allergy 
or intolerance is added, it will be displayed in the Allergies or Intolerances list at 
the top of the Rx / Medications screen.  
See the Adding, Editing, and Deleting Allergies or Intolerances section for more 
information.  
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Detail button Click one prescription in order to highlight it, then click Detail to view detailed 
information about the medication. Medication Detail displays with: 

 Route 
 Print Rx (yes or no) 

 Pat. instructions (yes or no) 
 Limit refills (yes or no) 

 Original date  
 Pharmacy 

 Note (yes or no) 
 Sig. 

On No Meds 
button 

Click this button if the patient is not taking any medications. A message asks you 
to confirm. Click the OK button. The Rx/Medications list will display ON NO 
MEDICATIONS in the Name column, and list the current date in the Date column. 
If a patient has ON NO MEDICATIONS noted on their medication list, and a 
prescription is created for the patient, the ON NO MEDICATIONS entry is 
removed automatically (and moved to the Historical Medications tab for future 
reference). 
If the patient has any current medications the button will be disabled.  

Action Click one prescription in order to highlight it, then click Action to perform one of 
these actions: 

• Print. A prescription also may be printed when writing it. 

• Edit. Change the prescription. 

• Renewal History. View the history for the medication prescribed with the 
same dosage. 

• Drug History. View the history for the medication, regardless of the 
dosage prescribed. 

• Interaction. Check for drug, allergy, and diagnosis interactions for all 
current drugs. For more information, see the Additional Features topic. 

• Delete. Delete the prescription. This is not discontinuing the drug. 

• View. View all details associated with the prescription. 

Other Click Other to perform one of these options: 
 Flag. Enter text to display every time the Rx/Medications screen is 

entered for this Patient. 
 Note. Edit or view the patient's medication notes. Use Medication Notes 

to enter general notes about the patient's medications.  
 Print All Rx. Print all un-printed prescriptions. 

 Print Med List. Print the patient's medication list. 
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Information and Actions on the Prescription screen 
The Prescription screen displays when creating or editing a prescription from Rx/Medications.  

Prescription 

Name Description 

Rx Template Code Type the template code or drug name to use for the prescription, then click 
Lookup to display Select Rx Template. 

Date Type a new date in the future using mm/dd/yy format, if necessary. A future 
date may only be used when Allow Future Rx's has been selected on the Rx 
Defaults tab of Prescription Defaults.  
The default value is today's date.  

Medication Type all or part of the medication name.  
When typing only part of the medication name, Select Drug Name opens with 
possible drugs. Click the drug name and then click OK to insert the name in 
Medication.  
If Select Drug Name opens, but what was typed in Medication was correct, 
click Drug OK. 

Size Either type the pill size or leave blank. An example size would be 250 mg. The 
maximum length is 25 characters. 

Calculator button Click this button to use the Dose Calculator to calculate patient-specific dosing 
by weight, calculated body surface area (BSA), or both. See the Dose Calculator 
section for more information.  

Take Either type or select how many to take or leave blank. 

Frequency Either type or select the frequency or leave blank. The default values in the list 
may be changed on the Prescription Defaults screen. The maximum length is 25 
characters. 

PRN Select this check box for medications taken as needed.  
When this check box is selected, the letters 'prn' are displayed after the 
selected frequency in the Freq column of the Rx \ Medications screen. 

Route Either type or select the route. The route must be specified. The maximum 
length is 20 characters. 

Duration Do one of the following: 
 Type or select the duration in days. 

 Leave blank for chronic medications. 
 Type prn for medications taken as needed. 

Amount Type the amount to dispense. This could be something like: 
 30 

 60 
 1 bottle 

The maximum length is 14 characters. 

Refills Either type or select how many refills. Use 0 (zero) for "no refills."  
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Print Click how the prescription should be printed:  
 Print locally immediately 

 Print remotely immediately 
 Print locally as a group 

 Print locally and transmit as a group 
 Transmit as a group 

 Transmit immediately 
 Print locally and fax as a group 

 Fax as a group 
 Print locally and remotely as a group 

 Print remotely as a group 
 Sample given 

 Do not print 
 Was printed 

Prov Do one of the following: 
 Type the provider's ID 

 Accept the default provider's code 
 Leave blank 

Outside Select this check box (instead of entering a provider ID in Prov) to indicate a 
prescription written by a provider not in this practice.  
Use this to keep a record of prescriptions written by other providers. This allows 
for drug interaction and allergy checking on all medications being taken by the 
patient. 
An outside prescription cannot be printed. It is for reference purposes only. 

Indication 1 
Indication 2 

Type one indication in Indication 1, or two indications in Indication 1 and 
Indication 2.  
To look up indications, click Lookup 1 or Lookup 2. When selecting an 
indication from the Select screen, the long description for the indication will 
appear in the Indication 1 or Indication 2 field. The maximum length is 35 
characters. 

Note Type a note or leave the box blank. 

Pharmacy Type the name of the pharmacy or leave the box blank. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 757 

 

Formulary Area This area displays the result of the formulary check. You can use the formulary 
checking feature to see the formulary status of a drug for a particular patient 
when writing a new prescription, editing an existing prescription, or renewing a 
prescription. 
In order to receive formulary information you must at least enter the medication 
name, size, and route. As soon as you have entered enough information on the 
Prescription screen to allow identification of the medication, Patient Records 
displays formulary data, if available, using the information from the most recent 
pharmacy benefits eligibility response. 
You can click the Details button to view any additional information about the 
coverage for the medication, based on the patient's health plan coverage. The 
Details button opens the Formulary Details screen. See the Formulary Checking 
section for a complete explanation of this screen.  

Note: If the “ShowCoverageDetailsOnPrescriptionDialog” setting in the [Rx] 
section of the Ppart.ini file is set to ON, the additional information about the 
coverage of a medication will display in the Formulary/Coverage Detail pane of 
the Prescription screen.  

You can click the Alternatives button to view the list of alternative medications 
with a more preferential formulary status. If there is no such data, the 
Alternatives button will be greyed out. You can select one of the alternative 
medications by clicking on the name of the medication in the list. After selecting 
the alternative medicine you will be returned to the Prescription screen. The 
alternative medicine name will be displayed in the Medication field. Patient 
Records will then perform a formulary check on the alternative medication 
selected by the user.  
Please note you cannot select an alternative medication when checking 
formularies when renewing a prescription. 
See the Formulary Checking section for a complete explanation of this feature. 

Note: The formulary checking feature will only be enabled if the ePrescribing 
module is installed and connectivity to the ePrescribing network is established.  

Extended Sig 
Area 

This area allows you to enter complex medication instructions (e.g., for topical 
medications or medication tapers) when writing a prescription. If you set up 
extended sig templates, you can also select an extended sig template to 
include on the prescription. See the Extended SIG Templates section for more 
information.  
You must select the Use Extended Sig check box to enable this area and to 
enter the following: 

• Extended Sig: Type the instructions in this field. You can add up to 250 
characters. 

• Code field: Enter the Extended Sig template code in this field. You can 
also use the Lookup button to select a template from the Extended Sig 
screen.  

• Create Sig Template: Select this check box to add the text entered in 
the Extended Sig field as a new Extended Sig template. After you have 
added the prescription, the Extended Sig: <New> screen appears. See 
the Extended SIG Templates section for information on adding an 
Extended SIG template.  
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Check Box Area Select the desired check boxes: 
• Use Extended Sig. Select to create a more complex prescription. This 

check box enables the Extended Sig area.  

• Use Extended Sig Only. Only print the extended sig, not the rest of the 
prescription. Use Extended Sig must be selected for this option to 
work. 

• Use Patient Instructions. Select to print patient instructions. 

• Limit Refills. This causes a warning message to display when approving 
a refill of the prescription. 

• Substitution OK. This writes the prescription to permit the pharmacist 
to substitute a generic medication. 

• Update Progress Note. This updates the progress note with the 
prescription. 

• Drug Interaction Check. This new prescription is compared with 
current prescriptions for interactions. 

• Allergy Check. This new prescription is compared with current 
prescriptions for allergies. 

• Change Pharmacy. Select to change the pharmacy. When this option is 
selected and you selected the Transmit as a group, Transmit 
immediately, Print locally and transmit as a group, Print locally and 
fax as a group, or Fax as a group print option, the Pharmacies for 
Patient screen appears after the prescription has been saved or you 
have exited the Rx / Medications screen. This screen allows you to select 
a different pharmacy associated to the patient, or select from a list of all 
pharmacies. See the Pharmacy Print options section for more 
information.  

• New Rx Template. Create a new template using this prescription. 

• OTC. Use to indicate that this is an over the counter drug, thus a 
prescription is not required. The prescription will not be added to the 
progress note if this option is selected. If the Update Progress Note 
check box is checked and this option is selected the Update Progress 
Note check box will be un-checked. 

Price Area This displays pricing information based upon the contents of a prescription 
template selected using the General Formulary tab. 
No values may be changed from Prescription. 

Alternative Click to view a list of alternative drugs of the same class and route in the drug 
interaction database as the one listed in Medication.  
A list of alternatives with their cost displays in Alternative Drugs. 

Dose Advisor Click this button to use the Dose Advisor to calculate a recommended dose for 
the patient. See the Dose Advisor section for more information.  
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Writing Prescriptions Using Patient Records 
Default settings may be used when writing prescriptions. Also, a PIN may be required when writing 
prescriptions. 

Prescriptions may be written: 

• While Patient Chart is open, or any open function from Patient Chart.  

• From Rx/Medication. In addition writing new prescriptions, current, historical, and ineffective 
medications may be viewed. 

Templates may be used when writing a prescription. A prescription may be added to a progress note 
that is being written.  

See Procedures for adding, editing, discontinuing, and deleting prescriptions. 

See Security when Writing Prescriptions to read about requiring providers to use PIN when writing a 
prescription.  

Using Prescription Templates 
Before beginning to write prescriptions for patients, prescription templates containing desired 
prescription information may be created. All providers in the practice may use the same prescription 
templates, or individual templates may be created for each provider. A template may be created from 
a new prescription. Patient Records has more than 600 prescription templates available.  

Adding a Prescription While Adding a Progress Note 
Rx/Medications may be opened while adding a progress note by clicking Rx on the tool bar. 

When writing a prescription, click the Update Progress Note check box. When saving the prescription, 
Patient Records adds the prescription to the note. 

When writing a prescription separately from a progress note, Patient Records will update a progress 
note with the prescription with the appropriate default settings. To do this, select the Progress Note 
check box on the Rx Defaults tab of Prescription Defaults. 
 
When saving a prescription, Patient Records finds and updates a progress note that has the same 
patient, provider, and date as the prescription. If the note did not exist when saving the prescription, 
Patient Records updates the progress note after creating it.  
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Additional Features 
There are additional features available when writing a prescription. Some features require an additional 
subscription fee. 

Electronic Signature on Prescriptions 
To prevent unauthorized operators from writing prescriptions, Rx/Medications may be configured to 
require the use of an electronic signature (PIN) when writing DEA restricted and/or non-restricted 
prescriptions. The PIN serves as a signature or co-signature on the prescription. When a signature is 
required, the prescription will not print or fax until the PIN is provided. Signing or co-signing is enabled 
if any of these are required to have signatures in PRUtils: 

• Restricted (DEA) prescriptions that are newly written, refilled, or changed. 

• All new prescriptions. 

• Non-restricted prescriptions that are changed. 

• Renewal (Refills) of non-restricted prescriptions. 

The system administrator uses Access Levels to configure the use of PINs in order to do the following: 

• Require signature for restricted prescriptions (use if no co-signature required). 

• Require signature for non-restricted prescriptions (use if no co-signature required). 

• Require co-signature for restricted prescriptions. 

• Require co-signature for non-restricted prescriptions. 

An operator must have an access level that permits signing or co-signing a prescription in order to use 
a PIN. 

Prescriptions from outside providers may be entered to the patient's record without a PIN. Entering 
these prescriptions allows drug interaction and allergy intolerance checking for all drugs being taken. 

If an Rx requires a co-signature, it is placed in suspended status until the co-signature is obtained. 
Suspended Rx's are highlighted in red and cannot be printed or faxed. To co-sign an Rx, a provider 
with signing privileges needs to open the patient’s medication list, and they will be presented with a list 
of medications that need co-signing. 

Drug Interaction Checking 
Drug interactions may be checked while writing prescriptions using an optional drug interaction and 
allergy checking database. This database is available on a quarterly subscription basis to all Patient 
Records users.  

If you are using the Drug Interaction feature, Lytec MD allows you to select medications from a coded 
list provided by Wolters Kluwer Health, Inc. This list includes medication names as well a numerical 
code (the "Medi-Span Drug Descriptor Identifier") which is not displayed Lytec MD but is stored in the 
database. This allows sophisticated checking of the medications you prescribe for interactions with 
patient allergies, other medications, or diagnoses, as well as dose checking. 

To protect against using outdated drug interaction information, the database checking is not available 
if the subscription expires. Please note you will receive a warning message 14 days prior to the 
subscription's expiration date.  

After subscribing to the database and installing it, select the Drug Interaction Check check box on the 
Drug Interactions tab of the Prescription Defaults screen to use this feature. Each medication is 
checked when entering the prescription.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 761 

 

If the medication name is not recognized, a list of possible names displays. Select a name or keep the 
original medication name.  

If there is an interaction indicated, the Drug Interactions screen appears: 

• Click OK when finished reading Drug Interactions. 

• Click Cancel to cancel writing the prescription. 

• Click Edit to edit the prescription. 

• Click More to check for additional interactions. 

• Click Mono to read a monograph using Drug Interaction Report, if available. This report may be 
printed.  

Note: Create a separate "prescription" for alcohol or food to check for possible drug interactions. The 
prescriptions for food and alcohol should be deleted (not discontinued) after checking. 

Allergy Intolerance Checking  
Allergy intolerance may be checked while writing prescriptions using an optional drug interaction and 
allergy checking database. This database is available on a quarterly subscription basis to all Patient 
Records users.  

To protect against using outdated allergy intolerance information, the database checking is not 
available if the subscription expires. 

After subscribing to the database and installing it with Patient Records, select the Allergy Check check 
box on the Rx Defaults tab of the Prescription Defaults screen to use this feature. Each medication is 
checked when entering the prescription. 

Allergy Checking displays if there as an allergy intolerance indicated for the prescribed drug or 
related to the drug prescribed. 

If there is an interaction indicated, the Allergy/Intolerance Checking screen displays: 

• Click OK when finished reading Drug Interactions. 

• Click Cancel to cancel writing the prescription. 

• Click Edit to edit the prescription. 

• Click More to check for additional interactions. 

• Click Mono to read a monograph using Allergy Interaction Report, if available. This report may 
be printed.  

Drug Dosage Checking 
A patient's drug dosage may be checked while writing and editing prescriptions using an optional 
drug interaction and allergy checking database (Medi-Span's Dose-Chek™ Version 2). This feature 
allows you to monitor prescribed drugs to ensure the dosage prescribed is appropriate for the patient. 
Dose-Chek Version 2 includes separate dosing values for adult, geriatric, pediatric, and infant patients 
(under 1 year of age).  

When a prescription is written or edited for the patient, the drug dose will be checked for validity. The 
dose is checked to see if it is too high, too low, or age appropriate, based on the entered, frequency, 
take, and size. If there is a contraindication, a warning message will be displayed to the user.  

Please note patient conditions such as renal insufficiency, hepatic dysfunction, obesity and malnutrition 
are not taken into account. 

To check drug dosage, the system administrator must select the Drug dose check check box on the 
Other Checks tab of Prescription Defaults. See the Prescription Defaults section for more information. 
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Diagnosis Checking 
A patient's diagnosis may be checked while writing prescriptions using an optional drug interaction 
and allergy checking database. This feature allows you to monitor prescribed drugs versus a patient's 
medical condition to ensure there is no adverse interaction and no drugs are prescribed that have 
potential contraindications with the patient's existing problems. 

When a prescription is written for a patient, the patient's current major problems, as well as other 
problems or diagnoses entered in the last few months (the number of months is controlled by a 
ppart.ini setting) are compared with the prescribed drug. Also, when you add a major problem, other 
problem, or diagnosis to the problem list, the added problem will be compared to all current 
prescriptions. In both cases, a warning displays when there is a contraindication, based on the setting 
level chosen.  

System administrators can use Prescription Defaults to select the warning level displayed during 
diagnosis checking. 

Checking for Interactions on Demand 
As described above, you can use an optional drug interaction and allergy checking database to 
automatically perform drug interaction, allergy intolerance, and diagnosis checks when you write a 
prescription for a patient. If required, you can also run these checks at any time from the 
Rx/Medications screen. 

To run interaction checks on demand: 

1. Do one of the following to open the Rx/Medications screen: 
• Select Show > Rx/Medications. 

• Click the Rx/Medications tab on the patient chart. 

• Click Rx/Meds on the Go To bar. 

2. On the Rx/Medications screen, click the Action button, and then select Interaction. Patient 
Records performs the following checks for the medications currently prescribed to the patient: 
• Drug interaction check 

• Allergy intolerance check 

• Diagnosis check 

3. If a drug interaction is found, the Drug Interactions screen appears. Review the information in 
the screen and then do one of the following: 
• Click OK if you do not want to check for additional interactions. A confirmation message 

appears, asking whether it is OK to stop the search. Click Yes. 

• Click Cancel to cancel the interaction check. A confirmation message appears, asking 
whether it is OK to stop the search. Click Yes. 

• Click More to check for additional interactions. 

• Click Mono to read a monograph using Drug Interaction Report, if available. This report 
can be printed. 

4. If an allergy intolerance or diagnosis check contraindication is found, a warning message 
appears. Review the message and then click OK. 

5. Repeat steps 3 or 4 for any additional interactions. 
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Entering Prescriptions from Outside Providers 
A patient may receive a prescription from an outside provider, such as a specialist to whom the patient 
was referred. This outside prescription needs to be entered to perform drug interaction and allergy 
intolerance checking, when available.  

Click Outside on Prescription to enter an outside prescription.  

An outside prescription does not need a PIN to enter it. This permits operators other than providers to 
make the entry. 

Note: An outside prescription cannot be printed or faxed.  

Adding Patient Instructions to Prescriptions 
Use Patient Instruction to add instructions to prescriptions. Either type the patient instructions or use 
patient instruction templates.  

To write prescriptions faster, Patient Instructions does not display if a template code for a Patient 
Instructions template matches the prescription template code. Patient Records uses the patient 
instructions template as is, and prints it automatically.  

Note: To review a patient instruction template before printing, use a different name than the 
corresponding prescription template.  

See Patient Instructions for more information. 

Adding Extended Sigs to Prescriptions 
Use Extended SIG when the instructions or format for a prescription are too complicated for the New 
Prescription. Up to 250 characters may be added using Extended SIG. Either type the extended sig or 
use extended sig templates.  

To make writing prescriptions faster, Extended SIG does not display if a template code for an 
extended sig template matches the prescription template code. Patient Records uses the extended sig 
template as is and prints it automatically.  

Note: To review an extended sig template before printing, use a different name than the 
corresponding prescription template.  

See Extended SIG for more information. 

Previewing Prescriptions Before Printing or Faxing 
A prescription may be previewed before printing or faxing using Preview Rx. This displays after writing, 
renewing, or editing a prescription.  

• Click OK to print or fax the prescription, depending on the print option selected.  

• Click Cancel to return to Rx/Medications.  

To preview a prescription, the system administrator must select the Review Rx on Screen check box on 
the Print Defaults tab of Prescription Defaults. See "About Prescription Defaults."  

Viewing Drug Cost Information  
When adding a prescription or creating a prescription template, the drug cost information may be 
viewed for many common drugs. This is available only with a subscription to the Drug Interaction 
database service.  
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To display a price, enter values in Medication and Size. If a drug has multiple routes, then complete 
Route to display the cost data.  

If a price is stored for the medication and its dosage, the system displays the cost in Per Unit.  

One way to display a total price, enter the Amount. Otherwise, the system calculates an amount if 
information is entered in Take, Frequency, and Duration. The value in Frequency must be valid (bid, 
tid, q4h, and so forth).  

When displaying a list of alternative drugs in the same class as the one being prescribed, the system 
includes their costs in the display.  

As part of drug costing, the unit or total cost of a drug may display when viewing the medication 
templates list. To display drug costs, the system administrator must select the Show Drug Costs in 
Template List check box on the Special Features screen. 

Complying with JCAHO's National Patient Safety Goal #2 
for 2004 (Communication) 

Using Standardized Terms 
There may be different ways to state the same frequency, size, name, or amount when writing a 
prescription. For example, the abbreviation "BID" (Latin, bis in die) means "twice a day" on a 
prescription.  

Sometimes one term can mean different things. For example, "HS" is an abbreviation for "half strength" 
and "bed time" (from Latin). 

You should consider not only changing your frequency defaults, but also modifying your RX templates 
to meet the JCAHO requirements.  

This capability is useful to meet the JCAHO National Patient Safety Goal #2 for 2004 (opens new 
window, Internet connection required).  

These standardized terms may be set using the following: 

• Modifying your frequency defaults 

• Changing your current Rx template 

• The system administrator may create settings in the ppart.ini file to change non-preferred terms 
to preferred terms when encountered. 

Minimum Required List of Terms to Avoid by JCAHO 
The JCAHO has determined that the following abbreviations are dangerous and should not be used in 
any form (uppercase, lowercase, with or without periods after letters). These must be on every 
organization's "Do not use" list, along with at least three other abbreviations, acronyms, or symbols of 
the organization's own choosing. (From "2004 National Patient Safety Goals - FAQs," Updated August 
30, 2004, JCAHO). 

Add each of these to the [Rx] section of the ppart.ini file to change an abbreviation, acronym, or symbol 
into a preferred term in printed prescriptions. For example, if added to the ppart.ini file, "Q.D." would 
change to "daily" when printed. 

The "Minimum Required List" of Dangerous Abbreviations, Acronyms, and Symbols for a "Do not 
use" List 
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Abbreviation, Acronym, or 
Symbol 

Potential problem Preferred term 

 U (for unit) Mistaken as zero, four, or cc Write "unit" 
 IU (for International 

unit) 
Mistaken as IV (intravenous) or 
10 (ten) 

Write "International Unit" 

 Q.D. (for once daily) 
 Q.O.D. (for once very 

other day) 

Mistaken for each other. The 
period after the Q or the "O" 
can be mistaken for an "I" 

Write "daily" or "every other 
day" 

 trailing zero (e.g., x.0 
mg) 

 lack of leading zero 
(e.g., .x mg), 

Decimal point is missed Never write a zero by itself after 
a decimal point (use x mg), and 
always use a zero before a 
decimal point (use 0.x mg) 

 MS 
 MSO4 

 MgSO4 

Confused for one another. Can 
mean either morphine sulfate 
or magnesium sulfate 

Write "morphine sulfate" or 
"magnesium sulfate" 

Additional Considerations 
In addition to the "Minimum Required List," the JCAHO recommends considering these items when 
expanding the "Do not use" list by three or more items. 
Use any of these in the [Rx] section of the ppart.ini file to prevent their use in printed prescriptions. 

The "Additional Considerations" of Dangerous Abbreviations, Acronyms, and Symbols for a "Do 
not use" List 

Abbreviation, Acronym, or 
Symbol 

Potential problem Preferred term 

 μg (for microgram) Mistaken for mg (milligram), 
resulting in ten-fold dosing 
overdose 

Write "mcg" 

 H.S. (for half-strength or 
Latin abbreviation for 
bedtime) 

Mistaken for either half-strength 
or hour of sleep. q.H.S. 
mistaken for every hour. All can 
result in a dosing error. 

Write out "half-strength" or "at 
bedtime" 

 T.I.W. (for three times a 
week) 

Mistaken for three times a day 
or twice weekly, resulting in an 
overdose. 

Write "3 times weekly" or "three 
times weekly" 

 S.C. or S.Q. (for 
subcutaneous) 

Mistaken as SL for sublingual or 
"5 every" 

Write "Sub-Q", "subQ", or 
"subcuteneously" 

 D/C (for discharge) Interpreted as discontinue 
whatever medications follow 
(typically discharge meds) 

Write "discharge" 

 c.c. (for cubic 
centimeter) 

Mistaken for U (units) when 
poorly written 

Write "ml" for milliliters 
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 A.S. (Latin abbreviation 
for "left ear") 

 A.D. (Latin abbreviation 
for "right ear") 

 A.U. (Latin abbreviation 
for "both ears") 

Mistaken for OS, OD, and OU 
respectively 

Write "left ear", "right ear", or 
"both ears" 

The Current Tab on Rx/Medications 
The Current tab on Rx/Medications displays information about a patient's current medications. Use 
this tab to do the following actions: 

• Add a prescription 

• Print a prescription 

• Change a prescription 

• Discontinue a prescription, and marking whether effective or not 

• Renew a prescription 

• Delete a prescription  

When discontinued, a medication moves to either the Historical tab or the Ineffective tab.  

Available Information 
Information on this tab includes the following details for current medications: 

• Date of prescription 

• Dosage 

• Frequency 

• Duration 

• Amount 

• Refills 

• Provider 

• Operator: This field displays the ID of the operator who signed the Rx. 

• Sign: This field may contain the following: 

• Y: Rx requires signature and has been signed.  

• N: Rx requires signature and has not been signed.  

• C: Rx requires co-signature.  

• Blank: When this field is blank the Rx does not require signature. 

• Co-Sign Provider: This field contains the ID of the provider who co-signed the Rx. 

• Co-Sign Operator: This field contains the ID of the operator who co-signed the Rx. 

• Co-Sign: This field may contain the following: 

• Y: Rx requires a co-signature and has been co-signed.  

• N: Rx requires co-signature and has not been co-signed.  

• Blank: When this field is blank the Rx does not require co-signature. 
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Viewing Hidden Information  
The table has more information than what can display when the screen is not maximized. Use the scroll 
bars or maximize Rx/Medications to see additional information: 

• Only the date, name, size, take (quantity taken per dose), and frequency display for an individual 
medication when Rx/Medications is not maximized. Scroll right or maximize to view the 
duration, amount (total quantity prescribed), refill, provider, signature, and co-signature.  

• The oldest prescriptions are at the top of the table. Scroll down to view more recently prescribed 
medications when they are not visible in the table. It is possible for there to be more medications 
prescribed than can display when maximizing Rx/Medications.  

Refills and Medication Notes 
An optional symbol in the left-most column on Rx/Medications warns when there is limited number of 
refills or when there is a medication note. The following table explains the symbol's meaning. 

Symbols Used in Left-Most Column on Rx/Medications 

Symbol Description 

!  Limited refills. For example, this could be used with narcotics prescriptions.  

* Note on medication. 

+ Limited refills and note on medication.  

When there is one of these symbols, view details about the medication using Medication Detail. Each 
prescription line has additional details, including route, extended signatures (sigs), notes, pharmacy, 
and original prescription date.  

Eligibility tab on the Rx/Medications screen 
Note: The Eligibility tab will only be enabled if the ePrescribing module is installed and connectivity to 
the ePrescribing network is established.  

You can receive real-time information about patients’ eligibility for pharmacy benefits with the 
ePrescribing module. The patient’s eligibility will be refreshed automatically when their chart is opened 
(unless a successfully eligibility query has occurred in the prior 24 hours). The results of the eligibility 
check will be displayed on the Rx/Medications screen’s Eligibility tab.  

You can also do an on-demand pharmacy eligibility check using the Check/Recheck Eligibility button 
on the Rx/Medications screen. If the eligibility check is successful the pharmacy benefits eligibility data 
will be displayed in the Rx/Medications screen’s Eligibility tab. The Eligibility tab displays the outcome 
(i.e., successful or unsuccessful) of the eligibility check and the date that the request was sent. If there is 
existing data in the tab, it will be replaced with the most recent pharmacy benefits eligibility data.  

Note: If no data has ever been received for the patient, the tab will display, "No pharmacy benefits 
eligibility has ever been sent for this patient." 

In order to send an eligibility request for a patient there must be a Lytec MD RxHub ID for the 
Provider/Practice under which you are logged into. If you are logged into a Provider/Practice that does 
not have a Lytec MD RxHub ID, or if there is no logon Provider and/or Practice the eligibility request will 
not be sent. You can enter the RxHub ID from the Practice Providers screen. The provider must also 
have a National Provider Identifier (NPI) and a Drug Enforcement Agency (DEA) number recorded. See 
the Adding NPIs and DEAs to your System section for more information. 
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Checking and printing pharmacy benefits eligibility data 

To check eligibility from the Rx/Medications screen: 

1. On the Rx/Medications screen, click the Eligibility tab.  

2. Click the Check/Recheck Eligibility button. Lytec MD will keep you updated with the status of 
the query. When the query is complete, the response will be displayed in the Eligibility tab.  

Note: If the eligibility check did not work you will receive a message letting you know the reason why. 
You can make the needed changes, and then re-try by clicking the Check/Recheck Eligibility button.  

To print the pharmacy benefits eligibility data: 

• On the Rx/Medications screen, click the Eligibility tab. Click the Print button. 
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Formulary Checking 
You can use the formulary checking feature to see the formulary status of a drug for a particular patient 
when writing a new prescription, editing an existing prescription, or renewing a prescription. The 
provided formulary information allows you to review details regarding the patient’s Pharmacy Benefits 
Manager’s coverage for a medication, including formulary status (e.g., "Preferred," "Non-Preferred," 
etc.), copay amounts, alternative medications that have a more preferential formulary status, other 
medications which the Pharmacy Benefits Manager requires the patient to try (if clinically appropriate) 
before the medication will be covered, and links to additional information. 

Before using the formulary checking feature you must run a pharmacy benefit eligibility query for the 
patient you want to check formulary information for. This is done automatically when you open a 
patient’s chart. You can also click the Eligibility button on the Prescription screen to send an eligibility 
request, and if information is received while you are still using the screen, the Formulary area of the 
Prescription screen will be updated with the acquired eligibility information. See the Eligibility tab on 
the Rx/Medications screen section for more information about sending an eligibility query.  

Note: You can specify the number of days to look back for formulary data on the Rx Defaults tab of the 
Prescription Defaults screen. See the Optional Configuration Settings section for more information.  

Formulary Checking requirements 
Before using formulary checking feature you must complete the following in the order listed below: 

□ Install Patient Records 9.4 

□ If you are not already subscribed to the Drug Interaction database, you must subscribe and 
install it before using the ePrescribing module. 

□ Enroll your providers with ePrescribing. To do this, please contact the Lytec MD EDI enrollment 
team (you do not have to contact RxHub directly to enroll your providers), by sending an e-mail 
to edienrollment@practicepartner.com. The EDI enrollment specialist will then contact you to 
obtain information about your practices and providers and complete the enrollment process 
for you.  

□ Add the ePrescribing Provider Identifiers provided to you by the EDI enrollment specialist to 
your Lytec MD system. See the Adding ePrescribing Provider Identifiers to your System section 
for more information. 

□ Add your Providers' NPIs (National Provider Identifiers) and DEA (United States Drug 
Enforcement Administration) numbers into Lytec MD (if you have not already done so). See the 
Adding NPIs and DEAs to your System section for more information.   

□ Install the ePrescribing module. See the ePrescribing Module Installation Guide for step-by-
step instructions.  

□ If needed, activate your installation of the ePrescribing module to the Lytec MD Clearinghouse. 
This process, by default, occurs during the installation of the ePrescribing interface, though you 
may choose to skip that step of the installation. If you do, you can activate your installation of 
RxHub and/or SureScripts to the Lytec MD Clearinghouse at a later time by running the 
standalone activation utility, which has the filename PMSI.CH.Activation.exe and is located in 
your database folder (usually p:\ppart). The activation utility must be run locally from the server.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 770 

 

□ If needed, use the ePrescribing Configuration Utility to configure the settings for the 
ePrescribing interface and the Pharmacy Download Utility. This utility runs automatically when 
the ePrescribing interface is installed. You can also run the utility at any time after the 
installation if you need to update the settings. You can find the utility, which has the filename 
PMSI.ePrescriptionConfiguration.exe in your database folder (usually p:\ppart). The 
ePrescribing Configuration Utility must be run locally from the server. See the ePrescribing 
Configuration Utility section in the ePrescribing Module User's Guide for more information. 

Using the Formulary Checking feature 
In order to receive formulary information you must at least enter the medication name, size, and route. 
As soon as you have entered enough information on the Prescription screen to allow identification of 
the medication, Patient Records displays formulary data for the health plan selected in the Plan drop-
down menu in the Formulary section of the screen, using the information from the most recent 
pharmacy benefits eligibility response. Each entry on the list represents a different health care 
coverage, as identified for the patient during the last pharmacy benefits eligibility check. If a patient has 
more than one health plan providing prescription benefits, there may be more than one option on the 
drop-down menu.  The default value for the Plan field is the first health plan from the eligibility 
response. To view formulary data for a different plan, click the arrow button to open a list of the 
available plans and select the desired one.  

Once the formulary check is complete for the selected health plan, one of the following formulary 
statuses will be displayed in the Formulary section of the Prescription screen: 

• Not Covered: This response is displayed when the medication has a Formulary Status of non-
reimbursable (0) or is subject to coverage exclusions (including coverage exclusions based on 
patient's age or sex). This means that the patient’s Pharmacy Benefits Manager’s formulary does 
not provide any coverage for this medication for the patient. Click the Details button for more 
information. 

• Non-Formulary: This response is displayed when the medication has a Formulary Status of non-
formulary (1). A status of non-formulary means that the prescription drug is not on a particular 
plan’s formulary. Non-formulary drugs are often covered by the health plan, but at a higher 
patient co-pay. 

• On Formulary (non-preferred): This response is displayed when the medication has a 
Formulary Status of non-preferred (2). 

• On formulary (preferred): This response is displayed when the medication has a Formulary 
Status of preferred (3-99). 

• Formulary status cannot be determined: This response is displayed when the medication’s 
formulary status cannot be determined. 

Co-pay information will be displayed in the Formulary section if there is a value for Copay_Tier for the 
medication and the "Non-Formulary", "On Formulary (non-preferred)", or "On Formulary (preferred)" 
results were returned. For example: 

On Formulary (preferred) 
Formulary status 8 
Copay: $13.79  

Formulary Details  
The Formulary Details section allows you to view any additional information about the coverage for the 
medication, based on the patient's health plan coverage.  
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The “ShowCoverageDetailsOnPrescriptionDialog” setting in the [Rx] section of the Ppart.ini file controls 
whether or not the system shows detailed formulary and coverage information on the Prescription 
screen itself. If this setting is set to ON, the additional information about the coverage for a medication 
(formulary status, quantity limits, copay information, alternative information, etc.) will display in the 
Formulary/Coverage Detail pane of the Prescription screen. If the 
“ShowCoverageDetailsOnPrescriptionDialog” setting is set to OFF, the Formulary Details will be 
hidden from view and will display on a separate screen accessible through the Details button in the 
Formulary section of the Prescription screen.  

You can click the Alternatives button to view the list of alternative medications with a more preferential 
formulary status. If there is no such data, the Alternatives button will be greyed out. You can select one 
of the alternative medications by clicking on the name of the medication in the list. After selecting the 
alternative medicine you will be returned to the Prescription screen. The alternative medicine name will 
be displayed in the Medication field. Patient Records will then perform a formulary check on the 
alternative medication selected by the user. See the Alternative Information explanation below for an 
overview of the information included on this screen.  

Note: You cannot select an alternative medication when checking formularies while renewing a 
prescription.  

You can print the formulary information on this screen by clicking the Print button.  

The "Details" will include all information provided by the patient’s Pharmacy Benefits Manager about 
coverage for the medication. Any or all of the following categories may be included: 

• Formulary status: This section displays the formulary status.  

• Not Covered: This response is displayed when the medication has a Formulary Status of 
non-reimbursable (0) or is subject to coverage exclusions (including coverage exclusions 
based on patient's age or sex). This means that the patient’s Pharmacy Benefits Manager’s 
formulary does not provide any coverage for this medication for the patient.  

• Non-Formulary: This response is displayed when the medication has a Formulary Status of 
non-formulary (1). A status of non-formulary means that the prescription drug is not on a 
particular plan’s formulary. Non-formulary drugs are often covered by the health plan, but 
at a higher patient co-pay. 

• On Formulary (non-preferred): This response is displayed when the medication has a 
Formulary Status of non-preferred (2). 

• On formulary (preferred): This response is displayed when the medication has a 
Formulary Status of preferred (3-99). 

• Formulary status cannot be determined: This response is displayed when the 
medication’s formulary status cannot be determined. 

• If the medication is not covered because of the patient's age or gender, this is indicated.  

• Resource links may be provided for the coverage exclusion(s) or formulary status. You can 
click on these links for further information.   

• Quantity Limits: This section displays information about limits imposed by the Pharmacy 
Benefits Manager as to the quantity of medication that can be dispensed to the patient 
(either in one fill event or over a time interval).  

• Copay information: This section displays information about the copay for which the 
patient will be responsible if the medication is prescribed. If the medication has a 
Formulary Status of non-reimbursable (0) or is subject to coverage exclusions (excluding 
coverage exclusions based on patient's age or sex), then the copay information section 
will not show any copay information for the medication. Since copay requirements may be 
different for different pharmacy types, this information is displayed in a tabular format. 
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• Alternative Information: This section displays alternative medications in two sections. 
Drugs that are specifically identified as alternative medications by the Pharmacy Benefit 
Managers (PBM) in their formulary tables are displayed in the first table. The second table 
displays medications in the same therapeutic class as the medication you selected which 
have an equal or higher formulary status with the patient’s Pharmacy Benefits Manager.   

• You can select one of the alternative medications by clicking on the name of the 
medication in the list. After selecting the alternative medicine you will be returned to the 
Prescription screen. The alternative medicine name will be displayed in the Medication 
field. Patient Records will then perform a formulary check on the alternative medication 
selected by the user.  

• Prior authorization requirements apply to this medication: If prior authorization 
information exists, this section displays links to additional information.  

• Medical Necessity requirements apply to this medication: If medical necessity information 
exists, this section displays links to additional information.  

• Step Therapy requirements apply to this medication: If step therapy information exists, 
this section displays links to additional information.  

• Step Medication requirements apply to this medication: This section displays step 
medication information. Information is displayed in this section when the patient’s health 
plan stipulates that the medication will only be covered if therapy with certain other 
medications has been attempted (if clinically appropriate).  

• Additional information from the pharmacy benefits manager: This section displays the 
text message in the formulary data.   

Resource links may be provided. You can click on these links for further information.   
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Electronic Signatures Personal Identification 
Numbers (PIN) for Prescriptions 
To prevent unauthorized operators from writing prescriptions, Rx/Medications may be configured to 
require the use of a personal identification number (PIN) when writing restricted and non-restricted 
prescriptions. Read more about PINs.  

The system administrator creates and resets PINs using the Patients Records tab of Operator 
Maintenance.  

Depending on what system settings were made with PRUtils, either the system administrator or the 
operator creates the PIN. A system administrator may reset a PIN at any time. Also, settings made in 
PRUtils control what restrictions there are in creating PINs. 

When an operator creates the PIN, either PIN or Rx PIN displays after logging on. The operator uses 
PIN or Rx PIN to create a PIN.  

Procedure for changing an Rx PIN 
To reset a PIN by a system administrator: 

A system administrator follows these steps when resetting a PIN. 

1. From the Maintenance menu, point to Set Up, and then click Operators. This opens Re-enter 
Password. 

2. Type the password in Please re-enter the password, and click OK. This opens Operator. 

3. Click to highlight the operator, then click Edit. This opens Operator Maintenance to the 
General tab. 

4. Click the Patients Records tab. 

5. Select the Reset Electronic Signature (PIN) check box. 

6. Click OK. This closes Operator Maintenance. 

7. Click Close on Operator. The PIN has been reset. 

8. Inform the operator of the new PIN. 

If the system administrator reset a PIN, the operator creates a new PIN when logging on. 

To create a new Rx PIN by an operator: 

An operator follows these steps when prompted by the system. This would occur when a system 
administrator resets a PIN for the operator. These steps follow immediately after typing the User ID and 
Password on Lytec MD Sign In and clicking OK. This opens PIN or Rx PIN. 

Note: Only asterisks (*) display in the box when typing the new PIN. This helps to protect the security of 
the new PIN from anyone that might see it on the monitor. 

1. Type your PIN in Please enter your electronic signature PIN in the box. 

2. Type the same PIN in Re-enter the PIN that as they were typed in Please enter your electronic 
signature PIN in order to verify the text. 

3. Click OK. The new PIN has been created. 
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Restrictions on Electronic Signatures (PINs) 
The system administrator restricts what may be used as a PIN in PRUtils. These settings include: 

• Set a minimum length for a PIN. The maximum PIN length is 6 characters. 

• Optionally require a PIN not to have more than one number repeat. 

A message warns when a new PIN violates one of the restrictions. A different PIN must be chosen 
before a new PIN may be saved. 

See PRUtils for more information about setting restrictions on passwords. 

Information on PIN or Rx PIN 
Field Description 

Please enter your electronic 
signature PIN  

Type your PIN in the box. This becomes the new PIN when 
finished. Please note your PIN may be no longer than 6 
characters. 
Only asterisks (*) display in the box in order to protect the 
security of the new PIN from anyone that might see it on the 
monitor. 

Please re-enter the PIN Type the same numbers in the same order that were typed in 
Please enter your electronic signature PIN. This verifies the 
new PIN. 
Only asterisks (*) display in the box in order to protect the 
security of the new PIN from anyone that might see it on the 
monitor. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 775 

 

Pharmacy Print options 
When you select the Transmit immediately, Transmit as a group, Print locally and transmit as a 
group, Print locally and fax as a group, or Fax as a group print options when adding, editing, or 
renewing a prescription and the patient is associated with more than one active pharmacy, no 
pharmacies, or you selected the Change Pharmacy check box, you can select which pharmacy the 
prescription will be sent to. See the sections below for a complete explanation.  

Transmit immediately, Transmit as a group, and Print locally 
and transmit as a group 
If the patient is associated with more than one active pharmacy, no pharmacies, or you selected the 
Change Pharmacy check box the Pharmacies for Patient screen appears after you have clicked the OK 
button to save a prescription. This screen displays the pharmacies associated with the patient (added 
from the Patient Configuration tab).  

To select which pharmacy the prescription will be sent to: 

1. On the Pharmacies for Patient screen, highlight the pharmacy in the list that you want to send 
the prescription to, and then click the OK button.  

2. If you do not see the pharmacy in the list that you want to send the prescription to, click the 
Pharmacies button. The Pharmacy Select screen appears.   

3. Highlight the pharmacy in the list that you want to send the prescription to, or use the search 
options to search for the pharmacy, and then click the OK button. Lytec MD will ask if you want 
the selected pharmacy to be added to the patient's pharmacy list. Click No to select the 
pharmacy without adding it to the patient's list. If you select Yes, the Link Pharmacy to Patient 
screen appears. 

4. Fill in the fields on this screen, and click the OK button. The pharmacy is added to the 
Pharmacies for Patient list. 

5. Click the OK button to transmit the prescription.  

Fax as a group and Print locally and fax as a group 
Important: The UseFaxServer ppart.ini setting must be enabled to send faxes as a group. 

If the patient is associated with more than one active pharmacy, no pharmacies, or you selected the 
Change Pharmacy check box the Pharmacies for Patient screen appears, after you have exited the Rx / 
Medications screen. This screen displays the pharmacies associated with the patient (added from the 
Patient Configuration tab).  

To select which pharmacy the prescription will be faxed to: 

1. On the Pharmacies for Patient screen, highlight the pharmacy in the list that you want to fax the 
prescription to, and then click the OK button.  

2. If you do not see the pharmacy in the list that you want to fax the prescription to, click the 
Pharmacies button. The Pharmacy Select screen appears.   

3. Highlight the pharmacy in the list that you want to fax the prescription to, or use the search 
options to search for the pharmacy, and then click the OK button. Lytec MD will ask if you want 
the selected pharmacy to be added to the patient's pharmacy list. Click No to select the 
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pharmacy without adding it to the patient's list. If you select Yes, the Link Pharmacy to Patient 
screen appears.  

4. Fill in the fields on this screen, and click the OK button. The pharmacy is added to the 
Pharmacies for Patient list.  

5. Click the OK button to fax the prescription.  
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Dose Advisor 
Important: If you are not already subscribed to the Drug Interaction database, you must subscribe and 
install it before using the Dose Advisor. If you attempt to use the Dose Advisor and you have not 
subscribed to the database, you will receive the following message: 
 
"The Dose Advisor feature requires installation of the Lytec MD Drug Interaction Database. This has not 
been installed on your system." 

The Dose Advisor uses the patient's demographic and clinical information and prescribed medication 
to calculate a recommended dose for the patient. You can use the dose provided by the Dose Advisor, 
or you can choose to enter a different dose. 

The Dose Advisor uses the drug interaction database. If the prescribed drug is not in the database you 
can not use the Dose Advisor. 

To use the Dose Advisor: 

1. On Rx/Medications, click New to open the Prescription <New> screen. 

2. Enter a valid medication name and route on the Prescription <New> screen. If there is no date 
of birth for the patient, or if the patient is under 13 years old and there is no recent weight 
entered, you will receive a message instructing you to enter that information in Patient 
Demographics before Dose Advisor can give valid advice.  

3. Click the Dose Advisor button. The Dose Advisor screen appears. The fields on this screen 
display data specific to the patient.  

4. If appropriate, add or adjust information on the Dose Advisor screen.  

5. Click the Calculate button. The Size, Take, Frequency, Duration, and Extended Sig fields will 
display the recommended values in the corresponding fields. You can change any of the values 
if you disagree with the recommended dose. You can also change values entered on this 
screen and re-calculate the dose. Once you are satisfied with the dose, click the OK button. The 
Size, Take, Frequency, and Duration fields on the Prescription screen will be filled in with the 
corresponding values from the Dose Advisor screen.  

Note: If you modify data on this screen and then click OK before re-calculating the dose, you will 
receive a message asking whether you want to re-calculate the dose before exiting the screen. Click 
Yes, to re-calculate the dose or No to return to the Prescription screen without re-calculating the dose.   

Fields on the Dose Advisor screen 
Field Description 

Dose Type Select the dose type from the drop-down menu (e.g., 
"Maintenance," "Loading," or "Initial" dose). 

Indication Select the indication. If an indication has been entered in the 
Indication 1 field on the Prescription screen it will be displayed 
in this field. If you select an indication from this screen, the 
Indication 1 or Indication 2 field will be filled in with this value 
after the dose has been calculated (depending on whether a 
value has already been entered in the Indication 1 field).   
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Weight This field displays the patient's most recent weight. You can 
click the Update button to update the patient's weight on the 
Vital Signs screen. Once you have entered the new weight, it 
will be displayed with the date it was updated.  

Height This field displays the patient's most recent height. You can 
click the Update button to update the patient's height on the 
Vital Signs screen. Once you have entered the new height, it will 
be displayed with the date it was updated.  

Liquid Select this check box if you wish Dose Advisor to search for 
liquid dosage forms of the medication. This only applies when 
the route was set to “Oral” on the Prescription screen. This 
check box will automatically be selected if the patient is under 
the age of 7. 

Serum Creatinine This field displays the patient's most recent serum creatinine. 
You can enter or change the serum creatinine value. The 
entered value will be used for dose calculation but will not be 
saved to the database.  

Estimated Creatinine Clearance The patient's estimated serum creatinine concentration is 
calculated based on their age, gender, and body weight.  
If a value is entered in this field you can select the radio button 
to use the value as a part of the dose calculation. You have the 
choice of using either this value or the Previously Recorded 
Creatinine Clearance value (if one exists). You may only use one 
or the other. 

Note: Creatinine clearance is an estimate of glomerular 
filtration rate or "GFR".  

Previously Recorded Creatinine 
Clearance 

This field contains the most recent Creatinine Clearance value 
from the patient's lab tables.  
If a value is entered in this field you can select the radio button 
to use the value as a part of the dose calculation. You have the 
choice of using either this value or the Estimated Creatinine 
Clearance value. You may only use one or the other.  

Calculate button Click this button to calculate the dose. The Size, Take, 
Frequency, and Duration fields will display the recommended 
values in the corresponding fields. You can change any of the 
values if you disagree with the recommended dose.  

Size This field displays the dose strength to which the dosing 
recommendation corresponds.   

Take This field displays the take recommendation. You can change 
the take if you disagree with the recommended dose.   

Frequency This field displays the frequency recommendation. You can 
change the frequency if you disagree with the recommended 
dose.   

Duration This field displays the duration recommendation. You can 
change the duration if you disagree with the recommended 
dose.   
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Extended Signature Type an extended signature in this field. If an extended 
signature is entered from this screen, the Use Extended Sig 
check box will be selected on the Prescription screen, and the 
entered text will be displayed on the Extended Sig screen.  
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Dose Calculator 
The Dose Calculator allows you to easily calculate patient-specific dosing by weight, calculated body 
surface area (BSA), or both.  

Using the Dose Calculator 
To use the Dose Calculator: 

1. On the Rx/Medications screen, click the New button. The Prescription <New> screen appears. 

2. Enter a valid medication name, route, and size.  

3. Click the calculator button  (next to the Take field). The Dose Calculator screen appears.  

4. (Optional) Click the Update button to enter or update the patient's weight and/or height from 
the Vital Signs screen. When you are finished, click OK. The new values will be displayed with 
the date they were updated in the appropriate fields.  

5. Enter the dosing parameters:  
• Type the factor value in the first field. The factor value is a number that will be used to 

calculate the dose by multiplying by the weight and/or calculated body surface area (BSA) 
(and, if you selected per day, divided by the number of doses per day indicated by the 
frequency value). The maximum length is up to 7 digits before the decimal point and 3 
digits after the decimal point. See the Dose Calculator Formulas section for more 
information. 

• Type or select a dosage unit from the second drop-down list.  

• Select the denominator from the third drop-down list.  

6. Select per dose or per day. If you select per day, type or select the frequency from the 
Frequency drop-down list.   

The calculated amount is displayed in the Dose section of the screen.  

7. When you finish, click the OK button. The Prescription screen appears.   

The calculated take and frequency will display the recommended values in the corresponding 
fields on the Prescription screen. You can change the values if you disagree with the calculated 
dose. Once you are satisfied with the dose, click the OK button.  

Dose Calculator Formulas 
The following formulas are used to calculate patient-specific dosing. The calculations are determined 
by the entered factor value which is used to calculate the dose by multiplying by the weight, BSA, or 
both (and, if you selected per day, divided by the number of doses per day indicated by the frequency 
value). 

Per Day Formula 
If you selected "per day", and you selected kg as the denominator the amount is calculated as: 

Dose = factor value x weight in kg / number of doses per day as indicated by the Frequency value 

If you selected "per day", and you selected m2 as the denominator the amount is calculated as: 

Dose = factor value x BSA in m2 / number of doses per day as indicated by the Frequency value 
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If you selected "per day", and you selected kg/m2 as the denominator the amount is be 
calculated as: 

Dose = factor value x weight in kg / BSA in m2 / number of doses per day as indicated by the 
Frequency value) 

Note: The number of doses per day = 1 for QD or Once daily, 2 for BID or Twice Daily, 3 for TID or 
Three times daily, 4 for QID or Four times daily, etc. The dose will not be calculated if you selected 
per day and the Frequency value is less than 1 dose per day. 

Per Dose Formula 
If you selected "per dose", and you selected kg as the denominator the amount is calculated as: 

Dose = factor value x weight in kg 

If you selected "per dose", and you selected m2 as the denominator the amount is calculated as: 

Dose = factor value x BSA in m2 

If you selected "per dose", and you selected kg/m2 as the denominator the amount is calculated 
as: 

Dose = factor value x weight in kg / BSA in m2 

Notes:  
- If the size you entered for the medication on the Prescription screen specifies the strength in terms of 
milligrams (e.g., "500 mg"), and the dosage unit numerator selected from the Dose Calculator is "mg", 
then the Take will be calculated in terms of number of units of the medication rather than in terms of 
the dose in mg. To do this, the "Take" arrived at with the formulas listed above will additionally be 
divided by the strength in mg as entered in the Size field. The calculated amount will be rounded to the 
nearest unit and displayed in the dose section of the screen followed by the calculated dose in mg in 
brackets (e.g., "2 [Rounded from 1200mg]").  
 
- If the size you entered for the medication on the Prescription screen species the strength in terms of 
milligrams/milliliters (e.g., "125mg/5 ml") or in milligrams/cubic centimeters (e.g., "500 mg/cc"), and 
the dosage unit numerator selected from the Dose Calculator is "mg", then the Take will be calculated 
in terms of volume of the medication (ml or cc) rather than in terms of the dose in mg. To do this, the 
“Take” arrived at with the formulas listed above will additionally be divided by the strength in mg/ml or 
mg/cc as entered in the Size field. The calculated amount will be rounded to an easy-to-measure 
amount (to the nearest ml or cc if the amount is less than 5 ml and to the nearest 2.5 ml or cc if the 
amount is greater than 5 ml) and displayed in the dose section of the screen followed by calculated 
dose in mg in brackets (e.g., "25ml [Rounded from 650mg]"). 

Fields and buttons on the Dose Calculator screen 
Field Description 

Weight Displays the patient's most recent weight, or the field will be 
blank if there is no weight entered for the patient. You can click 
the Update button to enter or update the patient's weight on 
the Vital Signs screen. Once you have entered the new weight, 
it will be displayed with the date it was updated.  
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Height Displays the patient's most recent height, or the field will be 
blank if there is no a height entered for the patient. You can 
click the Update button to enter or update the patient's height 
on the Vital Signs screen. Once you have entered the new 
height, it will be displayed with the date it was updated.  

Calculated body surface area Displays the patient's calculated body surface area (BSA), using 
the Mosteller Formula: 

• BSA (m2) = square root of (height (cm) x weight (kg) / 
3600) 

NEJM 317(17): 1098, 1987 

Note: The BSA will only be calculated if a height and weight are 
available for the patient.  

Dosing Parameters Enter or select the dosing parameters.  
• Type the factor value in the first field. The factor value is 

a number that will be used to calculate the dose by 
multiplying by the weight and/or calculated body 
surface area (BSA) (and, if you selected per day, divided 
by the number of doses per day indicated by the 
frequency value). The maximum length is up to 7 digits 
before the decimal point and 3 digits after the decimal 
point. See the Dose Calculator Formulas section for 
more information. 

• Type or select a dosage unit from the second drop-
down list.  

• Select the denominator from the third drop-down list.  

Note: If a needed parameter is not entered, the dose will not 
be calculated.  

per day Select if the quantity of the medication is taken per day. You 
must then type or select the frequency from the Frequency 
drop-down list.   

Frequency  If you selected per day, type or select the frequency. If a 
frequency was selected on the Prescription screen prior to 
opening the Dose Calculator, it will be displayed in this field.  

per dose Select if the quantity of the medication is taken per dose.    

Dose Frame Displays the calculated amount in the Take field. The amount 
will be rounded if there are more than 2 digits after the decimal 
point. For example, 5.66666666666 mg will be rounded to 5.67 
mg. 
The medication name, size, and route are displayed above the 
calculated amount.   
If the take could not be calculated based on the entered values, 
it will not be displayed.  
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Allergies and Intolerances  
To add a patient's allergies and intolerances, click the Allergy button on the Rx / Medications screen. 
This feature allows you to add, modify, and delete allergies and intolerances for medications. You can 
enter an unlimited number of allergies and intolerances for the patient. When an allergy or intolerance 
is added, it will be displayed in the Allergies or Intolerances list at the top of the Rx / Medications 
screen.  

If your organization uses drug interaction, the system will validate the medication or allergy name 
entered. First, the drug name is checked using the drug interaction database. If the entry is not found 
there, then the drug name cross-reference file is checked. If found in neither, a list displays from which 
to pick a medication. 

Note: You can record allergies and intolerances directly from the Rx / Medications screen, or load 
them from Progress Notes with the Text Data Loader. 

The Allergies or Intolerances list on the Rx / Medications screen allows you to record, review, and 
update the patient’s allergies and medication intolerances. You can also record the date this 
information was last reviewed with the patient by clicking the Today button next to the Allergies 
Reviewed date field. When clicked, the date, time, and the ID of the logged in operator who reviewed 
the allergies will be recorded. The current date will be displayed in the Allergies Reviewed field. The 
reviewed date will not change until updated by a user. If the user wishes to record that allergies were 
reviewed with the patient on a prior date, the date can be directly entered in the date field on this 
screen. 

Adding, Editing, and Deleting Allergies or Intolerances 
To add a patient's allergies and intolerances, click the Allergy button on the Rx / Medications screen. 
This feature allows you to add, modify, and delete allergies and intolerances for medications. You can 
enter an unlimited number of allergies and intolerances for the patient. When an allergy or intolerance 
is added, it will be displayed in the Allergies or Intolerances list at the top of the Rx / Medications 
screen.  

To add an allergy or intolerance: 

1. Open the Rx / Medications screen, and click the Allergy button. The Allergy: New screen 
appears. 

2. Fill in the fields on this screen. 

3. When you are finished, click OK. The new allergy or intolerance will be displayed in the 
Allergies or Intolerances list at the top of the Rx / Medications screen. 

Note: If you selected Food Allergy as the allergy type, and the Check Food Allergies when Checking 
Allergies check box is not selected in the Prescription Defaults screen Rx Defaults tab, you will receive 
a warning message when you click OK, stating that the system will ignore the allergy when you are 
prescribing medications. 

To edit an allergy or intolerance: 

1. Open the Rx / Medications screen, and double-click the allergy or intolerance you want to 
change in the Allergies or Intolerances list. The Allergy: Edit screen appears.  

2. Make the appropriate changes.  

3. When you are finished, click OK. 
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To delete an allergy or intolerance: 

1. Open the Rx / Medications screen, and double-click the allergy or intolerance you want to 
delete in the Allergies or Intolerances list. The Allergy: Edit screen appears.  

2. Click the Delete button. A confirmation message is displayed. Click Yes.  

Adding the NKA and NKDA Designation to a Patient's 
Allergies and Intolerances List 
If a patient has no known drug allergies, or no known allergies you can add "NKDA" (no known drug 
allergies) or "NKA" (no known allergies) to the patient's Allergies and Intolerances list. You cannot add 
the "NKA" designation for any patient who has any current allergies, or the "NKDA" designation for any 
patient who has any current allergies of the type "Drug Allergy".  

  Important: The NKDA (no known drug allergies) abbreviation is ignored when performing drug 
interaction and allergy checking. 

To add the NKA or NKDA designation to a patient's allergies and intolerances list:  

1. Open the Rx / Medications screen, and click the Allergy button. The Allergy: New screen 
appears. 

2. Type NKA or NKDA in the Medication/Allergy Name field.   

3. Optional Fill in the date and time identified in the provided fields.  

4. When you are finished, click OK. The NKA or NKDA designation will be displayed in the 
Allergies or Intolerances list at the top of the Rx / Medications screen. 

Note: If "NKA" or "None" is already entered in a patient's list, and you attempt to add an allergy, you 
will receive a message stating that the current "NKA" designation in the patient's allergies and 
intolerances list will be removed if you save the allergy.  
 
If "NKDA" is already entered in a patient's list, and you attempt to add an allergy of type "Drug Allergy", 
you will receive a message stating that the current "NKDA" designation in the patient's allergies and 
intolerances list will be removed if you save the allergy. 
 
If "NKDA" is already entered and a patient has no other non-drug allergies entered in their list, and you 
attempt to add "NKA", you will have the option to remove the "NKDA" designation from the patient’s 
allergies and intolerances list.  
 
When processing the .AL, .AL2, and .AL3 Dot codes in a note, or via the Text Data Loader, and 
importing allergy data from a CCR or CCD document using the "Import Medical Summary" feature the 
same "NKA" and "NKDA" rules will apply.  

Recording the Allergies and Intolerances Reviewed Date 
The Allergies or Intolerances list on the Rx / Medications screen allows you to record, review, and 
update the patient’s allergies and medication intolerances. You can also record the date this 
information was last reviewed with the patient by clicking the Today button next to the Allergies 
Reviewed date field. When clicked, the date, time, and the ID of the logged in operator who reviewed 
the allergies will be recorded. The current date will be displayed in the Allergies Reviewed field. The 
reviewed date will not change until updated by a user. If the user wishes to record that allergies were 
reviewed with the patient on a prior date, the date can be directly entered in the date field on this 
screen. 
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You can record the date that the patient's allergies and medication intolerances were reviewed with the 
patient. You can click the Today button to record the current date, time, and the ID of the logged in 
operator. If you wish to record that the allergies were reviewed with the patient on a prior date, the 
date can be directly entered in the Allergies review field on this screen. 

To record the allergies and intolerances reviewed date: 

Open the Rx / Medications screen, and do one of the following: 

• To record the current date: Click the Today button. The Allergies Reviewed field will display 
the current date.  

• To record a prior date: Type the date that the allergies and intolerances were reviewed with the 
patient in the Allergies Reviewed field using MM/DD/YYYY format.  

Viewing and Re-activating Deleted Allergies 
You can view and re-activate allergies or intolerances that have been deleted from Patient Records (i.e., 
add a new allergy using the data from a deleted allergy). When an allergy or intolerance is deleted in 
Patient Records, the deleted allergy or intolerance can be viewed from the Allergies-Deleted screen. If 
you choose to re-activate a deleted allergy or intolerance for a patient, you can select the allergy and 
choose to make it current. Before the allergy is re-activated you may make any required modifications. 
Once the allergy has been added for the patient it will be displayed in the Allergies or Intolerances list 
at the top of the Rx / Medications screen.  

Note: You will be blocked from adding the allergy if there is already a current allergy record for the 
same medication. 

To view a deleted allergy's details: 

1. Open the Rx / Medications screen, and click the View Deleted button. The Allergies-Deleted 
screen appears.  

2. Double-click the allergy that you want to view, or select the allergy and click the Details button. 
The Deleted Allergy: View screen appears.  

To make an inactive allergy current: 

1. Open the Rx / Medications screen, and click the View Deleted button. The Allergies-Deleted 
screen appears.  

2. Double-click the allergy that you want to make current, or select the allergy and click the 
Details button. The Deleted Allergy: View screen appears.  

3. Click the Make Current button. The screen name will change to Allergy: New, allowing you to 
edit all fields.  

4. Make any required changes to allergy or intolerance.  

5. When you are finished, click OK. The allergy will be displayed in the Allergies or Intolerances 
list at the top of the Rx / Medications screen. 

Allergy screen and Deleted Allergy: View screen 
The Allergy screen is used when adding, editing, or deleting allergies or intolerances. You can also use 
this screen to view the details for allergies that have been deleted.  
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To open the Allergy: New screen: 

• Open the Rx / Medications screen, and click Allergy button. The Allergy: New screen appears. 

To open the Allergy: Edit screen: 

• Open the Rx / Medications screen, and double-click the allergy or intolerance you want to 
change in the Allergies or Intolerances list. The Allergy: Edit screen appears.  

To open the Deleted Allergy: View screen:  

1. Open the Rx / Medications screen, click the View Deleted button. The Allergies-Deleted 
screen appears.  

2. Double-click the allergy that you want to make current, or select the allergy and click the 
Details button. The Deleted Allergy: View screen appears.  

Fields on the Allergy screen and Deleted Allergy: View screen 

Field Description 

Date/time identified Type the date and time (if known) the allergy or intolerance was 
identified using the mm/dd/yy format and the HH:MM format. 
That is the date and time of the vaccine reaction or allergic 
occurrence.  

Note: You may enter the date only. If you enter a time, you 
must also enter a date. 

Operator This field displays the logged in operator. 

Medication/Allergy Name Type all or part of the medication or allergy name.  
When typing only part of the medication name, the Select 
Drug Name screen opens with possible drugs. Click the drug 
name and then click OK to insert the name in the 
Medication/Allergy Name field.  
If Select Drug Name opens, but what was typed in 
Medication/Allergy Name field was correct, click the Drug OK 
button. 

Allergy Type Select the allergy type from the drop-down list. Your options 
include, Drug Allergy, Drug Intolerance, Miscellaneous, and 
Food Allergy.  

Note: The Check Food Allergies when Checking Allergies 
check box in the Prescription Defaults screen Rx Defaults tab 
determines whether food allergies are checked when 
medications are prescribed. 

Severity Select the severity of the allergy from the drop-down list. Your 
options include Severe, Moderate, and Mild.  

Reaction  Select the patient's reaction to the medication from the drop-
down list, or enter your own reaction. The reaction is displayed 
in the list next to the allergy or intolerance in parentheses.  

Code This field is reserved for future use.   
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Allergy originally entered on 
[date] at [time] 

Shows the date and time the allergy was originally entered. 

Allergy last edited on [date] at 
[time] 

Shows the date and time the allergy was last edited.  

Make Current button Click to re-activate the deleted allergy or intolerance (i.e., add a 
new allergy using the data from the deleted allergy). The screen 
name will change to Allergy: New. You can then edit the allergy 
or intolerance if needed before re-activating it.  
See the Viewing and Re-activating Deleted Allergies section for 
more information.  

Note: This button only appears on the Deleted Allergy: View 
screen.  

Allergies-Deleted screen 
The Allergies-Deleted screen lists the deleted allergies and intolerances for the selected patient. You 
can use this screen to view the details of any of the current patient's deleted allergies or intolerances.  

To open the Allergies-Deleted screen: 

• Open the Rx / Medications screen, and click the View Deleted button. The Allergies-Deleted 
screen appears. 

Fields on the Allergies-Deleted screen 

Field Description 

Deleted Allergies list Lists the allergies and intolerances that were deleted for the 
patient. The deleted items are shown in descending 
chronological order, that is, with the most recent at the top.  
Displays the allergy name, the date and time the allergy or 
intolerance was deleted, and the operator who deleted the 
allergy or intolerance.  

Details button Click to view the details for the selected deleted allergy or 
intolerance.  
See the Viewing and Re-activating Deleted Allergies section for 
more information.  
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ePrescribing Module 
The Electronic Prescribing ("ePrescribing") module allows you to send and receive prescription-related 
messages to and from pharmacies, to view real-time pharmacy benefits eligibility data on your patients, 
to see up-to-date formulary and coverage information for specific drugs during the prescribing 
process, and to view information about prescriptions your patients have had filled, even from other 
providers.  

To use the ePrescribing module you must first install the module and then establish connectivity to the 
ePrescribing network. See the ePrescribing Module User's Guide for step-by-step instructions on how 
to setup and use the ePrescribing module. 

Important: To use the ePrescribing module you must have an always-on Internet connection. 

Note: See the ePrescribing Module User's Guide for information on the ePrescribing Configuration 
Utility and the Clearinghouse enrollment process.  

  

Adding ePrescribing Provider Identifiers to your System 
Once you have enrolled your providers with ePrescribing, the EDI enrollment specialist will provide you 
with special ePrescribing identifiers that you must enter into your Lytec MD system. These will identify 
your providers to the two ePrescribing networks with which Lytec MD connects: SureScripts and RxHub. 
You will receive one RxHub ID for each Provider, and at least one SureScripts ID for each Provider 
(Providers who are associated with more than one “Practice” in your Lytec MD system will have one 
SureScripts ID for each Practice with which they are associated). 

To add ePrescribing Provider Identifiers to your system: 

1. Select Maintenance > Practices. The Practice Maintenance screen appears. 

2. On the Practice Maintenance screen, select the first practice for which you wish to add 
ePrescribing Provider Identifier data. Click the Edit button. The Practice Maintenance <Edit> 
screen appears. Click on the General 2 tab. 

3. In the Providers Affiliated with Practice grid highlight the first provider for which you wish to 
add SPI data and click the Edit Prv button.  If the provider is not listed, click the New Prv button 
and enter the Provider ID in the Provider field on the Practice Providers screen.  

4. Enter the ePrescribing Provider Identifiers for the selected provider in the SureScripts ID and 
RxHub ID fields. Note that the SureScripts ID will be different for each Practice for a particular 
Provider, but the RxHub ID will be the same for all Practices for a particular Provider. 

5. When you finish, click the OK button. 

6. Repeat steps 3-5 until you have entered ePrescribing Provider Identifiers for each provider for 
that Practice. Click OK to return to the Practices Maintenance screen. 

7. Repeat steps 2-6 for each of the practices for which you wish to add ePrescribing Provider 
Identifiers data. 

Important: If you wish in the future to allow new Providers at your site who use the ePrescribing 
module, you will need to enroll them and add their ePrescribing Provider Identifiers, as above. 
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Adding NPIs and DEAs to your System 
In order to use the ePrescribing module, each provider must have their National Provider Identifier and 
their Drug Enforcement Agency numbers added to the system.  

To add National Provider Identifiers to your system: 

1. Select Maintenance > Providers. The Providers Maintenance Select screen appears. 

2. On the Providers Maintenance Select screen, highlight the provider for which you want to enter 
an NPI. Click the Edit button. The Provider Maintenance <Edit> screen appears. Click the 
General tab.  

3. Enter the National Provider Identifier for the selected provider in the NPI field.    

4. When you finish, click the OK button. 

5. Repeat steps 2-4 until you have entered NPIs for each provider. Click OK to return to the 
Providers Maintenance Select screen. 

To add Drug Enforcement Agency (DEA) numbers to your system: 

1. Select Maintenance > Providers. The Providers Maintenance Select screen appears. 

2. On the Providers Maintenance Select screen, highlight the provider for which you want to enter 
the DEA information for. Click the Edit button. The Provider Maintenance <Edit> screen 
appears. Click the Credentials tab.  

3. Enter the Drug Enforcement Agency number for the selected provider in the DEA field.  

4. Enter the date the DEA number was first issued in the First Issued field, and enter the date the 
DEA number was last renewed, or the date it needs to be renewed in the Last/Next Renewed 
field. You can also click the down arrow button to access the calendar.  

5. When you finish, click the OK button. 

6. Repeat steps 2-4 until you have entered DEAs for each provider. Click OK to return to the 
Providers Maintenance Select screen. 

Adding Pharmacies to Patient Records 
Before you can send a prescription to a pharmacy electronically, that pharmacy needs to exist in your 
Lytec MD database. The preferred method to add pharmacies is using the automatic Pharmacy 
Download process of the ePrescribing module. See the ePrescribing Configuration Utility section in 
the ePrescribing Module User's Guide for a complete overview of this. This section describes how to 
enter a pharmacy into your database manually, though it is likely to be much more convenient, and the 
risk of errors is less, if you use the Pharmacy Download Utility. Once a pharmacy exists in your system, 
you can associate it with a patient in the Patient Demographics section. 

Note: This process is not necessary for any pharmacy downloaded from the ePrescribing pharmacy 
database. See the ePrescribing Configuration Utility section in the ePrescribing Module User's Guide 
for more information.   

To add a new pharmacy: 

1. Select Maintenance > Tables > Pharmacies. The Pharmacy IDs Select screen appears. 

2. On the Pharmacy IDs Select screen, click the New button. The Pharmacy <New> screen 
appears.  

3. Enter the pharmacy ID and name in the Pharmacy ID and Pharmacy Name fields. 
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4. Enter the NCPD ID in the corresponding field. Please note this ID must be obtained from the 
pharmacy you are entering the information for. 

5. Select SS from the Send Type drop-down menu if the pharmacy is affiliated with the 
SureScripts network, or RxH if it is affiliated with the RxHub network. 

6. Enter any other applicable information in the fields on this screen. 

7. When you are finished click the OK button. 

Repeat this process to add all desired pharmacies to Patient Records. 

See the Pharmacies section for a complete explanation of the fields on the Pharmacy <New> screen.  

Once a pharmacy exists in your system, you can associate it with a patient using Patient Demographics. 
See the Patient Pharmacies section for a complete explanation of how to associate a patient with a 
pharmacy. 

Refill Requests 
Refill requests are delivered to Lytec MD users via the Lytec MD messaging system. When you receive a 
refill request, you may approve or deny the request, or select “Change” to instruct the pharmacy to fill a 
prescription which differs from what they have requested. Once you have selected one of the options, 
your response will be sent back to the pharmacy via the ePrescribing module.   

Note: The ePrescribing module uses the Lytec MD messaging system to send refill requests. You must 
use the ePrescribing Configuration Utility’s Messaging Configuration tab to specify the provider ID and 
operator ID cross-reference relationships, to ensure that refill requests are sent to the correct operator. 
See the Messaging Configuration Tab section in the ePrescribing Module User's Guide for more 
information.   

To view and respond to a refill request: 

1. To open the Messages screen, do either of the following: 
• Click Msg on the toolbar. 

• From the Task menu, select Messages.  

2. In the message pane, select the message and click the View button. Otherwise, double-click 
the message. The message opens in the View Message screen, including the details of the refill 
request.  

Important: You can forward refill requests to operators. To forward a refill request click the Forward 
button. The Operator Select screen appears. Select the operator you want to forward the message 
to and click OK. The message will be sent to the operator with the following note at the top of the 
message window:  
 
"This refill authorization was referred to you by user" and then your Operator ID.   

3. On the View Message screen, click the Reply button. 

If Lytec MD can’t match the patient in an inbound refill request message to a patient in the 
database, it will still send the request to the Inbox of the designated operator for the provider. 
When you click Reply it will allow you to use the Patient Lookup function to select the 
appropriate patient to associate the patient with the refill request, or to indicate that the patient 
in the refill request is not a patient in your system.  

If a patient match was found, then Lytec MD will attempt to match the medication information 
sent from the pharmacy to the medications on the patient’s current medication list. If it finds a 
match, it will display in the header of the “Reply” screen the prescription details from the 
pharmacy, side-by-side with the details of the prescription in your Lytec MD database to which 
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it was matched. It is very important that you examine this information carefully to ensure that 
the match is correct.   

If you approve the refill request, this will instruct the pharmacy to fill the medication according 
to the details of their original request.  

If Lytec MD cannot find a medication on the patient’s current medication list which matches 
what the pharmacy has requested, then when you click Reply, Lytec MD will display the 
“Medication Picker” dialog, which allows you to manually pick a medication from the patient’s 
medication list that matches the refill request. This step allows for situations where the patient’s 
medication list does include the medication that the pharmacy has requested but because of 
slight differences in spelling etc. was not recognized by Lytec MD as indicating the same 
medication. If the patient’s medication list does not contain the medication requested by the 
pharmacy, click the Not on List button (you will then be prompted to deny the refill request). 

4. Click the Approve, Deny, or Change button to approve, deny, or change the refill request.  

If you have configured Lytec MD to require Electronic Signatures for prescriptions, then the 
user is prompted for a provider signature or PIN. If the current operator does not have 
prescription-signing authority, they will receive the following message: 

“You do not have the authority to sign prescriptions. Please select another user to handle 
this refill request.” 

Click OK to forward the message to an operator who has prescription-signing authorization. 
The Operator Select screen appears. Select an operator from the list, and click OK. If the 
selected operator is authorized to sign prescriptions, the message will be forwarded to the 
operator. You will receive a message if the selected operator does not have prescription-
signing authorization. Click OK to select another operator from the Operator Select screen. 
Click Cancel to cancel the prescription approval or change.   

Important: If the prescription is for a medication designated as a controlled substance by the United 
States Drug Enforcement Administration, and the ppart.ini file setting, 
"BlockTransmissionofControlled" for the controlled substance level is set to ON, you will receive a 
warning message when you click the Reply button. Your system administrator can use the controlled 
substance settings in the ppart.ini file to prevent operators from printing, faxing, or electronically 
transmitting prescriptions for medications that have a certain "schedule" level as controlled substances.  

These settings have been introduced to provide flexibility in behavior of the prescribing module of 
Patient Records in the event that laws and regulations regarding prescribing controlled substances 
change in the near future. They are not intended to facilitate circumventing such laws and regulations. 
It is the responsibility of every Lytec MD customer to ensure that your use of the system complies with 
applicable federal, state, and local laws and regulations regarding prescribing. 

• Approve: Select this option to approve the refill request as is. The Refills screen appears. 
You can change the number of refills by entering a new number in the corresponding 
field. When you are finished, click the OK button.  

Note: If the current active provider is different than the provider who wrote the prescription, the 
Provider screen will appear after Approve is selected. You may select a different Provider ID from 
the drop-down list. When finished, click the OK button.  

Important: The Approve button will be disabled if the medication selected is a controlled 
substance. You cannot electronically send a prescription for a medication designated as a 
controlled substance by the United States Drug Enforcement Administration. If you attempt to do 
so, you will receive a warning message.   

• Deny: Select this option to deny the refill. The Reason for Denial screen appears. Select 
the Code Option radio button to select from a list of pre-defined reasons for the denial. 
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Select the Customer radio button to enter your own reason for denial in the 
corresponding field. When finished, click the OK button.  

• Change: Select this option to change the refill. The Prescription screen appears. The Date 
and Medication are the only fields populated from the original prescription. When you 
have finished making your changes, click the OK button to send the refill change to 
pharmacy.  

Important: You cannot change the print type or the pharmacy.  

5. Click Cancel, to cancel the changes. Click OK, to save the prescription. 

This will send a reply back to the pharmacy.  

Once you have replied to the refill request, the message will be moved from your Inbox to the 
“Archived” folder. 

If there is a problem with the transmission of your prescription to the pharmacy, the operator 
assigned to receive ePrescribing-related messages for the provider (see above) will receive an 
error message in his or her Lytec MD message inbox. The message will include a description of 
the problem and also reference numbers which may help Lytec MD support personnel if they 
need to be consulted. See the Messaging System section for a complete overview of the Lytec 
MD Messaging system.  

Technical Note: When you approve an ePrescribing refill request, you will be approving one 
more fill than the number of refills listed. For example, if an Rx is renewed with 1 refill, this will 
authorize 2 total prescription fills by the pharmacy. If the number of refills is zero, then only 1 Rx 
fill will occur. This corresponds to standard conventions on written prescriptions, but is 
emphasized here for clarity. 

Sending a new prescription to pharmacies electronically 
Note: To send prescriptions to pharmacies electronically, the provider associated with the prescription 
must have the following information entered in the system: DEA number, NPI, RxHub ID, SureScripts ID, 
last name, practice address, and practice phone number. 

To send a new prescription: 

1. On the Rx/Medications screen, click the New button to open the Prescription screen. 

2. Complete the information on the Prescription screen.  
• A prescription template may be used to complete some of the information. A template 

search may be made by either the drug name or template code, or by indications.  

3. Select the Transmit immediately or Transmit as a group option from the Print drop-down list. 
Important Notes:  
- If the prescription is for a medication designated as a controlled substance by the United States 
Drug Enforcement Administration, and the ppart.ini file setting, "BlockTransmissionofControlled" 
for the controlled substance level is set to ON, you will receive a warning message. Your system 
administrator can use the controlled substance settings in the ppart.ini file to prevent operators 
from printing, faxing, or electronically transmitting prescriptions for medications that have a certain 
"schedule" level as controlled substances. 
 
These settings have been introduced to provide flexibility in behavior of the prescribing module of 
Patient Records in the event that laws and regulations regarding prescribing controlled substances 
change in the near future. They are not intended to facilitate circumventing such laws and 
regulations. It is the responsibility of every Lytec MD customer to ensure that your use of the system 
complies with applicable federal, state, and local laws and regulations regarding prescribing. 
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- For electronic prescriptions, you must enter an amount to dispense in the Amount field. If you do 
not enter an amount, you will receive a warning message.  

4. Click OK.  

The system will display warnings about drug interactions, prompts regarding adding health 
maintenance templates, and prompts for signatures or PINs as appropriate. See the 
Rx/Medications section for more information.  

Note: Prescriptions waiting to be transmitted or printed are highlighted in turquoise.  

5. Click the Close button on the Rx/Medications screen to send the prescription(s) to the 
pharmacy.  
If the patient is associated with more than one active pharmacy, no pharmacies, or you selected 
the Change Pharmacy check box on the Prescription Dialog, the Pharmacies for Patient screen 
appears after you have clicked the OK button. This screen displays the pharmacies associated 
with the patient (added from the Patient Configuration tab). If the patient has mail-order 
pharmacy benefits the Pharmacies for Patient list will include also the pharmacy(ies) 
representing the patient’s PBM(s) even if they are not associated with the patient. Highlight the 
pharmacy in the list that you want to send the prescription to, and then click the OK button.  

Note: If the patient has only one mail-order pharmacy, and the prescription is already being routed 
to the pharmacy (e.g., because that pharmacy was already specified on the Prescription screen, or 
is the patient’s preferred pharmacy), then the Pharmacies for Patient screen will not be displayed. 

You can also click the Pharmacies button to open the Pharmacy Select screen. This screen 
displays a list of all pharmacies in your system’s database. Highlight the pharmacy in the list that 
you want to send the prescription to, and click the OK button. Lytec MD will ask if you want the 
selected pharmacy to be added to the patient's pharmacy list. Click No to select the pharmacy 
without adding it to the patient's list. If you select Yes, the Link Pharmacy to Patient screen 
appears. Fill in the fields on this screen, and click the OK button. The pharmacy is added to the 
Pharmacies for Patient list. Click the OK button to transmit the prescription. 

• If you selected the Transmit immediately option when specifying Print options on the 
Prescription screen, then when you click the OK button, Patient Records will immediately 
proceed to the steps necessary to transmit the prescription. 

• If you selected the Transmit as a group option, the prescription is transmitted when you 
click the Close button on the Rx/Medications screen. 

If there is a problem with the transmission of your prescription to the pharmacy, the operator 
assigned to receive ePrescribing messages for the provider will receive an error message in his 
or her Lytec MD message inbox. The message will include a description of the problem and 
also reference numbers which may help Lytec MD support personnel if they need to be 
consulted. See the Messaging System section for a complete overview of the Lytec MD 
Messaging system.  

Important: Incoming ePrescribing-related messages, including error messages, are delivered to the 
operator specified on the ePrescribing Configuration Utility’s Messaging Configuration tab. This 
information must be configured to ensure that error messages are being sent to the correct provider. 
See the Messaging Configuration Tab section in the ePrescribing Module User's Guide for a complete 
explanation.  

See the Rx/Medications section for a complete explanation of the fields on the Prescription <New> 
screen.  
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Optional Configuration Settings 

Method for Recording Patient Consent 
If needed, your system administrator can specify the approach for recording patient consent to collect 
prescription fill history by adjusting the ppart.ini file setting, “RxFillHxCheckConsent.“  

When this setting =OFF, patient consent will be gathered based on your sites recording method 
preference (e.g., general care consent forms). This is the default setting.  

When this setting =ON, patient consent will be recorded using the Rx Fill Hx OK? field on the Other 
Data tab of the Patient screen. If this method is selected, you must add Rx Fill Hx OK? as a user-
defined Patient field. Once entered, the Rx Fill Hx OK? field will appear on the Other Data tab of the 
Patient screen. You will then need to establish a workflow where patients (or, for minor patients, their 
guardian) are informed that their pharmacy benefits provider provides information about the 
medications they have had filled at retail and mail-order pharmacies, and asked for their consent to 
request that data for medications prescribed by all providers, providers at your site, or not at all. You 
can enter the following values in the Rx Fill Hx OK? field based on the patient’s response:   

• Enter “Y” if the patient gives consent for all providers.  

• Enter “P” if the patient gives consent for providers at your site. 

• Enter “N” if the patient does not give consent.  

To add “Rx Fill Hx OK?” as a user-defined Patient field: 

1. Select Maintenance > Configuration > Define Other Data > Patient. The Patient Define Other 
Data Select screen appears.  

2. On the Patient Define Other Data Select screen, click the New button.  

3. Enter Rx Fill Hx OK? in the Label field, select Text from the Type drop-down list, and select 1 
Character from the Length drop-down list. Enter a description, then click the OK button.  

To enter a patient’s consent response: 

1. Select File > Open Patient, or click the Patient button in the toolbar. The Lookup screen 
appears. 

2. Enter the search criteria and filters you want to use to narrow the search.  

3. Click the Lookup button. 

4. In the search results table, highlight the appropriate patient and click the OK button. The 
Patient screen appears. 

5. Click the Other Data tab. Enter the patient’s consent response in the Rx Fill Hx OK? field. You 
can enter one of the following values: 
• Enter “Y” if the patient gives consent for all providers.  

• Enter “P” if the patient gives consent for providers at your site. 

• Enter “N” if the patient does not give consent.  

6. When you are finished, click the OK button.  
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Specify the Number of Days to Look Back for Formulary Data 
The Number of days back to look for formulary setting allows you to adjust the maximum number of 
days the on-file eligibility data for a patient can be for the formulary information references to be 
displayed to the user in the Formulary section on the Prescription screen. The default number of days is 
7. You can specify the number of days to look back for formulary data on the Rx Defaults tab of the 
Prescription Defaults screen.  

To specify the number of days to look back: 

1. Select Maintenance > Configuration > Prescription Defaults. The Prescription Defaults screen 
appears. 

2. Click the Rx Defaults tab.  

3. Select the maximum number of days from the Number of days back to look for formulary 
data drop-down list. 

Troubleshooting 
This section offers some troubleshooting tips for your electronic prescribing connection. If the 
ePrescribing interface is not working properly check the following. Contact Lytec MD Customer 
Support if these suggestions do not immediately correct the issue.  

Did you select the "Transmit as a group" print option?  

In order for the prescription to be sent via the ePrescribing module, you must select the “Transmit as a 
group” print option when writing a new prescription.  

Do you have Internet connectivity? 

Verify that you have constant Internet connectivity from the server. 

Are the Lytec MD Services running on your computer?  

You can use the PMSI Service Manger to check the status of Lytec MD Services and turn them on and 
off. 

To start the PMSI Service Manger: 

1. Open Windows Explorer, and navigate to your \ppart directory (usually p:\ppart). The PMSI 
Service Manager must be run locally from the server. 

2. Double-click the PMSI.Networking.Services.Manager.exe. The PMSI Service Manager screen 
appears. 

3. Is the PMSI Application Server status, “Running”? If the status is “Stopped”, click the Start 
button. Windows will start the PMSI Application Server and the status will change to “Running”.  

IMPORTANT:  
- If your site uses Web View it is advised that the services be restarted during off peak hours to ensure 
no users will be affected.  
 
- You should not stop the services when there are users still running Patient Records. The services can 
be stopped with clients still connected, but it is advised that all clients disconnect.  
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Is the ePrescription Server running?  

1. Start the Pharmacy Download Utility. Double-click the PMSI.ePrescriptionConfiguration.exe in 
the \ppart directory. This opens the ePrescribing Configuration Utility. 

2. Click the Status tab. Click the Start ePrescription Server button. This will start the ePrescription 
Server.  

Contact Lytec MD Customer Support if this does not correct the problem. 
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Problem list 
The Problem List section of the patient chart constitutes a longitudinal record of the problems for which 
the patient has sought or received care. Problems are organized into the following six categories, each 
displayed on a separate Tab: 

• Major Problems – The patient’s major medical problems. This is the "main" Problem List for the 
patient. 

• Other Problems – This category is intended as a list of problems of secondary importance, 
and/or chief complaints for individual patient visits (as represented, for instance, by the "Title" 
section of Progress Notes). 

• Procedures – Significant procedures which the patient has undergone. 

• Diagnoses – This category represents the diagnoses from specific patient visits. 

• Risks - The conditions that put patients at risk for diseased states and other adverse health 
events. 

• Hospitalizations - The problems for which the patient has been hospitalized.  

You can use the problem lists to organize a problem-oriented medical records system, or simply to 
provide a list of patient assessments. The names of the problems you use in the Problem List are 
reflected in the organization of other parts of the patient chart. For example, you can view the patient’s 
progress notes by a specific problem in the major problem list or the other problem list. 

The list screens contain a list of problems, the status of the problem, the date on which the patient first 
sought treatment for the problem, the date the problem last occurred, the provider, free-text notes 
about the problem, the problem's status, and two fields which can be used for codes from 
standardized terminology systems (such as ICD-9-CM or SNOMED-CT).  

Patient Records automatically assigns numbers to the problems in the Major Problem list and displays 
Major Problems in the order of their assigned number. By editing these, you may control the order in 
which Major Problems are listed on the  Problems/Procedures screen. You can change the assigned 
numbers so related problems are displayed next to each other on the screen. The other problems, 
procedures, diagnoses, risks, and hospitalizations list items are alphabetized. 

Problems can be added, deleted, or moved between lists. You can also merge two problems into a 
single problem, if necessary.  

You can enter problems directly into the lists, or you can enter problems through your progress notes 
using Dot codes. The progress notes are entered directly into Patient Records or are loaded through 
the Text Data Loader. Use the Text Data Loader to transfer information entered in Medical Writer or 
another word processor. 

You can select the Hide Inactive check box to block inactive problems from view. The major problems, 
other problems, diagnoses, and risks list screens allow you to hide inactive problems.  

You can sort the problems in any Problem List screen tab by clicking a column header. For example, to 
sort major problems by date, click the Date column header in the Major Problems tab. Click the column 
header again to reverse the sort direction. You can also resize the columns in the Problem List by 
clicking and dragging the column borders. 
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Customizing how problems, procedures, and diagnoses 
display in notes 
Your system administrator can decide how major problem, other problem, procedure, and diagnosis 
codes are inserted into notes by using the .imp Dot code. These codes can be displayed: horizontally 
(as in previous releases), vertically, vertically with code, and vertically with code and notes. Examples of 
these options are provided below. 

Note: If your system administrator does not set a preference, problem, procedure, and diagnosis 
codes will display horizontally. 

Horizontally 

DEPRESSION, LOW BACK PAIN, DIABETES 

Vertically 

DEPRESSION 
LOW BACK PAIN 
DIABETES 

Vertically with Code 

DEPRESSION (271.23) 
LOW BACK PAIN (384.00) 
DIABETES (280.45) 

Vertically with Code and Notes 

DEPRESSION (271.23) Started after father died 
LOW BACK PAIN (384.00) Workplace injury 
DIABETES (280.45) Recently became insulin dependent 

Procedures for adding, editing, and deleting problems 

Major problems 

To open the major problem list screen: 

1. When a chart is open, select Show > Problem List, or click the Problem List tab. You can also 
click the Prob Lists button on the go to bar.  

2. On the Problems/Procedures screen, click the Major Problems tab. 

To add a problem: 

1. On the major problem list screen, click the New button. The Major Problem <New> screen 
appears.  

2. Fill in the fields on the Major Problem <New> screen.  

Note: Be consistent in your use of problem names.  

3. When you finish, click the OK button. The new major problem appears in the major problem 
list.  

4. If the problem name (or synonym) is associated with a health maintenance template, a message 
asks whether you want to apply the health maintenance protocol to the patient. This message 
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will not display if this particular template is already assigned to the patient, or if a template with 
the same name as the problem is assigned to the patient. 

To change a problem: 

• On the major problem list screen, highlight the problem that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a problem: 

1. On the major problem list screen, highlight the problem that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

2. If the problem name (or synonym) is associated with a health maintenance template/protocol, a 
message asks whether you want to delete the related template assigned to the patient. 

Other problems 

To open the other problems list screen: 

1. When a chart is open, select Show > Problem List, or click the Problem List tab. You can also 
click the Prob Lists button on the go to bar.  

2. On the Problems/Procedures screen, click the Other Problems tab. 

To add a problem: 

1. On the other problems list screen, click the New button. The Other Problem <New> screen 
appears.  

2. Fill in the fields on the Other Problem <New> screen.  

3. When you finish, click the OK button. The new problem appears in the other problems list.  

4. If the problem name (or synonym) is associated with a health maintenance template, a message 
asks whether you want to apply the health maintenance protocol to the patient. This message 
will not display if this particular template is already assigned to the patient, or if a template with 
the same name as the problem is assigned to the patient. 

To change a problem: 

• On the other problems list screen, highlight the problem that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a problem: 

1. On the other problems list screen, highlight the other problems that you want to delete. Click 
the Delete button. A message asks you to confirm the deletion. Click the OK button. 

2. If the problem name (or synonym) is associated with a health maintenance template/protocol, a 
message asks whether you want to delete the related template assigned to the patient. 
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Procedures 

To open the procedures list screen: 

1. When a chart is open, select Show > Problem List, or click the Problem List tab. You can also 
click the Prob Lists button on the go to bar.  

2. On the Problems/Procedures screen, click the Procedures tab. 

To add a procedure: 

1. On the procedures list screen, click the New button. The Procedure <New> screen appears.  

2. Fill in the fields on the Procedure <New> screen.  

3. When you finish, click the OK button. The new procedure appears in the procedures list.  

To change a procedure: 

• On the procedures list screen, highlight the procedure that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a procedure: 

• On the procedures list screen, highlight the procedure that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 

Diagnoses 

To open the diagnoses list screen: 

1. When a chart is open, select Show > Problem List, or click the Problem List tab. You can also 
click the Prob Lists button on the go to bar.  

2. On the Problems/Procedures screen, click the Diagnoses tab. 

To add a diagnosis: 

1. On the diagnoses list screen, click the New button. The Diagnosis <New> screen appears.  

2. Fill in the fields on the Diagnosis <New> screen.  

3. When you finish, click the OK button. The new diagnosis appears in the diagnoses list.  

4. If the diagnosis name (or synonym) is associated with a health maintenance template, a 
message asks whether you want to apply the health maintenance protocol to the patient. This 
message will not display if this particular template is already assigned to the patient, or if a 
template with the same name as the problem is assigned to the patient. 

To change a diagnosis: 

• On the diagnoses list screen, highlight the diagnosis that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a diagnosis: 

• On the diagnoses list screen, highlight the diagnosis that you want to delete. Click the Delete 
button. A message asks you to confirm the deletion. Click the OK button. 
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• If the diagnosis name (or synonym) is associated with a health maintenance template/protocol, a 
message asks whether you want to delete the related template assigned to the patient. 

Risks 

To open the risks list screen: 

1. When a chart is open, select Show > Problem List, or click the Problem List tab. You can also 
click the Prob Lists button on the go to bar.  

2. On the Problems/Procedures screen, click the Risks tab. 

To add a risk: 

1. On the risks list screen, click the New button. The Risk <New> screen appears.  

2. Fill in the fields on the Risk <New> screen.  

3. When you finish, click the OK button. The new risk appears in the risks list.  

To change a risk: 

• On the risks list screen, highlight the risk that you want to change. Click the Edit button. Make 
the appropriate changes. When you finish, click the OK button. 

To delete a risk: 

• On the risks list screen, highlight the risk that you want to delete. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 

Hospitalizations 

To open the hospitalizations list screen: 

1. When a chart is open, select Show > Problem List, or click the Problem List tab. You can also 
click the Prob Lists button on the go to bar.  

2. On the Problems/Procedures screen, click the Hospitalizations tab. 

To add a problem: 

1. On the hospitalizations list screen, click the New button. The Hospitalization <New> screen 
appears.  

2. Fill in the fields on the Hospitalization <New> screen.  

3. When you finish, click the OK button. The new problem appears in the hospitalizations list.  

To change a problem: 

• On the hospitalizations list screen, highlight the problem that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

To delete a problem: 

• On the hospitalizations list screen, highlight the problem that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 802 

 

Moving and merging problems 
You can also move or merge problems between the Major Problems list, Other Problems list, 
Diagnoses list, Risks list, and Hospitalizations list. When you merge one problem with another, all the 
notes associated with the old problem are automatically linked to the new problem. When you look at 
notes on the Progress Notes/By Problem screen, for example, you will see the notes for the problems 
that have been merged. However, the new problem name will not appear on the .T: line, unless you 
change it in the Progress Notes screen. 

Please note it is difficult to undo a merge between problems; so think carefully before you merge two 
problems on the Problem list. 

You can move or merge problems between the following lists: 

• The Major Problems list allows you to move and merge with problems from the Other Problems 
list, Diagnoses list, and Risks list. 

• The Other Problems list allows you to move and merge with problems from the Major Problems 
list, Diagnoses list, and Risks list. 

• The Diagnoses list allows you to move and merge with problems from the Major Problems list, 
Other Problems list, and Risks list. 

• The Risks list allows you to move and merge with problems from the Major Problems list, Other 
Problems list, and Diagnoses list. 

• The Hospitalizations list allows you to move and merge with problems from the Major Problems 
list, Other Problems list, Diagnoses list, and Risks list. 

To move a problem to another list:  

1. On the selected list screen (i.e., major problem list, etc.), click the Move button. The 
Move/Merge screen appears.  

2. Select a list from the Choose category drop-down menu. 

3. In the table on the left side of the screen, highlight the problem that you want to move.  

4. Click the Move button. The problem appears in the selected category's table on the right side 
of the screen.  

5. When you finish, click the OK button.  

To insert a problem into another list:  

1. On the selected list screen (i.e., major problem list, etc.), click the Move button. The 
Move/Merge screen appears.  

2. Select a list from the Choose category drop-down menu. 

3. In the table on the right side of the screen, highlight the problem that you want to move.  

4. In the table on the left side of the screen, highlight the problem above which you want the 
other problem to display.  

5. Click the Insert button. The problem appears in the other table in the selected area.  

6. When you finish, click the OK button.  

To merge two problems on the problem list:  

1. On the selected list screen (i.e., major problem list, etc.), click the Move button. The 
Move/Merge screen appears.  
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2. Select a list from the Choose category drop-down menu.  

3. In the table on the left side of the screen, highlight the problem that you want to merge.  

4. In the table on the right side of the screen, highlight the other problem that you want to merge.  

5. If you want the newly merged problem to display in the table on the left side of the screen, click 

. If you want the newly merged problem to display in the table on the right side of 

the screen, click . 

6. When you finish, click the OK button.  

Fields and buttons on the Major Problem screen 
Field Description 

Major Problem Type the name of the new major problem, or click the Lookup button, 
to select a diagnosis code from the Diagnosis Code Select screen.  
The field to the left of the Major Problem field displays the assigned 
problem number. When a new problem is created Patient Records 
automatically assigns the new problem a problem number. The 
numbers assigned are in sequential order for each patient. For 
example, if the last problem added was 8000, the new problem will be 
number 8001. This ultimately provides a way for you to control the 
order in which problems are listed on the Problems/Procedures 
screen. 
You can also edit this field so that the problems are listed in whatever 
order you prefer.  
Please note the maximum name length is 50 characters. 

Code 1 Enter a diagnosis or other standard code. Click the Lookup button, to 
select a diagnosis code from the Diagnosis Code Select screen. If you 
selected a problem from the Diagnosis Code Select screen, the 
diagnosis code will automatically be entered in this field.  

Code 2 Enter an additional diagnosis or other standard code. Click the Lookup 
button, to select a diagnosis code from the Diagnosis Code Select 
screen.  

Provider The logon provider is automatically entered in this field. To change the 
logon provider, click the down arrow button. The Provider Select 
screen appears. Select the appropriate provider and click the OK 
button. The selected provider will be displayed in this field. 

External Provider Select the external provider that is associated with the problem for the 
patient. Click the down arrow button to access the Provider Select 
screen. Select the appropriate provider and click the OK button. The 
selected external provider will be displayed in this field.  

Indent Select the indentation from the drop-down menu. The default 
indention is 0. This field allows you to control how far the problem will 
be indented when displayed on the Problems/Procedures screen. For 
example, if you select 6, the problem will be indented 6 spaces.  

Note Enter any notes you may have about the problem. The maximum length 
is 100 characters.  
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Active/Inactive Select whether the problem is active or inactive. New problems default 
to Active.  

Date Enter the date of onset for the Problem. When creating a new problem, 
the date defaults to the current date. 

Date Last Enter the date the problem last occurred. This date is intended for 
episodic conditions. 

Date Resolved Enter the date the condition was resolved, if applicable. 

Lifecycle Select whether the condition is: Improving, Stable, Worsening, or 
Resolved. 

Related to This field allows you indicate relationships among problems for a 
patient. For example, if you create a new problem for Diabetic 
Retinopathy, you can indicate that it is related to the problem “Diabetes 
Mellitus.” 

Fields and buttons on the Other Problem, Procedure, 
Diagnosis, Risk, and Hospitalization screens 
Field Description 

Other Problem, 
Procedure, Diagnosis, 
Risks, or Hospitalizations 

Type the name of the new problem, procedure, diagnosis, risk, or the 
problem for which the patient was hospitalized. The maximum name 
length is 50 characters. You can also click the Lookup button, to select 
a diagnosis code from the Diagnosis Code Select screen. 

Code 1 Enter a diagnosis or other standard code. Click the Lookup button, to 
select a diagnosis code from the Diagnosis Code Select screen. If you 
selected a problem from the Diagnosis Code Select screen, the 
diagnosis code will automatically be entered in this field.  

Code 2 Enter an additional diagnosis code or other standard code. Click the 
Lookup button, to select a diagnosis code from the Diagnosis Code 
Select screen.  

Provider The logon provider is automatically entered in this field. To change the 
logon provider, click the down arrow button. The Provider Select 
screen appears. Select the appropriate provider and click the OK 
button. The selected provider will be displayed in this field. 

External Provider Select the external provider that is associated with the problem for the 
patient. Click the down arrow button to access the Provider Select 
screen. Select the appropriate provider and click the OK button. The 
selected external provider will be displayed in this field.  

Note Enter any notes you may have about the problem. The maximum length 
is 100 characters.  

Active/Inactive Select whether the problem is active or inactive. New problems default 
to Active.  

Date  Enter the date of onset for the Problem. When creating a new problem, 
the date defaults to the current date. 

Date Last Enter the date the problem last occurred. This date is intended for 
episodic conditions. 
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Date Resolved Enter the date the condition was resolved, if applicable. 

Lifecycle Select whether the condition is: Improving, Stable, Worsening, or 
Resolved.  
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Progress notes 
Progress notes are records of the patients visit. You can type progress notes directly into Patient 
Records, or you can use the Text Data Loader to import data from an outside source. Your notes do not 
need to be problem-oriented. If you prefer, you can use assessments instead of problem names for 
each note.  

Progress notes provide many of the features available in word processing software such as Microsoft 
Word. You can format the text by changing the font and size; bolding, italicizing, or underlining the 
text; centering or justifying the text; and indenting the text. You can also quickly add tables, hyperlinks, 
and other formatting. In addition, you can use many common word processing shortcut keys such as 
CTRL+C to copy and CTRL+V to paste. 

You can add or update notes on any of the progress notes screens, or move from one progress notes 
screen to another.  

You can also use the progress note procedures below to add notes to the other text-based chart 
sections: Consults, Hospital Reports, Messages, X-Ray, Pathology, Attending Notes, Lab Microbiology 
Notes, and the user-defined note sections. 

Every progress note starts with a date and a title. Todays date automatically defaults for the Date code. 
Follow the Title code with the name of at least one problem or assessment. You can add more 
problems after the Title code or change the date after the Date code. The notes are indexed by the 
problems on the .Title line. 

In addition to text, you can also place permanent hyperlinks directly into notes. These hyperlinks can 
point to any file viewable by a browser (for example, HTML pages, graphics files, text files, and files in 
the Lytec MD Knowledge Base).  

You can look up progress notes in the way that is easiest for you:  

• By chronological order, with the most recent note first.  

• For a specific problem from the patients major problem and other problem lists.  

• By selecting from a list of visits.  

• By specific criteria such as text pattern, problems, or visit dates.  

• From active notes shared (worked on) by multiple providers.  

About the auto-saved notes feature 
This feature can be used to recover HTML-based progress notes that are open when Lytec MD or your 
computer crashes. This feature is activated through the ppart.ini file. You must also select how often (in 
seconds) to auto-save the progress notes. As you write a progress note, you can manually save the note 
as a temporary file by pressing CTRL+S. 

When activated, progress notes that are open at the time of a crash are saved to temporary files (*.sav). 
The file names start with AutoSave, and include the operator ID and date/time the note was last saved. 
Once an auto-saved note has been correctly saved to the Lytec MD database, the temporary file is 
deleted. 

When you log back into Lytec MD, depending on how your system is set up, a list of AutoSaved notes 
may be presented to you, or you can access the AutoSaved list from the Task menu. The Auto Saved 
Notes List screen displays a list of your notes that were automatically saved as temporary files. You can 
open (and finish) or delete auto-saved notes from this screen. Through the ppart.ini file, you can 
specify: 

• How often progress notes are saved as they are added or edited.  
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• Whether the Auto Saved Notes List screen displays automatically when you log into Lytec MD. 
You can also view the screen at any time by selecting Task > Auto-Saved Notes.  

• The location in which auto-saved notes are stored. Once an auto-saved (or manually saved) note 
has been correctly saved to the Lytec MD database, the temporary file is deleted. 

Working with shared notes  
Shared notes are progress notes that are entered and edited on more than one Patient Records 
workstation. This feature is especially useful when a nurse or assistant starts progress notes that are 
completed by other providers.  

Any note can be a shared note. When you finish working with a note, click the OK button to save it. A 
message asks you whether you are permanently done with the note.  

If you click the No button, the note remains open for use by yourself or other providers as a shared 
note. When you access this patients notes again, you will be asked if you want to edit the Shared Note 
instead of adding a new one. You can also access it by clicking the Add/Edit Shared Note button on the 
Progress Note Selection screen.  

Once a shared note is permanently saved, the problem list, medication list, allergy list, laboratory data, 
vital sign tables and health maintenance status are updated as usual. Only one shared note at a time 
can be created for each patient.  

Signing shared notes 
When creating a progress note template or a progress note, you can type "^Shared_Note_Signature" 
into the progress note or template to allow nurses and assistants to sign a shared partially entered note 
using their operator personal identification number (PIN) (or their provider PIN if the operator is a 
provider). Please note you can only enter one shared signature line per note.  

The shared signature line will be saved in the note as "# NURSING NOTE ABOVE SIGNED BY" (or other 
text specified by the system administrator) followed by the operator's name, ID in parentheses, and the 
date and time. For example, # NURSING NOTE ABOVE SIGNED BY Jane Nurse, R.N. (123) 06/25/2008 
01:31PM. Your system administrator can specify the signature line text that will be saved using the 
ppart.ini setting, SharedNoteSignature.  

Note: ^Shared_Note_Signature will be available as a label marker from the Insert menu in a future 
version.  

To use ^Shared_Note_Signature in a progress note:  

• When in a note, if you wish to save in shared status but also want to add a signature, type 
^Shared_Note_Signature into the note. When you save the note, if you respond with the "No" 
option to the prompt "Permanently done with note?", you will be prompted for your Operator 
PIN (or, if you are a Provider, you may be prompted for your Provider Signature). If you don’t 
have an operator PIN or a provider PIN, you will receive the following message: "A shared note 
signature was called for, but since you don’t have a PIN, no early signature will be added to this 
note" and will be returned to the progress note screen to remove the ^Shared_Note_Signature 
line. 

Note: The Operator PIN is not the same as the Operator password. The Operator PIN is entered on the 
Patient Records tab of the Operator Maintenance screen.  

Customizing progress notes  
Your system administrator can set options in the ppart.ini and on the Special Features screen that will:  
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• Remove vertical blank lines from notes.  

• Removing blank lines from unexpanded labels in notes.  

• Determine how major problems inserted into notes display.  

• Configure the font used in notes.  

• Replace hard returns in the Subjective: (or S:) section of the note with a period and space, unless 
the preceding non-space character is also a period. In lines with two hard returns, one hard 
return is removed. 
 
For example: 
 
S: This is a 46 year old male with chest pain. 
Side: left 
Duration: one hour 
Location: mid-left sternal 
 
ROS is otherwise negative 
 
History of previous MI: none 
Smoking: none 
 
would be saved as: 
 
S: This is a 46 year old male with chest pain. Side: left. Duration: one hour. Location: mid-left 
sternal 
 
ROS is otherwise negative 
 
History of previous MI: none. Smoking: none 

Selecting progress notes by special criteria  
If you need to see older notes quickly, use the Special Criteria option.  

Using the Special Criteria screen, you can view progress notes selectively by very specific criteria. 
These criteria include dates, problems, or text patterns. You can also specify a provider or indicate if 
you wish to view the oldest notes.  

Note: The By Practice box reserves a place for a specific practice search to be added in a future 
version.  

Filtering the notes that display in the Patient Chart 
You can filter progress notes to automatically display notes for only one provider or for only one 
problem title. To use this feature, your system administrator must set it up through the Customize 
Patient Chart for Provider option. 

If you are using this feature, when you select a progress note option, you will see only the progress 
notes for the selected provider or problem title. 

To use the progress note filter: 

1. On the patient chart, select the Filter radio button. 

2. When you select a progress note option, only notes matching your filter will display. 
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3. To turn the feature off, select the All radio button on the right side of the screen. 

Checking for missing progress notes 
If you use both Patient Records and Appointment Scheduler, you can check for patients who do not 
have progress notes corresponding to each of their visits. The Missing Progress Notes report can be 
printed for a single provider or all providers and can be limited to a range of dates, if you wish.  

Adding, editing, and deleting progress notes 
To open the progress note screen: 

1. Select Show > Progress Notes, or click the Progress Notes tab. The Progress Note Selection 
screen appears.  

2. Mark the radio button for the type of progress note selection you want to make. Then click the 
OK button.  
• The Most Recent option displays progress notes in reverse chronological order, that is, 

with the most recent note first. 

• If you select By Problem, Patient Records displays a list of problems from the patients 
major problem and other problem lists. Highlight a problem, or enter the name of the 
problem for which you want to see progress notes, and click the OK button.  

• The Choose from List option displays a list of visits. Highlight the visit that you want and 
click the OK button.  

• If you select By Special Criteria, the Special Criteria screen appears. Enter the criteria you 
want to use to filter the notes. When you finish, click the OK button.  

To add a progress note: 

1. When the patient chart is open, click the Note button on the toolbar. If the Progress Note 
screen is open, you can also click the New button on this screen. The Progress Notes screen 
appears, with today's date in the first line. 

2. After the Title code, type a problem or assessment that you want to use as the title of the note. 

3. Enter the patient information. Patient Records provides many useful formatting and time-saving 
tools, including templates and QuickText. Many of these tools are accessed through the on 
screen buttons and Insert menu.  
 
As you write a progress note, you can manually save the note as a temporary file by pressing 
CTRL+S. 

4. When you finish, click the OK button. 

5. If the electronic signature feature is enabled on the provider maintenance screen, the Enter 
Signature screen appears. Type your signature, and then click the OK button. 

Note: You can sign notes as you save them, or all at once using the Review Data command on the Task 
Menu. For information on signing notes all at once, see Review Data and Note Status Reports. 
 
Note: Before a note is saved, the office code is replaced with standard code in the note text. 

To change a progress note: 

Note: All changes are recorded in the audit trail. You can edit a progress note up to nine times. 
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1. Select Show > Progress Notes, or click the Progress Notes tab. The Progress Note Selection 
screen appears.  

2. Locate and open the note you want to change.  

3. On the Progress Notes screen, click the Edit button.  

4. Make the necessary changes.  

5. When you finish, click the OK button. 

6. If the Electronic Signature feature is enabled, the Enter Signature screen appears. Type your 
signature, and then click the OK button.  

Note: The system administrator can set up Patient Records to prevent any changes to notes that have 
been signed.  

To delete a progress note: 

1. Select Show > Progress Notes, or click the Progress Notes tab. The Progress Note Selection 
screen appears.  

2. Locate and open the note you want to change.  

3. On the Progress Notes screen, select Edit > Delete Note. A message asks you to confirm the 
deletion. 

4. Click the OK button. 
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Note Compare 
Lytec MD keeps track of changes made to the text-based sections of the patient chart. You can 
compare up to five revised versions of the same note against previous versions.  

Note Compare displays additions and deletions made to notes between versions. Deleted text is 
displayed with strikethrough formatting (like this), and added text is highlighted in green (like this).  

Before you can use the Note Compare feature, your system administrator must enable the Access Level 
setting, "Note Compare".  

To use note compare: 

1. Open the note you want to compare. 

2. Select the Note Compare option from the Patient Records Edit menu. 
• If you have edited the note more than once, the Audit Trail Notes List screen appears. 

Highlight the version of the note that you want to compare to the current version of the 
note, and click the Compare button.  

The Changes to Note screen appears. From this screen you can view the changes to the 
note. If there are no audit trail notes to compare against the current note, a message will 
be displayed. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 812 

 

Formatting toolbar, buttons, and the Insert menu 
Notes about tabbing in progress notes:  

• Pressing the Tab key will move the cursor forward from QuickText label to QuickText label.  

• Pressing SHIFT+Tab will move the cursor backward from QuickText label to QuickText label.  

• Pressing CTRL+Tab will move the cursor forward five spaces. This is typical tabbing behavior in 
Microsoft Word and other word processing programs. 

• Pressing the arrow keys (left, right, up, down) will move the cursor to the appropriate cell in 
tables. 

Field Description 

Format toolbar This toolbar provides standard text formatting tools.  

 Select the font that you want to use in the note. Your 
system administrator can use settings in the ppart.ini file 
to define which fonts are available in the list. 

 Select the font size. Your system administrator can use 
settings in the ppart.ini file to define which font sizes are 
available in the list. 

 
Indicate whether you want text in the note to be bolded 
(B), italicized (I), or underlined (I). 

 
Indicate whether the text should be aligned with the left 
margin, centered, aligned with the right margin, or 
justified (text lines up with both the left and right 
margins). 

 
Indicate whether text should be bulleted. 

 
Indicate whether text should be indented five spaces 
toward the right margin, or moved five spaces toward 
the left margin. 

 
Select the size at which you want to view the text. 

 

Buttons 

QText Insert QuickText. You can also insert QuickText by selecting Insert > QuickText. 

Templ Insert a note template. You can also insert a template by selecting Insert > 
Template. 

Proc Insert a procedure code. You can also insert a code by selecting Insert > Procedure 
Code. 

Pb/Dx Insert a problem/diagnosis code (you can select from a list of all problem/diagnosis 
codes). You can also insert a code by selecting Insert > Problem/Diagnosis Code. 

QT Auto The QT Auto button works like the TAB and F10 keys, but it also lets you quickly 
merge QuickText that are built into the labels of templates. 
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When you click the QT Auto button, the cursor jumps to the next label. If the current 
label marker has an embedded QuickText item name, the item name is replaced 
with the associated QuickText. If part of the QuickText item name is embedded, 
Patient Records displays a QuickText picklist starting with that partial name. You can 
select the item from the list. 
Once the embedded text is inserted, the cursor then moves on to the next label.  
If you pressed TAB or F10 to reach a label, you can also press ALT+N to insert the 
QuickText associated with an embedded item name. 

Print To print the note:

1. Click the Print button.  

2. Under Print Range, specify the portion of the document you want to print.  

 Entire File: Select this option to print the entire file. 

 Selected Pages: Select this option to enter page numbers or page ranges 
you want to include. 

Note: The Selected Text option is currently not available. 

3. In the Number of Copies field, enter the number of copies you want to print. 

4. To print a complete copy of the note before the first page of the next copy is 
printed, select the Collate check box.  

5. Click OK, to print the note. 

Image Insert an image. On the Images screen draw the image select an existing image 
template (select File > Open Template, then select a template from the list).  
When you finish with the image, click the OK button. On the Image: Save As screen, 
mark one of the radio buttons. Mark Template to save the image as a new template, 
or mark Chart Attachment if the image is intended for this patient only. 
If the image is a chart attachment, enter a name for the image in the Name box. 
You can also insert an image by selecting Insert > Image. 

Spelling Check spelling in the note. The spell checker is based on Stedmans medical 
dictionary, and includes more than 500,000 English and medical words. You can 
also add words to the dictionary. Your system administrator will determine if the 
new words you add are shared among all users, or just specific to the workstation. 
If you have opened a new note or are editing an existing note, you can use the spell 
check feature to check the entire note for spelling errors. You can also limit the spell 
check to just one or more words by highlighting them before activating the spell 
check. 
You can also check spelling by pressing F7 or by selecting Edit > Check Spelling. 

Insert Table Insert a table. On the New Table Parameters screen, type the number of rows and 
number of columns for the table. 
You can also manage tables by selecting Edit > Table. From this menu, you can 
insert a table, insert a column, insert a row, and delete cells. 

EM Codes Insert an E&M label. You can also insert a label by selecting Insert > EM Label. 

Insert menu 

Page Break Insert a manual page break. In the note, click where you want to start a new page. 
On the Insert menu, click Page Break. 

Template Insert a note template. You can also insert a template by clicking the Templ button. 

QuickText Insert QuickText. You can also insert QuickText by clicking the QText button. 
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Procedure Code Insert a procedure code. You can also insert a code by clicking the Proc button. 

Problem/Diagnosis 
Code 

Insert a problem/diagnosis code (you can select from a list of all problem/diagnosis 
codes). You can also insert a code by clicking the Pb/Dx button. 

Individual 
Problems 

When selected, the Insert Problem screen appears. This screen allows you to select 
from a list of the patient's active and inactive Major Problems, Other Problems, and 
Diagnoses to insert into a note.  

Previous Note Insert the text of the old note into the current note. On the Insert Note screen, select 
the appropriate note. 

Partial Note 
Marker 

Insert a partial note marker to identify a point in the note at which text will be 
inserted later from an uploaded text data file. 

QuickText at Label Insert QuickText at a label. 

Bookmark Insert a bookmark in a note when you want someone to jump to a particular 
location. For example, with shared notes, you can place a bookmark at the point in 
the note where the next provider should begin. The provider can then jump right to 
that point, instead of scrolling and searching manually. You can include bookmarks 
in templates or insert them as you write notes. 
You can find your bookmark(s) by selecting Edit > Find. The Find screen appears. 
Select the Bookmark radio button, and click OK. Your cursor will move to next 
bookmark in the note.   

Label Insert a label. 
If you want to create a special label, move the cursor over the asterisk in the middle 
of the label. Then, enter the QuickText name or partial name, or «del», «*sex*», 
«*age*», or «*date*». A QuickText label could look like this: «NLFUNDI». 
In a note with these labels, age could be replaced by a value like 39 yr, and 
NLFUNDI by "Fundi are benign." If nothing followed the «del» label, the entire line 
would be deleted. 
You can also force the QuickText pick list to appear even when the QuickText entry 
is an exact match. To do that, follow the procedure above, and insert three periods 
(...) after you enter the QuickText item name. This label marker, with the embedded 
item name, becomes highlighted in red in a note or note template. Example: «item 
name...» 

Image Insert an image. On the Images screen draw the image select an existing image 
template (select File > Open Template, then select a template from the list).  
When you finish with the image, click the OK button. On the Image: Save As screen, 
mark one of the radio buttons. Mark Template to save the image as a new template, 
or mark Chart Attachment if the image is intended for this patient only. 
If the image is a chart attachment, enter a name for the image in the Name box. 
You can also insert an image by clicking the Image button. 

Image from File Insert an image from a file. From the Select Image File to Insert screen, browse to 
the existing image file. You can import BMP, WMF, GIF, TIF, and JPG formatted files. 
Click the Open button. The image file is displayed in the note. If the image file is 
larger than one page, an automatic page break will be inserted, and the image file 
will be displayed on the next page.  

Linked File Insert a linked file. 

Patient Education 
Link 

Insert a link to a Patient Education handout. You can select by module title or code. 
The handouts associated with the title or code you select display in the box. 
Highlight the appropriate handout, and click the OK button. 

Current Insert the patient's current medications. 
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Medications 

Problem List  

Major 
Problems 

Insert the patient's major problems. 

Other 
Problems 

Insert the patient's other problems. 

Pregnancy 
Problems 

Insert the patient's pregnancy problems.  

Diagnosis List Insert the patient's diagnosis. 

Procedure List Insert the patient's procedures. 

Social History  Insert the patient's social history. 

Past Medical 
History 

Insert the patient's past medical history. 

Family History Insert the patient's family history. 

Vitals from Today 
(BP, Pulse) 

Insert the patient's BP and pulse from today's visit. BP and pulse vital signs with 
today's date will be inserted into the note. 

Vitals from Today 
(Temp, Height, 
Weight) 

Insert the patient's temperature, height, and weight from today's visit. Temperature, 
height, and weight vital signs with today's date will be inserted into the note. 

Vitals form Today 
(OFC, Other) 

Insert the patient's OFC and other vital signs from today's visit. OFC and other vital 
signs with today's date will be inserted into the note. 

Vitals form Today 
(Respirations, 
Oximetry) 

Insert the patient's respirations and oximetry from today's visit. Respirations and 
oximetry vital signs with today's date will be inserted into the note. 

Vitals form Today 
(Posturals) 

Insert the patient's posturals from today's visit. Postural vital signs with today's date 
will be inserted into the note. 

Allergies Insert the patient's allergies with the last updated allergy date. For example:  
"Allergy history last updated on 11/30/09." 

Hospitalization List Insert the problems for which the patient has been hospitalized.  

Risks List Insert the conditions that put patients at risk for diseased states and other adverse 
health events. 

Time Insert the current system time. 

Letter Template Insert a letter template. 

Page Setup 
Template 

Insert a page template. 

Sound File Insert a sound file. 

Record a Dictation Record a dictation. 

E&M Label Insert an E&M label. You can also click the EM Codes button. 
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Unsaved progress notes feature 
You can use this feature to view a list of unsaved progress notes. From this list, you can quickly link to 
and sign the unsaved notes. 

You can also print a list of unsaved progress notes through the Unsaved Notes report. 

Accessing the unsaved progress notes feature 
To open the Unsaved Progress Notes screen: 

1. Select Task > Unsaved Progress Notes. The Unsaved Progress Notes Select screen appears. 

2. Enter the provider and date range for which you want to view the notes (or leave one or both 
fields blank to increase the number of notes viewed). The Unsaved Progress Notes screen 
appears. 

3. The table displays all notes that meet the criteria you specified. Double-click any note to open 
the note. Once open, you can sign and save the note. 

Recording Contributions to a Note 
You can use this feature to view all Operators who have contributed to a note, even if they did not 
permanently save or sign the note, including their name/credentials, date and time of their action(s), 
and the action(s) they performed. This feature can be accessed from all note sections of the Patient 
Chart (e.g., Past Medical History, Family History, Social History, Letters, Rx Note, etc.).   

Note: The PRUtils setting "Keep a record of all Operators who contributed to each Note" must be 
enabled for Lytec MD to capture the data that will be displayed in this feature. 

The following operator actions are recorded as "contributions" to a note, and will be displayed from 
the Contributions to Note screen when the OK button is clicked on the Note screen:  

Recorded Action Action Displayed on Contributions to Note screen 

Permanently saving a note  Permanent Save 

Saving a note in “shared” status Save as Shared 

Editing a permanently saved note  Edit 

Note: The operator's title can be entered in the Operator Maintenance screen's General tab. Entering 
the operator's title will make sure the operator's credentials are recorded for this feature.  

Contributions to Note screen  
The Contributions to Note screen displays the:  

• Operator Name/Credentials (Last, First, MI, and Operator Title). For example, Cobb, Able B M.D.  

• Date and Time of the action. For example, 07/02/2009 4:15pm.  

• Action (Permanent Save, Save as Shared, or Edit). 

The contributions are ordered chronologically with the oldest at the top of the list. You can sort the 
contributions on the screen by clicking a column header. For example, to sort contributions by date 
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and time, click the Date/Time of action column header. Click the column header again to reverse the 
sort direction. 

To open the Contributions to Note screen: 

• When in the Note screen, select View > Show Contributors to Note. The Contributions to Note 
screen appears.  
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Keyboard Shortcuts When Using Patient Notes  
If you are accustomed to using shortcut keys on the keyboard – rather than using a mouse – to perform 
tasks, use the tables below when you are using the text-based sections of the patient chart (including 
progress notes).  

Keyboard shortcuts when viewing notes 
Action Shortcut 

Start a new progress note Ctrl+N 

Close the note  Esc  

Edit a note  Alt+D  

Insert an image  Alt+M 

Print the note  Alt+P 

Sign the note  F5  

View the next note  F4 or Alt+O  

View the previous note F3 or Alt+N  

Keyboard shortcuts when adding or editing notes 
Action Shortcut 

Bold the selected text (or turn bolding on) Ctrl+B 

Italicize the selected text (or turn italicizing on) Ctrl+I 

Underline the selected text (or turn underlining on) Ctrl+U 

Activate the over-write mode as you type  Insert  

Activate the spell check feature  Alt+L or F7 

Cancel the note  Esc 

Copy the selected text to the clipboard  Ctrl+C or Ctrl+Insert 

Paste ASCII text (from the clipboard) at the cursor  Ctrl+P 

Cut a selected text and save it to the clipboard  Shift+Delete  

Delete all text in between the cursor and the end of the line  Ctrl+Delete 

Delete from the cursor to the beginning of the word  Ctrl+Backspace  

Insert a previous note  Shift+F7  

Insert a problem  Shift+F8  

Insert a problem code from a list  Shift+F3  

Insert a procedure code from a list  Shift+F4  

Insert a QuickText  Alt+F7  

Insert a template  F6  

Insert an image  Alt+M 

Move the cursor to the beginning of the text  Ctrl+Home or Ctrl+Page Up  
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Move the cursor to the beginning of the word or previous 
word  

Ctrl+Left arrow  

Move the cursor to the end of the text  Ctrl+End or Ctrl+Page Down  

Move the cursor to the end of the word or next word  Ctrl+Right arrow  

Move the cursor to the next line  Ctrl+Down arrow  

Move the cursor to the previous line  Ctrl+Up arrow  

Move to the next label  F10 or Tab  

Move to the previous label  Shift+F10 or Shift+Tab  

Paste the text (from the clipboard) at the cursor  Ctrl+V or Shift+Insert  

Print the note after it is saved  Alt+P  

Redo command  Ctrl+Y  

Replace an embedded QuickText item with the associated 
QuickText 

Alt+N or Alt+Q  

Replace an embedded QuickText item, but first display pick 
list 

Alt+A  

Save the note  Alt+O  

Select the entire document  Ctrl+A  

Select the entire line  Shift+Ctrl+Down arrow  

Select the text from the cursor to the beginning of the 
previous line  

Shift+Ctrl+Up arrow or Shift+Home  

Select the text from the cursor to the beginning of the text  Shift+Ctrl+Page Up or 
Shift+Ctrl+Home  

Select the text from the cursor to the beginning of the word 
or previous word  

Shift+Ctrl+Left arrow  

Select the text from the cursor to the end of the line  Shift+End 

Select the text from the cursor to the end of the text  Shift+Ctrl+End or Shift+Ctrl+Page 
Down  

Select the text from the cursor to the end of the word or next 
word  

Shift+Ctrl+Right arrow  

Select the text from the cursor to the next line up to the 
position below the cursor  

Shift+Down arrow  

Select the text from the cursor to the previous line up to the 
position above the cursor  

Shift+Up arrow  

Undo command  Alt+Backspace or Ctrl+Z  

Add an "open label" character: << Alt+0171 

Add a "close label" character: >> Alt+0187 

Add an "open label" character for E&M codes: † Alt+0134 

Add a "close label" character for E&M codes: ‡ Alt+0135 

If using the auto save notes feature, save the note to the auto 
save file 

Ctrl+S 
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Social history 
The patient chart provides three patient history sections:  

• Social History – Records medically relevant information about the patient's life, such as marital 
status, habits, work, etc. 

• Family History – Records medically relevant information about the patient’s family, including 
major diseases and chronic conditions. 

• Past Medical History – Records all the chronic illnesses, hospitalizations, and other health 
information for the patient. 

Adding patient history information is much like adding a progress note. You can type the history 
directly into Patient Records, or you can use the Text Data Loader to import data from an outside 
source.  

Each history section of the chart consists of a single note that displays the date you first entered history 
information for the patient. As with progress notes, you can use templates to quickly and accurately 
record historical information. Templates provide a general framework, indicating what information you 
should enter. 

The history sections can be as long as you like, and each section is treated much like one long progress 
note. You can design templates to provide forms for entering history information. You can also rename 
any, or all, of the three History sections of the chart and use these sections for your own categories of 
patient information. 
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Special studies 
The Special Studies section of the patient chart contains reports from any other type of test or study. 
Adding special studies information is much like adding a progress note. You can type the history 
directly into Patient Records, or you can use the Text Data Loader to import data from an outside 
source.  

As with progress notes, you can use templates to quickly and accurately record information. Templates 
provide a general framework, indicating what information you should enter. 
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Spirometry 

Brentwood Spirometry module 
If you have the Spirometry add-on module, Lytec MD provides full Spirometer functionality. The add-on 
module fully integrates the IQmark Digital Spirometer from Brentwood (Midmark) with Lytec MD. 

Brentwood’s product converts your PC into a real time Spirometer with interpretation. This means that 
you can acquire, display, interpret, and store test results through the PCs that are part of your Lytec MD 
system.  

The Spirometry module provides many features:  

• You can perform FVC, VC and MVV tests that meet or exceed the requirements of the American 
Thoracic Society. 

• You do not need to pay for expensive machines and components.  

• You can print results on plain paper, or simply store the results electronically without ever 
printing them. 

• Lytec MD stores the results as data points, which are more flexible and accurate than image files. 
Data points take up less memory, and you can use them for analysis and research.  

Your system administrator can specify on the Special Features screen the chart location where the 
Spirometry results should be stored. The administrator also needs to provide the appropriate users 
access to the module by assigning the Spirometer task item on the access level screen. 

Also, for the spirometer to make a correct interpretation of a spirometry test, a race must be specified 
for the patient. To do this, your system administrator must enable the Race field through the 
Demographic Settings screen. When this field is enabled, the Ethnicity field will also be enabled on the 
Patient screen. If the patient's race is white the Ethnicity field can be used to specify the patient's 
ethnicity as Hispanic or Non-Hispanic. If the patient's ethnicity is Hispanic, Brentwood Spirometry will 
treat the patient as Hispanic. 

Note: The Spirometer requires frequent calibration. Please read the Spirometer manual for details on 
how and when to calibrate the Spirometer. 

Working with the Brentwood module 
Taking Spirometry readings through Lytec MDis simple. You connect the Brentwood acquisition 
module to your computer. Then, in Lytec MD, you select a patient’s chart and run the test. While still in 
Lytec MD, you view the results and interpretation. You can also modify the interpretation. The results 
are then stored in Lytec MD. You can use the Special Features screen to indicate where the data is 
stored in the patient chart. 

You can review Spirometry results through the Task menu or through the Special Studies tab of the 
patient chart.  

The topics below provide basic instructions for using the module through Lytec MD. Refer to the 
Brentwood user’s manual for specific instructions on connecting, setting up, and using all features of 
the IQmark Digital Spirometer acquisition module. 
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Adding, editing, and deleting Spirometry readings with the 
Brentwood module 
To take a reading: 

1. Make sure the Spirometry module is plugged into the workstation, and has been properly 
calibrated. 

2. While the patient chart is open, select Task > Add-ons > Spirometry. The Spirometry screen 
appears. This screen lists all Spirometry readings that have been completed for the patient. 

Note: You can also select Task > Add-ons > Spirometry while the patient chart is not open. When the 
Lookup screen appears, select the appropriate patient and click the OK button.  

3. On the Spirometry screen, click the New button. The Spirometry for <Patient> screen appears.  

Note: The Spirometry module requires the patient's age, sex, height, and race. If the module cannot 
find this information in the patient chart, a message appears. 
 
To assist the Brentwood application in making a more accurate interpretation of a spirometry test, you 
should also specify the patient's race on the Patient screen. The race field is an optional field that must 
be configured on the Demographic Settings screen by your system administrator. 

4. From the Spirometry for <Patient> screen, you can run FVC, VC, and MVV tests. The top left of 
the screen displays the volume v. time graph of a test. The bottom left displays the flow v. 
volume for a test. The dotted line in each graph shows the predicted values for the patient.  
 
The grid on the right side displays the predicted value, measured value, and percent of the 
predicted value for each measurement of the currently-selected procedure type. The contents 
of the grid change when you select a new procedure type (FV, VC, or MVV).  
 
The center section displays the test phase and number of test performed, and contains several 
controls for viewing the tests performed. The Pre button switches to the pre-bronchodilator 
tests and the Post button switches to the post-bronchodilator tests. The Best check box marks 
the currently-displayed test as the best effort by the patient (normally, the module automatically 
selects the test with the best effort, but you can override the selection if necessary). You can 
scroll through the tests by clicking the Prev and Next buttons. 
 
From this screen, you can also calibrate the sensor, change configuration settings, and access 
the module's help. 

5. When you finish, click the Exit button. If you've taken multiple readings, you may need to select 
the results you want to save. 
 
The Spirometer results and interpretation are saved in Lytec MD as a text entry in the Special 
Studies tab of the patient chart. The Spirometry report is also attached to the text note, and can 
be displayed any time from within Lytec MD. 

Reviewing readings taken with the Brentwood module 
You can review Spirometry readings taken with the Brentwood module through the Task menu or 
through the patient chart.  
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To review a reading through the Task menu:  

1. While the patient chart is open, select Task > Add-ons > Spirometry. The Spirometry screen 
appears. This screen lists all Spirometry readings that have been completed for the patient.  

Note: You can also select Task > Add-ons > Spirometry while the patient chart is not open. When the 
Lookup screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the reading that you want to review.  

3. Click the View button. The Spirometry for <Patient> screen appears.  

4. When you finish, click the Exit button.  

To review a reading through the patient chart:  

1. In the patient chart, click the Special Studies tab. The newest special studies note (special 
studies include Spirometry readings) for the patient appears.  

2. Scroll through the reports to locate the reading you want to review. You can view the full 
interpretation in the report.  

3. To view the Spirometry report and associated graphs, click the  icon. 

4. When you finish, click the Exit button. You return to the special studies note. Click the Close 
button.  

To modify a reading taken with the Brentwood module: 

1. While the patient chart is open, select Task > Add-ons > Spirometry. The Spirometry screen 
appears. This screen lists all Spirometry readings that have been completed for the patient.  

Note: You can also select Task > Add-ons > Spirometry while the patient chart is not open. When the 
Lookup screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the reading that you want to modify or edit.  

3. Click the Edit button. The Spirometry for <Patient> screen appears.  

4. Make the necessary changes.  

5. When you finish, click the Exit button.  

To delete a reading taken with the Brentwood module: 

1. While the patient chart is open, select Task > Add-ons > Spirometry. The Spirometry screen 
appears. This screen lists all Spirometry readings that have been completed for the patient.  

Note: You can also select Task > Add-ons > Spirometry while the patient chart is not open. When the 
Lookup screen appears, select the appropriate patient and click the OK button.  

2. In the table, highlight the reading that you want to delete.  

3. Click the Delete button. A message asks you to confirm the deletion.  

4. Click the Yes button.  
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Searching UpToDate® Online from Patient Records 
UpToDate® Online is a web-based medical knowledge reference used by physicians and other health 
care professionals. If you have an UpToDate Online subscription, you can set up Patient Records so that 
you can easily perform searches for content related to problem names, lab name, and medication 
names in various Patient Records screens. 

Configuration Steps 
The following sections describe the configuration steps required to search UpToDate® Online from 
Patient Records: 

• Prerequisites 

• Configure Special Features Settings 

• Configure UpToDate Online User Names and Passwords for Lytec MD Operators 

Note: This section describes how to set up Patient Records so that you can search for UpToDate 
content if you already have an UpToDate Online subscription. For more information on subscribing to 
and using UpToDate Online, see the www.utdol.com web site. 

Prerequisites 
To enable integration with UpToDate® Online, ensure that you have the following: 

• A valid subscription for the UpToDate Online web site. 

• Access to the internet. 

Configure Special Features Settings 
Before you can search UpToDate® Online from Patient Records, you must configure a number of 
settings in the Special Features screen Records 8 tab. 

To configure Special Features settings for UpToDate integration: 

1. Select Maintenance > Configuration > Special Features. 

2. Click the Records 8 tab. 

3. Select the Enable UpToDate Integration check box. 

4. Verify that the text in the URL field matches the URL you use to access the UpToDate Online 
web site.  

Note: The URL may vary depending on your type of subscription. Lytec MD recommends that you 
verify the URL with UpToDate to ensure that the correct URL is entered here. 

5. Select one of the following options from the Integration Level list: 
• Level 1: Select this option if you use an IP-based site license to access UpToDate Online.  

• Level 2: Select this option if individual operators use separate user accounts to access 
UpToDate Online.  

Note: If you select Level 2, you must associate Lytec MD operator accounts with the relevant UpToDate 
Online user account information. For more information, see the Configure UpToDate® Online User 
Names and Passwords for Lytec MD Operators section below. 

6. Click OK. A confirmation message appears, indicating that you must exit and restart Patient 
Records for the settings to take affect. 
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7. Click OK. 

Configure UpToDate® Online User Names and Passwords for Lytec 
MD Operators 
If operators use separate accounts to access the UpToDate Online web site (i.e., Level 2 is selected as 
the integration level in Special Features screen), you must perform an additional configuration step to 
map Lytec MD operators to the relevant UpToDate Online user name and password. This allows the 
users to search UpToDate Online directly from Patient Records without first entering their log in 
information. 

The uptodate.ref file, located in the Lytec MD database directory (usually p:/ppart), is used to map 
Lytec MD operators to UpToDate Online account information. If the file is not there, you may need to 
create it using a text editor such as Notepad, which is included in all Microsoft Windows Operating 
Systems. This file must contain a separate line for each operator that you want to be able to access 
UpToDate Online, in the following format: 

[Lytec MD Operator ID]|[UpToDate UserName]|[UpToDate Password] 

Where: 

• [Operator ID] is the user's Lytec MD operator ID. 

• [UpToDate UserName] is the user name associated with the operator's UpToDate Online 
account. 

• [UpToDate Password] is the password associated with the operator's UpToDate Online account. 

For example: 

ABC|AbleCobb|password 

To configure uptodate.ref: 

1. Navigate to the Lytec MD database directory (usually p:/ppart) and open the uptodate.ref file 
in a text editor, such as Notepad. 

2. For each operator who you want to be able to access UpToDate Online, enter the following 
information on a separate line in the file: 

[Lytec MD Operator ID]|[UpToDate UserName]|[UpToDate Password] 

3. When you finish, save and close the file. 
Note: The UpToDate Online user names and passwords stored in uptodate.ref file are not encrypted. 
We advise that you do not choose passwords for UpToDate Online that you use for other secure 
applications. 
 
Lytec MD does not sell or provide technical support for UpToDate Online. If you wish to purchase 
UpToDate Online, you may contact UpToDate, Inc. at www.utdol.com. 

Launching UpToDate® Searches from Patient Records 
When you have configured Patient Records to work with UpToDate Online, you can perform searches 
of the UpToDate Online web site for the following types of terms:  

• Problem Names: You can search UpToDate Online for problem names from the Problem List 
and Chart Summary screens. 

• Medication Names: You can search UpToDate Online for medication names from the 
Rx/Medications and Chart Summary screens. 
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• Lab Test Names: You can search UpToDate Online for lab names from the Most Recent Lab, Lab 
Data Tables, Lab Table Review, and Chart Summary screens. 

To launch an UpToDate Online search: 

1. In the relevant Patient Records screen, right-click the term for which you want to search. For 
example, to search for a problem, right-click a problem name in the Problem List screen. A 
pop-up menu appears. 

2. Select Search UpToDate Online from the pop-up menu. The Lytec MD Browser appears, 
displaying the UpToDate Online web page. 

Note: If this is the first UpToDate Online search in the session, a license agreement page might appear. 
You must accept the license agreement before the search results are displayed.  
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Vital signs 
The Vital Signs section of the patient chart lets you record your own vital signs data, and pre-configured 
data including: height, weight, temperature, pulse, systolic blood pressure, diastolic blood pressure, 
OFC, and one other category of vital signs data. Vital signs data can be viewed in either tabular or 
graphic form. 

Before you begin entering vital signs data, your system administrator can set up vital sign names to 
define the data (other than the pre-configured data) that you want to display and track. In addition, the 
normal ranges that your system administrator defines on the Ranges screen determine which values are 
highlighted as abnormal on the Vital Sign screen for vital sign data entered directly into the program.  

Typically, you will want to add a new column of vital signs data for each patient visit. You can enter 
them directly, or via a progress note with the .V Dot code.  

This Vital Signs section of the patient chart also allows you to record postural Blood Pressure and Pulse 
data (in recumbent, sitting, and standing positions). You may enter up to 3 sets of postural data from 
the Posturals screen. You can also use a Welch Allyn vital sign device to acquire postural information. 
See the Posturals section for a complete overview. 

Using English or metric measurements 
If you use English measurements, you can use standard symbols when using vital sign Dot codes. For 
example, Patient Records understands entries such as 2' 4" and 3lb 10oz, and allows you to graph 
them.  

Depending on which option was selected during installation of Patient Records, growth charts are 
preset to either metric or English measurements for height and weight, and metric for head 
circumference.   

Plotting percentiles in children  
For children 18 years of age or younger, the 5th, 10th, 25th, 50th, 75th, 90th, and 95th percentiles are 
automatically plotted for height, weight and head circumference. The percentile files (.plt) are available 
in English and Metric and also by sex. During installation, Patient Records prompts you to select which 
percentile files to use.  

For children 2 years of age to 20 years of age, 3rd, 5th, 10th, 25th, 50th, 75th, 85th, 90th, 95th, and 
97th percentiles are automatically plotted for body mass index (BMI).  

Adding, graphing, editing, and deleting vital signs 
To open the Vital Signs screen: 

• In the patient chart, select Show > Vital Signs, or click the Vital Signs tab. You can also click the 
Vitals button on the go to bar. The Vital Signs screen appears. 

To add vital signs data directly in the patient chart: 

You can also import data from Welch Allyn vital sign devices. 

1. On the Vital Signs screen, select the vital signs template you want to work with from the 
Template drop-down menu.  

Note: You can quickly scroll through the templates by clicking the right or left arrows on the keyboard 
or next to the Template field.  
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You can also jump directly to a template by typing the first letter of the template name (for example, 
type the letter C to jump to the CBC template). The first template starting with that letter will be 
selected. If this is not the template you want, keep typing the letter until the template is selected (this 
scrolls alphabetically through the templates that begin with the letter).  

2. When the vital signs template appears, click the New button on the Vital Signs screen. The Vital 
Signs <New> screen appears.  

3. The current date and time are automatically entered in the date and time fields. Change the 
date and/or time if necessary. Add the value for each category in the appropriate fields. Use 
the TAB or arrow keys to move between fields.  

4. When you finish, click the OK button. 

To graph vital signs data: 

1. On the Vital Signs screen, highlight the column of vital sign data you want to graph. To 
highlight an entire row, click the row name. You can select up to four rows by clicking on one, 
then pressing SHIFT while you select the others.  
 
You can also highlight part of a row. To do that, click on the first cell, and then press SHIFT 
while you select the others.  
 
You can also highlight cells in different rows by clicking on the first cell in one row, and then 
pressing CTRL while you select other cells in other rows.  

2. Click the Graph button. The Graph screen appears. This screen displays a graph of the vital 
sign items you selected.  

To print a vital signs graph:  

• When the graph of the vital signs is open, click the Print button. If the Windows Print screen 
appears, select the printer and click the OK button. 

To change vital signs data: 

• On the Vital Signs screen, highlight the column of vital signs that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete a column of vital signs data: 

• On the Vital Signs screen, highlight the column of vital signs that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

To print a list of vital signs: 

• On the Vital Signs screen, click the Print button. If the Windows Print screen appears, select the 
printer and click the OK button. 

Viewing older and newer vital signs data: 

• To view previous vital sign data, click the Older button. To view more recent data, click the 
Newer button. 
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Viewing vital sign details: 

• On the Vital Signs screen, click the Detail check box located on the bottom right. The Details 
panel displays information such as vital sign name, the data entered, and the time the data was 
entered.  

Fields and buttons on the Vital Signs screen 
This section explains the pre-configured fields and buttons located on the Vital Signs screen. You can 
enter information in these fields, if applicable. If you defined your own vital sign names, they will be 
displayed on the lower half of this screen.  

Field Description 

Time The current time is automatically displayed in this field. You can 
change the time if necessary.  

Date The current date is automatically displayed in this field. You can 
change the date if necessary.  

Operator The current operator is displayed in this field. 

Weight Enter the patient's weight. A drop-down menu allows you to 
choose whether to enter the patient's weight in English or 
metric measurements. 

Height Enter the patient's height. A drop-down menu allows you to 
choose whether to enter the patient's height in English or 
metric measurements.  

BMI The body mass index (BMI) is calculated based on the patient's 
weight and height (BMI = weight in kilograms) / (height in 
meters)2). The weight from the same day is used to calculate 
the BMI. The height used for the calculation is based on the 
following time frames for female and male patients:    

• If the patient is under 17 years old, the current height 
will be used (i.e., the height from the same day). If there 
is no height, the BMI will not be calculated (or 
graphed).  

• If the patient is older than 17 years old, the most recent 
height within the past year will be used.  

Please note the BMI will not be calculated if a patient’s weight is 
not entered or if a height is not found within the time ranges 
specified above.   

OFC Enter the patient's occipito-frontal circumference (OFC) in 
inches or centimeters.  

Temperature Enter the patient's temperature. You can select to enter the 
patient's temperature in Fahrenheit (F) or Celsius (C). A drop-
down menu allows you to indicate by what route the 
temperature was measured.  

Pulse Enter the patient's pulse, or click the down arrow button to 
access the number input screen. You can select whether the 
patient's pulse was regular or irregular in the field located next 
to the Pulse field. 

Respirations Enter the number of respirations per minute.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 831 

 

Systolic Enter the patient's systolic blood pressure, or click the down 
arrow button to access the number input screen. 

Diastolic Enter the patient's diastolic blood pressure, or click the down 
arrow button to access the number input screen. 

Oximetry Enter the oximetry measurement. 

BP Location Select or enter the blood pressure location.  

Viewing Vital Signs 
The Vital Signs <View> screen provides a view-only display of vital signs data and allows you to view 
weight, height, temperature, and occipito-frontal circumference (OFC) measurements in different units 
from those displayed on the main Vital Signs screen. For example, if you entered a patient's height in 
English measurements, you can view the patient's height in metric measurements by selecting the 
Metric option from the Vital Signs <View> screen. This will not change the original selected 
measurements in the system; it will only allow you to see the patient's vital signs in another 
measurement.  

To view weight, height, temperature, or OFC in different units on the Vital Signs <View> screen:  

1. Open the Vital Signs screen, and highlight the column of vital signs that you want to view. 
Click the View button. The Vital Signs <View> screen appears.  

2. Change the unit for Weight, Height, Temperature, and/or OFC by selecting a unit from the 
corresponding drop-down menu. The fields that cannot be changed on the screen will be 
greyed out.  

3. When you finish, click the Close button. 

 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 832 

 

Posturals 
This Vital Signs section of the chart also allows you to record postural data. The Postural template 
provided by Patient Records, allows you to record blood pressure and pulse for patients in recumbent, 
sitting, and standing positions. Using the Posturals screen you can enter up to three sets of postural 
data. You can also import postural data from Welch Allyn vital sign devices.  

Adding, graphing, editing, and deleting postural data 
To add postural data directly to the patient chart: 

You can also import data from Welch Allyn vital sign devices. 

1. On the Vital Signs screen, select Posturals from the Template drop-down menu. You can also 
access the screen by clicking the Posturals button on the Vital Signs <New> and Vital Signs 
<Edit> screens.  
Note: You can quickly scroll through the templates by clicking the right or left arrows on the 
keyboard or next to the Template field.  
 
You can also jump directly to a template by typing the first letter of the template name (for 
example, type the letter C to jump to the CBC template). The first template starting with that 
letter will be selected. If this is not the template you want, keep typing the letter until the 
template is selected (this scrolls alphabetically through the templates that begin with the letter).  

2. When the Posturals template appears, click the New button on the Vital Signs screen. The Vital 
Signs <New> screen appears.  

3. Click the Posturals button. The Posturals screen appears. The screen allows you to enter three 
different sets of postural data for the patient (thus the fields are marked 1,2, and 3). Enter the 
patient's postural data in the provided fields. You can also click the Acquire button to acquire 
postural information from the Welch Allyn vital sign device. 

4. When you finish, click the OK button. 

To graph postural data: 

1. On the Vital Signs screen, highlight the column of postural data you want to graph. To 
highlight an entire row, click the row name. You can select up to four rows by clicking on one, 
then pressing SHIFT while you select the others.  
 
You can also highlight part of a row. To do that, click on the first cell, and then press SHIFT 
while you select the others.  
 
You can also highlight cells in different rows by clicking on the first cell in one row, and then 
pressing CTRL while you select other cells in other rows.  

2. Click the Graph button. The Graph screen appears. This screen displays a graph of the 
postural items you selected.  

To print a posturals graph:  

• When the graph is open, click the Print button. If the Windows Print screen appears, select the 
printer and click the OK button. 
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To change postural data: 

• On the Vital Signs screen, highlight the column of posturals that you want to change. Click the 
Edit button. Make the appropriate changes. When you finish, click the OK button. 

To delete a column of postural data: 

• On the Vital Signs screen, highlight the column of posturals that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

To print a list of posturals: 

• On the Vital Signs screen, click the Print button. If the Windows Print screen appears, select the 
printer and click the OK button. 

Viewing older and newer postural data: 

• To view previous postural data, click the Older button. To view more recent data, click the 
Newer button. 

Viewing postural details: 

• On the Vital Signs screen (when the Posturals template is selected), click the Details check box 
located on the bottom right. The Details panel displays information such as postural name, the 
data entered, and the time the data was entered.  

Fields and buttons on the Posturals screen 
Field Description 

Posture Select the patient's posture from the drop-down menu. Your 
options include: Recumbent (lying down), Sitting, and 
Standing 

Systolic Enter the patient's systolic blood pressure, or click the down 
arrow button to access the number input screen. 

Diastolic Enter the patient's diastolic blood pressure, or click the down 
arrow button to access the number input screen. 

Pulse Enter the patient's pulse, or click the down arrow button to 
access the number input screen. You can select whether the 
patient's pulse was regular or irregular in the pulse attribute 
field located next to the Pulse field. 

Acquire button Click the Acquire button to acquire postural information from 
the Welch Allyn vital sign device. 
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Welch Allyn vital sign devices 
Patient Records can import vital sign results from Welch Allyn vital sign devices, including Spot Device 
model 420 and Vital Signs Monitor 520 and 52000 models. This means that you can acquire, display, 
and store vital sign results through the PCs that are part of your Lytec MD system. 

To import data from these devices, you must have an access level that allows you to add vital sign data.  

Importing vital sign readings into Patient Records is simple. You connect the Welch Allyn acquisition 
module to your computer and take the readings. Then, in Patient Records, you select a patient’s chart 
and import the data, which is stored in the patient chart's Vital Signs section. 

You will need a Welch Allyn connectivity accessory kit that includes a serial cable to connect the vital 
sign device to your PC's COM port. If you do not have a standard COM port name for the 
communication port through which the vital sign equipment will interface with Lytec MD, your system 
administrator should use the [VitalsAcquire] setting in the ppart.ini file to specify the COM port. 

If another device was previously connected to the serial port, you may need to restart your computer. 
However, if you are using either the Brentwood EKG or Brentwood Spirometer add-on modules, be 
advised that the Brentwood software appropriates the serial port. You will not be able to import data 
from a meter attached to the same serial port without uninstalling the Brentwood software. 

The section below provides basic instructions for importing data into Patient Records. Refer to the 
Welch Allyn user’s manual for specific instructions on connecting, setting up, and using all features of 
the vital sign acquisition module. 

Importing vital sign readings with Welch Allyn devices 
To take readings and import data: 

1. Make sure the vital sign module is plugged into the workstation.  

2. Take the vital sign readings. 

3. While the patient chart is open, select Task > Add-ons > Vitals.  

Note: You can also select Task > Add-ons > Vitals while the patient chart is not open. When the Lookup 
screen appears, select the appropriate patient and click the OK button.  
 
When the Vital Signs screen is open, you can click the Acquire button to access the Acquire screen. 

The Acquire screen appears. This screen lists all vital sign readings that have been completed 
for the patient.  

If the readings are not visible, make sure the appropriate COM port (the port to which the 
device is attached) is selected in the COM Port field. If you change the port, click the Search 
Ports field to make sure the device is detected by Lytec MD. 

4. When you finish, click the OK button.  
 
The vital sign results are saved as regular data points in the patient chart's Vital Signs section. 
You can edit or delete the readings as necessary. 
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X-ray 
The X-ray section of the patient chart contains X-Ray reports for the patient. Adding x-ray information is 
much like adding a progress note. You can type the history directly into Patient Records, or you can use 
the Text Data Loader to import data from an outside source.  

As with progress notes, you can use templates to quickly and accurately record information. Templates 
provide a general framework, indicating what information you should enter. 
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Patient Education 
The Patient Education feature provides patient education materials that you and your staff can use as 
handouts for your patients. You can select these handouts from the various education modules that can 
be installed for Patient Education. The handouts can either be printed or be sent by e-mail. You can 
also create customized notes or comments to include with the handouts. 

To use Patient Education, you must have Microsoft Internet Explorer version 5.0 or later installed on 
your computer. 

Patient Education includes a tool called Patient Profile that automatically selects the appropriate 
education module for your patients by analyzing the patient’s age and sex. Patient Profile saves you the 
time that you would have spent deciding which module to view for a particular patient. 

Some of the Patient Education modules are available in English and Spanish versions. You can choose 
which version you want to use by choosing either the English or Spanish index title when you access 
the Patient Education program. If you are viewing the English index and you see an asterisk next to an 
index entry, the asterisk indicates that the entry has a Spanish translation. 

Note: You can also integrate Patient Records with MedQuest’s ExitCare® patient information system to 
provide patient education handouts. For more information, see Integrating Patient Records with 
ExitCare. 

Accessing Patient Education 
To access Patient Education:  

• From the Task menu, click Patient Education.  

• If a patient chart is open, you can select Patient Education from the task menu, or you can click 
Pat Ed (Patient Education) on the toolbar. You must do this each time you change patients, so 
that the Patient Education module is using the correct patient.  

To close Patient Education:  

• From the File menu, click Exit.  

Changing Patient Education modules  
If you have more than one Patient Education module installed, you can easily change from one module 
to another. For example, if you are currently using the Adult Health Advisor module, you can change to 
the Pediatric Advisor module without exiting the program.  

To change from one module to another:  

1. From the File menu, click Change Module. Otherwise click the Patient Education button in the 
bottom right corner of the window. This opens Current Module.  

2. Select the module that you want to use from the list.  

3. Click OK.  

Using the Patient Education menu and toolbar  
Some of the menu and toolbar options available in the Patient Education mode are also available in the 
knowledge base and browser modes.  
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From any window that you are viewing, you can go back to the previous page or go forward to the next 
page. To go back to the previous page, click Back from the toolbar. To go forward to the next page, 
click Forward.  

Clicking the Search button in the browser mode displays the Yahoo! search engine.  

Using the Patient Education index  
To display the Index, select Index from the Task menu, click Index from the toolbar, or click the English 
or Spanish index title from the window. At the top of the Index screen, you can select a letter of the 
alphabet where you want to find a topic. You could also scroll down the window until you find your 
topic.  

In the Index, you can select any of the underlined topics to display the handout. Topics that are not 
underlined refer to related sub-topics that are underlined.  

Using the Patient Education search function  
To display the Search screen, choose Search from the Task menu or choose the Search button from the 
toolbar. At the top of the screen, select the By Title radio button.  

The Document Index in the topic box looks similar to the regular Index. The main topics are listed in 
alphabetical order. The noticeable differences from the Index are:  

• Topics that display handouts have notepad icon next to it, instead of being underlined.  

• Topics that have sub-topics have a folder icon next to it. Select the main topic to display the sub-
topics.  

To search for a topic:  

1. In the box next to Search, type a topic or a description for the topic.  

2. Click Search. The first topic that contains the description you entered will be highlighted in the 
topic box.  

3. If the first highlighted topic is not what you want, click Search again to find the next related 
topic.  

4. Once you find your topic, click to display the handout. If you decide not to view a topic, click 
Close.  

Finding information in Patient Education  
When you access Patient Education, the first window that you see displays the name and version of the 
default module. The window also displays the language title available for the index (English or 
Spanish), the Credits title, and the Getting Started title. Some of the modules may have a Table of 
Contents title that leads to other sub-titles. You can select any of these titles to display information 
about each subject.  

You can find specific topics in two ways: by using the Index or by using the Search function. The Index 
lists topics in alphabetical order. The Search function also lists topics in alphabetical order, but also 
allows you to enter a description or code and search for it. Topics that are available in the Spanish 
version have an asterisk (*) next to them.  
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Using the patient profile feature in Patient Education  
Patient Education can automatically select the appropriate education module for a patient, as 
determined by a patient’s age and sex profile. When you have a patient chart open in Patient Records, 
you can access Patient Education and the module that is the most suitable for that patient’s age and sex 
appears.  

Once you access Patient Education, you can open another patient’s chart and the module that is the 
most suitable for that patient profile will be loaded. You do not have to decide which module is 
suitable for a patient because the module is automatically selected.  

For example, for a woman age 35, the Women’s Health Advisor module loads because it is the most 
suitable module for a woman of this age. For a man age 55, the Senior Health Advisor module loads.  

Using Patient Profile works best when you have installed all available modules and the system has a 
wider selection of modules from which to choose.  

If you have added a progress note for a patient, and if the patient is currently selected on the Patient 
Profile screen (available while you are in Patient Education by clicking the Profile or selecting Patient 
Profile from the Task menu), a notation will be added to the progress note that lists the handouts that 
you print for or e-mail to the patient. The notation is "Patient Education Hand-outs given to patient," 
followed by the handout title, whether the handout was printed or e-mailed, and the time the handout 
was provided to the patient.  

To use the Patient Profile feature:  

1. Open a patient chart.  

2. Click Pat Ed (Patient Education) on the toolbar. The appropriate module automatically loads.  

Note: Each time that you go back to Patient Records and open (or switch to) another patient chart, you 
must choose the Patient Education button in order for Patient Profile to load the appropriate module 
for that patient.  

To view the Patient Profile:  

1. From the Task menu, click Patient Profile. Otherwise, click Profile on the toolbar. This opens 
Patient Profile. The patient’s name, age, and sex display in the appropriate fields. The 
diagnostic coding system used and the diagnostic code, if available, also display.  

2. Click OK to close the dialog.  

Printing Patient Education handouts  
When you view a Patient Education handout, you can also print it.  

If you have added a progress note for a patient, and if the patient is currently selected on Patient 
Profile (available while you are in Patient Education by clicking the Profile button or selecting Patient 
Profile from the Task menu), a notation will be added to the progress note that lists the handouts that 
you print for the patient. The notation is "Patient Education Hand-outs given to patient," followed by 
the handout title and the time the handout was printed for the patient.  

If you print a Patient Education handout while a patient chart is open, the patient's name, ID, sex, age, 
and the print date will be printed at the top of the handout. 

To print a handout:  

1. From the File menu, click Print. Otherwise, click Print on the toolbar. This opens the Windows 
Print dialog.  
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2. Click OK.  

Using bookmarks in Patient Education handouts  
When viewing a handout, handout can be marked with a bookmark. Using a bookmark makes it easier 
to go back at a later time to view or print that handout.  

To mark a handout with a bookmark:  

• While viewing a handout, from the Bookmarks menu, click Add Handout.  

To view a handout marked with a bookmark:  

1. From the Bookmarks menu, point to Handout. A list of handouts displays in the submenu.  

2. Click the title of the handout from the submenu.  

To remove a bookmark:  

1. From the Bookmarks menu, click Edit Bookmarks. This opens Edit Bookmarks.  

2. Click the Handouts option button. A box displays a list of bookmarks made to handouts.  

3. Click the bookmark to be removed from the list.  

4. Click Delete.  

5. Click Close to leave Edit Bookmarks.  

Patient Education: setup 
The Patient Education feature of Patient Records provides patient education materials that you can use 
as handouts for your patients. To make viewing, printing, e-mailing, and editing files as easy as 
possible, you can set defaults options such as the patient education module you are currently using, a 
mail profile for e-mailing handouts, and templates to use when attaching notes to handouts. 

Note: To set the default options, you must run Patient Education as a stand-alone program. You will not 
be able to set the default option if you access Patient Education from the Patient Records application. 

Creating a default template for Patient Education comments  
To create a default template, you can edit the supplied default.rtf (located in the Patient Education 
directory) or create a new RTF file. This RTF file controls the header and the initial fonts for comments.  

You can use additional format files available with the RTF extension. The user can select these files 
when adding a comment.  

To create a default template for a comment:  

• Use Wordpad to create a text file that you want to use as your default comment. It controls the 
fonts and format of comments and has boilerplate text, such as practice name and phone 
number. Save the file, using the extension .RTF for the filename.  
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Setting defaults for Patient Education 
The Patient Education defaults also apply to the knowledge base and browser. 

To set defaults: 

1. Open Patient Education outside of Patient Records. 

2. Select Maintenance > Set Defaults. The Administration – Default Settings screen appears. This 
screen has three tabs: Files, E-Mail/Printing, and Editor. 

3. Click the appropriate tab for the section that you want to view or edit. For example, to change 
file defaults, click the Files tab. 

4. When you finish specifying the default settings, click the Close button. 

Adding Patient Education handouts and rebuilding the 
index  
To add a handout for Patient Education:  

1. Create a handout in HTML format using Word, FrontPage, or an HTML editor, or download a 
handout from the Internet.  

2. Copy the handout HTML file into the relevant Patient Education sub-directory. For example, the 
aha sub-directory has the adult handouts, and the pha sub-directory has the pediatric 
handouts.  

3. Add the title of the handout, and its sub-directory and filename, to the relevant textual index 
file. These textual index files are found in the Patient Education directory. For example the 
index file for adult handouts is named crs_aha_index.txt.  

4. If you are currently running Patient Education, close the program.  

5. Run the CRSINDEX program from the Patient Education part of the Start Menu.  

6. Select the module that you want to rebuild from the list box.  

7. Select Topics > Clear Index. The module is removed.  

8. Enter the name of the module that you want to rebuild in the Module Name field. Enter the 
subdirectory name of the module that contains the handout you added, in the Module 
Directory Prefix field. For example, enter aha.  

9. Click the Create button. The module is rebuilt and redisplays in the list box.  

10. Select the reloaded module from the list box.  

11. Select Topics > Build Index.  

Editing Patient Education handouts 
You can edit any handout by using the handout file, located in the appropriate education module 
folder in the database directory of Patient Education. To edit a handout, use Microsoft Word, 
FrontPage, or any HTML editor.  

Important: If you modify your patient education handouts, they may be overwritten when updating 
your Patient Education content in the future.  
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To edit a handout file:  

1. Open the file.  

2. Enter or change the text that you want.  

3. Save the file using the HTML file extension.  

Note: If you are using Microsoft Word, you must have the HTML file extensions installed in the Word 
program.  

4. Record the name of the file you edited so that you can save it during Patient Education 
updates.  

Adding comments for Patient Education handouts  
In addition to giving a handout to a patient, you can also include a comment or note that is tailored for 
the patient. The comment that you enter can be any additional instruction or any text that you want to 
give to the patient. You can print the comment along with the handout.  

To help format the comment and add default text, you should create a template file that includes the 
boiler-plate text, such as your Practice Name, that you want to include in your comment, as well as the 
margin and font information needed to format your text. This template must be created in Rich Text File 
(RTF) format, to ensure that format and fonts are displayed properly. You can use WordPad (a program 
that comes with Windows) or Microsoft Word to create this RTF file.  

To add a comment for a handout:  

1. Select Task > Notate, or click the Notate button in the tool bar. The Patient Education – 
Additional Comments screen appears.  

2. Enter the text in the window.  
You can also load a template, instead of entering text, by choosing the Templates button and 
selecting the template file. A sample template named default.rtf is included with this program. 
Template files must be in RTF format. If you get a message, “File cannot be opened,” when 
loading a template, then the file is not present.  

3. You can use the Cut, Copy, and Paste functions by pressing the right mouse button and 
choosing from the pop-up menu, or by selecting the functions from the Edit menu.  

4. If you want to modify the font for the text, you can either use the options on the tool bar in the 
screen, or select Format > Character to display the Fonts screen. From this screen, select 
among the following options, then click the OK button:  
• Select a Font and Size from the list boxes. Use the scroll bar to view up and down the list 

boxes.  

• Select one or more check boxes for the Attribute.  

• Select one option for the character Position.  

5. If you want to modify the paragraph settings, you can either use the alignment options on the 
tool bar in the screen, or select Format > Paragraph to display the Paragraph Format screen. 
From this screen, select among the following options, then click the OK button:  
• Select one option for the Line Spacing. You can also specify the space between the lines 

by entering a numeric value; indicate if the space should be in inches by selecting the 
check box.  

• Select one option for the Alignment.  

• Enter the spacing for the Indents.  

• Enter the spacing for the Distances.  
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6. If you decide to rewrite all of the text or decide not to use a template that you just loaded, click 
the Clear button.  

Note: The Reload button will reload a template that you just cleared if the template is the default 
template. See Setting Patient Education/Knowledge Base/Browser Defaults.  

7. When you finish, click the Close button.  

Note: To print the comment, you must first print a handout. A message will ask if you want to print the 
comment. You could also set the default settings to automatically include the comment when printing a 
handout. 

Sending Patient Education handouts through e-mail  
As an alternative to printing a handout, you can send a handout through e-mail. You can also include a 
comment.  

If you have added a progress note for a patient, and if the patient is currently selected on the Patient 
Profile screen (available while you are in Patient Education by clicking the Profile button or selecting 
Task > Patient Profile), a notation will be added to the progress note that lists the handouts that you e-
mail to the patient. The notation is "Patient Education Hand-outs given to patient," followed by the 
handout title and the time the handout was e-mailed to the patient.  

The progress note must be from the provider who is printing the handout. Also, only the first note for 
that provider and that day will include the notation.  

To send a handout through e-mail:  

1. Click the Email button on the tool bar. The Patient Education – Email screen appears.  

2. Enter the recipient address.  

3. Enter or change the mail profile. The mail profile is the email program you are using. If you are 
unsure which mail profile to select, ask your System Administrator for assistance.  

4. Enter the subject of the Email. You can use the default subject, “Patient Education Hand-out” or 
enter a different subject or topic. You can also leave this field blank.  

5. If you want to include the comment with the handout, mark the Include Additional Comments 
check box.  

6. If you want to view the comment, mark the Show Message Before Sending check box.  

7. When you finish, click the OK button.  

Note: If you want to automatically include the comment and view it when sending a handout by e-mail, 
see Patient Education/Knowledge Base/Browser Default Settings.  

Changing to the Knowledge Base or browser 
Once you have accessed Patient Education, the Knowledge Base, or the browser, you can switch to any 
one of the modes without exiting Lytec MD.  

To change modes:  

1. Select Task > Mode.  

2. Select one of the following modes: Knowledge Base or Browse Web.  
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Using ExitCare® with Patient Records  
MedQuest’s ExitCare is system for generating instructional handouts for patients. Each of the handouts 
in ExitCare’s extensive library can be customized for the specific patient’s situation at the time you are 
generating the handout. 

For detailed information about ExitCare, visit www.exitcare.com or consult your ExitCare 
documentation. To purchase ExitCare, please consult your Lytec MD sales representative. 

How does Patient Records work with ExitCare? 
If you install ExitCare with Patient Records you can: 

• Launch ExitCare directly from a patient’s chart in Patient Records 

• Display the currently selected patient’s demographic data from Patient Records in ExitCare 

• Use ExitCare to create and print handouts for the Patient Records patient 

• Automatically save the printed handouts in Adobe Acrobat (PDF) format in the Lytec MD patient 
chart. 

• Automatically add a link from the patient’s latest progress note to the PDF 

Required installation and configuration steps 
The following sections describe the installation and configuration steps required to use ExitCare with 
Patient Records: 

• System requirements 

• Install and configure ExitCare 

• Configure Patient Records PPart.ini file settings 

System requirements 
Patient Records can only be integrated with ExitCare version 6.3.0.6 or later. 

Before installing ExitCare, ensure that your system meets the minimum requirements recommended in 
the ExitCare documentation. 

Install and configure ExitCare 
To install and configure ExitCare, follow the installation instructions in your ExitCare documentation.  

During installation, ensure that ExitCare is installed on a location in your network that can be accessed 
by the Patient Records workstation. ExitCare must also be able to access a printer. 

After installation, ensure that the default ExitCare ‘genericuser’ account can be used to access the 
application. This account is created automatically during installation and will be used by Patient 
Records to launch ExitCare. If you add other user accounts in ExitCare, the default ‘genericuser’ 
account will be automatically disabled and you will not be able to launch ExitCare from Patient 
Records. 
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Configure Patient Records PPart.ini file settings 
Before you can access ExitCare from Patient Records, you must first configure several settings in the 
PPart.ini file. These settings enable Patient Records to launch ExitCare and allow data to be imported 
and exported between the two applications. 

To configure PPart.ini settings: 

1. Make a backup of the PPart.ini file. For example, copy the file and rename it as ppart.bak. 

2. Use WordPad, Notepad, or another text editor to open the file. 

3. Add the settings in the table below to the [PatientEducation] section of the ppart.ini file and 
set appropriate values: 

Key Description 

[PatientEducation] 

ExitCareInstalled= Specifies whether ExitCare can be accessed from Patient 
Records. This setting must be set to ON to enable ExitCare 
integration. 
If this setting =ON, operators can launch ExitCare from Patient 
Records.  
If this setting =OFF, operators will receive a warning message 
when they attempt to launch ExitCare from Patient Records. 

ExitCareClient= Specifies the location and name of the ExitCare executable file. 
Enter a path and file name, for example C:\ExitCare\exitcare.exe. 

Important: This file must be accessible from the Patient Records 
workstation. 

ExitCareDataPath= Specifies the location on the local Patient Records workstation in 
which to store the data files used in ExitCare integration. 
Enter a local path, for example C:\ExitCare\data. 

Important: This must be a location on the local Patient Records 
workstation, not a network location.  
Patient Records saves files containing demographic data to this 
location so that patient information can be displayed in ExitCare. 
Patient handouts exported from ExitCare are temporarily saved 
to this location before being imported into Patient Records and 
referenced by progress notes. 

ExitCareImportInterval= Specifies how often Patient Records checks the location specified 
by the ExitCareDataPath= setting for files exported by ExitCare.  
Enter a number of minutes. The default value is 1. 

ExitCareAdministratorOperator= Identifies the system operator who should receive any messages 
related to ExitCare. 
Enter a valid Patient Records operator ID. 

Note: The specified operator will receive messages through the 
Patient Records messaging system when there are problems 
deleting exported files from the ExitCareDataPath= folder. If you 
receive this message, manually delete the exported .mqe files 
from the data folder. 
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4. Save the PPart.ini file. 

Accessing ExitCare from Patient Records 
When ExitCare has been installed and you have completed the required configuration steps, you can 
launch ExitCare from Patient Records. 

To access ExitCare from Patient Records: 

1. Open a patient’s chart. 

2. Do one of the following: 
• Click the Exit Care button on the Patient Chart. 

• Select Task > Add-ons > Exit Care. 
ExitCare opens. The patient’s demographic information from Patient Records is 
automatically displayed in the Patient Information screen in ExitCare. 

Note: If you did not open a patient chart before selecting Task > Add-ons > ExitCare, the Patient 
Lookup screen appears. Select a patient and click OK. ExitCare opens. 

Working in ExitCare 
After you have launched ExitCare from Patient Records, you can select the handouts and forms that you 
want to print for the patient. The following procedures describe how to perform basic tasks in ExitCare. 
For more detailed information, consult your ExitCare documentation. 

Note: Some features, such as adding new patients, are disabled when you access ExitCare from Patient 
Records. 

To select and customize handouts: 

1. Click Choose Titles in the ExitCare sidebar. The Document Names screen appears, listing the 
documents that you can print for the patient. 

2. Select check boxes next to the names of the documents you want to print, and then click Done. 
A screen allowing you to customize the first selected document appears. 

3. If required, click the Add another caregiver or Add another follow-up buttons to select 
another provider for the patient or select a provider for a follow up appointment. 

4. Type any notes in the Additional Notes box. 

5. Select answers for each of the questions listed in the Custom Document Questions area. Your 
answers are used to customize the handout for the patient. 

6. If you selected multiple documents in step 2, click the next tab at the top of the screen and 
repeat these steps for the next document. When you are finished you can either add an excuse 
form or print the handouts. 

To add an excuse form: 

1. Click Add Excuse Form. A new tab appears at the top of the screen. 

2. Select one or more check boxes to indicate if the patient is excused from work, school, or 
physical activity. 

3. Select a date from the The Patient is Excused from Work/School from Now through the 
Following Date list. 
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4. If the patient must avoid physical activity until a specific date, select one of the additional check 
boxes and select a date from the relevant list. 

5. When you are finished, you can print the handouts. 

To print handouts: 

1. When you are ready to print the handouts, click Print/Fax/Email. The General Print Settings 
screen appears. A list of handouts that will be printed is displayed in the right side of the 
screen. 

2. Optionally, set the following printing options: 
• Select a printer from the Main Printer list. 

• If you want to print all handouts in a single document, select the Print Document as a 
Single Document check box. 

• If you want to fax the handouts to any doctors selected as follow-up providers, select the 
Fax Document to Follow-up Doctors check box. 

• If you want to print more than one signature page, select a number from the How Many 
Copies of the Signature Page do you want to Print? list. 

• To fax the signature page to any doctors selected as follow-up providers, select the Fax 
Signature Page to Follow Up Doctors check box. 

3. When you are finished, click Print. The handouts are printed and the patient details are closed. 

Viewing ExitCare handouts in Patient Records 
Any handouts you print for a Patient Records patient in ExitCare are saved temporarily to the data 
folder defined by the ExitCareDataPath= setting in the PPart.ini file. Patient Records monitors this folder 
and saves the exported file as a PDF file in the patient's chart. 

A link to the relevant PDF file is then automatically added to the patient’s most recent progress note in 
Lytec MD. If the patient does not have a progress note for the current day, a new note is created with 
the title ‘Exit Care Patient Handout’. If multiple handouts were printed for the patient in ExitCare, they 
are collated into a single PDF file. 

To view a patient’s ExitCare handouts in Patient Records: 

1. Open the patient’s chart. 

2. Click the Progress Notes tab. The Progress Note Selection screen appears. 

3. Select the Most Recent option and click OK. The most recent progress note is displayed. 

4. Click the PDF link in the progress note. The PDF is displayed in either the Patient Education 
browser or in Adobe Acrobat Reader, depending on the value of the Use native application 
for PLINK setting in the Special Features screen. 
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Zoom  
Lytec MD Zoom (Zoom) offers a streamlined way for you to import and link external documents and 
images to a patient’s chart, the Patient screen, and the Carrier screen in Lytec MD.  

Zoom allows you to scan your images directly into Lytec MD via the TWAIN interface, or directly select 
pre-scanned or any other viewable files. Once in the Zoom interface, these files can be linked to a note 
in any part of the patient’s chart and sent to a provider for review. You can also add text or comments 
to the note. The links appear in the note as a permanent hyperlink otherwise known as a PLINK. Unlike 
the LINK label marker, permanent hyperlinks are not removed when you save notes. Permanent 
hyperlinks can point to any file viewable by Internet Explorer (e.g., HTML pages, graphics files, text files, 
and files in the Lytec MD Knowledge Base). The actual files for permanent hyperlinks are stored in Lytec 
MD’s Document and File Images system which also includes patient photos, EKG’s, and Spirometry etc. 
  

You can also link a patient image and attachment to the Patient screen, and add a file as an attachment 
to the Carrier screen. 

Using the Lytec MD Zoom screen 
To access Zoom, select the Scan option from the Task menu. This displays the Lytec MD Zoom screen.  

The Lytec MD Zoom screen is highly configurable. You can select your own personal settings for the 
screen using the Lytec MD Zoom - Configuration screen. For a complete explanation of these settings 
please see the Zoom Configurations section. 

Lytec MD Zoom offers two ways for you to acquire your documents. You can either use the browse or 
explorer mode to select your scanned images or documents, or you can click the Scan button to scan 
your documents into Zoom. See the File section for a complete explanation of how to use this mode to 
acquire your documents. See the Scan section for a complete explanation of how to use Lytec MD 
Zoom – Acquire Scan screen to load your documents. 

The Lytec MD Zoom screen is broken down into 4 sections, which include File, Image(s), Document 
tabs, and Note. Each of these sections play a unique part in the scanning and linking process. In order 
to scan and link your document(s) you must complete the following tasks, in sequential order: 

1. Select the file(s) you want to attach to the patient’s chart. 

2. Select the patient information. 

3. Select where you want to attach the scanned documents to and enter a title or description for 
the document. 

4. Save the information to the patient’s chart. 

The following sections describe the Lytec MD Zoom screen in detail and will provide the information 
you need to successfully scan and link your images. 

File section 
This section of the screen may be viewed in explorer mode or browse mode. In browse mode, less 
screen space is used, allowing you to view your images in a larger area. To select the mode, click the 
down arrow   next to the Files title. To return to your previous mode, click the up   arrow.  

Note : You can configure Zoom to expand the Explorer Window when you move the pointer over the 
window in explorer mode. For details on how to turn this feature off see the Zoom Configurations 
section. 
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Browse Mode 
In browse mode you can browse to the file or folder’s location where your document(s) or image(s) are 
stored. Using this mode you can only select a single file.  

Important: You can only select one file for Patient Images, Patient Attachments, and Carrier 
Attachments. 

 

To select your documents from a folder: 

• Click the Browse button to open the Browse for Folder screen. Navigate to the folder where 
your documents are stored. Select the folder and click OK. The selected folder will be displayed 
in the Folder field. 

To select your documents from a file: 

• Click the Browse button to open the Choose File screen. Navigate to the file you wish to link. 
Select the file and click Open. The selected file will be displayed in the File field. If there are 
multiple files in the folder, you can use the up and down arrows located in the File field to scroll 
through the files/documents. Each of the selected files/documents will be displayed in the 
Image(s) section of the screen. For a complete explanation of this section see the Image(s) 
section. 

Explorer Mode 
In explorer mode you can navigate to the folder where your files are stored. The files in the folder will 
be displayed in the Explorer Window. From this window you can select the document(s) or image(s) 
you want to link. You can select multiple documents and images from the same folder to be linked to 
the same note. 

Important: You can only select one document or image for Patient Images, Patient Attachments, and 
Carrier Attachments. 

You can sort the files by name, type, size, date created, and date modified, by clicking the 
corresponding column headers in the Explorer Window. 

 

To select a file where your documents are stored in explorer mode:  

• Navigate to the folder where your documents are stored. Click on the folder. The folder’s 
contents are displayed in the Explorer Window. Select the file(s) you want to include in the single 
note. To select multiple files: 

• Click the first file, press and hold down SHIFT, and then click the last file. 
or 

• To select nonconsecutive files, press and hold down CTRL, and then click each file.  
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The selected file(s) will be displayed in the Image(s) section of the screen. See the Image(s) section for a 
detailed explanation of this section. Please note selected files that are not supported image files will 
not show up in the Image(s) section, although these files will still be linked in the note. 

Image(s) section 
The supported image file(s) you selected will be displayed in the Image(s) section of the Lytec MD 
Zoom screen. If you selected multiple images you can scroll through your selected images by clicking 
the right document arrow . To scroll back to the previous image or document click the left arrow 

. If your file has multiple pages you can scroll through the pages by clicking the right page arrow 
, to scroll back to the previous page click the left arrow .  

Note: You can configure the image window to expand when you move the pointer over the window. 
For details on how to turn this feature off see the Zoom Configurations section. 

You can also click the right mouse button, to display the shortcut menu and choose the commands 
described above. The shortcut menu offers the following options:  

• Previous Document: Select this option to view the previous document viewed. 

• Next Document: Select this option to view the next selected document. 

• Previous Page: Select this option to view the previous page viewed in the document. 

• Next Page: Select this option to view the next page in the document. 

• Delete Document: Select this option to delete the document displayed. 

• Delete Page: Select this option to remove a page from the document. This option is helpful 
because it allows you to select which pages will be linked to the selected patient’s chart. For 
example, if your document is a fax and you do not want to link the cover page to the patient’s 
chart you can delete this page. 

The Zoom drop-down menu allows you to increase or decrease the selected documents magnification 
level. To return the document or image to fit in the image window, select the Fit option. You can also 
magnify sections of the document by holding down the left mouse button. 

You can view the document in a full-screen by double-clicking on the document, selecting the 
Fullscreen Image option from the View menu, or by pressing CTRL+F. When the document is 
displayed on the full-screen, you can magnify sections of the document by holding down the left 
mouse button. You can also zoom in and out with the wheel button, and move back and forth, and up 
and down by moving the mouse if the image is larger than the screen. 

To return to the Lytec MD Zoom screen, double-click on the document, or press the <ESC> key.  

Scan section 
You can scan documents by clicking the Scan button, selecting the Scan option from the File menu, or 
by pressing CTRL+S. This opens the Lytec MD Zoom – Acquire Scan screen. This screen is used as the 
link between Lytec MD and your scanner(s). Once you have selected the scan folder and the options 
offered on this screen, click the Acquire New button and the TWAIN interface provided by your 
scanners manufacturer will present you with your scanning options. 

The Lytec MD Zoom – Acquire Scan screen is similar to the image layout section on the Lytec MD Zoom 
screen. If your document has more than one page you can use the Page arrows to scroll through the 
pages of your document. If you are scanning multiple documents you can use the document arrows to 
scroll through the individual documents. 
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To scan your document(s): 

1. Select a scan folder. The folder selected from the Lytec MD Zoom screen is automatically 
displayed in this field. You can click the Browse button to navigate to folder’s location where 
your files are stored. 

2. Enter the file prefix in the File Prefix field. The file prefix selected from the Lytec MD Zoom 
screen is automatically displayed in this field. Scanned files will be named with the file prefix 
with the current date and time appended to it. 

3. Select the documents resolution from the Purpose drop-down menu. Available options 
include: Black & White (Low Resolution), Color (Medium Resolution), and Photo (High 
Resolution). The selected resolution will dictate the size and format that the scanned image will 
be saved with. 

4. Select the documents resolution from the Purpose drop-down menu. Available options 
include: Black & White (Low Resolution), Color (Medium Resolution), and Photo (High 
Resolution). The selected resolution will dictate the size and format that the scanned image will 
be saved with. Low and Medium Resolution options will scan TIF image files, and the High 
Resolution Setting will scan PDF image files. Please note if you are merging or splitting 2 or 
more color images, the resulting image files will be dictated by the Purpose setting. 

5. If you have more than one image to scan you can select whether to save your images in a single 
document, or as separate documents. To save your images in a single document select the 
New As Single Document check box. To save your scanned images as separate documents do 
not select this check box. Please note the default selection is un-checked. 

6. Select the scanning source, by choosing the Select Source option from the File menu. This 
option allows you to select the scanner that will be used to scan your document(s). From the 
Select Source screen, select the scanner, and click Select.  

7. Click the Acquire New button to scan your document(s). This will open the TWAIN interface. 
From this screen you can select your scanning preferences. Once the image(s) has been 
scanned, the image(s) can be viewed in the Image(s) section of the Lytec MD Zoom screen. See 
the Image(s) section of this document for a complete explanation of this section. 

Document tab section 
Once you have selected your document(s), you can select where you want to attach the document(s).  

• Chart Note: Click this tab to link files to a note in any part of the patient’s chart.  

• Patient Photo: Click this tab to link a patient photo to the Patient screen.  

• Patient Attachment: Click this tab to attach file(s) to the Patient screen.  

• Carrier Attachment: Click this tab to attach file(s) to Carrier Maintenance.  

You can select the patient you want to have the document(s) attached to. To do this, type the patient’s 
ID in the ID field. The ID field offers an auto-complete feature. Meaning when you type the patient’s ID 
in the field, the application will display matching IDs and your last 5 ID entries, and up to 10 existing 
Lytec MD ID’s in the drop-down menu, allowing you to select the patient ID you are looking for. 

You can also select the Lookup button or press <Enter> when any of the patient fields are selected to 
open the Lookup screen. If there is data in the patient fields, the Lookup screen will appear and do an 
autosearch on those fields (e.g., if you type a last name and press enter, an autosearch with the entered 
name will be performed). From this screen you can select a patient from a list of registered patients. 
See the Lookup section for a complete explanation of this screen.  

Once you have entered or selected the patient’s ID, the patient’s last name, first name, middle initial, 
social security number, and birth date will automatically be displayed in the corresponding fields.  
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If you are linking files to the patient's chart pay attention to the   or   next to the Patient title. If a   
is located next to the Patient title, it means that you have selected a valid patient and you can go on to 
the Note section and enter the necessary data. If an  is located next to the Patient title, you have 
been prohibited from starting the next step. To see what the problem is move the pointer over the . 
A ToolTip window will appear and you will see the reason why you cannot proceed. The application 
gives you the opportunity to fix the error and move on to the next step. For example, you may receive 
an error because you have not selected a valid patient. 

When a  is located next to the Patient title, you can proceed to enter the note’s data. The Note 
section allows you to select the section of the chart the note will be attached to. You can also select the 
title of the note, the date of the note, and the time of the note. Default selections for these options can 
be configured from the Lytec MD Zoom Configuration screen. See the Zoom Configurations section for 
more information. 

To enter patient and note information: 

1. Enter patient’s ID in the ID field. If a valid patient ID is entered, the Last Name, First Name, MI, 
SSN and Birth Date fields will automatically be entered with the patient’s information. Please 
note the patient must be a registered patient in the Lytec MD database. 
• You can use the Lookup button to search for a registered patient in the Lytec MD 

database. See the Lookup section for a complete explanation of this screen. 

IMPORTANT: If there is a  located next to the Patient section, you can proceed to enter the 
note data. If there is an  located next to the Patient section, move the pointer over the  to 
see what the problem is. Please note the problem must be fixed before you enter the note’s 
data. 

2. Select the section of the chart you want the note attached to from the Section drop-down 
menu.  

3. Enter the title of the note. You can enter a title, or you can select from a list of pre-configured or 
recent titles. The application will display your last 5 title entries in the drop-down menu. See the 
Zoom Configurations section for details. 

4. Select the note’s date. Click the down arrow button to access the calendar. 

5. Select the note’s time. You can use the fields up and down arrows to scroll to the desired time. 

6. Enter or select the provider’s you want to link to the note. You can enter up to four providers in 
the corresponding fields, or you can click the arrow button to open the Provider Select screen. 
See the Provider Select section for a detailed explanation of this screen. 

7. If you want to add additional text to the note, enter the note’s text in the provided Note Text 
box. 

8. Click the Save button to save the note to the selected section in the patient’s chart. 

Once the note is saved you can open the patient’s chart, and select the section you saved the note to 
(e.g., Progress Note). The note will be displayed with your scanned PLINKs in the body of the note. 

Click the Clear button to clear the previous note’s information. You can use the configuration settings 
to permanently delete the note, or archive the note. See the Zoom Configurations section for more 
information. 

You may repeat the process described above until you have completed linking your files to notes in the 
patient’s chart.  

Click the Close button to exit Zoom. 
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To add a patient photo or patient attachment: 

1. Click the Patient Photo tab or Patient Attachment tab. 

2. Enter patient’s ID in the ID field. If a valid patient ID is entered, the Last Name, First Name, MI, 
SSN and Birth Date fields will automatically be entered with the patient’s information. Please 
note the patient must be a registered patient in the Lytec MD database. 
• You can use the Lookup button to search for a registered patient in the Lytec MD 

database. See the Lookup section for a complete explanation of this screen. 

If a patient photo already exists for the patient, a warning message will be displayed under the 
entry fields. You can overwrite the existing photo by clicking the Save button. 

Important: Patient photo files must have an extension of .BMP, .GIF, or .JPG. 

3. Click the Save button to save the patient photo or attachment to the Patient screen. 

To add a carrier attachment: 

1. Click the Carrier Attachment tab. 

2. Enter carrier ID in the ID field. You can also click the down arrow button to search for the 
carrier.  

3. Enter a description in the Description field.  

4. Click the Save button to save the carrier attachment to the Carrier screen. 

Zoom Configurations 
You can set your own Lytec MD Zoom screen settings using the Lytec MD Zoom - Configuration screen. 
To access this screen select the Configuration option from the Lytec MD Zoom File menu, or press 
CTRL+C. Select or enter the configuration information from each of the tabs and when you are done 
click Ok, to save your selected settings. See the Zoom Configuration Options section for a complete 
explanation of the configuration options. 

Zoom Configuration Options 
The following table offers detailed descriptions of the Lytec MD Zoom screen configurations. 

Configurations Description 

Folders and Files tab  

Scan Folder Enter the scan folder. You can also browse to the location of the 
Scan folder using the Browse button. 

File Prefix Enter the file prefix for newly scanned images. 

Loaded File Handling  

Delete Loaded Files Select this radio button to delete files after they have been 
loaded. 

Archive Loaded Files Select this radio button to archive files after they have been 
loaded. 

Archive Folder Select the file where the archived files will be stored. You can 
also browse to the location of the Archive folder using the 
Browse button. 

Archive Prefix Select the archive file prefix. 
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Default Titles tab  

Section Use this drop-down menu to select the different sections of the 
note. Once you have selected a section, enter the default title(s) 
in the corresponding box. 

Behavior tab  

Expanding explorer 
window 

Select this option to expand the Explorer Window when you 
move the pointer over the window. Un-select this option to 
keep the window the same size, even when you move the 
pointer over the window. 

Expanding image window Select this option to expand the image window when you move 
the pointer over the window. Un-select this option to keep the 
window the same size, even when you move the pointer over 
the window. 

Clear patient/insurance 
data after save 

Select this option to clear the Patient or Insurance data on the 
main screen after you have clicked Save. 

Clear note/attachment data 
after save 

Select this option to clear the Note or Attachment data on the 
main screen after you have clicked Save. 

Default Note Date  

Default note date to date of 
last file in list  

Select this option to use the date and time of the last file in the 
list of selected files as the default note date and time. This date 
will automatically be entered in the Date and Time fields of the 
note section. 

Default note date to current 
date 

Select this option to use the current date and time as the 
default date and time. This date will automatically be entered in 
the Date and Time fields of the note section. 

Default note date to last 
current date 

Select this option to use the last date and time used as the 
default date and time. This date will automatically be entered in 
the Date and Time fields of the note section. 

Clear note date Select this option to clear the note date on the main screen 
after you have clicked Save.  

Requirements tab  

 Select the requirements for the provider’s chart sections. These 
are the sections that will be required on the provider’s chart. 
Default requirements have been pre-selected. To change these 
requirements or to add new requirements select or un-select 
the check boxes. 

Fields and buttons on the Lytec MD Zoom screen 
The following table offers detailed descriptions of the fields and buttons on the Lytec MD Zoom screen. 

Field/Button Description 

Folder When the screen is in browse mode, you can select the folder 
where your files are stored. Use the Browse button to navigate to 
the folder where your files are stored. 

File When the screen is in browse mode, you can select the file where 
your document is stored. Use the Browse button to navigate to 
the file where your documents are stored. 
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Browse button Use the Browse button located next to the Folder and File fields 
to navigate to the folder or file where your document(s) are 
stored. 

Scan button Click this button to open the Lytec MD Zoom – Acquire Scan 
screen. See the Scan section for a complete explanation of this 
screen. 

Zoom Select the image's magnification level. The Zoom drop-down 
menu allows you to increase or decrease the selected documents 
magnification level. To return the document or image to fit in the 
image window, select the Fit option. 

Chart Note tab 

ID Enter the patient’s ID. The entered patient will have the note 
attached to their chart. Once a valid patient ID has been selected, 
the patient’s last name, first name, middle initial, social security 
number, and birth date will automatically be entered in the 
appropriate fields. 

Lookup button Click the Lookup button to open the Patient Lookup screen. 
From this screen you can select from a list of registered patients. 
See the Lookup section for a complete explanation of this screen.

Last Name Enter the patient’s last name. 

First Name, MI Enter the patient’s first name and middle initial. 

SSN Enter the patient’s social security number. 

Birth Date Enter the patient’s date of birth. 

Section Enter the section of the chart the note will be attached to.  

Title Enter the title of the note. You can enter a title, or you can select 
from a list of pre-configured and recent titles. See the Zoom 
Configurations section for details. 

Date Select the note’s date. You can enter the date, or click the down 
arrow button to access the calendar. You can configure a default 
note date using the Zoom Configuration options. See the Zoom 
Configurations section for details. 

Time Select the note’s time. 

Providers  Enter or select the provider’s you want to link to the note. You 
can enter up to four providers in the corresponding fields, or you 
can click the arrow button to open the Provider Select screen. 
See the Provider Select section for a detailed explanation of this 
screen. 

Note Text Enter the note’s text in the provided Note Text box. 

Patient Photo tab 

ID Enter the patient’s ID. The selected photo will be linked to the 
Patient screen. Once a valid patient ID has been selected, the 
patient’s last name, first name, middle initial, social security 
number, and birth date will automatically be entered in the 
appropriate fields. 

Lookup button  Click the Lookup button to open the Patient Lookup screen. 
From this screen you can select from a list of registered patients. 
See the Lookup section for a complete explanation of this screen.
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Last Name Enter the patient’s last name. 

First Name, MI Enter the patient’s first name and middle initial. 

SSN  Enter the patient’s social security number. 

Birth Date Enter the patient’s date of birth. 

Patient Attachment tab 

ID Enter the patient’s ID. The entered patient will have the file(s) 
attached to their patient demographic information. Once a valid 
patient ID has been selected, the patient’s last name, first name, 
middle initial, social security number, and birth date will 
automatically be entered in the appropriate fields. 

Lookup button  Click the Lookup button to open the Patient Lookup screen. 
From this screen you can select from a list of registered patients. 
See the Lookup section for a complete explanation of this screen.

Last Name Enter the patient’s last name. 

First Name, MI Enter the patient’s first name and middle initial. 

SSN Enter the patient’s social security number. 

Birth Date Enter the patient’s date of birth. 

Description Type a description of the file.  

Carrier Attachment tab 

ID Enter the carrier ID. The entered carrier will have the file(s) 
attached to the Carrier Maintenance. You can also click the down 
arrow button to access the Carrier Select screen. Once a valid 
carrier ID has been selected, the carrier’s name will automatically 
be entered in the Name field. 

Name Enter the carrier's name.  

Description Type a description of the file.  

Save button Click the Save button to save the note, photo, or attachment to 
the selected section in the chart. 

Clear button Click the Clear button to clear the previous note, attachment, or 
insurance information. You can use the Zoom configuration 
settings to permanently delete the note, or archive the note. See 
the Zoom Configurations section for details. 
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Order Entry 
Lytec MD Order Entry is a computerized physician order entry (CPOE) module for Patient Records. 
Order Entry can be used to electronically enter, review, and report on laboratory, radiology, pathology, 
and other diagnostic tests.  

Order Entry is designed to reduce data entry errors by replacing paper-based systems for writing 
diagnostic and treatment orders for patients. Electronic orders ensure that orders are legible, are 
actually completed, and are processed appropriately. Rather than just replacing a paper order with one 
entered on a computer, however, Order Entry can provide significant information at the time an order 
is created and on the history of an order. This information includes the patient’s insurance plan rules, 
order-specific diagnosis codes, order-specific patient and processor instructions, checking for 
duplicate orders, and user defined rules on the order’s appropriateness (based on diagnosis, 
laboratory values, medications, allergies, etc.).  

You can pre-load virtually every order possible into the system. New orders for patients are added 
through a simple interface that eliminates the need to type more than a few entries, or through the 
progress note using Dot codes. You can set up progress note templates to include order Dot codes, so 
that orders will be initiated automatically when the note is saved.  

You can set up provider-specific order trees that contain the orders the provider is most likely to 
initiate. The order tree is tailored to the provider’s personal preferences so that the most common 
orders are easy to find.  

You can also configure order sets that initiate several orders as a group at once. What this means is that 
a single order can initiate frequently used orders. You can enter an order set that is made up of a series 
of orders, instead of initiating each order separately for the patient.  

Additional Order Entry features include:  

• Both order trees and order sets can be configured to meet the specific needs of specialty 
providers.  

• Orders can require a pre-authorization from insurance carriers. These orders are not sent out 
until approved.  

• For each order, you can define when a stat or routine order becomes overdue. Using these 
values, Order Entry can track the order to make sure results are received when expected. You 
can run the Overdue Orders report to generate a list of overdue orders.  

• You can customize forms to match printed forms from various labs and facilities. You can also use 
an HL7 interface to electronically send orders to the processing facilities.  

• You can add cost information to orders. This information is displayed before the order is 
finalized, and can be printed and analyzed by using the Order Entry reports. You can also use 
reports to analyze turnaround times and orders for specific providers or patients.  

• You can create an order through a Dot code used in a progress note.  

• Order Entry’s audit trail automatically tracks the date, time, and signature of orders. 

• Autoissue, a standalone utility that processes future orders automatically when their dates come 
due. The utility is autoissue.exe and is found in \ppart\prwin. We recommend that you set this up 
in the Windows Scheduler to run automatically early in the morning. You can also run it from a 
command line (DOS) prompt as part of setting up future-order processing.   

Usual Order Entry workflow 
Lytec MD supports the entire order workflow, from the initial test order to the receipt and 
dissemination of the test results. An example of a typical order workflow is described below. In this 
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case, the order is issued through the progress note. The order can also be issued through the Orders 
screen. 

1. The provider orders a CBC while writing the progress note. The provider can either use the 
Orders button and select an order, or use QuickText or templates to bring in pre-written orders 
(using Dot codes). 
 
The provider can also initiate the order from the Orders tab of the patient chart, by selecting 
Task > New Orders when a chart is open, or from the Provider Orders screen.  

2. The order is created and becomes a Pending order, available to order processors. The order is 
automatically recorded in the progress note and populates the appropriate order review 
screen. 
In this example, the provider used Dot codes to issue the order. Depending on how Order 
Entry is configured, the following information will be pulled from the progress note (if the order 
was not initiated from a note, the information will be pulled from a note entered on the same 
day): 
• Diagnosis codes 

• Provider ID 

• Text for fields on the order’s extended screen 

3. The order processor receives the order. In this example, the processor is the provider’s nurse, 
who is also the phlebotomist. The processor can select orders by processor/operator ID, by 
provider, or by order type. 

4. The processor works through the order processing screens. When the order is complete, the 
processor can send the order, which will print the order and/or send it electronically to the lab. 

5. The lab receives the order (electronically or by paper) and sample. 

6. The lab processes the order and sends the results: 
• Electronically directly to Lytec MD through an HL7 interface, the lab data loader, or the 

text data loader. 

• Or by paper to the provider (not recommended). 

7. If the results were sent electronically, Order Entry updates the order and marks it as complete. 
If the results were sent by paper, the processor enters the results into the appropriate lab table 
or note section and marks the order as complete. 

8. The results are available in the provider’s lab or text review bin. 

9. At any time, you can run reports that indicate the orders that are pending, in process, 
completed, or overdue. You can also print analysis reports that show use and cost patterns. 

Order statuses 
You can assign one of the following statuses to orders: 

• Pending 

• Suspended 

• Sent 

• Approved 

• Completed 

• Denied 

• Cancelled 
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The order’s status determines, among other things, on what tab the order displays on the patient and 
provider review screens. Pending is the normal status for an order that has not yet been processed (for 
example, the sample has not been collected). Sent usually means the sample has been collected, but 
no results have been received. Suspended means that an order requires authorization, which has not 
yet been given. Approved means a suspended order (an order requiring authorization) has been 
approved and is similar to Pending.  Denied means that authorization has been denied.  Completed 
means the result or report have been received.  Cancelled means the order has been cancelled. 

A status of Partially Completed may be automatically assigned to an order that represents a “hidden” 
order set, where the order actually includes multiple items (tests), some of which may come back at 
different times (for example, a urine culture and sensitivity, or a panel). That is, some parts of the order 
may have been completed, while others are still Pending.  

Some basic rules for order statuses are: 

• There is no restriction on moving between Pending, Sent, and Completed. If you change an 
order status to Sent, it will normally result in a printed order slip and/or an electronic message. 

• You can change from Pending to Suspended. 

• When an insurance carrier requires an authorization for an order, the status is automatically set to 
Suspended. 

• You must have the appropriate access level to change an order to Denied or Approved. This is 
how order authorizations are enforced. 

• You must have the appropriate access level to change an order from Suspended, Denied, or 
Approved. This is how order authorizations are enforced. 

• An Approved status is similar to a Pending status. Once an order is approved, it can be 
processed. 

• A Denied status is similar to a Completed status. Once an order is denied, it will not be 
processed, so the order is moved to the Completed tab of the order review screen. 

• You cannot send a Completed or Partially Completed order, unless you first change the status to 
Approved, Pending, Suspended, or Denied. 

• If you change an order’s status to Denied, you can add a reason for the denial. 

• If you want to re-send an order with an initial status of Sent (that is, the order has already been 
sent), you need to change the status to Pending and then to Sent. 

• When you order an order that contains a hidden order set (this is an order that actually 
represents a number of orders from the point of view of the laboratory or other system – for 
example, a CBC that consists of a WBC, RBC, smear, etc., or a SMAC that includes K+, Na+, 
Creatinine, etc.), the status of the parent order (the name that is used for the order) will also 
initially be the status of all child orders (the orders that make up the set). For example, if the 
order is automatically marked as pending when you issue it, all child orders in the set will also be 
marked as pending. The reason hidden order sets are used is because the results for the 
different elements that make up the order may be received at different times, and Lytec MD 
needs to track when the entire order is actually complete. (Please note that there is a different 
kind of order set, the “visible” order set which is used as a convenient macro to order many tests 
at once). 

• For order sets, an "empty" order set that does not contain child orders cannot be issued. 

• Orders in a hidden order set must have a status of Sent before the order set can be marked as 
Completed. 

How Lytec MD marks orders as complete 
When an order result is received for a patient (through an interface or the data loader) and there is 
more than one non completed order for the same test for the patient, Lytec MD looks at the following 
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information to mark an order as complete: date/time the lab was drawn, the sending provider 1 ID, and 
the date/time overdue for the lab or the order ID. Then the following logic is used: 

1. Match on the order ID and mark the order complete (using .OC) 

--OR-- 

1. Matching sending provider 1 ID and within the date overdue date range. If not available, then... 

2. Within the date overdue date range. If not available, then... 

3. Matching sending provider 1 ID and within twice the date overdue date range. If not available, 
then... 

4. Within twice the date overdue date range. If not available, then... 

5. Most recent order with the matching send provider 1 ID. If not available, then... 

6. Most recent order. 

About issuing orders 
You can issue orders from within a progress note using the Orders button or Dot codes, from the 
Orders tab on the patient chart, and from the provider review screen. Your access level determines 
whether you can issue (add), edit, view, or delete orders. 

Your system administrator can configure Order Entry to: 

• Require a diagnosis code (or codes) for specific orders. 

• Warn you that you are not using the correct insurance diagnosis code for specific orders. 

• Require authorization for specific orders. 

• Check for duplicates. 

• Check order rules (which can check the patient’s medications, lab tests, diagnoses, allergies etc.) 
and then warn you, refuse to issue the order, or require authorization to issue the order. 

Issuing Orders from the Patient Chart or the Provider Review Screen 
Issuing orders from the patient chart and the Order Entry review screen is a similar process. When you 
access the Order tab of the patient chart, a review screen displays orders that are pending, in process, 
or completed for the specific patient. When you access the provider review screen, a review screen 
displays orders that are pending, in process, or completed for the specific provider (this list includes 
orders for all patients).  

To issue orders from a review screen, you simply click the New button to open the Order <New> 
screen. You will use this screen to enter information for the order.  

The Order screen uses an order tree to group orders and order sets together by  category (for 
example, immunization tests). You simply select the order from the order tree and move it to the box 
on the right side of the screen. Costs associated with orders or order sets are displayed in the box on 
the right.  

If a progress note for the patient has been entered on the same day that you issue an order, the Order 
<New> screen will be automatically populated with the following information, if it exists in the note: 

• Up to four diagnosis codes 

• Provider ID from the note’s .PV line 

• Encounter number (if you are using a scheduling interface) 
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A note about diagnosis codes  
If both a progress note and a shared note exist for the patient on the current day, and if both notes are 
in edit mode, Patient Records will use the note that has the provider ID associated with the order’s 
sending provider. If both notes have the same provider ID, Patient Records will retrieve the diagnosis 
codes from the shared note. 

The Order <New> screen will also be populated with the patient’s primary insurance carrier. The 
primary carrier is the carrier listed in the first column on the Patient screen’s Billing tab.  

Once the order is created, the progress note will be updated with the order’s name and other 
information. 

Issuing orders using Dot codes 
Order Entry provides six new Dot codes that simplify issuing orders from progress notes or through the 
Text Data Loader. For example, when you save a progress note that contains a new Dot code, Order 
Entry automatically creates an order using the Dot code information.  

You can use the Dot codes to add the following information to an order: 

• Order name – required 

• Urgency – routine, stat, do within x days 

• Up to two diagnosis codes 

• Up to four providers who should receive the order results – the sending provider is always the 
first provider of the progress note, based on the default (current) provider or the provider 
entered in the note’s .PV line. The current provider will also be automatically added to the “send 
to PVID” list 

• Name of the Lytec MD user who will process the order 

• Text for fields on the order’s extended dialog 

• ID for a referring source 

• Future dates to indicate that the order should be done in the future 

Only the order name is required. Depending on the Dot code that you use, you can enter the 
additional information that will populate the order screen. 

When you use the “do within xx days” option, you need to indicate only the number of days (in whole 
numbers). That is, instead of including the entire “do within xx days” phrase, you will simply use the xx. 

Order Entry provides the following Dot codes: 

• .OR: <<order name>> : <<urgency>> 

• .ORN: <<Caption Name>> : <<Value>> 

• .OR2: <<order name>> : <<urgency>> : <<Processor>> 

• .OR3: <<order name>> : <<urgency>> : <<Processor>> : <<Dx 1>> : <<Dx 2>> 

• .OR4: <<order name : <<urgency>> : <<Processor>> : <<Send To PVID1>> : <<Send To 
PVID2>>:<<Send To PVID3>>:<<Send To PVID4>> 

• .OR5: <<order name>> : <<urgency>> : <<Processor>>: <<Dx 1>> : <<Dx 2>> : <<Send To 
PVID1>> : <<Send To PVID2>>:<<Send To PVID3>>:<<Send To PVID4>> 

• .OR6: <<order name>> : <<urgency>> : <<Referral 
ID>>:<<Processor>>:<<Dx1>>:<<Dx2<<Send To PVID1>> : <<Send To PVID2>>:<<Send To 
PVID3>>:<<Send To PVID4>> 

• .OR7: <<order name>> : <<urgency>> :<<DoInXXX>>: <<Processor>>:<<Send To PVID1>> : 
<<Send To PVID2>>:<<Send To PVID3>>:<<Send To PVID4>> 
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• .OR8: <<order name >>: <<urgency>> :<<DoInXXX>>: <<Processor>>: <<Dx 1>> : <<Dx 2>> 
: <<Send To PVID1>> : <<Send To PVID2>>:<<Send To PVID3>>:<<Send To PVID4>> 

If the order is actually an order set, all child orders in the set must have the same extended dialog.  

If you do not use a Dot code to specify a sending provider or diagnosis codes (for example, .OR3, 
.OR4, and .OR5 include these values), they will be pulled automatically from the note if they exist. The 
sending provider will be pulled from the .PV line and will be automatically added to the “send to PVID” 
list, and the diagnosis codes will be pulled from the fist two .DX lines in the note. However, if the 
diagnosis codes or provider in the Dot codes are different from those in the note, the values in the Dot 
codes will be used to populate the order.  

You cannot use Dot codes to enter an encounter number, practice ID, or more than two diagnosis 
codes for orders. 

How orders are appended to notes 
If a patient has a progress note for the day that tests are ordered through Order Entry, the orders will 
be appended to the bottom of the progress note. That is, a list of orders will appear near the end of the 
note, after the prescription or Patient Education lines (these lines list any medications that were 
prescribed or Patient Education handouts that were printed for the patient that day). 

The format of the orders will depend on settings in Maintenance > Configuration > Special Features. 
Your options include displaying the orders horizontally or vertically, including the extended dialog, 
displaying the urgency for all orders, or displaying the urgency only for STAT orders. Examples of these 
options are provided below. 

Horizontally 

#Orders: CBC, CXray, U/A 

Vertically 

#Orders:  
CBC 
CXray 
U/A 

All urgencies, displayed vertically 

#Orders:  
CBC   [STAT] 
CXray   [Routine] 
U/A   [Do in 4 days] 

Only STAT urgency, displayed horizontally 

#Orders: CBC   [STAT], CXray, U/A 

Vertically, with extended dialog 

#Orders:  
Shoulder film 
CBC 
Shoulder film - additional information 
Reason for Xray: Fell off ladder 

Incorrect diagnosis code warning 
One of Order Entry’s many helpful features is the ability to enter insurance plan rules for specific tests. 
You can indicate whether a test requires authorization or can be done only for specified diagnoses. You 
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can also specify at which facility the test must be conducted, and which form is required by the carriers. 
For informational purposes, you can also enter carrier-specific costs. These insurance-specific values 
override the default values for the order (for example, if the default cost is $20 but the insurance cost is 
$15, the insurance cost will be used).  

Note: The cost is for reference purposes only. This is not necessarily the cost that will be used in 
MBWin. 

Order Entry uses the patient's primary insurance carrier or the selected insurance carrier to decide if an 
order requires a specific diagnosis code. If so, a message will appear. This message includes buttons 
that you can use to print a medical necessity form (also known as an Advance Beneficiary Notice, or 
ABN). An ABN notifies the patient that his or her insurance carrier will not pay for the test, and that the 
patient must assume financial responsibility for the service. An ABN prints for each order not covered 
by the insurance carrier. 

For patients with Medicare, you can automatically print Medicare numbers on the ABN. When directly 
entering orders, if the patient’s selected carrier has a claim type of Medicare, then the Insurance ID for 
that carrier will be printed. An alternative method is to have a user-defined field for the patient called 
Medicare # which will be used if there is no Medicare carrier. If entering orders using Dot codes, all of 
the patient’s carriers are checked for a carrier whose claim type is Medicare, and if one is found, that 
Insurance ID will be used. 

Your system administrator can also add settings to the ppart.ini file so that the order’s cost and date will 
print on the ABN. 

The ABN check is not available if you use the Text Data Loader to order procedures. 

Sending orders and receiving results 

Sending orders 
You can print individual orders on plain paper or paper forms to send to the processing facilities.  

You can also use an electronic interface to send orders to the processing facilities. An electronic 
interface provides speed and efficiency for processing orders, avoiding the re-entry of order data. 
Electronic interfaces are available for a variety of remote and internal laboratory, radiology, and other 
systems. By configuring an order with both paper and electronic forms, you can select to both print a 
form and send the order electronically if you need to form to accompany the patient sample. 

An order becomes sent when its status is set to Sent. You can do this individually by manually changing 
the status of an order (after the sample is collected for example), set up an order to become Sent as 
soon as it is ordered (for an order that does require a patient sample), or use an Order Entry report or 
utility to send many orders at once. 

Receiving test results 
If you are able to receive results electronically and load them through the Laboratory Data Loader or 
Text Data Loader, or through an interface, then the orders will automatically be marked as complete. 

In some cases, a single order (for example, Urinalysis) will be received as many separate components 
(Specific Gravity, Color, Urine Glucose, etc.). You should set up the order as a hidden order set with all 
components listed, if there is any possibility the components will not all be returned at once. In that 
case, the order will be properly marked as Completed or Partially Completed, based on whether all or 
some of the component results have been received. 

If you are receiving results from the processing facilities on paper and do not convert them to 
electronic format, you will need to manually enter the data into the associated lab table or note, and 
then mark the orders as Completed. 
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Receiving Results through the Text Data Loader 
Radiology, Pathology and other reports may be received in Lytec MD through the Text Data Loader. To 
mark the results as complete, a cross reference file must be created so that the title and type of the 
result can be linked to an Order Name. 

A cross-reference file is required if you want to use the Text Data Loader with Order Entry. Use a text 
editor to create a text-only (that is, ASCII) file named OEXREF.FL. The format for the file is: 

Result Title | Result Type | Note Type | Order Name 

Result Title is the value of the progress note's .T line. 

Result Type is the value of the progress note's .K line. 

Note Type can be left blank, or you can use a 0 (zero) to indicate progress note. 

Order Name is the name of the order that was issued. 

Receiving results through the Lab Data Loader 
The Lab Data Loader can easily automatically mark orders as complete. This avoids updating the status 
of orders manually.  

If the order names match laboratory test names, the orders are updated automatically in the Lab 
section of the patient chart.  

In addition to manually updated orders, you can use the Laboratory Data Loader to update orders. If 
the order names match laboratory test names, the orders are updated automatically in the Lab section 
of the patient chart.  

If order names and laboratory test names do not match, you can create a cross-reference file that links 
the order name with the laboratory data name. To do this, create a file named OELABXREF.FL with any 
text editor that can create a text-only (that is, ASCII) file. The file should contain a table in the following 
format:  

Lab Name | Order Name  

Lab Name is the name of the lab table item, or the first 18 characters of the note title. When the results 
of a lab test satisfy an order, the order will be updated automatically.  

Viewing orders and results 
Once you (or anyone in the Lytec MD system) enters an order, the order is automatically tracked in 
Order Entry. You can open the patient’s chart to review all pending, in process, and completed orders 
for the patient. You can also view all pending, in process, and completed orders that have been added 
by a specific provider. Finally, you can view pending orders for a specific processor (a Lytec MD user 
who processes orders) or order type, or for other criteria such as order status and dates. 

Orders that have not been started display on the review screen’s Pending tab. Orders that are currently 
being processed display on the In Process tab. Orders that have been completed (or that have been 
denied by the authorization process) display on the Completed tab.  

From the provider review or processor screen, you can print a copy of the order, print the order’s 
patient or operator instructions, change the order’s status, and electronically send the order. 

Your access level determines what information is available to you on the review screens, and what 
functions you can perform. For example, you may have access to add an order from the provider 
review screen, but not to edit or delete an order from this screen. 
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Setting up an Order Entry printer  
You must set up a default printer for Order Entry if you want to print copies of orders, order reports, 
and other Order Entry information.  

For some tasks, the user can override the default printer at print time by changing the printer on the 
familiar Windows Print screen (if this option is configured on the Printer Configuration screen). For 
example, the report printer can be changed. However, we recommend that you set up Order Entry to 
print the actual orders and labels without bringing up a Windows Print screen, to save time for 
providers and to make sure that the correct printers are used.  

Order Entry utilities 
To help you manage your orders, Lytec MD provides the following Order Entry utilities: Send Electronic 
Orders and Change Order Status. 

About Order Entry reports and analysis  
Order Entry provides several built-in reports that you can use to monitor ordering benchmarks. For 
example, you can print statistical reports that include:  

• Number, type, and status of orders for specific provider (who’s ordering what tests)  

• Number, type, and status of orders for specific patients  

• Turnaround times for processing orders (how long tests take to be completed)  

• Tests that are overdue  

You can also print financial reports that indicate spending and cost patterns.  

You can change the status of pending and approved orders to sent when you print them.  

The available reports are: 

• Standard order report  

• Custom order report  

• Order analysis report  

• Overdue orders report  

Configuring Order Entry  
Before you can use Order Entry, you need to configure it to meet your specific needs. The list below 
pinpoints the steps to take to set up Order Entry. 

• Review (and change if necessary) the settings on the Order Entry 1 tab (Maintenance > 
Configuration > Special Features). 

• Add order names (test and procedure names)  

• Link insurance carriers to orders  

• Add orders to create order sets  

• Link carrier-specific diagnosis codes to orders  

• Add cross-references to orders  

• Add order instructions for patients and processors  

• Add order facilities (facilities that will process the orders)  

• Add order types (used only in reports to group orders together)  
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• Add order categories (used in order trees and when issuing orders to group orders together)  

• Add extended order screens (used to add user-defined fields to orders)  

• Add order trees (a list of default or provider-specific orders)  

• Add custom order forms (you can create forms to match printed forms from various labs and 
facilities)  

• Use the Autoissue utility to process future orders automatically when their dates come due. The 
utility is autoissue.exe and is found in \ppart\prwin. You can run it from a command line (DOS) 
prompt as part of setting up future-order processing. 

Order Entry: issuing and editing orders 
Note: You can also issue orders through progress notes by using Dot codes. 

To open the Orders screen: 

• When a chart is open, click the Orders button in the toolbar or select Task > New Orders. You 
can also click the Orders tab on the Patient Chart. The Orders screen appears. 

Note: If a patient chart is not open, you can add an order through the Provider Orders screen. Select 
Task > Orders > Provider Orders. On the Provider/Practice selection screen, select the appropriate 
provider and practice, and then click the OK button. The Provider Orders screen appears. Click the 
New button. The Lookup screen appears. Select the appropriate patient. The Order <New> screen 
appears.  

To issue an order: 

1. On the Orders screen, click the New button. The Order <New> screen appears. 

2. To add an order, navigate through the order tree, select an order, and click Add. The selected 
order is added to the Queue pane (in the bottom right of the screen) with the settings you 
specified in the Details pane. If you want, you can complete the fields in the Details pane at the 
top of the screen before entering a new order. Repeat this step to add more orders. 

3. To edit an order's details, select it in the Queue pane, and then edit the information in the 
Details pane. 

4. To add or edit patient instructions for an order, select it in the Queue pane, and then type the 
instructions in the Patient Instructions box. Select the Print check box located above the box 
to print the instructions for the order. 

5. To add or edit operator instructions for an order, select it in the Queue pane, and then type the 
instructions in the Operator Instructions box. You can select the Print check box located 
above the box to print the instructions for the order. 

6. To remove an order, select it in the Queue pane, and then click the Remove button. 

7. If you want an order to repeat, select it in the Queue pane, click the Repeat button, and 
complete the fields in the Repeating Order screen. 

8. If you want to backdate the order or create a future order, click the Set Date/Time button, 
enter an order date and time, and then click OK. 

9. When you are finished, click the OK button. 

Note: A message appears if you order a visible order set that does not contain any child orders 
(orders in the order set). 
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8. If an insurance carrier linked to the order requires a specific diagnosis code and the correct 
diagnosis code was not selected, a message asks you to either select the correct diagnosis 
code, print a medical necessity form (ABN), or return to the Order <New> screen.  

9. If the signature feature is turned on, the Enter Signature screen may appear. Type your 
signature and click the OK button.  

10. If rules apply to any of the orders selected, you will see messages resulting from the rules and 
some of your orders may need revision or authorization.  

To change an order: 

• On the Orders screen, highlight the order that you want to change. Click the Edit button. On the 
Order <Edit> screen, make the appropriate changes. You can change everything except for the 
order’s diagnosis codes. When you finish, click the OK button. 

Note: If a patient chart is not open, you can select the order you want to change from the list on the 
Provider Orders screen. Select Task > Orders > Provider Orders. On the Provider/Practice selection 
screen, select the appropriate provider and practice, and then click the OK button. The Provider 
Orders screen appears. This screen displays orders for the current date. To select an order from a 
different date, click the Select button and change the date criteria. When you've located the order, 
click the Edit button. 

To delete an order: 

• On the Orders screen, highlight the order that you want to delete. Click the Delete button. A 
message asks you to confirm the deletion. Click the OK button. 
 
If you are deleting an order that is part of a repeating order set, a message asks whether you 
want to delete only the selected order or all orders in the set. If you choose to delete all orders, 
all future orders (orders with today's date or later) in the set will be deleted. 

Note: If a patient chart is not open, you can select the order you want to delete from the list on the 
Provider Orders screen. Select Task > Orders > Provider Orders. On the Provider/Practice selection 
screen, select the appropriate provider and practice, and then click the OK button. The Provider 
Orders screen appears. This screen displays orders for the current date. To select an order from a 
different date, click the Select button and change the date criteria. When you've located the order, 
click the Delete button. 

Fields and buttons on the Order screen 
Some of the fields below are not available or are read-only depending on whether you are adding or 
editing an order (indicated in the Mode column). 

Field Mode Description 

Details pane add, 
edit 

The fields in the Details pane, located at the top of the screen, specify 
settings for orders. 
When orders are added from the Order Tree to the Queue pane, they 
inherit the details currently specified in the Details pane. 
When an order is selected in the Queue pane, its name and details are 
displayed in the Details pane. Changing values in the Details pane when 
an order is selected in the Queue pane will update that order only. 
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Insurance add, 
edit 

If insurance information has been entered for the patient, the patient's 
primary insurance carrier displays in this field or it is blank, depending 
on the setting on the special features screen. You can select any of the 
patient's insurance carriers by clicking the drop-down arrow. This will be 
the insurance used for all of the orders. 

Urgency add, 
edit 

Indicate the urgency level for this order: 
 STAT 
 Routine 

 Do within [#] days 

Note: You can assign different urgencies to each procedure in the 
order. To do this, you must select the urgency before moving the 
procedure from the order tree. For example, you want the CBC to have 
an urgency of STAT and the hematocrit to have an urgency of Routine. 
Click the STAT radio button, then move CBC from the order tree to the 
selected order list. Then click the Routine radio button, and move 
hematocrit to the selected order list. Note that the urgency displays in 
the selected order list. 

Do in [xx] days add, 
edit 

Select this check box if you want the order issued in a specific number 
of days, that is you want the order to be issued in the future rather than 
today. For example, if you select "Do in 6 days", and then select "Do 
within 4 days" as the urgency, the order will be issued after 6 days and 
should be done within 4 days after that. 

Ordered by add, 
edit 

The current provider defaults in this field. Change the provider ID if 
necessary to display the provider who ordered the procedure.   

Facility add, 
edit 

Select the facility to be used for the order. If there is a facility tied to the 
selected insurance, the facility will be displayed in this field. The 
selected facility will override the facility defined in the Order Name 
screen and the Order Insurance screen. If you want to manually set the 
facility used for a group of orders, set this field before any orders are 
selected.  
Please note only facilities with an Active status will be displayed as an 
option. 

Print Default 
Label 

add Mark this check box if you want the default label (as defined on the 
Special Features screen) to automatically print when you save this order.

Practice add, 
edit 

If necessary, select the appropriate practice. 

Send Results 
to 

add, 
edit 

Select up to four providers who should receive the results of the 
procedure. The first field defaults to the selected provider in the Order 
by field.  

Encounter # add, 
edit 

If you are using an interface to another system, type an encounter 
number for the order(s). 

Diagnosis add, 
edit 

Select up to four diagnosis codes for the order(s).  
If the Diagnosis required check box was marked when the order name 
was added, you must select at least one diagnosis code. 
If a carrier-specific diagnosis code has been linked to the order, a 
message will display if you do not select the appropriate diagnosis code 
as required by the insurance carrier for the procedure. 
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Processor add, 
edit 

Click the arrow to open the Operator Select screen. Selections made for 
Processing Operator for Orders on the Records tab of Provider 
Maintenance control what operators are available for selection.  

Note add, 
edit 

Type a text note related to the order(s). 

Overdue 
Date/Time 

edit These fields indicate the date and time the order is overdue. 

ABN Signed edit You can use this field to indicate whether the patient signed a medical 
necessity form (also known as Advance Beneficiary Notice, or ABN) if 
the patient's insurance company will not pay for the test. 
A setting on the Special Features screen defines whether a screen that 
verifies that the patient signed the ABN should display when an ABN is 
printed.  

Referred To edit This field displays the referring source for the order. Click the drop-
down arrow to select a different referring source. 

Patient 
Instructions 

add, 
edit 

Type new instructions or modify existing instructions that can be printed 
for the patient for the selected order. Instructions can be up to 1000 
characters long.  
In addition to typing the instructions, you can link to an outside text, RTF 
(rich text format), HTML file, or web address. See the About Order 
Instructions section for details.  
To print the instructions, select the Print check box above the 
instruction's box. All patient instructions for the order(s) being placed 
will be printed in one document when the Order screen is closed. The 
instructions for the order will appear below the patient's name and 
order name in the printed document.  

Operator 
Instructions 

add, 
edit 

Type new instructions or modify existing instructions that will be 
displayed to or printed by the operator who processes the selected 
order. Instructions can be up to 1000 characters long.  
In addition to typing the instructions, you can link to an outside text, RTF 
(rich text format), HTML file, or web address. See the About Order 
Instructions section for details.  
Select the Print check box above the instruction's box to print the 
operator instructions. All operator instructions for the order(s) being 
placed will be printed in one document when the Order screen is 
closed. The operator instructions for the order will appear below the 
patient's name and order name in the printed document.  
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Order Tree add If there is a current provider, the order tree for that provider displays. 
Otherwise, the default order tree displays. 

Use the order tree to select the orders to add. Click   to expand the 
list. 

 To add an order: Highlight the order in the Order Tree, and 
then click the Add button. The order is added to the Queue 
pane on the right. 

 To remove an order: Highlight the order in the Queue pane 
and then click the Remove button. 

You can add an order multiple times. This is especially helpful if you use 
the do in xx feature (for example, you want a hematocrit run now and in 
five days). 
You must first select the urgency (stat, routine, do within xx days, or do 
in xx days) before you add the order. 

Lookup 
button 

add Click this button if you want to search for a specific order, without 
manually looking through the order tree.  

Queue Pane add Located in the bottom right of the screen, the Queue pane lists the 
orders that have been added to the current order. Click an order to view 
and edit its details in the Details pane. 

Order Set 
Cost 

add Total cost of the procedures in the currently selected order. 

Total Cost add Total cost of the procedures in all order listed in the Queue pane. 

Requirements edit When viewing or editing an order, this field displays the requirements 
for that order. Requirements can also be viewed on processing screens 
by clicking the Requirements button, or by right-clicking on an order 
and selecting Requirements. 

Extended 
button 

add, 
edit 

If the currently selected order has an extended dialog, click this button 
to view the dialog and edit the extended information. 

Repeat button add After you've added an order, click this button if you want to make the 
order a repeating or recurrent order. Criteria you enter on the 
Repeating Orders screen applies to the second and subsequent orders. 
Repeat orders inherit other settings from the original order. 

Process Info 
button 

add, 
edit 

Click this button to enter or view processing information for the order. 

Set Date/Time add, 
edit 

This button is available only if you have the appropriate access level 
(Order Date). 
Click this button if you want to backdate an order, or create a future 
order. You can set past or future dates and times. 
This feature is not available for completed or cancelled orders. 
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Order Entry: viewing orders 
Use either Order Processing Select or Overdue Orders to process outstanding orders.  

Several tasks can be selected by right clicking on an order or orders. For example, from the patient 
chart view, the right click options are send the order, print a copy, print a label, view the status, view 
process information, view the order's history, and view a list of orders in a repeating order set. See the 
Right-click menu options section for a complete explanation of the order review right-click menu 
options. 

Lytec MD uses the following logic to determine which order label should print, if Print Label is selected 
from the right-click menu: 

1. The insurance-specific order label prints, if one exists. If not... 

2. The facility-specific label for the order's default facility prints, if one exists. If not... 

3. The label for the order type prints. 

You can also select multiple orders, so that you can perform an action on all selected orders (print, 
change status, and so on). To select contiguous orders, clicking the first order, press and hold SHIFT, 
then click the last order.  
 
To select non-contiguous orders, press and hold CTRL while you click each order.  

When changing the status of multiple orders, all orders must be qualified to have their statuses 
changed. A message will display if Lytec MD cannot change the status of one or more of the selected 
orders. In this case, no statuses will be changed, and you will need to re-select the orders. 

Viewing orders for patients 

To view pending, in process, and completed orders for a patient: 

1. When the patient's chart is open, click the Orders tab. The Orders screen appears. 

2. From this screen, you can: 
• Add orders: Click the New button. The Order <New> screen appears. 

• Edit orders: Highlight the appropriate order in the table and click the Edit button. The 
Order <Edit> screen appears. 

• View orders: Highlight the appropriate order in the table and click the View button. The 
Order <View> screen displays the order's information, except for the procedures in the 
order. You cannot make changes to this information. 

• Delete orders: Highlight the appropriate order in the table and click the Delete button. A 
message asks you to confirm the deletion. 

3. To filter the orders that appear on this screen, click the Select button. Use the Select Orders 
screen to filter the orders that you want to view. 

4. To view repeating orders, highlight a repeating order and click the List button (or right click on 
the order and select List). The Repeating Orders for screen displays all repeating orders in the 
recurring order set.  
 
The Pending tab displays only the first order in the recurring order set. The In Process and 
Completed tabs display all orders in the set that are in process or completed. 

5. When you finish, click the OK button. 
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Viewing orders for processors 

To view pending, in process, and completed orders for a processor: 

1. Select Task > Orders > Order Processing. The Order Processing Select screen appears. 

2. Use this screen as a filter to select which orders you want to view. Your options are: 

Note: You must select at least one of the following options: operator, ordering provider, order type. 

Operator 

• To view orders for all operators, leave this field blank. 

• To view orders that have been assigned to you, click the arrow. 

Ordering Provider 

• To view orders for all providers, leave this field blank. 

• To view orders for a specific provider, click the arrow. On the Provider Select screen, 
select the appropriate provider and click the OK button. 

Practice 

• To view orders for all practices, leave this field blank. 

• To view orders for a specific practice, select the appropriate practice from the drop-down 
list. 

Order Type 

• To view orders for all order types, leave this field blank. 

• To view orders for a specific order type, select the appropriate type from the drop-down 
list. 

Order Status 

• To view orders with a status of Pending and Approved, leave this field blank. 

• To view orders for a specific status, select the appropriate status from the drop-down list. 
The available statuses are Pending, Sent, Suspended, Partial, Approved, Denied, 
Cancelled, and Completed. 

Dates 

• In the date fields, select the range of dates for which you want to view orders. When you 
select a starting and ending date, all orders created between those dates that meet the 
other criteria you set will display. 

3. When you finish, click the OK button. The Order Processing screen appears. This screen 
displays the orders that meet the criteria you selected. You cannot edit orders from this screen. 
 
For each order, the information that displays includes: 
• Date the order was entered 

• Time the order was entered 

• Patient name 

• Patient ID 

• Order name 

• Status 

• Repeat (a Y in this column indicates the order is recurrent/repeating) 

4. To process an order, click the Edit button to view the order. Then close the order screen to 
return to the Order Processing screen. Right click the order and select Status. You can also 
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print instructions or send the order electronically (if your system is set up to do this) by right 
clicking on the order. 
 
If you have the appropriate access level and you change an order’s status to denied, you can 
add a reason for the denial. 

5. To view the order's history, right click the order and select History. 

6. To change the orders that display, click Select. Choose the search criteria from Select Orders. 

7. To view the requirements for the orders, click the Requirements button. The Order 
Requirements screen displays requirements for orders with the same patient, status, and type. 

8. To print a standard order form for a patient, click the Forms button. The Standard Orders 
Printing Select screen appears. 

9. To view repeating orders, highlight a repeating order and click the List button (or right click on 
the order and select List). The Repeating Orders for screen displays all repeating orders in the 
recurring order set. 
 
The Pending tab displays only the first order in the recurring order set that meets the date 
criteria you specified on the Select Orders screen.  

10. To view processing information for the orders, click the Process Info button. 

11. When you finish viewing the orders, click the OK button to close the order review screen. 

Viewing orders for providers 

To view pending, in process, and completed orders for a provider: 

1. Select Task > Orders > Provider Orders. On the Provider/Practice selection screen, select the 
appropriate provider and practice, and then click the OK button. The Provider Orders screen 
appears. This screen displays orders for the current date. To select an order from a different 
date, click the Select button and change the date criteria. 

2. From this screen, you can: 
• Add orders: Click the New button. The Order <New> screen appears. 

• Edit orders: Highlight the appropriate order in the table and click the Edit button. The 
Order <Edit> screen appears. 

• View orders: Highlight the appropriate order in the table and click the View button. The 
view screen displays the order's information, except for the procedures in the order. You 
cannot make changes to this information. 

• Delete orders: Highlight the appropriate order in the table and click the Delete button. A 
message asks you to confirm the deletion. 

Note: The process for adding, editing, and viewing orders from the Providers Order screen is similar to 
the process from the Orders tab in the patient chart. 

3. To filter the orders that appear on this screen, click the Select button. Use the Select Orders 
screen to filter the orders that you want to view. 

4. To view processing information for the orders, click the Process Info button. 

5. To view repeating orders, highlight a repeating order and click the List button (or right click on 
the order and select List). The Repeating Orders for screen displays all repeating orders in the 
recurring order set. 
 
The Pending tab displays only the first order in the recurring order set. The In Process and 
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Completed tabs display all orders in the set that are in process or completed that meet the 
date criteria specified on the Select Orders screen. 

6. When you finish, click the OK button.  

Viewing overdue orders 
Use Overdue Orders to view overdue orders and process them if needed.  

To view Overdue Orders: 

1. Select Task > Orders > Overdue Orders. The Select Orders screen appears. 

2. Use this screen as a filter to select which orders you want to view. See the Viewing orders for 
processors section for a complete explanation of these options. 

Note: You must select at least one of the following options: operator, ordering provider, order type. 

3. When you finish, click the OK button. The Overdue Orders screen appears. This screen displays 
the overdue orders that meet the criteria you selected.  

For each order, the information that displays includes: 

• Date the order was entered 

• Time the order was entered 

• Patient name 

• Patient ID 

• Order name 

• Status 

• Provider ID 

• Repeat (a Y in this column indicates the order is recurrent/repeating) 

4. To modify an order, click the Edit button. See the Order Entry: issuing and editing orders 
section for a complete explanation. 

5. To view the order's history, right click the order and select History. 

6. To change the orders that display, click Select. Choose the search criteria from Select Orders. 

7. To view the requirements for the orders, click the Requirements button. The Order 
Requirements screen displays requirements for orders with the same patient, status, and type. 

8. To print a standard order form for a patient, click the Forms button. The Standard Orders 
Printing Select screen appears. 

9. To view repeating orders, highlight a repeating order and click the List button (or right click on 
the order and select List). The Repeating Orders for screen displays all repeating orders in the 
recurring order set. 

10. The Pending tab displays only the first order in the recurring order set that meets the date 
criteria you specified on the Select Orders screen.  

11. To view processing information for the orders, click the Process Info button. 

12. When you finish viewing the orders, click the OK button to close the order review screen.  
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Buttons and commands on Order Processing Select and 
Overdue Orders 
The following table shows the buttons located on Order Processing Select and Overdue Orders. 
Because the buttons differ on each of the screens, the Available On column lists the screens which have 
the listed button. 

Button Available On Purpose 

Close • Order Processing 
Select 

• Overdue Orders 

Close the dialog box. 

Note: Select Orders has more options when 
opened from Order Processing Select than 
Overdue Orders. Close Overdue Orders to use 
the additional options from Order Processing 
Select. 

Edit • Order Processing 
Select 

• Overdue Orders 

Process a selected order using Order. 

Select • Order Processing 
Select 

• Overdue Orders 

Change the search criteria using Select Orders. 

Note: Select Orders has more options when 
opened from Order Processing Select than 
Overdue Orders.   

Process Info • Order Processing 
Select 

• Overdue Orders 

View order processing information using 
Processing Extended Dialog. 

Requirements • Order Processing 
Select 

Display Order Requirements. 

Forms • Order Processing 
Select 

Print a standard order form using Standard Orders 
Printing Select. 

List • Order Processing 
Select 

Display all repeating orders in the recurring order 
set. 

Note: This button is only enabled when the 
highlighted order is a repeating order. 

Right-click menu options 
Several tasks can be selected by right-clicking on an order or orders from any of the order review 
screens. The following table offers an explanation of these options. 

Option Purpose 

Send Select this option to send the order to the printer. 

Print Copy Select this option to send a copy of the order to the printer. 

Print Label Select this option to print a label for the order. 
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Status Select this option to change the order's status. Select the status from 
the list and click OK. The new status will be displayed in the order 
review screen's Status field. 

Process Info Select this option to view order processing information from the 
Processing Extended Dialog screen. This screen displays the user-
defined processing information fields associated with the selected 
order. Fill in the appropriate information, and click OK. 

History Select this option to view the order's history. The history information 
includes the order ID, who it was ordered by, the order's current 
status, and the date and time ordered. If the order is overdue, the 
overdue date and time is also displayed.  

List Select this option to view all repeating orders in the recurring order 
set. To delete an order, highlight the order in the list, and click 
Delete.  

Note: This option is only enabled when the selected order is a 
repeating order. 

Requirements Select this option to view order requirements from the Order 
Requirements screen. This screen displays requirements for orders 
with the same patient, status, and type.  

Print Requisition  Select this option to print a requisition form for the order. The 
requisition form will print from the Order Requisitions printer.   

Print Operator Instructions Select this option to print operator instructions. 

Print Patient Instructions Select this option to print patient instructions. 

Show Group Select this option to automatically view grouped orders (based on 
the same patient, facility and processing dialog) from the Grouped 
Orders screen. To send the grouped orders, click OK. This will 
display the Processing Extended Dialog screen. Enter the 
appropriate information, and click OK. This will return you to the 
Order Processing Select screen. The status for the orders in the 
group are changed to "Sent".  
To remove an order from the group, highlight the order in the list, 
and click Remove.  

Note: This option is only enabled when the selected order is a part 
of a group. 

Group You can select individual orders you want to group, by clicking on 
the order, holding down the CTRL key, then clicking on additional 
orders one at a time. The orders in the group need to share the 
same patient, facility and processing dialog.   
Select this option to process the selected items as a group. When 
selected, the Processing Extended Dialog screen is displayed. Enter 
the appropriate information, and click OK. This will send the orders 
and return you to the Order Processing Select screen. The status for 
the orders in the group are changed to "Sent". 

Note: This option is only available from the Order Processing Select 
screen. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 876 

 

Provider Schedule 
If Lytec MD Appointment Scheduler is installed, you can use the Provider Schedule feature to view 
provider schedules, find patient appointments, and open patient charts for scheduled patients.  

If you are using Appointment Scheduler Enterprise, users can view schedules only for the practices 
their operator settings allow.  

Type of visit and status codes can be configured to display in color. You can use this feature to quickly 
identify each appointment's type and status. 

Viewing the provider schedule 
To open the provider schedule screen: 

1. If your system is configured to show the provider schedule, select Task > Provider Schedule, or 
click the Schedule button on the tool bar. 

2. If you did not enter a provider ID at some point in your current Patient Records session (for 
example, when you signed in), you must do so now. That way, Patient Records will know which 
provider’s schedule to display. Enter the ID in the Provider ID field, and then click the OK 
button. 

Note: After you enter a provider ID, it remains active until you change the ID or blank it out. 

3. The main Schedule for <provider> screen displays information about each scheduled patient. 
Following is a description of each column in this screen. 
• Time – Appointment time 

• ST – Appointment status code, for example, LA for late, NS for no-show, BL for blocked-
out, etc. 

• TOV – Type of visit code 

• Len – Visit length 

• Name – Name of the patient 

• ID – Patient ID 

• Room – Room for which the visit is scheduled 

• Reason – Reason for the visit 

4. To find a patient's appointment, click the Find button.  

Changing the calendar display: 
There are several ways to change which days display on the Schedule screen. 

To switch days: 

• On the provider schedule screen, you can quickly move between calendar dates by clicking the 
arrow keys. Click the left arrow to move one day back. Click the right arrow to move one day 
forward. 

To view the entire calendar: 

1. On the provider schedule screen, click the Calendar button to display an entire month’s 
schedule for the current provider. Days for which the provider is scheduled are highlighted. 
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2. To change the month, select a month from the drop-down list. To change the year, click the 
year list box. 

3. To view schedule detail for a day, double-click the appropriate date. The Schedule screen 
appears. 

Selecting a visit slot and opening a patient chart 
To select a visit slot and open the associated patient chart: 

1. On the provider schedule screen, highlight the appropriate visit slot. When you first display the 
screen, the slot closest to the current time is highlighted. Double-booked slots display with a 
green highlight. 

2. Click the OK button or double-click on the slot. The patient chart for the scheduled patient 
appears. 

Viewing appointment notes 
To view the appointment note for an appointment: 

1. On the provider schedule screen, select the appointment. 

2. Click the Note button. The Appointment Note screen appears. 
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Reviewing data 

Lab Table Review 
The Lab Table Review feature enables you to review laboratory test results for one or more patients. 
You can sign the lab test results and forward them to other providers so that they can review and sign 
the test results, as well. 

You can see a list of all patients whose lab needs reviewing. You can also change the sequence in 
which you view lab data. While you are viewing lab data, you can also view any progress notes linked to 
that lab data, or look at the patient chart. 

You can add a progress note related to lab results by clicking the Note button in the toolbar. Your 
system administrator can use a setting on the Special Features screen to specify a default lab review 
note template that will automatically display in the note. 

Note: If no provider code is assigned to the loaded laboratory data, all usual providers will receive the 
results in their lab tables for review. If there are no usual providers specified, then the primary provider 
will be sent the results if the primary provider is internal. When there is no provider code in the lab 
data, no usual providers for the patient and no internal primary provider specified for the patient, an 
error is written to the error log and the laboratory data will not be sent for review. 

Accessing the Lab Table Review screen 
To access Lab Table Review:  

• Select Task > Review Data > Lab Tables, or hold down your left mouse button while clicking the 
Review button on the tool bar and select Lab Tables. The Lab Table Review screen appears.  

When there are multiple lab tables for a patient, this screen displays "First for Patient" on the first lab 
table and "Last for Patient" on the final lab table. 

 

Note: The Recently Reviewed submenu located under the File menu will show up to 99 patients 
whose lab results, progress notes, or documents were most recently reviewed by the operator. This list 
is lost when the user parks or exits the system. 

Viewing Lab Data Tables When Reviewing Lab Results  
To view the laboratory data table:  

• Double-click the laboratory test result, or select the test result and press ENTER. The Laboratory 
Data Table appears.  

Note: The ppart.ini setting Lab_Chart under the [ReviewData] data section must be set to Yes for this 
feature to work. 

Viewing the list of All Lab Tests to Review  
To view the list of all lab tests to review:  

1. Click the List button. The List For Labs To Review screen appears.  
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2. From the table, select the patient whose lab tests you want to review.  
 
Each row displays the date and time of the lab tests, as well as the patient name and ID. Use the 
scroll arrows to scroll up or down the list.  

Note: The List for Labs to Review screen displays critical tests in red. Critical tests are defined as those 
with abnormal values.  

3. Click the OK button or double-click the lab. The Lab Table Review screen displays the lab 
template that you selected.  

Viewing Progress Notes 
You can use the Link button to open the most recent note for the patient whose chart is currently open 
(accessed through the Open Chart button). Note that this chart may not be for the patient whose lab 
data is currently displayed. 

To view the most recent progress note:  

• Click the Link button on the toolbar. The most recent note displays. If no note exists, you are 
prompted to create one. 

Changing the Order of Test Results that You Want to View  
To change the order of the test results that you want to view:  

1. Click the Select button. The Select Results To Review screen appears.  

2. In the Date Range fields, you can enter starting and ending dates. By default, the starting date 
is not set and the ending date is the current system date. The default settings will display all Lab 
Review templates that have not been reviewed, up to the current date.  

3. By default, the Order By Most Recent check box is selected. This option displays the templates 
in the order of most recent to the oldest template. If you want to view the templates from the 
oldest to the most recent, clear this check box.  

4. By default, the Group by Patient radio button is selected. This option will display all of one 
patient’s labs to review before displaying the lab results for the next patient.  
You can select the Group by Test Name option to group the lab results by test name. The 
results will be grouped by the name of the Lab Review template. The data is shown in 
alphabetical order based on the template name. 

If you do not want to group the lab results by patient or test name, but instead want to view the 
results in strict chronological order, select the Do Not Group radio button.  

5. By default, the All Data radio button is selected for the Status. All tests for the patient will be 
displayed.  
• If you mark the Abnormals radio button, the Lab Table Review will display only patient lab 

tests that have the status of A or B.  

• If you mark the STAT radio button, the Lab Table Review will display only patient lab tests 
that have the status of S or B.  

6. When you finish, click the OK button. The Lab Table Review screen will reflect the changes you 
selected.  
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Displaying the patient chart when reviewing data  
As you review laboratory data, you can display the patient chart for the patient whose data you are 
reviewing by clicking the Open Chart button on the Lab Table Review screen.  

As an alternative, you can automatically display the patient chart as a minimized screen as soon as you 
access the Lab Table Review screen. You can view the chart by maximizing or restoring the screen or 
selecting the patient chart from the Window menu. Closing the progress note automatically restores 
the patient chart screen.  

Note: Your system administrator can configure how the patient chart displays as you review data.  

Signing lab table results 
To sign lab table results:  

1. After you have reviewed the test result set and you are ready to sign it, click the Sign button 
and enter your electronic signature, if required. Then click the OK button.  
 
If you do not want to sign a particular test result set, just click the Skip button. Later, you can 
click the Previous button to view and sign the unsigned test results that you skipped.  

2. When subsequent test results display, click the Sign button. Patient Records automatically 
applies the electronic signature for you.  

Forwarding Lab Results to Another Provider  
Your system administrator can use a setting on the Special Features screen to require the original 
provider to sign the lab before forwarding results to another provider. 

To forward lab test results to another provider:  

1. Click the Forward button.  

2. Enter or select a provider, then click the OK button.  

Sending lab results via messaging 
You can link directly to the messaging system from the Lab Data Review screen, and can send lab 
results via a message. 

To link to the messaging system: 

1. Click the Msg button. A new message displays, with the current patient's information already 
filled in. A default lab review template for the message can be specified on the Special 
Features screen.  

2. Enter the message's recipients, and add any additional information or notes. Then click the 
Send button. 

Displaying the patient's Lab Data Tables and Most Recent 
Labs 
You can display the patient's lab data tables and most recent labs when reviewing the patient's 
laboratory results by clicking the corresponding buttons on the Lab Table Review screen.  
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To view a patient's lab data tables: 

• On the Lab Table Review screen, click the Lab Table button. The patient's chart opens to the 
Laboratory Data Table screen.  

To view a patient's most recent labs: 

• On the Lab Table Review screen, click the Most Recent Labs button. The patient's chart opens 
to the Most Recent Lab Data screen.  

Accessing RelayHealth® from the Lab Table Review screen 
If Patient Records has been configured to work with RelayHealth, it can be accessed directly from the 
Lab Table Review screen. You can access RelayHealth's New Message to Patient web page to compose 
a new message for the current patient. The New Message to Patient screen will open in the Lytec MD 
web browser.  

See the Sending New Messages to Patients in RelayHealth section for more information. For detailed 
information about composing a new message in RelayHealth, consult your RelayHealth documentation.  

To compose a new message for the patient using RelayHealth:  

1. Ensure that the Lab Table Review screen is displayed. 

2. Click the Pt Msg button. The New Message to Patient web page opens. 

Fields on the Lab Table Review screen 
At the top of the screen, the date and time of the tests are displayed, as well as the Lab Review 
template name, the patient’s name, and the provider ID. Each column in the table displays the data for 
each of the following: status, corrected flag, provider ID, lab name, value, units, high/low warning, 
normal range, previous date, previous value, and comment.  

The table below describes each field in the screen.  

Field Description 

St. The lab test status.  

Note: If an asterisk (*) is displayed it means you have the 
necessary access to view the lab.  

C The corrected flag.  

Prov The ID of the provider associated with the current operator who 
ordered the lab test. 

Lab Name The lab test name.  

Value The value for the lab test. If the value is low, it is highlighted in 
green. If it is high, it is highlighted in red.  

Units The unit of measurement specified for the value of the lab test.  

H/L If the value for the test is outside of the normal range, a high or 
low warning will display.  

Range The normal range of values for the lab test.  

Prev The most recent date when the previous lab test was drawn.  

Prev Value The lab test value for the most recent date.  
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Comment The comment entered for the current lab test.  
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Progress notes and documents 
Although you can sign progress notes individually when you save them, you can also sign them later in 
a single process. Once all notes are signed, you can print reports to provide status information on 
notes that need attention, including: 

• Missing Progress Notes – The Missing Progress Notes report prints a list of patients who were 
scheduled for a visit, but for whom no progress note exists. 

• Unsigned Notes – The Unsigned Notes report prints a list of patients with unsigned notes. 

• Unsaved Notes – The Unsaved Notes report prints a list of patients with notes that were not saved 
or loaded to the patient chart. (These include shared notes.) 

You can also review laboratory test results for one or more patients. You can sign the lab test results 
and forward them to other providers so that they can review and sign the test results, as well. If your 
provider ID is on the note's .PV line, after you forward the note, it will remain in your review bin. If your 
provider ID is not on the note's .PV line, the note goes to the next provider who needs to sign it. 

You can easily review and sign all notes using the Review Data feature. You can also view a specific 
note during the review process.  

About forwarding notes to another provider 
Your system administrator can use the WhenForwardHaveOriginalSign setting in the ppart.ini file to 
determine what happens to a note after it is forwarded to another provider. 

• When set to ON, the note is forwarded and then remains in the review bin until the original 
provider signs it. 

• When set to OFF, the note is forwarded and then is removed from the review bin without being 
signed. 

Reviewing and signing notes 
To review and sign notes:  

1. Select Task > Review Data > Progress Notes and Documents, or hold down your left mouse 
button while clicking the Review button on the tool bar and select Progress Notes and 
Documents. Your first unsigned note displays. To edit a note, click the Edit button. While you 
are reviewing and signing notes, you have full editing capabilities.  
 
If you do not want to sign a particular note, just click the Next button to skip it. You can also 
press F6 instead of clicking the Next button.  

Note: The Recently Reviewed submenu located under the File menu will show up to 99 patients whose 
lab results, progress notes, or documents were most recently reviewed by the operator. This list is lost 
when the user parks or exits Lytec MD. 

2. If the note is correct and you are ready to sign the note, click the Sign button and enter your 
electronic signature. You can also press F5 instead of clicking the Sign button. After you enter 
your signature, click the OK button.  

3. When subsequent notes display, click the Sign button. Patient Records automatically applies 
the electronic signature for you. The electronic signature(s) appears at the bottom of each note, 
followed by the date, after one skipped line:  

SIGNED BY PROVIDER NAME (ID)MM/DD/YY  
CO-SIGNED BY PROVIDER NAME (ID)MM/DD/YY  
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For example: 

# SIGNED BY Cobb B Able, Jr., M.D. (ABC)     04/14/2009 09:32AM  
# CO-SIGNED BY Blake B Brian, PA-C (BBB)     04/15/2009 11:36AM 

If you edit the note and sign the revision, the provider signature line will read: 

SIGNED BY PROVIDER NAME (ID)MM/DD/YY  
REVISED BY PROVIDER NAME (ID)MM/DD/YY  

For example: 

# SIGNED BY Cobb B Able, Jr., M.D. (ABC)     04/14/2009 09:32AM  
# REVISED BY Blake B Brian, PA-C (BBB)     04/15/2009 11:36AM 

You can edit a note and sign the revisions up to five times after it is first entered.  

Depending on the option selected by your system administrator, when you access the Review 
Provider Data screen, one of the following will happen:  

• You will see an Open Chart button on screen. If you click the Open Chart button, the patient 
chart displays for the patient whose progress note you are reviewing.  

OR  

• A patient chart displays as a minimized screen. This chart belongs to the patient whose progress 
note you are reviewing. You can view the chart by maximizing the screen or selecting the patient 
chart from the Window menu. Closing the progress note automatically restores the patient chart 
screen.  

Note: Notes containing partial note markers might be reassigned to you for review when the markers 
are replaced with text from an uploaded text data file. If you are reassigned a note that was updated in 
this way, the message 'Text was added since the last review' will be displayed in the Note Review 
screen when you review the note. 

To view a specific note:  

1. Select View > List of Notes.  

2. On the Select Note screen, select the note you want to view. You can sort the notes by date, 
provider, or problem, by clicking the corresponding column headers on the screen.  

3. Click the OK button.  

Signing all notes with review data 
If you are set up with an electronic signature, you can sign your notes. Although you can sign and save 
them individually at the time you write them, you can also sign them later all at once with the Review 
Data option. 

If you are one of several providers working on a note as indicated by a .PV Dot code, once saved the 
note goes into a signature queue for the first provider in the .PV line. When the first provider signs the 
note, it moves into the next provider’s queue, and so on. 

Here is a sample .PV: line: 

.PV: GPL: CLD: RMB: NSC: DOR: MBN 

Note: If your note includes a .PV line, up to six providers can sign a note. However, if Electronic 
Signature is set up for only one signature per note, then you can enter only one provider on the .PV: 
line. 
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Displaying the patient chart when reviewing data  
As you review progress notes or laboratory data, you can display the patient chart for the patient whose 
data you are reviewing by clicking the Open Chart button on the Review Provider Data screen.  

As an alternative, you can automatically display the patient chart as a minimized screen as soon as you 
access the Review Provider Data screen. You can view the chart by maximizing or restoring the screen 
or selecting the patient chart from the Window menu. Closing the progress note automatically restores 
the patient chart screen.  

Note: Your system administrator can configure how the patient chart displays as you review data.  

Sending messages 
You can send messages using the messaging system from the Note Review screen.  

To send a message from the Note Review screen: 

1. Click the Message button. A new message displays with a message type as Chart and with the 
current patient's information already filled in.  

2. Enter the message's recipients, and add any additional information or notes. Then click the 
Send button. 

Buttons on the Review Provider Data screen 
Button Description 

Newer Click this button to view more recent notes.  

Older Click this button to view previous notes.  

Sign If the note is correct and you are ready to sign the note, click 
the Sign button and enter your electronic signature. You can 
also press F5 instead of clicking the Sign button. After you 
enter your signature, click the OK button.  

Reviewed Click this button to acknowledge that you have reviewed a copy 
(CC) of the note. If the PRUtils setting "Require electronic 
signature when Reviewing notes" is enabled, you will be 
required to enter your electronic signature. When you indicate 
that you have reviewed a note, Lytec MD will add a line to the 
end of the note indicating that you reviewed it, with the date 
and time of review. 

Edit To edit a note, click the Edit button. While you are reviewing 
and signing notes, you have full editing capabilities.  
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Print To print the note:  

4. Click the Print button.  

5. Under Print Range, specify the portion of the 
document you want to print.  
 Entire File: Select this option to print the entire file. 
 Selected Pages: Select this option to enter page 

numbers or page ranges you want to include. 

Note: The Selected Text option is currently not 
available. 

3. In the Number of Copies field, enter the number of 
copies you want to print. 

4. To print a complete copy of the note before the first 
page of the next copy is printed, select the Collate 
check box.  

5. Click OK, to print the note. 
Fax Click this button to fax the current note to a referring source, 

patient, or other destination.  

CC Click this button to send a copy of the note to another provider 
so the provider may review the note. The Provider Select screen 
appears. Select the provider from the list and click the OK 
button.  

Forward Click this button to forward the note to another provider so the 
provider can sign the note. The Provider Select screen appears. 
Select the provider from the list and click the OK button.  

Message Click this button to send a message regarding the patient. See 
the Sending messages section for a complete explanation.  

Open Chart Click this button to open the patient's chart.  

Pt Comment Click this button to create a new patient comment note (for 
Web View sites only).  

Pt Msg Click to compose a new message in RelayHealth for the current 
patient. The New Message to Patient web page will open in a 
web browser window.   
See the Sending New Messages to Patients in RelayHealth 
section for more information.  

Note: This button will only be enabled if RelayHealth is installed 
and connectivity to the RelayHealth network is established.  

Online Sum Click to view the patient's online health summary. The 
RelayHealth Health Summary screen opens in a web browser 
window.  
See the Viewing a Patient's Online Health Summary in 
RelayHealth section for more information.  

Note: This button will only be enabled if RelayHealth is installed 
and connectivity to the RelayHealth network is established. 
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Reply Click to reply to a clinical message that has been imported from 
RelayHealth. The RelayHealth "View Message" screen will open 
in a web browser window. This button will only be enabled if 
the note you are viewing is an imported message from 
RelayHealth.  
See the Replying to RelayHealth Messages in Patient Records 
section for more information.  

Note: This button will only be enabled if RelayHealth is installed 
and connectivity to the RelayHealth network is established.  
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Transfer to portable and remote access: overview 
Some practices may want to set up Lytec MD for use in a remote location. You can: 

• Use Lytec MD from remote computers connected via modem to the computer where Lytec MD is 
installed.  

• Use Lytec MD on a portable computer to which all or part of your Lytec MD information has been 
transferred. 

About providing remote access to Lytec MD 
It may be convenient to access Lytec MD from a variety of locations not connected to your system. You 
can access Lytec MD from a remote computer located in the medical office, hospital, or home. To use 
Lytec MD remotely, you need another PC-compatible computer with a hard disk, a Windows-
compatible modem, and remote access software, such as pcANYWHERE™, Citrix, or Microsoft 
Windows Terminal Server. 

So equipped, you then use the remote access software to log on as usual to your network, Windows, 
and Lytec MD. 

The screen on the remote computer looks exactly as it does when you are running Lytec MD directly. 
You can use the same keys to perform Lytec MD tasks. The system’s response may be somewhat 
slower, however, because of the transmission of information over the modem. 

About transferring Lytec MD to a portable computer 
Lytec MD provides the ability to transfer patient data to a portable or laptop computer, add 
information, and then synchronize the data back to the main system. This means, for example, that you 
can transfer patient charts to a laptop, add new progress notes or prescribe an Rx, and resynchronize 
the updated information back into Lytec MD. 

This feature is intended to transfer some of your patient data, not the entire database. Transferring 
information for all patients may take an extremely long time.  

Note: You can only add data using the portable version. You cannot edit existing data. 

About the portable copy of Lytec MD 
The Transfer to Portable feature creates a standalone portable version of Lytec MD. This version looks 
and works just like the complete program, except that only the relevant features are active. These 
features include: 

• Adding patients  

• Adding progress notes 

• Adding vital signs 

• Adding lab data 

• Adding health maintenance data 

• Writing prescriptions 

• Adding images 

• Adding EKGs 

Features that are not available include: 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 889 

 

• Messaging – You cannot view, send, delete, or forward any messages. When you enter a critical 
value for labs or other test results, a message will not be sent to the message queue. You will 
need to create a message on the main Lytec MD database. 

• Review data – You cannot review lab data or progress notes, or sign progress notes. 

• Scheduling features, if you are also using Appointment Scheduler.  

• Electronic encounter forms. 

• PLINK2 labels in notes. 

How the Transfer to Portable feature works 
The feature provides three options:  

• Install a new copy of the portable version. When you install, patient data and the necessary 
program files are copied. 

• Refresh an existing copy. When you refresh, only patient data is copied. If you change templates 
or make other major changes to the configuration of Lytec MD on your main system, you should 
delete the entire portable version and install a new one during the next transfer. 

• Resynchronize data back into the main Lytec MD database. When you resynchronize, the patient 
data you added on the portable is transferred into the Lytec MD database on your network. 
 
Your system administrator can use a setting in the ppart.ini file to specify whether all patient 
records (even those untouched) should be resynchronized back into Lytec MD, or whether only 
patients whose charts have been accessed should be resynchronized. 

Transfer to portable: setting up and using 
When you use the Transfer to Portable feature, you can specify the individual or groups of patients that 
you want to transfer to the portable computer. You can select the data you want to transfer by any of 
the following criteria: 

• Records for individual patients, selected by name or identification number. 

• Records for patients registered during a given period, seen by a particular provider, or not seen 
since a given date. 

• Records for the selected patients only up to a given date. 

• Records indicated by a Patient Inquiry file. 

You need to enter information only in the fields that are relevant to the selection you are making. For 
example, if you want to create a transfer file for a single patient, you do not need to enter the name of 
the provider. You need to enter only the patient’s name or identification number. 

If your workstation is not the portable computer, follow the instructions in the Workstation to 
portable section. You must be able to: 

• Connect the laptop to your network and share the laptop’s drive at the root directory. The root 
directory is the top level of a hard drive (typically C:).  

• Map a drive for the laptop on your network. 

If your workstation is the portable (for example, you work on a laptop at the practice, and then you 
take the laptop on rounds), follow the instructions in the Portable to portable section. 
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Using the Transfer to Portable feature - workstation to 
portable 
Follow the procedures in this section if your workstation is not the portable computer. 

To install the portable version of Lytec MD: 

Note: You must run this feature from the workstation, not from the portable computer. 

1. Make sure all users are logged out of the system.  

2. Connect the laptop to your network. The drive for the laptop must be shared at the root 
directory.  

3. Map a drive to the laptop on your network.  

4. On the workstation, select Task > Portable Transfer > Transfer to Portable. The Transfer to 
Portable screen appears. 

5. In the Portable Drive Letter field, select the drive on the portable to which you are copying the 
portable version. This drive is typically C (the main hard drive). 

6. If you want to copy Drug Interaction files to the portable computer, mark the Copy Drug 
Interaction files check box. 

7. In the Mapped Drive to copy files to field, type the drive to the portable that you mapped 
earlier, followed by the folder name that you want to use for the portable version. Use the 
format drive:\folder_name. For example, if the portable is mapped as H, type H:\ppart. 

8. Click the OK button. The Transfer to Portable – Selection screen appears. 

9. Select whether you want to transfer information for a Single Patient, Selected Patients, All 
Patients, or Patient List File. 

10. In the Patient Data from field, type the dates for which you want to transfer information. You can 
also leave the date fields blank to select all dates. 

11. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected: 
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. A screen displays the status of the transfer 
process. 

• Selected Patients: The Transfer to Portable – Selection Criteria screen appears. Enter your 
criteria. You can fill in whatever information is appropriate, including scheduled provider, 
scheduled dates, registration dates, usual provider, patient status, and patient note (and 
the note’s function, such as Scheduler or Patient). When you finish entering your criteria, 
click the OK button. A screen displays the status of the transfer process. 

• All Patients: A screen displays the status of the transfer process. 

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to transfer. Then click the OK button. A 
screen displays the status of the transfer process. 

12. On the portable, use Windows Explorer to navigate to and open the prw.exe file. For example, 
if you used ppart as your folder name, the location is C:\ppart\prwin32\prw.exe. 
 
This step registers the necessary Lytec MD files.  

12. If prompted, reboot the laptop. 



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 891 

 

To refresh the portable version (workstation to portable):  

Note: You must run this feature from the workstation, not from the portable computer. 

1. Make sure all users are logged out of the system.  

2. Connect the laptop to your network. The drive for the laptop must be shared at the root 
directory.  

3. Map a drive to the laptop on your network.  

4. On the workstation, select Task > Transfer to Portable. The Transfer to Portable screen appears. 

5. In the Portable OS field, select the operating system on the portable. 

6. In the Portable Drive Letter field, select the drive on the portable that contains the portable 
version. This drive is typically C (the main hard drive). 

7. If you want to refresh Drug Interaction files on the portable computer, mark the Copy Drug 
Interaction files check box. 

8. In the Mapped Drive to copy files to field, type the drive to the portable that you mapped 
earlier, followed by the folder name that contains the portable version. Use the format 
drive:\folder_name. For example, if the portable is mapped as H, type H:\ppart. 

9. Click the OK button. The program asks whether you want to overwrite existing data on the 
laptop or refresh the patient data. 

10. Click the No button. The Transfer to Portable – Selection screen appears. 

11. Select whether you want to transfer information for a Single Patient, Selected Patients, All 
Patients, or Patient List File. 

12. In the Patient Data from field, type the dates for which you want to transfer information. You can 
also leave the date fields blank to select all dates. 

13. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected: 
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. A screen displays the status of the transfer 
process. 

• Selected Patients: The Transfer to Portable – Selection Criteria screen appears. Enter your 
criteria. You can fill in whatever information is appropriate, including scheduled provider, 
scheduled dates, registration dates, usual provider, patient status, and patient note (and 
the note’s function, such as Scheduler or Patient). When you finish entering your criteria, 
click the OK button. A screen displays the status of the transfer process. 

• All Patients: A screen displays the status of the transfer process. 

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to transfer. Then click the OK button. A 
screen displays the status of the transfer process. 

To resynchronize data back into the main Lytec MD database (workstation to portable):  

Your system administrator can use a setting in the ppart.ini file to specify whether all patients should be 
resychronized back into Lytec MD, or whether only patients whose charts have been accessed should 
be resynchronized. 

Note: You must run this feature from the workstation, not from the portable computer. 
 
Also, the portable version of Lytec MD must not be open when you resynchronize the data. 
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1. Connect the laptop to your network. The drive for the laptop must be shared at the root 
directory.  

2. Map a drive to the laptop on your network. 

3. On the workstation, select Task > Portable Transfer > Resynchronize Portable. The 
Resynchronize Portable screen appears. 

4. Enter the drive and pathname of the portable version. Type the drive to the portable that you 
mapped earlier, followed by the portable version’s folder name. Use the format 
drive:\folder_name. For example, if the portable is mapped as H and the folder name is ppart, 
type H:\ppart. 

5. Click the OK button. A screen displays the progress of the resynchronization process. 

Using the Transfer to Portable feature - portable to portable 
Follow the procedures in this section if your workstation is the portable computer. 

To use the transfer to portable feature when the workstation is the same as the portable, you must: 

• Make sure they are the same version (for example, both are version 9.3). You are creating two 
separate Lytec MD installations, and both must use the same program files. 

• Close the portable version when you are using the Transfer to Portable feature.  

• Run the feature from the main Lytec MD installation (the full workstation version) on the portable, 
not from the portable version. 

To install the portable version of Lytec MD (portable to portable): 

Note: You must run this feature from the full workstation version, not from the portable version. 

1. Make sure all users are logged out of the system.  

2. In the workstation version, select Task > Portable Transfer > Transfer to Portable. The Transfer 
to Portable screen appears. 

3. In the Portable OS field, select the operating system on the portable. 

4. In the Portable Drive Letter field, select the drive to which you are copying the portable version. 
This drive is typically C (the main hard drive). 

5. If you want to copy Drug Interaction files to the portable computer, mark the Copy Drug 
Interaction files check box. 

6. In the Mapped Drive to copy files to field, type the drive, followed by the folder name that you 
want to use for the portable version. Use the format drive:\folder_name. For example, if you are 
installing on the C drive, type C:\ppart. 

7. Click the OK button. The Transfer to Portable – Selection screen appears. 

8. Select whether you want to transfer information for a Single Patient, Selected Patients, All 
Patients, or Patient List File. 

9. In the Patient Data from field, type the dates for which you want to transfer information. You can 
also leave the date fields blank to select all dates. 

10. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected: 
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. A screen displays the status of the transfer 
process. 
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• Selected Patients: The Transfer to Portable – Selection Criteria screen appears. Enter your 
criteria. You can fill in whatever information is appropriate, including scheduled provider, 
scheduled dates, registration dates, usual provider, patient status, and patient note (and 
the note’s function, such as Scheduler or Patient). When you finish entering your criteria, 
click the OK button. A screen displays the status of the transfer process. 

• All Patients: A screen displays the status of the transfer process. 

• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to transfer. Then click the OK button. A 
screen displays the status of the transfer process. 

10. Use Windows Explorer to navigate to and open the prw.exe file. For example, if you used ppart 
as your folder name, the location is C:\ppart\prwin32\prw.exe. 
 
This step registers the necessary Lytec MD files.  

11. If prompted, reboot the laptop. 

To refresh the portable version (portable to portable):  

Note: You must run this feature from the full workstation version, not from the portable version. 
 
Also, make sure that the portable version of Lytec MD is not running. 

1. In the workstation version, select Task > Portable Transfer > Transfer to Portable. The Transfer 
to Portable screen appears. 

2. In the Portable OS field, select the operating system on the portable. 

3. In the Portable Drive Letter field, select the drive that contains the portable version. This drive is 
typically C (the main hard drive). 

4. If you want to refresh Drug Interaction files on the portable computer, mark the Copy Drug 
Interaction files check box. 

5. In the Mapped Drive to copy files to field, type the drive and folder that contains the portable 
version. Use the format drive:\folder_name. For example, type C:\ppart. 

6. Click the OK button. The program asks whether you want to overwrite existing data on the 
laptop or refresh the patient data. 

7. Click the No button. The Transfer to Portable – Selection screen appears. 

8. Select whether you want to transfer information for a Single Patient, Selected Patients, All 
Patients, or Patient List File. 

9. In the Patient Data from field, type the dates for which you want to transfer information. You can 
also leave the date fields blank to select all dates. 

10. Click the OK button. The next screen to appear depends on the criteria you selected. If you 
selected: 
• Single Patient: The Lookup screen appears. Enter your search criteria and select the 

appropriate patient. Then click the OK button. A screen displays the status of the transfer 
process. 

• Selected Patients: The Transfer to Portable – Selection Criteria screen appears. Enter your 
criteria. You can fill in whatever information is appropriate, including scheduled provider, 
scheduled dates, registration dates, usual provider, patient status, and patient note (and 
the note’s function, such as Scheduler or Patient). When you finish entering your criteria, 
click the OK button. A screen displays the status of the transfer process. 

• All Patients: A screen displays the status of the transfer process. 
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• Patient List File: The File Path and Name screen appears. Enter (or browse to) the Patient 
Inquiry file, with an .inq extension, that you want to transfer. Then click the OK button. A 
screen displays the status of the transfer process. 

To resynchronize data back into the main Lytec MD database (portable to portable):  

Your system administrator can use a setting in the ppart.ini file to specify whether all patients should be 
resycnchronized back into Lytec MD, or whether only patients whose charts have been accessed 
should be resynchronized. 

Note: You must run this feature from the full workstation version, not from the portable version. 
 
Also, make sure that the portable version of Lytec MD is not running. 

1. In the workstation version, select Task > Portable Transfer > Resynchronize Portable. The 
Resynchronize Portable screen appears. 

2. Type the drive and folder that contains the portable version. Use this format -- 
drive:\folder_name. For example, type C:\ppart 

3. Click the OK button. A screen displays the progress of the resynchronization process. 

Transfer to Portable messages 
The table below describes the messages you may see while you are transferring patient information to 
the portable computer. 

Message Description 

The destination directory does not 
exist. Create it? 

If you answer Y, the destination directory will be created on the 
portable. If you answer N, the transfer will be stopped. 

Unable to create the directory. 
Continue? 

Generally, you should answer N and check your portable for 
problems. However, if you are sure that you are correct, you can 
answer Y to retry. 

Initialize portable directory 
environment? 

The first time you transfer Lytec MD to the portable you will see 
this message. Answer Y to transfer the portable version of Lytec 
MD as well as the selected patient information to the portable. 
Once the environment exists on the portable, only the data will 
be transferred. 

Destination appears to lack disk 
space. Continue? 

You will see this message if there is insufficient disk space. If 
you answer Y, Lytec MD will attempt to copy files to the 
portable until it runs out of room. Of course, it is better to stop 
and delete files to make sure there is enough room. 

Batch file not present; 
environment not initialized. Press 
Y 

The file PORTENV.BAT is missing from the Lytec MD directory. 
Copy it from your Lytec MD CD-ROM. 
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Mapping a drive  
To use the Transfer to Portable feature, you must map a drive for the portable on the workstation’s 
directory. This mapping will enable the Transfer to Portable feature to locate the portable.  

In Windows Explorer, a directory is represented by a tree view. This tree view illustrates the drives that 
are currently mapped in the directory. Typically, this mapping includes A:\ (floppy drive), C:\ (hard 
drive), and E:\ (CD-ROM drive). Depending on your network, other drives may also be mapped.  

Procedures for mapping a drive to the laptop are provided for Windows XP. If you are using another 
operating system, refer to the Windows help file.  

For Windows XP  

To map a drive to the portable:  

Note: Make sure that the portable computer is connected to the network.  

1. On the workstation, open Windows Explorer. You can open Windows Explorer by right-clicking 
on the Start button and selecting Explore.  

2. Select Tools > Map Network Drive. The Map Network Drive screen appears.  

3. In the Drive field, select a letter for the new drive (for example, select H:\).  

4. In the Folder field, type \\computer_name, where computer_name is the name of the portable 
computer. You can also click the Browse button and navigate to the portable on your network.  

5. Mark the Reconnect at logon check box. This saves the drive mapping.  

6. Click the OK button.  

Sharing access to the laptop  
To use the Transfer to Portable feature, you must enable share access to the portable’s root directory. 
The root directory is the top level of a hard drive (typically C:). It contains folders such as Windows, My 
Documents, and Program Files.  

Procedures for sharing access to the laptop’s root directory are provided for Windows XP. If you are 
using another operating system, refer to the Windows help file.  

For Windows XP  

To share access to the portable’s root directory:  

1. On the portable, open Windows Explorer. You can open Windows Explorer by right-clicking on 
the Start button and selecting Explore.  

2. Right click the root directory (typically C:) and select Sharing and Security.  

Note: If this is the first time you are accessing the Sharing feature, a message asks you whether you 
understand the risks of sharing the root of the drive. Click the message to proceed.  

3. In the Network sharing and security frame, mark the Share this folder on the network radio 
button.  

Notes: 
If this is the first time you are accessing the Network sharing and security frame, you will first need to 
enable network sharing. You can either:  
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* Run the Network Setup Wizard (recommended if you are familiar with XP).  
 
* Click the “…share files without running the wizard” message and then mark the Just enable file 
sharing radio button on the Enable File Sharing screen.  

4. Click the OK button to close the Local Disk Properties screen.  

Run Transfer to Portable manually using a command (DOS) 
prompt 
Transfer to Portable can be run manually, rather than from within Patient Records using the Task > 
Portable Transfer menu. One reason to do it manually is so that you can have a scheduling program 
initiate the data transfer/resynchronization at regular intervals you specify. The TransferToPortable.exe 
is launched at a command line (DOS) prompt to transfer data to the laptop, refresh, and resynchronize, 
just as takes place directly within PR.  

The PPart.ini file within Patient Records has settings you must supply before running the 
TransferToPortable.exe; see the PPart.ini File topic and refer to the [Portable] key.   

To run the TransferToPortable utility: 

1. Supply your settings for [Portable] in the PPart.ini file. These are: Path, Drive Letter, Operating 
System, Patient Inquiry File, and AllPatients. 

2. Open a command line (DOS) prompt. 

3. To: 
• Transfer data to the portable, type the following on the command line: 

TransferToPortable.exe TRANSFER PPart.ini 

• To refresh the data on the portable, type the following on the command line: 
TransferToPortable.exe REFRESH_PORTABLE PPart.ini 

• To resync the data from the portable back to the server database, type the following on 
the command line: TransferToPortable.exe RESYNC_MAIN_DB PPart.ini.  

You'll see an Operation Completed message if the transfer was successful. If not, you will get a warning 
message or P error message and you can perform troubleshooting in the TransferToPortable.log file.  
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Fax Server 
You can integrate a Windows 2003 fax server or Zetafax with Lytec MD to enable fax server faxing for Rx 
prescriptions, notes and reports in Patient Records.  

Zetafax fax server integration 
Zetafax must be installed on all the client machines running Lytec MD. Please consult your Zetafax 
documentation for installation instructions.  

To integrate Zetafax with Patient Records: 

1. Install Zetafax on your client machines running Lytec MD. Consult your Zetafax documentation 
for installation instructions. 

2. Set the "UseFaxServer" ppart.ini setting to ON. The setting is located under the [Rx] section.  

3. Define your fax server settings in the ppfax.ini file. The ppfax.ini file is found in the \ppart 
directory.  

a. Set the "FaxType" setting to Zetafax. The setting is located under the [FaxType] section.  

b. Use the "FaxLogonName" setting to enter your Zetafax logon name. 

c. Use the cover letter settings to specify the cover letters that will be sent with letter, Rx, 
and chart faxes.  

Windows 2003 fax server integration 
Windows 2003 fax server must has be configured and running on your network. Please note that part 
of the configuration will be to set up the fax server "dialing rules" to ensure that numbers are dialed 
correctly by the fax server. You must also have Windows XP installed on each of the workstations using 
the fax server. Please consult the documentation for your Windows 2003 Operating System for details. 
If these requirements have been met, you can configure the following to enable fax server faxing for Rx 
prescriptions, notes and reports.  

Setting up your Windows 2003 fax server for Rx 
prescriptions 
To set up your fax server for Rx prescriptions: 

1. Set the "UseFaxServer" ppart.ini setting to ON. The setting is located under the [Rx] section.  

2. Define your fax server settings in the ppfax.ini file. The ppfax.ini file is found in the \ppart 
directory. The FaxServer= and ServerName= settings must be defined before you can use the 
fax server to send faxes. 

1. "FaxServer" should be set to the name of the fax server instance installed on the 
Windows 2003 computer running the fax server software. To find out what this name 
is: 

a. On the Windows 2003 computer running the fax server software, click on the 
"Start Menu"  

b. Click on "Printers and Faxes" 
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c. Identify the item on the list which corresponds to the fax server instance. If you 
click "View" and "Details" this should display with "Microsoft Shared Fax Driver" 
under the "Model" column. 

2. "ServerName" should be set to the network name of the Windows 2003 computer 
running the fax server software. To find out what this name is: 

a. On the Windows 2003 computer running the fax server software, right-click on 
"My Computer" 

b. Select "Properties" 

c. Click on the "Computer Name" tab.  If the computer name has multiple 
segments separated by periods (e.g., computername.xyz.org) use the first 
segment (e.g., "computername"). 

3. Set the "FaxType" setting to WinServer. The setting is located under the [FaxType] section. 

4. Use the ppfax.ini file cover letter settings to specify the cover letters that will be sent with Rx 
faxes.  

Setting up your Windows 2003 fax server for notes and 
reports 
To set up your fax server for notes and reports: 

1. Define your fax server settings in the ppfax.ini file. The ppfax.ini file is found in the \ppart 
directory. The FaxServer= and ServerName= settings must be defined before you can use the 
fax server to send faxes. 

1. "FaxServer" should be set to the name of the fax server instance installed on the 
Windows 2003 computer running the fax server software. To find out what this name 
is: 

a. On the Windows 2003 computer running the fax server software, click on the 
"Start Menu"  

b. Click on "Printers and Faxes" 

c. Identify the item on the list which corresponds to the fax server instance. If you 
click "View" and "Details" this should display with "Microsoft Shared Fax Driver" 
under the "Model" column. 

2. "ServerName" should be set to the network name of the Windows 2003 computer 
running the fax server software. To find out what this name is: 

a. On the Windows 2003 computer running the fax server software, right-click on 
"My Computer" 

b. Select "Properties" 

c. Click on the "Computer Name" tab.  If the computer name has multiple 
segments separated by periods (e.g., computername.xyz.org) use the first 
segment (e.g., "computername"). 

2. Set the "FaxType" setting to WinServer. The setting is located under the [FaxType] section. 

3. Use the ppfax.ini file cover letter settings to specify the cover letters that will be sent with letter 
and chart faxes.  
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4. Set up a printer for the fax server on each client workstation. This will allow proper rendering of 
the document for faxing. 

To set up a fax server as a printer: 

1. From the Windows desktop Start menu select Printers and Faxes. 

2. Select File > Add Printer. 

3. Complete the Add Printer Wizard, by entering your fax server information. You should add the 
fax server as a "network printer" and, when prompted to "specify a printer," indicate the printer 
name as \\server\printer. For instance, if your ServerName is "computername" and your 
FaxServer is "fax" you would type "\\computername\fax". 

See the Setting up your fax server for Rx prescriptions section for more information on ServerName and 
FaxServer. 

RTF File Extensions 

Your RTF extension must be associated with an external program for the fax server to work properly. If 
your RTF extension is not associated with an external program such as Microsoft Word, or WordPad, 
the fax will not be sent. This advisory step is typically for sites who do not use Microsoft Office.  

Note: If, on your workstation, the RTF extension is associated with an application that does not render 
images, such as Wordpad, then your images in a note or prescription will not be included in the fax. 
The header information in a note will also not be included in the fax. 

To check if your RTF extension is associated with an external program:  

1. Open Windows Explorer. 

2. Select Tools > Folder Options. 

3. Click the File Types tab. 

4. Highlight the RTF extension in the Register file types list. The associated program is displayed 
in the Details for 'RTF' extension section.  

To change the RTF extension: 

1. Click the Change button. Select Microsoft Office Word, or WordPad.  

2. Once you are finished, click OK.  

ppfax.ini File 
The ppfax.ini file is a configuration file that defines your fax server settings. You can define default 
settings for your practice or all practices. You can also add specific settings for practices. To add 
specific settings for practices, enter the practice name as a ppfax.ini section title (for example, [ABC]). 
Under the section title add the practice's settings.  

You can configure the ppfax.ini file for a Windows 2003 fax server and Zetafax. 

Procedure for changing the ppfax.ini file 
To open or edit the ppfax.ini file: 

1. Make a backup of the ppfax.ini file. For example, copy the file and rename it as ppfax.bak. 

2. Use WordPad, Notepad, or another text editor to open the file. 
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3. Make the necessary changes. The table below describes settings in the file, including which 
settings should not be edited. 

4. Save the file. 

Keys and variables in the ppfax.ini file 
The table below has the section titles and variables in ppfax.ini.  

Specific variable names and the name of any section must not be changed. 

Note: Changing a variable name or the section name will likely cause Lytec MD not to operate. 

Settings in ppfax.ini  

Windows 2003 Fax Server settings 

Key Description 

[Fax Type] 

FaxType= Enter WinServer.  

[Default] 

FaxServer=Fax Enter the fax server name. The default setting is Fax.  
"FaxServer" should be set to the name of the fax server instance 
installed on the Windows 2003 computer running the fax server 
software.  
To find out what this name is: 

1. On the Windows 2003 computer running the fax server 
software, click on the "Start Menu". 

2. Click on "Printers and Faxes". 
3. Identify the item on the list which corresponds to the fax 

server instance. If you click "View" and "Details" this 
should display with "Microsoft Shared Fax Server" under 
the "Model" column. 

ServerName= Enter the server name.  
"ServerName" should be set to the network name of the 
Windows 2003 computer running the fax server software.  
To find out what this name is: 

1. On the Windows 2003 computer running the fax server 
software, right-click on "My Computer". 

2. Select "Properties". 
3. Click on the "Computer Name" tab. If the computer 

name has multiple segments separated by periods (e.g., 
computername.xyz.org) use the first segment (e.g., 
"computername"). 

LetterCover= Enter the name of the cover page that will be sent with letter 
faxes.  

RxCover= Enter the name of the cover page that will be sent with Rx faxes.   

Chartcover= Enter the name of the cover page that will be sent with chart (i.e., 
note and report) faxes.  



Patient Records for Windows                                                                                                                              User’s and Technical Guide 

Page 901 

 

Zetafax settings 

Key Description 

[Fax Type] 

FaxType= Enter Zetafax. 

[Default] 

LetterCover= Enter the name of the cover page that will be sent with letter 
faxes.  

RxCover= Enter the name of the cover page that will be sent with Rx faxes.   

Chartcover= Enter the name of the cover page that will be sent with chart (i.e., 
note and report) faxes.  

FaxLogonName= Enter your Zetafax logon name.  
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RelayHealth 
RelayHealth is a Web-based service through which providers and patients can securely communicate 
online. When Patient Records is integrated with RelayHealth providers can access RelayHealth directly 
from Lytec MD, without logging in separately.  

If you install RelayHealth with Patient Records you can: 

• Open your RelayHealth Home page (to check your RelayHealth messages, compose a new 
message, or access other RelayHealth functions) from the Lytec MD Dashboard, Messages 
screen, or the Task Menu. 

• Launch the RelayHealth New Message to Patient screen to compose a new message for the 
current patient from the patient's Chart, Lab Table Review screen, or the Review Provider Data 
screen.  

• View the total number of messages and total number of unread messages in your RelayHealth 
Inbox from the Dashboard and Messages screen. You can click the Community Messaging 
button to open your RelayHealth Home page and check your messages.  

• View and reply to RelayHealth clinical messages within the Lytec MD Patient Chart and the 
Review Provider Data screen. You can also review copies of replies that were sent to RelayHealth 
clinical messages within the Patient Chart.   

• Open the current patient's online health summary in RelayHealth from the patient's chart or from 
the Note Review screen. 

For detailed information about RelayHealth, visit www.relayhealth.com or consult your RelayHealth 
documentation. To purchase RelayHealth, please consult your Lytec MD sales representative. 

Note: To use RelayHealth with Patient Records you must first install the Lytec MD Connect - RelayHealth 
Inbound and Outbound Interfaces. See the Lytec MD Connect - RelayHealth Inbound and Outbound 
Interfaces Guide for step-by-step instructions on how to setup and configure Patient Records for use 
with RelayHealth. 
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Configuration 
This section describes the special Lytec MD configuration settings for RelayHealth integration. 

Before you start using RelayHealth with Patient Records, your system administrator can update the 
following RelayHealth settings in Lytec MD to meet your site's needs.  

• Specify the storage location of RelayHealth "clinical messages" imported into Lytec MD using the 
Special Features setting "Store Imported RelayHealth Message in". The default location is 
Progress Notes. If you change the default location you must choose a note section of the chart 
that requires a provider signature, if you do not, the provider's RelayHealth messages will not be 
sent to their review bin.  

• Configure the default refresh time for the Community Messaging button as shown on the 
Messages screen and Dashboard. Your system administrator can change the default time (every 
60 seconds) by updating the ppart.ini file setting "MessageCountTimer". 

• If your organization uses Lytec MD Web View, you can specify whether you want to send 
messages to patients and outside providers in Patient Records using RelayHealth or Web View. 
See the System Administrator Notes for Practices that use Web View and RelayHealth section for 
more information.  

• If your organization's RelayHealth password changes, or you entered your password incorrectly 
during the PPConnect RelayHealth - Inbound and Outbound interfaces installation, your system 
administrator can change your password in Patient Records. See the Updating your password for 
the single sign-on feature section for more information.  

Update your Proxy Server settings 
If your organization uses a proxy server you must update your Internet Explorer settings and edit the 
PMSI Application Service settings on the server. 

Note: The following only needs to be completed on the server, and not on your client workstations. 

1. Update your Internet Explorer options on the server: 

1. On your server, open Internet Explorer.  
2. Select Tools > Internet Options.  
3. On the Internet Options screen, click the Connections tab.  
4. Click the LAN settings button. The Local Area Network (LAN) Settings screen appears. 
5. Select the Automatically detect settings check box.  
6. Deselect any other options that may be selected, and click the OK button.  
7. Click the OK button to close the Internet Options screen, and then close Internet Explorer.  

2. To edit the PMSI Application Service settings to login with specified credentials: 

1. On your server, open the Services control manager.  

a. Select Start > Run. The Run screen appears.  

b. Type Services.msc in the Open field, and click the OK button. The Services screen 
appears. 

2. Find the PMSI Application Service.  
3. Right-click the service and select Properties.  
4. On the PMSI Application Server Properties screen, click the Log On tab.  
5. Under the "Log on as" section, select the This account option.  
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6. Enter your credentials with the domain:  

a. Type your user name in the This account field. For example, JSMITH  

b. Type your password in the Password field, and re-type your password in the Confirm 
password field.  

7. When you are finished, click the OK button.  
8. Stop and restart the PMSI Application Service.  

• Right-click the service, and then select Restart.  

System Administrator Notes for Practices that use Web View and 
RelayHealth 
If you have RelayHealth integrated with Patient Records, it is possible to provide patients with access to 
their Web View Patient Chart through RelayHealth. Since both RelayHealth and Web View offer a way to 
send messages to patients and outside providers (Referring Sources), Lytec MD provides a way for you 
to choose which application you want to use to send messages.  

RelayHealth is selected as the default application during the Lytec MD Connect - RelayHealth Interfaces 
installation. If your site would prefer to use Web View to send messages, you can have your system 
administrator update the "AllowWVMessageToPatientFromPR" and 
"AllowWVMessageToReferringSourceFromPR" settings in the ppart.ini file. These settings control 
whether the messaging screens in Lytec MD show the controls for sending messages through Web 
View. See the PPart.ini file section for a complete explanation of these settings. 

To change the Web View settings in the ppart.ini file:  

1. Make a backup of the PPart.ini file. For example, copy the file and rename it as ppart.bak. 

2. Use WordPad, Notepad, or another text editor to open the file. 

3. Under the [WebView] section: 
• If you want to use Web View to send messages to patients, change the 

"AllowWVMessageToPatientFromPR" setting to =ON.   

• If you want to use Web View to send messages to referring sources, change the 
"AllowWVMessageToReferringSourceFromPR" setting to =ON.   

4. When you are finished, save the PPart.ini file.  

Updating the Password for the RelayHealth Single Sign-on Feature 
During the Lytec MD Connect - RelayHealth Interfaces installation you are prompted to enter the 
password for the single sign-on feature. This allows you to access web pages in RelayHealth without 
having to sign on. One RelayHealth password is used for your entire organization. If the password 
changes, or you entered the wrong password during the installation, your system administrator can 
change the password in Patient Records.   

To change the RelayHealth password in Patient Records for single sign-on access:  

1. Make sure your system administrator enables the Access Level settings (i.e., Add, Edit, Delete) 
for "External Systems" under the Maintenance/Setup section on the General tab. 

2. Select Maintenance > Setup > External Systems. The External Systems screen appears. 

3. Select the row that reads "RelayHealth" and click the Edit button.  

4. Type your new password in the provided field.  
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5. When you are finished, click the Save button.  

6. For the new password to take effect, you must exit and restart Lytec MD.  

Imported RelayHealth Messages 
Once the Lytec MD Connect - RelayHealth Interfaces have been installed and configured for Patient 
Records, there is no additional setup needed to import your RelayHealth messages into Patient 
Records. Messages sent in RelayHealth to individuals in your organization will be directed to Lytec MD, 
and you can view and reply to them from the Review Provider Data screen and Patient Chart, and view 
copies of sent RelayHealth messages from the Patient Chart.  

Note: Some messages sent from RelayHealth will not flow to Lytec MD (specifically, messages that were 
sent from a non-Patient, e.g., another provider and that also do not reference a patient). You can access 
your full RelayHealth inbox directly from Lytec MD, however, using the Community Messaging button 
on the Dashboard screen in Patient Records, which also displays the number of messages (total and 
unread) in your RelayHealth inbox. See Opening your RelayHealth Home page in Patient Records for 
more information. 

Where can I find my RelayHealth messages in Patient Records? 
Imported RelayHealth messages can be found in the Review Provider Data screen, and the Patient 
Chart. The default section of the chart is Progress Notes. Your system administrator can change the 
section of the patient chart in which messages are imported.  

How are my messages imported? 
RelayHealth messages are relayed to Lytec MD as HL7 MDM messages and imported into the Lytec MD 
database through the Lytec MD Connect - RelayHealth inbound interface. Each RelayHealth message is 
matched to a patient in Patient Records and imported as a note with a review queue item so the 
provider to whom the message was sent will be notified and have the opportunity to read the message.  

Note: RelayHealth identifies Lytec MD users by their Operator ID. In order for Lytec MD to be able to 
process inbound and outbound messages from and to RelayHealth, Lytec MD Operator IDs and 
Provider IDs must be cross-referenced. This is done as part of the initial configuration of the 
RelayHealth Interface, and details are provided in the Lytec MD Connect - RelayHealth Inbound and 
Outbound Interfaces Guide. 

What types of RelayHealth Messages are imported? 
Imported RelayHealth messages include all message types, for example, those launched through the 
RelayHealth links "Message the Office Staff" and "Message Your Provider" as well as WebVisits, and 
"Colleague" messages.  

How can I distinguish imported new messages from copies of 
messages? 
The title of new messages imported from RelayHealth are "External Message" followed by the subject 
associated with the inbound message, and the title of copies of sent replies are "Reply to External 
Message" followed by the subject associated with the inbound message. Copies of sent replies can 
only be found in the Patient Chart; they are not sent to the Review Provider Data screen.  
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What happens if a match cannot be made for the recipient in the 
message? 
See the Imported Message Exceptions section below for information.  

What will my imported RelayHealth messages look like in Patient 
Records? 
The content of the message be included in the text of the note. The note's title will be, "External 
Message" for new messages and "Reply to External Message" for copies of sent replies followed by the 
subject associated with the inbound message.  

The following information will be included in RelayHealth Messages imported into Patient Records: 

• Date: The date and time the message was received for new messages, and the date and time the 
message was imported into Lytec MD for copies of sent replies. For example: 08/24/09 : 3:15pm  

• Title: "External Message" for new messages followed by the subject associated with the inbound 
message. For example: External Message - Hello  

"Reply to External Message" for copies of sent replies followed by the subject associated with the 
inbound message. For example: Reply to External Message - RE: Hello  

• Providers: The recipient provider(s). The provider's ID will be displayed. For example: ABC 

New RelayHealth Clinical Messages Imported into Patient 
Records 
You can view your new RelayHealth messages from the Review Provider Data screen and the Progress 
Notes section of the Patient Chart (or other Patient Chart section specified by your system 
administrator). When an imported message from RelayHealth is displayed in the note, the Reply button 
on the right-hand side of the screen will be enabled. You can click this button launch a RelayHealth 
"View Message" screen and reply to the message. For detailed information about replying to a 
message in RelayHealth, consult your RelayHealth documentation.  

Please note exceptions may occur when a message is imported. See the Imported Message Exceptions 
section for more information.  

Replying to RelayHealth Messages in Patient Records 
To reply to RelayHealth messages from the Review Provider Data screen: 

1. Open the Review Provider Data screen.  

2. If the note you are viewing is a RelayHealth message, click the Reply button. A browser window 
opens showing the RelayHealth "View Message" screen for that message. 

3. You can reply to the patient by clicking the Reply To Patient button.  

To reply to RelayHealth messages from the Patient Chart: 

1. Open the Patient Chart.  

2. Click on the tab where you chose to create your messages imported from RelayHealth.  

3. If the note you are viewing is a RelayHealth message, click the Reply button. A browser window 
opens showing the RelayHealth "View Message" screen for that message. 
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4. Click the Reply To Patient button to reply to the patient.  

Copies of sent replies to RelayHealth "clinical messages" 
imported into Patient Records 
If you reply to a RelayHealth message, your replies are stored in Lytec MD Patient Records. Reply 
messages will be imported into Patient Records as notes and stored in the Progress Notes section of 
the Patient Chart (or other Chart Section specified by your system administrator).  

Copies of RelayHealth reply messages can be distinguished from other notes in a Patient Chart by the 
note's title. The title of messages imported from RelayHealth are, "Reply to External Message" followed 
by the subject associated with the inbound message. 

Please note that exceptions may occur when a message is imported. See the Imported Message 
Exceptions section for more information.  

Viewing imported copies of message replies 
To view imported copies of sent reply messages in Patient Records: 

1. Open the Patient Chart.  

2. Click on the tab where you chose to save your reply messages imported from RelayHealth.  

3. Scroll through your list of notes. Reply messages from RelayHealth will have the title - "Reply to 
External Message". 

Imported Message Exceptions 
If the addressee of an inbound RelayHealth message cannot be matched to a provider then the 
message will be sent to Note Review Queue of the patient's Primary Provider (if there is one on file). If a 
primary provider is not specified for the patient, then the message will be sent to the default provider 
for RelayHealth messages specified during the PPConnect - RelayHealth interfaces installation. If you 
need to change the default provider for RelayHealth messages after installation, see the Lytec MD 
Connect - RelayHealth Inbound and Outbound Interfaces Guide for details. If there is no default 
provider a message will be written to the Exception Log.  

Opening your RelayHealth Home page in Patient Records 
You can open your RelayHealth Home page (to check your RelayHealth messages, compose a new 
message, or access other RelayHealth functions) from the Messages screen, Dashboard, and the Task 
Menu in Patient Records. The application uses the standard RelayHealth single sign-on approach to 
display the page for the current Lytec MD operator in a web browser window.  

The Community Messaging button, as shown on the Messages screen and Dashboard, displays the 
total number of messages and unread messages in your RelayHealth Inbox for the current Lytec MD 
operator. If you have unread messages in your Inbox, the button will be highlighted in blue (like this). 
You can click this button to open your RelayHealth Home page.  

The number of messages on the button will be refreshed every time the Messages screen or 
Dashboard is opened. The system will also automatically refresh the message count shown on this 
button at a fixed interval. Your system administrator can change the default refresh time, by updating 
the ppart.ini file setting, "MessageCountTimer".  The default interval is 60 seconds. 

For detailed information about viewing messages in your RelayHealth Inbox and the RelayHealth Home 
page, consult your RelayHealth documentation.  
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To open your RelayHealth Home page from the Messages screen: 

1. Click the Msg button in the toolbar, or select Task > Messages. The Messages screen appears.  

2. Click the Community Messaging button. Your RelayHealth Home page opens in a web 
browser window. 

To open your RelayHealth Home page from the Dashboard: 

1. Click the Dash button on the toolbar. The Dashboard opens.  

2. On the Dashboard, click the Community Messaging button. Your RelayHealth Home page 
opens in a web browser window. 

To open your RelayHealth Home page from the Task menu: 

• Select Task > Community Messaging. Your RelayHealth Home page opens in a web browser 
window. 

Sending New Messages to Patients in RelayHealth 
The RelayHealth "New Message to Patient" screen can be accessed in Patient Records from the Patient 
Chart, Lab Table Review, and Review Provider Data screens. The application uses the standard 
RelayHealth single sign-on approach to display the page for the current patient. The New Message to 
Patient page will open in a web browser window.  

For detailed information about composing a new message in RelayHealth, consult your RelayHealth 
documentation.  

To send a new message to a patient from their chart in Patient Records:  

1. Open a patient's chart.  

2. Click the Pt Msg button on the Patient Chart.  The New Message to Patient web page opens in 
a web browser window. 

To send a new message to a patient from the Lab Review (Lab Table Review screen): 

1. Open the Lab Table Review screen.  

2. Click the Pt Msg button. The New Message to Patient web page opens in a web browser 
window. 

To compose a patient message in RelayHealth from the Review Provider Data screen: 

1. Open the Review Provider Data screen.  

2. Click the Pt Msg button. The New Message to Patient web page opens in a web browser 
window. 

Viewing a Patient's Online Health Summary in RelayHealth 
You can open a patient's online health summary when in Patient Records from the patient's chart or 
from the Note Review screen.  

The application uses the standard RelayHealth single sign-on approach to display the page for the 
current patient. The RelayHealth Health Summary web page opens in a web browser window.  
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For detailed information about viewing a patient's online health summary record in RelayHealth, 
consult your RelayHealth documentation.  

To view a patient's online health summary in RelayHealth from the patient's chart: 

1. Open a patient's chart.  
2. Click the Online Health Summary button on the Patient Chart. The RelayHealth Health 

Summary web page opens in a web browser window. 

To view a patient's online health summary in RelayHealth when reviewing a note for the patient:  

1. Select Task > Review Data > Progress Notes and Documents, or hold down your left mouse 
button while clicking the Review button on the toolbar and select Progress Notes and 
Documents. Your first unsigned note displays. 

2. Click the Online Sum button. The RelayHealth Health Summary web page opens in a web 
browser window.  
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Patient Data Link 
The Lytec MD Patient Data Link (PDL) is a Web service which allows inbound and outbound 
communication between an authenticated external system (such as a hospital information system) and 
Lytec MD for the purpose of information exchange for clinical care. The Patient Data Link functionality 
allows an external system to request and receive clinical data on specific patients which can be viewed 
alongside clinical data from one or more other systems thus providing physicians with a more 
comprehensive patient record and enabling them to make more accurate decisions regarding their 
patients.  

Every time the external system linked to your Lytec MD system requests patient clinical data, Lytec MD 
creates a document that summarizes the patient clinical data in a standardized format (C32 - HITSP 
Summary Documents Using HL7 Continuity of Care Document (CCD) Component, version 2.1) and 
sends it to the external system in response to its query.  

The content of the CCD document may include patient clinical data of any or all of the following types: 

• Allergies; 

• Current medications; 

• Lab results; 

• Problems (including the procedures the patient has undergone, as entered on the Procedures 
tab of the Problems/Procedures screen); 

• Immunizations;  

• Vital signs; 

• Overdue health maintenance items. 

If overdue health maintenance items are requested for a patient, the resulting CCD document will 
include a Plan of Care section which lists all overdue health maintenance procedures for the patient. If 
overdue health maintenance items are not specified as a query criterion, the CCD document will not 
include a Plan of Care section, even if there are overdue HM items for the patient.  

Lab results, immunizations, and vital signs can be filtered by date, which means that if a starting and/or 
ending date is specified in the query parameters, the query response will only include data created 
between the selected dates. 

The PDL service helps protect patient privacy by controlling export of data based on privacy settings 
you configure. You can set up your PDL service to run in either of two privacy modes: “Opt-In” in which 
data will be shared only for those patients who are noted to have given positive affirmation that they 
want their clinical data to be shared with the end-users of the external system, and “Opt-Out” in which 
data is shared on all patients unless the patient’s record indicates that the patient has asked not to have 
their data shared using PDL. When configuring the privacy settings for the Patient Data Link 
functionality, your system administrator should choose the privacy mode that best meets your 
organizational policies and understanding of applicable laws and regulations. For more information 
see the Configuring the Patient Data Link privacy settings section.  

Note: To use the Patient Data Link functionality, you need to install two applications - PDL Processor 
and PDL Web Service. See the Patient Data Link Installation Guide for step-by-step instructions on how 
to install these applications. 

To enable the Patient Data Link functionality: 

1. Make sure all users are logged off from Lytec MD. 

2. Start PRUtils. To do this, navigate to the client folder (typically this is the PRWIN folder) and double-
click PRUtils.exe. The Lytec MD Sign In screen appears. 
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Note: Before using this utility, you must contact Lytec MD for the PRUtils password. 

3. Type your Lytec MD User ID and Password, then click OK. The Password screen appears. 

4. Type the PRUtils password provided by Lytec MD, then click OK. A message appears asking 
whether all users are off the system. 

• If some users are still logged in, click No. PRUtils closes. 

• If all users are logged out, click Yes. The Electronic Security screen appears. 

5. On the Access 1 tab, select the Enable PDL check box in the PDL section of the screen. 

6. Click OK.  

Configuring the Patient Data Link privacy settings 

The PDL service helps protect patient privacy by controlling export of data based on privacy settings 
you configure. You can set up your PDL service to run in either of two privacy modes: “Opt-In” in which 
or for data will be shared only for these patients who are noted to have given positive affirmation that 
they want their clinical data to be shared with the end-users of the external system, and “Opt-Out” in 
which data is shared on all patients unless the patient’s record indicates that the patient has asked not 
to have their data shared using PDL. Whatever privacy mode is selected applies to all PDL activity for all 
patients in your Lytec MD system.  

Designating system-level data sharing status: 
1. Make sure all users are logged off from Lytec MD. 

2. Start PRUtils. To do this, navigate to the client folder (typically this is the PRWIN folder) and 
double-click PRUtils.exe. The Lytec MD Sign In screen appears. 

Note: Before using this utility, you must contact Lytec MD for the PRUtils password. 

3. Type your Lytec MD User ID and Password, then click OK. The Password screen appears. 

4. Type the PRUtils password provided by Lytec MD, then click OK. A message appears asking 
whether all users are off the system. 

• If some users are still logged in, click No. PRUtils closes. 

• If all users are logged out, click Yes. The Electronic Security screen appears. 

5. On the Access 1 tab, select the desired privacy mode for the Patient Data Link in the Privacy 
Mode field. Click the arrow button to select one of the two available options: 
• Select Opt-in if your practice wants to only share data on patients who give positive 

affirmation that they want their clinical data to be shared with the end-uses of the external 
system linked to your Lytec MD system through PDL. In this privacy mode, PDL will only 
return data on patients who have been specifically noted to have opted in to having their 
clinical data shared through PDL. If a PDL query is received on a patient who has not been 
marked as “Opt-In”, the PDL response will not even indicate that the patient exists in your 
system; the response will be identical to that when a patient is not found. 

• Select Opt-out if your practice wants to share data on all patients except those who 
specifically request that their clinical data not be shared with the end-users of the external 
system linked to your Lytec MD system through PDL. In this privacy mode, PDL will return 
data on any patient who has not been specifically noted to have opted out to having their 
data shared through PDL. If a PDL query is received on a patient who has been marked as 
“Opt-Out”, the PDL response will not even indicate that the patient exists in your system; 
the response will be identical to that when a patient is not found. 
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6. Click OK.  

Designating patient-level data-sharing status with the “Opt-In” 
privacy mode: 
Note: The following steps apply if you have chosen to use the “Opt-In” privacy mode for your 
organization.  If you have chosen to use the “Opt-Out” privacy mode, see the Designating patient-level 
data-sharing status with the “Opt-Out” privacy mode section below. 

1. Select File > Open Patient, or click the Patient button on the tool bar. The Lookup screen 
appears.  

2. Enter the search criteria and then click the Lookup button. The patients who match your criteria 
appear at the bottom of the Lookup screen.  

3. Highlight the patient you want to set up privacy mode for and click the OK button. 

4. Select the Other Data tab. 

5. In the Opt-In PDL field, type Y if the patient has opted-in (agreed to share their clinical data 
through PDL). Type N (or leave blank) if the patient has not opted-in (does not want to share 
their clinical data through PDL). 

6. Click OK. 

Designating patient-level data-sharing status with the “Opt-Out” 
privacy mode: 
Note: The following steps apply if you have chosen to use the “Opt-Out” privacy mode for your 
organization.  If you have chosen to use the “Opt-In” privacy mode, see the Designating patient-level 
data-sharing status with the “Opt-In” privacy mode section above. 

1. Select File > Open Patient, or click the Patient button on the tool bar. The Lookup screen 
appears.  

2. Enter the search criteria and then click the Lookup button. The patients who match your criteria 
appear at the bottom of the Lookup screen.  

3. Highlight the patient you want to set up privacy mode for and click the OK button. 

4. Select the Other Data tab. 

5. In the Opt-Out PDL field, type Y if the patient has opted-out (does not want to share their 
clinical data through PDL). Type N (or leave blank) if the patient has not opted-out (has not 
specifically requested that their clinical data not be shared with the end-users of the external 
system linked to your Lytec MD system through PDL). If a patient has not specifically opted-out, 
Lytec MD will share the patient's clinical data with external systems when they request it from 
Lytec MD through PDL.  

6. Click OK. 

Notes:  
- The Opt-In PDL and Opt-Out PDL fields are automatically added as user-defined fields on the Other 
Data tab of the Patient screen when you install PDL on your computer. If you select the "Opt-In" privacy 
mode during the installation, the Opt-In PDL field will be added as a patient user-defined field. If you 
select the "Opt-Out" privacy mode, the Opt-Out PDL field will be added as a patient user-defined 
field.  
- If your system administrator has changed the privacy mode after installing PDL, you will have to 
manually create an Opt-In PDL or Opt-Out PDL user-defined field, depending on the selected privacy 
mode.  
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Speech recognition using Dragon NaturallySpeaking® 
Note: To use Dragon NaturallySpeaking with Lytec MD, your system administrator must set the 
Use_Speech ppart.ini setting to ON. 

The Dragon NaturallySpeaking add-on module adds speech recognition to Lytec MD, so you can use 
voice commands to navigate through Patient Records or Appointment Scheduler and turn your speech 
into text in notes and messages. 

The recommended system requirements for this feature include a ScanSoft-approved USB noise-
canceling headset microphone and Dragon NaturallySpeaking installed locally on the workstation. 
Refer to the Dragon NaturallySpeaking documentation for additional system and hardware 
requirements. While you can use a ScanSoft-approved sound card and a serial microphone, we 
strongly recommend using a USB microphone. 

If you already use Dragon and have set up a voice profile, we recommend storing the voice profile file 
on the network, so that you can import the file through the Manage Users option onto different 
workstations, as needed. 

As you use Dragon, you can continue to train the software so that it becomes more accurate the more 
you use it. One method is to use the "correct that" command, which works on the currently-selected 
word or phrase. This command displays a list of alternative words or phrases. If the word or phrase you 
want is not listed, you can say or click "spell that" and type in the correction. This teaches Dragon the 
new word or phrase. You can also use the Words > Train menu, which is comparable to saying "correct 
that." Finally, depending on how Dragon is configured, you can simply say "select [word]" and a list of 
alternatives for [word] will display. To select the word you want (listed by #), say "choose [#]." 

Location of voice files 
You can copy or move your voice files to another system. To access them, open the following 
NaturallySpeaking directory where the voice files are typically stored: 

c:\Program Files\Dragon\NaturallySpeaking\Users\YourProfileName 

Setting up the speech recognition feature 
This section provides a general overview. For specific details on setting up Dragon NaturallySpeaking, 
refer to the Dragon documentation. To set up the speech recognition feature, you must: 

• Make sure your system administrator set the Use_Speech in ppart.ini setting to ON. 

• Install Dragon NaturallySpeaking on the workstation. 

• Install a microphone and speakers on the workstation. 

• If you do not already use Dragon, create a new user profile. You can do this within Lytec MD by 
selecting Speech Recognition from the Task menu, and then clicking New. Complete the new 
user training to teach Dragon to recognize your voice. To improve accuracy, you must train 
Dragon to recognize your speech patterns and voice. 

• If you already use Dragon, import your existing voice profile onto the workstation. 

Accessing the speech recognition feature 
To open the speech recognition feature: 

1. Select Speech Recognition from the Task menu. Select your voice profile from the list and 
press OK. 
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2. Turn on the microphone by clicking the microphone icon at the lower right corner of the 
Windows task bar. The microphone is on when it is vertical (pointing up). 

   Pause Dragon (put it in sleep mode) when a note is open by saying "Go to sleep" or "Stop 
listening." Dragon still listens while in sleep mode, but it responds only to "Wake up" or "Listen 
to me." If a note is not open, pause or reactivate Dragon by clicking the microphone icon. 

3. When finished, turn off the microphone by clicking the microphone at the lower right corner of 
the Windows task bar. You can also say "Microphone off." The microphone is off when it is 
horizontal. 

Dragon NaturallySpeaking voice commands 
You can open any of Lytec MD's menus through the Dragon NaturallySpeaking voice commands. 

• Commands Specific to Lytec MD 

• NaturallySpeaking Commands that work with Lytec MD 

Commands Specific to Lytec MD 
The tables below display the voice commands that are specific to Lytec MD. You can also use most of 
Dragon NaturallySpeaking's voice commands. 

• Editing a note 

• Editing a note and the template list open 

Editing a Note 
Press the CTRL key when speaking these commands. 

Command Description 

Backspace Move the cursor back one space. 

Bold Turns bold formatting on or off. 

Center Center the text. 

Close Chart Same as clicking Close Chart on the File menu. 

Close Schedule Same as clicking Close Schedule on the File menu. 

Delete That Delete the next letter. 

Expand That Expand the current label marker. 

Insert Allergies Insert the patient's allergies. 

Insert Blood Vitals Insert the patient's current blood vitals. 

Insert Bookmark Insert a bookmark. 

Insert Current 
Medications 

Display the current medication screen. 

Insert Diagnosis Insert the patient's diagnosis. 

Insert Family History Insert the patient's family history. 

Insert Height Vitals Insert the patient's height & weight vitals. 

Insert Image Display the image list. 

Insert Label Insert a label. 
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Insert Letter Template Display the letter template list. 

Insert Linked File Display the linked file screen. 

Insert Major Problems Insert the patient's major problems. 

Insert Other Problems Insert the patient's other problems. 

Insert Page Setup 
Template 

Display the page setup template list. 

Insert Past Medical 
History 

Insert the patient's past medical history. 

Insert Patient Education 
Link 

Display the patient education link screen. 

Insert Previous Note Display a list of the patient's previous notes. 

Insert Problem Display the patient's problem list. 

Insert 
Problem/Diagnosis 
Code 

Display the problem code list. 

Insert Procedure Code Display the procedure code list. 

Insert Procedures Insert the patient's procedures. 

Insert QuickText Display the QuickText list. 

Insert Record Dictation Display the record dictation screen. 

Insert Social History Insert the patient's social history. 

Insert Sound File Display the sound file screen. 

Insert Template Display the template list. 

Insert Time Insert the current system time. 

Italic Turns italic formatting on or off. 

Justify Line up the text with both the left and right margins. 

Left Justify Line up the text with the left margin. 

Lookup <Name> Letter 
Template 

Display the template list with the specified letter template <Name> 
highlighted. 

Lookup <Name> 
Template 

Display the template list with the specified note template <Name> 
highlighted. 

Messages Same as clicking Messages on the Task menu. 

Move Down Move the cursor in the edit window down by one line. 

Move Left 
Move Right 

Move the cursor left or right. You can also specify the number of spaces to 
move. For example, "Move Left 6" would move the cursor left six spaces. 

Move Up Move the cursor in the edit window up by one line. 

New Guarantor Same as clicking New Guarantor on the File menu. 

New Line Enter a carriage return. 

New Note Start a new note for the current patient. 

New Patient Same as clicking New Patient on the File menu. 

Next Label Jump to the next label marker. 

Open Chart Same as clicking Open Chart on the File menu. 
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Open Guarantor Same as clicking Open Guarantor on the File menu. 

Open Insurance Same as clicking Open Insurance on the File menu. A patient or chart 
must be opened before using this command. 

Open Patient Same as clicking Open Patient on the File menu. 

Open Schedule Same as clicking Open Schedule on the File menu. 

Park Application Same as clicking Park on the File menu. 

Previous Label Jump to the previous label marker. 

Review Lab Tables Same as clicking Lab Tables on the Review Data submenu, which is on 
the Task menu. 

Review Progress Notes Same as clicking Progress Notes and Documents on the Review Data 
submenu, which is on the Task menu. 

Right Justify Line up the text with the right margin. 

Show Label List Display the available labels for the current label marker. 

Tab Key Jump to the next label marker. 

Underline Turns underline formatting on or off. 

Editing a note and the template list open 
Do not press CTRL when speaking these commands. 

Command Description 

Insert Item Inserts what is currently highlighted into a progress note. For example, this 
command might be used from Note Template to insert a particular 
template. 

Move Up Move up one line in the template list. 

Move Down Move down one line in the template list. 

Cancel Button Press Cancel. 

NaturallySpeaking Commands that work with Lytec MD 
The tables below display some of the Dragon NaturallySpeaking commands that should work in Lytec 
MD. 

• Navigation 

• Selecting text 

• Formatting text 

• Cut and paste text 

• Punctuation 

• Help 

Note: A few voice commands require pressing the CTRL key. Some only require pressing CTRL when 
they are not recognized as a command. Other commands prohibit pressing CTRL. There is a label for 
each table as to pressing CTRL with the command.   

Navigation 
Press CTRL when speaking these commands. 
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Command Description 

Insert Before <Words> Move the cursor before <words>. 

Insert After <Words> Move the cursor after <words>. 

Do not press CTRL when speaking these commands. 

Command Description 

New Line Enter a carriage return. 

New Paragraph Insert a new paragraph. 

Space Bar Insert a space. 

Only press CTRL when Dragon NaturallySpeaking does not recognize these as commands. 

Command Description 

Tab Key Press the TAB key. 

Go to Bottom Move to the end of the document. 

Selecting text 
Only press CTRL when Dragon NaturallySpeaking does not recognize these as commands. 

Command Description 

Select <Words> Select <words>. 

Select Again Select the same words again. 

Formatting text 
Only press CTRL when Dragon NaturallySpeaking does not recognize these as commands. 

Command Description 

Cap <Words> Start the next word with a capital letter. 

All Caps <Words> Type <words> in all capital letters. 

Do not press CTRL when speaking these commands. 

Command Description 

Bold That Bold the selected text. 

Underline That Underline the selected text. 

Cut and paste text 
Only press CTRL when Dragon NaturallySpeaking does not recognize these as commands. 

Command Description 

Copy That Copy the selected text. 

Cut That Cut the selected text. 

Paste That Paste the selected text. 
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Scratch That Delete the last thing said. 

Punctuation 
Do not press CTRL when speaking these commands. 

Command Description 

Period Insert a period. 

Comma Insert a comma. 

Question Mark Insert a question mark. 

Exclamation Mark Insert an exclamation mark. 

Colon Insert a colon. 

Semicolon Insert a semicolon. 

Dash Insert a dash. 

Open Quote Insert an open quote mark. 

Close Quote Insert a close quote mark. 

Open Parenthesis Insert an open parenthesis. 

Close Parenthesis Insert a close parenthesis. 

Help 
Do not press CTRL when speaking these commands. 

Command Description 

What Can I Say Display the Lytec MD online help. 

Correct That Displays the Dragon correction menu. 

Some dictation tips 
• Make sure that the microphone is always the same distance from your lips.  Use the same 

configuration as when you trained Dragon initially. This improves accuracy. 

• Learn how to refine Dragons voice profile.  

• Pronounce each word clearly and distinctly. 

• Speak all punctuation (say "comma," "period," and so on). 

• Pause before and after saying commands. 

• Do not speak in a dull monotone. Dragon NaturallySpeaking is more likely to process your words 
accurately when you use your normal inflection. 

• Watch the dictation as Dragon processes it, to make sure it is rendered accurately. Maintain your 
train of thought by dictating a paragraph or two at a time, then go back and make corrections if 
necessary. 

• Stay hydrated! Drink lots of water.  
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More information on Dragon NaturallySpeaking 

Creating user files 
Before beginning to use Dragon NaturallySpeaking, create a set of user files. Your user files store 
acoustic information about your voice that Dragon NaturallySpeaking uses to recognize what you say. 
These files also store any changes you make to the standard Dragon NaturallySpeaking vocabulary, for 
example, any specialized words, names, acronyms, and abbreviations you might add. 

Your name 
A name you choose for your user files. Names can contain up to 128 characters including spaces. 
Names are not case-sensitive. You cannot create names that are the same except for capitalization. For 
example, you cannot create both Jean and jean as user names. 

Language 
The language or dialect (such as US English or UK English) in which you will be dictating. Your choices 
will depend on the Dragon NaturallySpeaking edition. 

Dictation source 
The type of device into which you will be speaking. The most common choice is a headset microphone 
plugged into the mic-in jack of your computer. Check the list to be sure that you have selected the 
correct source. 

Vocabulary 
The vocabulary list is available only if your edition and language let you choose among different types 
of vocabularies, such as the General vocabulary optimized for adult and business use, a Teens 
vocabulary for student use, or a Commands Only vocabulary for using Dragon NaturallySpeaking only 
to control computer and not for dictation. Check the list to see the available choices.  

Advanced 
Click the Advanced button to open a dialog box of advanced features that let you change the speech 
model and vocabulary levels from those recommended for your computer processor speed and 
memory (RAM). 

Notes 

• A new set of user files requires between 10 and 35 MB of hard-disk space. The exact amount 
depends on the particular speech model and vocabulary you select. 

• You can click Cancel to exit. The program remembers which steps you have completed so you 
can continue training at the current step the next time you open the user. 

• If you are using Windows 2000 as a restricted user, an administrative user must install Dragon 
NaturallySpeaking and create the first user.  

About speech models 
When you create a set of user files, you select a "speech model" on which to base the new user. A 
speech model includes an acoustic model that you adapt for your particular voice. 
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When you create a set of user files, Dragon NaturallySpeaking recommends the adult speech model 
that best fits your computers speed and memory. If you want to use the Teen model, you must choose 
US English as the language.  

Notes 

In Dragon NaturallySpeaking, you can choose between the following speech models: 

• BestMatch, which provides excellent recognition accuracy for general, business, and 
professional dictation. BestMatch is recommended for computers with at least 96MB of system 
memory and a processor speed of at least 300 MHz. 

• BestMatch III, which has the greatest recognition accuracy. Recommended for computers with at 
least 128MB of system memory and processor speeds of at least 450 MHz.  

About vocabularies 
A vocabulary in Dragon NaturallySpeaking is a body of information that includes a word list and a 
language model. The word list includes information about all the words that the program can 
recognize. The language model contains usage information about those words. Dragon 
NaturallySpeaking uses a vocabulary to recognize words correctly based not only on the sound of the 
words, but on their context. When you create a new user, you select the vocabulary on which to base 
the user. When you create a new user or new vocabulary for an existing user, you select the vocabulary 
on which to base the vocabulary you create.  

Vocabulary type 

You can select from among the following vocabularies: 

• General (US English)  A large vocabulary providing excellent recognition accuracy for general, 
business, and professional dictation. 

• Commands Only  A limited vocabulary containing only command words and phrases. Choose 
this vocabulary if you want to use Dragon NaturallySpeaking only for command and control of 
programs and not for dictation. 

• Teens (US English only)  A large vocabulary containing words selected for a student population 
and providing excellent recognition accuracy for higher pitched voices, for example ages 11 
through 18. 

Vocabulary size 

When you create a set of user files, Dragon NaturallySpeaking recommends the vocabulary that best 
fits your computers speed and memory. If you click the Advanced button, you can specify a different 
vocabulary size from among the following choices: 

• Extra Small. Designed for computers with less than 64 MB of RAM. 

• Small. Designed for computers with between 64 and 96 MB of RAM. 

• Medium. Designed for computers with between 96 and 128 MB of RAM 

• Large. Designed for computers with at least 150 MB of RAM. 

• Empty Dictation. A vocabulary with a language model but no words. This vocabulary is 
designed for use by value-added re-sellers who want to create specialized vocabularies. 

Advanced settings 
On the Create User screen of the New User Wizard, you can click the Advanced button to display the 
Advanced dialog box. On this dialog box, you can choose a different speech model and vocabulary 
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size. Dragon NaturallySpeaking automatically determines the best speech model and vocabulary size 
for your computer when you create a user, so you do not generally need to change these options.  

Note: Some Dragon NaturallySpeaking editions or add-on products may install additional 
vocabularies.  

Recording dictation 
Lytec MD provides a built-in digital dictation recorder. When writing a note, you can record dictation by 
simply using a microphone. The recorded dictation is saved in the note as a digital .wav file. You (or a 
transcriptionist) can play back recorded dictation from the progress note. 

Lytec MD’s recorder is similar to a tape recorder. The recorder screen provides the standard record, 
play, stop, rewind to beginning, and forward to end buttons. The screen specifies the dictation’s length 
in seconds and minutes, and uses a sliding bar to indicate the current position/time when playing back 
dictation. You can jump to a specific place in the dictation by moving the sliding bar. You can also enter 
a title for the recording that is used in the .wav file name. 

Dictation files appear in notes as SLINK labels, with the following format: 

<<SLINK:Title|FileID\filename.extension>> 

For example:  

<<SLINK: Abdominal_pain_history|20428913\Abdominal_pain.wav>> 

The .wav files provide portability. You can send the files to a transcriptionist, who can play back the files 
with any Windows-based audio software.   

Refer to the Windows documentation for instructions on installing and setting up a recording device. 
You must have speakers installed on the PC to listen to the dictation playback. 

Note: The access level for this item applies only to recording dictation. Anyone with access to the note 
can play back the dictation. 

Recording dictation for notes 

To record dictation for a note: 

1. Place the cursor at the point in the progress note where you want to insert the dictation file. 

2. Select Insert > Record a Dictation. The Recording screen appears. 

3. In the Title of File field, type an optional name for the file. This name will display in the note in 
front of the dictation's link. 

4. Click the start button, and record the dictation. 

5. Click the OK button. 

To play back dictation in a note: 

• In the note, click the recording (SLINK) label. If you entered a title, the label name begins with 
that title. The Recording screen appears. 
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Click the play button to listen to the dictation. Jump to any point in the dictation by moving the 
slide bar, or rewind to the beginning or forward to the end of the dictation. Add to the dictation 
by going to the end of the dictation and clicking the record button. Record over any part of the 
dictation by moving the slide bar to the section you want to change, then clicking the record 
button.  
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Drug route abbreviations 
Lytec MD uses standard abbreviations for drug routes.  

The following table lists the abbreviations and their descriptions. Use these abbreviations when 
entering information directly in the Rx/Medications section of the patient chart or in the Text Data 
Loader.  

Field Description 

BU  Buccal  

CO Combination of the above 

EX  External  

IJ  Injection (not specified)  

IM  Intramuscular injection  

IN Inhalation  

IR  Irrigation  

IT  Intrathecal injection  

IU Intrauterine  

IV Intravenous  

MT Mouth/throat  

NA Nasal  

OP Opthalmic  

OR  Oral  

OT  Otic  

RE Rectal  

SC  Subcutaneous  

SL Sublingual  

TD  Transdermal  

UR  Urethral  

VA  Vaginal  

VI  In vitro  

XX Does not apply  
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Medication abbreviations 
Lytec MD uses standard abbreviations for medications. When you print the medication list for a patient, 
medication terms are automatically translated. Also, if you marked the “Translate Sig” check box, Latin 
terms will be translated into everyday English (for example, it will translate "Qd" into "daily").  

The following table lists some terms and their descriptions.  

Term Description 

qd daily (once each day) 

bid twice each day  

tid  three times each day  

id  four times each day  

5xd  five times each day  

am  once each morning  

pm  once each afternoon  

Nh  every N hours (where N is 1 to 24)  

prn  as needed  
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Adding Organization Numbers to your system 
The Lytec MD organization number is used to identify your site when using the Continuity of 
Care Documents (CCD) import/export feature. The organization number will also be required 
for future Lytec MD integration features. If you are using the CCD import/export feature you 
must enter your organization number in the PP ORG NUM field on the Practice Maintenance 
screen’s Other Data tab after upgrading or installing Patient Records. If you do not enter your 
organization number, CCD documents will be created in error. To obtain your Lytec MD 
organization number for your practice(s), please go to the Customer Support Web site. After 
logging in, you can find your organization number listed under the Main Contact section as 
Cust # (e.g., Cust #01234). 

To specify the practice's Lytec MD organization number: 

1. Select Maintenance > Practices. The Practices Maintenance Select screen appears. 

2. Select the practice for which you want to add the organization number for, and then 
click the Edit button. The Practice Maintenance <Edit> screen appears.  

3. Click the Other Data tab.  

4. Enter the organization number for the selected practice in the PP ORG NUM field. 

5. When you are finished, click the OK button.  

6. Repeat steps 2-4 until you have entered your organization number for each practice.  

7. Click OK to return to the Practices Maintenance Select screen. 

If you do not have the PP ORG NUM field located on the Practice Maintenance screen’s Other 
Data tab you can add the field manually.  

To add the PP ORG NUM field:  

1. Select Maintenance > Configuration > Define Other Data > Practice. The Practice 
Define Other Data Select screen appears.  

2. Click the New button. The Practice Define Other Data <New> screen appears.  

3. Type PP ORG NUM in the Label field. 

4. Type Lytec MD Organization Number in the Description field.  

5. Select Numeric from the Type drop-down list.  

6. Select From 0 to 999,999,999 from the Format drop-down list.  

7. When you are finished, click the OK button.  
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Additional Screens 

Allergies screen  
The Allergies screen appears when you click the Allergies button on the Patient Information 
screen. The Allergies screen lists the allergies or intolerances that have been entered on the 
patient chart’s Rx/Medications tab.  

Alternative Drugs screen 
When you click the Alternative button while adding a prescription template or writing a 
prescription, Lytec MD displays all drugs in the Drug Interaction database that are in the same 
class as the drug entered in the medication field, along with their costs. To use one of the 
alternative medications, highlight the medication that you want, and click the OK button. When 
you display drug alternatives, Lytec MD only displays drugs with the same route. To use Route, 
enter a two-letter abbreviation (for example OR for oral or IN for inhalation). To view all routes, 
leave the Route field blank. 

Archive Patient Data - Selection Criteria Screen  
Using the Archive Patient Data – Selection Criteria screen, you can indicate the patient data that 
you want to archive.  

The first step is to select whether you want to archive data for:  

• Patients scheduled with a specific provider. You can also indicate specific from/to dates 
and a specific practice.  

• Patients not seen since a specific date.  

• Patients registered between specific dates (from/to dates).  

• No date selection. This means that all patients who meet the additional criteria you enter 
will be archived.  

Once you select one of these options, you can enter additional criteria. These include:  

• Usual provider, as entered in the Usual Provider field on the Patient Internal Provider 
screen.  

• Attending provider, as entered in the Attending field on the Patient Internal Provider 
screen. The attending provider feature must be selected on the Demographic Settings 
screen.  

• Primary provider, as entered in the Primary Provider field on the Patient screen’s 
Providers tab.  

• Usual (default) practice, as entered in the Practice field on the Patient Internal Provider 
screen. To make a practice the usual practice, mark the Default check box.  

• Patient status (such as deceased), as entered in the Status field on the Patient screen’s 
General tab.  

• Patient note, as entered on the Patient screen’s Notes tab.  

• Note function (such as Scheduler or Patient), as entered on the Patient screen’s Notes 
tab.  

When you finish entering your criteria, click the OK button. The Archive Drive and Pathname 
screen appears.  
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Attachments Screen 
The Attachments screen displays when you click the Attachments button to add files to a 
message. When you finish adding attachments, click the Close button to return to the 
message. The Attachments button will display the number of files attached to the message. 

To add an attachment: 

• Click the New button, then browse to the file. Click the Open button. The attachment will 
display in the box on the left of the Attachments screen. 

To view an attachment: 

• Highlight the attachment, then click the View button. The attachment will display in the 
file type's default program (for example, the default program for .bmp image files on 
your computer might be Microsoft Paint). When you finish viewing the attachment, close 
the default program. 

To delete an attachment: 

• Highlight the attachment, then click the Delete button.  

Audit Report Explanation screen 
When you delete information from Lytec MD (for example, when you delete a guarantor), the 
Audit Report Explanation screen may appear. For tracking and audit purposes, type a reason 
that the information is being deleted.  

Auto Saved Notes List screen 
This screen displays HTML-based progress notes that were recovered when Lytec MD or your 
computer crashes.  

Cancelled Reason screen 
If you have the appropriate access level and you change an order’s status to cancelled, the 
Cancelled Reason screen appears. You can use this screen to add a reason that the order was 
cancelled.  

Canceling an order leads to a Cancellation Form being printed, an electronic transmission of 
the cancellation, or both. The reason will print on the form. 

Carrier Select Screen  
This screen displays the list of insurance carriers. You can either:  

• Scroll through the list and highlight the insurance carrier that you want to use.  

• Mark the Code radio button and type the insurance carrier's ID in the field. Click the 
Search button. The insurance carrier that most closely matches the code will be 
highlighted in the list.  

• Mark the Description radio button and type the insurance carrier's description in the 
field. Click the Search button. The insurance carrier that most closely matches the 
description will be highlighted in the list.  

When the appropriate insurance carrier is selected, click the OK button.  
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Changing the Search Type Using the Keyboard  
To change the search type without a mouse, press Tab to move to the currently marked radio 
button (the radio button is selected when a dotted box appears around the button's name). 
Then press the arrow key to move to the next radio button.  

Chart Selection screen 
Use this screen to enter your criteria, including scheduled provider and scheduled dates. 
When you finish, click the OK button. 

Denial Reason Screen  
If you have the appropriate access level and you change an order’s status to denied, the Denial 
Reason screen appears. You can use this screen to add a reason that the order was denied 
authorization.  

Import Medical Summary: Detail Selection screen 
Use this screen to select the patient data you want to import as "discrete" data into the 
patient's Problem List, Medications, etc. The screen displays content from the CCR or CCD 
being imported. If the item has a + you can click it to expand the list. When the first level item is 
selected, all items in the list will be selected. To un-select an item click the corresponding 
check box. To re-select an item click the corresponding check box. You can click the – to close 
the list. 

The first level items correspond to the following sections of the document. Advance directives 
will not be displayed on this screen. Instead they will be automatically stored in the Chart 
section specified in the "MedSummAdvanceDirectivesSection" setting in the PPart.ini file. 

If the document has no data for sections described below the section will not be displayed on 
the screen. 

• Problems  

• Family History 

• Social History 

• Alerts (includes Allergies) 

• Medications 

• Immunizations  

• Vital Signs 

• Results 

• Procedures 

• Encounters - Encounters will be stored in the Chart section defined by the 
"MedSummEncounterSection" setting in the PPart.ini file. 

• Plan of care - Plan of care will be stored in the Chart Section defined by the 
"MedSummPlanOfCareSection" setting in the PPart.ini file. 

Notes:  
- The name and description of the sub-items for Problems, Family History, Social History, Alerts, 
Medications, and Plan of care will be displayed. For example, under Problems you may find the 
sub-item "Hypertension". 
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- The name, description and date of entry of sub-items for Immunizations, Vital Signs, Results, 
Procedures, and Encounters will be displayed. For example, under Vital Signs you may find the 
sub-item "1/20/08 4:00:00 PM – Pulse". 
 
- The Support, Functional Status, and Medical Equipment sections of the document do not 
have a correlate in discrete data elements in Patient Records and will not appear as nodes on 
the tree. 

Diagnosis Code Select screen 
This screen displays the list of diagnosis codes. You can either:  

• Scroll through the list and highlight the diagnosis code that you want to use.  

• Select the Office Code radio button and type the diagnosis code's ID in the field. Click 
the Search button. The diagnosis code that most closely matches the code will be 
highlighted in the list.  

• Select the Word radio button and type a word from the diagnosis code's description. 
Click the Search button. The closest match to the word will be highlighted in the table. 
The entire list starting at the beginning of diagnoses that contain this word will be listed. 
 Please note that since the entire list of diagnoses that contain the word is visible, starting 
at the top, the up arrow button will not scroll up any further.  

• Select the Short Description radio button and type the first few characters of the 
diagnosis code's short description in the field. Click the Search button. The diagnosis 
code that most closely matches the description will be highlighted in the list.  

• Select the Long Description radio button and type the first few characters of the 
diagnosis code's long description in the field. Click the Search button. The diagnosis 
code that most closely matches the description will be highlighted in the list.  

When the appropriate diagnosis code is selected, click the OK button.  

Inserting diagnosis codes into notes 
When the patient chart is open you can insert diagnosis codes into patient notes, by clicking 
the Pb/Dx button on the tool bar. This opens the Diagnosis Code Select screen. 

To insert a diagnosis code into a note: 

1. Select a diagnosis code from the list that you want to use or, select a radio button and 
type the diagnosis code's description. Click the Search button. The closest match to 
the word will be highlighted in the table.  

 You can also click the CodeWizard button to access Alpha II's CodeWizard. Use the 
CodeWizard to look up supporting diagnosis codes. 

2. Select an Insert into Text option. 
• Short Description: Select this option to insert the diagnosis code's short 

description into the note. 

• Long Description: Select this option to insert the diagnosis code's long 
description into the note. 

• Both: Select this option to insert the diagnosis code's short description and long 
description into the note. 

3. Select an Insert As option. 
• Major Problem: Select this option to insert the diagnosis code as a major 

problem into the note.  
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• Other Problem: Select this option to insert the diagnosis code as a other problem 
into the note.  

• Diagnosis: Select this option to insert the diagnosis code as a diagnosis into the 
note.  

4. Click OK, when finished. This will insert the selected diagnosis code into the note.  

Changing the Search Type Using the Keyboard  
To change the search type without a mouse, press Tab to move to the currently marked radio 
button (the radio button is selected when a dotted box appears around the button's name; in 
the example below, the Office Code button is currently selected). Then press the arrow key to 
move to the next radio button.  

 

 

Display Notes 
The Notes feature displays selected notes for a guarantor or patient each time Guarantor or 
Patient opens, respectively. For example, if the "guarantor" function is added to six notes, 
those notes will display each time Guarantor opens. Because more than one note may be 
selected to display, Lytec MD groups the notes into Display Notes.  

When opening a dialog that has notes attached by function, Display Notes opens in front of 
the dialog. It displays the note or notes for the guarantor or patient. If there is only one note, 
the entire note text displays on Display Notes. If there are two or more notes, the first two lines 
of each note displays. Use the arrow buttons to scroll through the note text.  

Notes may be viewed, edited, or deleted directly from Display Notes:  

• To view or edit a note, click Edit. The note displays in Patient Note.  

• To delete a note, click Delete.  

Duplicate Name Check Screen  
Depending on how your system is set up, the Duplicate Name Check screen may appear while 
you are registering patients and guarantors.  

If you have the Duplicate Name Check feature turned on, when you move out of the name, 
SSN, and birthdate fields, the system checks to see if a patient or guarantor with the same 
name already exists. If one does, then the Duplicate Name Check screen appears.  

• If the match is actually another patient or guarantor with the same name, click the Close 
button to return to the Patient or Guarantor screen so that you can continue data entry.  

• If the patient or guarantor already exists in the program, click the Cancel New button. 
This closes the Patient or Guarantor screen.  
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Duplicate Order screen 
This screen displays when Check for Duplicates is selected in Special Features on the Order 
Entry 1 tab. This setting determines whether the system checks for duplicate orders within a 
given number of days which you also specify on the Order Entry 1 tab.  

The check is made when an order is moved from the order tree to the order list (on the Order 
screen). If duplicates are found, the Duplicate Order screen appears. Since you can legitimately 
add duplicate orders, you can either go ahead and add the duplicate order (click the OK 
button on the message) or cancel the order (click the Cancel Order button). 

This feature also works when orders are added through Dot codes. It does not currently work 
when orders are added through the Text Data Loader. 

EEF Template Lookup Screen  
This screen displays the list of electronic encounter form templates. You can either:  

• Scroll through the list and highlight the template that you want to use.  

• Type the template ID in the field. Click the Search button. The template that most closely 
matches the ID will be highlighted in the list.  

When the appropriate template is selected, click the OK button.  

Enter Filename to Print screen 
This screen appears when you select to print Lab Data Loader or Text Data Loader files (such as 
error files). 

Enter the name of the error file (for example, MDNOTE.ERR). If the file you are loading is in a 
different directory than Patient Records, enter the file’s name and path (or click the Dir button 
to search for the file). 

Enter Insurance Carrier ID Screen  
Enter the ID of the insurance carrier you want to use.  

Enter Signature Screen  
If the electronic signature feature is enabled on the provider maintenance screen, the Enter 
Signature screen appears. Type your signature, and then click the OK button.  

Note: Providers are not allowed to sign notes with a signature of zero (0). 

Enter Specialty ID Screen  
Enter the ID of the provider specialty you want to use.  

Establish Patient Identity screen 
After you have selected the CCR or CCD that you want to import the Establish Patient Identity 
screen is displayed. You can use this screen to verify that the patient being imported from a 
document exists in the Lytec MD database. If there is not a match, you can add the patient to 
the database with the demographic information shown on the screen by clicking the New 
Patient button.  
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The imported patient's demographic information is displayed at the top of the screen. This 
information includes the patient's last name, first name, middle initial, and date of birth. The 
rest of the screen's functionality is similar to that of the Lookup screen. The screen defaults to 
the General tab, and the patient's first name, last name, and middle initial are displayed in the 
corresponding fields.  

Note: The Edit Patient button does not apply to this feature.  

To verify whether the patient exists in the Lytec MD database: 

• Click the Lookup button. If there is a match the patient's name will appear at the bottom 
of the Establish Patient Identity screen. Select the patient's name in the list and click the 
OK button.  

To add a new patient: 

• Click the New Patient button. You will receive a confirmation message, click the Yes 
button to proceed. You can use the Patient screen to update the patient's information.  

Extended Orders screen 
This screen displays the user-defined extended order fields associated with an order you 
selected. Fill in the appropriate information. Required fields are in bold. 

If you don't want to enter data in the fields when adding an order, click the OK button. Clicking 
Cancel will cancel the order (the order will not be selected). 

You can toggle to a multi-line text box screen by pressing CTRL+ENTER. The multi-line screen 
displays the maximum number of characters you can enter, as set by your system administrator, 
in the bottom right corner. 

If you need to indicate a referring source for the order, click the Referral button and select the 
appropriate referring source. 

Note: This screen can also be accessed from the extended order maintenance screen when 
testing an extended order. 

Extended Sig screen 
You can use the Extended SIG screen to select an extended sig template when writing a 
complicated prescription. The template text will replace the text in the Extended SIG field on 
the Prescription screen. You can also append the template text to the text in the Extended SIG 
field by selecting the Append to Existing Text check box.  

See the Extended SIG (Signature) Templates section for a complete explanation of setting up 
extended sig templates.  

To open the Extended SIG screen: 

• Open the Prescription screen, and then select the Use Extended SIG check box. In the 
Extended Sig frame, click the Lookup button. The Extended SIG screen appears. 
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Fields on the Extended Sig screen 

Field Description 

Search area Allows you to search for an existing extended sig template. 
Type a full or partial template ID code in the search field, and 
then click the Search button. The template with the closest 
matching code or description is selected in the template list. 

Extended Sig Template list Lists the extended sig templates that have already been set up 
in Patient Records. 

Append to Existing Text Select to append the template text to the text in the Extended 
SIG field on the Prescription screen. If the text exceeds 250 
characters the appended template text will be truncated.  
If not selected, the template text will replace the text in the 
Extended SIG field.  

Fax To screen 
When the Fax button or fax option is selected for notes and reports, the Fax To screen 
appears. This screen allows you to send your notes and reports via fax server to a referring 
source, patient, or other source.  

To send a fax: 

1. Select a "Fax To" option. Your choices are: 
• Referring Source: Select this option to send your fax to a referring source(s). Click 

the OK button. The Referring Source for Fax screen appears. 

Important: Fax numbers for referring sources must be entered before a fax can be sent 
to them. You can enter the referring source's fax number from the Referring Source 
Maintenance screen.   

• Click one of the following buttons on the Referring Source for Fax screen: 

• Patient's Current Referring Sources: Click this button to fax to one or 
more of the patient’s current referring sources. Once all referring 
sources have been selected, click the OK button. The selected 
source(s) will be displayed in the Ref. Sources for this Appt list. 

• Patient's Current Cases: Click this button to fax to a referring source 
associated with a current case. Once a case has been selected, click the 
OK button. The selected source(s) will be displayed in the Ref. Sources 
for this Appt list. Please note you may only select one case at a time. 

• Referring Source List: Click this button to fax to a referring source not 
currently assigned to the patient. This button displays the Referring 
Source Select screen. Once all sources have been selected, click the 
OK button. The selected source(s) will be displayed in the Ref. Sources 
for this Appt list. 

 Click the OK button on the Referring Source for Fax screen once all fax 
recipients have been selected.  

• Patient: Select this option to send your fax to a patient. Click the OK button. The 
Patient fax number screen appears. If the patient's fax number is stored in Patient 
Demographics, it will be displayed in this field. You can enter a new fax number 
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in this field. Click the OK button. If you entered a new fax number for the patient, 
you will receive a message asking if you want to store the new fax number as the 
permanent fax number. Click Yes to save the new fax number. Click No to keep 
the old fax number.  

• Other: Select this option to send your fax to a other source. Click the OK button. 
The Fax to Other screen appears. Enter the recipient's name in the Recipient 
Name field, and their fax number in the Fax Number field. Click the OK button.  

File Path and Name Screen  
On the File Path and Name screen, enter (or browse to) the file that you want to use.  

Graph Window screen 
This screen displays the flow chart or vital signs graph, based on the data you selected. 

Guarantor Note Screen  
The Display Notes screen lists the notes that have been added for the guarantor and that have 
been assigned a function of "Guarantor". This means that the note appears when you open the 
guarantor’s record.  

You can access the Guarantor Note screen from the Display Notes screen by highlighting the 
note (if there is more than one) and clicking the Edit button.  

The fields on this screen include:  

Field Description 

Function  Where the note should display.  

Active Date  The date the note is active. The active date is the day the note 
becomes “functional” (that is, the day the note displays 
according to the function indicated in the previous field).  

Expire Date  The note’s expiration date. The expiration date is the day the 
note will be archived or purged, depending on your system 
settings.  

Cycle  This feature has not yet been implemented. 

Note box  The note text.  

To do?  If the note is a "to do" item, the check box is marked.  

Priority  If the note is "to do", the note’s priority. This is used to prioritize 
"to do" notes only.  

Category  If the note is "to do", the note’s category. This is used to sort "to 
do" notes only.  

Assigned to  If the note is "to do", the operator assigned to the note.  

Subject  If the note is "to do", the note’s subject. The subject appears on 
the Guarantor screen’s Notes tab, and can either be a unique 
subject line or the first 30 characters of the note.  

Completed?  If the note is "to do", and the item has been completed, this 
check box is marked.  
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Image: Save As screen 
This screen appears when you are saving an image template or have added an image in the 
patient chart.  

When saving an image template, type a name for the template and click the OK button. 

When saving an image from the patient chart, you can save the image either as a template or 
as an attachment to the chart. 

• Template: Mark the Template radio button. Type a name for the template, then click the 
OK button. 

• Attachment: Mark the Chart Attachment radio button. Type a name for the template, 
then select the chart section related to the image (for example, if you are creating an 
image for a note, select Progress Notes). Once the section is selected, select the 
appropriate note in that section. Click the OK button. 

Insert Linked File screen 
You can place permanent hyperlinks directly into progress notes. Unlike the LINK label marker, 
permanent hyperlinks are not removed when you save the note. 

These permanent hyperlinks can point to any file viewable by Internet Explorer (for example, 
HTML pages, graphics files, text files, and files in the Lytec MD Knowledge Base). The address 
can be a relative or absolute path. Permanent hyperlinks appear in notes as PLINK2 labels, and 
are saved with the note. 

For image files, the PLINK and PLINK2 labels support JPG, BMP, WMF, GIF, and PNG file 
formats. Other image formats may open outside of Patient Records, using the default viewer 
for the format. This may allow users to access restricted images. For example, a TIF file on 
Windows XP may open with the Windows Picture and Fax Viewer, which allows the user to 
scroll through all image files in the image folder. Images inserted using PLINK and PLINK2 
labels print on reports such as Chart Summary.  

Adding permanent hyperlinks to notes 

To add a permanent hyperlink in a note: 

1. Place the cursor at the point in your note where you want to insert the hyperlink. 

2. Select Insert > Linked File. The Insert Linked File screen appears. 

3. In the Enter file name field, type the address or path to the file. The file must be 
displayable in Internet Explorer (examples include p:\ppart\kbase\Asthma 
Management.htm, f:\images\mri.jpg, and images.ct.jpg). 

4. In the Title of File field, type an optional name for the file. This name will display in the 
note in front of the link. 

5. Click the OK button. 

Insert Partial Note Marker screen 
Partial note markers can be added to existing notes to indicate points at which text will be 
inserted later from an uploaded text data file. This feature can be used, for example, if you 
want to enter part of a progress note directly into Lytec MD, and then dictate the remainder of 
the note so that it can be transcribed. 
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When markers have been added to a note, the Lytec MD creates a data file which identifies the 
note to be updated and the point(s) at which to insert text. When the text data file is uploaded, 
the partial note markers are automatically replaced with the relevant text from the uploaded 
file. 

Adding partial note markers 

To add a partial note marker to a note: 

1. Open a note. 

2. Place the cursor at the point in the note where you want to insert the marker. 

3. Select Insert > Partial Note Marker. The Insert Partial Note Marker screen appears. 

4. If required, type a new label for the partial note marker in the Name of Unique Partial 
Note Marker to Insert field. 

Note: By default, Patient Records will display a number in this field which is incremented 
by one from the last marker inserted in a note. Each partial note marker must have a unique 
label. You should note the marker label so that it can be correctly referenced in the text 
data file you will upload later. 

5. Click OK. The inserted partial note marker is shown in blue, underlined text with an 
^InsertText prefix. 

Replacing partial note markers with uploaded text 
Text data files containing partial text to add to an existing note must include a .D line 
containing date and patient information that can be used to identify the relevant note and .P 
lines identifying each partial note marker you want to replace, followed by the replacement 
text. For example, if you want to replace the partial note marker labeled '1001' in a note, the 
data file should contain the line .P: 1001, followed by the text to insert at that point. Dot codes 
can be included in the partial note text, as required. 

.D: 03/01/02 : 10:00 am : Smith, David : 1256  

.P: 1001 

.PV: AAB 
Left foot has been tender and red for 2 days. No previous history of redness in the area. No 
history of injury or insect bite. Seems to be getting worse. Has taken ASA to no avail.  
 
.P: 1002 
Dorsum of L foot, distal to 1st MP joint, there is a 3 cm in diameter area of bright erythema and 
heat. Moderate edema. No streaking. No palpable inguinal nodes. 
 
.TR: RClarke 03/01/01 

If required, the text data file can also contain a .PV line to identify the provider who should 
review the updated note. If the .PV line is not included, the note will be sent to the originating 
provider for review. In addition, a .TR line can be used to add transcriber information to the 
note. 

When the text data file is uploaded, Patient Records searches for an existing note matching the 
date and patient information in the .D line. When a matching note is found, Patient Records 
looks for partial note marker labels in the note which match the .P lines in the file. If matching 
labels are found, Patient Records replaces them with the relevant text from the data file, then 
saves the note and assigns it to the provider for review. 
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To replace partial note markers with text from an uploaded text data file: 

1. Create a text data file. 

2. Ensure that the note in which you want to replace partial note markers is identified by 
the .D line in the file. 

3. Ensure that the partial note markers you want to replace are identified by .P lines in the 
file, followed by the updated text. 

4. Click Task > Data Loader > Text Data Loader. The Text Data Loader screen appears.  

5. Click Browse, select the text data file created in step 1, and then click Load. The file is 
loaded and partial note markers in the progress note are replaced with the relevant 
text in the uploaded data file. 

Insert Problem screen 
This screen displays the patient's Major Problems, Other Problems, and Diagnoses, and allows 
them to be easily inserted into a note. When inserted, problems are prefaced by a .MP, DX, or 
.OP Dot code (according to the user’s selection of radio buttons on this screen). This will cause 
them to be added to those sections of the Problem List when the note is saved (and also to 
populate the Electronic Encounter Form if Electronic Encounter Forms are being used). You 
can select to insert the problem as a Major Problem or Diagnosis. If you are inserting a 
Diagnosis or Other Problem, you can choose to insert the problem as a Other Problem. The 
problem will then be inserted into the note with the preface Major Problem, Diagnosis, or 
Other Problem.  

Note: You can configure the default settings for the Insert As selections in the ppart.ini file or 
on the Records 5 tab of the Special Features screen. 

To insert a problem into a note: 

1. Click the Major Problems tab, Other Problems tab, or Diagnosis tab.  

2. Scroll through the list and highlight the problem that you want to insert.   

3. Select whether you want to insert the problem as a Major Problem, Diagnosis, or Other 
Problem by clicking the one of the corresponding radio buttons.  

You can select the Name Only (No Dot Code) radio button if you only want to insert 
the problem name into the note.  

4. When you are finished, click the OK button.  

Insert Problem/Diagnosis Code screen 
As you enter progress note information, you can insert problem/diagnosis codes. When you 
insert these codes, Patient Records will add Dot codes for major problem, other problem, or 
diagnosis code data. When the note is saved, the data is added to the patient chart's Problem 
tab. 

You can enter your own codes in any of the Lytec MD Windows products. 
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Adding problem/diagnosis codes to notes 

To insert a problem/diagnosis code in a note: 

1. Place the cursor at the point in your progress note where you want to insert the code 
and its description. 

2. Select Insert > Problem/Diagnosis Code, click the Pb/Dx button on the toolbar, or 
press SHIFT+F3. The Insert Problem/Diagnosis Code screen appears.  

3. You can look up codes by code, short description, or long description. Click on the 
appropriate radio button and choose the OK button. The list will highlight the closest 
match. 

4. Each code can have a short description and a long description associated with it, and 
you can merge either or both into the note. Remember that problem list titles have a 
maximum of 18 characters. When descriptions are added to the list, those longer than 
18 characters are truncated.  
 
Mark the radio button with the appropriate description choice: Short, Long, or Both. 

5. You can also select how you want the codes inserted: as a Major or Other problem, or 
as a diagnosis. Dot codes used are .MP, .OP, or .DX.  

Insert Procedure Code screen 
As you enter progress note information, you can insert procedure codes. When you insert 
these codes, Patient Records will add Dot codes (for procedures, .PR) for procedure 
information.  

You can enter your own codes in any of the Lytec MD Windows products. 

Adding procedure codes to notes 

To insert a procedure code in a note: 

1. Place the cursor at the point in your progress note where you want to insert the code 
and its description. 

2. Select Insert > Procedure Code, click the Proc button on the toolbar, or press 
SHIFT+F4. The Insert Procedure Code screen displays. 

3. You can look up codes by code, short description, or long description. Click on the 
appropriate radio button and choose the OK button. The list will highlight the closest 
match. 

4. Each code can have a short description and a long description associated with it, and 
you can merge either or both into the note. Mark the radio button with the appropriate 
description choice: Short, Long, or Both. 

Insert QuickText screen 
The Insert QuickText screen displays: 

• If you click on a QuickText picklist in a progress note (this is a red QuickText link). A 
picklist opens a screen from which you can choose from a pre-selected list of QuickText 
items. You can select multiple items by holding the CTRL key and clicking on each item.  
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Click the Vertical Insert button if you want the items to be inserted vertically instead of 
horizontally. You may find this feature useful, for example, if you want to select and insert 
Dot codes that will update other chart sections. 

• If you select Insert > QuickText. This screen displays all available QuickText items. The 
rest of this section discusses this particular QuickText screen. 

Note: A maximum of 32,767 QuickTexts can be displayed on the Insert QuickText screen.  

Once you have created a collection of QuickText, it is easy to enter QuickText in your notes and 
messages. On the Insert QuickText screen, select the Regular radio button to display the 
QuickText items (the other buttons display Dot codes and letter codes). 

QuickText can either be "universal" (available to all providers/practices) or specific (available 
only to a specific provider or practice, depending on the Allow QuickText and Templates by 
Practice setting on the Special Features screen). Universal QuickText displays in the list when a 
provider or practice has not been specified. To view specific QuickText, enter the provider or 
practice ID in the appropriate field and click the Refresh button. 

Adding QuickText to notes 

To insert a QuickText item:  

1. Place the cursor at the point in the progress note or message where you want to insert 
the text.  

2. Select Insert > QuickText, or click the QText button on the toolbar. The Insert 
QuickText screen appears.  

3. Highlight the QuickText that you want to insert. You can scroll through the list to select 
the QuickText, or you can enter part of the QuickText name in the QuickText name 
field. The QuickText item that most closely matches the name you enter will be 
highlighted.  

4. Click the Insert button to merge the QuickText into the note.  
 
When using embedded QuickText in a note, pressing ALT+A displays a pop-up list of 
the closest matches, even if there is an exact match. This enables you to enter 
abnormals into QuickText and pick them from a list.  

Insert Template screen 
The Insert Template screen displays the templates that have already been entered into the 
system.  

You can search for a template by entering the first part of the name in the Name field and 
clicking the Search button. When you locate the appropriate template, double click the name 
to edit or insert the template.  

Templates can either be "universal" (available to all providers/practices) or specific (available 
only to a specific provider or practice, depending on the Allow QuickText and Templates by 
Practice setting on the Special Features screen). Universal templates display in the list when a 
provider or practice has not been specified. To view specific templates, enter the provider or 
practice ID in the appropriate field. 

You can also add a template by clicking the New button.  
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Insert a Sound File screen 
As you enter progress note information, you can insert sound files. The sound file is saved only 
when the note is signed (if required) and saved. 

Adding sound files to notes 

To insert a sound file in a note: 

1. Place the cursor at the point in your progress note where you want to insert the sound 
file. 

2. Select Insert > Sound File. The Insert a Sound File screen appears. 

3. In the Enter file name field, type the address or path to the file. 

4. In the Title of File field, type an optional name for the file. This name will display in the 
note in front of the link. 

5. Click the OK button. 

Medication Flag screen 
When you click the patient chart's Rx/Medications tab, the Medication Flag screen displays Rx-
related notes added through the Rx/Medications screen's Other button. 

Members screen 
The Members screen displays the system operators who have been added to the operator 
group. 

This screen appears when you click the Members button on the Operator Search screen 
(accessed by clicking the To, Cc, or Bcc buttons when sending a message). 

Operator Select screen 
This screen displays a list of active Lytec MD operators (users). You can either:  

• Scroll through the list and highlight the operator that you want to use.  

• Mark the ID radio button and type the operator's ID in the field. Click the Search button. 
The operator that most closely matches the ID will be highlighted in the list.  

• Mark the Name radio button and type the operator's name in the field. Click the Search 
button. The operator that most closely matches the name will be highlighted in the list.  

When the appropriate operator is selected, click the OK button.  

Order History Screen  
You can view the history of an order by right clicking on the order in the provider or processor 
review screen and selecting History. Your access level determines whether you can access this 
screen, and whether you can edit the information.  

The history screen displays:  

• Order ID 

• Who initiated the order (the ordering provider)  
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• Current status of the order  

• Date/time entered 

• Date/time ordered  

• Date/time cancelled 

• Who cancelled the order 

• Cancellation reason 

If authorization is required for the order, you can also view the:  

• Date/time the order was authorized and which Lytec MD operator changed the status to 
Authorized.  

or  

• Date/time the order was denied, which Lytec MD operator changed the status to 
Denied, and the reason the order was denied.  

Order Requirements screen 
This screen displays requirements for orders with the same patient, status, and type. 

Order requirements are entered on the Order Names screen. For example, a requirement may 
be “One lavender top tube”. 

If the order is part of a repeating (recurrent) order, only the requirements for the oldest order 
in the group displays. 

You can print the requirements summary by clicking the Print button. 

Order Search screen 
On the Order Search screen, enter the parameters you want to use to search for a specific 
order. You can narrow down the search by selecting criteria including: 

• Order name 

• Order type 

• Order category 

• Provider 

Click the OK button when you've selected the criteria. The Orders screen displays the orders 
that most closely match the search parameters. Select the order from the list and click the OK 
button.  

Any or all search criteria can be left blank. You can type just the first few letters of the Order 
name if you wish. 

If the order you want doesn't appear in the list, click the New Search button and enter different 
criteria. 

Patient Comment Notes 
The Patient Comment notes feature allows you to create notes for patients pertaining to their 
lab data. These notes are viewed by the patient in Web View. When creating a Patient 
Comment note, you may choose to apply it to a specific lab test, all tests on a given template 
for a particular date, or all tests from that date. You can also create Patient Comment notes for 



Patient Records for Windows User’s and Technical Guide 

Page 942 

 

non-laboratory results when viewing or reviewing notes in other note-based sections of the 
chart. You can not create Patient Comment notes when viewing or reviewing progress notes.  

Note: Patient Comment notes do not require signatures and will not go to the review bin. 
These notes are also not supported by the data loaders. 

You can create a new Patient Comment note by clicking the Patient Comment button (i.e., Pat 
Comment or Pt Comment) on the lab and text-based sections of the chart.  

Once a Patient Comment note has been created, patients can log into Web View to view the 
patient comment. If the patient has a new comment, it is displayed on the first screen after they 
log in. Patients can also view their notes in the Lab section and Note section of the Web View 
patient chart.  

Important: To create Patient Comment notes for patients via Web View you must have Web 
View, and the "Allow Web View access for patient" configuration must be enabled for the 
patient.  

If the patient has a new lab result comment, the result will be displayed to them in Web View as 
a hyperlink. They can then click on the hyperlink to view the comment. If the patient has 
another note-based comment, they can click on the result hyperlink, to display the result. The 
result screen will display a message at the top of the screen indicating that a comment exists 
for the result. The patient can then click on the provided link to view the comment. The 
Comment column also displays a "Y" if a comment exists for the result.  

For example, if a Patient Comment note is created for a specified lab test, the patient can click 
on the Lab Results link on the navigation bar on the left hand side of the Web View page. When 
the Lab Results page is open, they can scroll to the lab result and click on it to view the result 
and comment.  

When viewing notes in Patient Records that have Patient Comment notes linked to them the Pt 
Comment button will be highlighted in blue. You can click the button to view the most recent 
Patient Comment linked to the note being viewed. If there is more than one Patient Comment 
linked to the note you can use the Older and Newer buttons to view previous and more recent 
Patient Comment notes.   

Note: The Pt Comment button will only be highlighted when notes are viewed from other 
note-based sections of the chart. This feature does not apply to Patient Comment notes linked 
to lab results.  

Viewing Patient Comment notes in Patient Records 
To view Patient Comment notes for a patient when their chart is open, select the Patient 
Comment Notes option from the Show menu. From the Patient Comment screen you can 
view older and newer notes, edit an existing note, print a note, fax a note, or attach an image to 
a note. 

Adding Patient Comment notes for Lab Data  
From the Most Recent Lab Data screen and the Laboratory Data Table screen you can create 
patient comments for all labs for a selected date, all labs for a template and date, or a specific 
lab test. 

To add a Patient Comment note for all labs for a selected date:  

1. On the screen, highlight the date you want to create a Patient Comment note for.  

2. Click the Pt Comment button to open the Comment for Patient covers screen.  
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3. Select the All Lab for the highlighted date radio button. Click the OK button. The 
Patient Comment screen appears. 

4. Enter text in the note-based section in any form you like, using Patient Records’ word 
processing functions. The date and time lines cannot be changed in the patient 
comment section. If you attempt to do so, you will receive a message, and the time and 
date will be changed back to their original values. Click the OK button when you have 
finished entering the relevant information. 

To add a Patient Comment note for all labs for the Template / Date:  

1. On the screen, highlight the column or lab test that you want to create a Patient 
Comment note for.  

2. Click the Pt Comment button to open the Comment for Patient covers screen.  

3. Select the All Lab for this Template / Date radio button. Click the OK button. The 
Patient Comment screen appears. 

4. Enter text in the note-based section in any form you like, using Patient Records’ word 
processing functions. The date and time lines cannot be changed in the patient 
comment section. If you attempt to do so, you will receive a message, and the time and 
date will be changed back to their original values. Click the OK button when you have 
finished entering the relevant information. 

To add a Patient Comment note for a specific lab test:  

1. On the screen, highlight the lab test that you want to create a Patient Comment note 
for.  

2. Click the Pt Comment button to open the Comment for Patient covers screen. 

3. Select the Specific Lab Test Selected radio button. Click the OK button. The Patient 
Comment screen appears. 

4. Enter text in the note-based section in any form you like, using Patient Records’ word 
processing functions. The date and time lines cannot be changed in the patient 
comment section. If you attempt to do so, you will receive a message, and the time and 
date will be changed back to their original values. Click the OK button when you have 
finished entering the relevant information. 

Adding Patient Comment notes for other note-based sections 
of the chart 
When adding Patient Comment notes for other note-based sections of the chart (i.e., X-Ray, 
EKG, etc.) you can create patient comments for specified results and results for the current 
date.  

To add a Patient Comment note: 

1. Click the Pt Comment button to open the Comment for Patient covers screen.  

2. Select This specific result to view Patient Comment notes for the specified result. 
Select All Results for this date to display Patient Comment notes for all results for the 
current date. Click the OK button. The Patient Comment screen appears. 

3. Enter text in the note-based section in any form you like, using Patient Records’ word 
processing functions. The date and time lines cannot be changed in the patient 
comment section. If you attempt to do so, you will receive a message, and the time and 
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date will be changed back to their original values. Click the OK button when you have 
finished entering the relevant information. 

Patient Inquiry File screen 
Use this screen to enter (or browse to) the appropriate Patient Inquiry file. Patient Inquiry files 
have an .inq extension. Then click the OK button.  

Patient Note  
Display Notes lists the notes that have been added for the patient and that have been 
assigned a function of "Patient." This displays when opening the patient’s record.  

Open Patient Note one of the following ways: 

• Display Notes. Select the note and click Edit. 

• Dashboard. Click the note in the To Do area. 

The fields on this screen include:  

Field Description 

Function  Where the note should display.  

Active Date  The date the note is active. The active date is the day the note 
becomes “functional” (that is, the day the note displays 
according to the function indicated in the previous field).  

Expire Date The note’s expiration date. The expiration date is the day the 
note will be archived or purged, depending on your system 
settings.  

Cycle This feature has not yet been implemented.  

Note box  The note text.  

To do?  If the note is a "to do" item, the check box is marked.  

Priority If the note is "to do", the note’s priority. This is used to prioritize 
"to do" notes only.  

Category  If the note is "to do", the note’s category. This is used to sort "to 
do" notes only.  

Assigned to  If the note is "to do", the operator assigned to the note.  

Subject  If the note is "to do", the note’s subject. The subject appears on 
the Patient screen’s Notes tab, and can either be a unique 
subject line or the first 30 characters of the note.  

Completed?  If the note is "to do", and the item has been completed, this 
check box is marked.  

Patient Select screen 
This screen displays the list of patients. You can either:  

• Scroll through the list and highlight the patient that you want to use.   

• Mark the ID radio button and type the patient's ID in the field. Click the Search button. 
The patient who most closely matches the ID will be highlighted in the list.  
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• Mark the Last, First, MI radio button. Three fields display below the radio button. The 
field on the left is for the patient's last name, the middle field for the patient's first name, 
and the field on the right for the patient's middle initial. Type any combination of last 
name, first name, and middle initial. Then click the Search button. The patient who most 
closely matches the names you entered will be highlighted in the list. 

When the appropriate patient is selected, click the OK button.  

Pharmacy Select screen 
The Pharmacy Select screen lists the pharmacies that have been set up in Patient Records.  

You can use this screen to: 

• Search for pharmacies. You can use one or all of the provided options.  

• Create a new pharmacy from Pharmacy Maintenance. See the Pharmacies section for 
more information.  

• Select a pharmacy to edit or delete from Pharmacy Maintenance. See the Pharmacies 
section for more information.  

• Add a pharmacy to a patient record, or modify the details regarding a pharmacy’s 
association with a patient, from the Patient screen's Configuration tab. See the Patient 
Pharmacies section for more information.  

• Select which pharmacy a prescription will be sent or faxed to. See the Pharmacy Print 
options section for more information. 

To open the Pharmacy Select screen when adding, editing, or deleting pharmacies: 

• Select Maintenance > Tables > Pharmacies. The Pharmacy Select screen appears. 

To open the screen when adding or editing patient pharmacies: 

1. Open the Patient screen for the patient you want to add the pharmacy for. Click the 
Configuration tab. 

2. In the Patient Pharmacies area, do one of the following: 
• Click the New button. The Patient Pharmacy <New> screen appears. 

• Highlight the pharmacy that you want to change. Click the Edit button. The 
Patient Pharmacy <Edit> screen appears. 

3. Click the Pharmacy ID drop-down arrow. The Pharmacy Select screen appears.  

To open the Pharmacy Select screen to select which pharmacy the prescription will be 
sent or faxed to: 

• On the Pharmacies for Patient screen, click the Pharmacies button. The Pharmacy Select 
screen appears.   

To select a pharmacy: 

1. Do one of the following: 
• Scroll through the list and highlight the pharmacy that you want to use.  

• Search for a pharmacy(ies) by name, ID, nickname, address, city, ZIP code, 
phone/fax, and/or neighborhood.  

• If you wish to search by city, ZIP code, phone/fax, or neighborhood, 
type the full or partial value in the provided fields.  
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• If you wish to search by pharmacy name, pharmacy ID, nickname, or 
street address, you can select the word radio button and type a word 
from the pharmacy's name, ID, nickname, or street address, or the 
starts with radio button to type the first few values from the pharmacy's 
name, ID, nickname, or street address.  

• When you are finished entering all your search criteria, click the Search 
button. Pharmacies matching all the criteria you entered are displayed 
in the Pharmacy list.  

2. Select the appropriate pharmacy from the list, and then click the OK button.  
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Fields on the Pharmacy Select screen 

Field Description 

Search area Allows you to search for pharmacies by pharmacy name, 
pharmacy ID, or nickname.  
If you wish to search by one of these, select an option from the 
drop-down list, and then type the full or partial name, pharmacy 
name, ID, or nickname in the corresponding field.  
Select word, to search for pharmacies for which the text you 
typed in matches the start of (or all of) a word in the name, ID, 
or nickname of the pharmacy.   
Choose starts with to search for a pharmacy(ies) that start with 
the entered value.  

Street Address If you wish to search by street address, type the full or partial 
street address in this field.  
Select word to search for pharmacies for which the text you 
typed in matches the start of (or all of) a word in the street 
address of the pharmacy.   
Select starts with to search for a pharmacy(ies) that start with 
the entered value for the full or partial address.  

City  If you wish to search by city, type the full or partial name of the 
city in this field. 

Neighborhood If you wish to search by neighborhood, type the full or partial 
name of the neighborhood in this field, or select the 
neighborhood from the drop-down list.  

Note: Neighborhoods are not automatically assigned to 
pharmacies; you must populate this field in your system’s 
pharmacy records. You can use List Maintenance to set up a list 
of neighborhoods that will be available from the drop-down list 
in Pharmacy Maintenance. Your administrator must then add 
the PharmacyNeighborhoodListName= setting under the 
[Pharmacy] section of the PPart.ini file, and then specify the list 
name you set up for neighborhoods. 

Phone/Fax If you wish to search by phone number or fax number, type the 
full or partial phone number or fax number in this field. 

Zip If you wish to search by ZIP Code, type the full or partial ZIP 
code in this field.  

Include Mail Order Pharmacies 
check box 

Leave this check box selected to include in the search all mail 
order pharmacies that match any of the non-geographic search 
parameters you have already specified for the search (e.g., 
pharmacy name, nickname, phone number, etc.). 
Clear the check box to limit the search to only pharmacies that 
match the criteria of your search. 
This check box is selected by default. 
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Pharmacy list  When you are finished entering all your search criteria, click the 
Search button. Pharmacies matching all the criteria you entered 
are displayed in the Pharmacy list that includes the pharmacy 
ID, name, nickname, type, address, phone number, fax number, 
NCPDP ID, and neighborhood.  

New button Click to add a new pharmacy. The Pharmacy <New> screen 
appears.  
See the Pharmacies section for more information.  

Note: This button is only displayed when adding, editing, and 
deleting pharmacies from Pharmacy Maintenance. 

Edit button Click to edit the currently selected pharmacy. The Pharmacy 
<Edit> screen appears.  
See the Pharmacies section for more information.  

Note: This button is only displayed when adding, editing, and 
deleting pharmacies from Pharmacy Maintenance. 

Delete button Click to delete the currently selected pharmacy. A message 
asks you to confirm the deletion. Click the OK button. 

Note: This button is only displayed when adding, editing, and 
deleting pharmacies from Pharmacy Maintenance. 

Phone Note Screen  
You can add several phone notes on the General tab of the Patient and Guarantor screens. 
These phone notes are related to the home, work, cell, and pager numbers that have been 
entered on this tab. For example, you can indicate that the patient does not want to be called 
before 8 a.m.  

To enter a phone note, click the  button next to the phone field.  

Print Patient Instructions Screen  
When you add an order that includes patient instructions, the Print Patient Instructions screen 
appears. You can use this screen to print the instructions onscreen or on paper.  

Procedure Code Search screen 
This screen displays the procedure codes that have already been entered in Lytec MD. You can 
select an existing code by: 

• Marking the Office Code radio button, typing a procedure code in the field, and clicking 
the Search button. The closest match to the procedure code is highlighted in the table.  

• Marking the Description radio button, typing a description in the field, and clicking the 
Search button. The closest match to the description is highlighted in the table.  

When the appropriate procedure code is highlighted, you can select it by double clicking on 
the code or by clicking the OK button. 
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Changing the search type using the keyboard 
To change the search type without a mouse, press Tab to move to the currently marked radio 
button (the radio button is selected when a black circle displays in the button; in the example 
below, the Office Code button is currently selected). Then press the arrow key to move to the 
next radio button. 

 

Processing Extended Dialog screen 
Many labs require orders to have specific processing information, entered when samples are 
collected, which in Lytec MD is linked to order facilities. The Processing Extended Dialog 
screen displays the user-defined processing information fields associated with an order you 
selected. Fill in the appropriate information. 

The Processing Extended Dialog screen can be accessed through the Process Info button on 
the Order Processing screen and the Provider Orders screen.   

If an order has both a processing screen and an extended order screen, and both user-defined 
screens have the same name, only one screen will display. If the screens do share the same 
fields, then the data on the last screen will be saved to the Lytec MD database. For example, if 
both screens have a Time Drawn field, and you enter data first on the processing screen and 
then on the extended order screen, the data on the extended order screen will be saved. 
Please note that the data on the first screen will be overwritten. 

If you need to print a requisition form for the order (this is usually facility-specific), click the 
Requisition button on the Processing Extended Dialog. The requisition form will print from the 
Order Requisitions printer.   

Your system administrator can use a setting in the ppart.ini file that requires processing 
information to be filled out before the order can be sent to the appropriate facility. 

Provider Search/Select screen  
This screen displays the list of providers. You can either:  

• Scroll through the list and highlight the provider that you want to use.  

• Mark the Code (or ID) radio button and type the provider's ID in the field. Click the 
Search button. The provider who most closely matches the ID will be highlighted in the 
list.  

• Mark the Name radio button and type the provider's name in the field. Click the Search 
button. The provider who most closely matches the name will be highlighted in the list.  

When the appropriate provider is selected, click the OK button.  
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Render to file screen 
If you selected to save a report to file, you can use this screen to specify the file's format and 
name. 

Select whether to save the file in PDF, HTML, or text format. Then enter the file's path, name, 
and extension (all three items are required).  

For example, if you want to save the file in HTML format in the Lytec MD directory with the 
name UnsavedNotes, you would enter: 

p:\ppart\UnsavedNotes.html 

where p:\ppart is the path to your Lytec MD database. 

Repeating Order screen 
You can use the Repeating Order screen to specify criteria for when an order should repeat. 
You can specify that the order should be done a certain number of times, or that it should be 
done every day within a selected time range. You can also set the urgency for the repeat 
orders. 

Criteria you enter on the Repeating Orders screen applies to the second and subsequent 
orders in the recurring order set. 

Field Description 

Do a certain number of times Select this option if you want the orders to be done in a set 
number of days, months, or years for a specific number of 
times. 
In the first field, type the interval number at which the order 
should be performed. In the second field, select the type of 
interval (days, weeks, or months). In the third field, type the 
number of times the order should be completed. 
The interval will start from the date of the order you originally 
added. That is, if the order date is May 14, and you specified 
that the repeat orders should be completed every 2 weeks for 
two times, the order will be repeated on May 21 and May 28. 
A week is defined as starting on Monday and ending on 
Sunday. 

Use start and end dates Select this option if you want the orders to be done in a 
specified time range and repeated in a specific number of days. 
Select the start date for the second order. You can also specify 
an end date after which the order should no longer repeat. 
In the Do every field, select the type of interval (days, weeks, or 
months).  
The interval will start from the date of the order you originally 
added. That is, if the order date is May 14, and you specified 
that the repeat orders should be completed every week for two 
times, the order will be repeated on May 21 and May 28. 
A week is defined as starting on Monday and ending on 
Sunday. 

Note: If you select weeks or months as the interval, the last 
order may be scheduled after the end date. Lytec MD 
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schedules through the end of the week or month selected, 
irrespective of the actual date entered. 

Do on If you select weeks or months as the interval, you can use the 
Do on field to select the day of the week on which the order 
should be completed. In the example above, if May 14 is a 
Friday and you select a Do on date of Monday, the order will be 
repeated on May 24 (the first Monday at least a week from the 
original order) and May 31. 

Urgency Select the urgency for the repeating orders: routine, stat, or do 
within xx days. 

Rx Template Info Screen  
This screen displays the formulary template’s code, name, Rx type, message, and insurance 
cost.  

Select Orders screen 
You can use the Select Orders screen to filter the orders that display on the order review 
screens. 

Using the Select Orders screen 

To select orders to view:  

1. On the order review screen, click the Select button. The Select Orders screen appears.  

2. Use the fields on this screen to select which orders you want to view.  

3. When you finish, click the OK button to return to the Orders or Provider Orders screen. 
This screen displays the orders that meet the criteria you selected.  

Fields on the Select Orders screen 
The following table shows the fields located on each of the order review screens. Because the 
fields differ on each of the screens, the Available From column lists the screens which have the 
listed field. 

Field Available From Description 

Practice   Provider 
Orders 

 Order 
Processing 

 Overdue 
Orders 

 Patient 
Orders 

To view orders for all practices, leave this field blank.  
To view orders for a specific practice, select the 
appropriate practice from the drop-down list.  
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Order Type   Provider 
Orders 

 Order 
Processing 

 Overdue 
Orders 

 Patient 
Orders 

To view orders for all order types, leave this field blank.  
To view orders for a specific order type, select the 
appropriate type from the drop-down list.  

Order Status   Provider 
Orders 

 Order 
Processing 

 Patient 
Orders 

To view orders for all statuses, leave this field blank.  
To view orders for a specific status, select the 
appropriate status from the drop-down list. The 
available statuses are Pending, Sent, Suspend, 
Approved, and Completed.  

Dates   Provider 
Orders 

 Order 
Processing 

 Patient 
Orders 

In the date fields, select the range of dates for which 
you want to view orders. When you select a starting and 
ending date, all orders created between those dates 
that meet the other criteria you set will display.  

Operator  Order 
Processing 

 Overdue 
Orders 

Select an operator from the Operator Select screen, and 
click OK. The operator will be displayed in the Operator 
field. 

Ordering Prov.  Order 
Processing 

 Overdue 
Orders 

 Patient 
Orders 

Select an ordering provider from the Provider Select 
screen, and click OK. The provider will be displayed in 
the Ordering Prov. field. 
 

Select Referring Source Type screen 
This screen displays a list of referring source types.  

To select a referring source type: 

1. Move the source into the list box on the right-hand side of the screen by clicking the 
right arrow button, or double-clicking the source. 

2. You can also remove the source from the list by selecting the source and clicking the 
left arrow button, or double-clicking the source. 

3. You can continue adding sources to the list by selecting and moving the sources into 
the list box on the right-hand side of the screen. 

4. When you are finished, click the OK button. This will return you to the AS/PR Referrals 
Report screen. 
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Select Rx Template screen 
The Select Rx Template screen appears when you need to select a prescription template. 

To open the Select Rx Template screen: 

1. In the Prescription screen, select the by Template Code option. 

2. Click the Lookup button. The Select Rx Template screen appears. 

Note: The Rx/OTC and Generic columns in the Select RX Template screen are reserved for 
future use. 

To select a prescription template by template code: 

1. In the Select Rx Template screen, type all or part of a template code in the Template 
Code field, and then click Search. A list of prescription templates matching your 
search text is displayed in the table. 

2. Click the name of the prescription template to be used, and then click OK. The 
Prescription screen appears and prescription template details are displayed in the 
relevant fields. 

3. Update the information on the Prescription screen, as required. 

To select a prescription template by indication: 

1. In the Select Rx Template screen, click the Indications button. 

2. Type all or part of a diagnosis code in the Indication field, and then click Search. The 
Diagnosis Code Select screen appears. A list of diagnoses matching your search text is 
displayed in the table. 

3. Click a diagnosis code in the table, and then click OK. The Select Rx Template screen 
appears. A list of prescription templates matching the selected diagnosis is displayed. 

4. Click the name of the prescription template to be used, and then click OK. A 
confirmation message appears, asking you whether to save indications for the 
prescription. 

5. Click Yes if you want to add the indications selected in the Select RX Template screen 
to the Indication 1 and Indication 2 fields in the Prescription screen. Click No if you 
want to leave these fields blank. The Prescription screen appears and prescription 
template details are displayed in the relevant fields. 

6. Update the information on the Prescription screen, as required. 

Select Specialty screen 
This screen displays a list of source specialties.  

To select a source specialty: 

1. Move the source into the list box on the right-hand side of the screen by clicking the 
right arrow button, or double-clicking the source. 

2. You can also remove the source from the list by selecting the source and clicking the 
left arrow button, or double-clicking the source. 
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3. You can continue adding sources to the list by selecting and moving the sources into 
the list box on the right-hand side of the screen. 

4. When you are finished, click the OK button. This will return you to the AS/PR Referrals 
Report screen. 

Special Criteria Window 
Patient Records can display the Special Criteria screen for any note-based section of the 
patient chart (including progress notes and history notes). 

All fields are optional. Fill in only the relevant fields. WITHIN each of the three main criteria 
(dates, problems, text pattern) "OR" logic is used. "AND" logic is used BETWEEN the three 
main criteria.  

You can search the progress notes by up to four specific dates (by day, month and year) and/or 
two ranges of dates (by day, month, and year). You can search for up to three specific 
problems from the patient’s problem list and you can search the progress notes by up to three 
specific text patterns. Patient Records attempts to match the text exactly as you type it. Use any 
combination of letters, numbers, spaces and punctuation to find the progress notes for which 
you are looking.  

For example, you can select all progress notes for three patient visit dates concerning one or 
two problems that also contain one of two text patterns. For example, you can look for all 
progress notes for Mrs. Smith for January 8, June 16, and October 10 for “low back pain” or 
“U.R.I.” that contain the phrases “very severe” or “moderately severe.”  

If there is more than one screen of notes, move to the next screen by clicking the Older button. 
The Newer button returns you to the previous screen. Because the notes are arranged in 
reverse chronological order, the Newer button scrolls to more recent notes. The Older button 
scrolls to older patient notes.  

You can search by practice and by oldest notes (that is, the last xx number of notes added in 
Patient Records). 

Examples of special criteria searches 
Simple searches: 

• Enter a couple of dates or a single range of dates. 

• Enter a single problem name (e.g., low back pain). 

• Enter a single text pattern (e.g., "severe depression"). 

• Select the five oldest notes. 

More complex searches: 

• Enter two date ranges and a provider ID. You will get notes in both ranges for that 
provider. 

• Enter two date ranges and a problem name. You will get notes with that problem name 
in both of the specified date ranges. 

• Enter a text pattern and a problem name. For example, the combination of the text 
pattern "severe" and the problem name "low back pain" retrieves only notes with the 
problem name "low back pain" which contain the word "severe." 

• Enter a problem name and choose a number of oldest notes. For example, if you enter 
"low back pain" and 5 oldest notes, you will see the five oldest notes concerning low 
back pain. 
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Very complex searches: 

• Select several dates or date ranges, two problems, and two text patterns. You will get 
notes in all designated dates and/or date ranges, for either of the two problems, and for 
either of the two text patterns. 

Accessing the Special Criteria screen 

To display the Special Criteria screen for all note-based chart sections: 

1. On the patient chart, mark the Search radio button on the right side of the screen. 
Once you mark this radio button, the Special Criteria screen will appear when you 
select any text-based section. 
 
For example, if you want to retrieve a patient’s chest X-Rays for the last three years, you 
can click the X-Ray tab. When the Special Criteria screen appears, you can then enter a 
range of dates and Chest X-Ray in the title box. The patient’s chest X-Ray reports for 
those dates will appear in reverse chronological order. 

2. To turn off the Special Criteria screen, mark the All radio button on the right side of the 
screen. 

Template Lookup Screen  
The Template Lookup screen displays the templates that exist in Lytec MD.  

You can search for a template by entering the first part of the name in the Name field and 
clicking the Search button. When you locate the appropriate template, double click the name 
to edit the template.  

Note, letter, and message templates can either be "universal" (available to all 
providers/practices) or specific (available only to a specific provider or practice, depending on 
the Allow QuickText and Templates by Practice setting on the Special Features screen). 
Universal templates display in the list when a provider or practice has not been specified. To 
view specific templates, enter the provider or practice ID in the appropriate field. 

You can also add a template by clicking the New button.  

To Do List 

About To Do Notes 
With Lytec MD's Note summary screens, you can easily view all patient (the default) or 
guarantor to do notes. These notes can be entered directly on the individual patient or 
guarantor screens. Note lists can be filtered by assigned operator, function, priority, range of 
active dates, and other criteria.  

Viewing To Do Notes 

To view to do notes: 

1. Select Task > To Do. The To Do Filter screen appears. Use this screen to filter the to do 
notes you want to view, then click the OK button. 

2. The To Do List screen displays the to do notes that meet the criteria (filters) you 
selected. You can add, change, archive, print, or delete the to do note from this screen.  
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Click the Filter button to change the criteria. 

3. When you finish viewing the to do notes, click the Close button. 
Note: A system administrator may use PPart.ini to specify the columns displayed on the To Do 
List screen.  

Adding, editing, deleting, and archiving to do notes 
To do notes are added and edited from the Patient Note or Guarantor Note screens. See the 
Adding, editing, and deleting patient registration notes section or the Guarantor Note 
Screen section for more information. 

To delete a to do note: 

• Highlight the to do note that you want to delete. Click the Delete button. A message 
asks you to confirm the deletion. Click the Yes button. 

To archive a to do note: 

• Highlight the to do note that you want to archive. Click the Archive button. A message 
asks you to confirm. Click the Yes button. 

Fields on the To Do Filter screen 
Use the fields on the To Do Filter screen to filter the to do notes you want to view. 

Field Description 

Assigned to Select the operator assigned to the notes you 
want to view, or leave blank for all operators. 

Demog. Type Indicate whether you want to view patient or 
guarantor notes. 

Current/Archived Indicate whether you want to view current or 
archived notes. 

Function Indicate the note function you want to view 
(patient, scheduler, etc.), or leave blank for all 
functions. 

Category Select whether you want to view call or reminder 
notes. Leave blank for all categories. 

Priority Select a priority, or leave blank for all priorities. 

Active Date Select a date range in which the notes were 
added, or leave blank for all dates. 

To Do Note Select 
The To Do Note Select screen lists the notes for a provider.  

To open the To Do Note Select screen, click the To Do area title on the Dashboard. 

To view or edit a specific note, click the note in the table and then click the Edit button. The 
note opens using Patient Note. When finished viewing or editing the note, click OK. (Even if 
no changes were made, a dialog asks if changes are to be saved.) 
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To delete a note, click the note in the table and then click the Delete button. Click Yes on the 
dialog box that verifies whether the note is to be deleted. 

To archive a note, click the note in the table and then click the Archive button. Click Yes on the 
dialog box that verifies whether the note is to be archived. 

To only display notes meeting specific criteria, click the Filter button. This opens the To Do 
Filter screen, which is used to set the filter criteria.  

The information in the table on the To Do Note Select screen includes the following:  

Information Description 

Active Date  This is the date the note became functional. It is the active date 
set in Patient Note.  

Patient ID This identification was assigned in Patients. 

Name This is a combination of First Name/MI and Last Name from 
Patients. 

Category The category was set in Patient Note. 

! (Priority) The priority was set in Patient Note. 

Assigned To  The operator assigned to the note was set in Patient Note. 

Subject  The subject of the note was set in Patient Note. 

Update Address and Phone Numbers Screen 
If you change the head of household for a patient, and your system administrator has Lytec MD 
set to use the head of household address for the patient address (on the Demographic 
Settings screen), the Update Address and Phone Numbers screen appears. This screen 
provides options for updating the patient's address and telephone numbers. Select the 
appropriate option, and click the OK button. 

Value Ranges 
When you set up lab data test names, vital sign names, and clinical element names you can 
enter normal value ranges for the test. You can set up ranges that are specific to the patient’s 
age, sex, and/or height, so that, for example, the range checking for patients of one age and 
gender is based on different values than the range checking for patients of another age and 
gender.  

Applying height ranges to clinical elements and vital signs 

A height range can be specified when setting up ranges for vital sign names and clinical 
element names, from the Ranges screen. For example, this feature can be used to check the 
normal ranges for peak expiratory flow rate based on height, and blood pressure ranges for 
children based on gender, age, and height.  

When vital sign or clinical element data is entered, if that vital sign or clinical element has a 
height-specific range, and the patient has a recent height value that falls in that height range, 
then that range shall be applied to the value entered. How "recent" the height value has to be 
is determined by the Special Features setting "Days to look back for height for Vitals/Clinical 
Elements normal range checking". This setting allows you to adjust the maximum number of 
days for the system to look back for height data when considering whether to use height-based 
normal ranges for vital signs and clinical elements. 
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Adding, editing, and deleting value ranges 

To open the value range screen: 

• On the screen used to add or edit names (Laboratory Test, Vitals Maintenance, Clinical 
Elements Maintenance, or Prenatal Maintenance), click the Ranges button. The 
corresponding Ranges screen appears.  

To add a value range: 

• On the Ranges screen, click the New button. Fill in the fields on this screen, then click 
the OK button. The value ranges you entered appear in the appropriate columns in the 
Ranges screen. If you selected both genders, one row displays the ranges for males and 
another row displays ranges for females. If you marked the Msg check box, the Msg 
column displays a Y for yes. Please note the Msg option is only available on the 
Laboratory Value Range screen.  

Note: You cannot enter overlapping value ranges for age, sex, and height for the same test. If 
all three ranges overlap, with an existing value range, you will receive a message, and will need 
to change at least one of your ranges.  

To change a value range: 

• On the Ranges screen, highlight the value range that you want to change. Click the Edit 
button. Make the appropriate changes. When you finish, click the OK button. 

Note: Age, Sex, and Height can not be modified when editing a value range.  

To delete a value range: 

• On the Ranges screen, highlight the value range that you want to delete. Click the 
Delete button. A message asks you to confirm the deletion. Click the OK button. 

Fields on the Range Logic screen 

Field Description 

Age Type the range for ages by using the year and month format 
(yyy/mm). For example, enter 003/02 for a child who is three 
years and two months old, or 004/00 for a child who is four 
years old.  
To enter a range of ages, enter the from age in the first two Age 
fields and a to age in the to fields.  
If a "from" age is not entered, a "from" age of 0 years and 0 
months (000/00) will be used. If a "to" age is not entered, a "to" 
age of 120 years and 0 months (120/00) will be used. 

Sex Select the appropriate gender for this laboratory value range.  
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Height Type the range for height that will be used to determine the 
normal height ranges for the vital sign or clinical element in 
centimeters.   
You can leave the fields blank if you want the range to apply to 
patients of any height. 
You can enter a height in the “from” field and leave the “to” 
field blank to apply the range to all patients with a recorded 
height greater than the height entered in the “from” field. You 
can enter a height in the “to” field and leave the “from” field 
blank to apply the range to all patients with a recorded height 
less than the height entered in the “to” field.  

Normal/Validation Type or select the From and To values.  

Critical Type the Less Than and More Than values. You can leave a 
range blank.   

IMPORTANT: This option only applies to laboratory value 
ranges.  

Msg check box If you want a message sent to the provider(s) when the value 
entered in the Laboratory Data Table is in the critical range, 
select this check box.  

IMPORTANT: This option only applies to laboratory value 
ranges.  



Patient Records for Windows User’s and Technical Guide 

Page 960 

 

Glossary 

A 
access: Entry to a program or particular feature of a program. For example, the main menu 
provides access to the submenus listing individual features of the application. 

Appointment Scheduler: A program that helps you schedule appointments for patients and 
keep track of patient registration. If you use Appointment Scheduler along with Patient 
Records, you can share patient registration information between the two programs. 

archive: To remove inactive patient records from your hard disk and store them on a backup 
medium, such as a floppy disk or tape. Patient Records lets you archive records which meet 
certain criteria, such as the date of last visit. You can restore archived records to the active hard 
disk, if necessary, when the patient returns. 

B 
back up: To create a spare copy of your program or data in case your disk is damaged or you 
accidentally delete a program or data file. 

C 
chart: The medical record of an individual patient, including such information as past medical, 
family, and social history, the problem list, health maintenance, vital signs, laboratory data, and 
other notes about the patient. 

chart summary: The section of the patient chart that contains a summary of the patient’s chart. 
It is designed to offer a quick overview of the most important patient information. 

clinic: The name of the practice (or clinic) where medical services are performed. You should 
enter the name of the practice(s) when you first set up the application. 

consults: The section of the patient chart where information about consultations with other 
physicians or health care providers is stored. You can use the Consults option on the patient 
chart menu to access the consults area of the patient chart. 

D 
data export: A Patient Records feature that allows you to translate patient information into the 
formats understood by other applications. You can export patient information to statistical, 
database, graphics, and word processing applications. 

data security: The features of the application that ensure patient confidentiality, prevent the 
loss or damage to data, and control access to all or part of the program. 

default: A choice automatically supplied by a program to save the user from having to enter a 
commonly selected option. Default values can be confirmed or changed by the user. 

demographic information: Demographic information is data added on the Patient, 
Guarantor, and Account Insurance Plan screens. 

diagnosis codes: Standard codes for medical diagnoses. You can access the list of diagnosis 
codes while you are viewing the Problem List section of the patient chart. 
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dialog box: A window that appears on the screen when you have selected a Microsoft 
Windows command. You can use the fields, lists, and buttons on the screen to provide the 
application with further information. 

Dot code: A code you enter into patient notes to tell Patient Records what type of information 
you are entering. Coded text is then transferred into the appropriate section of the patient 
chart. 

dot matrix printer: A type of printer that forms characters and graphics with an array of dots. 

Drug Interaction database: An optional feature of Patient Records, available on a subscription 
basis, that checks patient medications for drug interactions. 

E 
EKG: The section of the patient chart where EKG information is stored. To enter information 
about EKGs in Patient Records, click the patient chart’s EKG tab. 

enter: To move data into computer memory from the display screen. In the application, you 
display data on the screen, then click the OK button to enter, or save it. The [RETURN] key and 
the arrow keys also enter data on certain screens in the program. 

F 
family history: The section of the patient chart where medical information about the patient’s 
family is stored. Such medical information may be useful in diagnosis and treatment. You can 
use the Family History tab on the patient chart to enter this information in Patient Records. 

field: An area on an application screen set aside for entry of one data item, such as a name or 
date. 

file: A collection of data organized for use by the system. Files may be created by a program 
and stored on a disk or read from a disk and used by a program. 

flow chart: A section of the patient chart that displays a summary of numerical patient 
information in tabular form. 

G 
guarantor: The person or organization financially responsible for a patient. 

H 
health maintenance: The section of the patient chart where you record examinations, 
immunizations, tests and other medical services which need to be performed on a regular 
basis. You can use the Health Maintenance tab on the patient chart to see the schedule of 
services. 

health maintenance template: A schedule of procedures defined for all patients in a given 
sex and age group. Health maintenance templates should be defined for each patient group 
before you begin entering health maintenance information for patients. 

help: A handy online reference guide to the application. As in any standard Microsoft 
Windows online Help, you can search for topics via a subject index. 
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hospital reports: The section of the patient chart where information about hospital stays is 
stored. Click the Hospital Reports tab on the patient chart to access a patient’s hospitalization 
reports. 

I 
image template: A graphics image that you can load from a collection of images and revise 
for the individual patient note. 

images: A section of the patient chart where you can create graphics images to attach to a 
patient note. You can create graphics images from scratch or revise an image template. 

insert code: A code you enter into patient notes and letters to insert data from the 
medications, major problem list, social history, past medical history, family history, and vital 
sign areas of the patient chart. 

installation: Before you can use Patient Records for the first time, you must specify information 
about your system and practice (e.g., the type of network you are using). 

L 
laboratory data: The area on a patient chart where you record the results of laboratory tests. 

Laboratory Data Loader: A Patient Records feature that lets you transfer information supplied 
by an outside laboratory to the Laboratory Data section of the patient chart. 

letter code: A code you enter into a letter to insert patient demographic and clinic data into 
your correspondence. 

letters: The section of the patient chart where medical letters for the patient are stored. 

local area network: A configuration of systems that share applications, data, and resources. 

M 
mailmerge: A word processing feature that lets you take information about patients from a 
database and merge them into a form letter. 

maintenance: A group of features that help you use the application effectively and safely. 
Maintenance functions include archiving and restoring little-used data and creating backup 
copies of patient information. 

medications: The section of the patient chart where information about patient medications 
and allergies is stored. 

menu: A list of commands displayed on a bar across the top of the screen. 

message: Text that appears in a box on the screen to inform you about what is happening, 
prompt you to confirm an action, or warn you about a user error or system problem. 

messaging: A feature that lets providers communicate about patients by displaying messages 
in the application. 

N 
network: A configuration of systems that share applications, data, and resources. 
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O 
OFC: An abbreviation for occipito-frontal circumference, the head circumference of infants, 
which you can record in the Vital Signs section of the patient chart. 

operator: A person who uses the application. 

P 
park: A feature that lets you prevent unauthorized access to your system while a workstation is 
logged in, but temporarily not in use. 

password: A special word or string of characters you can use to protect the application from 
unauthorized access. 

past medical history: The section of the patient chart where information about the patient’s 
past illness and treatment is stored. 

pathology: The section of the patient chart where pathology results are stored. 

patient chart: The medical record of an individual patient, including such information as past 
medical, family, and social history, the problem list, health maintenance, vital signs, laboratory 
data, and other notes about the patient. 

patient history: The sections of the patient chart where information about patient history is 
stored. 

patient inquiry: A Patient Records feature that lets you select patients by a variety of criteria 
and print reports in different formats. 

patient registration: A feature (the Patient screen) that stores patient information, including 
patient name, address, sex, birthdate, financial and user-defined data. Patient data is shared 
between Patient Records and Appointment Scheduler. 

plotting: A Patient Records feature that lets you view laboratory, vital sign, health maintenance 
and medication data graphically, so that you can instantly assess results and trends. 

practice: The name of the practice (or clinic) where medical services are performed. You 
should enter the name of the practice(s) when you first set up the application. 

problem list: The section of the patient chart where problem lists are stored. The problem lists 
include those problems for which the patient has sought treatment. You can use the Problem 
List tab on the patient chart to access the Major List, Other List, Procedures List, Diagnoses List, 
Risks List, and Hospitalizations List. 

procedure code: Standard codes for medical procedures. You can access the list of procedure 
codes while you are viewing the Problem List section of the patient chart. 

progress notes: The section of the patient chart where Progress Notes are stored. Progress 
notes can be created for each individual patient on a specific date and for a specific set of 
problems. Progress notes for a patient may be retrieved in reverse chronological order, by 
problem, or by special criteria. 

provider: The physician or any other health care professional who provides service in your 
practice. 

provider tracking: A Patient Records feature that lets you track which provider has entered 
notes and medications for a patient. The provider ID is saved with any progress note entered 
into Patient Records. 
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R 
referring source: A person, such as a physician, or an entity who refers a patient to your clinic 
or practice. 

registration: A feature that stores demographic information for patients and guarantors. To 
enter a patient or guarantor name, address, insurance information and other data needed to 
create a file. Registration data is shared between Patient Records and Appointment Scheduler. 

remote access: A Patient Records feature that allows providers to access Patient Records from 
other terminals which are not part of the local area network. 

reports: Information that helps you analyze your practice. You can print Patient Records and 
Appointment Scheduler reports from the Reports menu. 

restore: To reinstate patient information in the application from an archive or backup. 

S 
screen: A window that appears on the screen when you have selected a Microsoft Windows 
command. You can use the fields, lists, and buttons on the screen to provide the application 
with further information. 

social history: The section of the patient chart where medically relevant information about a 
patient’s social history is recorded. 

special criteria: The criteria by which you can view the progress notes for a patient: including 
date, problems, or text patterns. Use the By Special Criteria options on the patient chart to 
access patient problem notes. 

special studies: The section of the patient chart where miscellaneous test reports or other 
information relevant to the patient are stored. 

specialty: A code that describes the type of medicine that providers practice. 

start date: In the Health Maintenance section of the patient chart, the start date is the date 
which tells you to which data the individual’s health maintenance template is applied. The 
displayed health maintenance template applies to all health maintenance data from the 
displayed start date up to the start date of the next health maintenance template for that 
individual, if there is one. If the start date is blank, the health maintenance template is the first 
one for the individual and applies to all health maintenance data before the start date of the 
next template. 

submenu: A menu displayed on the screen as a result of option selection from a previous 
menu. 

T 
template: A set of standardized formats that help you customize the application for your 
practice. With templates, you can simplify the entry of information by reusing the same format. 
You can create templates for laboratory data, health maintenance, flow charts, images, 
prescriptions, schedules, and more. 

Text Data Loader: An option on the Patient Records main menu that transfers the information 
you have entered with a word processor or with Medical Writer to Patient Records. 
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U 
user: A person (or operator) who uses the application. 

utilities: A set of programs provided with the application that can be used to repair data or 
correct system errors. 

V 
vital signs: The section of the patient chart where information about the patient’s vital signs, 
such as temperature, blood pressure, and pulse, is recorded. 

W 
window: A window that appears on the screen when you have selected a Microsoft Windows 
command.You can use the fields, lists, and buttons on the screen to provide the application 
with further information. 

X 
x-ray: The section of the patient chart where summaries of X-ray results are recorded. 
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